
Reference Guide

 Copyright 2022  Development-X Limited

®

18th October 2022



Ostendo Reference Guide2

Table of Contents

Introduction 14

Glossary 15

Global Options 23

................................................................................................................................... 231 Function Keys  

................................................................................................................................... 242 Spell Checker 

................................................................................................................................... 263 Quick Launch Toolbar 

................................................................................................................................... 264 Related Toolbar 

................................................................................................................................... 265 Drag and Drop Items 

................................................................................................................................... 266 Scroll Bar 

................................................................................................................................... 277 Panel Viewing Options 

................................................................................................................................... 298 Report Output Options 

................................................................................................................................... 299 Views Analysis Options 

................................................................................................................................... 3510 Views Chart Options 

................................................................................................................................... 3711 Views Pivot Grid Options 

................................................................................................................................... 4112 Alert Viewer 

Desktop 43

................................................................................................................................... 431 Desktop Views 

................................................................................................................................... 432 Workflows 

File 45

................................................................................................................................... 451 System Configuration 

......................................................................................................................................................... 45System Settings 

......................................................................................................................................................... 54System Alerts 

......................................................................................................................................................... 55User Security and Options 

......................................................................................................................................................... 61Licence Key 

......................................................................................................................................................... 62Ostendo Support Detail 

......................................................................................................................................................... 62Multiple Companies 

......................................................................................................................................................... 63Copy / Create Company 

......................................................................................................................................................... 64Alternate Database user 

......................................................................................................................................................... 64Global Name Change 

......................................................................................................................................................... 65Global Data Merge 

......................................................................................................................................................... 65Global Tax Code Change 

......................................................................................................................................................... 66Item Base Unit Swap 

......................................................................................................................................................... 66Descriptor Base Unit Swap 

......................................................................................................................................................... 67Audit Logging 

......................................................................................................................................................... 67Notifications Logging 

......................................................................................................................................................... 68Run Command Script 

......................................................................................................................................................... 68Optimize Database 



3Contents

................................................................................................................................... 682 Financial Configuration 

......................................................................................................................................................... 68Tax Codes 

......................................................................................................................................................... 70Tax Groups 

......................................................................................................................................................... 71Tax Matrix 

......................................................................................................................................................... 71Payment Methods 

......................................................................................................................................................... 73Payment Method Denominations 

......................................................................................................................................................... 74Payment Accounts 

......................................................................................................................................................... 75Credit Terms 

......................................................................................................................................................... 77Cut-Off Dates 

......................................................................................................................................................... 77Aging Periods 

......................................................................................................................................................... 78Statement Periods 

......................................................................................................................................................... 79Currency Codes 

.................................................................................................................................................. 82Multi-Site Cost Centres

......................................................................................................................................................... 83Cost Centre Mapping 

......................................................................................................................................................... 86Cost Centre Mapping by Site 

......................................................................................................................................................... 86Sales Mapping Matrix 

......................................................................................................................................................... 88Labour Mapping Matrix 

......................................................................................................................................................... 90External GL Codes 

......................................................................................................................................................... 91General Ledger Settings 

................................................................................................................................... 923 Reporting Configuration 

......................................................................................................................................................... 92Report and View Developer 

......................................................................................................................................................... 106Report Layout Editor 

......................................................................................................................................................... 106Reporting Periods 

......................................................................................................................................................... 108Web Reports 

......................................................................................................................................................... 109Web Inquiries 

......................................................................................................................................................... 109Specific Form Layouts 

......................................................................................................................................................... 111Specific Form Messages 

......................................................................................................................................................... 112Specific Email Text 

......................................................................................................................................................... 113Email-FTP 

......................................................................................................................................................... 114Inquiry Drill-Down 

................................................................................................................................... 1164 Scripting Configuration 

......................................................................................................................................................... 116Script Editor 

......................................................................................................................................................... 121Screen Data Scripts 

......................................................................................................................................................... 121Order Scripts 

......................................................................................................................................................... 122Scripting Preferences 

................................................................................................................................... 1235 Customisation Configuration 

......................................................................................................................................................... 123Additional Fields 

......................................................................................................................................................... 125Filter Screen Conditions 

......................................................................................................................................................... 126Order Tabs 

......................................................................................................................................................... 127Required Fields 

......................................................................................................................................................... 128System Screen Conditions 

......................................................................................................................................................... 129System Shortcuts 

......................................................................................................................................................... 129Touch Pads 

......................................................................................................................................................... 131User Defined Constants 

......................................................................................................................................................... 132User Defined Tables 

......................................................................................................................................................... 134User Defined Menus 

................................................................................................................................... 1346 Dashboard Configuration 

......................................................................................................................................................... 134Dashboard Setup 

......................................................................................................................................................... 137Assign Dashboards 

................................................................................................................................... 1377 Queue Service 

......................................................................................................................................................... 137Queue Settings 

......................................................................................................................................................... 139Queue Schedule 



Ostendo Reference Guide4

......................................................................................................................................................... 144Queue Log 

................................................................................................................................... 1448 Email Services 

......................................................................................................................................................... 147Auto Emails 

......................................................................................................................................................... 148Email Addresses 

......................................................................................................................................................... 148Email Queries 

......................................................................................................................................................... 150Email Forms 

......................................................................................................................................................... 151Email Form Errors 

......................................................................................................................................................... 151Email Blacklist 

................................................................................................................................... 1529 API Service 

......................................................................................................................................................... 152API Configuration 

......................................................................................................................................................... 154API Security 

................................................................................................................................... 15510 Desktop Tile Templates 

......................................................................................................................................................... 156Tile Collections 

......................................................................................................................................................... 157Desktop Tiles 

................................................................................................................................... 15811 Custom Menu Links 

................................................................................................................................... 15812 Custom Data Screens 

................................................................................................................................... 15813 Switch User 

................................................................................................................................... 15914 Change Company 

................................................................................................................................... 15915 Change Password 

................................................................................................................................... 16016 Active Connections 

................................................................................................................................... 16017 Data Importing 

................................................................................................................................... 16218 Data Exporting 

................................................................................................................................... 16219 Accounting Link 

................................................................................................................................... 16420 Archive Viewer 

General 165

................................................................................................................................... 1651 Company Sites 

................................................................................................................................... 1672 Company Assets 

......................................................................................................................................................... 171Company Asset Properties 

......................................................................................................................................................... 173Company Asset Documents 

......................................................................................................................................................... 174Company Asset Images 

......................................................................................................................................................... 176Company Asset History Notes 

......................................................................................................................................................... 177Company Asset Tracking 

................................................................................................................................... 1793 Cost Centres 

................................................................................................................................... 1814 Cost Centre Transactions 

................................................................................................................................... 1825 Budgets 

................................................................................................................................... 1906 Budget Comparisons 

................................................................................................................................... 1917 Data Spreadsheet 

................................................................................................................................... 1938 Run Any Report 

................................................................................................................................... 1939 Run Any View 

................................................................................................................................... 19310 Run Email Query 

................................................................................................................................... 19311 Knowledge Base 

................................................................................................................................... 19512 Document Management 

................................................................................................................................... 19713 Image Management 



5Contents

................................................................................................................................... 19914 Frequently Used Text 

................................................................................................................................... 20015 Hazards 

................................................................................................................................... 20216 Hazard Groups 

................................................................................................................................... 20417 Hierarchical Structures 

................................................................................................................................... 20618 Settings 

......................................................................................................................................................... 206Departments 

......................................................................................................................................................... 206Work Times 

......................................................................................................................................................... 207Holiday Dates 

......................................................................................................................................................... 207Asset Types 

......................................................................................................................................................... 208Cost Groups 

......................................................................................................................................................... 208Analysis Groups 

......................................................................................................................................................... 209Quote Lost Reasons 

......................................................................................................................................................... 210Spread Factors 

......................................................................................................................................................... 212Service Zones 

......................................................................................................................................................... 213Service Zone Times 

......................................................................................................................................................... 213Standard Units 

......................................................................................................................................................... 214Standard Properties 

......................................................................................................................................................... 215Article Types 

......................................................................................................................................................... 216Article Categories 

......................................................................................................................................................... 217General Rules 

CRM 220

................................................................................................................................... 2201 Contacts 

......................................................................................................................................................... 223Contact Properties 

................................................................................................................................... 2242 Activity Calendar 

................................................................................................................................... 2283 Call Centre 

......................................................................................................................................................... 235Call Centre Documents 

......................................................................................................................................................... 237Location Map 

................................................................................................................................... 2374 Activity Events 

................................................................................................................................... 2405 Operations Centre 

................................................................................................................................... 2456 Settings 

......................................................................................................................................................... 245Call Classifications 

......................................................................................................................................................... 246Call Sub-Classifications 

......................................................................................................................................................... 247Call Resolution Codes 

......................................................................................................................................................... 247Pipelines 

......................................................................................................................................................... 248Pipeline Stages 

......................................................................................................................................................... 249Pipeline Actions 

......................................................................................................................................................... 250Call Styles 

......................................................................................................................................................... 252Call Tracking 

......................................................................................................................................................... 252Service Agreements 

......................................................................................................................................................... 253Service Agreement Levels 

......................................................................................................................................................... 254Service Agreement Steps 

......................................................................................................................................................... 255Service Agreement Measures 

......................................................................................................................................................... 255OC Settings 

.................................................................................................................................................. 256OC Activities

.................................................................................................................................................. 257OC Activity Descriptions

.................................................................................................................................................. 258OC Preview

.................................................................................................................................................. 259OC Relations

.................................................................................................................................................. 259OC Search

.................................................................................................................................................. 260OC KPIs



Ostendo Reference Guide6

.................................................................................................................................................. 262OC Statistics

.................................................................................................................................................. 263OC KPI Indicators

......................................................................................................................................................... 264OC Rules 

......................................................................................................................................................... 265CRM Rules 

Mobility 267

................................................................................................................................... 2671 Introduction 

................................................................................................................................... 2672 Employee Mobility Settings 

................................................................................................................................... 2843 Check Lists 

................................................................................................................................... 2904 Style Templates 

................................................................................................................................... 3025 Style Template Matrix 

................................................................................................................................... 3036 Notify Messages 

................................................................................................................................... 3057 Guide Definitions 

................................................................................................................................... 3088 Find Definitions 

................................................................................................................................... 3109 Guide Packs 

................................................................................................................................... 31210 Find Packs 

................................................................................................................................... 31411 Feature Packs 

................................................................................................................................... 31712 Inquiry Packs 

................................................................................................................................... 32413 Employee Locations 

................................................................................................................................... 32514 Standalone Solutions 

................................................................................................................................... 32715 Data Sheets 

................................................................................................................................... 32816 Settings 

......................................................................................................................................................... 328Note Names 

......................................................................................................................................................... 330Signature Names 

......................................................................................................................................................... 331Sketch Names 

......................................................................................................................................................... 331Mobility Teams 

......................................................................................................................................................... 332Mobility Team Pooling 

......................................................................................................................................................... 333Fixed Time Template 

......................................................................................................................................................... 333Guide Groups 

......................................................................................................................................................... 334Find Groups 

......................................................................................................................................................... 334Template Groups 

......................................................................................................................................................... 335Statistic Groups 

......................................................................................................................................................... 335Corrective Action Styles 

......................................................................................................................................................... 336Notify Groups 

......................................................................................................................................................... 337Print Names 

......................................................................................................................................................... 338Mobility Outputs 

......................................................................................................................................................... 338Mobility Paths 

......................................................................................................................................................... 339Job Info Fields 

......................................................................................................................................................... 339Planned Job Line Info 

......................................................................................................................................................... 340Customer Info Fields 

......................................................................................................................................................... 340Asset Info Fields 

......................................................................................................................................................... 341Supplier Info Fields 

......................................................................................................................................................... 341Assembly Info Fields 

......................................................................................................................................................... 342Delivery Info Fields 

......................................................................................................................................................... 342Linked Table Info Fields 

......................................................................................................................................................... 343Mobility Captions 

......................................................................................................................................................... 344Mobility Barcode Rules 

......................................................................................................................................................... 345Mobility Rules 



7Contents

Labour 351

................................................................................................................................... 3511 Employees 

......................................................................................................................................................... 358Employee Properties 

......................................................................................................................................................... 360Employee Documents 

......................................................................................................................................................... 361Employee Images 

......................................................................................................................................................... 363Employee History Notes 

................................................................................................................................... 3652 Employees Cost Matrix 

................................................................................................................................... 3653 Labour Codes 

......................................................................................................................................................... 370Labour Properties 

......................................................................................................................................................... 372Labour Documents 

......................................................................................................................................................... 373Labour Images 

......................................................................................................................................................... 375Labour History Notes 

......................................................................................................................................................... 377Labour Override Times 

......................................................................................................................................................... 378Labour Alternates 

................................................................................................................................... 3804 Labour Rates 

................................................................................................................................... 3825 Special Employee rates 

................................................................................................................................... 3836 Capabilities 

................................................................................................................................... 3857 Capability Matrix 

................................................................................................................................... 3868 Timesheets 

................................................................................................................................... 3919 Settings 

......................................................................................................................................................... 391Rate Levels 

......................................................................................................................................................... 392Rate Scales 

......................................................................................................................................................... 393Rate Scale Matrix 

......................................................................................................................................................... 394Capability Types 

......................................................................................................................................................... 394Blocked Times 

......................................................................................................................................................... 395Blocked Time Descriptions 

......................................................................................................................................................... 396Labour Rules 

Inventory 399

................................................................................................................................... 3991 Items 

......................................................................................................................................................... 412Item Properties 

......................................................................................................................................................... 414Item Documents 

......................................................................................................................................................... 416Item Images 

......................................................................................................................................................... 417Item History Notes 

......................................................................................................................................................... 419Item Mobility and Web 

......................................................................................................................................................... 422Item Hazards 

......................................................................................................................................................... 423Item Quantities 

......................................................................................................................................................... 424Item Market Codes 

......................................................................................................................................................... 424Item Nutrition 

......................................................................................................................................................... 426Item Shipper Labels 

......................................................................................................................................................... 428Item Units 

......................................................................................................................................................... 430Item Dimensions 

......................................................................................................................................................... 432Item Barcodes 

......................................................................................................................................................... 433Item Site Master 

......................................................................................................................................................... 437Item Site Settings 

......................................................................................................................................................... 439Item Customers 

......................................................................................................................................................... 441Item Markups 

................................................................................................................................... 4422 Descriptors 

......................................................................................................................................................... 450Descriptor Properties 



Ostendo Reference Guide8

......................................................................................................................................................... 451Descriptor Documents 

......................................................................................................................................................... 453Descriptor Images 

......................................................................................................................................................... 455Descriptor History Notes 

......................................................................................................................................................... 457Desc Mobility and Web 

......................................................................................................................................................... 459Descriptor Markups 

................................................................................................................................... 4613 Lists 

................................................................................................................................... 4654 Matrices 

................................................................................................................................... 4685 Serial Kits 

................................................................................................................................... 4716 Warehouses 

......................................................................................................................................................... 474Warehouse Properties 

................................................................................................................................... 4767 Locations 

......................................................................................................................................................... 478Location Properties 

................................................................................................................................... 4808 Item Batches 

................................................................................................................................... 4839 Inventory Availability 

................................................................................................................................... 48810 Mass Rental Availability 

................................................................................................................................... 48911 Inventory Adjustments 

................................................................................................................................... 49212 Inventory Change 

................................................................................................................................... 49513 Inventory Unit Change 

................................................................................................................................... 49814 Inventory Transfer 

................................................................................................................................... 50315 Quick Transfer 

................................................................................................................................... 50416 Location Re-Stock 

................................................................................................................................... 50817 Inventory Count 

................................................................................................................................... 51218 Inventory Labels 

................................................................................................................................... 51319 Inventory and WIP Value 

................................................................................................................................... 51420 Containers 

................................................................................................................................... 51921 Cross Contamination 

................................................................................................................................... 52322 Off Site Containers 

................................................................................................................................... 52423 Content Group Matrix 

................................................................................................................................... 52524 Item Forecast 

................................................................................................................................... 52725 Item Daily Forecast 

................................................................................................................................... 52926 Item Add-On Sales 

................................................................................................................................... 53127 Settings 

......................................................................................................................................................... 531Item Traceability  

.................................................................................................................................................. 531Item Grades

.................................................................................................................................................. 533Item Sizes

.................................................................................................................................................. 535Item Colours

.................................................................................................................................................. 536Item Batches

.................................................................................................................................................. 539Item Revisions

......................................................................................................................................................... 541Categories 

......................................................................................................................................................... 542Sub Categories 

......................................................................................................................................................... 542Feature Groups 

......................................................................................................................................................... 543Location Groups 

......................................................................................................................................................... 543Location Aisles 

......................................................................................................................................................... 544Location Racks 

......................................................................................................................................................... 544Location Rows 



9Contents

......................................................................................................................................................... 545In Transit Defaults 

......................................................................................................................................................... 546Adjustment Types 

......................................................................................................................................................... 547Adjustment Types by Warehouse 

......................................................................................................................................................... 547Manufacturers 

......................................................................................................................................................... 548Brands 

......................................................................................................................................................... 549Matrix Dimensions 

......................................................................................................................................................... 551Market Codes 

......................................................................................................................................................... 551GS1 Definitions 

......................................................................................................................................................... 552Container Types 

......................................................................................................................................................... 554Container Content Groups 

......................................................................................................................................................... 554Restocking Templates 

......................................................................................................................................................... 557Picking Classes 

......................................................................................................................................................... 557Mass Replacement 

......................................................................................................................................................... 559Item Rules 

Pricing 565

................................................................................................................................... 5651 Item Pricing 

................................................................................................................................... 5692 Descriptor Pricing 

................................................................................................................................... 5723 Special Pricing 

................................................................................................................................... 5764 Discount Matrix 

................................................................................................................................... 5785 Order Pricing Matrix 

................................................................................................................................... 5816 Item Costing 

................................................................................................................................... 5847 Descriptor Costing 

................................................................................................................................... 5868 Price Inquiry 

................................................................................................................................... 5889 Batch Price Update 

................................................................................................................................... 59310 Price Update from File 

................................................................................................................................... 59711 Batch Cost Update 

................................................................................................................................... 60112 Settings 

......................................................................................................................................................... 601Price Levels 

......................................................................................................................................................... 601Pricing Groups 

......................................................................................................................................................... 602Pricing Rules 

Requirements 604

................................................................................................................................... 6041 Inventory Replenishment 

................................................................................................................................... 6132 Create Required Orders 

......................................................................................................................................................... 617Purchase Requirements Split 

................................................................................................................................... 6183 Order Inventory Availability 

................................................................................................................................... 6254 Constraint Scheduling 

................................................................................................................................... 6295 Resource Loading Board 

................................................................................................................................... 6296 Graphical Plant View 

................................................................................................................................... 6307 Assignment Profiles 

................................................................................................................................... 6338 Assignment Board 

................................................................................................................................... 6409 Assignment Loading 

................................................................................................................................... 64110 Settings 

......................................................................................................................................................... 641Loading Indicators 



Ostendo Reference Guide10

......................................................................................................................................................... 641Assignment Captions 

......................................................................................................................................................... 642Requirements Rules 

......................................................................................................................................................... 646Assignment Rules 

Purchasing 650

................................................................................................................................... 6501 Suppliers 

......................................................................................................................................................... 654Supplier Properties 

......................................................................................................................................................... 655Supplier Documents 

......................................................................................................................................................... 657Supplier Images 

......................................................................................................................................................... 658Supplier History Notes 

......................................................................................................................................................... 660Supplier Contacts 

......................................................................................................................................................... 662Location Map 

................................................................................................................................... 6622 Supplier Catalogues 

................................................................................................................................... 6683 Supplier Sub-Contractors 

................................................................................................................................... 6724 Supplier Contracts 

................................................................................................................................... 6745 Purchase Orders 

......................................................................................................................................................... 686Purchase Order Properties 

......................................................................................................................................................... 688Purchase Order Documents 

......................................................................................................................................................... 690Purchase Order Images 

......................................................................................................................................................... 691Purchase Order History Notes 

................................................................................................................................... 6936 Purchase Shipments 

................................................................................................................................... 7017 Purchase Receipts 

................................................................................................................................... 7078 Purchase Invoices 

................................................................................................................................... 7189 Settings 

......................................................................................................................................................... 718Supplier Types 

......................................................................................................................................................... 718Supplier Categories 

......................................................................................................................................................... 719Supplier Regions 

......................................................................................................................................................... 720Supplier Codes 

......................................................................................................................................................... 720Supplier Shipping Methods 

......................................................................................................................................................... 721Supplier Shipping Types 

......................................................................................................................................................... 721Purchase Types 

......................................................................................................................................................... 722Purchase Tracking 

......................................................................................................................................................... 723Purchase Shipment Tracking 

......................................................................................................................................................... 724Purchase Approval Limits 

......................................................................................................................................................... 725Purchase Rules 

Assembly 729

................................................................................................................................... 7291 Bills Of Material 

......................................................................................................................................................... 742History Notes 

................................................................................................................................... 7432 Custom Products 

................................................................................................................................... 7533 Standard Cost Rollup 

................................................................................................................................... 7564 Routing Templates 

................................................................................................................................... 7595 Where Used Inquiry 

................................................................................................................................... 7606 Assembly Orders 

......................................................................................................................................................... 774Assembly  Properties 

......................................................................................................................................................... 775Assembly Documents 

......................................................................................................................................................... 777Assembly Images 

......................................................................................................................................................... 778Assembly History Notes 



11Contents

................................................................................................................................... 7807 Assembly Issues 

................................................................................................................................... 7858 Assembly Receipts 

................................................................................................................................... 7899 Assembly Closing 

................................................................................................................................... 79110 Settings 

......................................................................................................................................................... 791Assembly Tracking Codes 

......................................................................................................................................................... 791Step Names 

......................................................................................................................................................... 792Scrap Codes 

......................................................................................................................................................... 793Configured Markups 

......................................................................................................................................................... 793Item ChangeOver Times 

......................................................................................................................................................... 794Item Setup Groups 

......................................................................................................................................................... 795Assembly Rules 

Sales 799

................................................................................................................................... 7991 Customers 

......................................................................................................................................................... 807Customer Properties 

......................................................................................................................................................... 809Customer Documents 

......................................................................................................................................................... 811Customer Images 

......................................................................................................................................................... 812Customer History Notes 

......................................................................................................................................................... 814Customer Statistics 

......................................................................................................................................................... 818Location Map 

................................................................................................................................... 8182 Customer Hazards 

................................................................................................................................... 8193 Customer Mobility 

................................................................................................................................... 8214 Customer Reservations 

................................................................................................................................... 8225 Kitsets 

................................................................................................................................... 8256 Sales Orders 

......................................................................................................................................................... 845Line Qty Dimensions 

......................................................................................................................................................... 846Sales Order Picking 

......................................................................................................................................................... 848Sales Order Properties 

......................................................................................................................................................... 849Sales Order Documents 

......................................................................................................................................................... 851Sales Order Images 

......................................................................................................................................................... 853Sales Order History Notes 

......................................................................................................................................................... 854Sales Quote Options 

......................................................................................................................................................... 856Location Map 

................................................................................................................................... 8567 Sales Deliveries 

................................................................................................................................... 8648 Recurring Invoices 

................................................................................................................................... 8709 Direct Invoicing 

................................................................................................................................... 87810 Batch Invoicing 

................................................................................................................................... 88811 Batch Invoice Printing 

................................................................................................................................... 89012 Customer Deposits 

................................................................................................................................... 89313 Customer Payments 

................................................................................................................................... 89914 Bank Deposits 

................................................................................................................................... 90215 Customer Aging 

................................................................................................................................... 90416 Customer Statements 

................................................................................................................................... 90617 Settings 

......................................................................................................................................................... 906Customer Types 

......................................................................................................................................................... 907Customer Regions 



Ostendo Reference Guide12

......................................................................................................................................................... 907Customer Codes 

......................................................................................................................................................... 908Customer Lead Sources 

......................................................................................................................................................... 908Shipping Methods 

......................................................................................................................................................... 909Contract Categories 

......................................................................................................................................................... 910Invoicing Groups 

......................................................................................................................................................... 911Statement Cycles 

......................................................................................................................................................... 911Sales Types 

......................................................................................................................................................... 913Sales Tracking 

......................................................................................................................................................... 913Sales Rules 

......................................................................................................................................................... 919Sales Quote Change Rules 

POS 921

................................................................................................................................... 9211 Point of Sale 

......................................................................................................................................................... 927POSPayment 

................................................................................................................................... 9292 POS Deliveries 

................................................................................................................................... 9313 POS Pickups 

................................................................................................................................... 9334 POS Workshop 

................................................................................................................................... 9355 POS Sessions 

................................................................................................................................... 9366 POS End of Day 

................................................................................................................................... 9387 POS History 

................................................................................................................................... 9398 Settings 

......................................................................................................................................................... 939POS Stations 

......................................................................................................................................................... 940POS Segmented Barcodes 

......................................................................................................................................................... 941POS Rules 

Service 945

................................................................................................................................... 9451 Customer Assets 

......................................................................................................................................................... 953Customer Asset Properties 

......................................................................................................................................................... 955Customer Asset Documents 

......................................................................................................................................................... 956Customer Asset Images 

......................................................................................................................................................... 958Customer Asset History Notes 

......................................................................................................................................................... 959Customer Asset Readings 

......................................................................................................................................................... 961Customer Asset Reading Names 

......................................................................................................................................................... 963Customer Asset Hierarchy 

......................................................................................................................................................... 965Customer Asset Tracking 

................................................................................................................................... 9672 Warranty Definitions 

................................................................................................................................... 9693 Service Plans 

................................................................................................................................... 9714 Warranty List 

................................................................................................................................... 9735 Service Confirmations 

................................................................................................................................... 9756 Service Orders Required 

................................................................................................................................... 9787 Settings 

......................................................................................................................................................... 978Customer Asset Types 

......................................................................................................................................................... 979Customer Asset Service Types 

......................................................................................................................................................... 979Customer Asset Reading Types 

......................................................................................................................................................... 980Confirmation Text 

......................................................................................................................................................... 981Service Rules 

Jobs 982



13Contents

................................................................................................................................... 9821 Projects 

......................................................................................................................................................... 987Project Properties 

......................................................................................................................................................... 988Project Documents 

......................................................................................................................................................... 990Project Images 

......................................................................................................................................................... 991Project History Notes 

................................................................................................................................... 9932 Project Budgets 

................................................................................................................................... 9953 Project Budget Comparisons 

................................................................................................................................... 9954 Task Bills 

................................................................................................................................... 9985 Templates 

................................................................................................................................... 10046 Job Calendar 

................................................................................................................................... 10127 Job Orders 

......................................................................................................................................................... 1040Line Qty Dimensions 

......................................................................................................................................................... 1041Job Order Issues 

......................................................................................................................................................... 1043Job Properties 

......................................................................................................................................................... 1045Job Documents 

......................................................................................................................................................... 1046Job Images 

......................................................................................................................................................... 1048Job History Notes 

......................................................................................................................................................... 1049Job Quote Options 

......................................................................................................................................................... 1050Job Tasks 

......................................................................................................................................................... 1056Job Order Resources 

......................................................................................................................................................... 1058Job Values 

......................................................................................................................................................... 1062Location Map 

................................................................................................................................... 10628 Job Hazards 

................................................................................................................................... 10639 Job Transactions 

................................................................................................................................... 106910 Job Pending Invoices 

................................................................................................................................... 107211 Job Retentions 

................................................................................................................................... 107512 Job Invoices 

................................................................................................................................... 108213 Job Budgets 

................................................................................................................................... 108414 Job Budget Comparisons 

................................................................................................................................... 108415 Job Closing 

................................................................................................................................... 108616 Settings 

......................................................................................................................................................... 1086Project Types 

......................................................................................................................................................... 1086Job Types 

......................................................................................................................................................... 1089Job Type Posting Template 

......................................................................................................................................................... 1089Job Categories 

......................................................................................................................................................... 1090Job Tracking 

......................................................................................................................................................... 1091Task Names 

......................................................................................................................................................... 1092Job Rules 

......................................................................................................................................................... 1099Job Calendar Rules 

......................................................................................................................................................... 1099Job Quote Change Rules 



14 Ostendo Reference Guide

1 Introduction

Ostendo  is a Business Software solution designed ‘from the ground up’ using today’s technology.
Its foundation is a revolutionary framework design that allows it to address functionality and
features not available in ‘traditional’ Software.  For example: 

· Covers the complex diversity within business operations rather than just the basics
· Includes functional areas not normally addressed such as Warranty Control, ‘Drag and

Drop’ Planning Board, multiple stocking Units of Measure, negative stock, Job and
Project Cost projections, etc

· Increased ‘Real -Time’ visibility of information
· Includes many cost reduction techniques (Order-on-Demand, zero Inventory, etc)
· Allows you to develop and integrate your own unique ‘Value-Add’ solution(s)
· Includes a flexible Report Writer to amend existing Reports
· Fully integrates with existing financial applications so you don’t have to change
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2 Glossary

ABC Classification - A method used to categorise inventory into groups based upon certain
activity characteristics such as Sales $.   ABC categories are used to develop inventory planning
policies, set count frequencies for cycle counting, and other inventory management activities.

Accounting Basis - Refers to the way your Company accounts are run.  The options in Ostendo
are:
  - Invoice: Sales Revenue and Tax Amount are posted at time Invoice was raised 
  - Cash Deferred Sales: Sales Revenue and Tax Amount are posted at time of payment.  
  - Cash Immediate Sales: Sale Revenue is posted at time Invoice was raised.  Tax Amount is
posted at time of Payment

Activity Alerts - Software functionality that triggers specific actions based upon the occurrence of
a specific event or combination of events.    For example: If inventory drops below a predetermined
level (reorder point) a message is triggered to a planner. 

Actual cost - An Inventory costing method used in manufacturing and jobbing environments that
uses the actual materials, machine, and labour costs recorded against a specific order to calculate
the cost of the finished product or service. 

‘Add-On’ Sale - An Add-On sale is a Sales technique whereby you offer a complementary product
at a special price whenever the main product is being sold.  For example, If the Item you are
selling is a tin of Paint then you may wish to suggest the purchase of Paint Brushes, Brush
Cleaner, etc.  These ‘Add-On’ Sales Items may have their own Sell Price specifically used when
sold along with the originating Sales Line.

Administrator: An Administrator is a person charged with maintaining the correct functioning of
your computer installation and Ostendo Software. Sometimes called a systems administrator, an
Administrator monitors the software, maintains users, and performs other important technical and
operational tasks. 

Allocations - Allocations refer to the linking of actual demand for an Item in a Sales, Assembly or
Job orders to the Inventory Item.    It provides an indication as to when, and in what quantities, the
Item is required.

Assembly Order - An Assembly Order is an Order that is placed within the organisation to
manufacture an end product.  This normally uses a Bill Of Material and a Routing.  Upon
completion the Product is moved into Stock

Available (or Free) Stock - Refers to the status of inventory as it relates to its ability to be sold or
consumed. Availability calculations to determine this status basically subtract any current
allocations of demands on inventory from the current on-hand balance. An example of an
availability calculation would be: [Available] = [Quantity allocated to Assembly Orders] - [ Quantity
allocated to Job Orders] - [Quantity allocated To Sales Orders]. 

Average cost - An Inventory costing method that recalculates an item’s cost at each receipt by
averaging the actual cost of the receipt with the cost of the current inventory. 

Backflushing: Automatic issue of Components and Descriptors to an order.  Upon receipt of the
goods from an Assembly order the components required to make the product are automatically
issued (I.e. Backflushed)

Backorder: Refers to unshipped Line Items on a shipped Sales Order. For example, if a Customer
orders four Lines, but only two of the Lines are shipped (or partially shipped), the remaining Lines
would be on backorder. 
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Barcode: An alternating series of vertical bars and white spaces of varying widths used to encode
information that can be read by electronic scanners.   Typically these are used to identify an Item
or a specific SKU

Bill of Material - A Bill of Material lists materials (components or ingredients) required to produce
the end product.   Multilevel BOMs show subassemblies and their components.  Other information
such as scrap factors may also be included in the BOM.

BOM - see Bill of Material

ByProduct - An Item that is sometimes (but not always) produced at the same time as the main
product in an Assembly Order.  These usually do not absorb some of the Costs associated with
the production of the main product.

Capacity Planning - A process for determining the amount of Asset (machine) and Labour
resources required to meet the demand.

COGS - See Cost of Goods Sold 

Component - An Item or Descriptor that is required for the production of another Item.
Components are the Items and Descriptors listed on a Bill of Materials. 

Consignment Stock - Inventory that is in the possession of the customer, but is still owned by the
supplier. Consignment inventory is used as a marketing tool to make it easier for a customer to
stock a specific supplier’s inventory.

Consolidate Invoice - A consolidated Invoice is a single Invoice that contains a collection of
individual billing lines over a defined period.  Two options are available in Ostendo
  - Consolidate by Order - During Invoice generation all lines due to be Invoiced from a single
Order will be included in the Invoice. 
  - Consolidate by Customer - During Invoice generation all lines across all Orders due to be
Invoiced will be included in a single consolidated Invoice.

Contract Invoice - (Also known as a ‘Recurring’ Invoice) A Contract Invoice is a billing schedule
agreed with the Customer.  This can be either a schedule of planned Invoices each with a value, or
a single planned invoice charged on a regular frequency

CoProduct - An Item that is always produced at the same time as the main product in an
Assembly Order.  Co-Products will absorb some of the Costs associated with the production of the
main product.

Cost Centre - A specific function or service area for which a budget is prepared and costs
identified within the Company’s Accounts.  Cost Centres are used by Ostendo to gather Costs
These Cost Centres are associated with the actual GL Account Code(s) in the associated
Accounting Package.

Costing method - Refers to the calculations used to determine the value (cost) of inventory. 

Cost of Goods Sold - An accounting term used to describe the total value (cost) of products sold.
Since inventory is an asset, it is not expensed when it is purchased or produced.  Instead it goes
into an asset account (usually called Inventory).  When a product is sold, the value of the product
(the cost, not the sell price) is moved from the asset account to an expense account called Cost of
Goods Sold or COGS.  COGS appears on the profit-and-loss statement.

Credit Terms - Credit Terms are part of the general Terms and Conditions pertaining to your
business.  They set out what you will do for your customers and what you expect your customers
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to do in return.

CRM – Customer Relations Management.    A means of managing the overall marketing, sales
and service process.   Generally includes lead management from initial prospect to close of sale
and beyond.

Current (or Last) Cost - An inventory costing method that applies the cost of the most recent
receipt to a specific item.

Custom Product - A Custom Product is a product that is created to a Customer’s unique
specification.  The Manufacturer normally makes an end ‘Model’ that has infinite variables.  The
Customer defines the specific values of the variables from which a ‘Customer Specific’ product
can be defined, quoted, and manufactured.

Cycle Count - Refers to process of regularly scheduled inventory counts that “cycles” through your
inventory.  The User normally determines how often certain items/locations are counted.

Demand - The need (from a Sales, Assembly, or Job Order) for a specific product or service in a
specified quantity.  

Dependent Demand - A demand generated from scheduled production of other items.  Within
Ostendo this refers to Components used in an Assembly Order.

Descriptor - Any quantifiable product or Service that you can handle, buy, sell, consume, or track
can be considered a Descriptor (or non-Stock Item). This covers everything from Travel,
Accommodation Costs, to non-stocked supplies from Suppliers Catalogues. 

Direct Invoicing - Direct Invoicing allows you to create a Customer Invoice that does not originate
from a Sales or Job Order.

Direct Ship - Direct Shipping and Drop Shipping are two interchangeable terms.  They describe a
process whereby three parties interact with the sales transaction (your Customer, You, and your
Supplier).  The Customer orders a product from You who then arranges with the Supplier to ship
the product directly to the Customer.    The Customer pays You and You pay the Supplier.

Discrete Manufacturing - This describes manufacturing of distinct items (items you can easily
count, touch, see) such as a light bulb, telephone, bicycle, fuel pump, etc.  

Distribution Requirements Planning - Process for determining inventory requirements in a
multiple Site/Warehouse environment.  DRP may be used for both Distribution and Manufacturing. 
In manufacturing, DRP will integrate directly with MRP.   

Distributor - Describes the organisation that does not manufacture goods but purchases for
distribution (Wholesaler).  This process covers storing, shipping, and transporting goods.  

Drop Ship - Drop Shipping and Direct Shipping are two interchangeable terms.  They describe a
process whereby three parties interact with the sales transaction (your Customer, You, and your
Supplier).  The Customer orders a product from You who then arranges with the Supplier to ship
the product directly to the Customer.    The Customer pays You and You pay the Supplier.

Economic Order Quantity - The result of a calculation that determines the most cost effective
quantity to Purchase or Assemble.  The formula basically finds the point at which the combination
of order cost and carrying cost is the least.  The standard formula is EOQ = Square Root [2 *
(Annual Usage) * (Order Cost) / (Annual Carrying Cost/unit)].  

EDI – Electronic Data Interchange
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Event Management - Software functionality that triggers specific actions based upon the
occurrence of a specific event or combination of events.    For example: If inventory drops below a
predetermined level (reorder point) a message is triggered to a planner.  This is event
management. 

Fast Moving Consumer Goods (FMCG) - Description of common high volume products such as
food, hygiene product, or cleaning supplies.  These would be products that the average consumer
would frequently purchase such as cereals, toothpaste, or dish soap.

FIFO - First-in-first-out.  In Warehousing it describes the method of rotating inventory to use the
oldest product first.  It also refers to an accounting term used to describe an inventory costing
method. 

Finite Capacity Planning - Finite Capacity Planning is an approach to determine which Assembly
Orders can be produced in a fixed time period whilst taking the limitations on different resources
into consideration. The goal of Finite Capacity Planning is to ensure that work proceeds at an even
and efficient pace throughout the plant without overloading workcentres

Fixed Overheads - Stable costs that occur regardless of whether or not goods are being
produced (i.e. rent of factory). These are allocated according to the number of production hours
worked. 

Forecast - A Forecast is an estimation of future demand and is used to replenish Inventory Levels.
Most forecasts are based on historical demand.  Adjustments for seasonality and trend are often
necessary.

Forecast Consumption - Describes the method Ostendo uses to reduce forecasted demand by
the actual demand that occurs during the forecast period. 

Free Stock – See ‘Available Stock’ 

Independent Demand - A demand generated from Forecasts, Inventory Minimum Stock, Sales,
Assembly or Job Orders.

Infinite Capacity Planning - Infinite Capacity Planning is where the loading requirements are
based on the planned or scheduled dates and do not rearrange them if capacity is not available. 
This produces a view that compares the current actual Load to the availability of the Resource to
make it.  The resultant View and provides information regarding over or under conditions based on
this calculated Load -v- Capacity.  From this the manager can take steps to even out this loading
by, for example, authorise Overtime, or Subcontract the work so that the Order is not delayed.

Inventory - Any quantifiable item that you, buy, sell, and store in a Warehouse can be considered
inventory.  This covers everything from office and maintenance supplies, to raw material,
semi-finished products and finished goods. 

Inventory Management - The direction and control of activities with the purpose of getting the
right inventory in the right place at the right time in the right quantity in the right form at the right
cost. 

Inventory Turn - The number of times inventory is consumed or sold during a one year period.
Generally calculated by dividing the average inventory level (or current inventory level) into the
annual inventory usage (annual Cost of Goods Sold).

Item - refers to a specific item identity.  The Item could have varying Units of Measure and other ‘
Item Characteristics’ such as Colour, Lot Number, Grade, Expiry Date, etc
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Item Characteristics - Data that describes ‘Sub-Level’ characteristics of an item so that it can be
uniquely identified in Inventory.  These characteristics may include Colour, Size, Grade, Expiry
Date, Batch, Lot, or Serial Number.

Job Order - Covers carrying out a Service activity or a series of Tasks.  This style of Order is used
for Service and Maintenance activities in addition to Construction and Contracting.  It can involve
large ‘Projects’ that have multi-Invoice stages based on actual achievement rather than a known
value of the Sales Order

Jobbing Shop - Jobbing (or Job) shops are typically small manufacturing operations that handle
specialised manufacturing processes such as small customer orders or small batch jobs.  Job
shops typically move on to different jobs (possibly with different customers) when each job is
completed. 

Kitset - In Ostendo a Kitset is defined as a collection of Items and Descriptors that can be called
up and added to a Sales Orders line.  Any Invoice generated from the sale of a Kitset will use the
sell price of that Kitset.  However the individual lines within the Kitset will be issued to the Sales
Order.  

Landed Cost - An Inventory costing method that includes the purchased cost plus transportation
costs, import fees, duties, taxes, and other costs incurred in obtaining the Item. 
 
Last (or Current) Cost - An Inventory costing method that applies the cost of the most recent
receipt to all inventory of a specific item.

Lead Time - The amount of time required for an item or Descriptor to be available for use from the
time it is ordered.   Lead time generally includes purchase order processing time, vendor
processing time, in transit time, receiving, inspection, and any prepack times.

LIFO - Last-in-first-out - In Warehousing it describes the method for using the newest inventory
first.  It is also used in accounting to describe an inventory costing method.

Lot Number: A unique identifier assigned to a batch of Items produced at the same time and also
share the same specifications.

MRP / MRPII - Manufacturing Resource Planning - Process for determining Material, Labour and
Machine requirements specifically in a manufacturing environment.   MRP was originally designed
for materials planning only.   When Labour and Machine (Resources) planning was incorporated it
became known as MRPII.  Today the definition of MRPII is generally associated with MRP
systems.

Negative Inventory - An inventory condition whereby the on-hand inventory balance is listed as a
quantity less than zero.  This can occur (for example) when an Item is placed in Inventory and
formally issued.  However its receipt from Purchasing has not yet been recorded.

Obsolete Inventory - Inventory that has had no sales or usage activity for a specific period of
time.  The period of time varies by company and industry and may even vary by product line within
a specific company

Order Cost - Also known as Purchase Cost.  Order Cost is the sum of the fixed costs that are
incurred each time an item is ordered.  These costs are not associated with the quantity ordered
but primarily with physical activities required to process the order.   For purchased items, these
would include the cost to enter the purchase order and/or requisition, any approval steps, the cost
to process the receipt, incoming inspection, invoice processing and vendor payment, and in some
cases a portion of the inbound freight may also be included in order cost. 

Phantom Bill of Material - A fictitious Bill of Material created for common subassemblies that you
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do not normally produce as separate items.  For example, if you have a number of products that all
use the same common components you can create a phantom bill for the common components
and then just put the phantom item on the bills for all products that use it. 

Physical inventory - Refers to the process of counting all inventory in a warehouse or plant.  A ‘
Physical’ Inventory is commonly carried out once per year.

POS - Point of sale or point of service (POS or PoS) can mean a retail shop, a checkout counter in
a shop, or the location where a chargeable transaction occurs such as Vehicle Servicing, Spare
Parts sales, Whiteware sales. Jobbing Shop, Etc.

Price Breaks - These are price reductions given for the Customer purchasing larger quantities.
The rationale behind Price Breaks is to obtain economies of scale and pass some (or all) of these
savings on to the customer. 

Process Manufacturing - A type of manufacturing where a product is produced or transformed
through mixing, chemical reactions, etc.  Examples of process manufacturing would be extracting
copper from ore, combining materials to make paint, mixing ingredients and making biscuits.

Purchase Order - A document used to approve, track, and process purchased items.   A
purchase order is used to communicate a purchase to a supplier. It is also used as an
authorisation to purchase. A purchase order should state quantities, costs, and delivery dates. The
purchase order is also used to process and track receipts and supplier invoices/payments
associated with the purchase.

Quantity Allocated - Also known as committed quantity and denotes the quantity required by, and
allocated to, current open Sales, Assembly or Job orders.

Quantity Available - Refers to the status of inventory as it relates to its ability to be sold or
consumed.  Availability calculations are used to determine this status. Availability calculations
basically subtract any current allocations of demands on inventory from the current on-hand
balance. An example of an availability calculation would be: [Available] = [Quantity allocated to
Assembly Orders] - [ Quantity allocated to Job Orders] - [Quantity allocated To Sales Orders].

Quantity In Transit - In multi-branch environments, quantity in transit reflects the quantity that has
been shipped from one branch/facility to another branch/facility, but has not yet been received by
that branch/facility. 

Quantity On-Hand - Quantity on hand describes the actual physical inventory in the possession of
the business.  When inventory is received or produced it is added to the quantity on hand.  When
inventory is sold or consumed it is removed from quantity on hand. 

Quantity On-Order - Includes quantity on open Purchase or Assembly orders. 

Queue Time - The amount of time a job waits at one Step, Stage or Operation prior to it being
worked upon in that step.  This usually forms part of the manufacturing lead time.

Recurring Invoice - (Also known as a ‘Contact’ Invoice) A recurring Invoice is a billing schedule
agreed with the Customer.  This can be either a schedule of planned Invoices each with a value, or
a single planned invoice charged on a regular frequency

Reorder Point - A number held against an Inventory Item that triggers a Suggested Order
whenever the Quantity Available falls below this level.

Reorder Quantity - A number held against an Inventory Item that represents the minimum
quantity to be ordered whenever a Suggested Order is triggered.  The resultant Suggested Order
quantity is the greater of either this Reorder Quantity or the quantity required to bring the Quantity
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Available up to the Reorder Level

Replenishment Order: A Planned Order issued by the Replenishment Run to re-supply an Item
whose available quantity has fallen below its Reorder Point.

Revision Control - Revision control is the management of multiple revisions of the same unit.  It is
most commonly used in engineering to manage ongoing development versions of the same
product.  Changes are identified by incrementing an associated Revision Number (or Letter) code,
termed the "revision number".

Routing - used in conjunction with the bill of material in Assembly operations.  While the BOM
contains the material requirements, the routing will contain the specific steps required to produce
the finished items.  Each step generally consists of a description of what is to be done and also
contains machine and labour requirements.

Sales and Distribution - Describes the organisation that does not manufacture goods but
purchase for sale.  Part of this process covers storing, shipping, and transporting goods.  Also
describes the facilities (distribution operations, distribution centres) that conduct these activities.  

Sales Order - A Sales Order represents a Customer demand for your products.  This can range
from Point of Sale (Supermarkets, etc), Counter Sale (Car Parts Retailer), or
Distributor/Manufacturer (Pick/Despatch/Invoice)

Schedule of Quantities - Is a detailed listing of the quantities of materials, labour and any other
items required to carry out a task (Example: Fitting a Bathroom, or laying a length of drainage).   It
is often used in the Building and Construction industry to quickly formulate quotations.  When
making a quotation the SOQ is selected and a quantity applied.  The contents of a Schedule of
Quantities is expanded to provide details, costs and timescale.

Serial Number: A unique number used to identify a single Item.

Setup time: The amount of time required to prepare an Assembly Order (or Step) before the
process of assembling the parent Item can begin.  Setup time is charged only once per Order,
regardless of the quantity ordered.

Source on Demand - An ordering method reacting to a direct demand for an Item.  Whenever a
Demand is created be a Sales, Assembly or Job Order then a matching supply Order (Assembly or
Purchase) for the required quantity is created.

Standard Cost - Inventory costing method used in (mainly) manufacturing environments that uses
the materials costs in the bill of materials combined with the labour and machine costs in the
routing to calculate the cost of the finished or semi-finished item.

Step - A step is a definitive process phase within an Assembly Order that defines where the
activity is being carried out, what will be done to complete that step, and how long the step will
take.  A sequence of consecutive Steps can describe a complete Assembly process (Example:
Cut, Machine, Assemble, Inspect)

SKU – Stock Keeping Unit is a unique identifier for each distinct product or product variation that
can be stocked.   SKU usage is usually associated with data management and enables stock
tracking in warehouses and retail outlets.

Suggested Order - Term used within Inventory Replenishment for a system-generated planned
order quantity.  Suggested Orders only exist within the computer system and serve multiple
functions.  One function is to notify the planner or buyer to produce or order materials, which is
done by converting a Suggested Order into a Purchase or Assembly Order.  
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Supplier Catalogue - A Supplier Catalogue is designed to present the Supplier’s products to you.
It contains information about the products and includes Item details along with Purchase Pricing,
Quantity Discounts, recommended Sell Price, etc.

Supply From Stock - An ordering method whereby any demand created by a Sales, Assembly or
Job Order immediately makes an allocation against current Stock.  Inventory Maintenance routines
maintain the Stock Level by addressing the total demands 

System Alerts - Are pre-defined exception conditions which generates a ‘pop-up’ messages that
appear on your PC at a selected time after the alert condition has occurred.  (For Example: A
Purchase Order has overdue Lines). 

Task - A Task is used in the Job Order environment to define a ‘descriptive’ activity.  (Example: Fit
out a Kitchen, or Lay 100 Mtrs of Cable).  It comprises of materials and activities that contribute to
the complete activity.  A Task is also known a ‘Schedule of Quantities’

Task Bill - A Task Bill is a pre-defined list of materials, Descriptors and Labour activities.  This is
often referred to as a ‘Schedule of Quantities’.  It is used as the basis for adding a known Task to a
Job Line.   The Task Bill has Header Information plus details lines that make up the Schedule of
Quantities

Job Template - A Job Template is a pre-defined Job Order list that can contain multiple Tasks,
Task Lines and Resources.  A Template is - optionally - selected when creating a new Job; the
copied contents can then be amended as required.

Timesheets - Timesheets are used to record the start and end time of tasks, or just the duration. It
may contain a detailed breakdown of tasks accomplished throughout the Job or Project. This
information may be used for payroll, client billing, and increasingly for project costing, estimation,
tracking and management.

Unit of Measure - Describes how the quantity of an item is tracked throughout the system. The
most common unit of measure is “each”, which simply means that each individual item is
considered one unit.   An item that uses “case” as the unit of measure would be tracked by the
number of cases rather than by the actual piece quantity. 

Unit-of-Measure Conversions - Unit-of-Measure conversion is needed whenever you work with
multiple units of measure in Purchasing, Sales or Inventory.   For example, An Item that has a
base UOM of ‘Each’ may also sell, purchase or stock in ‘Pack’.  Therefore you would require a
conversion to allow the system to calculate how many ‘Each’ are represented by a quantity of
Packs. 

Variable Overheads - Changeable overhead costs that vary according to the number of goods
produced (i.e. water and lights). These are allocated according to the number of labour hours used
to produce the finished product(s).

Warehouse Management - The flexibility to define a variety of warehouses and locations and then
manage inventory across these locations.   Functions usually include a warehouse master record,
item/warehouse cross-references and monitoring Inventory on hand, available and allocated stock
in relation to Re-Order Point and Re-order levels

Work-in-Process (WIP) - Generally describes activity that is currently being processed in an
Assembly Order.   WIP is actually an inventory account that represents the value of materials,
labour, and overhead that has been issued to Assembly Orders but has not yet produced a
stockable item.  
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3 Global Options

Ostendo provides a variety of flexible options where the end user can define how they wish to view
the product.  These range from defining your own Quick Launch Toolbar, defining display format,
defining the print options, through to defining data export output formats

3.1 Function Keys

The following Function Keys are used throughout Ostendo

F1 - Help
F2 - Where a ‘Notes’ field has limited visible space for data entry, clicking on this button will open a
separate screen for entry of the extended notes
F3 - This functions as a ‘Look-Up’ shortcut in the following instances

· For fields with a Look-Up (spyglass) Icon this will display the table.  
· For ‘Notes’ fields the ‘Frequently Used Text’ screen will be presented for selection of a

Text/Phrase.
F4 - When cursor is positioned within a field that has a dropdown then this enables the drop-down
list to be displayed.  Also if the cursor is in a 'Notes' field then this will immediately add a data
string showing the current date and time plus the current User.  For example [1/02/2012 11:01:39
a.m. - ADMIN] 
F5 - ‘Add’ a new record. On multi-line entry screens this button will save the current line and
automatically move the cursor to a new line (I.e. a combined F6 and F5 function)
F6 - ‘Save’ the current record
F7 - ‘Cancel’ information keyed in since accessing the record or ‘Save’ was selected
F8 - ‘Delete’ the current record

Ctrl/F5 - When in Job Orders, Sales Orders, Assembly Orders, Purchase Orders and Direct
Invoicing screens this will bring up a panel for creation of a new order
Crtl/Tab - Allows you to move from left to right across a suite of screens (For example: if the
current view contains List, Detail, Lines, and Variants tabs then Ctrl Tab takes you forward through
these tabs
Crtl/W - If you have multiple screens open at any one time (Example Sales Orders, Customers,
Inventory) then this will toggle between the current screen and the previous screen.  If you click
Ctrl/W and keep the Ctrl Key pressed a panel will appear showing all current opened screens.  You
can now use the 'W' key to select one of the current open screens
Crtl/Q - When in the Sales Order Lines screen and you are addressing a selected line then Ctrl/Q
will perform the following actions:

· If the Line Type is Item Code and the Item Master record contains Order Dimensions then the Item
Dimensions screen is presented for entry of Dimensions

· If the Line Type is Descriptor Code, Kitset Code or Catalogue Code then a Line Freight Screen
screen is presented for entry of freight details directly relating to this line

Shift/Crtl/Tab - Allows you to move from right to left across a suite of screens (For example: if the
current view contains List, Detail, Lines, and Variants tabs then Ctrl Tab takes you backwards
through these tabs
Alt/F4 - This will close the current Ostendo screen
Tab - Move from field to the next field
Shift/Tab - Move backwards from field to the previous field
Space Bar - ‘Check’ or ‘uncheck’ a checkbox
Home - Go to first record in a 'List' View
End - Go to last record in a ‘List’ View
Page Up - Display previous 'Page' of data in a 'List' View
Page Down - Display next 'Page' of data in a 'List' View
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For Ostendo screens that have a Print Button in them (Example: Order Acknowledgement in the

Sales order Screen) you can print the document by using the following keys rather than clicking on

the Button then selecting the Output Option:

·    Ctrl-P Output to Printer

·    Ctrl-E Output to Email

·    Ctrl-S Output to Screen

Specifically when using One-Step Sales Orders/Invoicing the use of 

·    Ctrl-I will immediately send the Invoice to your Printer

·    Ctrl-S will immediately send the Sales Order to your Screen

3.2 Spell Checker

All Memo and Notes fields in Ostendo are validated against a dictionary using Ostendo's inbuilt
Spell Checker.   This feature can be Enabled/Disabled by going to the Environment Settings of
screen File>System Configuration>System Settings.

If 'Enabled' then whenever a word is not found in the dictionary, it will be underlined in red.  From
here you can carry out the following actions

If you 'Right Mouse' on the word then the following options are presented

(Suggestions): Suggested words from the Dictionary.  Select the correct word to replace the word
in error.

Ignore All: All potential errors in this Memo or Notes field will be ignored

Auto Correct: This displays suggested words from the Dictionary.  Select the correct word to
replace the word in error.  In addition, a single option (Auto Correct Options) enables you to define
conditions surrounding Auto Correct.  If this is selected a panel will be displayed containing the
following

· Correct Two Initial Capitals:  If this is ‘checked’ then any word that begins with two
Capital letters will have the second letter reduced to Lower Case.

· Capitalise first letter of a sentence:  If this is ‘checked’ then any sentence that
commences with a Lower-Case letter will have that letter amended to Upper Case.

· Correct accidental use of cAPS LOCK key: If this is ‘checked’ and you are in the middle
of a word when you accidently press the ‘Caps Lock’ button then the entered word will
revert to lower case once the word is completed.

· Disable Caps Lock: If this is ‘checked’ the ‘Caps Lock’ Key is disabled
· (Button) Exceptions: If you click on this button then another panel will appear for you to

define exceptions.  The fields in this panel are:
- Abbreviations (No subsequent capital):  Enter the abbreviation (For example ‘ie’).

Whenever this abbreviation is used it is immediately followed by a ‘full stop’ (period).
Normally the next letter in sequence would automatically be in Upper Case but in this
instance that will not happen

- Words with Two Initial CApitals:  If the checkbox to ‘Correct Two Initial Capitals’
(above) is checked then you can still allow certain wirds that have two initial capitals by
adding them here

· Replace Text as you Type: This replaces a common spelling mistake with the correct
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spelling.  For example you may usually type ‘Filed’ instead of ‘Field’.  In this instance you
would enter ‘Filed’ in the ‘Replace’ area and ‘Field’ in the ‘With’ area.

· Automatically use Suggestions from the Spelling Checker: This replaces the entry
with a valid from the Dictionary.  For example.  If you enter WineCellar it will get converted
to Wine Cellar.

Spelling: A panel will be presented where you can manipulate the current word to give you the
desired result

This displays the current word in error along with a field to type in a replacement word.  Also in this
panel is a list of current suggested words 

Suggested words taken from the Dictionary.  Select the correct word to replace the word in error. 
In addition, a single option (Auto Correct Options) enables you to define conditions surrounding
Auto Correct.  If this is selected a panel will be displayed containing the following

· Not In Dictionary: This is a display only field of the word that was found to be in error
· Change To: In the first instance this is prefilled with the first entry from the ‘Suggestions’

panel but you can amend it if required by clicking on an alternate suggested word or
phrase or simply overtyping the entry in this field.

· Suggestions: Display only field showing suggestions.  If you click on a suggestion then it
will replace the current entry in the ‘Change To’ field.

· (Button) Ignore: If this is selected then the current value in ‘Not in Dictionary’ is accepted
and any suggested changes in this screen are ignored

· (Button) Ignore All: If this is selected then the all occurrences of the ‘Not in Dictionary’
value in the current ‘Memo’ or ‘Notes’ field are accepted and any suggested changes in
this screen are ignored.

· (Button) Change: If this is selected then the value in ‘Not in Dictionary’ is replaced by the
value in ‘Change To’.

· (Button) Change All: If this is selected then the value in ‘Not in Dictionary’ is replaced by
the value in ‘Change To’ for all occurrences in the current ‘Memo’ or ‘Notes’ field.

· (Button) Add: Not active in the current version of the spell checker
· (Button) Suggest: If you manually change the content of field ‘Change To’ and that value

is not in the ‘Suggestions’ panel then this button becomes active.  When selected the
content of the ‘Suggestions’ panel will change to reflect a dictionary check against the new
entry.

· (Button) Options: If you click on this button then another panel will appear for you to
enhance the Spelling Options.  The fields in this panel are:
- Ignore words in UPPERCASE: If this is ‘checked’ then the spell checker will ignore

all words that are completely Upper Case.
- Ignore words in MiXeDcASe: If this is ‘checked’ then the spell checker will ignore all

words that contain Upper Case characters interspersed with Lower Case characters.
- Ignore words with numbers: If this is ‘checked’ then the spell checker will ignore all

words that contain numbers.
- Ignore repeated words: If this is ‘checked’ then the spell checker will ignore where

the same word is immediately repeated in a sentence.
- Ignore emails: If this is ‘checked’ then the spell checker will ignore any email

addresses.
- Ignore web sites: If this is ‘checked’ then the spell checker will ignore any web site

addresses.
- Edit Custom Dictionary: Not active in the current version of the spell checker
- International Dictionaries: Select the dictionary from the drop-down list.
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3.3 Quick Launch Toolbar

To help go directly to common functions a User-Defined Quick Launch Toolbar is available.  

Initially this is located under the top toolbar but you can click on the extreme left of the Quick
Launch bar and drag it to any location on your screen.

If you click on the 'More Buttons' icon located at the extreme right of the Quick Launch bar then a
drop-down list of 40 main functions are visible.  Select a function to make it visible on the Quick
Launch bar

3.4 Related Toolbar

All of the main data entry screens have a ‘Related’ button down the right hand side of the screen.
Clicking this button will display a list of options that are related to the current main screen which,
when selected, will take you to that Screen.  

Option is provided to have these ‘Related’ options appear as a Toolbar at the top of the screen.  

To activate/deactivate this feature go into File>System Configuration>System Settings and click on
the ‘Environment Settings’ tab.  In that screen ‘check’ or  ‘uncheck’ the ‘Hide Related Toolbar’
checkbox as required.

When visible you can click on the ‘Customise’ Button on the ‘Related Toolbar’ and check/uncheck
the desired Related options.  If you have selected more options that that can fit into the toolbar
then a drop-down arrow will appear at the extreme right of the Related Toolbar from which the
additional options can be selected.

3.5 Drag and Drop Items

Facility is provided in the BOM, Inventory Adjustments, Sales Order, Job Order, and Assembly
Order screens to 'Drag and Drop' Items.   When in the above screens you can select the 'Drag and
Drop' Item screen which can be found under the 'Related' Button or the 'Related' Toolbar.  Simply
locate the Item - using the filtering, sorting and search options if required - this then drag and drop
the selected code into the main screen

3.6 Scroll Bar

All the major screens (Item, Descriptor, Customer, etc) open in a List view with option to highlight a
record and go to the detail view of that record.  If, in the Detail, view you require to go to the next -
or previous - record then the Scroll Bar at the top of the Detail screen can be used rather than
returning to the List View and selecting the record.  

The button options on the Scroll bar are (from left to right):
· Go to beginning of the record in the List View
· Go back one page of records currently displayed in the List View
· Go to previous record
· Go to next record
· Go forward one page of records currently displayed in the List View
· Go to end of records in the List View
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3.7 Panel Viewing Options

All of the main ‘List’ and 'Lookup' panels throughout Ostendo have some - or all - of the following
to provide a best possible viewing option to suit the end user

Displayed fields.  The displayed fields are taken from the master record to which the List or
Lookup applies.  The selection of which fields to display is at the user’s discretion.  To select the
fields to display simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.  If this
option is not displayed then you don't have the rights (on your User Security and Options screen
found under File>System Configuration) to make these changes.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Field Position - Field positions can be adjusted as follows:
· On List screens you can move the field position by dragging the column heading left or right

to the position where you want it to appear.
· On 'Lookup' screens you can adjust the field position as described but the positions will not

be retained when you exit the screen.  To retain a permanent adjustment in 'Lookup'
screens you should 'right-mouse' and select 'Customize Fields'.  In the upper area of the
displayed panel simply drag and drop the field to the display sequence required.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select the specific entries to display records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  

Note: If you enter multiple words into the ‘Search’ field then the interrogation will look for all records
containing either word.  If you enter multiple words enclosed in ‘double quotes’ then the search
will look for the combined words as they appear within the quotation marks.

If the ‘Advanced Searching’ option is ‘checked’ in System Settings (File>System
Configuration>System Settings) then, in the following screens, an additional facility is provided
to search the content of all Properties linked to the master record in addition to searching the
fields currently displayed in the list.
· Assembly Order
· Customer Assets
· Customers
· Descriptors
· Items **
· Job Orders
· Labour Codes
· Purchase Orders
· Sales Orders
· Supplier Codes
· Warehouses
· Inventory Availability
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** Additionally the Advanced Search for Items will also address the linked Supplier records and
search a Supplier’s Part Number

Other Options - If you right-click on any column ‘Heading’ a panel will appear that offers the
following options.  Note: Some options may be ‘greyed out’ because the above ‘Filtering and
Sorting’ checkbox has not been ‘checked’.

Sort Ascending: The current column will be sorted into ascending sequence

Sort Descending: The current column will be sorted into descending sequence

Clear Sort: This will clear the sort sequence in the current column

Group By This Field: A ‘band’ will appear above the list into which the current field now resides as
a ‘box’.  The data in the main panel is grouped by this selection.  If you click on the ‘+’ sign in the
main panel then the group will expand to show all records in the group.  Note that:

· You are not restricted to a single grouping in the top Group Box.  I.e. You can have
Groups within a Group.

· You can also ‘change’ the grouping sequence by simply ‘dragging’ one of the Group
Boxes left or right as required

· If you ‘right mouse’ on a Group Box you will note that the option ‘Group by this field’ now
reads ‘Remove from Grouping’.  Select this to remove this Group Box and restore the
details to the main panel 

Group By Box: A ‘band’ will appear above the list.  You can select and drag any column heading
into this area where it will now reside as a ‘box’.  

· If you ‘right mouse’ on a Group Box you will note that the option ‘Group by this field’ now
reads ‘Remove from Grouping’.  Select this to remove this Group Box and restore the
details to the main panel.

· If you select the ‘Group Box’ again then it will not appear in the panel; however any
Groupings will still be retained

Footer: A band will appear at the bottom of the display.  Under each column - if you click the ‘right
mouse’ - you have the option to display:

· Sum - The total of the values in the column (only if it is numeric)
· Max - The maximum value that exists in the column (only if it is numeric)
· Min - The minimum value that exists in the column (only if it is numeric)
· Ave - The Average of all the values in the column (only if it is numeric)
· Count - The Number of records in the column
· None - No value displayed

Group Footers: Similar to the above ‘Footer’ but the values appear at each ‘Group’ level

Remove this column: This will ‘hide’ the column from the current display.  To restore the column
select ‘Field Chooser’

Field Chooser: The fields displayed in the main panel are defined in the above ‘Displayed Fields’
option.  Using this feature you can ‘Hide’ selected fields from those on display.  When ‘Field
Chooser’ is selected a small panel will appear.  You can hide fields by clicking on the column
header and dragging it to this panel.  Restoring the field to the display is simply the reverse of this
action

Best Fit:  Selecting this will adjust the width of the selected column to that defined by the
maximum width of the data entered into it, or the Column Title, whichever is the greater
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Best Fit (All Columns): Performs the same function as ‘Best Fit’ on all the columns in the display

3.8 Report Output Options

Whenever a report is run you are presented with a simple panel containing the following three
options:

· Screen - View on Screen
· Print - Send to Printer
· Email - Email with this report attached

Screen  The report will be returned to the screen where you have the following options from the
top toolbar:

· Send to Printer
· Output to File (with facility to recall and print)
· Export to a Matrix Printer
· Export to a CSV file
· Export to a HTML file
· Export to a JPG Image
· Export to a PDF file
· Search the document for specified Text

Note:-  Whenever you return a Report to the Screen you have the option to click on the 'New
Selection Criteria' Icon located at the upper left of the screen.  This allows you to re-run the Report
with different parameter values

Print  A panel will be shown where you have the following options:
· Select the printer
· Print to file (.prn extension)
· Select pages to print
· Enter number of copies
· Collate multiple copies
· Define print order (Reverse Print)

Email  The program will generate the report as a ‘pdf file and attach it to your PC’s emailing
routine (Example; Microsoft Outlook) as shown in the picture on the right

3.9 Views Analysis Options

‘Views’ in Ostendo provides facility for Users to define their own analysis of data within the
Ostendo database, view that information, and output to various media.  Whenever a ‘View’ is run
the relevant information is returned from which you can carry out the following functions. 

Analysis Options
The main Analysis screen shows the retrieved information from your database.  The extracted
records can be ‘sliced and diced’ in the following manner.

Search & Sort     
The following features are available that allow you to sort and filter the displayed data.

§ Sort any column in the displayed records into ascending or descending sequence by
clicking on the selected column heading

§ You may ‘filter’ the records based upon your own selection criteria by clicking on the blue
triangular symbol in the selected column heading.  From the drop-down list you may
select the following:-
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- All - displays all records
- Blanks - Displays only those records that have no data in the field
- Non-Blanks - Displays only those records that contain data in this field
- Select the specific field content

Moving and Hiding Columns   
You may also move columns as well as take unwanted columns from the display

§ You can move columns by clicking on the column heading and ‘dragging’ the column into
the required position.    

§ If you double click on the Column Heading’s right edge you can make the column
automatically ‘close up’ to match the amount of data in the field.  You can also achieve
this by ‘Right Clicking’ the column heading and selecting ‘Best Fit’. 

§ If you wish to ‘Close Up’ all the columns then you should ‘Right Click’ on any column
heading and select ‘Best Fit - All Columns’.

§ If you ‘Right Click’ on a column Heading and select ‘Field Chooser’ then a panel will
appear for storing unwanted columns and enables you to ‘Customise’ the screen.     You
can move any unwanted columns to this panel by simply clicking on the column heading
and dragging the column into this panel.  You can recall stored columns by reversing this
procedure.
An alternative to this is to ‘Right Click’ on a column Heading and select ‘Remove this
column’.  This will automatically place the unwanted column in the storage panel
To hide the ‘Field Chooser’ Panel simply click on the ‘x’ in the upper right corner of the
panel

Grouping    
You may wish to Group ‘like’ records.  To do this simply drag the required column
heading into the area at the top of the screen where it states ‘Drag a column header here
to group by that column’.  (If this area is not visible then you should ‘Right Click’ on any
column heading and select ‘Group By Box’)

The screen will now group all records where the content of the ‘Grouped’ field is the
same. 

§ If you click on the ‘+’ indicator against each Group you can see the detailed records.
§ This Grouping facility is not just single level.   You can Group within Group, etc by simply

dragging and dropping the ‘sub-group’ to the right of the first Group.
§ This can be repeated for as many levels as you require.
§ An alternative method of achieving this is to ‘Right Click’ on the selected column heading

and select ‘Group By This Field’)

Summary Totals   
For each Group you may wish to display summary totals.     To do this, expand a Group
by clicking on the‘+’ indicator to display the individual records.      At the bottom of the
Group List is a blank area.      If this area is not visible then ‘Right Click’ on a column
heading and select ‘Group Footers’. 

Now go to this blank area under any column and ‘right click’ the mouse to display the following
options.  These can be accessed depending upon the type of field (For example, you cannot ‘Sum’
a Date field)

§ Sum Numeric fields only
§ Min Numeric and Date fields only
§ Max Numeric and Date fields only
§ Count All fields
§ Average Numeric fields only
§ None All fields
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The selected column will now display the summary information

Grand Totals   
You may also wish to display grand totals for the displayed data.  To do this you should see a
blank area at the end of the displayed list.  If this area is not visible then ‘Right Click’ on any
column Heading and select ‘Footer’. 

As with Group Footers, you can go to the blank area under any column and ‘right click’ the mouse
to display the options.  

Print Options

Whenever you click on the Printer Icon on the top toolbar you have the option to:
· Immediately print the displayed data
· View the ‘report’ from which you may further change the ‘Look and Feel’ prior to finally

sending to the printer.

The following options are available from the ‘Preview’ option

File Menu

Design

By clicking on the ‘Design’ icon you can define the way the Report is to be presented and has
facilities to address the report’s:-

View  - predefine what can be viewed when printing the document.  The options include:-
§ A caption created when the View program was generated
§ Column Headings
§ Group and Report Footers
§ Group expansion Buttons
§ Filter information

Behaviors  - Defines what data is to be printed such as:-
§ The complete Analysis Screen Data or selected lines
§ Expand Groups upon printing including all Details
§ Automatically size the columns to conform to the data being printed

Formatting  - Define how the printed document appears such as:-
§ Flat, Standard, or Ultra Flat appearance
§ Transparent Graphics display
§ Re pagination upon change of top level Group
§ Go to new page upon change of Group

Styles  - Define Font, Colour, and Texture of Bands, Captions, Headers, Footers, etc

Preview  - Define previewing options such as:-
§ Visible Bands
§ Auto Size height
§ Maximum Line Count

Cards - Lets you define the format of the Card view with details such as:-
§ Auto Width or keep same width and height
§ Horizontal and Vertical spacing
§ Borders on the Cards
§ Display Column separator lines and/or record lines
§ Card shadow Colour and depth
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Title Properties - By clicking on this button you can enter a Report Title in addition to formatting
the Font, Colour and Alignment of the title on the document

Reloading Saved Reports

On the displayed panel select the previously saved report (with extension .rps).  If you now select
the ‘Open’ button in that panel the saved report will be displayed.

Unloading current Reports

If you have more than one report open then you can release the current report by selecting the ‘
Unload’ option.  You may also enable this option by keying Ctrl-F4.

Save

This option allows you to save the current report for future recall.  Upon selecting this option a
panel will appear and a new document created prefilled with ‘New Report’.  This file name can be
amended if required.

Print

This option displays the normal pre-print panel as set up on your PC.  From there you can print the
report.

Page Setup

This option brings up a screen with 4 panels that allow you to format the page setup of the report. 
The panels are:-

Page  - Define paper details such as:-
§ Size (Letter, A4, etc)
§ Orientation (Portrait or Landscape)
§ Source

Margins  - Define margins on each page such as:-
§ Left, right, top, bottom
§ Header, Footer
§ Centre Horizontally or Vertically

Header/Footer  - Define details for Header and Footer such as:-
§ Font size, Colour, and Background Fill
§ Alignment
§ Insertions (Page Number, Date, Time, etc)
§ Reverse on Even Page selection

Scaling  - Defines the number and position of report pages per printed page

Options

The Report Options is selected from the drop-down list under File on the top toolbar.  It lets you
define additional Report options that you may wish to use, such as:-

§ Show Margins and Margin Hints
§ Zoom Steps and whether it can be used with IntelliMouse
§ Measurement Units (Inches, Millimetres, or your PC setting)
§ Margin Colours
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View Options Menu

View Options are selected from the drop-down list under View on the top toolbar.  It enables you to
set various switches relating to how the display is presented.  The options are:-

Margins - If this is checked then the report will have its top, bottom and side margins displayed. 
You may also use Ctrl-M to perform this function.

Flat Toolbar Button - If this is checked then the main Toolbar will be displayed in flat format.   If
not checked then it will have ‘shadows’ to each icon

Large Toolbar Button - If this is checked then the main Toolbar will be displayed in a larger
format.

Margins Bar - If this is checked then a bar will appear below the main Toolbar showing the
position and dimensions of the margins.

Status Bar - If this is checked then a document status bar will be displayed at the bottom of the
screen

Thumbnails - If this is checked then a panel will appear on the right of the screen showing
thumbnails of the current report.  If you select a thumbnail then the actual page will be displayed
on the left.

Zoom - If this is checked then you can zoom in on the current document in the following forms:-
§ 100%
§ Page Width
§ Whole Page
§ Two Pages
§ Four Pages
§ Source Width
§ User defined setup

Page Header - If this is checked then the Page Headers will be displayed

Page Footers - If this is checked then the Page Footers will be displayed

Format Options Menu

Format Options are selected from the drop-down list under Format on the top toolbar.  It enables
you to define the following options prior to printing or saving

Title - You have the option to give the report a title if it does not already have one.  This will appear
at the top of the report.

Date and Time - If the Page Setup has ‘Date and Time Printed’ on the Header or Footer then you
can specify the format of that date and time prior to printing

Page Numbering - If the Page Setup has ‘Page#’ on the Header or Footer then you can specify
the format and start number of the page prior to printing

Fit to Page - If this is selected then all the selected data will be printed on a single page across the
width.  This may cause unreadable printout so you should consider either hiding unwanted fields or
unselecting this option.
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Background - If this is selected then a panel will appear for you to select a background colour and
effect. 

  
Go Menu

The ‘Go’ drop-down presents the following options

First Page - Go to first page of the Report

Previous Page - Go to previous page in this Report

Next Page - Go to first page in this Report

Last Page - Go to last page in this Report

Email Options

PDF
Generates a Portable Document Format (PDF) document of the displayed information and then
opens up the Emailing routine on your PC with this PDF document as an attachment

XLS
Generates an XLS (spreadsheet) from the displayed information and then opens up the Emailing
routine on your PC with this XLS document as an attachment

HTML
Generates an HTML format and displays this in the ‘body’ of the generated email

XML
Generates an XML document, which can be called and displayed as a standard Web form.    It
also creates an XSL document showing the source document from the displayed information.  The
program then opens up the Emailing routine on your PC with the XML and XSL documents
attached.

CSV
Generates an CSV (Comma Separated Value) document from the displayed information and then
opens up the Emailing routine on your PC with this CSV document as an attachment

Exporting the Analysis View

The following options are available for you to export the View.  The option can be selected from the
top toolbar

Export as PDF
Generates a Portable Document Format (PDF) document.   This file can then printed and/or
attached to an email

Export to Excel      
If this is selected then a panel will appear for you to save the current displayed data as an Excel
Spreadsheet.  You may then call up Excel and manipulate the data as required.

Export to HTML    
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If this is selected then a panel will appear for you to save the current displayed data as an HTML
file.  This file can then be called and displayed as a standard Web form using your Browser.

Export to XML   
If this is selected then a panel will appear for you to save the current displayed data as an XML file.
Two files are created.    

§ An XML document that can be called and displayed as a standard Web form using your
Browser.

§ An XSL document showing the source document 

This file can then be called and displayed as a standard Web form using your Browser.

Export to CSV 
If this is selected then a panel will appear for you to save the current displayed data as a Comma
Separated Value file.  This can be used as an import format to external systems.     You may also
call up the CSV file in Excel (File Type = .csv) and manipulate the data as required.

Mail Merge 
If this is selected then the displayed information will be exported to a .csv file that forms the basis
of generating a Word Document to print out the information in that document.  A separate tutorial
is available that describes how to set up and run this feature

3.10 Views Chart Options

The Charts View enables you to see pictorial representations of various statistics with option to drill
down, filter, select chart format, etc.

1. Main Toolbar

Data Levels:  This shows the drill-down data levels available on each view.  You can either select
the Data Level by clicking on the Level Name.  Alternatively you can ‘left mouse’ on the chart
diagram to drill down one level at a time and ‘right mouse’ to go back up the levels

Selection within Level: If you click on the field to the right of each Level then a drop-down list is
presented showing all the options within that level.  Selecting from the drop-down list will restrict
the display to that option

Customize Chart: Clicking on this button will allow you to customise the presentation.  The
presentation options are:

Series:  Within this panel you can select:
· Select the field(s) to be displayed
· Drag and drop the field to the required appearance order

Data Groups:  Not currently used
Options:  Within this panel you can:

· Define the position of the Chart’s Legend
· Define, within the above selection, where the Legend is to appear
· Define the orientation of the Legend
· Define if the Legend has a border around it
· Define if the Legend ‘key’ has a border around it
· Define the position of the Chart’s Title
· Define, within the above selection, where the Title is to appear
· Define where the Toolbar is to appear
· Define if the Toolbar has a border
· Identify if the Diagram selector is to be visible
· Select if you want ‘hints’ to be visible when curso is moved over the
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display

Column Diagram: From the drop-down list select the display format of the Chart.  The options
are:

· Column Diagram
· Bar Diagram
· Line Diagram
· Area Diagram
· Pie Diagram

2. Output Options

Print: You can output the current view to your screen prior to printing or print directly to a selected
printer.

Email: The drop-down list provides the following options
PDF - Generates a Portable Document Format (PDF) document of the displayed
information and then opens up the Emailing routine on your PC with this PDF document as
an attachment
XLS - Generates an XLS (spreadsheet) from the displayed information and then opens up
the Emailing routine on your PC with this XLS document as an attachment
HTML - Generates an HTML format and displays this in the ‘body’ of the generated email
XML - Generates an XML document, which can be called and displayed as a standard
Web form.    It also creates an XSL document showing the source document from the
displayed information.  The program then opens up the Emailing routine on your PC with
the XML and XSL documents attached.
CSV - Generates an CSV (Comma Separated Value) document from the displayed
information and then opens up the Emailing routine on your PC with this CSV document as
an attachment

Export: The drop-down list provides the following options
PDF - Generates a Portable Document Format (PDF) document.   This file can then
printed and/or attached to an email
XLS -  If this is selected then a panel will appear for you to save the current displayed data
as an Excel Spreadsheet.  You may then call up Excel and manipulate the data as
required.
HTML - If this is selected then a panel will appear for you to save the current displayed
data as an HTML file.  This file can then be called and displayed as a standard Web form
using your Browser.
XML - If this is selected then a panel will appear for you to save the current displayed data
as an XML file.  Two files are created.    

· An XML document that can be called and displayed as a standard Web form
using your Browser.

· An XSL document showing the source document 
This file can then be called and displayed as a standard Web form using your
Browser.

CSV - If this is selected then a panel will appear for you to save the current displayed data
as a Comma Separated Value file.  This can be used as an import format to external
systems.     You may also call up the CSV file in Excel (File Type = .csv) and manipulate
the data as required.
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3.11 Views Pivot Grid Options

1. Introduction

When looking for the tools of analysing data in different ways without any coding, the pivot grid is
the best solution.  With the drag-and-drop functionality, it allows Users to rearrange fields in the
view dynamically.  This includes:

Interchanging columns and rows on the fly

Filtering and sorting items in different ways

Collapsing and expanding data at different levels.

The main features of the Pivot Grid include:

Automatic summary calculation for each cell – There are 5 summary functions available: Sum,
Count, Min, Max, and Average.

Display Multiple data fields – This feature allows you to calculate and display multiple
summaries at the intersection of each column and row.

Multiple column and row fields – The values of column and row fields are listed along the top
and right edges of the control and they identify column and row headers. The values of multiple
column (row) fields are arranged into a hierarchy and can be expanded.

Automatic Total calculation – Totals display total summaries calculated for outer column and
row fields.

Automatic Grand Total calculation – Grand Totals display overall summary totals calculated
against all the columns and rows. They are displayed as the bottom-most rows or right-most
(left-most) columns.

Filtering data – This feature enables you to limit which records are processed. A User can easily
change the filter at runtime via the Filter Drop-down.

Automatic sorting of column and row field values in alphabetical order (for text data) and in order
of magnitude (for numeric and date/time data). A User can change a field's sort order (from
ascending to descending and vice versa) by clicking the field header.

Sorting by summary values – The Pivot Grid control enables column and row field values to be
sorted by total summary values.

Customizable position of data field headers.

Export – to HTML, XML, XLS and TXT formats.

Cell selection and copying to clipboard – A User can select a range of cells with the mouse and
then copy their contents by pressing the CTRL+C shortcut. The selected data is copied to the
clipboard in the tab-separated format that is natively supported by Microsoft Excel, for instance.

Dragging fields between different areas – Users can freely drag field headers between different
control areas. This gives them full control when analysing the data.

Built-in Customisation Form – Allows Users to temporarily hide fields and make them visible
again.
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2.  Basic View

A Pivot Grid in Ostendo has four major ‘working’ areas shown in the top of the display

Filter Band: A band across the top of the Grid in which you can display fields and their filtering
options.  If you click on the drop-down contained within each field then you can specify the specific
selection(s) to appear in the Pivot Grid.

Data Area: A small area immediately under the Filter Band in the left part of the screen.  These
show the fields being calculated whose details are displayed in the main Pivot Grid

Column Area: An area immediately under the Filter Band to the right of the Data Area.  If you:
· Click on the drop-down contained within each field name then you can specify the specific

selection(s) of that name to appear in the Pivot Grid.
· Click on the transparent arrow within each field name to sort the columns into ascending

or descending order

Row Area: An area immediately under the Data Area.  If you:
· Click on the drop-down contained within each field name then you can specify the specific

selection(s) of that name to appear in the Pivot Grid.
· Click on the transparent arrow within each field name to sort the rows into ascending or

descending order

3.  Field Visibility

You can carry out the following activities that enable you to address the visibility of selected fields.

Individual Field visibility options:  If you ‘right mouse on any field in the upper ‘work area’ then
the following options are available

· Hide: Hides the selected field from the display
· Order: Moves the selected field to:

o Move to Beginning
o Move to End
o Move Right
o Move Left

· Hide or Show Field List: Hides or shows a panel in the bottom right of the screen for
hiding and restoring multiple fields.  See next option

Multiple Field visibility options:  If you ‘right mouse outside of any field in the upper ‘work area’
then the following is displayed

· Hide or Show Field List: Hides or shows a panel in the bottom right of the screen for
hiding and restoring multiple fields.  Within this panel you can 
o Drag any shown field onto the Pivot Grid for use in the Grid
o Drag any field from the Pivot Grid to this panel to hide the field

4.  Expanding, Collapsing, Grouping of Columns and Rows

You can click on the ‘Plus’ or ‘Minus’ buttons shown in the heading of fields to expand and collapse
columns and rows that have nested columns and rows:

5.  Filtering

Data can be filtered against column, row and filter fields by clicking the filter button (Black
downward facing triangle seen in the field header) and selecting items in the filter drop-down.
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6.  Field Drill-Down

For any calculated field in the main body of the Pivot Grid you can ‘double click’ on the field to drill
down and display the records that are the source of the displayed summary information.

7.  Keyboard Shortcuts

The keyboard shortcuts and mouse operations listed in the table below can be used by the User to
move focus between cells.

· Clicking a cell: Focuses the clicked cell.

· Pressing the Up, Down, Left or Right arrow keys: Focuses a corresponding adjacent
cell.

· Pressing the Page Down key: Moves row focus one page down preserving the column
focus.

· Pressing the Page Up key: Moves row focus one page up preserving the column focus.

· Pressing the Home key: Focuses the first cell within the current row.

· Pressing the End key: Focuses the last cell within the current row.

· Pressing the Ctrl+Home key: Focuses the first cell within the first row.

· Pressing the Ctrl+End key: Focuses the last cell within the last row.

8. Re-Ordering Fields

The following operations can be performed by Users to rearrange fields:

· Drag a field header and drop it at a new position within the same or another header area.

· Select an option from the "Order" submenu in the field header context menu.

· Double-click a field header within the customisation form or selecting a field header and
clicking the form's Add To button.

9. Resizing Columns

The following operations can be performed by Users to resize columns:

· Drag the right edge of a column header to change the width of the current and relative
columns.

· If you Double-click the right edge of a column header then it applies best fit to the current
and relative columns

10.  Selecting Cells

The Pivot Grid control allows Users to select multiple data cells using the mouse or the available
keyboard shortcuts. The data that is displayed by the selected cells can be copied to the clipboard
and pasted into other applications (e.g. MS Excel, MS Word).

Pressing the Shift+Arrow key combination enables Users to select a continuous range of data
cells. When such actions are carried out any previous cell selection is cleared.

Pressing the Ctrl+A key combination will select all data cells within the data area.

11.  Copying Selected Records to the Clipboard

Pressing the Ctrl+C or Ctrl+Ins key combination will copy the selected data cells to the clipboard
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as text.

12.  Sorting

The values of column fields and row fields are always displayed in ascending or descending order. 
You can alternate between ascending and descending by simply clicking on the field header. 

13.  Output Options

Print: You can output the current view to your screen prior to printing or print directly to a selected
printer.

Email: The drop-down list provides the following options
PDF - Generates a Portable Document Format (PDF) document.   This file can then
printed and/or attached to an email
XLS - Generates an XLS (spreadsheet) from the displayed information and then opens up
the Emailing routine on your PC with this XLS document as an attachment
HTML - Generates an HTML format and displays this in the ‘body’ of the generated email
XML - Generates an XML document, which can be called and displayed as a standard
Web form.    It also creates an XSL document showing the source document from the
displayed information.  The program then opens up the Emailing routine on your PC with
the XML and XSL documents attached.
CSV - Generates an CSV (Comma Separated Value) document from the displayed
information and then opens up the Emailing routine on your PC with this CSV document as
an attachment

Export: The drop-down list provides the following options
PDF - Generates a Portable Document Format (PDF) document.   This file can then
printed and/or attached to an email
XLS -  If this is selected then a panel will appear for you to save the current displayed data
as an Excel Spreadsheet.  You may then call up Excel and manipulate the data as
required.
HTML - If this is selected then a panel will appear for you to save the current displayed
data as an HTML file.  This file can then be called and displayed as a standard Web form
using your Browser.
XML - If this is selected then a panel will appear for you to save the current displayed data
as an XML file.  Two files are created.    

· An XML document that can be called and displayed as a standard Web form
using your Browser.

· An XSL document showing the source document 
This file can then be called and displayed as a standard Web form using your
Browser.

CSV - If this is selected then a panel will appear for you to save the current displayed data
as a Comma Separated Value file.  This can be used as an import format to external
systems.     You may also call up the CSV file in Excel (File Type = .csv) and manipulate
the data as required.

14.  Multi-View Option

Using the same selection criteria you can save and recall have multiple Views.  Three buttons are
available on the top toolbar:

Save: Click on this button and enter the name that you are giving this specific View and then click
the OK button

Restore: Click on this button to display a list of the saved Views.  Selecting one of these will
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restore that View.

Delete: Click on this button to display a list of the saved Views.  Selecting one of these will Delete
that View.from the list

3.12 Alert Viewer

System Alerts (maintained via File>System Configuration>System Alerts) provide facility to have a 
‘pop-up’ message appear on your PC at a selected time after an alert condition has arisen.  (For
Example: A Purchase Order has overdue Lines). The notification can then be forwarded (emailed)
to the relevant Employee should any action be required.

Whenever an Alert is ‘triggered’ a notification appears on the screen for a few seconds.
Subsequently you may click on one of three ‘icons’ displayed on the bottom right of the screen (‘
Low’, ‘Medium, or ‘High’ severity) and a panel is displayed that shows:

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Alert Severity: Three ‘Checkboxes’ are available:
· Low
· Medium
· High

The relevant checkbox will be prefilled relative to the icon selected at the bottom of the screen. 
This will show all the Alerts assigned to your User Signon that have this Severity.  You have the
option to ‘Check’ the other two checkboxes as required to show those Alerts at the same time.

Alert Module: Display only field showing the Module or functional area to which this Alert is
related.

Alert Name: Display only field showing the Identity of this Alert

Severity: Display only field showing the severity that applies to this Alert.  The displayed options
are:

· Low
· Medium
· High

Date Raised: The date when this Alert was raised

Description: Display only field showing a short description of the Alert

Buttons

Close: This will close the Alert Viewer screen.  

Delete: If this Alert is now not required or has been completed then select the line and click this
button to remove it from the Alerts Viewer screen

Email: Highlight the ‘Alert’ then click on this button to create an email containing the Alert
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information 
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4 Desktop

Desktop functions comprise of Views and Workflows.  They are displays that replace the opening ‘
Ostendo’ panel and provide information and Views.  These lie behind the Ostendo working
screens and can provide user-defined information relating to Ostendo activities, KPIs, Workflows,
Installations Guides, etc.  The displays can be information only or can be interactive

4.1 Desktop Views

Desktop Views are user-defined presentations of information taken from Ostendo.  They can be
Analysis Views, Charts, Pivot Views or KPI’s.   Additionally the displayed information can be
refreshed at a user-defined frequency to provide up-to-the-minute information.

The option to use and display Desktop Views is defined against the User’s Security and Options
record (see File>System Configuration>User Security and Options).  Up to 4 Views can appear on
a user’s Desktop.  The Views themselves are created via the Report and Views Developer
function.  These would normally be Analysis Views, Graphs, Charts, or KPI’s.   
These Views are display only and provides no interaction with the User.  However drill-down
facilities are available if the View has been specified to provide this

4.2 Workflows

Workflows are user-defined graphical representations of Operational Activities, Training Guides,
Installations Guides, KPIs, etc.   The Workflow itself can include interaction with Ostendo such that
clicking on a Graphical object takes the User directly to a Screen, Report, or View in Ostendo. 
Additionally, the object can be linked to Custom Menu Scripts that can perform Customised
Activities.  These activities can be refreshed automatically or each time the object is selected

A separate Graphical Developer is available for the User to create the Workflows.   The option for
a User to see Workflows is defined against the User’s Security and Options record.   (See
File>System Configuration>User Security and Options). 

Once linked to a User the Workflow will be available for viewing on the User’s Desktop where the
following facilities are available:

Right Mouse on an Object

Assign Function: If this is selected then you can select any Menu Item (For example:
Selecting Sales>Settings Customer Types) and that selection will be linked to this Object. 
If you now click on the Object the linked screen will be presented.
You may link any Screen, Report, View or Custom Menu Script (available to the User via
User Security settings) to an Object

Object ID: This is available for the Advanced User who may wish to use scripting to
activate functions within it.  For example: The object could simply be a KPI Text in which
the KPI variable is calculated and amended within the script by referencing the Object ID.

Link to Another Workflow: A panel will appear where you can point this button to another
Workflow.  Subsequently, whenever this object is selected the linked workflow will replace
the currently viewed Workflow

Right Mouse away from an Object
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Refresh: The current Workflow is loaded ‘into memory’.   If you make any changes to the
Workflow via the Graphical Editor then you should not only save the changes in the
Graphical Editor but also select this ‘refresh’ option to reload the saved Workflow.

Move/Resize: With this selected you have the facility to move and resize any object on the
Workflow to suit your requirements.  

· To move a group of Objects simply place the cursor to (say) the top-left of the
Group and drag the cursor to form a rectangle around the Group.  You can then
move the Group as required.

· To move selected objects ‘in unison’ Shift/click on each object and they will move
as one.

Select Move/Resize again to exit this function

You should note that this action only adjusts the Workflow ‘in memory’ and does not affect
the originating Graphical Design.

Edit Workflow: If this is selected then the Graphical Editor will be resented showing the
current Workflow.  You can make changes to the Workflow as described in the Graphical
Designer Tutorial.  You must ‘Save’ the changes for them to be effective.   Having saved
the Workflow source you now need to ‘Refresh’ the Desktop to bring the changes into ‘
memory’ 

Load From File: With this feature you can locate and use other Workflows.  You should
note that the current selected Workflow will become the default Workflow to be used the
next time you sign onto Ostendo
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5 File

5.1 System Configuration

5.1.1 System Settings

System Settings form the foundation to the way Ostendo will run.  The settings are normally set up
as part of the initial installation process.  They can be amended at any time as required.

Panel 1 - Company Information

Entry and Display fields

Company Name: This is prefilled with the Company Name contained in your Licence Key.  If you
have a Multi-Company Licence then a drop-down list will show the companies covered by the
Licence.  Select the Company that applies to this current signon.  This is used, by default, on all
reports in Ostendo.   It is also used in the opening display.

Postal Address: Three lines are available for you to enter your company’s address.  This should
include Number, Street and District.  The Town/City should be entered into the next field.  This
address will be used, by default, on all documents that use your company information. 

City: Enter the Town or City where your company is located.  This will appear on all documents
that use your company address.

State: Enter the State where your company is located.  No validation checks are made on this
entry.  This will appear on all documents that use your company address.

Code: Enter the Company’s Postcode or Zone Improvement Program (Zip) Code.  This code will
be used on all documents that use your company address. 

Country: Enter the Country in which your company is located.  This will appear on all documents
that use your company address.

Phone: Enter the Company’s Telephone Number.  This will appear on all documents that use your
company address.

Fax: Enter the Company’s Facsimile Number.  This will appear on all documents that use your
company address.

Email: Enter the Company’s Email Address.  This will appear on all documents that use your
company address.

Web: Enter the Company’s Web Address.  This will appear on all documents that use your
company address.

Invoice Remittance: If this is ‘checked’ then the Invoice print will include a Remittance slip.

Statement Remittance: If this is ‘checked’ then the Customer Statement will include a Remittance
slip.

Default Company Site: From the drop-down list select the default Site address for this company.
This site address will be used as the default receipt address for Purchase Orders.  Company Sites
are maintained via General>Company Sites
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Tax  Settings

Tax Name: Enter the name of the Tax that will appear on your documents.  Example; Tax, GST,
VAT, etc

Tax Number: Enter your Tax Number.  If required this number can be printed on all your formal
documents, etc

Official Company Number: If your company has an official registration number then enter it here.
This will be available for printing on all forms where your company name is used.

Accounting Basis: From the drop-down select the basis by which your accounts are run.  The
options are:

· Invoice: Sales Revenue and Tax Amount are posted at time Invoice was raised
· Cash Deferred Sales: Sales Revenue and Tax Amount are posted at time of payment.

Note: This method is not allowed in New Zealand
· Cash Immediate Sales: Sale Revenue is posted at time Invoice was raised.  Tax Amount

is posted at time of Payment

Company Settings

Invoice Name: This is the Legal name of the Invoice that will be displayed on the Invoice Print

Credit Name: This is the Legal name of the Credit Note that will be displayed on the Credit Note
Print

Max Debtor Days aging: Enter the default maximum number of days that are allowed against
Debtors.  When a Sales Order or Job Order is being created, or goods are being picked against
existing orders and the Customer has an outstanding payment that is greater than this number of
days then a message will be returned.  This can be varied at Customer level and made specific to
the Customer if required

Max Entry Days Forward: Entry of Invoices, Payments, etc can only be made up to this number
of days forward from the system date.

Min Allowable Margin %: Whenever a Sell Price is amended against an Item or Descriptor (either
individually or in batch) and Ostendo finds that the resultant Margin falls below this percentage
then System Alert 'Std Sell Price Below Margin' will be triggered.

Activate Credit Warning: If this checkbox is ‘checked’ then a Warning Message will be given
during Order Entry if the Customer is approaching the Credit Limit defined by the percentage
entered in the next field.

Warning %: Enter the percentage of the Credit at which this warning message will be presented
when creating Sales orders.

Financial Start Month: Enter the month that equates to you Financial Start Month.  This can be
referenced by the Reporting Periods screen to enable the Report an View Developer to generate
reports relating to the Financial Year

Financial Costing Methods

Inventory Costing Method: From the drop-down list select the method by which Inventory will be
costed.  Options are Average or Standard. 
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Descriptor Costing Method: From the drop-down list select the method by which Descriptors will
be costed.  Options are Last, Buy Price, or Standard.

Editing Decimals: Select the number of decimal places that you will use against all Prices and
Costs across Ostendo when editing the value.  The minimum allowed is 2 decimal places and the
maximum is 6

Display Decimals: Select the number of decimal places that you wish to see when displaying
Prices and Costs across Ostendo.  The minimum allowed is 2 decimal places and the maximum is
6

Dimensions, Weights & Volumes

Length and Width Unit: From the drop-down list select the basic unit of Length that will be used
throughout Ostendo.  Units are maintained via General>Settings>Standard Units.

Weight Unit: From the drop-down list select the basic unit of weight that will be used throughout
Ostendo.  Units are maintained via General>Settings>Standard Units.

Volume Unit: From the drop-down list select the basic unit of Volume that will be used throughout
Ostendo.  Units are maintained via General>Settings>Standard Units.

Area Unit: From the drop-down list select the basic unit of area that will be used throughout
Ostendo.  Units are maintained via General>Settings>Standard Units.

Logo

Company Logo: Click to open the box. Right-Click on the box to load the image file containing the
company's logo. This should be a png or jpeg file of no more than 100k bytes. 

  This logo can be used in html reports generated by the Freeway app.

Buttons

Close: This will close the System Configuration screen.  If you have any unsaved data you will be
asked if you wish to save it before the screen is closed.

Save: Click on this button to save the entry.

Cancel: Any changes made to the current screen or the last time the ‘Save’ Button was pressed
will be lost.

Panel 2 - Environmental Settings

Entry and Display fields

Hide Related Toolbar: If this is ‘checked’ then the ‘Related Toolbar’ will not be displayed at the
top of each main screen that has Related Screens.  Note: The ‘Related’ button down the right hand
side of the screen will still be available for accessing the Related screens.

Enable Auto Complete on Look-ups: If this is ‘checked’ then, where there is a drop-down list,
you can begin typing characters and the display will commence at those sequence of characters. 
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If the sequence of characters is unique to a specific record then the record's remaining characters
will automatically populate the field.

Enable Spell Checking: If this is ‘checked’ then all Memo and Notes fields in Ostendo are
validated against a dictionary using Ostendo's inbuilt Spell Checker.

De-activate Auto Correcting: If this is ‘checked’ then the automatic correcting of spelling errors
will be deactivated.  The error, however will still be highlighted by a red underline

Email Client: From the drop-down list select the preferred method by which you wish to send
emails.  The Options are Outlook or Other.

· If you choose 'Other' then you are required to inform Windows that the message being sent
uses the Email Service as defined in your Windows setup.  The generated email will be in
Text Format.

· If you choose 'Outlook' then this informs Ostendo that you are specifically using Microsoft
Outlook and this provides the opportunity to use .rtf formats for your email is required.  If the
'Incl Signature' checkbox is 'checked' then the email will automatically contain your Outlook
signature.

This setting is copied to a User record when a User is created where it can be amended, if
required, and made specific to that User

Email Address Prefix:  If 'Other' was chosen in the previous field then this is required to inform
Windows that the message being sent is an Email message (rather than a Fax, etc). It is
recommended that the system default of smtp: is left unchanged.
This setting is copied to a User record when a User is created where it can be amended, if
required, and made specific to that User

Incl Signature:  This will become active if 'Outlook' is chosen as the Email Client.  If you 'check'
this checkbox then your Outlook Signature will also be included in the email message.
This setting is copied to a User record when a User is created where it can be amended, if
required, and made specific to that User

Advanced Searching: If this is ‘checked’ then the search facility in the following screens will
include facility to search the content of all Properties linked to the master record in addition to
searching the fields currently displayed in the list.

· Assembly Order
· Customer Assets
· Customers
· Descriptors
· Items **
· Job Orders
· Labour Codes
· Purchase Orders
· Sales Orders
· Supplier Codes
· Warehouses
· Inventory Availability

** Additionally the Advanced Search for Items will also address the linked Supplier records and
search a Supplier’s Part Number

For Multi-value Search use: 'Check' the radio button that suits the way in which you want to
search in all List screens and Views.  The options are:

· And - All the entries in the Search field must be present for the record to be displayed
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· Or - Any of the entries in the Search field must be present for the record to be displayed

Licence Notification to Administration Users Only: If this is ‘checked’ then whenever the
Ostendo Licence Key is due for renewal then only Users identified as ‘Administrators will be
notified during signon.  If it is not ‘checked’ then all Users will be notified.

Location Map Link  Enter the Location Map Link to the http address of the mapping system being
used.  Currently this is set to Google Maps for which the Link is

http://maps.google.com/?q=

When in a relevant screen (Customer, Supplier, Prospect, Order, etc) Ostendo will assemble the
address and append this to the above.  Before transmission via the Internet you will be asked if
you wish to view the Location Map or the Directions to this address from your own address.

Embed Fonts when saving or emailing reports as PDF: If this is ‘checked’ then the Report
Fonts will be embedded in the generated pdf documents when that document is saved or attached
to an email

Activate Screen Logging: If this checkbox is selected then Ostendo will record - by User - every
time a Screen, Report, View, etc has been activated along with the Date and Time when that
activation took place.  You can view these logs by going to General>Inquiries>Inquiry - Screen
Logging

Enable Database Message Trace: If this is not 'checked' than a Firebird Database error is
returned to the User with a message that states what has happened but not where it occurred
within the program's process flow.  If this checkbox is selected then the error message will also
contain the database trigger path that the program has gone through.  This would highlight where
the error arose.  If communicating this error message to Development-X then the message Trace
details should also be supplied.

Web Services Code: Basic Ostendo does not include the ability to use Ostendo's Web Services.
This can only be activated by a license code supplied by Development-X.   If you have the license
code then enter the code into this field.

Web Services Company: Display only field showing the Company covered by the Web Services
Licence Code

Web Services Expiry: Display only field showing the expiry date of the above Web Services
Licence Code

Wordwrap column headings for Inquiry and Analysis Views: If this is 'checked' then if the
column width is less than the Heading Text then the Text will 'wordwrap' into a second row.  If this
is not 'checked' then the Heading Text will concatenate to the column width.

Dynamic Archive Days for Closed and Updated Orders, Invoices & Payments: Enter the
number of Days prior to which Ostendo will automatically archive closed and updated transactions
from opening screens (i.e. Sales Orders, Job Orders, Invoices etc...).   You should note that this
doesn’t actually remove the data but filters it out for everyday operations  thus making screen
loading faster.  The data is still there for reporting and analysis purposes.  

Currency Symbol Override: Enter the Currency symbol here if you wish to override the system's
Regional Settings symbol. 

Network
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Stand Alone: If this radio button is selected then Ostendo will only run on the current computer

Shared Access: If this radio button is selected then Ostendo will run Client/Server, Peer-to-Peer,
and Terminal Server configurations

Buttons

Close: This will close the System Configuration screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Save: Click on this button to save the entry. 

Cancel: Any changes made to the current screen or the last time the ‘Save’ Button was pressed
will be lost.

Panel 3 - System Numbering

Automatic numbering is used extensively throughout Ostendo.  This screen enables you to define
and maintain auto-numbering 

Entry and Display fields

Module: Display only field showing under which Module this auto-generated number is used

Description: Display only field showing the specific area where this auto-generated number is
used

Current Value: Display only field showing the current number that is being used by the program

New Value: If you wish to revise the numbering sequence you may enter any number greater than
the current number .  Upon entering the number you should click the ‘Set’ button to reset all
numbers that have been changed.

Buttons

Close: This will close the System Configuration screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Set: This will update all records that have a value in their ‘New Value’ field.

Panel 4 - Accounting Link

This screen allows you to define the way in which you want the Accounting Link to function.  There
are three main sections

· identify the Accounting package being linked to
· Define if you are using single or multi-currency in the linked Accounting Package
· Define if Daily Journals are to be created in selected areas
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Entry and Display fields

Accounting Link Style: From the drop-down list select the Account Link method being used.  The
options are 

· MYOB Link 
· Quickbooks Link 
· Sage Pastel Evolution
· Xero
· MoneyWorks
· AccountRight Live Desktop
· AccountRight Live Cloud
· Sage Evolution Live
· Reckon Accounts Desktop
· Reckon Accounts Hosted
· Quickbooks Online
· Other Accounting Solutions 

There are two types of Accounting Links:
- the Batched Accounting Link ( MYOB, Quickbooks, and Sage Pastel Evolution ); and
- the Automated Accounting Link ( AccountRight Live Desktop/Cloud, MoneyWorks, Xero,

Sage Evolution Live)

The following applies to Batched Accounting links:

Process Batch Files Script: Only visible when the ‘Other Accounting Solution’ option is selected
above.    From the drop-down list select the Script that applies to generating and outputting the
Batch files.  The script itself is generated via screen File>Custom Scripts.

Re-Process Batch Files Script: Only visible when the ‘Other Accounting Solution’ option is
selected above.    From the drop-down list select the Script that applies to reprocessing a Batch
File.  The script itself is generated via screen File>Custom Scripts.

AR Style: This applies to AccountRight Live links only. Select either 
- Standard Invoice and Payment Posting,                  or 
- Post Invoices and Payments as Journals . (This is like the classic

MYOB Link where invoices and payments are posted across to AccountRight Live as journals.)

Invoice Number Prefix: For AccountRight Live this is mandatory. The default is "S". But you can
change it to some other preferred prefix.

Post all Foreign Currency transactions as Local currency Ledger transactions: If the linked
accounting package only addresses local currency or you are only using local currency Journals
then ‘check’ this checkbox.  All generated Ostendo Journals will be exported in local currency
although Foreign Currency amounts and Exchange Rates will still be retained in Ostendo.

Post Daily Summaries for Applying Deposits: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Applied Deposit’ transactions made within the day.
This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Applying Payments: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Applied Payment’ transactions made within the day.
This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Assembly Issues: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Assembly Order Issue’ transactions made within the
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day.  This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Assembly Receipts: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Assembly Order Receipt’ transactions made within the
day.  This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Assembly WIP Variances: If this is ‘checked’ Ostendo will create a
single (summary) journal for each day covering all ‘Assembly WIP Variance’ transactions made
within the day.  This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Customer Deposits: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Customer Deposit’ transactions made within the day
(only when using Bank Deposits).  This summary Journal is sent to the Ostendo-Accounting Link
routine.

Post Daily Summaries for Customer Payments: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Customer Payment’ transactions made within the day
(only when using Bank Deposits).  This summary Journal is sent to the Ostendo-Accounting Link
routine.

Post Daily Summaries for Inventory: If this is ‘checked’ Ostendo will create a single (summary)
journal for each day covering all ‘Inventory’ transactions made within the day.  This summary
Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Job Order Issues: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Job Order Issue’ transactions made within the day.
This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Job WIP Variances: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Job WIP Variance’ transactions made within the day.
This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Purchase Receipts: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Purchase Receipt’ transactions made within the day.
This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Purchase Price Variances: If this is ‘checked’ Ostendo will create a
single (summary) journal for each day covering all ‘Purchase Price’ transactions made within the
day.  This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Sales Invoice Costs: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Sales Invoice Cost’ transactions made within the day.
This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Sales Invoice Revenue: If this is ‘checked’ Ostendo will create a
single (summary) journal for each day covering all ‘Sales Invoice Revenue’ transactions made
within the day.  This summary Journal is sent to the Ostendo-Accounting Link routine.

Post Daily Summaries for Sales Order Issues: If this is ‘checked’ Ostendo will create a single
(summary) journal for each day covering all ‘Sales Order Issue’ transactions made within the day.
This summary Journal is sent to the Ostendo-Accounting Link routine.

External Accounts Receivable: This is always ticked if Automated Accounting Links (see below)
are selected.

No External Payments Returned: Ticking this will stop the posting of payments from external
accounting system into Ostendo. This means payments only goes from Ostendo to the external
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accounting system, not the other way round.

Prevent Manual Payments: Ticking this will prevent payments from being manually entered in
Ostendo (but POS payments will still be accepted). This is used to force the entry of payments only
from the external Accounting System.

Post Daily Summaries the Following Day : Ticking this box will ensure the Daily Summaries will
be posted on the next day.

· This field is used in conjunction with the Post Daily Summaries options on the

same screen. 

A journal will be created for all transactions dated “today”. All transactions

dated “today” will be accumulated within this Journal for the entire day,

effectively making this journal a summary of the day’s transactions. The

journal will remain with a “Ready to Send” Batch Status however will not have

a Financial Batch Number allocated until the first user logs into Ostendo the

following day.

NB: Any transactions that are backdated are posted to the accounting software

immediately rather than being delayed for accumulation. Only those

transactions dated “today” are held back and accumulated.

The purpose of this option is to reduce the volume of data posted thru to the

accounting software, along with reducing the number of connection attempts

to that software.

Automated Accounting Links: 

An Automated Accounting Link is where postings are automatically made at a predefined
frequency and currently applies to the following Accounting Styles:

· Xero
· Moneyworks
· AccountRight Live Desktop
· AccountRight Live Cloud
· Sage Evolution Live
· Quickbooks Online

Posting Frequency: This is how frequent the system will post "Ready to Send" transactions to the
accounting package. Minimum recommended is around 15 minutes.

Cutover Date: Only transactions dated from this date onwards will be posted. When first
implementing the accounting link consideration should be given to this date to ensure that all
postings are covered

Timeout (min): Set the maximum time the process will wait for a batch to complete posting before
another batch is started. Ostendo recommends around 120 minutes.

Retry Count: The number of times the system will attempt to post a transaction when
encountering connection issues.

Invoice Number Prefix : Enter a preferred invoice number prefix for all invoices created in
Ostendo. Having a default prefix will help identify that the invoice was created in Ostendo. 
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This is especially useful when integrating with other accounting systems.

Buttons

Close: This will close the ‘System Settings’ screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

5.1.2 System Alerts

System Alerts provides facility to have a ‘pop-up’ message appear on your PC at a selected time
after an alert condition has arisen.  (For Example: A Purchase Order has overdue Lines). The
notification can then be forwarded (emailed) to the relevant Employee should any action be
required.

Whenever an Alert is ‘triggered’ a notification appears on the screen for a few seconds.
Subsequent to that you may click on one of three ‘icons’ (displayed on the bottom right of the
screen) and all the current Alerts for the User are displayed.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Alert Active: All Alerts are pre-defined in Ostendo.  If you wish to use this Alert then ‘check’ this
checkbox

Alert Module: The Module or functional area to which this Alert is related.

Alert Name: The Identity of this Alert

Description: A short description of what the Alert is monitoring

Assigned To: From the drop-down list select the User(s) to which this Alert will be sent.  The Alert
will be sent to each User selected.  The Users in this List are those defined under File>System
Configuration> User Security and Options.

Tolerance: If the Alert is triggered by a tolerance value then that value is entered here.  Two basic
Tolerance values are used:

· The Number of Days before (negative) or after (positive) an event was due
· The percentage achieved against an anticipated value 

Severity: From the drop-down list select the severity that you are applying to this Alert.  The
options are:

· Low
· Medium
· High

Frequency: This is a system-defined frequency for when the Alert will be sent.  The displayed
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options are:
· Every Occurrence
· Once a Day

Alert or Email: Options are Alert Only, Email Only, or Alert and Email. Emailed alerts are sent to
the email address of the assigned user (as defined in his/her User Option screen). 

Buttons

Close: This will close the Alerts screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

5.1.3 User Security and Options

This facility allows you to create new Users, define which screens, reports and views can be
accessed, and how that User can adjust their available screens.

Users Panel

This panel allows you to create or remove Users.

Display fields

Username: Display only field showing the current Username for this person or department

First Name: Display only field showing the First Name of the User

Last Name: Display only field showing the Last Name of the User

Administrator: Display only field showing if this person has ‘Administrator’ rights.  I.e. full access
to all parts of Ostendo

Buttons

Close: This will close the User Security screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for entry of the new User as follows:
· Username: Enter a Username for this person.  Duplicate Usernames not allowed
· First Name: Enter the User’s first name
· Last Name: Enter the User’s last name
· Normal User or Administrator: select the radio button that will apply to this user noting

that an Administrator has unrestricted access to all areas of Ostendo

Click the ‘OK’ button when complete

Save: Not applicable to this panel

Cancel: Not applicable to this panel
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Delete: This will remove the current highlighted User record

Copy User: If you select a current User and click this button then all the access information held
against the current user will be copied to the new user after completion of the following
information:

· Username: Enter a Username for this person.  Duplicate Usernames not allowed
· First Name: Enter the User’s first name
· Last Name: Enter the User’s last name
· Normal User or Administrator: select the radio button that will apply to this user noting

that an Administrator has unrestricted access to all areas of Ostendo

Click the ‘OK’ button when complete

Reset PW: If you select a current User and click this button their password will be reset to ‘pass’.
This is useful if that User has forgotten their password.  They should immediately use the screen
File>Change Password and reset it to their own requirements.

Security Access Panel

This panel allows you to define which screens and reports a User has access to.  If the User has ‘
Administrator’ rights, or the User's 'Inherit Security From' checkbox is 'checked', then this panel is
not available.

Display fields

Category: Display only field showing the Main Menu Category

Access Granted: ‘Check’ the checkbox to denote if this User has access to that screen.  You may
speed up this process by using the ‘Check All’ and ‘Uncheck All’ buttons described below

Buttons

Close: This will close the User Security screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Check All: You can click this button to ‘Check’ all screens in the system or just the current
highlighted category

Clear All: You can click this button to ‘Uncheck’ all screens in the system or just the current
highlighted category

User Options Panel

This panel allows you to set features by User.  These features include:

Display and Entry fields

Save Grid Layouts: Any changes made to the Grid Layouts such as moving columns, resizing
columns, etc will be saved when the User exits Ostendo and will remain until changed by the User
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in the relevant screen or the ‘Reset Grid Layouts’ button selected.

Reset (Grid Layouts): If this button is pushed then all Grid Layouts will revert to the Ostendo
basic format.

List Customising: Any changes made to the Customising of Lists such as adding or removing
columns or amending their sort sequence will be saved when the User exits Ostendo.  This will
remain until changed by the User in that screen or the ‘Reset List Grids’ button selected.

Reset (List Grids): If this button is pushed then amended List Grids will revert to the Ostendo
basic format.

Save List Filter Conditions: If this is ‘checked’ then any filter conditions set in 'List' screens will
be retained for this User and can be used the next time the screen is displayed.  If more than one
Filter Condition has been used then each condition will be available for selection by clicking on the
drop-down arrow to the right of the current selection

Auto Activate Filtering and Sorting: If this is ‘checked’ then Ostendo will automatically filter the
data in line with the last filter condition (if the above 'Save List Filter Conditions' button has been
'checked').  This feature is present because if there is a large amount of data to display then the
filtering and sorting can take a short while every time you enter this screen.  If this feature is NOT
checked then the screen is not filtered and the response is quicker.  You then have the option to
Filter the data within the screen itself.

Disable Grid Print / Export: If this is ‘checked’ then the option to print or export the current grid
will not be allowed.

Other Options
 
Allow Approvals: If this is ‘checked’ then the approvals process will be visible to this user.  If not
checked then approvals must be carried out by an ‘approved’ person before the relevant process
can go to the next step

Cannot change order prices: If this is ‘checked’ then this user will not be able to amend the
system evaluated Sell price against Sales Order Lines, or Sell Price against Job Order Lines.
If not checked then no restrictions will be enforced

Alert Screen not displayed on login: If this is not ‘checked’ than the Alert Panel will automatically
display immediately after signon.  If this is ‘checked’ then the Alerts Panel will not appear and the
User will have to click on the Alert Icons at the bottom-right of the screen to view current Alerts.  

Allow Change of Customer Calculated Prices:  The Sales Order Line, Job Order Line, and
Direct Invoicing Line screens contain a field called ‘Std Price’.   This is the system calculated Sell
Price.   If this field is ‘checked’ then this User will be allowed to amend this base Sell Price

Blind POS End of Day:  If this is 'checked' then this User can see the X-Report in POS End of
Day but that report will not display the Till Balance, Office Balance, and Variance Columns.  The
User can only enter the Closing Balance amounts

Allow Site Change:  A User is normally limited to transactions within the Site name linked to this
User (see 'User Site Name' below).  However if this is 'checked' then this User can change sites if
required

Hide Purchase Receipt Cost:  If this is 'checked' then this User cannot see any costs during the
receipt process in Purchasing.   The (hidden) cost used will either be the Purchase Order Price if
receiving against a Purchase order or the Buy Price from the item/Supplier price record and will
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default to the Item Buy Price if an Item/Supplier record does not exist.

Enable Option Price Change:  If this is 'checked' then this User can amend the Sell Prices during
a Features and Option product configuration

Disable Preview Export:  If this is 'checked' then the ability to export the report into all formats
excluding PDF from with the Print Preview screen is disabled.

Display Sales Costs:  If this is 'checked' then Order line costs are displayed in the Job and Sales
Order Lines screens.

Inventory Availability by Site:  If this is 'checked' then this User can only view Inventory
Availability for the Site identified in field 'User Site Name' (see below). If this is not 'checked' then
Inventory across all sites will be evaluated

Allow Inventory Site Change:  If this is 'checked' and the previous checkbox (Inventory
Availability by Site) is also 'Checked' then this User can select the specific Site from which to
display the Inventory Availability.

Allow Pricing Matrix Exclusions:  If this is 'checked' then the user is allowed to exclude the
pricing matrix within the Overrides tab of Sales and Job Order screens.

Disable Graphic Plant View Editing:  If this is 'checked' then the user is not allowed to edit the
Graphical Plant View displayed via Requirements>Graphical Plant View.   If this is not 'checked'
then changes may me made by clicking the 'right mouse' in the View and selecting 'Edit Plant
View'

No External GL Posting:  If this is 'checked' then the user is not allowed to post to the linked
external Accounting System.

Hide Assembly Costs:  If this is 'checked' then the user cannot see Assembly Costs in the
Assembly Order screen

Hide Item Buy Price:  If this is 'checked' then the user cannot see the Item Buy Price in the Item
Master screen

Hide Descriptor Buy Price:  If this is 'checked' then the user cannot see the Descriptor Buy Price
in the Descriptor Master screen

Allow Purchase Approvals:  If this is 'checked' then the user can carry out approvals to the limits
specified in Purchasing>Settings>Purchase Approvals

Can only Create Prospect: If this box is ticked, then this user can only create prospect records,
not customer records.

Default Assignment Profile: Select the default Profile for this user when using the Assignment
Board.

Default Ops Centre Company Type: Select the default company type when using Operations
Centre.

Purchase Order Alert Limit: If this User raises a Purchase Order that is greater than this amount
then an Alert will automatically be generated and ‘posted’ to the User identified against the Alert
message

User Site Name: From the drop-down list select the Site to which this User is linked.  All Orders
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generated by this User will contain this Site Reference in the Order Header record..This facility
allows for Orders and their Financial Transactions to be segregated by Site

Inherit Security From: If this is 'checked' then the adjacent field becomes active from which you
can select another User.  This feature enables you to create a 'Group User' (Example: Sales
Department) that contains the allowable Screens and Reports for this 'Group User'.  All other
Users linked to the 'Inherit Security From' User will automatically use the 'Group User' Screen and
Reports  Access criteria

Login Script: If this has a linked Script (created via File>Custom Scripts) then whenever this User
signs into Ostendo then this script will be run.  This is useful, for example, if the User is restricted
to a specific screen, or an information panel is displayed with current data prior to actually going
into Ostendo.

Email Client: Upon creation of a new User this is prefilled with the settings obtained from the
System Settings screen but can be amended her if required and made specific to this User.  From
the drop-down list select the preferred method by which you wish to send emails.  The Options are
Outlook or Other.

· If you choose 'Other' then you are required to inform Windows that the message being sent
uses the Email Service as defined in your Windows setup.  The generated email will be in
Text Format.

· If you choose 'Outlook' then this informs Ostendo that you are specifically using Microsoft
Outlook and this provides the opportunity to use .rtf formats for your email is required.  If the
'Incl Signature' checkbox is 'checked' then the email will automatically contain your Outlook
signature.

Email Address Prefix:  Upon creation of a new User this is prefilled with the settings obtained
from the System Settings screen but can be amended her if required and made specific to this
User.  If 'Other' was chosen in the previous field then this is required to inform Windows XP that
the message being sent is an Email message (rather than a Fax, etc). It is recommended that the
system default of smtp: is left unchanged.

Incl Signature:  Upon creation of a new User this is prefilled with the settings obtained from the
System Settings screen but can be amended her if required and made specific to this User.  This
will become active if 'Outlook' is chosen as the Email Client.  If you 'check' this checkbox then your
Outlook Signature will also be included in the email message.

Email Address:  Enter the default email address for this user.

Flag Announcements as Read: This flag must be ticked if the user wants to be able to mark an
Ostendo announcement as Read.
Ostendo Announcements are indicated on the Main Header Bar of the Ostendo main screen. 
Clicking on this Announcements heading will display the Announcements List Screen.
Announcements details are shown by clicking on the Detail tab. From this Detail screen, users can
press the Email button to forward the Announcement to anyone who may have a need to know.

System Style: From the drop-down list select the system style (I.e. the way the screens are
presented) that you wish to use.  The options are:

· Flat
· Ultra Flat
· Standard
· Native Windows
· Enhanced
· Skin
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As you make your selection the lower part of this panel will change in appearance to reflect the
choice made.

Desktop Views Panel

This panel allows you to select the Desktop View that will be used by this User.  The Views
themselves should already have been created via the Report and Views Developer function
(File>System Configuration>Report and View Developer)

Display and Entry fields

Enable Desktop Views:  If this is ‘checked’ then views will be enabled when the User signs onto
Ostendo

There are four independent Views that can be specified.  Each View contains the following fields.

View Type: From the drop-down list select the Type of View.  The options are:
· Analysis
· Chart
· Pivot

If you do not wish to display this view on the Desktop then select the ‘blank’ option 

View: Only active if a View Type is selected.   This drop-down will show all available Analysis,
Chart, or Pivot Views from which you should make a selection

Auto Refresh: If this is ‘checked’ then the View will be refreshed at the time interval defined in the
next field taking into account the current data within Ostendo.  If this is not ‘checked’ then you can
still refresh the View within the Desktop by clicking on the ‘Refresh’ key that appears above each
View

Refresh Interval: If the previous field is ‘Checked’ then enter the refresh time interval in this field.
The time intervals are in minutes starting at a minimum of 1 minute.

Workflow Panel

This panel allows you to define multiple Workflows that are available to the User on the Ostendo
Desktop

Display and Entry fields

Enable Workflow: ‘Check’ this checkbox to enable a Workflow to be displayed on the User’s
Desktop

Disable Workflow Editing: If this is ‘checked’ then the User cannot amend the layout or linkages
on the Workflow.  This is normally achieved by clicking the 'Right Mouse' when in the Workflow
screen

Start on Workflow when Desktop Views are also enabled: This is only active if 'Enable
Workflow' checkbox has been 'checked'.  If this is ‘checked’ then this becomes the default
Desktop display if the Desktop Views have also been selected for display in the ‘Desktop Views’
panel
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Workflows Tab

Caption: Enter a short name for this workflow.  This will be presented on a button down the right
side of the User's Desktop

Workflow File Name: Locate the Workflow file (ending in .dat) from within the computer network
and select it.  The full file path must be entered (or selected).

Sequence: This is prefilled with a sequence number that defines the order in which the Workflow
buttons are presented on the User's Desktop.  You can amend this sequence here if required

Preview Tab

This looks at the selected Workflow and displays a preview of its contents.  You can migrate
through the Workflow by clicking on the Graphic Buttons, etc.  However, linked Screens, Reports,
Scripts, etc, are not active.

Operations Centre Exclusion Panel

This panel allows you to exclude selected Operations Centre features by User. 

Display and Entry fields

Type Excluded: From the drop-down list select the Type to be excluded.  The options are:
Activity
KPI
Statistic

Name: From the drop-down list select the Name to be excluded.  The content of the drop-down
varies dependent upon the Type selected above.  I.e.:

Activity: Only Operational Activities are displayed
KPI: Only KPIs are displayed
Statistic: Only Statistics are displayed

Buttons

Close: This will close the User Security screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Adds a new line for linking to a new Workflow

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Deletes the current highlighted Workflow from this list

5.1.4 Licence Key

This screen allows you to load a licence key to either register the owner of Ostendo or increase the
number of allowable users.  The key will normally be supplied as file ‘ostendo.ldf’ but may be
supplied in text form.  Both are covered below.



62 Ostendo Reference Guide

Buttons

Load Licence Key from File: You should already have received the Licence Key ‘ostendo.ldf’ and
saved it on your computer.  If you click on this button then a panel will appear for you to point the
program to where the Licence Key resides.  Locate that key and press the ‘Open’ button.  The
display will then update your licence and revert to the ‘Load Licence Key’ screen with your Licence
Key information displayed.

Enter as Text: A panel will appear into which you should enter the following:

User Name: Enter the user name that was used to generate the Licence Key.  This must
be exactly the same as that supplied to generate the key.  You may wish to consider a ‘
Copy’ and ‘Paste’ function from the Text file that contains the User Name.
Organization: Enter the organisation Identity that was used to generate the Licence Key.
This must be exactly the same as that supplied to generate the key.  You may wish to
consider a ‘Copy’ and ‘Paste’ function from the Text file that contains the Organisation.
Licence Key: Enter the Licence Key exactly as supplied.  As this contains a combination
of numbers and alpha characters in both upper and lower case it is preferable that you ‘
Copy’ and ‘Paste’ function from the Text file.
(Button) OK: press this button to load the key.  The display will then revert to the ‘Load
Licence Key’ screen with your ‘key’ information displayed.

OK: Exit the Load Licence Key screen

5.1.5 Ostendo Support Detail

This screen allows you to capture the following Ostendo Partner contact information if required:

· Name

· Contact

· Web link

· Email Address

· Notes

This information will be displayed on the Help --> Ostendo Support page.

5.1.6 Multiple Companies

This feature enables you to point to other Ostendo databases created via the ‘Copy / Create
Company’ screen.  These Databases are given a ‘Company Colour’ in this screen and made
available to users on your network.  

Entry and Display fields

Company ID: Enter a short name of the Company.  This name will appear on the Ostendo Main
screen whenever this Company is accessed.

Company Colour: From the drop-down list select the colour that you associate to this company.
A box with this colour will surround the company name box on the main Ostendo screen.  This
provides a visual reference to the current - signed on - company.

Computer Name: This is the name of the Computer/System where this database is residing.

Database File Name: Locate the database in the folder where it is placed.
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Buttons

Close: This will close the Multi-Companies screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Company.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Company from this list.  You should be aware that
this only removes the link; it will not delete the database from your computer.

5.1.7 Copy / Create Company

This feature enables you to create multiple Ostendo databases on your network.  Each company
can be accessed in accordance with the User Signon Codes entered into that company.  This
feature is very useful for:

· Enabling a multi-company facility, and
· Copying an existing database and then using that for testing potential or actual changes

before adding the change to the ‘Live’ system.

Entry and Display fields

Copy or Create New: Select the appropriate ‘radio’ button.  If you select ‘Copy’ then you are
required to nominate the Company to be copied.  If you select ‘Create New’ then the program will
create a blank database with User: ADMIN, Password: pass

Copy From Company: If the ‘Copy’ radio button is ‘checked’ then, from the drop-down list, select
the company to be copied.

New Company ID: Enter the identity of the new company.

Computer Name: Enter the identity of the computer on which the database resides

New Database File Name: Locate where you want to place the new company database and give it
a name.  The program will give it an extension of .fdb  (Example: If you call the Database ‘Test’
then this company’s database will be Test,fdb)

Apply an online Data Template: Future Development feature

(Data Template Name): Future Development feature

Buttons

OK: If you click this button then the new Company Database will be created.

Cancel: This will exit the screen without creating the database
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5.1.8 Alternate Database user

Ostendo uses a Firebird database, which requires a Username and Password for access.  A
standard Username and Password is provided by Firebird and Ostendo uses this by default.  This
feature allows an Administrator to specify a Username and Password that is different from the
Firebird standard.  Ostendo will then use this Username / Password for automatic access to the
Firebird Database.

You should note that the Alternate Username and Password should also be set up in Firebird and,
whilst facility to do this is not provided in Ostendo, there are tools freely available on the Internet.

Use Alternate: ‘Check’ this checkbox if you are entering a revised User and Password.  This will
activate the following fields.

Username: Enter the Username that you will use to access Ostendo’s Firebird Database.  Note:
This must also be defined within the Firebird Database

Password: Enter the Password that will allow access to the Firebird Database.  Note: This must
also be defined within the Firebird Database.

Confirm Password: As the Password is displayed as asterisks you should re-enter it here to
provide a double-check that it was entered correctly above.  Unless the entries are identical you
will not be allowed to register the Alternate User/Password

Buttons

OK: If you click this button then the new Alternate Username and Password will overwrite the
current entry.

5.1.9 Global Name Change

There are instances when you may wish to globally change the name of (for example) a Customer,
or Inventory Item.  This feature allows you to instantly apply a change to numerous fields across
Ostendo.  You are only allowed to replace with ‘new’.  I.e. If the replacing record Identity already
exists then you will not be allowed to carry out the change.

Entry and Display fields

Select the Table-Field for Name Changing: From the drop-down list select the field type against
which you are making the change.  The content of the next two fields will reflect the selection

From Old Value: From the drop-down list select the ‘old’ identity that you are replacing.

To New Value: Enter the name of the replacement.  The program will check that this does not
currently exist.

Buttons

Apply change to entire database:  If you click this button then all occurrences of the ‘Old Name’
will be replaced with the ‘New Name’

Close: Takes no action and exits the screen.
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5.1.10 Global Data Merge

This feature allows you to rename key fields to one that currently exists in Ostendo.  

Warning: If you commit the renaming then the old value will be merged with the current value and
there is no ‘undo’ facility

Entry and Display fields

Select the Table-Field for Data Merging: From the drop-down list select the Table and Field
name against which the merge will take place.

From Old Value: From the drop-down list select the ‘old’ value that you are going to rename.

To New Value: From the drop-down list select the current value to which the ‘Old’ value will be
renamed.

Buttons

Merge All Records from Old to New Value:  If you click this button then all occurrences of the ‘
Old Value’ will be renamed as the ‘New Value’

Close: Takes no action and exits the screen.

5.1.11 Global Tax Code Change

If Tax Rates are changed - usually by government legislation - then this screen allows you to apply
that change across selected segments of Ostendo.  You should first set up the Date-effective Tax
Code change via the Tax Matrix screen.  This screen will take the system date and apply the Tax
Code effective on this date

Entry and Display fields

Update all Open Sales Orders with Tax Codes from Tax Matrix: If this checkbox is 'checked'
then all 'Open' Sales Orders will be updated to the Tax Code effective at the current System Date

Update all Open Purchase Orders with Tax Codes from Tax Matrix: If this checkbox is
'checked' then all 'Open' Purchase Orders will be updated to the Tax Code effective at the current
System Date

Update all Open Job Orders with Tax Codes from Tax Matrix: If this checkbox is 'checked'
then all 'Open' Job Orders will be updated to the Tax Code effective at the current System Date

Recalculate all Item & Descriptor Tax inclusive Prices from Tax Matrix: This will use the
default Customer/Supplier Tax Groups identified in the Tax Group Screen combined with the Tax
Group held against the Item/Descriptor record to determine the Tax Code effective at the System
Date.

Update all Open Recurring Invoices from Tax Code: This will update current open recurring
Invoices whose Tax Code is the 'From' Tax Code and replace it with the 'To' Tax Code

Buttons

Apply change to entire database:  If you click this button then all occurrences of the 'Old
Taxcode' will be replaced with the ‘New Taxcode’
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Close: Takes no action and exits the screen.

5.1.12 Item Base Unit Swap

There are instances when you may wish to change the base Unit of Measure against an Item. 
This feature allows you to instantly apply the change to all fields where the Item is used across
Ostendo.  

Entry and Display fields

Select Item Code for Base Unit Swap: From the drop-down list select the Item Code against
which you are making the change.  The next two fields will change to reflect the selection

Existing Base Unit: Display only field showing the current Base Unit held against the Item Code

Swap to this Unit: From the drop-down list select the new Unit that will replace the existing Unit.  
Note: The drop down list will show the current Units of Measure held against this Item record that
have a Conversion Factor of 1.  I.e. Additional Units against an Item Code are maintained via
Inventory>Items, selecting the above Item Code, then clicking on the ‘Related’ Button and
selecting ‘Item Units’. 

Buttons

Apply change to entire database:  If you click this button then all occurrences of the ‘Existing
Base Unit’ will be replaced with the ‘Swap to Unit’

Close: Takes no action and exits the screen.

5.1.13 Descriptor Base Unit Swap

There are instances when you may wish to change the base Unit of Measure against a Descriptor. 
This feature allows you to instantly apply the change to all fields where the Descriptor is used
across Ostendo.  

Entry and Display fields

Select Descriptor Code for Base Unit Swap: From the drop-down list select the Descriptor Code
against which you are making the change.  The next two fields will change to reflect the selection

Existing Base Unit: Display only field showing the current Base Unit held against the Descriptor
Code

Swap to this Unit: From the drop-down list select the new Unit that will replace the existing Unit.  
Note: The drop down list will show the current Units of Measure held in Ostendo.  These are
maintained via General>Settings>Standard Units

Buttons

Apply change to entire database:  If you click this button then all occurrences of the ‘Existing
Base Unit’ will be replaced with the ‘Swap to Unit’

Close: Takes no action and exits the screen.
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5.1.14 Audit Logging

This screen allows you to identify a specific field in an Ostendo Database which, when a record is
added, changed, or deleted and this field is contained in that record then an Audit Log is created
that records the old value and the new value along with the User that carried out the action and the
Date and Time it was carried out

Entry and Display fields

Table Name:  From the drop-down select the Ostendo Table Name against which you are carrying
out this Audit Log.

Field Name:  For the Table Name selected in the previous field Ostendo will present you with a
drop-down list of all Field Names used by that Table.  Select the Field Name against which you are
carrying out this Audit Log.

SQL Type:  From the drop-down list select the screen event at which this Audit Log will be applied.
The options are Insert, Update, or Delete.

Buttons

Close: This will close the Audit Log screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will take you to a new line for entry of a new Audit Log record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the Audit Log record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: This will delete the highlighted Audit Log record

5.1.15 Notifications Logging

This screen allows you to identify a specific field in an Ostendo Database which, when a record is
added, changed, or deleted and this field is contained in that record then a Notification Log is
created that records the old value and the new value along with a notification Flag.   This record
and flag can then be addressed by a script and actioned accordingly.  
 (For example: The Script could be a ‘Command Line Script’ and scheduled to run on a regular
basis to view the Notification Log Table for ‘Sales Deliveries’.  From that the Script could generate
an email and inform the Customer of the delivery)

Entry and Display fields

Table Name:  From the drop-down select the Ostendo Table Name against which you are creating
a Notification Log.

Field Name:  For the Table Name selected in the previous field Ostendo will present you with a
drop-down list of all Field Names used by that Table.  Select the Field Name against which you are
creating a Notification Log.

SQL Type:  From the drop-down list select the screen event at which this Notification Log will be
applied.  The options are Insert, Update, or Delete.

Buttons
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Close: This will close the Notifications Log screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will take you to a new line for entry of a new Notifications Log record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the Notifications Log record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the highlighted Notifications Log record

5.1.16 Run Command Script

This feature allows you to automatically run a script that has been supplied by Development-X
without the need to add it to your own scripts within Ostendo.  This would normally be used for
miscellaneous upgrades and changes supplied by Development-X.

You will be presented with a panel from which you point to the location of your external script (held
as a .txt file).  Upon selecting the file you will be presented with an Information message warning
you that you are about to modify data and do you wish to proceed.   Upon clicking the ‘Yes’ button
the script will be run.

5.1.17 Optimize Database

Select this option to optimise the Database Indexes and improve performance within Ostendo.  
You should note that the 'Backup and Restore' routine (Executable 'Dbutils.exe' which can be
found under the Ostendo Folder) will also do this as part of its backup/restore process.  

This optimize function resets the index statistics of the database. This should be done periodically
because inserting, updating,and deleting records changes these statistics.
Firebird calculates it when index is first created and when the database is restored from backup.

So regular backup and restore of the database will optimize the database. But between the
scheduled backup/restores, it may be necessary to use this function to reset the index statistics so
the database perform efficiently. 

5.2 Financial Configuration

5.2.1 Tax Codes

This screen allows you to maintain Tax Codes.  Within Ostendo:
· Customers and Suppliers are given a Tax Group.  
· Items, Descriptors and Labour Codes are also given a Tax Group.
· The combination of the Customer or Supplier’s Tax Group and the Item, Descriptor or

Labour Code’s Tax Group is linked to one of these Tax Codes (and hence a Tax Rate).  

The Tax Codes themselves can be defined as:
· Single Tax Amount 
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· A Consolidated Tax Code consisting of two or more individual Tax Codes
· A Tax-on-Tax Tax Code showing two or more Tax Codes where consecutive Code take

into account a previous Tax Amount in the List

This table enables you to define Tax Codes and their Tax rate.

Entry and Display fields

Upper Portion of the screen

Code: Enter the Tax Code (Example GST, VAT, Tax, etc).   Duplicates not allowed.

Description: Enter a short description of the Tax Code.  No checks are made on this entry

Tax Rate %: Enter a Tax Rate (Example 12.5 = 12.5%) that will apply whenever this Tax Code is
used

Tax Type: Select the Tax Type from the drop-down list.  The options are:
Standard: where a single Tax Amount is used
Consolidated: Where the Tax Codes to be included are entered in the lower part of this
screen.

The Tax Rate% (above) will automatically be evaluated from the sum of the individual Tax
Code percentages

Tax-On-Tax: Where the Tax Codes to be included are entered in the lower part of this screen.
The Tax Rate% (above) will automatically be evaluated by determining a Tax based on
the Tax-inclusive Price calculated from the previous Tax Code in the sequence

 
External Tax Code: Enter the Tax Code used in the linked accounting system. 

External Purchase Tax Code: Enter the Purchase Tax Code used in the linked accounting
system.   An entry is not essential but is helpful when integrating with accounting systems such as
Xero (where there are different tax codes for sales and purchasing). If the External Purchase Tax
Code is left blank the above External Tax code is used for both Sales & Purchase style of
transactions. 

Lower Portion of the screen

Enter the Tax Codes that make up the Consolidated or Tax-on-Tax Codes.

Code: Enter the Tax Code from the drop-down list.

Sequence: If the Tax Type is 'Tax-on-Tax' then enter the sequence by which Ostendo will
determine the Tax-on-Tax values to arrive at a Tax Rate%

Description: Display only field showing the description of the Tax Code

Rate: Display only field showing the Tax Rate applicable to this specific Tax Code

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons
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Close: This will close the Tax Code screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Tax Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Tax Code.

Set Default: Highlight a Tax Code than then click this Button.  This Tax code will be displayed at
the top of this screen and will become the default Tax Code to be used if no combination of
Customer/Supplier’s Tax Group and  Item/Descriptor/Labour Code’s Tax Group combination has
been defined.

5.2.2 Tax Groups

This screen allows you to maintain Tax Groups.  Within Ostendo:
· Customers and Suppliers are given a Tax Group.  
· Items, Descriptors and Labour Codes are also given a Tax Group.
· The combination of the Customer or Supplier’s Tax Group and the Item, Descriptor or

Labour Code’s Tax Group is linked to a Tax Code that provides a Tax Rate.  

This table enables you to define the Tax Groups.

Entry and Display fields

Group: Enter the Tax Group (Example Taxable, Overseas, etc).   Duplicates not allowed.

Description: Enter a short description of the Tax Group.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Tax Group screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Tax Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Tax Group.

Set Default: 
· Sales Default: Highlight a Tax Group and click on this button.  Select ‘Sales’ from the

drop-down.  This Tax Group will prefill the screen when creating a new Customer but can
be amended in that screen if required.



71File

· Purchase Default: Highlight a Tax Group and click on this button.  Select ‘Purchasing’
from the drop-down.  This Tax Group will prefill the screen when creating a new Supplier
but can be amended in that screen if required.

5.2.3 Tax Matrix

This screen allows you to maintain Tax Matrices.  Within Ostendo:
· Customers and Suppliers are given a Tax Group.  
· Items, Descriptors and Labour Codes are also given a Tax Group.
· The combination of the Customer or Supplier’s Tax Group and the Item, Descriptor or

Labour Code’s Tax Group is linked to a date-effective Tax Code  to determine a Tax
Rate.  

This table enables you to define this relationship.

Entry and Display fields

Customer/Supplier Tax Group: From the drop-down list select the Tax Group that applies to
Customers and/or Suppliers.

Items/Descriptor Tax Group: From the drop-down list select the Tax Group that applies to Items,
Descriptors or Labour Codes.

Tax Code: From the drop-down list select the Tax Code that will apply to this relationship

Effective From: From the drop-down calendar identify the date from which this Tax Rate will
become effective.

To determine which Tax Code to use Ostendo will extract the Customer/Supplier Tax Group and
the Item/Descriptor Tax Group and - for the date entered - extract the effective Tax Code

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Tax Matrix screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Tax Matrix.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Tax Matrix.

5.2.4 Payment Methods

This screen allows you to maintain Payment Methods, which are used to record the method by
which a payment was made by a Customer.  

Entry and Display fields
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Method: Enter the Method (Example: TT, DC, Cash, etc).  Duplicates not allowed.

Description: Enter a short description of the Method.  No checks are made on this entry

Available in POS: If this is ‘checked’ then this payment method is used in the Point of Sale
function

Rounded in POS: When used in Point of Sales the Payment Method may be ‘rounded’.  This
specially applies to cash style sales where, in some countries, the currency uses (say) dollars and
cents and this is used for electronic transactions.  However, for Cash Transactions, the Sales total
is rounded to a specified value (+ or -).  Whenever this checkbox is ‘checked’ you should also
specify the rounding factors in the POS Rules 

Bank Account: From the drop-down list select the Bank Account into which this payment method
is to be banked.  Bank Accounts are maintained via File>Financial Configuration>Payment
Accounts

Finance Charge: Against the Payment Method you can define if any Finance Charge will be
applied.  If Finance Charges are to be applied for this Payment Method then select the Finance
Charge Style from the drop-down list.   The Options are:

· Fixed Percentage: The percentage entered into field Charge %
· Fixed Amount: The Finance Charge amount will be manually entered into the appropriate

screen
· No Charge: Finance Charges do not apply

Charge %: Only available if the Finance Charge Style is 'Fixed Percentage' or 'Fixed Amount'.
Enter the percentage or amount value that will be applied

POS Sequence: Enter the Sequence Number to define the order in which you want Ostendo to
display the Payment buttons in the 'POS Payment' panel.

Image: From the drop-down list select the Image that you want to be displayed in the Payment
button in the 'POS Payment' panel.

Available in Mobility : Tick this box if this Payment Method is available when using Freeway app
to collect payments.

Default Banking Method : Either Directly to Account or Using Bank Deposit.

POS Banking Method : This is the banking method used specifically when taking payments via
Freeway.

Restrict to POS Site : Ticking this will restrict this Payment Method to be used for the site
specified in the next field.

POS Site : The site that this Payment Method is restricted to.

Script Name : A script can be linked to the Payment Method. Example - Tyro EFTPOS integration.
(Refer to Tyro EFTPOS Setup Guide pdf in : TYRO EFTPOS Pack ).

Script TimeOut (Seconds) : Set the timeout duration for the script.

Method Status : Either Active or InActive. Payment Methods can now be set as inactive when no
longer in use.

http://ostendo.info/downloads/ostendo/TYRO_EFTPOS_PACK.zip
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Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Payment Method screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Payment Method.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Payment Method.

5.2.5 Payment Method Denominations

This screen allows you to define the denominations (if any) that apply to a Payment Method.  For
example the accepted denomination for ‘Cash’ may be 10cents, 20cents, 50cents, 1 dollar, 5
dollars, etc.   This will allow the user to identify the coinage in each denomination during ‘End Of
Day’ transactions in Point of Sale

List Tab

Display fields

Method: The name of the payment method as entered into the ‘Payment Methods’ screen.  This
cannot be added, amended, or deleted in this screen 

Description: Description of the Payment Method as entered in the Payment Method screen

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Buttons

Close: This will close the Payment Methods Denominations screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry and maintenance of Denominations
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Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Denomination Name: Enter the name by which you know the denomination (Example 10 Cents,
50 Pence, 5 Dollars, etc.   Duplicate Denomination Names are not allowed

Value: Enter the Value of the Denomination Name.  For example:
10 Cents = .10
One Pence = .01
Five Dollars = 5.00

The End of Day function will multiply the counted coinage by this value to arrive at a total ‘cash-up’
value

Buttons

Close: This will close the Payment Methods Denominations screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Denominations

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current highlighted record

5.2.6 Payment Accounts

This screen allows you to maintain Payment Accounts, which are used to record the Bank Account
into which the Customer payment is to be deposited.  

Entry and Display fields

Code: Enter the Bank Account Code of your payment receipts.  Duplicates not allowed.

Description: Enter a short description of the Bank and type of Account.  No checks are made on
this entry

Cost Centre: From the drop-down list select the Cost Centre into which the payment will be made.
Cost Centres are maintained via General>Cost Centres.

Currency Code: From the drop-down list select the Currency Code that applies to this Payment
Account if it is not your local currency.  Currency Codes are maintained via File>Financial
Configuration>Currency Codes.

Data Display Options
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Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Payment Accounts screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Payment Account.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Payment Account.

5.2.7 Credit Terms

This screen allows you to maintain Credit Terms.  These Terms are applied to both Customers
and yourself when linked to a Supplier.

Entry and Display fields

List Panel

Term Name: Display only field showing the name of the Terms as entered into the ‘Detail’ tab

Description: Display only field showing a description of the Terms

Term Days: Display only field showing number of days from the ‘Days From’ parameter that
defines when the payment is due.

Days From: Display only field showing when payment is due.  The displayed options are:
· Invoice Date
· End of Month
· End of Next Month

Early Discount: Display only checkbox showing if an early payment discount is applied to these
terms.

External Term Name: Display only field showing the name of the associated Term (in the linked
Accounting System) as entered into the ‘Detail’ tab

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Credit Terms screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.



76 Ostendo Reference Guide

Add: This will show a blank ‘Detail’ screen for entry of a new Credit Term.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current highlighted Credit Terms.

Set Default: Highlight a Credit Term and click on this button.   This will then become the default
Terms that will prefill the screen when creating a new Customer or Supplier.  The Terms can be
amended in those screens and made specific to the Customer or Supplier.

Detail Panel

This screen enables you to maintain Credit Terms as follows:

Term Name: Access is only allowed during an ‘Add’ transaction.  Enter a name for the Terms
(example: Nett 30, EOM, 20th Next, etc).  Duplicate Names not allowed.

Description: Enter a short description of the Term.  No validity checks are carried out.

Term Days: Enter the number of days from the ‘Days From’ definition when the payment is due.

Days From: From the drop-down list select the time from which the ‘Term Days’ will be applied.
The options are:

· Invoice Date
· End of Month
· End of Next Month

Early Payment Discount Applies: If you are offering an early payment discount against this Term
then ‘check’ this checkbox.  This will open the following 3 fields for entry of the early payment
details.

Term Days: Enter the number of days from the ‘Days From’ definition up to which an early
payment discount will be given.  For example: If 10 days from ‘Invoice Date’ is entered then any
payment prior to the 10 days will benefit from the ‘Prompt Payment’ Discount.

Days From: From the drop-down list select the time from which the ‘Term Days’ will be applied.
The options are:

· Invoice Date
· End of Month
· End of Next Month

Payment Discount %: Enter the percentage amount of discount that will be given if the payment is
made within the Early Payment time period.

Notes: You can add extensive notes to this Credit Term.  Whenever you click on this field an icon
will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.  Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

Buttons

Close: This will close the Credit Terms screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.
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Add: This will show a blank ‘Detail’ screen for entry of a new Credit Term.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

5.2.8 Cut-Off Dates

This screen allows you to maintain Financial Cut-Off Dates, which are used to prevent entry of
transactions prior to that date.  The transaction areas covered are:

· Orders, Order Transactions and Inventory  
· Supplier Invoicing
· Customer Invoicing and Payments

Entry and Display fields

Orders, Order Transactions and Inventory: This parameter date is compared against activity
dates in Orders, Order Transactions and Inventory movements.  Any activity prior to this parameter
will not be allowed.  Maintain this date by keying directly, or selecting it from the drop-down
calendar.

Supplier Invoicing: This parameter date is compared against the Invoice Date in the Purchase
Invoicing screen and the Invoice Date is prior to this parameter the date will not be allowed. 
Maintain this date by keying directly, or selecting it from the drop-down calendar.

Customer Invoicing and Payments: This parameter date is compared against the Invoice Date
and Payment Dates in the Sales Invoicing, Customer Deposits, and Customer Payments screens
and if the Date is prior to this parameter the date will not be allowed.  Maintain this date by keying
directly, or selecting it from the drop-down calendar.

Buttons

Close: This will close the Cut-Off Dates screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current dates without exiting the screen

Cancel: Any changes made to a date since the last time the ‘Save’ Button was pressed will be lost
and the dates will revert to it’s pre-change position.

5.2.9 Aging Periods

This screen allows you to define Aging Periods, which are used in the Customer Aging Report.

Entry and Display fields

Aging Periods are calculated from: From the drop-down list select the option that determines the
Basis for aging.  The options are:

· Invoice Date
· Due Date
· Monthly
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Aging Period: This is not applicable to Monthly Aging periods as that uses Calendar Months.  For
Invoice Date and Due Date aging four fields are displayed.  The Basis Date is compared against
the nominated date at which the Aging is being carried out to determine the period in which the
payment is due/overdue

Period 1 Starts at the Basis Date defined by the entry above
Ends at the Basis Date + (Number of days in Period 2 - 1)

Period 2 Starts at the Basis Date + Number of days in Period 2
Ends at the Basis Date + (Number of days in Period 3 - 1)

Period 3 Starts at the Basis Date + Number of days in Period 3
Ends at the Basis Date + (Number of days in Period 4 - 1)

Period 4 Includes everything in the Basis Date + Number of days in Period 4

Buttons

Close: This will close the Aging Periods screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current dates without exiting the screen

Cancel: Any changes made to a date since the last time the ‘Save’ Button was pressed will be lost
and the dates will revert to it’s pre-change position.

5.2.10 Statement Periods

This screen allows you to define Aging Periods, which are used on the Customer Statement.

Entry and Display fields

Statement Periods are calculated from: From the drop-down list select the option that
determines the Basis for aging.  The options are:

· Invoice Date
· Due Date
· Monthly

Statement Period: This is not applicable to Monthly Aging periods as that uses Calendar Months.
For Invoice Date and Due Date aging four fields are displayed.  The Basis Date is compared
against the nominated date at which the Aging is being carried out to determine the period in which
the payment is due/overdue

Period 1 Starts at the Basis Date defined by the entry above
Ends at the Basis Date + (Number of days in Period 2 - 1)

Period 2 Starts at the Basis Date + Number of days in Period 2
Ends at the Basis Date + (Number of days in Period 3 - 1)

Period 3 Starts at the Basis Date + Number of days in Period 3
Ends at the Basis Date + (Number of days in Period 4 - 1)

Period 4 Includes everything in the Basis Date + Number of days in Period 4

Buttons

Close: This will close the Statement Periods screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Save: This will save the current dates without exiting the screen

Cancel: Any changes made to a date since the last time the ‘Save’ Button was pressed will be lost
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and the dates will revert to it’s pre-change position.

5.2.11 Currency Codes

This screen allows you to define currency codes and maintain ongoing exchange rates against
each code.  The Currency Code routine has three screens:

List: showing the Currency Codes that are in Ostendo
Detail: The Currency Code maintenance screen
Rates: For entry of exchange rates

List Tab

Display fields

The displayed fields are taken from the Currency Code details entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Currency Codes screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Currency Code

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Currency Code from this table

Related: This will bring up a list of functions that are related to Currency Codes.  
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Reports: This will bring up a list of Reports that are related to the Currency Code.  You can
immediately run the report whilst still remaining in the Currency Code screen.

Detail Tab

Entry and Display fields

Currency Code: Enter the Currency Code.  This is normally 3 characters and duplicate codes are
not allowed.  For your information here are a few of the more common currencies and the
International Codes relating to them

AED United Arab Emirates Dirham 
AUD Australian Dollar 
CAD Canadian Dollar 
CHF Swiss Franc 
CNY Chinese Yuan Renminbi 
EUR Europe
GBP British Pound 
HKD Hong Kong Dollar 
INR Indian Rupee 
JPY Japanese Yen 
NZD New Zealand Dollar 
RUB Russian Rouble 
SGD Singapore Dollar 
THB Thai Baht 
USD US Dollar 
ZAR South African Rand 

Symbol: Enter the Currency Symbol that represents this currency.  Here are a couple of ways to
enter the Currency Symbol if the symbol is not on your keyboard

1.  Go into Microsoft Word and select 'Insert' on the top toolbar.  In the dropdown list select ‘
Symbol’.  You can now select the symbol and ‘Insert’ into the word document.  From there you can
copy the symbol and paste it into this field

2.  Set your keyboard with ‘Numerics Lock’.  Using the enabled numbers due to the Numerics Lock
being on (I.e. NOT the numbers 0 to 6 on the top row of the keyboard) you should place the cursor
where the symbol is to appear and then - holding down the ‘Alt’ key - enter

0128 for the Euro (€)
0163 for the Pound (£)
0165 for the Yen (¥)

Description: Enter a short description of the Currency.  No checks are carried out on this entry.

Foreign Purchase Receipts: From the drop-down list select the Cost Centre that will be used for
the Purchase Receipt Cost for the above Currency.

Foreign Debtors Control: From the drop-down list select the Cost Centre that will be used for the
Debtors Control Account for the above Currency.  

Foreign Debtors Exchange: From the drop-down list select the Cost Centre that will be used for
the Exchange Account in MYOB for the above Currency.

Foreign Unapplied Deposits: From the drop-down list select the Cost Centre that will be used for
the Unapplied Deposits for the above Currency.  
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Foreign Unapplied Payments: From the drop-down list select the Cost Centre that will be used
for the Unapplied Payments for the above Currency.  

Foreign Discounts Given: From the drop-down list select the Cost Centre that will be used for
Discounts Given for the above Currency.  

Foreign Payment Rounding: From the drop-down list select the Cost Centre that will be used for
Payment Rounding for the above Currency.  

Exchange Gain or Loss: From the drop-down list select the Cost Centre that will be used for
Exchange Rate Gain or Loss for the above Currency.  

Foreign Payment Charge: From the drop-down list select the Cost Centre that will be used for
additional Finance Charges for the above Currency.  

Multi-Site Cost Centres (Button): If you click on this button you will be taken to a separate
screen for entry of Cost Centre Codes covering Multi-Currency by Site using the above
Transaction Types

Notes: Extended Notes held against this record as entered in the ‘Detail’ screen 

Buttons

Close: This will close the Currency Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Currency Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not active in this view

Related: This will bring up a list of functions that are related to the Currency Code.  You may open
and maintain information in those screens whilst still remaining in the Currency Code screen.

Reports: This will bring up a list of Reports that are related to the Currency Code.  You can
immediately run the report whilst still remaining in the Currency Code screen.

Rates Tab

Entry and Display fields

Rate Type: From the drop-down list select the Rate Type.  The options are:

Fixed Term: The Exchange Rate will be effective within the date range.  A Fixed Term
Rate always takes preference over a Floating Rate.
Floating: The Exchange Rate will be effective from the ‘Effective From’ date and will
supercede a ‘Floating’ Rate containing a prior ‘Effective From’ date

Effective From: From the drop-down calendar select the effective start date when this exchange
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rate becomes effective

Effective To: This is only active for ‘Fixed Term’ Rate Types.  From the drop-down calendar select
the effective start date when this exchange rate becomes effective

Exchange Rate: Enter the Exchange Rate that will convert from your home currency to the foreign
currency.  For example, if this currency was AUD and your home currency was NZD and the
exchange rate was 1 NZD = 0.8 AUD then you should enter 0.8

Buttons

Close: This will close the Currency Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Rate

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Currency Rate record

Related: This will bring up a list of functions that are related to the Currency Code.  You may open
and maintain information in those screens whilst still remaining in the Currency Code screen.

Reports: This will bring up a list of Reports that are related to the Currency Code.  You can
immediately run the report whilst still remaining in the Currency Code screen.

5.2.11.1 Multi-Site Cost Centres

This screen is accessed from the Currency Code – Detail screen and allows you to define specific
Multi-Currency Cost Centre Codes by Site

Display fields

Site Name: From the drop-down list select the specific Site against which this mapping will apply.
Company Sites are maintained via General>Company Sites

Transaction Type: From the drop-down list select the specific transaction against which the
mapping will apply.  Transaction Types are pre-defined in Ostendo and represent the activities that
make up a financial Journal

Currency Code: From the drop-down list select the specific Currency against which the mapping
will apply.  Currency Codes are maintained via File>Financial Configuration>Currency Codes

Cost Centre Code: From the drop-down list select the Cost Centre that will apply to the
Site/Transaction/Currency combination.  Cost Centres are maintained via General>Cost Centres.

Buttons

Close: This will close the Multi-Site Cost Centre mapping screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Company Site Currency Mapping
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record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to a date since the last time the ‘Save’ Button was pressed will be lost
and the dates will revert to it’s pre-change position.

Delete: This will delete the current highlighted record

5.2.12 Cost Centre Mapping

To facilitate basic Accounting functions Ostendo is pre-set with defaults.  This enables any user to 
‘Load and Go’ and immediately have information necessary to fully integrate with their existing
Accounting System.  Ostendo also allows for a more complex Accounting structure if required.

The basic accounting functions are listed here and each is linked to a Cost Centre (Costs Centres
are user-maintained via General>Cost Centres).  Cost Centres are then linked to the specific Chart
of Accounts structure required by your current Accounting System

Accounting Areas

Stock: All Stock across all Warehouses and Locations in your Company’s Inventory is kept against
this Cost Centre.  If a Warehouse is allocated a specific Cost Centre then that will be used in
preference to this default.

Stock Adjustment Variance: Stock Adjustments are ‘received from’ or ‘issued to’ a Cost Centre.
This Cost Centre provides a global place for ‘posting’ the Costs from this function

Negative Stock Variance: Stock adjustment variances can occur whenever you receive Stock but
the current stock levels are negative.  In this case the Average Cost for the Item is not amended
but the difference between the Average Cost and the Cost of this receipt is ‘posted’ to this Cost
Centre

Revaluation of Stock Variance: Whenever the Stock is re-valued  (Standard Cost or Average
Cost) the difference between the old value and the new value is ‘posted’ to this Cost Centre

Stock Count Variance: Stock variances (plus or minus) as a result of a Stock Count are ‘posted’
to this Cost Centre.  

Stock In Transit: Whenever Stock is moved from one Warehouse to another via the Inventory
Transfer routine this Cost Centre will be used for that transfer.

Receipt Cost Var: Used if the Inventory Costing method is ‘Standard Costing’.  In that instance
this stores the cost difference between the Assembly Order actual Cost and the Standard Cost of
the Item.

Descriptor Expenses: This is the default Cost Centre used by Descriptors.  It can be amended at
Descriptor level to another Cost Centre and made specific to that Descriptor.   This Cost Centre is
then used as the ‘allocated’ Cost Centre during Purchase Receipts.

Catalogue Expenses: This is the default Cost Centre used by Supplier Catalogue Items.  This
Cost Centre is used as the ‘allocated’ Cost Centre during Purchase Receipts.  If a Supplier
Catalogue is allocated a specific Cost Centre then that will be used in preference to this default.

Warranty Costs: Where a Job Issue has it’s ‘Actual Issue’ allocated to a Charge Style of ‘
Warranty’ then the costs are ‘posted’ to this Cost Centre
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Contract Costs: Where a Job Issue has it’s ‘Actual Issue’ allocated to a Charge Style of ‘Contract’
then the costs are ‘posted’ to this Cost Centre

Direct Labour Costs: When an Employee Timesheet Transaction is made then the costs are ‘
posted’ to this Cost Centre

Fixed Labour Overhead Costs: When an Employee Timesheet Transaction is made then the
associated FOH costs - held against the linked Labour Code - are ‘posted’ to this Cost Centre

Variable Labour Overhead Costs: When an Employee Timesheet Transaction is made then the
associated VOH costs - held against the linked Labour Code - are ‘posted’ to this Cost Centre

Purchases Received Not Invoiced: For any Purchase Orders that have been received via the ‘
Purchase Order Receipts’ function are held in this Cost Centre until they have been ‘matched’ in
the ‘Purchase Order Invoicing’ screen 

Purchase Price Variance: Purchase Orders received via the ‘Purchase Order Receipts’ function
contain a Purchase Price and this is ‘posted’ at that time.  When it is matched against the ‘
Purchase Order Invoicing’ there may be a Price difference.  This difference is posted to this Cost
Centre.  

Creditors: Whenever a Purchase Invoice is received then the amount of that Invoice is ‘posted’ to
this Cost Centre.  

Assembly Work In Progress: For any Issues (Material, Labour, Descriptors, etc) that have been
issued to Work In Progress for an Assembly Order the cost of that issue is ‘posted’ to this Cost
Centre.  Note: The cost of the Assembly Order is taken out of this Cost Centre whenever the
Assembly Order is received into Inventory

Assembly Order Variance: If the Assembly Order has been completed and its status is ‘Closed’
then any subsequent Issues or Bookings to this Order will go direct to this Cost Centre rather than
the Assembly Work In Progress Cost Centre.

Job Work In Progress: For any Issues (Material, Labour, Descriptors, etc) that have been issued
to Work In Progress for a Job Order the cost of that issue is ‘posted’ to this Cost Centre.  Note:
The cost of the Job Order is taken out of this Cost Centre whenever the Job Order is Invoiced.

Job Cost Of Goods Sold: Any Invoice raised against the Job Order will take the cost of the
Invoice out of the ‘Job Work In Progress’ Cost Centre and add it to this Cost Centre.

Job Cost Variance: If the Job Order is ‘Closed’ then any subsequent Issues or Bookings to this
Order will go direct to this Cost Centre rather than the Job Work In Progress Cost Centre. 

Job Income: Any Income received that has been applied to a Job Invoice Line will be ‘posted’ to
this Cost Centre.  

Sales Lines Picked: Whenever a Sales Order Line is ‘Picked’ the cost of that line is moved from
the source Cost Centre (Example: ‘Stock’ Cost Centre for Inventory Items) and moved to this Cost
Centre.

Sales Cost Of Goods Sold: Whenever a Sales Order Line is ‘Invoiced’ the cost of that line is
moved from the ‘Sales Line Picked’ Cost Centre to this Cost Centre.

Sales Income: Any Income received that has been applied to a Sales Invoice Line will be ‘posted’
to this Cost Centre.  



85File

Sales Freight: Any Income received that covers Freight and has been applied to an Invoice will
be ‘posted’ to this Cost Centre.  

Debtors: Whenever an Invoice (or credit) is raised then the amount of that Invoice is ‘posted’ to
this Cost Centre.  Whenever a Deposit or Payments is matched to an Invoice then it is moved from
this Cost Centre to the above Sales Invoice, Sales Freight, and Sales tax Cost Centres.

Contract Income: Any Income received that has been applied to a Contract Invoice Line will be ‘
posted’ to this Cost Centre.  Until it is ‘posted’ the income will reside in the ‘Unapplied Deposits’ or ‘
Unapplied Payments’ Cost Centres

Deferred Cost Of Goods: The value of any Retention amount raised against a Job Order Invoice
will take the cost of the Retention out of the ‘Job Work In Progress’ Cost Centre and add it to this
Cost Centre.

Deferred Income: This is only used in ‘Progress Claim’ environments that have an Invoicing
Schedule where the specific scheduled Invoice has an Accounting Style of ‘Income Deferred’. This
provides facility to have this type of Income deferred for future P & L recognition.

Deferred Freight: This is only used in ‘Progress Claim’ environments that have an Invoicing
Schedule where the specific scheduled Invoice has an Accounting Style of ‘Income Deferred’. This
provides facility to have this type of Freight deferred for future P & L recognition

Deferred Tax: This is only used in ‘Progress Claim’ environments that have an Invoicing Schedule
where the specific scheduled Invoice has an Accounting Style of ‘Income Deferred’. This provides
facility to have this type of Tax deferred for future P & L recognition

Un-Applied Deposits: Deposits received from a Customer will be ‘posted’ to this Cost Centre.
When they are applied to an Invoice they will be moved to the ‘Sales Income’ Cost Centre

Un-Applied Payments: Payments received from a Customer will be ‘posted’ to this Cost Centre.
When they are applied to an Invoice they will be moved to the ‘Sales Income’ Cost Centre

Bank: Upon validation that the Payment was banked (Deposit Slip status updated to ‘Banked’ then
the amount is transferred from the ‘Undeposited Funds’ Cost Centre and ‘posted’ to this Cost
Centre

Payment Rounding: If the ‘matched’ payment amount is within a ‘Rounding Tolerance’ entered in
that screen then the Payment record status is amended to ‘Fully Applied’.  The actual value of the
Rounded amount is ‘posted’ to this Cost Centre, 

Discounts Given: If a Discount Amount is entered during Payment Matching (Example: ‘Prompt
Payment’ discount) then the value of this discount is ‘posted’ to this Cost Centre.

Undeposited Funds: If you are using Bank Deposit Slips to bank payment receipts then the initial
receipt will be ‘posted’ to this Cost Centre prior to transfer to the Bank Account 

POS End of Day Variance: Whenever a 'Z' Report is printed from the End Of Day processing in
the Point of Sales function than if the Till Balance is at variance to the expected balance then the
difference is posted to this Cost Centre  

POS Shop Expenses: Whenever a Cash withdrawal or deposit is made within the POS function
then the amount Withdrawn/Deposited is held in this Cost Centre

Exchange Loss or Gain: Any Loss or Gain made from Foreign Currency Transactions is held in
this Cost Centre
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Assembly Cost Variance: If you are using Standard Costing then the difference between the
Standard Cost of the Receipt and the actual WIP Cost of the Item is posted to this Cost Centre

Payment Charge: If a Charge has been applied to a Customer Payment (Example:- Credit Card
charge) then that charge will be posted to this Cost Centre

Buttons

Close: This will close the Cost Centre Mapping screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Save: This will save the current dates without exiting the screen

Cancel: Any changes made to a date since the last time the ‘Save’ Button was pressed will be lost
and the dates will revert to it’s pre-change position.

5.2.13 Cost Centre Mapping by Site

This screen allows you to define Cost Centres by Company Site whenever you wish to segregate
designated Account Codes by Site.   If the Site specific Cost Centre allocation is not entered here
then Ostendo will use the base Cost Centre as entered into the Cost Centre Mapping screen

Display fields

Site Name: From the drop-down list select the specific Site against which this mapping will apply.
Company Sites are maintained via General>Company Sites

Transaction Type: From the drop-down list select the specific transaction against which the
mapping will apply.  Transaction Types are pre-defined in Ostendo and represent the activities that
make up a financial Journal

Cost Centre Code: From the drop-down list select the Cost Centre that will apply to the
Site/Transaction combination.  Cost Centres are maintained via General>Cost Centres

Buttons

Close: This will close the Cost Centre Mapping screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Company Site Mapping record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to a date since the last time the ‘Save’ Button was pressed will be lost
and the dates will revert to it’s pre-change position.

Delete: This will delete the current highlighted record

5.2.14 Sales Mapping Matrix

Whereas the Cost Centre Mapping screen provides a ‘Load and Go’ option, this screen extends
that basic functionality and allows a User to establish a more detailed structure covering the Sales
area.  It consists of a hierarchical structure using

1 - Currency
2 - Invoice Customer Type
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3 - Invoice Customer Region
4 - Order Customer Type
5 - Order Customer Region
6 - Order Class
7 - Order Type
8 - Sales Order Person
9 - Category

And mapping them to 
· Income Cost Centre
· Cost of Goods Cost Centre

In the above matrix the level 9 (Category) takes the most significant whereas Level 1 (Currency)
takes the least significant.  For example:

If there are two mapping records containing:

· Category/Order Type/Order Class/Order Customer Type (I.e. Levels 9/7/6/4)
· Category/Sales Order Person/Order Customer Region (I.e. Levels 9/8/5)

The second mapping record would take priority over the first. 

Entry and Display fields

Currency: From the drop-down list select the Currency to be used that relates to this Mapping

Site Name: From the drop-down list select the Site Name to be matched against the Site  Name
held against the signed-in User (via File>System Configuration>User Security and Options). 

Invoice Customer Type: From the drop-down list select the Customer Type to be matched
against the Customer Type held against the Invoice Customer (I.e. the Billing Customer)

Invoice Customer Region: From the drop-down list select the Region to be matched against the
Customer Region held against the Invoice Customer (I.e. the Billing Customer)

Order Customer Type: From the drop-down list select the Customer Type to be matched against
the Customer Type held against the Order Customer

Order Customer Region: From the drop-down list select the Region to be matched against the
Customer Region held against the Order Customer

Order Class: From the drop-down list select the Order Class to be matched against the Order
Customer.  The options are:

· Sales Orders
· Job Orders
· Contract
· Direct Invoice

Order Type: From the drop-down list select the Order Type to be matched against the Order
Customer.  The available options in the drop-down are linked to the class of Order from where the
Invoice originated (I.e. the Order Class)

Order Category: If the Order Class selected above is 'Job Orders' then you can make a further
selection against the the Order Category.  From the drop-down list select the Order Category to be
matched against the value held against the Job Order Header
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Order Sales Person: From the drop-down list select the Sales Person to be matched against the
Order Customer.  

Category: From the drop-down list select the Category to be mapped against the Item, Descriptor,
or Labour Code’s Category at the Invoice Line level

Sub Category: From the drop-down list select the Sub Category to be mapped against the Item,
Descriptor, or Labour Code’s Category at the Invoice Line level

Code Type: From the drop-down list select the code type (Item/Descriptor/Labour) .

Code: From the drop-down list select the item/descriptor/labour code.

Mapped Cost Centres

The above matrix combination is now mapped to Income and Cost Of Goods Cost Centres.  Cost
Centres are maintained via General>Cost Centres.

Income Cost Centre: From the drop-down list select the Cost Centre that represents the Income
side of the Journal for this matrix combination.  

Cost Of Goods Cost Centre: From the drop-down list select the Cost Centre that represents the
COGS side of the Journal for this matrix combination.  

Buttons

Close: This will close the Sales Mapping Matrix screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Sales Mapping record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current Sales Mapping line from this table

Related: This will bring up a list of functions that are related to Sales Mapping.  You may open and
maintain information in those screens whilst still remaining in the Sales Mapping screen.

Reports: This will bring up a list of Reports that are related to Sales Mapping.  You can
immediately run the report whilst still remaining in the Sales Mapping screen. Sales Mapping

5.2.15 Labour Mapping Matrix

The Cost Centre Mapping screen provides a ‘Load and Go’ option where a User can run Ostendo
with basic requirements to fully integrate with their existing Accounting System.   

This screen extends that basic functionality and allows a User to establish a more detailed
structure covering the Labour Code area.  It consists of a hierarchical structure using

1 - Category
2 - Labour Code Department
3 - Employee Department
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4 - Labour Code
5 - Job type
6 - Employee

And mapping them to 
· Direct Labour Cost Centre
· Fixed OH Cost Centre
· Variable OH Cost Centre

In the above matrix the level 6 (Employee) takes the most significant whereas Level 1 (Category)
takes the least significant.  For example:

If there are two mapping records containing:

· Employee/Employee Department/Category (I.e. Levels 6/3/1)
· Employee/Labour Code/Category (I.e. Levels 6/4/1)

The second mapping record would take priority over the first. 

For Ostendo Freeway Subcontractors, the Labour Mapping Matrix should be used to map the
Labour Code used by the Subcontractor employee to the appropriate Cost Centre which is linked
to the Subcontractor Clearing Account in the General Ledger.

Entry and Display fields

Site Name: From the drop-down list select the Site to be used in the Employee Timesheet booking

Category: From the drop-down list select the Category to be matched against the Labour Code
used in the Employee Timesheet booking

Labour Code Department: From the drop-down list select the Department to be matched against
the Labour Code used in the Employee Timesheet booking

Employee Department: From the drop-down list select the Department to be matched against the
Employee linked to the Timesheet booking

Labour Code: From the drop-down list select the Labour Code to be matched against the Labour
Code linked to the Employee’s Timesheet booking

Employee: From the drop-down list select the Employee to be matched against the Employee
making the Timesheet booking

Mapped Cost Centres

The above matrix combination is now mapped to Cost Centres.  Cost Centres are maintained via 
General>Cost Centres.

Direct Labour Cost Centre: From the drop-down list select the Cost Centre that will be used for
the Direct Labour content of the Employee Booking

Fixed OH Cost Centre: From the drop-down list select the Cost Centre that will be used for the
Fixed Overhead content of the Employee Booking

Variable OH Cost Centre: From the drop-down list select the Cost Centre that will be used for the
Variable Overhead content of the Employee Booking
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Buttons

Close: This will close the Labour Mapping Matrix screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Labour Mapping record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current Labour Mapping line from this table

Related: This will bring up a list of functions that are related to Labour Mapping.  You may open
and maintain information in those screens whilst still remaining in the Labour Mapping screen.

Reports: This will bring up a list of Reports that are related to Labour Mapping.  You can
immediately run the report whilst still remaining in the Labour Mapping screen.

5.2.16 External GL Codes

This screen enables you to enter General Ledger Codes from your related Accounting System. 
This can then be used to cross-link Ostendo’s Cost Centres to these GL Codes so that any
Financial Transaction outputs can directly state the GL Code rather than Ostendo’s Cost Centres

Entry and Display fields

Ledger Code: Enter the General Ledger Code as held in the linked Accounting System’s
database.  No checks are made on this entry.

Description: Brief Description of the above General Ledger Code.  No checks are made on the
entry  

Classification: You may enter the classification of each external General Ledger code (e.g.
Income, COGS).   You should note that this field is automatically populated when the Ledger
codes are from Xero, MYOB Accountright Live or Moneyworks.

Buttons

Close: This will close the External GL Codes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new GL record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the GL Code from this list
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5.2.17 General Ledger Settings

This screen allows you to record all the data required to work with the respective Accounting
Systems’ API (e.g. Xero, MYOB Account Right Live, MoneyWorks, etc.). Setting up this record
correctly is pre-requisite to enabling the link to the accounting package.

Entry & Display Fields

Accounting Link:  This drop-down allows you to select the Accounting System you are linking to.

URL or Path:  This is the URL required when GETting or POSTing data to the linked Accounting
system. 
Common Connection: If Accounting Link is Sage Evolution Live, then this replaces the URL or
Path. 

Username:  This is the Username required for access to the company file in the Accounting
System. (Not required for Xero)

Password:  Password required to the company file in the Accounting System. (Not required for
Xero)

API Token:  Consumer Key required for access to Xero.

Private Key:  The name of the privatekey file used for authentication when accessing Xero.   This
file must be stored in the Ostendo folder.  (Note:  If Accounting Link is Sage Evolution Live, then  
Database Connection replaces the Private Key)

Version:  This is a display-only field. It shows the Ledger Script version number you are using.

DebugMode:  Tick this box if you want to save a debug file to the Ostendo folder each time a
batch of financial records are posted to the Accounting system.

Database Path:  This is a display-only field. It shows the actual path of the Ostendo database that
this link is set up for.

Buttons

Close: This will close the General Ledger Settings screen.

Add:  This allows you to add a new General Ledger Settings record. You need just one record.

Save:  This will save the current data without exiting the screen.

Cancel:  Any changes made since the last time the ‘Save’ Button was pressed will be lost.

Delete:  Deletes the General Ledger Settings record.

Set Default:  Sets the current record as the default General Ledger Settings record.

Connect:  This button allows you to test the connection to the Company File in the Accounting
system.  Use this button after you have loaded all the scripts using the Update button.

Import:  This button is a drop-down menu to enable you to import General Ledger Codes,
Customers, and Suppliers from the Accounting system into Ostendo.

Export:  This button is a drop-down menu to enable you to export Customers and Suppliers from
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Ostendo to the Accounting system.

Update:  Press this button when you are creating a new General Ledger Settings record. This
loads or updates all the scripts required for the Accounting Link. 

Setup:  This button will appear only if you are linking to MYOB AccountRight Live (Cloud or
Desktop). Pressing this button will help you populate the above General Ledger Settings fields via
a series of prompts.

5.3 Reporting Configuration

5.3.1 Report and View Developer

The Report and View Developer allows you to create and/or amend Reports, Inquiry Screens,
Analysis Views, Charts, and Pivot Views within Ostendo and include these in the Ostendo Menu
structure.

The steps taken when generating a new Report, Inquiry Screen, View, Chart, or Pivot are as
follows:

· Define the Style of the output and where it is to appear in the Menu Structure
· Define the Data to be extracted to produce the output
· Define the Parameters to be used when running the report
· If it is a Report then create the Report output format

In generating a new Report, Inquiry Screen or View, or copying an existing one, you should note:

· System Reports and Views Ostendo contains a base folder of reports that are held
under Ostendo sub-folder ‘Reports’.  These reports and views are maintained and updated
by Development-X and cannot be amended by the end user.

· Customer Reports, Inquiry Screens and Views An Ostendo user can create their own
Report, Inquiry Screen or View by either (a) Creating a new Report (Inquiry Screen or
View) ‘from scratch’, or (b) Copying a ‘System’ level Report, Inquiry Screen or View and
amending it as required.  In both cases the new report, screen or view will be created and
held in an Ostendo sub-folder whose name will be the current signed on Company.

· Reporting Priority Whenever the Report, Inquiry Screen or View is called in normal ‘
day-to-day’ activity Ostendo will first look into the ‘Company’ folder to get the document.  If
it does not exist in that folder then the base Ostendo Report, Inquiry Screen or View will be
used.
For Reports only, if you wish to make a Report that is User-Specific then create a
sub-folder under the 'Company' folder whose identity is the The User Name.  Save the
specific Report in that folder.  Ostendo will then refer to this folder for an existing report
prior to looking in the Company Folder.

NB: Update 237 initially introduced an Upgraded Report Writer. As this new Report Writer has
features within it that did not exist in the prior versions it is strongly recommended that reports
created / modified in either 237 or 238 are not moved to databases running prior to 237. If you
need to create or modify a report for an Ostendo database running a version prior to 237, ensure
you do this against an earlier version of Ostendo prior to 237.

List Tab
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The displayed fields are taken from the Report or View record.   

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Displayed Fields

Category - The Category to which the Report belongs as entered in the ‘Master Settings’ tab.

Name: Display only field showing the name of the Report, Analysis, Chart, or Pivot View

Type: Display only field showing the Type of Output.  The displayed variants are:
Report
Analysis
Chart
Pivot
Inquiry
Edit View

Level - The entry Level at which the Report was created.  The options are:
System: Reports generated by Development-X. 
Company: Reports generated by the end user.  ‘System’ level reports can be copied and
saved as ‘Company’ Level reports.  Company Level Reports take priority over a System
Level report if it has the same Report Name

Menu Order: Display only field showing the sequence number that dictates where this Report will
appear in a drop-down list

Master SQL: Display only field showing main data extraction criteria using an SQL Query
(Structured Query Language) Statement as entered into the ‘Master Settings’ tab

Buttons

Close: This will close the Reports and Views Developer screen. 

Add: This will bring up a panel for defining the new Report, Inquiry Screen, Analysis, Chart, or
Pivot View.  You can create a new display ‘from scratch’ or copy an existing format.  In either case
it will create an output who’s ‘Level’ will be preset at ‘Company’.  On this panel the following fields
are available.

Create from Scratch: Select this Radio Button if you are going to generate the Report,
Analysis, Chart, Edit, or Pivot View from scratch.  The following two fields will be presented
which must be completed

Type: Select the Radio Button that represents the type of view being created.  The
options are:

Report
Analysis
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Chart
Pivot View
Inquiry
Edit View

Name: Enter the Name of the view.  Duplicate Names are not allowed
Copy from Another: Select this Radio Button if you are going to generate the Report,
Inquiry Screen, Analysis, Chart, Edit, or Pivot View by copying an existing view and using
that as a start point.  The following options are now presented

Output to be copied: From the drop-down list select the current Report, Inquiry
Screen, Analysis, Chart, Edit, or Pivot View that will form the basis of the new
report or view.  When selecting this option you can define what will happen to the
copied view as follows:

Copy to Company: Select this Radio Button to denote that the above ‘Output
to be Copied’ document will be created at 'Company' level.  This will produce a
'Company-Level' document of the same name in the ‘Company’ Reports folder
Add New To Company: Select this Radio Button to denote that the above ‘
Output to be Copied’ document will be used as the basis for creating a new
report or view.  The name of the new should be entered into the next field
Name: Mandatory entry if the ‘Add New To Company’ Radio Button has been
selected.  
Report File Name: Mandatory entry if the ‘Add New To Company’ Radio
Button has been selected.  Enter the name of the .fr3 Report if you are
copying an existing Report.  Once again Duplicate Report File Names are not
allowed

Save: Not applicable to the List View

Cancel: Not applicable to the List View

Delete: This removes the current Report, View, Chart, or Pivot from this table

Master Settings Tab

This panel is split into three sections:
· Definition: This allows you to define the specific attributes to the Report, Inquiry Screen,

View, Chart, or Pivot document. 
· Master Query:  This contains the master query that relates to the extracted data
· Conditions:  Allows you to define any parameters to be used

Section 1 - Definition

The fields in this section will vary depending upon the Type of report being generated

Reports

Include in Main Menu: ‘Check’ this checkbox if the Report is to appear in the ‘Reports’ section in
the Main Menu.  If this is checked then an entry is required in field ‘Category’ to denote under
which Main Menu Toolbar Category the Report is to appear.

Name: A mandatory entry where you should specify the name of the report.  This is the name that
will appear in the Menu drop-down lists.  Duplicate entries of the same name are not allowed. 

Menu Order: Enter a sequence number that dictates where this Report will appear in the
drop-down list in both the Main Menu and the Specific Screen.  No checks are made against this
entry and duplicates will not be rejected.
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Category: This is a mandatory selection in which you should select the Main Menu Category
under which this report will appear.  

Type: From the drop-down list select the style of Report being produced.  Ostendo has two distinct
templates to help get you started.  They are: 

· Report: A Report is generally a multi-page output containing an optional Report Heading
sheet containing the Report’s selection criteria

· Form: A Form is generally a single output that does not produce a Header sheet and is
usually linked to a single master record (Example, Invoice, Purchase Order, Job Sheet,
etc)

Specific Screen: An optional entry field where you can select a specific screen from the
drop-down list.  This informs Ostendo that, when in this specific screen, the ‘Reports’ button will
contain this Report in the drop-down list

Report File Name: The Report will be added to Ostendo’s list of reports using the name supplied
here.  The name should be unique and comprise of Alphas and/or Numerics with no spaces. 
Ostendo will allocate it an extension of .frf

Script Name: Scripting can be used in the Report Layout Editor to control printing options such as
printing fields under certain data conditions, etc.    The script is created as a 'Before Report' style
script via File>Scripting Configuration>Scripting Editor and is then selected from the drop-down list
in this field

Archive: 'Check' this checkbox if you wish Ostendo to automatically generate an archived copy of
the generated report.  The archived document that then be recalled and reprinted via File>Archive
Viewer

Archive Prefix: You can define the format of the archived document name.  This can be a
combination of plain text and fields taken from the Master Query (see below).  For example if this
was a Sales Invoice you may wish to name the archived document 'Invoice - INV1234' where the
word Invoice is open format text and INV1234 is the actual Invoice number
Therefore the entry in this field will be Invoice - [INVOICENUMBER].   Note: the Master Query field
is enclosed in 'Square Brackets'

Archive Folder Name: enter a Folder name under which this archived document will be located.
If this folder does not currently exist under Ostendo>Archive Files then it will be created.

Analysis Views

Include in Main Menu: ‘Check’ this checkbox if the View is to appear in the ‘Views’ section in the
Main Menu.  If this is checked then an entry is required in field ‘Category’ to denote under which
Main Menu Toolbar Category the View is to appear.

Name: A mandatory entry where you should specify the name of the View.  This is the name that
will appear in the Menu drop-down lists.  Duplicate entries of the same name are not allowed. 

Menu Order: Enter a sequence number that dictates where this View will appear in the drop-down
list in both the Main Menu and the Specific Screen.  No checks are made against this entry and
duplicates will not be rejected.

Category: This is a mandatory selection in which you should select the Main Menu Category
under which this View will appear.  

Master Key Field: If you wish to display the View into groups (Example: All BOM Components
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within a Parent Item) then you should identify the Key field by which the grouping is to be made 

Detail Key Field: If you wish to display the View into Sub-Groups within the above Master Key
Group then you should identify the Detail Key field by which the sub-grouping is to be made 

Title:  Enter a short name for the Analysis View.  This will appear as a title to the View whenever it
is run.  No checks are made on the entry

Mail Merge:  You have the option to print a document from within Ostendo where the  source data
can be merged with a Word document to produce printed forms containing data from both
sources.  For more information on how to achieve this refer to Help>Tutorials and select Mail
Merge.  

· Mail Merge Word Document:  Enter a document name (Example: SuppLetter) that will
become the Merge Template Document.

· Merge Data File:  Enter a file name (Example: SuppSource) that will become the Merge
Source Data.

Charts

Include in Main Menu: ‘Check’ this checkbox if the Chart is to appear in the ‘Views’ section in the
Main Menu.  If this is checked then an entry is required in field ‘Category’ to denote under which
Main Menu Toolbar Category the Chart is to appear.

Name: A mandatory entry where you should specify the name of the Chart.  This is the name that
will appear in the Menu drop-down lists.  Duplicate entries of the same name are not allowed. 

Menu Order: Enter a sequence number that dictates where this Chart will appear in the
drop-down list in both the Main Menu and the Specific Screen.  No checks are made against this
entry and duplicates will not be rejected.

Category: This is a mandatory selection in which you should select the Main Menu Category
under which this Chart will appear.  

Title:  Enter a short name for the Chart.  This will appear as a title to the Chart whenever it is run.
No checks are made on the entry

Pivots

Include in Main Menu: ‘Check’ this checkbox if the Pivot View is to appear in the ‘Views’ section
in the Main Menu.  If this is checked then an entry is required in field ‘Category’ to denote under
which Main Menu Toolbar Category the Pivot View is to appear.

Name: A mandatory entry where you should specify the name of the Pivot View.  This is the name
that will appear in the Menu drop-down lists.  Duplicate entries of the same name are not allowed. 

Menu Order: Enter a sequence number that dictates where this Pivot View will appear in the
drop-down list in both the Main Menu and the Specific Screen.  No checks are made against this
entry and duplicates will not be rejected.

Category: This is a mandatory selection in which you should select the Main Menu Category
under which this Pivot View will appear.  

Title:  Enter a short name for the Pivot View.  This will appear as a title to the Pivot View whenever
it is run.  No checks are made on the entry

Inquiry
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Include in Main Menu: ‘Check’ this checkbox if the Inquiry Screen is to appear in the ‘Inquiry’
section in the Main Menu.  If this is checked then an entry is required in field ‘Category’ to denote
under which Main Menu Toolbar Category the Inquiry is to appear.

Name: A mandatory entry where you should specify the name of the Inquiry.  This is the name that
will appear in the Menu drop-down lists.  Duplicate entries of the same name are not allowed. 

Menu Order: Enter a sequence number that dictates where this Inquiry will appear in the
drop-down list in both the Main Menu and the Specific Screen.  No checks are made against this
entry and duplicates will not be rejected.

Category: This is a mandatory selection in which you should select the Main Menu Category
under which this Inquiry will appear.  

Title:  Enter a short name for the Inquiry Screen.  This will appear as a title to the Inquiry whenever
it is run.  No checks are made on the entry

Edit View

Name: A mandatory entry where you should specify the name of the Edit View.  This is the name
that will appear in Custom>Edit View section of Ostendo.  Duplicate entries of the same name are
not allowed. 

Script Name: An optional field to specify the Script that will be used to control that  data entry/edit
function to the Edit View.  Select the Script from the drop-down list of 'Edit View' Style scripts. 

Style: Two Viewing Styles are available:
List Detail: displays records in a List panel in which you can select a line and go to a Detail
panel to maintain the record
Detail Grid: Where all the records and their fields are displayed in a single grid.  You may
maintain multiple record within this single grid.

Title:  Enter a short name for the Edit View.  This will appear as a caption to the View.  No checks
are made on the entry

Section 2 - Master Query

This is a mandatory entry and allows you to define the main data extraction criteria using an SQL
Query (Structured Query Language) Statement.  SQL Statements can range from simple to
complex. 
To generate your Query you can either key you Query directly in to this field or click on the ‘SQL
Builder’ Button.  This will bring a separate panel in which you have help in creating the query.  On
the displayed screen there are three panels

Tables - The names of all the Tables (database files) that are used by Ostendo
Fields - Having selected a specific Table this will show each field in that Table
Query - This is where you create and maintain the query as described below

You can enter a query in one of two ways
§ Type in directly
§ Create using ‘prompts’

To create using ‘prompts’ you can copy:-
§ Tables to the Query by selecting the table and either double clicking the left mouse

or clicking on the ‘Add Table to Query’ button
§ Fields to the Query by first selecting the correct Table then the field and either
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double clicking the left mouse or clicking on the ‘Add Field to Query’ button
§ Keywords to the Query by clicking the ‘Options’ button and selecting ‘Add Keyword’

and then selecting the appropriate keyword.    Available Keywords are Select, *,
Sum, Count, From, Where

§ Operators to the Query by clicking the ‘Options’ button and selecting ‘Add Operator’
and then selecting the appropriate Operator.   Available Operators are >, <, =. <>,
+, -, /

You should note that an Inquiry Screen SQL requires the the main Table's SYSUNIQUEID field to
be included

Section 3 - Conditions

This panel allows you to define selection criteria for use against that SQL.  These will be displayed
as parameter entry fields when running the Report, View, Chart, or Pivot.

There are six basic types of Conditions:
· Selection(s) from an Ostendo Table (Example: Job Order Number)
· Manual entry against which to compare data (Example: Date, entered text, etc)
· Condition(s) selected from pre-defined variables (Domains)
· Boolean Condition select (‘Yes’ or ‘No’)
· Multiple Select Options (Example: Select A,C and F from a list of A,B,C,D,E, and F)
· Select from any Table in Ostendo including User-Defined Tables

These conditions can be used as selection criteria to be made against both the Master Query and
nominated Detail Queries.  Examples are given below to show how you can apply conditions to the
Master Query.   For applying Conditions to Detail Queries see Section 4.

Condition 1 - Field Value Lookup

This Condition allows you to interrogate an Ostendo Table and select a specific value.  The format
of this type of parameter is DisplayName;Condition linked to a Condition Index where:

DisplayName is the text that you wish to appear on the parameter entry screen
Condition has three elements

Field Name: The specific field within the Table identified within the Master SQL
and ‘Condition Index’
Operator: The specific Operator that you wish to apply to this parameter.  The
Available Operators are >, <, =, <>, >=, <=
Identifier: Enter a unique identifier that you are assigning to this parameter.  For
example: if the parameter is the start range of Job Numbers then this could be
given an Identifier of ‘JobFrom’

Condition Index refers to the Table that contains the above Field Value.  Click on the
drop-down against field ‘Condition Indexes’ and select an Index in the 1000 range.  

Example for use against the Master Query: If you are creating a Job Orders Report then the
Master SQL will refer to the Table JOBHEADER.  This parameter represents the start range of
selected Job Numbers and will show - in a drop-down list - all Job Orders currently in Ostendo.  In
this instance the parameter could be:

Conditions: Job Order From;ORDERNUMBER>= :JOBFROM 
Condition Index: 1075 (Job Orders)

Condition 2 - Free Format Entry

This format allows the user to enter a specific value against a parameter.  The format of this type
of parameter is DisplayName;Condition linked to a Condition Index where:
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DisplayName is the text that you wish to appear on the parameter entry screen
Condition has three elements

Field Name: The specific field within the Table identified in the Master SQL
Operator: The specific Operator that you wish to apply to this parameter.  The
Available Operators are >, <, =, <>, >=, <=
Identifier: Enter a unique identifier that you are assigning to this parameter.  For
example: if the parameter is the start date of a range of Job Orders then this could
be given an Identifier of ‘DateFrom’

Condition Index refers to the style of Free Format entry.  The values are all within the
2000 range.  For example:

2001 - Open format area to store Text entries
2002 - Date format
etc

Example: If you are creating a Parameter that represents the start date of selected Job Orders
then the full line could be:

Conditions: Job Date From;ORDERDATE>=:DATEFROM
Condition Index: 2002 (Date)

Note: If you only require a single Condition with Operator linked to the manual entry then you can
simply create a Parameter Line as follows

Conditions: Job Date;ORDERDATE>=:SCREENPARAM
Condition Index: 2002 (Date)

Condition 3 - Multiple Select Option

Ostendo contains many tables that are User maintained.  For example: Job Types, Item
Categories, etc.  This parameter format allows you to nominate one of these tables from which you
can make one or more selections from the drop-down list

The format of this type of parameter is DisplayName;Parameters linked to a Condition Index
where:

DisplayName is the text that you wish to appear on the parameter entry screen
Parameters has five elements

First Parameter: The output fields in the Master SQL should contain a field
whose content is user defined in a lookup Table.  (Example: Field JOBTYPE in
table JOBHEADER).  
Second Parameter: Refers to the Look-Up Table Name equating the field name
in the previous Table.  (Example: Table JOBTYPES equates to the field JOBTYPE
in Table JOBHEADER) 
Third Parameter: This refers to the field name in the Look-up table whose data
will form the drop-down list.  (Example” Field ORDERTYPE in Table JOBTYPES)
Fourth Parameter: The drop-down list will be sorted in the sequence defined by
this field.  Normally this will be the same as the Third Parameter but can be any
other field in the ‘Look-Up’ table

Condition Index For Look-Up related parameters this is always 3000

Example: If you are creating a Parameter in which you want to select (say) the Order Type from
the Job Type Table when selecting record from a Job Header then the full line could be:

Conditions: Job Type;JOBTYPE;JOBTYPES;ORDERTYPE;ORDERTYPE
Condition Index: 3000

Condition 4 - Pre-Defined Variables (Domain)
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Within Ostendo there are many pre-defined variables (such as Job Status) and are referred to as ‘
Domains’.  This parameter format allows you to point to the ‘Domain’ tables and select the specific
Table from which a selection or selections can be made.  Note: During Parameter entry all entries
in the nominated Domain Name Table are displayed in a drop-down list.  You have the option to
make one or more selections from that list

The format of this type of parameter is DisplayName;Condition linked to a Condition Index
where:

DisplayName is the text that you wish to appear on the parameter entry screen
Condition has two elements

Identifier: Enter the field relating to the Domain Name For example: if the Domain
is ‘ORDER_STATUS’ then this would be ‘ORDERSTATUS’
Domain Name: The specific Domain Name.  There are around 550 Domain
Names in Ostendo 

Condition Index For Domain related parameters this is always 4000

Example: If you are creating a Parameter in which you want to select all Jobs of a Status then the
full line could be:
 

Conditions: Job Status;ORDERSTATUS;ORDER_STATUS
Condition Index: 4000

 
Condition 5 – Defined Table Option

This Condition statement allows you to refer to any Table in Ostendo from which you can make a
selection from a list of displayed records from that Table.  This would commonly be used when
selecting from User-Defined Tables

The format of this type of parameter is 

DisplayName;ParamDef;TableName;Fields;Captions;ReturnedField;OrderBy where:

DisplayName is the text that you wish to appear on the parameter entry screen
ParamDef has three parts:

KeyField is the field name in the Query from which you making the comparison
Condition is the condition that you are applying to the parameter
TheStoredValue is a unique reference that you give this selected parameter

TableName is the name in the Table containing your selection
Fields are the Field Names from the selected Table that you wish to be displayed
Captions are the names that equate to the Fields and will be displayed in the extracted
column headings
ReturnedField is the field in the selected Table from which data will be returned and
populate the above ‘DisplayName’ Variable
OrderBy is the sort order by which the selected records will be displayed

Condition Index For this style of Parameter entry this is always 5000

Example: If you are creating a Parameter in which you want to select a Drawing Number from a list
of Drawings created in your own User-Defined Table then the full line would be:

Conditions:
Drawing_Number;DrawingNumber=:DrawingNumber;OSTDEF_DRAWINGREGISTER;Dr
awingNumber;Drawing;DrawingNumber;DrawingNumber
Condition Index: 5000
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Condition 6 – User-Defined Selection Option

This Condition statement allows you to create user-defined values that will appear in a drop-down
list when run.  This is useful when used in conjunction with a User-Defined Table where the
variables are specified in the Edit View script.  It could also be used to restrict selections made
against base Ostendo Tables

The format of this type of parameter is DisplayName;Condition;Selections where:
DisplayName is the text that you wish to appear on the parameter entry screen
Condition has three elements

Field Name: The specific field within the Table identified within the Main Query
Operator: The specific Operator that you wish to apply to this parameter.  The
Available Operators are >, <, =, <>, >=, <=
Identifier: Enter a unique identifier that you are assigning to this parameter.

Selections Each possible selection is entered separated by a comma.  Note: If the
selection contains a space in its identity (Example - In Progress) then it must be
surrounded by double quote ("In Progress")

Condition Index This is always 6000

Example: If you have a User-defined Edit View that contains the following options (Planned, In
Progress, Complete) against field Status then this condition would allow you to select the specific
Status for output.  Therefore the condition would be::

Conditions:Select Status:Status=:Status;Planned,"In Process",Complete
Condition Index: 6000

Condition 7 - User-Defined

User-Defined entries allow you to specify a Parameter and its format.  Upon entry of the parameter
it is stored in the 'Variables' of the Report and can be used to process activities within the report

The format of this type of parameter is DisplayName;{Format} linked to a Condition Index
where:

DisplayName is the text that you wish to appear on the parameter entry screen
{Format} This is the format of this entry {contained in ‘squiggly’ brackets}.  Data entry is
validated against this format although the value itself is stored as a String in the database. 
The validation options are:

· Boolean
· Integer
· String
· Date
· Time
· Double

Condition Index This is always 9000

Example: If you are creating a Parameter in which you provide the option to print the Run
Parameters then the full line could be:

Conditions: Exclude Parameters;{Boolean}
Condition Index: 9000

This is linked to an Exclude Parameters Variable in the Report Layout which you can then use this
to determine if the parameters are to be printed or not.
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Section 4 - Detail Query Conditions

This uses the 'Conditions' panel in the Master Query Screen and its similar to the Master Query
Conditions except that you need to specify the Detail Data Query to which the Condition applies

This references the Detail Data Query Number along with the field within that query.  For example
if we wish to show a range of Job Orders held against a Range of Customers then the Master
Query would refer to the Customer data and Detail Data Query would refer to the linked Job
Orders.

To select the Range of Customers the following Conditions would apply.

 From Customer;CUSTOMER>=:CUSTFROM (Type) 1015 
 To Customer;CUSTOMER<=:CUSTTO (Type) 1015 

To select the Range of Job Orders the following Conditions would apply.

 Job Order From;ORDERNUMBER>= :DDC_1_JOBFROM (Type) 1075
 Job Order To;ORDERNUMBER<= :DDC_1_JOBTO  (Type) 1075

Where DDC_1 represents the Detail Query Number to which the condition will apply

Additionally you may have additional Detail Queries that also link to the selected Job Order
Number.  For Example Job Order Lines (DD_2), Job Order Documents (DD_3), etc.  In this
instance you would simply extend the above condition to include the Detail Query Number -
separated by a #

 Job Order From;ORDERNUMBER>= :DDC_1#2#3_JOBFROM (Type) 1075
 Job Order To;ORDERNUMBER<= :DDC_1#2#3_JOBTO  (Type) 1075

Buttons

The following buttons are used to save the current Report, View, Chart, Pivot, or Edit View in
addition to processing the respective layouts

Close: This will close the Reports and Views Developer screen. 

Add: This will bring up a panel for defining the new Report, Analysis, Chart, or Pivot View.  You
can create a new report ‘from scratch’ or copy an existing format.  In either case it will create an
output whose ‘Level’ will be preset at ‘Company’.  On this panel the following fields are available.

Create from Scratch: Select this Radio Button if you are going to generate the Report,
Inquiry Screen, Analysis, Chart, or Pivot View from scratch.  The following two fields will be
presented which must be completed

Type: Select the Radio Button that represents the type of view being created.  The
options are:

Report
Analysis
Chart
Pivot View
Inquiry
Edit View

Name: Enter the Name of the view.  Duplicate Names are not allowed
Copy from Another: Select this Radio Button if you are going to generate the Report,
Inquiry Screen, Analysis, Chart, or Pivot View by copying an existing view and using that
as a start point.  The following options are now presented
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Output to be copied: From the drop-down list select the current Report, Inquiry,
Analysis, Chart, or Pivot View that will form the basis of the new view.  When
selecting this option you can define what will happen to the copied view as follows:
Replace the Existing: Select this Radio Button to denote that the ‘Output to be
Copied’ document will be replaced after changes have been made
Be an Additional: Select this Radio Button to denote that the ‘Output to be
Copied’ document will be used as the basis for creating a new view.  The name of
the new view should be entered into the next field
Name: Mandatory enter if the ‘Be an Additional’ Radio Button ahs been selected.
Duplicate Names are not allowed

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: Not applicable to this View

Edit: This is only available in the 'Master Settings' tab and only applies to reports.   If you click on
this button then you will be taken through the parameters currently held against this Report so that
you can create and/or maintain the physical document.  If you are creating the Report then a panel
will be presented where you can either use a ‘Wizard’ to create the basic report or select an
existing Report to use as a start point.  

Note 1: A guide to the Report Design Wizard is shown at the end of this section
Note 2: A simple Tutorial is available under Ostendo ‘Help’ that describes some of the
basic functions such as:

· Adding Data Fields
· Adding Text Fields
· Adding your Company Logo
· etc

Preview: This will take you through the parameters currently held against this Report or View and
then produce the output as if you were an end user. 

Export: If you click on this button then the current Report, View, Pivot, or Chart’s details will be
exported and generated as a .dat file.   You should note that, in the case of a Report, this does
NOT export the .fr3 file.  This must be copied separately if you are transferring the Report to
another Ostendo.

Import: If you click on this button then you will be asked to point to the .dat file generated using the
above ‘Export’ process.  Upon selecting the .dat file the Report, View, Pivot, or Chart’s details will
immediately be imported into the current (sign-on) Company.   You should note that, in the case of
a Report, you should also copy the specific .fr3 file into the ‘Company’ reports folder.

Detail Query Tab

This tab allows you to create up to:
· 20 additional sub queries for reports
· 1 additional sub query for Analysis Views
· 1 additional sub query for Edit Views
· 12 additional sub queries for Inquiries

Each Sub Query contains the following fields

Query #: This allows you to define a sub-query linked to the Main, or a higher level, SQL (see the
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next field).  

Link to Query #:  This enables you to define the ‘Level’ that the Query occupies and therefore to
which parent Query it is joined. For example:

Any Query at Level 0 will be Left Joined to the Master SQL
Any Query with Level 1 will be Left Joined to the immediate previous Level 0
Any Query with Level 2 will be Left Joined to the immediate previous Level 1
Etc…

SQL Builder: Supporting screen to help you design your query.  On the displayed screen there are
three panels

Tables - The names of all the Tables (database files) that are used by Ostendo
Fields - Having selected a specific Table this will show each field in that Table
Query - This is where you create and maintain the query as described below

You can enter a query in one of two ways
§ Type in directly
§ Create using ‘prompts’

To create using ‘prompts’ you can copy:-
§ Tables to the Query by selecting the table and either double clicking the left mouse

or clicking on the ‘Add Table to Query’ button
§ Fields to the Query by first selecting the correct Table then the field and either

double clicking the left mouse or clicking on the ‘Add Field to Query’ button
§ Keywords to the Query by clicking the ‘Options’ button and selecting ‘Add Keyword’

and then selecting the appropriate keyword.    Available Keywords are Select, *,
Sum, Count, From, Where

§ Operators to the Query by clicking the ‘Options’ button and selecting ‘Add Operator’
and then selecting the appropriate Operator.   Available Operators are >, <, =. <>,
+, -, /

The following buttons are used to save the current Report, View, Chart, Pivot, or Edit View in
addition to processing to the respective layouts

Buttons

The following buttons are used to save the current Report, View, Chart, or Pivot in addition to
processing to the respective layouts

Close: This will close the Reports and Views Developer screen. 

Add: This will bring up a panel for defining the new Report, Analysis, Chart, or Pivot View.  You
can create a new report ‘from scratch’ or copy an existing format.  In either case it will create an
output whose ‘Level’ will be preset at ‘Company’.  On this panel the following fields are available.

Create from Scratch: Select this Radio Button if you are going to generate the Report,
Inquiry Screen, Analysis, Chart, or Pivot View from scratch.  The following two fields will be
presented which must be completed

Type: Select the Radio Button that represents the type of view being created.  The
options are:

Report
Analysis
Chart
Pivot View
Inquiry
Edit View

Name: Enter the Name of the view.  Duplicate Names are not allowed
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Copy from Another: Select this Radio Button if you are going to generate the Report,
Inquiry Screen, Analysis, Chart, or Pivot View by copying an existing view and using that
as a start point.  The following options are now presented

Output to be copied: From the drop-down list select the current Report, Inquiry
Screen, Analysis, Chart, or Pivot View that will form the basis of the new view. 
When selecting this option you can define what will happen to the copied view as
follows:
Replace the Existing: Select this Radio Button to denote that the ‘Output to be
Copied’ document will be replaced after changes have been made
Be an Additional: Select this Radio Button to denote that the ‘Output to be
Copied’ document will be used as the basis for creating a new view.  The name of
the new view should be entered into the next field
Name: Mandatory enter if the ‘Be an Additional’ Radio Button  has been selected.
Duplicate Names are not allowed

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: Not applicable to this View

Report Creation Wizard

Whenever a Report is being created and the ‘Edit’ button is pressed a panel is presented to help
you define a starting point for the new Report.  Three options are available:

Option 1.  You can use an existing Report’s Format as the basis for the new Report by clicking on
the ‘Templates’ tab and selecting the specific Report. 

Option 2. You can construct a Report ‘from scratch’ by using a ‘Wizard’.  This contains the
following steps

Step 1 - Data: This panel allows you to identify the dataset(s) from which the fields will be
extracted.  The basic datasets shown are:

SYS_   This contains all the fields relating to your Company
SC_  This shows the parameters that have been identified against this Report
MD_  This shows the fields extracted via your Master Query (above)
DD_#  This shows the Detail-queries that were created against the Report.  The #
after the DD_ identifies the Detail-query number in the Detail Query List

Select the dataset then click on the ‘Next’ button

Step 2 - Fields: This panel shows the available fields within the dataset selected above.
Select the field(s) that you want to appear on the Report and move them to the right side
of the screen.   Click on the ‘Next’ Button when done.

Step 3 - Groups: This is an optional step that allows you to Group the extracted records.
You should note that the Query used to extract this data should also include an ‘ORDER
BY’ statement to reflect the grouping being defined here.  The left side of the screen
shows the extracted fields defined in step 2.  Select the ‘Group By’ field(s) and move to the
right-hand area.  Click on the ‘Next’ Button when done.

Step 4 - Layout: Select the following:
Orientation:- Landscape or Portrait
Layout:- Tabular or Columnar (The display to the right of the panel will reflect the
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selection)
Fields Fit to Width:- If ‘checked’ then the selected fields will be restricted to the
width of the page and field concatenation could occur.  If not ‘checked’ then the
field will continue into a second (and third line) if necessary to show all the data.

Click on the ‘Next’ Button when done.

Step 5 - Style: Select the Report Style that you wish to use.  The options are Bold,
Standard, Soft Gray, or Corporate.  The picture to the right of the panel shows an example
of the report style. Click on the ‘Finish’ Button when done.

Option 3. You can construct a Report ‘from scratch’ by starting with a blank ‘palette’ by selecting
on the ‘Standard Report’ icon and clicking on the ‘OK’ button.  A blank report will be presented.
You now need to make the Datasets and their available for inclusion in the report.  To do this you
should select Reports on the top toolbar and choose ‘Data’ from the dropdown list.  ‘Check’ those
datasets from which you wish to select fields and click the ‘OK’ button.

5.3.2 Report Layout Editor

This function enables you to edit any Report created by the User through the ‘Reporting and View
Developer’ function.  You should note that this screen does not allow you access to any base
Ostendo reports.

The opening screen shows all current reports in the Company Reports folder.  Select the report
that you wish to amend and click the ‘Run’ button.  The Report Layout Editor screen will show the
selected report in preparation for editing.  Refer to the Report Editor Guide for information on how
to make changes to the report.

Using this feature you can:
· ‘Save’ the report and it will be used as the standard Ostendo report, or
· ‘Save as’ and, using the ‘Specific Form Layout’ screen, provide a link to specific

Customers, Customer Types, Suppliers, etc. so that Ostendo will use that layout in
preference to the standard layout.

Buttons

Close: This will close the Report Layout Editor screen. 

Run: This will run the Report Editor program and display the selected report.

5.3.3 Reporting Periods

This screen allows you to define Reporting Periods that can be used with the Report and View
Developer.  The objective is to provide a simplified method where dates and date ranges can be
specified thus making the reporting function much easier to specify.

Using this screen you can define up to four Periods – each having their own date/period definition.
You could, therefore, define the following options

· Extract Month-to-Date records for (say) Sales Commissions
· Extract MTD compared to previous Year’s MTD
· Extract MTD in addition to YTD figures
· Extract MTD/YTD figures and compare to previous Year’s MTD/YTD

Entry and Display fields
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Reporting Period:  Enter the Reporting Period definition.  Duplicate Reporting Period names are
not allowed.

Description:  Enter a short description of the Reporting period record.

Period 1 - Start
Start Date Type:  You can select one of the following to define the Type from which the
entries in the next three fields will determine the exact date:

None: No Type selected (not applicable to Period Definition 1
Fixed Date: This uses the date defined in field ‘Fixed Date’
BOM: This uses the first day of the current month offset by the value entered into ‘
Start Offset Type’ and ‘Start Offset’ fields
BOY: This uses the first day of the current year offset by the value entered into ‘
Start Offset Type’ and ‘Start Offset’ fields
EOM: This uses the last day of the current month offset by the value entered into ‘
Start Offset Type’ and ‘Start Offset’ fields
EOY: This uses the last day of the current year offset by the value entered into ‘
Start Offset Type’ and ‘Start Offset’ fields
Current Date: Uses the current System Date
Financial BOY: Using the Fiscal Month entered into System Settings this will
determine the Beginning of the Financial Year derived from the date evaluated by
the ‘Start Offset Type’ and ‘Start Offset’ fields
Financial EOY: Using the Fiscal Month entered into System Settings this will
determine the End of the Financial Year derived from the date evaluated by the ‘
Start Offset Type’ and ‘Start Offset’ fields.

Start Offset Type: You can specify the Offset to be in Days or Months
Start Offset: This can be the number of days or months (positive or negative) around the
base date from the Start Date Type
Fixed Date: This is used specifically against the ‘Fixed Date’ Start Date Type to denote
the actual Date.

The above (Period 1 Start) group of fields is repeated for Period 1 End and the equivalent fields in
Periods 2, 3 and 4

Here are few examples of what can be defined:

Beginning of previous Month
Start Date Type: BOM
Start Offset Type: Month
Start Offset: -1
Fixed Date:

Beginning of Last Year’s previous Month
Start Date Type: BOM
Start Offset Type: Month
Start Offset: -13
Fixed Date:

Beginning of current Financial Year
Start Date Type: Financial BOY
Start Offset Type:
Start Offset:
Fixed Date:

31
st

 October
Start Date Type: Fixed Date
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Start Offset Type:
Start Offset:
Fixed Date: select 31st Oct from drop-down Calendar

For more information on how this is used refer the the Tutorials found under 'Help'

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Reporting Periods screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Reporting Period record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Reporting Period record

5.3.4 Web Reports

This screen allows you to define which reports a Web-based User can access.  The screen
returned to the User's specific data entry/Inquiry device will show only these reports.

Entry and Display fields

Lookup Table: From the drop-down list select the Table to which the Report is linked.   The
options are:

· Customers
· Suppliers
· Job Orders
· Sales Orders
· Items
· Sales Invoices
· Purchase Orders

Report Name: From the drop-down list select the Report that will be available to the User.   Note:
The Report MUST only have a single selection Condition and must relate to the above Table

Employee: From the drop-down list select the Employee to which this Web Report will be effective

Condition Name: Display only field showing the single Condition that is passed to the Report 

Buttons

Close: This will close the Web Reports screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.
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Add: This will send the cursor to a new line for entry of a new Web Report record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Web Report record.

5.3.5 Web Inquiries

This screen allows you to define which Inquiries a Web-based User can access.  The screen
returned to the User's specific data entry/Inquiry device will show only these inquiries.

Entry and Display fields

Inquiry Name: From the drop-down list select the Inquiry to be made available to the User.   

Employee: From the drop-down list select the Employee to which this Web Inquiry will be effective

Buttons

Close: This will close the Web Inquiries screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Web Inquiry record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Web Inquiry record.

5.3.6 Specific Form Layouts

This screen allows you to link Customers or Suppliers to specifically designed forms.

Using the Report Editor Layout function you can amend a standard report layout and ‘Save as’ a
different name.  This screen enables you to establish a link between specific Customers,
Customer Types, Suppliers, etc. and this report so that Ostendo will use its layout in preference to
the standard layout.

Entry and Display fields

Print Form Name: From the drop-down list select the type of form being linked.  The options are:
· Invoice
· Statement
· Sales Order
· Job Order
· Delivery Document
· Purchase Order
· Job Quote
· Sales Quote



110 Ostendo Reference Guide

· Reminder Letter
· Reminder List

Condition: From the drop-down list select the condition under which the form will be printed.
These conditions are specific to the above Print Form Name.  The options are:

· Invoice
Customer Type
Customer

· Statement
Customer Type
Customer

· Sales Order
Customer Type
Customer
Sales Type

· Job Order
Customer Type
Customer
Job Type

· Delivery Document
Customer Type
Customer
Sales Type

· Purchase Order
Supplier Type
Supplier
Purchase Type

· Job Quote
Customer Type
Customer
Job Type

· Sales Quote
Customer Type
Customer
Sales Type

· Reminder Letter
None

· Reminder List
None

Value: For the selection made in the previous field this shows the current entries in the specific
table.  For example: If Customer was selected then this drop-down will show all available
Customers.

Filename: locate the full path name of the saved Form.  For example: 

C:\NewForms\Reports\SpecialStatement.fr3

You should note that all Ostendo Forms have an extension of .fr3

Email Form File Name: An Email Form is used in instances where the standard form is output to
Pre-Printed stationery (that may contain your company Logo, etc).   As the Email form is fully
system generated electronically the inclusion of the Logo, etc should be within the form’s design.
Having designed the form using the Report and View Developer you should locate its full path
name in this field.  For example: 
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C:\NewForms\Reports\SpecialStatement.fr3

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Buttons

Close: This will close the Specific Report Layout screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new linkage.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current linkage record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current Specific Report Layout Linkage record.

5.3.7 Specific Form Messages

This screen enables you to create a Date-effective message that will appear on a selected Report. 
This can be used, for example, to print a message on the document (such as a Special Offer) for a
specified date range

Entry and Display fields

Name: From the drop-down list select the specific Form that will display this message.  The
available Forms are:

· Invoice
· Statement
· Purchase order
· Sales order
· Job Order
· Job Quote
· Sales Quote
· POS Invoice
· POS Payment

Date From: From the drop-down calendar select the date from which this message will be
effective

Date To: From the drop-down calendar select the date up to which this message will be effective

Message: Enter the Message that you wish to appear on the selected document.

Buttons

Close: This will close the Specific Form Messages screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.
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Add: This will send the cursor to a new line for entry of a new Message record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current Message record

5.3.8 Specific Email Text

This screen allows you to create and maintain Email Text for various Forms in Ostendo.   This
Text will populate an Email whenever the respective ‘Form’ is emailed to a Customer or Supplier.
The Text can contain plain text or can also include data taken from the specific Form. (See later)

Entry and Display fields

Name: Select the specific form from the drop-down list.  The available forms are:
· Invoice
· Statement
· Sales Order
· Job Order
· Delivery Document
· Purchase Order
· Job Quote
· Sales Quote  

Email Subject: The content of this field will populate the Subject Line of the generated Email.  It
can be plain text or can include fields from the database relevant to the document being sent.  

For example: If a ‘Purchase Order’ was to be emailed as an attachment to an Email then the
available database fields for placing in this Text will come from the ‘Purchase Order’ Print Layout.
To view the fields that are available to a Purchase Order carry out the following:

· Click on File>Reporting Configuration>Report Layout Editor
· Select the specific report (in this example “Purchase Order”)
· ‘Run’ the report to bring up the Report Layout
· Select ‘Report’ on the top toolbar and select ‘Variable’
· In the right-hand panel under ‘Data’ you will see all the fields
· Scroll until you see dataset MD_
· All the fields under that dataset are available for inclusion in the Email

Now, if a Purchase Order ‘PO34567’ had been created in Ostendo and the Purchase Order
Number should appear in the Emails Subject Line then the format would be

Purchase Order [MD_."ORDERNUMBER"] is attached for your attention

Upon sending the Email the Subject Line in the Email would appear as:

Purchase Order PO34567 is attached for your attention

Note:
1.  The format of the field in the Subject Line is always [MD_."FIELDNAME"] where FIELDNAME is
the name defined in the specific dataset.
2.  The available Forms all have their own MD_ dataset
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A maximum of 200 characters of information including spaces can be entered into this field

Email Body: The content of this field will populate the main area of the generated Email.  This field
may contain plain text plus the same database fields shown above.  There is no restriction to the
number of characters that you can use in this field

Attachment Name: The content of this field will define the name given to any attachment (Invoice,
Purchase Order, etc).  This field is limited to a maximum of 100 characters and may contain plain
text plus the same database fields shown above.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Specific Email Text screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Specific Email Text record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Specific Email Text record.

5.3.9 Email-FTP

This feature allows you to send emails via an FTP link to all, or selected recipients.   This is useful
if the recipient is having problems going through the company’s normal emailing function.

You should note that if "All Emails" is used in this setup then this overrides all other entries and
uses "FTP Link" for all emails.

Entry and Display fields

Email Address: This defaults to ‘All Emails’ and uses the email address that currently exists
against the Customer or Supplier.  If you click on the drop-down then a panel will appear asking if
this entry is a Customer or Supplier.  Depending upon your selection the appropriate Customer or
Supplier list screen will be presented for you to make the specific selection.  Upon making the
selection the email address currently held against that record is brought back to this field.

NOTE: if any line has ‘All Emails’ selected then ALL other entries will be ignored and all Ostendo
emailing will be via FTP

Description:: Enter a short description of the entry.  For example: the Customer or Supplier Name

Ftp Host: Enter the ftp server, website hostname or IP Address to which the pdf file can be
uploaded.  For Example: www.development-x.com
 
Ftp User: Enter the Username for ftp account.  For Example:  ftpsite@development-x.com
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Ftp Password: Enter the Password for ftp account.  
 
Http Link: The http path (this will be the ftp accounts home directory, setup on the ftp server) in
order for the file to be downloaded via http link placed in the email body. The unique filename is
appended to this path.    (For Example: http://www.development-x.com/ftpsite/)
 

Buttons

Close: This will close the Email-FTP screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: The curser will go to a new line for entry of a new Email-FTP record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: After confirmation this will delete the current record

5.3.10 Inquiry Drill-Down

This screen allows you to define specific fields in a nominated Inquiry View such that, within the
View, you can drill down on the field and display another Ostendo Screen or Inquiry View showing
the specific data.  Two tabs are available:

To Screen: Allows you to identify the Screen to which you are drilling down
To Inquiry: Allows you to identify the Inquiry to which you are drilling down

'To Screen' tab

Entry and Display fields

Inquiry: From the drop-down list select the Inquiry Screen to which this drill-down is being
associated.

Module: From the drop-down list select the module where the screen to be displayed from the
drill-down is located

Screen: From the drop-down list select the screen within the above module to define the screen to
be displayed from the drill-down

Linked To: From the drop-down list select either Header or Lines to denote which part of the
Order is being enquired upon.  

Screen Field: From the drop-down list select the Key field in the referenced screen.  This is the
field against which the Inquiry Drill-down data is matched 

Tab Index: Enter the number of the screen tab that will be displayed in the drill-down.  This is
usually:
   0 = The List View of the data (Example: Sales Order List View)
   1 = The Main Data View of the data (Example: Sales Order Header Detail)
   2 = The Order Line View (Example: Sales Order Line information)
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Inquiry Field: Identify the specific field in the Inquiry Screen that will be compared to the Drill-down
screen.  You should note that this is the Query Identity of the field.  If you have renamed the field in
the Inquiry Query then that name should be specified here.

'To Inquiry' tab

This screen enables you to link a defined Inquiry Screen to other Inquiry Screen(s).   When using
the Inquiry Screen you can 'right mouse' to display the available 'Drill Downs' (as defined in this
screen).  Selecting a Drill Down will take you to that Inquiry Screen.

Entry and Display fields

Inquiry From: From the drop-down list select the Inquiry screen against which this drill-down is
being added. 

From Field: From the drop-down list select the field from the 'Inquiry From' screen from which the
Drill Down Value is passed

Linked To: From the drop-down list select either Header or Lines to denote which part of the
Order is being enquired upon.  Note: Some Inquiries do not have the Header/Lines relationship.  In
this instance select 'Header'.

Inquiry To: From the drop-down list select the Inquiry screen to which you are drilling down to.

To Field: From the drop-down list select the field in the 'Inquiry To' record is being compared
against the 'From Field value

'To Script' tab

This screen enables you to link the defined Inquiry Screen to a Script.   When using the Inquiry
Screen you can 'right mouse' to display the available 'Drill Downs' (as defined in this screen). 
Selecting a Drill Down will run the Script.

Entry and Display fields

Inquiry From: From the drop-down list select the Inquiry screen against which this drill-down is
being added. 

Linked To: From the drop-down list select either Header or Lines to denote which part of the
Order is being enquired upon.  Note: Some Inquiries do not have the Header/Lines relationship.  In
this instance select 'Header'.

Script To: From the drop-down list select the Script that will be run when this is selected in the
Inquiry Screen

Buttons

Close: This will close the Inquiry Drill Down screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Drill Down record

Save: This will save the current data without exiting the screen



116 Ostendo Reference Guide

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the current Drill Down record from this list

5.4 Scripting Configuration

5.4.1 Script Editor

Scripts can be created to perform a multitude of user-defined tasks at various levels across
Ostendo such as:

1. System Action

With this type of script you can define specific actions that would take place prior to the linked
screen being displayed.  This is useful, for example, to enable a User can look at selected data
from the Item Master but cannot maintain that data.  

2. Standard

Adds the Script Name to the drop-down under ‘Custom’ on Ostendo’s top Toolbar.   Selecting this
will run the Script.  

Examples of the types of script are:
§ Updating your existing system with information from Ostendo
§ Updating Ostendo with information from your existing system 
§ Importing Supplier Catalogues
§ Send user-defined KPI information via email, or to a Mobile phone

3. Related

Add the Script Name to the drop-down Menu held against the ‘Related’ button within specific
screens.  Examples could be as above with information specifically related to the current main
screen

4.  Screen Data

This is related to Master, Order, Receiving, and Invoicing Screens where the action of Adding or
Deleting a record or changing any field within the record will automatically run the Script to provide
a resultant action.  For example

§ Zero Price Check on Sales Order Lines
§ Update Sell Price based on Last receipt Cost
§ In Purchasing check for best price from all Suppliers
§ Have a pop-up Sales Message appear
§ Specify a minimum order quantity
§ Show active Promotion when Sales Line Entered

5.  Order

This allows you to create a Script that is run against an Order as a whole in the following areas:
§ Assembly
§ Jobs
§ Sales
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§ Purchase
§ POS

and enables you to add extra specific functionality such as:
§ Total Order Value discounting based on Order content
§ Freight calculations based on Order content
§ Order Authorisation Levels (Example: User Purchasing levels)
§ Order Margin Control with User-defined Margin levels
§ Order Validation and/or Checks
§ Workflow actions (Example: send Email regarding this Order)
§ Promotions (Example: 3 for price of 2, etc) 

The Script can also be defined as ‘Mandatory’ in which case Picking, Receiving, Printing, etc is
denied until the Script has been run

6.  Accounting Link

This type of script enables you to define links to other Financial Accounting Packages.  You can
define scripts that will output in the appropriate format to suit the standards required by the
receiving Accounting system

7.  Custom Data Screen

A Custom Data Screen enables a User to create Custom Screens that provide the following
options

Display Types: The Screen itself can be Inquiry only, Data Entry only or a combined
Inquiry/Data Entry
Data Entry Styles: You have the option to use a Computer Keyboard, Graphical Keyboard,
Touch Screen, or Barcode Scanner.  All four can be utilised in the same Custom Data Screen.
Data Options: This can include Open format entry, validated against data within the Custom
Data Script, or validated against Ostendo data.
Data Storage Options.  The data being entered can be held in temporary storage for ‘Batch
Posting’ into Ostendo or posted immediately - a single record at a time.  If the data is held in
temporary storage it can be held in non-Ostendo files and subsequently recalled into the data
screen.

Upon creation of the first Custom Data Script and linking it to a Graphical Display Ostendo will
create a new Menu Item under File called 'Custom Data Screens' from where they can be called by
the User

8.  Web Service

A Web Service script allows access to applications via the internet, mobility devices, in addition to
giving third party developers a way of interfacing their software products. The following can be
achieved with Web Service scripts

· Enable Ostendo to interface with other web enabled applications
· Allow Ostendo Users (and their Customers / Suppliers) to seamlessly connect, inquire and

enter information via the internet real time
· Allow the use of mobility devices such as IPhones, IPads, Smart Phones & Tablets to

interface real time with Ostendo
· Provide a developers interface for third party software applications
· Allow productivity tools (such as MS Excel spreadsheets) to connect real time with Ostendo

9.  Edit View

An Edit View Script is used in conjunction with the Edit View as generated via the User-Defined
Table routine and applies the content of the script whenever records are being added or
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maintained to the User-Defined Table

10.  Before Report

Scripting can be used in the Report Layout Editor to control printing options such as printing fields
under certain data conditions, etc.    The script is created here as a 'Before Report' style script
which is then selected from a drop-down field in the Report Parameters screen

Entry and Display fields

List Tab

Script Name: Display only field showing the name of the script maintained via the ‘Detail’ panel.

Style: Display only field showing the Style of the script.  The displayed options are:
· System Action
· Standard
· Related
· Screen Data
· Order
· Accounting Link
· Custom Data Screen
· API
· Edit View
· Web Service
· Before Report

Related Screen: Display only field showing the Screen for the Related script.

Category: Display only field showing the Category to which the script belongs as maintained via
the ‘Detail’ panel.

Description: Display only field showing the Description of the script maintained via the ‘Detail’
panel.

Buttons

Close: This will close the Custom Menu Scripts screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will go to the ‘Script’ panel for entry of a new Pascal Script

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: After confirmation this will delete the selected menu Custom Menu Script

Detail Tab

Script Name: Enter the name of the Script.  It is recommended that this does not contain spaces.
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Therefore a script for Customer Check could be written as CustomerCheck.

(Radio Buttons): Select the Radio Button that defines where the Custom Script will appear.  The
Options are:

All Users: If this is selected then this script is available for use by all non-administrator
users.  Specific Users, however can be included/excluded from seeing this script through
the normal Security Access Options held against the User.
(User) Only: This displays the name of the current User sign-on Name.  If this is selected
then this script is only available to this User

 
Style: Selected the Script Style from the drop-down list.  Depending on the style selected other
fields are presented as follows:

System Action Script
System Action: From the drop-down list select the Screen which this Action relates.

: (Notes): A Notes field for entry of information about this Script

Standard Script
: (Notes): A Notes field for entry of information about this Script

Related Script
Related Menu: From the drop-down list select the screen against which this Custom
Script will be presented when the ‘Related’ button is pressed in that screen.

: (Notes): A Notes field for entry of information about this Script

Screen Data Script
: (Notes): A Notes field for entry of information about this Script

Order Script
Mandatory: If this is ‘checked’ then it denotes that the script MUST be run before the
linked order can progress to the next step

: (Notes): A Notes field for entry of information about this Script

Accounting Link Script
: (Notes): A Notes field for entry of information about this Script

Custom Data Screen Script
Data Screen File: Click on the (...) Icon and point this script to its associated Graphic
'Edit' (Button): Click on this button to activate the Graphical Editor and, if you have
already linked a Graphic, open up the Graphic

: (Notes): A Notes field for entry of information about this Script

API Script
This style script is just to prevent showing in the Custom menu, as an API call can also be

done with a standard script if you intend for it to also be run via the Custom menu
      : (Notes): A Notes field for entry of information about this Script

Edit View Script
: (Notes): A Notes field for entry of information about this Script

Web Service Script
: (Notes): A Notes field for entry of information about this Script

Before Report Script
: (Notes): A Notes field for entry of information about this Script
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Button (Download Online Template): This is only visible if you are creating a new Script.  When
selected you can download a pre-defined script from the www.Ostendo.info website.  Of course
you require access to the Internet to get the download.

Script Tab

Select a Script function: The drop-down list shows you all the current available scripting
functions.  Simply select the required function and it will be placed in the main Script area at the
cursor position.  This provides a quick entry of standard functions in addition to providing a guide to
the function’s syntax

(script): This is where the script is created and maintained.  It is not the intention here to carry out
detailed information on Pascal Scripting; for this see separate Tutorials.  

Here are a couple of simple scripts that may wish to try out this feature:

Example 1
begin
  showmessage ('This is my test of Custom Scripts');
end. 

You can test the script by clicking on the ‘Test Script’ button.  In this instance you should see a
message box.  Upon saving the script as available to All Users you will see the Script Name
appear under ‘Custom’ Menu on the top toolbar.  If you click on the Script Name then the script will
be actioned.

 Example 2

begin
  executesql('update customermaster set ADDITIONALFIELD_1 = substring(Customer
from 1 for 10)');
end. 

This will copy the first 10 characters of the Customer Name to the first User Defined Field in the
Customer record

Here is a Screen Data Script that may be used during Insert into the Customer table.  It checks if
the entry contains a ‘&’ and, if so, rejects it.

begin
  if pos('&',QueryValue('CUSTOMER')) > 0 then
  begin
    MessageDlg('Please do not use && in Customer Name',mtinformation,mbok,0); //Note:
the double && is just so it displays correctly in the message
    Abort;
  end;
end.

Buttons

Close: This will close the Custom Menu Scripts screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will present a blank ‘Script’ panel in readiness for creating a new Script

Save: This will save the current dates without exiting the screen

http://www.Ostendo.info
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Cancel: Any changes made to a date since the last time the ‘Save’ Button was pressed will be lost
and the dates will revert to it’s pre-change position.

Delete: Not applicable to the ‘Script’ panel

Test Script: Clicking on this button will run the entered script.  

5.4.2 Screen Data Scripts

This screen allows you to generate and maintain Scripts that are activated in association with
Database Triggers.  You should have detailed knowledge of Ostendo’s Database Triggers before
defining and using Screen Data Scripts

Entry and Display fields

Screen:  From the drop-down select the screen against which this Screen Data Script will be
activated.

Table Name:  For the screen selected in the previous field Ostendo will present you with a
drop-down list of all Table Names used by that screen.  Select the Table Name against which the
script is being maintained

SQL Type:  From the drop-down list select the screen event at which this Data screen will be
applied.  The options are Insert, Update, or Delete.

Script Name:  This will show - in a drop-down list - all Custom Scripts created via screen ‘Custom
Scripts’ and flagged as a Screen Data Script.   Select the Custom Script that will apply to this entry.

Buttons

Close: This will close the Screen Data Script screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will take you to a new line for entry of a new Screen Data Script record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the Screen Data Script record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the highlighted Screen Data Script record

5.4.3 Order Scripts

This screen allows you to link Scripts - previously generated via screen Custom Scripts and
flagged as an ‘Order Script’  - to where the script is visible and can be run.  In each case a button
will appear in the ‘Lines’ view against the following areas

§ Assembly Orders
§ Assembly Order Lines
§ Assignments
§ Job Orders
§ Job Order Lines
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§ Job Calendar
§ Job Calendar Top
§ Sales Orders
§ Sales Order Lines
§ Purchase Orders
§ Purchase Order Lines
§ POS

Entry and Display fields

Screen:  From the drop-down select the screen against which this Order Script will be activated.

Script Name:  From the drop-down list select the Script to run within the screen

Buttons

Close: This will close the Order Script screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will take you to a new line for entry of a new Order Script record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the Order Script record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the highlighted Order Script record

5.4.4 Scripting Preferences

For 'Web Service' Style Scripts this defines the ports to be used.  You can check that these are
correct by creating a 'Web Service' Style script and, in the 'Script' tab, click on the 'Run' Button.  A
panel will present itself that is prefilled with the Local Host IP Address plus the Port Number as
entered here.   You can click the 'Run Local' button in that panel to validate the script.

Also, if you click the 'Run Remote' Button it will validate the script using the Remote connection
information set up in this screen.

Entry and Display fields

Run (Remote) Default Host: This is the Host is the host IP/Name that is running Ostendo Web
Service

Run (Remote) Default Port: Remote Port that the Ostendo Web Service has been started
on...example 80 or 85 etc 

Run (Local) Default Port: Local Port that you want to use if port 80 is in use as that will be used
by default

Default Web Theme: Select the Theme from the dropdown

Disable Code Completion: 'Check' this checkbox if you wish to disable code completion.  (This is
used as aid when writing Scripts)

SSL Certificate File:  Locate the Certificate File (ending in .cer or .crt) from within the computer
network and select it.  The full file path must be entered (or selected).
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SSL Key File:  Locate the Key File (ending in .pem or .key) from within the computer network and
select it.  The full file path must be entered (or selected).

Use HTTP Compression:  'Check' this checkbox if you wish to use HTTP Compression

Buttons

Close: This will close the Scripting Preferences screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

5.5 Customisation Configuration

5.5.1 Additional Fields

The Additional Fields function enables you to define your own field definitions in key areas across
Ostendo.  If you define an additional field then it will be immediately available for data entry,
reporting and analysis purposes.

From Ostendo Update 234 onwards, the length of Additional Fields is increased to 100 characters.

Entry and Display fields

Module: From the drop-down list select the key area where you want to maintain the additional
field(s).  The following have 8 fields containing Date Formats, plus up to 100 fields containing a
mixture of all Formats

· Activity Events
· Assembly Orders
· Assembly Steps
· BOM Header
· BOM Steps
· Call Centre
· Company Assets
· Contracts
· Customer Asset
· Customers
· Descriptors
· Employees
· Items
· Job Invoices
· Job Orders
· Job Tasks
· Labour Codes
· Projects
· Purchase Invoices
· Purchase Orders
· Purchase Receipts
· Purchase Shipments
· Sales Deliveries
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· Sales Orders
· Sales Invoices
· Suppliers

The following have 2 fields containing Date Formats, plus up to 100 fields containing a mixture of
all Formats

· Assembly Lines
· BOM Lines
· Job Lines
· POS Lines
· Purchase Invoice Lines
· Purchase Lines
· Purchase Receipt Lines
· Sales Invoice Lines
· Sales Lines
· Timesheet Lines

Note:-

· If an Additional Field against a Customer Record has exactly the same Identity as the
Additional Field against a Sales Order, Job Order, or Customer Asset then the content of
the Additional Field will be copied from the Customer record to the Order or Asset when
that record is created.

· If an Additional Field against a Supplier Record has exactly the same Identity as the
Additional Field against a Purchase Order then the content of the Additional Field will be
copied from the Supplier record to the Purchase Order when that record is created.

· If an Additional Field against an Item, Descriptor, or Labour Code Record has exactly the
same Identity as the Additional Field against an Order Line record then the content of the
Additional Field will be copied from the Item, Descriptor, or Labour Code Record to the
Order when that record is created.

Caption: Enter the name that you wish to apply to this Additional Field.  This caption will be
displayed wherever this additional field is used

Field Type: From the drop-down list select the format of the field.   The options are:
· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

You should note that the field itself is stored as a 'String'.  This field Type is only used to validate
the entry.

Sequence: Enter a Sequence Number.   All Additional Fields belonging to the same 'Module' will
be displayed on the data entry screen in this Sequence

Value List: You can define specific values (each on a separate line).  If you enter any values then
data entry will be restricted to these entries

Available to Mobility: This is applicable only to Orders, Invoices, Receipts. Ticking this box will
allow the AdditionalField to be available for Mobility use when the Style Template includes item
types like JOBFIELDS / TASKFIELDS / SALESFIELDS / PURCHASEFIELDS / RECEIPTFIELDS /
INVOICEFIELDS. 
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Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Buttons

Close: This will close the Additional Fields screen.  

Add: This will send the cursor to a new line for entry of a new Additional Field record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Additional Field record.  You should note that if
records already use this field then the data against this field in those records will be removed.

5.5.2 Filter Screen Conditions

This feature allows you create and maintain conditions which are applied to the opening
data on nominated screens

Entry and Display fields

Condition Name: Enter a name for the Condition Filter.  This name will appear on the Filter
Toolbar in the screen where it is used

Screen: From the drop-down list select the screen to which this Filter will apply. The Options are:
· Assembly Orders
· Batch Invoicing
· Call Centre
· Customer Assets
· Customers
· Descriptors
· Drag & Drop Items
· Items
· Job Orders
· Labour Codes
· OC Customer
· OC Customer Asset
· OC Jobs
· OC Manufacturing
· OC Purchasing
· OC Sales
· OC Supplier
· Purchase Invoicing
· Purchase Orders
· Purchase Receipts
· Purchase Shipments
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· Sales Deliveries
· Sales Orders
· Suppliers
· Timesheets

Filter Condition: Clicking on this field will bring up the Query Builder Screen.   In this screen you
can construct the Query relating to the screen to which the Filter will apply.  This can either be via
the Tables and Fields panels or keyed directly into the 'Query' field.  For example:  If the filter is to
be used in Screen 'Sales Orders' then the Query could be ORDERSTATUS = 'Quote'

Specific User: If this Filter Condition is to apply to a specific user then 'check' this checkbox and
select the User in the next field.   If this is not checked then this Condition will apply to all Users

User: From the drop-down list select the User to which this Filter Condition applies.  If this is left
blank then this Condition will apply to all Users

Buttons

Close: This will close the Filter Screen Conditions screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Filter Screen Condition record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Filter Screen Conditions record.

5.5.3 Order Tabs

This will allow you to define the content of a tab in the Purchase, Sales, Assembly or Job Order
Lines screen.  The name of the tab and the way it functions is defined via a User-Defined Script in
this record

Entry and Display fields

Screen Name: From the drop-down list select the Order Line screen where this will be presented.
The options are:

· Sales Orders
· Purchase Orders
· Assembly Orders
· Job orders

Note:  Only one line can be created for each of the above options

Tab Caption: Enter a short description that will appear on the displayed tab

SQL Query: Enter the Query details that will extract the data to be displayed under this tab.

Buttons
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Close: This will close the Order Tabs screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: The curser will go to a new line for entry of a Order tab SQL

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: After confirmation this will delete the current record

5.5.4 Required Fields

This feature allows you to define which fields across Ostendo are ‘mandatory’ entry fields.  If the
User does not enter data into this field in the designated screen then an error message will be
returned.  A user-defined Display Field Name can be entered here and this will be output to the
error message panel. For order screens like Job Orders and Sales Orders, an Order is still created
- but with OrderStatus = "Planned". 

Entry and Display fields

Required Type: You will see from the drop-down list that two ‘Types’ are available.

· System: These are required by Ostendo and cannot be added, changed or deleted.
They are displayed here for your reference

· Company: These entries are defined by the User and can be added, changed, or
deleted.  The entry is specific the currently logged-on Company

Table Name: From the drop-down list select the name of the Table in which the specific field
resides.

Field Name: From the drop-down list select the field - within the above table - that will be subject
to the mandatory entry.

Display Field Name: Enter a short description of the field.  This description will appear in the error
message in the following manner:

SYSTEM: The Item Number is a required field
COMPANY: The Customer Address Line 2 is a required field

Where the highlighted text is your entry in this field

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.
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Display System Required Fields - If you ‘check’ the checkbox then the displayed data will include
all records with Required Type ‘SYSTEM’.

Buttons

Close: This will close the Required Fields screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new ‘COMPANY’ required field record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Required Field.  Note: ‘SYSTEM’ required fields
cannot be deleted

5.5.5 System Screen Conditions

This screen allows you to identify - by User - restrictions regarding which records can be
addressed.  When the User goes into the relevant screen(s) only those records defined here are
available.

Entry and Display fields

User Name: From the drop-down list select the User to which this screen condition applies.  

Screen: From the drop-down list select the specific screen against which the condition is being
specified.  

Filter Conditions: Enter the specific condition that applies.  There are two formats for specifying
conditions.  

These are:

‘AND’ Conditions where all the specified conditions must apply before the record is visible to the
User.  When applying the ‘And’ condition each condition must be entered in a separate line.  For
example, in the Sales Orders screen we may wish to restrict the displayed list to Counter Sale
Orders whose status is ‘In Progress’.  In this instance the Filter Conditions would be:

ORDERTYPE = 'CounterSales'  
ORDERSTATUS = 'InProgress'

‘OR’ Conditions where each specified conditions will be visible to the User.  When applying the ‘Or’
condition the whole statement must be enclosed in parentheses.  For example, in the Sales
Orders screen we may wish to restrict the displayed list to Sale Orders whose status is ‘In
Progress’ or ‘Open’.  In this instance the Filter Conditions would be:

(ORDERSTATUS = 'InProgress' or ORDERSTATUS = 'Open')

Note: The available fields to which a condition can be applied are those contained within the
relevant master record.  For example: The Sales Order fields are defined in table SalesHeader,
Items are defined in ItemMaster, etc.  You can print out a list of available fields by going into
General>Reports>Full Listing of Tables
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Buttons

Close: This will close the ‘Screen Filter by User’ screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: A new line will be created for entry of a filter condition

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: After confirmation this will delete the current referenced line

5.5.6 System Shortcuts

This feature allows you nominate Short-keys by User where each short-key can either run a script
or perform a System Action

Entry and Display fields

User Name: From the drop-down list select the User to whom this Short-Cut Key will apply.

Shortcut: From the drop-down list select the shortcut key to be used.  The Options are the 'Ctrl'
key in combination with the alphabet (a to z) or numbers 1 to 9

System Action: From the drop-down list select the specific screen that will be displayed when this
shortcut key is selected.   If an entry is made here then no entry is allowed in field 'Script Name'

Script Name: From the drop-down list select the Script that will be run when this shortcut key is
selected.   If an entry is made here then no entry is allowed in field 'System Action'

Buttons

Close: This will close the System Shortcuts screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Shortcut record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted System Shortcut record.

5.5.7 Touch Pads

This screen allows you to nominate a Workflow screen that will display on Sales, Jobs,
Purchasing, and Assembly Order to facilitate 'Touch Pad' Order line entry

Entry and Display fields
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Order Screen: From the drop-down list select the Order style to which this will apply. The options
are:

· Sales
· Jobs
· Assembly
· Purchase

Note:- For POS orders the Touch Pad link is held against the POS Station record
(POS>Settings>POS Stations)

User Name: From the drop-down list select a User (as maintained via File>System
Configuration>User Security and Options).  The 'Touch Pad'; will then appear on the selected
Order Screen whenever this User is in that screen

Touch Pad Filename: Enter the full path (Example C:\Ostendo\TouchPad2.dat) to the location of
the .dat workflow file that you wish to display

Buttons

Close: This will close the Touch Pads screen. If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Touch Pads record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current Touch Pads record from this table
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Add to POS Stations

Touch Pad Filename: Enter the full path (Example C:\Ostendo\TouchPad2.dat) to the location of
the .dat workflow file that you wish to display at this POS Station

.

5.5.8 User Defined Constants

User-Defined Constants allow the Administrator to specify a definitive value for a Constant.  By
having the Constant in this table called USERDEFINEDCONSTANTS, it allows you to amend the
value of the Constant without going into the Scripts that uses it.

To retrieve the value of this constant in your script, you just use a SELECT statement. For
example, if you have defined a constant called "ABC", then to retrieve the value of "ABC" you can
use a statement like:

GetSQLresult('Select CONSTANTVALUE from USERDEFINEDCONSTANTS where
CONSTANTNAME = ''ABC''') ; 

Entry and Display fields

Constant Name: Enter a short identity of the Constant.  It is this Name that is called within the
Script and the value contained field 'Value' becomes the value of the Constant in the Script

Constant Type: From the drop-down list select the field type of the 'Value' field.  This will ensure
that a value of the correct format is entered.  The Drop-down list options are:

· Text
· Decimal
· Integer
· Currency
· Yes/No
· Date
· Time

Value: Enter the definitive value of this Constant

Buttons

Close: This will close the User-Defined Constants screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new User-Defined Option

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted User-Defined Constant record from this list.  You
should be aware that this only removes the value from this Table; it will not delete the link to this
Constant that is currently in any Script.
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5.5.9 User Defined Tables

This feature enables you to create your own Database Tables in Ostendo.  These created Tables
will then allow you to:

· Maintain your data using standard Add, Change, Delete, and Inquiry functions
· Have data maintenance screen appear in the standard Ostendo Menu.
· Fully integrate the Table(s) within Ostendo’s standard database structure
· Be able to produce Reports, Views, Charts, and Inquiries
· Allow access to Screens, Reports, etc using standard User access routine

Display and Entry Fields

New (Radio Button):  If this is selected then you should enter a Table Name in the ‘Name’ field
followed by clicking the ‘Create Table’ button to generate the Table ‘Header’

Existing (Radio Button):  If this is selected then you should select the drop-down icon in the ‘
Name’ field and selected the existing Table.

Name:  This is the Name of the new or existing Table.   

If the Table is being generated (‘New’ Radio Button selected) then enter the name of the
table with no spaces (Example: Loan Register should be entered as either
LOANREGISTER or LOAN_REGISTER).  If you now click on the ‘Create Table’ button
then Ostendo will precede your Table Name with OSTDEF_.   

If the Table is being recalled (‘Existing’ Radio Button selected) then click on the
drop-down Icon and select the existing Table.  If you wish to delete the whole table then
click on the adjacent ‘Drop Table’ button

Field Definitions Tab

Field Name: Enter the name of the field.  This must not contain spaces nor be a ‘Reserved Word’.
As there are many Reserved Words it is suggested that you enter a name that is unique.  For
example if the field is a Print option then you would not use the name ‘PRINT’ as that is a
Reserved Word.  It is better to state (say) DOCUMENTPRINT.  You should note that this is the
field name in the database.   This can be renamed in the data entry screen (via the ‘Generate Edit
View’ tab) to a more meaningful display name

Type: From the drop-down list select the format of this field.  The options are:
· VARCHAR
· BOOLEAN
· INTEGER
· DATE
· DOUBLE PRECISION
· TIME
· TIMESTAMP
· BLOB

Size: Enter the maximum size of this field

Domain: If you are using an Ostendo ‘Domain’ (I.e. Values already set up in Ostendo by
Development-X) then select the Domain from the drop-down list.  During Data Entry the values
from this Domain will be displayed for selection

Having defined the Fields within the Table you should now click on the ‘Generate Edit View’ tab to
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create the Edit View and define additional information 

Buttons

Add: This will send the cursor to a new line for addition of a new field in the Table

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current line (field) from the Table.  Note: This action will remove this
field from the Table along with all data previously entered into this field.

Generate Edit View Tab

This tab enables you to automatically generate a View into which you can enter and edit data. 
(Alternatively you can go into File>Reporting Configuration>Report and View Developer and
manually create it)   There are four sections

· Giving the View a Name and a Title
· Linking a script to the View so that data validation can take place
· Selecting a Lines Table if a Parent/Child relationship is to be created
· Defining the Field ‘Caption’ names for display in the View

Name: Enter a unique Name by which the View will be known.  (Example: LoanRegister).

Title: Enter the Name of the View.  This will be presented in the Title bar of the View

Script: From the drop-down list select the Script if one has been developed to support the View.
This script will have been previously created in  File>Custom Scripts and be of type ‘Edit View’.

Lines Table: If you are creating a Parent/Child style View then – from the Drop-Down List - select
the Table that represents the Child.  This Table should already exist in the list of User-Defined
Tables

(Button) Generate

Clicking on this button will use the entered Table(s) and their re-defined Field Names and generate
an Edit View.  You can now enter data by clicking on Custom>Edit Views and selecting this View.

The generated View can be edited by going into File>Report and View Developer

List and Detail Captions – Sub Tab

Field Name: Display only field showing each Field in the main Table.

Caption: Enter a caption against each field name.  This caption will be displayed in the
column heading of the ‘List’ panel and adjacent to the relevant field in the Data entry panel
of the Edit View

Line Captions – Sub Tab

Field Name: Display only field showing each Field in the Lines Table.
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Caption: Enter a caption against each field name.  This caption will be displayed in the
column heading of the ‘List’ panel and adjacent to the relevant field in the Data entry panel
of the Edit View

5.5.10 User Defined Menus

This feature enables you to have your Custom Menu Links, Custom Data Screens, Standard
Scripts, or Edit Views appear under your specified Ostendo Menu Category.  If these are not
referenced in this User-Defined Menu screen then they will appear in their default position under
Custom>Edit View

Display and Entry Fields

Custom Menu Name:  From the drop-down list select the Custom Menu Links, Custom Data
Screens, Standard Scripts, or Edit Views that you wish to appear under a specified Ostendo Menu
Category.

Custom Menu Type:  Display only field showing the 'type' of the selection made in the previous
field.

Menu Category:  From the drop-down list select the Ostendo Main Menu Category under which
this User-defined menu item is to appear

Sub Menu Name:  Enter the name of a Sub Menu that will appear under the 'Main Category'
selection.   In Ostendo the above Custom Menu Name will appear as a sub-set to this Sub Menu
Name.

Buttons

Close: This will close the User Defined Menus screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new User Define Menu record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted User Defined Menu record.

5.6 Dashboard Configuration

5.6.1 Dashboard Setup

This screen allows you to create and maintain Dashboards.  

List Tab

The List panel shows a grid of all Dashboards currently in Ostendo

Display fields

Dashboard Name: This is display only that shows the Dashboard Name that exists in Ostendo. 
This is created using the Dashboard panel - see the 'Add' Button (below).
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Title: This is the title of the Dashboard as entered into the Dashboard panel

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking against
will sort in descending order. 

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Dashboards screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the 'Dashboard' panel for creation of a Dashboard.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Dashboard record

Related: This will bring up a list of functions that are related to the Budget.  You may open and
maintain information in those screens whilst still remaining in the Budget screen.

Reports: This will bring up a list of Reports that are related to the Budget.  You can immediately
run the report whilst still remaining in the Budget screen.

Dashboard Tab

This tab enables you to maintain the Dashboard Master.  The content of the Dashboard is defined
via the 'Controls' tab

Entry and Display fields

Dashboard Name: Enter the name of the Dashboard.  Duplicates not allowed

Title: Enter a brief description of the Dashboard.  No checks are made on this entry

Width: Enter the value - in Pixels - of the Dashboard display screen

Column Split%: Enter the percentage split to represent the width of dashboard display relative to
the total width.  For example: If the Percentage Split is 40% then the first Dashboard script will take
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up 40% of the width of the whole Dashboard screen and, if you have a second Dashboard Script,
then it would take up the remaining 60%

Buttons

Close: This will close the Dashboards screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank Dashboard screen in preparation for creating a new Dashboard.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Dashboard panel

Controls Tab

This tab facilitates the entry and maintenance of the individual Displays that are presented in the
Dashboard

Entry and Display fields

Type: Select the Type of display from the drop down list.  The Options are:
· Line Chart
· Bar Chart
· Pie Chart
· Gauge
· Grid

Caption: Enter the caption that will be output to the Dashboard

Display Order: Enter a number that will define the sequence in which the displays are presented
on the Dashboard

SQL Statement: Click on the SQL Button in this field to bring up the Query Builder Screen.   In this
screen you can construct the Query relating to the Display.  For example, you may wish to display
the 'Top 10 Inventory Categories - Stock Holding Value.  You would probably construct an SQL
statement as follows:

select first 10 coalesce(itemmaster.itemcategory,'UnKnown') as "Category" ,
cast(sum(itemmaster.averagecost * itemmaster.onhandqty) as decimal(18,0)) as "Stock
Value"
from itemmaster 
group by 1
order by 2 desc

Width: Enter the Width value - in Pixels - of this Display

Height: Enter the Height value - in Pixels - of this Display

X Label: Enter a brief name that represents the content on the X Axis of the display
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Y Label: Enter a brief name that represents the content on the Y Axis of the display

Buttons

Close: This will close the Dashboards screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to the lower panel in preparation for entry of a new Display

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the currently selected Display in the lower part of the screen

5.6.2 Assign Dashboards

This screen allows you to assign Dashboards to selected Employees.

Entry and Display fields

Dashboard Name: From the drop-down list select the Dashboard that wish to assign to the
Employee

Employee: From the drop-down list select the Employee that you allocating to this Dashboard

Buttons

Close: This will close the Assign Dashboards screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Shortcut record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Assign Dashboards record.

5.7 Queue Service

5.7.1 Queue Settings

This panel defines the settings that allows you to send an email message from information
generated within the Queue Service. 

Email Defaults (SMTP)

From: The sender of the email.  Example info@development-x.com
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Host: The email server account name that services the emails.  For Example:

smtp.youremailserver.com

Port: The Port defined by your email provider.  

Use SSL: If you are using a Secure Socket Layer (SSL) connection then tick this checkbox .

Use TLS:  If you are using Transport Layer Security (TLS) connection, then tick this checkbox.

User: The User Name for access to Host. 

Password: The password for access to Host.

Email Defaults (Receive)

Attachment Path: The default folder path where the received attachments will be stored. 

POP3 settings

Host: The email server account name that receives the emails.  For Example:

pop3.youremailserver.com

Port: The Port defined by your email provider.  

Use SSL: If you are using a Secure Socket Layer (SSL) connection then tick this checkbox .

Use TLS:  If you are using Transport Layer Security (TLS) connection, then tick this checkbox.

User: The User Name for access to Host. 

Password: The password for access to Host.

IMAP settings

Host: The email server account name that receives the emails.  For Example:

imap.youremailserver.com

Port: The Port defined by your email provider.  

Use SSL: If you are using a Secure Socket Layer (SSL) connection then tick this checkbox .

Use TLS:  If you are using Transport Layer Security (TLS) connection, then tick this checkbox.

User: The User Name for access to Host. 
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Password: The password for access to Host.

Mailbox Name: The IMAP mailbox name for receiving emails.  For Example: INBOX

Use SASL Authentication: Tick this box if SASL authentication is used.  

Buttons

OK: This will close the Queue Settings screen.

5.7.2 Queue Schedule

The Scheduling function allows you to run routines at various times and frequencies.  This could
be (for example) to run End of Day 
Statistics, Inventory Replenishment Runs, etc.   The Queue Service covers the following styles of
Events

· Email Report: Used for regular emailing of reports (i.e. send the Weekly Sales report
to the Sales Manager every Friday Night). You’ll also notice there is the ability to enter
the recipients, the body, the selection criteria for the report, CC & BCC email address,
and any file attachments you wish to include with the email.

· Print Report: Used for regular printing of reports (i.e. print the previous days orders
in, every morning). It should be noted there is a new rule in Sales Rules allowing One
Step Invoice printing to use the Queue Service – this can alleviate the need to wait
while the invoice is being sent to the printer before starting the next order.

· Email: Used for sending out regular emails (This feature is very useful for sending
emails based on triggered events - i.e. email a customer once a sales delivery has
been shipped  – see ‘Using Events with Queue Services’ below

· Script: This is designed for executing/running standard scripts at regular/fixed times
(i.e. collate Business Key Performance data and email it to senior management every
week night, run the Inventory Replenishment once a week, etc...).

· DataSheet: Used for generating a pdf of completed datasheet and updating the
document links to the appropriate Job/Assembly/Sales/Purchase/Invoice. 

· This only happens if the Parent Folder Path is defined in General Rules
and the "Create Data Sheet Linked Docs From" is defined in Mobility Rules..

· Accounting Link: Allows for the automated running of the Accounting Link screen
within Ostendo (see the ‘Run’ option for executing the Ostendo-Accounting System
automatically as well)

· Run: This option allows the regular/fixed execution of external applications. This is
useful for running the Ostendo-MYOB, Ostendo-QB, or the Ostendo-Evolution links
automatically – note that you need to pass a command line parameter ‘background’

for the programs to run in none visual mode. 
· Auto Email: This is used to run Auto Email actions set up in Email Services.
· Receive Email POP3: This reads emails sent to the specified POP3 email address and

processes them according to the style specified in Email Services - Email Addresses.
· Receive Email IMAP: This reads emails sent to the specified IMAP email address and

processes them according to the style specified in Email Services - Email Addresses.
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Using Events with Queue Services
There are numerous times when changes in the database require further action (i.e. email the
Customer when a Sales Delivery has been shipped, email the Sales Manager if an order is
greater than a certain value or margin, email the Project Manager if the job/project is going off
track, etc...).  To accommodate this Ostendo contains a database table called ‘
OUTPUTQUEUE’.   This could be written to (via say a Database Trigger) when that event

occurs.   The Queue Service will then action that request.      

List Tab

Display fields

The displayed fields are taken from the Item information entered into the ‘Detail’ tab.  The selection
of which fields to display is at the user’s discretion.  To select the fields to display simply ‘right
mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Queue Schedule screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the 'Detail' Tab ready for entry of a new Schedule

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Schedule

Detail Tab

Entry and Display fields
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Schedule Type: From the drop-down list identify whether it is to be run:
Fixed - At a fixed time of day
Interval - At a defined Interval
Fixed Date - On a Fixed Date

Active: 'Check' this checkbox to make this Schedule active

Days: This is only visible if the Schedule Type is either Fixed or Interval.   When visible 'Check' the
days when it is to be run

Fixed Date: This is only visible if the Schedule Type is Fixed Date.   When visible select the
specific Date from the drop-down calendar

Fixed Hrs/Fixed Mins: This is only visible if the Schedule Type is either Fixed or Fixed Date. 
When visible enter the Time (Hours and Minutes) within the day that this is to be run

Interval (min): This is only visible if the Schedule Type is Interval.   When visible enter the
Frequency (in Minutes) that this is to be run

General sub Tab

Output Type: From the drop-down list identify the type of output required:  The options are

Email Report - Email the selected Report.  The following parameters are required.  You can
identify the Recipients, enter information for the email Body, add selection Criteria, add CC's
and BCC's to the Email and make attachments using the remaining sub-tabs in this screen

Report Name - From the drop-down list select the Report to be emailed
Subject - In up to 50 characters enter the text that will appear in the Subject line
of the email
From Email - The sender of the email. Example info@development-x.com
Host - The email server account name that services the emails. For Example:
smtp.youremailserver.com
User - The User Name for access to Host. 
Password - The password for access to Host.
Use SSL - If you are using a Secure Socket Layer (SSL) connection then 'Check'
this checkbox .
Port - The Port defined by your email provider

Print Report - Print the selected Report.  The following parameters are required.  You can
identify the Recipients, enter information for the email Body, add selection Criteria, add CC's
and BCC's to the Email and make attachments using the remaining sub-tabs in this screen

Report Name - From the drop-down list select the Report to be emailed
Subject - In up to 50 characters enter the text that will appear in the Subject line
of the email
From Email - The sender of the email. Example info@development-x.com
Host - The email server account name that services the emails. For Example:
smtp.youremailserver.com
User - The User Name for access to Host. 
Password - The password for access to Host.
Use SSL - If you are using a Secure Socket Layer (SSL) connection then 'Check'
this checkbox .
Port - The Port defined by your email provider

Email - Send an email.  The following parameters are required.  You can identify the
Recipients, enter information for the email Body, add selection Criteria, add CC's and BCC's to
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the Email and make attachments using the remaining sub-tabs in this screen
Report Name - From the drop-down list select the Report to be emailed
Description - Enter a description that will be output with the Report
From Email - The sender of the email. Example info@development-x.com
Host - The email server account name that services the emails. For Example:
smtp.youremailserver.com
User - The User Name for access to Host. 
Password - The password for access to Host.
Use SSL - If you are using a Secure Socket Layer (SSL) connection then 'Check'
this checkbox .
Port - The Port defined by your email provider

Script - Run the selected Script
Script Name - From the drop-down list select the Script

       DataSheet: Used for generating a pdf of completed datasheet and updating the document
links to the appropriate Job/Assembly/Sales/Purchase/Invoice. 
                         This only happens if the Parent Folder Path is defined in General Rules and the "
Create Data Sheet Linked Docs From" is defined in Mobility Rules..

Accounting Link - Runs the Accounting Link using the Script defined in Files>System
Configuration>System Settings>Accounting Link

Description - Enter a brief description to identify the link. No checks are made on
this entry
Link Mode - From the drop-down list select the Mode of this link.  The options are:

· Import
· Export
· Import and Export

Run - Runs the routine identified in the 'Filename' selection
Description - Enter a brief description to identify this run. No checks are made on
this entry
Filename - From the drop-down list select the routine to be run
Parameters - Enter any parameter values required by this run file

      Auto Email - Runs the Email Actions specified in Email Services - Auto Email.
                        Description - Enter a brief description to identify this run. No checks are made on
this entry

      Receive Email POP3 - reads emails sent to the specified POP3 email address and processes
them according to the style specified in Email Services - Email Addresses.
                        Sub-Folder - The folder path for received emails is already specified in Queue
Settings. Here you can enter a specific folder name to hold the attachments brought in by this
Receive Email function.
                         Host - enter the email host name here.
                         User - enter the email address here.
                         Password - enter the email account password here.
                         Use SSL - Tick this box if SSL authentication is required.
                         Port - Enter the receive email port number here.

      Receive Email IMAP - reads emails sent to the specified IMAP email address and processes them
according to the style specified in Email Services - Email Addresses.
                        Sub-Folder - The folder path for received emails is already specified in Queue
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Settings. Here you can enter a specific folder name to hold the attachments brought in by this
Receive Email function.
                         Host - enter the email host name here.
                         User - enter the email address here.
                         Password - enter the email account password here.
                         Use SSL - Tick this box if SSL authentication is required.
                         Port - Enter the receive email port number here.

Recipients sub Tab

Only available to the Email Report, Print Report, and Email output options.  Enter the full Email
Address of the Recipient.  You may enter more than one recipient but the entries must be
separated by a semi-colon

Body sub Tab

Only available to the Email Report, Print Report, and Email output options.  Enter the text that will
become the 'Body' of the generated email

Selection Criteria sub Tab

Only available to the Email Report, Print Report, and Email output options.  

CC sub Tab

Only available to the Email Report, Print Report, and Email output options.  Enter the full Email
Address of any Recipient that is being given a copy of this email  You may enter more than one
recipient but the entries must be separated by a semi-colon

BCC sub Tab

Only available to the Email Report, Print Report, and Email output options.  Enter the full Email
Address of any Recipient that is being given a Blind copy of this email  You may enter more than
one recipient but the entries must be separated by a semi-colon

Attachments sub Tab

Only available to the Email Report, Print Report, and Email output options.  Click on the 'Add
Attachment' button to locate the attachment.   Repeat this for all attachments

Buttons

Close: This will close the Queue Schedule screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the 'Detail' Tab ready for entry of a new Schedule

Save: Not applicable to the List panel
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Cancel: Not applicable to the List panel

Delete: This removes the current Schedule

5.7.3 Queue Log

The Queue Log shows what Schedules, and when, they were run. 

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Display fields

Name: The Name of the Schedule as maintained in the Queue Schedule screen

Type: The Schedule Type as maintained in the Queue Schedule screen

Date Time: The Date and Time when the Schedule was run

Buttons

OK: This will close the Queue Log screen.

Clear Log: This will remove the displayed Queue Log.

5.8 Email Services

Email Services provides the following capabilities:

· Automatically emailing out Ticket Actions, System Alerts, Calendar Reminders, Sales &
Job Quote Follow ups and History Note Follow ups

· Automatically receiving correspondence emails and auto assigning them to Customers or
Suppliers (also checks all contacts) based on the originating email address 

- this allows for email Forwarding and Blind Copying (BCC) and is smart enough to check if
the email was forwarded from an employee and then determine who the originating source
was. 

- If the email address was not recognised it will be logged as unassigned and can be
assigned through the Operations Centre.

· Automatically receive reply emails from Ticket Actions, System Alerts, Calendar
Reminders, Sales & Job Quote Follow ups and History Note Follow ups emails and do the
following:

- An employee can complete or flag as done the following (Ticket Actions, Calendar
Reminders, Sales & Job Quote Follow ups and History Note Follow ups) by replying with the
word DONE at the beginning of the email subject –more detail later.

- An employee can also email files (photos, PDF’, documents etc...) and have them
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automatically appended to a Job Order/Quote, Sales Order/Quote or Ticket
- An employee can also email notes and have them automatically created as History Notes

and linked to a Job Order/Quote, Sales Order/Quote or Ticket
· An employee can ask for database information via an Email Query. The information will be

emailed back embedded in the body of the email (the body is formatted in Html)
· An employee can request and process a form/spreadsheet via email (Email Form). This

basically means that data entry activities like: Service Sheets, Quotes, Orders, Time sheets
etc... can be setup using spreadsheets and then emailed back to Ostendo for automatic
processing.

· Automatic emailing of a Sales Delivery Advice, defined against the Customer

Setting up Email Services 

Email services uses Queue services to schedule the automatic polling of "receiving from", and
"sending to", email addresses. 
The first thing to do is setup the defaults for your outgoing and incoming email accounts in the
Queue Settings screen 
Next, you need to decide how you want to handle Outgoing Emails and Incoming Emails.

Outgoing Emails:

You need to define what activities you would like to have automatically emailed out and then create
a Queue Schedule record for the Auto Emailing function to run at pre-determined intervals. 
With Auto Emailing, you could send out emails automatically for each of the following activities:
Calendar Reminders, Ticket Actions, History Note Follow-ups, Quote Follow-ups, System Alerts,
and Sales Delivery Advice Notifications. See Auto Emails for more details.
Once you have defined what activities will generate automatic emails to be sent out, you will need
to create a Queue Schedule record to specify the frequency you wish to send out Auto Emails. 

Incoming Emails:

Receiving incoming emails can be automated via the Queue Schedule. You can receive from
either POP3 or IMAP accounts.
These emails are automatically logged into an Ostendo table (EMAILLOG).
Attachments are stored based on the Attachment Path defined in Queue Settings. Subfolder
names can also be defined in the Queue Schedule record.
Incoming Emails can be divided into three types. An email account needs to be set up for each of
these types:

- To Be Assigned: This is usually correspondence email that are to be automatically linked
to Customers and/or Suppliers via the originating email address, or manually assigned within
the Operations Centre.   If your emails are forwarded to the To-Be-Assigned email address,
then Ostendo will automatically link the email to the respective Customer or Supplier.

- Data Only: This address is where data is being emailed in for further processing (e.g.EDI,
E-Commerce Orders, Remote Data Synchronisation, etc.).  These applications require a
specific script written that will process the data accordingly.

- Response: This type of incoming email requires a response which could be automated,
such as Queries, Request for Quote, Submission of Service Spreadsheet or Timesheets for
processing, etc. This is described further in the sections below.

To automate the handling of incoming emails, you should first use the Email Addresses panel to
define the email address for each of the three types of email.  
You should then define a Queue Schedule record for each of these email accounts to specify the
frequency of receiving such emails.

Response Emails:

· Responding to Quote or Note Follow-ups, Calendar Reminders and Ticket Actions
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(DONE ): 

When a User receives an email with a Follow-up, Reminder or Action from Ostendo,
he/she can let the system know that it has been actioned by simply replying to the email and
appending the word DONE to the beginning of the email subject 

Example: User receives an email reminder to follow-up on a specific Sales Quote. The
subject of the email could read something like: 

 {SQ#14661936} Ostendo Quote Follow Up for Customer: [XYZ Limited] Quote
No: [S301306])

The User can indicate that a follow up is to be done by simply appending DONE to the beginning of
the Subject making sure that a space is included between the word DONE and the rest of the
subject 

(i.e. DONE {SQ#14661936} Ostendo Quote Follow Up for Customer: [XYZ
Limited] Quote No: [S301306])

If action notes are required when completing an action, they can be added into the body of the
reply, terminated by typing the character ']' twice (i.e. ]]).  Ostendo will then update the Call Ticket
or Calendar Reminder accordingly.

· Adding Files to Jobs, Sales and Tickets (FILE ):

Users can email files (i.e.Photos, PDF's, etc...) and have Ostendo automatically link it to the
specified JOB, SALES, or TICKET.
The subject needs to start with the word FILE (followed by a space) and then followed by either
JOB, SALES or TICKET with the character # (hash) either side of the Order Number or Ticket ID
(e.g. FILE JOB#125000#).
If notes are required for the linked file they can be added into the body of the reply, terminated by
typing the character ']' twice (i.e. ]])

· Adding History Notes to Jobs, Sales and Tickets (NOTE ):

Users can email in History Notes by simply formatting the email subject based on the following.
The subject needs to start with the word NOTE (followed by a space) and then followed by either
JOB, SALES or TICKET with the character # (hash) either side of the Order Number or Ticket ID
(e.g. NOTE TICKET#78990#). 
The actual History Note is added into the body of the reply, terminated by typing the character ']'
twice (i.e. ]]).
Ostendo will automatically generate the History Note and link it to the respective JOB, SALES, or
TICKET.

· Running a Query and returning the Results as an Email (QUERY ):

Users can request information from Ostendo by using pre-defined Email Queries. Results are
automatically formatted and returned within the body of the email.
When sending in an Email Query, the subject needs to start with the word QUERY (followed by a
space) and then followed by the pre-defined Query name with the character # (hash) either side
of the Key Value (e.g. QUERY JobInfo#125000#).

· Requesting a Form (Spreadsheet) (REQUEST ):

Users can request a pre-formatted Form (Spreadsheet) and have that automatically emailed
back with specific cells pre-filled if defined that way.
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The subject needs to start with the word REQUEST (followed by a space) and then followed by
the pre-defined Form name with an optional character # (hash) either side of the Key Value
(only if needed) (e.g. REQUEST ServiceSheet#125000#).

· Processing a Form (Spreadsheet) (PROCESS ):

Users can email in a pre-formatted Form (Spreadsheet) and have the data automatically inserted
into Ostendo.
The subject needs to start with the word PROCESS (followed by a space) and then followed by
the pre-defined Form name (i.e. PROCESS ServiceSheet).

5.8.1 Auto Emails

Auto Emailing provides the facility to send out emails automatically for each of the following
activities: 

- Calendar Reminders
- Ticket Actions
- History Note Follow-ups
- Quote Follow-ups
- System Alerts
- Sales Delivery Advice Notifications

Entry and Display fields

Email Action: Select the Email Action from the drop-down list. 

Override Email: Tick this box if you wish to use an Override Email instead of the default set up in
Queue Settings.

Override Email Address: Enter the Override Email Address if Override Email is ticked.

Non-assigned Email Address: For Quotes follow-ups the Sales Persons email is used therefore
if there is no Salesperson or that employee doesn’t have an email address then the Non-Assigned
Email Address will be used.

BCC Email Address: Enter a BCC email address if required.

Status:  Set as Active or InActive.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.
.
Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.
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Delete: This will immediately delete the current record from the list.

5.8.2 Email Addresses

Receiving incoming emails is automated via the Queue Schedule, facility is provided to receive
from either POP3 or IMAP accounts and then automatically log those emails in a table within
Ostendo (table is called EMAILLOG). Any attachments are also stored based on the attachment
path defined in the Queue Settings (and can be further segregated via a sub folder name as
defined in the schedule record). The receiving of emails can be split into 3 different types:

· To Be Assigned: This type of email is for correspondence emails that are typically
forwarded to Ostendo for auto linking to Customer and/or Suppliers

· Data Only: This type of email is for where data is being emailed for further processing (i.e.
EDI, E-Commerce Orders, Remote Data Synchronisation)

· Response: This type of email is for where you’re able to reply to, and sign off, actions,
follow-ups and reminders. As previously mentioned you can also Query data, send through
files and notes, and request and process spreadsheets (i.e. Email Forms like Service
Sheets, Quotes etc...)

Entry and Display fields

Email Address Style: Select one from the drop-down list:
· To Be Assigned 

· Data Only 
· Response 

Email Address: Enter the email address designated for the Email Address Style. 

For each email address specified, you need to create a Queue Schedule record to specify how
often you wish to process each of these types of incoming email.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the current record from the list.

5.8.3 Email Queries

An Email Query provides the ability for employees to request a pre-defined query to be run and
retuned via email (in an HTML format). The queries defined here can only be requested by active
employees (checks their email address).

The frequency of processing such queries is defined in the Queue Schedule record (Queue Type =
Receive Email) linked to the Email Address defined for Response Email Address Style.
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Formatting of the Query Results:
The resultant Query when returned as an email is automatically formatted to suit the fields and
records returned. 
You have the option of inserting either a blank line or horizontal line for header fields by including
the following in your SQL statement:

· Blank Line: To insert a blank line define a field in your SQL as BLANKLINE (i.e. ‘’as
BLANKLINE).   This inserts a space between fields. For more than one blank line, append
each with a number (i.e. ‘’as BLANKLINE1, ‘‘as BLANKLINE2, etc...)

· Horizontal Line: To insert a blank line define a field in your SQL as HORIZONTALLINE (i.e. ‘’
as HORIZONTALLINE).   This inserts a horizontal line between fields. For more than one
horizontal line, append each with a number (i.e. ‘’as HORIZONTALLINE 1, ‘‘as
HORIZONTALLINE 2, etc...)

Entry and Display fields

Query Name: This is the name the Query is referred to in the Email Subject line.

Query Description: This is an internal description of the Query.

Email Subject: This is the subject text that will be sent back to the employee (e.g. Assembly Order
Detail for [KEYFIELD] - where KEYFIELD is the value passed for the query.

Header Title: This will appear as a title for the header fields in the Body of the email sent to the
employee.

Header Note: These notes, if entered, will be inserted directly under the Header title in the body of
the email. 

System Header SQL: This is the SQL statement provided with the system. This will only be filled
in where the Query is a standard, system-supplied one. It cannot be modified, but can be copied
and used in the Company header SQL.

Company Header SQL: This is where you could enter your own SQL statement to generate the
Header fields instead of using the System Header SQL.

Lines Title: This appears as a title for the lines fields in the Body of the email.

Lines Note: These notes, if entered, will appear directly under the Lines Title in the body of the
email.

System Lines SQL: This is the system-supplied SQL to generate the lines. It cannot be modified,
but can be copied and used in the Company Lines SQL.

Company Lines SQL: This is where you could enter your own SQL statement to generate the
Lines fields instead of using the System Lines SQL.

Footer Note: These notes, if entered, will appear in the footer of the body of the email.

Lookup Index: This links a Lookup Index (like what is used in Report & View Conditions) and is
for running the Email Query under 'General-Run Email Query'.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.
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Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the current record from the list.

5.8.4 Email Forms

The purpose of Email Forms is to automatically process spreadsheet (.xls) forms sent in by users.

The frequency of processing such Forms is defined in the Queue Schedule record (Queue Type =
Receive Email) linked to the Email Address defined for Response Email Address Style.

Entry and Display fields

Form Name: Enter the name of the Email Form.

Description: Enter a description of the Email Form.

System Request SQL: This is the SQL statement provided with the system. This will only be filled
in where the Email Form is a standard, system-supplied one. It cannot be modified, but can be
copied and used in the Company header SQL.

Company Request SQL: This is where you could enter your own SQL statement to generate the
required fields instead of using the System Request SQL.

Spreadsheet Filename: This is the full path for the Spreadsheet File.

KeyField Required: Tick this box if a KeyField is required.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the current record from the list.

Email Forms can be used in a variety of ways. For example:
· An estimator may be using an excel spreadsheet to generate all the information required to

prepare a quote. If this spreadsheet information is prepared in a certain prescribed form, he
could email it to Ostendo and a quote could be generated in the system without having to
re-key in the information into the Ostendo Quote Detail and Lines screens.

· Service personnel could be emailed service sheets in the form of spreadsheet attachments.
They could use tablets or laptops in the field to view the job information in the spreadsheet
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and at the same time fill in notes, time & material usage. The completed spreadsheet form is
then emailed back to a designated email address where a Queue Service script can be run
at regular intervals to update the relevant job or timesheet tables.

· A spreadsheet form can be designed to collect all sorts of data. Ostendo Email Forms can
facilitate such data collection needs by receiving the emailed forms, processing them, and
updating any Ostendo system or user-defined tables.

· Email Forms can replace paper forms. Paper forms are often required to be filled, reviewed,
and approved before the data in those forms can be loaded into Ostendo (for example New
Customer process). A spreadsheet form can be designed for the same purpose. Instead of
pushing paper, the spreadsheet can be circulated via email and filled in by various
individuals before finally being sent to a designated email address and a new Customer
record is automatically generated in Ostendo.

To learn how to implement Email Forms, request for the Email Forms package from HelpDesk.
The package consists of sample Forms, scripts, and a tutorial.

5.8.5 Email Form Errors

This screen displays errors logged when processing Email Forms.

Display fields

Employee: Name of employee requesting or submitting Email Form.

Email ID: Email address of employee.

FileName: The full path of the spreadsheet Form.

Errors: Error description.

Button

Close: This will close the screen.  

5.8.6 Email Blacklist

You can blacklist certain email addresses via this screen. 

Entry and Display fields

To Email Address : Enter the TO email address you wish to blacklist. This means any email sent
to this address will not be processed by Email Services. If the FROM email address field is blank,
then ANY email with this TO address will be blacklisted.

From Email Address: Enter the FROM email address you wish to blacklist. If the TO email
address is blank, then ANY email coming from this email address will be blacklisted by Email
Services.

If BOTH TO and FROM email addresses are filled in, then only emails with that specific
combination of TO and FROM addresses will be blacklisted.
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Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the current record from the list.

5.9 API Service

The Ostendo API Rest Service provides the facility for external third-party applications to integrate
with Ostendo. 

Any application which can make HTTP calls can integrate with Ostendo via this service. 

Even common applications like MS Excel can be integrated with Ostendo via user-written macros
which talks to the Ostendo API Service.

When the Ostendo API Service is switched on or STARTED, external applications can GET
information from or POST information to any table in the Ostendo database. A unique feature of
the Ostendo API service is the ability to post  SQL queries to extract specific data from one or
more tables.

Please note that even if all users are logged off from Ostendo, the API service remains active and
running until it is STOPPED.

The data format used is primarily XML. 

As a security measure, only developers/applications which are defined and authorised in the
Ostendo database can have access to the API Service. It is recommended that, for enhanced
security, use HTTPS instead of HTTP.

5.9.1 API Configuration

For enhanced security, it is strongly recommended that HTTPS be used in preference to HTTP.
This is because all HTTPS sessions are encrypted. Use HTTP only if the Http requests are not
routed via the internet.  To use HTTPS, you would require a SSL Certificate and SSL Key.

The API Service Configuration consists of a Settings tab and provision for up to 10 Configuration
tabs.

Settings Tab

This tab defines the general settings required for the API Service. 

Service Port: (For HTTP only) Specify the network port which is dedicated to this API service.

Use Https: Tick this box if you are using HTTPS.

Https Port: Specify the HTTPS port if using HTTPS.  
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Static File Directory: Specify the directory of the Static File Folder. This folder is where you store
html pages which can be accessed by the API user. 

Alternate DB Username: If the Firebird Database Username is not the default, then enter it here. 

Alternate DB Password: If the Firebird Database Password is not the default, then enter it here. 

Override Local IP Address: For HTTP: If there is more than one IP address for that server, this
allows you to specify the specific IP address used for the API Service when connecting locally.
For HTTPS: Enter the Domain Name here. (The domain which has the SSL certificate issued by a
Certification Authority.)

Override Remote IP Address: For HTTP: If there is more than one IP address for that server, this
allows you to specify the specific IP address used for the API Service when connecting remotely.
For HTTPS: Enter the Domain Name here. (The domain which has the SSL certificate issued by a
Certification Authority.)

Note: For HTTPS, the SSL certificate needs to be installed and configured using windows http.sys
.

Config Tabs

There are ten configuration tabs (Config 0 to Config 9) allowing you to define up to 10 databases
that can be accessed via the API Service. 

Active: Tick this box if you want the Database named below to be accessible via the API service.
This allows you to switch ON or OFF the API access to the database.

Allow Freeway Access: Tick this box if you want the Database named below to be accessible by
the Freeway Mobility apps.
Note: The Ostendo API Service must be activated/re-started whenever the Mobility License
Code is loaded (in Mobility Rules).

The Mobility App can connect to Ostendo either via wifi - Local Area Network (LOCAL) or via the
internet/WAN (REMOTE). This preference is specified in the Configuration Values of the Freeway
app.  For REMOTE connection, you will need to get the IPv4 address of your Ostendo server and
set up Port Forwarding on your router so that all calls to that API port will be forwarded to the
Ostendo server correctly.

NOTE: For operating environments with very strict security where access to websites are tightly
controlled, please ensure the following two sites are allowed:

www.freewayapi.com
http://api.ipify.org

This is required to allow Freeway to send API keys to the cloud and determine IP addresses stored for
Freeway.

Database Filename: Specify the full path of the Ostendo database.

Buttons

API Service: This button allows you to Start, Stop, Install, and Uninstall the API Service.

http://www.freewayapi.com
http://api.ipify.org
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OK: This will close the API Service Configuration screen.

Cancel: This will cancel all changes made.

5.9.2 API Security

The API Security screen allows you to authorize one or more third-party developers and products
and Freeway Mobility users to have access to your Ostendo API Service. 
It also enables you to generate the API key for each developer-product / Freeway Mobility user.

For Freeway usage, it is mandatory to have separate API Security records for Employees, for
Customers, and for SubContractors. This is to prevent customers and subcontractors from
"accidentally" accessing Freeway/Ostendo as an employee.

Entry and Display fields

Developer Name: Enter the name of the Developer. 

Product Name: Enter the name of the Product or Application.

Expiry Date: The date this authorisation will expire.

SQL Allowed: Tick this box if this Application is allowed to use SQL to query the Ostendo
database.

API Key for: Select one of the following styles:

- Internal : Generally for internal Freeway users
only. 

- Mobility B2B : For Customer Freeway users
- Mobilty SubContractor : For Subcontractor Freeway users

Multiple employees can share the same Internal API Security record.
Similarly, multiple customers can share the same Mobility B2B API Security record and multiple
subcontractors can share the same Mobility SubContractor API Security record.

Third-party software can use any of the above styles.

Buttons

Close: This will close the API Security screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new API Security record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the current record from the list.

API Key: This will generate the URL-encoded API Key for the current Product/Application. 
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Fast Code: This will generate a short code which can be sent to a Freeway mobility user. When
the mobility user keys in this Fast Code into the app, it will pull the actual API Key and the Freeway
License key into the app. This simplifies the process of loading the Keys into the Freeway mobility
app. 
The Fast Code can be used multiple times until its expiry as specified in Mobility Rules. 

Fast Codes are normally generated via the Employee Mobility Settings screen or the Customer
Mobility Screen.

5.10 Desktop Tile Templates

Ostendo Desktop Tiles are like windows tiles - they are just shortcuts to Ostendo
programs/reports or files or to external URL links. 

By default, Ostendo has one System Default Tile Template that is specified globally at a
System level. (You cannot modify this). Below this level, Users can be linked (via their
Security and Options) to specific User-default Templates.

If no Template is defined at a User Level, the System Default is used.

At an Administration level , one or more new Tile Collections (Templates) can be
created (eg: Manufacturing, Sales etc..) and linked to appropriate users. 

Each Tile Collection (Template) can have multiple custom Desktop Tiles with different Tile
Colours or a Tile graphic to represent the Tile shortcut.

When a Tile Collection (template) is assigned to an Ostendo User (in Security -- Options),
it serves as his or her Default Tile Collection. (If the user has no assigned Tile Collection,
then by default he/she gets the System Default Tile Template.)

At the User Level, individual users can further control their specific Tiles layout presented
under their profile by right-clicking on the Ostendo desktop background or on the tile itself
or just move the tiles and re-positioning them by dragging them around the desktop... 

Right-clicking on the Ostendo Desktop background will display the following buttons at
the bottom right of the screen:

Title Clicking this button allows the user to modify the title of
the Tile Template

Reset Clicking this button will reset back to the unmodified Tile
template or System Default Template (if none is assigned)

New Tile Clicking this allows the user to add a new tile to the
desktop

Group Captions Clicking this allows the user to modify or delete the group
captions.
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A new group can be created by dragging a tile left or right until a vertical bar appears and
dropping the tile onto the vertical bar..

Right-clicking on one or more Tiles will display the following buttons on the bottom left of
the screen:

Clear SelectionThis un-selects the selected tiles

Small Reduce the size of the selected tile(s) to a quarter of the
regular size.

Regular (Note: this button only appears if the selected tile(s) is not
of regular size). Restore the tile(s) to Regular size.

Large Double the size of the selected tile(s) (Rectangle shape)

Extra Large Increase the size of the selected tile(s) to 4 times the
regular size

Properties This allows you to change the Tile Caption, Caption
colour, Icon, tile colour, tile background image or delete the selected tile(s)

Assign This allow you to change the assignment of the tile to
some other Ostendo Menu item. Remember to select the menu item after clicking on the
Assign button.

In summary, the user can perform the following with the tile layout on his Ostendo
desktop:

· Amend the Template Title

· Add  / Move / Delete Individual Tiles

· Amend Tile Captions

· Amend Tile Sizing to Regular / Large (Rectangle) / Extra Large

· Assign Buttons to Ostendo options eg: specific Reports / Inquiries, screens etc.

· Create  / Rename Tile Groups

· Reset entire User Tile Customisation back to the Standard Tile Template linked to
that User

5.10.1 Tile Collections

This screen allows you to specify the names of each Tile Collection (template).

Each Tile Collection (Template) can have multiple custom Desktop Tiles with different Tile Colours
or a Tile graphic to represent the Tile shortcut

Entry and Display fields

Name: Enter the Name of the tile Collection.
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Description: Enter the Tile Collection description here.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the current record from the list.

5.10.2 Desktop Tiles

This screen allows you to add tile definitions to the Tile Collections (template).

Each Tile Collection (Template) can have multiple custom Desktop Tiles with different Tile Colours
or a Tile graphic to represent the Tile shortcut

Entry and Display fields

Collection Key: Select the name of the Tile Collection from the drop-down list. 

Link Type: Select the type of shortcut link from dropdown list (System Action / URL / File)

Link Value: Depending on the Link Type, enter or select the required System Action / URL / File
Path

Caption:  Enter the tile caption or accept the default

Image:  Select the relevant icon image to represent the tile function from the dropdown list.

Background Image:  Right-click on the empty box to load the desired image to be used as the tile
background.

Tile Size: select the desired tile size from the dropdown list (Small / Regular / Large / Extra Large)

Tile Colour:  Select the tile colour (if you do not specify a Background Image)

Caption Colour: Select the caption colour (Black or White).

'
Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen
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Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the current record from the list.

5.11 Custom Menu Links

This screen allows you create links to other files or functions in your computer network and have
them displayed under their own menu within Ostendo.   Upon creation of the first ‘Link’ record a
menu heading called ‘Custom’ will appear on the top toolbar and the link will be displayed in the
drop-down list under it.   

Entry and Display fields

Caption: Enter the name of the Link.  This name will appear in the drop-down list under the ‘
Custom’ menu

File Name: This is the full path to the documents, spreadsheet, or program that you are linking to.
Click on the three dots to bring up a panel.  Within that panel locate the path to the file.  The file
format can be any file extension recognised by your computer (Example, .doc for document, .exe
for a program, etc)

Buttons

Close: This will close the Custom Menu Links screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a blank line in readiness for creating a new menu link

Save: This will save the current dates without exiting the screen

Cancel: Any changes made to a date since the last time the ‘Save’ Button was pressed will be lost
and the dates will revert to it’s pre-change position.

Delete: After confirmation this will delete the selected menu link

5.12 Custom Data Screens

If you have created a Custom Data Screen using the Custom Scripts facility then this Menu Item
will appear.  You can then make these Scripts available to selected Users via the User Security
and Options function

5.13 Switch User

This screen allows you to switch to another User Name within the same Company.  The standard
sign-on panel will be presented for entry of the User and Password.  Upon acceptance the screen
layout and access functions linked to the new User will be applied.

Entry and Display fields

User Name: Enter the name of the User.  The program does a progressive search during entry
until a unique name is encountered; after which the full name will be displayed.
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Password: Enter the password for this User.  If you have forgotten the password then a User with
Administrator rights can reset this for you.  

Buttons

OK: Log into Ostendo as this User.  Upon entry as the new user the ‘User Name’ on the main
Ostendo panel will intermittently flash for a few seconds

5.14 Change Company

This screen allows you to switch to another Ostendo database on your network.   This company
must already have been set up via File>System Configuration>Multiple Companies.  Upon gaining
access to the new Company the standard sign-on panel will be presented for entry of a Username
and Password.  

Note: This selection is de-activated if you currently have a Screen open in this Company

Entry and Display fields

Select Company: From the drop-down list select the company that you wish to access.  This
company must already have been set up via File>System Configuration>Multiple Companies.

Buttons

OK: The standard sign-on panel will be presented for entry of the User and Password.  This user
must already exist in this company’s database.  Upon entry to this Company the Company Name
on the main Ostendo panel will intermittently flash for a few seconds.

Cancel: Cancel this requirement and remain in the current Company database.

5.15 Change Password

This facility allows the user to change the password.  In changing this, the current password is
required to be entered.  This is followed by the new password (displayed as asterisks).  

To ensure that the new password has been entered correctly you are asked to re-input so that
validation can take place.    

If a password is forgotten it can be reset by an Administrator via File>System Configuration>User
Security and Options.  This resets the Password to ‘pass’.  The User should call up this screen to
change it from the ‘pass’ condition

Entry and Display fields

Username: Display only field showing the name of the current signed-on User

Password: Enter the new password.  It is recommended that this be a combination of alphas
(combination of upper and lower case) and numerics.

Verify Password: As you cannot see the previous entry you are asked to input again to validate
that the entry is correct.  If both the New and Verify Passwords are the same then the change is
accepted.

Buttons
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OK:  The program validates that the current password is correct as well as the New and Verify
passwords are the same.  If all is correct then the password will be updated.  If any errors are
detected then a message will be returned and the program exited.

5.16 Active Connections

This screen allows you to view Users who are currently signed onto Ostendo.   The number of
current Users signed on is displayed at the top of the screen and the individual Users are listed
below.   If you have Administrator rights in Ostendo you may also disconnect any currently
signed-on User

Get Connection Details (Button): Click this button to refresh the signed-on User count plus  the
details in the lower part of this screen.

Display fields

User Name: Display only field showing the Name of the User 

Connection ID: The current connection ID allocated by Ostendo.  If this is a negative number then
this denotes that it is an external User

Computer Name: The Name of the computer where the User is currently signed on. 
Sometimes the Computer Name may be blank due to various reasons. For example this is the
case when a mobile device (Freeway app) is connecting to the database via the ostendo API
Service.

Note: for connections via the Ostendo API service, these connections will appear for each Freeway
app (or third-party app) connected. Once the app is offline, the connection will also drop from the
list (may take a few seconds to refresh). In any case, no matter how many connections is made via
the Ostendo API service, they are all counted as one user license only (i.e. the Ostendo API
Service license).

Logged in At: The date and time when the User Logged into the Ostendo database.

App Path : The Application Path shows the application used to connect to the database.

App Response : Shows either "Responded" or "Not Responding".

Session Type : Shows the type of User Session; example: Ostendo User, Queue Service, Web
Service, etc.

Buttons

Close: This will close the Active Connection screen.  

Remove: This is only active if you are an Ostendo Administrator.  When active clicking this button
will remove the currently selected User  

5.17 Data Importing

This function allows you to populate tables and fields in Ostendo with data from an outside source. 
The procedure uses a simple Wizard that takes you through the whole process as follows.  You
should note that this uses a standard data Importing function used throughout Ostendo therefore
not all entry fields are required.
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IMPORTANT NOTE:  You should be aware that, in Ostendo, the apostrophe (‘) is not allowed in ‘
Key’ fields.  If the key field (Example, Customer, Supplier, Item, Descriptor, etc) in the source file
contains an apostrophe then it must be amended to a ‘backwards’ apostrophe (found on your
keyboard to the left of the number 1 key) before importing.  If this is not done then the import will
be rejected.
You should also be aware that if you make this change when importing Suppliers then any linked
Financial package should also have their Supplier Code amended

Step 1: Click on the appropriate ‘Radio’ button to select whether the data being imported is in a
Comma Separated Value (.csv) or a Excel Spreadsheet (.xls) file format then click the ‘Next’
button.  Note: The ‘Load Specification’ button is described in Step 7

Step 2: Select the Table into which the data is being imported and click the ‘Next’ button

Step 3: Point to where the source file resides, and then inform the import routine as to the
following conditions in that file:

Start at Row - From which row in the import file is the importing to commence
Field Names - tell the program which row in the import file contains headings
Record Separator - unless you have specifically defined otherwise leave this as CRLF
Text Qualifier - unless you have specifically defined otherwise leave this as “

Click the ‘Next’ button.  

Step 4: You should now match the fields in your .csv or .xls file with the equivalent fields required
in Ostendo.  Simply click on ‘(Click here to map)’ at the top of each column and match the column
content to that required by Ostendo.  Once each field has been mapped click the ‘Next’ button.  

Step 5: Define the format of the fields in the Import File.   This allows the import routine to convert
it from the .csv file (or .xls file) format to the format defined in the Regional Settings of your
computer.

Step 6: You can now tell the Import routine what you want it to do with the data relative to existing
information in Ostendo.  I.e.:

· Append - Add all records even if they currently exist in Ostendo
· Update - Update existing Ostendo records where there is a matching key.  You will be

required to identify the unique key field identity from the drop-down list
· Append/Update - Add the record if it doesn’t exist and update the record where there is

a matching key.  You will be required to identify the unique key field identity from the
drop-down list.

· Delete - Delete existing records where there is a matching key.  You will be required to
identify the unique key field identity from the drop-down list

· Copy - Delete all existing records in Ostendo and recreate from the import file.
· Append New - Add a new record where the record in the Import file does not currently

exist in Ostendo.  You will be required to identify the unique key field identity from the
drop-down list

Click the ‘Next’ button.  

Step 7: This screen confirms your settings.  Ensure that all the settings are correct.  

At this point you will see that the ‘Load Specification’ button has changed to ‘Save Specification’.  If
you click on this button then you can save the results of Steps 1 through 6 and use this in future
rather than go through each step in turn.

Click the ‘Execute’ button to perform the import.  
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5.18 Data Exporting

This function allows you to export data in Ostendo to either a Comma Separated Value file or an
Excel Spreadsheet.  The procedure uses a simple Wizard that takes you through the whole
process as follows.

Step 1: Click on the appropriate ‘Radio’ button to select whether the data is to be exported to a
Comma Separated Value (.csv) or a Excel Spreadsheet (.xls) file.

Step 2: Point to where the generated file will reside and give it a name.   You can also specify the
following conditions that will apply to that file if it a is a .csv output format:

Record Separator - select the record separator from the drop-down list
Text Qualifier - select the Text Qualifier from the drop-down list

Click the ‘Next’ button.  

Step 3: Select the Table from which the data is being exported and click the ‘Next’ button

Step 4: The fields in the selected table will be displayed.  They are all pre-selected for output.  You
have the option to:

· Select specific fields by checking or unchecking the checkbox adjacent to each field
· You can alter the sequence in which they are output by dragging and dropping the field

into the required position
Click the ‘Next’ button.  

Step 5: Define the format of the fields in the Exported File.   This allows the export routine to
convert it from the current Ostendo settings (defined in the Regional Settings of your computer) to
that required in the exported file.

Step 6: This screen confirms your settings.  Ensure that all the settings are correct.  

Click the ‘Execute’ button to perform the export.  

5.19 Accounting Link

Entry and Display fields

For Automated Accounting Links (AccountRight Live, MoneyWorks, QBO, Sage Evolution Live,
Xero), the following applies:

Last Time this Process was run: Display only field showing the last time that a batch of
transactions was posted. 

For Batched Accounting Links (MYOB, Quickbooks, Reckon Desktop, Reckon Hosted, Sage
Pastel), the following applies: 

This screen will process all Accounting Transactions that have not yet been processed by creating
and sending a single batch file to a separate Accounting Interface routine.  The data in that routine
will post to the respective Accounting System and will return a status of the Batch and all included
transactions.

Last Time this Process was run: Display only field showing the last time that an Accounting Link
batch run was generated.
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Number of Batches Received: Display only field showing the number of Batches that have been
returned that contain an invalid transaction.  If this is greater than zero then the button ‘Display All
Batches that Failed’ will be available for you to look at the invalid transaction(s)

Import Received Batch Files: If this is ‘checked’ then those batches and their transactions -
previously sent to the Accounting Interface routine - will be updated with the status as held in that
routine.  If any Batch contained errors then this will be reflected in the count displayed in ‘Number
of Batches Received’ field

Export Batch Files for sending: If this is ‘checked’ then the following actions will take place.

· All outstanding Accounting Transactions in Ostendo will be pulled together into a single
Batch and sent to the Accounting Interface routine awaiting posting to the third-party
Accounting system.

· All new Purchase Invoices from Ostendo will be sent to the Accounts Interface module in
preparation for updating the third-party Accounting system.

· All new or amended Supplier records in Ostendo will be sent to the Accounts Interface
module in preparation for updating the third-party Accounting system.

Buttons

Display All Batches that Failed: This button will only be visible if there are any ‘Failed’ Batches.
If you click this button then the following screen will be displayed

List panel
This panel shows all the batches that contain transaction errors. Batches and their
Transactions in error will be displayed for your reference.

Detail Panel
For the selected Batch this panel shows, by Accounting area, all transactions that were
found to contain errors.  The displayed fields are:

Date: The date the transaction was created.  This can be amended here if
required.
Reference: The Reference to the source of the transaction.  This reference is
specific to the Accounting Area being addressed
Debit Cost Centre: The Debit Cost Centre linked to the transaction.  This can be
amended here if required.
Credit Cost Centre: The Credit Cost Centre linked to the transaction.  This can
be amended here if required.
Failure Message: Details of the error

(Button) Close: Closes the Failed Batches screen

(Button) Re-Post Batch: This will reset all the ‘failed’ Transactions with status ‘Ready to
Send’.  These will then be picked up and included in a new Batch when the ‘Process Batch
Files’ Button (below) is selected.

Process Batches:  For Automated Accounting Links, this will trigger the posting of "Ready
to Send" transactions, if any exists. 

For Batched Accounting Links, all current Accounting Transactions in



164 Ostendo Reference Guide

Ostendo will be pulled together in a single Batch and sent to the Accounting Interface routine
where it will await posting to the third-party Accounting system

Re-Process Old Batch:  If this is selected then a panel will be presented for you to select and
re-send a previously sent Batch.  This is used where - for whatever reason - the original batch had
not been return with a Batch Status update from the Accounting Interface routine.  

Export Lookup Files:  (For Batched Accounting Links only) Selecting this button will send the
current Cost Centres and Tax Codes from Ostendo to the Accounting Interface routine where it will
mapped to Account Codes within the third party accounting system 

Close: Close this Accounting Link process and exit the screen.

5.20 Archive Viewer

In the Report and View developer you can identify which Reports/Forms are to be archived when
printed. This Viewer allows you to view these archived documents and reprint them if required. 
Simply locate the required document and click the ‘Open’ button.  You cannot amend any
document displayed via the viewer.
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6 General

6.1 Company Sites

This screen allows you to define multiple sites within the company.  Company Assets and
Warehouses are linked to a company site and facilitates analysis of stored data by Site

List Tab

Display fields

The displayed fields are taken from the Company Site information entered into the ‘Detail’ tab.
The selection of which fields to display is at the user’s discretion.  To select the fields to display
simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Company Sites screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of new Company Site details.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Company Site from this table

Detail Tab

Entry and Display fields
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Site Name: Entry is only allowed during an Add transaction.  Enter the name of the new Site.  
Duplicate site names are not allowed

Physical Address: Three lines are available for entry of the physical address of the site.  No
checks are made and this can be amended at any time.

Site Contact: Select the main contact at this site from the drop-down list.  The drop-down list is
taken from the current list of Employees

City: Enter the Town or City where this Company Site is located.

State: Enter the State where this Company Site is located.

Code: Enter the Postcode or Zone Improvement Program (ZIP) Code where this Company Site is
located.

Country: Enter the Country where this Company Site is located.

Phone Number: Enter the Telephone Number of the Company Site

Fax Number: Enter the Facsimile Number of the Company Site

Default POS Warehouse: From the drop-down list select the Warehouse to be used as the
default Warehouse for Point of Sale when logged into this Company Site.  This Warehouse will be
used if no other Warehouse is specified during POS transactions.  Warehouses are maintained via
Inventory>Warehouses

Default POS Location: From the drop-down list select the Location within the above Warehouse
to be used as the default Warehouse/Location for Point of Sale when logged into this Company
Site.  This Location will be used if no other Location is specified during POS transactions. 
Locations are maintained via Inventory>Locations.

POS Sales Type: From the drop-down list select the Sales Type to be used as the default Sales
Type for Point of Sale when logged into this Company Site.  This Sales Type will be used if no
other Sales Type is specified during POS transactions

Replenish From Site: If you replenish inventory by transferring Items from another site then you
should select the 'From Site' from the dropdown list.    The Transfer batch as generated from the
'Create Required Orders' screen (Requirements>Create Required Orders) will use this Site as the
source of the Transfer

Notes: You can enter unlimited amount of Notes that are related to this Company Site.  These
notes will be available wherever the Site is reported.  Whenever you click on this field an icon will
appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text table. 
Select the text to be copied and either press the OK Button in that screen or double-click the
selected record.

Buttons

Close: This will close the Company Sites screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of new Company Site details.

Save: This will save the current data without exiting the screen
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Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

6.2 Company Assets

This screen allows you to define Company Assets. These Assets can be linked to Service Jobs
and a complete Service History maintained

List Tab

Display fields

The displayed fields are taken from the Company Asset information entered into the ‘Detail’ tab. 
The selection of which fields to display is at the user’s discretion.  To select the fields to display
simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Assets whose
status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Company Assets screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Company Asset.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel
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Delete: This removes the current Company Asset from this table

Related: This will bring up a list of functions that are related to the Company Asset.  You may open
and maintain information in those screens whilst still remaining in the Company Asset screen.

Reports: This will bring up a list of Reports that are related to the Company Asset. You can
immediately run the report whilst still remaining in the Company Asset screen.

Detail Tab

Entry and Display fields

Asset Name: Entry is only allowed during an Add transaction.  Enter the name of the new Asset.  
Duplicate Asset names are not allowed

Asset Number: This is an open format field where you can enter any unique identifier for this
Asset.   No validation checks are carried out.

Asset Type: Select the Asset Type from the drop-down list.  Asset Types are user-maintained
under General>Settings>Asset Type.

Status: Select the current status from the drop-down list.  The options are ‘Active’ or ‘Inactive’

Calendar Order: Select the position (commencing from 0) that determines where this Company
Asset will appear in the Job Calendar

No Scheduling: If this is 'checked' then this Company Asset will not display in the Shop Calendar
and the Assignment Board.  

Assignment Image: Select an image for this Asset to be displayed in the Assignment Board.

Description: Enter a brief description of the Asset.  A longer description can be entered into the
Notes (see below)

Department Code: From the drop-down list select the Department Code to which the Asset
belongs. Department Codes are user-maintained under General>Settings>Departments.

Physical Location: Enter the physical location within the Company Site where the Asset is
located.  This is open format and no validation checks are made against the entry.

Qty: Enter a number here if there are multiple quantities of this Asset sharing the same asset
name and number.

Site Name: From the drop-down list select the Company Site where the Asset is located.
Company Sites are user-maintained under General>Company Sites.

Default User for Reminders: From the drop-down list select a User.  All Employees linked to this
User will be emailed a Reminder when activity against this Asset is due.

Maximum Weight: The total weight of the Asset(s). This is used for Deliveries to calculate the
weight when this asset is used.

Maximum Volume: The total volume of the Asset(s) - Used for Deliveries to calculate the volume
when this asset is used. 
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Linked Service Asset Info

Service Asset:  If you already have an existing record in Customer Assets defined for this
Company Asset, you can now link it by selecting the Asset name in this field and press “Create
Service Asset” button.
If you do not have a Customer Asset record defined for this Company Asset, then you can leave
this field blank. Pressing the “Create Service Asset” button will create the Customer Asset record
with the same name as the Company Asset and link them.

(Button) Create Service Asset:  Pressing this button will link an existing Customer Asset record
(specified in Service Asset field) to this Company Asset record or create a new Customer Asset
record (if Service Asset field is blank) for this Company Asset record and link them.

Purchase Details & Asset Values 

Supplier: Enter the name of the Supplier from whom the Asset was purchased.  This is open
format and no validation checks are made against the entry.

Purchase Number: For your own reference enter the originating Purchase Order Number for the
Asset.

Purchase Date: Select the date - from the drop-down calendar - when the Asset was purchased

Original Value: Enter the original Purchase Price of the Asset.  No validation checks are made
against the entry.

Warranty Applies: If a Suppliers or Manufacturers Warranty has been supplied with this asset
then ‘check’ this checkbox to open up the next two fields.

Warranty Expiry: Select the date - from the drop-down calendar - to indicate when the Warranty
will expire.

Warranty Reference: Enter the reference identity of the Warranty.  This is open format and no
validation checks are made against the entry.

Asset Tracking Information

Asset Currently At: Display only field showing where the Asset is currently located (Customer,
Supplier, or On Site).  The specific location is maintained via the ‘Asset Tracking’ button.

(Button) Asset Tracking: This will bring up a separate screen where you can maintain the current
Location (and location history) for this Asset.  For more information on the Asset Tracking function
see later in this Reference Guide.

Notes Tab

Notes: You can enter unlimited amount of Notes that are related to this Asset.  These notes will be
available wherever the Asset is reported.  Whenever you click on this field an icon will appear in
the top-right.  By clicking on this Icon you can bring up the Frequently Used Text table.  Select the
text to be copied and either press the OK Button in that screen or double-click the selected record.

Capabilities Tab
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This panel allows you to record the Asset's capabilities.

Capability Name: Select from drop-down list of pre-defined Capabilities. An asset can have
multiple capabilities. Add a record for each capability.

Capability Expires: Tick this box if this Capability has an expiry date. 

Capability Expiry: If the previous box is ticked, then enter the expiry date here.

Reference: If the capability is a Licence or a Qualification, this would be a Licence Number or
Certificate Number. 

Buttons

Close: This will close the Company Asset screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related:     This will bring up a list of functions that are related to the Company Asset.  You may
open and maintain information in those screens whilst still remaining in the Company Asset
screen.

Reports:     This will bring up a list of Reports that are related to the Company Asset.  You can
immediately run the report whilst still remaining in the Company Asset screen.

History Tab

Display fields

This screen shows the full Service History for the selected Company Asset.

Job Type: The Type of Job that created this record.  Job Types are maintained under the
Job>Settings>Job Types

Order Number: The Job Number against which the Service was carried out

Order Date: The date when the Service was carried out

Status: The current status of the Job taken from the Job record

Actual Cost: The Cost of the Service to maintain this Asset

Buttons

Close: This will close the Company Asset screen.  If you have any unsaved data then you will be
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asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Company Asset

Save: Not applicable to the History panel

Cancel: Not applicable to the History panel

Delete: Not applicable to the History panel

Related: This will bring up a list of functions that are related to the Company Asset. You may open
and maintain information in those screens whilst still remaining in the Company Asset screen.

Reports: This will bring up a list of Reports that are related to the Company Asset. You can
immediately run the report whilst still remaining in the Company Asset screen.

6.2.1 Company Asset Properties

This screen allows you to define properties that are specific to a Company Asset.  Property titles
are user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Company Assets.

Display fields

The displayed fields are taken from the Company Asset Details.  The selection of which fields to
display here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons



172 Ostendo Reference Guide

Close: This will close the Assets Properties screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Asset Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Asset Name: Display only field showing the Asset selected in the List screen

Description: Display only field showing the description of the Asset selected in the List screen

Status: Display only field showing the status of the Asset selected in the List screen

Site: Display only field showing the Company Site where the Asset is located

Lower Panel

Property: From the drop-down list select the Standard Property against which a value specific to
this Asset will be made.  Standard Properties are maintained via General>Settings>Standard
Properties

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Buttons

Close: This will close the Company Asset Properties screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Asset Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Asset Property record or the last time the ‘Save’ Button
was pressed will be lost.

Delete: This enables you to delete the selected Asset Property record.
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6.2.2 Company Asset Documents

This screen allows you to define documents, etc that are specific to a Company Asset.    

List Tab

Display fields

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Company Asset to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Assets Documents screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Asset Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Company Asset

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name that you are calling the document in this Document-Asset
linkage.    No checks are made on the entry.

Document Type: Prefilled with ‘Company Asset’
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Linked to: From the drop-down list select the Company Asset that uses this document

Copy to Jobs: If this is ‘checked’ then the document link will be copied to all Job Orders raised
against this Asset.

Copy to Sales: If this is ‘checked’ then the document link will be copied to a Sales Order raised
against this Asset.

Correspondence: This is used for Operations Centre. This option is ticked to include this
document as Correspondence which can be searched based on the Notes.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Assets Documents screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Asset Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Asset Documents record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

6.2.3 Company Asset Images

This function allows you to link Images to a Company Asset.    

List Tab

Display fields

Image Name: The name of the Image as entered into the Details screen,

Linked To: This is the specific Company Asset to which this Image relates.

File Name: This is the full path name of the Image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Assets Images screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Asset Images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Image from a Company Asset

View: If you select a line and then this button the Image will be displayed using your default Image
display software. 

Detail Tab

Entry and Display fields

Image Name:  Enter the name that you are calling the Image on this Image-Asset linkage.    No
checks are made on the entry.

Image Type: Prefilled with ‘Company Asset’

Linked to: From the drop-down list select the Company Asset that uses this Image

Copy to Jobs: If this is ‘checked’ then the Image will be copied to all Job Orders raised against
this Asset.

Copy to Sales: If this is ‘checked’ then the Image will be copied to a Sales Order raised against
this Asset.

Image Details: locate the full path name of the Image.  It should be noted that the file extension
must be an image format (I.e. .jpg, .bmp, .ico, .wmf, .emf)

Preview: The selected Image is displayed for your reference

Buttons

Close: This will close the Assets Image screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.
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Add: This will bring up a blank ‘Detail’ screen for entry of an Asset Image record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Asset Image record or the last time the ‘Save’ Button
was pressed will be lost.

Delete: Not applicable to the Detail panel

6.2.4 Company Asset History Notes

This function allows you to link multiple time-stamped notes to a Company Asset.    

List Tab

Display fields

Asset Name: This is the name of the Company Asset against which the history is being
maintained.

Description: Description of the Company Asset taken from the Asset record

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Asset History Notes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Company Asset to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.
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Reference: A short description of the entry.  No validation checks are carried out.

Call Classification: From the drop-down list select a Classification under which you wish to store
this History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned: ‘Check this box if the follow-up has been actioned. This can be done via
Operations Centre as well.

Priority Note: ‘Check this box if this is a Priority Note. It will be highlighted in the Operations
Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.  Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History: Display only area in the lower part of the screen shows the Notes history against this
Company Asset.   Each record will also have the first 3 lines of the notes displayed.  To view the
full Notes simply click on the history record and the details will be displayed in the upper part of the
screen

Buttons

Close: This will close the Assets History Notes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of an Asset History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Asset History Notes record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

6.2.5 Company Asset Tracking

This screen allows you to maintain a tracking history file of each Asset.  This also provides
information relating to the current location of all the Assets owned by the company.

List Tab
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Display fields

Asset Name: Display only field showing the Asset Name taken from the Asset Register

Asset Number: Display only field showing the Asset Number as held against the Asset record.

Description: Display only field showing the description of the Asset as held against the Asset
record.

Status: Display only field showing the status of the Asset as held against the Asset record.

Type: Display only field showing the Type of Asset as held against the Asset record.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Asset records
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Company Asset Tracking screen.

Detail Panel

Display fields

Asset Name: Display only field showing the Asset Name taken from the Asset Register

Status: Display only field showing the status of the Asset as held against the Asset record.

Asset Number: Display only field showing the Asset Number as held against the Asset record.

Asset Type: Display only field showing the Type of Asset as held against the Asset record.

Description: Display only field showing the description of the Asset as held against the Asset
record.

Movements and History

Data Entry fields
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Date Out: The date when the Asset was moved to the new location.  This is prefilled with the
system date but can be amended by keying in the revised date or selecting it from the drop-down
calendar.

Time Out: The time of day when the Asset was moved to the new location.  This is prefilled with
the system time but can be amended by keying in the revised time.

Where: From the drop-down list select the type of location where the Asset has been located.  The
options are:

· Customer Site
· Supplier Site
· Company Site

Name: From the drop-down list select the specific location of the Asset.  The drop-down list
reflects the choice made in the previous field.

Due In: An optional entry field showing the date when the Asset is due to be returned.  You can
add a date by either keying in the date or selecting it from the drop-down calendar.

Comments: An optional entry field for entry of comments relating to this tracking record.

Buttons

Close: This will close the Company Asset Tracking screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Tracking record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Tracking record.

6.3 Cost Centres

This screen allows you to create and maintain Cost Centres.  These are referenced against
Warehouses, Descriptors, etc and are used when linking financial transactions to an Account
Code 

List Tab

Display fields

Cost Centre Code: Display only field showing the Cost Centres that are currently in Ostendo

Description: Description of the Cost Centre taken from the Cost Centre Code record

Status: Current Status of the Cost Centre taken from the Cost Centre Code record

Group: The Cost Centre Group to which the Cost Centre belongs and is taken from the Cost
Centre Code record

Ledger Code: The GL Code that is linked to this Cost Centre.  This is used for exporting Financial
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Transactions via the Scripting Option.  

Financial Category: This field links to the FINANCIALCATEGORIES table which is populated by
importing Job Numbers and Job Names from AccountRight Live, or Projects from Sage Evolution,
or Tracking Categories and Options from Xero. 

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Labour Codes
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Cost Centre Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will take you to the ‘Details’ screen for entry of a new Cost Centre.

Save: Not active in this view

Cancel: Not active in this view

Delete: This will delete the highlighted Cost Centre record

Detail Tab

Entry and Display fields

Cost Centre Code: Enter a Cost Centre Code.  Duplicate Cost Centres are not allowed.

Status: From the drop-down list select the current status.  The options are ‘Active’ or ‘Inactive’.

Description: Add a brief description of the Cost Centre.  No checks are made on the entry but
something must be entered.

Cost Group: Select the Cost Group from the drop-down list.  Cost Groups are User-defined and
maintained via the Cost Group screen (General>Settings>Cost Groups).

Restrict Cost Centre to mapping only: This provides the facility to 'hide' selected Cost Centres
(and hence their linked Account Codes) when selecting a Cost Centre in 'transactional' bookings
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(Timesheets, etc).  If this is 'checked' then this Cost Centre will not be visible in the drop-down list
in transaction type screens.   The Cost Centre will still be available for mapping purposes when
interfaced with the linked Accounting package.

Accounting System Ledger Code: From the drop-down list select the associated General Ledger
Code that applies to this Cost Centre.  The General Ledger Codes are maintained via screen
Financial Configuration>External GL Codes

Description: Once the Ledger Code is selected, this field will display its description.

Financial Category: If applicable, select a Financial Category for this Cost Centre.

Notes: An extended description can be added to the Cost Centre record.  No checks are made on
the entry.  Whenever you click on this field an icon will appear in the top-right.  By clicking on this
Icon you can bring up the Frequently Used Text table.  Select the text to be copied and either
press the OK Button in that screen or double-click the selected record.

Buttons

Close: This will close the Cost Centre screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Details’ screen for entry of a new Cost Centre.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the Cost Centre record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not active in this panel

6.4 Cost Centre Transactions

This screen emulates a Trial Balance by allowing you to print Financial Transactions covering a
date range for selected Cost Centres.  You have the option to print Cost Centre transaction details
or simply print a summary value for each selected Cost Centre.

A summary of Tax Paid and Received Tax Code is also printed

Entry and Display fields

Transaction Date From:  From the drop-down Calendar select a Date.  All Financial records at, or
later than, this date will be extracted for printing.

Transaction Date To:  From the drop-down Calendar select a Date.  All Financial records at, or
earlier than, this date will be extracted for printing.

Specific Cost Centre Group: If you wish to select a specific Cost Centre Group for output then
select the group from the drop-down list.  If no Group is selected then all Groups are assumed

Specific Cost Centre: If you wish to select a specific Cost Centre for output then select the Cost
Centre from the drop-down list.  If no Cost Centre is selected then all Cost Centres are assumed

Print Details: If this is 'checked' then the report will print details of all the requested Transactions
grouped by Cost centre.  If this is not 'checked'.
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Buttons

Print: This will print the Cost Centre Transaction Report using the above parameter values

Cancel: This will close this panel without printing the Report

6.5 Budgets

This screen allows you to create and maintain Sales or Purchasing Budgets covering Costs or
Revenue at various levels such as Company, Site, Region, etc. with option to further drill down to
Salesperson/Buyer, product category, etc.

List Tab

The List panel shows a grid of all Budgets currently in Ostendo

Display fields

Budget Name: This is display only that shows the Budget Names that exist in Ostendo.   This is
created using the Budget Create panel - see the 'Add' Button (below).

Budget Year: This is display only and shows the Budget Year as maintained in the 'Detail' Tab

Budget Class: This is display only and shows the Budget Class as maintained in the 'Detail' Tab.
The available Classes are:

· Sales
· Purchasing

Budget Type: This is display only and shows the Budget Type as maintained in the 'Detail' Tab
The available Types are:

· Revenue
· Cost

Total Value: This is display only and shows the Total Value of this Budget.  It is maintained by
Ostendo from the entries made in the 'Lines' tab

Budget Style 1: This is display only and shows the Budget Style 1 as maintained in the 'Detail'
Tab.    The available Styles are:

· All
· Site
· Company
· Company Type
· Company Region
· Company Code
· Salesperson or Buyer
· Product Category
· Analysis Group
· Line Type
· Item Code
· Labour Code
· Descriptor Code
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Budget Style 2: This is display only and shows the Budget Style 2 as maintained in the 'Detail'
Tab.    The available Styles are:

· All
· Site
· Company
· Company Type
· Company Region
· Company Code
· Salesperson or Buyer
· Product Category
· Analysis Group
· Line Type
· Item Code
· Labour Code
· Descriptor Code

Budget Style 3: This is display only and shows the Budget Style 3 as maintained in the 'Detail'
Tab.    The available Styles are:

· All
· Site
· Company
· Company Type
· Company Region
· Company Code
· Salesperson or Buyer
· Product Category
· Analysis Group
· Line Type
· Item Code
· Labour Code
· Descriptor Code

 

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking against
will sort in descending order. 

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons
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Close: This will close the Budgets screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the following "New Budget" panel for creation of a Budget.

There are 3 options when creating a new Budget.  They are
· Create Budget From Scratch
· Create Budget by copying an existing Budget
· Generate the Budget from History

Select the appropriate Radio Button and enter information as follows:-

Create Budget from Scratch

Budget Name: Enter a unique Budget Name.  Duplicate Budget Names are not
allowed.  

If you now click the 'Create' Button you will be taken to the 'Detail' tab for entry of
further information

Copy Budget from another

Budget to be copied: From the drop-down select the existing Budget that is
going to be copied
New Budget Name: Enter a unique Budget Name.  Duplicate Budget Names are
not allowed.  
Factor % to Use: Enter a percentage factor (plus or minus) which will be used
when copying the Budget. 

If you now click the 'Create' Button you will be taken to the 'Detail' tab where you
will see that the details of the 'Budget to be copied' now exist against this new
Budget and have been adjusted by the entered %

Generate from History

Budget Name: Enter a unique Budget Name.  Duplicate Budget Names are not
allowed.  
Budget Class: From the drop-down list select the Budget Class.  The options are
Sales or Purchasing
Budget Year: From the drop-down list select the year for which the Budget will be
created
Budget Type: From the drop-down list select the Type of Budget to be created
Budget Style 1: From the drop-down list select the Budget Style 1 element to be
used in the created Budget
Budget Style 2: From the drop-down list select the Budget Style 2 element to be
used in the created Budget
Budget Style 1: From the drop-down list select the Budget Style 3 element to be
used in the created Budget

You should now select the history from where the Budget will be generated.  The
options are:

· From Previous Year
· Monthly Average.  In this instance enter the number of days history to

assess

Factor to Use: Enter a percentage factor (plus or minus) which will be applied to
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the extracted history data

If you now click the 'Create' Button you will be taken to the 'Detail' tab where you
will see that the details of the Budget have been created from the above
information

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Budget record

Related: This will bring up a list of functions that are related to the Budget.  You may open and
maintain information in those screens whilst still remaining in the Budget screen.

Reports: This will bring up a list of Reports that are related to the Budget.  You can immediately
run the report whilst still remaining in the Budget screen.

Detail Tab

This tab enables you to maintain the Budget summary information.  The information shown is that
currently existing against the Budget.   The details within this Budget are added/maintained in the ‘
Line’ tab

Entry and Display fields

Budget Name: This is display only that shows the Budget Name that was entered in the creation
panel (see the 'Add' Button - below)

Budget Year: This shows the year to which this Budget applies.  This can be amended by
selecting another year from the drop-down list

Budget Class: This shows the Class to which this Budget applies.  This can be amended by
selecting another Class from the drop-down list.  The available Classes are:

· Sales
· Purchasing

Budget Type: This shows the Type to which this Budget applies.  This can be amended by
selecting another Type from the drop-down list.  The available Types are:

· Revenue
· Cost

Total Value: This is display only and shows the Total Value of this Budget.  It is maintained from
the entries made in the 'Lines' tab

Budget Style 1: From the drop-down list select the Budget Style 1 that will apply to this Budget
record.    The available Styles are:

· All
· Site
· Company
· Company Type
· Company Region
· Company Code
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· Salesperson or Buyer
· Product Category
· Analysis Group
· Line Type
· Item Code
· Labour Code
· Descriptor Code

Budget Style 2: From the drop-down list select the Budget Style 2 that will apply to this Budget
record.    The available Styles are:

· All
· Site
· Company
· Company Type
· Company Region
· Company Code
· Salesperson or Buyer
· Product Category
· Analysis Group
· Line Type
· Item Code
· Labour Code
· Descriptor Code

Budget Style 3: From the drop-down list select the Budget Style 3 that will apply to this Budget
record.    The available Styles are:

· All
· Site
· Company
· Company Type
· Company Region
· Company Code
· Salesperson or Buyer
· Product Category
· Analysis Group
· Line Type
· Item Code
· Labour Code
· Descriptor Code

Billing or Delivery : If Budget Class is "Sales" then this selection will appear to allow you to
choose whether this budget is set up for Billing Customer or Delivery Customer.

Notes: You can enter unlimited amount of Notes that are related to this Matrix Style.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record. 

Buttons

Close: This will close the Budgets screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.
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Add: This will bring up the following "New Budget" panel for creation of a Budget.

There are 3 options when creating a new Budget.  They are
· Create Budget From Scratch
· Create Budget by copying an existing Budget
· Generate the Budget from History

Select the appropriate Radio Button and enter information as follows:-

Create Budget from Scratch

Budget Name: Enter a unique Budget Name.  Duplicate Budget Names are not
allowed.  

If you now click the 'Create' Button you will be taken to the 'Detail' tab for entry of
further information

Copy Budget from another

Budget to be copied: From the drop-down select the existing Budget that is
going to be copied
New Budget Name: Enter a unique Budget Name.  Duplicate Budget Names are
not allowed.  
Factor % to Use: Enter a percentage factor (plus or minus) which will be used
when copying the Budget. 

If you now click the 'Create' Button you will be taken to the 'Detail' tab where you
will see that the details of the 'Budget to be copied' now exist against this new
Budget and have been adjusted by the entered %

Generate Budget from History

Budget Name: Enter a unique Budget Name.  Duplicate Budget Names are not
allowed.  
Budget Class: From the drop-down list select the Budget Class.  The options are
Sales or Purchasing
Budget Year: From the drop-down list select the year for which the Budget will be
created
Budget Type: From the drop-down list select the Type of Budget to be created
Budget Style 1: From the drop-down list select the Budget Style 1 element to be
used in the created Budget
Budget Style 2: From the drop-down list select the Budget Style 2 element to be
used in the created Budget
Budget Style 1: From the drop-down list select the Budget Style 3 element to be
used in the created Budget

You should now select the history from where the Budget will be generated.  The
options are:

· From Previous Year
· Monthly Average.  In this instance enter the number of days history to

assess

Factor to Use: Enter a percentage factor (plus or minus) which will be applied to
the extracted history data
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If you now click the 'Create' Button you will be taken to the 'Detail' tab where you
will see that the details of the Budget have been created from the above
information

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current Budget record

Related: This will bring up a list of functions that are related to the Budget.  You may open and
maintain information in those screens whilst still remaining in the Budget screen.

Reports: This will bring up a list of Reports that are related to the Budget.  You can immediately
run the report whilst still remaining in the Budget screen.

Lines Tab

This tab facilitates the entry and maintenance of all the individual variables within the information
entered into the 'Detail' tab

Entry and Display fields

Budget Style 1: Display only field showing the Style that has been applied to the 'Budget Style 1'
field in the 'Detail' tab

Style Value 1: From the drop down list select the specific value to which this budget line applies.
The Values are 'All' plus the unique values held against the Style.  For example if the Style is
Labour Code then the drop-down will display the individual Labour Codes with the option to select
'All'

Budget Style 2: Display only field showing the Style that has been applied to the 'Budget Style 2'
field in the 'Detail' tab

Style Value 2: From the drop down list select the specific value to which this budget line applies. 

Budget Style 3: Display only field showing the Style that has been applied to the 'Budget Style 3'
field in the 'Detail' tab

Style Value 3: From the drop down list select the specific value to which this budget line applies. 

Total Value: Display only field showing the sum of the individual monthly budget amounts held
against this Line record.

Annual Spread Amount: You can enter an Annual Amount associated to a Spread Factor and,
upon saving, Ostendo will populate the individual Monthly Amounts fields.  See Example of this at
the end of this section

Spread Factor: From the drop-down list select the Spread Factor that will be applied to the value
entered in 'Annual Amount' field.  Upon saving, Ostendo will populate the individual Monthly
Amounts fields.  See Example of this at the end of this section

Monthly Amounts: Enter or maintain the individual Monthly Amounts.  You should note that the
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column Headings are derived from a combination of the Budget Year and the Financial Start
Month as entered in System Settings (File>System Configuration>System Settings)

Buttons

Close: This will close the Budgets screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record against this Budget

Save: This will save the current data without exiting the screen.  It will also apply any Annual
Amount to the individual Monthly amount fields using the Spread Factor

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current Line record

Related: This will bring up a list of functions that are related to the Budget.  You may open and
maintain information in those screens whilst still remaining in the Budget screen.

Reports: This will bring up a list of Reports that are related to the Budget.  You can immediately
run the report whilst still remaining in the Budget screen.

Example of using Spread Factor

Assuming that there is a Spread Factor record containing the following:

Spread Factor:  Example of Spread Factor
Month 1 Factor: 0
Month 2 Factor: 3
Month 3 Factor: 2
Month 4 Factor: 10
Month 5 Factor: 0
Month 6 Factor: 6
Month 7 Factor: 1
Month 8 Factor: 0
Month 9 Factor: 0
Month 10 Factor: 4
Month 11 Factor: 2
Month 12 Factor: 2
Total Spread Factor: 30 (System calculated from the sum of the above)

If you now create a Budget Line with an Annual Amount of (say) $45,000 then Ostendo will
populate the 12 Monthly Amount fields as follows

Annual Amount = $45,000
Number of Factors = 30
Amount per Factor = $45,000 / 30 = $1,500

Month 1 Factor: 0 Amount = $0
Month 2 Factor: 3 Amount = $4,500
Month 3 Factor: 2 Amount = $3,000
Month 4 Factor: 10 Amount = $15,000
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Month 5 Factor: 0 Amount = $0
Month 6 Factor: 6 Amount = $9,000
Month 7 Factor: 1 Amount = $1,500
Month 8 Factor: 0 Amount = $0
Month 9 Factor: 0 Amount = $0
Month 10 Factor: 4 Amount = $6,000
Month 11 Factor: 2 Amount = $3,000
Month 12 Factor: 2 Amount = $3,000

Total     = $45,000

6.6 Budget Comparisons

This screen enables you to run a Pivot or Analysis Budget View against parameters entered in this
screen.

Entry and Display fields

Budget Name: From the drop-down list select the first Budget Name to be used in this
comparison.  Budget Names are maintained via General>Budgets.

Secondary Budget: From the drop-down list select the second Budget Name to be used in this
comparison.  Budget Names are maintained via General>Budgets

Comparison Type: From the drop-down list select the type of comparison being made.  The
options are:

· Budget to Budget
· Budget to Actual

Actual Year: If the 'Comparison Type' is 'Budget to Actual' then enter the year from which the
'Actual' values will be extracted

Buttons

Pivot View: This will create a Pivot View using the above parameters and return the results to the
screen.  From here you have the option to Print, Email, Export, or Save the View

Analysis View: This will create an Analysis using the above parameters and return the results to
the screen.  From here you have the option to search and filter the results in addition to outputting
to Print, Email, or Export the View

Chart View: This will create a Chart View using the above parameters and return the results to the
screen.  From here you have the option to Print, Email, Export, or Save the View

Cancel: This will close the Budget Comparison parameter entry panel
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6.7 Data Spreadsheet

This feature shows a basic spreadsheet into which you can (a) create your own spreadsheet from
data held within Ostendo and (b) display existing .xls files.   Upon first entering this screen it will
show a standard Spreadsheet layout.  This guide will take you through the process of accessing
your Ostendo Database and extracting information for viewing in the spreadsheet.

To extract information you first need to create a Query.  A Query is a sequence of instructions that
tells the computer what to extract from the database.     

Select Data>Query Builder to commence creating your query.   On the displayed screen there are
four panels

Tables - The names of all the Tables (database files) that are used by Ostendo
Fields - Having selected a specific Table this will show each field in that Table
Query - This is where you create and maintain the query as described below
Selection Criteria - Enables you to define parameters when running this query

Tables: This lists the current tables in Ostendo.    

Fields: This lists the current fields within the selected table.    

Query: Enter your Query statement.   You can enter a query in one of three ways
§ Type in directly
§ Select from the list by clicking on the ‘Query List’ Button
§ Create using ‘prompts’

To create using ‘prompts’ you can copy:-

§ Tables to the Query by selecting the table and either double clicking the left mouse or
clicking on the ‘Add Table to Query’ button

§ Fields to the Query by first selecting the correct Table then the field and either double
clicking the left mouse or clicking on the ‘Add Field to Query’ button

§ Keywords to the Query by clicking the ‘Options’ button and selecting ‘Add Keyword’ and
then selecting the appropriate keyword.    Available Keywords are Select, *, Sum, Count,
From, Where

§ Operators to the Query by clicking the ‘Options’ button and selecting ‘Add Operator’ and
then selecting the appropriate Operator.   Available Operators are >, <, =. <>, +, -, /

Selection Criteria: A parameter gives you the option to insert selection criteria whenever the
Query is run. For example: if you want to look at a range of Customers then the parameters would
be:

From Customer:
To Customer:

To create a parameter you should first:
· Highlight the Table in the ‘Table’ panel
· Create the Query in the ‘Query’ panel

An then click the ‘Add’ button at the bottom of the screen.  This will add a new line in the ‘Selection
Criteria’ Panel.  Enter the following information

Display Name: This is the name that will be displayed during ‘Run’ for entry of the parameter

Field Name: From the drop-down list select the field against which the parameter entry will be
made.
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Operator: From the drop-down list select the operand that will apply to the parameter.  The
available operands are:

= (Equal To)
> (Greater Than)
< (Less Than)
>= (Greater than or equal)
<= (Less than or equal)
<> (Not equal to)

Look Up Table: If the selection criteria is a Customer, Supplier, Item, or Descriptor then select this
from the drop-down list.  The relevant master data will be available for selecting a record when
running the Query.

Buttons

Run: This runs the query and outputs the information to the spreadsheet

Cancel: Closes this form and goes back to the spreadsheet view

Options: Click on this button to add a Keyword or Operator and also to create a runtime
Parameter

List: Click on this button to list current saved queries for selection onto this screen 

Save Query: If you wish to retain the Query for future use then you can save the query.   A screen
where you have the option to create a new saved query or overwrite an existing query 

Delete: This will bring up your saved queries from which you can select and delete

Simple Introduction to Queries

With the Data Spreadsheet you can extract information and output to an Excel Spreadsheet.  Here
are simple instructions to creating your own extract file.

The first thing to note is the structure of the database holding your data.  To view the structure
select Data>Query Builder. You upper-left panel shows the tables in Ostendo.  Clicking on one of
these will show you the individual fields within a table in the panel below. Now we can construct a ‘
Query’.

The first command is ‘select’.  With this command you are telling the computer which fields to
select.  However the computer doesn’t know from which table you are selecting therefore the
command should be extended to tell it from which table to extract the field.  As an example let us
extract all fields from the Inventory Master (Inventory) table.  The instruction would be 

Select * from Inventory

If you type this in the right hand panel and hit ‘Run’ button the full data from the Inventory table will
be output to a spreadsheet.  (Hint – when you get to the ‘Inventory’ table in the left-hand panel you
can double click on it and it will automatically copy to the right)

You may wish to extract only selected fields from the Inventory table.  This is simply done by
specifying the required field in the ‘select’ statement.  For example:

Select ItemCode, WarehouseCode, LocationCode from Inventory

Note:  Each selected field is separated by a comma.
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(Hint – Once again you can double click on the field on the left side of the screen and it will
automatically copy to the right)

6.8 Run Any Report

This function enables you to run any report currently in Ostendo.  The opening screen shows all
current reports.  Select the report that you wish to run and click the ‘Run’ button.  The relevant run
parameters will be presented and - upon clicking another ‘Run’ button - the report will be produced.

6.9 Run Any View

This function enables you to run any View currently in Ostendo.  The opening screen shows all
current Views.  Select the View that you wish to run and click the ‘Run’ button.  The relevant run
parameters will be presented and - upon clicking another ‘Run’ button - the View will be displayed.

6.10 Run Email Query

This function allows you to directly run any Email Query you have defined in Email Services without
having to wait for Queue Services.

This is useful for testing new Email Queries.

6.11 Knowledge Base

This screen allows you to maintain useful information that can be used for your own reference or in
response to Customer Enquiries.

List Tab

Display fields

The displayed fields are taken from the Knowledge Base information entered into the ‘Detail’ tab. 
The selection of which fields to display is at the user’s discretion.  To select the fields to display
simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
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(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Knowledge Base screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Knowledge Base records.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected record from the Knowledge Base

Related: This will bring up a list of functions that are related to the Knowledge Base.  You may
open and maintain information in those screens whilst still remaining in the Knowledge Base
screen.

Reports: This will bring up a list of Reports that are related to the Knowledge Base.  You can
immediately run the report whilst still remaining in the Knowledge Base screen.

Detail Tab

Entry and Display fields

Article #: This is an automatically generated number that uniquely identifies the record.

Article Type: From the drop-down list select the Article Type.  Article Types are maintained either
by clicking the ‘Related’ Button or using the toolbar menu General>Settings>Article Types

Article Category: From the drop-down list select the Article Category.  Article Categories are
maintained either by clicking the ‘Related’ Button or using the toolbar menu
General>Settings>Article Categories.

Article Date: This is prefilled with the System Date.   You can amend this date by overtyping or
select from the drop-down calendar.

Description: Enter a short description of the Knowledge Base question.  This will provide a quick
indication as to the content of the Knowledge Base record

Question: Enter as much detail as you can which relates to the reason for this Knowledge Base
record.  This will assist in the ‘Search’ function on the List panel

Answer: Enter as much detail as you can which relates to the answer or response to this
Knowledge Base record.  This will assist in the ‘Search’ function on the List panel

Buttons

Close: This will close the Knowledge Base screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.
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Add: This will bring up a blank ‘Detail’ screen for entry of a new Knowledge Base record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Knowledge Base record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Knowledge Base.  You may
open and maintain information in those screens whilst still remaining in the Knowledge Base
screen.

Reports: This will bring up a list of Reports that are related to the Knowledge Base.  You can
immediately run the report whilst still remaining in the Knowledge Base screen..

6.12 Document Management

This screen allows you to maintain a library of documents, etc that are used across all areas of
Ostendo.

List Tab

Display fields

Document Type: This denotes from where in Ostendo the Document link originated.  The options
are:

· Item
· Descriptor
· Labour
· Company Asset
· Employee
· Customer Asset
· Customer
· Supplier
· Project
· Knowledge Base
· Template Task
· Job
· Sales
· Assembly
· Purchasing

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific record identified by the Document Type to which this document
relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
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heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Documents Management screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Document.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from the Documents Master

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name:  Enter the name that you are creating in this screen.  No checks are made on
the entry.

Document Type: From the drop-down list select the Document Type.  These are already defined
in Ostendo and show where this document feature is used

Linked to: Dependent upon the Document Type selected this will show the relevant records from
that source.  Therefore, from the drop-down list select the reference that uses this document

Copy to Jobs: This will be visible dependant upon the Document Type.  When visible it can be ‘
checked’ to indicate that the document will be copied to all Job Orders raised against this ‘Linked
To’ reference.

Copy to Sales: This will be visible dependant upon the Document Type.  When visible it can be ‘
checked’ to indicate that the document will be copied to all Sales Orders raised against this ‘Linked
To’ reference.

Copy to Purchases: This will be visible dependant upon the Document Type.  When visible it can
be ‘checked’ to indicate that the document will be copied to all Purchase Orders raised against
this ‘Linked To’ reference.
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Copy to Assemblies: This will be visible dependant upon the Document Type.  When visible it
can be ‘checked’ to indicate that the document will be copied to all Assembly Orders raised against
this ‘Linked To’ reference.

Print / Email with order: This document is included when the order is printed or emailed.

Print / Email with quote: This document is included when the quote is printed or emailed.

Correspondence: This is used for Operations Centre. This option is ticked to include this
document as Correspondence which can be searched based on the Notes.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:- .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Documents Management screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Document.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Document record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

6.13 Image Management

This screen allows you to maintain a library of Images, etc that are used across all areas of
Ostendo.

List Tab

Display fields

Image Type: This denotes from where in Ostendo the Image link originated.  The options are:
· Item
· Descriptor
· Labour
· Company Asset
· Employee
· Customer Asset
· Customer
· Supplier
· Project
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· Knowledge Base
· Template Task
· Job
· Sales
· Assembly
· Purchasing

Image Name: The name of the Image as entered into the Details screen,

Linked To: This is the specific record identified by the Image Type to which this Image relates.

File Name: This is the full path name of the Image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Image Management screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Image.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Image from the Image Master

View: If you select a line and then this button the Image will be displayed on the screen. 

Detail Tab

Entry and Display fields

Image Settings

Image Name: Enter the name if the Image that you are creating in this screen.  No checks are
made on the entry.
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Image Type: From the drop-down list select the Image Type.  These are already defined in
Ostendo and show where this Image feature is used

Linked to: Dependent upon the Image Type selected this will show the relevant records from that
source.  Therefore, from the drop-down list select the reference that uses this Image

Copy to Jobs: This will be visible dependant upon the Image Type.  When visible it can be ‘
checked’ to indicate that the Image will be copied to all Job Orders raised against this ‘Linked To’
reference.

Copy to Sales: This will be visible dependant upon the Image Type.  When visible it can be ‘
checked’ to indicate that the Image will be copied to all Sales Orders raised against this ‘Linked To’
reference.

Copy to Purchases: This will be visible dependant upon the Image Type.  When visible it can be ‘
checked’ to indicate that the Image will be copied to all Purchase Orders raised against this ‘
Linked To’ reference.

Copy to Assemblies: This will be visible dependant upon the Image Type.  When visible it can be
‘checked’ to indicate that the Image will be copied to all Assembly Orders raised against this ‘
Linked To’ reference.

Display on Price List: This is displayed if the Image Type is Item.  If ‘checked’ then the image will
be available for printing on the Standard Item Price List report

Image Details

Filename: locate the full path name of the Image.  It should be noted that the file extension must
be an image format (I.e. .jpg, .bmp, .ico, .wmf, .emf)

Preview: Displays a preview of the image

Buttons

Close: This will close the Image Management screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Image record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Image record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the Image will be displayed on the screen. 

6.14 Frequently Used Text

There may be occasions when you wish to use the same text time and time again.  Rather than
retyping this each time you have the option to create it here then, whenever you need the text, to
simply click an icon located at the top-right of each ‘Notes’ field.  This brings up this Frequently
Used Text table from which you can copy and paste the selected Text.
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Data Display Options

Field Position - You can move any field position by dragging the column heading left or right to
the position where you want it to appear.

Entry fields

Name:  Enter an Identifier to the Frequently Used Text record.  Duplicates not allowed

Description: Enter a short description that provides some indication to the Text Subject.  No
checks are carried out on the entry.

Text / Phrase: Enter the Frequently Used Text.  This is the text that will be copied to the selected
document(s)

Buttons

Close: This will close the Frequently Used Text screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will move the cursor to a new line for entry of a new Frequently Used Text record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Frequently Used Text record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This will delete the selected Frequently Used Text record

6.15 Hazards

This screen allows you to create and maintain a lst of Hazards and Instructions.  Hazards and
Instructions can be linked to Customers, Jobs, and Bill of Materials. 

List Tab

Display fields

Hazard Code: The code for the hazard/instruction. 

Description: Description of the hazard/instruction. 

Location: Location of the hazard/instruction. 

Risk Level: The Risk Level of the Hazard (Low/Moderate/High/Extreme). Risk Level = "Instruction"
denotes that this is an Instruction (not a hazard). 

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.
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· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will take you to the ‘Details’ screen for entry of a new record.

Save: Not active in this view

Cancel: Not active in this view

Delete: This will delete the highlighted record

Detail Tab

Entry and Display fields

Hazard Code: Enter a Code for the Hazard or Instruction.  Duplicate Hazard Codes are not
allowed. (Maximum 50 chars.)

Risk Level: Select from drop-down list. If "Instruction" is selected, then this record becomes an
Instruction instead of a hazard. 

Description: Add a brief description of the hazard/instruction.  No checks are made on the entry
but something must be entered. (Maximum 200 chars.)

Location: Describe the location of the hazard/instruction. (Maximum 200 chars.)

Auto Include Hazard Rule: Select one of the rules:
- Only Add when Linked to Order or Company -

This hazard will only be added to the datasheet template if the hazard is linked to 
an order or a

company. (Template must have hazard item included.)
- Auto Add to All Datasheets -

This hazard is added to all datasheet templates which has the hazard item. This 
means that this

hazard does not need to be linked to every individual order or 
company.

Notes: Enter more detailed description of the hazard or instructions here.

Risk Control: Describe what has been done to mitigate the risk here. (Not applicable to
Instructions).

Buttons
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Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Details’ screen for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the record or the last time the ‘Save’ Button was pressed will be
lost.

Delete: This will delete the current record

6.16 Hazard Groups

This screen allows you to create and maintain Hazard Groups.   

List Tab

Display fields

Hazard Group: The name of the hazard group. 

Description: Description of the hazard group. 

Auto Include Group Rule: Shows how the Hazard Group is added to the datasheet.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will take you to the ‘Details’ screen for entry of a new record.

Save: Not active in this view

Cancel: Not active in this view
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Delete: This will delete the highlighted record

Detail Tab

Entry and Display fields

Group Name: Enter a name for the Hazard Group.  Duplicate names are not allowed. (Maximum
50 chars.)

Description: Add a brief description of the group.  No checks are made on the entry but
something must be entered. (Maximum 100 chars.)

Auto Include Group Rule: Select one of the rules:
- Only Add when Linked to Order or Company - This

hazard group will only be added to the datasheet template if the group is linked to 
an order or a company.

(Template must have hazard item included.)
- Auto Add to All Datasheets - This

hazard group is added to all datasheet templates which has the hazard item. This 
means that this

hazard group does not need to be linked to every individual order or 
company.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Details’ screen for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the record or the last time the ‘Save’ Button was pressed will be
lost.

Delete: This will delete the current record

Lines Tab

Entry and Display fields

Hazard Code: Select a Hazard Code.

Description: You can modify the description if required. (Maximum 200 chars.)

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.
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Add: This will bring up a blank ‘Details’ screen for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the record or the last time the ‘Save’ Button was pressed will be
lost.

Delete: This will delete the current record

6.17 Hierarchical Structures

These screens allows you to create and maintain Hierarchical Structures which can be used to
organize things like Items and Descriptors in a more structured format. 
This is useful, for example, when organizing a Sales Catalog of Items and Descriptors in the
Freeway Mobility app where users can look for items in a more structured way.    

List Tab

Display fields

Name: The name of the structure. 

Description: Description of the hierarchical structure. 

Notes: Additional notes relating to the purpose of this structure.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will take you to the ‘Details’ screen for entry of a new record.

Save: Not active in this view

Cancel: Not active in this view

Delete: This will delete the highlighted record
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Detail Tab

Entry and Display fields

Name: Enter a name for the Hierarchical Structure.  Duplicate names are not allowed. (Maximum
50 chars.)

Description: Add a brief description of the Structure.  No checks are made on the entry but
something must be entered. (Maximum 100 chars.)

Notes: Enter additional notes to explain the purpose of this structure.

Level1 to Level 4 Subtabs
Enter as many names as required to cover all possible items/descriptors at each level (up to 4
levels).
Level 1 is the top of the hierarchy, while Level 4 is the lowest.

Entry and Display fields

Seq No: Enter a sequence number.

Level Name: Enter a name of a group of items/descriptor that is at this Level.

Level Description: Enter a description for the Level Name

Image: Select a jpeg or png image which represents this group of items/descriptors.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Details’ screen for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the record or the last time the ‘Save’ Button was pressed will be
lost.

Delete: This will delete the current record

Hierarchy Tree Tab

This display-only tab will show the hierarchy you have defined in the Detail tab.
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6.18 Settings

6.18.1 Departments

This screen allows you to maintain a list of Departments, which are used to analyse Company
Asset and Employee records.    

Entry and Display fields

Department Code: Enter the Name of the Department.  Duplicates not allowed.

Description: Enter a short description of the Department.  No checks are made on this entry

Sequence: Enter a sequential number which represents the display sequence the Department will
be output in Inquiries 'Inquiry - Assembly Progress' and 'Inquiry - Job Progress'.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Department screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Department.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Department.

6.18.2 Work Times

This screen allows you to create and maintain Work Times.  This defines the basic working week
that will be used when scheduling Jobs.   This also displays as the background colour in the
Calendar Views of Jobs and CRM

Entry and Display fields

Total Hours for standard working week:  System calculated value from the entries made in this
screen

(Days): ‘Check’ the days that are to be included in the normal working week

(Times): Enter the Start and End times for both morning and afternoon periods.  The times can be
manually entered to the format hh.mm.ss or you can place the cursor against the hh, mm, or ss
element and use the Up/Down arrows

Buttons

OK: This will save and close the Work Times screen. 
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Close: This will close the Work Times screen without saving.

6.18.3 Holiday Dates

This screen allows you to maintain holidays.  These will overlay the Work Times to arrive at actual
workdays and times.

Entry and Display fields

Date:  From the drop-down calendar select the date of the holiday.  Duplicate dates are not
allowed.

Description: Enter a short description of the reason for the holiday.  No checks are made on this
entry

Buttons

Close: This will close the Holidays screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Holiday record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current selected Holiday record

6.18.4 Asset Types

This screen allows you to maintain a file of Asset Types, which are used to analyse Company
Assets.  Asset Types are User-defined and can include such types as:

· Lathes
· Cranes
· Vehicles

Entry and Display fields

Type: Enter the Name of the Asset Type.  Duplicates not allowed.

Description: Enter a short description of the Asset Type.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Asset Type screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Asset Type.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Asset Type.

6.18.5 Cost Groups

This screen allows you to maintain a list of Cost Groups, which are used to group and analyse
Cost Centre records.    

Entry and Display fields

Name: Enter the Name of the Cost Group.  Duplicates not allowed.

Description: Enter a short description of the Cost Group.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Cost Group screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Cost Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Cost Group.

6.18.6 Analysis Groups

This screen allows you to maintain a list of Analysis Groups, which are used:

· To group and analyse Inventory, Labour, and/or Descriptor records
· To enable you to group lines in the following documents where the Job Order Invoice Style

is ‘Actual Quantity’ 
o Quote Form
o Order Form
o Invoice Form

Entry and Display fields

Name: Enter the Name of the Analysis Group.  Duplicates not allowed.

Description: Enter a short description of the Analysis Group.  No checks are made on this entry
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Quote Form Grouping: From the drop-down list select the style by which Quote Lines within this
Group will be printed.  The options are:

No Grouping: All Lines will printed
Header and Footer:  A Header containing the name of the Analysis Group will be printed
followed by the Lines within the Group.  At the end of the Group a Footer record will be
printed showing a summarised total of the group content
Group Totals Only: A single line will be printed showing the summarised total for the
Group

Order Form Grouping: From the drop-down list select the style by which Order Lines within this
Group will be printed.  The options are:

No Grouping: All Lines will printed
Header and Footer:  A Header containing the name of the Analysis Group will be printed
followed by the Lines within the Group.  At the end of the Group a Footer record will be
printed showing a summarised total of the group content
Group Totals Only: A single line will be printed showing the summarised total for the
Group

Invoice Form Grouping: From the drop-down list select the style by which Invoice Lines within
this Group will be printed.  The options are:

No Grouping: All Lines will printed
Header and Footer:  A Header containing the name of the Analysis Group will be printed
followed by the Lines within the Group.  At the end of the Group a Footer record will be
printed showing a summarised total of the group content
Group Totals Only: A single line will be printed showing the summarised total for the
Group

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Analysis Group screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Analysis Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Analysis Group.

6.18.7 Quote Lost Reasons

This screen allows you to maintain a list of Reasons why a Quotation was lost.  This is attached to
the quote for analysis purposes.

Entry and Display fields

Name: Enter the Name of the Lost Reason Code.  Duplicates not allowed.
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Description: Enter a short description of the Lost Reason Code.  No checks are made on this
entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Lost Reason Code screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Lost Reason Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Lost Reason Code.

6.18.8 Spread Factors

This screen allows you to create and maintain Spread Factors that can be applied to an Annual
Budget and 'spread' the value as defined by factors in this record

Entry and Display fields

Spread Factor:  Enter the Name of the Spread Factor.  Duplicates not allowed.

Month 1 Factor: Enter the Factor to be used against Month 1.  See below for example of how this
Factor is used

Month 2 Factor: Enter the Factor to be used against Month 2.  See below for example of how this
Factor is used

Month 3 Factor: Enter the Factor to be used against Month 3.  See below for example of how this
Factor is used

Month 4 Factor: Enter the Factor to be used against Month 4.  See below for example of how this
Factor is used

Month 5 Factor: Enter the Factor to be used against Month 5.  See below for example of how this
Factor is used

Month 6 Factor: Enter the Factor to be used against Month 6.  See below for example of how this
Factor is used

Month 7 Factor: Enter the Factor to be used against Month 7.  See below for example of how this
Factor is used

Month 8 Factor: Enter the Factor to be used against Month 8.  See below for example of how this
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Factor is used

Month 9 Factor: Enter the Factor to be used against Month 9.  See below for example of how this
Factor is used

Month 10 Factor: Enter the Factor to be used against Month 10.  See below for example of how
this Factor is used

Month 11 Factor: Enter the Factor to be used against Month 11.  See below for example of how
this Factor is used

Month 12 Factor: Enter the Factor to be used against Month 12.  See below for example of how
this Factor is used

Total Spread Factor: Display only field showing the sum of the values entered into the Month
Factor fields

Buttons

Close: This will close the Spread Factors screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Spread Factor record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Spread Factor record

Example of using Spread Factor

Assuming that there is a Spread Factor record containing the following:

Spread Factor:  Example of Spread Factor
Month 1 Factor: 0
Month 2 Factor: 3
Month 3 Factor: 2
Month 4 Factor: 10
Month 5 Factor: 0
Month 6 Factor: 6
Month 7 Factor: 1
Month 8 Factor: 0
Month 9 Factor: 0
Month 10 Factor: 4
Month 11 Factor: 2
Month 12 Factor: 2
Total Spread Factor: 30 (System calculated from the sum of the above)

If you now create a Budget Line with an Annual Amount of (say) $45,000 then Ostendo will
populate the 12 Monthly Amount fields as follows

Annual Amount = $45,000
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Number of Factors = 30
Amount per Factor = $45,000 / 30 = $1,500

Month 1 Factor: 0 Amount = $0
Month 2 Factor: 3 Amount = $4,500
Month 3 Factor: 2 Amount = $3,000
Month 4 Factor: 10 Amount = $15,000
Month 5 Factor: 0 Amount = $0
Month 6 Factor: 6 Amount = $9,000
Month 7 Factor: 1 Amount = $1,500
Month 8 Factor: 0 Amount = $0
Month 9 Factor: 0 Amount = $0
Month 10 Factor: 4 Amount = $6,000
Month 11 Factor: 2 Amount = $3,000
Month 12 Factor: 2 Amount = $3,000

Total     = $45,000

6.18.9 Service Zones

This screen allows you to maintain a list of Service Zones. Service Zones together with Service
Zone Times can be used to estimate the time for a service technician or field worker to move from
one site to another site.    

Entry and Display fields

Service Zone: Enter the name of the Service Zone.  Duplicates not allowed.

Description: Enter a short description of the Service Zone.  No checks are made on this entry

Sequence: Enter a sequence number for the zone.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Cost Group screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Cost Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Cost Group.
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6.18.10 Service Zone Times

This screen allows you to maintain a list of travel times between Service Zones. Service Zone
Times can be used to estimate the time for a service technician or field worker to move from one
site to another site.    

Entry and Display fields

From Zone: Select the name of the From Service Zone.  

To Zone: Select the name of the To Service Zone.

Travel Time in Minutes: Enter the average time it takes to travel between the two zones.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Cost Group screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Cost Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Cost Group.

6.18.11 Standard Units

This screen allows you to maintain Standard Units.  Standard Units are used:

· Against Items and Descriptors to define a base Unit
· Against Items where the Item can be Purchased, Sold and Stocked in multiple Units. 
· Against Labour Codes to define the Unit of Time   

Entry and Display fields

Unit:  Enter the Name of the Standard Unit.  For Example:-
· Case
· Pack
· Box
· Day
· Ltr
· Mtr
· Each

Duplicate Unit Names are not allowed

Description: Enter a short description of the Unit.  No checks are made on this entry
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Is Time Unit: If this is a Time Unit then ‘check’ this checkbox.  If this is ‘checked’ then:
· It will not be available to the drop-down list in the Item or Descriptor screen
· It will only be available to the drop-down list in the Labour Code screen

Time Per Hour: If this is a Time Unit then the entry here will convert the Time Unit to a base unit of
Hour.  For example: If the Time Unit is ‘Day’ then the entry here will be 24.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Standard Unit screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Standard Unit.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Standard Unit.

6.18.12 Standard Properties

This screen allows you to maintain Standard Properties.  Standard Properties are used throughout
Ostendo to enable additional information to be attached to key records such as:

· Items
· Descriptors
· Customers
· Suppliers
· Sales Orders
· Assembly Orders
· Jobs   
· Company Assets
· Customer Assets
· Etc

The Standard Properties are then available to Reports and Analysis Views.

Entry and Display fields

Property Name:  Enter the Name of the Standard Property.  For Example:-
· Colour
· Voltage
· Asset Grade

Duplicate Property Names are not allowed

Property Type: Select the Property Type from the drop-down list.  The options are:
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· Text
· Decimal
· Integer
· Currency
· Yes/No
· Date
· Time

This will dictate what type of entry can be made when the Standard Property is used.

Property Values: When the Property is used then, by default, the entry is restricted only to the
Property Type.  You may further restrict the entry to specific Values by entering those Values in
this field.   For example: A Property Name ‘Colour’ would have Property Type of ‘Text’ and can
also have entries in this field of Red, Blue, Green (each entry should be on a new line).   When this
Property is used then the Value can only be selected from this list.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Standard Property screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Standard Property.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Standard Property.

6.18.13 Article Types

This screen allows you to maintain a file of Article Types, which are used to analyse Knowledge
Base records.  Article Types are User-defined and can include such types as:

· Education
· Setup
· How To
· Examples

Entry and Display fields

Type: Enter the Name of the Article Type.  Duplicates not allowed.

Description: Enter a short description of the Article Type.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
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left or right to the position where you want it to appear.

Buttons

Close: This will close the Article Type screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Article Type.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Article Type.

6.18.14 Article Categories

This screen allows you to maintain a file of Article Categories, which are used to analyse
Knowledge Base records.  Article Categories are User-defined and can include such categories
as:

· Internal Information
· Customer Questions

Entry and Display fields

Category: Enter the Name of the Article Category.  Duplicates not allowed.

Description: Enter a short description of the Article Category.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Article Category screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Article Category.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Article Category.
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6.18.15 General Rules

These are the SQL's to the Budget Routines used for Sales and Jobs

Entry and Display fields

Budget Pivot SQL: Clicking on this field will bring up the Query Builder Screen.   In that screen
you can construct the Query relating to the Budget Pivot Display generated via the
General>Budget Comparisons screen.  This SQL can either be via the Tables and Fields panels or
keyed directly into the 'Query' field.  A basic SQL covering the relevant Budget is supplied with
Ostendo.  This can be adjusted here if required

Budget Analysis SQL: Clicking on this field will bring up the Query Builder Screen.   In that screen
you can construct the Query relating to the Budget Pivot Display generated via the
General>Budget Comparisons screen.  This SQL can either be via the Tables and Fields panels or
keyed directly into the 'Query' field.  A basic SQL covering the relevant Budget is supplied with
Ostendo.  This can be adjusted here if required

Budget Chart SQL: Clicking on this field will bring up the Query Builder Screen.   In that screen
you can construct the Query relating to the Budget Pivot Display generated via the
General>Budget Comparisons screen.  This SQL can either be via the Tables and Fields panels or
keyed directly into the 'Query' field.  A basic SQL covering the relevant Budget is supplied with
Ostendo.  This can be adjusted here if required

Job Budget Pivot SQL: Clicking on this field will bring up the Query Builder Screen.   In that
screen you can construct the Query relating to the Budget Pivot Display generated via the
Jobs>Job Budget Comparisons screen.  This SQL can either be via the Tables and Fields panels
or keyed directly into the 'Query' field.  A basic SQL covering the relevant Budget is supplied with
Ostendo.  This can be adjusted here if required

Job Budget Analysis SQL: Clicking on this field will bring up the Query Builder Screen.   In that
screen you can construct the Query relating to the Budget Pivot Display generated via the
Jobs>Job Budget Comparisons screen.  This SQL can either be via the Tables and Fields panels
or keyed directly into the 'Query' field.  A basic SQL covering the relevant Budget is supplied with
Ostendo.  This can be adjusted here if required

Job Budget Chart SQL: Clicking on this field will bring up the Query Builder Screen.   In that
screen you can construct the Query relating to the Budget Pivot Display generated via the
Jobs>Job Budget Comparisons screen.  This SQL can either be via the Tables and Fields panels
or keyed directly into the 'Query' field.  A basic SQL covering the relevant Budget is supplied with
Ostendo.  This can be adjusted here if required

Project Budget Pivot SQL: Clicking on this field will bring up the Query Builder Screen.   In that
screen you can construct the Query relating to the Budget Pivot Display generated via the
Jobs>Project Budget Comparisons screen.  This SQL can either be via the Tables and Fields
panels or keyed directly into the 'Query' field.  A basic SQL covering the relevant Budget is
supplied with Ostendo.  This can be adjusted here if required

Project Budget Analysis SQL: Clicking on this field will bring up the Query Builder Screen.   In
that screen you can construct the Query relating to the Budget Pivot Display generated via the
Jobs>Project Budget Comparisons screen.  This SQL can either be via the Tables and Fields
panels or keyed directly into the 'Query' field.  A basic SQL covering the relevant Budget is
supplied with Ostendo.  This can be adjusted here if required

Project Budget Chart SQL: Clicking on this field will bring up the Query Builder Screen.   In that
screen you can construct the Query relating to the Budget Pivot Display generated via the
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Jobs>Project Budget Comparisons screen.  This SQL can either be via the Tables and Fields
panels or keyed directly into the 'Query' field.  A basic SQL covering the relevant Budget is
supplied with Ostendo.  This can be adjusted here if required

Customer Used for Company Assets:  From the drop-down list select the “Customer” name to

be used for Company Assets. This should be the Company Name defined as a “Customer” in the

Customer Master

The following three rules relates to Linked Documents and Job and Assembly Folders.

Synchronise Job and Assembly Docs with Folders :  Ticking this box will cause Ostendo to 

a. create a folder (if it does not already exist) for each Job/Assembly Order or Projects

which has a linked document when you click on View Documents. The path used is specified in the

next rule (Parent Folder Path).

b. synchronise Linked Documents in the folder to the respective Job or Assembly order

whenever it is opened.

c. if only this rule is ticked, then the View Documents screen could show documents which

are stored in this Job/Assembly folder as well as documents stored in other folders (if any).

Parent Folder Path : Enter the windows directory path for the Job / Assembly / Sales /

Purchase / Invoice Folders. Example: c:\OSTENDO_DOCUMENTS.  

This entry, together with Mobility Rules - "Create Data Sheet Linked

Docs From"  are required for activating the DataSheet Queue Type in Queue Schedule to

generate the actual pdf when a datasheet is completed.

Copy Linked Documents into Job or Assembly Folder :  Ticking this box will cause Ostendo to 

a. make a copy of any linked document and store it in the respective Job/Assembly folder.

This is useful when you want to make a copy of a template form, edit it and store the modified

version with the Job/Assembly folder.

b. if this rule is ticked, then all linked documents are stored in the associated folder, even

though the original version of that document may be somewhere else.

Email Reports on behalf of user email address : This controls batch invoicing and

statement “From” email Address to be used for the outgoing email. When ticked, this setting

instructs Ostendo to use the email address setup for that Ostendo user's Security-User Options. 

This setting is useful when multiple Ostendo databases are in operation so that batch generated
emails are sent from the appropriate email address.

NB: There maybe some Outlook setup required to enable Outlook to send using this different
address. 
(Refer to this article for more details https://kb.intermedia.net/Article/2165)

https://kb.intermedia.net/Article/2165
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This setting does not control single generated report emails eg: Quotes / Invoices etc...  

Buttons

Close: This will close the General Rules screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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7 CRM

7.1 Contacts

This screen allows you to maintain a file of Contacts.  These Contacts can be referenced when
creating and maintaining a Call record.  Each Contact record contains details of:

· Name and contact details
· Source of Contact
· Additional Notes

List Tab

Display fields

Contact Type: Display only field showing the Contact Type as entered into the Detail tab.  The
displayed options are:

· Company
· Supplier
· Prospect
· Other

Contact Name: Display only field showing the Contact as entered into the Detail tab.  

Customer / Supplier: Display only field showing the Customer or Supplier as entered into the
Detail tab.  

Title: Display only field showing the Contact’s Title as entered into the Detail tab.  

First Name: Display only field showing the First Name of the Contact as entered into the Detail
tab.  

Last Name: Display only field showing the Last Name of the Contact as entered into the Detail tab.
 

Position: Display only field showing the Contact’s position as entered into the Detail tab.  

Phone: Display only field showing the Contact’s Telephone Number as entered into the Detail tab.
 

Mobile: Display only field showing the Contact’s Mobile Number as entered into the Detail tab.  

Fax: Display only field showing the Contact’s Facsimile Number as entered into the Detail tab.  

Email: Display only field showing the Contact’s Email Address as entered into the Detail tab.  

Status : Display only field showing the Contact’s status as entered into the Detail tab. 

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking



221CRM

against will sort in descending order.
· Click on the black ‘down arrow’ to the right of your selected column heading and you can

either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Contacts screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Contact.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Contact from this table

Related: This will bring up a list of functions that are related to the Contact.  You may open and
maintain information in those screens whilst still remaining in the Contacts screen.

Reports: This will bring up a list of Reports that are related to the Contact.  You can immediately
run the report whilst still remaining in the Contacts screen.

Outlook: If you click on this button then the current displayed records will be posted to your
Microsoft Outlook and each line will create an entry in your Outlook Address Book.  Two points to
note:

· Only those records displayed will be posted to Outlook.  Therefore you should first filter the
records to include only those that you want to post to Outlook.

· If you attempt to post a Contact that already exists in Microsoft Outlook then no action will
be taken against that record.  I.e. No ‘Change’ or ‘Delete’ option is provided with this
option

Detail Tab

Entry and Display fields

Contact Name: Entry is only allowed during an Add transaction.  Enter the name of the new
Contact.  

Contact Type: From the drop-down list select the Contact Type.  The options are:
· Company
· Supplier
· Prospect
· Other

Company Name: For Customer or Supplier Contact Type a drop-down list is available for you to
select the Customer or Supplier.  The Customers and Suppliers are maintained under Sales and
Purchasing menus respectively.  For Prospects and other Contact Types you can key in the
relevant Company information.
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Title: Enter the tile (Mr, Mrs, Ms, etc) that applies to the Contact.  No validation checks will be
carried out on this entry

First Name: Enter the First or Forename of the Contact.  No validation checks will be carried out
on this entry

Last Name: Enter the Last or Surname of the Contact.  No validation checks will be carried out on
this entry 

Position: Enter the current position being held by the Contact.  No validation checks will be carried
out on this entry

Phone: Enter the telephone number of the Contact.  No validation checks will be carried out on
this entry

Fax: Enter the Facsimile Number of the Contact.  No validation checks will be carried out on this
entry

Mobile: Enter the Mobile Telephone Number of the Contact.  No validation checks will be carried
out on this entry

Email: Enter the Email address of the Contact.  No validation checks will be carried out on this
entry

Status : Select either Active or InActive.

Notes: You can enter unlimited amount of Notes that are related to this Contact.  These notes will
be available wherever the Contact record is accessed.  Whenever you click on this field an icon
will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.  Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

Buttons

Close: This will close the Contact screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Contact.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Contact.  You may open and
maintain information in those screens whilst still remaining in the Contacts screen.

Reports: This will bring up a list of Reports that are related to the Contact.  You can immediately
run the report whilst still remaining in the Contacts screen.

Outlook: If you click on this button then the current displayed records will be posted to your
Microsoft Outlook and each line will create an entry in your Outlook Address Book.  Two points to
note:

· Only those records displayed will be posted to Outlook.  Therefore you should first filter the



223CRM

records to include only those that you want to post to Outlook.
· If you attempt to post a Contact that already exists in Microsoft Outlook then no action will

be taken against that record.  I.e. No ‘Change’ or ‘Delete’ option is provided with this
option

7.1.1 Contact Properties

This screen allows you to define properties that are specific to a Contact.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Contacts.

Display fields

The displayed fields are taken from the Contact Details.  The selection of which fields to display
here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Contact Properties screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Contact Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel
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Detail Tab

Entry and Display fields

Contact: Display only field showing the Contact selected in the List screen

Company: Display only field showing the Company relating to the Contact selected in the List
screen

Type: Display only field showing the Company related to the Contact.  The display options are:
Customer, Supplier, Prospect, Other

Lower Panel

Property: From the drop-down list select the Standard Property against which a value specific to
this Assembly Order will be made.

Value: Enter a value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    Standard Properties are maintained via
General>Settings>Standard Properties

Buttons

Close: This will close the Contact Property screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Contact Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Contact Property record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Contact Property record.

7.2 Activity Calendar

The Activity Calendar view allows you to see what resources (Employees and/or Assets) are
required to perform the required Activity Events.  The main screen is split into three sections

· The main panel shows Resources, when and on what Event they are required.
· The upper-right panel shows a calendar for you to select the displayed time periods
· The lower- right panel shows all overdue Events

You can resize these panels by clicking on the panel boundaries and dragging them to the
required position



225CRM

Main Panel

The Main Panel shows all Events scheduled for each day displayed.  The Events on display can be
viewed:

· For single or multiple Employees and/or Assets
· Grouped by Resource within Date, Date within Resource, or Events by Date
· In Daily, Workday, Weekly, Monthly, or user-selected time periods
· With a horizontal Timeline

See the ‘Toolbar’ Buttons - below for setting up these functions

The following options are available.

Time Scale: To amend the timeslots of the visible panel right click on the scale down the left-hand
side.  The scale options are:

5 Minutes
6 Minutes (0.1 Hour)
10 Minutes
15 Minutes
30 Minutes
60 Minutes

Activity Information: Each Event shows the following Information
Start and End Time - This is only shown if the start time and/or end time coincides with
the Time Scale defined above
Event Description - Description of the Event entered when it was created
Event Number - Number assigned to the Event when it was created

Over 1 day: If an Event goes over one day then it is presented above the timeslots:
Begins today - The panel will have a ‘clock’ icon on the left showing the start time of the
Event
Ends Today - The panel will have a ‘clock’ icon on the right showing the end time of the
Event
Begins Earlier and ends Later than today - The panel will appear above the timeslots
with no ‘clock’

Event Status: The Event Status is displayed as a coloured ‘band’ surrounding the Event.  These
are pre-defined and represent:

White - Free
Diagonal White Stripe on Blue - Tentative
Blue - Busy
Magenta - Out of Office

Event Status Side Band: The Event Status is also displayed as a thin coloured ‘band’ to the left of
the Timeline.  This displays the Event Status of both Events completed within a day and Events
that take more than a day.

Event Type: The Event itself can be colour-coded to provide an immediate view of the Type of
Event.  Event Types and their colours are predefined as:

· None
· Important
· Business
· Personal
· Vacation
· Must Attend
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· Travel Required
· Needs Preparation
· Birthday
· Anniversary
· Phone Call

To assign an Event Type to an Event simply double click on the Event then select from the
drop-down list against Event Type in the displayed panel.

Event Details: To look at the Event Details either:
Double click on the Event, or
Right Click on the Event and select ‘Open’

      The Event’s Detail screen will be presented.  In this screen you can:
· Amend the Start Time, End Time and/or Duration of the Event
· Amend the Resource allocated to the Event
· Link it to a Customer, Supplier, Prospect, Other, or Employee

Drag and Drop: You can drag an Event and drop:
· Against another Resource
· In the same Resource but to another timeslot

Amend Timeline: You can amend the timeline against a Event by dragging the Start or End
boundary and dragging it to the Required Time

Parallel Events: You can assign Parallel Events to a Resource and they will appear side-by-side
in the Main View

Multiple Resources per Event: If you move one Resource’s Start and End time for an Event then
all other Resources involved with that Event will also move.

Calendar Panel

This panel shows a standard Calendar by month.  You can view more months by dragging the
Calendar Panel boundary left/right/up/down to let you view the desired months.  Within this panel
you will see the following:

Active Days: Any Days that contain a Event will be in Bold.  Clicking on this day will bring up that
day in the Main Panel.  

View Days: If you Drag the cursor over a few days then release, the Main Panel will immediately
reflect the selected time-span.

Overdue Events Panel

This panel shows all the Events that should have been completed by the system date but have not
yet been removed from the Activity Event list.

Toolbar Buttons

Print: You can output the current view to your screen prior to printing or print directly to a selected
printer.
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Email: The drop-down list provides the following options
PDF - Generates a Portable Document Format (PDF) document of the displayed
information and then opens up the Emailing routine on your PC with this PDF document as
an attachment
XLS - Generates an XLS (spreadsheet) from the displayed information and then opens up
the Emailing routine on your PC with this XLS document as an attachment
HTML - Generates an HTML format and displays this in the ‘body’ of the generated email
XML - Generates an XML document, which can be called and displayed as a standard
Web form.    It also creates an XSL document showing the source document from the
displayed information.  The program then opens up the Emailing routine on your PC with
the XML and XSL documents attached.
CSV - Generates an CSV (Comma Separated Value) document from the displayed
information and then opens up the Emailing routine on your PC with this CSV document as
an attachment

Export: The drop-down list provides the following options
PDF - Generates a Portable Document Format (PDF) document.   This file can then
printed and/or attached to an email
XLS -  If this is selected then a panel will appear for you to save the current displayed data
as an Excel Spreadsheet.  You may then call up Excel and manipulate the data as
required.
HTML - If this is selected then a panel will appear for you to save the current displayed
data as an HTML file.  This file can then be called and displayed as a standard Web form
using your Browser.
XML - If this is selected then a panel will appear for you to save the current displayed data
as an XML file.  Two files are created.    

· An XML document that can be called and displayed as a standard Web form
using your Browser.

· An XSL document showing the source document 
This file can then be called and displayed as a standard Web form using your
Browser.

CSV - If this is selected then a panel will appear for you to save the current displayed data
as a Comma Separated Value file.  This can be used as an import format to external
systems.     You may also call up the CSV file in Excel (File Type = .csv) and manipulate
the data as required.

Resources: If you click on this button then the following options are presented in the drop-down
list

Group By: The Main Panel display will change to reflect the selection from
None - All Events (not showing Resources) for above Calendar View
Resource - Display will be Date within Resource for above Calendar View
Date - Display will be Resource within Date for above Calendar View

Resource Layout Editor: ‘Check’ the Resources that you want to appear on the Main
Panel and use the ‘Up’ or ‘Down’ buttons to defined the order in which they are to be
displayed.
Resources per page: Enter or select the number of Resources you wish to appear to be
visible on the Main Panel.  Note: At the bottom left of the Main Panel are scroll arrows that
lets you scroll left or right to view all Resources.
Employee and/or Asset: Check either (or both) Resources to select if they are to appear
in the Main Panel

Views: The Views drop-down enables you to select a view that changes the way you look at the
current Events:

· Days - Shows Resource requirements for current Day
· Workdays - Shows Resource requirements for the days identified as a workday in the
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current week as set up in General>Settings>Work Times.
· Weeks - Shows Resource requirements for current week
· Months - Shows Resource requirements for current Month
· Timeline - Displays the daily Resource requirements in a horizontal format
· Go to Date - Brings up a panel for you to enter the date to display
· View Position - You can select whether to have the ‘Calendar’ and ‘Overdue Events’

Panels appear on the left or right of the screen.

7.3 Call Centre

This screen allows you to create and maintain Customer and Prospect Calls then action and track
them through to closure.

List Tab

Display fields

The displayed fields are taken from Call Centre information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’.
· Click the ‘Save’ Button when done.

Note: If you select to display the CURRENTDUECOLOUR field then the field will show colours
relating to the Action Required Date compared to today's date.  The displayed colours are:

· Red - Overdue
· Orange - Due Today
· Yellow - Due Tomorrow

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Calls whose
status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Call Centre screen.  If you have any unsaved data then you will be asked
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if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Call

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Call from this table

Related: This will bring up a list of functions that are related to the Call Centre.  You may open and
maintain information in those screens whilst still remaining in the Call Centre screen.

Reports: This will bring up a list of Reports that are related to the Call Centre.  You can
immediately run the report whilst still remaining in the Call Centre screen.

Detail Tab

Record Scroll Bar: The button on this bar enable you to show previous or subsequent Calls
without first having to go back to the ‘List’ view.  The button options are (from left to right):

· Go to beginning of Calls in the List View
· Go back one page of calls currently displayed in the List View
· Go to previous Call
· Go to next Call
· Go forward one page of calls currently displayed in the List View
· Go to end of Calls in the List View

Quick Launch Toolbar: To help go directly to common functions a User-Defined Quick Launch
Toolbar is available.   If you click on the extreme right of the Quick Launch bar (the button with the
>> symbol) then a drop-down list of the following main functions is visible.  

· Call Centre Documents
· Contacts
· Customers
· Customer Statistics
· Suppliers
· Sales Orders
· Job Orders
· Purchase Orders
· Knowledge Base
· Price Inquiry
· Inventory Inquiry

Select a function to make it visible on the Quick Launch

Entry and Display fields

Ticket ID: This Call Number is automatically generated from the User-defined numbering set-up in
File>System Configuration>System Settings

Call Method: From the drop-down list select the method by which the call was received.  The
options are:

· Phone
· Fax
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· Email
· Visit
· Letter
· Web
· Other

Call Style: From the drop-down list select the Style which the Call will be using.  The Call Style
(maintained via CRM>Settings>Call Styles) defines the way in which the Call is monitored and
what information is presented.

Date: This is prefilled with the system date and denotes when the Call was received.  You can
amend the date by either overtyping the date or selecting the date from the drop-down calendar.

Time: This is prefilled with the system time and denotes when the Call was received.  You can
amend the date by either overtyping the date or selecting the date from the drop-down calendar.

Service Status:  Upon creating a Call this will show that the call has been ‘Logged’.  This status is
amended when a Service Step has been completed by going into the ‘Service Response’ tab and
entering a date/time in the ‘Actual Response Time’ field.

Call Status: This shows the status of the Call.  This is system maintained.  The displayed options
are:

· Open
· Action Required
· Action Complete
· Closed

Who Ticket is For

'Who'  sub-Tab

Type: From the drop-down list select the Type.  The options are:
· Company
· Supplier
· Prospect
· Other
· Employee

Contact: You can either click on the drop-down list and select a Caller Name from the list of
Contacts that you have on file, or type a name directly into this field.

Company: For Customer or Supplier Call Type a drop-down list is available for you to select the
Customer or Supplier.  The Customers and Suppliers are maintained under Sales and Purchasing
menus respectively.  For Prospects and other Call Types you can key in the relevant Company
information.

Additional Details: If required, enter some additional details relating to the call

Asset: If this call is linked to a Customer Asset then select the Asset from the drop-down list.

Phone: Enter the telephone number of the Caller.  No validation checks will be carried out on this
entry

Phone or Mobile: Enter the Mobile phone number of the Caller.  No validation checks will be
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carried out on this entry

Email: Enter the Email address of the Caller.  No validation checks will be carried out on this entry

Lead Source: From the drop-down list select the source from where this call was received.  Lead
Sources are user defined via Sales>Settings>Customer Lead Sources.

'Address'  sub-Tab

Enter the following information that applies to the Address relating to this Call.  No checks are
made and these fields can be amended at any time.

· Address: Three lines are available for entry of the postal address of the Caller 
· City: Enter the Town or City where this Caller is located.
· State: Enter the State where this Caller is located.
· Code: Enter the Postcode or ZIP Code where this Caller is located.
· Country: Enter the Country where this Caller is located.

What Type of Call

Classification: From the drop-down list select the Classification of the call.  Call Classifications
are user maintained via CRM>Settings>Call Classifications.
 
Sub-Class: From the drop-down list select the Sub-Classification within the previously selected
Call Classification.  Call Sub-Classifications are user maintained via CRM>Settings>Call
Sub-Classifications.

Tracking Code: From the drop-down list select the Tracking that represents the current tracking
status.  Tracking Codes are user maintained via CRM>Settings>Call Tracking

Description: Enter a short description of the reason for the call.  This is available for output to
summarised print lists of calls.

Urgent Ticket : Tick this box if flag this as an urgent ticket. (Urgent flags are also available on Job
Orders, Sales Deliveries, and Assembly Orders). When and urgent Order is sent to Freeway, it will
be displayed at the top of the list for the Start Day it is assigned to. It will also be marked with a
Red indicator.

Call Relates To

Relates to: From the drop-down list select which type the call is referenced to.  The options are:
· Call Only
· Job Order
· Sales Order
· Item
· Customer Asset
· Company Asset
· Purchase Order
· Sales Invoice

Create Order: This button is enabled if 'Sales Order' or 'Job Order' is selected in the above field.
If this button is clicked then the Sales Order or Job Order creation screen will be presented for
creation of a new order.  This Call reference will be copied to the created Order.
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Linked to: For the selection made in field ‘Relates To’ select the specific Order, Asset or Item to
which this Call relates.

Call Notes - Sub Tab

This sub-tab enables you to record additional information about the call and define further actions

Requires Further Action: ‘Check’ this checkbox if further action is required to resolve this call.
When ‘checked’ an additional ‘sub-tab’ (Action Information) will appear and the following two fields
will be activated.

Required By: This is the date when an answer is required to this action.  It is prefilled with the
system date.  However, you can amend the date by either overtyping the date or selecting the date
from the drop-down calendar.

Priority: From the drop-down list select the priority that you are attaching to this call.  The options
are:

· 1-Urgent
· 2-High
· 3-Normal
· 4-Low

Pipeline: This is prefilled with the pipeline linked to the Call Style.   If no pipeline is present against
the Call Style then it can be selected from the dropdown list of Pipelines (Pipelines are maintained
via CRM>Settings>Pipelines

Current Stage: Display only field showing the Current Stage within the Pipeline.

Action Information - Sub Tab

This sub-tab appears if the Call 'Requires Further Action' checkbox is set (See below).   You
should also note that if the Call is linked to a Pipeline that contains Pipeline Actions then those
actions are copied to this call and the 'Requires Further Action' checkbox is automatically set.   

When visible this tab enables you to create/maintain activity records which record the progress of
the call.  An individual Activity record can be immediately emailed to the person responsible for this
activity.

Sequence: Enter a Sequence Number.  This is reference only and is used to determine the
sequence when printing out the Call Actions.

Stage: From the dropdown list select the Stage to be linked to the Action 

Action Sequence: Enter an Action Sequence Number.  This is reference only and is used to
determine the Action Sequence within the above Sequence when printing out the Call Actions.

Action Description: Open format field in which you can enter a brief description of the Action.  No
checks are made on this entry. 

Assigned To: If you wish this action to be assigned to a specific person then select that person
from the drop-down list of Employees.

CC To: If the action is to be copied to a second person then select that person from the drop-down
list of Employees.
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Required Date: Enter the date when the action is to be completed.  

Action History: Enter details of this Action. This can be maintained as required

Complete: If you ‘check’ this checkbox then the following two fields will become active for you to
record the completion information

Sign Off Date: Enter the date when the action was completed by manually entering the date or
selecting it from the drop-down calendar.

Signed Off By: From the drop-down list select the Employee who completed the action.

Emailed: This checkbox is system maintained and when 'checked' denotes that this action has

been emailed.

Auto Email: If this is 'checked' then the Action will automatically be emailed to the 'Assigned To'
and 'CC To' email addresses.  If it is not 'checked' then the email activity can be carried out by
right clicking on the record and selecting 'Email Action'

Auto Email Leadtime: This determines the number of days before the action is due that the
email will be automatically emailed to the Employee 

Required Time and Required Time To is used to set time periods (e.g. appointments) which can

then be displayed on the Assignment Board (if Call Ticket actions are included).

· Required Time: Planned Start Time

· Required Time To: Planned end time.

Call Resolution Information - Sub Tab

This sub-tab enables you to close the Call and record the resolution details

Notes: Enter details of how the closure was achieved.  Whenever you click on this field an icon will
appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text table. 
Select the text to be copied and either press the OK Button in that screen or double-click the
selected record.

Resolution Code: From the drop-down list select the Resolution Code.  These Codes are
maintained via CRM>Settings>Call Resolution Codes.

Additional Fields - Sub Tab

If you have defined Additional Fields against the Call Centre function (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day
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Service Level - Sub Tab

This sub-tab only appears if the ‘Service Level Tracking Activated’ checkbox in CRM Rules screen
has been ‘checked’.   When displayed it shows the Service Agreement and Service Level held
against the Customer record.  If the Customer does not have a definitive Service Agreement or the
source of this call is from other than a Customer then the Service Agreement defined in CRM
Rules will be used.

Severity Level: This is prefilled with the Default Service Agreement Level as entered into the CRM
Rules screen or the Service Agreement Level as held against a Customer Record.  It can be
amended here to another Severity Level if required

Notes: You can enter unlimited amount of Notes that are related to this Service Level. Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record. 

Service Response - Sub Tab

This sub-tab only appears if the ‘Service Level Tracking Activated’ checkbox in CRM Rules screen
has been ‘checked’.   When displayed it shows all the Steps contained within the Service Level
Agreement for the Service Severity level (as entered in the Service Level Sub-Tab).  This screen
allows you to record the actual time spent on each Step within this Service Agreement.  This
feature enables you to analyse the actual response times relative to the agreed Service Agreement
response times 

Step: Display only field showing each Step held against the Service Agreement/Severity level

Planned Response Time: Display only field showing the Planned Response time for this Step
within the Service Agreement.  It is evaluated from the Call origination Date and Time plus the
Planned Duration held against this Step and uses the Work Times calendar and Holiday Dates as
set up in General>Settings.

Planned Duration: Display only field showing the Planned Duration Response time for this Step
within the Service Agreement.  It represents the elapsed time from when the Call was received to
when this Step should be completed.  The duration is taken from the Service Agreement Measures
record (as maintained via CRM>Settings>Service Agreement Measures). 

Actual Response Time: This field enables you to enter the actual Date/Time when the Step was
completed.  You can click on the drop-down Calendar and

· Select the Date by clicking on the Day
· Select the Time by clicking on the time element (HH, MM, or SS) and using the up/down

arrows
· Selecting the a.m./p.m. field and alternating using the up/down arrows
· Click on the ‘Now’ button to select the current Date/Time

Actual Duration: Display only field showing the Actual Duration Response time for this Step and is
calculated from the Call origination Date and Time plus the Actual Response Time entered in the
previous field.

Comment: Option entry field for you to enter a comment relating to the line Actual Duration:
Display only field showing the Actual Duration Response time for this Step and is calculated from
the Call origination Date and Time plus the Actual Response Time

Standard Information - Sub Tab
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This sub-tab displays information identified against the Call Style selected in the Call Centre 'Detail'
screen.  Call Styles are maintained via CRM>Settings>Call Styles.   If the Call Style is flagged to
allow changes then the information in this tab can be amended as required.

Time Line - Sub Tab

This sub-tab displays a graph of the Actions within the Pipeline linked to this call.   The dates
against each action is evaluated from the Call Date plus the number of 'Required Days From Start'
as held against the Pipeline Actions record.

Close Off Call

(Button) Close Call: Clicking this button will change the Call status to ‘Closed’.  

Date: Display only field showing the date when the Call was closed. Note: A previously closed Call
Ticket can be re-opened by clearing this date here.

Time: Display only field showing the time when the Call was closed.

Buttons

Close: This will close the Call Centre screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will show a blank ‘Detail’ screen for entry of a new Call.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not active in this view

Related: This will bring up a list of functions that are related to the Call Centre.  You may open and
maintain information in those screens whilst still remaining in the Call Centre screen.

Reports: This will bring up a list of Reports that are related to the Call Centre.  You can
immediately run the report whilst still remaining in the Call Centre screen.

7.3.1 Call Centre Documents

This screen can be found by clicking the 'Related' Button on the Call Centre screen.  It allows you
to define documents, etc that are specific to a Call Ticket.    

List Tab

Display fields

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Call Ticket to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options
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Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Call Centre Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Call Ticket Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Call Ticket

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name that you are calling the document in this Document- Call Ticket
linkage.    No checks are made on the entry.

Document Type: Prefilled with ‘Call Centre’

Linked to: From the drop-down list select the Call Ticket that uses this document

Copy to Jobs: If this is ‘checked’ then the document link will be copied to all Job Orders raised
against this Call Ticket.

Copy to Sales: If this is ‘checked’ then the document link will be copied to a Sales Order raised
against this Call Ticket.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.
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Buttons

Close: This will close the Call Centre Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Call Centre Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Call Ticket Documents record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

7.3.2 Location Map

This screen can be found by clicking the 'Related' Button on the Call Centre screen.  When
selected it will display a panel in which you can select either Map or Directions

If you select 'Map' Ostendo will use the mapping system identified in System Settings (this is
initially set to use Google Maps) and, using the Prospect's Address, open up the Google Map at
that address

If you select 'Directions' Ostendo will use the mapping system identified in System Settings and
provide directions to travel from the address set up in System Settings to the Prospect's Address

7.4 Activity Events

This screen allows you to add and maintain details of Activity Events.  These Events can also be
created and maintained in the Activity Calendar view.  Activity Events enable you to:

· Log Events as they arise
· Allocate an Event Type and Status
· Allocate an estimated start date/time and duration
· Contact Name and details
· Activity Notes

List Tab

Display fields

The displayed fields are taken from the Activity Event details entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options
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Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Activity Event screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Activity Event.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Activity Event from this table

Related: This will bring up a list of functions that are related to the Activity Event.  You may open
and maintain information in those screens whilst still remaining in the Activity Event screen.

Reports: This will bring up a list of Reports that are related to the Activity Event.  You can
immediately run the report whilst still remaining in the Activity Event screen.

Detail Tab

Entry and Display fields

Event Type: From the drop-down list select the Type of Event.  The options are:
· None
· Important
· Business
· Personal
· Vacation
· Must Attend
· Travel Required
· Needs Preparation
· Birthday
· Anniversary
· Phone Call  

Event Status: From the drop-down list select the Event Status.  The options are:
· Free
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· Tentative
· Busy
· Out of Office  

Description: Enter a brief description of the Activity Event.  A longer description can be entered
into the Notes field.

Resources: From the drop-down list select the Resource(s) that are allocated to this Event.

Start Date / Time: Enter the start date and time for this Event.  This will be the start date/Time that
will appear on the Activity Calendar.

End Date / Time: Enter the end date and time for this Event.  Entry here is not required if the next
field is ‘checked’

All Day Event: If this is ‘checked’ then the Event’s elapsed time is equal to, or greater then, one
day.

Complete: Tick this box if the event is already completed.

Where: A free-format entry field in which you can define where the Event is being carried out.

Contact Details

Contact Type: From the drop-down list select the Contact Type.  The options are:
· Company
· Supplier
· Prospect
· Other

Contact Name: You can either click on the drop-down list and select a Contact Name from the list
of Contacts that you have on file, or type a name directly into this field.

Email: Enter the Email address of the Contact.  No validation checks will be carried out on this
entry

Company: For Customer or Supplier Contact Type a drop-down list is available for you to select
the Customer or Supplier.  The Customers and Suppliers are maintained under Sales and
Purchasing menus respectively.  For Prospects and other Contact Types you can key in the
relevant Company information.

Phone: Enter the telephone number of the Contact.  No validation checks will be carried out on
this entry

Mobile: Enter the Mobile Telephone Number of the Contact.  No validation checks will be carried
out on this entry

Message: You can enter unlimited amount of Notes that are related to this Event. Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Activity Event screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.
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Add: This will bring up a blank ‘Detail’ screen for entry of a new Activity Event.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Activity Event.  You may open
and maintain information in those screens whilst still remaining in the Activity Event screen.

Reports: This will bring up a list of Reports that are related to the Activity Event.  You can
immediately run the report whilst still remaining in the Activity Event screen.

7.5 Operations Centre

This screen pulls together all activities and emails that have occurred within Ostendo from a
nominated source (example: Customer, Supplier, Sales, Jobs, Manufacturing, etc) plus emails that
have been assigned to Customer, Suppliers and other activities via an email add-in.    It presents a
central source of information from which all associated data is instantly accessible.   Additionally,
facility is provided to transact requests or actions emanating from that source

The main Operations Centre screen is divided into three panels:
Conditions and Activities Bar - for selecting what is to be displayed
Activities Panels - showing all information derived from the Conditions and Activities
setting
Preview Panel - Displays details of the selected activity in the Activities panel

The Outlook Add-In used with the Operations Centre has been modified to run with Outlook
2016. This update includes a new OutlookAddIn.exe which is stored in the Ostendo folder.

Download the latest Version from: 
http://www.ostendo.info/downloads/ostendo/OutlookAddIn.exe

To apply this update to an existing installation of the Add-In, perform the following:
· Ensure you fully close Outlook

· Run the OutLookAddIn.exe as Administrator

· Uninstall the Existing Add In on each machine and reinstall the new version.

Conditions and Activities Bar

This panel contains two toolbars:
New Activities Toolbar: Provides the ability to create new activities based on the Type
that has been selected in the 'Type' dropdown in the Conditions Toolbar.
Conditions Toolbar: Provides the ability to condition what appears in the Activity List and
Preview panels.

New Activities Toolbar
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(Left Arrow): By clicking on this arrow you can progressively browse through previous selections
made in this session.

(Down Arrow): Clicking this arrow will display a drop-down of all previous selections made in this
session.  You may then select the specific selection for display.

(Activity Buttons): Various Activity buttons are presented depending upon the selection made in
field 'Type' in the Conditions Toolbar.  These are:

Type 'Customer'
New Sales Order - Brings up the Sales Order entry screen for creation of a new
Sales Order.  If a Customer was also selected in the Conditions Toolbar then that
Customer will prefill the relevant fields in the Sales Order Entry panel.
New Job Order - Brings up the Job Order entry screen for creation of a new Job
Order.  If a Customer was also selected in the Conditions Toolbar then that
Customer will prefill the relevant fields in the Job Order Entry panel.
New Direct Invoice - Brings up the Direct Invoice entry screen for creation of a
new Invoice.  If a Customer was also selected in the Conditions Toolbar then that
Customer will prefill the relevant fields in the Direct Invoice Entry panel.
New Payment - Brings up the Payment entry screen for creation of a new
Payment record.  If a Customer was also selected in the Conditions Toolbar then
that Customer will prefill the relevant fields in the Payment Entry panel.
New Deposit - Brings up the Deposit entry screen for creation of a new Deposit
record.  If a Customer was also selected in the Conditions Toolbar then that
Customer will prefill the relevant fields in the Deposit Entry panel.
New Email - Brings up your computer's email panel for creation of a new Email.  If
a Customer was also selected in the Conditions Toolbar then that Customer
Contact's email address will prefill the relevant field in the Email.
New History Note - Brings up the History Notes screen for creation of a new
Note.  If a Customer was also selected in the Conditions Toolbar then that
Customer will prefill the relevant fields in the History Note Entry panel.  If a
Customer has not been selected then you are required to select the Customer
from a pop-up screen prior to going to the History Note screen.
New Call Ticket - Brings up the Call Centre screen for creation of a new Call
Ticket.  If a Customer was also selected in the Conditions Toolbar then that
Customer will prefill the relevant fields in the Call Ticket Entry panel.
New Customer - Brings up the Customers screen for creation of a new Customer
record. 

Type 'Supplier'
New Purchase Order - Brings up the Purchase Order entry screen for creation of
a new Purchase Order.  If a Supplier was also selected in the Conditions Toolbar
then that Supplier will prefill the relevant fields in the Purchase Order Entry panel.
New Purchase Receipt - Brings up the Purchase Receipt entry screen for
creation of a new Purchase Receipt.  If a Supplier was also selected in the
Conditions Toolbar then that Supplier will prefill the relevant fields in the Purchase
Receipt Entry panel.
New Purchase Invoice - Brings up the Purchase Invoice entry screen for creation
of a new Purchase Invoice.  If a Supplier was also selected in the Conditions
Toolbar then that Supplier will prefill the relevant fields in the Purchase Invoice
Entry panel.
New Email - Brings up your computer's email panel for creation of a new Email.  If
a Supplier was also selected in the Conditions Toolbar then that Supplier
Contact's email address will prefill the relevant field in the Email.
New History Note - Brings up the History Notes screen for creation of a new
Note.  If a Supplier was also selected in the Conditions Toolbar then that Supplier
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will prefill the relevant fields in the History Note Entry panel.  If a Supplier has not
been selected then you are required to select the Supplier from a pop-up screen
prior to going to the History Note screen.
New Call Ticket - Brings up the Call Centre screen for creation of a new Call
Ticket.  If a Supplier was also selected in the Conditions Toolbar then that
Supplier will prefill the relevant fields in the Call Ticket Entry panel.
New Supplier - Brings up the Suppliers screen for creation of a new Supplier
record. 

Type 'Customer Asset'
New History Note - Brings up the History Notes screen for creation of a new
Note.  If a Customer Asset was also selected in the Conditions Toolbar then that
Asset will prefill the relevant fields in the History Note Entry panel.  If a Customer
Asset has not been selected then you are required to select the Asset from a
pop-up screen prior to going to the History Note screen.
New Call Ticket - Brings up the Call Centre screen for creation of a new Call
Ticket.  If a Customer Asset was also selected in the Conditions Toolbar then that
Asset will prefill the relevant fields in the Call Ticket Entry panel.
New Customer Asset - Brings up the Customer Asset screen for creation of a
new Customer Asset record. 

Type 'Sales' - No buttons directly linked to Sales Orders

Type 'Purchases' - No buttons directly linked to Purchase Orders

Type 'Jobs' - No buttons directly linked to Job Orders

Type 'Manufacturing'
New Assembly Order - Brings up the Assembly Orders screen for creation of a
new Assembly Order record. 

Type 'Un-Assigned Emails' - No buttons directly linked to Un-Assigned Emails

Conditions Toolbar

Type: From the drop-down list select the primary focus of the screen.  The options are: 
· Customer
· Supplier
· Customer Asset
· Sales
· Jobs
· Purchasing
· Manufacturing
· Un-Assigned Emails
· To-Do

Name: The following is available:
· For Customer, Supplier, or Customer Asset select the specific record from the drop-down

list.  
· For  Sales, Jobs, Purchasing, Manufacturing you can select the status from either ‘Exclude

Closed and Updated’ or ‘All Status’.  
· For To-Do the display will show any Calendar Reminders, History Note Follow-ups,

Outstanding Ticket Actions and Quote Follow-ups that relate to the user currently logged into
Ostendo.  You may 'right click' on the displayed activities and a panel gives you the options
to ‘Update to Actioned’which flags the Calendar Reminder, History Note Follow-up, Quote
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Follow-up or Ticket Action as being completed.  
· This field is not applicable to Type 'Un-Assigned Emails'

Display Pending Events: If you 'check' this checkbox you can include pending activities such as
pending Purchase Orders or Assembly Orders when returning the activity list results. 

Site: 'Check' this checkbox and select the Site from the drop-down in the adjacent field if you wish
to restrict to a specific company site 

Date From: This determines the date from which data will be analysed.   It is prefilled with a date
calculated from the 'Days Back' as held in the CRM>Settings>OC Rules screen.   You may amend
this by selecting an new date from the drop-down calendar

Date To: This determines the date up to which data will be analysed.   It is prefilled with the
system date but you may amend this by selecting an new date from the drop-down calendar

Mode: Select the type of mode from the 3 options which are: 
Activity: This is the default mode.  It pulls back all activities related to the Type selected
(For example if the Type = ‘Customer’ then the activities pulled back would be: Sales
Quotes, Sales Orders, Sales Invoices, Customer Payments, Customer Emails, Customer
Notes, Customer Tickets etc...).   These Activity Types are defined in the ‘
CRM>Settings>OC Activities’ screen in a Query.   You may (a) add your own data to that
query (where you have defined a user defined table / solution), or (b) modify the SQL to
suit your specific company requirement. 
Relationship: This mode enables you to select a type of Activity and its specific ID (for
example a Sales Invoice activity and a specific Invoice Number).  Ostendo then returns all
other related activities (using our example the related activities could be Sales Orders, Job
Orders, Customer Deposits, Customer Payments, Emails, Notes, Sales Deliveries, Call
Tickets).   These Relationships are defined in the ‘CRM>Settings>OC Relations’ screen.  
Search: This mode allows you to search through all activities or a specific type for a series
of characters or phrase. The search checks for descriptive, note, reference, order number,
and code fields for that sequence of characters anywhere in those fields. This is useful for
finding correspondence that might contain say a Project name (searches email bodies,
history notes, linked document notes etc...). The fields that are searched are defined in
the ‘CRM>Settings>OC Search’ screen, therefore, you are able to add your own fields to
suit a specific company requirement. 

Activity Panels

The Activity Panels display the current information from the selections made in the Conditions
Toolbar.   This shows a 'Balance Bar' (for Type 'Customer' only) and four Tabs (List, KPI,
Statistics, and Info)

Balance Bar: This only displays if the Type = ‘Customer’ and shows the Outstanding customers
balance, any unapplied payments or deposits, and the outstanding balances aged according to the
aging period definition in the ‘File-Financial Configuration-Aging Periods’.   Each of the captions to
the left of the values can be clicked on/off which then filters the Activity List displaying only
transactions that relate to that period. At the end of the Balance Bar there is a ‘Statements’ button
which, when clicked on, will generate a Customer Statement for current Customer.

List Tab: The Activity List is the hub of the screen, and displays the activities determined via the
Conditions Toolbar. There are four elements to the Activity 'List' tab:

Search: If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then
all the 'List' Activity records will be interrogated and those records that contain the entered
text will be displayed. To revert back to displaying all records click on the ‘Eraser’ Icon
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Filter: By default 'All' records satisfying the Condition will be displayed.  A quick filter of
these records can be achieved by clicking the appropriate button.  The displayed buttons
vary depending upon the 'Type' selected.
Priority Note: This will only display if there are priority notes flagged against the Type
selected.  You have the option to click on an adjacent 'Display Priority Notes' button to
view these Notes.
Activities: All the Activities extracted in accordance with the Condition (and Filters) are
displayed.   A full display of key information can be seen by using the horizontal scroll bar. 
The actual fields displayed will depend on the Activity Type.  You will also note that under
each Activity Type record there is a description (in Blue Italics) which provides more
information about that activity.
Additionally you have the option (via CRM>Settings>OC Activities screen) to colour code
each Activity for ease of recognition.
If you 'Right Mouse' on the Activity List a menu is presented that offers the following:

Show Relationship: This will automatically set the Mode (in Conditions Panel) to ‘
Relationship’ along with the ID from the highlighted activity, so that all activities
related to the current activity are displayed. 
Set to Activity Mode: This sets the Mode (in Conditions Panel) to Activity and
displays all activities for the other conditions specified. 
Go Back: This goes back to the previous conditional settings
Create Note: Automatically creates a History Note based on the activity currently
selected. 
Create Internal Email: This creates an email passing the Activity Type and ID to
the subject of the email and setting the email address based on the default held
against the Activity Type (see CRM>Settings>OC Activities). 
Create External Email: This creates an email passing the Activity Type and ID to
the subject of the email and setting the email address based on the Customer
and/or Supplier of the activity. 
Create Ticket: This creates a Call Ticket passing the Customer or Supplier and
also the Activity Type to the 'Relates To' option in the Call Ticket (if that Activity
Type is available in the 'Relates To' dropdown). 

KPI Tab: This tab has two panels.  The left-hand panel displays Key Performance Indicators (KPI’
s) that relate to the Type and name selected in the Conditions Panel.   I.e. If you selected a
Customer, then the KPI’s will relate to that customer.   It contains three value fields:

· Key Value - The base value against which the KPI is evaluated
· Comparative Value - The value against which the Key Value is compared
· Percentage - system calculated from ((Key Value) / (Comparative Value) * 100).  This field

can be colour coded (via CRM>Settings>KPI Indicators) to provide instant recognition of
values outside an expected tolerance

The right-hand panel displays information that makes up that KPI value. The definition of these KPI
’s can be found in the CRM>Settings>OC KPIS screen.   You should also note that the KPI
percentages can also be colour coded based on their value (These are defined in the ‘
CRM>Settings>OC KPI Indicators’ screen). 

Statistics Tab: This tab has two panels.  The left-hand panel displays Statistics that relate to the
Type and name selected in the Conditions Panel.   I.e. If you’ve selected a Customer, then the
Statistics will relate to that customer.   The right-hand panel displays information that makes up
that Statistic value. The definition of these Statistics can be found in the CRM>Settings>OC
Statistics screen. 

Info Tab: This tab displays general information about the Type and name selected in the
Conditions Panel.   For example:- If you select a Customer then you may wish to display address
and contact details. The definition of this is in the CRM>Settings>OC Rules screen
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Preview Panel

This panel is visible when in the 'List' tab and displays up to two of the following (dependent upon
the Activity Type selected): 

Inquiry: This displays a standard inquiry for the selected Activity Type (as defined in the
CRM>Settings>OC Preview screen). Not applicable to Emails, Notes and Linked
Documents 
Report: This displays a standard report preview for that Activity Type (as defined in the
CRM>Settings>OC Preview screen). Not applicable to Emails, Notes and Linked
Documents 
Email: This displays the HTML representation of the linked email (along with attachments,
embedded images and web links). This is only applicable to emails. 
Note: This displays the notes and header information of the History Note. This is only
applicable to History Notes. 
Document: This displays the document notes and header information of the Linked
Document (you can display the linked document by clicking on the embedded document
path). This is only applicable to Linked Documents that have been flagged as
Correspondence. 
Contacts: This displays all contacts for either the Customer or Supplier. The tab will not
display if the company has no contacts defined. You have the option to right click and
email that contact directly.
Assets: This only displays for Customers with Customer Assets defined. You have the
option to right click on a specific asset within the grid, and then by selecting the ‘Show
Relationship’, the main Type in the Conditions Toolbar will be set to ‘Customer Asset’ the
Name will be pre-filled with asset name and the Activity List will now display any related
activities for that asset.
History: This displays for Customers and Suppliers, and lists a ranked history of all
products and services (either sold or purchased) for the period as defined in the
CRM-Settings-OC Rules ‘Invoiced History Days Back’ field. There are also columns that
indicate the average discount per product and whether that product or service is in growth
or decline (compares to the previous period – i.e. For 365 Days the comparison would be
for the previous 365 Days) .
Pricing: This only displays for Customers, and lists all Price Levels, Special Pricing,
Discounting and Order Pricing Rules that apply for the current date, and into the future.
Timeline: This only displays when the Activity is linked to a Call Ticket. A Timeline view of
the Actions/Stages is shown, giving a graphical representation of status of that Ticket.
About: This is a graphical file (edited through the Ostendo Graphical Editor) that can used
as a graphical help.

7.6 Settings

7.6.1 Call Classifications

This screen allows you to maintain a file of Call Classifications Codes, which are used for Call
Analysis purposes.  Call Classifications Codes are User-defined and can include such codes as:

· General
· Product
· Service

Entry and Display fields

Class: Enter the Name of the Call Classification Code.  Duplicates not allowed.

Description: Enter a short description of the Call Classification Code.  No checks are made on
this entry
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Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Call Classification screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Call Classification Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Call Classification.

7.6.2 Call Sub-Classifications

This screen allows you to maintain a file of Call Sub-Classifications Codes, which are used for Call
Analysis purposes.  Call Sub-Classifications Codes are User-defined and can include such codes
as:

· Ostendo
· Evestigo
· Small Business Pack

Entry and Display fields

Class: From the drop-down List select the Call Classification to which this sub-classification is
being applied

Sub Class: Enter the Name of the Call Sub-Classification Code.  Duplicates not allowed.

Description: Enter a short description of the Call Sub-Classification Code.  No checks are made
on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Call Sub-Classification screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Call Sub-Classification Code.

Save: This will save the current data without exiting the screen
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Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Call Sub-Classification.

7.6.3 Call Resolution Codes

This screen allows you to maintain a file of Call Resolution Codes, which are used for Call Analysis
purposes.  Call Resolution Codes are User-defined and can include such codes as:

· Training Required
· Pdf write-up sent

Entry and Display fields

Code: Enter the Name of the Call Resolution Codes.  Duplicates not allowed.

Description: Enter a short description of the Call Resolution Codes.  No checks are made on this
entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Call Resolution Codes screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Call Resolution Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Call Resolution Code.

7.6.4 Pipelines

Pipelines show the various 'steps' that a Call is to go through along with supporting information and
actions.  It appears on the Call Centre Ticket screen as a display 'tab' headed 'Timeline'.   The
creation of the Timeline display comprises of a combination of three screens

Pipelines: Description of the Pipeline
Pipeline Stages: Defines the various 'Stages' within the Pipeline
Pipeline Actions:  Action(s) required within the Stages

This screen defines the Pipelines

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
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left or right to the position where you want it to appear.

Entry and Display fields

Pipeline Name: Enter the name of the Pipeline.  No checks are made on this entry but duplicates
are not allowed.

Description: Enter a brief description of the Pipeline.  No checks are made on this entry.

Buttons

Close: This will close the Pipeline screen. If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Pipeline record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Pipeline record.

7.6.5 Pipeline Stages

Pipelines show the various 'steps' that a Call is to go through along with supporting information and
actions.  It appears on the Call Centre Ticket screen as a display 'tab' headed 'Timeline'.   The
creation of the Timeline display comprises of a combination of three screens

Pipelines: Description of the Pipeline
Pipeline Stages: Defines the various 'Stages' that can be used within a Pipeline
Pipeline Actions:  Identifies the Pipeline Stages to be used within a selected Pipeline and
also nominate action(s) required within the Stages

This screen defines the Pipeline Stages

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Stage Name: Enter the name of the Stage.  No checks are made on this entry but duplicates are
not allowed.

Sequence: Enter a number which defines the sequence in which the Pipeline Stages are to be
displayed.  No checks are made on this entry.

Stage Colour: This allows you to nominate a colour which will be displayed against this Stage in
the 'Timeline' tab on the Call Centre screen.   Select the Colour from the drop-down list



249CRM

Probability %: This is the probability of a successful outcome for the process when this stage is
reached or achieved. Enter an integer value.

Buttons

Close: This will close the Pipeline Stages screen. If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Pipeline Stage record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Pipeline Stage record.

7.6.6 Pipeline Actions

Pipelines show the various 'steps' that a Call is to go through along with supporting information and
actions.  It appears on the Call Centre Ticket screen as a display 'tab' headed 'Timeline'.   The
creation of the Timeline display comprises of a combination of three screens

Pipelines: Description of the Pipeline
Pipeline Stages: Defines the various 'Stages' that can be used within a Pipeline
Pipeline Actions:  Identifies the Pipeline Stages to be used within a selected Pipeline and
also nominate action(s) required within the Stages

This screen defines the Pipeline Actions

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Pipeline: From the dropdown list select the Pipeline to which this Action applies.

Stage Sequence: Enter a Sequence Number.  You can then use this sequence when printing out
the Pipeline Actions.

Stage: From the dropdown list select the Stage to be linked to the Pipeline 

Action Sequence: Enter an Action Sequence Number.  This is output to the relevant field in the 
'Action Information' tab of the Call Centre screen where this Pipeline is used

Action Description: Open format field in which you can enter a brief description of the Action.  No
checks are made on this entry.  This is then output to the relevant field in the 'Action Information'
tab of the Call Centre screen where this Pipeline is used

Assigned To: If you wish this action to be assigned to a specific person then select that person
from the drop-down list of Employees.
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CCed To: If the action is to be copied to a second person then select that person from the
drop-down list of Employees.

Required Days From Start: Enter the number of days from the start of the Call when this action is
required to be completed.

Auto Email Action: If this is 'checked' then the Action will automatically be emailed to the
'Assigned To' and 'CCed To' email addresses.  If it is not 'checked' then the email activity can be
carried out by right clicking on the record in the 'Action Information' tab of the Call Centre screen

Buttons

Close: This will close the Pipeline Actions screen. If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Pipeline Action record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Pipeline Actions record.

7.6.7 Call Styles

The Call Style determines the style of Ticket being actioned (For example: Opportunity, Customer
Claim, Capital Approval, etc...).  Against the Call Style you are able to define:

· Whether the Ticket Actions are modifiable
· The default Pipeline linked to this Style
· Whether this Style is a Sales Opportunity (for reporting purposes)
· Whether this Style is an Order Approval (for reporting purposes)
· The following fields can also be activated for reporting purposes

Expected Revenue
Expected Costs
Probability %
Completion %
Employee Responsible
Strengths (Notes Field)
Weaknesses (Notes Field)
Risks (Notes Field)
Benefits (Notes Field)
Competition (Notes Field)

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Style: Enter the name of the Style.  No checks are made on this entry but duplicates are not
allowed.
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Can Be Modified: If this is 'Checked' then the details of the Style when it has been copied to a Call
cannot be modified.   If this is not 'checked' then changes can be made within the Call that this has
been copied to.

Linked Pipeline: From the dropdown list select the Pipeline to be associated with this Style. 
Pipelines are maintained within CRM>Settings

Sales Opportunity: If this Style is to be associated with a Sales Opportunity then 'check' this
checkbox.   

Order Approval: If this Style is to be associated with a Purchase Order then 'check' this
checkbox.   

Display Expected Revenue: If this is 'checked' then an Expected Revenue field will appear on the
'Standard Information' tab in the Call Ticket's main screen where you can enter and maintain the
Expected Revenue amount.

Display Expected Costs: If this is 'checked' then an Expected Cost field will appear on the
'Standard Information' tab in the Call Ticket's main screen where you can enter and maintain the
Expected Cost amount.

Display Probability: If this is 'checked' then a Probability field will appear on the 'Standard
Information' tab in the Call Ticket's main screen where you can enter and maintain the Probability
amount.

Display Completion %: If this is 'checked' then an Completion % field will appear on the
'Standard Information' tab in the Call Ticket's main screen where you can enter and maintain the
Completion Percentage amount.

Display Responsibility: If this is 'checked' then a Responsibility field will appear on the 'Standard
Information' tab in the Call Ticket's main screen where you can enter and maintain the entry.

Display Strength Notes: If this is 'checked' then a Strength Notes field will appear on the
'Standard Information' tab in the Call Ticket's main screen where you can enter and maintain
information about the Customer's/Supplier's Strengths.

Display Weakness Notes: If this is 'checked' then a Weakness Notes field will appear on the
'Standard Information' tab in the Call Ticket's main screen where you can enter and maintain
information about the Customer's/Supplier's Weaknesses.

Display Risk Notes: If this is 'checked' then a Risk Notes field will appear on the 'Standard
Information' tab in the Call Ticket's main screen where you can enter and maintain information
about the Customer's/Supplier's Risks.

Display Benefits Notes: If this is 'checked' then a Benefits Notes field will appear on the
'Standard Information' tab in the Call Ticket's main screen where you can enter and maintain
information about the Customer's/Supplier's Benefits.

Display Competition Notes: If this is 'checked' then a Competition Notes field will appear on the
'Standard Information' tab in the Call Ticket's main screen where you can enter and maintain
Competition information relating to the Customer/Supplier.

Buttons

Close: This will close the screen. If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.
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Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

7.6.8 Call Tracking

Call Tracking allows you to nominate a colour relating to a Tracking Status.   This Tracking Status
is then selected within the main Call Centre Ticket screen.   This facilitates the display of the the
Tracking Colour in the Call Centre 'List' view for quick identification and filtering

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Status: Enter the name of the Tracking Status.  No checks are made on this entry but duplicates
are not allowed.

Description: Enter a brief description of the Status.  No checks are made on this entry.

Tracking Colour: This allows you to nominate a colour which will be displayed whenever this
status is selected in the Call Centre screen.   Select the Colour from the drop-down list

Buttons

Close: This will close the Call Tracking screen. If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Call Tracking record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Call Tracking record.

7.6.9 Service Agreements

This screen allows you to maintain Service Agreements.  These are used to link Service Response
Levels and Service Steps to an agreement then monitor actual progress and level of response
achieved.   

Entry and Display fields
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Service Agreement: Enter the name of the Service Agreements.   Duplicates not allowed.

Description: Enter a short description of the Service Agreement.  No checks are made on this
entry

Notes: You can (optionally) enter an extended description of the Service Agreement

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Service Agreement screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Service Agreement.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Service Agreement.

7.6.10 Service Agreement Levels

This screen allows you to define the Service Agreement levels that can be used against a Service
Agreement.  This Level - combined with a Service Agreement Step - will have a desired Service
Response time.  This relationship is maintained via screen ‘Service Agreement Measures’

Entry and Display fields

Service Agreement: From the drop-down list select the Service Agreement to which this Service
Level is being associated

Service Level: Enter a Severity Level against which you wish to use against this Agreement.  The
entry must be a numeric Integer.  Duplicate Service Agreement/Agreement level combinations not
allowed

Description: Enter a short description of the Service Level.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons
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Close: This will close the Service Level screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Service Level.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Service Level.

7.6.11 Service Agreement Steps

This screen allows you to define the Service Agreement Steps that can be used against a Service
Agreement.  A Step - combined with a Service Level - will have a desired Service Response time. 
This relationship is maintained via screen ‘Service Agreement Measures’

Entry and Display fields

Service Agreement: From the drop-down list select the Service Agreement to which this Service
Step is being associated

Step Sequence: Enter the sequence of the Service Step.

Service Step: Enter an identifier to the Service Step that you will use within the above Service
Agreement.  Duplicate Service Agreement/Agreement Step combinations not allowed

Description: Enter a short description of the Service Step.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Service Step screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Service Step.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Service Step.
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7.6.12 Service Agreement Measures

Using combinations of the Service Levels and Steps identified against a Service Agreement this
screen enables you to identify the expected Service Response Time

Entry and Display fields

Service Agreement: From the drop-down list select the Service Agreement to which this Service
Measure is being applied.

Service Level: From the drop-down list select the Service Level to which this Service Measure is
being applied.

Service Step: From the drop-down list select the Service Step to which this Service Measure is
being applied.

(Note: Duplicate Service Level/Service Step combinations within the Service Agreement is not
allowed)

Response Scale: From the drop-down list select the scales to be used in conjunction with the ‘
Response Time’ field.  The options are Days, Hours, or Minutes

Response Time: Enter the number of Days, Hours, or Minutes (defined in the Response Scale
field) that will be expected for this Service Step/Service Level combination to be completed.  This
represents the elapsed time from the start of the Call 

Response Target %: Enter the target percentage where the Actual Response Time to Expected
Response Time should be achieved.  

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Service Agreement Measures screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Service Agreement Measure.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Service Agreement Measure.

7.6.13 OC Settings
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7.6.13.1 OC Activities

This screen allows you to create and/or maintain your own selection criteria for Activities that will
be presented in the 'Operations Centre' screen (CRM>Operations Centre).

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Company Type: From the drop-down list select the Activity Type.  This points to the primary focus
of the Activity.  The options are:

· Customer
· Supplier
· Customer Asset
· Sales
· Jobs
· Purchasing
· Manufacturing
· Un-Assigned Emails

Style Of Activity: From the drop-down list select the Activity Style.  This points to the primary
source of the Activity.  The options are:

Screen: If it relates to data maintained via an Ostendo Screen then use this option
Table: If it relates directly to a Table (I.e. data not maintained via an Ostendo Screen) then
use this option

Style Name: From the drop-down list select the Style Name.  The presented options are
dependent upon the Type and Style selections.  For example: If the Type is 'Customer' and the
Style is 'Screen' then all screens related to the Customer are presented

Activity Type: User-defined name of the Activity.  This is the name that will be displayed on the
Operations Centre 'List' tab against this Activity

System Activity SQL: This is the base system Activity SQL that will be used if a Company Level
Activity SQL (see field below) does not exist.   This SQL cannot be amended BUT you have the
option to copy this SQL from the drop-down panel and paste this into the Company Activity SQL
field where it can be amended.

System Condition SQL: This is the base system Condition SQL that will be used if a Company
Level Condition SQL (see field below) does not exist.   This SQL cannot be amended BUT you
have the option to copy this SQL from the drop-down panel and paste this into the Company
Condition SQL field where it can be amended.

Company Activity SQL: You can create and maintain your own Activity SQL related to this Activity
record.  An SQL here will take priority over the System Activity SQL.   You may wish to consider
copying the System Activity SQL and paste it into this field where it can be amended.

Company Condition SQL: You can create and maintain your own Condition SQL related to this
Activity record.  An SQL here will take priority over the System Condition SQL.   You may wish to
consider copying the System Condition SQL and paste it into this field where it can be amended.
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Pending Event: If this Activity is a 'Pending' event (Example: Order awaiting approval) then
'check' this checkbox.   In the Operations Centre screen you have the option to include or exclude
events flagged as 'Pending'

Internal Email Address: If you 'Right Mouse' on an Activity in the Operations Centre screen an
option is presented to send an 'Internal Email'.   It is the address entered here that populates the
generated email

Background Colour: From the drop-down list select a colour.  This colour will be used against
this Activity in the Operations Centre screen.   This provides a quick visual reference to all
activities of this type

Buttons

Close: This will close the OC Activities screen. If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new OC Activity record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted OC Activity record.

7.6.13.2 OC Activity Descriptions

This screen allows you to create and/or maintain descriptions related to Operation Centre
Activities.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Company Type: From the drop-down list select the Activity Type.  This points to the primary focus
of the Activity.  The options are:

· Customer
· Supplier
· Customer Asset
· Sales
· Jobs
· Purchasing
· Manufacturing
· Un-Assigned Emails
· To Do

Activity Type: Select from a list of pre-defined Activity Types.

System Description SQL: This is the base system Description SQL that will be used if a
Company Level Description SQL (see field below) does not exist.   This SQL cannot be amended
BUT you have the option to copy this SQL from the drop-down panel and paste this into the
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Company Description SQL field where it can be amended.

Company Description SQL: You can create and maintain your own Description SQL related to
this Activity Description record.  An SQL here will take priority over the System Description SQL.  
You may wish to consider copying the System Description SQL and paste it into this field where it
can be amended.

Buttons

Close: This will close the OC Activities screen. If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new OC Activity record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted OC Activity record.

7.6.13.3 OC Preview

The Operations Centre 'Preview' panel has three tabs (Inquiry, Report, About).  This OC Preview
screen is where you define which Inquiry and/or Report to display against a selected Activity record

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Activity Type: From the drop-down list select the Activity Type.  This list shows all the Activities
currently held in the OC Activities screen

Inquiry Name: From the drop-down list select the Ostendo Inquiry that you wish to display against
this Activity.  Inquiries are maintained via File>Reporting Configuration>Report and View
Developer

Report Name: From the drop-down list select the Ostendo Report that you wish to display against
this Activity.  Reports are maintained via File>Reporting Configuration>Report and View Developer

Buttons

Close: This will close the OC Preview screen. If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new OC Preview record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
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pressed will be lost.

Delete: This removes the current highlighted OC Preview record.

7.6.13.4 OC Relations

The Operations Centre screen has the option to view a 'Relationship' Mode.   This displays all
activities that are 'related' to the Activity Type'   This screen enables you to define which related
activities are to be displayed

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Activity Type: From the drop-down list select the Activity Type.  This list shows all the Activities
currently held in the OC Activities screen

Related Type: From the drop-down list select the Related Activity Type.  This list shows all the
Activities currently held in the OC Activities screen

System SQL: This is the base System SQL that will be used if a Company SQL (see field below)
does not exist.   This SQL cannot be amended BUT you have the option to copy this SQL from the
drop-down panel and paste this into the Company SQL field where it can be amended.

Company SQL: You can create and maintain your own SQL related to this Relationship record.
An SQL here will take priority over the above System SQL.   You may wish to consider copying the
System SQL and paste it into this field where it can be amended.

Buttons

Close: This will close the OC Relations screen. If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new OC Relations record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted OC Relations record.

7.6.13.5 OC Search

The Operations Centre screen has the option to view a 'Search' Mode.  That 'Search' checks for
descriptive, note, reference, order number, and code fields for an entered sequence of characters
anywhere in those fields. This is useful for finding correspondence that might contain say a Project
name (searches email bodies, history notes, linked document notes etc...).  This screen enables
you to define which related activities are to be included in the Search

Data Display Options
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Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Activity Type: From the drop-down list select the Activity Type.  This list shows all the Activities
currently held in the OC Activities screen

System Search SQL: This is the base System Search SQL that will be used if a Company Search
SQL (see field below) does not exist.   This SQL cannot be amended BUT you have the option to
copy this SQL from the drop-down panel and paste this into the Company Search SQL field where
it can be amended.

System Condition SQL: This is the base system Search Condition SQL that will be used if a
Company Level Search Condition SQL (see field below) does not exist.   This SQL cannot be
amended BUT you have the option to copy this SQL from the drop-down panel and paste this into
the Company Search Condition SQL field where it can be amended.

Company Search SQL: You can create and maintain your own Search SQL related to this Activity
Type record.  An SQL here will take priority over the above System Search SQL.   You may wish to
consider copying the System Search SQL and paste it into this field where it can be amended.

Company Search Condition SQL: You can create and maintain your own Search Condition SQL
related to this Activity record.  An SQL here will take priority over the System Search Condition
SQL.   You may wish to consider copying the System Search Condition SQL and paste it into this
field where it can be amended.

Buttons

Close: This will close the OC Search screen. If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new OC Search record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted OC Search record.

7.6.13.6 OC KPIs

The Operations Centre screen has an Activity Panel called KPI.   That screen shows KPI
information for the selected 'Type'.   In that screen are two panels.  

· The left-hand panel displays Key Performance Indicators (KPI’s) that relate to the Type
and name selected in the Conditions Panel of the Operations Centre.   The Values
displayed in that screen compare the 'Key Value' derived from a Value SQL to a
'Comparative Value' derived from a Comparative SQL

· The right-hand panel displays information that makes up the KPI values.  

This 'OC KPIs' screen enables you to define the content of both the KPI panel and the drill-down
panel
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Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Company Type: From the drop-down list select the Company Type.  This list shows all the
Company Activities currently held in the OC Activities screen
 
KPI Name: Open format entry where you can describe what the KPI is for.  This name will appear
in the Operations Centre's KPI Screen

System Value SQL: This is the base System Value SQL that will be used if a Company Value
SQL (see field below) does not exist.   This SQL cannot be amended BUT you have the option to
copy this SQL from the drop-down panel and paste this into the Company Value SQL field where it
can be amended.

System Comparative SQL: This is the base System Comparative SQL that will be used if a
Company Comparative SQL (see field below) does not exist.   This SQL cannot be amended BUT
you have the option to copy this SQL from the drop-down panel and paste this into the Company
Comparative SQL field where it can be amended.

System Drilldown SQL: This is the base System Drilldown SQL that will be used if a Company
Drilldown SQL (see field below) does not exist.   This SQL cannot be amended BUT you have the
option to copy this SQL from the drop-down panel and paste this into the Company Drilldown SQL
field where it can be amended.

Company Value SQL: You can create and maintain your own Value SQL related to this Activity
Type record.  An SQL here will take priority over the above System Value SQL.   You may wish to
consider copying the System Value SQL and paste it into this field where it can be amended.

Company Comparative SQL: You can create and maintain your own Company Comparative SQL
related to this Activity record.  An SQL here will take priority over the System Comparative SQL.  
You may wish to consider copying the System Comparative SQL and paste it into this field where it
can be amended.

Company Drilldown SQL: You can create and maintain your own Company Drilldown SQL
related to this Activity record.  An SQL here will take priority over the System Drilldown SQL.   You
may wish to consider copying the System Drilldown SQL and paste it into this field where it can be
amended.

Value Fields Format: From the drop-down list select the format of the displayed Values.  The
options are:

· Currency: The number will be preceded by the currency symbol used by your company
· Quantity: No currency symbol will be displayed

Sequence: Defines the sequence - within the Company Type - that the KPI will be displayed.
During creation of the record this is incremented by 10 within the Company Type.  However you
can amend the number if required.

Buttons
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Close: This will close the OC KPIs screen. If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new OC KPIs record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted OC KPIs record.

7.6.13.7 OC Statistics

The Operations Centre screen has an Activity Panel called Statistics.   That screen shows
Statistical Information for the selected 'Type'.   In that screen are two panels.  

· The left-hand panel displays a Description of the Statistic along with the current value
· The right-hand panel displays drilldown information that makes up that Statistic.  

This 'OC Statistics' screen enables you to define the content of both the Statistic panel and the
drill-down panel

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

Company Type: From the drop-down list select the Company Activity Type.  This list shows all the
Activities currently held in the OC Activities screen
 
Statistics Name: Open format entry where you can describe what the Statistic is measuring.  This
name will appear in the Operations Centre's Statistics Screen

System Statistics SQL: This is the base System Statistics SQL that will be used if a Company
Statistics SQL (see field below) does not exist.   This SQL cannot be amended BUT you have the
option to copy this SQL from the drop-down panel and paste this into the Company Statistics SQL
field where it can be amended.

System Drilldown SQL: This is the base System Drilldown SQL that will be used if a Company
Drilldown SQL (see field below) does not exist.   This SQL cannot be amended BUT you have the
option to copy this SQL from the drop-down panel and paste this into the Company Drilldown SQL
field where it can be amended.

Company Statistics SQL: You can create and maintain your own Statistics SQL related to this
Activity Type record.  An SQL here will take priority over the above System Statistics SQL.   You
may wish to consider copying the System Statistics SQL and paste it into this field where it can be
amended.

Company Drilldown SQL: You can create and maintain your own Company Drilldown SQL
related to this Activity record.  An SQL here will take priority over the System Drilldown SQL.   You
may wish to consider copying the System Drilldown SQL and paste it into this field where it can be
amended.
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Value Fields Format: From the drop-down list select the format of the displayed Values.  The
options are:

· Date: The display will be output in Date format as defined in your Systems Settings
· Currency: The number will be preceded by the currency symbol used by your company
· Value: No currency symbol will be displayed

Sequence: Defines the sequence - within the Company Type - that the Statistic will be displayed.
During creation of the record this is incremented by 10 within the Company Type.  However you
can amend the number if required.

Buttons

Close: This will close the OC Statistics screen. If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new OC Statistics record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted OC Statistics record.

7.6.13.8 OC KPI Indicators

The Operations Centre screen has an Activity Panel called KPI.   That screen shows KPI
information for the selected 'Type'.   That screen displays Key Performance Indicators (KPI’s) that
relate to the Type and name selected in the Conditions Panel of the Operations Centre.   The
Values displayed in that screen compare the 'Key Value' to a 'Comparative Value'.  A third field
(Percentage) is a system calculated percentage from (Key Value) divided by (Comparative Value). 
This field can be colour coded to provide instant recognition of values outside an expected
tolerance.
This screen allows you to nominate a percentage value against which a colour Code is attached. 
That colour will display against the KPI record in the Operations Centre if the percentage has been
reached.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Entry and Display fields

KPI Name: From the drop-down list select the KPI. 
 
Percentage: Enter the percentage at which the colour code will be displayed.  The actual
percentage is calculated from ((Key Value) / (Comparative Value) * 100) in the KPI panel of the
Operations Centre screen

Indicator Colour: From the drop-down list select the colour
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Buttons

Close: This will close the KPI Indicators screen. If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new KPI Indicators record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted KPI Indicators record.

7.6.14 OC Rules

This screen allows you to maintain the Operations Centre Rules. Operations Centre Rules define
what rules, within the Operations Centre area, you wish to apply. The following rule settings are
available

Entry and Display fields

Activity Days Back: In the Operations Centre Conditions Toolbar a 'Date From' field defines how
far back into history the Operations Panel should look.  By default that screen uses the System
Date less the number of days entered here.  Therefore you should enter the number of days back
that Ostendo should look when gathering Operational Data.

Invoiced History Days Back: Enter the number of days back when gathering Invoice History data

Info SQL: In the Operations Centre Activity Panel there is a tab called 'Info'.  Clicking on this tab
will bring up information relating to the selected 'Type'.  For example:- If you select a Customer
then you may wish to display the Customer's address and contact details.  
There are seven SQL's covering the various Types:

· Customer
· Supplier
· Customer Asset
· Manufacturing 
· Sales 
· Jobs 
· Purchasing

The individual SQL (Memo) fields have been pre-populated with basic information.  You have the
option to click on the drop-down and maintain the SQL

About Filename: By default the 'Preview' panel on the Operations Centre screen displays the
Ostendo Operations Centre graphic.  You may create your own company graphic using the
Ostendo Graphical Editor.   In this field you should then point to that Graphics file.     Upon opening
the Operations Centre that graphic will be displayed.

Include signature on reply: Tick this box if the user's email signature is to be included when
replying to correspondence in the Operations Centre.

Buttons

Close: This will close the screen. 
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Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

7.6.15 CRM Rules

Service Level Tracking Activated: If this is ‘checked’ then the progression of each call can be
recorded through the Call’s Service Response function.

Default Service Agreement: From the drop-down list select the Default Service Agreement that
will be used when generating a Call.   You should note that if a Customer has a Service Support
Agreement identified against the Customer record then that Service Agreement will be used in
preference to this default.  Service Agreements are maintained via CRM>Settings>Service
Agreements

Default Severity Level: From the drop-down list select the Service Level within the above
Agreement that will be used as the default when generating a Call.   You should note that if a
Customer has a Service Support Agreement/Service Level identified against the Customer record
then that Service Agreement Level will be used in preference to this default.  Service Agreement
Severity Levels are maintained via CRM>Settings>Service Agreement Levels

Default Job Type for Service Jobs: From the drop-down list select the Default Service Job Type
that will be used when creating a Service-related Job from CRM.  This Job Will be used when
generating a Job from CRM where the call relates to a Customer Asset. 

Default Style:   Select one of the Call Styles as the default style.

Default Stage:   Select one of the stages as the default stage.

Auto Email Ticket Action Changes:  Tick this box if you wish to automatically email any Ticket
Action changes.          

Auto Email Ticket Action Deletions:  Tick this box if you wish to automatically email any Ticket
Action deletions.          

Include Past Due Action Tag Line in Emails:  Tick this box if you wish to include a tag line when
auto emailing Ticket Action items which are past due.      

Reminder Leadtime:  Specify the leadtime for email reminders to be sent out.                     

Alert or Email for Reminders: Select from one of the following:
· Alert Only
· Email Only
· Both Alert and Email.                         

Include Reply Response Help in Emails:  Tick this box if you wish to include the Response Help
text in your Reply.                                                                                                                                 
                                                                                                                         
Local Currency Symbol:  (Optional) Enter the local currency symbol.                                             
                                                                                                                      
Email Font Name: (Optional)  Enter the name of the font to use when sending email.                    
                                                                                                            
Email Font Size: (Optional)  Enter the font size to be used.                                                              
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Email Action as Text: Tick this box if you wish to email the Action as text (default is HTML).
                                                                                                                                                             
   
Prospect Customer Record:  This setting allows you to create Prospect Customer records from
the Call Centre screen  either automatically or manually or not at all. There are three possible
options:

· No Creation: This basically means that, if a Prospect is entered against a ticket, no action
will be taken (the prospect will remain only as a contact).

· Create Immediately: This, if selected, will automatically convert the Prospect entered within
the Call Centre to a Prospect Customer, thereby allowing Quotations to be created.

· Create on Demand: This, if selected, will allow the user to manually convert a Prospect in
the Call Centre to a Prospect Customer, via a button that automatically appears.

Customer for Internal Employee Emails:  You can create a dummy "Customer" record which
can be used to facilitate internal employee emails. Select the "dummy customer" record here. 

This is used when all emails are forwarded to a 'To-Be-Assigned" email address in Email Services
and a Receive Email function is setup in Queue Schedule. When To-Be-Assigned emails are
processed, Ostendo checks both the Sender and Receiver and if they  both are internal employee
email addresses, then Ostendo assigns such emails to this "dummy Customer". If no such dummy
Customer is set up, then such internal emails will remain unassigned. 

Use Assignment Board for Ticket Actions:  Tick this box if you wish to use the Assignment
Board to assign ticket actions.

Default Call Method:  From the drop-down list select the default Call Method when creating a new
Call Ticket.

Buttons

Close: This will close the screen. 

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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8 Mobility

8.1 Introduction

Ostendo Freeway is the set of functions and mobile apps designed to provide mobility solutions to
Ostendo users.

The Freeway.apk mobile app is designed to run on Android/IOS/Windows tablets and phones. 

Ostendo Freeway mobile app will synchronize with the Ostendo database via the Ostendo API.

Ostendo Freeway Mobility solution is designed to be easy to setup and deploy. It consists of three
main components:

1. The Ostendo API Configuration and Security Setup
2. The Ostendo Mobility Setup and Definition Screens in Ostendo (Mobility Menu)
3. The Freeway.apk Mobile App on the mobile device

The Ostendo Freeway Setup and Definition process defines what data is to be displayed and/or
collected, what is mandatory and what is not, and who can use what mobility sheets. This can be
done without programming skills by making use of a combination of Check Lists, Images,
Signatures, Sketches, Notes, etc. 

Freeway.apk has all the necessary features to collect data for a wide variety of functions including:
- Service Jobs/Quotes/Direct Invoices 
- Sales Orders/Quotes/Direct Invoices
- Purchase Orders/Receipts
- Update Assembly Orders
- Update Delivery Orders
- Customised Data Collection and business process implementations – for example :

Purchase Requisition approvals, New Customer Credit review, Quality Assurance, etc.

Check Lists, images, signatures, sketches, notes, materials, times, etc., are the basic building
blocks of the Freeway Mobility app or mobility sheet. You can specify a combination of such
objects to perform hazard checks, capture input data, conduct surveys, etc.

The primary objective of Ostendo Freeway is to enable Ostendo users to quickly set up and
deploy customised mobile solutions that will enhance business efficiency.

This Mobility Menu facilitates the following:

1.  Defines Checklists, and Style Templates

2.  Specify Employee Mobility Settings

3.  Set up the Style Template Matrix

4.  Provide access to the data collected via the mobile app.

8.2 Employee Mobility Settings

Employee Mobility Settings list the employees who are authorised to work with Freeway Mobility
App. 

The detail screen identifies all the mobility sheets that the employee can have access to, the Lists
to use for materials, labour, his unique ID prefix, etc. 
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List Tab

Display fields

Employee: The name of the employee authorised to use one or more Mobile apps,

Sitename: This is the Company sitename.

Customer Selection Available: This check box indicates whether the employee can work with
Customers.

Job Selection Available: This check box indicates whether the employee can work with Jobs.

Supplier Selection Available: This check box indicates whether the employee can work with
Suppliers.

Assembly Selection Available: This check box indicates whether the employee can work with
Assembly Orders.

Delivery Selection Available: This check box indicates whether the employee can work with
Delivery Orders.

Purchase Selection Available: This check box indicates whether the employee can work with
Purchase Receipting.

Inventory Count Selection Available: This check box indicates whether the employee can work
with Inventory Counts.

Transfer Selection Available: This check box indicates whether the employee can perform stock
transfers.

Internal Selection Available: This check box indicates whether the employee can work with
Internal processes.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons
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Close: This will close thise screen.  If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Employee Mobility Settings record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Employee Mobility Settings record.

Detail Tab

The top portion of the Detail Tab have the following entries:

Entry and Display fields

Employee: Name selected from list of employees. (Maximum 30 char)

Password: Specify the employee's mobility password here. (Maximum 50 char)

Employee Style: This is a display-only field. Possible values are:

- Internal : This is one of your own
employees.
 - Mobility B2B : This "employee" is used for
Customer Mobility setting.

- Mobility SubContractor : This is a SubContractor
employee.

FastCode Button: Click on this button to generate a FastCode for the employee. Fast Codes are
used to simplify the process of loading the API Key and the Freeway Mobility Licence key onto
the mobile device when installing the Freeway app.

You will first be prompted to select the appropriate API Security record (if multiple records exists).
When the FastCode is generated, an email is also opened for you to send the code to the
employee.

Department: Display-only field which shows the employee department as per the employee
record.

Site Name: Select a site name from the list. (Maximum 50 char)

Optional Warehouse: The default warehouse to use for Materials used. (If left blank,then the
default warehouse rules are used.) (Maximum 20 char)

Optional Location: The default location for materials. (If left blank,then the default location rules
are used.) (Maximum 20 char)

Sheet Prefix:  Enter the Prefix for this employee. This prefix will be used to create a unique
datasheet ID for this employee. No duplicates allowed. (Maximum 4 char)

Device Print Option: Select either Email / View / Email or View. (Used to determine how the
mobility print outputs are distributed.)
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Default Internal Email: This specifies the default email address when Output is sent from mobile
app to internal. If left blank, the email will go to the Employee's email address as per the employee
record. (Maximum 100 char)

Exclude this Employee from Forwarding Sheet on to others: Ticking this box will prevent this
employee from forwarding datasheets to others.

Job Selection Available: Ticking this box allows this employee to work with jobs.
Customer Selection Available: Ticking this box allows this employee to work with Customers.
Supplier Selection Available: Ticking this box allows this employee to work with Suppliers.
Assembly Selection Available: Ticking this box allows this employee to work with Assembly
Orders.
Delivery Selection Available: Ticking this box allows this employee to work with Sales Deliveries.
Purchase Selection Available: Ticking this box allows this employee to work with Purchase
Orders Receipting.
Inventory Count Selection Available: Ticking this box allows this employee to work with
Inventory Counts.
Transfer Selection Available: Ticking this box allows this employee to do inventory transfers.
Internal Selection Available: Ticking this box allows this employee to work with Internal work
processes.

Inherit Mobility Settings from another Employee: Select the employee to inherit mobility
settings from. After inheriting the settings from another employee (and Saved), you can delete the
name and the inherited settings will still remain - effectively copying the settings from another
employee. You can then make changes if required. 

Level of Information Displayed: Select either "Standard" or "Minimum".The default is
"Standard". 
This is to provide the capability to supply varying amounts of information
(Job/Assemblies/Customer/Supplier/Deliveries) to different types of users.

With the introduction of Customer and Sub-Contractor usage of Freeway, it may be necessary to
limit the amount of information that will be exposed to these third parties.
Use “Minimum” if you wish to limit such information to a bare minimum (basic contact information)
to the “employee” concerned. 
Additional fields can be added to this “bare minimum” option through the use of Mobility Settings
like “Job Info fields, Customer Info Fields, etc.

The Lower portion of the Detail Tab have the following sub-tabs:

Device sub-Tab

Entry and Display fields

Number of Synchronised Sheets Retained: Specify the number of synchronised sheets to be
kept on the device at any one time. This is for the convenience of the mobile worker who may wish
to review some of the recent jobs/tasks he has done. Retained sheets are for review only - no
updates.

Auto Synchronise Completed Data Sheets: Ticking this box will enable sheets to be
synchronised with the host immediately upon completion (live update). If this box is NOT ticked,
then synchronization is done only when the mobile worker chooses to synchronise.
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Auto set On and Off Site for Sheet Creation and Completion when Tracked: If the Style
Template has Tracking, ticking this option will automatically capture the GPS coordinates  and the
status will be set to On Site when the data sheet is first created. When the sheet is completed, it
will set the status to OffSite.

Auto set On and Off Site for Start/Stop Times: If Times data is captured on the datasheet
template , then ticking this option will automatically capture the GPS coordinates and the status will
be set to On Site when Start Time is entered on the datasheet. When the Stop Time is entered, it
will set the status to OffSite, Note that "Time Tracking is Active if Auto on and Off Site for
Start/Stop Times is Set" on the Style Template Detail tab must also be ticked.
This setting is mutually exclusive to the previous setting above.)

Set Tracking Codes for Creation and Completion of Sheets: Ticking this box means Tracking
Codes will be automatically updated when the datasheet is first created and when the sheet is
completed. Default Tracking Codes can be set for Jobs, Assembly Steps, and Deliveries in the
Freeway app. These Tracking Codes must first be defined in Jobs Settings, Assembly Settings,
and Sales Settings. 

Notification Method (if any) used when forwarding to others: Text Message or Email or None.
When data sheets are designed to be passed from worker to worker, it may be desirable to send a
notification message to the one who is receiving the data sheet next - so that he/she can start
reviewing it soonest possible.

The number of Days forward to display To Do activities: Enter number of days here. To Do
tasks are generated by Call Ticket Actions, Job/Sales Quotes Follow-Up Actions, Activity Calendar
Events (appointments), and History Notes Follow-Up Actions.

Auto Sync the To Do when selected: Ticking this box will automatically refresh the To Do
activities when the To Do button is pressed. Otherwise it will only be refreshed whenever
synchronization is carried out.

Product Selection Style for Warehousing: Options are Manual Selection or Scan Barcode.
Manual Selection means items are selected manually from delivery list when picking the items.
Scan Barcode means items are picked by scanning barcodes.

StationID for POS Orders : Select the POS Station ID to be associated with this user (mobile
device) . With the appropriate Style Template, an On-Hold POS Order will be created using this
Station ID. At the checkout cashier's station, the POS Order can be reviewed and converted into
an invoice to receive payment.
You could create an Employee Mobility Settings record for each tablet you intend to use for POS. 

Standalone Auto Update Days : Set the number of days to automatically refresh the Standalone
Solution on the mobile device. 

Fixed Internal Style Name for Scanning : Select the Style Template to initiate when an
Employee barcode is scanned using the Scan On button on the Front Screen.

Default Screen after Scan : - Select "Front Screen" if you want to return to the front
screen after initiating the datasheet using the Scan On button.

- Select "Sheet Summary" if you want to display the
initiated Datasheet after using the Scan On button to scan a barcode.

Find Pack Name :  Select the Find Pack Name for this employee.

Guide Pack Name : Select the Guide Pack Name for this employee.
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Feature Pack : Select the Feature Pack Name for this employee.

Inquiry Pack : Select the Inquiry Pack Name for this employee.

Product Selection Style for Warehousing : Options: Manual Selection or Scan Barcode .
Manual Selection means items are selected manually (no barcode scanning).
Scan Barcode means items are selected primarily by scanning. However, manual input is still
allowed.

Station ID for POS Orders : Select the Station ID for POS Orders entered by this employee.

Materials sub-Tab

Entry and Display fields

Restricted Material List Code: Optional - Select the Code for the Material List to be used by this
employee. (Maximum 50 char). If this is left blank, then the following two conditions can be used to
restrict what Items / Descriptors the employee can select via Freeway App.

Items Restriction Condition: (Applicable only if Restricted Material List Code is blank.) Specify
the condition that will restrict the employee to using certain Items. For example: itemcategory <>
'INTERNAL' . (Maximum 1000 char)

Descriptors Restriction Condition: (Applicable only if Restricted Material List Code is blank.)
Specify the condition that will restrict the employee to using certain Descriptors. For example:
descriptorcategory <> '111' .  (Maximum 1000 char)

Material Pre-Fill List: Select the List that this employee can use. This list must be a subset of the
Material List selected above. (Maximum 50 char)

Pre-Fill list items will appear automatically in the Freeway App and the
user just needs to fill in the quantities used.

Hierarchical Name: Enter the Name of the Hierarchical Structure that is used by this employee
to view materials. 

Hierarchical Structures are defined in the General Menu.
In the Related Menu of Items, there is a function called Item Mobility and Web which enable you to
specify additional information about the item (Short Description, Long Description, Specifications,
Hierarchical Names, and Features). Same goes for Descriptors..

Material Lookup Structure: Select either Flat or Hierarchical. Flat means materials are
presented as a list. Hierarchical means materials are presented according to predefined
Hierarchical Structures. If you select Hierarchical, you must have also specified a Hierarchical
Name in the previous setting.

Product Inquiry Available: Tick this box if this employee is allowed to do Product Inquiries. If this
is not ticked, then the employee will not be able to do product inquiries even if his/her assigned
Inquiry Pack contains product inquiries.

Style of Product Inquiry Lookup: Select an option from the drop-down list - Standard or
Graphical .
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Stock Inquiry Level: Select an option to display the stock levels this employee is allowed to view.
Options are:

All Site Totals Inventory Totals for all sites.
Mobility Site Totals Inventory Totals for the Site

assigned to this mobility employee.
All Site|Warehouse Totals Inventory Totals for all Sites and

broken down by Warehouse.
Mobility Site|Warehouse Totals Inventory Totals for this

employee's site and the totals for warehouses within that site.
All Site Details Inventory Details for all

sites.
Mobility Site|Details Inventory Details for Site

assigned to this mobility employee.

Note that this selection together with the Restricted Warehouses (specified in Restricted
Warehouses tab) determines what stock levels this employee can view.
For example if this selection is Mobility Site Totals, and only two warehouses listed in Restricted
Warehouses for this employee falls within the Mobility Site assigned to this employee, then this
employee will only be able to view the Inventory Totals for those two warehouses combined.

Default Picking and Receipting Location Logic: Options are : 
Use Product Details - Use Product's

default Issue/Receipting Warehouse and Location. If Restricted Warehouses are specified for the
employee, then only products from those locations will be shown.

Fixed From Employee - use the default
warehouse and location specified in Employee mobility Settings.

User Specified - The user will specify
the location for each item picked. The Location Barcode Style needs to be specified in Mobility
Barcode Rules. User need to scan or enter the Location Barcode before picking the items.

Drill Down Product Inquiry Name :  When picking items in a Delivery Order with Freeway, you
can drill-down on the item to see product details like Product Image and quantities available. You
can also specify your own inquiry to display other information pertaining to the item. This Inquiry
name must be defined in an Inquiry Pack Content record.

Default the Picking Qty : Tick this box if you wish to default the Pick Qty. This will save the user
from having to enter picked quantity for every item picked. The user can overwrite if required. 

Default the Receipting Qty : Tick this box if you wish to default the Receipt Qty. This will save the
user from having to enter receipted quantity for every item received. The user can overwrite if
required. 

Product Inquiry Quantity Display Style : Possible options are : Actual Quantities , Only
Positive Quantities , Availability Status.

For "Only Positive Quantities" style, all negative quantities will be displayed as zero (0).
For "Availability Status" style, the quantity displayed is either "In Stock" or "Out of Stock".

This is to cater for situations where you do not wish to show the actual stock quantities to the
Freeway Mobility user.

Next Button Caption : Specify a caption for the "Next" Button here (if desired).
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Finish Button Caption : Specify a caption for the "Finish" button here (if desired).

Swap Scan button for Lookup : Tick this box to change the Scan button to a materials Lookup
button. 

Lookup Button caption : If Scan button is changed to a Lookup button, you can specify a caption
for the "Lookup" button (if desired).

Time Entry sub-Tab

Entry and Display fields

Restricted Labour List Code: Optional - Select the Code for the Labour List that this employee
can use. (Maximum 50 char).  If this is left blank, then the following condition can be used to
restrict what Labour Codes the employee can select via Freeway App.

Labour Restriction Condition:  (Applicable only if Restricted Labour List Code is blank.) Specify
the condition that will restrict the employee to using certain Labour Codes (Maximum 1000 char)

Time Entry Mode: Select either Time of Day / Start Stop / Fixed Times / Hours 

Fixed Time Template: Select the Fixed Time Template that this employee can use. (Maximum 20
char)

Mobility Team for Time Entry: Select the Mobility Team that this employee can enter times for
(The employee must be a member of the Mobility Team - typically used where the employee is the
Supervisor or Team Leader) . (Maximum 20 char)

Auto Insert Time Entry on Sheet Creation: Ticking this inserts a time line automatically when the
Data Sheet is created.

Default Labour Code for Time Entry: This specifies the Labour Code for the Time Line that was
inserted automatically (see Auto Insert Time Entry on Sheet Creation).(Maximum 50 char)

How Times are Posted in Ostendo: Options are: - Job Direct / Create New Timesheet /  Add
To Existing Timesheet / Add to Daily Timesheet / Add to Weekly Timesheet 

Weekly Timesheet Start Day: If "Add to Weekly Timesheet" is selected above then enter the start
day of the week for this employee.

Customers sub-Tab

Entry and Display fields

Customer Restriction Condition: Specify the condition that will restrict the employee to working
with certain Customers only (Maximum 1000 char)

Customer Asset Selection: Ticking this will allow the employee to access Customer Assets via
the Freeway App.

Customer Asset Restriction Condition: Specify the condition that will restrict the employee to
working with certain Customer Assets only. (Maximum 1000 char)
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Number of Latest Customer History Notes: This specifies the number of history notes to be
displayed to the employee when a Customer is selected.

Number of Latest Customer Asset History Notes: This specifies the number of history notes to
be displayed to the employee when a Customer Asset is selected.

Sales Type for New Sale: Select the default Sales Type when a new sale is generated.
(Maximum 20 char)

Hide Pricing for Materials: Tick this box if pricing is to be hidden from user.

Include Purchase Reference in Sales Fields: Tick this box if user can enter PurchaseReference
into Sales Order when SALESFIELDS is included in the Style Template.

Include Purchase Reference in Invoice Fields: Tick this box if user can enter
PurchaseReference into Invoice when INVOICEFIELDS is included in the Style Template.

Include Project in Invoice Fields: Tick this box if user can enter Project into Invoice when
INVOICEFIELDS is included in the Style Template.

Include Purchase Reference in Job Fields: Tick this box if user can enter PurchaseReference
into Job Order when JOBFIELDS is included in the Style Template.

Include Job Category in Job Fields: Tick this box if user can enter JobCategory into Job Order
when JOBFIELDS is included in the Style Template.

Include Mobility Team in Job Fields: Tick this box if user can enter MobilityTeam into Job Order
when JOBFIELDS is included in the Style Template.

Include Job Required Date Info in Job Fields:Tick this box if user can enter Job Required Date
Info into Job Order when JOBFIELDS is included in the Style Template.

Allow Payment Entry: Tick this box if Mobility user is allowed to collect payment from Customer.
This will enable the user to key in some basic Payment Data.

PlaceHolder Customer for Creating New Customers: Select the temporary customer name
used when creating new customers via the Freeway app.

The following information can be preset in the Placeholder Customer so that when the new
Customer is created, it will automatically copy these same properties:

CUSTOMERTYPE, CUSTOMERSTYLE, PRINTSTATEMENT, PRICELEVEL, CREDITTERM,
CREDITLIMITAPPLIES ,  CREDITLIMIT , TAXGROUP, SALESPERSON ,  SHIPPINGMETHOD

The PlaceHolder customer must not be a real Customer.

Customer Details Style: Select one of the following Options: 
Create or Update - This enables the mobility user to create new

customer record or update existing customer record.
Information Only - This means mobility user cannot create or

update customer records. Someone else in the office will need to do that with the information
collected.

Allow Assignment Booking for New Jobs: Tick this box to indicate that mobility user can also
assign any new jobs he created.

Include Service Employee in Job Fields: Tick this box if user can enter Service Employee into
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Job Order when JOBFIELDS is included in the Style Template.

Style of Customer when creating from Internal Sheet: Select either PROSPECT or
CUSTOMER.

Style of Customer when creating for a Quote:  Select either PROSPECT or CUSTOMER.

Direct Invoice Numbering Style: Select one of the following Options: 
Automatic - the number will be generated by Ostendo
SheetID - the SheetID will be the Invoice Number
Entered - the Invoice Number is manually entered. 

Style of Payment created in Ostendo from Mobile Payment: Select one of the following
Options:  

Create Real Payment or Deposit - An actual
payment will be created in Ostendo together with financial records. 

Record as External Payment or Deposit - External
Payment with no financial records created in Ostendo.

Information Only - No payment
created.

Fixed Customer Style Name for Scanning : Select the Style Template to initiate when a
Customer barcode is scanned using the Scan On button on the Front Screen.

Fixed Asset Style Name for Scanning : Select the Style Template to initiate when a Customer
Asset barcode is scanned using the Scan On button on the Front Screen.

Jobs sub-Tab

Entry and Display fields

Job Selection Range: Either All Open Jobs or Only Assigned Jobs or Mobility Team. (Mobility
Team includes Mobility Employee as well). 

Job Restriction Condition: Specify the condition that will restrict the employee to working with
certain Jobs only. This limits the jobs to be displayed to the employee for selection and only
applies if Job Range is “All Open Jobs”. (Maximum 1000 char)

You may specify any condition here. For example, assume you are selecting records from the
JOBHEADER and JOBTASKS tables - (Select * from JOBHEADER,JOBTASKS where .........)
The conditions you specify is what comes after " ....where JOBHEADER.ORDERNUMBER =
JOBTASKS.ORDERNUMBER and "       and could be

JOBHEADER.JOBTYPE in ( 'Service', 'Standard') 
JOBHEADER.JOBCATEGORY = '                     '
JOBHEADER.SALESPERSON = '                ' and JOBHEADER.JOBTYPE = '                     ' 
(JOBHEADER.PROJECTNAME = '                ' or JOBHEADER.PROJECTNAME = '
                     ') and JOBHEADER.SALESPERSON = '                        ' 

     JOBTASKS.TASKNAME = '                  '

Number of Latest Job History Notes: This specifies the number of history notes to be displayed
to the employee when a Job is selected.
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Job Type for New Job Order: Select the default Job Type when a new Job is generated.
(Maximum 20 char)

Job Type for New Job with Customer Asset: Select the default Job Type when a new Job with
Customer Asset is generated. (Maximum 20 char)

Include Non-Finished Assignments A Number of Days Back: The number entered here will
allow the employee to view un-finished Assignments up to that number of days back.

How Actual Lines are inserted: Select Create New Line or Add to Existing Line

Hide Pricing for Materials: Tick this box if pricing is to be hidden from user.

Auto Sync the Job List when selected: Tick this box if the Job List is refreshed each time the
Job Lookup is selected.

Activate Mobility Pooling: Tick this box if employee can participate in Team Pooling. If this box is
un-ticked, then any job assigned to a Pooling Team will be hidden from the user even if he is a
member of the same Mobility Team. .

Job Horizon Days: Enter the number of days. This will display jobs or assignments whose
required start date falls within this horizon. For example, if Job Horizon is set at 2 days, then the
Mobility user will only see jobs/assignments which start in the next two days. This is to avoid
displaying unnecessarily large number of jobs/assignments for selection.

Set Job/Assignment to InProgress from OnSite Tracking: Tick this box if you want to
automatically change the Job Status to "In Progress" when OnSite Tracking is triggered. 

Shift Assignment to reflect actual Start from OnSite Tracking: Tick this box if you want to
automatically shift the Assignment to reflect Actual Start time when OnSite Tracking is triggered.

Allow Payment Entry: Tick this box if Mobility user is allowed to collect payment from Customer.
This will enable the user to key in some basic Payment Data.

Disable Job Decline: Tick this box if the Mobility User is not allowed to decline
jobs/assignments.

Planned Job Line PreFill Style: Select one of the following Options: 
No Planned Line PreFill - this means

Planned Lines are not added to the materials list. 
Prefill Planned Line with Zero Quantity - Planned Lines

are automatically added to the Materials List - but with Quantity = 0
Prefill Planned Line with Remaining Quantity - Planned Lines are

automatically added to the Materials List with Quantity = Remaining Qty.

Fixed Job Style Name for Scanning : Select the Style Template to initiate when a Job barcode is
scanned using the Scan On button on the Front Screen.

Include Planned Lines with Zero Remaining Qty : Tick this box if you wish to also show planned
lines where the remaining quantity is zero.

Job Picking Tolerance % : Enter the percentage the user is allowed to pick above the required
amount.
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Suppliers sub-Tab

Entry and Display fields

Supplier Restriction Condition: Specify the condition that will restrict the employee to working
with certain Suppliers only. (Maximum 1000 char)

Number of Latest Supplier History Notes: This specifies the number of history notes to be
displayed to the employee when a Supplier is selected.

Purchase Type for New Purchase: Select the default Purchase Type when a new Purchase is
generated. (Maximum 20 char)

Hide Pricing for Materials: Tick this box if pricing is to be hidden from user.

Include Packing Slip in Receipt Fields: Tick this box if user can enter Packing Slip No. into
Purchase Receipt when RECEIPTFIELDS is included in the Style Template.

Allow Payment Entry: Tick this box if Mobility user is allowed to make payment to Supplier. This
will enable the user to key in some basic Payment Data.

PlaceHolder Supplier for Creating New Suppliers: Select the temporary supplier name used
when creating new suppliers via the Freeway app.

The following information can be preset in the Placeholder Supplier so that when the new
Supplier is created, it will automatically copy these same properties:

SUPPLIERTYPE, CREDITTERM,  TAXGROUP, BUYER ,  SHIPPINGMETHOD

Supplier Details Style: Select one of the following Options:  
Create or Update - This enables the mobility user to create

new supplier record or update existing supplier record.
Information Only - This means mobility user cannot create

or update supplier records. Someone else in the office will need to do that with the information
collected.

Fixed Supplier Style Name for Scanning : Select the Style Template to initiate when a Supplier
barcode is scanned using the Scan On button on the Front Screen.

Include Job Order selection in Purchase Fields : If this box is ticked, then JobOrder number
selection will be available in style templates which utilizes the PURCHASEFIELDS type. The Job
OrderNumbers will only be those available on the device.

Assemblies sub-Tab

Entry and Display fields

Assembly Selection Range: Either All Open Assemblies or Only Assigned Assemblies or Mobility
Team. (Mobility Team includes Mobility Employee as well). 

Assembly Restriction Condition: If Assembly Selection Range is "All Open Assemblies" then
you can specify the condition that will restrict the employee to working with certain Assemblies
only. (Maximum 1000 char)

Number of Latest Assembly History Notes: This specifies the number of history notes to be
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displayed to the employee when an Assembly is selected.

Include Non-Finished Assignments A Number of Days Back: The number entered here will
allow the employee to view un-finished Assignments up to that number of days back.

How Actual Lines are inserted: Select Create New Line or Add to Existing Line

Auto Sync the Assembly List when selected: Tick this box if the Assembly List is refreshed
each time the Assembly Lookup is selected.

Assembly Horizon Days: Enter the number of days. This will display assemblies or assignments
whose required start date falls within this horizon. For example, if Assembly Horizon is set at 2
days, then the Mobility user will only see assemblies/assignments which start in the next two days.
This is to avoid displaying unnecessarily large number of assemblies/assignments for selection..

Set Assembly/Assignment to InProgress from OnSite Tracking: Tick this box if you want to
automatically change the Assembly Status to "In Progress" when OnSite Tracking is triggered.

Shift Assignment to reflect actual Start from OnSite Tracking: Tick this box if you want to
automatically shift the Assignment to reflect Actual Start time when OnSite Tracking is triggered.

Fixed Assembly Style Name for Scanning : Select the Style Template to initiate when an
Assembly Order barcode is scanned using the Scan On button on the Front Screen.

Assembly Picking Tolerance % : Enter the percentage the user is allowed to pick above the
required amount.

Deliveries sub-Tab

Entry and Display fields

Delivery Selection Range: Either All Open Deliveries or Only Assigned Deliveries. 

Delivery Restriction Condition: If Delivery Selection Range is "All Open Deliveries", then you can
specify the condition that will restrict the employee to working with certain Deliveries only.
(Maximum 1000 char)

Include Non-Finished Assignments A Number of Days Back: The number entered here will
allow the employee to view un-finished Assignments up to that number of days back.

Hide Pricing for Materials: Tick this box if pricing is to be hidden from user.

Include Invoiced Deliveries: Tick this box if Invoiced Deliveries are to be included.

Auto Sync the Delivery List when selected: Tick this box if the Delivery List is refreshed each
time the Delivery Lookup is selected.

Delivery Horizon Days: Enter the number of days. This will display deliveries or assignments
whose required start date falls within this horizon. For example, if Delivery Horizon is set at 2 days,
then the Mobility user will only see deliveries/assignments which start in the next two days. This is
to avoid displaying unnecessarily large number of deliveries/assignments for selection..

Shift Assignment to reflect actual Start from OnSite Tracking: Tick this box if you want to
automatically shift the Assignment to reflect Actual Start time when OnSite Tracking is triggered.
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Set Assignment to InProgress from OnSite Tracking: Tick this box to enable user to update the
tracking code to InProgress when arriving OnSite for delivery.

Fixed Delivery Style Name for Scanning : Select the Style Template to initiate when a Delivery
barcode is scanned using the Scan On button on the Front Screen.

Delivery Mode : choose either "Proof of Delivery" or "Delivery Pick".

Selecting Proof of Delivery means the employee can only select deliveries which are ready to be
delivered (e.g. truck driver).
Proof of Delivery mode would include Deliveries where the status is "Shipped" (or "Invoiced" or "
Invoiced not Shipped" if "Include Invoiced Deliveries" is ticked) AND Dropped Off flag is not
ticked.

Selecting Delivery Pick means the employee can only select deliveries which are ready to be
picked.
Delivery Pick mode would include Deliveries where the status is "Planned" or "InPicking" AND (
Picked Status <> 'Complete'  or  Packed Status <> 'Complete' ) .

Restrict Picking and Receipting to Restriction Warehouses : Tick this box if picking and
receipting are to be restricted to certain warehouses as listed in the Restricted Warehouses tab.

Purchases sub-Tab

Entry and Display fields

Purchase Restriction Condition: Specify the condition that will restrict the employee to working
with certain Purchase Orders only. (Maximum 1000 char)

Auto Sync the Purchase List when selected: Tick this box if the Purchase Orders List is
refreshed each time the Purchase Lookup is selected.

Purchase Horizon Days: Enter the number of days. This will display Purchase Orders whose
required date falls within this horizon. For example, if Purchase Horizon is set at 2 days, then the
Mobility user will only see Purchase Orders which are required in the next two days. This is to
avoid displaying unnecessarily large number of Purchase Orders for selection.

Counts sub-Tab

Entry and Display fields

Inventory Count Restriction Condition: Specify the condition that will restrict the employee to
working with certain Inventory Counts only. (Maximum 1000 char)

Auto Sync the Inventory Count List when selected: Tick this box if the Inventory Counts List is
refreshed each time the Inventory Count Lookup is selected.

Display Stock On hand for Count Lines: Tick this box if you wish to display the expected On
Hand quantity in the Count lines.
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Assignment Move Rules sub-Tab

These rules apply to how assignments are affected when an assignment status changes from
"Active" to "InProgress" on the Freeway app.
For example if the original scheduled start of an assignment was 9.00 am. But the mobile user only
get to start working on this assignment at 10.30 am.
This means this current assignment was shifted by 1.5 hours. The following rules define which
assignments are affected.
Note that any assignment which already overlaps the current assignment will not be affected since
they are already overlapping.
Only those assignments which are not overlapping could be affected.
If the shift in the current assignment does not lead to overlapping with the next assignment, then
the next assignment will not be moved. This merely closes the gap between the current
assignment and the next assignment.
 
Entry and Display fields
   
How other Assignments are affected by a Job or Assembly Shift: Select one of the following
Options: 

No Assignment Move - No assignments on the Assignment
Board are moved - not even the current assignment.

Move Current Assignment - Move only the current assignment to its
actual start time. All follow-on assignments are not moved.

Move Assignments to End of Working Week - If the new end time of the current
assignment overlaps the start time of the next assignment, then the next assignment will be shifted
to accommodate the shift in the current assignment. 

Only assignments starting within the
current week will be shifted. Assignments starting the following week will not be affected.  

Move Assignments for a No. of Days - Only assignments which start within the
horizon days are affected. Horizon days are set in the "Assignment Move Horizon in Days" below.  

End of Day Assignment Completion Tolerance (Mins): This specify the number of minutes an
assignment is allowed to go past end of day before it is split into the next day (if Assignment
Spitting is allowed).

Allow Assignment Splitting when moved: Tick if Assignment Splitting is allowed.

Assignment Move Horizon in Days: Enter the number of days for the "Move Assignments for a
No. of Days" option.

Restricted Warehouses sub-Tab

This list the warehouses that this employee is restricted to work with. Add as many as required.

Click on Add button to add a warehouse.

Entry and Display fields

Site : Company site  (display-only field)

Warehouse : Select from drop-down list of available warehouses linked to the employee's
Company Site..
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Picking Classes sub-Tab

This screen allows you to restrict the employee to picking only items belonging to certain classes.
Picking Classes are defined in Inventory Settings.
Picking Classes allow you to group together items with similar characteristics (e.g. Dangerous
goods, Heavy goods, etc...) 

Entry and Display fields

Include or Exclude : Select either Include or Exclude.

Picking Class : Select the Picking Class to include or exclude.

Transfers sub-Tab

This screen allows yu to specify the Selection Style for doing inventory transfers.

Entry and Display fields

Transfer Selection Style : Select either From Mobility Site ,or All Sites, or Restricted
Warehouses.

Buttons and Backgrounds Tab

Background Style : select From Rules (as per Mobility Rules settings), Default (new style) or
Classic (original Freeway background style)

Modifying the Look & Feel of the Main Screen 
 
The next 4 pair of items allow you to load the portrait and landscape background images for the
Freeway app for the three basic device dimensions (for smartphones & tablets).
The background images should be saved as png or jpeg files. 

The Layout Button on the right-hand side of the screen allows you to re-arrange the 8 buttons on
the Main Screen.

Click on the following fields to display the box. Then right-click on the box to load/delete the image.

Portrait Home Image (4:3 - Ipad): The recommended pixel ratio for the portrait image is Height:
2998 by Width: 2267

Landscape Home Image (4:3 - Ipad): The recommended pixel ratio for the Landscape image is
Height: 2174 by Width: 3038

Portrait Home Image (16:9) : The recommended pixel ratio for the portrait image is Height: 1730
by Width: 1080 
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Landscape Home Image (16:9) : The recommended pixel ratio for the landscape image is Height:
920 by Width: 1920

Portrait Home Image (16:10) : The recommended pixel ratio for the portrait image is Height: 2553
by Width: 1650

Landscape Home Image (16:10) : The recommended pixel ratio for the landscape image is
Height: 1499  by Width: 2652

Portrait Home Image (18.5/19.5:9) : The recommended pixel ratio for the portrait image is Height:
   by Width:     

Landscape Home Image (18.5/19.5:9) : The recommended pixel ratio for the landscape image is
Height:       by Width:     

Button Style : select From Rules (as per Mobility Rules settings), or Black (default) or White, or
Classic (original Freeway button style) 

Button Transparency : select From Rules (as per Mobility Rules settings), or No Transparency
to 90 percent in steps of 10% . Default is 40%.

You can customise the Main Menu buttons by loading your preferred images here:

Update Button Image - Landscape  
Solutions Button Image - Landscape
New Button Image - Landscape
Existing Button Image - Landscape
ToDo Button Image - Landscape
Notify Button Image - Landscape
Inquiry Button Image - Landscape
ScanOn Button Image - Landscape
Find Button Image - Landscape 
Guides Button Image - Landscape

Update Button Image - Portrait  
Solutions Button Image - Portrait
New Button Image - Portrait
Existing Button Image - Portrait
ToDo Button Image - Portrait
Notify Button Image - Portrait
Inquiry Button Image - Portrait
ScanOn Button Image - Portrait
Find Button Image - Portrait 
Guides Button Image - Portrait

Layout Button : Clicking on the Layout button allows you to re-arrange the Main Screen buttons.
You can also tick or untick any of the buttons to either display or hide the button on the Main
Screen. A maximum of 8 buttons can be displayed on the Main screen. 

The following button icons are available for selection and re-arrangement. 

1. Update This button re-synchronizes Freeway with Ostendo  
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2. Solutions This button allows you to select the available Freeway solutions. 
3. New This button starts a new datasheet and displays a menu for selecting a
Job / Customer / Supplier / Assembly / Delivery , etc.
4. Existing This button shows existing uncompleted datasheets.
5. To Do This displays a list of To Do tasks for selection. In Ostendo, such tasks
are generated by Call Ticket Actions, Jobs / Quotes Follow-Up Actions / Activity 

Calendar Events (appointments) / History Notes Follow-Up Actions.
6. Notify This lists all the pre-defined Notification Messages that the user can send.
7. Inquiry This lists all the standard Inquiries available for selection.
8. Scan On This allows you to scan a barcode to immediately initiate a datasheet
(short-cut way to launch datasheets).
9. Find   This allows you to look up Catalogues or other information.
10. Guides   This display all the help Guides available to the user.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another Employee Mobility Settings
record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Layout : Click on this to re-arrange the Main Screen buttons.

Fast Code : Click on this to generate a Fast Code and create an email to send the Fast Code to
the employee. (The employee must have an email address defined in the Employee screen).

8.3 Check Lists

One of the basic building blocks of the mobility app. 
Each Check List (CheckName) can have one or more GroupNames associated with it. And each

Check group will have one or more Check items. 

The Check Lists screen has 5 tabs (List-Detail-Groups-Items-Conditional rules). 

The Detail screen shows the Check List name and description.

The Groups screen shows the GroupNames and their “Mandatory_Style” (Optional / All items
mandatory / Any One item).

Each item in each group is then defined in the Items tab. Each item is either a CheckBox / Text /
Number / Date / Integer / Memo / List / Info / Signature / Time / PhotoNote / Group Checkbox. 

Conditional Rules are dynamically applied as the user enters values or responses to the CheckList
items.
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This enables the user to navigate through a set of CheckList items based on responses or data
entered. 

This powerful feature is useful for the creation of practical applications like:

a.  Product Configuration
b.  Problem diagnostics
c.  Quality Testing
d.  Compliance Audits

and so on...

List Tab

Display fields

Name: The name of the Check List,

Description: The description of the Checklist.

Mandatory: This check box indicates whether the Check List is mandatory. This is automatically
set based on whether the Check List contains any mandatory items or groups.

CheckList Notes: any checklist notes are shown here

CheckList Style: shows the Checklist style.

Customer:

Include Customer CheckList :

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Check List record.



286 Ostendo Reference Guide

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Check List record.

Detail Tab

Entry and Display fields

Name: Name of the Check List.

Description: Enter the Check List description here.

List or Form:  Specify whether the Check List is presented as a simple List or as a Form. If
Formis chosen,then each CheckList Item can also have a Form Caption associated with it
(maximum 15 characters).

Include CheckLists in Notes:  Ticking this box will add entries associated with any CheckList
Item to the Notes field in the job. 

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another Check List record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Groups Tab

Entry and Display fields

Groups Seq: The sequence number of the Check List group. By default, it starts with 10 and
increments by 10. 

Group Name: Enter the name of the Group here.

Mandatory Style: Select either Optional (not mandatory) or All (every item is mandatory)  or Any
One (at least one item must be responded to).

For Group CheckBox, Mandatory Style must be Optional.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
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to save it before the screen is closed.

Add: This will bring up a new ‘Group’ line for entry of another Check List Group record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected Group record.

Items Tab

Entry and Display fields

Groups Name: The name of the Check List Group.

Group Seq: The sequence number of the Check List Group

Item Seq: The sequence number of the Check List Item. By default, it starts with 10 and
increments by 10. Check List Items are displayed in Item Sequence order.

Variable Name: (Optional) Enter a Variable Name for this item if it will be used in Conditional
Rules. Variable Names must be unique across ALL Check Lists.

  Variable names must not be the same as Item Seq. 

Description: Enter a description for the item.

Type: Select a type from the drop-down list. Options include: 

       
       AssetList - displays the list of assets belonging to the customer.

Ostendo Freeway can be used to facilitate the servicing of multiple customer assets at a
site.

For a full description of how to do that, please refer to : Freeway Multi Asset Servicing 
       
       Batch Status - allows the selection of a Item Batch Status (Approved / OnHold
/ QC Required / Rejected ) 

       Checkbox         -         a tick box
       Date                 -         allows entry of a date value 
       GPS                 -         allows capture of GPS coordinates
       Group Checkbox - This provides a sub-checklist within a checklist.

When this Group Checkbox is ticked (in the mobile app), it opens up a sub-checklist.
Sub-Checklist can have any item type (except another Group Checkbox).

            You can have multiple (separate) Group Checkboxes within the same Checklist.        
Each Group CheckBox must have its own Group Name. 
All items belonging to a Group CheckBox will have the same Group Name. 
The first item in a Group CheckBox group must be a Group CheckBox type. 
All other items in this group can be of any item type except Group CheckBox.

       ImageList         -         allows you to display a list of images for your selection. 

http://ostendo.info/downloads/ostendo/Freeway_Multi_Asset_Servicing_Explained.pdf
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Once you have “Saved” the ImageList record in Check List – Items, a bottom section will
appear to enable you to add the images that make up this ImageList. Click on the bottom
section and click Add button to add an image to the list.

Sequence : Sequence number of the image. Increments in 10.
Option : Enter an Option Name for this Image.
Option Description :  Enter an Option Description for this image.
Option Image : Click on the field; then right-click to load an image file (jpeg or

png).   
Add as many images as required to make up the ImageList.

When using the Freeway app, selecting an image from a CheckList-ImageList, the Option
Name associated with the selected image will be the value of the Checklist item. 

       Info                 -         use this to provide brief information or instructions for the user
       Integer                 -         allows entry of integer values only
       JobOrder         -         allows you to display a list of Job OrderNumbers which are on the

Freeway device for selection. The selected ordernumber will be the value of the Checklist
item.

            This is useful when you want to associate a datasheet with a particular
Job OrderNumber.

       List                 -         provide a list of values for selection
       Memo                 -         allows entry of multi-line text
       Number         -         allows entry of numeric values with or without decimals
       PhotoNote         -   to take a photo and be able to annotate on the image
       PrintNames - allows selection of preferred PrintName from a list of
PrintNames. 

This is useful if the datasheet have several possible Print output
styles.

Mobility user can then be prompted with this checklist to select
the appropriate PrintName.
       
       Reading - allows entry of a reading value in the checklist.
       Scan - allows scanning of a barcode
       Signature   - to accept a signature
       SQLList         -         allows you to display a list of values from an SQL query for
selection. 

The SQL query must select only one field, e.g. select itemcode from itemmaster where
itemcategory = 'BOLTS' . 

The sql statement is entered in the "List Values or Info Text" column. The selected value
will be the value of the Checklist item.

            You can also include the #employeename# parameter in the SQL statement if necessary. 
The #employeename# parameter will pass the Freeway employee name to the SQL

statement.
            e.g. select ORDERNUMBER from PURCHASEHEADER where BUYER =
#employeename#   
 
       Stopwatch         -         this adds a stopwatch function to the checklist to capture
time/duration values.
        Text                 -         allows entry of a single line of text up to 200 characters
       Time                 -         allows entry of a time value

List Values or Info Text: If the item is a List type, then enter the list of values here. This
will force the user to select values from this list only.
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If the item is an Info type, then enter the information text here.
If the item is an SQLList type, then enter the SQL select

statement here.

Help Text: Enter any applicable help text here for the item. This help text can be displayed by the
Freeway app user as required.

Form Caption: Enter a caption for item if the CheckList is a Form. Maximum 15 characters.

Property : Select a standard property to be associated with the Property item. 

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new ‘Item Line for entry of another Check List Group Item record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected Item record.

Conditional Rules Tab

Entry and Display fields

This set of Conditional Rules will be dynamically applied as the Check List Items are being
responded to. 
Each Conditional Rule could result in either a branch off to another CheckList or the presentation
of a resulting computed value or a set of pre-defined text.

Rule Sequence: The sequence number of the Conditional Rule. Conditional Rules are applied
strictly according to this sequence.

Conditional Name: Enter a Name for this Condition.

Conditional Rule: This could be a simple statement like:  $$VOLTAGE > 240   (where VOLTAGE
is a Variable Name  defined in CheckList Items).
                             Another example :   $$VOLTAGE > 240  and $$AMP <= 3.5   (where VOLTAGE
and AMP are Variable Names).

If the data entered in response to the CheckList items satisfy this rule, then there are two
possibilities:

1.  Branch off to another CheckList (you specify this by adding the CheckList Name to the "Check
List to Add" column) and leaving the "Result Expression" column BLANK.

2.  Present a Resulting Value. You use the "Result Type" and "Result Expression" columns to
define the resulting value.
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Result Expression or Text:  This will be left BLANK if the result of the Condition Rule is to branch
off to another Check List. However, if a resulting value is to be presented, then:

a.  If "Result Type" = Text, then type in the textual information to be presented here.

b.  If "Result Type" = Expression, then type in the formula or expression used to derive the
resultant value. This expression could include comparative, conditional, and boolean logic (<, >, =,
<>,CASE WHEN THEN ELSE END, AND, OR) .
     The Variable Names (defined in CheckList Items) used in this expression must be preceded by
two dollar symbols ($$).                                         

Check List to Add: This is used only if the Conditional Rule results in branching off to another
CheckList. Enter the "branched to" CheckList Name here. 

Result Type:  Select either Text or Expression. 
                      Text means the result of this condition check will be a set of text as entered in the
"Result Expression" column. 
                      Expression means the resulting value is computed based on the formula specified
in the "Result Expression" column.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new ‘Item Line for entry of another Check List Group Item record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected Item record.

8.4 Style Templates

A Style Template is how a Freeway DataSheet is organized to capture data.

The Style Template screen has 4 tabs (List-Detail-Template-Settings).

List Tab

Display fields

Style Name: The name of the Style Template,

Template Group: The name of the Template Group,

Description: The description of the Style template.

Flowname :
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Icon Indicator : 

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Style Template record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Style Template record.

Detail Tab

Entry and Display fields

Name: Name of the Style Template.

Description: Enter the Style Template description here.

Template Group: The name of the Template Group. Templates belonging to the same Template
Group will be listed under their Group Name in the Freeway app. 

The primary purpose of a Datasheet is to capture data. The first thing to bear in mind is what this
datasheet is related to. With Ostendo Freeway, you can initiate datasheets to capture data for 
Customers, Suppliers, Job Orders, Assembly Orders, Delivery Orders, Purchase Receipt,
Inventory Counts,Transfers. We also have another class of datasheets called Internal
Datasheets to cater for everything else.

Then the next thing to consider is what to do with the data after you have collected it. This is where
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the “Creation Style” fields come in.

The 9 Creation Style fields enables you restrict where this style template is used and to specify
what happens to the data when when you select and use it. 
For example, if the Style Name is "SALES ORDER" and Creation Style when Selecting Customer
is "New Order Sales"  - then what this means is that 
If you select a Customer and then you select this "SALES ORDER" template, then this will enable
you to create a New Sales Order for that customer.

If the Style Name is "SALES ORDER" and Creation Style when Selecting Supplier is "N/A" - then
what this means is that if you select a Supplier, you will not see this style template.
This is just another way for you restrict where this style template is available for selection.

The Creation Style selected (other then N/A) determines what will be done with the data entered -
e.g. new job/order created, or update Assembly order, or just data only, etc... 

Creation Style when Selecting Customer: 7 options are available:

0. N/A - Not Applicable - use this to make this style
UNAVAILABLE when Selecting Customer

1. New Direct Invoice - A new Direct Invoice will be created in Ostendo
when this style is used. No job is created.

2. New Actual Job - A new Job with Actuals will be created in
Ostendo.

3. New Order Job - A new Job Order will be created (no Actuals) in
Ostendo.

4. New Quote Job - A new Job Quote will be created in Ostendo.
5. New Quote Sales - A new Sales Quote will be created in Ostendo.
6. New Order Sales - A new Sales Order will be created in Ostendo.
7. New POS Order - A new On-Hold POS order will be created in

Ostendo.
8. Data Only - This is for data collection only. No quote or order

created/updated in Ostendo.

Creation Style when Selecting Supplier: 3 options are available:

0. N/A - Not Applicable - use this to make this style
UNAVAILABLE when Selecting Supplier

1. New Order Purchase - A new Purchase Order will be created in
Ostendo.

2. New Receipt Purchase - A new Purchase Receipt will be created in
Ostendo.

3. Data Only - This is for data collection only. No order
created/updated in Ostendo.

Creation Style when Selecting Job: 2 options are available:

0. N/A - Not Applicable - use this to make this style
UNAVAILABLE when Selecting Job

1. Data Only - This is for data collection only. No order
created/updated in Ostendo.

2. Update Order - Order in Ostendo will be updated.
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Creation Style when Selecting Assembly: 2 options are available:

0. N/A - Not Applicable - use this to make this style
UNAVAILABLE when Selecting Assembly

1. Data Only - This is for data collection only. No order
created/updated in Ostendo.

2. Update Order - Order in Ostendo will be updated.

Creation Style when Selecting Delivery: 2 options are available:

0. N/A - Not Applicable - use this to make this style
UNAVAILABLE when Selecting Delivery

1. Data Only - This is for data collection only. No order
created/updated in Ostendo.

2. Update Order - Order in Ostendo will be updated.

Creation Style when Selecting Purchase: 2 options are available:

0. N/A - Not Applicable - use this to make this style
UNAVAILABLE when Selecting Purchase Order

1. Data Only - This is for data collection only. No Receipts
created/updated in Ostendo.

2. Update Receipt - Purchase receipt in Ostendo will be
created/updated.

Creation Style when Selecting Count: 2 options are available:

0. N/A - Not Applicable - use this to make this style
UNAVAILABLE when Selecting Inventory Count

1. Data Only - This is for data collection only. No Inventory
Counts updated in Ostendo.

2. Update Count - Inventory Count in Ostendo will be updated.

Creation Style when Selecting Transfers: 2 options are available:

0. N/A - Not Applicable - use this to make this style
UNAVAILABLE when Selecting Inventory Count

1. Data Only - This is for data collection only. No Inventory
Transfers updated in Ostendo.

2. Update Transfer - Inventory Transfers in Ostendo will be updated.

Creation Style when Selecting Internal: 3 options are available:

0. N/A - Not Applicable - use this to make this style
UNAVAILABLE when Selecting Internal

1. Data Only - This is for data collection only. No order
created/updated in Ostendo.

2. Update Times - Timesheet in Ostendo will be updated.
3. New ReStock Order This data sheet will create a PLANNED Purchase

Order for Items or Descriptors.
Using this Internal Data Sheet Style allows you to easily generate Planned

Purchase Orders for Items or Descriptors. 
This selection is only available if the Mobility Rule "Default ReStock Supplier" is
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filled in.
When completed New ReStock Order data sheets are sent back to Ostendo, they

will create Planned Purchase Orders for the default Supplier for each item/descriptor. 
If the item/descriptor has no default supplier then the Default ReStock Supplier

specified in Mobility Rules is used.
New ReStock Order data sheets will keep adding to existing PLANNED Purchase

Orders (for the same Supplier) until the status is changed.
 

Set "Copy to Invoice" for Linked Job Data Sheet Creation : Tick this box if you want to "Copy
to Invoice" when a Data Sheet pdf is generated and linked to the Job.

Material Lookup Style : Select either Standard or Graphical. Graphical means images are
included in the items/descriptors lookup. Images will be displayed if the item or descriptor  has a 
Mobility Image associated with it. The Mobility Image must be square and optimal size is 256 by
256 pixels.

Job Type for New Job Order : Select the JobType for the new Job Order created using this
template (if applicable).

Job Type for New Job with Customer Asset : Select the JobType for the new Job with Asset
created using this template (if applicable).

Purchase Type for New Purchase Order : Select the PurchaseType for the new Purchase Order
created using this template (if applicable).

Sales Type for New Sales Order : Select the SalesType for the new Sales Order created using
this template (if applicable).

Style Image : You can select an icon from this drop-down list of images which best represent your
Style template. There are about 20 images for you to choose from.

This icon will be displayed next to the name of the Template in the template
selection list in Freeway.

How Material Quantities are Posted : Options are "Quantities UnChanged" or "Quantities
Reversed" . The default is Quantities UnChanged.

This setting provides an option to create a template that can handle product returns where the
quantities entered will be reversed when posting back into Ostendo.

Time Tracking is Active if Auto On and Off Site for Start/Stop Times is set : Tick this box to
activate Time Tracking when "Start/Stop On Site and Off Site" is set to Auto On. 
This flag needs to be turned on if you wish the mobile device to send back GPS tracking
coordinates only when Times data is captured on the datasheet template.

No Auto Post : Tick this box if you do not wish to post the datasheet automatically.

Assignment Un-Finished on Completion : Tick this box to prevent the Assignment booking from
being updated to "Finished" when the Datasheet is completed. This means the Assignment  will
still be available to the Freeway user. This is useful if some Pre-Work needs to be conducted prior
to the actual work itself. 

Materials are Added as Planned Only : Tick this box to ensure Materials and Labour are added
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to the Job or Assembly order as "Planned Lines" rather than Actual Issues.

Sheet completion Instruction : Enter a brief instruction relating to the completion of the
datasheet. 

Sheet Completion caption : Enter a caption for the Sheet Completion button.

Default Picking and Receipting Location Logic : Select the default logic from the drop-down
list. This will override the Employee Mobility Settings.

- User Specified
- From Mobility Settings
- Use Product Defaults
- Fixed From Employee

Notes subtab : 

Enter notes relating to this Style Template here.

Forwarding Employees subtab :  This only applies if the Style Template has the Forwarding
Type. 

This grid has the following columns : 

Employee or Capability : Select either "Employee" or "Capability" . Datasheets can be
forwarded either to a specific employee or all employees with the specified Capability.

Name : Select name of Employee or Capability. 

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another Style Template Detail record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Template Tab

Entry and Display fields

Sequence: The sequence number of the Template item. By default, it starts with 10 and
increments by 10. 
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Type: Select the Template item type from drop-down list: 
 

- ASSET                                 to view the Customer Asset 
§ Asset linked to a Job or the Assets / Equipment List linked to a Customer.

- ASSETSERVICESTATUS to prompt the Freeway user to indicate whether the asset
is serviced or not. Options are:

- Service Completed
- Service Not Completed - Asset In Use 
- Service Not completed - Asset Not Found
- Service Not Completed - Asset in Repair
- Service Not completed - Other 

If the assets are not serviced, notes can be added to
describe the reasons for the non-completion.

Ostendo Freeway can be used to facilitate the servicing
of multiple customer assets at a site.

For a full description of how to do that, please refer to :
Freeway Multi Asset Servicing 

- ASSYPICKING to pick items from inventory for use in the Assembly Step
(remaining quantities only). (Requires a live connection with the Ostendo database). 

- ASSYRECEIPTING to receipt assembled items into inventory.
(Requires a live connection with the Ostendo database). 

- ASSYTRACKINGCODE           to immediately update the Tracking Code of the
associated Assembly Order.

- AUDIO                                 to record an audio.
- CHECKLIST                         adds a CheckList to the template. Requires a CheckList

Name.

- CORRECTIVEACTION this type allows you to initiate a Call Ticket only, or a
Quote, or an Order, or a Ticket and an Order, or a Ticket and a Quote to address
situations which may arise at the site while working on a task. The types of corrective
actions that can be initiated depends on the Corrective Action Styles defined in Mobility
Settings. A further explanation of this concept can be found here: Freeway Corrective
Actions Explained

- COUNTLINES to dynamically pull in Inventory Count Lines. (Requires a
live connection with the Ostendo database). 

- CUSTOMERDETAILS               to enter some basic data for new customers.

- DELIVERYDETAILS adding this type will automatically create a Picking
Checklist to allow the user to enter the following information:

- Picking and Packing Status:
- Picking Complete - this is a checkbox to

indicate if picking is completed for the delivery order.
- Packing Complete - this is a checkbox to

indicate if the items are all packed.
- Delivery Shipment Details:
- Actual Weight (Kg) - enter the weight of the

shipment here
- Actual Volume (M3) - enter the volume here
- Number of Pieces - enter the quantity here

http://ostendo.info/downloads/ostendo/Freeway_Multi_Asset_Servicing_Explained.pdf
http://ostendo.info/downloads/ostendo/Freeway_Corrective_Actions_Explained.pdf
http://ostendo.info/downloads/ostendo/Freeway_Corrective_Actions_Explained.pdf
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- Freight Information:
- Shipping Reference - enter shipping reference

here
- Specified Shipping Method - enter shipping

method here
- Override Standard Freight Charge - tick this

checkbox if required
- Specified Nett Freight Charge - enter value

here

All the above checklist items are optional. Use as
required. 

When the datasheet is completed and synchronized with
Ostendo, these details will be used to update the Delivery Order.

- DELIVERYDROPOFF Allows you to indicate whether the delivery was actually
dropped off at the site (by ticking a box) and also to add some notes. These notes will
update the Drop-Off Notes tab in Sales Delivery.

- DELIVERYLINES to dynamically pull in delivery lines from Ostendo Delivery
Order.

If Delivery Mode for Mobility User is "Proof of delivery"
then he can just view the delivery lines.

If Delivery Mode is "Delivery Pick", then he can proceed
with picking of each Delivery line.

Note that Delivery Lines are dynamically synchronized
with Ostendo during the picking process. This means that this function require a live
connection with the Ostendo database. 

- DYNAMICCHECKLIST to generate a dynamic checklist for a Job or Assembly or
Delivery. The checklist is defined by some specifications entered in the Notes or
Instructions section of the Job/Assembly/Delivery. 

- FOLLOWUP                         to generate a follow-up assignment.
- FORWARD                         to forward the DataSheet to another employee. 

§ The employees that can be forwarded to are defined in the Style Template's Detail
- Forwarding Employees tab.

- HAZARDS                         to view hazards and instructions linked with the job /
Customer site / BOM. 
§ In Ostendo, hazards and instructions are defined in GENERAL -- Hazards /

Hazard Groups. 
§ Hazards and Instructions can be linked to Customers, Jobs, and Bill Of Materials.

- IMAGES                         to add or take pictures.

- INQUIRY  to run a relevant inquiry relating to key Datasheet data.
E.g. a job datasheet will only be able to run a JOBINQUIRY type, a Assembly 

datasheet will only be able to run an ASSEMBLYINQUIRY type..
Standard Freeway Inquiries (like Job Info, Customer Info,

Assembly info, etc) will NOT be available from within the Datasheet.
Custom Inquiries will NOT be available to Templates for

Stock Counts or specific products. 
An internet connection is required to run these real-time

inquiries.

- INVOICEFIELDS to enter data into AdditionalFields.
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- ITEMBATCHENTER to enter the Item Batch Number manually
- ITEMBATCHSCAN to enter the Item Batch Number by scanning
- ITEMSCANBATCHENTER to enter the Item Batch Number by scanning or keying in.

- JOBFIELDS to enter data into AdditionalFields.

- JOBPICKING to dynamically pull in Job Task Lines for picking
(remaining quantities only). (Requires a live connection with the Ostendo database).

- MAP                                 to view a map based on the address of the selected
Customer. 

- MATERIALS                         to enter materials for a job or order or restock or
expenses/claims made by a subcontractor employee.
§ What materials can be entered is controlled by Employee Mobility Settings -

Materials tab - Restricted Materials List.

- NEWGUIDE to create two sections in the DataSheet to help compile a
draft User Guide.
§ One section to enter Guide Name, Guide Description, and Guide Notes
§ Next section to create Guide Slides (with Slide Name, Slide Description, Slide

Image, Slide Notes, and Slide Sequence)
 

- NEWJOBTASK to allow the Freeway user to add a new job task to the job.

- NOTE                                 to enter notes. Requires a Note Name.

- NOTIFY to send a notification text or email message from within a
Datasheet. The Notify Group Name is specified in the Template line Option.

The idea here is to be able to define formal "Control
Points" during a datasheet process, allowing the user to send a Freeway Notification 

(Txt or Email) from specific points within the Datasheet. This
could also be used to force the Freeway user to send a txt or email when a 

specific point of the Datasheet has been reached.
   

- PLANNEDLINEINFO                to view the planned Job Lines in the selected job. 
- PRINT                                 to print/email a report. Requires a Print Name.
- PURCHASEFIELDS to enter data into AdditionalFields.

- PURCHASERECEIPTING to dynamically pull in Purchase Order Lines for receipting
(remaining quantities only). (Requires a live connection with the Ostendo database). 

- PURCHASERECEIPTSLIP to enter the packing slip number of the receipted goods.

- QUANTITIES to record quantities for statistical purposes. These
recorded quantities will then update statistics of the associated Customer or Supplier / 

Customer Asset / Customer Asset Readings / Site / Item .
QUANTITIES must be associated with a List of materials

(Items and/or Descriptors).
A further explanation of this concept can be found here:

Recording Quantities & Statistics

- READING                         to record meter readings of the associated Asset. 
- RECEIPTFIELDS to enter data into AdditionalFields.
- REGISTER                         to enter multiple lines of data. Requires a CheckList

http://ostendo.info/downloads/ostendo/Freeway_Recording_Qtys_And_Stats_Explained.pdf
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Name.
§ Up to 20 fields per line can be defined via a CheckList. 
§ Register type can also be used with multi asset servicing checklists.

- RESTOCK to indicate when the selected restock materials are
required by.

- SALESFIELDS to enter data into AdditionalFields.
- SALESTRACKINGCODE to immediately update the Tracking Code of the

associated Delivery Order.
§ For Sales Orders and Quotes, this will update only when the datasheet is

synchronized.
- SIGNATURE                         to capture a signature. Requires a Signature Name.
- SKETCH                        to draw a sketch. Requires a Sketch Name. 

§ Sketch type can also be used to take a picture and add annotations onto it. 
- STEPSTATUS to update the Assembly Step status as “Finished” if this

is ticked.
- SUPPLIERDETAILS               to enter some basic data for new suppliers. 

- TASKFIELDS to enter data into AdditionalFields. 
- TASKSTATUS                         to update the JobTask status as “Finished” if this is

ticked.
- TICKET                                 to raise a Call Ticket. 
- TICKETACTIONS                 to create one or more Call Ticket Action.
- TIMES                                 to enter labour times for internal employees and

subcontractor employees. 
§ The Time Entry Mode is specified in Employee Mobility Settings - Time Entry tab.

- TRACKING                         to indicate OnSite / OffSite tracking. 
§ This will also capture the GPS coordinates at the point when this is selected.

- TRACKINGCODE                 to immediately update the Tracking Code of the
associated Job.

 
     - TRANSFERADHOC to select and transfer stock from one location to another.
User can select multiple items from one warehouse location and transfer them to a specific
warehouse location.  

This type of transfer is suitable when you wish manually
select the items to transfer. These items are not restricted to your Materials List or any Item
Restriction Conditions under the Employee Mobility Settings

TRANSFERASSIGNED to transfer stock required for a user's assigned jobs to
his/her van stock. The system will compare what is required from all the assigned jobs against the
current van stock levels. 

This type of transfer pre-populates transfer lines with all
sum totals of items which have remaining ‘planned’ quantities for jobs that have been assigned to
this Freeway employee. The idea here is to suggest what items and total quantities are required
(based on the remaining qtys of job planned lines) for all jobs assigned to this employee. The
employee can then simply choose to transfer what they believe they will require. They are not
forced to transfer anything if they choose not to. In addition to this, these transfers allow the user to
also select materials from their “Materials” list if they choose.

TRANSFERRESTOCK to re-stock a technician's van stock based on a
pre-defined Re-Stocking Template (Inventory -- Settings).

The concept here is to create a Re-Stock Template
(From Inventory-> Settings->Re-Stock Template), so that field staff can replenish vehicle stock
back to their optimum levels. In addition to this, these transfers allow the user to also select
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materials from their “Materials” list if they choose.

Stock transfers initiated from the Freeway App requires
an online connection as the transfers are entered into Ostendo dynamically and posted when the
datasheet is completed. 

The following types allow user to enter data into those AdditionalFields which have been
marked as "Available to Mobility" in ADDITIONAL FIELDS definitions as well as those fields
included in Employee Mobility Settings - Customer tab 

- JOBFIELDS                        
- TASKFIELDS                        
- SALESFIELDS                         
- PURCHASEFIELDS                
- RECEIPTFIELDS                
- INVOICEFIELDS                

Description: Enter a short description for each Template item.

Option: Where applicable, you need to associate the desired name with the Template item. For
example, if the type is CHECKLIST, then the Option must contain the name of a pre-defined
Check List. 

Include in Print: Tick this box to include this template sequence and type in the printout.

Display Option : Select one of the following :
- Always : template item will always appear in the screen
- Optional : template item will be hidden unless the user choose to display it on the

screen
- Hidden at PreStart : this entry is hidden from the Freeway screen until the PreStart

Checklist has been completed or mandatory satisfied. 
- Shown at PreStart : this entry is shown on the Freeway screen when the PreStart

Checklist is presented.
- PreStart Checklist : Only one checklist in a style template may be defined as a

"Pre-Start".

The concept of this is to force the Freeway user to complete various functions within the
Datasheet prior to commencing the work in full. For example, you may
have a PreStart checklist to identify hazards prior to starting the work. Once these are
completed, only then does the Datasheet reveal all other template options available to the
user.
A PreStart checklist is setup the same as any other checklist, however one or more
groups in it must be set to ‘Mandatory’.

Override Group Caption : If you wish to group a few template items together, you can do so
by entering the same caption for those items here. 

All items belonging to the same group should be listed one after
another. 

Mandatory Entry : Tick this box if this template type must be actioned. This is applicable only to
the following types:

- ASSYTRACKINGCODE
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- READING
- SALESTRACKINGCODE
- TRACKINGCODE

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new ‘Template' line for entry of another Template Item record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected Template item record.

Settings Tab

Entry and Display fields

Specific Employee: Tick this box if this setting is for a specific employee.

Employee Name: If "Specific Employee" is ticked, then this field is enabled to allow selection of
the employee name.

How Times are Posted in Ostendo: Select the appropriate method for posting labour times to
Ostendo.

- Use Employee Setting
- Job Direct
- Create New Timesheet
- Add to Existing Timesheet
- Add to Daily Timesheet
- Add to Weekly Timesheet

Default Labour Code for Time Entry: Select the default Labour Code for this template. A
non-blank entry here will override what is specified in the Employee Mobility Settings.

Auto Time Entry Creation Rule: Select one of the following options:
- Use Employee Setting
- Auto Insert Time Entry on Sheet Creation
- No Auto Insert of Time Entry

Material Pre-Fill List: Select the materials list that will be used with this template. This will
override what is specified in Employee Mobility Settings.
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Charge Style: Select the charge style for all labour times capture with this template. Select one of
the following:

Chargeable
Non-Charge

Non-Charge Code: Select the Cost Centre Code if Charge Style is Non-Charge.

Use Pre-Fill Qty : Tick this box if this template defaults to using the Pre-Fill Qty.

Assigned Transfer Horizon Days: Enter the number of days for the horizon for Assigned
Transfers.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected record.

8.5 Style Template Matrix

The Style Template Matrix screen defines what Data Sheet Template styles are available based on
the combination of parameters. 

It is a grid with the fields – DATASHEETSTYLE, JOBTYPE, CUSTOMERTYPE, CUSTOMER,
SUPPLIERTYPE, SUPPLIER, EMPLOYEENAME, STYLENAME.

This matrix allows you the flexibility to define as specific or as general as you wish as to what Style
Template will be available to the user based on a combination of these factors.

For each line in this grid, all non-blank conditions must be satisfied (“AND” condition).

    For example if both Customer Type and Employee is specified, then the template will only be
available if that employee selects a customer of that Customer Type.

If there are multiple rows with the same Style Name, then if any row is satisfied, the template will
be available (“OR” condition).

Entry and Display fields

Data Sheet Style: Select either Customer / Job / Supplier / Assembly / Delivery / Purchase /
Count / Internal / Transfer / All 
"All" is not applicable to B2B Customers.
For B2B Customers, you need to specify the specific "employee name" and/or the Customer name
(in the respective columns) before the template is available to them. 
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Job Type: Select the Job Type (Optional).

Customer Type: Select the Customer Type (Optional).

Customer: Select a specific customer (Optional).

Supplier Type: Select the Supplier Type (Optional).

Supplier: Select a specific Supplier (Optional).

Employee: Select the employee name (Optional).

Style Name: Select the style name to be used for this combination.

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new matrix line.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected matrix line.

8.6 Notify Messages

The idea of this is to define formal “Control Points” during a process when completing a Freeway
Datasheet. This allows the user to send a Freeway Notification (Txt or Email) from specific point(s)
within a Datasheet. An example of this could be when the customer requires a notification from the
Tech they are on their way to the job after already opening the Datasheet to record Travel Time.
This could also be used to force the Freeway user to send a Txt or email when a specific point of
the Datasheet has been reached.

This approach also allows the message to be stored within the Datasheet, thereby retaining a
record of these communications at defined control points within the process.

Multiple Notify “Control Points” maybe defined within a Style Template

Setup:
A new screen is available allowing you to create a “Notify Group Name”. This also allows you to

define whether this group is Mandatory or Optional as a whole.

The Notifications screen now includes an additional “Notify Level” option called ‘Notify Group’. The
Group is then defined in the “Level Name” field. 

A new Style Template Type field called “NOTIFY” allows you to link the “Notify Group Name” to the
Template line Option..
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List Tab

Display fields

Notify Level: Select one of the options:
-  All Employees
-  Specific Employee
-  Internal Employees
-  B2B Employees
-  Subcontractors
-  Notify Group

.
"Specific Employee" means only the employee specified in the next column can

select & send this Notify Message

Level Name: This lookup is only applicable if the Notify Level is "Specific Employee" or "Notify
Group".

Sequence No.: Enter an integer number.

Notify Caption : Enter a standard notify message here (maximum 100 characters). This message
can be modified by the sender just before sending (if required).

Notification Method : This is either "None", or  "Email", or "Text Message".

Who to Notify : Select one of the following:
- "All Employees", 
- "Mobility Team", 
- "Specific Employee", 
- "Notify Employee" , 
- "Job Contact" ,
- "Customer Contact" , 
- "Salesperson" ,
- "Buyer"
- "Specific Email"
- "Specific Mobile"

Notify Name/Email/Mobile : Depending on what is selected in "Who to Notify" this will provide the
appropriate lookup for name selection.

ON/OFF Site Indicator: Select the appropriate OnSite / OffSite / Customer GPS indicator when
this message is sent.

Basically this is to indicate on the map whether the employee is arriving on site or leaving
the site when this Notification message is sent.

No GPS Sent : Ticking this flag will stop GPS coordinates being sent with the Notify message.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close thise screen.  If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected record.

8.7 Guide Definitions

This screen allows the definition of Guides to be used in Ostendo Freeway. 

Guides are collections of images (storyboard) with accompanying notes. Examples are 'How-To"
guides, Diagnostic guides, etc.

Every Freeway user can be assigned a specific Guide Pack (a collection of guides). 

On the Freeway app, the user can access his/her Guide pack via the GUIDE button.

List Tab

Display fields

Guide Name: Name of the Guide definiton.

Description: This is a description of the Guide.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
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and sorting:
· To sort the data in a selected column simply click on the column heading.  Clicking

against will sort in descending order.
· Click on the black ‘down arrow’ to the right of your selected column heading and you can

either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close thise screen.  If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected record.

Detail Tab

Entry and Display fields

Guide Name: Name of the Guide.

Description: Enter the Guide description here.

Author: Enter the Guide author's name here.

Version No: This display-only field shows a system generated version number for this guide.
This number increments by one each time the Guide is updated.

Slide Count: This display-only field shows the number of slides in this Guide. 

Include Guide Properties Slide: Tick this box if you wish to include a Guide Properties Slide at
the end of the guide. The Guide Properties Slide will display the Author, Version No., Slide Count,
and Comments entered below.

Comments: Enter any relevant comments about this guide which will be displayed in the notes
accompanying the Guide Properties Slide.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another record.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Slides Tab

Entry and Display fields

Seq No: Enter a sequence number.

Slide Name: Enter a name for the slide. A guide can have as many slides as required.

Description: Enter the Slide description here.

Slide Image: Click on the field, then right-click to load the image associated with this slide here.

The bottom section of the Slides screen has two other tabs:

HTML SubTab: This allows you to key in the notes in HTML format using the appropriate
control keys.
You can also click on the Editor button which will bring up the editor screen with built-in
functions for entering notes in html format.

Text SubTab: This allows you to key in the notes in plain text. If you have keyed in the
notes using the Editor, this subtab will show the embedded html tags together with the
textual data.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Editor: This button calls up the HTML editor and enables you to key in notes related to the current
slide.
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8.8 Find Definitions

This screen allows the definition of Find Catalogues and Information to be used in Ostendo
Freeway. 

Every Freeway user can be assigned a specific Find Pack (a collection of Find Catalogues and
Information). 

On the Freeway app, the user can access his/her Find pack via the FIND button.

List Tab

Display fields

Seq No: Sequence number.

Find Name: Name of the Find definition.

Description: This is a description of the Find definition.

Style: The Find Style - either Catalogue or Information.

Hierarchical Name: This is the name of the Hierarchical structure used with this Find Definition.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected record.



309Mobility

Detail Tab

Entry and Display fields

Find Name: Name of the Find Catalogue or Information.

Description: Enter the description here.

Seq No: Enter the Sequence number here.

Style: Select the style - Catalogue - Catalogues are collections of materials - items or
descriptors. 

Information - Information are made up of textual elements.

Hierarchical Name: Select the Hierarchical name associated with this Catalogue or Information
style. This is a required entry.

For Catalogue style, the contents are defined by the Hierarchical Name together with the
associated Items or Descriptors as specified in Item Mobility and Web.
For Information style, the contents are defined by the entries in the Elements tab.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Elements Tab

This tab only appears if the style is Information. 

Entry and Display fields

Seq No: Enter a sequence number.

Name: Enter a name for the Information element. A Find Information definition can have as many
elements as required.

Description: Enter the Element description here.

Hierarchical Level: Select the hierarchical level this element is linked to.

The textual content of the Information element is entered in the bottom section of the screen.
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The bottom section of the Elements screen has two other tabs:

HTML SubTab: This allows you to key in the textual content in HTML format using the
appropriate control keys.
You can also click on the Editor button which will bring up the editor screen with built-in
functions for entering the textual content in html format.

Text SubTab: This allows you to key in the contents in plain text. If you have keyed in
the contents using the Editor, this subtab will show the embedded html tags together with
the textual data.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Editor: This button calls up the HTML editor and enables you to key in notes related to the current
slide.

8.9 Guide Packs

This screen allows you to group one or more guides into Packs. You can have multiple Guide
packs defined to meet the different needs of different groups of Freeway users. 

A Freeway user can have only one Guide Pack name assigned, but that pack can have many
guides. 

List Tab

Display fields

Pack Name: Name of the Guide Pack.

Description: This is a description of the Pack.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:
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· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected record.

Detail Tab

Entry and Display fields

Pack Name: Name of the Guide.

Description: Enter the Guide description here.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Contents Tab

Entry and Display fields

Guide Group: Select the Guide Group Name. you can add as many groups as you need. Guide
Group names serves to organize the Guide Pack into some logical fashion. 
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Guide Group names are defined in Mobility -- Settings.

Seq No: Enter a sequence number for the guide.

Guide Name: Select the name of the guide here.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank record for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

8.10 Find Packs

This screen allows you to group one or more Find elements into Packs. You can have multiple
Find packs defined to meet the different needs of different groups of Freeway users. 

A Freeway user can have only one Find Pack name assigned, but that pack can have many Find
elements. 

List Tab

Display fields

Pack Name: Name of the Find Pack.

Description: This is a description of the Pack.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
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records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected record.

Detail Tab

Entry and Display fields

Pack Name: Enter the Name of the Find Pack .

Description: Enter the Find Pack description here.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Contents Tab

Entry and Display fields

Find Group: Select the Find Group Name. you can add as many groups as you need. Find Group
names serves to organize the Find Pack into some logical fashion. 

Find Group names are defined in Mobility -- Settings.

Seq No: Enter a sequence number for the Group.

Find Name: Select the name of the Find Definition here.

Each record adds a Find Definition to the contents of the Pack.
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You can add in as many records as required.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

8.11 Feature Packs

In Item Mobility and Web (and Descriptor Mobility and Web) screens you can enter specific
Features for each Item or Descriptor.

However there may be other features that you wish to include which applies across all items/
descriptors (e.g. the Standard Sell Price).

So instead of adding Standard Sell Price as a feature in each Item or Descriptor, we can use 
Feature Packs to do that.

Feature Packs also allow you to pull in all associated Item Properties / Descriptor Properties to
be included as Features. 

If no Feature Packs are defined, then you will only see the features defined for each individual item
/ descriptor via the Item/Descriptor Mobility and Web screens.

You can have multiple Feature packs defined to meet the different needs of different groups of
Freeway users. 

A Freeway user can have only one Feature Pack name assigned, but that pack can have many
Feature Groups.

Feature Group Names are defined in Inventory -- Settings. 

List Tab

Display fields

Pack Name: Name of the Feature Pack.

Description: This is a description of the Pack.

Data Display Options



315Mobility

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected record.

Detail Tab

Entry and Display fields

Pack Name: Enter the Name of the Feature Pack .

Description: Enter the Feature Pack description here.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Contents Tab
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Entry and Display fields

Feature Group: Select the Feature Group Name. you can add as many groups as you need.
Feature Group names serves to organize the Feature Pack into some logical fashion. 

Feature Group names are defined in Inventory -- Settings.

Feature Code Type: Select one of these : Item Code / Descriptor Code / Catalogue Code .

Feature Style: Select one of the following:
- Standard : - this feature applies to all items (or descriptors or catalogue

codes) .
- Properties : - this will take all properties associated with this Item or Descriptor

and generate them as features to be included in this Pack.

Seq No : Enter a sequence number for the Group.

Bear in mind that the Features entered in the individual Item / Descriptor Mobility and Web screens
will also have Feature Group Name and Sequence Number.
The system will combine the Features entered in Feature Pack with those entered in Mobility
and Web screens and order them by Group Seq No and by Feature Description.

Feature Description: Enter a description for the Feature.
If "Standard" Feature Style, then the Description can include merged

fields from the ITEMMASTER or DESCRIPTORMASTER (depending on Code Type).
Merged fields are Fieldnames enclosed by double square brackets

(e.g. [[STDSELLPRICE]] )

If Feature Style is "Properties", then the Feature Description is not used
as each property will have its own description. 

Feature Notes: Enter notes relating to the "Standard" feature here. 

Each record adds a Feature(s) to the contents of the Pack.
You can add in as many records as required.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel
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8.12 Inquiry Packs

These screens allow you to define standard inquries for use with Ostendo Freeway mobility app. 

This is in fact an Inquiry report generator allowing you to easily create your own inquiries which can
be viewed through the Freeway app.

You can define multiple Inquiry Pack names and their associated contents (inquiries) here.

Each mobility employee can have an Inquiry pack name assigned. This is done in Employee
Mobility Settings - Device tab.

A short tutorial can be found here: http://ostendo.info/downloads/ostendo/
Freeway_Inquiries_Tutorial.pdf

List Tab

Display fields

Pack Name: Name of the Inquiry Pack.

Description: This is a description of the Pack.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

http://ostendo.info/downloads/ostendo/Freeway_Inquiries_Tutorial.pdf
http://ostendo.info/downloads/ostendo/Freeway_Inquiries_Tutorial.pdf
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Delete: This enables you to delete the selected record.

Detail Tab

Entry and Display fields

Pack Name: Enter the Name of the Inquiry Pack .

Description: Enter the Inquiry Pack description here.

Authorised for Customer B2B Use : Tick this box to allow B2B customers to use this Inquiry
Pack.

Authorised for Sub-Contractor Use: Tick this box to allow Sub-Contractors to use this Inquiry
Pack.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Contents Tab

Entry and Display fields

Add a record to define an Inquiry.

Inquiry Type: Select a Type from the drop-down list. Options are:

ASSEMBLYINQUIRY - Inquiry by selecting Assembly OrderNumber
CUSTOMERINQUIRY - Inquiry by selecting Customer
DELIVERYINQUIRY - Inquiry by selecting Delivery Number
INTERNALINQUIRY - General inquiry not linked to any specific

customer/job/assembly/delivery/supplier/product
JOBINQUIRY - Inquiry by selecting Job OrderNumber
PRODUCTINQUIRY - Inquiry by selecting Itemnumber or

DescriptorNumber
SUPPLIERINQUIRY - Inquiry by selecting Supplier

Inquiry Name: Enter a name for this inquiry. This will be displayed as the title of this Inquiry.
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Inquiry Style: Select the appropriate style from the drop-down list. Options are: 

CHART - Only a chart is displayed in this inquiry.
CHART-SCORECARD - The inquiry displays both a chart and a

scorecard (KPI values)
CHART-SCORECARD-LISTING- The inquiry displays a chart, a scorecard,

and a listing
CHART-LISTING - The inquiry displays a chart and

a listing
SCORECARD - The inquiry displays a scorecard only
SCORECARD-LISTING - The inquiry displays a scorecard and a

listing
LISTING - The inquiry displays a listing only

Seq No: Enter a sequence number for the inquiry.

Inquiry Explanation: Enter a brief explanation of the Inquiry. This will be displayed under the title
when the inquiry is run.

Display Customer Aging: Tick this Checkbox if Customer Aging balances are to be included in
the inquiry. (Applicable to CUSTOMERINQUIRY / INTERNALINQUIRY). 
If selected, Aging data will be displayed first before Chart/Scorecard/Listing. 

Display Stock Levels: Tick this Checkbox if Stock Levels are to be displayed in the Inquiry.
(Applicable to PRODUCTINQUIRY).
If selected, Stock Levels will be displayed first before Chart/Scorecard/Listing.  

Each record adds an inquiry to the contents of the Pack.
You can add in as many records as required.

The following sub-tabs at the bottom section of the screen is used to specify the parameters
required to generate the inquiry style. 

Listing sub-tab:
If the inquiry style includes listing, then this tab needs to be filled in for that Inquiry record.

Listing Caption:  Enter a descriptive caption for this Inquiry listing. (Example: Open Sales Orders
)

Header Line: enter the labels and fieldnames of the header record to be displayed here.
Example: '<b>Order No: </b>' || ordernumber || ' ' || '<b>Order Date: </b>' || (select *
from RETURN_DATEASTEXT(orderdate)) 
Explanation:  This whole string is made up of : Label1 || Field1 || space || Label2 || Field2
                    where Label1 ( '<b>Order No: </b>' ) is displayed as Order No: 

Field1  ( ordernumber ) is the value of ORDERNUMBER from
SALESHEADER table

Label2 ( '<b>Order Date: </b>' ) is displayed as Order Date: 
Field2 in this example uses a special Procedure

(RETURN_DATEASTEXT) to convert the date field (orderdate) into a text field.

Header Note: (Optional) Enter the note fieldname where the header notes is coming from. Use
this if you wish to display notes from the table into your listing.
(Example:  ordernotes )

Header to Detail Key: Optional. Enter the fieldname of the keyfield that links the detail records to
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the header record. If you have detail records to display, then use this to link the header and detail
records. (Example:  ordernumber )

Header From and Where Clause: Enter the From and Where clause for the SQL statement used
to extract the required header records. 
Example: from salesheader where customer = :passedselectedvalue and orderstatus
<> 'Closed' order by sysuniqueid  
Explanation: In this example, the :passedselectedvalue is the Customer you selected when
initiating this inquiry. 

For other inquiries, the :passedselectedvalue could be the Assembly/Job ordernumber,
DeliveryNumber, ItemNumber, DescriptorNumber, or Supplier.
You can also use :passedemployee (which refers to the mobility user name) in the inquiry as well
where appropriate.

So in this example, the SQL Select statement for the Header Lines in the Listing becomes:

Select '<b>Order No: </b>' || ordernumber || ' ' || '<b>Order Date: </b>' || (select *
from RETURN_DATEASTEXT(orderdate)) 

from salesheader 
where customer = :passedselectedvalue and orderstatus <> 'Closed' 
order by sysuniqueid

Header Results Restriction Count: If you wish to restrict the number of Header records
displayed,then enter the number here.

Header Indicator Logic:Optional. Either enter the Colour field name or a CASE statement to
define when a certain colour should be displayed. This is used to highlight the header record by
displaying the appropriate colour in a box next to the header record.
Example1: trackingcolour
Explanation1: This will simply display whatever the TrackingColour is for that header record.

Example2: case when (orderdate < (current_date - 365)) then 255 else 16777215 end
Explanation2: This case statement highlights those orders whose date is older than one year
with a RED (255) colourbox. Others will have a WHITE (16777215) colourbox.

There is an analysis view in Mobility Menu - Views which displays all the available
colours and the associated numbers. 

You can use this colour chart to select the colours you wish to use with your case
statement. 

Detail Line: Optional. Enter the labels and fieldnames of the detail record to be displayed here.
Example: cast(orderqty as decimal(18,3)) || ' ' || lineunit || ' <b>' || codetype || '</b> ' ||
linecode || ' : ' || linedescription || ' '
Explanation:  This whole string is made up of : Field1 || space || Field2 || space || Field3 || space
|| Field4 || : || Field5 || space
                    where Field1 is ORDERQTY cast as decimal(18,3) 

Field2 is LINEUNIT 
Field3 is CODETYPE highlighted in bold  
Field4 is LINECODE 
Field5 is LINEDESCRIPTION

Detail Note: Enter the note fieldname where the detail notes is coming from. Use this if you wish
to display notes from the table into your listing.
(Example:  linenotes )

Detail From and Where Clause: Enter the From and Where clause for the SQL statement used
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to extract the required detail records.
Example: from saleslines where ordernumber = :HEADERKEY order by linenumber
Explanation: :HEADERKEY is a reserved word that holds the value of the fieldname indicated
in "Header to Detail Key".

In this example, the SQL Select statement for the Detail Lines in the Listing becomes:
 

Select cast(orderqty as decimal(18,3)) || ' ' || lineunit || ' <b>' || codetype || '</b> ' ||
linecode || ' : ' || linedescription || ' '

from saleslines 
where ordernumber = :HEADERKEY 
order by linenumber

You can also use the :PassedEmployee parameter in the Detail Query. For example the Header
Query could be showing job order information while the Detail Query could show Timesheet entries
captured for that same job for the Freeway User.

Detail Queries can now run independently of the Header Query. For example, Header Query could
display total value of all orders for the month, while the Detail Query could display all individual
orders for the month.

Detail Results Restriction Count:  If you wish to restrict the number of Detail records displayed,
then enter the number here.

Detail Indicator Logic: Optional. Either enter the Tracking code field name or a cast statement to
define when a certain colour should be displayed.
(Refer to examples in Header Indicator Logic).

Chart sub-tab:
If the inquiry style includes Chart, then this tab needs to be filled in for that Inquiry record.
For Inquiries, only horizontal Bar charts are available.

Chart Caption: Enter a caption for the chart. This will be displayed as the title of the chart.
(Example: Sales by Country )

Chart Style: Select one of the options from the drop-down list:

Single Series : Chart is based on the values of one series as defined in
Series One Value.

Two Series : Chart is based on the values of two series as defined in
Series One and SeriesTwo Value.

Percentage Series : The value is expressed as a percentage of the total
values of all selected records. 

Percentage Series require only the Series One Value
and Series One Label to be filled in.

Series One Value: Enter the fieldname or aggregate expression here for the first series or for
the Percentage Series.
Example: SUM(INVOICENETTAMOUNT)

Series Two Value: This is applicable only to Two Series charts. Enter the fieldname or
aggregate expression here for the second series.  
Example: COUNT(INVOICENUMBER)
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Series One Label: Enter the label for the first series or Percentage series. This can be a text
string, a fieldname or a case statement.
Example: case when coalesce(billingcountry,'') = '' then 'Not Specified' else
BillingCountry end

Series Two Label: This is applicable only to Two Series charts. Enter the label for the
seconnd series.This can be a text string, a fieldname or a case statement.
Example: case when coalesce(billingcountry,'') = '' then 'Not Specified' else
BillingCountry end

Series One Format: Select one of the drop-down options:(None, Local Currency, FX
Currency,Decimal ). This is used to format the values displayed in Series One.

Series Two Format: Select one of the drop-down options:(None, Local Currency, FX
Currency,Decimal ). This is used to format the values displayed in Series Two.

Chart From and Where Clause:  Enter the From and Where clause for the SQL statement
used to extract the required data for this chart.
Example:  from salesinvoiceheader  where customer = :passedselectedvalue
group by 3,4  order by 1 desc
Explanation: The "group by" clause is only used when Series One Value or Series Two
Value is an aggregated value.

The number 1 refers to Series One Value; 2 refers to Series Two Value, 3
refers to Series One Label, and 4 refers to Series Two Label.

So for this chart, the SQL Select statement becomes like this:

Select sum(INVOICENETTAMOUNT),
count(INVOICENUMBER), 

case when coalesce(billingcountry,'') = '' then 'Not Specified' else
BillingCountry end, 

case when coalesce(billingcountry,'') = '' then 'Not Specified' else
BillingCountry end 

from salesinvoiceheader 
where customer = :passedselectedvalue 
group by 3,4 
order by 1 desc

Like your typical SQL statement, always group by the numbers which are
not aggregate values.

In this example, the :passedselectedvalue is the Customer you selected when initiating this
inquiry. 

For other inquiries, the :passedselectedvalue could be the Assembly/Job ordernumber,
DeliveryNumber, ItemNumber, DescriptorNumber, or Supplier.
You can also use :passedemployee (which refers to the mobility user name) in the inquiry as well
where appropriate.

Chart Results Restriction Count:  If you wish to restrict the number of records displayed,
then enter the number here.

Scorecard sub-tab:
If the inquiry style includes Scorecard, then this tab and the Scorecard (Statistics) tab needs to be
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filled in for that Inquiry record.

Scorecard Caption: Enter the caption for the Scorecard here.

Scorecard (Statistics) sub-tab:
You can have multiple statistics displayed in the Scorecard.

Seq No: Enter the sequence number of the statistic here.

Statistic Name:Enter the name of the statistic here.

Statistic Value Field: Enter the fieldname or aggregate expression here.
Example: sum(INVOICENETTAMOUNT) 

Statistic From and Where Clause: Enter the From and Where clause for the statistic's sql
statement here.
Example: from salesinvoiceheader where customer = :passedselectedvalue 
Explanation: In this example, the :passedselectedvalue is the Customer you selected when
initiating this inquiry. 

For other inquiries, the :passedselectedvalue could be the Assembly/Job ordernumber,
DeliveryNumber, ItemNumber, DescriptorNumber, or Supplier.
You can also use :passedemployee (which refers to the mobility user name) in the sql as well
where appropriate.

Statistic Format: Select the appropriate option for this statistic from the drop-down list.
Options are:

Date
Decimal
Integer
Local Currency
Local Currency No Decimals
Text

Highlight Conditional Type: Select the Highlight Conditional Type and the corresponding
Conditional Value if you wish to highlight each statistic based on certain conditions. Options are:

No Highlight
Equal To the Conditional value
Greater Than the Conditional value
Less Than the Conditional value

Highlight Conditional Value: Enter the Conditonal value for the corresponding Highlight
Conditional Type. This is a decimal value.

Highlight Colour: You can select one of four colours to be your highlight colour for the
statistic. (Choices are Blue, Green, Yellow, Red.)

Group Seq: Enter the Group Sequence here to order the group of statistic
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Group Name: Select the Statistic Group from the drop-down list. (Statistic Groups are defined in
Mobility Settings.)

Using the Group Seq and Group Name will enable you to group various statistics together and
present the statistics in the desired order.

You can click the Add button to add another statistic.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank screen for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to this panel

Display: This button allows you to display the Inquiries on your Ostendo screen (to preview it).
You will be prompted to select the Employee name and the record to run this

inquiry against (Customer / Supplier / Job / Delivery / Assembly / Product).
The Employee you select must have this Inquiry pack name assigned in his/her

Employee Mobility Settings - Device tab.

8.13 Employee Locations

Clicking on this item in the Mobility menu will show you a map of the employee’s last known
location. Blue pin means on site and orange pin means off site.

In Mobility Rules, you can set the Refresh Interval (in minutes) to update this display after the
specified time. You can also set a view Horizon. This will determine how far back in time
(hours) the app will retrieve the employee’s location data.

Google Maps

Recently, Google removed the ability for third party applications to connect freely to ‘specific’
Google Maps features. They have since changed this policy, to force any connection

to google maps to subscribe to their paid service in order to use their API. Subscribed users will
then be issued with an API key from Google which can then be loaded into
Ostendo.Mobility->Settings->Mobility Rules-Map API Key

Because of this new policy, the Employee Locations screen will only function for those Ostendo
sites who have a valid Google Maps API key.

We suggest you use the “Map Javascript API” google key. (refer below) Information is available
from:
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Costs:
https://developers.google.com/maps/billing/understanding-cost-of-use

Obtaining An API Key:
https://developers.google.com/maps/documentation/embed/get-api-key

User Guide
https://cloud.google.com/maps-platform/user-guide/

NB: This does not apply to the “Location Map” function, found against Jobs & Sales which uses a
different form of Google Maps.

8.14 Standalone Solutions

These screens allow Freeway Solution partners to upload their Standalone Freeway solutions and
make it available to their end users. 

List Tab

Display fields

Solution ID : The unique ID of the Standalone Solution. This ID is supplied by Development-X
Ltd. 

Solution Name : The name of the Standalone Solution.

Solution Description : A brief description of the Standalone Solution.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

https://developers.google.com/maps/billing/understanding-cost-of-use
https://developers.google.com/maps/documentation/embed/get-api-key
https://cloud.google.com/maps-platform/user-guide/
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Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected record.

Detail Tab

Entry and Display fields

Solution ID: Enter the Solution ID provided by Development-X Ltd. 

Solution Name: Enter the name of the Standalone Solution.

Solution Description: Enter a brief description of the Solution.

Employee Name for Settings: Enter the name of the representative employee whose Employee
Mobility Settings are used to generate this Standalone Solution.

Version No: The current version number of this Standalone Solution.

Version Date: The date of this current version.

Solution is Private: Tick this box if this is a private Standalone Solution. Private solutions can only
be downloaded by entering a Private Code supplied by the owner of the Standalone Solution.
Public Standalone Solutions can be downloaded by anyone.

Private Code: Enter your private code for this Standalone Solution.

Returned Private Code (Give to Client) : This code is generated by Ostendo and is to be used to
download the Standalone Solution to a mobile device.

Copy to clipboard button: Click this button to copy the Returned Private Code.

Upload Solution Package button: Click this button to upload the Standalone Solution package to
the Freeway Cloud Service. Once uploaded, the Solution can then be downloaded by the end
users. 

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel
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8.15 Data Sheets

The Data Sheets screen allows the user to view and edit the Data Sheets data created on the
mobile device. 

It has 3 tabs (List-Detail-Contents).

Each time a DataSheet is captured using the Freeway Mobile App, a SheetID is assigned. 

The List tab display a list of all Data Sheets by SheetID.

The Detail tab shows the summary grid of all records relating to a specific Data Sheet.

The Contents tab allows you to browse through the actual data in the Data Sheet.

List Tab

Display fields

Sheet ID: The ID number generated by the mobile app,

Style: The name of the Style Template used.

Name:  The name of the Data Sheet created by the mobile app.

Description: The description of the Data Sheet.

Employee: The name of the employee.

Completed: This indicates whether the DataSheet is completed.

Updated: This check box indicates whether the data has been updated to the job.
 

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated: Tick this box if you wish to see Service Sheets which have been "Updated" - i.e.
posted to jobs or invoices.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

 record.
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Detail Tab

Entry and Display fields

Name: Name of the various pieces of data captured by the Data Sheet.

Description: Description of the data.

Type: The Type of data (example: INFO, CHECKLIST, NOTE, MATERIALS, TIMES,
SIGNATURE, SKETCH, IMAGES, ASSET, MAP, AUDIO, TRACKING , etc...)

Contents Tab

The Contents Tab shows the actual values or contents of the various pieces of information
captured in the Data Sheet.

What is displayed in the Contents tab will vary depending what Template Type is being displayed.

For CHECKLIST types, Contents will show the value of each CheckList item.

For NOTE types, Contents will show the text of the notes recorded.

For MATERIALS, Contents will show a list of items or materials used in the service job.

For TIMES, Contents will show the Labour Codes and times recorded.

For SIGNATURE, Contents will show the actual signature image captured by the mobile app.

For SKETCH, Contents will show the image of the sketch captured by the mobile app.

For IMAGE, Contents will show the photos captured by the mobile app.

For AUDIO, Contents will be the audio record captured by the mobile app.

8.16 Settings

8.16.1 Note Names

Note Names allows you to pre-define different types of notes you wish to use with your
Style Templates.

Entry and Display fields

Note Name: Enter the Name of the Note.
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Description: Enter the Note description here.

Besides defining the Note Name here, you can also specify what else could be done with the
Notes when the Datasheet is completed and synchronized back to Ostendo. 

Just tick any of the following options if it applies to this Note Name.

Copy to Customer Notes: Tick this Check Box if you wish the notes to be automatically copied to
Customer Notes.

Copy to Customer History Notes: Tick this Check Box if you wish the notes to be automatically
copied to Customer History Notes.

Copy to Direct Invoice Notes: Tick this Check Box if you wish the notes to be automatically
copied to Direct Invoice Notes.

Copy to Job Notes: Tick this Check Box if you wish the notes to be automatically copied to Job
Notes.

Copy to Job History Notes: Tick this Check Box if you wish the notes to be automatically copied
to Job History Notes.

Copy to Job Invoice Notes: Tick this Check Box if you wish the notes to be automatically copied
to Job Invoice Notes.

Copy to Asset Notes: Tick this Check Box if you wish the notes to be automatically copied to
Customer Asset Notes.

Copy to Asset History Notes: Tick this Check Box if you wish the notes to be automatically
copied to Asset History Notes.

Copy to Sales Notes: Tick this Check Box if you wish the notes to be automatically copied to
Sales Notes.

Copy to Sales History Notes: Tick this Check Box if you wish the notes to be automatically
copied to Sales History Notes.

Copy to Supplier Notes: Tick this Check Box if you wish the notes to be automatically copied to
Supplier Notes.

Copy to Supplier History Notes: Tick this Check Box if you wish the notes to be automatically
copied to Supplier History Notes.

Copy to Purchase Notes: Tick this Check Box if you wish the notes to be automatically copied to
Purchase Notes.

Copy to Purchase History Notes: Tick this Check Box if you wish the notes to be automatically
copied to Purchase History Notes.

Copy to Assembly Notes: Tick this Check Box if you wish the notes to be automatically copied to
Assembly Notes.

Copy to Assembly History Notes: Tick this Check Box if you wish the notes to be automatically
copied to Assembly History Notes.

Copy to Delivery Notes: Tick this Check Box if you wish the notes to be automatically copied to
Sales Delivery Notes.
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Copy to POS Instructions: Tick this Check Box if you wish the notes to be automatically copied
to POS Instructions field.

Call Classification: (Optional) Select the Call Classification associated with this Note.

Call Sub Classification: (Optional) Select the Call Sub Classification associated with this Note.

Include Materials in Note: Tick this Check Box if you wish to append the Materials used in a job
to the Note when the datasheet comes back to Ostendo.

Include Times in Note: Tick this Check Box if you wish to append the Times recorded in a job to
the Note when the datasheet comes back to Ostendo.

Include Checklists in Note: Tick this Check Box if you wish to append the Checklist items to the
job Note when the datasheet comes back to Ostendo

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank Note Name line for entry of another Note Name record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected Note Name line.

8.16.2 Signature Names

Signature Names allows you to pre-define different types of signatures you wish to use
with your Style Templates.

Entry and Display fields

Signature Name: Enter a Name for this type of Signature.

Description: Enter the Signature description here.

Mandatory: Tick this Check Box if you wish to make this Signature as Mandatory.

Lock Checklists when Signed: Tick this Check Box if you wish to prevent user from making
changes to the Checklist responses after this signature is captured.

Lock Materials when Signed: Tick this Check Box if you wish to prevent user from making
changes to the Materials quantities after this signature is captured.

Lock Times when Signed: Tick this Check Box if you wish to prevent user from making changes
to the Times entries after this signature is captured.



331Mobility

Signature Clause: Enter the Signature Clause here (if any). The signature clause is a brief
paragraph to indicate the purpose of affixing the signature.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new Signature Name line for entry of another Signature Name record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected Signature Name line.

8.16.3 Sketch Names

Sketch Names allows you to pre-define different types of sketches you wish to use with
your Style Templates.

Entry and Display fields

Sketch Name: Enter a Name for this type of Sketch.

Description: Enter the Sketch description here.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new Sketch Name line for entry of another Sketch Name record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected Sketch Name line.

8.16.4 Mobility Teams

Mobility Teams setting allow you to define the names of teams of workers whose time
can be entered by a supervisor and/or assignment to jobs. 

Entry and Display fields
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Team Name: Enter the name of the Mobility Team.

Employee Name: Select the employee from the drop-down list. 

Mobility teams can have one or more employees.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new Mobility Team line for entry of another Mobility Team record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected Mobility Team line.

8.16.5 Mobility Team Pooling

Mobility Team Pooling allow you to list the teams which function on a "pooled" basis. 

When jobs are assigned to a "Pooled Team", any member of the team can grab the job or
assignment. 

Once a member has booked or selected the job/assignment, then no one else in the team can
select it. 

Entry and Display fields

Team Name: Select the name of the Mobility Team (from the drop-down list) which will function as
a "Pooled Team".

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new for entry of another Mobility Team name.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.
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8.16.6 Fixed Time Template

Fixed Time Template allows you to pre-define all the fixed time slots associated with a
Fixed Time Template name. You can define multiple time slots for one or more names.

Entry and Display fields

Fixed Name: Enter a Name for the Fixed Time Template.

Start Time: Enter the Start Time of the time slot.

End Time: Enter the End Time of the time slot.

Normally, you would have multiple time slots associated with each Fixed Name.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.7 Guide Groups

Guide Groups setting allow you to define the names of Guide Groups which can be used when
organizing Guide Packs  for Freeway app. 

On the Freeway App is a Guides button which provide access to Guides provided as part of a
Freeway Solution. Each Freeway user can be assigned a Guide Pack which is a collection of
Guides organized into Groups.

Entry and Display fields

Group Name: Enter the name of the Guide Group.

Group Seq: Enter the sequence number of the Guide Group.

Group Description: Enter the description of the Guide Group here. 

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.8 Find Groups

Find Groups setting allow you to define the names of Find Groups which can be used when
organizing Find Packs  for Freeway users. 

On the Freeway App is a Find button which provide access to Find Catalogues and Find
Information provided as part of a Freeway Solution. Each Freeway user can be assigned a Find
Pack which is a collection of Find Definitions organized into Groups.

Entry and Display fields

Group Name: Enter the name of the Find Group.

Group Seq: Enter the sequence number of the Find Group.

Group Description: Enter the description of the Find Group here. 

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.9 Template Groups

Template Groups setting allow you to define the names of Template Groups which can be used
when organizing Style Templates. 

Entry and Display fields

Group Name: Enter the name of the Template Group.

Group Seq: Enter the sequence number of the Template Group.

Group Description: Enter the description of the Template Group here. 

Buttons
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Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.10 Statistic Groups

Statistic Groups setting allow you to define the names of Statistic Groups which can be used when
defining Score Card Statistics in Inquiry Packs. 

Entry and Display fields

Group Name: Enter the name of the Statistic Group.

Group Seq: Enter the sequence number of the Statistic Group.

Group Description: Enter the description of the Statistic Group here. 

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.11 Corrective Action Styles

The Corrective Action Style Matrix screen defines what types of actions can be initiated while
working on a Freeway template. 

A Corrective Action could be just raising a Call Ticket to ensure a customer query is followed up; or
it could involve a Call Ticket linked to a Job Order for additional work to be done; or  a Call
Ticket linked to a Sales Quote requested by the customer for additional requirements.

More explanation on the concept of Corrective Actions can be found here: Corrective Actions
Explained

http://ostendo.info/downloads/ostendo/Freeway_Corrective_Actions_Explained.pdf
http://ostendo.info/downloads/ostendo/Freeway_Corrective_Actions_Explained.pdf
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Entry and Display fields

Corrective Style: Enter a descriptive name for the Corrective Action Style. 

Action Type: Select one of these: 
Ticket Only  ,  
Quote Only  ,
Order Only  ,
Ticket and Order  ,
Ticket and Quote

Default Description: Enter a description for this Style.

Job Type: Select the job type if an order is to be raised.

Job Category: Select the Job Category if  a job order is to be raised.

Ticket Style: Select a user-defined Ticket Style. These are created from CRM->Settings->Call
Style and dictates the Pipeline and Action Stages relevant for the ticket when it is created. .

Ticket Classification: Select one of the pre-defined ticket Classification. These are defined in
CRM->Settings->Call Classifications.

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new matrix line.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected matrix line.

8.16.12 Notify Groups

Notify Groups setting allow you to define the names of Notify Groups which can be used when
organizing Notify messages for Freeway app. 

On the Freeway App is a Notify button which allows the Freeway user to send pre-defined
notification messages to others. 

Entry and Display fields

Group Name: Enter the name of the Notify Group.

Group Description: Enter the description of the Guide Group here. 

Mandatory: Tick the box if this is  a mandatory group.
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Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.13 Print Names

Mobility Print Names allows you to list different types of print outputs you wish to use with your
Style Templates. 

The standard html output can be completely replaced by another customised version if required.

Entry and Display fields

Print Name: Enter a Name for this type of print output. (Must not include and special characters
like "/", etc.)

Default Email To: Select either Internal or External. 
Internal - means by default, this print output will be emailed to an Internal email address (refer to
Employee Mobility settings).
External - means by default, this print output will be emailed to the Customer's email address (also
CCed to the default Internal email address).

Override HTML Code: Enter the HTML Code you want to use to replace the default HTML for this
Print Name. This allows you to design your own HTML for this Print Name output.

Email Audio Files: Tick this box if Audio File is to be emailed.

Email Image Files: Tick this box if Image Files are to be emailed.

Display Prices: Tick this box if you want the html output to include prices.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.



338 Ostendo Reference Guide

Delete: This enables you to delete the selected line.

8.16.14 Mobility Outputs

Mobility Outputs allows you to define the override HTML contents of the print output for one or
more sections.

Entry and Display fields

Print Name: Select the Print Name whose standard html output is to be modified.

Type: Select the output type to modify. (CHECKLIST / IMAGES / TIMES / MATERIALS /
SIGNATURE / SKETCH / ASSET / INFO)

Click the Save button to save the record first before modifying the default HTML.

HTML Code: Depending on the Type you selected, the default HTML code will be populated when
the record is saved. This code defines how the type (or section) of output is displayed in the
browser. 
You can now alter this default code as per your requirements (font size, bold, etc.). 

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.15 Mobility Paths

Mobility Paths allows you to specify the full Universal Naming Convention (UNC) path for each of
your mapped drives. 

This is required to ensure that the Freeway app can access the linked documents which may be
stored in mapped drives.  

Entry and Display fields

Mapped Drive: Enter the drive letter here.

Server Path: Enter the UNC path of the mapped drive. The format would be :
\\ComputerName\SharedFolder\Resource 
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Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.16 Job Info Fields

Job Info Fields allows you to add any other Job Header record fields to be displayed in the mobile
app - Job Inquiry function. 

Use this to add fields which are not part of the default fields included in Job Inquiry.

Entry and Display fields

Field Name: Select the name of the Job Header field to be included in the display.

Field Caption: Enter the desired caption for that field.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.17 Planned Job Line Info

Planned Job Line Info allows you to add any other job line fields to be displayed in the mobile app.
The default fields that are always displayed in Planned Lines are LineNumber, LineCode,
LineDescription. 

Entry and Display fields

Field Name: Select the name of the Job Line field to be included in the display.
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Field Caption: Enter the desired caption for that field.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.18 Customer Info Fields

Customer Info Fields allows you to add any other Customer master record fields to be displayed in
the mobile app - Customer Inquiry function. 

Entry and Display fields

Field Name: Select the Customer Master field to be included in the display.

Field Caption: Enter the desired caption for that field.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.19 Asset Info Fields

Asset Info Fields allows you to add any other Customer Asset record fields to be displayed in the
mobile app - Asset Inquiry function. 

Entry and Display fields
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Field Name: Enter the name of the Customer Asset Master field to be included in the display.

Field Caption: Enter the desired caption for that field.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.20 Supplier Info Fields

Supplier Info Fields allows you to add any other Supplier master record fields to be displayed in the
mobile app - Supplier Inquiry function. 

Entry and Display fields

Field Name: Select the Supplier Master field to be included in the display.

Field Caption: Enter the desired caption for that field.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.21 Assembly Info Fields

Assembly Info Fields allows you to add any other AssemblyHeader record fields to be displayed in
the mobile app - Assembly Inquiry function. 

Entry and Display fields
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Field Name: Select the AssemblyHeader field to be included in the display.

Field Caption: Enter the desired caption for that field.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.22 Delivery Info Fields

Delivery Info Fields allows you to add any other SalesDeliveryHeader record fields to be displayed
in the mobile app - Delivery Inquiry function. 

Entry and Display fields

Field Name: Select the SalesDeliveryHeader field to be included in the display.

Field Caption: Enter the desired caption for that field.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.23 Linked Table Info Fields

Linked Table Info Fields allows you pull fields from any table linked to Customers/Suppliers/Jobs/
Assemblies/Deliveries/Assets to be displayed in the mobile app Inquiry function. 
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Entry and Display fields

Link Style: Select the style (Customer / Supplier / Job / Assembly / Delivery / Asset).

Linked to Field Style: Select either "Primary Field" or "Sysuniqueid". 
Primary Field means you are using the PRIMARY KEY of the base table (e.g.
CUSTOMERMASTER - CUSTOMER) to 
link with a similar field in the table where your linked fields are coming from.

SYSUNIQUEID means you are using the SYSUNIQUEID of the base table (e.g.
CUSTOMERMASTER - SYSUNIQUEID) to link with a similar field in the other table.

Source Table Name: Enter the name of the table where the data is coming from.

Source Key Field: Enter the key field to be used to link the table. This field must match the style
selected for the base table. If the base table and the data source table has a one-to-many
relationship, then only the latest record will be pulled back. 

Source Data Field: Enter the Fieldname to be included. each record in this grid allow you to define
one field. Use multiple records to define multiple fields (or use Multi Field Names).

Field Caption: Enter the desired caption for that field.

Multi Field Names : Instead of a single field, you can concatenate several fields together to
display as one string. Enter the concatenated fields here.
Example: CONTACTNAME || ' ph: ' || coalesce(CONTACTPHONE,'')

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.24 Mobility Captions

Mobility Captions allows you to modify the captions and instructions for the New Button menu on
the mobile device.  

Use this if the default captions and instructions are not suitable. 
You can modify one or more of the New button menu items.  

Entry and Display fields

Menu Item: Select the Menu Item from the drop-down list. Options are: DISPLAYCUSTOMERS 
DISPLAYSUPPLIERS
DISPLAYJOBS
DISPLAYASSEMBLIES
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DISPLAYDELIVERIES
DISPLAYPURCHASES
DISPLAYCOUNTS
DISPLAYINTERNAL

Menu Item Instruction: Enter a brief instruction for this menu item. The instruction is displayed
above the Caption in the Freeway screen.

Menu Item Caption: Enter the desired caption for that menu item.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a new line for entry of another record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

8.16.25 Mobility Barcode Rules

We plan to make barcode scanning a bit more intelligent than merely another means of data input.
By scanning a barcode, the Freeway app will know what type of entity was scanned and perhaps

proceed to the next logical step.

For example, in a manufacturing environment, you start by scanning an Assembly barcode.
Freeway knows that you are starting an Assembly.
Later, when you scan the same Assembly barcode again, Freeway can be set to assume you have

completed this Assembly datasheet. 
Or, if you scan another Assembly barcode, Freeway can be set to assume you have finished the

previous Assembly datasheet and now starting another Assembly.

With these Mobility Barcode Rules, you can specify the desired field to be used for each type of
entity for scanning purposes. 

This gives Freeway the ability to know what type of entity is being scanned and perhaps what to
expect next.

Entry and Display fields

Product Barcode Style : Select one option: No Barcode / Barcode / Product code / SYSID. 
Products can be uniquely identified by the BARCODE field or the Product Code (e.g. ITEMCODE
field)  or the SYSUNIQUEID. Choose one of these to be the mobility barcode. 

Customer Barcode Style : Select one option: No Barcode / Membership Number / SYSID
Customers can be uniquely identified by Membership Number or Sysuniqueid. Choose one of
these to be the mobility barcode.  

Supplier Barcode Style : Select one option: No Barcode / SYSID
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Suppliers can be uniquely identified by Sysuniqueid.

Job Barcode Style : Select one option: No Barcode / SYSID
Job Tasks can be uniquely identified by JOBTASKS Sysuniqueid.

Assembly Barcode Style : Select one option: No Barcode / SYSID
Assembly Steps can be uniquely identified by ASSEMBLYSTEPS Sysuniqueid.

Delivery Barcode Style : Select one option: No Barcode / Delivery No. / SYSID
Deliveries can be uniquely identified by Delivery number or Sysuniqueid.

Customer Asset Barcode Style : Select one option: No Barcode/ AssetNo / AssetName /
SYSID
Customer Assets can be uniquely identified by Asset Number, Asset Name, or Sysuniqueid.

Location Barcode Style : Select one option: No Barcode/ Location barcode / SYSID
Product locations can be uniquely identified by Location barcode or Sysuniqueid.

Employee Barcode Style : Select one option: No Barcode/ Employee Number / SYSID
Employees can be uniquely identified by employee number or Sysuniqueid.

Selecting “No Barcode” for any of the above Styles means that style will have to be manually
selected.

If the same barcode number applies to more than one style, then Freeway will ask the user to
choose the applicable style at the point of scanning. 

8.16.26 Mobility Rules

With these rules, you can stop automatic posting to Service Jobs or Sales Orders when data is
synchronized with the host. 

You can also specify whether editing or deletion of the uploaded sheets is allowed.

The Registered Company Allows you to display the name of your company in the main menu of
the Ostendo Freeway Service.

Entry and Display fields

No Automatic Data Sheet Posting: Tick this Check Box if you wish to stop the automatic posting
of actuals to jobs when DataSheet is uploaded to Ostendo..

Allow Data Sheet Editing: Tick this Check Box if you wish to allow the DataSheet contents to be
edited after it has been uploaded to Ostendo.

Allow Data Sheet Deletion: Tick this Check Box if you wish to allow the deletion of DataSheet
records (i.e. not stored permanently)

Registered Company: Enter the name of the company to be displayed in the "Registered to" field
in the mobile app main menu.

Mobility License Code: Load the license key from your Freeway License File (.flf).
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Notes: The Ostendo API Service must be activated/re-started AFTER the Mobility License Code
is loaded.

The Mobility App can connect to Ostendo either via wifi - Local Area Network (LOCAL) or
via the internet/WAN (REMOTE). This preference is specified in the Configuration Values of the
Freeway app.

For REMOTE connection, you will need to get the IPv4 address of your Ostendo server
and set up Port Forwarding on your router so that all calls to that API port will be forwarded to the
Ostendo server correctly.

When the Mobility License Code (Mobility Key) is updated in Mobility rules,Ostendo will
keep both the new Mobility Key and the previous key. This means a Freeway user in the field will
not be impacted as Ostendo will automaticaly update their key to the new one if the user's Mobility
Key is the previous one. If the Freeway user have not synced his device for a while, and there is
more than one change of Mobility Key, then he will not be automatically updated with the new key.
He needs to get a new FastCode in order to load in the new Mobility key.     

Employee Locations - Refresh Interval (Minutes): This setting refreshes the Employee
Locations display in the specified minutes.

Employee Locations - Horizon (Hours back): This setting determines how far back in time
(hours) the app will retrieve the employee's location data.

Company Cross Reference Style : Cross Reference checking is used when the Freeway app is
used to create new Customer or Supplier records. This check helps to prevent creation of
duplicate customer/supplier records. 

Select one of the following Options: 
Match Name OR ANY Cross Reference - either the name or any of the Cross

Reference selected below matches
Match Name AND ANY Cross Reference - both the name AND any one of the

Cross Reference selected below must match
Match ANY Cross Reference Only - any of the Cross Reference selected

below matches
Match EVERY Cross Reference Only - ALL the Cross References selected

below must match
Match Name AND EVERY Cross Reference - Both the Name and ALL the Cross

References selected below must match
Match Name Only - Only the Name is matched

Check Mobile in Cross Reference : The Mobile number is used for cross reference checking.

Check Phone in Cross Reference : The Phone number is used for cross reference checking.

Check Email in Cross Reference : The Email address is used for cross reference checking.

Create Data Sheet Linked Docs From : Select the date when Data Sheet pdf Documents will
begin to be automatically created and linked to the respective
Jobs/Assembly/Sales/Purchase/Invoice. 
(There must also be a Parent Folder Path specified in General Rules and a DataSheet Queue
type defined in Queue Schedule before this automated process is triggered.)

Default ReStock Supplier : Select a Supplier as the default for the "New ReStock Order" internal
data sheet.

Long Description Label : Specify the default Long Description label for Item Mobility and Web
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and Descriptor Mobility and Web.

Specification Label : Specify the default Specifications label for Item Mobility and Web and
Descriptor Mobility and Web.

Features Label : Specify the default Features label for Item Mobility and Web and Descriptor
Mobility and Web.

Picking Sequence : Select the default option for Picking (Sales Deliveries / Jobs and
Assemblies). Options are:

Location Sequence (on Location Master)
Product Sequence (on Item Master -> Additional Inventory Settings)
Delivery Line No (Sales Delivery)
Line No (Sales Order / Job Order or Assembly Order)

NB: The Options “Delivery Line No” and “Line No” are treated as the same, this is because the
Line No option was added into an Update after the initial release of this feature)

Expiry Days Remaining for Picking : Specify the default number of days to expiry date. Items
with expiry dates must meet both this requirement and the Customer's requirement  before it can
be picked. 

Job Note Source : Select either Job Instructions  or  Work Instructions.
In the Job Orders Detail screen - Instructions section, you now have two separate Instructions (Job
and Work). One can be used for internal only and the other can be sent to the mobile devices. This
rule allows you to decide which would be sent to the mobile devices as job notes.

No. of Remaining Count Lines to Display : Enter the number of remaining Count Lines you wish
to display on the mobile device at any one time.(Default is 50 lines when not specified.) (NB:
maximum number of lines = 200. Anything greater will be ignored and 200 will be used instead.)

No. of Counted Count Lines to Display : Enter the number of counted Count Lines you wish to
display on the mobile device at any one time. (Default is 50 lines when not specified.) (NB: There
is no limit placed on Counted lines.)

Display Counted Lines Style : Select either "All Counted Lines"  or  "Only Employee Counted
". 
This rule decides whether the mobility user will be able to see all lines already counted (by
everyone) or only his own counted lines.

Customer Note Source : You now have two sets of notes in the Customer Notes section. This is
to provide you the flexibility to specify which set of notes will be displayed as part of Customer
information on the mobility device.  Select either General Notes  or  Mobility Notes.

Supplier Note Source : You now have two sets of notes in the Supplier Notes section. This is to
provide you the flexibility to specify which set of notes will be displayed as part of  Supplier
information on the mobility device.  Select either General Notes  or  Mobility Notes.

Fast Code Expiry Hours : Enter the default number of hours (from 1 to 72) before a generated
Fast Code expires.

Store Hazards added Remotely : Tick this box if you wish to update the Customer hazards when
new hazards are recorded with Freeway app. 

Additional Materials B2B Conditional Style : Select either "Ignore Item and Descriptor B2B
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Include Flag"  or  "Filter Items and Descriptors where B2B Include Flag is True". 

Include Multiple Item Units : Tick this box if you wish to display multiple UOM (if exists) for the
items in Freeway.

Assigned Transfer Horizon Days : enter the number of days for the Assigned Transfer horizon.
This global rule specifies how far Freeway needs to review stock requirements of assigned jobs for
all employees. If this entry is left Blank, Freeway will only look for jobs assigned 1 day out. 
NB: There is also an override “Assigned Transfer Horizon Days” setting on the Settings Tab of the
Style Template. This takes precedence over the value in the Mobility Rules.

Start Day for Assigned Work : This rule tells Freeway to only look at assigned jobs with a Start
Day from either the “Current Day” (Today onwards + Horizon Days) or the Next Day (tomorrow +
Horizon Days) (Default is “Current Day”)

Map API Key : Enter the API key provided by Google Maps subscription service here. This will
enable the Employee Location function.

Information is available from:

Costs:

https://developers.google.com/maps/billing/understanding-cost-of-use

Obtaining An API Key:

https://developers.google.com/maps/documentation/embed/get-api-key

User Guide

https://cloud.google.com/maps-platform/user-guide/

Background Style : Default (new style) or Classic (original Freeway background style).

Button Style : Black (default), White, or Classic (original Freeway button style).

Button Transparency : From No Transparency to 90 percent in steps of 10% (default is 40%).

Use Assignment Captions for Lookups : Tick this box to use Assignment Captions in Lookups.

Assignment Captions are defined from Requirements->Settings->Assignment Captions (Caption
Type “SUBJECT”) 
This rule allows these Captions to apply to both Assignment Board and Non Assignment Board
assignments depending upon how you are deploying assignments to the Mobility user.

Dynamic Job Checklist from Notes : Tick this box if jobs can have Dynamic Checklists defined
in the notes section.

Dynamic Assembly Checklist from Notes : Tick this box if Assembly Orders can have Dynamic
Checklists defined in the notes section.

Dynamic Delivery Checklist from Notes : Tick this box if Delivery Orders can have Dynamic
Checklists defined in the notes section.

Dynamic Start Phrase for Checklist items : Enter any unique string in your Notes section that
will denote the start of your checklist definitions. The default string is {Checkist}. 

Dynamic End Phrase for Checklist items :  Enter any unique string in your Notes section that will

https://developers.google.com/maps/billing/understanding-cost-of-use
https://developers.google.com/maps/documentation/embed/get-api-key
https://cloud.google.com/maps-platform/user-guide/
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denote the end of your checklist definitions. The default string is {End}

Dynamic Item Bullet Character : Enter any unique character to denote the start of each checklist
item.The default character is "-". 

Dynamic Job Checklist from : Select either "Job Instructions" or "Work Instructions" to
indicate where the dynamic checklist will be defined.

The idea behind this is that you may want to include some specific Checklist items in your Style
Template to the mobility user when they create the Datasheet for this specific Job, Sales Delivery
or Assembly Order.
An example of this is where you may have defined a standard checklist in the Style Template,
however for this specific job you require the mobility user to capture some specific data relating to
this order.

Syntax to be entered into the relevant Instructions field on the Job / Assembly or Delivery
(NB: For convenience, these could be predefined in General->Frequently Used Text)

Keywords (case insensitive) for determining Checklist Item Type

o 'PHOTO', ‘IMAGE’, ‘PICTURE’, ‘PHOTOGRAPH’ = PhotoNote

o ‘DATE’ = Date

o ‘TIME’ = Time

o ‘QUANTITY’, ‘QTY’ = Integer

o ‘NUMBER’, ‘VALUE’ = Number

o ‘CHECK’ = CheckBox

o ‘NOTE’, ‘NOTES’ = Memo

o ‘SIGN’, ‘SIGNATURE’ = Signature

o ‘LIST (value1,value2,value3...)’ = List 

o ‘GPS’ = GPS

o If there is no key word then the Type is assumed to be Text

o You are also able to set the Check Item to mandatory using the "must" keyword
in your checklist item.

o Syntax of the List keyword is List (value1,value2,value3…) – where the opening
and closing brackets are the list start and end, and each list value is delimited by a
comma. 

o Refrain from using more than one keyword per checkllist item. If there are multiple
keywords in the same checklist item, only the first keyword will be selected.
For example: - Please sign and date the record.  -  there are 2 keywords in this
sentence; but only "sign" will be taken as a keyword and only a signature is
expected for this item.

Ensure you define a Template Type of “DYNAMICCHECKLIST” in the Style Template
to be used

Dynamic Checklist Syntax Example: (Not case sensitive)

An example is as follows to be typed into Order Notes / Instructions:

{checkList}
- you must take a picture of the washing machine
- please record the date of the work
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- enter the time when the work as done
- take another photo

- you must enter some notes
{end}

Job Material Posting: The options are: Job direct (default) - The issue of materials from
Freeway will be posted directly to the job.

Job Transactions. - When the Datasheet is returned to
Ostendo, a Job Transactions batch will be created (InProgress) first. This allows a back-office user
to authorize and post the material issues to the job.

Assembly Material Posting: The options are: Assembly Direct (default) - The issue of
materials from Freeway will be posted directly to the Assembly Order.

Assembly Issues  - When the Datasheet is
returned to Ostendo, an Assembly Issues batch will be created (InProgress) first. This allows a
back-office user to authorize and post the material issues to the Assembly Order.
 

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

License: Press this key to load the new Mobility License Code into Mobility Rules. You then have
two options:

- Update Cloud Record:  This Option will update the cloud record. If updated, all mobile
devices with the current licence code from here on will use the host/ip addresses
configured for the API service that is connected to this Ostendo database. This option is
appropriate for updating an expired/expiring licence code

- Update Ostendo Database Only:  This Option will only update the Ostendo database
with the new licence code. This option is appropriate for consultants who are testing mobile
devices with a clients database and want to change the licence code to their own without
changing the clients cloud record.
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9 Labour

9.1 Employees

This screen allows you to maintain a file of Employees.  These Employees are referenced
extensively throughout Ostendo.  Each Employee record contains details of:

· Name and contact details
· Type of Employee
· Normal Cost and Charge rates
· Emergency Contacts details
· HR Details (Holidays, Sickness, Qualifications)

List Tab

Display fields

The displayed fields are taken from the Employee details entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Employees
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Employee screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Employee.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel
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Delete: This removes the current Employee from this table

Related: This will bring up a list of functions that are related to the Employee.  You may open and
maintain information in those screens whilst still remaining in the Employee screen.

Reports: This will bring up a list of Reports that are related to the Employee.  You can immediately
run the report whilst still remaining in the Employee screen.

Detail Tab

Entry and Display fields

Employee Name: Entry is only allowed during an Add transaction.  Enter the name of the new
Employee.  

Employee Number: Enter the Employee’s Staff reference Number.  Duplicate Employee Numbers
are not allowed

Start Date: Enter the Employees Start Date or select the Date from the drop-down calendar

Status: Select the current status from the drop-down list.  The options are ‘Active’ or ‘Inactive’

Classification: From the drop-down list select the current classification of the Employee.   The
options are Full-Time, Part-Time, Contract, or Sub-Contractor.
Employees defined for (Ostendo Freeway) Subcontractors must be classified as Sub-Contractor
and linked to the appropriate Supplier in the Sub-Contractor Supplier field.

Qty: If this resource name have multiple quantities, then enter the quantity here.

Assignment Image: Select the image that represents this Resource. This will be used in the
Assignment Board.

Employee Details

Title: Enter the tile (Mr, Mrs, Ms, etc) that applies to the Employee.  No validation checks will be
carried out on this entry

First Name: Enter the First or Forename of the Employee.  No validation checks will be carried out
on this entry

Last Name: Enter the Last or Surname of the Employee.  No validation checks will be carried out
on this entry 

Position: Enter the current position being held by the Employee.  No validation checks will be
carried out on this entry

Department Code: From the drop-down list select the Department Code to which the Employee
belongs.  Departments are user-maintained under General>Settings>Departments.

Calendar Order: Select the position (commencing from 0) that determines where this Employee
will appear in the Job Calendar

No Scheduling: If this is 'checked' then this Employee will not display in the Shop Calendar or
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Assignment Board.  This is primarily used for Employees that have left the company but you wish
to retained that employees history

Phone: Enter the telephone number of the Employee.  No validation checks will be carried out on
this entry

Fax: Enter the Facsimile Number of the Employee.  No validation checks will be carried out on this
entry

Mobile: Enter the Mobile Telephone Number of the Employee.  No validation checks will be
carried out on this entry

Email: Enter the Email address of the Employee.  No validation checks will be carried out on this
entry

Sub-Contractor Supplier: Select the Sub-Contractor or Supplier this resource is linked to. This
will indicate that this is a subcontractor employee.

This Employee is a Salesperson: If this Employee is a Salesperson then ‘check’ this checkbox.
This Employee will then be available for selection when creating or maintaining a Sales order.

This Employee is a Buyer: If this Employee is a Buyer then ‘check’ this checkbox.  This
Employee will then be available for selection when creating or maintaining a Purchase order.

Employee is used to Post Timesheet entries for Asset: Select the Asset that requires
timesheet data to be captured. If there is a requirement to record times when an Asset is used, this
feature facilitates that. Since timesheet data are captured only for employees, such data can be
captured for an Asset by creating a "dummy" employee and using this feature to link it to that
Asset, 

Employee Unit Cost: Enter a Unit Cost per hour that will be incurred by this Employee.  This base
Unit Cost will be used as a basis for actual cost accounting throughout Ostendo
This is the Direct Cost associated with the Employee. For Subcontractors, this is the cost charged
to the company for each hour of service performed by the subcontractor. 

Default Labour Code for Charging: Select a Labour Code from the drop-down list.  The list of
available Labour Codes is linked to the Employee via the ‘Labour Codes’ tab described below

Default User for Reminders: Any ‘Alerts’ that are linked to this User Sign-on Code will be
displayed to this Employee.  From the drop-down list select the Sign On User code that is to apply.

Assignment Priority : Enter the relative Assignment Priority of this employee here. The higher the
number, the higher the priority. 

The Employee is a POS Operator: If this Employee is a POS Operator then ‘check’ this
checkbox. This Employee will then be available to use the Point of Sale facility.  If this is 'checked'
then you should also click on the 'Set Password' button to define a POS password to be used by
this employee.  

(Button) Set Password: This facility allows you to define or reset the Password that will apply to
POS Stations.  You should enter the password.  As the Password outputs as asterisks you are
required to re-enter it and the two entries are compared and, if the same, the password is
accepted.

Username: Display only field showing the name of the current signed-on User

Password: Enter the password.  It is recommended that this be a combination of alphas
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(combination of upper and lower case) and numerics.

Verify Password: As you cannot see the previous entry you are asked to input again to
validate that the entry is correct.  If both the New and Verify Passwords are the same then
the change is accepted.

(Button) OK:  The program validates that the New and Verify passwords are the same.  If
all is correct then the password will be updated.  If any errors are detected then a
message will be returned and the program exited

Default POS Sales Person: From the drop-down list select the Sales Person that will be the
attributed to Sales made by this Employee.   This Sales Person will be the default unless amended
at the time of Order entry

Pooling Team Name : If this employee belongs to a Pooling Team, select the Team name from
the drop-down list.

Can change POS prices: If this is ‘checked’ then this user will be able to amend the system
evaluated Sell price against Point of Sale Order Lines.  If not checked then changes will not be
allowed

Can change Sale Date: If this is ‘checked’ then this user will be able to amend the Date of the
Sale (This is normally prefilled with the System Date).  If not checked then changes will not be
allowed.

Can see POS Line Costs and Margins: If this is ‘checked’ then this user can see the POS order
Line costs and Sell Price margin.  If not 'checked' then this will not be visible.

Show the following POS related buttons: On the POS screen a series of buttons - linked to
related activities - are displayed down the right of the screen.  You can define which related
activities this Employee has access to.  The available buttons are:

· Inventory Availability
· Price Inquiry
· Customer Statistics
· Sales orders
· Images
· Payout
· History
· Cash Drawer
· End of Day

Create POS Payments Only : Tick this checkbox if this employee is restricted to create POS
Payments only.

Notes: You can enter unlimited amount of Notes that are related to this Employee.  These notes
will be available wherever the Employee record is accessed.  Whenever you click on this field
an icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that screen or
double-click the selected record.

Address and Emergency Contact Tab

This Tab allows you to record the Employees Home address and any emergency contact
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information

Address: Three lines are available for entry of the Employee’s Home address.  No checks are
made and this can be amended at any time.

Code: Enter the Postcode or Zone Improvement Program (ZIP) Code where this Employee
resides.

City: Enter the Town or City where this Employee resides.

State: Enter the State where this Employee resides.

Country: Enter the Country where this Employee resides.

Contact Name: Enter the Name of the main Contact in case of emergency.  No checks are made
and this can be amended at any time.

1st Contact Phone: Enter the first contact Telephone Number of the Contact

2nd Contact Phone: Enter the second contact Telephone Number of the Contact

HR Details Tab

This panel allows you to record HR information about the Employee

Annual Vacation Days: Enter the number of Annual Vacation Days that the Employee is allowed.
  You may also use the up/down arrows to help you enter this.

Annual Sick Days: Enter the number of Annual Sick Days that the Employee is allowed.  You may
also use the up/down arrows to help you enter this.

Qualifications and Skills: You can enter extensive notes (or copy from another document and
paste here) describing the Employee’s Qualifications, Training history, Skill, etc.  Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Employee screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Employee.  You may open and
maintain information in those screens whilst still remaining in the Employee screen.

Reports: This will bring up a list of Reports that are related to the Employee.  You can immediately
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run the report whilst still remaining in the Employee screen.

Capabilities Tab

This panel allows you to record the Employee's capabilities (example Certified skills/qualifications,
Driving License type, etc.)

Capability Name: Select from drop-down list of pre-defined Capabilities (As maintained via
Labour>Settings>Capability Types). An employee can have multiple capabilities. Add a record for
each capability.

Capability Expires: Tick this box if this Capability has an expiry date (example - license expiry). 

Capability Expiry: If the previous box is ticked, then enter the expiry date here.

Reference: Enter any reference information relating to this capability. E.g. Driving License
Number, Registration No., Certificate, etc..

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add another Capability record to this Employee.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Use this to delete the current highlighted line.

Related: This will bring up a list of functions that are related to the Employee.  You may open and
maintain information in those screens whilst still remaining in the Employee screen.

Reports: This will bring up a list of Reports that are related to the Employee.  You can immediately
run the report whilst still remaining in the Employee screen.

Additional Fields Tab

If you have defined Additional Fields against the Employee (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Absentee Days Tab
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This panel allows you to record details of all occurrences when the Employee was not available for
work. 

Entry and Display fields

Absentee Type:  Select the Type from the drop-down list.  The available options are Vacation,
Public Holiday, Sick, Training, Other.

Days: Enter the number of work-days included in this absence record.

From Date: Select the date - from the drop-down calendar - denoting when the absence began

To Date: Select the date - from the drop-down calendar - denoting when the absence ended

Reference: You can optionally enter a brief text to explain the absence

Buttons

Close: This will close the Employee screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: The cursor will go to a new line for entry of an Absentee record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the specific record was amended or the last time the ‘Save’
Button was pressed will be lost.

Delete: This will delete the current selected Absentee record

Related: This will bring up a list of functions that are related to the Employee.  You may open and
maintain information in those screens whilst still remaining in the Employee screen.

Reports: This will bring up a list of Reports that are related to the Employee.  You can immediately
run the report whilst still remaining in the Employee screen.

Labour Codes Tab

Lines in Job Orders that can be defined as Labour Code because, at the time when the Job Order
is raised, the specific Employee to do the work may not be known.  The Labour Code contains
nominal Costs for quoting and planning purposes.   When an Employee makes a time booking
against a ‘Labour Code’ line then the ‘Actual Cost’ of that time is taken from the relationship
between the Labour Code and the Employee that carried out the work.  This relationship between
Employee Costs and the Labour Code is defined here

Entry and Display fields

Labour Code: Select a Labour Code from the drop-down list.  Labour Codes are maintained via a
separate screen.

Direct Labour: Display only field that shows the Employee Unit Cost as entered into the ‘Detail’
screen.

Fixed Overhead Value: If you have a fixed monetary recovery rate per Unit then enter a value
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here.  This value will be added to the Direct Labour Cost and Variable O/H % to give the Total Cost
per unit. 

Variable O/H %: If you have Overhead recovery based on a percentage of the Direct Labour Cost
then enter a percentage figure here.   The calculated value will be added to the Direct Labour Cost
and Direct Labour Cost to give the Total Cost per unit. 

Total Cost per Unit: This is the total Cost per Unit for this Employee when work is carried out
against this Labour Code.  The Total Cost per Unit is calculated from Direct Labour Cost +
Variable O/H % + Fixed Overhead Value. 

Buttons

Close: This will close the Employee screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: The cursor will go to a new line for entry of an Employee/Labour Code record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the specific record was amended or the last time the ‘Save’
Button was pressed will be lost.

Delete: This will delete the current selected Employee/Labour Code record

Related: This will bring up a list of functions that are related to the Employee.  You may open and
maintain information in those screens whilst still remaining in the Employee screen.

Reports: This will bring up a list of Reports that are related to the Employee.  You can immediately
run the report whilst still remaining in the Employee screen.

9.1.1 Employee Properties

This screen allows you to define properties that are specific to an Employee.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Employees.

Display fields

The displayed fields are taken from the Employee Details.  The selection of which fields to display
here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Employee Properties screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Employee Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Employee Name: Display only field showing the Employee selected in the List screen

Employee Number: Display only field showing the ID Number of the Employee selected in the List
screen

Status: Display only field showing the status of the Employee selected in the List screen

First Name: Display only field showing the First Name of the Employee selected in the List screen

Last Name: Display only field showing the Last Name of the Employee selected in the List screen

Property: From the drop-down list select the Standard Property (as maintained via
General>Settings>Standard properties) against which a value specific to this Employee will be
made.

Value: Enter a value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    



360 Ostendo Reference Guide

Buttons

Close: This will close the Employee Property screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Employee Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Employee Property record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Employee Property record.

9.1.2 Employee Documents

This screen allows you to define documents, etc that are specific to an Employee.    

List Tab

Display fields

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Employee to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Employee Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Employee Documents.

Save: Not applicable to the List panel
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Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from an Employee record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name of the document that you are creating in this
Document-Employee linkage.  No checks are made on the entry.

Document Type: Prefilled with ‘Employee’

Linked to: From the drop-down list select the Employee that uses this document

Correspondence: Tick this box if this document is to be treated as correspondence in Operations
Centre usage.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:- .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Employee Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Employee Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Employee Documents record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

9.1.3 Employee Images

This function allows you to link Images to an Employee.    

List Tab

Display fields
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Image Name: The name of the Image as entered into the Details screen,

Linked To: This is the specific Employee to which this Image relates.

File Name: This is the full path name of the Image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Employee Images screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Employee Images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Image from an Employee.

View: If you select a line and then this button the Image will be displayed using your default Image
display software. 

Detail Tab

Entry and Display fields

Image Name: Enter the name that you are calling the Image on this Image - Employee linkage.  
No checks are made on the entry.

Image Type: Prefilled with ‘Employee’

Linked to: From the drop-down list select the Employee that uses this Image

Image Details: locate the full path name of the Image.  It should be noted that the file extension
must be an image format (I.e. .jpg, .bmp, .ico, .wmf, .emf)

Preview: The selected Image is displayed for your reference
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Buttons

Close: This will close the Employee Image screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of an Employee Image record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Employee Image record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

9.1.4 Employee History Notes

This function allows you to link multiple time-stamped notes to an Employee record.    

List Tab

Display fields

The displayed fields are taken from the Labour/Employee master record.  The selection of which
fields to display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in
the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Employee History Notes screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Detail Tab
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Entry and Display fields

The Employee to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Mobile Employee : Select the Mobile employee name to make this History Note available to that
employee.

Call Classification: From the drop-down list select a Classification under which you wish to store
this History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.  Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this Employee is displayed in the lower part of the screen.
Each record will also have the first 3 lines of the notes displayed.  To view the full Notes simply
click on the history record and the details will be displayed in the upper part of the screen.

Buttons

Close: This will close the Employee History Notes screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of an Employee History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Employee History Notes record or the last time the ‘
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Save’ Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

9.2 Employees Cost Matrix

The screen is designed for override employee costs for different combinations of labour codes,
customers and orders. These override costs are then used when posting employee time entries to
jobs and assemblies. 

Entry and Display fields

Order Class: This can be one of (‘Job’, ‘Assembly’ or ‘Job and Assembly’ )

Rate Scale: This is the employee rate scale that applies to the rule

Employee Level: This can be one of (‘All Employees’, ‘Employee’ or ‘Employee Department’)

Employee Level Selection: This is the value that relates to the Employee Level – blank for ‘All
Employees’

Labour Level: This can be one of (‘All Labour Codes’, ‘Labour Code’ or ‘Labour Department’)

Labour Level Selection: This is the value that relates to the Labour Level – blank for ‘All Labour
Codes’

Customer Level: This can be one of (‘All Customers’, ‘Customer’ or ‘Customer Type’)

Customer Level Selection: This is the value that relates to the Customer Level – blank for ‘All
Customers’

Order Level: This can be one of (‘All Orders’, ‘Project’, ‘Order Type’ or ‘Order Category’)

Order Level Selection: This is the value that relates to the Order Level – blank for ‘All Orders’

Direct Labour: This is the direct employee cost which can be edited so it is different to the cost
held against the employee record.

Fixed O/H Value: This is the fixed value of overhead expenses 

Variable O/H %: This percentage is used to calculate a value derived from the direct cost

Total Cost per unit: This is the calculated read-only cost from the Direct, Fixed and Variable
values 

9.3 Labour Codes

This screen allows you to maintain a file of Labour Codes.  Labour Codes are used extensively
throughout Ostendo to provide details of Labour used in Job Orders, Assembly Orders, and Task
Bills.  Each Labour Code record contains details of:

· Standard and Special Charge rates
· Standard Cost with Cost breakdown
· Whether Warranty applies
· Extensive notes for copying to various functional areas

Labour Codes can be associated with specific employees in the Employees screen. Employees
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can be either internal employees or subcontractors.
All employees should have a Direct Cost and Labour Codes associated with it.
Direct Costs associated with subcontractor employees should reflect their actual hourly charge
rate to the company.
For subcontractors, the Labour Mapping Matrix should be used to channel the financial credits to
an appropriate Cost Centre defined for the Subcontractor which is linked to a Subcontractor
Clearing Account in the General Ledger.

List Tab

Display fields

The displayed fields are taken from the Labour Code details entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.   To select the fields to display simply
‘right mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel you
can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Labour Codes
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Labour Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Labour Code.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Labour Code from this table

Related: This will bring up a list of functions that are related to the Labour Code.  You may open
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and maintain information in those screens whilst still remaining in the Labour Code screen.

Reports: This will bring up a list of Reports that are related to the Labour Code.  You can
immediately run the report whilst still remaining in the Labour Code screen.

Detail Tab

Entry and Display fields

Labour Code: Entry is only allowed during an Add transaction.  Enter the identity of the new
Labour Code.    Duplicate Labour Codes are not allowed.

You should be aware that, in Ostendo, the apostrophe (‘) is not allowed in ‘Key’ fields.  If the
Labour Code contains an apostrophe and it is keyed in then the program will replace it with a ‘
backwards’ apostrophe (found on your keyboard to the left of the number 1 key).

Unit: From the drop-down list select the Units.  These Units are User-maintained under
General>Settings>Standard Units.  Only those flagged as ‘Time Units’ will be displayed

Description: Enter a brief description of the Labour Code.   

Barcode: Enter a barcode to identify the Labour Code.  This can be used on shop-floor
documentation for time bookings.  No validation checks are carried out on what you enter here.   It
is suggested, therefore, that the Barcode reference is the same as the Labour Code.

Status: Select the current status from the drop-down list.  The options are ‘Active’ or ‘Inactive’

Labour Settings Tab

Category: Select a Category from the drop-down list.   Categories are User-maintained under
Inventory>Settings>Categories and enable you to select or analyse Labour Code by Category.  
   
Analysis Group: The Analysis Group allows you to analyse Inventory, Labour, and/or Descriptor
records.  It is also used in defining the presentation of the order lines when it is printed on a Quote,
Order, or Invoice associated with an ‘Actual Quantity’ Job Order.  The presentations are selectable
by Analysis Group and offer different format options to the above three documents.

No Grouping: All Lines within the Analysis Group will printed
Header and Footer:  A Header containing the name of the Analysis Group will be printed
followed by the Lines within the Analysis Group.  At the end of the Group a Footer record
will be printed showing a summarised total of the Analysis Group content
Group Totals Only: A single line will be printed showing the summarised total for the
Analysis Group.

Select the Analysis Group from the drop-down list.  Analysis Groups are User-maintained under
General>Settings>Analysis Groups.     

Department: From the drop-down list select the Department Code to which the Labour Code is
linked.  Departments are user-maintained under General>Settings>Departments.

Tax Group: Select a Tax Group from the drop-down list.  The Tax Group is linked to Customer
Tax Groups to define what Tax to charge.  Tax Groups are User-maintained under File>Financial
Configuration>Tax Groups.  

All Timesheet Entries create new Job or Assembly Lines:  If this checkbox is ‘checked’ then
each Employee Timesheet booking made against a Job or Assembly Order will create a new Line
in the Order.  If this is not ‘checked’ then each booking will be accumulated against the same
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Order Line.

Budget Tab

Representative Code for Budgets: You can use one Labour Code to represent some or all
Labour Codes for budgeting purposes. Select the representative Labour Code here that you wish
to represent this Labour Code. This means all actuals associated with this Labour Code will be
aggregated under the Representative Labour Code for Budget vs Actuals comparisons.. 

Additional Fields Tab

If you have defined Additional Fields against the Labour Code (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

 

Labour Rates & Costing

Standard Rate: Enter the basic Charge Rate per Unit that will be charged for this Labour Code. 
Variations from this charge rate can be addressed by clicking on the ‘Special Rate Details’ Button

Standard Cost: Enter the Standard Cost per Unit that will be incurred by this Labour Code.  This
will be used to evaluate planned cost and margins when planning Assembly and Job Orders. 
Alternatively, you may wish to break down the cost into Direct Labour Cost, Fixed Overhead and
Variable Overhead elements by clicking on the Standard Cost Breakdown Button

Capacity Settings

Daily Capacity in Hours: Enter the number of hours per day that are available to this Labour
Code.  This capacity is used to compare against the anticipated load generated from Jobs and
Assembly Orders that use this Labour Code.

This Code is Scheduled: If this Code is used in the Constraint Scheduling routine then 'Check'
this checkbox.  You should now click on the following button and complete the required fields

(Button)Scheduling Information: If this Code is used in the Constraint Scheduling routine then
you should review the following fields

· Always Swap with Code: If you are using a 'Group' Labour Code for Scheduling purposes
(Example this Resource is an individual machine that belongs to a Group of Machines and
the Group is used in the Constraint Scheduling routine) then you should select the 'Group'
Code from the drop-down list

· Capacity Type: Select the Capacity Type from the drop-down list.  The options are:
· Infinite - Resource Scheduling routine will not take any Capacity into account when

loading the activities.  However you can compare the required load against the available
capacity

· Finite - Resource Scheduling routine will take the Capacity into account when loading
the activities.  I.e. It will NOT load the Resource to more than its available Capacity
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· Continuous Operation: Some operations require continuous running – typically in the
process industries or where setup time is large. If you 'check' this checkbox then the activity
will only be loaded if there enough time to complete it continuously. 

· Efficiency %: Where a Resource or group of Resources is not performing to their standard
rates it might be necessary to adjust the efficiency, rather than adjusting all the bills of
material or job templates.  Therefore enter the efficiency that you wish to apply (Example
50% efficient means the activity will takes twice as long as the base time)

· Number of Resources: Enter the number of this Resource that is available for Scheduling
· Minimum Gap in Minutes: Where the Resource is NOT flagged as Continuous Operation

you can still define a minimum amount of time that must be available before this Resource
can be scheduled.  

· (Start and End Times): Enter the Start and End Times for each day of the week that this
Resource is available. 

After Sales Settings

Sales Warranty Applies: ‘Check’ this checkbox if you offer Warranty against task carried out
against this Labour Code.

(Warranty Code): When ‘Sales Warranty Applies’ is ‘Checked’ then this field becomes active.
From the drop-down list select the Warranty Code that applies to this Labour Code.

Notes: You can enter unlimited amount of Notes that are related to this Labour Code.  These
notes can specifically apply to the following areas where Labour Code is used:

· General Notes
· Sales Notes
· Job Notes
· Purchase Notes
· Assembly Notes

Whenever you click on these fields an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Messages: You can enter up to 200 characters of Text that will be displayed in a ‘Message Bar’
across the centre of the Order Lines screen in Sales, Job, Purchase or Assembly Order screen. 
This will be displayed in a Red font and is intended to attract the attention of the person entering
the Order Line with information relevant to the Labour Code being added. 

The content of the message line can be plain text or can include fields from the Labour Code
Master record.  These fields will be populated with the latest information held against the Labour
Code.  For example: You may wish to show the Last Cost for the Labour Code whenever you are
adding it to a Sales Order.  Therefore the text would be (say)

The Labour Code’s Last Cost was [LASTCOST]

This would display on the Order ‘Message’ Bar as 

The Labour Code’s Last Cost was $23.5

The fields in the square brackets are taken from the LABOURMASTER table.  To see the available
fields go to General>Reports>Full Listing of Tables and select LABOURMASTER

Buttons

Close: This will close the Labour Code screen.  If you have any unsaved data then you will be
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asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Labour Code.  You may open
and maintain information in those screens whilst still remaining in the Labour Code screen.

Reports: This will bring up a list of Reports that are related to the Labour Code.  You can
immediately run the report whilst still remaining in the Labour Code screen.

9.3.1 Labour Properties

This screen allows you to define properties that are specific to a Labour Code.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Labour Codes.

Display fields

The displayed fields are taken from the Labour Code Details.  The selection of which fields to
display here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons
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Close: This will close the Labour Code Properties screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Labour Code Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Labour Code: Display only field showing the Labour Code selected in the List screen

Description: Display only field showing the description of the Labour Code selected in the List
screen

Status: Display only field showing the status of the Labour Code selected in the List screen

Property: From the drop-down list select the Standard Property (as maintained via
General>Settings>Standard properties) against which a value specific to this Labour Code will be
made.

Value: Enter a value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Copy to Job Lines: Tick this box if the property value is to be copied to Job Lines.

Copy to Assy Lines: Tick this box if the property value is to be copied to Assembly Lines.

Copy to SO Lines: Tick this box if the property value is to be copied to Sales Order Lines.

Buttons

Close: This will close the Labour Code Property screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Labour Code Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Labour Code Property record or the last time the ‘Save’
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Button was pressed will be lost.

Delete: This enables you to delete the selected Labour Code Property record.

9.3.2 Labour Documents

This screen allows you to define documents, etc that are specific to a Labour Code.    

List Tab

Display fields

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Labour Code to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Labour Code Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Labour Code Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Labour Code record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields
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Document Name:  Enter the name that you are calling the document on this Document - Labour
Code linkage.    No checks are made on the entry.

Document Type: Prefilled with ‘Labour’

Linked to: From the drop-down list select the Labour Code that uses this document

Copy to Jobs: If this is ‘checked’ then the Image will be copied to all Job Orders raised against
this Labour Code.

Copy to Sales: If this is ‘checked’ then the Image will be copied to a Sales Order raised against
this Labour Code.

Copy to Assemblies If this is ‘checked’ then the Image will be copied to an Assembly Order
raised against this Labour Code.

Print / Email with order: Tick this box if this document is to be printed/emailed with the Order.

Print / Email with quote: Tick this box if this document is to be printed/emailed with the quote.

Correspondence: Tick this box if this document is to be treated as correspondence in the
Operations Centre.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Labour Code Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Labour Code Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Labour Code Documents record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

9.3.3 Labour Images

This function allows you to link Images to a Labour Code.

List Tab

Display fields
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Image Name: The name of the Image as entered into the Details screen,

Linked To: This is the specific Labour Code to which this Image relates.

File Name: This is the full path name of the Image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Labour Code Images screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Labour Code Images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Image from a Labour Code.

View: If you select a line and then this button the Image will be displayed using your default Image
display software. 

Detail Tab

Entry and Display fields

Image Name:  Enter the name that you are calling the document on this Image - Labour Code
linkage.  No checks are made on the entry.

Image Type: Prefilled with ‘Labour’

Linked to: From the drop-down list select the Labour Code that uses this Image

Copy to Jobs: If this is ‘checked’ then the Image will be copied to all Job Orders raised against
this Labour Code.

Copy to Sales: If this is ‘checked’ then the Image will be copied to a Sales Order raised against
this Labour Code.



375Labour

Copy to Assemblies: If this is ‘checked’ then the Image will be copied to an Assembly Order
raised against this Labour Code.

Image Details: locate the full path name of the Image.  It should be noted that the file extension
must be an image format (I.e. .jpg, .bmp, .ico, .wmf, .emf)

Preview: The selected Image is displayed for your reference

Buttons

Close: This will close the Labour Code Image screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Labour Code Image record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Labour Code Image record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

9.3.4 Labour History Notes

This function allows you to link multiple time-stamped notes to a Labour Code record.    

List Tab

Display fields

The displayed fields are taken from the Labour Code/Employee master record.  The selection of
which fields to display is at the user’s discretion.   To select the fields to display simply ‘right mouse
’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon
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Buttons

Close: This will close the Labour Code History Notes screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Labour Code to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Mobile Employee : Select the Mobile employee name to make this History Note available to that
employee.

Call Classification: From the drop-down list select a Classification under which you wish to store
this History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.  Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this Labour Code is displayed in the lower part of the screen. 
Each record will also have the first 3 lines of the notes displayed.  To view the full Notes simply
click on the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Labour Code History Notes screen.  If you have any unsaved data then
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you will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Labour Code History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Labour Code History Notes record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

9.3.5 Labour Override Times

This screen is accessed via the 'Related' button in the Labour Codes screen and allows you to
override the nominal Scheduling start and stop dates as entered via the 'Scheduling Information'
button in the Labour Codes screen.  This allows you to specify time variations relating to
nominated dates (example: Christmas Day, etcz)

List Tab

This displays the current list of Labour Codes.

Display fields

The displayed fields are taken from the Labour Code Details.  The selection of which fields to
display here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Labour Alternates screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.
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Detail Tab

Entry and Display fields

Labour Code: Display only field showing the Labour Code selected in the List screen

Unit: Display only field showing the Unit of Measure of the Labour Code selected in the List screen

Description: Display only field showing the description of the Labour Code selected in the List
screen

Analysis Group: Display only field showing the Analysis Group to which the Labour Code belongs

Status: Display only field showing the status of the Labour Code selected in the List screen

Standard Rate: Display only field showing the Standard Charge Rate of this Labour Code

Standard Cost: Display only field showing the Standard Cost of this Labour Code

(Override records)

Override Date: From the drop-down Calendar select the effective date of this override record

Start Time: Enter the Start Time from which this Resource is available. 

End Time: Enter the End Time up to which this Resource is available. 

Buttons

Close: This will close the Labour  Override Times screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Override Time record

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Override Time record or the last time the ‘Save’ Button
was pressed will be lost.

Delete: This enables you to delete the selected Override Time record.

9.3.6 Labour Alternates

This screen is accessed via the 'Related' button in the Labour Codes screen and allows you to
define alternate Labour Codes to be used with the current Labour Code.  

List Tab

This displays the current list of Labour Codes.

Display fields
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The displayed fields are taken from the Labour Code Details.  The selection of which fields to
display here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Labour Alternates screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

Labour Code: Display only field showing the Labour Code selected in the List screen

Unit: Display only field showing the Unit of Measure of the Labour Code selected in the List screen

Description: Display only field showing the description of the Labour Code selected in the List
screen

Analysis Group: Display only field showing the Analysis Group to which the Labour Code belongs

Status: Display only field showing the status of the Labour Code selected in the List screen

Standard Rate: Display only field showing the Standard Charge Rate of this Labour Code

Standard Cost: Display only field showing the Standard Cost of this Labour Code

Alternate Code: From the drop-down list select the alternate Labour Code that can be used.

Speed Percent: This defaults to 100% but can be amended here to any other percentage and
represents the efficiency of this Labour Code when used during Constraint-Based Scheduling.
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Load Balance For Schedule: If this is 'checked' then any overload on the main Labour Code will
be given to this Labour Code during Constraint-Based Scheduling.  Multiple entries can be made
here and each - in turn - will be used as an alternative to the main Labour Code.

Buttons

Close: This will close the Labour Alternatives screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of an Alternate Labour Code record

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Alternate Labour Code record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Alternate Labour Code record.

9.4 Labour Rates

This screen allows you to define multiple Charge Rates for a Labour Code.   This is achieved
through the use of ‘Charge Levels’.   A selected ‘Charge Level’ - and therefore a Charge Rate -
can be linked to a Customer whenever this Labour Code is used.

List Tab

Display fields

The displayed fields are taken from the Labour Code master record.   The selection of which fields
to display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Labour Codes
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
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records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Labour Rates screen. 

Related: This will bring up a list of functions that are related to Labour Rates.  You may open and
maintain information in those screens whilst still remaining in the Labour Rates screen.

Reports: This will bring up a list of Reports that are related to the Labour Rates.  You can
immediately run the report whilst still remaining in the Labour Rates screen.

Detail Tab

Entry and Display fields

Labour Code: Display only field showing the selected Labour Code

Unit: Display only field showing the unit of charge unit for the Labour Code

Description: Display only field showing a brief description of the Labour Code.   

Analysis Group: Display only field showing the Analysis Group to which the Labour Code belongs

Status: Display only field showing the current status of the Labour Code

Standard Rate: Display only field showing the current Standard Charge Rate for the Labour Code

Standard Cost: Display only field showing the current Standard Cost for the Labour Code

Rate Level: From the dropdown list select the Rate Level at which the Charge Rates are to apply.
Rate Levels are maintained via the ‘Related’ Button or can be found under the ‘Pricing’ Menu.

Price Calculation Method: From the dropdown list select the Price Calculation Method.  The
Options are:

Std Labour Rate + $ Value
Std Labour Rate - $ Value
Std Labour Rate + % Value
Std Labour Rate - % Value
Std Labour Cost + $ Value
Std Labour Cost - $ Value
Std Labour Cost + % Value
Std Labour Cost - % Value
Rate $ Value

Value: Enter a Value relating to the Price Calculation Method selected.  For example:- if the Std
Labour Rate is $200 and

· If Std Labour Rate + $ Value is selected and the Value is 50 then total will be $250
· If Std Labour Rate + % Value is selected and the Value is 50% then total will be $300

Note: The Value is in the currency held against the Rate level (As maintained via
Labour>Settings>Rate levels)

New Rate: Display only field showing the final Charge Rate based on the above calculation
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Currency: Display only field showing the Currency of this Rate level

Buttons

Close: This will close the Labour Rates screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank line for entry of a new Labour Rate.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Labour Rate record or the last time the ‘Save’ Button
was pressed will be lost.

Delete: This will delete the current Labour Rate Line

Related: This will bring up a list of functions that are related to Labour Rates.  You may open and
maintain information in those screens whilst still remaining in the Labour Rates screen.

Reports: This will bring up a list of Reports that are related to the Labour Rates.  You can
immediately run the report whilst still remaining in the Labour Rates screen.

9.5 Special Employee rates

The Special Employee Rates screen defines what special rates will be used when a particular
employee is used in a job.

These rates affect the Actual Unit Price of the specified Labour Code. 
In other words, the price of the job can vary depending on who is sent to do it.

For example, if the standard rate for Labour Code "SERVICE" is $50 per hour and employee Bob
has a  Special Rate of $75 per hour (for Labour Code "SERVICE"), then whenever Bob is used for
"SERVICE", the actual unit price charged to the customer will be $75 per hour instead of $50 per
hour. 

If different employees are used in the same job, then the average Actual Unit Price will be the
weighted average of all the applicable rates.

This list of Special Rates have these fields – EMPLOYEE, LABOUR CODE, CUSTOMER,
EMPLOYEE RATE.

Display fields

Employee: Select an employee from the drop-down list

Labour Code: If a Labour Code is selected from the drop-down list then the rate applies to this
Labour Code only. If blank, then the rate applies to all Labour Codes.

Customer: Select a specific customer (Optional).

Employee Rate: Enter the special hourly rate for this employee.
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Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

9.6 Capabilities

This screen allows you to define as many Capabilities as required..  Capabilities can be used to
ensure the correct resources are assigned to a task or activity or assembly step in the planned
Assignments when using the Assignment Board.

List Tab

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Capability Name: Enter a name for the Capability to be defined. You cannot enter duplicate
Capability names.

Description: Enter a short description for this Capability.

Type: Select one of the Capability types you have previously defined in Labour Settings.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

Related: This will bring up a list of related functions.
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Detail Tab

Entry and Display fields

Capability Name: Display only field showing the selected Capability.

Description: Editable field showing a brief description of the Capability.   

Type: Modifiable field showing the Capability Type.

Notes: Enter any relevant notes here.

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

Related: This will bring up a list of related functions.

Dependants Tab

This screen is used to define any other associated capabilities which are required whenever this
Capability is used. For example if a Capability called 10-Tonne Truck is required, then a dependent
Capability could be a Class 5 License.

Entry and Display fields

Dependant Name: Select from one of the Capabilities in the drop-down list.

Qty: Enter the quantity required for each instance of the primary Capability. Default is one.   

Type: Either "Fixed" or "Multiplied". 
"Fixed" means no matter how many instances of the primary Capability is required, you

only need the specified quantity of this Dependant Capability.  
"Multiplied" means the quantity of the Dependant Capability required is multiplied by the

number of instances of the primary Capability assigned.

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
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to save it before the screen is closed.

Add: This will add a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

Related: This will bring up a list of related functions.

Equivalents Tab

This screen is used to define what this current Capability is equivalent to (or can take the place of).
For example if a Capability called Class 3 Driving License is equivalent to both Class 1 and Class
2 Driving Licenses (BUT NOT THE OTHER WAY ROUND).

Entry and Display fields

Equivalent Name: Select from one of the Capabilities in the drop-down list. You can have more
than one equivalent by adding more records.

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

Related: This will bring up a list of related functions.

9.7 Capability Matrix

This screen allows you to define and maintain a list of default Capabilities required for Customers,
Job Types, Task Names, or Assembly Step Names. 

Entry and Display fields

Default Type:  Select the type from the drop down list. Options are: Customer, Job Type, Task
Name, Step Name.
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Default Value: Select a specific customer or Job type or Task name or Step Name if required. If
left blank it means that the capability is required for all customers / job types / task names / step
names. 

Capability Name: Select the name of the required Capability.

Qty:  Enter the quantity required. Default is one.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the last time the ‘Save’ Button was pressed will be lost.

Delete: This removes the current highlighted record.

9.8 Timesheets

This screen allows you to make Timesheet entries against Assembly Orders, Job Orders, or
non-charge.  The entries can be by Employee, Assembly Order, Job Order, or non-charge code
and times can either be in elapsed time or Start/Finish times

The process for Entering Timesheets includes the following Steps
· Create a Timesheet Batch
· ‘Save’ the Batch Header and go to the ‘Lines’ tab
· Add Lines to the Timesheet Batch - separate line to cover each Item
· Go back to the Batch Header
· Post the Batch - Ostendo generates the Time Bookings against the relevant Orders and

non-charge codes.

Note: Until a Batch is ‘Posted’ the times will not be recorded against the specified orders or
non-charge codes.

List Tab

Display fields

Timesheet Batch No: This is the Timesheet Batch Number as generated by Ostendo and
provides a unique reference to the Timesheet Batch

Reference: The Reference attached to this Timesheet Batch as entered into the Details screen,

Status: The status of this Timesheet Batch.  There are two statuses (In Progress and Updated),
which are maintained by the program. 
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Batch Date: The date held against the Timesheet Batch.  

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Timesheet screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Timesheet Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Timesheet Batch with status ‘In Progress’.  In
this instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Timesheets.  You may open and
maintain information in those screens whilst still remaining in the Timesheet screen.

Reports: This will bring up a list of Reports that are related to Timesheets.  You can immediately
run the report whilst still remaining in the Timesheet screen.

Detail Tab

This tab enables you to create and maintain a Timesheet Batch Header.   After creation of a Batch
Header it must be saved (click on the ‘Save’ Button) before Lines can be added 

Entry and Display fields

Timesheet Batch No:  This is a unique number automatically allocated by the program.  It cannot
be amended.

Status: This is the status of the Timesheet Batch and is maintained by the program.  The
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displayed variants are:
In Progress - The Timesheet Batch is still being worked on
Updated - The Timesheet Batch has been ‘Posted’ and Assembly Order Lines updated

Reference: Open format entry field for any Reference you may wish to attach to this Timesheet,

Batch Settings

Entries By: From the drop-down list select whether you will be making entries by:
· Employee
· Assembly Order
· Job Order
· Non-Charge Code
· Any

(Entries By): Dependant upon your selection in the last field this will provide a drop-down list
showing Employees, Assembly Orders, Job Orders, or Non-Charge Codes.  Select the specific
entry from this list.  This field will be disabled if the selection is ‘Any’

Use Start and End Times to Calculate Hours: If this checkbox is ‘checked’ then the entries must
quote a Start Time and End Time; the program then evaluates the duration.   If this checkbox is
not ‘checked’ then entries are the duration of the time booking

Payroll Information

This is display-only information which will appear if and when Ostendo is integrated with third party
payroll applications.The integration process can use these fields to indicate the posting status of
the timesheet data.

Posting Status: Display field showing whether the timesheet hal;s been posted to the third-party
payroll application. l

Date Posted: Display field showing the date the timesheet was posted.

Posting Style: Select either  " All Lines are Costed" or "All Lines are Non-Charge with No
Costs".

Batch Updating

Batch Creation Date: This is prefilled with the system date.  It can be amended at any time up to
Posting the Batch by entering the date or by clicking on the drop-down menu and selecting the
date.

Total Hours for Batch: Display only field showing the total hours currently entered against this
batch.

Interpret Timesheet Button: Click on this button if timesheet data is to be "interpreted" based on
the rules defined in Rate Scale Matrix for this employee.

Interpreted Hours: Result displayed after Interpret Timesheet button is pressed.

Break Hours: Result displayed after Interpret Timesheet button is pressed.
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Approval Process

Approval Status: This is only visible if you are authorised to carry out approvals (User Setup
option).  When visible you have the option to take the Timesheet Batch through the following
steps:

· Waiting Approval
· Approved
· Approval on Hold

Until a batch is ‘Approved’ it cannot be ‘posted’

Date Approved: This is only visible if you are authorised to carry out approvals (User Setup
option).  When visible it shows the system date when this batch was ‘Approved’

Post All Timesheet Entries: If this button is selected then all the entries contained in the ‘Lines’
panel will be actioned and the referenced Lines updated.  The status of this Batch will then be
amended to ‘Updated’

Notes: Extended Notes for your own information can be attached to this Timesheet Batch. 
Whenever you click on this field an icon will appear in the top-right.   By clicking on this Icon you
can bring up the Frequently Used Text table.   Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Timesheet screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Timesheet Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Timesheet Batch Header record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Timesheet.  You may open and
maintain information in those screens whilst still remaining in the Timesheet screen.

Reports: This will bring up a list of Reports that are related to the Timesheet.  You can
immediately run the report whilst still remaining in the Timesheet screen.

Lines Tab

This tab enables you to add and maintain Timesheet lines.  The Timesheet Batch Number and
status will be displayed at the top of the panel.

Entry and Display fields

Two Formats of data entry are displayed; Employee based or Order/non-charge code based - and
reflects the selection made in the ‘Details’ tab

Date: In the first instance this is prefilled with Batch Header Date or another Line date whichever is
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the later date.  You can change this date by entering the date or clicking on the drop-down menu
and selecting the date.

Type: If the entry option is by ‘Employee’ then this column will display.  You should select Job,
Assembly, or Non-Charge from the drop-down 

Reference: If the entry option is by ‘Employee’ then this column will display the list as defined by
the ‘Type’ field selection.   If the entry option is by Non-Charge, Assembly, or Job then this column
will display ‘Employee’ in which case you should select the Employee from the drop-down list

Rate Scale: From the drop-down list select the Rate Scale that will be applied to this booking. 

Start Time: This field is only visible if the ‘Use Start and End Times to calculate hours’ checkbox in
the Detail panel is ‘checked’.  Enter the Start Time - to the format HH.MM - when the task started

End Time: This field is only visible if the ‘Use Start and End Times to calculate hours’ checkbox in
the Detail panel is ‘checked’.  Enter the End Time - to the format HH.MM - when the task ended

Hours: If the ‘Use Start and End Times to calculate hours’ checkbox in the Detail panel is ‘
checked’ then you cannot access this field as the duration is calculated from the Start and End
times.  If the checkbox is not ‘checked’ then enter the Time in HH.DD format

Task or Step: From the drop-down list select the Step Name within the Assembly or Job Order
where this booking applies

Labour Code: This is prefilled with the default Labour Code linked to the Employee record.   It
may be amended to another Labour Code by selecting from the drop-down list

Charge Style: From the drop-down list select the charge style.  The options are:
· Chargeable -This is the default and denotes that this is a chargeable line
· Warranty - Denotes that this is covered by Warranty
· Contract - Denotes that this is included in a Contracted price
· Non-Charge - Denotes that this is a non-chargeable activity

Charge Code: From the drop-down list select the charge code.  The contents of the drop-down list
reflect the choice made in the previous field.  I.e.

· Chargeable - No entry required
· Warranty - Displays Warranty records
· Contract - Displays Recurring Invoice Contracts
· Non-Charge - Displays non-charge codes

Reference Description: Display-only field showing the description of the Reference field.

Interpreted: This CheckBox indicates whether the line is interpreted.

Break Hours: Display-only field showing the number of Break hours

Linked Assets: Select the Asset to be linked to this timesheet line.

Copy to Job History Notes: This is displayed if the ‘Type’ is Jobs.    If this is ‘checked’ then the
notes will be copied to the Job History Notes.

Copy to Assembly History Notes: This is displayed if the ‘Type’ is Assembly.    If this is ‘checked’
then the notes will be copied to the Assembly Order History Notes.

Copy to Job Line Instructions: This is displayed if the ‘Type’ is Jobs.    If this is ‘checked’ then
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the notes will be copied to the Job Lines.

Copy to Assembly Line Instructions: This is displayed if the ‘Type’ is Assembly.    If this is ‘
checked’ then the notes will be copied to the Assembly Order Lines.

Copy to Invoice Line Instructions: This is displayed if the ‘Type’ is Jobs.    If this is ‘checked’
then the notes will be copied to the Job’s Invoice Lines.

Recorded Notes: Extended Notes for your own information can be attached to this Timesheet
Line.  

Additional Fields Tab

If you have defined Additional Fields against the Timesheet Lines (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Buttons

Close: This will close the Timesheet screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Timesheet record.

Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Timesheet Line

Related: This will bring up a list of functions that are related to the Timesheet.  You may open and
maintain information in those screens whilst still remaining in the Timesheet screen.

Reports: This will bring up a list of Reports that are related to the Timesheet.  You can
immediately run the report whilst still remaining in the Timesheet screen.

9.9 Settings

9.9.1 Rate Levels

This screen allows you to maintain a list of Rate Levels, which are linked to Customers to define
which Labour Rate factor should be applied in determining the final charge rate

Entry and Display fields

Rate level:  Enter the Name of the Rate Level.  Duplicates not allowed.
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Description: Enter a short description of the Rate Level.  No checks are made on this entry

Currency Code: From the drop-down list select the currency that applies to this Rate level.  If this
applies to your local currency then leave this field blank

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Rate Level screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Rate Level.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Rate Level.

9.9.2 Rate Scales

This screen allows you to maintain a list of Rate Scales.  Rate Scales are used during Timesheet
Entry and apply a factor to cover Employee charges that vary from the norm (Example:  Evenings
Weekends, etc)

Entry and Display fields

Rate Scale: Enter the Name of the Rate Scale.  For example
· Standard Time
· Double Time
· Time and a Half

Duplicates not allowed.

Description: Enter a short description of the Rate Scale.  No checks are made on this entry

Factor: Enter a multiplication Factor that will convert the normal rate to the new rate.   For
example;

Standard Time 1
Double Time 2
Time and a Half 1.5

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Rate Scale screen.  If you have any unsaved data then you will be asked
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if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Rate Scale.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Rate Scale.

Set Default: Highlight a Rate Scale and click on this button.   This will then become the default
Rate that will prefill the Timesheet and other screens when entering Employee times.  The Rate
can be amended in those screens if required and made specific to the time booking.

9.9.3 Rate Scale Matrix

The Rate Scale Matrix allows you to define what rates to use based on a combination of factors.
This matrix is activated when the Timesheets Interpreted rule (in Labour Rules) is turned on.

This feature is often used in industries where the actual Labour rate depends on a combination of
factors such as Employee utilised, or day of the week, or specific dates.

You can use each line to specify both the break hours entitled and the Rate Scale to use. 

Entry and Display fields

Specific Employee:  Tick this box if this line is specified for a specific employee. Leave unticked if
it applies to all employees.

Employee Name: If Specific Employee is ticked, then select the name of the employee from the
drop-down list.

Day of Week: Select the day of week or "All Days" or "Date"

Specific Date: If "Date" is selected in the previous column, then specify the date here.

Hours from Day Start: Enter the number of hours from Day Start Time.

Break Hours: Enter the number of break hours entitled.

Rate Scale: Select the applicable rate scale from drop-down list.

For example you could use this matrix to define the following:

1. (Hours from Day Start = 4, Break Hours = 0, Rate Scale = STD): 0 to 4 hours worked - Standard
rate applies, no Break hours. 

2. (Hours from Day Start = 8, Break Hours = 0.5, Rate Scale = STD): up to next 4 hours worked -
Standard rate and 0.5 hours, Break applies. (Total = 8 hours)

3. (Hours from Day Start = 12, Break Hours = 0, Rate Scale = OVERTIME): up to next 4 hours
worked - Overtime rate , (Total = 12 hours ==> 8 hours Standard rate and 4 hours Overtime rate).
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Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Matrix Line.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

9.9.4 Capability Types

This screen allows you to maintain a list of Capability Types, which helps to classify the
Capabilities defined in the system.

Entry and Display fields

Capability Type:  Enter the type of capability here.  Duplicates not allowed.

Type Description: Enter a short description of the type.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Capability Type.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

9.9.5 Blocked Times

This screen allows you to maintain a list of Blocked Times for Assets and employees. Blocked
times are used to indicate when an asset or an employee is not available for assignments.
Examples of blocked times are when an asset is scheduled for maintenance or when an employee
is scheduled to be on vacation and will not be available to be assigned any tasks.

Entry and Display fields
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Resource Type:  Select the type of resource (Asset / Employee).

Resource Name:  Select the applicable resource name from dropdown list.

Start Time:  Enter the Start date and time here,

Finish Time:  Enter the End date and time here,

Description: Enter a short description for this blocked time. No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

9.9.6 Blocked Time Descriptions

This screen allows you to maintain a list of Blocked Time Descriptions and set the Default Duration
in Hours for each blocked time.

Entry and Display fields

Blocked Description: Enter a short description for this blocked time. No checks are made on this
entry

Default Duration in Hours : Enter the default number of hours for the blocked time duration.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.
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Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

9.9.7 Labour Rules

This screen allows you to maintain Labour Rules.  Labour Rules allow you to define what rules,
within the Labour area, you wish to apply.  The following rule settings are available

Entry and Display fields

Timesheet Approvals: ‘Check’ this checkbox if you wish to include Timesheet Approvals into the
Timesheet Process.  I.e.

· If this is checked then User Signon Codes designated as having ‘Approval’ rights will
approve Timesheets before they are posted.

· If this is not checked then the ‘Approval’ process will not be used.

Hours by Time of Day: This defines the default method of entering times in the Timesheet
screen.  It can changed when entering times and made specific to the session.  The options are:

· If this is ‘checked’ then the Timesheet entry screen will default to entering a Start and End
Time from which the program will evaluate the duration.  

· If this is not ‘checked’ then the entry will be the duration.

Copy to History Notes: This enables you to default the status of the equivalent checkbox on the
Timesheet ‘Lines’ screen.  I.e. If this is ‘checked’ then the checkbox on the Timesheet ‘Lines’
screen will default to being ‘checked’

Copy to Order Line Notes: This enables you to default the status of the equivalent checkbox on
the Timesheet ‘Lines’ screen.  I.e. If this is ‘checked’ then the checkbox on the Timesheet ‘Lines’
screen will default to being ‘checked’

Copy to Invoice Line Notes: This enables you to default the status of the equivalent checkbox on
the Timesheet ‘Lines’ screen.  I.e. If this is ‘checked’ then the checkbox on the Timesheet ‘Lines’
screen will default to being ‘checked’

Default Timesheet Line Type: This provides facility to have a preferred Timesheet Type when
first entering the Timesheet screen.  The options are:

· Employee
· Job
· Assembly
· Non-Charge

Default Labour Code: This allows you to define the Labour Code related to Timesheet Lines
against an Employee.  The options are:

· Any Labour Code:  The Labour Code field on the Timesheet Line must be selected from
the drop-down list of Labour Codes 

· Default Employee Labour Code: The Labour Code field is prefilled with the default
Labour Code held against the Employee record but can be amended by selecting from the
drop-down list of Labour Codes 

· Only Labour Codes from Order:  Having identified the Order then the Labour Code field
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selection is restricted to those contained in the Order.

Default Employee for Non-Allocated Tasks: If you identify a default Employee (Example:-
'Unallocated') then this 'employee' will appear in the first column in the Scheduling Calendar View
from where you can drag-and-drop to allocate to Employees.  This provides you with the facility
define Job Tasks which, when used in a Job will automatically pull in the 'Unallocated' Employee
into the Calendar

Prevent Posting of Timesheet Line if Task/Step is Closed: If this is ‘checked’ then the
Timesheet lines are checked to determine if they are associates with a Job Order Task or an
Assembly Order Step have a 'Closed' status.   If this is found to be the case then the posting will
be refused

Variable Overhead Application: From the drop-down list select when you wish Variable
Overheads are to be applied when related to Timesheet entries.  The options are:

After Rate Scale: The Variable Overhead to be calculated from entered time * Rate Scale
Before Rate Scale:The Variable Overhead to be calculated from entered time only

Timesheets Interpreted: If this is 'checked' then you have the ability to Interpret Timesheet

entries based on rules as defined in the Rate Scale Matrix screen (found in ‘Labour-Settings-Rate

Scale Matrix’). Note: If set, when posting the Timesheets, only Interpreted lines will be posted

(Total hours for Interpreted Lines must also balance to Non Interpreted Lines).      

Where there is no Employee-Labour Cost: Select from drop-down list. Either "Use Labour

Standard Cost" or "use Employee Direct Cost".

Default Timesheet Style: Select the default TimeSheet Style which will be displayed in the

"Entries By" field in the Detail tab when creating a new timesheet. 

No Cost Non-Charge Cost Centre: Select the Cost Centre which represents a No Cost

Non-Charge Cost Centre. There will not be any financial transactions generated for any postings to

this cost centre. This is used mainly for "Internal" time recording which have no financial impact.

You may need to add a new Cost Centre to your existing list of Cost Centres to allow for this.

Timesheet Interpreted Logic: Select either "Standard Procedure" or "Custom Procedure".

(The default is Standard Procedure.)

There are now three possible ways to apply timesheet interpretation logic.

1. "Standard Procedure" means it will use the Rate Scale Matrix specified in Labour Settings to

interpret the Timesheet entries. This should satisfy the requirements of the majority of companies. 

If the Rate Scale Matrix is not sufficient to handle the requirements, then you could write a Stored

Procedure or a System Action script to achieve that.

2. "Custom Procedure" means it will use a user-defined Stored Procedure to interpret the

Timesheet entries. Make sure you specify the name of your Custom Procedure in the next rule.

3. A third option is to use a user-defined System Action script which will be run when the

"Interpret Timesheet" button is pressed. Make sure your System Action script has an Abort

statement at the end so the Standard Procedure or Custom Procedure is not run after your script

is completed.

Interpreted Custom Procedure Name: Enter the name of your user-defined Stored Procedure
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here. You should have created this procedure first before selecting "Custom Procedure" in the

above rule.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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10 Inventory

10.1 Items

This screen allows you to create and maintain Inventory Items.   

List Tab

Display fields

The displayed fields are taken from the Item information entered into the ‘Detail’ tab.  The selection
of which fields to display is at the user’s discretion.  To select the fields to display simply ‘right
mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Obsolete Status - If this is checked then the displayed list will include those Items whose
status is ‘Obsolete’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Items screen.  If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.

Add: This will bring up a panel that allows you to create a new Item ‘from scratch’ or ‘by copy’.
The following fields are available for data entry

Create Item from scratch - select this ‘Radio Button’ if you are creating an Item from
scratch.  The next field will be available for you to enter the new number.  Upon clicking
the ‘Create’ Button this entry will be checked to ensure that it does not currently exist in
Ostendo

New Item Code - In up to 50 characters enter the identity of the new Item Number
Copy Item from another - select this ‘Radio Button’ if you are creating an Item by copying
details of an existing Item.  The following fields will be available for you to define the copy
criteria.  Upon clicking the ‘Create’ Button this entry will be checked to ensure that it does
not currently exist in Ostendo.  Having validated the new Item Number then the new record
is created along with the following if they exist against the ‘Copy From’ Item
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· All additional Units of Measure
· Any Properties
· Any Dimensions
· Colour Variants 
· Size Variants
· Grades

Item Code to be copied - From the drop-down list select the Item Code that is
being copied 
New Item Code - In up to 50 characters enter the identity of the new Item
Number.  This must not currently exist in Ostendo
Include Customer Pricing - ‘Check’ this checkbox if you wish the Customer
Pricing structure of the ‘Copy From’ Item to be copied to the New Item 
Include Supplier Pricing - ‘Check’ this checkbox if you wish the Supplier Pricing
structure of the ‘Copy From’ Item to be copied to the New Item 
Include Add-On Sales - ‘Check’ this checkbox if you wish the ‘Add-On Sales’
structure of the ‘Copy From’ Item to be copied to the New Item 
Include Forecast - ‘Check’ this checkbox if you wish the Item Forecast of the ‘
Copy From’ Item to be copied to the New Item 
(Button) Create - Clicking this button will validate the above details before
generating the new Item and taking you to the Item ‘Detail’ screen 
(Button) Cancel - This will ignore any entries and exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Item from this table

Related: This will bring up a list of functions that are related to the Item.  You may open and
maintain information in those screens whilst still remaining in the Item screen.

Reports: This will bring up a list of Reports that are related to the Item.  You can immediately run
the report whilst still remaining in the Item screen.

Detail Tab

Entry and Display fields

Item Code: This is mandatory entry and is only allowed during an Add transaction.   In up to 50
characters, enter the name of the new Item.  Duplicate Item Codes are not allowed.
You should be aware that, in Ostendo, the apostrophe (‘) is not allowed in ‘Key’ fields.  If the  Item
Code contains an apostrophe (Example - Board 3' x 1.5') and it is keyed in then the program will
replace it with a ‘backwards’ apostrophe (found on your keyboard to the left of the number 1 key).

Unit: This is mandatory entry and is only allowed during an Add transaction.  Select the Unit of
Measure from the drop-down list.  Units of Measure are user-maintained by clicking on the icon to
the right of the field or by selecting General>Settings >Standard Units

Description: This is mandatory field therefore enter a brief description of the Item.  A longer
description can be entered into the ‘Notes’ field at the bottom of the screen.  No checks are made
on the entry

Barcode: Enter the barcode identification of the Item.  This will print out (in barcode format) on
reports.  No validation checks are carried out on this entry
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Status: Select the current status from the drop-down list.  The options are:
Active - Is currently used throughout Ostendo
Planned - Can be Purchased or Assembled.  I.e. cannot be in a BOM or Sales/Job Order
Runout - Cannot be ordered but can be used until stock is zero
Obsolete - Cannot be ordered, Issued, or received

Item Settings Tab

Category: This is mandatory entry.  Select the Item Category from the drop-down list.   Item
Categories are user-maintained by clicking on the icon to the right of the field or by selecting
Inventory>Settings >Categories

Sub Category: Select the Item’s Sub Category from the drop-down list.  Item Sub Categories are
user-maintained by clicking on the icon to the right of the field or by selecting Inventory>Settings
>Sub Categories.

Pricing Group: From the drop-down list select the Pricing Group to which this Item belongs.
Pricing Groups are used both for Analysis purposes and for ‘group’ updates of Price changes.
Pricing Groups are maintained by clicking on the icon to the right of the field or by selecting
Pricing>Settings >Pricing Groups

Tax Group: This is prefilled with the default Tax Group identified in the System Configuration
Setting.  It is used to combine with Customer and/or Supplier Tax Groups to provide a specific Tax
recovery Code.  If you wish to change the Tax Group then select it by clicking on the drop-down
symbol and selecting the group.  Tax Groups are user-maintained by clicking on the icon to the
right of the field or by selecting File>Financial Configuration>Tax Groups

Analysis Group: The Analysis Group allows you to analyse Inventory, Labour, and/or Descriptor
records.  It is also used in defining the presentation of the order lines when it is printed on a Quote,
Order, or Invoice associated with an ‘Actual Quantity’ Job Order.  The presentations are selectable
by Analysis Group and offer different format options to the above three documents.

No Grouping: All Lines within the Analysis Group will printed
Header and Footer:  A Header containing the name of the Analysis Group will be printed
followed by the Lines within the Analysis Group.  At the end of the Group a Footer record
will be printed showing a summarised total of the Analysis Group content
Group Totals Only: A single line will be printed showing the summarised total for the
Analysis Group.

Analysis Groups are user-maintained by clicking on the icon to the right of the field or by selecting
General>Settings >Analysis Groups

Default Supply Method: This defines whether the Item is:
Supply From Stock - Supply to Sales Orders, Assembly Issues, Job Orders will come
from stock.  In this instance Inventory will normally be maintained using the Inventory
Replenishment routine.
Source On Demand - Whenever a demand (Sales Order, Assembly Order, Job Order) is
made then Ostendo will immediately create a matching ‘Suggested’ Supply Order
(Assembly Order or Purchase order).  This Suggested Supply Order can then be
converted - along with Suggested Replenishment Orders - using the ‘Create Required
Orders’ option found under ‘Requirements’ Menu

This is prefilled with ‘Supply from Stock’ but you can amend this by clicking on the drop-down list
and selecting the Supply Method

Manufacturers Info Tab

Manufacturer: Select the Manufacturer of this Item from the drop-down list.   Manufactures are
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user-maintained by clicking on the icon to the right of the field or by selecting Inventory>Settings
>Manufacturers

Brand: Select the Manufacturer’s Brand from the drop-down list.   Brands are user-maintained by
clicking on the icon to the right of the field or by selecting Inventory>Settings >Brands

Model: Enter the Manufacturer’s Model Name for this Item

Web Link: Enter the full name of the web link to the Manufacturer’s specification for this Item.

RTF Path: From the drop-down panel locate the source of the Manufacturers specification for this
Item on your computer.  This document should be stored in Rich Text Format (.rtf).

  
Order Dims tab

The fields in this tab denote that the Item has dimensional input capabilities to calculate the Order
Quantity in Sales and Job orders.  This covers four basic scenarios that can be combined to
provide an extensive array of options.  The basic scenarios are:

Single Dimension:  This enables you to enter multiple lines of single dimensions to arrive at an
Order Quantity.  For example, you can:

Enter multiple Individual lengths of wood to arrive at the total Order Line length
Enter length of Electrical Cable to arrive at the number of required Cable Clips**
Etc.
** you can also apply a rounding factor to evaluate the number of whole Boxes of Cable
Clips

Two Dimensions:  You can enter multiple lines of two dimensional 'cuts' to arrive at an Order
Quantity.  For example, you can specify Length and Width and:

Enter multiple lines to determine the total area required in the Order Line coverage
Enter multiple room wall sizes to arrive at the Paint coverage required**
Etc.
** you can also apply a conversion factor to evaluate the number of Litres of paint required
to cover the wall dimension.

Three Dimensions:  You can enter multiple lines of three dimensions to arrive at an Order
Quantity.  For example, you can specify Length, Width and Depth:

Enter multiple lines to determine the total volume required in the Order Line coverage
Enter multiple concreting requirements to arrive at the total amount of concrete required**
Etc.
** you can also apply a conversion factor to evaluate the number of Mixer Loads of
concrete required to cover the total requirement

Pack Sizes:  You can enter multiple lines of various Pack sizes; each with their own conversion to
a base Unit of Measure.  A good example of this is in the Meat and Fertiliser industries.   For
example: Enter multiple order pack sizes to arrive at a Planned Order Quantity.  You should note
that, if using this feature, you may also consider 'checking' the 'Delivery Tolerance %' on the
Customer Master record to allow 'actual' variations in the content of the packs

Entry and Display fields

Use Length: If this is 'checked' then it denotes that the 'Length' dimension will be used in Order
Entry.

Fixed: If this is 'checked' then a value is required in the next field.   
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(Value): If the previous field (Fixed) is 'checked' then enter the standard Length of the Item.  This
value will be divided into the Length identified at Order Entry and rounded up to the nearest whole
number to arrive at a Quantity.  For example if the Item is (say) a Ceramic Tile that has a length of
15cm and the measured height (entered during Order Line entry) is 287cm then Ostendo will
calculate that 287/10 = 19.1333 tiles are required.  This will be rounded round up to 20 whole tiles
required to cover the height.  For further clarification see the 'Width' value (below).

Use Width: If this is 'checked' then it denotes that the 'Width' dimension will be used in Order
Entry.

Fixed: If this is 'checked' then a value is required in the next field.   

(Value): If the previous field (Fixed) is 'checked' then enter the standard Width of the Item.  This
value will be divided into the Width identified at Order Entry and rounded up to the nearest whole
number to arrive at a Quantity.  For example if the Item is (say) a Ceramic Tile that has a width of
10cm and the measured width (entered during Order Line entry) is 512cm then Ostendo will
calculate that 512/10 = 61.2 tiles are required.  This will be rounded round up to 52 whole tiles
required to cover the width.
Taking both the Height and Width calculations Ostendo will calculate that you need 20 * 52 = 1040
whole tiles to cover the wall

Use Depth: If this is 'checked' then it denotes that the 'Depth' dimension will be used in Order
Entry.

Fixed: If this is 'checked' then a value is required in the next field.   

(Value): If the previous field (Fixed) is 'checked' then enter the standard Depth of the Item.  This
value will be divided into the Depth identified at Order Entry and rounded up to the nearest whole
number to arrive at a Quantity.  
  
Use Pack Size: If this is 'Checked' then it denotes that Pack Sizes and quantities will be entered
during Order Entry.  If 'checked' you should declare the pack sizes by clicking on the 'Enter Pack
Sizes' button.  

Enter Pack Sizes (Button)

Restrict Pack Sizes to List Below: If this is 'Checked' then the selection of Pack Size in
Order Entry must exist in this List.  If this is not 'checked' then you can manually enter a
Pack Size during Order Entry

Pack Size: Enter the Pack Size.  This can be up to 50 characters and no checks are made
on the entry

Conversion: Enter the quantity of the Item that is nominally used in the Pack Size.  For
example if the Item is (say) 'Sand' sold in 'Kg' and the Pack Size is 'Large Bag' then the
conversion factor could be 40 to denote that the Large Bag contains 40Kg of Sand

Conversion Factor: This is optional entry field in which you can enter a multiplication factor.
Once the Order Quantity is evaluated from the above dimensions and pack sizes you can apply
this Conversion Factor.  For example: If the Item is 'Paint' that is sold in Litres and 1 Litre of Paint
covers 4 Square Mtrs of surface area then, if the Length and Width dimensions are used to
calculate the surface area then the Litres of Paint required is the evaluated surface area multiplied
by 0.25.  Therefore you should enter 0.25 in this field

Budget tab
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Representative Code for Budgets: Select the Representative Item Code that this code belongs
to. This means that all actuals associated with this item code will be aggregated with all other item
codes associated with the same Representative Code. This is used for Actuals vs Budget
comparisons for groups of products. 

Times tab  (The concept here is for Sales Deliveries. This feature allows you to specify and
control Assignment Booking times on the basis of specific item pick times. For example an item
could take 30minutes to pick as you may have to get a forklift to pick it, whilst most other items
take a much shorter time to pick. Therefore the Assignment planned booking duration should
reflect this.)

Override Pick Time: Tick this box if you wish to override the default set in Assignment Board
Rules.

Pick Minutes: Enter the override time to pick one unit of this item.

Multiply Pick Time by Qty: Total pick time is the multiple of Pick Time and quantity issued. 

Setup Group: Select the Setup Group that this item belongs to. Setup Groups are defined in
Assembly Settings. Setup Groups are used, for example, to define ChangeOver Times during
Assembly Setup operations. 

Item Sales Settings

Sales Warranty Applies: ‘Check’ this checkbox if the Item is covered by a Sales/Service
Warranty.  When this is checked the adjacent field (Warranty Codes) becomes active.  Click on
the drop-down list to select a Warranty Code.  Warranty Codes are user-maintained by clicking on
the icon to the right of the field or by selecting Service >Warranty Definitions.

Create Customer Asset: ‘Check’ this checkbox if the Item is converted to a Customer Asset when
sold via a Sales Order or Job Order.  
When this is checked the adjacent button (Customer Asset Options) becomes active.  Clicking on
this button will bring up a panel for selection of the following: 

· Asset Type - Select from drop-down list. Asset Types and Service Schedules are
user-maintained by clicking on the icon to the right of each field or by selecting
Service>Settings>Asset Type or Service>Service-Plans respectively.

· Create Service Schedule from Plan - Ticking this box and selecting the Service Plan code
will generate the required Service Schedule for this Asset when it is created.

· Create Recurring Schedule Rule - Ticking this box will generate a Recurring Service
Schedule for this Asset when it is created. The following parameters relates to Recurring
Schedule only.

· Frequency Period - This can be Days or Weeks or Months. This selection together with
Frequency number defines how frequent the recurring service occurs.

· Template Code - Select the appropriate service job template.
· Job Type - Select the appropriate service job type.
· Frequency - Enter a number.
· Nearest Working Day - Tick this box if you want the recurring service dates are always a

working day.
· Predictive Style - Select "Include Predictive Event" or "No Predictive Event".  If Include

Predictive Event is selected, then the following two parameters applies and the next
recurring service date is calculated based on the earlier of the next Frequency Period event
or the next Predictive Event.  

· Reading Type - Predictive Events are based on Reading Type and Reading Value (example
- every 20000 KM or every 1000 hours, etc...). Select a Reading Type.
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· Reading Value - Enter an integer value.

Add On Sales Apply: ‘Check’ this checkbox if the Item has ‘Add-On’ Sales - a list of ‘linked’ Items
or promotions used at Sales Order entry for potential additional sales.  When this is checked the
adjacent button (Add-On Sales List) becomes active.  Clicking on this button will bring up a panel
for maintenance of the ‘Add-On’ Sale Items.  Add-On Sale Items can also be maintained selecting
Inventory>Item Add-On Sales.

Mobility Image: Click on this field and Right-Click to load an image (png or jpeg) for use with the
Graphical Material Lookup Style in Mobility Freeway templates.

  Images must be square and the recommended optimal size is 256 pixels by 256
pixels.

Inventory Information

On-Hand Qty: Display only field showing the current stock level across all Warehouses and
Locations.  For detailed on-hand information click on the adjacent button (Inventory Availability)

Supply Qty: Display only field showing the sum of the current Supply Orders (Purchase Orders
and Assembly Orders).

Demand Qty: Display only field showing the sum of the current demand orders (Sales Orders,
Assembly Orders, and Job Orders).

Availability: Clicking on this button will bring up a separate panel that shows details of the
Inventory Availability for this Item.  This includes

· Stock by Location segregated by Tracking Characteristic if applicable
· Projected Availability taking into account current stock plus supply and demand
· List of Supply and Demand orders

For more details on this Inventory Availability screen see ‘Inventory Availability’ section found
under Inventory>Inventory Availability

Re-Order Basis: From the drop-down list select the basis on which the Re-Order level and
Re-Order quantities will be based.  This can be either:

Fixed Qty: A defined quantity as entered into the following two fields, or
History Days: A system calculated quantity based on the number of days entered into the
following two fields

Level: This is used in the Inventory Replenishments Routine to define the stock level at which the
program generates a Planned Supply order.  The field heading reflects the 'Re-Order Basis'
selected above and affects the way that Ostendo evaluates the Re-Order level

Level (Qty):  Enter the Quantity relating to the Re-Order Level.   This will be used in the
Replenishments Routine
Level (Days):  Enter the number of days over which Ostendo will dynamically calculate the
average daily usage.   This is multiplied by the number of days to dynamically calculate the
Re-Order Level which is then used in the Replenishments Routine

Re-Order: This is used in the Inventory Replenishments Routine to define the Re-Order Quantity.
The field heading reflects the 'Re-Order Basis' selected above and affects the way that Ostendo
evaluates the Re-Order Quantity

Order (Qty):  Enter the Re-Order Quantity.   This will be used in the Replenishments Routine
Order (Days):  Enter the number of days over which Ostendo will calculate the average daily
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usage.   This is multiplied by the number of days to dynamically calculate the Re-Order
Quantity which is then used in the Replenishments Routine

Qty Multiple: If you normally order in a quantity multiple then enter the multiple here.  (Example:-
you stock in ‘each’ but your Supplier only supplies in multiples of 10).  The evaluated Planned
Order quantity will be increased to take account of this multiple.  If nothing is entered then no
multiple will be applied.

Primary Supplier: From the drop-down list select the Primary Supplier for this Item.  This is only
required if the ‘Sourced By’ is Purchasing or Supplier assembled.  This is used by the
Replenishment routine, or Source on Demand function to generate a planned Order linked to a
preferred Supplier.  Suppliers are maintained by clicking on Purchasing>Suppliers

Lead Time: Enter the number of days that it normally takes from placing the order to obtaining the
Item.  This lead-time will be applied to both Purchase Orders and Assembly Orders to determine
when the order should be placed.  If nothing is entered then a zero Lead-time is assumed.

Sourced By: Select the normal method by which this Item is sourced.  This will allow the Ostendo
to generate planned orders in the area where it is sourced (Assembly or Purchase).   Click on the
drop-down list to select a source.  The options available are:

Purchasing - Fully purchased Item
Assembly - Assembled in-house
Custom - Created via the ‘Custom Product’ routine

Configured By: If ‘Custom’ is selected in the previous field (‘Sourced By’) then this field will be
visible.  From the drop-down list select the method by which this Item will be configured.  The
options available are:

Rules – Configures the product using a Script previously created via Assembly>Custom
Products
Manual – Configures the product using a pre-defined BOM which can be amended during
configuration and made specific to this order line
Features – Configures the product using the Features and Options facility held against the
Item's Bill of Material.

Additional Inventory Settings: Clicking on this button will bring up a sub-panel for entry of
additional Inventory information as follows:

ABC Classification:  From the drop-down list select the ABC Class.  These
Classifications are used to segregate Inventory for Cycle Check purposes.   Classifications
A, B, C, D and E are available for selection.

Cycle Count Code:  From the drop-down list select the Cycle Count Code.  These Codes
are used to facilitate selective areas of Inventory to be included in a Cycle Count
segregate Inventory for Cycle Check purposes. 

Duty%: Enter the amount of Duty - expressed as a Percentage of the Purchase Price -
that will apply to this Item when it is imported.

Alternate Item Available: ‘Check’ this checkbox if an alternative Item is available when
this Item cannot be supplied.  When this is checked the next field (Item List) becomes
active.   Click on the drop-down list to select an Item Code. 

(Alternate Item): only active when the 'Alternate Item Available' checkbox is 'checked'.
Click on the drop-down list to select the Alternate Item Code. 

Introduction Date: Upon creating the Item this is prefilled with the System Date.  To
amend the date you can overtype it or click on the drop-down calendar and select the
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date.

Prevent Negative Stock for this Item: This is only visible if the ‘Disable Negative Stock
for all Items’ checkbox is not ‘Checked’ in the Inventory Rules screen.  If this is ‘checked’
then Issuing of the Item from Stock will not be allowed if the resulting stock level goes
below zero.

Backflush Issues on Assembly Receipt: If this is 'checked' then, whenever an Assembly
Order is raised against this Item and it is being received into stock, the Assembly Order's
components relative to the received quantity are automatically issued.

Exclude from Web: If this is 'checked' then this Item will not be extracted when displaying
for Web Sales.

Exclude from POS: If this is 'checked' then this Item will not be extracted when displaying
for POS Sales.

Include in Mobility B2B: Tick this box if you wish to specifically make this item available
for B2B Customer selection.  (This is controlled by the Mobility Rule - "Additional
Materials B2B Conditional Style)".

Purchase Warranty Applies:  If this is 'checked' then a Warranty record will be generated
whenever this Item is received through Purchasing   You should note that this will only
occur if the Item is Serial Controlled.   The generated Warranty record can be found under
Service>Warranty List.

Item has been Superceded: 'Check' this checkbox if this Item is has been superseded.
In this instance the next field must contain the superceding Item.  

Supersession Code: From the drop-down list select the Item Code will supercede this

Item.   If the Item Rule 'Item Supersession is Active' is 'checked' and the Superceded Item
is added to a Sales, Purchase, POS Order ot Direct Invoice then it will be immediately
replaced by this Superceding Item.

Segmented POS Barcodes: This is applicable mainly to Retail environments which uses
weighing scales like the Wedderburn. Such scales generate a segmented barcode which
contains the product code as well as the weight (or price) of that particular purchase. Such
items would normally be sold by weight. Tick this box if this product uses segmented
barcodes. The format of the segmented barcode is defined in POS Settings - POS
Segmented Barcodes.

Single Scan for Picking: Ticking this box means that each scan of this item's barcode
picks one unit of that item. You pick multiple quantities by doing multiple scans (instead of
entry the quantity).

Picking Sequence: This only applies if the Picking Sequence rule in Mobility Rules is set
to Product Sequence. Items with the lowest number will be picked first. Picking Sequence
numbers can be negative.

Picking Class: Select the Picking Class for this item. Picking classes are defined under
Inventory Settings.

Default Issue Warehouse: Click on the drop-down list to select the default Warehouse.
This will prefill any Issue transaction for this Item but can be changed before physical
issue.  Warehouses are user-maintained by clicking on the icon to the right of the field or
by selecting Inventory>Warehouses.
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Default Issue Location: Click on the drop-down list to select the default Location within
the selected Warehouse.  This will prefill any Issue transaction for this Item but can be
changed before physical issue.  Locations are user-maintained by clicking on the icon to
the right of the field or by selecting Inventory>Locations.

Default Receipt Warehouse: Click on the drop-down list to select the default Warehouse
into where this Item is normally received.  This will prefill any receipt transaction for this
Item but can be changed before physical receipt.  Warehouses are user-maintained by
clicking on the icon to the right of the field or by selecting Inventory>Warehouses.

Default Receipt Location: Click on the drop-down list to select the default Location within
the selected Warehouse.  This will prefill any receipt transaction for this Item but can be
changed before physical receipt.  Locations are user-maintained by clicking on the icon to
the right of the field or by selecting Inventory>Locations.

Item Pricing & Costing

Sell Price: Enter the Standard Sell Price for this Item.  This will be used as the basis for evaluating
the many sell-price options that are available in Ostendo.  In the absence of any pricing matrices
relating to the various Price Levels then this price will be used.  If the amount in this field is
amended then the next field ‘SP (Incl Tax)’ will be amended accordingly

SP (incl Tax): This shows the Sell Price including Tax.  The Tax rate used is that defined as the
default Tax under File>Financial Configuration>Tax Codes.  If the amount in this field is amended
then the previous field ‘Sell Price’ will be amended accordingly

Buy Price: Enter the Standard Buy Price for this Item.  This will be the standard but price through
the Purchasing system unless a Supplier Specific Pricing structure has been entered via the ‘
Pricing’ routine.  Refer to the above ‘Pricing’ button.

Pricing: Click on this button to address the comprehensive pricing options available in Ostendo.
For a guide to this function see ‘Item Pricing’ under the ‘Pricing’ Menu  

Costing: Click on this button to maintain and/or view the Last, Average and Standard Costs for
this Item. For more information on Item Costing refer to ‘Item Costing’ under the ‘Pricing’ Menu.  

Actual Costing is used: This only applies to Items that are Serial or Batch Controlled.  If this
checkbox is ‘checked’ then receipts and issues of stock will be at Actual Cost irrespective of the
system settings set up in File>System Configuration>System Settings. 
You should note that for Serial Numbered Items the receipt Cost will apply to the specific Serial
Numbered Item.  For Batch Controlled Items the receipt Cost will generate an Average Cost
covering the batch and this Average will be used for issues from this Batch.

Calculate Sell Price from Receipt Cost for Jobs: If this is ‘checked’ then the Job’s Sell Price of
this Item will be calculated from the Receipt Cost rather than the Item’s Pricing Level.  When this
option is selected then a Markup % must be specified in the following field

Markup: If the previous field is ‘checked’ then this field will become active.  Enter the Markup %
that will be applied to the Receipt Cost to determine the Sell Price when used in a Job Order

Inventory Tracking

Serial No: If this is ‘checked’ then all stock movements for this Item must be accompanied with a
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Serial Number.  You should note that the serial number applies to individual Items.   Therefore if 3
Items are included in a transaction then 3 Serial Numbers are required. 

Serial Kit: ‘Check’ this checkbox if this Item is a Serial Kit (an assortment of variable Items that
are stocked as a unique Kit).  Any Item identified as being a Serial Kit must also be Serial
Controlled

Kit List: This is only visible if the Serial Kit checkbox is ‘Checked’.  From the drop-down list you
can (optionally) select an Inventory List (created via Inventory>Lists) that will form the base
template that is attached to the Serial Kit when the Serial Kit is received into stock.  The Kit content
can be amended at that time and made specific to the Serial Kit.

Expiry Date: If this is ‘checked’ then all stock movements for this Item must include an Expiry
Date. 

Revision No: If this is ‘checked’ then the Item must contain a Revision Number.  The current
Revision Level is selected from the drop-down list on the adjacent ‘Current Revision’ field.   Click
on the icon to the right of the field to maintain Revision Levels history.

Current: If the previous (Revision No) field is 'checked' then this field becomes active and you
should select the current Revision Number applicable to this Item from the drop-down list.   Click
on the icon to the right of the field to maintain Revision Levels history.

Batch No: If this is ‘checked’ then all stock movements for this Item must be accompanied with a
Batch Number.  You can pre-specify Batches to be used by clicking on the ‘Batches’ button.  In
addition to defining the Batches you can also specify if the batch identity is restricted to those
defined in this list.

Batch Requires QC : Tick this box if this item requires QC inspection. This field is used in
conjunction with Item Batch Records, to control the initial Item Batch Status when the Batch
Record is initially created via a receipt. This is useful when all purchases of new item batches must
undergo a QC process prior to making them available for subsequent issues to jobs etc.. With this
field ticked, all purchases will have a default batch status set to “QC Required” to prevent them
from being issued. To release it from this status you must change the status either manually from
within the Batch screen or via a Freeway Datasheet linked to that batch.

Prevent Container Batch Mixing:  This flag prevents the same item being added to a container
before that container has been cleaned. There are some environments where you cannot add the
same product with a different batch number to a container before that container has been cleaned.
This flag compares the containers last clean date / time against the current date and time.
Freeway will prevent you adding the item to that container if there have been subsequent picks /
receipts for the same item with a different batch number where the container has not been cleaned
in between times.

Size: If this is ‘checked’ then all stock movements for this Item must be accompanied with a Size
reference.  You can pre-specify Sizes to be used by clicking on the ‘Sizes’ button.   In addition to
defining the Sizes you can also specify if the Size selection is restricted to those defined in this list. 
A Point to note here is that the Size could be used with Variable Units of Measure.  In this instance
you should also complete the following fields

This Size is used as a variable Unit of measure: If this is ‘checked’ then it denotes that
the Item is stocked, sold, and purchased in the Base Unit of Measure but the Sales Invoice
uses the Unit of Measure defined in the following two fields taking into account the actual
sizes issued against the Order.
Default Conversion Factor: This is only active if the previous field is ‘checked’.  Enter the
default conversion factor that represents the nominal conversion quantity between the
Base Unit and the Unit identified in the next field.
Size Unit: From the drop-down list select a Unit of Measure that you are going to
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nominate as the ‘Size Unit’.  This unit will appear on the Invoice.   Standard Units are
maintained by selecting General>Settings >Standard Units.

Colour: If this is ‘checked’ then all stock movements for this Item must be accompanied with a
Colour reference.  You can pre-specify Colours to be used by clicking on the ‘Colours’ button.  In
addition to pre-defining the Colours you can also specify if the Colour selection is restricted to
those defined in this list.

Grade: If this is ‘checked’ then all stock movements for this Item must be accompanied with a
Grade Reference.  You can pre-specify Grades to be used by clicking on the ‘Grades’ button.   In
addition to defining the Grades you can also specify if the Grade selection is restricted to those
defined in this list.

Note: If the Item Rule "Container Tracking" is set to either "Use Grade for Tracking" or "Use
Colour for Tracking" then one of the above will be replaced by the following:

Container:  If this is checked, then this item is Container Tracked. When the record is saved, and
there are existing inventory for this item, a Container Creation screen will pop up:

Container Creation Screen:
The top section of the Container Creation screen shows your current inventory records for

the item. By default, Ostendo will assign a new container for the first record on the bottom section
of the screen. If you wish to group some inventory from different batches together in the
same container, you can add records to the bottom section and link one inventory record to
another by using the Grouping ID field. (Any character can be used for this.)

Type in the Grouping ID in the bottom section. When the Create Button is pressed, this will
cause all the grouped records with the same Grouping ID to be combined onto the same
container.

By using different Grouping IDs you can combine contents together over multiple
containers.

Any inventory quantities not defined will be treated as Non-Containerised and will have a
corresponding attribute of "--".
 
For a full description on how to make use of Ostendo Container Tracking function see this white
paper:Ostendo Container Tracking Module 

Use Virtual Container: This field is used for Sourced By “Assembly or Custom” items where you
wish to track all issues and receipts for this item in a virtual container from the Assembly Order

Container Content Group: This allows you to group item codes together for the purposes of
allowing or disallowing groups of items being stored on any one container collectively: eg: You may
want to prevent explosives from being stored on the same container as flammable products like
fuels. 

Item Images Tab

If this Item has linked images (added via Inventory>Items>Item Images) then the first Image will be
displayed.  To view other images linked to this Item simply click the left or right arrow at the bottom
of the Image Display panel.

Additional Fields Tab

If you have defined Additional Fields against the Item (created via System Configuration>Additional

http://ostendo.info/downloads/ostendo/Container_Tracking_Module.pdf
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Fields) then an addition tab will be presented which, when selected, will display the available fields.
Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

General Notes: You can enter unlimited amount of Notes that are related to this Item.  These
notes will be available wherever the Item is reported.  Whenever you click on this field an icon will
appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text table. 
Select the text to be copied and either press the OK Button in that screen or double-click the
selected record.  Other Notes panels are available whose content will be carried across to the
relevant area that the Item is used.   I.e.

Sales Notes
Job Notes
Purchase Notes
Assembly Notes

Messages: You can enter up to 200 characters of Text that will be displayed in a ‘Message Bar’
across the centre of the Order Lines screen in Sales, Job, Purchase or Assembly Order screen. 
This will be displayed in a Red font and is intended to attract the attention of the person entering
the Order Line with information relevant to the Item being added. 

The content of the message line can be plain text or can include fields from the Item Master
record.  These fields will be populated with the latest information held against the Item.  For
example: You may wish to show the Last Cost for the Item whenever you are adding it to a Sales
Order.  Therefore the text would be (say)

The Item’s Last Cost was [LASTCOST] which was on [LASTCOSTDATE]

This would display on the Order ‘Message’ Bar as 

The Item’s Last Cost was $23.5 which was on 21/10/09

The fields in the square brackets are taken from the ITEMMASTER table.  To see the available
fields go to General>Reports>Full Listing of Tables and select ITEMMASTER

Buttons

Close: This will close the Inventory Item screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.
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Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Inventory Item.  You may open
and maintain information in those screens whilst still remaining in the Inventory Item screen.

Reports: This will bring up a list of Reports that are related to the Inventory Item.  You can
immediately run the report whilst still remaining in the Inventory Item screen.

10.1.1 Item Properties

This screen allows you to define properties that are specific to an Item.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Items in the system.

Display fields

Item Code: Display only field showing all Item Numbers in your database

Description: Display only field showing descriptions of the Items

Unit: Display only field showing the Unit of Measure of the displayed Items

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Properties screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of new Item Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel
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Detail Tab

Entry and Display fields

Item Code: Display only field showing the Item selected in the List screen

Description: Display only field showing the description of Item selected in the List screen

Unit: Display only field showing the Unit of Measure of the Item selected in the List screen

Property: From the drop-down list select the Standard Property against which a value specific to
this Item will be made.

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Copy to SO Lines: If this checkbox is ‘checked’ then this property will be copied to a Sales Order
Line along with the Item

Copy to Job Lines: If this checkbox is ‘checked’ then this property will be copied to a Job Order
Line along with the Item

Copy to PO Lines: If this checkbox is ‘checked’ then this property will be copied to a Purchase
Order Line along with the Item

Copy to Assy Lines: If this checkbox is ‘checked’ then this property will be copied to an Assembly
Order Line along with the Item

Buttons

Close: This will close the Item Properties screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Item Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Item Property record or the last time the ‘Save’ Button
was pressed will be lost.

Delete: This enables you to delete the selected Item Property record.
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10.1.2 Item Documents

This screen allows you to define documents, etc that are specific to an Inventory Item.    

List Tab

Display fields

Document Type: Prefilled with ‘Item’ and cannot be amended

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Item to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon.

Buttons

Close: This will close the Item Documents screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Item Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from an Item

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name that you are calling the document in this Document-Item
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linkage.    No checks are made on the entry.

Document Type: Prefilled with ‘Item’

Linked to: From the drop-down list select the Item that uses this document

Copy to Jobs: If this is ‘checked’ then the document link will be copied to all Job Orders where
this Item is used.

Copy to Sales: If this is ‘checked’ then the document link will be copied to Sales Orders where this
Item is used.

Copy to Purchases: If this is ‘checked’ then the document link will be copied to Purchase Orders
where this Item is used.

Copy to Assemblies: If this is ‘checked’ then the document link will be copied to Assembly Orders
where this Item is used.

Print / Email with order: Tick this box if this document is to be included when printing / emailing
the order.

Print / Email with quote: Tick this box if this document is to be included when printing / emailing
the quote.

Correspondence:  Tick this box if this document is to be treated as correspondence in the
Operations Centre screen.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:- .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Item Documents screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Item Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Item Documents record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 
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10.1.3 Item Images

This function allows you to link Images to an Item.    

List Tab

Display fields

Image Type: Always 'Item' and cannot be amended

Image Name: The name of the Image as entered into the Details screen,

Linked To: This is the specific Item to which this Image relates.

File Name: This is the full path name of the Image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Images screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Item Images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Image from an Item

View: If you select a line and then this button the Image will be displayed using your default Image
display software. 

Detail Tab

Entry and Display fields
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Image Name: Enter the name that you are calling the document on this Image-Item linkage.  No
checks are made on the entry.

Image Type: Prefilled with ‘Item’

Linked to: From the drop-down list select the Item that uses this Image

Copy to Jobs: If this is ‘checked’ then the Image link will be copied to all Job Orders where this
Item is used.

Copy to Sales: If this is ‘checked’ then the Image link will be copied to Sales Orders where this
Item is used.

Copy to Purchases: If this is ‘checked’ then the Image link will be copied to Purchase Orders
where this Item is used.

Copy to Assemblies: If this is ‘checked’ then the Image link will be copied to Assembly Orders
where this Item is used.

Display on Price List: If this is 'checked' then the Image will be displayed in the Price List. 

Image Details: locate the full path name of the Image.  It should be noted that the file extension
must be an image format (I.e. .jpg, .bmp, .ico, .wmf, .emf)

Preview: The selected Image is displayed for your reference

Buttons

Close: This will close the Item Image screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of an Item Image record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Item Image record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

10.1.4 Item History Notes

This function allows you to link multiple time-stamped notes to an Item.    

List Tab

Display fields

The displayed fields are taken from the Item Master record.  The selection of which fields to
display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
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· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item History Notes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Item to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Call Classification: From the drop-down list select a Classification under which you wish to store
this History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.
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Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.  Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History: The Notes history against this Item is displayed in the lower part of the screen.  Each
record will also have the first 3 lines of the notes displayed.   To view the full Notes simply click on
the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Item History Notes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of an Item History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Item History Notes record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

10.1.5 Item Mobility and Web

This function allows you to define additional information related to an item. Such information is
normally used in E-Commerce websites or in the Freeway Mobility app.   
This function and screens are accessed via the Related Menu button in Items screen.

List Tab

This displays the current list of Items in the system.

Display fields

Item Code: Display only field showing all Item Numbers in your database

Description: Display only field showing descriptions of the Items

Unit: Display only field showing the Unit of Measure of the displayed Items

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
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either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of the new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Item Code: Display only field showing the Item selected in the List screen

Description: Display only field showing the description of Item selected in the List screen

Unit: Display only field showing the Unit of Measure of the Item selected in the List screen

Short Description: Enter a more detailed description of the Item

Showcased: Tick this box if this is a showcased Item. Showcased items are used in E-Commerce
sites to highlight or showcase certain items for marketing or promotional purposes.

Long Description Label: Enter a label for the Long Description if you wish to caption it differently
from the default. (You can set the default label in Mobility Rules so that it applies to all items and
descriptors.)

Specification Description Label: Enter a label for the Specifications  if you wish to caption it
differently from the default. (You can set the default label in Mobility Rules so that it applies to all
items and descriptors.)

Features Label: Enter a label for the Features if you wish to caption it differently from the default.
(You can set the default label in Mobility Rules so that it applies to all items and descriptors.)

For example, the above three labels could be General Description, Technical Specs, Special
Features & Accessories (instead of Long Description, Specifications,Features)

Long Description Subtab
Enter a more comprehensive description of the item. This is usually a non-technical description of the item.
You can also include merged fields from the ITEMMASTER table. Merged fields must be enclosed with
double square brackets (e.g. [[STDSELLPRICE]] ).
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HTML SubTab: This allows you to key in the notes in HTML format using the
appropriate control keys.

You can also click on the Editor button which will bring up the editor screen with
built-in functions for entering notes in html format.

Text SubTab: This allows you to key in the notes in plain text. If you have keyed
in the notes using the Editor, this subtab will show the embedded html tags
together with the textual data

Specifications Subtab
Enter any technical specifications for this item.

HTML SubTab: This allows you to key in the notes in HTML format using the
appropriate control keys.

You can also click on the Editor button which will bring up the editor screen with
built-in functions for entering notes in html format.

Text SubTab: This allows you to key in the notes in plain text. If you have keyed
in the notes using the Editor, this subtab will show the embedded html tags
together with the textual data

Keywords Subtab
Enter all the keywords associated with this item. Keywords must be separated by commas. Keywords are
used much like how they are used in webpage searches.

Hierarchical Names Subtab
If the items are to be displayed in a hierarchical structure, then use this tab to associate the item to the
Hierarchical Names and Levels.

Hierarchical Name: Select the Hierarchical Name that this item is associated with.

Hierarchical Level: Select the Hierarchical Level that this item is associated with.

An item could be associated with multiple Hierarchical Names and Levels.

Features Subtab
Use this subtab to enter a list of features associated with the product.

Group: Select the Features Group Name. (Feature Group names are defined in Inventory
Settings).

Seq No: Enter the sequence number.

Feature: Enter the feature description.
You can also include merged fields from the ITEMMASTER table. Merged fields must be enclosed

with double square brackets (e.g. [[STDSELLPRICE]] ).

Feature Notes: Enter any additional notes related to this feature.

An item can have many features. Feature Group names must be pre-defined in Inventory -
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Settings - Feature Groups.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: This enables you to delete the selected record.

Editor: This button calls up the HTML editor and enables you to key in notes related to the current
record.

10.1.6 Item Hazards

This screen allows you to maintain the Hazards and Instructions associated with an item. For
example, certain chemicals may be hazardous and requires special handling protocols. 

Detail Tab

Entry and Display fields

Hazard Style: Select either Code or Group. Code refers to an individual hazard/instruction, while
Group refers to a group of hazards/instructions. 

Group or Code: Select one of the Group or Code from the drop-down list of pre-defined
hazards/instructions.

Override: Tick this box if you wish to override the Description and/or Notes.

Description: The description of the hazard/instruction or group of hazards/instructions.

Notes: Notes relating to the hazard/instruction.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank line for entry of a record.

Save: This will save the current data without exiting the screen
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Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: This will delete the current highlighted record.

10.1.7 Item Quantities

This screen displays summarised quantities and statistics for an item which were captured through
the Freeway App.

For a full description of this function, please refer to this white paper: Freeway Qtys & Stats
Recording 

Statistics Tab

Display fields

Item Code : The Item Code.

Statistic Code:  The name of the statistic

Statistic Description: The description of the statistic.   

Recorded Style:  Completed Qty Only / Completed Qty with Time / Continuous Qty Only /
Continuous Qty with Time

   Start Stop Time Only / Start Stop Time with Completed Qty  

Last Recorded Date: Date of last statistic recording

Statistical Aggregate: SUM /  MIN / MAX / LAST / HOURLYAVG / ENTRYAVG

Statistical Value:  The resulting value of the statistic.

 
Quantities Tab

Display fields

SheetID : The Freeway Datasheet ID

Entry Date:  Date of entry of the quantities recorded

Start Time: The Start Time 

End Time:  The End Time

Entered Value:  Quantity recorded  

Entry Notes : Notes recorded 

http://ostendo.info/downloads/ostendo/Freeway_Recording_Qtys_And_Stats_Explained.pdf
http://ostendo.info/downloads/ostendo/Freeway_Recording_Qtys_And_Stats_Explained.pdf
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Buttons

Close: This will close the screen.

10.1.8 Item Market Codes

This screen allows you to link applicable Market Codes to an Item.

Market Codes are generally used to restrict certain items or batches to customers which may have
certain requirements as to the quality  or source of the products.  
For example, if a customer has a requirement that all food products that they purchase must meet
EU standards, then we could assign a market code of "EU" to this customer.
Then only items or batches with the same Market Code can be sold to this customer.

Market Codes are first defined in Inventory Settings.

Detail Tab

Entry and Display fields

Item Code : Display-only field showing the current Item Code.

Unit:  Display-only field - Item Unit

Description: Display-only field - Item description.   

Click Add button to select a Market Code for this item. (Market Codes are first defined in Inventory
Settings.)
An item can have multiple Market Codes.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

10.1.9 Item Nutrition

This screen enables you to record nutritional information about the product. 

The idea is that eventually this information will be uploaded to Ostendo.Work.

Outside parties using a Standalone Freeway solution can then draw down this information as
required by scanning a 2D barcode. 

The Barcode value itself will be a Global Unique ID (ie: this code is unique across all Ostendo
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databases)

In addition, you could include this information (or even just the 2D Barcode) on reports generated
from within Ostendo eg: Packing Slip or Delivery Documents.

From the List Grid of this screen, press the Add button to create a nutritional information record
for this item..

Detail Tab

Entry and Display fields

Item Code : Enter or select the item code to enter its nutritional information.

Nutritional Description:  Type in a relevant Nutritional Description eg: Servings per package 2.
Serving Size 210g

Per Serving Caption: e.g.: "Avg Qty Per Serving 210g" 

Per Weight / Volume Caption: e.g.: "Avg Qty Per 100g"

Per Serving Daily Intake % Caption:   e.g. "Daily Intake %"

Notes: You can enter 5 different types of notes in the following tabs:
Ingredient Notes
Serving Notes

 Storage Notes
Origin Notes
Allergen Notes  

Info Tab
You enter the detailed nutritional information here line by line. Click Add button to add each line.

Entry and Display fields

Item Code : Display-only field

Seq No: Enter the line sequence number here. 

Nutrition Line: Enter the nutritional item here - e.g. Sugar, or Energy, or Protein

Per Serving Value: Enter the per serving value here. (e.g. 840kj)

Per Weight / Volume Value:  Enter the per weight or per volume value here. (e.g. 400kj)

Per Serving Daily Intake: Enter the per serving daily intake here. (e.g. 5.5% )

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.
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Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

Related: This will bring up a list of functions that are related to the Item Nutrition.

Reports: This will bring up a list of Reports that are related to the Item Nutrition.

  

10.1.10 Item Shipper Labels

The concept behind this is to allow Delivery picking of Shipper cartons which contain multiples of
the same SKU. 

Eg: You may stock a SKU called ‘Spanners’ with a UOM of Each, however they could be physically
stored in Shipper boxes containing 50 in each box. In this case you would setup a Shipper record
with a Shipper Quantity of 50. You can then print off Shipper Barcode labels to attach to each
shipper box. Then when the warehouse person scans that shipper box for a delivery pick,
Ostendo would interpret that pick qty of 50.

The Shipper Label barcode is basically a concatenation of the itemcode and the shipper quantity.

If the delivery required a pick qty of 56, the warehouse person could scan one shipper label to pick
50, then scan the individual SKU barcode label and pick the remaining 6

Essentially Ostendo is interpreting the Shipper Label barcode and picking a qty according to that
Shipper size. 

Further to this, When the Delivery is initially created, a new display only field is populated against
each Delivery Line with a ‘Suggested Picking Instruction’ eg: “pick 1 shipper of 50 and 6 single
units”. This is only a suggestion, and therefore could be ignored if no shippers are physically
available for that item. The idea here is that this extra piece of information assists the warehouse
picker in determining the best configuration to pick for that item on the delivery.

List Tab

This displays the current list of Items in the system.

Display fields

Item Code: Display only field showing all Item Numbers in your database

Description: Display only field showing descriptions of the Items

Unit: Display only field showing the Unit of Measure of the displayed Items
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Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of the new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Labels: This allows you to print Shipper Barcode Labels associated with the highlighted item. The
barcode will be a concatenation of the itemcode and the shipper quantity.

Detail Tab

Entry and Display fields

Item Code: Display only field showing the Item selected in the List screen

Unit: Display only field showing the base unit of measure of the item.

Description: Display only field showing the item description.

Click the Add button to add Shipper Quantity records for this item.

Shipper Quantity: Enter the Shipper quantity here.

Shipper Description: Enter a brief description.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.
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Add: Moves the cursor to the lower panel for creation of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: This enables you to delete the selected record.

Labels: This button enables you to print Shipper Barcode Labels associated with the highlighted
record. The barcode is basically a concatenation of the itemcode and the shipper quantity. 

10.1.11 Item Units

This function allows you to define multiple Item-specific Units of Measure, their unit conversion
factor, and the relative Sell Price Discount factor.    

List Tab

Display fields

Item Number: This is the Item Number identity against which the Unit Of Measure is being
maintained.

Description: Description of the Item taken from the Inventory record

Unit: The base Unit of Measure for the Item taken from the Inventory record

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Unit screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will go to the ‘Detail’ screen and position the cursor ready for entry of a new Unit
Conversion record.
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Save: Not applicable to the Unit List panel

Cancel: Not applicable to the Unit Conversion List panel

Delete: Not applicable to the Unit Conversion List panel

Detail Tab

Entry and Display fields

The Item to which these Unit Conversion records relate is shown at the top of this panel.

Item Code: Display only field showing the Item Number selected in the List panel

Unit: Display only field showing the base Unit of Measure for this Item as held against the Item
Master record

Description: Display only field showing the Description of this Item as held against the Item
Master record.

Note: A single Unit Conversion record already exists that relates to the base unit.  It will have a
conversion Unit of 1 and a discount of 0%.  This record cannot be amended

Unit Conversions

To Unit:  From the drop-down list select an additional Unit of Measure that you are going to use
with this Item.  Standard Units are maintained by selecting General>Settings >Standard Units.

Conversion Factor: Enter the number that will convert this Unit to the Item’s base unit.  For
example if the base unit was ‘Each’ and this Unit was ‘Tens’ then the entry here will be 10

Sell Price Discount %: Enter the amount of discount relative to the base price that is given when
this Unit of Measure is sold.  For example if the Price per base Unit is $100 and the price per ‘Ten’
is $80 then the value entered here will be 20 (I.e. 20% of the Base Sell Price is the discount)

Status : Select either "Active" or "InActive". Unit can only be set as InActive if there is no current
inventory for that item-unit combination.

Buttons

Close: This will close the Unit screen.  If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Unit Conversion record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Unit record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Unit record
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10.1.12 Item Dimensions

This function allows you to define dimensions for each of the Units of Measure set up against this
Item

List Tab

Display fields

Item Number: This is the Item Number identity against which the Dimensions are being
maintained.

Description: Description of the Item taken from the Inventory record

Unit: The base Unit of Measure for the Item taken from the Inventory record

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Dimensions screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will go to the ‘Detail’ screen and position the cursor ready for entry of a new Dimensions
record.

Save: Not applicable to the Dimensions List panel

Cancel: Not applicable to the Dimensions List panel

Delete: Not applicable to the Dimensions List panel

Detail Tab

Entry and Display fields

The Item to which these Dimensions records relate is shown at the top of this panel.

Item Code: Display only field showing the Item Number selected in the List panel
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Unit: Display only field showing the base Unit of Measure for this Item as held against the Item
Master record

Weight Unit: Display only field showing the unit of weight that will apply to the weights entered into
the lower part of this panel.  The unit of weight is defined in File>System Configuration>System
Setup

Volume Unit: Display only field showing the unit of Volume that will apply to the volumes entered
into the lower part of this panel.  The unit of Volume is defined in File>System
Configuration>System Setup

Area Unit: Display only field showing the unit of Area that will apply to the area entered into the
lower part of this panel.  The unit of Area is defined in File>System Configuration>System Setup

Description: Display only field showing the Description of this Item as held against the Item
Master record.

Length and Width Unit: Display only field showing the unit of Length and Width that will apply to
the Lengths entered into the lower part of this panel.  The unit of Length and Width is defined in
File>System Configuration>System Setup

Unit Conversions

To Unit: From the drop-down list select the Unit of Measure against which you are going to record
the dimensions.  Units of Measure are maintained via General>Settings>Standard Units.

Actual Weight: Enter the weight of the Item for the defined Unit.  No checks are made on this
entry.

Actual Volume: Enter the volume of the Item for the defined Unit.  No checks are made on this
entry.

Actual Length: Enter the length of the Item for the defined Unit.  No checks are made on this
entry.

Actual Width: Enter the width of the Item for the defined Unit.  No checks are made on this entry.

Actual Height: Enter the height of the Item for the defined Unit.  No checks are made on this
entry.

Actual Area: Enter the Area of the Item for the defined Unit.  No checks are made on this entry.

Buttons

Close: This will close the Dimensions screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Dimensions record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Dimensions record or the last time the ‘Save’ Button
was pressed will be lost.
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Delete: This will delete the selected Dimensions record

10.1.13 Item Barcodes

This screen allows you to create and maintain barcode identifiers for each unique sub-level
variation (Batch, Expiry Date, Colour, Revision Level, etc) of any item.  When scanning Items in
POS this can immediately point to the specific Item/Variant.

List Tab

Display fields

Item Code: Display only field showing the identity of the Item taken from the Item Master record

Description: Display only field showing the description of the Item taken from the Item Master
record

Unit: Display only field showing the base unit of the Item taken from the Item Master record

Internal/External:  Display only field showing whether the Barcode is a Supplier's Barcode or one
used 'In-House'.  Note: Both these can be held against the Item Code for the same Unit.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Buttons

Close: This will close the Item Barcodes screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: For the current selected Item this will bring up the ‘Detail’ tab for entry and maintenance of
barcodes at sub-levels

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields
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Item Code: Display only field showing the identity of the Item selected in the List view

Description: Display only field showing the description of the Item selected in the List view

Unit: Display only field showing the unit of the Item selected in the List view

Barcode: Enter the barcode identification of this variant.  No validation checks are carried out on
this entry.  If, during POS, it is found that two or more items have the same barcode then they will
be displayed for selection prior to adding to the order.

Variant: If the Item has one of the following Variants then, for each variant, a drop-down list is
available for you to make a selection.  The above Barcode will then be associated with the
combination of variants

· Unit
· Expiry Date
· Batch Number
· Revision Number
· Grade Colour
· Size

Note: Serial Number is a unique identity against a specific Item.  Whenever the Serial Number is
swiped with a Barcode Reader, Ostendo knows the above variant combinations (if any) against the
Item.  Although the Serial Number is unique within an Item Code the same number may be used in
another Item Codes.  In this instance all Items with the same Serial Number are presented to the
POS Operator for selection of the correct Item

Internal/External:  This is prefilled with 'External' to denote that the Barcode relates to a Supplier's
Barcode.  You can amend this to 'Internal' from the drop-down list to denote that the Barcode is
specific to your internally used barcoding methodology.  This enables you to identify internally used
SKUs (Stock Keeping Units) for stock-take and POS purposes

Buttons

Close: This will close the Item Barcodes screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Barcode

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current highlighted record

10.1.14 Item Site Master

This screen is accessed from the Item Master screen and clicking on the 'Related' Button down the
right hand side.   Item Site Master allows you to maintain Item Site parameters focussing on the
replenishment criteria such as ROQ, Order Multiple, etc.  These parameters will be used when
running Replenishment by Site.  If the Item/Site parameters do not exist then Ostendo will use the
information held against the Item Master record

List Tab
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Display fields

The displayed fields are taken from the Item Site Master record.  

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Site Master screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the Detail panel for entry and maintenance of Item Site Details

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

This screen allows you to maintain Item Site Details

Entry and Display fields

Item Code:  Display only field showing the selected Item Code against which the Details are being
maintained

Unit: Display only field showing the base Unit of the selected Item Code

Description: Display only field showing the Description of the selected Item Code

Sites Sub-Tab

Site Name: When adding a record select the Site from the Drop-down list.  Duplicate records
containing the same Site will not be allowed

Buttons

Close: This will close the Item Site Master screen.  If you have any unsaved data then you will be
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asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Item/Site record

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This will delete the selected Item/Site record

Item Site Details Sub-Tab

When adding a record this will be prefilled with the data already entered against the Item Master
record but can be amended here as follows

Default Supply Method: This defines whether the Item is:
Supply From Stock - Supply to Sales Orders, Assembly Issues, Job Orders will come
from stock.  In this instance Inventory will normally be maintained using the Inventory
Replenishment routine.
Source On Demand - Whenever a demand (Sales Order, Assembly Order, Job Order) is
made then Ostendo will immediately create a matching ‘Suggested’ Supply Order
(Assembly Order or Purchase order).  This Suggested Supply Order can then be
converted - along with Suggested Replenishment Orders - using the ‘Create Required
Orders’ option found under ‘Requirements’ Menu

Sourced By: Select the normal method by which this Item is sourced.  This will allow the Ostendo
to generate planned orders in the area where it is sourced (Assembly or Purchase).   Click on the
drop-down list to select a source.  The options available are:

Purchasing - Fully purchased Item
Assembly - Assembled in-house
Custom - Created via the ‘Custom Product’ routine
Transfer - Item is transferred from another Site

Configured By: If ‘Custom’ is selected in the previous field (‘Sourced By’) then this field will be
visible.  From the drop-down list select the method by which this Item will be configured.  The
options available are:

Rules – Configures the product using a Script previously created via Assembly>Custom
Products
Manual – Configures the product using a pre-defined BOM which can be amended during
configuration and made specific to this order line
Features – Configures the product using the Features and Options facility held against the
Item's Bill of Material.

Primary Supplier: From the drop-down list select the Primary Supplier for this Item.  This is only
required if the ‘Sourced By’ is Purchasing or Supplier assembled.  This is used by the
Replenishment routine, or Source on Demand function to generate a planned Order linked to a
preferred Supplier.  Suppliers are maintained by clicking on Purchasing>Suppliers

Lead Time: Enter the number of days that it normally takes from placing the order to obtaining the
Item.  This lead-time will be applied to both Purchase Orders and Assembly Orders to determine
when the order should be placed.  If nothing is entered then a zero Lead-time is assumed.

On-Hand Qty: This is a display only field showing the current stock level across all Warehouses
and Locations linked to this site.  
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Supply: Display only field showing the sum of the current Supply Orders (Purchase Orders and
Assembly Orders).

Demand: Display only field showing the sum of the current demand orders (Sales Orders,
Assembly Orders, and Job Orders).

Available: Display only field showing the Available quantity (calculated from the above On-Hand +
Supply - Demand).

Free Qty: Display only field showing the Free quantity.  This ignores any outstanding Supply
Orders.  I.e. It is calculated from the above On-Hand - Demand.

Re-Order Basis: From the drop-down list select the basis on which the Re-Order level and
Re-Order quantities will be based.

Level: This is used in the Inventory Replenishments Routine to define the stock level at which the
program generates a Planned Supply order.  The field heading reflects the 'Re-Order Basis'
selected above and affects the way that Ostendo evaluates the Re-Order level

Level (Qty):  Enter the Quantity relating to the Re-Order Level.   This will be used in the
Replenishments Routine
Level (Days):  Enter the number of days over which Ostendo will dynamically calculate the
average daily usage.   This is multiplied by the number of days to dynamically calculate the
Re-Order Level which is then used in the Replenishments Routine

Re-Order: This is used in the Inventory Replenishments Routine to define the Re-Order Quantity.
The field heading reflects the 'Re-Order Basis' selected above and affects the way that Ostendo
evaluates the Re-Order Quantity

Order (Qty):  Enter the Re-Order Quantity.   This will be used in the Replenishments Routine
Order (Days):  Enter the number of days over which Ostendo will dynamically calculate the
average daily usage.   This is multiplied by the number of days to dynamically calculate the
Re-Order Quantity which is then used in the Replenishments Routine

Order Multiple: If you normally order in a quantity multiple then enter the multiple here.
(Example:- you stock in ‘each’ but your Supplier only supplies in multiples of 10).  The evaluated
Planned Order quantity will be increased to take account of this multiple.  If nothing is entered then
no multiple will be applied.

Last Cost: This is maintained through receipts into Inventory for this site.  There are instances,
however, when the cost of the last receipt is not known, therefore you can enter that cost here if
required.

Average Cost: This is maintained through receipts into Inventory for this site.  There are
instances, however, when the current Average cost is incorrect, therefore you can enter the correct
Average cost here if required.

Standard Cost: This is maintained here although the Standard Cost can be updated via the Cost
update routine.

Cost History

The following list shows a complete history of cost changes made to this Item

Cost Type: Display only field showing which Cost was updated

Date Changed: Display only field showing the date when this Item’s Cost record was updated.
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Old Cost: Display only field showing the cost prior to the change

New Cost: Display only field showing the cost after the change

Buttons

Close: This will close the Item Site Master screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Item/Site record

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This will delete the selected Item/Site record

10.1.15 Item Site Settings

This screen is accessed from the Item Master screen and clicking on the 'Related' Button down the
right hand side.   Item Site Settings screen allows you to maintain default Warehouses and
Locations by Site.  Within each Site you can also define the defaults for Sales, POS, Purchasing,
Jobs and Assembly Orders.   Whenever a Warehouse/Location is referenced for the
Site/Order-Type then this default will prefill the relevant screen with these defaults. Of course you
can amend the defaults in that screen if required

List Tab

Display fields

The displayed fields are taken from the Item Master record.  

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Site Settings screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the Detail panel for entry and maintenance of Site Settings
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Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

This screen allows you to maintain Item Site Defaults

Entry and Display fields

Item Code:  Display only field showing the selected Item Code against which the default
Warehouse Locations are being maintained

Unit: Display only field showing the base Unit of the selected Item Code

Description: Display only field showing the Description of the selected Item Code

Site Name:  From the drop-down list select the site to which this default Warehouse and Location
will be linked.  Company Sites are maintained via screen General>Company Sites.

Order Class: From the drop-down list select the Order Class to which the default Warehouse and
Location will be linked.  The displayed options are:

Sales - Sales Order specific
POS – Point of Sales Order specific
Purchases – Purchase Order specific
Job – Job Order specific
Assembly – Assembly Order specific
All - All Order Classes where a specific Order Class has not been specified

Issue Warehouse: Click on the drop-down list to select the default Warehouse from where Items
are normally issued.  This will prefill any Issue transaction for Items but can be changed before
physical issue.  Warehouses are user-maintained via Inventory>Warehouses.

Issue Location: Click on the drop-down list to select the default Location from where Items are
normally issued.  This will prefill any Issue transaction for Items but can be changed before
physical issue.  Locations are user-maintained via Inventory>Locations.
 
Receipt Warehouse: Click on the drop-down list to select the default Warehouse into which Items
are normally received.  This will prefill any receipt transaction for Items but can be changed before
physical receipt.  Warehouses are user-maintained via Inventory>Warehouses.

Receipt Location: Click on the drop-down list to select the default Location into which Items are
normally received.  This will prefill any receipt transaction for Items but can be changed before
physical receipt.  Locations are user-maintained via Inventory>Locations.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.
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Buttons

Close: This will close the Item Site Settings screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Item Site Default.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Item Site Default record

10.1.16 Item Customers

This screen is accessed from the Item Master screen and clicking on the 'Related' Button down the
right hand side.   Item Customers screen allows you to define the Item Code that Customers use
when referring to Ostendo’s internal Item Code.  The Customer Item Code can be printed on Order
Acknowledgement and Invoice documents.  Additionally, if the ‘Advanced Searching’ checkbox is
set in screen File>System Configuration>System Settings, you can search an Item Listing by
entering the Customer’s Item Code and locate your internal equivalent.

List Tab

Display fields

Item Number: This is the Item Number identity against which the Unit Of Measure is being
maintained.

Description: Description of the Item taken from the Inventory record

Unit: The base Unit of Measure for the Item taken from the Inventory record

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Customers screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.
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Add: This will go to the ‘Detail’ screen and position the cursor ready for entry of a new Item
Customer record.

Save: Not applicable to the Item Customers List panel

Cancel: Not applicable to the Item Customers List panel

Delete: Not applicable to the Item Customers List panel

Detail Tab

Entry and Display fields

The Item to which these Item Customer records relate is shown at the top of this panel.

Item Code: Display only field showing the Item Number selected in the List panel

Unit: Display only field showing the base Unit of Measure for this Item as held against the Item
Master record

Description: Display only field showing the Description of this Item as held against the Item
Master record.

Customer:  From the drop-down list select the Customer whose Item Code is being linked to the
above Item.

Customer Code: Enter the Item Code by which the Customer refers to the above Code.  No
checks are made on this entry.

Unit: This is prefilled with the base Unit of measure for the Ostendo Item.  By using the drop-down
list it can be amended to any other Unit applicable to this Customer Item

Conversion:  This represents the conversion factor between the Customer’s Unit of Measure and
the Item’s base Unit of Measure as defined in the Item Master record.  This is used as follows.  If
the Customer’s Unit of Measure is ‘Drum’ and the base Unit of Measure in Ostendo is ‘Litres’ and
1 drum contains 50 Litres then enter 50 into this field.  This allows you to order and despatch in the
Customer’s UOM.  This field is prefilled with a conversion factor of 1 but can be amended as
required.

Customer Description: Open format field where you can enter the Customer’s description of the
Item.  No checks are made on this entry.

Buttons

Close: This will close the Item Customers screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Item Customer record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Item Customer record or the last time the ‘Save’ Button
was pressed will be lost.
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Delete: This will delete the selected Item Customer record

10.1.17 Item Markups

This screen is accessed from the Item Master screen and clicking on the 'Related' Button down the
right hand side.   Item Markups Screen allows Ostendo to calculate a Sell Price based on a single
Mark-Up percentage being applied to the Receipt Cost of the Item.   This screen allows you to
override that percentage by applying a markup percentage based upon the Price Level of the Job
or Customer.

List Tab

This displays the current list of Items in the system.

Display fields

Description: Display only field showing descriptions of the Items

Unit: Display only field showing the Unit of Measure of the displayed Items

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Markups screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of new Item Markups.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields
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Item Code: Display only field showing the Item selected in the List screen

Description: Display only field showing the description of the Item selected in the List screen

Unit: Display only field showing the Unit of Measure of the Item selected in the List screen

Price Level: From the drop-down list select the Price Level against which a markup percentage
specific to this Item will be applied.

Markup %: Enter the markup percentage that will be applied  to the Price Level

Buttons

Close: This will close the Item Markups screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Item Markup record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Item Markup record or the last time the ‘Save’ Button
was pressed will be lost.

Delete: This enables you to delete the selected Item Markup record.

10.2 Descriptors

This screen allows you to create and maintain Descriptors.   A Descriptor can represent anything
that you wish to Invoice that is not an Inventoried Item.  Examples of Descriptors are:

· Non-Stock Items
· Travel
· Accommodation
· One-off charges
· etc

List Tab

Display fields

The displayed fields are taken from the Descriptor information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.   To select the fields to display simply
‘right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering



443Inventory

and sorting:
· To sort the data in a selected column simply click on the column heading.  Clicking

against will sort in descending order.
· Click on the black ‘down arrow’ to the right of your selected column heading and you can

either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Descriptors
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Descriptor screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will bring up a panel that allows you to create a new Descriptor ‘from scratch’ or ‘by copy
’.  The following fields are available for data entry

Create Descriptor from scratch - select this ‘Radio Button’ if you are creating a
Descriptor from scratch.  The next field will be available for you to enter the new Descriptor
Code.  Upon clicking the ‘Create’ Button this entry will be checked to ensure that it does
not currently exist in Ostendo

New Descriptor Code - In up to 50 characters enter the identity of the new
Descriptor.

Copy Descriptor from another - select this ‘Radio Button’ if you are creating an
Descriptor by copying details of an existing Descriptor.  The following fields will be
available for you to define the copy criteria.  Upon clicking the ‘Create’ Button this entry will
be checked to ensure that it does not currently exist in Ostendo.  

Descriptor Code to be copied - From the drop-down list select the Descriptor
Code that is being copied 
New Descriptor Code - In up to 50 characters enter the identity of the new
Descriptor Code.  This must not currently exist in Ostendo
Include Customer Pricing - ‘Check’ this checkbox if you wish the Customer
Pricing structure of the ‘Copy From’ Descriptor to be copied to the New Descriptor 
Include Supplier Pricing - ‘Check’ this checkbox if you wish the Supplier Pricing
structure of the ‘Copy From’ Descriptor to be copied to the New Descriptor 

(Button) Create - Clicking this button will validate the above details before generating the
new Descriptor and taking you to the Descriptor ‘Detail’ screen 
(Button) Cancel - This will ignore any entries and exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Descriptor from this table

Related: This will bring up a list of functions that are related to the Descriptor.  You may open and
maintain information in those screens whilst still remaining in the Descriptor screen.

Reports: This will bring up a list of Reports that are related to the Descriptor.  You can immediately
run the report whilst still remaining in the Descriptor screen.
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Detail Tab

Entry and Display fields

Descriptor Code: This is mandatory entry and is only allowed during an Add transaction.   In up to
50 characters, enter the name of the new Descriptor.  Duplicate Descriptor Codes are not allowed.
You should be aware that, in Ostendo, the apostrophe (‘) is not allowed in ‘Key’ fields.  If the 
Descriptor contains an apostrophe and it is keyed in then the program will replace it with a ‘
backwards’ apostrophe (found on your keyboard to the left of the number 1 key).

Unit: This is mandatory entry and is only allowed during an Add transaction.  Select the Unit of
Measure from the drop-down list.  Units of Measure are user-maintained by clicking on the icon to
the right of the field or by selecting General>Settings >Standard Units

Description: This is mandatory field therefore enter a brief description of the Descriptor.   A longer
description can be entered into the ‘Notes’ field at the bottom of the screen.  No checks are made
on the entry

Barcode: Enter the barcode identification of the Descriptor.  This will print out (in barcode format)
on reports.  No validation checks are carried out on this entry

Status: Select the current status from the drop-down list.  The options are:
Active - Is currently used throughout Ostendo
Inactive - Cannot be used but history retained

Descriptor Settings Sub-Tab

Category: Select the Descriptor Category from the drop-down list.  Descriptor Categories are
user-maintained by clicking on the icon to the right of the field or by selecting Inventory>Settings
>Categories

Sub-Category: Select the Descriptor Sub-Category from the drop-down list.  Sub Categories are
user-maintained by clicking on the icon to the right of the field or by selecting Inventory>Settings
>Sub Categories

Pricing Group: From the drop-down list select the Pricing Group to which this Descriptor belongs.
Pricing Groups are used both for Analysis purposes and for ‘group’ updates of Price changes.
Pricing Groups are maintained by clicking on the icon to the right of the field or by selecting
Pricing>Settings >Pricing Groups

Tax Group: This is prefilled with the default Tax Group identified in the System Configuration
Setting.   It is used to combine with Customer and/or Supplier Tax Groups to provide a specific
Tax recovery Code.  If you wish to change the Tax Group then select it by clicking on the
drop-down symbol and selecting the group.  Tax Groups are user-maintained by clicking on the
icon to the right of the field or by selecting File>Financial Configuration>Tax Groups

Analysis Group: The Analysis Group allows you to analyse Inventory, Labour, and/or Descriptor
records.  It is also used in defining the presentation of the order lines when it is printed on a Quote,
Order, or Invoice associated with an ‘Actual Quantity’ Job Order.  The presentations are selectable
by Analysis Group and offer different format options to the above three documents.

No Grouping: All Lines within the Analysis Group will printed
Header and Footer:  A Header containing the name of the Analysis Group will be printed
followed by the Lines within the Analysis Group.  At the end of the Group a Footer record
will be printed showing a summarised total of the Analysis Group content
Group Totals Only: A single line will be printed showing the summarised total for the
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Analysis Group.
Analysis Groups are user-maintained by clicking on the icon to the right of the field or by selecting
General>Settings >Analysis Groups

Expense Cost Centre: From the drop-down list, select the Expense Cost Centre against which
transactions linked to this Descriptor will be posted.  If nothing is selected then the system default
(Descriptor Expenses) identified in Cost Centre Mapping will be used.
For Ostendo Freeway Subcontractors, if this Descriptor is set up for Purchase Receipts and
Purchase Invoices relating to SubContractor Labour Charges, then ensure this Expense Cost
Centre is set to be the SubContractor clearing Cost centre.

Income Cost Centre: From the drop-down list, select the Income Cost Centre against which
transactions linked to this Descriptor will be posted.  If nothing is selected then the system default
(Descriptor Expenses) identified in Cost Centre Mapping will be used.

Additional Fields Sub-Tab

If you have defined Additional Fields against the Descriptor (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Rental Settings Sub-Tab

Rental Descriptor: A Rental Descriptor is one which is used to in a Sales Order to provide a
charge against the Line.  Linked to this Descriptor is an Inventoried Item such that the Item can be
tracked throughout its Rental process.  ‘Check’ this checkbox if this Descriptor is to be a Rental
line in a Sales Order. 

Rental Item Code: From the drop-down list select the Item Code that is directly linked to this
Descriptor Code.   Whenever the Descriptor (and its charge-out rate) is added to a Sales Order
then this Item and its usage will be tracked throughout the Rental process

Default Rental Qty: Enter the default quantity of the above Item that will be used whenever a
single Rental Descriptor Code is orders.  This can be amended in a generated Sales Order and
made specific to that order.

Rental Qty same as Order Qty: ‘Check’ this checkbox if you always want the entered line quantity
against the Rental Descriptor to also be the quantity in the linked Item Code

Freight Sub Tab

This panel allows you to identify this as a Freight Descriptor.  This will then allow you to quickly
determine Freight Costs in a Sales or Job Order and add this Descriptor as an additional line to the
Order.

In this panel there is a button ‘Freight Rates’ in which you can enter the charge rate for various
weights and volumes.  When this Descriptor is added to a Sales or Job Order Line you can enter
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the orders actual weight and/or volume from which Ostendo will determine the rate for the weight
and volume and evaluate which is the greater.  This rate is returned to the Order line, where it can
be amended if required

Freight Descriptor: ‘Check’ this checkbox if you are defining this as a Freight Descriptor.  The ‘
freight Rates’ button will become active for entry of the charge rates

(Button) Freight Rates: This button is only active if the previous checkbox has been ‘checked’.  A
panel will appear for you to enter charge rates for various weights and volumes

· Quantity: Enter the quantity break that applies to this charge rate.  All quantities equal to,
or greater than, this quantity (up to the next quantity break) will incur the charge rate
entered against this line

· Weight or Volume: From the drop-down list select whether the above quantity applies to
the Weight or the Volume

· Rate: Enter the monetary vale that relates to the Weight/Volume quantity 

On-Charge Sub Tab

This tab facilitates the On-Charging of an Order Amount to a Third Party Customer.  For example:
If a Spare Part is sent to a Customer and the whole (or portion) of the bill is sent to a Third Party
such as an Insurance Company

Entry and Display fields

On Charge: 'Check' this checkbox if this Descriptor is to be used for On Charging.

Action: From the drop-down list select where this On Charge Descriptor will be actioned.  The
options are:

· Immediate Invoice
· Accumulate to Item

On Charge Customer: From the drop-down list select the Customer to which this On Charge will
apply.

Accumulation Code: If the selection under 'Action' is 'Accumulate to Item' then you should select
the Item Code from the drop-down list to which the On Charge will be accumulated

Budget tab

Representative Code for Budgets: Select the Representative Descriptor Code that this code
belongs to. This means that all actuals associated with this Descriptor code will be aggregated with
all other Descriptor codes associated with the same Representative Code. This is used for Actuals
vs Budget comparisons for groups of products. 

Times tab

Override Pick Time: Tick this box if you wish to override the default set in Assignment Board
Rules.

Pick Minutes: Enter the override time to pick one unit of this Descriptor.

Multiply Pick Time by Qty: Tick this box to indicate that Total pick time is the multiple of Pick
Time and quantity used. 
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Descriptor Sales Settings

Sales Warranty Applies: ‘Check’ this checkbox if the Descriptor is covered by a Sales/Service
Warranty.   When this is checked the next field (Warranty Codes) becomes active.   Click on the
drop-down list to select a Warranty Code.  Warranty Codes are user-maintained by clicking on the
icon to the right of the field or by selecting Service >Warranty Definitions.

Exclude from Web Sales: If this box is 'checked' then the Descriptor will not be available for Web
Sales.

Include in Mobility B2B: Tick this box if you wish to specifically make this Descriptor available for
B2B Customer selection.  (This is controlled by the Mobility Rule - "Additional Materials B2B
Conditional Style)".

Segmented POS Barcodes: This is applicable mainly to Retail environments which uses weighing
scales like the Wedderburn. Such scales generate a segmented barcode which contains the
product code as well as the weight (or price) of that particular purchase. Such items would
normally be sold by weight. Tick this box if this descriptor uses segmented barcodes. The format
of the segmented barcode is defined in POS Settings - POS Segmented Barcodes.

Mobility Image: Click on this field and Right-Click to load an image (png or jpeg) for use with the
Graphical Material Lookup Style in Mobility Freeway templates.

  Images must be square and the recommended optimal size is 256 pixels by 256
pixels.

Exclude from Containers: Tick this box to prevent this descriptor from being added to Container
Contents when picked (e.g. Sales Delivery picking). This setting is relevant to Non-Physical type
Descriptors (e.g. Charges) that are picked but not physically recorded against the Container
Contents.

Descriptor Information

Primary Supplier: From the drop-down list select the Primary Supplier for this Descriptor.  This is
only required if the ‘Sourced By’ is Purchasing.   The Primary Supplier is copied along with the
Descriptor when it is added to a Job Line.   Suppliers are maintained by clicking on Purchasing>
Suppliers

Lead Time: Enter the number of days that it normally takes from placing the order to obtaining the
Descriptor.  This lead-time will be applied to both Purchase Orders and Assembly Orders to
determine when the order should be placed.  If nothing is entered then a zero Lead-time is
assumed.

Sourced By: From the drop-down list select the method by which this Descriptor is sourced.  The
options are ‘Purchasing’ or ‘In-House’

Duty%: Enter the amount of Duty - expressed as a Percentage of the Purchase Price - that will
apply to this Descriptor when it is imported.

Unit Weight: Enter the weight of the Item.  No checks are made on this entry.  The unit of Weight
is defined in File>System Configuration>System Setup

Unit Volume: Enter the volume of the Item.  No checks are made on this entry.  The unit of
Volume is defined in File>System Configuration>System Setup
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Unit Area: Enter the Area of the Item.  No checks are made on this entry.  The unit of Area is
defined in File>System Configuration>System Setup

Introduction Date: This shows when this Descriptor was introduced. It is prefilled with the system
date but can be amended by selecting a date from the drop-down calendar. 

Descriptor Pricing & Costing

Sell Price: Enter the Standard Sell Price for this Descriptor.  This will be used as the basis for
evaluating the many sell-price options that are available in Ostendo.  In the absence of any pricing
matrices relating to the various Price Levels then this price will be used.  If the amount in this field
is amended then the next field ‘SP (Incl Tax)’ will be amended accordingly

SP (incl Tax): This shows the Sell Price including Tax.  The Tax rate used is that defined as the
default Tax under File>Financial Configuration>Tax Codes.  If the amount in this field is amended
then the previous field ‘Sell Price’ will be amended accordingly

Buy Price: Enter the Standard Buy Price for this Descriptor.  This will be the standard buy price
through the Purchasing system unless a Supplier Specific Pricing structure has been entered via
the ‘Pricing’ routine.  Refer to the above ‘Pricing’ button

Pricing: Click on this button to address the comprehensive pricing options available in Ostendo. 
For a guide to this function see ‘Descriptor Pricing’ under the ‘Pricing’ Menu  

Costing: Click on this button to maintain and/or view the Last and Standard Costs for this
Descriptor. For more information on Descriptor Costing refer to ‘Descriptor Costing’ under the ‘
Pricing’ Menu.    

Calculate Sell Price from Receipt Cost for Jobs: If this is ‘checked’ then the Job’s Sell Price of
this Descriptor will be calculated from the Receipt Cost rather than the Descriptor’s Pricing Level.
When this option is selected then a Markup % must be specified in the following field

Markup: If the previous field is ‘checked’ then this field will become active.  Enter the Markup %
that will be applied to the Receipt Cost to determine the Sell Price when used in a Job Order

Descriptor Classification: Descriptors can be used for many things.   Within Ostendo there are
three classifications that are addressed in different ways.  The options are:

· General Purpose - Used as if it was a non-stock Item.  The Pricing and Costs are as
above

Freeform: If this is ‘checked’ then whenever this Descriptor is received via the
Purchase Receipt function directly to a Job or Assembly Line then each receipt will
create a separate line in the Order.  If this is not ‘checked’ then the receipt will add
its ‘actual’ value to any existing line for the Descriptor

· Kitset Code - This is where a Kit contains many Parts that can be picked but the Sell
Price can (optionally) be at the Kitset (Descriptor) level

· Task Bill - This is where a Task Bill contains many Items, Descriptors and Activities for
detailed cost evaluation and scheduling but has a single ‘Task Bill’ for invoicing purposes

Descriptor Mobility Quantities: Use these settings when there is a requirement to capture
quantities completed or productivity rates (e.g. average lineal metres of carpet installed).

· Mobility Quantity Capture   - ( NA / Completed Qty Only / Completed Qty with Time /
Continuous Qty Only / Continuous Qty with Time / Start Stop Time Only / Start Stop Time
and Completed Qty )
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· Mobility Quantity Aggregate   - (SUM / MIN / MAX / LAST / ENTRYAVG /
HOURLYAVG )

· Log Quantities Against   - ( NA / Company Asset / Customer or Supplier / Site / Item  )
· Linked Company Asset   - select the appropriate Company Asset from the drop-down

list.
· Update Reading Name   - select the Reading Name if the Mobility Quantities are to be

associated with an Asset Reading. 

A short tutorial on this topic is provided here: 
http://ostendo.info/downloads/ostendo/Freeway_Recording_Qtys_And_Stats_Explained.pdf

General Notes: You can enter unlimited amount of Notes that are related to this Descriptor.
These notes will be available wherever the Descriptor is reported.   Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.   Select the text to be copied and either press the OK Button in that screen or
double-click the selected record.  Other Notes panels are available whose content will be carried
across to the relevant area that the Item is used.   I.e.

Sales Notes
Job Notes
Purchase Notes
Assembly Notes

Messages: You can enter up to 200 characters of Text that will be displayed in a ‘Message Bar’
across the centre of the Order Lines screen in Sales, Job, Purchase or Assembly Order screen. 
This will be displayed in a Red font and is intended to attract the attention of the person entering
the Order Line with information relevant to the Descriptor being added. 

The content of the message line can be plain text or can include fields from the Descriptor Master
record.  These fields will be populated with the latest information held against the Descriptor.  For
example: You may wish to show the Last Cost for the Descriptor whenever you are adding it to a
Sales Order.  Therefore the text would be (say)

The Descriptor’s Last Cost was [LASTCOST] which was on [LASTCOSTDATE]

This would display on the Order ‘Message’ Bar as 

The Descriptor’s Last Cost was $23.5 which was on 21/10/09

The fields in the square brackets are taken from the DESCRIPTORMASTER table.  To see the
available fields go to General>Reports>Full Listing of Tables and select DESCRIPTORMASTER

Buttons

Close: This will close the Descriptor screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Descriptor.  You may open and

http://ostendo.info/downloads/ostendo/Freeway_Recording_Qtys_And_Stats_Explained.pdf
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maintain information in those screens whilst still remaining in the Descriptor screen.

Reports: This will bring up a list of Reports that are related to the Descriptor.  You can immediately
run the report whilst still remaining in the Descriptor screen.

10.2.1 Descriptor Properties

This screen allows you to define properties that are specific to a Descriptor.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Descriptors in the system.

Display fields

Descriptor Code: Display only field showing all Descriptors in your database

Description: Display only field showing descriptions of the Descriptors

Unit: Display only field showing the Unit of Measure of the displayed Descriptors

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Descriptor Properties screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of new Descriptor Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields
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Descriptor Code: Display only field showing the Descriptor selected in the List screen

Description: Display only field showing the description of the Descriptor selected in the List screen

Unit: Display only field showing the Unit of Measure of the Descriptor selected in the List screen

Property: From the drop-down list select the Standard Property against which a value specific to
this Descriptor will be made.  Standard Properties are maintained via General>Settings>Standard
Properties

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Copy to SO Lines: If this checkbox is ‘checked’ then this property will be copied to a Sales Order
Line along with the Descriptor

Copy to Job Lines: If this checkbox is ‘checked’ then this property will be copied to a Job Order
Line along with the Descriptor

Copy to PO Lines: If this checkbox is ‘checked’ then this property will be copied to a Purchase
Order Line along with the Descriptor

Copy to Assy Lines: If this checkbox is ‘checked’ then this property will be copied to a Assembly
Order Line along with the Descriptor

Buttons

Close: This will close the Descriptor Properties screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Descriptor Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Descriptor Property record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Descriptor Property record.

10.2.2 Descriptor Documents

This screen allows you to define documents, etc that are specific to a Descriptor.    

List Tab

Display fields
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Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Descriptor to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Descriptor Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Descriptor Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Descriptor

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name that you are calling the document in this Document- Descriptor
linkage.  No checks are made on the entry.

Document Type: Prefilled with ‘Descriptor’

Linked to: From the drop-down list select the Descriptor that uses this document

Copy to Jobs: If this is ‘checked’ then the document link will be copied to all Job Orders where
this Descriptor is used.

Copy to Sales: If this is ‘checked’ then the document link will be copied to Sales Orders where this
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Descriptor is used.

Copy to Purchases: If this is ‘checked’ then the document link will be copied to Purchase Orders
where this Descriptor is used.

Copy to Assemblies: If this is ‘checked’ then the document link will be copied to Assembly Orders
where this Descriptor is used.

Print / Email with order: Tick this box if this document is to be included when printing / emailing
the order.

Print / Email with quote: Tick this box if this document is to be included when printing / emailing
the quote.

Correspondence:  Tick this box if this document is to be treated as correspondence in the
Operations Centre screen.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:- .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Descriptor Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Descriptor Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Descriptor Documents record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

10.2.3 Descriptor Images

This function allows you to link Images to a Descriptor.    

List Tab

Display fields

Image Name: The name of the Image as entered into the Details screen,

Linked To: This is the specific Descriptor to which this Image relates.

File Name: This is the full path name of the Image on your computer network.
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Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Descriptor Images screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Descriptor Images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Image from a Descriptor

View: If you select a line and then this button the Image will be displayed using your default Image
display software. 

Detail Tab

Entry and Display fields

Image Name:  Enter the name that you are calling the document on this Image - Descriptor
linkage.    No checks are made on the entry.

Image Type: Prefilled with ‘Descriptor’

Linked to: From the drop-down list select the Descriptor that uses this Image

Copy to Jobs: If this is ‘checked’ then the Image link will be copied to all Job Orders where this
Descriptor is used.

Copy to Sales: If this is ‘checked’ then the Image link will be copied to Sales Orders where this
Descriptor is used.

Copy to Purchases: If this is ‘checked’ then the Image link will be copied to Purchase Orders
where this Descriptor is used.

Copy to Assemblies: If this is ‘checked’ then the Image link will be copied to Assembly Orders
where this Descriptor is used.
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Display on Price List: If this is 'checked' then the Image will be displayed in the Price List. 

Image Details: locate the full path name of the Image.  It should be noted that the file extension
must be an image format (I.e. .jpg, .bmp, .ico, .wmf, .emf)

Preview: The selected Image is displayed for your reference

Buttons

Close: This will close the Descriptor Image screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Descriptor Image record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Descriptor Image record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

10.2.4 Descriptor History Notes

This function allows you to link multiple time-stamped notes to a Descriptor.

List Tab

Display fields

The displayed fields are taken from the Descriptor master record.  The selection of which fields to
display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon
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Buttons

Close: This will close the Descriptor History Notes screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Descriptor to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Call Classification: From the drop-down list select a Classification under which you wish to store
this History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.   Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this Descriptor is displayed in the lower part of the screen.
Each record will also have the first 3 lines of the notes displayed.  To view the full Notes simply
click on the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Descriptor History Notes screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Descriptor History Notes record.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Descriptor History Notes record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

10.2.5 Desc Mobility and Web

This function allows you to define additional information related to a Descriptor. Such information
are normally used in E-Commerce websites or in the Freeway Mobility app.   
This function and screens are accessed via the Related Menu button. 

List Tab

This displays the current list of Descriptors in the system.

Display fields

Descriptor Code: Display only field showing all Descriptors in your database

Description: Display only field showing descriptions of the Descriptors

Unit: Display only field showing the Unit of Measure of the displayed Items

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of the new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel



458 Ostendo Reference Guide

Detail Tab

Entry and Display fields

Descriptor Code: Display only field showing the Descriptor selected in the List screen

Description: Display only field showing the description of the Descriptor selected in the List screen

Unit: Display only field showing the Unit of Measure of the Descriptor selected in the List screen

Short Description: Enter a more detailed description of the Descriptor

Showcased: Tick this box if this is a showcased Descriptor. Showcased items are used in
E-Commerce sites to highlight or showcase certain items for marketing or promotional purposes.

Long Description Label: Enter a label for the Long Description if you wish to caption it differently. 
You can also include merged fields from the DESCRIPTORMASTER table. Merged fields must be enclosed
with double square brackets (e.g. [[STDSELLPRICE]] ).

Specification Description Label: Enter a label for the Specifications  if you wish to caption it
differently

Features Label: Enter a label for the Features if you wish to caption it differently

For example, the above three labels could be General Description, Technical Specs, Special
Features & Accessories (instead of Long Description, Specifications,Features)

Long Description Subtab
Enter a more comprehensive description of the Descriptor. This is usually a non-technical description of the
Descriptor.

Specifications Subtab
Enter any technical specifications for this Descriptor.

Keywords Subtab
Enter all the keywords associated with this descriptor. Keywords must be separated by commas. Keywords
are used much like how they are used in webpage searches.

Hierarchical Names Subtab

Entry and Display fields

Hierarchical Name: Select the Hierarchical Name that this Descriptor is associated with.

Hierarchical Level: Select the Hierarchical Level that this Descriptor is associated with.

A Descriptor could be associated with multiple Hierarchical Names and Levels.

Features Subtab
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Entry and Display fields

Group: Select the Features Group Name.

Seq No: Enter the sequence number.

Feature: Enter the feature description.
You can also include merged fields from the DESCRIPTORMASTER table. Merged fields must be enclosed
with double square brackets (e.g. [[STDSELLPRICE]] ).

Feature Notes: Enter any additional notes related to this feature.

A Descriptor can have many features. Feature Group names must be pre-defined in Inventory -
Settings - Feature Groups.

HTML SubTab: This allows you to key in the notes in HTML format using the appropriate
control keys.
You can also click on the Editor button which will bring up the editor screen with built-in
functions for entering notes in html format.

Text SubTab: This allows you to key in the notes in plain text. If you have keyed in the
notes using the Editor, this subtab will show the embedded html tags together with the
textual data

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: This enables you to delete the selected record.

Editor: This button calls up the HTML editor and enables you to key in notes related to the current
record.

10.2.6 Descriptor Markups

The main Descriptor Screen enables Ostendo to calculate a Sell Price based on a single Mark-Up
percentage being applied to the Receipt Cost of the Descriptor.   This screen allows you to
override that percentage by applying a markup percentage based upon the Price Level of the Job
or Customer.  This screen can be accessed by going into the main Descriptor Screen
(Inventory>Descriptors) and clicking on the 'Related' button located down the right hand side of the
screen.
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List Tab

This displays the current list of Descriptors in the system.

Display fields

Descriptor Code: Display only field showing all Descriptors in your database

Description: Display only field showing descriptions of the Descriptors

Unit: Display only field showing the Unit of Measure of the displayed Descriptors

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Descriptor Markups screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of new Descriptor Markups.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Descriptor Code: Display only field showing the Descriptor selected in the List screen

Description: Display only field showing the description of the Descriptor selected in the List screen

Unit: Display only field showing the Unit of Measure of the Descriptor selected in the List screen

Price Level: From the drop-down list select the Price Level against which a markup percentage
specific to this Descriptor will be applied.
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Markup %: Enter the markup percentage that will be applied  to the Price Level

Buttons

Close: This will close the Descriptor Markups screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Descriptor Markup record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Descriptor Markup record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Descriptor Markup record.

10.3 Lists

This screen allows you to create and maintain pre-defined Lists containing Items, Descriptors,
Catalogue Codes, and Labour Codes.   Lists can be called up in Sales Orders, Assembly Orders,
Purchase Orders and Jobs where the contents of the List are displayed.  The user then makes
selections (with quantities) of lines from the List.  These selections are then copied to the Order as
individual order lines.

List Tab

Display fields

The displayed fields are taken from the Inventory List information entered into the ‘Detail’ tab.   The
selection of which fields to display is at the user’s discretion.   To select the fields to display simply
‘right mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel you
can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Lists whose
status is ‘Inactive’
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Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Inventory Lists screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Inventory List.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Inventory List from this table

Related: This will bring up a list of functions that are related to the Inventory List.  You may open
and maintain information in those screens whilst still remaining in the Inventory List screen.

Reports: This will bring up a list of Reports that are related to the Inventory List.  You can
immediately run the report whilst still remaining in the Inventory List screen.

Detail Tab

Entry and Display fields

List Code: Entry is only allowed during an Add transaction.  Enter the name of the new List.  
Duplicate List names are not allowed

Description: Enter a brief description of the List.  A longer description can be entered into the
Notes (see below)

Status: Select the current status from the drop-down list.  The options are ‘Active’ or ‘Inactive

Selection Options: Select the button that applies to this List.  The options are:
List Available to All - This List is available to all Customers and Suppliers
List Linked to a Customer - Only available for use against a specified Customer
List Linked to a Supplier - Only available for use against a specified Supplier

Customer / Supplier: From the drop-down list select the Customer or Supplier.  The drop-down
list displays Customers or Suppliers dependent upon the above Selection Option

List Style: From the drop-down list select the Style by which the List will be presented during
Sales Order Line configuration.  The options are:

· Check List: All lines have a ‘checkbox’ against them to denote whether the line will be
used or not.  Additionally you can amend each line’s Order quantity and then, in the
Checklist Header enter a single quantity that will apply to each line and recalculate the
total line quantity

· Order Pad: All lines are displayed with the quantity field in the first column.  You can
simply accept the prefilled quantity or overtype with a new quantity (even if it is zero).  Any
line with a quantity greater than zero will be copied to the Sales Order

List Generation: 
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By default the List will contain pre-defined Items/Descriptors/Labour Codes and quantities as
entered via the 'Lines' tab.  However you can get Ostendo to automatically generate lists in one of
two ways

Default the Line Qty to the Order Qty:  If this box is ticked, then the Line Qty is used as the
default Order Qty.

The List is generated dynamically from Order History: Option is provided to auto generate the
Lines content - based on recent Sales history - every time it is used.  To use this feature you
should 'check' this checkbox.  Additionally you should enter:

Max Number of Days to Look Back - Enter the number of days of Sales History that you
want to be included in the List
Max Number of Orders - Enter the number of Orders against each Customer from Sales
History that you want to be included in the List

Default the Line Qty to the Order Qty : Tick this box if you wish to make the Line Qty the same
as the Order Qty by default.

Include Current Order in History Results - 'Check' this checkbox if you wish to include this
Order when looking at Order History calculations

Line Numbering: Select the button that applies when this List is used.  The options are:
Added to existing - The copied Lines will have their line numbers allocated from the end
of the current line numbers in the Order
Specific Numbers used - The line numbers defined here will be used when the selected
lines are copied to the Order.

Notes: You can enter unlimited amount of Notes that are related to this List.   Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Inventory List screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Inventory List.  You may open
and maintain information in those screens whilst still remaining in the Inventory List screen.

Reports: This will bring up a list of Reports that are related to the Inventory List.  You can
immediately run the report whilst still remaining in the Inventory List screen.

Lines Tab

This screen allows maintenance of the content of an Inventory List.   The List name is displayed at
the top of this panel.  The lines in the list range from a simple Item List and quantities through to an
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Item List showing quantities for selected variations of the same Item Number.  This feature is
useful when ordering (say) a garment with varying Colours and Sizes.  

When multiple variants of the same Item Code are copied to the Sales Order then a single Sales
Order Line will be created for the full quantity and the Variants, with their individual quantities, will
be copied to the ‘Planned Variants’ tab in the Order Line

Entry and Display fields

Line Number:  This is an optional entry field.   You should be aware of the Line Numbering option
defined in the ‘Detail’ tab.    I.e. If the option is 

· ‘Add to Existing’ then the program will allocate a sequential line number
· ‘Specific Number used’ then the program will use this number - even if it is blank

Code Type:  Select the Code Type from the drop-down list.  The options are:
· Item Code
· Descriptor Code
· Labour Code
· Catalogue Code
· Kitset Code

Code: From the drop-down list select the code.   The drop-down list displays the codes relating to
the selection made in the Code Type field

Description: The description is copied from the Item, Descriptor, or Labour Code record.  It may
be amended here and made specific to this List. 

Unit: The base unit is copied from the Item.   It may be amended here by selecting an alternate
unit from the drop-down list of other units held against the Item record.

Qty: Enter a default quantity to be used.   This will display during selection and copy to an order. 
It can be amended at that time and made specific to the Order.   If nothing is entered here then 1
is assumed.

Grade: If the Item has Grade Variants then you can enter the specific Grade against this List Line.
If it has no Grade Variants then it will be greyed out

Colour: If the Item has Colour Variants then you can enter the specific Colour against this List
Line.  If it has no Colour Variants then it will be greyed out

Size: If the Item has Size Variants then you can enter the specific Size against this List Line.  If it
has no Size Variants then it will be greyed out

Special Instructions : Enter any special instructions related to this item.

Buttons

Close: This will close the Inventory List screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new List Item.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line record was accessed or the last time the ‘Save’ Button
was pressed will be lost.
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Delete: This will delete the current highlighted record.

Related: This will bring up a list of functions that are related to the Inventory List.  You may open
and maintain information in those screens whilst still remaining in the Inventory List screen.

Reports: This will bring up a list of Reports that are related to the Inventory List.  You can
immediately run the report whilst still remaining in the Inventory List screen.

List Groups Tab

This screen allows you to define List Groups for use in this specific List.   List Groups can be
selected for each line in the List and serve to facilitate sorting of the List during Sales Order entry. 
I.e. The List will be presented in Line Number within Group Name sequence

Entry and Display fields

Group Name:  If you are grouping the List Lines then you should define the Groups here.  No
checks are made on the content however duplicates are not allowed

Buttons

Close: This will close the Inventory List screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line record was accessed or the last time the ‘Save’ Button
was pressed will be lost.

Delete: This will delete the current highlighted record.

Related: This will bring up a list of functions that are related to the Inventory List.  You may open
and maintain information in those screens whilst still remaining in the Inventory List screen.

Reports: This will bring up a list of Reports that are related to the Inventory List.  You can
immediately run the report whilst still remaining in the Inventory List screen.

10.4 Matrices

This screen allows you to create and maintain Matrices.  These Matrices are used in the Purchase
and Sales Order screens to facilitate the entry of multiple Order Lines using a single order entry
panel.  It is directed at those Businesses that have multiple variants of the same 'theme' (For
example: Apparel Style) and each variant combination is a unique Item Code in the Inventory
module

List Tab

Display fields

Matrix Style: This is display only that shows the current Matrix Styles that exist in Ostendo.    
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Description: Description of the Matrix Style taken from the Matrices record.

Matrix Type: The Matrix Type taken from the Matrices record.  The displayed options are:
· XY for a two dimensional array
· XYZ for a three dimensional array

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking against
will sort in descending order. 

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Matrices screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Matrix Style.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Matrix Style record from this table

Detail Tab

This tab enables you to maintain the Master record for this Matrix Style.  The variables and their
related Item Code are added in the ‘Lines’ tab

Entry and Display fields

Matrix Style: Enter a Matrix Style Identity.  Duplicate Matrix Styles are not allowed

Matrix Type: Select the Matrix Type.  The Options are
· XY if the Matrix comprises of two variables
· XYZ if the Matrix comprises of three variables

Description: Description of the Matrix Style.  A description must be entered.  However, no checks
are made on the entry content

X Axis: From the drop-down list select the Matrix Code that represents the first Variable.  Matrix
Codes are maintained via screen (Inventory>Settings>Matrix Dimensions).
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Y Axis: From the drop-down list select the Matrix Code that represents the second Variable.
Matrix Codes are maintained via screen (Inventory>Settings>Matrix Dimensions).

Z Axis: Only visible if Matrix Type XYZ (above) has been selected).  From the drop-down list select
the Matrix Code that represents the third Variable.  Matrix Codes are maintained via screen (
Inventory>Settings>Matrix Dimensions).

Notes: You can enter unlimited amount of Notes that are related to this Matrix Style.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record. 

Buttons

Close: This will close the Matrices screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will present this screen in preparation for entry of a new Matrix Style record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Lines Tab

This tab facilitates the entry and maintenance of all the variants that apply to this Matrix Style.  It
allows you to associate X, Y and Z variant combinations to specific Item Codes or Descriptors.  

Entry and Display fields

Code Type: From the drop-down list select the line type that the variant combination will relate to.
The options are:

· Item Code
· Descriptor Code

Line Code: From the drop-down list select the Item or Descriptor Code to which the variant
combination will apply.

Unit: For Descriptors this is a display only field.  For Item Codes this is prefilled with the Item's
base Unit.  You may select any other Unit currently valid for this Item from the drop-down list.

(X Axis): The column heading is the X-Axis Matrix Code selected in the 'Details' tab.  Select the
specific variable within this Matrix Code from the drop-down list.   Note: This list is maintained via 
Inventory>Settings>Matrix Dimensions.

(Y Axis): The column heading is the Y-Axis Matrix Code selected in the 'Details' tab.  Select the
specific variable within this Matrix Code from the drop-down list.   Note: This list is maintained via 
Inventory>Settings>Matrix Dimensions.

(Z Axis): The column heading is the Z-Axis Matrix Code selected in the 'Details' tab.  Select the
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specific variable within this Matrix Code from the drop-down list.   Note: This list is maintained via 
Inventory>Settings>Matrix Dimensions.

Buttons

Close: This will close the Matrices screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Variant.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will remove the current Variant from this Matrix Style

10.5 Serial Kits

Serial Kits are individual – unique - Serial Numbers within an Item.  Each Serial Kit can comprise of
one or more Items that may vary in their individual attributes (Colour, Size, Batch, Serial Number,
Expiry Date, etc).  When a Serial Kit Item is received into stock, and given a Serial Number,
Ostendo will attach a ‘Template’ Kit ‘Content’ List as defined against the Serial Kit Item record.

This screen allows you to view each generated Serial Kit and its associated Kit List and then allow
you to add, change, or delete the Kit content. 

List Tab

This tab shows the Serial Kits that have been generated when the Serial Kit was received into
stock.  It is display only and data cannot be amended.  However you can define which fields are
displayed by clicking 'Right Mouse' in the centre of the screen and selecting 'Customize Fields'

Display fields

Item Code: Display only showing the Serial Kit Item Code.

Status: Display only showing the current status of the Serial Kit Item Code.  The display options
are:

· InStock - Currently in stock
· Issued - Issued to an Order

Description: Display only field showing the Description of the Serial Kit Item Code

Serial Number: Display only field showing the specific Serial of the Serial Kit Item

Unit: Display only field showing the base Unit of Measure of the Serial Kit Item Code

Lines: Display only field showing the number of Kit content lines that are held within the Serial Kit.
These can be viewed and amended in the ‘Lines’ tab

Lines Incomplete: Any Kit content line that that has variables (Colour, Size, Serial Number, etc)
should have those variables defined via the ‘Lines’ tab,  This field shows the number of ‘variable’
Lines that have not been completed
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(Checkbox) Include Issued: The basic display will only show those Serial Kits that are currently in
stock.  ‘Check’ this checkbox to also view ‘Issued’ Serial Kits.

Buttons

Close: This will close the Serial Kits screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: Not active in this view

Save: Not active in this view

Cancel: Not active in this view

Delete: Not active in this view

Related: This will bring up a list of functions that are related to the Serial Kit.  You may open and
maintain information in those screens whilst still remaining in the Serial Kit screen.

Reports: This will bring up a list of Reports that are related to the Serial Kit.  You can immediately
run the report whilst still remaining in the Serial Kit screen.

Detail Tab

This tab shows details of the selected Serial Kit.  It is display only except for the ability to add ‘
Notes’ to the Serial kit

Input and Display fields

Item Code: Display only showing the Serial Kit Item Code.

Status: Display only showing the current status of the Serial Kit Item Code.  The display options
are:

· InStock - Currently in stock
· Issued - Issued to an Order

Description: Display only field showing the Description of the Serial Kit Item Code

Serial Number: Display only field showing the specific Serial Number of the Serial Kit Item

Unit: Display only field showing the base Unit of Measure of the Serial Kit Item Code

Total Number of Content Lines: Display only field showing the number of Kit Content  lines that
are held within the Serial Kit.  These can be viewed and amended in the ‘Lines’ tab

Number of Content Lines missing tracked info: Any Kit Content line that that has variables
(Colour, Size, Serial Number, etc) should have those variables defined via the ‘Lines’ tab,  This
field shows the number of ‘variable’ Lines that have not been completed

Create Warranty Record for Contents: If this is 'checked' then, when the Serial Kit is sold, any
Item in the Kit that is flagged as having a linked Warranty reference will have a Warranty record
generated
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Notes: Open format field into which you can add notes that are specific to this record

Buttons

Close: This will close the Serial Kits screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: Not active in this view

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not active in this view

Related: This will bring up a list of functions that are related to the Serial Kit.  You may open and
maintain information in those screens whilst still remaining in the Serial Kit screen.

Reports: This will bring up a list of Reports that are related to the Serial Kit.  You can immediately
run the report whilst still remaining in the Serial Kit screen.

Lines Tab

This tab allows you to add, change, or delete the Kit Contents in addition to including any specific
attributes about each line such as Colour, Length, Expiry Date, etc.

Input and Display fields

At the top of the panel

Item Code: Display only showing the Serial Kit Item Code.

Serial Number: Display only field showing the specific Serial Number of the Serial Kit Item

In the multi-line panel

Component Code: The Item Code that is included in the Serial Kit.

Description: Description of the Item Code taken from the Item record.

Unit: The Unit of Measure of the Item Code.  This is prefilled with the base unit for the Item but
can be amended to any other unit applicable to the Item by selecting that Unit from the drop-down
list.

Qty: Enter the Kit Content quantity for the Unit of Measure.  This can only be 1 if the Item is Serial
Controlled

Serial Number: If the Item is Serial Controlled then enter the Serial Number here

Expiry Date: If the Item is Expiry Date Controlled then enter the Expiry Date here

Batch No: If the Item is Batch Number Controlled then enter the Batch Number here
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Rev No: If the Item is Revision Number Controlled then enter the Revision Number here

Size: If the Item is Size Controlled then enter the Size here

Colour: If the Item is Colour Controlled then enter the Colour here

Grade: If the Item is Grade Controlled then enter the Grade here

Notes: Enter any additional notes that are specific to this line such as Length, Width, etc

Buttons

Close: This will close the Serial Kits screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Content Item Code

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Content Line record

Related: This will bring up a list of functions that are related to the Serial Kit.  You may open and
maintain information in those screens whilst still remaining in the Serial Kit screen.

Reports: This will bring up a list of Reports that are related to the Serial Kit.  You can immediately
run the report whilst still remaining in the Serial Kit screen.

10.6 Warehouses

This screen allows you to maintain Warehouses that are used in Ostendo.   These Warehouses
are referenced extensively throughout Ostendo.  Each Warehouse record contains details of
where it is located and if it should be taken into account during the Stock Replenishment routine

List Tab

Display fields

Warehouse Code: The Warehouse Name as entered into the ‘Detail’ tab.   

Description: Description of the Warehouse taken from the Warehouse record.   

Site Name: Place where the Warehouse is located taken from the Warehouse record.   

Status: The default status is 'Active'.  If you wish to make this status 'Inactive' then select it from
the drop-down list.  Once selected the Warehouse will NOT be visible in Warehouse drop-downs

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Warehouse screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Warehouse.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Warehouse from this table

Related: This will bring up a list of functions that are related to the Warehouse.  You may open
and maintain information in those screens whilst still remaining in the Warehouse screen.

Reports: This will bring up a list of Reports that are related to the Warehouse.  You can
immediately run the report whilst still remaining in the Warehouse screen.

Detail Tab

Entry and Display fields

Warehouse Code: Entry is only allowed during an Add transaction.   Enter the name of the new
Warehouse.   Duplicate Warehouse Codes are not allowed.

Status: The default status is 'Active'.  If you wish to make this status 'Inactive' then select it from
the drop-down list.  Once selected the Warehouse will NOT be visible in Warehouse drop-downs

Description: Enter a brief description of the Warehouse.  This description will accompany the
Warehouse wherever it is used in Ostendo.  No validation checks are carried out on this entry.

Company:  From the drop-down list select the site where this Warehouse is located.  The options
are:

Site - You own (company owned) Site
Customer - A Customer’s Site
Supplier - A Supplier’s Site

Exclude Inventory from Replenishment: If this is ‘checked’ then the Warehouse’s Inventory will
be excluded from the Inventory Replenishment routine

Name: From the drop-down list select the address this Warehouse is located.  The displayed
drop-down list is directly related to the ‘Site’ selection made above.  I.e:
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If ‘Site’ selected then drop-down will show only Company sites
If ‘Customer’ selected then drop-down will show Customers only
If ‘Supplier’ selected then drop-down will show Suppliers only

Cost Centres: If you wish to have Financial Controls at a Warehouse Level then, from the
drop-down list, select the Cost Centres to cover the following transactions.  If nothing is selected
then the system defaults identified in Cost Centre Mapping will be used

· Inventory: All Stock in this Warehouse will be posted to this Cost Centre.  
· Adjustments: Stock Adjustments against this Warehouse are ‘received from’ or ‘issued to

’ this Cost Centre. 
· Negative Stock: Stock adjustment variances can occur whenever you receive Stock but

the current stock levels are negative.  In this case the Average Cost for the Item is not
amended but the difference between the Average Cost and the Cost of this receipt is ‘
posted’ to this Cost Centre

· Re-Valuation: Whenever the Stock is re-valued  (Standard Cost or Average Cost) the
difference between the old value and the new value is ‘posted’ to this Cost Centre

· Stock Count: Stock variances (plus or minus) as a result of a Stock Count are ‘posted’ to
this Cost Centre.  

· Receipt Cost Var: Used if the Inventory Costing method is ‘Standard Costing’ and this
stores the cost difference between the Purchase Receipt actual Cost and the Standard
Cost of the Item. 

· Assembly Cost Var: Used if the Inventory Costing method is ‘Standard Costing’ and this
stores the cost difference between the Assembly Order actual Cost and the Standard Cost
of the Item. 

Notes: You can enter unlimited amount of Notes that are related to this Warehouse.  These notes
will be available wherever the Warehouse record is accessed.  Whenever you click on this field an
icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.   Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

Categories Tab

This panel allows you to define Financial Controls at an Item Category level within each
Warehouse.  From the drop-down list, select the Cost Centres to cover the following transactions. 
If nothing is selected then the Warehouse defaults identified in the Warehouse Cost Centre
Mapping will be used

Category: From the drop-down list select the Category to which the following Cost centres will be
applied.

Cost Centres: For each Warehouse/Category combination you can select the following Cost
centres

· Inventory: All Stock in this Category/Warehouse will be posted to this Cost Centre.  
· Adjustments: Stock Adjustments against this Category/Warehouse are ‘received from’ or

‘issued to’ this Cost Centre. 
· Negative Stock: Stock adjustment variances can occur whenever you receive Stock but

the current stock levels are negative.  In this case the Average Cost for the Item is not
amended but the difference between the Average Cost and the Cost of this receipt is ‘
posted’ to this Cost Centre

· Re-Valuation: Whenever the Stock is re-valued  (Standard Cost or Average Cost) the
difference between the old value and the new value is ‘posted’ to this Cost Centre

· Stock Count: Stock variances (plus or minus) as a result of a Stock Count are ‘posted’ to
this Cost Centre.  

· Receipt Cost Var: Used if the Inventory Costing method is ‘Standard Costing’ and this
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stores the cost difference between the Purchase Receipt actual Cost and the Standard
Cost of the Item. 

· Assembly Cost Var: Used if the Inventory Costing method is ‘Standard Costing’ and this
stores the cost difference between the Assembly Order actual Cost and the Standard Cost
of the Item. 

Buttons

Close: This will close the Warehouse screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Warehouse.  You may open
and maintain information in those screens whilst still remaining in the Warehouse screen.

Reports: This will bring up a list of Reports that are related to the Warehouse.  You can
immediately run the report whilst still remaining in the Warehouse screen.

10.6.1 Warehouse Properties

This screen allows you to define properties that are specific to a Warehouse.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Warehouses.

Display Fields

Warehouse Code: Display only field showing the Warehouse Name held against the Warehouse
record.

Description: Display only field showing the description of the Warehouse held against the
Warehouse record.

Where: Display only field showing where the Warehouse is located.  The displayed options will be
Site, Customer, or Supplier

Name: Display only field showing the specific Company, Customer or Supplier Site where the
Warehouse is located.

Data Display Options

The displayed fields are taken from the Warehouse Details.  The details can be viewed as follows: 

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Warehouse Properties screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Warehouse Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Warehouse Code: Display only field showing the Warehouse selected in the List screen

Description: Display only field showing the description of the Warehouse selected in the List
screen

Property: From the drop-down list select the Standard Property against which a value specific to
this Warehouse will be made.

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Buttons

Close: This will close the Warehouse Properties screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Warehouse Property record.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Warehouse Property record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Warehouse Property record.

10.7 Locations

This screen allows you to maintain Warehouse Locations that are used in Ostendo.  These
Locations are referenced extensively throughout Ostendo.  Each Location record contains details
of the Warehouse to which it belongs, its Location Group and the Location sequence.

List Tab

Display fields

Warehouse Code: The Warehouse that contains the Location Code Name

Location Code: The Location Code as entered into the Details panel.

Description: Description of the Location taken from the location record.   

Group: Group to which the Location belongs taken from the location record.   

Sequence: Check Sequence Number taken from the location record.   

Status: The Status of the Location taken from the location record.  

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Locations screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Location.

Save: Not applicable to the List panel
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Cancel: Not applicable to the List panel

Delete: This removes the current Location from this table

Related: This will bring up a list of functions that are related to the Location.  You may open and
maintain information in those screens whilst still remaining in the Location screen.

Reports: This will bring up a list of Reports that are related to the Location.  You can immediately
run the report whilst still remaining in the Location screen.

Detail Tab

Entry and Display fields

Location Code:  Entry is only allowed during an Add transaction.   
· If the Item Rule (Inventory>Settings>Item Rules) 'Auto Build Location Code' is 'checked'

then the Location Code will automatically be constructed from the Aisle,Rack,Row entries
made below

· If the Item Rule (Inventory>Settings>Item Rules) 'Auto Build Location Code' is not 'checked'
then enter the name of the new Location.   Duplicate Location Codes within the same
Warehouse is not allowed.

Description: Enter a brief description of the Location.   This description will accompany the
Location wherever it is used in Ostendo.   No validation checks are carried out on this entry.

Status: The default status is 'Active'.  If you wish to make this status 'Inactive' then select it from
the drop-down list.  Once selected the Location will NOT be visible in Location drop-downs

Warehouse: From the drop-down list select the Warehouse against which this location is being
added.

Group: From the drop-down list select the group to which this Location belongs.   Location Groups
are user-defined (via Inventory>Settings>Location Groups).   Examples of Location Groups could
be Hazard, Electrical, Oils, etc

Location Sequence: The location sequence is intended for use in Inventory Check routines to sort
the locations into a sequence compatible with the stocktake function.   For example Row 5 Bin 201
could have a Sequence of 5001

Aisle: From the drop-down list select the Aisle in which this location is situated.   Location Aisles
are user-defined (via Inventory>Settings>Location Aisles).   

Rack: From the drop-down list select the Rack in which this location is situated.   Location Racks
are user-defined (via Inventory>Settings>Location Racks).   

Row: From the drop-down list select the Row in which this location is situated.   Location Rows are
user-defined (via Inventory>Settings>Location Rows).   

Weight: Enter the maximum Weight that can be held in this Location.  This will provide information
when determining if an Item can be stored at this location taking into account current Inventory
held here

Volume: Enter the maximum Volume that can be held in this Location.  This will provide
information when determining if an Item can be stored at this location taking into account current
Inventory held here
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Location Barcode: Enter the location barcode string value here.

Notes: You can enter unlimited amount of Notes that are related to this Location.   These notes
will be available wherever the Location record is accessed.  Whenever you click on this field an
icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.   Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

Buttons

Close: This will close the Location screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Location.  You may open and
maintain information in those screens whilst still remaining in the Location screen.

Reports: This will bring up a list of Reports that are related to the Location.  You can immediately
run the report whilst still remaining in the Location screen.

10.7.1 Location Properties

This screen allows you to define properties that are specific to an Inventory Location.   Property
titles are user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Warehouse Locations.

Display fields

Warehouse Code: The Warehouse that contains the Location Code Name

Location Code: The Location Code as held against the location record.

Description: Description of the Location taken from the location record.   

Group: Group to which the Location belongs taken from the location record.   

Sequence: Check Sequence Number taken from the location record.   

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
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and sorting:
· To sort the data in a selected column simply click on the column heading.  Clicking

against will sort in descending order.
· Click on the black ‘down arrow’ to the right of your selected column heading and you can

either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Location Properties screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Location Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Location Code: Display only field showing the Location selected in the List screen

Description: Display only field showing the description of the Location selected in the List screen

Warehouse: Display only field showing the Warehouse to which the Location belongs.

Property: From the drop-down list select the Standard Property against which a value specific to
this Location will be made.

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Buttons

Close: This will close the Location Properties screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Location Property record.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Location Property record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Location Property record.

10.8 Item Batches

Item Batch records will now automatically be created when Batch Tracked items are receipted into
stock from Purchasing, Assemblies and Adjustments. This will allow additional information
to be trapped

later against this batch either manually through the Item Batch screen or by Freeway (NB: The
Freeway portion is currently under development and will be released later)

Item Batch records now contain the following fields to allow further data to be captured:
o Batch Status

o Supply Style

o Source

o Manufacture Date

o Expiry Date

List Tab

Display fields

Item Code: Display-only field.

Description: Display-only field.

Unit: Display-only field.  

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons
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Close: This will close the Locations screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Location from this table

Related: This will bring up a list of functions that are related to the item.

Reports: This will bring up a list of Reports that are related to the item. 

Detail Tab

Entry and Display fields

Item Code:  Display-only field.   

Description: Display-only field.

Unit : Display-only field.

Restrict Batch Numbers to the List Below : Tick this box if you wish to restrict Item Batch
Numbers for this item.

Batch Information

List tab

Batch No. : Enter the Item Batch number here.

Description: Enter a brief description.

Batch Status : Select from the drop-down list (Approved / OnHold / QC Required / Rejected)

Supply Style: Select from the drop-down list (Purchased / Manufactured / Adjustment)

Source : Enter the Source of the batch.

Manufacture Date: Enter the date of manufacture.   

Expiry Date: Enter the batch expiry date.  (Use Inventory Change to amend these dates on
existing inventory records)

Notes: You can enter unlimited amount of Notes that are related to this batch.   

Properties tab (Standard Properties can be linked to a Batch for the purposes of recording test
results. (Eventually Freeway will allow you to update these from a new “Property” field in a
checklist)).
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Batch No. : Display-only field showing the linked Item Batch number.

Property : Enter/select the name of the property here.

Value : Enter the value of the property here.

Market Codes tab (The concept of this is to restrict the issuing of specific items and batches to
customers. An example of this is where a customer associated with a particular market eg: EU can
only purchase items and Batches flagged as EU Market Code. Only items or item batches that
have restrictions need to be flagged with a Market Code. All other items (without that defined) will
be available for sale to all Markets. Markets Codes are initially setup from
Inventory->Settings->Market Codes)

Batch No. : Display-only field showing the linked Item Batch number.

Market Code : Select the appropriate Market Code to restrict this item batch to.

Status Change Log tab
This screen logs all the changes to the Item Batches. The latest change appears as the first
record.

Batch No. : Display-only field showing the linked Item Batch number.

Old Status : Display-only field showing the previous batch status.

New Status : Display-only field showing the new batch status.

From User or Employee : Display-only field showing the Ostendo User or Mobility employee who
created this record.

From Name : Name of Ostendo User or Mobility Employee. 

Change Source : The source of the change.

Data Sheet ID : The Datasheet ID, if this record came from Freeway.  

Changed Date : The date this record was created.

Changed Time : The time this record was created.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new batch record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.
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Delete: this will delete the current highlighted record.

Related: This will bring up a list of functions that are related to the item. (e.g. Item Batch
Documents)

Reports: This will bring up a list of Reports that are related to the item. 

10.9 Inventory Availability

This screen allows you to view the current and projected availability status of selected Inventory
items.  It has three views:

· Current Inventory by Location
· Project Stock Availability
· Current Supply and Demand orders

List Tab

Display fields

The displayed fields are taken from the Item record.  The selection of which fields to display is at
the user’s discretion.  To select the fields to display simply ‘right mouse’ in the main panel and
select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Inventory Availability screen.  

Detail Tab

This screen shows details of the selected Item with option to display 3 views
· Current Inventory by Location
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· Project Stock Availability
· Current Supply and Demand orders

Entry and Display fields

Item Code: Display only field showing the Item selected in the ‘List’ screen

Unit: Display only field showing the base Unit of Measure of the selected Item.

Description: Display only field showing the description of the selected Item.

Barcode: Display only field showing the Barcode of the selected Item.

Status: Display only field showing the current status of the selected Item.

Filtered By Site: This checkbox will be active if this User's Options (File>System
Configuration>User Security and Options) has both the following checkboxes 'checked':

· Inventory Availability by Site
· Allow Inventory Site Change

(Site Name): This field provides the option to select the Site if the previous checkbox is active and
has been 'checked'   Select the Site from the drop-down List of Company Sites

Projected Availability Settings

Period Length: This allows you to vary the period length shown on the ‘Projected Availability’ tab.
The options in the drop-down list are: Daily, Weekly or Monthly time buckets.

Include Planned Orders: If this checkbox is ‘Checked’ then the Projected Availability view will
include Planned Orders in the projected balances.

Inventory Information

These fields show inventory information relating to the base Unit Of measure

· On-Hand: Display only field showing the current calculated on hand quantity of the Item
across all Warehouses and Locations.

· Supply: Display only field showing the sum of the current Supply Orders (Purchase Orders
and Assembly Orders).

· Demand: Display only field showing the sum of the current demand orders (Sales Orders,
Assembly Orders, and Job Orders).

· Available: Display only field showing the Available quantity (calculated from the above
On-Hand + Supply - Demand).

· Free Qty: Display only field showing the Free quantity.  This ignores any outstanding Supply
Orders.  I.e. It is calculated from the above On-Hand - Demand.

Next Supply Date: Display only field showing the date when the first Supply order is scheduled to
be received

Item Info: Clicking on this button will display more details about the selected Item.  These include:
Re-Order Level: This is used in the Inventory Replenishments Routine to define the stock
level at which the program generates a Planned Supply order.   
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Minimum Re-Order Quantity: This is used in the Inventory Replenishments Routine to
define the minimum quantity to order when the stock is at, or below, the Re-Order Level. 
The Replenishment Routine will generate a Planned Order based on the greater of the
actual demand or the Re-Order Quantity.

Lead Time: The number of days that it normally takes from placing the order to obtaining
the Item. This lead-time will be applied to both Purchase Orders and Assembly Orders to
determine when the order should be placed.  

Default Supply Method: This defines whether the Item is:
Supply From Stock - Supply to Sales Orders, Assembly Issues, Job Orders will
come from stock.  In this instance Inventory will normally be maintained using the
Inventory Replenishment routine.
Source On Demand - Whenever a demand (Sales Order, Assembly Issue, Job
Order) is made then Ostendo will immediately create a matching ‘Planned’ Supply
Order (Assembly Order or Purchase order)

Sourced By: This is the normal method by which this Item is sourced and will allow
Ostendo to generate planned orders in the area where it is sourced (Assembly or
Purchase).  These are:

Purchasing - fully purchased Item
Assembly - Assembled in-house
Supplier Assembled - Components sent to Supplier for Assembly

Default Supplier: This is used by the Replenishment routine, or Source on Demand
function to generate a planned Order linked to a preferred Supplier.   

Default Issue Warehouse: The default Warehouse from where this Item is normally
issued.   This will prefill any Issue transaction for this Item but can be changed before
physical issue. 

Default Issue Location: The default Location within the selected issue Warehouse.  This
will prefill any Issue transaction for this Item but can be changed before physical issue. 

Default Receipt Warehouse: The default Warehouse into where this Item is normally
received.  This will prefill any receipt transaction for this Item but can be changed before
physical receipt. 

Default Receipt Location: The default Location within the selected receipt Warehouse. 
This will prefill any receipt transaction for this Item but can be changed before physical
receipt. 

Alternate Item Available: If this is ‘Checked’ then an alternative Item is available when
this Item cannot be supplied.  The next field shows the Alternative Item Code.

Size On-Hand Qty: If this Item is flagged as having a Variable Unit of Measure (in the Item Units
screen linked to the Item Master screen via the ‘Related’ button) then this field will be displayed
which shows the On-Hand Quantity for the Item in the Variable Unit Of Measure using its default
conversion factor.

Size Unit: If this Item is flagged as having a Variable Unit of Measure (in the Item Units screen
linked to the Item Master screen via the ‘Related’ button) then this field will be displayed which
shows the Variable Unit of Measure.

Pack Sizes
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These fields show inventory information relating to the Pack Size

· On-Hand: Display only field showing the current calculated on hand quantity of the Item
across all Warehouses and Locations.

· Supply: Display only field showing the sum of the current Supply Orders (Purchase Orders
and Assembly Orders).

· Demand: Display only field showing the sum of the current demand orders (Sales Orders,
Assembly Orders, and Job Orders).

· Available: Display only field showing the Available quantity (calculated from the above
On-Hand + Supply - Demand).

· Free Qty: Display only field showing the Free quantity.  This ignores any outstanding Supply
Orders.  I.e. It is calculated from the above On-Hand - Demand.

Show Qty in Pack Size: If this is 'checked' then the information in the 'Inventory by Location' and
'Projected Availability' tabs will be in the Pack Size selected in the next field

Pack Size: From the drop-down list select the Pack Size by which the quantities in the 'Inventory
by Location' and 'Projected Availability' tabs will be displayed.  If you only have one pack size
against the Item then it will automatically prefill this field.

Inventory By Location Tab

This screen shows all the current stock locations for the selected Item and the stock at that
location.   Where the Item has variants (Unit of Measure, Batch Number, Colour, etc) then all
variants are displayed.  
On this panel you can move the field position by dragging the column heading left or right to the
position where you want it to appear.

Projected Availability Tab

This screen uses the periods defined in the above ‘Detail’ screen and dynamically calculates the
anticipated Issues and Receipts by period.    Each Period will show

Qty on Hand - Quantity on hand at the beginning of this period
(-) Sales Orders - Sales Orders whose lines are due to be despatched this period
(-) Job Orders - Job Orders whose lines are due to be completed this period
(-) Assembly Issues - Assembly Order Components that are due to be issued this period
(+) Purchase Orders - Purchase Order Lines due to be received in this period
(+) Assembly Receipts - Assembly Orders that are due for completion this period
(-) Rentals Out – Rental Orders planned or actually issued in this period
(+) Rentals In - Rental Orders planned or actually returned in this period
Expected On-Hand Qty - Result of periods anticipated Issues and Receipts

Note: you have the option (on the Details tab) to include or exclude Planned Orders (those orders ‘
Suggested’ via the Replenishment routine.

Order Details Tab

A view is available that shows all the Supply and Demand orders against this Item.  These are
initially sorted in Date sequence.  The displayed fields are:

Date: The date when the Order is due
Type: ‘Demand’ or ‘Supply’
Class: Order Source (Example: Sales, Purchase, Jobs, etc)
Order No: The Order Identity within the Order Source
Status: The current status of the Order
Order Qty: The total quantity ordered via the above order
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Remaining Qty: The outstanding quantity held against this order
Original Order Qty: The original order quantity for this order
Original Remaining Qty: The original Remaining Quantity held against this order
Original Unit: The unit of the original order.
Customer or Supplier: The Customer or Supplier Name related to this line
Site Name: The Site Name related to this line

Transaction History Tab

This screen shows the Transaction History for the selected Item.  The display opens in reversed
date sequence.   Where the Item has variants (Unit of Measure, Batch Number, Colour, etc) then
all variants are displayed.  

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Data Display Fields

Item Code: The Code identifying the Item whose Transaction history is being reviewed

Unit: The base Unit of Measure held against the above item

Description: Brief description of the above item

Date: The Date when the transaction was carried out

Qty: The quantity involved in the Transaction 

Running Total: The cumulative running total of each line quantity  

Unit: The Unit of Measure covered by the Transaction

Source: The Functional area source of the Transaction.  The displayed options are:
Adjustment
Sales Issue
Job Issue
Purchase Receipt
Transferred
Assembly Receipt
Assembly Issue

Type: The ‘Adjustment Type’ of the transaction.  Adjustment Types are maintained via
Inventory>Settings>Adjustment Types and applied to the transaction at the time
transaction is being carried out.
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Reference: The Reference relating the Transaction.  The Reference relates to the ‘Source
’.   I.e:

Adjustment Batch Number if source is Adjustment
Transfer Batch Number if source is Transferred
Sales Order Number if Source is Sales Issue
Job Order Number if Source is Job Issue
Assembly Order Number if Source is Assembly Issue or Assembly Receipt
Purchase Order Number if Source is Purchase Receipt

Variants: If the Item has ‘sub-level’ variants such as Serial Number, Batch Number,
Colour, etc then the fields applicable to the Item will be displayed.

Customer or Supplier: The Customer or Supplier Name related to this line

Right-clicking on any Transaction History line will bring up the following menu of functions:

Print Grid: selecting this function will print the Transaction History grid
Export Grid: This will export the grid as pdf / xls / xlsx / html / xml / csv
Clear Sorting: This will clear the sort sequence
Go To Order:  This will display the associated order
Go To Invoice: This will display the associated invoice.

Buttons

Close: This will close the Transaction History screen.  

10.10 Mass Rental Availability

This shows, for a selected Category, all Items and their available quantity for rental over a
specified time period

Start Date: From the drop-down Calendar select the start date from which you want the availability
screen to commence

End Date: From the drop-down Calendar select the end date at which you want the availability
screen to finish

Category: From the drop-down list select the Item Category that you wish to be displayed.

Buttons

OK:  Click this button to evaluate the availability of Items within the specified Category

Cancel: This will close this panel without showing the Availability screen

Display fields

This screen shows all the Items in the selected Category along with their nett Availability (Total
Inventory minus 'On-Rental') over the specified date range

Buttons
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Inventory Availability: This will bring up the Inventory Availability screen for the current line
selected in the upper part of the screen

Close: This will close this screen

10.11 Inventory Adjustments

This screen allows you to make miscellaneous Inventory Adjustments.  These adjustments can be
either positive (Receipts) or negative (Issues) quantities.

The process for Inventory Adjustments comprises the following Steps
· Create an Adjustment Batch
· ‘Save’ the Batch Header and go to the ‘Lines’ tab
· Add Lines to the Batch - separate line to cover each stock adjustment
· Go back to the Batch Header
· Post the Batch - Ostendo generates the stock movements

Note: Until a Batch is ‘Posted’ the stock movement will not be recorded against the included
Item(s)

List Tab

Display fields

Adjustment No: This is the Adjustment Number as generated by Ostendo and provides a unique
reference to the Batch. 

Reference: The Reference attached to this Adjustment Batch as entered into the Details screen,

Status: The status of this Adjustment Batch.  There are two statuses (In Progress and Updated),
which are maintained by the program. 

Adjustment Date: The date held against the Adjustment Batch.  Initially this is the system date but
it can be amended at any time prior to updating the Batch

Site Name: The name of the Site where this adjustment batch was made

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Adjustment Batches that have not
been updated.   If you wish to see all batches including those that have been updated then ‘check’
this checkbox. 
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Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Inventory Adjustments screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Adjustment Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to an Adjustment Batch with status ‘In Progress’.
In this instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to the Inventory Adjustment.  You may
open and maintain information in those screens whilst still remaining in the Inventory Adjustment
screen.

Reports: This will bring up a list of Reports that are related to the Inventory Adjustment.  You can
immediately run the report whilst still remaining in the Inventory Adjustment screen.

Detail Tab

This tab enables you to create and maintain an Adjustment Batch Header.   After creation of a
Batch Header it must be saved (click on the ‘Save’ Button) before Lines can be added 

Entry and Display fields

Adjustment No: This is a unique number automatically allocated by the program.  It cannot be
amended.

Status: This is the status of the Adjustment Batch and is maintained by the program.  The
displayed variants are:

In Progress - The Adjustment Batch is still being worked on
Updated - The Adjustment Batch has been ‘Posted’ and Stock movements created for the
included Items

Reference: Enter a brief description of the Adjustment Batch.  No validation checks will be carried
out on this field.

Site Name: From the drop-down list select the Site at which the Adjustment is to be made.

Adjustment Date: This is prefilled with the system date.  It can be amended at any time up to
Posting the Batch by entering the date or by clicking on the drop-down menu and selecting the
date.

Financial Category: Select the Financial Category for this Adjustment if applicable.

Post All Adjustments: If this button is selected then all the adjustments contained in the ‘Lines’
panel will be actioned and stock movement transactions created.  The status of this Batch will then
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be amend to ‘Updated’

Company Style:  (Customer / Supplier / None - default): This allows you to link

the Chep pallet transaction to a Customer or Supplier. 

Company Name:  Select the name of the customer or supplier.

Notes: Extended Notes for your own information can be attached to this Adjustment Batch. 
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Inventory Adjustments screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Adjustment Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Adjustment Batch Header record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Inventory Adjustment.    You
may open and maintain information in those screens whilst still remaining in the Inventory
Adjustment screen.

Reports: This will bring up a list of Reports that are related to the Inventory Adjustment.   You can
immediately run the report whilst still remaining in the Inventory Adjustment screen.

Lines Tab

This tab enables you to add and maintain Adjustment lines.  The Adjustment Batch Number and
status will be displayed at the top of the panel.

Entry and Display fields

Warehouse: From the drop-down list select the Warehouse against which the adjustment is being
made.

Location: From the drop-down list of Locations within the above Warehouse select the location
where the adjustment is being made.

Item Code: From the drop-down list select the Item Number against which the adjustment is being
made.

Description : The description of the item.

Unit: From the drop-down list of Units linked to the above Item Code select the Unit of Measure
that applies to this Adjustment

Adjustment Type: From the drop-down list of Adjustment Types select the Type of adjustment
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being made against this Item.  Adjustment Types are user-defined under
Inventory>Settings>Adjustment Types.

Adjustment Quantity: Enter the quantity being adjusted.  Note the following:
· If the Adjustment is a Receipt then this quantity is a positive number
· If the Adjustment is an Issue then this quantity is a negative number
· If the Item is Serial Controlled then the Quantity must be 1 or -1

If the Adjustment Quantity is a negative then:
· If it is Serial Numbered the Serial Number must exist
· If it is Revision Level controlled then the Revision Level must exist

Adjustment Unit Cost: The current Cost of the Item is displayed.  You have the option to adjust
this cost if necessary.   Note:- If it is a Receipt transaction then this Cost will be taken into account
when re-calculating the current Average Cost.

Notes: Enter brief notes if required. 

Variants: If the Item has ‘sub-level’ variants such as Serial Number, Batch Number, Colour, etc
then the fields applicable to the Item will be available for entry of the variant.  All variant fields that
are not applicable will be ‘greyed out’.   If the variation value is not entered then the Adjustment
Transaction will not be accepted.

Buttons

Close: This will close the Inventory Adjustments screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Adjustment record.

Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Adjustment Line

Related: This will bring up a list of functions that are related to the Inventory Adjustment.    You
may open and maintain information in those screens whilst still remaining in the Inventory
Adjustment screen.

Reports: This will bring up a list of Reports that are related to the Inventory Adjustment.   You can
immediately run the report whilst still remaining in the Inventory Adjustment screen.

10.12 Inventory Change

This screen is intended for use when a posted Inventory receipt contained errors.   It allows
amendments to be made to the Item’s variables in the current Warehouse, Location without
creating a Stock Movement Transaction.  You should note that this feature does not allow changes
to the stock Quantity or the Unit of Measure. 

All changes to the inventory are recorded in the INVENTORYLOG table.

List Tab
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Display fields

Item Code: This is display only that shows the Item Number.  Initially only Active Items are
displayed but you can show all Items by ‘checking’ the checkbox at the bottom of this panel

Description: Description of the Item taken from the Item record

Unit: Basic Unit of Measure of the Item taken from the Item record

Status: Current status of the Item taken from the Item record

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - By default the display will only show Items that are ‘Active’   If you wish
to see all Items then ‘check’ this checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Inventory Change screen.  

Detail Tab

This tab enables you to make changes to the current Item.  These changes are limited to
Warehouse/Location changes in addition to Serial Number, Batch, Colour, Size, Grade, Expiry
Date and Revision Level

Entry and Display fields

Item Code: Display only field showing the Item selected in the ‘List’ screen

Unit: Display only field showing the base Unit of Measure of the selected Item.

Description: Display only field showing the description of the selected Item.

Barcode: Display only field showing the Barcode of the selected Item.

Status: Display only field showing the current status of the selected Item.

On-Hand Qty: Display only field showing the current calculated on-hand quantity of the Item
across all Warehouses and Locations.
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Inventory Details Inquiry: Clicking on this button will display more details about the selected Item.
These include:

Re-Order Level: This is used in the Inventory Replenishments Routine to define the stock
level at which the program generates a Planned Supply order.   

Minimum Re-Order Quantity: This is used in the Inventory Replenishments Routine to
define the minimum quantity to order when the stock is at, or below, the Re-Order Level. 
The Replenishment Routine will generate a Planned Order based on the greater of the
actual demand or the Re-Order Quantity.

Lead Time: The number of days that it normally takes from placing the order to obtaining
the Item.  This lead-time will be applied to both Purchase Orders and Assembly Orders to
determine when the order should be placed.  

Default Supply Method: This defines whether the Item is:
Supply From Stock - Supply to Sales Orders, Assembly Issues, Job Orders will
come from stock.   In this instance Inventory will normally be maintained using the
Inventory Replenishment routine.
Source On Demand - Whenever a demand (Sales Order, Assembly Issue, Job
Order) is made then Ostendo will immediately create a matching ‘Planned’ Supply
Order (Assembly Order or Purchase order)

Sourced By: This is the normal method by which this Item is sourced and will allow
Ostendo to generate planned orders in the area where it is sourced (Assembly or
Purchase).  These are:

Purchasing - fully purchased Item
Assembly - Assembled in-house
Supplier Assembled - Components sent to Supplier for Assembly

Default Supplier: This is used by the Replenishment routine, or Source on Demand
function to generate a planned Order linked to a preferred Supplier.   

Default Issue Warehouse: The default Warehouse from where this Item is normally
issued.   This will prefill any Issue transaction for this Item but can be changed before
physical issue. 

Default Issue Location: The default Location within the selected issue Warehouse.  This
will prefill any Issue transaction for this Item but can be changed before physical issue. 

Default Receipt Warehouse: The default Warehouse into where this Item is normally
received.  This will prefill any receipt transaction for this Item but can be changed before
physical receipt. 

Default Receipt Location: The default Location within the selected receipt Warehouse. 
This will prefill any receipt transaction for this Item but can be changed before physical
receipt. 

Alternate Item Available: If this is ‘Checked’ then an alternative Item is available when
this Item cannot be supplied.  The next field shows the Alternative Item Code.

Warehouse: If the Warehouse is being adjusted then, from the drop-down list select the
Warehouse against which the change is being made.

Location: If the Location is being changed then, from the drop-down list of Locations within the
above Warehouse select the location where the change is being made.
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On-Hand Quantity: This is for information only and cannot be adjusted 

Unit: This is for information only and cannot be adjusted

Variables: If the Item has variables (Serial Number, Batch Number, Colour, Revision Level, etc)
then these fields will be displayed.  You can amend the content as required

Buttons

Close: This will close the Inventory Change screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record being changed or the last time the ‘Save’ Button
was pressed will be lost.

10.13 Inventory Unit Change

This screen allows you to adjust the Unit of Measure of a selected Item from its current unit to
another Unit held against the Item record. 

List Tab

Display fields

Item Code: This is display only that shows the Item Number.  Initially only Active Items are
displayed but you can show all Items by ‘checking’ the checkbox at the bottom of this panel

Description: Description of the Item taken from the Item record

Unit: Basic Unit of Measure of the Item taken from the Item record

Status: Current status of the Item taken from the Item record

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - By default the display will only show Items that are ‘Active’   If you wish
to see all Items then ‘check’ this checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon
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Buttons

Close: This will close the Inventory Unit Change screen.  

Detail Tab

This tab enables you to make restock a current Item in another Unit of Measure that is valid for the
Item.  

Entry and Display fields

Item Code: Display only field showing the Item selected in the ‘List’ screen

Unit: Display only field showing the base Unit of Measure of the selected Item.

Description: Display only field showing the description of the selected Item.

Barcode: Display only field showing the Barcode of the selected Item.

Status: Display only field showing the current status of the selected Item.

On-Hand Qty: Display only field showing the current calculated on-hand quantity of the Item
across all Warehouses and Locations.

(button) Inventory Details Inquiry: Clicking on this button will display more details about the
selected Item.  These include:

Re-Order Level: This is used in the Inventory Replenishments Routine to define the stock
level at which the program generates a Planned Supply order.   

Minimum Re-Order Quantity: This is used in the Inventory Replenishments Routine to
define the minimum quantity to order when the stock is at, or below, the Re-Order Level. 
The Replenishment Routine will generate a Planned Order based on the greater of the
actual demand or the Re-Order Quantity.

Lead Time: The number of days that it normally takes from placing the order to obtaining
the Item.  This lead-time will be applied to both Purchase Orders and Assembly Orders to
determine when the order should be placed.  

Default Supply Method: This defines whether the Item is:
Supply From Stock - Supply to Sales Orders, Assembly Issues, Job Orders will
come from stock.   In this instance Inventory will normally be maintained using the
Inventory Replenishment routine.
Source On Demand - Whenever a demand (Sales Order, Assembly Issue, Job
Order) is made then Ostendo will immediately create a matching ‘Planned’ Supply
Order (Assembly Order or Purchase order)

Sourced By: This is the normal method by which this Item is sourced and will allow
Ostendo to generate planned orders in the area where it is sourced (Assembly or
Purchase).  These are:

Purchasing - fully purchased Item
Assembly - Assembled in-house
Supplier Assembled - Components sent to Supplier for Assembly

Default Supplier: This is used by the Replenishment routine, or Source on Demand
function to generate a planned Order linked to a preferred Supplier.   
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Default Issue Warehouse: The default Warehouse from where this Item is normally
issued.   This will prefill any Issue transaction for this Item but can be changed before
physical issue. 

Default Issue Location: The default Location within the selected issue Warehouse.  This
will prefill any Issue transaction for this Item but can be changed before physical issue. 

Default Receipt Warehouse: The default Warehouse into where this Item is normally
received.  This will prefill any receipt transaction for this Item but can be changed before
physical receipt. 

Default Receipt Location: The default Location within the selected receipt Warehouse. 
This will prefill any receipt transaction for this Item but can be changed before physical
receipt. 

Alternate Item Available: If this is ‘Checked’ then an alternative Item is available when
this Item cannot be supplied.  The next field shows the Alternative Item Code.

(Button) Change Unit of Measure for Selected Record: If you highlight a current stock record in
the lower panel then click on this button a panel will appear for you to amend the Unit of Measure
as follows:

From Unit: Display only field showing the Unit of measure of the selected stock

From Qty: Enter the quantity that you are going to convert 

To Unit: From the drop-down list select the Unit to which the above quantity is being
converted.  The displayed units are those that are valid for this Item

To Qty: Display only field showing the quantity of the Item that will be stocked using the
new Unit of Measure 

(Button) Update: Click this button to amend the Unit of Measure for the selected quantity

(Button) Cancel: Click this button to exit this panel without taking any action

Lower Panel

Warehouse: If the Warehouse is being adjusted then, from the drop-down list select the
Warehouse against which the change is being made.

Location: If the Location is being changed then, from the drop-down list of Locations within the
above Warehouse select the location where the change is being made.

On-Hand Quantity: This is for information only and cannot be adjusted 

Unit: This is for information only and cannot be adjusted

Variables: If the Item has variables (Serial Number, Batch Number, Colour, Revision Level, etc)
then these fields will be displayed.  You can amend the content as required

Buttons

Close: This will close the Inventory Unit Change screen.  If you have any unsaved data then you
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will be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record being changed or the last time the ‘Save’ Button
was pressed will be lost.

10.14 Inventory Transfer

This screen allows you to make inter-location transfers.  Each transfer record creates an Issue
transaction from the Issuing Warehouse/Location and a Receipt transaction at the receiving
Warehouse/Location

The process for Inventory Transfers comprises the following Steps
· Create a Transfer Batch
· ‘Save’ the Batch Header and go to the ‘Lines’ tab
· Add Lines to the Transfer Batch - separate line to cover each Item
· Go back to the Batch Header
· Post the Batch - Ostendo generates the stock movements

Note: Until a Batch is ‘Posted’ the stock movement will not be recorded against the included
Item(s)

List Tab

Display fields

Transfer No: This is the Transfer Number as generated by Ostendo and provides a unique
reference to the Transfer Batch

Reference: The Reference attached to this Transfer Batch as entered into the Details screen,

Status: The status of this Transfer Batch.  There are two statuses (In Progress and Updated),
which are maintained by the program. 

Transfer Date: The date held against the Transfer Batch.  Initially this is the system date but it can
be amended at any time prior to updating the Batch

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 
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Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Inventory Transfer screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Transfer Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Transfer Batch with status ‘In Progress’.  In
this instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Inventory Transfers.  You may open
and maintain information in those screens whilst still remaining in the Inventory Transfer screen.

Reports: This will bring up a list of Reports that are related to Inventory Transfers.  You can
immediately run the report whilst still remaining in the Inventory Transfer screen.

Detail Tab

This tab enables you to create and maintain a Transfer Batch Header.   After creation of a Batch
Header it must be saved (click on the ‘Save’ Button) before Lines can be added 

Entry and Display fields

Transfer No:  This is a unique number automatically allocated by the program.  It cannot be
amended.

Status: This is the status of the Transfer Batch and is maintained by the program.  The displayed
variants are:

In Progress - The Transfer Batch is still being worked on
Updated - The Transfer Batch has been ‘Posted’ and Stock movements created for the
included Items

Created From: Display only field showing the source of this Transfer Batch.  The display options
are

Manual - The Transfer Batch has been created manually in this screen
Replenishment - The Transfer Batch has been automatically generated from the
Inventory Replenishment routine

Reference: Enter a brief description of the Transfer Batch.  No validation checks will be carried out
on this field.

Transfer Style: From the drop-down list select the Transfer Style.  The options are:
Location Transfer: Inventory Transfer to other Warehouses/Locations within the same
Site
Site Transfer: Inventory Transfer to other Sites
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From Site: This is only visible if the Transfer Style is 'Site Transfer'.  From the drop-down list
select the 'From' Site

To Site: This is only visible if the Transfer Style is 'Site Transfer'.  From the drop-down list select
the 'To' Site

Transfer Charge Applies: 'Check' this checkbox if you are applying a charge to this Transfer.

Charge Code: This is only applicable if the 'Transfer Charge Applies' is selected.   Select the
Descriptor Code from the drop-down list against which the charge code is referenced.

Charge Caption: This is prefilled with the description of the Descriptor Code selected above but
can be amended if required.

Allocation Method: The Transfer Charge will be proportionally applied to all the Lines in the
Transfer Batch in accordance with the Allocation Method.  The Allocation Method can be selected
from the drop-down list.  The options are:

· Quantity
· Cost
· Weight
· Volume

Cost Centre: This is prefilled with the Cost Centre held against the selected Descriptor but can be
amended if required.  A Cost Centre must exist in this field before the Transfer can be posted

Charge Amount: Enter the total amount of the Transfer Charge.  On 'Posting' this will be
apportioned to each line using the Allocation Method to determine each line's allocation
percentage

Transfer Date: This is prefilled with the system date.  It can be amended at any time up to Posting
the Batch by entering the date or by clicking on the drop-down menu and selecting the date.

Post All Transfers: This button is visible if the Transfer Style is 'Location Transfer'.   If it is
selected then all the Transfers contained in the ‘Lines’ panel will be actioned and the two stock
movement transactions created.   The ‘From’ Location will have a negative Quantity and the ‘To’
Location a positive Quantity.   The Stock Movement records will have a movement Type of ‘
Transferred’.  The status of this Batch will then be amended to ‘Updated’

Transferred to In Transit: This button is visible if the Transfer Style is 'Site Transfer'.   If the
current Transfer Status is 'In Progress' then this button will be come active and, when selected, will
update the status to 'In Transit' in addition to transferring the Items from the current location to the
'In Transit' Warehouse as defined in Inventory>Settings>In Transit Defaults

Receipted From In Transit: This button is visible if the Transfer Style is 'Site Transfer'.   If the
current Transfer Status is 'In Transit' then this button will be come active and, when selected, will
update the status to 'Updated' in addition to transferring the Items from the 'In Transit' Location to
the receiving Site.

Post All Transfers: This button is visible if the Transfer Style is 'Location Transfer'.   If it is
selected then all the Transfers contained in the ‘Lines’ panel will be actioned and the two stock
movement transactions created.   The ‘From’ Location will have a negative Quantity and the ‘To’
Location a positive Quantity.   The Stock Movement records will have a movement Type of ‘
Transferred’.  The status of this Batch will then be amended to ‘Updated’

Notes: Extended Notes for your own information can be attached to this Transfer Batch. 
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Whenever you click on this field an icon will appear in the top-right.   By clicking on this Icon you
can bring up the Frequently Used Text table.   Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Inventory Transfer screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Transfer Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Transfer Batch Header record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Inventory Transfer.  You may
open and maintain information in those screens whilst still remaining in the Inventory Transfer
screen.

Reports: This will bring up a list of Reports that are related to the Inventory Transfer.  You can
immediately run the report whilst still remaining in the Inventory Transfer screen.

Lines Tab

This tab enables you to add and maintain Transfer lines.  The layout of the display is dependent
upon the value in 'Created From' in the Transfer Batch header

Manual Transfer Batch

If the Transfer Batch has been Manually created then the following will be available

Entry and Display fields

Item Code: When you click on the drop-down icon a separate panel will appear showing all Stock
Locations for all Items.  Select the specific Warehouse/Location/Variant that you wish to transfer.

Unit: Display only field showing the Unit of Measure taken from the record selected above

From Warehouse: Display only field showing the current Warehouse taken from the record
selected above

From Location: Display only field showing the current Location taken from the record selected
above

On-Hand Qty: Display only field showing the Quantity on Hand taken from the record selected
above

Transfer Qty: Enter the quantity of this Item that you will be transferring.  This quantity cannot be
greater than the current On-Hand quantity

To Warehouse: From the drop-down list select the Warehouse to where the transfer is being
made.
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To Location: From the drop-down list of Locations within the above Warehouse select the location
to where the transfer is being made.

Variants: All displayed records are already segregated by their variations and these are displayed
here for reference.

Replenishment Transfer Batch

If the Transfer Batch has been created by the Replenishment routine then the following will be
available

Entry and Display fields

Upper Panel

Item Code: Display only showing the Item Code to be Transferred

Unit: Display only field showing the Unit of Measure taken from the above record

Planned Qty: Display only field showing the Quantity suggested for Transfer by the Replenishment
routine

In Transit Qty: Display only field showing the Quantity entered in the lower panel

Transfer Qty: Display only field showing the Quantity that was received at the receiving Site

Lower Panel

Prefill Lines Button: Instead of manually adding the transfer lines to the lower panel, you can
click on this button to quickly prefill the lower panel with the items from the upper panel. The
transfer quantity will be calculated based on the applicable replenishment and item rules.

Item Code: When you click on the drop-down icon a separate panel will appear showing all Stock
Locations for the Item selected in the upper panel.  Select the specific
Warehouse/Location/Variant that you wish to transfer.

Unit: Display only field showing the Unit of Measure taken from the record selected above

From Warehouse: Display only field showing the current Warehouse taken from the record
selected above

From Location: Display only field showing the current Location taken from the record selected
above

On-Hand Qty: Display only field showing the Quantity on Hand taken from the record selected
above

Transfer Qty: Enter the quantity of this Item that you will be transferring.  This quantity cannot be
greater than the current On-Hand quantity

To Warehouse:  

To Location:  

Variants: All displayed records are already segregated by their variations and these are displayed
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here for reference.

Description:  The item description

To Container ID: The destination container.

Buttons

Close: This will close the Inventory Transfer screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Transfer record.

Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Transfer Line

Related: This will bring up a list of functions that are related to the Inventory Transfer.  You may
open and maintain information in those screens whilst still remaining in the Inventory Transfer
screen.

Reports: This will bring up a list of Reports that are related to the Inventory Transfer.  You can
immediately run the report whilst still remaining in the Inventory Transfer screen.

10.15 Quick Transfer

This screen offers a quick and easy way to transfer a bunch of items from one location to another.

Transfer From

Warehouse : Select the Transfer From warehouse from the drop-down list.

Location : Select the Transfer From warehouse location from the drop-down list.

Transfer To
This is the default Transfer To warehouse and location. When the transfer list is generated,you
can modify the To Warehouse and Location for any of the transfer lines if required.

Warehouse : Select the default Transfer To warehouse from the drop-down list.

Location : Select the default Transfer To warehouse location from the drop-down list.

Prefill Transfer

By entering a Search Code and hitting the Prefill Transfer List button, you can very quickly
create a list of items to be transferred.
Once the list is generated, go through the list and enter the quantities to be transferred for each
item.

Search Code : Enter a search string to identify all items you wish to select for transferring. The
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item Barcodes, Serial Numbers, Batches, Descriptions, and ItemCodes will be searched to match
this string.

Hit the Prefill Transfer List button to populate the transfer list based on your search string.

The following fields can be modified in the generated list of items:

Transfer Qty : Enter the quantity to be transferred for each item. 

To W/H : Select the Transfer To warehouse if different from the default.

To Loc : Select the Transfer To location if different from the default.

Variants: All displayed records are already segregated by their variations and these are displayed
here for reference.

Container: This is the current (From) container 

To Container ID:  This is the To Container.

Buttons:

Related : Hit this button to display all the items from itemmaster.

Transfer Items : Hit this button to transfer al the items in the list. This will create all the inventory
transfer records and post them immediately. 

Close : This will close the screen and exit from Quick Transfer.

10.16 Location Re-Stock

This screen facilitates the Restocking of Inventory at a specified Location based upon Restocking
parameters.     This can be used, for example, to cover:

· Replenishment of stock at a remote Warehouse
· Replenishment of stock in a Delivery Van

The Restocking process has the following Steps
· Create a Restocking Batch
· ‘Save’ the Batch Header and go to the ‘Lines’ tab
· Add Lines to the Batch (use Restocking Template if required)
· Go back to the Batch Header
· Post the Batch - Ostendo generates the stock movements

Note: Until a Batch is ‘Posted’ the stock movement will not be recorded against the included
Item(s)

List Tab

Display fields

Transfer Batch No: This is the Restocking Transfer Number as generated by Ostendo and
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provides a unique reference to the Batch.

Reference: The Reference attached to this Restocking Batch as entered into the Details screen,

Status: The status of this Restocking Batch.  There are two statuses (In Progress and Updated),
which are maintained by the program. 

Created Date: The date when the Restocking Batch was created.   Initially this is the system date
but it can be amended at any time prior to updating the Batch

Transferred Date: The date when the Restocking Batch was transferred.  This is created from the
system date when the Batch was posted

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Restocking screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Restocking Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Restocking Batch with status ‘In Progress’.  In
this instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Inventory Restocking.  You may
open and maintain information in those screens whilst still remaining in the Inventory Restocking
screen.

Reports: This will bring up a list of Reports that are related to Inventory Restocking.  You can
immediately run the report whilst still remaining in the Inventory Restocking screen.
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Detail Tab

This tab enables you to create and maintain a Restocking Batch Header.   After creation of a Batch
Header it must be saved (click on the ‘Save’ Button) before Lines can be added 

Entry and Display fields

Transfer Batch No: This is a unique number automatically allocated by the program.  It cannot be
amended.

Status: This is the status of the Restocking Batch and is maintained by the program.  The
displayed variants are:

In Progress - The Restocking Batch is still being worked on
Updated - The Restocking Batch has been ‘Posted’ and Stock movements created for the
included Items

Reference: Enter a brief description of the Restocking Batch.  No validation checks will be carried
out on this field.

From Warehouse: From the drop-down list select the Warehouse from where the Items will be
issued.

From Location: From the drop-down list of Locations within the above Warehouse select the
location from where the Items will be issued.

To Warehouse: From the drop-down list select the Warehouse into where the Items will be
received.

From Location: From the drop-down list of Locations within the above Warehouse select the
location into where the Items will be received.

Creation Date: This is prefilled with the system date.  It can be amended at any time up to Posting
the Batch by entering the date or by clicking on the drop-down menu and selecting the date.

Transferred Date: The date when the Restocking Batch was transferred.  This is a display only
field as the program generates this when the Batch is posted.

Use Inventory Template: If this checkbox is ‘checked’ then the next field will be activated to allow
selection of a Restocking Template.

(Restocking Template): This field becomes active when the previous field (Use Inventory
Template) is ‘checked’.  From the drop-down list select the Restocking Template to copy to this
Batch.   The details of that template will be copied to this Batch if you exit this panel or click the ‘
Save’ Button.   Restocking Templates are maintained under Inventory>Settings>Re-Stocking
Template

Transfer if not <> 0: If this button is selected then all the records in the ‘Lines’ panel which have a
Transfer quantity greater than zero will be actioned and the two stock movement transactions
created.   The ‘From’ Location will have a negative Quantity and the ‘To’ Location a positive
Quantity.   The Stock Movement records will have a movement Type of ‘Transferred’.   The status
of this Batch will then be amended to ‘Updated’

Notes: Extended Notes for your own information can be attached to this Restocking Batch. 
Whenever you click on this field an icon will appear in the top-right.   By clicking on this Icon you
can bring up the Frequently Used Text table.   Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.
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Buttons

Close: This will close the Inventory Restocking screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Restocking Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Restocking Batch Header record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to Inventory Restocking.  You may
open and maintain information in those screens whilst still remaining in the Inventory Restocking
screen.

Reports: This will bring up a list of Reports that are related to Inventory Restocking.  You can
immediately run the report whilst still remaining in the Inventory Restocking screen.

Lines Tab

This tab enables you to add and maintain Restocking lines.  The Restocking Batch Number and
status will be displayed at the top of the panel.

Entry and Display fields

Item Code: When you click on the drop-down icon a separate panel will appear showing all Stock
at the ‘From’ Warehouse/Location.  Select the specific Warehouse/Location/Variant that you wish
to transfer.

Unit: If the Item has only one Unit then it will be displayed here.  If it has multiple Units then select
the specific Unit from the drop-down list

From Loc On-Hand Qty: Display only field showing the current stock at the issuing Warehouse /
Location

Planned Restock Quantity: If the line was created from a Restocking Template then this field will
show the planned restock quantity held against that Template.

Actual Transfer Qty:  If the line was created from a Restocking Template then this field will be
prefilled with the planned restock quantity held against that Template.   If you are manually adding
this line in this Restocking Batch then this will be zero.  In either case you can overwrite the
quantity to denote the actual quantity that is going to be transferred.
Note:  If the Item has variants (Example: Serial Number, Grade, Expiry Date, etc) then you cannot
enter a quantity directly.  In this instance a button will appear in this field for selection of the
specific Variant(s). 

Buttons

Close: This will close the Inventory Restocking screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Restocking record.
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Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Restocking Line

Related: This will bring up a list of functions that are related to Inventory Restocking.  You may
open and maintain information in those screens whilst still remaining in the Inventory Restocking
screen.

Reports: This will bring up a list of Reports that are related to Inventory Restocking.  You can
immediately run the report whilst still remaining in the Inventory Restocking screen.

10.17 Inventory Count

This screen enables you to carry out stock counts on all, or selective areas, of your Inventory.  The
Inventory Count process comprises the following Steps

· Create an Inventory Count Batch and identify the selection criteria
· Generate the Lines from the selection criteria
· Print the Check Sheet
· Update the Batch Lines with the counted stock
· Add lines where Item found that was not expected
· Go back to the Batch Header
· Update the quantities against lines that have been flagged as ‘Counted’

List Tab

Display fields

Count No: This is the Inventory Count Reference Number as generated by Ostendo and provides
a unique reference to the Count Batch.

Reference: The Reference attached to this Count Batch as entered into the Details screen,

Status: The status of this Count Batch.  There are two statuses (In Progress and Updated), which
are maintained by the program. 

Count Date: The date when the Count Batch was created.  

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.
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Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Count screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Count Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Count Batch with status ‘In Progress’.  In this
instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Inventory Count.  You may open
and maintain information in those screens whilst still remaining in the Inventory Count screen.

Reports: This will bring up a list of Reports that are related to Inventory Count.  You can
immediately run the report whilst still remaining in the Inventory Count screen.

Detail Tab

This tab enables you to create and maintain a Count Batch Header.   

Entry and Display fields

Count No: This is a unique number automatically allocated by the program.  It cannot be
amended.

Status: This is the status of the Count Batch and is maintained by the program. The displayed
variants are:

In Progress - The Count Batch is still being worked on
Updated - The Count Batch has been ‘Posted’ and Stock movements created for the
included Items

Reference: Enter a brief description of the Count Batch.  No validation checks will be carried out
on this field.

Count Dates:

Count Date: This is prefilled with the system date.  It can be amended at any time up to Posting
the Batch by entering the date or by clicking on the drop-down menu and selecting the date.

Updated Date: This displays the date the Count was updated.

Mobility Restriction:
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Mobility Team: (Optional) Select the Mobility Team name if you wish to restrict this count to be
carried out only by a certain Team.

Prevent Mobility Editing: Tick this box when you are in the process of reviewing the Count before
posting it to update the Inventory records. (You don't want anyone to change the data when you
are about to post it.)

Inventory Quantity Restriction:

Count Style: From the drop-down list select the Items to be included in the list.  The Options are:
Current Inventory only – Ostendo will only list those items that have + or – qty
Current Inventory Plus items with past history -  Ostendo will only list those items that have
+ or – qty plus any zero quantity Items that have previously had transactions
Current Inventory Plus items with zero qty – Output all items

Count Update:

Updated Counted Inventory Lines: Selecting this Button will first ask you to confirm the update
and then post the ‘checked’ variances to Inventory with a Transaction Type of ‘COUNT’.   The
Count Date field will be updated with the system Date and the Count Batch status will be changed
to ‘Updated’.

Count Selection: The following selection criteria can be entered to restrict the Items that will
appear in the Count Batch.   

· For Site: From the drop-down list select the Site if you wish to restrict the Count to a
certain site. (Ensure an Item Site Settings default Warehouse / Location record is set up
for each item.)

· Warehouse: From the drop-down list select the ‘From’ and ‘To’ Warehouse Range.  If
nothing is selected then all warehouses are assumed.

· Location: From the drop-down list select the ‘From’ and ‘To’ Location Range.  If nothing
is selected then all Locations within the Warehouse Range is assumed.

· Location Group: From the drop-down list select the Location Group if you wish to restrict
the Count to a certain Location Group. 

· Location Sequence Range: Enter the ‘From’ and ‘To’ Location Sequence Range if
desired.

· Category: From the drop-down list select the ‘From’ and ‘To’ Item Category Range.  If
nothing is selected then all Categories will be assumed.

· Sub Category: From the drop-down list select the ‘From’ and ‘To’ Item Sub Category
Range.  If nothing is selected then all Sub Categories will be assumed.

· Item: From the drop-down list select the ‘From’ and ‘To’ Item Range.  If nothing is
selected then all Items will be assumed.

· Primary Supplier: Select the Primary Supplier if you wish to count items from this
Supplier only.

· Cycle Count Code: Enter the Cycle Count Code to restrict the batch to those Items that
are linked to this Code.  If nothing is selected then all Codes will be assumed. 

· ABC Classification: From the drop-down list select the ABC Code to restrict this batch
to those Items that are linked to this Classification.  If nothing is selected then all
Classifications will be assumed. 

Generate Inventory Count Lines: When this button is selected you will be asked to confirm the
above selection criteria.  If you accept the setting then the program will generate count lines.  The
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routine will create Lines within the above parameters but will exclude any Items within the selected
Warehouse(s) that currently exist in other Inventory Counts whose status is ‘In Progress’.  The
generated lines can then be viewed on the ‘Lines’ tab

Notes: Extended Notes for your own information can be attached to this Count Batch.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Recorded Notes: This blob field is used to store notes recorded when the Count is performed
using the the Freeway Mobility app.

Buttons

Close: This will close the Inventory Count screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Count Batch Header record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to Inventory Count.  You may open
and maintain information in those screens whilst still remaining in the Inventory Count screen.

Reports: This will bring up a list of Reports that are related to Inventory Count.  You can
immediately run the report whilst still remaining in the Inventory Count screen.

Lines Tab

This tab enables you to add and maintain Count lines.  The Count Batch Number and status will be
displayed at the top of the panel.

Entry and Display fields

Warehouse: The Warehouse where the Item is currently stocked.  It can be amended if the stock
was found to be in another Warehouse.

Location: The Location in the Warehouse where the Item is currently stocked.  It can be amended
if the stock was found to be in another Location.

Item Code: Display only field showing the Item Number at this location

Unit: Display only field showing the Unit of Measure of the Item at this location

On-Hand Quantity: Display only field showing the current On-Hand quantity at this location

Count Qty: Enter the quantity that you counted at this location.  Note:- If the Item has variants
(Serial Number, Batch Number, etc) then each variant will have its own line in this check list. 
Ensure that you are updating the correct line
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Variance: Display only field showing the variance between the current Oh-Hand quantity and the
Counted Quantity.

Counted: Display only field showing this Item at this location has been counted.  This function
enables filtering of all uncounted lines.

(Variants): Where an Item has Variants then each occurrence will be displayed along with the
content of that variation.  Variations can cover

· Serial Number
· Batch Number
· Expiry Date
· Revision Number
· Grade
· Colour
· Size

Category: Display only field showing this Item's category.

Sub Category: Display only field showing this Item's Sub-category.

Buttons

Close: This will close the Inventory Count screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: The cursor will go to a new line for entry of a count record where the Item is not currently
contained in this list.  It the Item that you enter is in another Inventory Count batch whose status is ‘
In Progress’ and the Warehouse is the same then you will not be allowed to add the record

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Count Batch Lines record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This will delete the current highlighted line from this list

Related: This will bring up a list of functions that are related to Inventory Count.  You may open
and maintain information in those screens whilst still remaining in the Inventory Count screen.

Reports: This will bring up a list of Reports that are related to Inventory Count.  You can
immediately run the report whilst still remaining in the Inventory Count screen.

10.18 Inventory Labels

This function allows you to print labels for Inventory Items.  This routine is used is three areas of
Ostendo

Inventory - where you can select Inventory Items and the quantity of labels to print
Purchase Receipt - where you select the receipted Item(s) and print labels for the
received quantity
Assembly Receipt - where you select the receipted Item(s) and print labels for the
received quantity

Field Position - In the main panel you can move the field position by dragging the column heading
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left or right to the position where you want it to appear.

Entry and Display fields

Labels For: Display only field showing that the labels are selected from Inventory records

Select: ‘Check’ this checkbox if you want to print a Label for this Item.

Label Qty: This is prefilled with the current Inventory quantity but can be amended if required

Buttons

Select All Codes: Clicking this Button will place a check-mark in the Select column against all
displayed Items

De-select All Codes: Clicking this Button will remove check-marks from the Select column against
all displayed Items

Print Labels for Selected: All Items that have been selected will have labels printed for the
quantity defined against the above record

Close: This will close the Labels Print screen.  

10.19 Inventory and WIP Value

This screen allows you to determine the value of Inventory, JOB WIP and Assembly WIP at a
specified date.  You should note the Inventory As At Valuation Style parameter setting in Item
Rules screen as this will affect the results of the Inventory Valuation

Upon entry of the date you should click on the 'Print' button and select where you wish the results
to be output

Entry and Display fields

Run Valuation as at:  This is the date at which the value of your Inventory will be calculated.  It is
prefilled with the system date but you can amend this by clicking on the drop-down calendar. 

Buttons

Inventory Value - Print: This will print the Inventory Valuation report showing the stock quantity
and value of Inventory Items at the entered date.

Job Order WIP - Print: This will print all the Job Orders and their WIP value at the specified date

Assembly Order WIP - Print: This will print all the Assembly Orders and their WIP value at the
specified date

Cancel: This will close this panel without printing the Report
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10.20 Containers

The Ostendo Container Tracking Module allows products to be containerised and maintained via
Freeway. 

Detailed information can be found in the Container Tracking Module White Paper here: Ostendo
Container Tracking Module

This screen allows you to create and maintain Containers in Ostendo.

List Tab

Display fields

The displayed fields are taken from the Inventory-Containers information entered into the ‘Detail’
tab.   The selection of which fields to display is at the user’s discretion.   To select the fields to
display simply ‘right mouse’ in the main panel and select ‘Customize Fields’.   On the displayed
panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Containers
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Inventory Containers screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will pop up the "New Container" window.
Select the Container Type, Enter any Reference details, and the Container Qty. then hit

"OK" button. 
Each Container record contains details for ONE container only. So if you enter a Qty of 5,

then five records will be created each with a unique Container ID.

Save: Not applicable to the List panel

http://ostendo.info/downloads/ostendo/Container_Tracking_Module.pdf
http://ostendo.info/downloads/ostendo/Container_Tracking_Module.pdf


515Inventory

Cancel: Not applicable to the List panel

Delete: This removes the highlighted Inventory Container from this table

Related: This will bring up a list of functions that are related to the Inventory Containers.  You may
open and maintain information in those screens whilst still remaining in the Inventory Containers
screen.

Reports: This will bring up a list of Reports that are related to the Inventory Containers.  You can
immediately run the report whilst still remaining in this screen.

Labels: This will enable you to print labels for containers. 

Global Unique ID (GUID). As the Container ID will only be unique to that Ostendo

database, we will also be generating a Global Unique ID (GUID). This is a 40

character ID prefixed with "#TC#" and is unique to ALL Ostendo databases. 

The Container Label will show both the 2D Barcode of the GUID along with a 1D
Barcode for the Container ID. Either of these barcodes may be scanned internally by
Freeway in order to link stock to the container. Eg: from Picking / Receipting or
Transferring etc.

NB: Even though, internally we are not showing the GUID against our
inventory records, Freeway can accept either the GUID 2D Barcode or our
internal Container ID barcode. (both are automatically cross-referenced back
in Ostendo in order to interpret each other)

Detail Tab

Entry and Display fields

Container ID: This is a combination of the Container Type Prefix followed by a system generated
number.

Reference:  This is entered during New Container creation. Can be modified at any time.

Status: Display field showing the current status of the container (e.g. Empty, InUse, Shipped,
OnHold, Scrapped)

Scrap Container:  Tick this box if this container is to be scrapped. Only Empty containers can be
scrapped.

Print Status: Either "Printed"  or  "NotPrinted". Updated when labels are printed.

Container Type: Display only field showing the Container Type.

Last Clean Time: Display only field showing the Last Cleaned date and time. Automatically
updated from the last Cleaning Log entry in the Cleaning Log Tab. This is used when
the Cross Contamination Rules are evaluated.

Certification Applies: Tick this box if this is a certified Container.

Certification Expiry: Enter the Certification Expiry date here. Goods can only be linked to this
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container up to this date.

Certification Reference: enter the Certification Reference details here.(maximum 100 characters)

Container Style: Display only field showing "Container Contents"  or  "Assembly Order" 

SSCC Code: This is only displayed if the Container Type is set to Manual SSCC. You can type or
paste in the SSCC code for this container here.

Dimensions Section -----------------------------------------------------------------

These indicate the default capacities of the container and are based upon the default
value of the Container Type. These can be overridden if required. 
Zero means Not Applicable. 
The dimensional units come from the System Settings.

Tare Weight: Default Unladen Container weight. 

Max Weight:  The maximum weight that can be placed in this container. 

Max Volume: The maximum volume that can be placed in this container. 

Max Length: The maximum length of any one item. 

Max Height: The maximum height of any one item. 

Contents Weight: Display only value. This is the calculated aggregate weight of all items
weights in the container contents. 

Contents Volume: Display only value. This is the calculated aggregate volume of all items
volumes in the container contents. 

Actual Weight: This would be the total weight of all items plus the tare weight of the Container. 
If the Container Max Weight is not equal to Zero, this value (less the

Container Tare Weight) is compared and validated to ensure it is greater than or
equal to the Max Weight.

Actual Volume: This would be the total volume of all items in the container. Can be amended.
If the Container Max Volume is not equal to Zero, this value is

compared and validated to ensure it is greater than or equal to the Max Volume.

Upload Status ------------------------------------------------------------------------------

Upload Status: Display only field.
(Upcoming Feature) This will be used when we upload Container Contents to

Ostendo.Work enabling a Freeway Standalone solution to read the Container

Contents.

Latest Upload Time: Display only field.
(Upcoming Feature) This will be used when we upload Container Contents to

Ostendo.Work enabling a Freeway Standalone solution to read the Container

Contents.

Notes:  Relevant notes can be entered here.
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Buttons

Close: This will close the Inventory Containers screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will pop up the "New Container" window.
Select the Container Type, Enter any Reference details, and the Container Qty. then hit

"OK" button. 
Each Container record contains details for ONE container only. So if you enter a Qty of 5,

then five records will be created each with a unique Container ID.

Save: This will save all changes made to the current record.

Cancel: This will cancel all changes to the current record since the last Save.

Delete: This removes the current Inventory Container from this table

Related: This will bring up a list of functions that are related to the Inventory Containers.  You may
open and maintain information in those screens whilst still remaining in the Inventory Containers
screen.

Reports: This will bring up a list of Reports that are related to the Inventory Containers.  You can
immediately run the report whilst still remaining in this screen.

Labels:  This will bring up the label printing function. 

Global Unique ID (GUID). As the Container ID will only be unique to that Ostendo

database, we will also be generating a Global Unique ID (GUID). This is a 40

character ID prefixed with "#TC#" and is unique to ALL Ostendo databases. 

The Container Label will show both the 2D Barcode of the GUID along with a 1D
Barcode for the Container ID. Either of these barcodes may be scanned internally by
Freeway in order to link stock to the container. Eg: from Picking / Receipting or
Transferring etc.

NB: Even though, internally we are not showing the GUID against our
inventory records, Freeway can accept either the GUID 2D Barcode or our
internal Container ID barcode. (both are automatically cross-referenced back
in Ostendo in order to interpret each other)

Container Contents Tab
This screen displays all contents of a container along with associated reference information
showing the source of the item (eg: Delivery / Assembly or Job Order) from inventory or the
container ID if one container has been loaded into another.
The information shown here is populated principally from the Freeway Picking or Freeway
Receipting process to a container. 
There might be low volume situations where you may want to enter this information directly into
Ostendo (rather than Freeway). This is manually allowed on this screen.

Entry and Display fields
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Container ID: Display-only field showing the Container ID that these contents belong to.

Line Type: Item Code / Descriptor / Kitset / Catalogue Code / Container ID

Code/ID: Select or Enter the appropriate code. This can either be an Item Code or a Container ID.
This means a Container can be holding other containers as well. 

Description: Description of the content item.

Unit: Unit of Measure

Qty: The Picked or Receipted quantity

Date: The Pick or Receipt Date

Serial No.: The Serial No. of the item

Expiry Date: The expiry date of the item

Batch No.: The batch no. of the item

Revision: The revision no. of the item

Colour / Grade: (either Colour or Grade is shown depending on which attribute is used for
Container in Item Rules) The Colour (or Grade) of the item.  

Size: The size of the item. 

Transaction Style: Display-only field (Issue / Receipt)

Source: Source of the transaction - Delivery / Assembly Order / Job Order / Transfer / Mixed
"Mixed" means the content item came from multiple sources

Source Reference: Reference No of source document  or  "Mixed" if multiple sources 

Cleaning Log Tab
This screen allows you to manually record cleaning dates / times of this container. 
The latest record will update the Last Clean Date field on the Container Header.

Entry and Display fields

Container ID: Display-only field showing the Container ID that these Cleaning records belong to.

Reference:  Enter reference details for this log entry

Date/Time:  Enter the actual Clean Date and Time

Notes: Enter any relevant notes here.  

Allowable Products Tab
This screen allows you to define specific items that can be linked to a container. 
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In effect you could restrict a container to just one item or a selection of items. 
(If no records defined here, any item may be linked to this container)

Entry and Display fields

Container ID: Display-only field showing the Container ID.

Item Code:  Enter the item code here 

Description:  Enter the description of the item

Hold Log Tab
This screen allows you to manually add ‘On Hold’ or ‘Off Hold’ records to this container. 
You may only either Add new records to this screen or Update Reason or Notes field against an
existing log record.

If a log record is added to a container with a Container Status not equal to OnHold, the log record
will be recorded as ‘On Hold’ and the Container Status will be updated to ‘OnHold’ 

If a log record is added to a Container that already has a Container Status of OnHold, the log
record will be recorded as ‘Off Hold’ and the Container Status will be updated to Empty or InUse,
depending upon whether it has contents or not. 
A container will only be returned to a Shipped Status if it was originally Shipped immediately prior
to going OnHold.

Entry and Display fields

Container ID: Display-only field showing the Container ID.

Date/time:  Automatically populated when adding a new log entry. Cannot be modified. 

Status:  OnHold  /  OffHold

Reason:  Enter a brief reason for the log entry (maximum 200 characters)

Notes: Add any additional notes/details here.  

10.21 Cross Contamination

Cross Contamination rules are specific to a Container Type. This matrix defines what mix of
products ‘cannot’ be used in the same container. 
Multiple items defined here would mean those products cannot co-exist in the same container.

An example of this might be in the Food industry where a specific container type cannot hold a
mixture of Peanut and Non-Peanut type products together.
Firstly, you would define the individual Peanut Products (or Category as a whole), then you would
define the individual Non-Peanut Products (or Category as a whole). 

Both this rule and the Allowable Products rule on the container work in combination. 
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The Allowable Products Rule is applied first, then the Cross Contamination Rules
When picking or receipting to a container, Freeway would first check for the Allowable products on
the container, then if this passes that condition, the Cross Contamination Rules would be run to
check whether that item exists in either the (List ‘A’) Peanut OR (List ‘B’) Non-Peanut lists. If it is
not found, then Freeway would allow the stock to be linked to that Container.

Further to this you can define whether the logic runs in a Bidirectional or Unidirectional manner.
Simply put, this means the rule either compares the list values in both directions or just in one
direction.
The detail screen allows you to define the Matrix header itself, whilst the Matrix tab allows you to
define the items in both lists.

List Tab

Display fields

The displayed fields are taken from the data entered into the ‘Detail’ tab.   The selection of which
fields to display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in
the main panel and select ‘Customize Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Containers
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new Cross Contamination Matrix record.

Save: Not applicable to the List panel
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Cancel: Not applicable to the List panel

Delete: This removes the highlighted record from this table

Related: This will bring up a list of functions that are related to Cross Contamination.  You may
open and maintain information in those screens whilst still remaining in the Cross Contamination
screen.

Reports: This will bring up a list of Reports that are related to Cross Contamination.  You can
immediately run the report whilst still remaining in this screen.

Detail Tab

Entry and Display fields

Matrix Name: Enter a name for this Cross Contamination Matrix.

Style:  Select the Cross Contamination Style from dropdown: Since Last Clean  /  Never Mix 
Never Mix:
When this Cross Contamination is evaluated, Ostendo will check all current

and previous container contents history for that container since inception and prevent
any linkage if there has ever been a product in that container stated in the Cross
Contamination Restriction list for that Container Type. (This Style would generally be
applicable to Temporary containers where no cleaning regime is required prior
to different types of product being linked to it.) eg: A container for Peanut products
may never have Non-Peanut products linked to it irrespective of whether
the container has been cleaned or not.

Since Last Cleaned:
When this Cross Contamination is evaluated, Ostendo will check all current

and previous container contents history going back to the “Last Cleaned Date” on the
Container Master record for that container and prevent any linkage if there
has ever been a product in that container stated in the Cross Contamination
Restriction list for that Container Type. (This would apply generally to
Temporary containers where a cleaning regime is required prior to different types of
product being linked to it.) eg: A container for Peanut products may
only have Non-Peanut Products linked to it after the container has been cleaned.

Directional Style:  (Bidirectional or Unidirectional): This defines whether the rule should
look at item values in both directions or just one. 

Bidirectional – Items compared in List A to List B
Items compared in List B to List A

Unidirectional – Items compared in List A to List B only

Example of Bidirectional:
Where Peanut SKUs can never be mixed with Non-Peanut SKUs
whether they exist in List A or List B

Example of Unidirectional:
Where lighter shaded paints must be linked first before darker shaded
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paints. In this case the lighter shaded paint SKUs would be specified in List B and the

Darker in List A

Reference:  Enter some details here as a reference for this matrix.

Status:  Active  or  InActive
  
First List Caption:  This is the Heading you wish to give List A. This caption will appear
in the Matrix Tab for List A

Second List Caption:  This is the Heading you wish to give List B. This caption will
appear in the Matrix Tab for List B

Notes:  Enter more detail notes here if required.

Buttons

Close: This will close the Inventory Containers screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will add a new Cross Contamination Matrix record..

Save: This will save all changes made to the current record.

Cancel: This will cancel all changes to the current record since the last Save.

Delete: This removes the current record from this table

Related: This will bring up a list of functions that are related to Cross Contamination.  You may
open and maintain information in those screens whilst still remaining in the Cross Contamination
screen.

Reports: This will bring up a list of Reports that are related to Cross Contamination.  You can
immediately run the report whilst still remaining in this screen.

Matrix Tab

Entry and Display fields

This tab is split into Upper and Lower grids. Items defined in the Upper grid refer to
List A whilst items defined in the lower grid refer to List B. Clicking in the appropriate
grid area (upper or lower) will dictate which grids records you are modifying. The
defined First List Caption and Second List Captions are displayed in the respective
Grid headers.

Item Code:  Select the item code.

Item Description:  Amend the description as required,
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10.22 Off Site Containers

This screen displays Chep pallet inventory by Customer by Container Type.

 List Tab

Display fields

The List grid shows the Total OffSite Chep Pallets for all Customers linked to the corresponding
Item Code.   The selection of which fields to display is at the user’s discretion.   To select the fields
to display simply ‘right mouse’ in the main panel and select ‘Customize Fields’.   On the displayed
panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Containers
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Display fields

Container Type: The Container Types for these Off Site Containers

Item Code: The inventory item codes for these Off Site Containers

Item Description: The inventory description for these Off Site Containers

Item Unit:  The unit of measure

Primary Supplier:  The Suppliers for these Off Site Containers

Off Site Qty:  The total off site quantities of each Container Type.
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Detail Tab
The Detail screen shows individual customer totals by Container Type.

Display fields

Container Type: The Container Types for these Off Site Containers

Item Code: The inventory item codes for these Off Site Containers 

Customer:  The Customer name associated with each Off Site Container

Customer Qty: The number of Off Site containers held at customer's location. 

Buttons

Close: This will close the Inventory Off Site Containers screen.  

Related: This will bring up a list of functions that are related to the Inventory Off Site Containers. 

Reports: This will bring up a list of Reports that are related to the Inventory Off Site Containers.   

10.23 Content Group Matrix

This screen allows you to define matrix rules between Container Types and Container Content
Groups.

Essentially, for each Container Type, you can either  "Restrict To"  one or more

Container Content Groups  OR  "Exclude From"  one or more Container Content

Groups - (but not both)

List Tab

Display fields

Container Type: This is a display-only field that shows the Container Types defined in the system.

Description: This shows the description of the Container Type.

Highlight a Content Type and click on either "Restrict To" tab  OR  "Exclude From" tab.
For each Container Type, you can only choose either "Restrict To" or "Exclude From" tab (not
both).

Container Content Group :  click the Add button to add one or more Container Content Group
names for the selected Container Type.
Depending on the tab (Restrict To or Exclude From) selected, this Container Type will either be
restricted to or excluded from the list of Container Content Groups. 
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Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank line for selecting a new Container Content Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: Removes the highlighted record.

10.24 Item Forecast

This screen enables you to define monthly Forecasts against selected Items.  This forecast can be
used in the Inventory Replenishment routine which looks at Actual -v- Forecast Demands

List Tab

This panel shows all Inventory Items and if they have a monthly Forecast attached to them.

Display fields

Item Code: Display only field showing the Item Number

Site Name: Display only field showing the Site

Description: Display only field showing the Description of the Item taken from the Inventory
record.

Unit: Display only field showing the Base Unit of Measure for the Item taken from the Inventory
record.

Status: Display only field showing the Current status of the Item taken from the Inventory record.

Forecasted: Display only checkbox showing if the Item has a Forecast held against it

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Obsolete Status - By default the display will only show Items that have a status of ‘Active’
.   If you wish to see all Items including those that have status ‘Obsolete’ then ‘check’ this
checkbox. 
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Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Forecast screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Detail Tab

This tab enables you to create and maintain a Forecast against an Item selected in the ‘List’ tab

Entry and Display fields

Item Code: Display only field showing the Identity of the selected Item

Unit: Display only field showing the base Unit of Measure for the selected Item

Description: Display only field showing the Description of the selected Item

Default Supply Method: Display only field showing the Supply Method held against the selected
Item

Status: Display only field showing the current status of the selected Item

On-Hand Qty: This is a display only field showing the current stock level across all Warehouses
and Locations.  For detailed on-hand information click on the adjacent button (Inventory
Availability)

Inventory Availability: Clicking on this button will bring up a separate panel that shows details of
the Inventory Availability for this Item.  This includes

· Stock by Location segregated by Tracking Characteristic if applicable
· Projected Availability taking into account current stock plus supply and demand
· List of Supply and Demand orders

Sourced By: Display only field showing how this Item is sourced.  The display options are
Purchasing - fully purchased Item
Assembly - Assembled in-house
Supplier Assembled - Components sent to Supplier for Assembly

Re-Order Level: Display only field showing the Re-Order Level.  This is used in the Inventory
Replenishments Routine to define the stock level at which the program generates a Planned
Supply order. 

Min Re-Order Quantity: Display only field showing the Minimum Re-Order Quantity.  This is used
in the Inventory Replenishments Routine to define the minimum quantity to order when the stock is
at, or below, the Re-Order Level.  The Replenishment Routine will generate a Planned Order
based on the greater of the actual demand or the Re-Order Quantity.

Lead Time: Display only field showing the Item’s Lead time.  This will be applied to both Purchase
Orders and Assembly Orders to determine when the order should be placed.    

Default Supplier: Display only field showing the Item’s default Supplier.  This is used by the
Replenishment routine, or Source on Demand function to generate a planned Order linked to a
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preferred Supplier. 

Forecast Settings

Forecasts are entered relative to the requirements within each month, thus providing seasonal
variations.   Within each month the Forecast can be held as a single value for the month or a daily
value (based on a 5, 6, or 7 day working week).   

Forecast Applies: ‘Click’ the checkbox if you are establishing a Forecast for the respective Month.
This will make the following fields active against that month.

Average Forecast Quantity: The quantity entered here will apply to all occurrences of the
frequency defined in the next field

Frequency: From the drop-down list select the frequency for the forecast demand entered into the
previous field.  The options are:

Monthly - The demand date will be the first of the Month
5-day Week- Each Mon, Tues, Wed, Thurs, and Fri in the Month
6-day Week- Each Mon, Tues, Wed, Thurs, Fri, and Sat in the Month
7-day Week- Each day in the Month

Buttons

Close: This will close the Inventory Forecast screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

10.25 Item Daily Forecast

This screen enables you to define daily Forecasts against selected Items.  This forecast can be
used in the Inventory Replenishment routine which looks at Actual -v- Forecast Demands

List Tab

This panel shows all Inventory Items and if they have a daily Forecast attached to them.

Display fields

Item Code: Display only field showing the Item Number

Description: Display only field showing the Description of the Item taken from the Inventory
record.

Unit: Display only field showing the Base Unit of Measure for the Item taken from the Inventory
record.

Status: Display only field showing the Current status of the Item taken from the Inventory record.

Forecasted: Display only checkbox showing if the Item has a Forecast held against it

Data Display Options
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Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Obsolete Status - By default the display will only show Items that have a status of ‘Active’
.   If you wish to see all Items including those that have status ‘Obsolete’ then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Forecast screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Detail Tab

This tab enables you to create and maintain a Forecast against an Item selected in the ‘List’ tab

Entry and Display fields

Item Code: Display only field showing the Identity of the selected Item

Unit: Display only field showing the base Unit of Measure for the selected Item

Description: Display only field showing the Description of the selected Item

Default Supply Method: Display only field showing the Supply Method held against the selected
Item

Status: Display only field showing the current status of the selected Item

On-Hand Qty: This is a display only field showing the current stock level across all Warehouses
and Locations.  For detailed on-hand information click on the adjacent button (Inventory
Availability)

Inventory Availability: Clicking on this button will bring up a separate panel that shows details of
the Inventory Availability for this Item.  This includes

· Stock by Location segregated by Tracking Characteristic if applicable
· Projected Availability taking into account current stock plus supply and demand
· List of Supply and Demand orders

Sourced By: Display only field showing how this Item is sourced.  The display options are
Purchasing - fully purchased Item
Assembly - Assembled in-house
Supplier Assembled - Components sent to Supplier for Assembly
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Re-Order Level: Display only field showing the Re-Order Level.  This is used in the Inventory
Replenishments Routine to define the stock level at which the program generates a Planned
Supply order. 

Min Re-Order Quantity: Display only field showing the Minimum Re-Order Quantity.  This is used
in the Inventory Replenishments Routine to define the minimum quantity to order when the stock is
at, or below, the Re-Order Level.  The Replenishment Routine will generate a Planned Order
based on the greater of the actual demand or the Re-Order Quantity.

Lead Time: Display only field showing the Item’s Lead time.  This will be applied to both Purchase
Orders and Assembly Orders to determine when the order should be placed.    

Default Supplier: Display only field showing the Item’s default Supplier.  This is used by the
Replenishment routine, or Source on Demand function to generate a planned Order linked to a
preferred Supplier. 

Daily Forecast Records

Forecasts quantities are entered relative to the requirements for each date and for each Site.     

Buttons

Close: This will close the Inventory Forecast screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

10.26 Item Add-On Sales

This feature enables you to maintain multiple lists of ‘Add-On Sales’ records.  An ‘Add-On Sale’ list
is linked to an Inventory Item and is used to prompt the Salesperson about promotions, special
deals, and prices that can be associated with the Item as it is being sold.      

List Tab

Display fields

Item Code: Display only field showing all Items that have ‘Add-On Sales’.   It will only appear in
this list if the checkbox is ‘checked’ in the Item’s main screen (Inventory>Items)

Description: Display only field showing the description of each listed Item    

Unit: Display only field showing the base Unit of Measure of each listed Item    

Standard Sell Price: Display only field showing the Standard Sell Price as held against the Item    

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
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heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Add-On Sales screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Detail Tab

This tab enables you to add promotional and add-on sales Items to the parent Item.   

Entry and Display fields

Upper Panel

Item Code: Display only field showing the selected Item.    

Description: Display only field showing the description of the Item    

Unit: Display only field showing the base Unit of Measure of the Item    

Standard Sell Price: Display only field showing the Standard Sell Price as held against the Item    

Centre Panel

The centre panel lists the current ‘Add-On’ Sales entries.  Each entry shows:
Line Type - Item, Descriptor or Kitset
Code - The Item, Descriptor, or Labour Code
Qty - The quantity entered via the lower panel
Explanation - The Sales Explanation entered via the lower panel
Price Applies - The Special Price Applies checkbox as entered via the lower panel
Special Price - The Special Unit Price as entered via the lower panel
Extra Warranty - Checkbox showing if this line is covered by Warranty
Notes - Additional Notes as entered via the lower panel

The fields in this panel can be repositioned by dragging the column heading left or right to the
position where you want it to appear.

Lower Panel

The lower panel is where you maintain the ‘Add-On’ Sales Items

Line Type:  Select the Line Type from the drop-down list.  The options are:
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· Item Code
· Descriptor Code
· Kitset Code

Code: From the drop-down list select the code.  The drop-down list displays the codes relating to
the selection made in the Line Type field

Default Qty: Enter a default quantity to be used.  This will display during the sales function.   It can
be amended at that time and made specific to the Order. 

Unit: Display only field showing the base unit copied from the Item, Descriptor or Kitset.     

Special Pricing: If this is ‘checked’ then the associated special price will apply when this Add-On
Sales is used.   If it is not ‘checked’ then the line’s normal pricing matrix will apply.

Special Price: If the Special Pricing’ checkbox is ‘checked’ then the price entered here will
override any other sell price against this line.
     
Description: Display only field showing the description of the Item, Descriptor, or Kitset Code
record. 

Sales Explanation: A short sentence that will help the Sales Person to promote this Line.

This is an extended or Optional Warranty Charge: This will only appear if the Item or Descriptor
is flagged as having a Sales Warranty.  If this is ‘checked’ then the line is offering an extended
Warranty or that the sale of the main Item has this ‘Add-On’ as an optional Warranty.

Notes: Extended Notes for your own information can be attached to this Add-On Sales Line. 
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Add-On Sales screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank Lower Panel for entry of a new Add-On Sale line.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Add-On Sale Line record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This deletes the current highlighted line

10.27 Settings

10.27.1 Item Traceability

10.27.1.1 Item Grades

This function allows you to view all Items that are segregated by Grade with drill-down on each
Item to view what Grade are available against the Item and whether the Item is restricted to those
Grades.
(Note: If the variant Grade is utilised for Containers, then this screen is not applicable).
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List Tab

Display fields

This shows a List of all Item records that are segregated by Grade.   I.e. Their ‘Grade’ checkbox ‘
checked’ in the Item Master record

Item Code: The Item Number identity against which the Grades are being maintained.

Description: Description of the Item taken from the Inventory record

Unit: Description of the Item taken from the Inventory record

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Traceability - Grades screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will go to the ‘Detail’ screen and position the cursor ready for entry of a new Grade
record applicable to the current highlighted Item.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Detail Tab

Entry and Display fields

Item Code: Display only field showing the Item Number selected in the List panel

Description: Display only field showing the description for this Item as held against the Item
Master record

Unit: Display only field showing the base Unit of Measure for this Item as held against the Item
Master record
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Restrict Grades to List Below: If this is ‘Checked’ then the entry of Grades during stock
movements is restricted to those defined in this list.  Note: If current stock exists for this
Item/Grade then this checkbox cannot be accessed.

Grade Number: Enter the Grade Identity that will be used with this Item.  No validation checks are
made but duplicate Grades are not allowed.

Description: Enter a brief description of the Grade.  This will be useful during selection against the
item

Notes: You can enter unlimited amount of Notes that are related to this Item/Grade. 

Buttons

Close: This will close the Traceability - Grades screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Grade record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Grade record or the last time the ‘Save’ Button was
pressed will be lost.

10.27.1.2 Item Sizes

This function allows you to view all Items that are segregated by Size with drill-down on each Item
to view what Sizes are available against the Item and whether the Item is restricted to those Sizes.

List Tab

Display fields

This shows a List of all Item records that are segregated by Size.   I.e. Their ‘Sizes’ checkbox ‘
checked’ in the Item Master record

Item Code: The Item Number identity against which the Sizes are being maintained.

Description: Description of the Item taken from the Inventory record

Unit: Description of the Item taken from the Inventory record

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
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records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Traceability - Sizes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will go to the ‘Detail’ screen and position the cursor ready for entry of a new Size record
applicable to the current highlighted Item.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Detail Tab

Entry and Display fields

Item Code: Display only field showing the Item Number selected in the List panel

Description: Display only field showing the description for this Item as held against the Item
Master record

Unit: Display only field showing the base Unit of Measure for this Item as held against the Item
Master record

Restrict Sizes to List Below: If this is ‘Checked’ then the entry of Sizes during stock movements
is restricted to those defined in this list.  Note: If current stock exists for this Item/ Size then this
checkbox cannot be accessed.

The Size is used as a variable Unit of Measure: If this box is ticked, then this item can be sold
or issued based on the size instead of the base unit of measure. For example an item may be
stocked in kilograms but sold in bags. Ticking this box will allow you to enter the default conversion
factor and the size unit.

Default Conversion Factor:  Enter the factor to convert size unit to base unit of measure.

Size Unit: Select the size unit of measure. 

Sizes

Size: Enter the Size Identity that will be used with this Item.  No validation checks are made but
duplicate Sizes are not allowed.

Description: Enter a brief description of the Size.   This will be useful during selection against the
item

Notes: You can enter unlimited amount of Notes that are related to this Item/ Size. 

Buttons

Close: This will close the Traceability - Sizes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.
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Add: This will send the cursor to a new line for entry of a new Size record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Size record or the last time the ‘Save’ Button was
pressed will be lost.

10.27.1.3 Item Colours

This function allows you to view all Items that are segregated by Colour with drill-down on each
Item to view what Colours are available against the Item and whether the Item is restricted to those
Colours.
(Note: If the variant Colour is utilised for Containers, then this screen is not applicable).

List Tab

Display fields

This shows a List of all Item records that are segregated by Colour.  I.e. Their ‘Colours’ checkbox ‘
checked’ in the Item Master record

Item Code: The Item Number identity against which the Colours are being maintained.

Description: Description of the Item taken from the Inventory record

Unit: Description of the Item taken from the Inventory record

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Traceability - Colours screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will go to the ‘Detail’ screen and position the cursor ready for entry of a new Colour
record applicable to the current highlighted Item.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel
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Detail Tab

Entry and Display fields

Item Code: Display only field showing the Item Number selected in the List panel

Description: Display only field showing the description for this Item as held against the Item
Master record

Unit: Display only field showing the base Unit of Measure for this Item as held against the Item
Master record

Restrict Colours to List Below:  If this is ‘Checked’ then the entry of Colours during stock
movements is restricted to those defined in this list.  Note: If current stock exists for this
Item/Colour then this checkbox cannot be accessed.

Colours

Colour: Enter the Colour Identity that will be used with this Item.  No validation checks are made
but duplicate Colours are not allowed.

Description: Enter a brief description of the Colour.   This will be useful during selection against
the item

Notes:  You can enter unlimited amount of Notes that are related to this Item/ Colour. 

Buttons

Close: This will close the Traceability - Colours screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Colour record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Colour record or the last time the ‘Save’ Button was
pressed will be lost.

10.27.1.4 Item Batches

Item Batch records will now automatically be created when Batch Tracked items are receipted into
stock from Purchasing, Assemblies and Adjustments. This will allow additional information
to be trapped

later against this batch either manually through the Item Batch screen or by Freeway (NB: The
Freeway portion is currently under development and will be released later)

Item Batch records now contain the following fields to allow further data to be captured:
o Batch Status

o Supply Style

o Source

o Manufacture Date

o Expiry Date
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List Tab

Display fields

Item Code: Display-only field.

Description: Display-only field.

Unit: Display-only field.  

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Locations screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Location from this table

Related: This will bring up a list of functions that are related to the item.

Reports: This will bring up a list of Reports that are related to the item. 

Detail Tab

Entry and Display fields

Item Code:  Display-only field.   

Description: Display-only field.
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Unit : Display-only field.

Restrict Batch Numbers to the List Below : Tick this box if you wish to restrict Item Batch
Numbers for this item.

Batch Information

List tab

Batch No. : Enter the Item Batch number here.

Description: Enter a brief description.

Batch Status : Select from the drop-down list (Approved / OnHold / QC Required / Rejected)

Supply Style: Select from the drop-down list (Purchased / Manufactured / Adjustment)

Source : Enter the Source of the batch.

Manufacture Date: Enter the date of manufacture.   

Expiry Date: Enter the batch expiry date.  (Use Inventory Change to amend these dates on
existing inventory records)

Notes: You can enter unlimited amount of Notes that are related to this batch.   

Properties tab (Standard Properties can be linked to a Batch for the purposes of recording test
results. (Eventually Freeway will allow you to update these from a new “Property” field in a
checklist)).

Batch No. : Display-only field showing the linked Item Batch number.

Property : Enter/select the name of the property here.

Value : Enter the value of the property here.

Market Codes tab (The concept of this is to restrict the issuing of specific items and batches to
customers. An example of this is where a customer associated with a particular market eg: EU can
only purchase items and Batches flagged as EU Market Code. Only items or item batches that
have restrictions need to be flagged with a Market Code. All other items (without that defined) will
be available for sale to all Markets. Markets Codes are initially setup from
Inventory->Settings->Market Codes)

Batch No. : Display-only field showing the linked Item Batch number.

Market Code : Select the appropriate Market Code to restrict this item batch to.

Status Change Log tab
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This screen logs all the changes to the Item Batches. The latest change appears as the first
record.

Batch No. : Display-only field showing the linked Item Batch number.

Old Status : Display-only field showing the previous batch status.

New Status : Display-only field showing the new batch status.

From User or Employee : Display-only field showing the Ostendo User or Mobility employee who
created this record.

From Name : Name of Ostendo User or Mobility Employee. 

Change Source : The source of the change.

Data Sheet ID : The Datasheet ID, if this record came from Freeway.  

Changed Date : The date this record was created.

Changed Time : The time this record was created.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new batch record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: this will delete the current highlighted record.

Related: This will bring up a list of functions that are related to the item. (e.g. Item Batch
Documents)

Reports: This will bring up a list of Reports that are related to the item. 

10.27.1.5 Item Revisions

This screen allows you to maintain Revision Levels against selected Items.   For these Items
Inventory is segregated by their Revision Level.

List Tab

Display fields

The displayed fields are taken from those Item records flagged as being Revision Level controlled. 
Selecting a line and clicking the ‘Detail’ tab will enable you to maintain Revision Levels against the
Item.

Item Code: Display only field showing the identity of the Revision controlled Item 
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Description: Display only field showing the description of the above Item.

Unit: Display only field showing the unit of measure of the above Item

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Revisions screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Revision Level.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Item Code: Display only field showing the identity of the Revision controlled Item 

Description: Display only field showing the description of the above Item.

Unit: Display only field showing the base unit of measure of the above Item.

Revision No: Enter a Revision Number for this Revision Level.  Duplicate Revision Levels not
allowed.    

Description: Enter a short description of the reason for the Revision.  No checks are made on this
entry.

Status: Select the current status of this Revision from the drop-down list.  The options are ‘Active’
or ‘Inactive’

BOM Version:  Select the BOM Version used for this Revision.
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Date: From the dropdown calendar select the effective start date of this Revision.

Notes: You can enter unlimited amount of Notes that are related to this Revision. 

Buttons

Close: This will close the Item Revisions screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Revision Level.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will remove the current highlighted Revision Level.

10.27.2 Categories

This screen allows you to maintain a list of Categories, which are used to group and analyse Items
and Descriptors records.    

Entry and Display fields

Name: Enter the Name of the Category.   Duplicates not allowed.

Description: Enter a short description of the Category.  No checks are made on this entry

Mobility Image: Click on this field and Right-Click to load an image (png or jpeg) for this Category
for use with the Graphical Material Lookup Style in Mobility Freeway templates.

  Images must be square and the recommended optimal size is 256 pixels by 256
pixels.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Category screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Category.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Category.
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10.27.3 Sub Categories

This screen allows you to maintain a list of Item Sub Categories, which are used to group and
analyse Item records.    

Entry and Display fields

Category: From the drop-down list select the Category to which this Sub-Category belongs.
Categories are maintained via Inventory>Settings>Categories

Sub Category: Enter the Name of the Sub Category.   

Description: Enter a short description of the Sub Category.  No checks are made on this entry

Mobility Image: Click on this field and Right-Click to load an image (png or jpeg) for this Sub
Category for use with the Graphical Material Lookup Style in Mobility Freeway templates.

  Images must be square and the recommended optimal size is 256 pixels by 256
pixels.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Sub Category screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Sub Category.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Sub Category.

10.27.4 Feature Groups

This screen allows you to maintain a list of Feature Group Names which are used in Item Mobility
and Web and Descriptor Mobility and Web specifications.    

Entry and Display fields

Group Seq: Enter the Group Sequence Number

Group Name: Enter the Name of the Features Group.   

Group Description: Enter a short description of the Features Group.  No checks are made on this
entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.
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Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Features Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

10.27.5 Location Groups

This screen allows you to maintain a list of Location Groups, which are used to group and analyse
Locations in addition to facilitating selective stocktakes by Location Group.    

Entry and Display fields

Name: Enter the Name of the Location Group.   Duplicates not allowed.

Description: Enter a short description of the Location Group.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Location Group screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Location Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Location Group.

10.27.6 Location Aisles

This screen allows you to maintain a list of Location Aisles.  Location Aisles are commonly used in
combination with Racks and Rows to define the precise location within a Warehouse.    

Entry and Display fields

Location Aisle: Enter the Name of the Aisle.   Duplicates not allowed.

Description: Enter a short description of the Aisle.  No checks are made on this entry
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Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Location Aisle screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Location Aisle record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Location Aisle record.

10.27.7 Location Racks

This screen allows you to maintain a list of Location Racks.  Location Racks are commonly used in
combination with Aisles and Rows to define the precise location within a Warehouse.    

Entry and Display fields

Location Rack: Enter the Name of the Rack.   Duplicates not allowed.

Description: Enter a short description of the Rack.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Location Rack screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Location Rack record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Location Rack record.

10.27.8 Location Rows

This screen allows you to maintain a list of Location Rows.  Location Rows are commonly used in
combination with Aisles and Racks to define the precise location within a Warehouse.    

Entry and Display fields



545Inventory

Location Row: Enter the Name of the Row.   Duplicates not allowed.

Description: Enter a short description of the Row.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Location Row screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Location Row record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Location Row record.

10.27.9 In Transit Defaults

This screen allows you to create and maintain In Transit Defaults to specifically annotate a default
Warehouse to be used whilst the Transfer Batch is 'In Transit' during Site to Site Transfers

Entry and Display fields

From Site: From the drop-down list select the Site from where the Transfer will begin

To Site: From the drop-down list select the Site to where the Transfer will ultimately end

In Transit Warehouse: From the drop-down list select the Warehouse where the transfer batch
will be held whilst it is 'In Transit'.  The Warehouses in the drop-down list will be restricted to those
linked to the 'From' Site

In Transit Location: From the drop-down list select the Location where the transfer batch will be
held whilst it is 'In Transit'.  The Locations in the drop-down list will be restricted to those in the
above Warehouse

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the In Transit Defaults screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new In Transit Default record.

Save: This will save the current data without exiting the screen
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Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted In Transit Default record.

10.27.10Adjustment Types

This screen allows you to maintain a list of Adjustment Types, which are used in Inventory
Adjustment Transactions to segregate the adjustment into meaningful Movement Types.    

When making a Stock Adjustment Ostendo goes through the following hierarchy to determine the
Cost Centre:

Get Cost Centre from 'Adjustment Type by Warehouse' screen for the Warehouse/Adjustment
Type
If that doesn't exist then get Cost Centre from 'Cost Centre Mapping By Site' screen for Site/Stock
Adjustment Variance
If that doesn't exist then get Cost Centre from 'Adjustment Type' (this screen) for Adjustment Type
If that doesn't exist then get 'Base' Cost Centre from ''Cost Centre Mapping' for Stock Adjustment
Variance

Entry and Display fields

Type: Enter the name of the Adjustment Type.  Duplicates not allowed.

Description: Enter a short description of the Adjustment Type.  No checks are made on this entry

Cost Centre: From the drop-down list select the Cost Centre that will be used when using this
Adjustment Type.

No Cost Shrinkage Type: Tick the box to indicate that this Adjustment Type does not have any
cost shrinkage.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Adjustment Type screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Adjustment Type.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Adjustment Type.
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10.27.11Adjustment Types by Warehouse

Each Warehouse record contains a default Cost Centre for Stock Adjustments.  This screen
allows you to maintain Cost Centres against specific Adjustment Types when issuing to, or from, a
nominated Warehouse.

When making a Stock Adjustment Ostendo goes through the following hierarchy to determine the
Cost Centre:

Get Cost Centre from 'Adjustment Type by Warehouse' (this screen) for the
Warehouse/Adjustment Type
If that doesn't exist then get Cost Centre from 'Cost Centre Mapping By Site' screen for Site/Stock
Adjustment Variance
If that doesn't exist then get Cost Centre from 'Adjustment Type' for Adjustment Type
If that doesn't exist then get Cost Centre from ''Cost Centre Mapping' for Stock Adjustment
Variance

Entry and Display fields

Warehouse: From the drop-down list select the Warehouse to which a specific Adjustment and
Cost Centre is being defined

Adjustment Type: From the drop-down list select the Adjustment Type that is being addressed

Cost Centre: From the drop-down list select the Cost Centre that will be used for this
Warehouse/Adjustment Type combination

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Adjustment Types by Warehouse screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Warehouse/Adjustment Type record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Warehouse/Adjustment Type record

10.27.12Manufacturers

This screen allows you to maintain a list of Manufacturers, which are used to identify the
originating Manufacturer against Item records.    

Entry and Display fields

Manufacturer: Enter the Name of the Manufacturer.   Duplicates not allowed.

Notes: Enter any Notes that are relevant to this Manufacturer.  No checks are made on this entry
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RTF Filename: From the drop-down panel locate the .rtf file that contains information about this
Manufacturer.  This rtf file can then be printed directly onto your own documentation as required.
:  

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Manufacturers screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Manufacturer.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Manufacturer.

10.27.13Brands

This screen allows you to maintain a list of Brand Names used by a Manufacturer.

Entry and Display fields

Manufacturer: From the drop-down list select the Manufacturer to which this Brand belongs.
Manufacturers are maintained via Inventory>Settings>Manufacturers.

Brand: Enter the name of the Brand used by this Manufacturer.   

Notes: Enter some notes relating to this Brand.  No checks are made on this entry

Rtf Filename: From the drop-down panel locate the .rtf file that contains information about this
Brand.  This rtf file can then be printed directly onto your own documentation as required.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Brands screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Brand.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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Delete: This removes the current highlighted Brand.

10.27.14Matrix Dimensions

This screen allows you to create and maintain Matrix Dimensions.  These Dimensions are used by
the Matrices (Items>Matrices) screen to facilitate the creation of an Order Entry Template which
displays an array using Two (or Three) Dimensions so that, during Sales or Purchase Order Entry,
a single panel is used to enter quantities against the allowable dimension combinations

List Tab

Display fields

Matrix Code: This is display only that shows the current Matrix Codes that exist in Ostendo.    

Description: Description of the Matrix Code taken from the Matrix Code record.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking against
will sort in descending order. 

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Matrix Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Matrix Code.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Matrix Code record from this table

Detail Tab

This tab enables you to maintain the Master record for this Matrix Dimension.  The variables within
this record are added in the ‘Levels’ tab

Entry and Display fields

Matrix Code: Enter a Matrix Code Name.  This name will be available for selection in the
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Inventory>Matrices screen to provide the XY or XYZ options used in Sales or Purchase Order
entry.   

Description: Description of the Matrix Code.  A description must be entered.  However, no checks
are made on the entry content

Buttons

Close: This will close the Matrix Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will present this screen in preparation for entry of a new Matrix Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Values Tab

This tab facilitates the entry and maintenance of all the variants that apply to this Matrix Code.

Entry and Display fields

 
Value: Enter a Value that will be displayed in the Matrices.  For example, if the Matrix Code is
'Size' then this entry could be 'Small' and further entries in this screen could be 'Medium' and
'Large'.

Sort Sequence: This is the Sequence in which the variables are displayed in the Order Matrix.
When adding a record it is automatically given a number of the current highest number plus 10. 
You may amend this number at any time to denote the sequence in which you want it to be
displayed in the order Matrix

Buttons

Close: This will close the Matrix Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Variable.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will remove the current Variable from this Matrix Code
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10.27.15Market Codes

This screen allows you to maintain a list of Market Codes.
Market Codes are generally used to restrict certain item batches to customers which may have
certain requirements as to the quality  or source of the products.  
For example, if a customer has a requirement that all food products that they purchase must meet
EU standards, then we could assign a market code of "EU" to this customer.
Then all item batches produced must be tested against the published EU standards, and if the
batch meets them, then that batch will be assigned the "EU" market code.
Batches that do not have the "EU" market code will not be sold to this customer.

Entry and Display fields

Market Code : Enter the code.

Description: Enter a short description for this code.   

Notes: Enter some notes relating to this code.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

10.27.16GS1 Definitions

This screen allows you to enter and maintain the Function Code 1 codes required for GS1 code
generation.

Entry and Display fields

FNC1 Style: Select either ASCII Value or Text Value for the Function Code 1 Style.

FNC1 Value: Enter the value of the FNC1 code here.   

Description: Enter some description for this code.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
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left or right to the position where you want it to appear.

Buttons

Close: This will close the Brands screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

10.27.17Container Types

This screen allow you to define the various types of Containers to be used in the company.

Entry and Display fields

Type: (e.g. Pallet / Pail / Silo ...etc. ) Enter the type of container.

Description:  Enter a brief description of this Container Type.

Prefix:  Enter 1 - 4 characters as the starting prefix for the container ID

Reusable Style:  Select either Reusable or NonReusable. The default is Reusable.
A NonReusable container's status will be automatically changed to "Scrapped" once it is empty.

Certification Required:  Tick this box if this Container Type should have an applicable
Certification Expiry Date.

Certification Days:  Enter the number of days after container creation before the Container
Certificate will expire.

The following dimensional values indicate the default capacities of the container and are passed
through to the Container master record on creation. They can be overridden if required.

Tare Weight:   Enter the unladen weight of the container. 

Max Weight :  Enter the maximum total weight of all items that can be added to the
container.  

Max Volume:  Enter the maximum total volume of all items that can be added to the
container

Max Length:  Enter the longest length of any one item that can be stored in the container.

Max Width:  Enter the maximum width of any one item that can be placed in the
container.  

Max Height: Enter the maximum height of any one item that can be placed in the
container.
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Container Style: Select either "Container Contents"  or  "Assembly Order".  The default is
Container Contents.

"Container Contents" - means anything can go into this container.
"Assembly Order" - is a "Virtual Container" - this container type can only

store contents from a single Assembly Order (issues and receipts).
This controls whether this container is a virtual storage

container for the purposes traceability of manufactured serialised or batched products
and their associated component issues. This means that the
contents of this virtual container will show all components and their variants (eg:
batch / S/N) in one place along with the receipt finished product. 

Each Serialised Finished Goods Item must be linked to ONE
container. Equally in a Batched Finished Goods environment, ONE batch
will be associated with ONE container.

This container will automatically be marked as shipped, when
the AO is closed however it will remain in the system for historic
purposes allowing full component->Serialised
Product traceability

This Container style is copied to the Container Master record
upon creation of the Container itself. The first issue or receipt to this container
will link this container to that AO.

Label Report: If required, a Label Report can be linked to this Container Type.

SSCC Options: (Serial Shipping Container Code) - Options are "No SSCC"  or "Manual SSCC"
"Manual SSCC" will enable an SSCC field to be available for entering an SSCC

code for the actual container.

Linked Item Code: If this is a "Chep Pallet" or loan pallet type, then enter the item code for that
pallet type. This will enable Ostendo to keep track of the inventory of such containers.

Adjustment Type: Select a stock Adjustment Type from the dropdown list. This defines the
Default Stock Adjustment Type which will initially populate the new containers when created. The
stock Adjustment Type can be amended before the container ID is saved.

Upload Required: (Upcoming Feature) This will be used when we upload Container
Contents to Ostendo.Work enabling a Freeway Standalone solution to read the
Container Contents.

Status: Select either "Active" or "InActive".

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

10.27.18Container Content Groups

These Container Content Group names allow you to group item codes together for the purposes of
allowing or disallowing groups of items being stored on any one container collectively.

Container Content Group names are used in Inventory --> Container Group Matrix which groups
items together.

Entry and Display fields

Container Content Group: Add Group Names as required (maximum 100 characters per name.)

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.container 

10.27.19Restocking Templates

This screen allows you to create and maintain Restocking Templates.  Restocking Templates are
used to facilitate the mass transfer of Inventory from one location to another.  For example:-

· Replenishment of stock at a remote Warehouse
· Replenishment of stock in a Delivery Van

List Tab

Display fields

Template: This is display only that shows the current Templates in Ostendo.    

Description: Description of the Template taken from the Template record.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
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and sorting:
· To sort the data in a selected column simply click on the column heading.  Clicking

against will sort in descending order.
· Click on the black ‘down arrow’ to the right of your selected column heading and you can

either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Restocking Templates screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Template.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Template from this table

Related: This will bring up a list of functions that are related to the Restocking Templates.  You
may open and maintain information in those screens whilst still remaining in the Restocking
Templates screen.

Reports: This will bring up a list of Reports that are related to the Restocking Templates.  You can
immediately run the report whilst still remaining in the Restocking Templates screen.

Detail Tab

This tab enables you to maintain Restocking Template Heading.   The Template details are added
to this Template in the ‘Levels’ tab

Entry and Display fields

Template: Entry is only allowed during an Add transaction.   Enter the name of the new Template.
  Duplicate Template names are not allowed

Description: Enter a brief description of the Template.   A longer description can be entered into
the Notes (see below)

ReOrder Style: Select either "Maximum Level" or "Minimum Level" to reorder.

Notes: You can enter unlimited amount of Notes that are related to this Template.   These notes
will be available wherever the Template is reported.   Whenever you click on this field an icon will
appear in the top-right.   By clicking on this Icon you can bring up the Frequently Used Text table.  
Select the text to be copied and either press the OK Button in that screen or double-click the
selected record.

Buttons

Close: This will close the Restocking Template screen.  If you have any unsaved data then you will
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be asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Template.  You may open and
maintain information in those screens whilst still remaining in the Template screen.

Reports: This will bring up a list of Reports that are related to the Template.  You can immediately
run the report whilst still remaining in the Template screen.

Levels Tab

Entry and Display fields

This screen facilitates the entry of all Items that may be restocked along with their Re-Order Level
and Transfer Quantity.   Whenever this Template is used the current Stock level at the Warehouse
is compared against the Re-Order level defined here.   If that current Stock is less than the
Re-order level then it is added to a Transfer List and the quantity to transfer will be the ‘Transfer
Quantity’ defined below.

Item Code: From the dropdown list select the Item Code to be included in this Restocking
Template

Unit: From the drop-down list of Units available against the Item Code select the Unit to be
addressed in this Restocking Template

Reorder Level: Enter the Stock level at which the program will create a transfer record

Transfer Multiple: Enter the quantity that will be transferred in the Transfer record

Reorder UpTo Qty: Enter the maximum quantity to be re-ordered.

Buttons

Close: This will close the Restocking Template screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: The cursor will go to a new line for entry of a new Restocking record

Cancel: Any changes made since the line was accessed or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current line in the Template

Related: This will bring up a list of functions that are related to the Template.    You may open and
maintain information in those screens whilst still remaining in the Template screen.
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Reports: This will bring up a list of Reports that are related to the Template.   You can immediately
run the report whilst still remaining in the Template screen.

10.27.20Picking Classes

This screen allows you to maintain a list of Picking Classes. 
Picking Classes helps to classify products into various groups from the perspective of goods
picking.
For example, you could have a class of goods which require a forklift to pick it or another class
which require special handling procedures, etc...    

Entry and Display fields

Picking Class: Enter the name of the Picking Class.   Duplicates not allowed.

Class Description: Enter a short description of the Picking Class.  No checks are made on this
entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record.

10.27.21Mass Replacement

Mass Replacements allows you to carry out replacement of an Item, Descriptor or Labour Code by
an Item, Descriptor or Labour Code at selective occurrences across the whole system.   This is
achieved on a single screen and one update function.

Entry and Display fields

Existing Component (Old)

Code Type: From the drop-down list select the Type of product that is being replaced.   The
options are Item, Descriptor or Labour Code

Code: From the drop-down list select the specific product.  This drop-down list shows the relevant
list relating to the Code Type

Description: Display only field showing the description of the Item, Descriptor or Labour Code.
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Unit: Display only field showing the Unit of Measure for the Item, Descriptor or Labour Code.

Replacement Component (New)

Code Type: From the drop-down list select the Type of product that is replacing the old product. 
The options are Item, Descriptor or Labour Code.  You should note that you do not have to replace
a Code Type with the same Code Type

Code: From the drop-down list select the specific product.  This drop-down list shows the relevant
list relating to the Code Type

Description: Display only field showing the description of the Item, Descriptor or Labour Code.

Unit: Display only field showing the Unit of Measure for the Item, Descriptor or Labour Code.

Parent Types

Types for Replacement: In the drop-down list ‘check’ the areas where you are making the
replacement.   The Options are:

· Bills Of Material
· Kitsets
· Templates
· Task Bills
· Lists

Retrieve: Having selected the Types of replacement this button becomes active.  Upon Clicking
on this the program will return all occurrences of the ‘Old’ components in the above ‘Types for
Replacement’ categories and display them in the lower panel for further action.

Lower Panel

Select: ‘Check’ the checkbox where you want the replacement to be made.   You have the option
to click on the ‘Select All Codes’ Button at the bottom of this panel to select all the records.  You
may also click on the ‘De-select All Codes’ Button at the bottom of this panel to ‘un-select’ all the
records

Parent Type: This is a display only field that shows where the component being replaced exists in
Ostendo.  This can be:

· Bills Of Material
· Kitsets
· Templates
· Task Bills
· Lists

Parent Code: This is a display only field that shows the Parent Type’s parent Identity

Old Quantity: This is a display only field that shows the current usage quantity of the ‘old’
component in the Parent Identity.

Old Unit: This is a display only field that shows the Unit of Measure of the ‘old’ component in the
Parent Identity.

New Quantity: This is prefilled with the ‘Old Quantity’ but may be amended to suit this
replacement.
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New Unit: This is prefilled with the ‘Old Unit’ but may be amended to suit this replacement.  If this
is being changed then select the alternate unit from the drop-down list.  This displays only those
units that are used by the ‘New’ component

Parent Description: This is a display only field that shows the Parent’s Description.

Buttons

Select all Codes: Selecting this button will ‘check’ all the components in the lower panel

De-select all Codes: Selecting this button will ‘un-check’ all the components in the lower panel

Update selected Parents: All the ‘checked’ lines will have their ‘old’ component replaced with the ‘
new’ component.

Cancel: Any changes made since this screen was accessed will be lost.

10.27.22Item Rules

This screen allows you to maintain Item Rules.  Item Rules allow you to define what rules, within
the Inventory area, you wish to apply.  The following rule settings are available

Entry and Display fields

Default Warehouse: From the drop-down list select the Warehouse that will become the system
default. 

Default Location: From the drop-down list select the Location within the above Warehouse that
will become the system default. 

Stock Sourcing Override: This allows you apply a ‘Source On Demand’ activity against ‘Supply
from Stock’ Items whenever a selected condition is found.  The options are:

Standard Replenishment: Never use ‘Source on Demand’ for this ‘Supply from Stock
Item
Source on Demand if On-Hand is insufficient: Use ‘Source on Demand’ whenever the
Item’s stock on hand would go negative with the current demand
Source on Demand if Available is insufficient: Use ‘Source on Demand’ whenever the
Item’s Available (free) stock would go negative with the current demand

Disable Negative Stock for all Items: If this is ‘Checked’ then Issuing of Items from Stock will not
be allowed if the resultant Inventory level goes below zero.  Note: If this is not checked then you
have the option to selectively apply this to individual Items in the Item master record.  

If Barcode is empty then populate with Code - If this is ‘checked’ then the Item or Descriptor
Code will be copied to the Barcode field when generating a new Item or Descriptor.

Assembly Backflush Policy- From the drop-down list select the policy regarding Backflushing
during Assembly Order receipts.  The options are:

· Item Specific:The Backflushing option is defined at individual Item level in the 'Additional
Inventory Settings' screen of the Item Master record

· All Items: All Assembly Orders will be backflushed

Free Stock Options: This defines the way in which Available Free Stock is calculated during
Order Entry.  Select the preferred option from the drop-down list

Not Used:  You are not using Freestock criteria during Order entry
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By Required Date:  The demands/supply is based on the order Line Required Date
By Order Date:  The demands/supply is based on the Order Header’s Order Date

Inventory As At Valuation Style - From the drop-down list select the method by which you want
the Inventory to be valued in the 'Inventory and WIP Valuation' routine.   The options are:

Cost History:  This looks at the Cost History records held against each Item and uses the
Cost that was effective at the time of the stock movement.
Financial History: This looks at the Financial Journals that were created for the Items and
uses the costs held against each Journal   

The reason for these options is that if a Stock Adjustment record was posted with a prior date then
all subsequent receipt transaction should take account of that when evaluating their Average Cost. 
If you want this realistic valuation then choose 'Cost History'   However, a Financial Transaction
would simply post a cost of the adjustment to the linked Accounting package and that would not
re-evaluate existing Receipt transactions.  If this is the preferred option then select 'Financial
History

Pack Size On-Hand Calculation - From the drop-down list select the method by which the
On-Hand Pack size is calculated.  The options are:

Conversion Factor:  This looks at the default Conversion Pack Size as held in the 'Size'
variable panel of the Item Master and applies this factor to the current Size Variables held
in stock to arrive at an assessed quantity of the Pack Size currently in stock
Batch Count: This looks at the various Batches currently in stock for each Item and
assumes a quantity of one Pack quantity per Batch Number.  

Qty to Use for Web - From the drop-down list select the source of the Item stock quantity
information for use with Web-based ordering.  The options are:

On Hand Qty:  The Item's Total Stock Quantity
Available Qty: The Item's (Total Stock Quantity - Total Demand Qty + Total Supply Qty)
Free Qty: The Item's (Total Stock Quantity - Total Demand Qty)

Auto Build Location Code - If this is 'checked' then, when creating Locations via screen
Inventory>Locations the Location Code will be automatically created from the entered Aisle, Rack,
and Row when creating the Location record

Cost By Site - If this is 'checked' then Ostendo will maintain  cost records at Site level.  If it is not
checked then these will be maintained at Company level only

Stock Write-Off Type - From the drop-down list select the Inventory Adjustment Type that will be
used when writing off Stock

Disable Negative Stock Level - You can prevent Ostendo going into Negative Stock either for
ALL Items (Disable Negative Stock for all Items - above) or, if that is not selected - at Item level in
the Item Master record.  This field allows you to specify at which level the the Negative Stock
check is to be carried.   Therefore, from the drop-down list, select the level at which this is to be
applied.  The options are:

Item - If the sum of the Item stock across all locations for the Company goes negative
Site - If the sum of the Item stock across all locations for the Company Site goes negative
Warehouse - If the sum of the Item stock across all locations for the Warehouse goes
negative
Location - If the Item stock for a specific Location goes negative
Item Variant - If the sum of the Item's Variant stock across all locations for the Company goes
negative
Site Variant - If the sum of the Item's Variant stock across all locations for the Company Site
goes negative
Warehouse Variant - If the sum of the Item's Variant stock across all locations for the
Warehouse goes negative
Location Variant - If the Item's Variant stock for a specific Location goes negative
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Auto Create Item Site Records - By default Ostendo will always create Item Site records if the
above 'Costs By Site' checkbox is 'Checked'.  If the 'Costs By Site' checkbox is not 'checked' you
can still automatically create Item Site records to define ROL, ROQ, Leadtime, etc by Site if this
field is 'checked'

Adjustment Cost Default - From the dropdown list select the Cost Method that will used to
determine the prefilled Cost when making Stock Adjustment.  The Cost copied to the Adjustment
record can, of course, be amended prior to posting the Adjustment Batch.   The Cost options are:

· Last
· Standard
· Buy Price
· Average

Re-Order History Period Basis: The Re-Order Level in the Item Master record can be evaluated
from either Fixed Quantity or History Days.  The option selected in the Item Master record
determines how the quantity is calculated.  In that record:

· If 'Fixed Quantity' is used then that is entered directly into the Item Master record.
· If 'History Days' is selected then the quantity is evaluated based on the Number of Days as

entered into the Item Master record * Average Daily Usage Quantity
That source, in association with the following Rule, determines the Average Daily Usage.  From
the drop-down list select the History Period Basis.  This will determine the number of day's history
to address when determining the Average Daily Usage.  The options are:

· Use Re-Order Days - The number of days to use is as entered in the Item Master record
· Use History Period Days - The number of days to use is as entered in the next Rule

(Number of Days History)

Number of History Days: If the selection in the previous Rule (Re-Order History Period Basis) is
'History Days' then enter the number of days over which the Average daily usage will be
evaluated

Item Supersession is Active:  'Check' this checkbox if you intend to use Item supersession

control in Sales Orders, Job Orders, Purchase orders, POS and Direct Invoicing.

Default Inventory Availability Period:  Select either Days or Weeks or Months.

Obsolete and RunOut Status Control:  Default is "Strict Control". This means items that are

Obsolete or RunOut cannot be issued to a job even if they are already in the joblines. "Allow

Issues and Receipts" is less strict. This option means that if the item already exists in the

joblines, then it can still be issued to the job regardless if the ItemStatus is Obsolete or RunOut. 

Availability Transaction Running Total:  Ticking this box will show a running total of the

availability of any item in the Transaction History of that item.

Automatically create Unique Item Code:  Ticking this box will let the system generate the next

item code whenever a new item is created. Users will not be able to just enter any code they like

unless this rule is unticked.

Site Transfer Stock Remaining Balance %:  Enter an integer value for the percentage of stock to

be maintained at the Transfer From location. This is to prevent the depletion of stocks during
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transfers.

The following 4 Reservation Styles control the creation behaviour of Reservation Stock

Locations:

Sales Reservation Style:  Select the appropriate style for the creation of Reservation Stock

Locations for Sales orders. Options are - 

- No Reservations - this is the default. No reservation stock logic is used.

- Manual Reservations Only - this allows the user to manually set up the

locations. 

The location coding structure must be as follows:  SALE#xxxxxxx (where

xxxxxxx is the ordernumber). 

This rule also automatically creates a Reservations Warehouse (if it does

not exist) in the following format: RS#sitenamennn where nnn is a sequence number

starting with 001.

- Source on Demand Reservations - This will trigger the auto creation of

a Stock Location (SALE#xxxxxxx) when the first Source on Demand PO is created.

A Reservations Warehouse (if it does not exist) will also be automatically

created (RS#sitenamennn). 

Jobs Reservation Style:  Select the appropriate style for the creation of Reservation Stock

Locations for Job orders. Options are - 

- No Reservations - this is the default. No reservation stock logic is used.

- Manual Reservations Only - this allows the user to manually set up the

locations. 

The location coding structure must be as follows:  JOB#xxxxxxx (where

xxxxxxx is the ordernumber). 

This rule also automatically creates a Reservations Warehouse (if it does

not exist) in the following format: RS#sitenamennn where nnn is a sequence number

starting with 001.

- Source on Demand Reservations - This will trigger the auto creation of

a Stock Location (JOB#xxxxxxx) when the first Source on Demand PO is created.
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A Reservations Warehouse (if it does not exist) will also be automatically

created (RS#sitenamennn). 

Assemblies Reservation Style:  Select the appropriate style for the creation of Reservation Stock

Locations for Assembly orders. Options are - 

- No Reservations - this is the default. No reservation stock logic is used.

- Manual Reservations Only - this allows the user to manually set up the

locations. 

The location coding structure must be as follows:  ASSY#xxxxxxx (where

xxxxxxx is the ordernumber). 

This rule also automatically creates a Reservations Warehouse (if it does

not exist) in the following format: RS#sitenamennn where nnn is a sequence number

starting with 001.

- Source on Demand Reservations - This will trigger the auto creation of

a Stock Location (ASSY#xxxxxxx) when the first Source on Demand PO is created.

A Reservations Warehouse (if it does not exist) will also be automatically

created (RS#sitenamennn). 

General Reservation Style:  Select the appropriate style for the creation of General Reservation

Stock Locations for customers or for quarantine purposes. Options are - 

- No Reservations - this is the default. No reservation stock logic is used.

- Manual Reservations Only - this allows the user to manually set up and

link a Customer location so that any item (Source on Demand or Supply from Stock) can be

receipted / transferred into it.. 

For Customer Reservation Locations, only issue / pick transactions

relating to a specific Customer can be processed to its own pre-defined Reservation Location.

(Only Source on Demand or Supply from Stock items). 

For Quarantine Locations, items (Source on Demand or Supply from

Stock) can be receipted or transferred into it. However. items can only be transferred or

adjusted out of that location.

This rule also automatically creates a Reservations Warehouse (if it does

not exist) in the following format: RS#sitenamennn where nnn is a sequence number

starting with 001.
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Automatically Create Item Batch on Receipt : Tick this box if you wish to automatically create a
Batch when the items are receipted. 

This will allow additional information to be
trapped later against this batch either manually through the Item Batch screen or by Freeway 

Container Tracking: This rule globally controls Container tracking in the Database and defines

which item attribute (Colour or Grade) is to be used for Container Tracking.

Select from one of the following options:

No Tracking (Default)

Use Grade for Tracking

Use Colour for Tracking

There must not be any current inventory records using the chosen

attribute (Grade or Colour).

Once chosen, the item attribute label will be changed "Container" on all

the relevant screens.

Buttons

Close: This will close the Item Rules screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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11 Pricing

11.1 Item Pricing

This screen allows you to create and maintain Sell and Buy Prices for Items

List Tab

Display fields

The displayed fields are taken from the Item information entered into the ‘Detail’ tab.  The selection
of which fields to display is at the user’s discretion.  To select the fields to display simply ‘right
mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Obsolete Status - If this is checked then the displayed list will include those Items whose
status is ‘Obsolete’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Pricing screen.  

Related: This will bring up a list of functions that are related to the Item.  You may open and
maintain information in those screens whilst still remaining in the Item screen.

Reports: This will bring up a list of Reports that are related to the Item.  You can immediately run
the report whilst still remaining in the Item screen.

Detail Tab

Entry and Display fields

Item Code:  Display only field that shows the current selected Item
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Unit: Display only field that shown the base Unit of Measure for the Item

Description: Display only field that shown the description as held against the Item

Pricing Group: Display only field that shown the Pricing Group as held against the Item

Status: Display only field that shown the current status of the Item. The options are:
Active - Is currently used throughout Ostendo
Planned - Can be Purchased only
Runout - Cannot be ordered but can be used until stock is zero
Obsolete - Cannot be ordered, Issued, or received

Sell Price Update Settings

Round to the nearest:  You can specify that, after any price calculations and discounts have been
applied, the resultant sell-price is rounded up to the nearest factor.  
The allowable rounding factors are 0.000001, 0.00001, 0.0001, 0.001, 0.01, 0.05,  0.10,  0.25, 
0.50,  1.00,  5.00, 10.00,  25.00,  50.00,  100.00

Inventory Information

Last Cost: Display only field that shows the Actual Cost of the Item when it was last received into
stock.

Average Cost: Display only field that shows the current Average Cost of the Item across all
Warehouses and Locations.

Standard Cost: Display only field that shows the Standard Cost of the Item as held against the
Item record.

Activity Dates

Last Receipt: Display only field showing the date when this Item was last received.

Last Sale: Display only field showing the date when this Item was last sold.

Last Price Update: Display only field showing the date when this Item’s Price was last updated.

Standard Prices

Standard Sell Price: Display only field showing the current Standard Sell Price as held against the
Item record

Standard Buy Price: Display only field showing the current Standard Buy Price as held against the
Item record

Standard Margin%: Display only field showing the current Margin.  This calculated from

(Standard Sell Price - Standard Buy Price)
-------------------------------------------------------------       x    100
                Standard Sell Price
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Sell Price Tab

Price Level: From the drop-down list select the Pricing Level.   Pricing Levels are user-defined in
Pricing>Settings>Price Levels and represent the level of pricing offered to (say) Retail, Trade,
Wholesale, etc

Price Calculation Cost Method: Against each Item the user can - for each Price Level - define
both a sell price that is evaluated using the following criteria:

Std Sell Price
Std Sell Price + $ Value
Std Sell Price - $ Value
Std Sell Price + % Value
Std Sell Price - % Value
Std Buy Price + $ Value
Std Buy Price - $ Value
Std Buy Price + % Value
Std Buy Price - % Value
Fixed Price $ Value
Last Cost + $ Value
Last Cost - $ Value
Last Cost + % Value
Last Cost - % Value
Std Cost + $ Value
Std Cost - $ Value
Std Cost + % Value
Std Cost - % Value

% Value or $ Value: Dependant upon what Price Calculation Cost Method was selected the
column title will change between ‘% Value’ and ‘$ Value’.   The entry into this field represents that
Value.    

Unit Price: Display only field showing the calculated Sell price.  Taking the previous two fields into
account this field would contain a Unit Price as follows.  For example:

If the Standard Sell Price is $80
Price Calculation Method is ‘Std Sell Price - % Value’
Entry in ‘% Value or $ Value’ field is 10

Then the Unit sell price would be evaluated at $72 ($80 - (80 * 10 / 100))

Quantity Breaks: You can enter up to 5 Quantity Breaks.  These breaks are in the form of
If Order quantity greater than aa then Percentage Discount = ss%
If Order quantity greater than bb then Percentage Discount = tt%
If Order quantity greater than cc then Percentage Discount = uu%
If Order quantity greater than dd then Percentage Discount = vv%
If Order quantity greater than ee then Percentage Discount = ww%

The screen will allow entry of order quantities and Discount % and, from these, will calculate and
display the Sell Price.

Currency: Display only field showing the currency code for the Price Level

Buy Price Tab

Restrict to listed Suppliers: If this is ‘checked’ then the purchase of this Item in the Purchasing
Module can only be made from these Suppliers
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(Primary Supplier): Only active if the previous field is ‘Checked’.  Entry is optional and facilitates
automatic ordering from the Replenishment run if required.

Supplier: From the drop-down list select a Supplier.

Currency Code: Display only field showing the Currency held against this Supplier.

Unit: This is prefilled with the base Unit of measure for the Item.  By using the drop-down list it can
be amended to any other Unit applicable to this Item

Conversion:  This represents the conversion factor between the Supplier’s Unit of Measure and
the Item’s base Unit of Measure as defined in the Item Master record.  This is used as follows.  If
the Supplier’s Unit of Measure is ‘Drum’ and the base Unit of Measure in Ostendo is ‘Litres’ and 1
drum contains 50 Litres then enter 50 into this field.  This allows you to order and receive in the
Supplier’s UOM but place into Inventory in your own UOM.  This field is prefilled with a conversion
factor of 1 but can be amended as required.

Supplier Item Code: This is an optional entry and allows you to identify the Supplier’s Item
Number if it is different than your own internal number.  Both numbers are available for printing on
the Purchase Documents.

Supplier Item Code: This is the Supplier's description of the item.

Unit Price: Upon creating this line it is prefilled with the Standard Buy Price.  You can amend this if
the Supplier’s Price is different.

Quantity Breaks:  Up to 5 Quantity Breaks can be defined.   These breaks are in the form of
If Order quantity greater than aa then Percentage Discount = ss%
If Order quantity greater than bb then Percentage Discount = tt%
If Order quantity greater than cc then Percentage Discount = uu%
If Order quantity greater than dd then Percentage Discount = vv%
If Order quantity greater than ee then Percentage Discount = ww%

Buttons

Close: This will close the Item Pricing screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: The cursor will go to a new line for entry of a Sell or Buy Price record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was accessed or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current Sell or Buy Price record

Related: This will bring up a list of functions that are related to Item Pricing.  You may open and
maintain information in those screens whilst still remaining in the Item Pricing screen.

Reports: This will bring up a list of Reports that are related to the Item Pricing.  You can
immediately run the report whilst still remaining in the Item Pricing screen.
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11.2 Descriptor Pricing

This screen allows you to create and maintain Sell and Buy Prices for Descriptors

List Tab

Display fields

The displayed fields are taken from the Item information entered into the ‘Detail’ tab.  The selection
of which fields to display is at the user’s discretion.  To select the fields to display simply ‘right
mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Descriptors
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Descriptors Pricing screen.  

Related: This will bring up a list of functions that are related to the Descriptors.  You may open and
maintain information in those screens whilst still remaining in the Descriptors screen.

Reports: This will bring up a list of Reports that are related to the Descriptors.  You can
immediately run the report whilst still remaining in the Descriptors screen.

Detail Tab

Entry and Display fields

Descriptor Code: Display only field that shows the current selected Descriptor

Unit: Display only field that shown the Unit of Measure for the Descriptor
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Description: Display only field that shown the description as held against the Descriptor

Pricing Group: Display only field that shown the Pricing Group as held against the Descriptor

Status: Display only field that shown the current status of the Item. The options are:
Active - Is currently used throughout Ostendo
Inactive - Cannot be used but history retained

Sell Price Update Settings

Round-up to the nearest:  You can specify that, after any price calculations and discounts have
been applied, the resultant sell-price is rounded up to the nearest factor.  The allowable rounding
factors are 0.01, 0.05, 0.10, 0.25, 0.50, 1.00, 5.00,10.00, 25.00, 50.00,100.00

Descriptor Information

Last Cost: Display only field that shows the Actual Cost of the Descriptor when it was last received
into stock.

Standard Cost: Display only field that shows the Standard Cost of the Descriptor as held against
the Descriptor record.

Activity Dates

Last Receipt: Display only field showing the date when this Descriptor was last received.

Last Sale: Display only field showing the date when this Descriptor was last sold.

Last Price Update: Display only field showing the date when this Descriptor’s Price was last
updated.

Standard Prices

Standard Sell Price: Display only field showing the current Standard Sell Price as held against the
Descriptor record

Standard Buy Price: Display only field showing the current Standard Buy Price as held against the
Descriptor record

Standard Margin%: Display only field showing the current Margin.  This calculated from

(Standard Sell Price - Standard Buy Price)
------------------------------------------------------       x    100
                Standard Sell Price

Sell Price Tab

Price Level: From the drop-down list select the Pricing Level.  Pricing Levels are user-defined in
Pricing>Settings>Price Levels and represent the level of pricing offered to (say) Retail, Trade,
Wholesale, etc
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Price Calculation Cost Method: Against each Item the user can - for each Price Level - define
both a sell price that is evaluated using the following criteria:

Std Sell Price
Std Sell Price + $ Value
Std Sell Price - $ Value
Std Sell Price + % Value
Std Sell Price - % Value
Std Buy Price + $ Value
Std Buy Price - $ Value
Std Buy Price + % Value
Std Buy Price - % Value
Fixed Price $ Value
Last Cost + $ Value
Last Cost - $ Value
Last Cost + % Value
Last Cost - % Value
Std Cost + $ Value
Std Cost - $ Value
Std Cost + % Value
Std Cost - % Value

% Value or $ Value: Dependant upon what Price Calculation Cost Method was selected the
column title will change between ‘% Value’ and ‘$ Value’.   The entry into this field represents that
Value.    

Unit Price: Display only field showing the calculated Sell price.  Taking the previous two fields into
account this field would contain a Unit Price as follows.  For example:

If the Standard Sell Price is $80
Price Calculation Method is ‘Std Sell Price - % Value’
Entry in ‘% Value or $ Value’ field is 10

Then the Unit sell price would be evaluated at $72 ($80 - (80 * 10 / 100))

Quantity Breaks: You can enter up to 5 Quantity Breaks.  These breaks are in the form of
If Order quantity greater than aa then Percentage Discount = ss%
If Order quantity greater than bb then Percentage Discount = tt%
If Order quantity greater than cc then Percentage Discount = uu%
If Order quantity greater than dd then Percentage Discount = vv%
If Order quantity greater than ee then Percentage Discount = ww%

The screen will allow entry of order quantities and Discount % and, from these, will calculate and
display the Sell Price.

Currency: Display only field showing the currency code for the Price Level

Buy Price Tab

Restrict to listed Suppliers: If this is ‘checked’ then the purchase of this Descriptor in the
Purchasing Module can only be made from these Suppliers

(Primary Supplier): Only active if the previous field is ‘Checked’.  Entry is optional and facilitates
automatic ordering from the Replenishment run if required.

Supplier: From the drop-down list select a Supplier.

Currency Code: Display only field showing the Currency held against this Supplier.
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Unit: This is prefilled with the base Unit of measure for the Descriptor.   

Supplier Item Code: This is an optional entry and allows you to identify the Supplier’s Reference
Number if it is different than your own internal number.  Both numbers are available for printing on
the Purchase Documents.

Supplier Description: This is the Supplier's description of the Descriptor.

Conversion:  This represents the conversion factor between the Supplier’s Unit of Measure and
the Descriptor’s base Unit of Measure as defined in the Descriptor Master record.  This is used as
follows.  If the Supplier’s Unit of Measure is ‘Drum’ and the base Unit of Measure in Ostendo is ‘
Litres’ and 1 drum contains 50 Litres then enter 50 into this field.  This allows you to order and
receive in the Supplier’s UOM but receive in your own UOM.  This field is prefilled with a
conversion factor of 1 but can be amended as required.

Unit Price: Upon creating this line it is prefilled with the Standard Buy Price.  You can amend this if
the Supplier’s Price is different.

Quantity Breaks:  Up to 5 Quantity Breaks can be defined.  These breaks are in the form of
If Order quantity greater than aa then Percentage Discount = ss%
If Order quantity greater than bb then Percentage Discount = tt%
If Order quantity greater than cc then Percentage Discount = uu%
If Order quantity greater than dd then Percentage Discount = vv%
If Order quantity greater than ee then Percentage Discount = ww%

Buttons

Close: This will close the Descriptor Pricing screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: The cursor will go to a new line for entry of a Sell or Buy Price record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was accessed or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current Sell or Buy Price record

Related: This will bring up a list of functions that are related to Descriptor Pricing.  You may open
and maintain information in those screens whilst still remaining in the Descriptor Pricing screen.

Reports: This will bring up a list of Reports that are related to the Descriptor Pricing.  You can
immediately run the report whilst still remaining in the Descriptor Pricing screen.

11.3 Special Pricing

This function allows you to define special prices for Items and/or Descriptors for a specific period
of time.  This feature can be used for sell-offs, Sales, Promotions, etc.   These Prices take
precedence over any other price for the time-span of the special price.

List Tab

Display fields
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The displayed fields are taken from the Special Price information entered into the ‘Detail’ tab.   The
selection of which fields to display is at the user’s discretion.   To select the fields to display simply
‘right mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel you
can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Special Price
Lists whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Special Price List screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Price List.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Price List from this table

Related: This will bring up a list of functions that are related to Special Price Lists.  You may open
and maintain information in those screens whilst still remaining in the Special Price List screen.

Reports:     This will bring up a list of Reports that are related to the Special Price Lists.  You can
immediately run the report whilst still remaining in the Special Price List screen.

Details Tab

Entry and Display fields

Contract Number: This is a system maintained reference that segregates differing Special Price
Lists.  It cannot be amended.
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Status: The current status of the Special Pricing Contract.  Upon creating a new Contract Number
it is given a status of ‘Active’.   At any time this can be amended to ‘Inactive’ by selecting this from
the dropdown list.  Care should be taken when having the same Item/Descriptor in multiple ‘Active’
 Contracts with overlapping Dates.   In this instance the Price evaluation routine will select the first
occurrence.

Reference: Enter a short description that describes the reason for this Contract Number.   No
checks are made on this entry.

Date Effectivity

Start Date: This is the effective Start Date for using the Items and Descriptors in this Pricing
Contract.  It is prefilled with the system date.   To amend the date either manually overtype the
date or click on the drop-down calendar and select the date.

Finish Date: This is the effective Finish Date for using the Items and Descriptors in this Pricing
Contract.  It is prefilled with the system data plus 12 months.   To amend the date either manually
overtype the date or click on the drop-down calendar and select the date.

Customer Range

Pricing is for: From the drop-down list select the target market for this Price List.  The options are:
· Specific Customer
· Customer with Price Level
· All Customers

For the first two options the next field will change to reflect the selection

(Customer or Price Level): This field will change in line with the selection made in the previous
field.  I.e.

· If Specific Customer is selected then select the Customer from the drop-down list
· If Customer with Price Level is selected then select the Price Level from the drop-down

list
· If All Customers are selected then this field is disabled

Notes: Extended Notes for your own information can be attached to this Special Price List. 
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Products Tab

Entry and Display fields

Pricing is for:  Display only showing the entry made in the 'Detail' tab

(Description):  Display only showing the entry made in the 'Detail' tab

Start Date:  Display only showing the entry made in the 'Detail' tab

Finish Date:  Display only showing the entry made in the 'Detail' tab
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Special Pricing No: This is display only and identifies the unique Line Number within the Special
Pricing Contract

Item Or Descriptor: From the dropdown list select whether the special Price is for an Item or
Descriptor.  

Pricing is For: From the drop-down list select the Item or Descriptor option for this Price List.  The
options are:

· Specific Item or Descriptor
· Items or Descriptors with Pricing Group
· All Items or Descriptors

Lookup Selection: The drop-down in this field will change in line with the selection made in the
previous field.  I.e.

· If Specific Item is selected then select the Item from the drop-down list
· If Specific Descriptor is selected then select the Descriptor from the drop-down list
· If Price Group is selected then select the Price Group from the drop-down list
· If All Items is selected then this field is disabled
· If All Descriptors is selected then this field is disabled

Unit: If the selection in the 'Pricing if For' field is 'Specific Item' then this field will be displayed
where you should select the Unit Of Measure for the specific Item.

Price Qty: Enter the quantity at which the Special Price will be effective.

The following two fields allow you to specify the special price.  For a range of Items or Descriptors
it is usually expressed as a percentage discount although a fixed price can be used.   For a
definitive Item or Descriptor it can be either a percentage discount of a fixed price.   

Discount or Fixed Price: From the drop-down list select the pricing factor. The options are:
· Discount
· Fixed Price

The next field changes to reflect this selection

Value: If the selection in the previous field is:
· Discount then enter a % discount here (Example 20% will reduce the Item’s or

Descriptor’s base sell price by 20%)
· Price for Fixed Price then enter the special Price here.  This will take precedence over all

other prices for the period of this special price list
· Price for Price Incl Tax then enter the special Tax Inclusive Price here.  This will take

precedence over all other prices for the period of this special price list

Currency: From the drop-down list select the Currency Code relating to this Special Price

Description:  Display only showing the Description of the Item, Descriptor or Pricing Group
selected above

Line Notes:  Enter notes related to this line here.

Forecast Tab

Entry and Display fields

For each Product entered you can create an anticipated Sales Forecast.  This forecast may
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optionally be included in the Replenishment routine

Pricing is for:  Display only showing the entry made in the 'Detail' tab

(Description):  Display only showing the entry made in the 'Detail' tab

Start Date:  Display only showing the entry made in the 'Detail' tab

Finish Date:  Display only showing the entry made in the 'Detail' tab

Item Code:  Display only showing the Item selected in the 'Products' tab

Description:  Display only showing the Description of the Item selected in the 'Products' tab

Date:  From the dropdown Calendar enter the date of the demand Forecast

Qty:  Enter the quantity required on the above date

Site:  From the dropdown selected the specific Site at which this demand is to be forecast.  If this
is left blank then the User's Site will be assumed.

Buttons

Close: This will close the Special Pricing screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will present a blank ‘Detail’ screen ready for entry of a new Special Price List.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Special Price List record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the details panel

Related: This will bring up a list of functions that are related to Special Price Lists.  You may open
and maintain information in those screens whilst still remaining in the Special Price List screen.

Reports: This will bring up a list of Reports that are related to the Special Price Lists.  You can
immediately run the report whilst still remaining in the Special Price List screen.

11.4 Discount Matrix

This screen allows you to define a Discount to be applied to an Order Line’s Sell Price.   Ostendo
will first determine the Sell Price for the line (using Price Levels and Quantity Discounts) and then
apply this discount.  The Discount has an effective Start and Stop Date and can apply at the
following levels

· Customer
· Price Level
· All

And refers to the following levels
· Item, Descriptor, or Labour Code
· Category of the Item, Descriptor, Labour Code, Supplier Catalogue Line
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In determining the discount the order of priority is as follows

Customer Item, Descriptor, Labour Code
Customer Category of the Item, Descriptor, Labour, or Supplier Catalogue Line
Price Level Item, Descriptor, Labour Code
Price Level Category of the Item, Descriptor, Labour, or Supplier Catalogue Line
All No selection required as all lines have this discount

Entry and Display fields

Discount Level: From the drop-down list select the Discount Level.  The options are:

· Customer
· Price Level

Discount Level Name: From the drop-down list select the specific Customer or Price Level.

Product Level: From the drop-down list select the Product Level.  This field will not be accessible
if ‘All’ was selected in field ‘Discount Level’.  The options are:

· Item
· Descriptor
· Labour Code
· Pricing Group
· Category
· All

Product Level Code: From the drop-down list select the specific Item, Descriptor, Labour Code,
or Category.  This field will not be accessible if ‘All’ was selected in field ‘Product Level’.  

Product Level Description: Display only field showing the description of the product selected in
field 'Product Level Code'

Sub Category: You have the option to select a Sub Category from the dropdown list that will apply
to this matrix rule

Product Level Unit: From the drop-down list select the specific Unit of Measure.  All Products with
this Unit (within other selection criteria) will be addressed.  

Qty: Enter the Quantity when the Discount will become effective.  This discount will apply where
the Order quantity is equal to, or greater than, this entered quantity.   If nothing is entered then all
quantities are assumed

Disc1: Enter the percentage discount that will apply to the above combination.

Disc2 %: Enter the percentage discount that will applied to the nett value after applying Disc1%.
See below for example of cumulative discounting

Disc3 %: Enter the percentage discount that will applied to the nett value after applying Disc2%.
See below for example of cumulative discounting.

Example of Cumulative Discounting assuming an Item's Std Sell Price is $100 
If you are using Price Level 1 you get 10% discount - this is entered in Disc1 %
If you sell Items in Category 'Electrical' you get a further 10% - this is entered in Disc2 %



578 Ostendo Reference Guide

If you sell by Container Unit of measure you get a further 10% - this is entered in Disc3 %

Therefore if the three conditions are satisfied then the total discount will be

((($100 * .9) * .9) * .9) = $27.10 and this result is displayed in field 'Total Discount
Percentage'

Total Discount Percentage: Display only field showing the evaluated discount from the values
entered into Disc1 %, Disc2 %, Disc3 % fields

Start Date: Enter the date when the Discount will become effective.  If nothing is entered then any
date equal to or earlier than the finish date will be assumed

Finish Date: Enter the date when the Discount will become effective.  If nothing is entered then
any date equal to, or later than, the start date will be assumed

Matrix Description: Enter a brief description of this Matrix.  No checks are carried out

Buttons

Close: This will close the Discount Matrix screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Discount Matrix record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current Discount Matrix line from this table

Related: This will bring up a list of functions that are related to Discount Matrix.  You may open
and maintain information in those screens whilst still remaining in the Discount Matrix screen.

11.5 Order Pricing Matrix

This screen is processed after Order Line Prices have been established to provide additional
functionality that is applied to the Order as a whole.    It facilitates:

1.  Overall Order Discounts

2.  Additional Order Lines - Examples are: 
· Buy 'A' get 'B' free
· Order Value < $xxx then Freight = $20

Entry and Display fields

Matrix Level: From the drop-down list select the level at which the matrix will be applied. The
options are:

· All
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· Customer
· Customer Type
· Customer Region
· Price Level
· Rate Level

Matrix Level Name: From the drop-down list select the specific Level.  The content of the
drop-down is derived from the 'Matrix Level' selection.  This drop-down is not active if the 'Matrix
Level' selection is 'All'

Product Level: From the drop-down list select the Level to which this Pricing Matrix applies.   The
options are:

· All
· Category
· Product Group
· Analysis Group
· Item
· Descriptor
· Labour

Product Level Code: From the drop-down list select the specific Level.  The content of the
drop-down is derived from the 'Product Level' selection.  This drop-down is not active if the
'Product Level' selection is 'All'

Product Level Unit: From the drop-down list select a specific Unit of Measure. All Product Level
selections with this Unit will be addressed. 

Based On: From the drop-down list select the criteria that will apply to this Matrix.  The options
are:

· Quantity
· Nett Value
· Gross Value
· Weight
· Volume

Value From: This, combined with 'Value To' enables you to restrict this Matrix to a specific range
of values.  Enter the start value of the 'Based On' selection for the range.  If nothing is selected
then all values up to 'Values To' are assumed.  If both 'Values From' and 'Values To' do not have
an entry then all values are assumed.

Value To: This, combined with 'Value From' enables you to restrict this Matrix to a specific range
of values.  Enter the end value of the 'Based On' selection for the range.  If nothing is selected
then all values from 'Values From' are assumed.  If both 'Values From' and 'Values To' do not have
an entry then all values are assumed.

Style: This identifies the action to take place when the Matrix Conditions have been satisfied.  The
options are:

· Fixed Discount: The discount entered into the next field (Fixed Discount) will be applied
to the Order.

· Insert Lines: The Lines entered in the lower part of this screen will be added to the Order.

Fixed Discount: Enter the Discount or Surcharge (-) percentage that will be applied if the 'Style' is
'Fixed Discount'.  Note: If the Discount% entered here is less that the Discount held against the
Customer's master record then the master record's discount will override this value.
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Start Date: Enter the date when the Matrix will become effective. If nothing is entered then any
date equal to or earlier than the finish date will be assumed

Finish Date: Enter the date when the Matrix will become effective. If nothing is entered then any
date equal to, or later than, the start date will be assumed

Matrix Description: Enter a brief description of this Matrix.  No checks are carried out

Sub Category: You have the option to select a Sub Category from the dropdown list that will apply
to this matrix rule

Buttons

Close: This will close the Order Pricing Matrix screen. If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: If the cursor is in the upper part of the screen then clicking the 'Add' button will send the
cursor to a new line in the upper panel for entry of a new Order Pricing Matrix record.

If the cursor is in the lower part of the screen then clicking the 'Add' button will send the cursor to a
new line in the lower panel for entry of a new line.   This line will be added to the Order if the Matrix
Style is 'Insert Lines'.  Fields in this lower panel are:

Line Type: From the drop-down list select the Line Type. The options are:
· Item Code
· Descriptor Code

Line Code: From the drop-down list select the Code. The drop-down list will vary
dependent upon the Line Type selection. 

Unit: This is prefilled with the Unit for the Code. If this is an Inventoried Item with multiple
Units then you can amend the Unit of Measure by clicking on the drop-down icon and
selecting the Unit.

Description: This is prefilled with the description as held against the Item or Descriptor. It
can be amended here if required.

Qty Method: From the drop-down list select the Method by which the Quantity of the Line
will be calculated when added to the Order. The options are:

· Fixed Qty - The quantity entered will be used when this line is added to the
Order

· Fixed Discount - The quantity entered will apply as a % Discount to the whole
Order

· Fixed Qty * Order Qty - This quantity will be multiplied by the Order quantity
and the result is used as the Order Quantity for this added line

· Fixed Qty * Weight - This quantity will be multiplied by the Weight of the Order
and the result is used as the Order Quantity for this added line

· Fixed Qty * Volume - This quantity will be multiplied by the Volume of the
Order and the result is used as the Order Quantity for this added line

· One per Qty - This quantity will generate an extra one and the result is used
as the Order Quantity for this added line

Qty: Enter the quantity of the Qty Method that will be added to the Order
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Unit Price: This is prefilled with the base Price of the Code.  You may amend this to make
it specific to this Order Matrix if required

Price Is: From the drop-down list select the Price/Tax relationship.  The options are:
· Tax Exclusive
· Tax Inclusive

Line Notes: This is prefilled with any ‘Notes’ that are held against the Code. It may be
amended here and made specific to this Line. Whenever you click on this field an icon will
appear in the top-right. By clicking on this Icon you can bring up the Frequently Used Text
table. Select the text to be copied and either press the OK Button in that screen or
double-click the selected record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current line from this screen

Related: This will bring up a list of functions that are related to Order Pricing Matrix. You may open
and maintain information in those screens whilst still remaining in the Order Pricing Matrix screen.

Reports: This will bring up a list of Reports that are related to the Order Pricing Matrix.  You can
immediately run the report whilst still remaining in the Order Pricing Matrix screen.

11.6 Item Costing

This screen allows you to create and maintain Last, Average and Standard Costs for Items in
addition to viewing the current Item availability and Cost History. 

List Tab

Display fields

The displayed fields are taken from the Item information contained in the Item Master file.   The
selection of which fields to display is at the user’s discretion.   To select the fields to display simply
‘right mouse’ in the main panel and select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
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either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Obsolete Status - If this is checked then the displayed list will include those Items whose
status is ‘Obsolete’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Item Costing screen.  

Related: This will bring up a list of functions that are related to Item Costing.   You may open and
maintain information in those screens whilst still remaining in the Item Costing screen.

Reports: This will bring up a list of Reports that are related to Item Costing.  You can immediately
run the report whilst still remaining in the Item Costing screen.

Detail Tab

Entry and Display fields

Item Code: Display only field that shows the current selected Item

Unit: Display only field that shown the base Unit of Measure for the Item

Description: Display only field that shown the description as held against the Item

Pricing Group: Display only field that shown the Pricing Group as held against the Item

Status: Display only field that shown the current status of the Item. The options are:
Active - Is currently used throughout Ostendo
Planned - Can be Purchased only
Runout - Cannot be ordered but can be used until stock is zero
Obsolete - Cannot be ordered, Issued, or received

Inventory Costing Information

Last Cost: This is maintained through receipts into Inventory.  For Purchased Items however the
Last Cost may not be known at the time of receipt therefore it is also updated by the Purchase
Invoice price if that is different to the Goods Receipt Price .  There are instances, however, when
the cost of the last receipt is not known, therefore you can enter that cost here if required.

Average Cost: This is maintained through receipts into Inventory.  There are instances, however,
when the current Average cost is incorrect, therefore you can enter the correct Average cost here
if required.

Standard Cost: This is maintained here although the Standard Cost can be updated via the Cost
update routine.

Inventory Information
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On-Hand Qty: This is a display only field showing the current stock level across all Warehouses
and Locations.  For detailed on-hand information click on the adjacent button (Inventory
Availability)

Inventory Availability: Clicking on this button will bring up a separate panel that shows details of
the Inventory Availability for this Item.   This includes

· Stock by Location segregated by Tracking Characteristic if applicable
· Projected Availability taking into account current stock plus supply and demand
· List of Supply and Demand orders

For more details on this Inventory Availability screen see ‘Inventory Availability’ section

Sourced By: This is a display only field showing the normal method by which this Item is sourced.
 The displayed options are:

Purchasing - fully purchased Item
Assembly - Assembled in-house
Supplier Assembled - Components sent to Supplier for Assembly
Custom - Custom made in-house

Standard Prices

Standard Sell Price: Display only field showing the current Standard Sell Price as held against the
Item record

Standard Buy Price: Display only field showing the current Standard Buy Price as held against the
Item record

Standard Margin%: Display only field showing the current Margin.  This is calculated from

(Standard Sell Price - Standard Buy Price)
------------------------------------------------------       x    100
                Standard Sell Price

Activity Dates

Last Receipt: Display only field showing the date when this Item was last received.

Last Sale: Display only field showing the date when this Item was last sold.

Last Price Update: Display only field showing the date when this Item’s Price was last updated.

Cost History

The following list shows a complete history of cost changes made to this Item

Cost Type: Display only field showing which Cost was updated

Date Changed: Display only field showing the date when this Item’s Cost record was updated.

Old Cost: Display only field showing the cost prior to the change

New Cost: Display only field showing the cost after the change
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Buttons

Close: This will close the Item Costing screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the Cost Fields or the last time the ‘Save’ Button was pressed will
be lost.

Related: This will bring up a list of functions that are related to Item Costing.  You may open and
maintain information in those screens whilst still remaining in the Item Costing screen.

Reports: This will bring up a list of Reports that are related to the Item Costing.  You can
immediately run the report whilst still remaining in the Item Costing screen.

11.7 Descriptor Costing

This screen allows you to create and maintain Last and Standard Costs for Descriptors in addition
to viewing their Cost History. 

List Tab

Display fields

The displayed fields are taken from the Descriptor information contained in the Descriptor Master
file.   The selection of which fields to display is at the user’s discretion.   To select the fields to
display simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed
panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Descriptors
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon
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Buttons

Close: This will close the Descriptor Costing screen.  

Related: This will bring up a list of functions that are related to Descriptor Costing.  You may open
and maintain information in those screens whilst still remaining in the Descriptor Costing screen.

Reports: This will bring up a list of Reports that are related to Descriptor Costing.  You can
immediately run the report whilst still remaining in the Descriptor Costing screen.

Detail Tab

Entry and Display fields

Descriptor Code: Display only field that shows the current selected Descriptor

Unit: Display only field that shown the Unit of Measure for the Descriptor

Description: Display only field that shown the description as held against the Descriptor

Pricing Group: Display only field that shown the Pricing Group as held against the Descriptor

Status: Display only field that shown the current status of the Item. The options are:
Active - Is currently used throughout Ostendo
Inactive - Cannot be used but history retained

Descriptor Costing Information

Last Cost: This is maintained through receipts through Purchases.  There are instances, however,
when the cost of the last receipt is not known, therefore you can enter that cost here if required.

Standard Cost: This is maintained here although the Standard Cost can be updated via the Cost
update routine.

Descriptor Information

Descriptor Classification: Descriptors can be used for many things.   Within Ostendo there are
three classifications that are addressed in different ways.   The options are:

· General Purpose - Used as if it was a non-stock Item.  The Pricing and Costs are as
above

· Kitset Code - This is where a Kit contains many Parts that can be picked but the Sell
Price can (optionally) be at the Kitset (Descriptor) level

· Task Bill - This is where a Task Bill contains many Items, Descriptors and Activities for
detailed cost evaluation and scheduling but has a single ‘Task Bill’ for invoicing purposes

Sourced By: This is a display only field showing the normal method by which this Descriptor is
sourced.    The displayed options are ‘Purchasing’ or ‘In-House’

Standard Prices

Standard Sell Price: Display only field showing the current Standard Sell Price as held against the



586 Ostendo Reference Guide

Descriptor record

Standard Buy Price: Display only field showing the current Standard Buy Price as held against the
Descriptor record

Standard Margin%: Display only field showing the current Margin.  This calculated from

(Standard Sell Price - Standard Buy Price)
------------------------------------------------------       x    100
                Standard Sell Price

Activity Dates

Last Receipt: Display only field showing the date when this Descriptor was last received.

Last Sale: Display only field showing the date when this Descriptor was last sold.

Last Price Update: Display only field showing the date when this Descriptor’s Price was last
updated.

Cost History

The following list shows a complete history of cost changes made to this Descriptor

Cost Type: Display only field showing which Cost was updated

Date Changed: Display only field showing the date when this Item’s Cost record was updated.

Old Cost: Display only field showing the cost prior to the change

New Cost: Display only field showing the cost after the change

Buttons

Close: This will close the Descriptor Costing screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the Cost Fields or the last time the ‘Save’ Button was pressed will
be lost.

Related: This will bring up a list of functions that are related to Descriptor Costing.  You may open
and maintain information in those screens whilst still remaining in the Descriptor Costing screen.

Reports: This will bring up a list of Reports that are related to the Descriptor Costing.  You can
immediately run the report whilst still remaining in the Descriptor Costing screen.

11.8 Price Inquiry

This screen allows you to make ad-hoc enquiries into Item and/or Descriptors for existing
Customers and Prospects to determine the current sell price taking into account the
comprehensive Pricing Matrix offered in Ostendo.   A full path of how the Sell price was evaluated
is displayed for your information
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Entry and Display fields

Customer/Prospect: Click on either the Customer or Prospect ‘Radio’ Button.  Depending upon
your selection the next two fields will be enabled or disabled.

Customer: If the Customer ‘Radio’ button is selected then field becomes active.   From the
drop-down list select the Customer to which this enquiry relates.

Price Level: If the Prospect ‘Radio’ button is selected then field becomes active.   From the
drop-down list select the Price Level that applies to this Prospect.   Pricing Levels are user-defined
in Pricing>Settings>Price Levels and represent the level of pricing offered to (say) Retail, Trade,
Wholesale, etc

Item/Descriptor: Click on either the Item or Descriptor ‘Radio’ Button.  Depending upon your
selection the following fields will reflect the selection made.

Quantity: This is prefilled with1 but you can amend the quantity as required.  This will be used in
any quantity break discounts that may apply to the Item or Descriptor.

Code: Three methods are available for you to enter the specific Item or Descriptor
· Key in the Item/Descriptor number and the program will recognise it
· Click on the drop-down list icon and select the Item or Descriptor
· Click on the barcode icon and scan a linked barcode reader 

Unit: For a Descriptor this will display the Unit of Measure held against the Descriptor record.  For
an Item this will prefill this field with the base Unit of Measure held against the Item record.  In this
instance you can click on the drop-down icon and select an alternate unit if this applies to the Item.
 This alternate unit could have a discount and this will be applied to the final calculation.

Description Display only field showing the description of the Item or Descriptor

Ex Tax  /  Incl Tax

Base Sell Price: Display only field showing the Standard Sell Price currently held against the Item
or Descriptor.

Unit Price: Display only field showing the evaluated unit Sell Price taking into account the
complete pricing matrix.   See ‘Price Route’ below

Extended Price: Display only field showing the evaluated extended Sell Price (Unit Price * Qty)

Price Route: Display only field showing how the Sell Price was evaluated.  It can be:

Special Price if a special price exists or
or

Calculated Price taking into account:
Price Level entered or Price Level held against the Customer
Price Calculation Method
Quantity Breaks
Price Rounding
Customer specific discount
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Inventory Availability: Display only field showing the availability of the item:

Onhand Qty
Supply
Free Qty
Available
Demand

This is broken down by Site Name, Warehouse, Location, and Variants (Serial No, Expiry
Date, Batch No, Revision No, Grade, Colour, Size)

Price Levels: Display only field showing the applicable price levels.

Price Level
Unit Price

Buttons

Close: This will close the Price Inquiry screen.  

Re-calculate: Whenever you enter or amend any of the information on the screen, click this button
to re-calculate the Sell Price.  

11.9 Batch Price Update

This screen enables you to update the Buy and/or Sell Price of all, or selected Items and
Descriptors.  The Batch Price Update process comprises the following Steps

· Create a Price Update Batch enter the selection and update criteria
· Generate the Lines from the selection criteria
· Review the lines for the new prices
· Select, amend, confirm Lines
· Go back to the Batch Header
· Update the prices against lines that have been flagged

List Tab

Display fields

The displayed fields are taken from the Pricing Batch information entered into the ‘Detail’ tab.   The
selection of which fields to display is at the user’s discretion.   To select the fields to display simply
‘right mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel you
can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column



589Pricing

heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.   Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Price Update screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Price Update Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Price Update Batch with status ‘In Progress’.
In this instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Price Update.  You may open and
maintain information in those screens whilst still remaining in the Price Update screen.

Reports: This will bring up a list of Reports that are related to Price Update.  You can immediately
run the report whilst still remaining in the Price Update screen.

Detail Tab

This tab enables you to create and maintain a Price Update Batch Header.   

Entry and Display fields

Pricing Batch No: This is a unique number automatically allocated by the program.  It cannot be
amended.

Status: This is the status of the Pricing Batch and is maintained by the program.  The displayed
variants are:

In Progress - The Pricing Batch is still being worked on
Updated - The Pricing Batch has been ‘Posted’ and the records updated against the
included Items

Reference: Enter a brief description of the Pricing Batch.  No validation checks will be carried out
on this field.
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Pricing Date: This is prefilled with the system date.  It can be amended at any time up to Posting
the Batch by entering the date or by clicking on the drop-down menu and selecting the date.

Selection Criteria

In this section you define what you want to update

Items or Descriptors: Click on the appropriate ‘Radio’ button to select whether this Update batch
covers Items or Descriptors.

Update Record Selection: The following selection criteria can be entered to restrict the Items or
Descriptors that will appear in the Pricing Update Batch.   

· Category: From the drop-down list select the ‘From’ and ‘To’ Category Range.  If nothing
is selected then all Categories will be assumed.

· Sub-Category: From the drop-down list select the ‘From’ and ‘To’ Sub-Category Range.
If nothing is selected then all Sub-Categories will be assumed.

· Pricing Group: From the drop-down list select the ‘From’ and ‘To’ Pricing Group Range.
If nothing is selected then all Groups will be assumed.

· Code: This will display a list of Items or Descriptors dependent upon the Radio Button
selected above.  From the drop-down list select the ‘From’ and ‘To’ Range.  If nothing is
selected then all will be assumed. 

Update Settings

In this section you define what Prices you want to update

Update Area: Any one of three price areas can be selected for update.  These are:
· Update Standard Sell Price
· Update Standard Buy Price
· Update Specific Price Level

Click on the appropriate ‘Radio’ button to select which you are updating.  This will define which of
the following fields become activated for entry of parameters

Update Standard Buy Price: These parameters are required if the ‘Update Standard Buy Price’
Radio button has been selected

% Change: Specify the required percentage change relative to the price defined in the
next field.  This can be positive or negative.
Based On: From the drop-down List select the basis against which the Price Update will
be applied.  The options are:

- Std Sell Price (For Items and Descriptors)
- Std Buy Price (For Items and Descriptors)
- Last Cost (For Items and Descriptors)
- Average Cost (For Items Only)
- Standard Cost (For Items Only)

Round to the Nearest: From the drop-down List select the rounding factor that will be
applied to the recalculated Price.  The allowable rounding factors are 0.000001, 0.00001,
0.0001, 0.001, 0.01, 0.05,  0.10,  0.25,  0.50,  1.00,  5.00, 10.00,  25.00,  50.00,  100.00

Update Standard Sell Price: These parameters are required if the ‘Update Standard Sell Price’
Radio button has been selected.

% Change: Specify the required percentage change relative to the price defined in the
next field.  This can be positive or negative.
Based On: From the drop-down List select the basis against which the Price Update will
be applied.  The options are:
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- Std Buy Price (For Items and Descriptors)
- Last Cost (For Items and Descriptors)
- Average Cost (For Items Only)
- Standard Cost (For Items Only)

Round to the Nearest: From the drop-down List select the rounding factor that will be
applied to the recalculated Price.  The allowable rounding factors are 0.000001, 0.00001,
0.0001, 0.001, 0.01, 0.05,  0.10,  0.25,  0.50,  1.00,  5.00, 10.00,  25.00,  50.00,  100.00

Update Specific Price Level: These parameters are required if the ‘Update Specific Price Level’
Radio button has been selected

Price Level: From the drop-down list select the Pricing Level.  Pricing Levels are
user-defined in Pricing>Settings>Price Levels and represent the level of pricing offered to
(say) Retail, Trade, Wholesale, etc 
Based On: From the drop-down list select the basis for the revised pricing.  The options
are:

Std Sell Price
Std Sell Price + $ Value
Std Sell Price - $ Value
Std Sell Price + % Value
Std Sell Price - % Value
Std Buy Price + $ Value
Std Buy Price - $ Value
Std Buy Price + % Value
Std Buy Price - % Value
Fixed Price $ Value
Last Cost + $ Value
Last Cost - $ Value
Last Cost + % Value
Last Cost - % Value
Std Cost + $ Value
Std Cost - $ Value
Std Cost + % Value
Std Cost - % Value

New Value:  Dependant upon what ‘Based On’ Method was selected the value entered
here represents the ‘% Value’ or ‘$ Value’ to be applied in the Pricing Update.  
Round to the Nearest: From the drop-down List select the rounding factor that will be
applied to the recalculated Price.  The allowable rounding factors are 0.000001, 0.00001,
0.0001, 0.001, 0.01, 0.05,  0.10,  0.25,  0.50,  1.00,  5.00, 10.00,  25.00,  50.00,  100.00
Insert Price Level if not current in selection: When this checkbox is ‘checked’ then any
Items or Descriptors in the Selection Range that do not have a Price level will be given the
price Level that is currently being addressed

Update Prices with Changes: Clicking this button will update the relevant price against those
records whose ‘Select’ field in the ‘Lines’ tab have been ‘checked’.  This will not only update the
price but will also update the price history against each record

Notes: Extended Notes for your own information can be attached to this Price Update Batch. 
Whenever you click on this field an icon will appear in the top-right.   By clicking on this Icon you
can bring up the Frequently Used Text table.   Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Pricing Update screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.
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Add: This will show a blank screen for entry of a new Price Update Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Pricing Update Batch Header record or the last time the
‘Save’ Button was pressed will be lost.

Delete: If the Pricing Update Batch status is ‘Planned’ then it can be deleted at any time.   ‘
Updated’ batched cannot be deleted.

Related: This will bring up a list of functions that are related to Pricing Update.  You may open and
maintain information in those screens whilst still remaining in the Pricing Update screen.

Reports: This will bring up a list of Reports that are related to Pricing Update.  You can
immediately run the report whilst still remaining in the Pricing Update screen.

Lines Tab

This tab enables you to add and maintain Pricing Update lines.  The Pricing Update Batch Number
and status will be displayed at the top of the panel.    

If the Batch Update relates to a Pricing Level then the following two fields are displayed for your
information:

Price Level:  Display only field showing the Price Level selected in the ‘Detail’ tab
Price Calculation Method:  Display only field showing the Method selected in the ‘Detail’
tab

On this screen you can move the field position by dragging the column heading left or right to the
position where you want it to appear.

Entry and Display fields

Select: ‘Check’ the checkbox where you want the Price Update to be made.  You have the option
to click on the ‘Select All Codes’ Button at the bottom of this panel to select all the records.  You
may also click on the ‘De-select All Codes’ Button at the bottom of this panel to ‘un-select’ all the
records

Code: Display only field showing the Item Number or Descriptor reference

Description: Display only field showing the description of the Item or Descriptor. The Last Cost
Date will also be appended to this description.

Unit: Display only field showing the Unit of Measure of the Item or Descriptor

Last Cost:  Display only field showing the last cost price of the Item or Descriptor

Old Buy Price: Display only field showing the previous Buy Price of the Item or Descriptor

New Buy Price: Field showing the current Buy Price of the Item or Descriptor - can be amended

Value Difference: Display only field showing the difference between the Old Price and the New
Price - can be amended prior to update.

% Change: the difference expressed as a percentage.
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Buttons

Close: This will close the Price Update screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Price Updates.  You may open and
maintain information in those screens whilst still remaining in the Price Update screen.

Reports: This will bring up a list of Reports that are related to Price Updates.  You can
immediately run the report whilst still remaining in the Price Update screen.

11.10 Price Update from File

This function allows you to maintain standard Buy Prices or Sell Prices in some other database or
spreadsheet and import these into Ostendo.  This feature requires that the other database is
capable of exporting to .csv or .xls format

The Price Update process uses a standard Ostendo routine to carry out this process and
comprises the following Steps

· Create a Price Update Batch and define the update criteria
· Point the import function to the .csv or .xls file
· Match the import file to the fields in the .csv or .xls file
· Run the import function to a temporary file
· View the results and re-run if necessary
· Update the prices

You should note that because this uses a common Ostendo Import function some of the fields are
not applicable to Price Update from File.  This will be explained when you reach the appropriate
step.

List Tab

Display fields

The displayed fields are taken from the Update Batch information entered into the ‘Detail’ tab. 
The selection of which fields to display is at the user’s discretion.   To select the fields to display
simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel
you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
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and sorting:
· To sort the data in a selected column simply click on the column heading.  Clicking

against will sort in descending order.
· Click on the black ‘down arrow’ to the right of your selected column heading and you can

either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Update screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Update Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Update Batch with status ‘In Progress’.  In this
instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Update.  You may open and
maintain information in those screens whilst still remaining in the Update screen.

Reports: This will bring up a list of Reports that are related to Update.  You can immediately run
the report whilst still remaining in the Update screen.

Detail Tab

This tab enables you to create and maintain a import Price Update Batch Header.   

Entry and Display fields

Update No: This is a unique number automatically allocated by the program.  It cannot be
amended.

Status: This is the status of the Update Batch and is maintained by the program.   The displayed
variants are:

Planned - The Update Batch is still being worked on
Updated - The Update Batch has been ‘Posted’ and the records updated against the
included Items

Reference: Enter a brief description of the Update Batch.  No validation checks will be carried out
on this field.

Pricing Date: This is the date the Batch was created.  It is prefilled with the system date and
cannot be amended.
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Pricing Update Options

In this section you define what you want to update

Items or Descriptors: Click on the appropriate ‘Radio’ button to select whether this Update batch
covers Items or Descriptors.

Matched to Item Code or Supplier Code: Click on the appropriate ‘Radio’ button to select
whether you are matching imported records against your own Item or Descriptor identity or are
using the Supplier’s reference.   In the case of the second option you also need to enter a Supplier
in the next field.

Supplier: This is only required if the prices being imported use the Supplier’s reference as the
main key.  In this instance select the Supplier from the drop-down list

Update Batch Pricing: Click on the appropriate ‘Radio’ button to select whether you are going to
update the Buy Price or the Std Sell Price against your Item or Descriptor.   This enables the
program to evaluate the % increase or decrease of the new price to the old price

Apply update on the above settings: Clicking on this button will perform an update of the Price
against all the records in the Update file.  This is performed after the Import Routine described
below.

Notes: Extended Notes for your own information can be attached to this Update Batch.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Import Routine

Import Data from file and generate price update lines: Clicking on this button will bring up a
sub-routine where you can match the .csv or .xls file to that required for the import process.  The
following steps are carried out.   You should note that this uses a standard data Importing function
that is used throughout Ostendo; therefore not all entry fields are required.

Step 1: Click on the appropriate ‘Radio’ button to select whether the data being imported is in a
.csv or a xls. File format then click the ‘Next’ button.  Note: The ‘Load Specification’ button is
described in Step 5

Step 2: Point to where the source file resides and inform the import routine as to the following
conditions in that file:

Start at Row - From which row in the import file is the importing to commence
Field Names - tell the program which row in the import file contains headings
Record Separator - unless you have specifically defined otherwise leave this as CRLF
Text Qualifier - unless you have specifically defined otherwise leave this as “

Click the ‘Next’ button.  

Step 3: You should now match two fields in your .csv or .xls file with the two fields required in
Ostendo.  These are:

Item Code - The Item Number, Descriptor Code, or Supplier’s Reference Number
New Price - The new price to be imported

Click the ‘Next’ button.  

Step 4: Define the format of the fields in the Import File.   This allows the import routine to convert
it from your remote data source format to the format defined in the Regional Settings of you
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computer if different.

Step 5: This screen confirms your settings.  Ensure that all the settings are correct.  

At this point you will see that the ‘Load Specification’ button has changed to ‘Save Specification’.  If
you click on this button then you can save the results of Steps 1 through 5 and use this in future
rather than go through each step in turn.

Click the ‘Execute’ button to perform the import.  You will then be sent to the Lines Panel in
Ostendo 

Lines Tab

This tab shows you the result of the Import.  I.e 
Code - The Code of the Item or Descriptor
Description - description of the Item or Descriptor
Unit - base unit of the Item or Descriptor
Old Price - the current price of the Item or Descriptor
New Price - the new (imported) price 
% Change - the percentage change

You should note that this is an interim file where you can assess the results before actually posting
the update.  No changes can be made here.  If you require changes then amend the source .csv or
.xls file and re-import

To complete the update, go back to the ‘Detail’ Tab an click on the following button:

Apply update on the above settings:  Clicking on this button will perform an update of the Price
against all the records in the Update file

Buttons

Close: This will close the Pricing Update screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will show a blank screen for entry of a new Price Update Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Pricing Update Batch Header record or the last time the
‘Save’ Button was pressed will be lost.

Delete: If the Pricing Update Batch status is ‘Planned’ then it can be deleted at any time.  ‘Updated
’ batched cannot be deleted.

Related: This will bring up a list of functions that are related to Pricing Update.  You may open and
maintain information in those screens whilst still remaining in the Pricing Update screen.

Reports: This will bring up a list of Reports that are related to Pricing Update.  You can
immediately run the report whilst still remaining in the Pricing Update screen.
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11.11 Batch Cost Update

This screen enables you to update the Cost of all, or selected Items and Descriptors.  The Batch
Price Update process comprises the following Steps

· Create a Cost Update Batch enter the selection and update criteria
· Generate the Lines from the selection criteria
· Review the lines for the new costs
· Select, amend, confirm Lines
· Go back to the Batch Header
· Update the Costs against lines that have been flagged

List Tab

Display fields

The displayed fields are taken from the Cost Batch information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Cost Update screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Cost Update Batch.

Save: Not applicable to the List panel
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Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Cost Update Batch with status ‘In Progress’.
In this instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Cost Update.  You may open and
maintain information in those screens whilst still remaining in the Cost Update screen.

Reports: This will bring up a list of Reports that are related to Cost Update.  You can immediately
run the report whilst still remaining in the Cost Update screen.

Detail Tab

This tab enables you to create and maintain a Cost Update Batch Header.   

Entry and Display fields

Costing Batch No: This is a unique number automatically allocated by the program.  It cannot be
amended.

Status: This is the status of the Costing Batch and is maintained by the program.  The displayed
variants are:

Planned - The Costing Batch is still being worked on
Updated - The Costing Batch has been ‘Posted’ and the records updated against the
included Items

Reference: Enter a brief description of the Costing Batch.  No validation checks will be carried out
on this field.

Costing Date: This is prefilled with the system date.  It can be amended at any time up to Posting
the Batch by entering the date or by clicking on the drop-down menu and selecting the date.

Selection Criteria

In this section you define what you want to update

Items or Descriptors: Click on the appropriate ‘Radio’ button to select whether this Update batch
covers Items or Descriptors.

Specific Site: If this is 'checked' then this update will apply to Costs for a Specific Site 

Site: This will become active if the previous field is 'Checked'.  Select the Specific Site from the
drop-down list against which this Batch Cost Update is to be carried out

Update Record Selection: The following selection criteria can be entered to restrict the Items or
Descriptors that will appear in the Costing Update Batch.   

· Category: From the drop-down list select the ‘From’ and ‘To’ Category Range.  If nothing
is selected then all Categories will be assumed.

· Code: This will display a list of Items or Descriptors dependent upon the Radio Button
selected above.   From the drop-down list select the ‘From’ and ‘To’ Range.  If nothing is
selected then all will be assumed. 

· Sourced By: From the drop-down list select the sourcing method.  The options are
o All
o Purchasing
o Assembly
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o Custom

Update Settings

In this section you define what Costs you want to update

Update Area: Any one of two Cost areas can be selected for update.  These are:
· Update Standard Cost (applicable to Items and Descriptors)
· Update Average Cost (applicable to Items only)

Click on the appropriate ‘Radio’ button to select which you are updating.  This will define which of
the following fields become activated for entry of parameters

Update Standard Cost: These parameters are required if the ‘Update Standard Cost’ Radio
button has been selected.

% Change: Specify the required percentage change relative to the Cost defined in the
next field.  This can be positive or negative.
Based On: From the drop-down List select the basis against which the Price Update will
be applied.  The options are:

- Std Buy Price (For Items and Descriptors)
- Last Cost (For Items and Descriptors)
- Average Cost (For Items Only)
- Standard Cost (For Items Only)

Update Average Cost: This will only be visible if the ‘Items’ Radio Button is selected.   When
visible these parameters are required if the ‘Update Average Cost’ Radio button has been selected

% Change: Specify the required percentage change relative to the price/cost defined in
the next field.  This can be positive or negative.
Based On: From the drop-down List select the basis against which the Cost Update will
be applied.  The options are:

- Std Sell Price
- Std Buy Price
- Last Cost
- Average Cost
- Standard Cost

Update Costing with Changes: Clicking this button will update the relevant cost against those
records whose ‘Select’ field in the ‘Lines’ tab have been ‘checked’.  

Notes: Extended Notes for your own information can be attached to this Cost Update Batch. 
Whenever you click on this field an icon will appear in the top-right.   By clicking on this Icon you
can bring up the Frequently Used Text table.   Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Cost Update screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will show a blank screen for entry of a new Cost Update Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Costing Update Batch Header record or the last time
the ‘Save’ Button was pressed will be lost.
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Delete: If the Costing Update Batch status is ‘Planned’ then it can be deleted at any time.  ‘
Updated’ batched cannot be deleted.

Related: This will bring up a list of functions that are related to Costing Update.  You may open
and maintain information in those screens whilst still remaining in the Cost Update screen.

Reports: This will bring up a list of Reports that are related to Costing Update.  You can
immediately run the report whilst still remaining in the Cost Update screen.

Lines Tab

This tab enables you to add and maintain Cost Update lines.   The Costing Update Batch Number
and status will be displayed at the top of the panel.  Also at the top of the panel is the following
information:

· The Cost being updated (Standard or Average)
· The % change being applied
· The revised Cost Basis

On this screen you can move the field position by dragging the column heading left or right to the
position where you want it to appear.

Entry and Display fields

Select: ‘Check’ the checkbox where you want the Cost Update to be made.  You have the option
to click on the ‘Select All Codes’ Button at the bottom of this panel to select all the records.  You
may also click on the ‘De-select All Codes’ Button at the bottom of this panel to ‘un-select’ all the
records

Code: Display only field showing the Item Number or Descriptor reference

Description: Display only field showing the description of the Item or Descriptor

Unit: Display only field showing the Unit of Measure of the Item or Descriptor

Buy Price: Display only field showing the current Buy Price of the Item or Descriptor

Last Cost: Display only field showing the Last Cost of the Item or Descriptor

Average Cost: Display only field showing the Average Cost of the Item

Old Std Cost: Display only field showing the current Standard Cost of the Item or Descriptor

New Std Cost: The system calculated Cost based on the criteria set in the Detail panel. This Cost
can be amended prior to update.

%Change: Display only field showing the percentage change of the New Cost relative to the Old
Cost.

Buttons

Close: This will close the Cost Update screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Cost Updates.  You may open and
maintain information in those screens whilst still remaining in the Cost Update screen.
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Reports: This will bring up a list of Reports that are related to Cost Updates.  You can immediately
run the report whilst still remaining in the Cost Update screen.

11.12 Settings

11.12.1 Price Levels

This screen allows you to maintain a list of Price Levels, which are linked to Customers to define
which price factors should be applied in determining the final Sell Price

Entry and Display fields

Price level: Enter the Name of the Price Level.  Duplicates not allowed.

Description: Enter a short description of the Price Level.  No checks are made on this entry

Currency Code: From the drop-down list select the Currency Code that applies to this Price Level.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Price Level screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Price Level.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Price Level.

11.12.2 Pricing Groups

This screen allows you to maintain a list of Pricing Groups, which are linked to Items and
Descriptors to facilitate batch updating if Prices and Costs

Entry and Display fields

Price Group: Enter the Name of the Pricing Group.  Duplicates not allowed.

Description: Enter a short description of the Pricing Group.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons
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Close: This will close the Pricing Group screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Pricing Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Pricing Groups.

11.12.3 Pricing Rules

This screen allows you to maintain Pricing Rules which define what rules, within the Pricing area,
you wish to apply.  The following rule settings are available

Entry and Display fields

Get Best Price: Normally Item, Descriptor and Labour Sell prices go through a pre-defined logic
of:

· Check Special Pricing to see if a Special Price exists and, if so, use it
· Check Price-level price to see if a Price exists and, if so, use it
· Use Standard Sell Price

If you 'check’ this checkbox then all the above are accessed and the Lowest evaluated Price used. 

Round to Nearest: When adding an Item or Descriptor to a Sales or Job Order the and the Price
is evaluated from a Price Level then Ostendo calculates that sell price from screen Pricing>Item
Pricing  (or Pricing>Descriptor Pricing) using the specified 'Price Calculation Method' with no 
Rounding.   If you require the calculated price to be rounded then 'check' this checkbox and
specify whether you want to round 'Up' or 'Down' in the next field.   The value against which this
rounding takes place is that currently held in the  Pricing>Item Pricing  (or Pricing>Descriptor
Pricing) screens

Round Style: Used in conjunction with the previous field to define which way the rounding should
take place.  The options are

Round Up:  This will round the evaluated Price up to the nearest rounding value entered into
the Item or Descriptor Pricing Screen.  For example If the evaluated Price was $23.456 and
the Rounding Factor was .01 then the resulting price would be $23.46
Round Down:  This will round the evaluated Price down to the nearest rounding value entered
into the Item or Descriptor Pricing Screen.  For example If the evaluated Price was $23.456
and the Rounding Factor was .01 then the resulting price would be $23.45
Round Standard:  This will round the evaluated Price to the nearest rounding value entered
into the Item or Descriptor Pricing Screen.  For example:

 - If the evaluated Price was $23.452 and the Rounding Factor was .01 then the resulting
price would be $23.45
 - If the evaluated Price was $23.456 and the Rounding Factor was .01 then the resulting
price would be $23.46

Special Pricing List Style: Select either "By Product" or "By Contract". The first option will list all
records for each Special Pricing contract. This could result in a very long list if the Special Pricing
contract relates to a large number of products. The second option, By Contract, simply condenses
the opening list by just showing one record per contract. Clicking on the Product tab will show all
the products related to that contract.  
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Descriptor Price Calculation Method: Select the default Price Calculation Method to appear in
the Sell Prices tab in Descriptor Pricing screen.

Item Price Calculation Method: Select the default Price Calculation Method to appear in the Sell
Prices tab in Item Pricing screen.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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12 Requirements

12.1 Inventory Replenishment

This function allows you to run an Inventory replenishment routine that looks at an Item’s current
stock level and addresses Supply and Demand into the future.  From this it makes
recommendations to ensure that actual and anticipated demands will be satisfied.  

Two options are available for Inventory Replenishment:

Single Level MRP: This focuses on nominated Items and addresses the Item’s current actual
and/or forecast future demands to create Suggested Orders required to maintain stock.

Multi-Level MRP:  In addition to looking at the current actual and/or forecast future demands for
each Item this option also looks to see if the Item is a Parent in a Bill of Material and, if so, will ‘
explode’ any Suggested Orders to determine the components required to make it.  These are then
used as ‘Suggested Demands’ when assessing component requirements

The results of these processes is presented for your attention where you can amend the
recommendations before converting into actual Assembly or Purchase Orders.

Opening Screen

Entry and Display fields

Create New or Open Previous:  Only one Replenishment Run can exist at any time in the
database.     Therefore the following scenarios can exist

· If the Replenishment has never been run before then you must generate ‘New’
· If the previous Replenishment has been ‘Updated’ then you must generate ‘New’
· If a previous run has not been ‘Updated’ then you have the option to open the current run

details or run ‘New’.  If you run ‘New’ then the old data is overwritten irrespective of the
Site settings of the previous run.

In the first two instances you have no choice but to run ‘New’, in which case the parameters in the
opening screen need to be completed.  In the final scenario you should ‘check’ the appropriate
checkbox.  If the ‘Previous’ checkbox is selected then, upon clicking the OK Button, you will be
directed to the Detail screen

Previous Replenishment Run

Replenishment Last Run Date: If a previous Replenishment run exists that has not been posted
then this will show the date when it was run.   If no previous run has been done or the previous run
has been posted then this field will be blank

Status: If a previous Replenishment run exists then this will be prefilled with the status ‘In
Progress’.    If no previous run has been done or the previous run has been posted then this field
will be blank.

New Replenishment Run

Replenishment Horizon: This tells the Replenishment routine how far into the future to look at
Supply and Demand.  The following options are available:

Fixed Period in Days - If this checkbox is ‘checked’ then the number in the adjacent field
is the number of days into the future that the Replenishment run will process
Lead Time + Additional Days - If this checkbox is ‘checked’ then the number of days into
the future that the Replenishment run will process is defined by the Lead Time days
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against the individual Item plus the number of days entered in the adjacent field.

Daily or Weekly: Select either Daily or Weekly replenishment quantities. 

Multi Level Explosion: If this checkbox is:
· Not ‘checked’ then the Single Level MRP process will be used against the selection criteria

entered in the following fields
· Is ‘checked’ then the Multi-Level MRP process will be carried out against all Items in

Ostendo and therefore the following Item selection options will not be used

Specific Site: If this checkbox is ‘checked’ then the following field will be made available for
selecting the Site

(Specific Site Selection): If the previous checkbox is ‘checked’ then select the specific Site from
the drop-down list.  The Replenishment Routine will then only run against Inventory and
Replenishment Parameters linked to this Site.

Convert Transfers to Purchases: If this is 'checked' then the Replenishment process will
override any Transfer requirement to a purchase requirement. You should note that this only
applies when multiple sites are involved and items have been defined as being sourced via
transfers from other parent sites 

Exclusions

Exclude Sales Demand: If this checkbox is ‘checked’ then any Demands from Sales Orders will
be ignored

Exclude Jobs Demand: If this checkbox is ‘checked’ then any Demands from Job Orders will be
ignored

Exclude Assembly Demand: If this checkbox is ‘checked’ then any Demands from Assembly
Order Lines will be ignored

Exclude Purchase Supply: If this checkbox is ‘checked’ then any potential receipts from
Purchase Orders will be ignored

Exclude Assembly Supply: If this checkbox is ‘checked’ then any potential receipts from
Assembly Orders will be ignored

Exclude 'Planned' Order Status: If this checkbox is ‘checked’ then any  Sales, Purchase, Job, or
Assembly Order whose status is 'Planned' will be ignored

Exclude 'On-Hold' Order Status: If this checkbox is ‘checked’ then any  Sales, Purchase, Job, or
Assembly Order whose status is 'On-Hold' will be ignored

Forecasting

During the Replenishment Process Ostendo will compare Forecast demands and Actual Demands
for each Item to arrive at an ongoing demand based on the greater of the Cumulative Forecast and
the Cumulative Actual Demand.   (See Replenishment Process below for more details).  The
Forecast can originate from one of two sources:

Inventory:  This type of forecast is based on future Inventory transactions and is primarily
used by the Warehousing/Distribution industry to replenish stock.  This Forecast generation is
often based on past Inventory transactions projected into the future
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Sales:  This type of forecast is based on future Sales and/or Job Orders (Independent
Demands) and is primarily used by the Manufacturing industry who use multi-level Material
Requirements Planning (MRP) to create Replenishment Orders.  This forecast is driven by
Sales/Job Demands to determine an Ongoing 'Independent' Demand.  The Multi-level
Replenishment run then adds other - Dependent Demands - emanating from 'Suggested'
Assembly Orders created during the Replenishment run.  

Exclude any Forecasts for Items: If this checkbox is ‘checked’ then Forecasts held in Ostendo
will be ignored during the Replenishment Run.

Forecast Style: From the drop-down list select the Forecasting Style which you wish to use in the
Replenishment Run.  The options are 'Inventory' or 'Sales'

Forecast From: From the drop-down list select the source of the Forecast to be used.  The
options are:

Entered Monthly:  Refers to the Monthly Forecast as entered into screen Inventory>Item
Forecast
History Generated:  This Forecast will be generated during this  Replenishment Run.  The
next field (History Source) defines from where this information is obtained

History Source:  The Source of the History used to generate the Forecast.  The Options (and their
method of calculation) are:

Average Days:  If this is selected then the Ostendo calculates the sum of the history
(Inventory or Sales) over the number of days entered into 'History Days' and determines and
average daily quantity.  This is used to calculate the Monthly quantity for the current and
subsequent months.  This calculated value is then uplifted by the History Factor (I.e 10% uplift
= Monthly Quantity * 1.1) to arrive at a monthly Forecast to use.  

Same Month Last year:  If this is selected then the Ostendo calculates the usage over the
equivalent month in the past year and applies the History Factor (I.e 10% uplift = Monthly
Quantity * 1.1) to arrive at a monthly Forecast to use in this Replenishment run.  

History Days:  Used by the 'Average Days' History Source to define the number of days history to
use when determining the Average usage per day

History Factor:  Used by the History Source to facilitate and increase or decrease in the Forecast
based upon the History Source value.  An entered value of 10% will increase the History Source
amount by 10% (I.e. History Source * 1.1).

Include Pricing Forecasts:  If you wish to include Pricing Forecasts in this Replenishment Run
then 'check' this checkbox.   Note: Pricing Forecasts are forecasts relating to a Special Price 

Expedite

You can define whether you want the Replenishment Run to look at Supply Orders with the
assumption that they can be expedited to satisfy an earlier demand.  In this instance an Expedite
Report is produced identifying what Supply Order(s) has been expedited to satisfy the demand
requirements.

Expedite Purchase Orders: If this checkbox is ‘checked’ then all Purchase Orders will be used to
expedite demand where required.   A report can be produced showing where this has occurred. 
Note:- When this is 'checked' you have the additional option to NOT expedite specific Purchase
Orders by going to the Purchase Order Header screen and 'checking' the 'No Expediting of this
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Order' checkbox

Expedite Assembly Orders: If this checkbox is ‘checked’ then all Assembly Orders will be used to
expedite demand where required.   A report can be produced showing where this has occurred. 
Note:- When this is 'checked' you have the additional option to NOT expedite specific Assembly
Orders by going to the Assembly Order Header screen and 'checking' the 'No Expediting of this
Order' checkbox

Item Selection Options

Selection Options: The following selection criteria can be entered to restrict the Items that will be
actioned in the Replenishment Run.   

· Item: From the drop-down list select the ‘From’ and ‘To’ Item Range.  If nothing is
selected then all Items will be assumed.

· Category: From the drop-down list select the ‘From’ and ‘To’ Item Category Range.  If
nothing is selected then all Categories will be assumed.

· ABC Classification: From the drop-down list select the Classification.  If nothing is
selected then all Classifications will be assumed.

· Specific Supplier: Tick and select the specific Supplier if applicable.

Buttons

OK: If the ‘Open Previous Replenishment’ radio button was selected then clicking this button will
bring up the Replenishment Results screen described below.  If the ‘Create New Inventory
Replenishment’ radio button was selected then the program will carry out a scheduling run as
described below before going to the Replenishment Results screen. 

Cancel: Any entries made to the Opening screen will be ignored and the Replenishment Run
process will be ended

Replenishment Process

This is a brief description of the Replenishment Process.   The following values, taken from the
Inventory record, will be used in the Replenishment calculations:-

§ Reorder Level
§ Reorder Quantity
§ Order Multiple
§ Lead-time

Step 1.     Delete previous Run Results

The first step is to delete the previous run results.  You should be aware, therefore, that every time
you run the Replenishment routine you are, effectively, starting ‘from scratch’ and all amendments
to the previous run that have not been updated will be lost.

Step 2.    Gross Demand

Looking at the first Item we must first determine the Gross Demand.  This comes from 2 sources
 ‘Actual’ Demand

Actual demand represents the demand coming from Orders in Ostendo with
status ‘Open’, ‘In Progress’ or ‘On Hold’.  The quantity required is the un-issued
quantity and the date is the ‘Start Date’ of the Order or Task.  However, where the
date is beyond the Replenishment Horizon then the demand is ignored.
Additionally, if it is a Multi-Level MRP run then Suggested Demands (see below)
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generated from Suggested Assembly Orders will be included
Forecast Demand

Demand also comes from the Forecast where the Forecast date is equal to, or
later than, the system date.  Item Forecasts are generated during this run to
create forecast quantities/date as defined in the Item’s Forecast screen

A combination of the ‘Actual’ Demand and the ‘Forecast’ demand is used to arrive at the ‘Gross’
demand.   This is carried out as follows.

For each Inventory Item the program calculates the greater of the cumulative Actual Demand and
cumulative Forecast Demand to determine a demand that will satisfy both.

   Actual Demand            4    2    4    7    1    5    6    7
   Forecast Demand        4    4    4    4    4    4    4
                                         ------------------------------------
                 Demand         4    4    4    5    3    4    5    7

Step 3.     The following process is carried out depending upon the type of Replenishment being
carried out.

Replenishment Process - Single Level MRP

The Single Level MRP Replenishment program goes through the following activities:

1.  The first day’s demand is assessed by adding any overdue Supply Orders to the Current Stock
Level
2.  Is the ‘expected’ Stock Level below the Item’s Re-Order Level?

No - Go to question 4
Yes - Determine the greater of (a) the quantity required to bring it up to the Re-Order Level
and (b) the Re-Order Quantity.     Round this up in accordance with the Item’s Order
Multiple and create a Suggested Order

3.  Add the Suggested Order Quantity to the Current Stock Level
4.  Go to the next day.  If the ‘Demand Horizon’ has been reached then select the next Item and go
back to Activity 1
5.  Add any Supply Orders (Assembly Orders or Purchase orders) scheduled for this day
6.  Deduct any ‘Cumulative Demand’ scheduled for this day.
7.  Go back to the question 2

The results of the Replenishment run are displayed showing all Items that have had Suggested
Orders created.  You can drill-down on each Item to see the detailed results of the run.  This
shows (by Day) all Demands, Supply Orders, and Suggested Orders with a resulting stock balance
at the end of the day.
The quantity displayed against the Suggested Order can be amended in this display.   The results
of the amendment is immediately reflected on all subsequent daily balances

Replenishment Process - Multi-Level MRP

In the Multi-Level MRP Replenishment routine ALL Items are processed therefore no Item
selection parameters are available.  The program goes through the following Logic:

1.  Determine the Low-Level Code for each Item.  This Code represents the lowest level in the Bill
of Material structure that the Item appears and defines the priority sequence in which Items are
processed.        
2.  The next step is to delete all previous Suggested Orders and Suggested Demands
3.  Commencing with the first Item at Low Level Code 0 the Actual Demand is evaluated on a daily
basis.  



609Requirements

4.  The first day’s demand is assessed by adding any overdue Supply Orders to the Current Stock
Level.
5.  Is the ‘expected’ Stock Level below the Item’s Re-Order Level?

No - Go to activity 6
Yes - Determine the greater of (a) the quantity required to bring it up to the Re-Order Level
and (b) the Re-Order Quantity.     Round this up in accordance with the Item’s Order
Multiple and create a Suggested Supply Order.    
If this Item is ‘Assembled’ then get the component requirements from the Item’s BOM and
create ‘Suggested Demand Orders’ for each Component where the quantity is that
required to make the parent ‘Suggested Supply Order’ quantity (including component
scrap) and the required date is the Parent Item’s required date, less its Leadtime.

6.  Go to the next day.  
§ If the MRP Horizon has been reached then select the next Item and go back to Activity 4
§ If it is not beyond the MRP Horizon then, commencing with the current stock level, add any

Supply Orders (Assembly Orders or Purchase orders), and deduct any ‘Cumulative
Demand’ scheduled for this day then go back to the Activity 5

The results of the Replenishment run are displayed via the ‘Create Required Orders’ screen where
each Suggested Order can be amended and confirmed prior to converting into a physical order

Replenishment Results

This function shows the Suggested orders when running the Single-Level MRP option.  (The
Multi-Level MRP option will immediately bring up the 'Create Required Orders' screen)

It comprises of three screens
· The List Tab showing the each Item and the total Suggested Order Quantity generated

via the Replenishment Run
· A Replenishment Tab showing the daily calculations made by the Replenishment Run
· A Detail Tab showing all the Actual Supply and Demand Orders used in the

Replenishment Run

List Screen

This screen shows each Item and the total Suggested Order Quantity generated via the
Replenishment Run.   By default those Items that have no Suggested Orders are not displayed but
they can be included by ‘checking’ the ‘Include Zero Qtys’ checkbox.

Display fields

Replenishment Run Date: Display only field showing when this Replenishment run was carried
out

Replenishment Horizon: Display only field showing the Horizon parameters that were used for
this Replenishment Run

Specific Site: Display only field showing the specific Site if this was selected for this
Replenishment Run

Include Zero Qtys:  By default this is not ‘checked’ and only those Items that have Suggested
Orders are displayed.  If this is ‘checked’ then the List panel will display all Items.

Select: ‘Check’ the checkbox where you want the Item’s Suggested Orders to be created.   You
have the option to click on the ‘Select All Items’ Button at the bottom of this panel to select all the
records.  You may also click on the ‘De-select All Items’ Button at the bottom of this panel to ‘
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un-select’ all the records

Item Code: Display only field showing the Item Number

Description: Display only field showing the description of the Item taken from the Item master
record

On-Hand Qty: Display only field showing the current on-hand quantity including the quantity in
Warehouses not included in the Replenishment Run

Sourced By: Display only field showing how the Item is sourced.  The displayed options are
Assembly, Purchasing, or Supplier Assembled.

Total Suggested Quantity: Display only field showing the total of the Suggested Orders contained
in the Details screen.  

Total Buy Value: Display only field showing the sum of the Suggested Quantity multiplied by the
Item's base Buy Price

Total Supply Quantity: Display only field showing the total of current Purchase and/or Assembly
Supply Orders. 

Total Actual Demand Quantity: Display only field showing the total of current Sales and/or Job
Line Orders. 

Total Forecast Demand Quantity: Display only field showing the total of the Forecast Demands
for the Replenishment Period

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering - Click on the black ‘down arrow’ to the right of your selected column heading and you
can either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Buttons

Select All Items: Clicking this Button will place a check-mark in the Select column against all
displayed Items

De-select All Items: Clicking this Button will remove check-marks from the Select column against
all displayed Items

Accept Replenishment Results for Selected Items: All Suggested Orders against the Items that
have been selected will be fixed as a Suggested Order and the remainder removed.  These
Suggested Orders can then be converted into physical orders via the ‘Create Required Orders’ 

Close: This will close the Replenishment Results screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Save: If you have ‘checked’ any line you should click this button to save the entry and stay in this
screen

Cancel: Any ‘checked’ lines that have been made since the last time the ‘Save’ Button was
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pressed will be lost.

Related: This will bring up a list of functions that are related to Inventory Replenishment.  You may
open and maintain information in those screens whilst still remaining in the Inventory
Replenishment screen.

Reports: This will bring up a list of Reports that are related to Inventory Replenishment.  You can
immediately run the report whilst still remaining in the Inventory Replenishment screen.

Detail Screen

This screen has two tabs
· Projected Requirements showing the day-by-day processing from the Replenishment

Run.
· Details showing the actual Supply and Demand orders included in the Replenishment

Run

Entry and Display fields

Item Code: Display only field showing the Identity of the selected Item

Unit: Display only field showing the base Unit of Measure for the selected Item

Description: Display only field showing the Description of the selected Item

Default Supply Method: Display only field showing the Supply Method held against the selected
Item

Status: Display only field showing the current status of the selected Item

On-Hand Qty: This is a display only field showing the current stock level across all Warehouses
and Locations.    For detailed on-hand information click on the adjacent button (Inventory
Availability)

Sourced By: Display only field showing how this Item is sourced and is taken from the Item
master record

Re-Order Basis: Display only field showing the basis on which the Re-Order level and Re-Order
quantities have been based.

Level: Display only field showing the stock level at which the program has evaluated the Planned
Supply order.  The field heading reflects the 'Re-Order Basis' selected above and affects the way
that Ostendo evaluates the Re-Order level

Level (Qty): The Quantity relating to the Re-Order Level.
Level (Days):  The number of days over which Ostendo has dynamically calculated the
Re-Order Level

Re-Order: Display only field showing the evaluated Re-Order Quantity .  The field heading reflects
the 'Re-Order Basis' selected above and affects the way that Ostendo evaluates the Re-Order
Quantity

Order (Qty):  The entered Re-Order Quantity.
Order (Days):  The number of days over which Ostendo has dynamically calculated the
average daily usage.   

Order Multiple:  Display only field showing the Item’s Order Multiple.  
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Default Supplier: Display only field showing the Item’s default Supplier.   

Lead Time:  Display only field showing the Item’s Lead time.   

Sourced By: This is prefilled with the current ‘Sourced Bay’ value held against the Item Master
record.   You can amend that and make the amendment specific to these Suggested Orders by
clicking on the drop-down icon and making your selection.  The options are

Purchasing - fully purchased Item
Assembly - Assembled in-house
Supplier Assembled - Components sent to Supplier for Assembly

Supplier: This is only active if the ‘Sourced By’ selection is ‘Purchasing’.   When active select the
Supplier from the drop-down list

Override Suggested Qty:  If you change a Suggested Order Quantity then Ostendo will
automatically re-calculate the Suggested quantities on subsequent days based upon this new
value.  If you do not want this recalculation to take place then ‘check’ this checkbox

Projected Requirements

This panel shows the day-to-day processing carried out by the Replenishment Run.  It displays all
Supply and Demands by day in addition to the Suggested Order Quantity generated during this
Replenishment Run.  You have the option to amend the ‘Suggested’ quantity against any day and
the program will immediately re-run the Replenishment Process against subsequent records for
this Item taking into account the ‘Suggested Order’ change you have just made.  

The following fields are display only and cannot be amended

Date: Date of the Supply/Demand record
Supply - Opening: Opening stock for this day.  The first day is always the current Stock
Level.  Subsequent days take into account the effect of the previous day(s)
Supply - Purchase: Purchase Order quantity expected this day
Supply - Assembly: Assembly Order quantity expected this day
Demand - Sales: Sales Orders quantity required on this day
Demand - Job: Job Orders quantity required on this day
Demand - Assembly: Assembly Orders quantity required on this day
Demand - Forecast: Forecast quantity required on this day
Calculated - Demand: Gross demand for this day 
Calculated - Projected: Projected stock (Opening + Supply - Demand)
Calculated - Closing: Closing Balance taking into account the Suggested Order

The following field can be amended

Calculated - Suggested:  This is the Suggested Order quantity recommended by the
Replenishment Run.  You can amend this quantity in which case the program will immediately
re-run the Replenishment Process against subsequent records for this Item taking into account
the ‘Suggested Order’ change you have just made.  

Detail

All the fields in this panel are display only and show the Supply and Demand Orders that have
been included in the Replenishment Run.  The fields are:

Order Type: Source of the Order (Example Job, Purchase, Sales)
Order Number: Identity of the Order
Required Date: Date when the Order receipt or issue is planned
Name: The Supplier or Customer against the Order 
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Order Quantity: The current Order quantity
Remaining Quantity: The quantity outstanding against this Order line

12.2 Create Required Orders

This function addresses the Suggested Orders generated from:
· The Replenishment Routine plus 
· Items and Descriptors whose ‘Supply Method’ is ‘Source on Demand'.

This routine allows you to modify and/or approve their requirements before finally converting them
into physical Orders.

An initial selection panel lets you select all or a portion of the Suggested Orders and displays the
results in another panel.  You have the option to:

· Select the lines to convert to Order(s)
· Combine the Lines into a single Purchase Order if Purchased.
· Combine the Lines into a single Assembly Order if Assembled.

Opening Screen

This screen allows you to select the range of Suggested Orders that you wish to process further.

Entry and Display fields

Information Panel: This gives information about the Replenishment Run that created these
records and shows:

· The maximum date addressed in the Suggested Orders file
· The Number of Purchase requirements addressed in the Suggested Orders file
· The Number of Assembly requirements addressed in the Suggested Orders file
· The Number of Items requiring to be Transferred as addressed in the Suggested Orders

file

Display Requirements up to Date: From the drop-down calendar select the date after which the
Suggested Orders will not be selected for view in the next step

Display Requirements for: From the drop-down list select the type of orders to be displayed in
the next step.  The options are ‘Assembly Orders’, ‘Purchase Orders’, and 'Transfers'. 

Filters - These filters further refines the above 'Display Requirements' selection.  The displayed
filters relate to the selection made under 'Display Requirements For'.  I.e.

Purchase Orders
Filter for Single Supplier
Filter for specific Site

Assembly Orders
Filter for Single Item Code
Filter for specific Site

Transfers
Filter for specific Site

Buttons

OK: This will use the criteria entered above and populate the screen shown in the next step with
the selected Suggested Orders
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Cancel: Any entries made in this Opening screen will be ignored and the Create Required Orders
process will be ended

Create Required Orders

Information Panel: This gives information about the Suggested Order file and shows
· The maximum date addressed in the Suggested Orders file
· The Display Requirements option selected in the opening screen (Purchase Orders,

Assembly Orders, or Transfers)

Settings: This gives information about the filters that you applied on the previous screen.  These
are:

· Filter 1 selection in the opening screen
· Filter 2 'Site' selection made in the opening screen

Single or Combined Order: This will only be displayed if the Requirements are for Purchase or
Assembly Orders.

You can create orders that reflect the individual Suggested Order or can combine them into a
single order as follows:

For Assembly Orders: select the Radio Button from -
· Individual Assembly Order for each demand source
· Combine requirements into single order by Item Number

For Purchase Orders: select the Radio Button from -
· Create Separate orders for each demand source
· Combine requirements into single order by Supplier

Sub Assembly Explosion Policy: This field is displayed if the Create Required Orders selection
is for 'Assembly Orders'.  This allows you to not only create the Assembly Order for the Selected
Line(s) but also for Sub-Assemblies throughout the product structure of the selected line(s).    A
drop-down list is presented from which you can select  one of the following options:

· No Explosion.  This denotes that only the selected line will be converted into an
Assembly Order

· Explode Source On Demand.  The selected line and all its lower-level sub Assemblies
whose Default Supply Method (as defined against the sub-assembly's Item Master 
record) is 'Source On Demand' will be converted into an Assembly Order and each will
contain reference to the Assembly Order of the selected line

· Explode All.  The selected line and all its lower-level sub Assemblies will be converted
into individual Assembly Orders and each will contain reference to the Assembly Order of
the selected line

List Tab

This tab displays the selected Suggested orders.  You can make further selections in this screen
relating to which Suggested Order you want converting into actual orders.   All fields except the ‘
Select’ field are display only.  You can make changes to each line by highlighting the line and click
on the ‘Details’ tab

Display fields

Select: ‘Check’ the checkbox if you want the Item’s Suggested Orders to be converted into an
actual Order or Transfer.  You have the option to click on the ‘Select All Required’ Button at the
bottom of this panel to select all the records.  You may also click on the ‘De-select All Required’
Button at the bottom of this panel to ‘un-select’ all the records
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Required Date: This shows the date the Suggested order is required to be available.  This can be
amended by selecting another date from the drop-down calendar.   Using the revised date
Ostendo will recalculate the Order Date based on the Leadtime held against the Item or
Descriptor.

Required Qty: Display only field showing the Quantity required by the Suggested Order

Purchase Date (or Assembly Date): Display only field showing the Date when the Order should
be placed (Required Date less Leadtime).  Not shown for 'Transfers'

Purchase Qty (or Assembly Qty): Display only field showing the Quantity required as amended in
the Detail tab
   or
Transfer Qty: Quantity to be transferred.  This can be amended if required

Code Type: Display only field showing the Type of Line.  This can be Item Code or Descriptor
Code (Purchasing only)

Code: Display only field showing the Item Number or Descriptor Code (Purchasing Only) to be
ordered

Unit: Display only field showing the base unite of the Item Number or Descriptor Code

Fixed Price: If you have negotiated a Buy Price that is different to the standard Buy Price then you
should ‘check’ this checkbox and enter the negotiated price in the next field.  This will then copy
through to the generated Purchase Order 

Fixed Buy Price: This is prefilled with the evaluated Buy Price.  If the previous field is ‘checked’
then the price in this field can be amended.

Description: Display only field showing the Description of the Item or Descriptor taken from the
master record

Supplier: Only visible in the Purchase lines screen and shows the default Supplier for the Item or
Descriptor

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Buttons

Select All Required: Clicking this Button will place a check-mark in the Select column against all
displayed Items

De-select All Required: Clicking this Button will remove check-marks from the Select column
against all displayed Items

Generate Orders for Selected Requirements: All Suggested Orders against the Items that have
been selected will be converted into a Purchase Order (or Assembly Order) with status ‘Open’

Close: This will close the Create Required Orders screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Create Required Orders.  You may
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open and maintain information in those screens whilst still remaining in the Create Required
Orders screen.

Reports: This will bring up a list of Reports that are related to Create Required Orders.  You can
immediately run the report whilst still remaining in the Create Required Orders screen.

Details Tab

This tab displays a selected Suggested order and allows you to amend certain information against
that order.  The fields that can be amended are related to whether the Item is Purchased or
Assembled.  The following fields are available for amendment.

Purchased Items and Descriptors
Select:  ‘Check’ the checkbox where you want the Item or Descriptor’s Suggested Order
to be created into an actual order.  
Purchase Order Date: From the drop-down calendar you can amend the date when the
Item or Descriptor should be ordered
Purchase Order Type: From the drop-down list you can amend the Purchase Order Type
to be generated from this Suggested Order
Supplier: From the drop-down list you can amend the Supplier against which this Order is
to be generated
Purchase Qty: You can amend the Purchase quantity from the Suggested Order Quantity
Fixed Price: If you have negotiated a Buy Price that is different to the standard Buy Price
then you should ‘check’ this checkbox and enter the negotiated price in the next field.  This
will then copy through to the generated Purchase Order 
Fixed Buy Price: This is prefilled with the evaluated Buy Price.  If the previous field is ‘
checked’ then the price in this field can be amended.

Assembly Items
Select: ‘Check’ the checkbox where you want the Item’s Suggested Order to be created
into an actual order.  
Assembly Order Date: From the drop-down calendar you can amend the date when the
Item should be ordered
Order Qty: You can amend the Assembly Order quantity from the Suggested Order
Quantity

Source of Requirement
Required Date : ths date field can be modified if necessary.
Required From : Display field showing the source of the requirement.
Requirement Order Type : Display field - either Job or Assembly or Sales
Requirement Order No. : Display field
Required Qty : Display field
Requirement Unit : Display field
Task Name: Display field

Buttons

Close: This will close the Create Required Orders screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Create Required Orders.  You may
open and maintain information in those screens whilst still remaining in the Create Required
Orders screen.  One option to note in this list is 

Split Requirements:  If this is selected then a separate panel will appear in which you can
split the suggested requirements across one or more Suppliers.
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Reports: This will bring up a list of Reports that are related to Create Required Orders.  You can
immediately run the report whilst still remaining in the Create Required Orders screen.

12.2.1 Purchase Requirements Split

This screen allows you to split a suggested Purchase Order requirement across multiple Suppliers.

Entry and Display fields

Code: Display only field showing the Item Code whose Suggested Purchase Order requirements
are being split

Unit: Display only field showing the base Unit of the Item Code

Required Date: Display only field showing the required date of the Suggested Purchase Order

Suggested Required Qty: Display only field showing the Suggested Quantity generated by the
Replenishment Run

Description: Display only field showing the description of the Item Code

Calculated Required Qty: Display only field showing the sum of the split quantities in the lower
panel.

Supplier: From the drop-down list select the Supplier of the split quantity.  During the initial display
a single record is presented prefilled with the default Supplier.  This can be amended here if
required.

Qty: Enter the quantity that you are going to order from this Supplier.   You should note that the
sum of the quantity from all lines in this lower panel is displayed in the ‘Calculated Required Qty’
above

Fixed Price: If you have negotiated a Buy Price that is different to the standard Buy Price from the
Supplier then you should ‘check’ this checkbox and enter the negotiated price in the next field.
This will then copy through to the generated Purchase Order 

Fixed Buy Price: This is prefilled with the evaluated Buy Price from this Supplier.  If the previous
field is ‘checked’ then the price in this field can be amended.

Side Buttons

Add: The curser will go to a new line for entry of a new Split Requirement record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: After confirmation this will delete the current record

Lower Buttons

Cancel: This will exit this screen without accepting any changes
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Accept Requirements Split: This will accept the current splits and return you to the Create
Required Orders screen where the ‘Splits’ have replaced the original Suggested Order

12.3 Order Inventory Availability

This screen allows you to assess current stock with a view to assessing whether an Order can be
released or delivered.   It goes through the following steps

1.  Define which Orders, and in what priority sequence, are to assessed
2.  Define partial or complete order fulfilment options
3.  Run assessment against Current stock levels or selected Purchase Receipt

The resultant views show both what Orders are available to be picked in addition to viewing and
assessing any shortages

Order Availability - Initial Screen

Whenever this routine is called an initial parameter screen is presented.  This is prefilled with the
settings already entered into Requirement Rules but can be amended here and made specific to
this Availability run

Input and Display fields

(Radio Button): You should select the required option.  These are:
Create New Run - This will create new Availability information taking into account the
selection parameters.  This option will overwrite any existing Order Availability details
Open Previous Run – This will display details of the previous Order Availability run

Last Run Date and Time: Display only field showing the Date and Time when the last Order
Availability run took place

Priority Sequencing:  Three fields are available for you to define the priorities by which the stock
availability will be carried out.  Priority Field 1 defines the major priority order.  Within that priority
you can define a lower (Priority Field 2) priority and so on with Priority 3.  The available options
against each Priority level are:

None - No priority sequence
Required Date - The Order Required Date
Order Date - The Date the Order was raised
Customer Priority - The Priority defined against the Customer master
Order Priority - The Priority Number defined against the Order
Order Started - Orders whose status is ‘In Progress’ come first

Order Classes:  Three checkboxes are available for you to define which Order Classes you want
included in this Order Availability run.  ‘Check’ the checkbox against the required Order class from

· Sales Orders
· Job Orders
· Assembly Orders

Include Status: Ostendo will always include Open and In-Progress Order statuses in the
Availability run.  You also have the option to include Orders with other statuses by ‘checking’ the
appropriate checkbox.  The other statuses are;

· Planned
· On Hold
· Quote

How Stock is Allocated by Order: You can select the way stock allocations are made by
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selecting the option from the drop-down list.  The options are;
Partial order Fulfilment Allowed - You can allocate the line quantity even though other
lines in the order cannot be fully satisfied
Only Full Order Fulfilment Allowed - If any line in the order cannot be fully satisfied then
none of the lines in the Order will be included
Determined by Order Full Delivery Flag - If any line in an Order flagged as ‘Full Delivery’
cannot be fully satisfied then none of the lines in that Order will be included.  Any Order not
flagged as ‘Full Delivery’ will be treated as ‘Partial Fulfilment Allowed’

Demand Up To Required Date: This denotes that all selected orders whose Required Date is
equal to, or earlier than, this date will be included.  This field is prefilled with the date determined
from the system date plus the number of days defined in the Requirements Rules screen.  It can
be amended by typing in a date or selecting it from the drop-down calendar

Future Supply Order Settings: This option is used in the ‘Shortages’ panel of the Order
Availability screen.  It allows you to assess shortages and compare them against Supply Orders.  
The entry options here are:

Include in Shortages - ‘Check’ this checkbox if you wish to see Supply Orders in the
Shortage view
Up To - All Supply Orders up to this date will be included.  It is prefilled with the system
date but can be amended by typing in a date or selecting it from the drop-down calendar

Restrict to Site: This option allows you to restrict the Order Availability run to be restricted to all
stock at a given Site.  The entry options here are:

Restrict to Site - ‘Check’ this checkbox if you wish to restrict the Stock availability to all
Warehouses linked to a specified Site
(Site) - From the drop-down list select the Site to be assessed

Restrict to Purchase receipt: This option allows you to focus on a specific Purchase receipt (in
addition to current stock levels).  The combination can then be processed for Order Availability. 
The entry options here are:

Restrict to Purchase receipt - ‘Check’ this checkbox if you wish to assess the Order
Availability by including this Receipt.
(Receipt) - From the drop-down list select the Purchase receipt reference to be assessed

Buttons

OK: This will commence the Order Availability routine.  At the end the Order Availability Results
screen will be presented

Cancel: Exits this panel without taking any action

Order Availability Results

This screen is presented:
· After a new Order Availability run has been generated, or
· You selected to view the results of a previous run

 
‘Results’ Panel

This panel shows the results of the Order Availability run with options to make changes to the
evaluated results

Input and Display fields
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The upper part of this screen displays the parameter criteria entered to gain the results.  These
criteria are:

Priority Sequencing:  Three fields are displayed showing the priorities by which the stock
availability was be carried out.  The available options against each Priority level are:

None - No priority sequence
Required Date - The Order Required Date
Order Date - The Date the Order was raised
Customer Priority - The Priority defined against the Customer master
Order Priority - The Priority Number defined against the Order
Order Started - Orders whose status is ‘In Progress’ come first

Order Classes:  Display only fields showing which Order Classes were included in the Order
Availability run. 

Include Status: Ostendo always includes Open and In-Progress Order statuses.  In addition the
additional ‘checked’ statuses were also included

How Stock is Allocated by Order: This displays the selected option that dictates the way stock
allocations are made.  The options are;

Partial order Fulfilment Allowed - Allocation are made to lines even though other lines in
the order cannot be fully satisfied
Only Full Order Fulfilment Allowed - Orders that cannot be fully satisfied are excluded.
Determined by Order Full Delivery Flag - Orders flagged as ‘Full Delivery’ cannot be
fully satisfied then they are excluded from this allocation.  Orders not flagged as ‘Full
Delivery’ will be treated as ‘Partial Fulfilment Allowed’

Demand Up To Required Date:  All selected orders whose Required Date is equal to, or earlier
than, this date have been included. 

Future Supply Order Settings: This option is used in the ‘Shortages’ panel of the Order
Availability screen.  It allows you to assess shortages and compare them against Supply Orders.  
The displayed options are:

Include in Shortages - This is ‘checked’ if Supply Orders are included in the Shortage
view
Up To - If the ‘Include in Shortages’ checkbox is ‘checked’ then all Supply Orders up to
this date have been included. 

Restrict to Site: If the selection has been restricted to a specific Site then the Site is displayed
here

Restrict to Purchase receipt: If a Purchase receipt was included in the selection criteria then that
receipt number is displayed here.

Action Bar

Two buttons are available on this 'Action' Bar

Release Orders: If you click on the drop-down list you can select the action that you wish to be
carried out.  You will be asked to confirm the action after which the selected 'Available' Order will
be adjusted accordingly.  The options available from the drop-down list are:

Jobs - Change 'Open' Order status to 'In Progress'
Assemblies - Change 'Open' Order status to 'In Progress'
Delivery Orders - Generate Delivery Batches
Counter Sale Orders - Change 'Open' Order status to 'In Progress'

Print: If you click on the drop-down list you can select the documents that you want to be printed.
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You will be asked to confirm your selection after which the documents for the selected 'Available'
Orders will be printed.  The options available from the drop-down list are:

Job Sheets - Not Printed - Print selected Job Sheets that have not yet been printed
Job Sheets - All - Print all selected Jobs Sheets
Assembly Sheet - Not Printed - Print selected Assembly Sheets that have not yet been
printed
Assembly Sheets - All - Print all selected Assembly Sheets
Delivery Picklists - Not Printed - Print selected Delivery Picklists that have not yet been
printed
Delivery Picklists - All - Print all selected Delivery Picklists
Counter Picklists - All - Print all selected 'Counter' Sales Order Picklists

‘Orders’ Tab

This shows the results of the Order Availability run.  In this screen fields ‘Order Priority’, ‘Available’,
or ‘No Shortages Allowed’ fields can be amended if required.  Having made the amendments you
should click the ‘Re-Generate Results’ button to re-evaluate Order Availability.

The following fields are shown in this grid

Seq No: This is a control sequence number generated by the Order Availability Generate run and
cannot be changed.

Priority: This value is taken from the Order Header priority.  You can change this to any number
from 1 to 9 (1 being the highest priority).   You should note that making a change here will also
update the current Priority against the Order Header.

Order Class:  Display only field showing the Order Class of this line.  The displayed options are:
· Sales Orders
· Job Orders
· Assembly Orders

Order Number:  Display only field showing the Order Number within the Order Class.

Available:  This denotes whether the Stock is available in relation to the Allocation Policy defined
by this run.  I.e.

Partial order Fulfilment Allowed - This will be ‘checked’ if any line in the Order is
available
Only Full Order Fulfilment Allowed - This will be ‘checked’ if all lines in the Order are
available
Determined by Order Full Delivery Flag - This will be set in line with the ‘Full Delivery
Only’ checkbox held against the Order.  I.e.

· If the checkbox is ‘checked’ AND all Lines in the Order are available then this field
will be ‘checked’

· If the checkbox is not ‘checked’ AND any Line is available then this field will be ‘
checked’

Required Date:  Display only field showing the Required Date of the Order.

Order Date:  Display only field showing the Date the Order was raised.

Order Status:  Display only field showing the current status of the Order.

Line Count:  Display only field showing the number of Lines in this Order.

Shortages:  Display only field showing the number of lines that could not be fulfilled by this Sales
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Allocation run.

No Shortages Allowed:  This is a checkbox that shows the status of the ‘Full Delivery Only’
checkbox for this Order.  You have the option to ‘check’ or ‘uncheck’ this box.  You should then
click on the ‘Re-Generate Results’ button to take account of this change

Customer Priority:  Display only field showing the content of the ‘Priority’ field in the Customer
master record

Delivery No:  Display only field showing the Delivery Number if this is a Sales Order with Sales
Style of ‘Delivery’.

Tracking status : Display only field

Tracking Colour : Display only field

Order Description : Can be modified

Planning Note : Can be modified

Purchase Reference : Can be modified

Buttons

Re-Create Availability: This will bring up the ‘Order Availability - Initial Screen’ for regeneration of
Order Availability with new run parameters

Re-Generate Results: Taking into account any changes made to ‘Priority’ or ‘No Shortages
Allowed’ this button will regenerate the Order Availability using the previous run parameters

‘Lines’ Tab

For the selected line in the ‘Orders’ tab this screen shows the Line details for the Order.  All fields
are display only

The following fields are shown in this tab

Upper panel

Line No: The Line Number within the Order.  If the Item is within a Kitset or Task Bill then this is
the Line Number of the Kitset or Task Bill shown in the lower panel.

Code: The Item Code applicable to this line. 

Description: Description of the Item Code

Unit: The base Unit of Measure applicable to this Item Code. 

Order Qty: The quantity - in the base unit of measure - ordered for this line. 

Remaining Qty: The quantity yet to be delivered from this order line

Total Allocated: The quantity allocated by the Sales Allocation run

Shortage Qty: The quantity short (Remaining Qty - Total Allocated) for this Line
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Stock Availability: The calculated Free Stock after higher Priority allocations have been taken into
account

Receipt Availability: The calculated Free Stock after higher Priority allocations have been taken
into account from a specific Purchase Receipt reference

Stock Allocation: The quantity allocated to this line from Inventory stock

Receipt  Allocation: The quantity allocated to this line from a Purchase receipt reference

On-Hand Qty: The current total On-Hand quantity in stock

Receipt Qty: The total quantity in the Purchase receipt reference

Parent Code: If this Line is contained in a Task Bill Code or Kitset Code then Code Identity will be
displayed here.  Note: The Task Bill Code or the Kitset Code will be displayed in the lower panel

Lower panel

This panel shows all the Descriptors, Labour Codes, Task Bill Codes, and Kitset Codes that are
also included in the Order

Line No: The Line Number within the Order.  

Code Type: The type of line.  The displayed options are:
· Kitset Code
· Task Bill Code
· Labour Code
· Descriptor Code

Code: The specific Code related to the Code Type

Description: Description of the Code

Unit: The Unit of Measure applicable to the Code. 

Order Qty: The quantity ordered for this line. 

Remaining Qty: The quantity yet to be issued to this order line

Buttons

Close: This will close the Order Availability results screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Related: This will bring up a list of functions that are related to Order Availability results.  You may
open and maintain information in those screens whilst still remaining in the Order Availability
results screen.
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Reports: This will bring up a list of Reports that are related to Order Availability results.  You can
immediately run the report whilst still remaining in the Order Availability results screen.

‘Shortages’ Tab

This panel shows all the Items where there is insufficient stock to satisfy the Order Allocation
demands.  For any selected Item the lower panel shows all current Supply Orders with their
quantities and due dates.  This is for information only and editing is not allowed.

Upper Panel

Item Code: The Item Code that is having a shortage. 

Description: Description of the Item Code

Unit: The base Unit of Measure applicable to this Item Code. 

First Shortage Date: The date against the Order where the cumulative allocated quantity
exceeded the current available quantity

Shortage Qty: The quantity - in the base unit of measure - short for this line. 

First Supply Date: The date of the first Supply Order - displayed in the lower panel - that could
satisfy this shortage

Supply Qty: The quantity scheduled to be received in the first Supply Order in the Lower panel

Lower Panel

Order Class: The Order Class of the Supply Orders.  The Display options are:
· Purchase Orders
· Assembly Orders

Order Number:  Display only field showing the Order Number within the Order Class.

Required Date: The Required Date of the line within the Supply Order

Supply Qty: The remaining quantity to be received from the Supply Order

Supplier: If the Order Class is ‘Purchase orders’ then the Purchase order number will be
displayed.

Planning Note : Brief notes can be entered here.

Buttons

Close: This will close the Order Availability results screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.
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Related: This will bring up a list of functions that are related to Order Availability results.  You may
open and maintain information in those screens whilst still remaining in the Order Availability
results screen.

Reports: This will bring up a list of Reports that are related to Order Availability results.  You can
immediately run the report whilst still remaining in the Order Availability results screen.

12.4 Constraint Scheduling

This function allows you to address Assembly and Job Orders and determine Resource
Requirements by taking into account any Constraints that apply to nominated Resources.  
Additionally this scheduling process carriers out load balancing across multiple resources, varying
working patterns, efficiencies and process step overlaps.

Parameter Entry Screen

Whenever this routine is called an initial parameter entry screen is presented. 

Input and Display fields

(Radio Button): You should select the required option. These are:
· Create New Schedule - If the Constraint Schedule has never been run before then you

must 'Create New Schedule'
· Open Last Planned Schedule - If you have previously run the Schedule and are

continuing with assessment of Planned results then you must use ‘Open Last Planned
Schedule’

· Open Last Firm Schedule - If you have previously run and Firmed up the Schedule and
are continuing with assessment of Firmed results then you must use ‘Open Last Firm
Schedule’

(Last Run Date and Time): Display only fields against 'Open Last Planned Schedule' and 'Open
Last Firm Schedule' showing the Date and Time when the last run took place

Options

These Options allow you to define what is to be scheduled.  The Options are:

Priority Sequencing: Three fields are available for you to define the priorities by which the
Scheduling will be carried out. Priority Field 1 defines the major priority order. Within that priority
you can define a lower (Priority Field 2) priority and so on with Priority 3. The available options
against each Priority level are:

· Order Sequence - The Order Number sequence
· Required Date - The Order Required Date sequence
· Order Date - The Order Creation Date sequence
· Critical Ratio - The Order's Critical Ratio (I.e. is an index number computed by dividing the

time remaining to the Order's due date by the work time remaining)
· The Order Priority - The Priority Number defined against the Order
· Order Started - If the Order has already started then this is prioritised before Orders that

have not yet started

Order Classes: Two checkboxes are available for you to define which Order Classes you want
included in this Scheduling run. ‘Check’ the checkbox against the required Order class from:

· Job Orders
· Assembly Orders
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Include Status: Ostendo will always include Open and In-Progress Order statuses in the
Scheduling run. You also have the option to include Orders with other statuses by ‘checking’ the
appropriate checkbox. The other statuses are:

· Planned
· On Hold
· Quote

Date Horizon

Horizon Type: From the drop-down list select the Scheduling Horizon Type.  The Options are:
· Required Date
· Order Start Date

Up To - From the drop-down calendar select a date.  The 'Horizon Type' date against each order
will be assessed and those orders which contain a date up to this date will be extracted for
scheduling.

Start Scheduling from - This is prefilled with the system date but can be amended if required
from the drop-down calendar.   The Scheduling run will commence the scheduling from this date

Include Firm Scheduled Orders - If this is 'checked' then Firm Scheduled Orders will be included
in this run.  When checked then the following date range will be used

· From Date - From the drop-down calendar select a date.  All Firm Scheduled orders that
are equal to, or later than, this date will be included in the Scheduling run.  If nothing is
entered then all Firm Scheduled orders up to the 'To Date' will be included.

· To Date - From the drop-down calendar select a date.  All Firm Scheduled orders that are
equal to, or earlier than, this date will be included in the Scheduling run.  If nothing is
entered then all Firm Scheduled orders from the 'From Date' will be included

Include Inventory

Include Inventory Availability: If this is 'checked'  then the scheduling function will take into
account the availability of Items in Inventory.

Future Supply Order Settings

Include in Shortages - ‘Check’ this checkbox if you wish to see Supply Orders in the Shortage
view

Up To - All Supply Orders up to this date will be included. It is prefilled with the system date but
can be amended by typing in a date or selecting it from the drop-down calendar

Restrict Options

These options allow you to restrict the Order Scheduling run to all Orders at a given Site. The entry
options here are:

· Restrict to Site - ‘Check’ this checkbox if you wish to restrict the Scheduling to all Orders
linked to a specified Site

· (Site) - From the drop-down list select the Site to be assessed

Restrict Order Sequence: ‘Check’ this checkbox if you wish to restrict the scheduling process to
address a range of Order (or Product) Sequence Numbers as defined against each Assembly
Order.
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From - Enter the 'From' Sequence Number.  The Scheduling routine will include all Assembly
Orders who's Order contains a Sequence Number equal to, or greater than, this entered number

To - Enter the 'To' Sequence Number.  The Scheduling routine will include all Assembly Orders
who's Order contains a Sequence Number equal to, or less than, this entered number

Buttons

OK: This will commence the Constraint Scheduling routine.  The first step will be to extract the
orders that satisfy the parameter entry criteria.    At the end of this activity the 'Scheduling Orders'
screen will be presented

Cancel: Exits this panel without taking any action

Scheduling Orders

If you selected Create New Schedule' you are now presented with a screen titled ‘Scheduling
Orders’ which displays all the orders that met the criteria from the previous parameter entry
screen. From this screen you are able to adjust the following information that will be used in the
next step to generate the schedule:

· The ability to individually exclude an order from the run
· The ability to adjust the remaining schedule hours per resource code (labour code). This is

important if actual times/timesheets are not up to date
· The ability to select an override resource code (I.e. manually swap to another resource)

and also set the speed factor (in case the resource you’re swapping to is either faster or
slower than the default resource)

Input and Display fields

List Tab

Order Style:  Display only field showing the Style of the Order.  The displayed options are
Assembly Order or Job order

Order Status:  Display only field showing the current status of this Order

Order Number: Display only field showing the Order Number

Order Description: Display only field showing the Order Description

Parent Order: Identity of the parent Order that this order is linked to.  You have the option to
amend this at this time.  You should be aware, however, that no checks are made on this entry.   
This column facilitates filtering of the displayed records within this view. 

Parent Description: The description of the parent Order that this order is linked to.  You have the
option to amend this at this time if required

Required Date: Display only field showing the Order's Required Date

Order Date: Display only field showing the Order's Order Date

Leadtime: Display only field showing the Order's Lead Time

Exclude Order: 'Check' this checkbox if you wish to exclude this Order from further scheduling
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Minimum Start Date: If you wish to specify a date before which this Order must NOT be
scheduled then enter the date in the drop-down calendar.  

Generated Sequence: During this initial scheduling step Ostendo determines the Sequence in
which the Order is scheduled.    This will be used in the next step of the scheduling process.   If
you would like to amend this sequence then it can be adjusted in the next field.

Schedule Sequence: During this initial scheduling step Ostendo determines the Sequence in
which the Order is scheduled.    This is displayed in the previous field.   If you would like to amend
this prior to the final Scheduling step then it can be adjusted here.

Product/Order Sequence: Each Order contains a Product/Order Sequence identifier.  This
determines the sequence that a series of related Orders are loaded (For example: you may wish to
control similar Orders that have varying Colours such that you load light colours first and progress
through to dark colours).  You may amend the Order Sequence here if required

Order Started: This is automatically 'checked' if the Order has already started.  You have the
option to amend this setting.   Orders that have been started have priority of those that are yet to
start if all other criteria are the same

Order Priority: This is prefilled with the Job or Assembly Order's Priority which may be amended
here prior to generating the detailed Resource Constraint schedule in the next process step

The remaining fields are displayed only and are taken from the Order Header record

Order Lines Tab

This tab displays the current information about the Labour Code lines in the selected order.   You
may adjust the Remaining Hours against any line if your assessed remaining hours differ from the
system evaluated hours.  This adjusted value will be used in the next step of the Constraint
Scheduling process

Buttons

Continue: Once you have made any changes to the orders and line click on the ‘Continue’ button.
You will be presented with a ‘Please Wait’ dialog that stays on the screen while the main process
of scheduling occurs (the time taken to schedule is very much dependant on the number of orders,
number of resources, how many resources are constrained, and how far out the horizon is set).
After the schedule process has completed you’ll be presented with the main Constraint Scheduling
Board.

Scheduling Board

Within the Scheduling Board you’re presented with the following:

At the top of the screen are two Toolbars

· Related Toolbar that displays related screens that can be accessed on clicking the various
buttons

· Filtering Toolbar that is primarily used when in the Graphical Schedule tab (displayed in a
Gantt/Calendar style of view)

Under the 'Schedule' Tab there are two panels
· The Main Scheduling Panel which shows the details of the Resources within the Schedule.

 The scheduling information can be amended as required
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· Loading / Utilisation Panel which is situated above the 'Main Scheduling' Panel provides a
quick glance of the loading for the resource (or Department) selected in the Main Scheduling
Panel over a 30 day (or week) period, colour coded to highlight potential capacity issues.
The colour coding is defined in the ‘Loading Indicators’ screen
(Requirements>Settings>Loading Indicators)

There are also 2 more tabs within this panel:
Graphical Schedule: This presents a graphical calendar/Gantt style of interface where
you can drag & drop the Resource allocation records around when in resource mode. If in
Order mode, you’re able to view the orders in a project style of interface displaying the
total elapsed time for each step/task and the inter-dependant links between each, within
that order.
Loading & Capacity: This is charting representation of the loading verses the capacity
enabling grouping by: (Department, Resource, Year-Week, Year-Month)

12.5 Resource Loading Board

This screen provides a view of the Loading and Utilisation for all Resources or Departments for a
30 day or 30 week period.  You have the option to display either the Firm Schedule or the latest
Planned Schedule.

Selection Options

Schedule: Select either Planned or Firm from the drop-down list

Resource Level: Select either Resource or Department from the drop-down list

Period Length: Select either Days or Weeks from the drop-down list

Buttons

Close: Exits this screen
  

12.6 Graphical Plant View

The Graphical Plant View is view of the Plant (User-Designed via the Workflow Editor) that shows
the loading generated by the Constraint Scheduling Process.   The Graphical Plant View is linked
to the generated Workflow in Requirements>Settings>Requirement Rules

Selection Options

Schedule: Select either Planned or Firm from the drop-down list

(Selection Period): Select either Date or Week Start from the drop-down list to select the time
span

(Date): Select the date for the display.  For Week Start (above) this denotes the first date in the
week

Buttons

Close: Exits this screen
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12.7 Assignment Profiles

This screen allows you to define as many Assignment Profiles as required..  Assignment Profiles
are used to define or set up what can be viewed and managed on the Assignment Board.

For example you can have one Profile for managing just field service assignments and another
Profile for managing Assembly operations. 

List Tab

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Profile Name:  This shows the name of the Profile. Profile names are unique.

Incl Jobs: This box is ticked if this Profile can see job assignments.

Incl Assemblies: This box is ticked if this Profile can view Assembly assignments.

Sales Included: This box is ticked if this Profile can view Sales Orders assignments

Incl Deliveries: This box is ticked if this Profile can view Deliveries assignments.

Incl Activities: This box is ticked if this Profile can view Activity assignments.

Incl Tickets: This box is ticked if this Profile can view Ticket assignments.

Incl Employees: This box is ticked if this Profile can view Employee resources.

Incl Assets: This box is ticked if this Profile can view Assets resources.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

Reports: This will bring up a list of related reports.
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Detail Tab

Entry and Display fields

Profile Name: When adding a new Profile, enter the name of the Profile here. Profile names must
be unique. At other times, this is a Display only field showing the selected Profile.

Resources

Employees Included: Tick this box if this Profile can view employee resources.    

Assets Included: Tick this box if this Profile can view Asset resources. 

Horizon

Days Back: Enter the number of days back from current date that this profile can view
assignments. 

Days Forward: Enter the number of days forward from current date that this profile can view
assignments.

Display

Display Employee and Asset Images: Tick this to display the image held against the Employee
or Asset on the Assignment Board

Display Employee and Asset Extra Info: Tick this to display extra information against the
resource like the department on the Assignment Board

Display Order and Project Images: Tick this to display the image held against the Order, Project
or Zone on the Assignment Board

Display Order and Project Extra Info: Tick this to display extra information against the Order,
Project or Zone on the Assignment Board

Specific Site: Tick this to restrict this profile to a specific site.

(Site): This becomes active if the previous (Specific Site) checkbox is 'checked'.   Select the
specific Site from the drop-down list

Board is Read-Only : Tick this box to prevent changes to the board. (This disables the ability to
amend any entries on the Assignment Board).

Move to Current Day when Refreshed : Tick this box to move the display to current date when
the board is refreshed. (This option simply resets the screen to show the Assignment Board from
the start of "Today").

Bookings

Hide Bookings Panel: Tick this box if the profile is going to be used more as a display view (i.e.
on a large screen on a wall – the auto refresh minutes should also be defined for that purpose) 
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Jobs Included: Tick this box if this Profile can view job assignments.    

Assemblies Included: Tick this box if this Profile can view Assembly assignments. 

Deliveries Included: Tick this box if this Profile can view delivery assignments.    

Sales Order Included: Tick this box if this Profile can view Sales Orders assignments.    

Tickets Included: Tick this box if this Profile can view Ticket assignments. 

Activities Included: Tick this box if this Profile can view Activity assignments. 

Warnings

Check for ... Options: Out of Sequence, Double Booking, Overdue, Shortages.
By selecting or not selecting these – they are either included or not included on the Assignment
Board

Auto Refresh

Refresh Minutes: The number of minutes for the Assignment Board to automatically refresh the
contents. If set to zero no automatic refreshing will occur on the Assignment Board

Check for Warnings on Load: Ticking this box means that this Profile will check for warnings on
Assignment Load always.

Scale Buttons 

These define the 3 time scales used as defaults within the Assignment Board (i.e. Daily, Weekly &
Monthly)

Default: This sets the default user defined scale for the Assignment Board (1, 2 or 3)

Captions: This define the captions for each scale button

Time Scale: This sets the major time scale bucket (Day-Hour would the most common used)

Step: Only relates when the Time Scale is set to ‘Day-Hour’ and determines the number of
minutes per minor bar between hourly intervals (i.e. 5, 10, 15, 30 etc…)

Width: Defines the physical display width of the major Time Scale on the Assignment Board     

Notes sub-tab: Enter any relevant notes here.

Conditions sub-tab: This sub-tab allows you to further define what this Profile can view/manage
on the Assignment Board.

        Condition Type: Select from the drop-down list: Job type / Sales type / Customer Type /
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Service Zone / Call Style / Department / Employee / Asset / Step Department / Task
Department .    

        Include or Exclude: Select either an Include or an Exclude clause for this Condition. 

        Condition Value: Select the appropriate value from the drop-down list.  

  

Buttons

Close: This will close this screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will add a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current screen record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This enables you to delete the selected line.

Reports: This will bring up a list of related reports.

12.8 Assignment Board

The Assignment Board is the planning board function of Ostendo.

You can use this screen to create and schedule assignments for Jobs, Assemblies, Sale
Deliveries, Sales Orders, Ticket Actions, and Activities.

For example, Job or Assembly tasks can be assigned to resources like employees, contractors,
plant equipment, vehicles, etc. These assignments can be scheduled or re-scheduled when
required.

The Ostendo Assignment Board has the additional dimension of evaluating requirements of a task
against the capabilities of the resource to ensure the correct resources are assigned to the task. 

For example, if a job requires the use of a 10 ton truck which in turn requires a driver with
a Class 2 licence, then these capability requirements are evaluated against the resources
assigned. If the requirements are not met, the assignment is flagged as Planned (the
assignment bar is highlighted red) and is deemed not available for dispatch until these
issues are resolved.

Ostendo also allows you to set up "Blocked Times" for any resource (e.g. vacation time, system
maintenance etc...). The Assignment Board will not allow tasks to be assigned to a resource during
their blocked times.

When you click on Assignment Board, you will first be prompted to select a Profile Name. 

Profile Names are set up under the Assignment Profiles screen. This allows you to define what
jobs or tasks, resources, departments etc that the user can manage through the Assignment
Board. There are also further options and defaults that determine the display and behavior of the
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board, some of these are:

· The default date horizon for both the days back and forward

· The definition of the 3 time scale buttons that allow the board to be displayed in a minute
by view, right through to monthly buckets

· An auto refresh interval in minutes (if zero the auto refresh facility is deactivated)

· Conditions tab allowing for specific inclusions or exclusions to be defined (i.e. Employees,
Departments, Job Types, Service Zones, etc.,,)

When the Assignment Board screen is displayed, the title of the screen is Assignment Board with
the Profile name in brackets.

The Assignment Board screen is split into five main sections

· The Toolbars at the top of the screen

· The left panel shows the Resources (employees and assets)

· The main panel in the middle shows the assignments scheduled for each resource 

· The upper-right panel shows a calendar for you to select the displayed time periods

· The lower-right panel (Un-Assigned Bookings) shows all Jobs/Tasks/Tickets/etc. yet to be
assigned

You can resize the panels by clicking on the panel boundaries and dragging them to the required
position

Toolbars

Days Back – Assignments will be displayed up to the specified number of days back.

Days Forward – Assignments will be displayed up to the specified number of days
forward.

Refresh – Click this button to refresh the assignment board contents.

Auto Refresh – This toggles the activation of the auto refresh feature

Switch Profile – Allows the user to switch to another assignment profile

Resources – 

Group By – None / Resource / Date

Resources Layout Editor – This allows you to select or de-select any resource and place
them in the desired order.

Resources per Page – Select how many resources to be displayed per page.

Employee  - Tick to display Employees
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Asset – Tick to display Assets

View – 

TimeLine Scale

Major Unit – can be Day / Week / Month / Quarter / Year

Minor Unit – can be Hour / Day / Month / Quarter

Time Step (in Minutes) - (applies only when minor scale is in Hours ) can be 1 / 5 / 6 / 10
/ 15 / 30 / 60 minutes (affects the number of segments in an hour)

Hour Width – Width of the Hour scale (in pixels)

Day Width – Width of the Day scale (in pixels)

Month Width – Width of the Month scale (in pixels) 

Quarter Width – Width of the Quarter scale (in pixels)

Assignment Bar Detail - if Assignment notes available, this will expand the height of the
bar to display the notes.

View Position – This gives the option to place the main panel either to the left or to the
right  of the Calendar and To-Be-Assigned panels.

Display Mode – 

Resource – Displays the board with the employees or assets order based on the
department sequence and then the resource calendar order

Order - Displays the board grouped by order number 

Project - Displays the board grouped by project

Zone - Displays the board grouped by service zone

Publish – 

Print - the Assignment Board graphical screen

Email - the Assignment Board screen in various formats

Export – the Assignment Board screen in various formats 

Reports  – View and print related reports. Additional reports can be defined in the Report
and View developer and linked to the Assignment Board via the specific screen drop down

Scale Buttons Shortcuts – These three buttons are shortcuts for what is set in the Assignment
profile (Time scales, Steps, and widths). You can also specify a caption for each of these
shortcuts.

Update Orders – Click this button to update any changes made to orders (dates and times).
Unless this button is clicked changes to dates and times will not be reflected in the Job and
Assemblies order screens.
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Work Times – Clicking on Work Times will display only work times for each day. This is a toggle
switch. Clicking it again will revert back to the previous setting. The work times are defined in the
General-Settings-Work Times screen.

Work Days – Clicking on Work Days button will display only working days on the main panel. This
is a toggle switch. Clicking it again will revert back to the previous setting. The work days are
defined in the General-Settings-Work Times screen.

Highlight By – 

Tracking Code: this will show the current Tracking Code colour for each assignment

Assignment Status: Blue = In-progress, Green = Completed, Red = capability not met,
White = active assignment

Overdue: this will highlight the assignment bars in a yellow highlight colour that are
overdue

Out of Sequence: this will highlight the assignment bars in a yellow highlight colour where
the tasks/steps are out of sequence as defined in either the Job Tasks or Assembly Steps

Double Booked:  this will highlight the assignment bars in a yellow highlight colour where
the resource has been double booked

Shortages: this will highlight the assignment bars in a yellow highlight colour where there
are material shortages for the orders they are linked to. A time picker will be popped up for
the user to select a start date and time to be used as the starting point for the
accumulative shortage check for assignments.   

Display Actuals – This function allows you to display the actual times as read in from the
Timesheet lines. There are a few options for actuals as determined via the Assignment Rules
screen. The options are as follows:

Create New Actual Assignments: if this is set, then completely new assignment bars are
created and displayed on the board, they are identified by a unique bar icon and are
always green in colour. These actual bars are either displayed in the same row as all other
current assignments for that resource, or are displayed in their own row as determined by
the Assignment Rule – ‘How Timesheet Entries are shown on the board if displayed’.

Update Existing Assignments: if this is set then the specific assignment bar is updated in
duration and status (completed) by the timesheet posting. There is another rule that can
be set if this option is used, and that is the shift assignments logic. There is the ability to
have all subsequent assignments for the same resource to shift by the same offset that
the updated assignment was either late or early.   

Legend – This displays a legend of the possible icons shown on the assignment bars and what
they indicate. 

Changes – This button will only appear if the mobility module is being used (by defining
employees in Employees Mobility Settings screen – making sure the Service Sheet is activated),
the employee has synchronized at least once with Ostendo Freeway, and there have been
changes to his or her schedule since they last synchronized. On clicking the button a dropdown of
the employees where changes have occurred since they last synchronized – with ability to display
those changes.   

Filter By – Use this function to filter assignments by Customer / Job Order / Sales Order /
Assembly Order / Resources without Assignments / Resources with Assignments. For
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example – filtering by Customer allows you to focus on all assignments related to a particular
Customer. Filtering will prompt you to enter the specific customer name or order number for the
above. There is also the ability to filter the board by Resources with or without assignments (a date
range is prompted if this option is selected); this is useful where there are a large number or
employees or assets and filtering out who or has not got work assigned could be very time
consuming otherwise.  

Toolbar Shortcut Buttons: These shortcut buttons allow you to open the following screens:

· Customers

· Employees

· Job Orders

· New Job

· Call Centre        

· Activity Calendar 

Main Panel

The Main Panel shows all Assignments scheduled for the period displayed and the profile
definition. 

Creating Assignments and Resource Allocation

Assignment bookings can be created 3 ways:

Dragging and Dropping: from the Un-Assigned Bookings list you are able to either
singularly select or multi-select and then drag and drop onto the appropriate employee or
asset and the booking (or bookings) will be displayed immediately. The duration of the
booking is determined by the assignment rules (Job Duration style, Assembly Duration
style or the default minutes for each booking type).  

Using the Job or Assembly Schedule Buttons: These buttons will appear at the top of
either the Job or Assembly Un-Assigned lists based on the Assignment Rules – Assembly
Schedule Button Logic or Job Schedule Button Logic. They allow the bookings to be
created either by selecting a single or multiple list items, and then clicking on the button:
this will in turn create the bookings based on predetermined resources in the Job or
Assembly order.   

Automatically from the Job Task Resources: Assignment bookings will be automatically
created from the Job Resource tasks if the Assignment Rule – Auto Create Assignments
from Job Tasks is selected.

Displaying the Booking Details

The assignment booking details can be displayed by clicking the assignment bar, where upon an 
Assignment screen will be displayed with the following: 

Header tab – this provides a summary of the booking and the ability to override the
subject displayed in the assignment bar. Although there are default subject and location
captions for all the assignment types there is the ability to define custom labels from field
values (i.e. Phone number, Contact Name, Required Date etc…) via the
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Requirement-Settings-Assignment Captions screen.  

ID - Assignment ID

Type - Assignment Type

Start Time - Assignment Start Date and Time

Finish Time - Assignment Finish Date and Time

Status - Assignment Status

Description

Assignment Subject - 

Assignment Location

Override Subject - Tick the box and key in a new Subject.

Settings

Can't be Split - Assignment cannot be split.

Fixed Time Slot - Assignment is requested to be performed at the
specified time. 

Schedule Following Assignments button - use this button to schedule the
follow-on assignments when the current assignment is delayed..

Undo button. - Use this button to undo the above scheduling.and return
to original.

Information

Bookings - Summary of all the bookings linked to this assignment.

Resources - Summary of all the resources linked to this assignment.

Warnings - Summary of all warnings applicable to this assignment.

Shortages - Summary of all shortages in this assignment.

Capability Satisfied - Ticked indicates that all required capabilities for this
assignment are satisfied.

Required Hours - Summary of required hours.

Booked Hours - Summary of booked hours.

% - Percentage of Required / Booked hours.

Bookings tab – this displays the order(s) or activity(s) that this assignment booking is
linked to. There is the ability to add or subtract others (as long as they are the same
assignment type) from there.  
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Booking Type -

Booking -

Description -

Required Date - 

Resources tab – this displays the resources (either employees or assets) and provides
the ability to add or subtract others. There is also the ability to De-Couple the resource
from the others, by this we mean if that resource is moved or there duration is altered it
doesn’t affect the other resources (by default all resources are moved and their durations
are synchronized when any one of them is altered).   

Resource Type -

Resource Name -

Start -

Finish - 

De-Coupled -

Capability Required tab – this displays the capabilities required for the assignment
booking and then dynamically compares these to the capabilities held against the
resources (defined against the Employees or Assets screens) and if the capabilities
required are not satisfied by the linked resources then the booking is deemed to be
planned (not Active) and there for not available to be dispatched to the mobile or factory
workforce (if using Ostendo Freeway planned assignments are not uploaded). The
assignment bar is a red colour and displays a specific icon to highlight the issue. Required
Capabilities can be added, modified and subtracted at the specific assignment booking, if
required.  

Capability Name - 

Capability Type - 

Capability Qty - 

Source -

Warnings tab – this displays any warnings generated for this assignment booking. The
types of warnings indicated are defined against the assignment profile.  

Message -

From Type -

From Name - 
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Shortages tab – this displays any specific shortages for the assignment booking. The
Highlight by-Shortages needs to be run for these to be current.

Item Code -

Description -

Required Qty -

Available Qty -

Shortage Qty - Required Qty minus Available Qty

Unassigned Bookings (Lower Righthand Panel)

Assignments can be created by dragging the selected orders/items from these lists and dropping
them into the Main Panel.

Search field - to help find Jobs, Assemblies, etc... from the Unassigned list.

Jobs tab - list of unassigned Job Orders

Assemblies tab - list of unassigned Assembly Orders

Deliveries tab - list of unassigned Deliveries

Sales tab -  list of unassigned Sales Orders

Tickets tab - list of unassigned Tickets

Blocked Times - list of standard, pre-defined Blocked Times that can be assigned to any
resource at any time.

12.9 Assignment Loading

This screen provides a view of the Loading and Utilization for Employees, Assets and Departments
for a 30 day or 30 week period based on the Assignment Board bookings. The cells can be colour
coded for highlighting where capacity is potentially a problem based on the definitions in the
Requirements-Settings-Loading Indicators screen.   

Selection Options

Resource Level: Select either Resource or Department from the drop-down list

Period Length: Select either Days or Weeks from the drop-down list

Buttons
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Close: Exits this screen

12.10 Settings

12.10.1 Loading Indicators

Loading Indicators provide facility for you to nominate various colours that represent the amount of
Load (or Overload).  These colours will be used in the Resource Loading Board screen to provide
an instant recognition of any potential problem areas.   As an example of how this works assume
that the following records have been created

Loading Name Percentage Indicator Colour
IND-1 80 Yellow
IND-2 90 Orange
IND-3 100 Red

If the actual Load was 75% then the cell will not be filled with colour
If the actual Load was 95% then the cell will be filled with Orange colour
If the actual Load was 100% then the cell will be filled with Red colour

Entry and Display fields

Loading Name:  Enter the Name of this Loading Indicator.  Duplicates not allowed.

Percentage: Enter the percentage up to which the Resource Loading Board will display this colour
in the relevant loading cell.

Indicator Colour: From the drop-down list select the colour to be used

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Loading Indicator screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Rate Level.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Loading Indicator.

12.10.2 Assignment Captions

This screen allows you to design the Captions to be displayed when an Assignment is created on
the Assignment Board. If you do not define any Captions, then the system will display some default
captions.
Captions consists of two portions - a 200 character "SUBJECT" string followed immediately by a
200 character "LOCATION" string which is enclosed in brackets.
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Both SUBJECT and LOCATION strings can consist of one or more user-selected field values.

Each record identifies a field name to be used in the caption. If you wish to include multiple field
values in your caption, then you need to use multiple lines to define the whole caption.

Entry and Display fields

Assignment Type:  Select the type of assignment from the drop-down list. ( Job / Assembly /
Delivery / Ticket Action / Activity ) 

Caption Type: This is either the Subject portion or the Location portion of the caption. The
Location portion is enclosed in brackets and always comes after the Subject portion.

Field Name: From the drop-down list, select the field name to be included in this portion of the
caption. 

Sequence: You can order the fields in your caption by entering a sequence number for each field.
Fields are concatenated from left to right according to their Caption Type ( SUBJECT / LOCATION
) and sequence number.

Prefix: You can enter a prefix for this field name if desired for clarity. Each field value will be
separated by a colon (:) in the Caption string.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the last time the ‘Save’ Button was pressed will be lost.

Delete: This removes the current highlighted line.

12.10.3 Requirements Rules

This screen allows you to maintain Requirements Rules.  Requirements Rules allow you to define
defaults that will be used in the Requirements Run program.  The following rule settings are
available

Entry and Display fields

Replenishment Horizon: This tells the Requirements routine how far into the future to look at
Supply and Demand.  Select one of the following from the drop-down list:

· Fixed - Denotes that the Replenishment Days defined at the commencement of the
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Requirements routine will determine the planning horizon for all Items
· Lead Time - Denotes that the Replenishment Days defined at the commencement of the

Requirements routine plus each Item’s Leadtime will determine the planning horizon for
each Item

Replenishment Days or Weeks: This defines the default Replenishment Days or Weeks that will
be displayed each time the Requirements Routine is run.  If required it can be altered in that
screen and made specific to that run. 

Exclude Forecasts: This defines the default parameter that will be displayed each time the
Replenishment Routine is run.   The options are:

· If checked then Item Forecasts will not be included in the Requirements Run
· If unchecked then Item Forecasts will be included in the Requirements Run

Exclude Sales Demand:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Exclude Sales Demand' field in that screen will be
defaulted to this entry.

Exclude Job Demand:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Exclude Job Demand' field in that screen will be
defaulted to this entry.

Exclude Assembly Demand:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Exclude Assembly Demand' field in that screen will
be defaulted to this entry.

Exclude Purchase Supply:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Exclude Purchase Supply' field in that screen will be
defaulted to this entry.

Exclude Assembly Supply:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Exclude Assembly Supply' field in that screen will be
defaulted to this entry.

Exclude Planned Orders:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Exclude Planned Orders' field in that screen will be
defaulted to this entry.

Exclude OnHold Orders:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Exclude OnHold Orders' field in that screen will be
defaulted to this entry.

Forecast Style:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Forecast Style' field in that screen will be defaulted
with this value.  From the drop-down list, select the Forecasting Style which you wish to default in
the Replenishment Run. The options are 'Inventory' or 'Sales'

Forecast From:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Forecast From' field in that screen will be defaulted
with this value.  From the drop-down list select the source of the Forecast to be used. The options
are:

Entered Monthly: Refers to the Monthly Forecast as entered into screen Inventory>Item
Forecast
History Generated: This Forecast will be generated during this Replenishment Run.

Entered Daily: Refers to the Daily Forecast as entered into screen Inventory>Item Forecast
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History Source:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'History Source' field in that screen will be defaulted
with this value.  The Source of the History used to generate the Forecast. The Options (and their
method of calculation) are:

Average Days: If this is selected then the Ostendo calculates the sum of the history (Inventory
or Sales) over the number of days entered into 'History Days' and determines and average
daily quantity. This is used to calculate the Monthly quantity for the current and subsequent
months. This calculated value is then uplifted by the History Factor (I.e 10% uplift = Monthly
Quantity * 1.1) to arrive at a monthly Forecast to use. 

Same Month Last year: If this is selected then the Ostendo calculates the usage over the
equivalent month in the past year and applies the History Factor (I.e 10% uplift = Monthly
Quantity * 1.1) to arrive at a monthly Forecast to use in this Replenishment run. 

History Days:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'History Days' field in that screen will be prefilled with
this value.  

History Factor:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'History Factor' field in that screen will be prefilled
with this value.  

Expedite Purchase Orders:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Expedite Purchase Orders' field in that screen will be
defaulted with this entry.  

Expedite Assembly Orders:  Whenever you start a new Inventory Replenishment run via screen
Requirements>Inventory Replenishment  the 'Expedite Assembly Orders' field in that screen will
be defaulted with this entry.  

Availability Priority Sequence 1:  This defines the default Priority sequence by which the Order
Availability routine evaluates availability of stock to Orders.  The available options against this
Priority level are:

None - No priority sequence
Required Date - The Order Required Date
Order Date - The Date the Order was raised
Customer Priority - The Priority defined against the Customer master
Order Priority - The Priority Number defined against the Order
Order Started - Orders whose status is ‘In Progress’ come first

Availability Priority Sequence 2:  This defines the second Priority (Sorted within the first Priority)
sequence by which the Order Availability routine evaluates availability of stock to Orders.  The
available options against this Priority level are:

None - No priority sequence
Required Date - The Order Required Date
Order Date - The Date the Order was raised
Customer Priority - The Priority defined against the Customer master
Order Priority - The Priority Number defined against the Order
Order Started - Orders whose status is ‘In Progress’ come first

Availability Priority Sequence 3:  This defines the third Priority (sorted within the second Priority)
sequence by which the Order Availability routine evaluates availability of stock to Orders.  The
available options against this Priority level are:

None - No priority sequence
Required Date - The Order Required Date
Order Date - The Date the Order was raised
Customer Priority - The Priority defined against the Customer master
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Order Priority - The Priority Number defined against the Order
Order Started - Orders whose status is ‘In Progress’ come first

Availability Include Jobs: ‘Check’ this checkbox if you want the Order Availability parameter
screen to be defaulted with the option to include Job Orders

Availability Include Sales: ‘Check’ this checkbox if you want the Order Availability parameter
screen to be defaulted with the option to include Sales Orders

Availability Include Assemblies: ‘Check’ this checkbox if you want the Order Availability
parameter screen to be defaulted with the option to include Assembly Orders

Availability Include Planned: ‘Check’ this checkbox if you want the Order Availability parameter
screen to be defaulted with the option to include Orders whose status is ‘Planned’

Availability Include On-Hold: ‘Check’ this checkbox if you want the Order Availability parameter
screen to be defaulted with the option to include Orders whose status is ‘On-Hold’

Availability Include Quote: ‘Check’ this checkbox if you want the Order Availability parameter
screen to be defaulted with the option to include Orders whose status is ‘Quote’

Availability Required Horizon Days: Enter the number of days that will be added to the Order
Availability run date to provide a date to populate the  ‘Demand Up To Required Date’ field in the
Order Availability Parameter screen.  If nothing is entered here then zero is assumed.

Availability Include Future Supply: ‘Check’ this checkbox to prefill the equivalent checkbox in
the Order Availability parameter screen.  This feature allows you to assess shortages and compare
them against Supply Orders.   

Availability Supply Horizon Days: This field is used in conjunction with the previous field to
provide the date up to which the Future Supply will be assessed.  Enter the number of days that
will be added to the Order Availability run date to provide an inclusion date for future supply orders.
If nothing is entered then zero days is assumed.

Availability Fulfilment Policy: From the drop-down list select the Policy that will prefill the Order
Availability parameter screen.  You can, of course, select another policy before running the Order
Availability routine.  The policy options are:

Partial order Fulfilment Allowed - You can allocate the line quantity even though other
lines in the order cannot be fully satisfied
Only Full Order Fulfilment Allowed - If any line in the order cannot be fully satisfied then
none of the lines in the Order will be included
Determined by Order Full Delivery Flag - If any line in an Order flagged as ‘Full Delivery’
cannot be fully satisfied then none of the lines in that Order will be included.  Any Order not
flagged as ‘Full Delivery’ will be treated as ‘Partial Fulfilment Allowed’

Availability Assembly Full Pick Only: ‘Check’ this checkbox if your policy is to only pick
Assembly Order lines when ALL the components are available.  If this is not checked then the
above ‘Partial order Fulfilment Allowed’ policy will be assumed.

Availability Jobs Full Pick Only: ‘Check’ this checkbox if your policy is to only pick Job Order
lines when ALL the components are available.  If this is not checked then the above ‘Partial order
Fulfilment Allowed’ policy will be assumed.

Schedule Horizon Days: Enter the number of days that the Constraint Scheduling process will
process.  If nothing is entered then all current and future loadings will be scheduled.

Display Schedule Inquiry: If this is 'checked' then an Inquiry Panel will appear at the bottom of
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the Scheduling screen.   The content of that display is defined by the queries entered into the next
two fields.

Schedule Resource Inquiry SQL: Enter the SQL query that will define the displayed fields and
format of the Inquiry Panel (shown at the bottom of the Resource Loading Board) whenever  a
Resource is selected

Schedule Order Inquiry SQL:  Enter the SQL query that will define the displayed fields and
format of the Inquiry Panel (shown at the bottom of the Resource Loading Board) whenever an
Order is selected

Sub Assembly Explosion Default: The selection here will be the default that is displayed in the
'Create Required orders' screen for Assembly Orders.  In that screen it allows you to not only
create the Assembly Order for the Selected Line(s) but also for Sub-Assemblies throughout the
product structure of the selected line(s).   The options are:

· No Explosion.  This denotes that only the selected line will be converted into an Assembly
Order

· Explode Source On Demand.  The selected line and all its lower-level sub Assemblies
whose Default Supply Method (as defined against the sub-assembly's Item Master  record)
is 'Source On Demand' will be converted into an Assembly Order and each will contain
reference to the Assembly Order of the selected line

· Explode All.  The selected line and all its lower-level sub Assemblies will be converted into
individual Assembly Orders and each will contain reference to the Assembly Order of the
selected line

Graphical Plant View Filename:  From the drop-down point to the location of your Graphical
Plant View Workflow.   This then informs screen Requirements>Graphical Plant View which
workflow to apply to the display.

Daily or Weekly: Choose either Daily or Weekly replenishment planning.

Use Item Site Lead Time for Replenishment: Tick this option to use Site Lead Time for
replenishment.  (Item Site records are created if either the Cost by Site or Auto Create Item Site
Records option is ticked in Item Rules).

Multi-Level Explosion: Tick this box to default the Multi-Level Explosion checkbox in Inventory
Replenishment screen

Buttons

Close: This will close the Replenishment Rules screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

12.10.4 Assignment Rules

This screen allows you to maintain Assignment Rules.  Assignment Rules allow you to define
defaults that will be used in the Assignment Board.  The following rule settings are available

Entry and Display fields
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Include Job Quotes in Assignments: Tick this box if you wish to include job quotes.

Default Job Duration Minutes: Enter the default number of minutes for job duration when
assigning jobs.

Job Duration Style: This tells the Assignment Board routine the style to use when assigning Job
Tasks. Select one of the following from the drop-down list:

· Default Minutes - The default minutes will be used.
· From Labour Lines - Use the time allocated to Labour lines in the Job task.
· From Task – Uses the estimated duration held against the task

Default Assembly Duration in Minutes: Enter the default number of minutes for assembly step
duration when assigning Assembly steps.

Assembly Duration Style: This tells the Assignment Board routine the style to use when
assigning Assembly steps.  Select one of the following from the drop-down list:

· Default Minutes - The default minutes will be used.
· From Labour Lines - Use the time allocated to Labour lines in the Assembly step.

Default Delivery Duration Minutes: Enter the default number of minutes for each delivery when
assigning Delivery orders.

Default Sales Duration Minutes: Enter the default number of minutes for each Sales Order when
assigning Sales orders.

Default Activity Duration Minutes: Enter the default number of minutes for each Activity when
assigning Activities.

Include Started Assignments in Shortages: Tick this box if you wish to include started
Assignments when calculating Shortages. Assignments are checked for shortages of materials in
chronological order taking into account the cumulative requirements of previous assignments for
the day.

How Timesheet entries are displayed on Board: This tells the Assignment Board routine how to
display actual Timesheet entries on the Board. Select one of the following from the drop-down list:

· No Actuals - No actuals will be displayed on the Board.
· Update Existing Assignments - The existing assignments will be updated to reflect actual

time spent.
· Create New Actual Assignments - Actuals will be displayed separately. The original

planned assignment is not affected.

Shift Assignments Logic if Timesheets update Assignments: (This rule applies only when
Timesheets are entered via Ostendo Freeway) This tells the Assignment Board routine how to
shift the assignments on the Board when actuals are updated against existing assignments. 
Select one of the following from the drop-down list:

· Shift Existing Assignments only - Only the updated assignment is shifted.
· Shift Existing and Following Assignments - The existing assignment and any

subsequent assignments for that resource will be offset based on the timing of the
assignment being updated

How Timesheet entries are shown on the Board if displayed: This tells the Assignment Board
routine how to display actual timesheet entries on the Board.  Select one of the following from the
drop-down list:

· Combined - The Timesheet entries are shown in the same band as the assignment in the
Board
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· Separate - The Timesheet entries are shown in a separate band in the Assignment Board.

Default Job Gap in Minutes: Enter the default number of minutes gap when auto assigning jobs
onto the Board.

Default Assembly Gap in Minutes: Enter the default number of minutes gap when auto assigning
Assembly tasks onto the Board.

Default Delivery Gap in Minutes: Enter the default number of minutes gap when auto assigning
Delivery orders onto the Board.

Default Sales Gap in Minutes: Enter the default number of minutes gap when auto assigning
sales orders onto the Board.

Auto Create Assignments from Job Tasks: This determines whether assignments are
automatically generated when resources are added to the Job Task Resource screen

Assembly Schedule Button Logic: This tells the Assignment Board whether and how
un-assigned work is scheduled when automated scheduling is required:

· No Button – No automated scheduling based on pre-assigned resources occurs 
· Assign from Step Resources – A button will appear at the top of the Un-Assigned

Assembly list which if clicked will create the assignments based on the pre-determined
resources linked to the Assembly step

Job Schedule Button Logic: This tells the Assignment Board whether and how un-assigned work
is scheduled when automated scheduling is required:

· No Button – No automated scheduling based on pre-assigned resources occurs 
· Assign from Task Resources – A button will appear at the top of the Un-Assigned Job list

which if clicked will create the assignments based on the pre-determined resources linked to
the Job task

· Assign from Job Header – A button will appear at the top of the Un-Assigned Job list which
if clicked will create the assignments based on the either the pre-determined employee
name or mobility team name assigned to the Job Header

Dynamic Assignment Captions: Tick this box if the Assignment Captions can change
dynamically based on changes to the values of fields included in the captions.

Job Tracking Colour From: Select one of the following:

· Job Task – Tracking colour follows the Tracking Colour from Job  Task. 
· Job Header – Tracking colour follows the Tracking Colour from Job Header.

Assembly Tracking Colour From: Select one of the following:

· Assembly Header – Tracking colour follows the Tracking Colour from Assembly Header. 
· Assembly Step – Tracking colour follows the Tracking Colour from Assembly Step.
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13 Purchasing

13.1 Suppliers

This screen allows you to create and maintain Suppliers in Ostendo.   

List Tab

Display fields

The displayed fields are taken from the Supplier information entered into the ‘Detail’ tab.   The
selection of which fields to display is at the user’s discretion.   To select the fields to display simply
‘right mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel you
can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Suppliers
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Suppliers screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Item.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Supplier from this table

Related: This will bring up a list of functions that are related to the Supplier.  You may open and
maintain information in those screens whilst still remaining in the Supplier screen.
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Reports: This will bring up a list of Reports that are related to the Supplier.  You can immediately
run the report whilst still remaining in the Supplier screen.

Detail Tab

Entry and Display fields

Supplier Name: This is mandatory entry and is only allowed during an Add transaction to enter the
name of the Supplier.  Duplicate Supplier Names are not allowed
You should be aware that, in Ostendo, the apostrophe (‘) is not allowed in ‘Key’ fields.  If the
Supplier Name contains an apostrophe (for example O'Brien) and it is keyed in then Ostendo will
replace it with a ‘backwards’ apostrophe (found on your keyboard to the left of the number 1 key).

Supplier Printout Name: This is the name that will print out on your Purchase Order and allows
you to enter a name (Example; Their Trading Name) rather than the above Supplier Name.  If you
leave this field blank then it will automatically be filled with the Supplier Name when you save the
record.

Postal Address: Enter the following information that applies to the Postal Address of the Supplier.
 No checks are made and these fields can be amended at any time.

· Address: Three lines are available for entry of the postal address of the site.  
· City: Enter the Town or City where this Supplier is located.
· State: Enter the State where this Supplier is located.
· Code: Enter the Postcode or ZIP Code where this Supplier is located.
· Country: Enter the Country where this Supplier is located.

Same as Postal Address: If this is ‘checked’ then the fields for the Physical Address cannot be
updated directly.  These are updated with the same data that you enter into the Postal Address
fields

Physical Address: Enter the following information that applies to the physical Address of the
Supplier.  No checks are made and these fields can be amended at any time.

· Address: Three lines are available for entry of the postal address of the site.  
· City: Enter the Town or City where this Supplier is located.
· State: Enter the State where this Supplier is located.
· Code: Enter the Postcode or ZIP Code where this Supplier is located.
· Country: Enter the Country where this Supplier is located.

Contact Details: Enter the following contact information that relates to the Supplier.  Separate
detailed information can be entered for multiple contacts.  No checks are made and these fields
can be amended at any time.

· Phone: Enter the Telephone Number of the Supplier
· Website: Enter the Internet web address of the Supplier
· Fax: Enter the Facsimile Number of the Supplier
· Email: Enter the main email address of the Supplier
· Mobile: Enter the Mobile Telephone Number of the Supplier
· Primary Contact: from the drop-down list select the Primary Contact from the list of

contacts against this Supplier.  To create a Contact you can click on the icon to the right
of this field or click on the ‘Related’ button and select Supplier Contacts’.

General Settings Tab

Billing Supplier: If payments are made to a Supplier Name other than the above Supplier then ‘
check’ this checkbox.  This will activate the next field.
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(Billing Supplier): If the above checkbox is ‘checked’ then, from the drop-down list select the
Billing Supplier. 

Status: From the drop-down list select the Status of this Supplier.  The options are:
· Active
· Inactive

A Supplier with a Status of Inactive will not be shown on the drop-down list when creating a
Purchase Order.

Supplier Type: This is prefilled with the default Supplier Type as entered into the Supplier Type
maintenance screen.  You may amend this Type by clicking on the drop-down icon and selecting
an alternative Supplier Type.  Supplier Types can be maintained by either clicking on the icon to
the right of this field or click on the ‘Related’ button and select ‘Supplier Types’.

Supplier Region: From the drop-down list select the region that covers this Supplier.  You may
maintain Supplier Regions by either clicking on the icon to the right of this field or click on the ‘
Related’ button and select ‘Supplier Regions’.

Supplier Code: From the drop-down list select the Code linked to this Supplier.  You may maintain
Supplier Codes by either clicking on the icon to the right of this field or click on the ‘Related’ button
and select ‘Supplier Codes’.

Shipping Method: From the drop-down list select the normal Shipping Method that this Supplier
uses.  You may maintain Shipping Methods by either clicking on the icon to the right of this field or
click on the ‘Related’ button and select ‘Supplier Shipping Methods’.

Buyer: From the drop-down list select the Buyer that is normally related to this Supplier.  You may
maintain Buyers by selecting General>Employees and identifying the Employee as a ‘Buyer’

Terms: From the drop-down list select the Credit Terms that apply to this Supplier.  You may
maintain Credit Terms by selecting File>Financial Configuration>Credit Terms

Tax Group: From the drop-down list select the Tax Group that applies to this Supplier.  The Tax
Group of this Supplier combined with the Tax Group of the Item or Descriptor being purchased
defines the rate of Tax that applies.  You may maintain Tax Group by selecting File>Financial
Configuration>Tax Groups

Foreign Currency: If you using multi Currency in Ostendo then ‘check’ this checkbox.  If you are
not using multi-currency then Ostendo will assume the Regional Settings of your Computer.

Currency Code: This will be activated if the previous field is ‘checked’.  In this instance select the
Supplier’s Currency from the drop-down list.  Currencies are maintained via File>Financial
Configuration>Currency Codes

Suppler is a Sub-Contractor: Tick this box if this supplier is also a sub-contractor.

Payment Settings Tab

Bank Account Name: Enter the Bank Account Name of this Supplier.  This will be used when
making Payments to this Supplier

Bank Account Number: Enter the full number of the Supplier’s Bank Account.  This will be used
when making Payments to this Supplier
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Company Number: Enter a number for this Company.  No checks are made on this entry.

Outputs Tab

Purchase Email Address: If you email the Purchase Order to an email address other than the
Contact Details Address entered above then enter that address here.  This will take preference
over the Supplier's base email address

Additional Fields Tab

If you have defined Additional Fields against the Supplier (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

  
Notes: Two types of Notes are available:

General Notes: You can enter unlimited amount of Notes that are related to this Supplier.
These notes will be available wherever the Supplier is reported.  Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Mobility Notes: This is similar to General Notes. 

This is to provide you the flexibility to specify which set of notes (General or Mobility) will be
displayed as part of Supplier information on the mobility device. 

Messages: You can enter a message here that will appear whenever this Supplier is used in
the following areas

Supplier: Message will be displayed in the Operations Centre for this Supplier.
Order: Message will appear at the top of the Order Lines screen
Invoice: Message will appear at the top of the Invoice Lines screen

Buttons

Close: This will close the Supplier screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up a blank screen for entry of a new Supplier record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Supplier.  You may open and
maintain information in those screens whilst still remaining in the Supplier screen.
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Reports: This will bring up a list of Reports that are related to the Supplier.  You can immediately
run the report whilst still remaining in the Supplier screen.

13.1.1 Supplier Properties

This screen allows you to define properties that are specific to a Supplier.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Suppliers.

Display fields

The displayed fields are taken from the Supplier Details.  The selection of which fields to display
here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Supplier Properties screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Supplier Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab
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Entry and Display fields

Supplier Name: Display only field showing the Supplier selected in the List screen

Property: From the drop-down list select the Standard Property against which a value specific to
this Supplier will be made.

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Copy to PO Lines: Tick this box if the property is to be copied to Purchase Order Lines.

Buttons

Close: This will close the Supplier Properties screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Supplier Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Supplier Property record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Supplier Property record.

13.1.2 Supplier Documents

This screen allows you to define documents, etc that are specific to a Supplier.    

List Tab

Display fields

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Supplier to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Supplier Documents screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Supplier Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Supplier record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name of the document that you are creating in this Document-
Supplier linkage.  No checks are made on the entry.

Document Type: Prefilled with ‘Supplier’

Linked to: From the drop-down list select the Supplier that uses this document

Copy to Purchases: ‘Check’ this checkbox if you want the contents of this document to be copied
to Purchase orders

Correspondence: Tick this box if the document is to be treated as correspondence in the
Operations Centre.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons
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Close: This will close the Supplier Documents screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Supplier Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Supplier Documents record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

13.1.3 Supplier Images

This screen allows you to define images that are specific to a Supplier.    

List Tab

Display fields

Image Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Supplier to which this image relates.

File Name: This is the full path name of the image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Supplier image screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Supplier images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel
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Delete: This enables you to delete the selected image from a Supplier record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Image Name: Enter the name of the document that you are creating in this image - Supplier
linkage.    No checks are made on the entry.

Image Type: Prefilled with ‘Supplier’

Linked to: From the drop-down list select the Supplier that uses this image

Copy to Purchases: ‘Check’ this checkbox if you want the contents of this image to be copied to
Purchase orders

Image Details: locate the full path name of the image.  It should be noted that any file extension
recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Image: This panel displays the selected Image.

Buttons

Close: This will close the Supplier image screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Supplier images.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Supplier image record or the last time the ‘Save’ Button
was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

13.1.4 Supplier History Notes

This function allows you to link multiple time-stamped notes to a Supplier record.    

List Tab

Display fields

The displayed fields are taken from the Supplier master record.  The selection of which fields to
display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
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· Define the sort sequence of the records by going to the lower panel and dragging the field
from ‘Available Fields’ to ‘Sort By’. 

· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Supplier History Notes screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Supplier to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Mobile Employee : Select the Mobile employee name to make this History Note available to that
employee.

Call Classification: From the drop-down list select a Classification under which you wish to store
this History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.
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(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.   Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this Supplier is displayed in the lower part of the screen.   Each
record will also have the first 3 lines of the notes displayed.   To view the full Notes simply click on
the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Supplier History Notes screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Supplier History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Supplier History Notes record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

13.1.5 Supplier Contacts

This screen allows you to define multiple contacts and their details at a Supplier site.  The Supplier
Contacts screen is accessed from the Supplier’s screen where you select the ‘Related’ button.
The contact(s) are specific to the current selected Supplier.   This function is also fully supported
under the CRM Menu where you can maintain contacts across Customers, Suppliers, Prospects,
Others.

List Tab

This displays the current list of Suppliers.

Display fields

The displayed fields are taken from the Supplier Details.  The selection of which fields to display
here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options
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Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Supplier Contacts screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Supplier Contacts.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Contact Name: This is only accessible during an ‘Add’ transaction.   Enter the name of the
Contact.  No checks are made on the entry an duplicates are not rejected.

Contact Type: Display only field showing the Contact Type ‘Supplier’

Company Name: Display only field showing the current selected Supplier

Title: Enter the tile (Mr, Mrs, Ms, etc) that applies to the Contact.  No validation checks will be
carried out on this entry

First Name: Enter the First or Forename of the Contact.  No validation checks will be carried out
on this entry

Last Name: Enter the Last or Surname of the Contact.  No validation checks will be carried out on
this entry 

Position: Enter the current position being held by the Contact.  No validation checks will be carried
out on this entry

Phone: Enter the telephone number of the Contact.  No validation checks will be carried out on
this entry

Fax: Enter the Facsimile Number of the Contact.  No validation checks will be carried out on this
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entry

Mobile: Enter the Mobile Telephone Number of the Contact.  No validation checks will be carried
out on this entry

Email: Enter the Email address of the Contact.  No validation checks will be carried out on this
entry

Notes: You can enter unlimited amount of Notes that are related to this Contact.  These notes will
be available wherever the Employee record is accessed.  Whenever you click on this field an icon
will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.   Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

Buttons

Close: This will close the Supplier Contact screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Supplier Contact record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Supplier Contact record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Supplier Contact record.

Outlook: Filter the Contacts 'List' screen to display those records that you wish to add to your
Outlook contacts then click the 'Outlook' Button.  Upon confirmation that you wish to add these
displayed contacts Ostendo will add them to your Outlook Contacts list.

13.1.6 Location Map

This will display a panel in which you can select either Map or Directions

If you select 'Map' Ostendo will use the mapping system identified in System Settings (this is
initially set to use Google Maps) and, using the Supplier's Address, open up the Google Map at
that address

If you select 'Directions' Ostendo will use the mapping system identified in System Settings and
provide directions to travel from the address set up in System Settings to the Supplier's Address

13.2 Supplier Catalogues

Supplier Catalogue Items can be called up in Sales Orders, Job Orders, and Purchase Orders
where the contents of the Catalogue are displayed.  The user makes selections (with quantities) of
lines from the Catalogue.  This selection(s) are then copied to the Order.  

This routine allows you to import and maintain those Supplier Catalogues.  Additionally you have
the option to hold selected Catalogue Items as Ostendo Items.  Whenever a Catalogue Item is
selected against Sales, Assembly, or Purchase Order Lines and it exists as an Ostendo Item the
program will display the Item’s current Ostendo Stock level.  The User has the option to use that
stock or continue as a Catalogue Item.  If the Catalogue Item option is selected then Ostendo will
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create a ‘Source On Demand’ record to satisfy the Order.  This ‘Source On Demand’ record can
be converted into a Purchase Order using the Requirements>Create Required Orders function

It is worth noting how the Importing Function interacts with Ostendo’s Item Master file:

· If an Ostendo Item Master record contains a Primary Supplier that matches the Catalogue
Supplier/Supplier Item Code then the imported record (shown in the ‘Lines’ view - below)
will have its ‘Linked Item Code’ field updated to include the Ostendo Item Code

· In the Ostendo Item’s Pricing screen (Pricing>Item Pricing - Buy Prices tab) if a record
contains a Buy Price Supplier whose Supplier Item Code and Supplier Unit matches the
Catalogue Supplier, Supplier Part Number, and Unit then the imported record  (shown in
the ‘Lines’ view - below) will be updated to include the Ostendo Item Code that relates to
this Item/Unit.

List Tab

This shows a list of Supplier Catalogues currently in the system.

Display fields

Catalogue Number: Display only field showing the system generate Identity Number of the
Catalogue

Supplier: Display only field showing the Supplier of this Catalogue

Catalogue Name: Display only field showing the Name given to the Catalogue in the ‘Details’
screen.

Status: Display only field showing the current status of the Catalogue.  The options are ‘Active’ or ‘
Inactive’

Description: Display only field showing the description of the Catalogue as entered into ‘Details’
screen

Intro Date: Display only field showing the date when the Catalogue was introduced.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Lists whose
status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon
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Buttons

Close: This will close the Supplier Catalogue screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Supplier Catalogue.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Supplier Catalogue from this table

Related: This will bring up a list of functions that are related to the Supplier Catalogue.  You may
open and maintain information in those screens whilst still remaining in the Supplier Catalogue
screen.

Reports: This will bring up a list of Reports that are related to the Supplier Catalogue.  You can
immediately run the report whilst still remaining in the Supplier Catalogue screen.

Detail Tab

Entry and Display fields

Catalogue Number: This is a system maintained unique Identity for the Catalogue.

Introduction Date: This is the date when this Catalogue was created or maintained.  When
creating a new Catalogue it is prefilled with the system date.  You may amend this date at any time
by either overtyping the date or clicking on the drop-down calendar and selecting the date.

Status: Select the current status from the drop-down list.  The options are ‘Active’ or ‘Inactive’

Name: Enter a brief identifying name for the Catalogue.  No validation checks will be made on the
entry.

Cost Centre: From the drop-down list select the Cost Centre against which purchases made from
the catalogue will be posted.  Cost Centres are maintained via General>Cost Centres

Description: Enter a brief description of the Catalogue.  A longer description can be entered into
the Notes (see below)

Catalogue Supplier: From the drop-down list select the Supplier of this Catalogue

Last Date Catalogue was updated: Display only field showing the date when this Catalogue was
last updated

Currency Code: Display only field showing the Currency used by this Supplier

Catalogue Details: If the Catalogue Codes match any Item Codes or if there is a
matchingSupplier Buy Price record then you have the option to update various prices as follows:

Update Item Code Standard Sell Price from the Catalogue:  ‘Check’ this checkbox if
you wish the Import to update the Standard Sell Price of the matching Item in inventory.
Update Item Code Standard Buy Price from the Catalogue:  ‘Check’ this checkbox if
you wish the Import to update the Standard Buy Price of the matching Item in inventory.
Update Item Code Standard Cost from the Catalogue:  ‘Check’ this checkbox if you
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wish the Import to update the Standard Cost of the matching Item in inventory.
Contents not Purchased:  ‘Check’ this checkbox if you are using this Supplier Catalogue
as a template for quoting.   If the Quote is turned into an Order then the Supplier
Catalogue Item will NOT generate a Request to Purchase

(Import / Update / Delete) Catalogue From File: Clicking on this button will bring up a
sub-routine where you can match the .csv or .xls file to that required for the import process.  The
following steps are carried out.   You should note that this uses a standard data Importing function
that is used throughout Ostendo; therefore not all entry fields are required.  When importing
Supplier data the following steps are used:

Step 1: Click on the appropriate ‘Radio’ button to select whether the data being imported is
in a .csv or a xls. File format then click the ‘Next’ button.  Note: The ‘Load Specification’
button is described in Step 5

Step 2: Point to where the source file resides and informs the import routine as to the
following conditions in that file:

Start at Row - From which row in the file is the importing to commence
Field Names - tell the program which row in the import file contains headings
Record Separator - unless you have defined otherwise leave this as CRLF
Text Qualifier - unless you have specifically defined otherwise leave this as “

Click the ‘Next’ button.  

Step 3: You should now match fields in your .csv or .xls file with the fields required in
Ostendo.  These are:

Catalogue Code - The Supplier’s Item Reference Number
Code Description - Description of the Supplier’s Item
Code Unit - The Unit of Measure for the Item
Tax Group - The Tax Group that relates to this Item
Analysis Group - The Analysis Group that relates to this Item
Standard Sell Price - The price that the Supplier suggests you sell the Item
Standard Buy Price - The Standard price that the Supplier is selling the Item
Standard Cost - The nominal Cost (incl. carriage, etc. to Purchase this Item)
Linked Item Code - Your Ostendo Item Code that relates to this Item
LeadTime - The nominal Leadtime for Purchasing this Item
Manufacturer - The Manufacturer of the supplied Item
BrandName - The Brand Name to which the Item is related
ModelName - The Model Code to which the Item is related
Specification Web Link - Web Link to the Manufacturer/Brand/Model Spec.
Alternate Code - An Alternative Item Code that could be substituted
CodeNotes - Extended Notes that are specific to this Item
SalesNotes - Extended Notes that will be copied to Sales Orders
JobNotes - Extended Notes that will be copied to Job Orders
PurchaseNotes - Extended Notes that will be copied to Purchase Orders

Click the ‘Next’ button.  

Step 4: Define the format of the fields in the Import File.   This allows the import routine to
convert it from the format in your Import file to the format defined in the Regional Settings
of you computer.

Step 5: This screen confirms your settings.  Ensure that all the settings are correct.  

At this point you will see that the ‘Load Specification’ button has changed to ‘Save
Specification’.  If you click on this button then you can save the results of Steps 1 through
5 and use this in future rather than go through each step in turn.
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Click the ‘Execute’ button to perform the import.  You will then be sent to the Lines Panel
in Ostendo 

Currency Code: Display only field showing the Currency of the Supplier’s Catalogue.

Notes Tab

Notes: You can enter unlimited amount of Notes that are related to this Supplier Catalogue. 
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Pricing Levels Tab

This area enables you to identify the Item’s Sell Prices based on your Customer’s Pricing Level.

Price Level: From the drop-down list select the Pricing Level.   Pricing Levels are user-defined in
Pricing>Settings>Price Levels and represent the level of pricing offered to (say) Retail, Trade,
Wholesale, etc

Price Calculation Cost Method: Against each Item the user can - for each Price Level - define a
sell price based on the Supplier Catalogue supplied prices using the following criteria:

Std Sell Price
Std Sell Price + $ Value
Std Sell Price - $ Value
Std Sell Price + % Value
Std Sell Price - % Value
Std Buy Price + $ Value
Std Buy Price - $ Value
Std Buy Price + % Value
Std Buy Price - % Value
Std Cost + $ Value
Std Cost - $ Value
Std Cost + % Value
Std Cost - % Value

% Value or $ Value: Dependant upon what Price Calculation Cost Method was selected the
column title will change between ‘% Value’ and ‘$ Value’.   The entry into this field represents that
Value.    

Buttons

Close: This will close the Supplier Catalogue screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel
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Related: This will bring up a list of functions that are related to the Supplier Catalogue.  You may
open and maintain information in those screens whilst still remaining in the Supplier Catalogue
screen.

Reports: This will bring up a list of Reports that are related to the Supplier Catalogue.  You can
immediately run the report whilst still remaining in the Supplier Catalogue screen.

Lines Tab

This screen shows a list of all the Codes in the selected Catalogue.  In addition to
Importing/updating the Supplier Catalogue you have the option to select specific lines so that the
Import routine will also create them as Ostendo Items.    Within this screen you also have the
option to manually amend or delete lines in addition to adding new lines.

Whenever a Catalogue Item is selected against Sales, Assembly, or Purchase Order Lines the
program will determine if it also exists as an Ostendo Item and, if so, will display the current Stock
level.  The User has the option to use this stock or continue as a Catalogue Item.  If the Catalogue
Item option is selected then Ostendo will create a ‘Source On Demand’ record to satisfy the Order.
 This ‘Source On Demand’ record can be converted into a Purchase Order using the
Requirements>Create Required Orders function

Entry and Display fields

Selected: ’Check’ this checkbox if you want this Supplier Catalogue Item to also exist as an
Ostendo Item.  Note: If the line already has a ‘Linked Item Code’ then this field is disabled for this
line.

Code: The Catalogue Code as copied from the Supplier Catalogue

Description: The description as copied from the Supplier Catalogue

Unit: The base unit as copied from the Supplier Catalogue

Category: The Category under which this Item is held

Buy Price: The Buy Price (your Purchase Price) as copied from the Supplier Catalogue

Sell Price: The Sell Price (The Supplier’s recommended Sell Price) as copied from the Supplier
Catalogue

Standard Cost: The nominal Cost (incl. carriage, etc. to Purchase this Item)

Linked Item Code: Your Ostendo Item Code that relates to this Item

Manufacturer: The Manufacturer of the supplied Item

Brand: The Brand Name to which the Item is related

Model: The Model Code to which the Item is related

Substitute Code: An Alternative Item Code that could be substituted

Web Link: Web Link to the Manufacturer/Brand/Model
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Tax Group: The Tax Group as copied from your Import file

Analysis Group: The Analysis Group as copied from your Import file

Notes: Extended Notes that are specific to this Item

Unit Weight: Enter the weight of the Item.  No checks are made on this entry.  The unit of Weight
is defined in File>System Configuration>System Setup

Unit Volume: Enter the volume of the Item.  No checks are made on this entry.  The unit of
Volume is defined in File>System Configuration>System Setup

Unit Area: Enter the Area of the Item.  No checks are made on this entry.  The unit of Area is
defined in File>System Configuration>System Setup

Buttons

Select All Codes: Clicking this button will select all the displayed records.  Hint: You can ‘filter’ the
records to only show a selected group (For example: A specific Category) and then clicking this
button to select only this Category for conversion to Ostendo Item Codes

Deselect All Codes: Clicking this button will de-select all the displayed records.  Hint: You can ‘
filter’ the records to only show a selected group (For example: A specific Category) and then
clicking this button to de-select this Category only.

Convert Selected Codes to Inventory Items: Clicking this button will immediately convert the
selected Catalogue Items into Ostendo Item Codes.

Close: This will close the Supplier Catalogue screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Catalogue Code Line

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Catalogue Code Line

Related: This will bring up a list of functions that are related to the Supplier Catalogue.  You may
open and maintain information in those screens whilst still remaining in the Supplier Catalogue
screen.

Reports: This will bring up a list of Reports that are related to the Supplier Catalogue.  You can
immediately run the report whilst still remaining in the Supplier Catalogue screen.

13.3 Supplier Sub-Contractors

Supplier Sub-Contractors screen allows you to define a set of rules (via a matrix) to determine
what transactions could be generated based on a combination of sub-contractor employee, Labour
Code, Descriptor Code, and Effective Date.

For example, if you have a sub-contractor performing jobs or assemblies on your behalf, the times
entered by the subcontractor employee could be used to raise Purchase Receipts transactions
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(instead of timesheet lines which are for your employees only).

More information on this topic an be found here:  
http://ostendo.info/downloads/ostendo/Freeway_For_Subcontractors_Explained.pdf 
 

List Tab

This shows a list of all Suppliers where the "Supplier is a Sub-Contractor" box is ticked.
Display fields

Supplier: Display only field showing the Suppliers who are also sub-contractors.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: Not applicable to the List panel.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Supplier: This is a display-only field.

Times tab

Times tab entries are used to translate timesheetlines recorded by subcontractor employees into
Purchase Receipt or Purchase Invoice lines.

Sub-Contractor Employee: (Optional) Select a name from the drop-down list. Different
subcontractor employees can generate different Descriptor codes/Transaction styles.
If left blank, then these records applies to all subcontractor employees.

Labour Code : Select a Labour Code from the drop-down list.

Descriptor Code for Generated Transaction : Select the Descriptor Code that the above Labour
Code will be translated to when a Purchase Receipt or Purchase Invoice is created.
This is required as Purchase receipt/invoice lines cannot have Labour Codes.

Effective Date From : Select the effective-from date.

Generated Transaction Style : Select the style from the drop-down list. Options are:

None - The subcontractor times are not translated into
anything.

http://ostendo.info/downloads/ostendo/Freeway_For_Subcontractors_Explained.pdf
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Purchase Receipt for Order : - Times recorded are translated to Purchase
Receipt lines with the specified Descriptor Codes for the associated Job/Assembly Order.

Purchase Receipt Only : - Times recorded are translated to Purchase
Receipt lines with the specified Descriptor Codes.

Purchase Invoice only : - Times recorded are translated to Purchase
Invoice lines with the specified Descriptor Codes

Quantities tab

Quantities tab entries are used to define the types of quantities to be recorded when work is
performed by the subcontractor (e.g. lineal metres of carpet laid).
Quantities data captured could be used for analysis of productivity rates and costings.

Sub-Contractor Employee: (Optional) Select a name from the drop-down list.

Descriptor Code used for Quantity Capture : Select the Descriptor Code defined to be used for
quantities capture.

Effective Date From : Select the effective-from date.

Generated Transaction Style : Select the style from the drop-down list. Options are:

None - The subcontractor quantities are not translated
into anything. (For statistical purposes only).

Purchase Receipt for Order : - Quantities recorded are translated to Purchase
Receipt lines with the specified Descriptor Codes for the associated Job/Assembly Order.

Purchase Receipt Only : - Quantities recorded are translated to Purchase
Receipt lines with the specified Descriptor Codes.

Purchase Invoice only : - Quantities recorded are translated to Purchase
Invoice lines with the specified Descriptor Codes

Claims tab

Claims tab entries are used to define the types of claims that could be submitted by the
subcontractor.

Sub-Contractor Employee: (Optional) Select a name from the drop-down list.

Claims Style: Select one of the following options - 

No job Entry: No Issue will be recorded against the Job. Therefore this descriptor
should NOT be linked to Sub Contractor Clearing Cost Centre as you are treating this as an
expense and will not be recovering it.

Job Cost & Price 
(When both Claim Markup & Claim Qty fields are completed): A new
Line will be added to the job and issued with a unit cost based on the Qty
entered in Freeway. The Sell price of the line will be derived from the Cost
plus the Claim Markup % specified in this screen

(When both Claim Markup & Claim Qty fields are blank. This setting
has the same result using Job Cost & STD Price)
A new Line will be added to the job and issued with a unit cost based on
the Descriptor / Supplier Buy Price. The sell price will be based on the
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Descriptor sell price rule.
 
(When Claim Markup is blank & Claim Qty is ticked)
A new Line will be added to the job and issued with a unit cost based on
the Descriptor / Supplier Buy Price. The Sell price will be equal to the cost
(as no Markup was applied)

(NB: Do not set a Claim Markup without ticking Claim Qty as this is
ignored)

Job Cost & STD Price: (Not to be used with Claim Markup and Claim Qty) A
new line will be added to the job and issued with a cost based on the Descriptor /
Supplier Buy Price whilst the Sell Price will based on the Descriptor sell price rule.

Job Cost Only: A new Line will be added to the job and issued for this descriptor
to record the Cost based on the recorded Qty if the “Claim Qty is used as Cost” is
ticked’, otherwise the Descriptor / Supplier Buy price is used. Markup is ignored as
the price be automatically overridden to Zero

Job Price Only: A new line will be added to the job and issued for this descriptor
Zero cost. If the “Claim Qty is used as Cost” is ticked, The sell Price will be
calculated from the recorded qty plus the Claim Markup %. If not ticked, the sell
price will come from the Descriptor sell price rule. (NB: As with No job Entry, this
descriptor should NOT be linked to Sub Contractor Clearing Cost Centre as you
expensing this only and not costing it to the job)

Job STD Price Only: A new Line will be added to the job and issued with a Zero
Cost, whilst the Sell Price will based on the job customers sell price.

Claim Mark-Up %: Enter the mark up percentage for the claim. 

Claim Quantity is used as Cost: Tick this box if the claim quantity is used as cost.

Descriptor Code used for Claim : Select the Descriptor Code to be used for the claims.

Effective Date From : Select the effective-from date.

Generated Transaction Style : Select the style from the drop-down list. Options are:

None - The subcontractor claim is not translated into
anything.

Purchase Receipt for Order : - Claims recorded are translated to Purchase
Receipt lines with the specified Descriptor Codes for the associated Job/Assembly Order.

Purchase Receipt Only : - Claims recorded are translated to Purchase
Receipt lines with the specified Descriptor Codes.

Purchase Invoice only : - Claims recorded are translated to Purchase
Invoice lines with the specified Descriptor Codes

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.
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Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

13.4 Supplier Contracts

Supplier Contracts screen allows you to setup Supplier Purchasing Contracts in Ostendo
allowing for special pricing for specific items / descriptors based on either an open or
fixed period of time. A purchase order line can be linked to a specific contract for that
Supplier / Code combination. 

When the user enters a PO Line, Ostendo will check to see if there are any contracts
in force for this supplier / item or descriptor combination and advise the user by way
of an indicator message

If the user then selects the contract and links it to this line, that contracts pricing will
override the existing default price. Further to this the Ext Nett Value will update the
Contract Value to Date on the Contract. This will enable monitoring progress of this
contract. 

There is also a Tolerance % on the Contract which allows a threshold all linked PO’s
may exceed the Contract Value in total.
Eg: Contact Value = $200 and Tolerance = 10%, therefore Ostendo will allow the
Contract value to date to get to $210 before preventing further lines being linked to
that contract.

List Tab

This shows a list of all Supplier Contracts created.

Display fields

ContractNo. : Display only field showing the Supplier Contract number.

Supplier: Display only field showing the Supplier for the contract.

Contract Status : Shows the status of the contract. (Active or InActive)

Contract Term : Shows the Term Style of the contract. Either "Open Term"  or  "Fixed Term". 

Contract Value Style : Value Style is either based on "Total Quantity" or "Total Amount".

Contract Start : If Fixed Term contract, then this will show the Start Date of the Contract.

Contract Finish : If Fixed Term contract, then this will show the Finish Date of the Contract.
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Contract Value : Shows the total value of the contract.

Contract Value Todate :  Shows the value to date.

Code Type : Select either Item or Descriptor.

Code : Select the code from the drop-down list.

Description: This is a display-only field.

Unit : This is a display-only field.

Unit Price : Enter the unit price here.

Currency Code : This is a display-only field.

Tolerance % : This is the percentage of total contract value which is allowed to be exceeded by -
based on the total value of all PO's linked to this Supplier Contract  

Reference : Enter any reference information here.

Notes : Enter notes here.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: Not applicable to the List panel.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

ContractNo. : Display only field showing the Supplier Contract number.

Supplier: Select the Supplier for the contract.

Contract Status : Select the status of the contract. (Active or InActive)

Contract Term : Select the Term Style of the contract. Either "Open Term"  or  "Fixed Term". 

Contract Value Style : Select the value style for the contract. Value Style is either based on "Total
Quantity" or "Total Amount".
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Contract Start : If Fixed Term contract, then select the Start Date of the Contract.

Contract Finish : If Fixed Term contract, then select the Finish Date of the Contract.

Contract Value : Enter the total value of the contract.

Contract Value Todate :  Display-only field showing the contract value to date.

Code Type : Select the code type (Item Code or Descriptor Code)

Description : Display-only field showing the description of the item/descriptor

Unit : Select the unit of the item/descriptor

Unit Price : enter the unit price for this item.

Currency Code : Enter the currency code applicable 

Tolerance % : Enter the percentage of total contract value which is allowed to be exceeded by -
based on the total value of all PO's linked to this Supplier Contract  

Reference :  Enter any relevant references here.

Notes :  Enter any relevant notes here.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

13.5 Purchase Orders

This screen allows you to create and maintain Purchase Orders.   

List Tab

Display fields

The displayed fields are taken from Purchase Order information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
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· Click the ‘Save’ Button when done.

Note: If you select the CURRENTDUECOLOUR field then the field will show colours relating to the
Due Date of the Order compared to today's date.  The displayed colours are:

· Red - Overdue
· Orange - Due Today
· Yellow - Due Tomorrow

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Purchase
Orders whose status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Purchase Order screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for entry of the following information that is required when creating
a new Purchase Order

Supplier:  From the drop-down list select the Supplier against who this Purchase Order is
being created.  If the Supplier does not currently exist in the database you have the option
to type in a Supplier Name and - upon exiting this field - a panel will appear asking if you
wish to create the Supplier record.  If you confirm this a Supplier Maintenance screen will
appear.  After you have completed the creation details you will be returned to this screen.
Order Date: The Date that the Order was issued.  This is prefilled with system date but
can be amended by selecting the date from the drop-down calendar
Required Date: The Date when the Order is required.  This is prefilled with system date
but can be amended by selecting the date from the drop-down calendar
Create New Purchase Order: If this radio button is ‘checked’ then the next field should be
completed

Purchase Type: From the drop-down list select the Purchase Type.   Purchase
Types are user-defined and maintained under Purchasing>Settings>Purchase
Types
Order Number: If the Purchase Ordering numbering is manual (as defined
against the Purchase Type) then this field will become active.  You are required to
enter a Purchase Order Number before you are allowed to proceed

Copy from another Purchase Order: If this radio button is ‘checked’ then the next field
should be completed

Select Existing Order: From the drop-down list select the Purchase Order that is
to be used as the basis for creating this Purchase Order
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Pricing Method: From the drop-down list select the method by which the copied lines will
be priced.   The options are:

Re-Calculate Prices: which uses the Buy Prices in force at the current date, or
Existing Prices: which copies the prices from the order being copied

Reverse Quantities: If this is 'checked' then the original Order Quantities will be copied
but with a reversed sign.  This is useful when raising a new Purchase Order to facilitate
return to a Supplier

Buttons
Create: Click the ‘create’ button to take you to the ‘Details’ tab for entering further
information.
Cancel: Click the ‘cancel’ button to exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Purchase Order from this table

Related: This will bring up a list of functions that are related to the Purchase Order.  You may open
and maintain information in those screens whilst still remaining in the Purchase Order screen.

Reports: This will bring up a list of Reports that are related to the Purchase Order.  You can
immediately run the report whilst still remaining in the Purchase Order screen.

Print: This will generate and print the current Purchase Order

Detail Tab

Entry and Display fields

Order Number: Display only field showing the Order Number.  During an ‘Add’ transaction an
Automatically generated number is not allocated until the ‘Save’ button is pressed.

Order Date: This is prefilled with the system date.  You can amend the date by either overtyping
the date or selecting the date from the drop-down calendar.

Status: During Purchase Order creation this is prefilled with the status defined against the
Purchase Type.  You can amend this status by selecting the required status from the drop-down
list.  The options are:

· Planned
· Open
· Finished
· On-Hold
· Closed

Description: Enter a brief description of the Purchase Order.  A longer description can be entered
into the ‘Notes’ field at the bottom of the screen.  No checks are made on the entry

Purchase Type: Display only field showing the Purchase Type selected during order creation or
the Purchase Type of the Order copied during Order creation.

Creation Style: System maintained field indicating from where the order was created.  The display
options are:

Generated - created from ‘Replenishment’ routine or ‘Order on Demand’
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Manual - Manually entered here

Print Status: Defines the current print status of the order.  If the Purchase Order is printed this will
be set to ‘Printed’ by the print run and will not appear on the list of Purchase Orders yet to be
printed. You can reset it to ‘Not Printed’ from the drop-down list if required.

Tracking Code: From the drop-down list select the Tracking Code.  Tracking Codes are user
maintained (Purchasing>Settings>Purchase Tracking) and enable you to track your Purchase
Orders and filter views or reports by this Code.

Site name: From the drop-down list select the company site. 

Order Settings Tab

Tax Group: This defaults to the Tax Group held against the Supplier but you may amend this from
the drop-down list and select the Tax Group that applies to this Purchase Order.  This Tax Group
combined with the Tax Group of the Item or Descriptor being purchased defines the rate of Tax
that applies.  You may maintain Tax Group by selecting File>Financial Configuration>Tax Groups

Buyer: This defaults to the Buyer held against the Supplier but you may amend this from the
drop-down list of Buyers. 

Shipping Method: This defaults to the Shipping Method held against the Supplier.   You can
change this method by clicking on the drop-down icon and selecting the Shipping Method that you
wish to apply to this Order. 

Credit Terms: This defaults to the Credit Terms held against the Supplier.  You can amend the
Credit Terms by clicking on the drop-down icon and selecting the Terms that apply to this Order. 

Required Date: This is prefilled with the system date.  You can amend the Order Required date by
either overtyping the date or selecting the date from the drop-down calendar.

Order Properties: If you click on this button then a panel will appear for you to attach properties
that are specific to this Purchase Order.  For more information on Purchase Order Properties see
separate entry in this Guide

No Expediting of this Order: The Inventory Replenishment routine has  an option to 'Expedite
Purchase Orders' which means that it will assume that a  Purchase Order's required date can
potentially be moved to satisfy replenishment demands.  If that is not the case for this specific
Order then 'check' this checkbox

Currency Code: This is only visible if the Supplier uses a Foreign Currency.  When displayed it
shows the Currency Code taken from the Supplier record.  It is for information only and cannot be
changed

Exchange Rate: This is only visible if the Supplier uses a Foreign Currency.  When displayed it is
prefilled with the Exchange Rate held against the above Currency.  It can be amended here, if
required, and made specific to this Purchase Order.

Additional Fields Tab

If you have defined Additional Fields against the Purchase Order (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
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· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Overrides Tab

Override Locations: If this is 'checked' then you may override the Warehouse/Location that
will apply to this Order

Warehouse: This is prefilled with the default Receipt Warehouse for this Order.  You can
amend this by clicking on the drop-down list to select the Warehouse into which the Items are
to be received.  

Location: This is prefilled with the default Receipt Location - within the above Warehouse for
this Order.  You can amend this by clicking on the drop-down list to select the specific Location
into which the Items are to be received.  

Financial Tab

Financial Category: From the drop-down list select the Financial Category for this order. This
is relevant only if Ostendo is linked to an external General Ledger system

Default Allocation Type:Select one of the options: Default / Job Order / Assembly Order / Cost
Centre.

Allocation Reference: Select the appropriate Order Number or Cost Centre if Allocation Type is
Job Order or Assembly Order or Cost Centre.

Supplier: This is filled with the Supplier selected in the Order Creation panel.   It may be changed
by selecting the Supplier from the drop-down list.    The facility to amend the Supplier is only
available if the Purchase Order does not have any Purchase Order Lines.

Address: These fields are prefilled with the Postal Address of the Supplier.  They can be amended
at any time.

· Address: Three lines are available for entry of the postal address of the site.  
· City: Enter the Town or City where this Supplier is located.
· State: Enter the State where this Supplier is located.
· Code: Enter the Postcode or ZIP Code where this Supplier is located.
· Country: Enter the Country where this Supplier is located.

Additional Supplier Details: These fields are prefilled with details from the Supplier record.  They
can be amended at any time as follows.

· Contact: To change the Contact select from the drop-down list
· Phone: Enter the Telephone Number of the Supplier
· Fax: Enter the Facsimile Number of the Supplier
· Email: Enter the Email Address of the Supplier.  If an entry does not exist here then the

email address held against the Supplier will be used when emailing Purchase Orders,
etc.

Deliver To: The Delivery Address can be an address within your Company, or another Supplier or
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Customer if the Order is to be Drop-shipped.  Select the Radio Button relating to the Delivery
Address.  I.e.

· If the ‘Company’ Button is selected then the next field will only show Company Addresses
as entered in General>Company Sites

· If the ‘Customer’ Button is selected then the next field will only show Customers as
entered in Sales>Customers

· If the ‘Supplier’ Button is selected then the next field will only show Suppliers as entered
in Purchasing>Suppliers

The Company/Customer/Supplier address where the Purchases are to be delivered.    The
address will prefill the following fields.  They can be amended at any time.

· Address: Three lines for entry of the postal address of the delivery site.  
· City: Enter the Town or City where this delivery is to be made
· State: Enter the State where this delivery is to be made
· Code: Enter the Postcode or ZIP Code where this delivery is to be made
· Country: Enter the Country where this delivery is to be made

Approval Process: If the Purchasing Rule - Purchase Order Approvals is ticked, then these
fields will appear:

Approval Status : the default is "Waiting Approval". Other options are "Approved" or 
"Approval OnHold"

Date Approved : Display only field. The value will appears when the order is approved.

Order Values: This is for information only and shows:
Original Order:

Nett Amount
Tax Amount
Total Amount

Remaining Order Amount (amount not yet Invoiced):
Nett Amount
Tax Amount
Total Amount

Notes: You can enter unlimited amount of Notes that are related to this Purchase Order.  These
notes will be available wherever the Order is reported.  Whenever you click on this field an icon will
appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text table. 
Select the text to be copied and either press the OK Button in that screen or double-click the
selected record.

Buttons

Close: This will close the Purchase Order screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel
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Related: This will bring up a list of functions that are related to the Purchase Order.  You may open
and maintain information in those screens whilst still remaining in the Purchase Order screen.

Reports: This will bring up a list of Reports that are related to the Purchase Order.  You can
immediately run the report whilst still remaining in the Purchase Order screen.

Print: This will generate and print the current Purchase Order

Lines Tab

This screen allows you to add Lines to the Purchase Order.  The Purchase Order Number and its
Status is displayed at the top of the panel.

Purchase Order Lines can be created from the following sources:
· Lists
· Items
· Descriptors
· Catalogues
· Matrices
· Required Orders screen
· Manual

Each Method is described here

Lists: Lists are pre-defined Lists of Item Codes, Descriptor Codes, Catalogue Codes, and Labour
Codes from which selections are made.  Maintenance of Lists is covered in it’s own section within
this guide.   To use ‘Lists’ click on the ‘Lists’ icon on the upper toolbar.  On the displayed panel use
the drop-down list to select the specific List.   This will display the contents of the List. Now ‘check’
the checkbox against each line that you want to be copied to the Purchase Order.  You have the
option to click on the ‘Select All Contents’ Button at the bottom of this panel to select all the
records.  You may also click on the ‘De-select All Contents’ Button at the bottom of this panel to ‘
un-select’ all the records.   For each selected record you can amend the ‘Per Qty’ to denote the
quantity you require per ‘List’.  You can enter a multiplying quantity in ‘Multiplied Contents By’ field,
which will extend the above ‘Per Qty’ by this factor.
If you now click on the ‘Create Lines from Selected Contents’ Button then all the selected Lines will
be copied to the Purchase Order.   At this time any prices and quantity discounts will be applied to
determine the Purchase Price for each Line.

Items: To select single or multiple Items click on the ‘Items’ icon on the upper toolbar.  This will
display all Items that are currently ‘Active’.   Simply highlight the Item in the top panel then click
the ‘Add to Selected Items’ Button to copy it to the lower part of the screen.  Repeat this for all
required Items.  In the Lower panel amend the required quantity per line as required, or remove the
line by clicking on the ‘Remove from Selected Items’ Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Purchase Order.   At this time any prices and quantity discounts will be applied to
determine the Purchase Price for each Line.

Descriptors: To select single or multiple Descriptors click on the ‘Descriptors’ icon on the upper
toolbar.  This will display all Descriptors that are currently ‘Active’.   Simply highlight the Descriptor
in the top panel then click the ‘Add to Selected Descriptors’ Button to copy it to the lower part of the
screen.  Repeat this for all required Descriptors.  In the Lower panel amend the required quantity
per line as required, or remove the line by clicking on the ‘Remove from Selected Descriptors’
Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
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be copied to the Purchase Order.   At this time any prices and quantity discounts will be applied to
determine the Purchase Price for each Line.

Catalogue Items: To select single or multiple Codes from a Supplier’s Catalogue click on the ‘
Catalogue Items’ icon on the upper toolbar.  This will display all Codes that are included in the
Catalogue against whom this order is being placed.   Simply highlight the Code in the top panel
then click the ‘Add to Selected Items’ Button to copy it to the lower part of the screen.  Repeat this
for all required Codes.  In the Lower panel amend the required quantity per line as required, or
remove the line by clicking on the ‘Remove from Selected Items’ Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Purchase Order.  At this time any prices and quantity discounts will be applied to
determine the Purchase Price for each Line.

Matrices: Clicking on this button will bring up the 'Matrices Batch Entry' screen.  On that screen
click the 'Add' button to add a new Matrix line and add the following:

Styles Tab
Upper Panel

Matrix Style: From the drop-down list select the Matrix Style against which you are
going to enter the required quantities.  
Description: Display only showing the Description of the selected Matrix Style
Total Qty: Display only showing the sum of the entries made in the lower part of this
screen.
Required Date: Date when the Order Line is required.  This is prefilled with the
system date.  You can amend this any other date by clicking on the drop-down
calendar and selecting the date.

Lower Panel
Matrix Tab:  This panel displays the X, Y, and Z variables for the Matrix Style selected
above.  You can now enter the order quantities against the matrix combinations.  
Click on any XYZ cell and enter the required quantity.   If the Cell contains the
characters --- then that Matrix combination has not been defined for the Matrix Style
and a quantity cannot be save in this cell.
Notes Tab:  Enter any information Notes that will be specific to this Order/Matrix 

Properties Tab
Initially, this will display the Properties copied from the entry made against the Matrix Style
in screen (Inventory>Matrices>Properties).  You can amend the values here and make it
specific to this Order Line

Buttons
Close: This will close the Batch Entry - Matrices screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.  Upon closing this
screen Ostendo will generate an Order Line for each Item or Descriptor Code associated
with the Matrix Style/X/Y/Z combination
Add: This will send the cursor to a new line for entry of a new Matrix Style for this Order
Save: This will save the current data without exiting the screen
Cancel: Any changes made to the Required Date and Notes field since this screen was
opened or the last time the ‘Save’ Button was pressed will be lost.
Delete: This will remove the current Matrix Style from this Batch entry screen along with
any Order Lines currently generated by this Matrix Style

Required Orders screen: Automatically added to the Order from screen Requirements>Create
Required Orders

Manual: Individually entered in the lower part of this screen

(Script): This button will only be displayed if an ‘Order Script’ has been created (via File>System
Configuration>Order Scripts).   When visible the button name will be prefilled with the script name
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and, when pressed, will perform the functions of that script. 

The Purchase Line Grid (upper half of the screen) displays the following fields for each Purchase
Line entered:

 - Line No.
 - Type
 - Code
 - Order Qty
 - Unit
 - Unit Price 
 - Description
 - Tax Code
 - Unit Tax 
 - Required Date
 - Analysis Code
 - Line Tax
 - Line Total 
 - Total Received Qty
 - Remaining Qty
 - Status
 - Line Nett Total
 - Line Allocations (Allocations summary - This display-only field provides a quick view of
the specific allocation (order, inventory etc...) without having to drill down on the
allocation tab for each line. )
 - Additional Fields (dynamically added if available)

Info Line

A line is presented between the Upper and Lower panels which contain buttons relating to the
current line Item and is presented for further information and maintenance.   The displayed buttons
are:

Alternate Item:  The current Alternate Item linked to this Item is displayed for your
reference along with the current on-hand quantity of this alternative.
Stock/Avail:  This shows the current On-Hand quantity (in stock) and Available Quantities
(On-Hand + Supply - Demand) for this Item along with the Item’s basic Unit of Measure.
Clicking on this button will show further details. 

Lower Panel

The Line Maintenance applies to any line generated by any of the above methods.  Four ‘Tabs’ are
associated with this section:

· Purchase Line: Main Entry area for Purchase Order Lines
· Line Allocations: Demand Source (Sales, Jobs, etc) that are allocated to this Line
· Line Properties: Specific Properties that apply to the ordered Line
· Line Receipts: Receipt History of this Line

Purchase Line Tab

This is the main entry and maintenance area for Purchase Order Lines. 

Entry and Display fields

Line Number: This is auto-generated by the program in increments of 10 from the previous Line
Number.  You can amend this number if required.  This number can be used as a sort sequence
for printing the lines on a Purchase Order.  No checks are made on the entry
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Line Type: From the drop-down list select the Line Type.  The options are:
Item Code
Descriptor Code
Labour Code
Kitset Code

A further Code (Catalogue Code) is system generated when the Code is copied from a Catalogue

Code: From the drop-down list select the Code.  The drop-down list will vary dependent upon the
Line Type selection.  When entering a Inventoried Item you may wish to look at further Item Code
information:

· A ‘Stock Availability’ icon is situated just above the lower panel for this task.  
· An ‘Alternate Item’ icon is also available if the Item has alternatives

Order Quantity: This is prefilled with the quantity entered into the preliminary selection panels
defined above or 1 if manually entering the line.  This can be amended here if required

Unit: This is prefilled with the Unit for the Code.  If this is an Inventoried Item with multiple Units
then you can amend the Unit of Measure by clicking on the drop-down icon and selecting the Unit.

Unit Price: This is prefilled with the program calculated Unit Price of the Code taking into account
any quantity Discounts, etc.  This can be amended here if required.

Description: This is prefilled with the description as held against the Item, Descriptor, Labour
Code, or Catalogue Item.  It can be amended here if required.

Tax Code: The Tax Code as evaluated from the relationship between the Supplier Tax Group and
the line’s Tax Group (See File>Financial Configurations>Tax Matrix).  The Tax Code can be
amended from the drop-down list if required

Line Tax Amount: The system-calculated tax amount based on the Order Quantity, Unit Price and
Tax Code.

Line Total Amount: The system-calculated total amount for the Line based on the Order Quantity,
Unit Price and Tax Code.

Line Total Amount: The system-calculated total amount for the Line based on the Order Quantity,
Unit Price and Tax Code.

Price Override:  If the Unit Price has been amended then this checkbox will automatically be
'checked'.   If this is amended to 'unchecked' then the Unit price will revert back to it's original price

Required Date: If the Purchase Order Line is manually entered then this will prefill the Line with
the Purchase Order Date.  If it is generated from any other source (Example: batch Item entry,
Catalogue Items, etc) then the Code’s lead-time will be added to the Purchase Order date.   It can
be amended by overtyping the date or selecting a date from the drop-down calendar.

Analysis Group: This is prefilled with the Analysis Group held against the Code.  This can be
amended by selecting another Analysis Group from the drop-down list. 

Total Receipted Qty: This is a system maintained quantity that shows the quantity already
received against this line.

Remaining Qty: This is a system maintained quantity that shows the quantity yet to be received
against this line.
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Line Status: This shows the current status of this line.  The options are ‘Open’ or ‘Closed’.   The
program will close the status if the full quantity has been received.   You can amend this by
selecting ‘Open’ from the drop-down list.     Similarly, if you have not received the full order quantity
and know that the remainder will not be delivered then you can amend the status to ‘Closed’.  If the
Line is an Inventoried Item then a status of ‘Closed’ will inform the Replenishment Routine to
ignore this line.

Supplier Contract No. : When a PO Line is entered, Ostendo will check if there are any contracts
in force for this Supplier Item or Descriptor combination and advise the user by way of an indicator
message next to this field. The user can then select the contract and link it to this line. This will
effectively use the contract pricing to override the default price. the Extended Nett value of this line
will also update the Contract Value to Date on the Supplier Contract.

Line Instructions: This is prefilled with any ‘Notes’ that are held against the Code that are flagged
as being copied to the Purchase Order Line.   It may be amended here and made specific to this
Line.  Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon
you can bring up the Frequently Used Text table.  Select the text to be copied and either press the
OK Button in that screen or double-click the selected record.

Line Allocations Tab

You can define allocations defining where the Purchase Order Line is to be used.  This is not a
hard definition but merely serves as an intention. In the first instance it is prefilled with the source
allocation if it originated from ‘Replenishment’ or ‘Source on Demand’ requirements.  If no
allocation is made then it is assumed that the balance will go into Inventory (applicable to
Inventoried Items only) or a Cost Centre (Descriptors only).

Allocation Type: From the drop-down list select the allocation type.  The options are:
· Inventory
· Sales Order
· Job Order
· Assembly Order
· Cost Centre
· Company Asset
· Employee

Allocation Reference: The specific Reference relating to the Allocation Type.  For all Allocation
Types except Inventory the drop-down list will reflect the Allocation Type choice made above.

Allocation Quantity: This is the quantity that is allocated to the reference.

Item Variants: If the Allocation is for an Inventory Item and the Item has variants (Colour, Batch,
Size, etc) then these fields will appear here and you can allocate specific variants.

Task or Step: This is a display-only field showing the allocated JobTask name or Assembly Step
name.

Note: If you 'right mouse' on the allocation then you have the option to go directly to the specified
Order

Line Properties Tab

Any specific property values can be viewed here.  For example: A ‘property’ against an Item could
be ‘Voltage’ and the specific value entered against the Item Master is ‘240 Volts’.  All designated
Properties are displayed here showing:
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Property: The Property Name allocated to this Code

Value: The specific Property Value given to this Code.

Line Receipts Tab

This shows the Receipt History against this Line.

Receipt Number: Display only field showing a system generated number identifying the Receipt
Batch against which this Item was created

Receipt Date: Display only field showing the date when this receipt was made

Receipt Quantity: Display only field showing the quantity received against this Receipt Number.

Order History Tab

This shows the Supplier's Order History of the Item or Descriptor

Order Date: This is a display only field showing the date held against the Order Line

Supplier: This is a display only field showing the Supplier of this Item / Descriptor

Status: This is a display only field showing the current status of the Order

Order Number: This is a display only field showing the Order Number that contained this
Item/Descriptor Code

Qty: This is a display only field showing the quantity ordered in this Order Number

Unit: This is a display only field showing the Unit of Measure held against this Order Number

Unit Price: This is a display only field showing the Unit Buy Price in this order

Supplier Code Tab

This is prefilled with the Supplier's equivalent Code for the line Item/Descriptor (as entered into
screen Pricing>Item Costing (or Descriptor Costing).  You can amend it here is required.  
Code: From the drop-down list select the Supplier Code.  You have the option to key in a code if
required.

Description: If a Code was selected in the previous field then this will be filled with the Description
from that record.  It can be amended here if required

Unit: If a Code was selected in the Code field then this will be filled with the Unit from that record.
It can be amended here if required.

Additional Fields Tab

If you have defined Additional Fields against the Purchase Line (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:
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· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Buttons

Close: This will close the Purchase Order Line screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Not applicable to the Purchase Order Line panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Purchase Order Line panel

Related: This will bring up a list of functions that are related to the Purchase Line.  You may open
and maintain information in those screens whilst still remaining in the Purchase Order screen.

Reports: This will bring up a list of Reports that are related to the Purchase Order.  You can
immediately run the report whilst still remaining in the Purchase Order screen.

Print: This will generate and print the current Purchase Order

13.5.1 Purchase Order Properties

This screen allows you to define properties that are specific to a Purchase Order.  Property titles
are user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Purchase Orders.

Display fields

The displayed fields are taken from the Purchase Order Details.  The selection of which fields to
display here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Purchase
Orders whose status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Purchase Order Properties screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Purchase Order Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Order Number: Display only field showing the Purchase Order selected in the List screen

Description: Display only field showing the Description of the Purchase Order selected in the List
screen

Status: Display only field showing the status of the Purchase Order selected in the List screen

Supplier: Display only field showing the Supplier of the Purchase Order selected in the List screen

Order Type: Display only field showing the Order Type of the Purchase Order selected in the List
screen

Property: From the drop-down list select the Standard Property against which a value specific to
this Purchase Order will be made.

Value: Enter a value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
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Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Buttons

Close: This will close the Purchase Order Property screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Purchase Order Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Purchase Order Property record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: This enables you to delete the selected Purchase Order Property record.

13.5.2 Purchase Order Documents

This screen allows you to define documents, etc that are specific to a Purchase Order.    

List Tab

Display fields

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Purchase Order to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Purchase Order Documents screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Purchase Order Documents.
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Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Purchase Order record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name of the document that you are creating in this Document-
Purchase Order linkage.  No checks are made on the entry.

Document Type: Prefilled with ‘Purchasing’

Linked to: From the drop-down list select the Purchase Order that uses this document

Print / Email with order: Tick this box if this document is to be printed/emailed with the Order.

Correspondence: Tick this box if this document is to be treated as correspondence in the
Operations Centre.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Purchase Order Documents screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Purchase Order Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Purchase Order Documents record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 
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13.5.3 Purchase Order Images

This function allows you to link Images to a Purchase Order.    

List Tab

Display fields

Image Name: The name of the Image as entered into the Details screen,

Linked To: This is the specific Purchase Order to which this Image relates.

File Name: This is the full path name of the Image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Purchase Order Images screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Purchase Order Images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Image from a Purchase Order.

View: If you select a line and then this button the Image will be displayed using your default Image
display software. 

Detail Tab

Entry and Display fields

Image Name: Enter the name that you are calling the Image on this Image - Purchase Order
linkage.    No checks are made on the entry.

Image Type: Prefilled with ‘Purchasing’
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Linked to: From the drop-down list select the Purchase Order that uses this Image

Image Details: locate the full path name of the Image.  It should be noted that the file extension
must be an image format (I.e. .jpg, .bmp, .ico, .wmf, .emf)

Preview: The selected Image is displayed for your reference

Buttons

Close: This will close the Purchase Order Image screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Purchase Order Image record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Purchase Order Image record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

13.5.4 Purchase Order History Notes

This function allows you to link multiple time-stamped notes to a Purchase Order record.    

List Tab

Display fields

The displayed fields are taken from the Purchase Order master record.  The selection of which
fields to display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in
the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon
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Buttons

Close: This will close the Purchase Order History Notes screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Purchase Order to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Mobile Employee : Select the Mobile employee name to make this History Note available to that
employee.

Call Classification: From the drop-down list select a Classification under which you wish to store
this History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.  Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this Purchase Order is displayed in the lower part of the
screen.  Each record will also have the first 3 lines of the notes displayed.  To view the full Notes
simply click on the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Purchase Order History Notes screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.
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Add: This will bring up a blank ‘Detail’ screen for entry of an Purchase Order History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Purchase Order History Notes record or the last time
the ‘Save’ Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

13.6 Purchase Shipments

This screen allows the entry of Purchase Shipments giving the ability to spread additional costs of
the shipment across all purchase order lines linked to the shipment.  The process steps carried out
using this function are:

· Create the Purchase Shipment via the Detail Panel
· Link Purchase Orders that are included in this shipment (via the Purchase Orders tab)
· Identify Additional Charges (via the Shipment Charges tab)
· Ostendo will pro-rate the charges (in line with the ‘Charge Allocation Method) to each

selected Purchase Order
· You should now review the Allocations in the ‘Lines’ panel and amend the charges as

required
· Once the shipment has been received and validated click on the ‘Receive Purchases &

Close Shipment’ button.  Ostendo will generate all Receipt records for the included
Purchase lines

List Panel

Display fields

The displayed fields are taken from Shipment information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’.
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Shipments



694 Ostendo Reference Guide

whose status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Purchase Shipments screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ screen for entry of a new Shipment.

Save: Not active in this view

Cancel: Not active in this view

Delete: This removes the current highlighted Shipment Number

Related: This will bring up a list of functions that are related to Purchase Shipments.  You may
open and maintain information in those screens whilst still remaining in the Purchase Shipments
screen.

Reports: This will bring up a list of Reports that are related to Purchase Shipments.  You can
immediately run the report whilst still remaining in the Purchase Shipments screen.

Detail Panel

Entry and Display fields

Shipment No: This is the Shipment Number as generated by Ostendo.   It cannot be amended.
Numbering sequence is defined via File>System Configuration>System Settings

Shipment Date: This is the date you wish to record against this Shipment.  It is prefilled with the
system date.  You can amend the date by either overtyping the date or selecting the date from the
drop-down calendar.

Status: From the drop-down list select the status of the Shipment.  The options are:
· Planned
· Departed
· Landed

An additional ‘Closed’ status is used by Ostendo when the Shipment has been completed.  I.e. The
Receive Purchase & Close Purchase Shipment’ Button on the ‘Detail’ tab has been selected.

Reference: Enter a brief description of the Purchase Shipment.  A longer description can be
entered into the ‘Notes’ field at the bottom of the screen.  No checks are made on the entry

Shipment Print Status: This defines the current print status of the Purchase Shipment.  You can
print the Shipment by clicking on the adjacent icon.  After printing this will be set to ‘Printed’.  You
can reset it to ‘Not Printed’ from the drop-down list if required.

Tracking Code: From the drop-down list select the Tracking Code.  Tracking Codes are user
maintained (Purchasing>Settings>Shipment Tracking) and enable you to track your Purchase
Shipment and filter views or reports by this Code.
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Shipment Info sub-tab

Shipment Type: From the drop-down icon and select the Shipment Type that applies to this
Shipment.  Shipping Methods are user-maintained via Purchasing>Setting>Supplier Shipping
Methods.

Shipping Method: From the drop-down icon and select the Shipping Method that applies to this
Shipment.  Shipping Methods are user-maintained via Purchasing>Setting>Supplier Shipping
Methods.

Departure Date: Enter the Shipment Departure Date by either typing the date or selecting the date
from the drop-down calendar.

ETA Date: Enter the estimated Arrival Date of the Shipment by either typing the date or selecting
the date from the drop-down calendar.

Actual Arrival Date: Enter the actual Arrival Date of the Shipment by either typing the date or
selecting the date from the drop-down calendar.

Shipping Document Reference: Enter the Reference Identifier of the shipment.

Departure Port: Enter the Port of departure for the Shipment.  No checks will be made on this
entry

Arrival Port: Enter the Arrival Port of the Shipment.  No checks will be made on this entry

Insert Shipment Charges as Purchase Receipt Lines: This applies to single Purchase Order
and single currency only. Tick this box if you wish to add the Shipment Charges to the Purchase
Receipt, and consequently to the cost of the item.

Additional Fields sub-tab

If you have defined Additional Fields against the Purchase Shipment (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

This Shipment is for single Supplier: ‘Check’ this checkbox if the Shipment comes from a single
Supplier.  When ‘checked’ the next field becomes active so that you can identify the specific
Supplier.

Supplier: If the previous checkbox is ‘Checked’ then you should select the specific Supplier form
the drop-down list.  The displayed orders in the ‘Purchase Orders’ tab (below) will then be
restricted to those orders from this Supplier
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Shipment Values: The following display only fields show the current values relating to this
shipment.  The fields are:

Purchase Orders - Local Value: The total value of the Purchase Orders entered into the ‘
Purchase Order’ tab expressed in Local Currency
Purchase Orders - Foreign Value: The total value of the Purchase Orders entered into
the ‘Purchase Order’ tab expressed in the Supplier’s Currency
Shipment Charges: The total value of the Shipment Charges entered into the ‘Shipment
Charges’ tab expressed in Local Currency
Total Landed Costs: The sum of the above Purchase Orders - Local Value and Shipment
Charges
Number of Charges Out of Balance: This fields will display the number of ‘Charge
Codes’ who’s total cost does not equate to the individual applied costs in the ‘Lines’ tab

Create Purchase Invoice for all Receipts on Posting: If this is ‘Checked’ then, upon posting  the
Shipment, a Purchase Invoice will automatically be created.  You may view this via
Purchasing>Purchase Invoices.    If this is not ‘Checked’ then, upon posting  the Shipment, a
Purchase Receipt only will be created. You may view this via Purchasing>Purchase Receipts.  You
can then subsequently match a Purchase Invoice against this Receipt
  
(Button) Receive Purchases and Close Purchase Shipment: This field will become active when
the above ‘Number of Charges Out of Balance’ is zero (I.e. all charges have been allocated in the ‘
Lines’ tab.  When selected this will ‘post’ the Purchase Shipment and change the shipment status
to ‘Closed’

Notes sub-tab

You can enter unlimited amount of Notes that are related to this Purchase Shipment.  These notes
will be available wherever the shipment is reported.  Whenever you click on this field an icon will
appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text table. 
Select the text to be copied and either press the OK Button in that screen or double-click the
selected record. 

Purchase Orders sub-tab

Order No: Click on the drop-down list to select the Purchase Order to be included in this
Shipment.  If a specific Supplier was entered into the ‘Detail’ panel then this list will be restricted to
Purchase Orders linked to that Supplier

Supplier: Display only field showing the Supplier held against the selected Purchase order

Currency Code: Display only field showing the currency code as held against the Purchase Order

Exchange Rate: The exchange rate for the above currency.  In the first instance this is taken from
the Currency Code table but can be amended here if required.

Description: Display only field showing the description of the Purchase Order taken from the
order header

Shipment Charges sub-tab

Charge Code: From the dropdown list select the Charge Code Descriptor to use against this
shipment.  Charge Codes are maintained as Descriptors via Inventory>Descriptors
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Charge Caption: Enter, in up to 10 characters, a caption that will be used in the ‘Lines’ tab to
describe the Charge Code.  No checks will be made against the entry.  If nothing is entered then
the first 10 characters of the Charge Code Descriptor will be used.

Allocation Method: From the drop-down list select the Allocation Method.  The options are:
· Price
· Quantity
· Volume
· Weight
· Duty Payment

Ostendo will evaluate the pro-rate the Charge Value across all the Purchase Orders selected in
the ‘Purchase Orders’ tab in line with the method of allocation.  You then have the option to go into
the Lines tab and amend the allocations as required

Charge Cost Centre: This is prefilled with the Cost Centre Code held against the Charge Code
Descriptor record.  You may amend this here by selecting another Cost Centre from the drop-down
list

Currency Code: If this field is left blank then your home currency is assumed.  For other
currencies select the currency from the drop-down list

Exchange Rate: The exchange rate for the above currency.  In the first instance this is taken from
the Currency Code table but can be amended here if required.

Charge Value: Enter the Shipment Charge value.  This should be related to the currency code
entered into the next field

Sub Charges sub-tab

Charge Code: Display-only field.

Sub Code: Select a code from the drop-down list.

Description: The description of the selected code is displayed. This field can be modified.

Amount: Enter the value.

Buttons

Close: This will close the Purchase Shipments screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Purchase Shipment.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not active in this view

Related: This will bring up a list of functions that are related to the Purchase Shipment.  You may
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open and maintain information in those screens whilst still remaining in the Purchase Shipments
screen.

Reports: This will bring up a list of Reports that are related to the Purchase Shipment.  You can
immediately run the report whilst still remaining in the Purchase Shipments screen.

Lines Panel

This panel displays the charges and allows the user to edit individual charge values to reflect
specific charges per line rather than the ‘spread’ created by Ostendo.

Entry and Display fields

Charges Summary

The upper area shows, for each of the Shipment Charges entered into the ‘Detail’ panel (‘
Shipment Charges’ tab) Ostendo will show the following information:

Total Cost: The Total value of the Shipment Charge as entered into the ‘Shipment Charges’ Tab

Applied Cost: The Total value of the Costs that have been applied to the Shipment Charge in this
panel

Cost Diff: The difference between the above two values.  Note:  Until ALL Cost difference fields
are zero you will not be allowed to ‘post’ the Shipment

(Button) Reapply Changes: If this is selected then all current manual allocations will be removed
and Ostendo will re-calculate the individual Line values based on the Shipment Charge’s ‘
Allocation Method’

Line Display

This central area shows all the included Purchase Order Lines along with the allocation values
against each line.  If you wish to make any changes to an allocation then highlight the line here and
amend the details in the lower panel

Receipts sub-tab

This is the main area for manually amending the Shipment Details and Charge Code values
against individual Lines

Order No: Display only field showing the Purchase Order covering this shipment line

Req Date: Display only field showing the Required Date of this Purchase Order line

Line No: Display only field showing the Line Number within the Purchase Order

Line Type: Display only field showing the Line Type of the Purchase Order Line

Code: Display only field showing the Code within the Line Type of the Purchase Order Line

Currency: Display only field showing the currency of the Purchase Order

Order Qty: Display only field showing the quantity of this Line that has been ordered
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Order Unit Price: Display only field showing the Unit Price of the ordered line

Unit: Display only field showing the Unit Of Measure of the Order Line

Description: Description of the Ordered Line.  This can be amended if required.  No checks are
made on any changes.

Unit Weight: The Unit Weight taken from the Item, Descriptor or Catalogue record.  This can be
amended here if required 

Unit Volume: The Unit Volume taken from the Item, Descriptor or Catalogue record.  This can be
amended here if required

Duty%: The Duty Percentage taken from the Item, Descriptor or Catalogue record.  This can be
amended here if required

Rec Qty: Prefilled with the outstanding receipt quantity against this Order Line.  This can be
amended here if required

Rec Unit Price: Prefilled with the Order Line’s Unit Price.  This can be amended here if required

Local Rec Price: Display only field showing the unit price in Local currency taking into account the
above Receipt Unit Price and Exchange Rate entered in the Purchase Order tab of the ‘Detail’
panel

Charges Unit Cost: Display only field showing the sum of the 6 Charge fields

Landed Unit Cost: Display only field showing the sum of the line’s ‘Local Rec Price’ (above) plus
the above Charges Cost.

IMPORT DUTY : Enter the import duty of the shipment here.

CARRIAGE : Enter the carriage costs here.

Suppliers Code: This is only displayed if the line has a cross reference code linked to the
Supplier.  This is the Code used by the Supplier

Suppliers Unit: This is only displayed if the line has a cross reference code linked to the Supplier.
This is the Unit used by the Supplier

Suppliers Qty: This is only displayed if the Code has a cross reference code linked to the
Supplier.  It represents the quantity of the Supplier’s Unit of Measure that is being received.  This
field and the above ‘Rec Qty’ field will interact.  For example: If the Conversion Factor (described
below) is 10 and you enter 2 in this field then the Rec Qty field will change to 20.

Suppliers Price: This is only displayed if the line is an Item Code and has a cross reference code
linked to the Supplier and represents the unit Price in the Supplier’s Unit of Measure.  This field
and the above ‘Local Rec Price’ field will interact.  For example: If the Conversion Factor is 10 and
you enter $200 in this field then the Local Rec Unit Price field will change to $20. 

Conv. Factor: Display only field showing the Conversion factor between the Supplier’s Unit of
Measure and the base Unit of Measure as held against the Item or Descriptor.

Allocations sub-tab
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This tab shows details of allocations against the selected line.  

(Button) Edit Allocation Quantities: The allocations can be adjusted prior to posting by clicking
on the ‘Add’ button to create a new Line to expose this button.  You may add new allocations and
spread the allocated quantity across the allocations.  The total of all the allocations must equal the
Received quantity before the allocations are accepted.

(Button) Import Serial Numbers: If the line is Serial Number controlled then this button will be
displayed.  This gives you the opportunity to import Serial Numbers from a .csv file if required. 
When using this option you MUST ensure that the .CSV file contains only one column (I.e. the
Serial Numbers) without a column heading.  The import routine will also check that the number of
Serial Numbers in the .csv file equals the number of records to be populated.

Allocation Type: From the drop-down list select the allocation type.  The options are:
· Inventory
· Sales Order
· Job Order
· Assembly Order
· Cost Centre
· Company Asset
· Employee

Allocation Reference: The specific Reference relating to the Allocation Type.  For all Allocation
Types except Inventory the drop-down list will reflect the Allocation Type choice made above.

Allocation Quantity: This is the quantity that is allocated to the reference.

Receipt Quantity: This is the quantity received against this Allocation.

Warehouse: If the Allocation is for an Inventory Item then select a Warehouse from the drop-down
list.

Location: If the Allocation is for an Inventory Item then select the Location within the above
Warehouse from the drop-down list.

ContainerID: Displayed only if this is a containerised item. Select the Container.

Buttons

Close: This will close the Purchase Shipments screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: When viewing the ‘Allocations’ tab this button will send the cursor to a new line for entry of a
new Allocation

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not active in this view

Related: This will bring up a list of functions that are related to the Purchase Shipment.  You may
open and maintain information in those screens whilst still remaining in the Purchase Shipments
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screen.

Reports: This will bring up a list of Reports that are related to the Purchase Shipment.  You can
immediately run the report whilst still remaining in the Purchase Shipments screen.

13.7 Purchase Receipts

This screen allows you to receive goods or services with, or without, a prior Purchase Order. The
process for Purchase Order Receipts comprises the following Steps

· Create a Receipt Batch
· ‘Save’ the Batch Header and go to the ‘Lines’ tab
· Add Receipt quantities against lines where there has been a receipt
· Go back to the Batch Header
· Post the Batch - Ostendo generates movement to the appropriate destination

Note: Until a Batch is ‘Posted’ the movements will not be recorded against the included Items or
Descriptors.

List Tab

This shows Receipt Batches.  By default it displays only batches that are in progress.  You can
click on the ‘Include Updated Status’ checkbox at the bottom of the screen to also include batches
that have been ‘posted’.

Display fields

The displayed fields are taken from Purchase Receipt information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon
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Buttons

Close: This will close the Purchase Receipt screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Receipt Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Receipt Batch with status ‘In Progress’.  In this
instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Purchase Receipts.  You may open
and maintain information in those screens whilst still remaining in the Purchase Receipts screen.

Reports: This will bring up a list of Reports that are related to Purchase Receipts.  You can
immediately run the report whilst still remaining in the Purchase Receipts screen.

Detail Tab

This tab enables you to create and maintain a Purchase Receipt Batch Header.   After creation of
a Batch Header it must be saved (click on the ‘Save’ Button) before Lines can be added 

Entry and Display fields

Receipt Batch No:  This is a unique number automatically allocated by the program.  It cannot be
amended.

Status: This is the status of the Receipt Batch and is maintained by the program.  The displayed
variants are:

In Progress - The Receipt Batch is still being worked on
Updated - The Receipt Batch has been ‘Posted’ and a receipt Stock movement created
for the included Items

Reference: Enter a brief description of the Receipt Batch.  No validation checks will be carried out
on this field.

Receipt Style: This is prefilled with ‘Receipts for Order’.  If the receipt does not have an originating
Purchase Order then select ‘Receipts No Order’ from the drop-down list

Purchase Order Number: This becomes ‘active’ if the previous field’s selection is ‘Receipts for
Order’.  From the drop-down list select the Purchase Order against which the receipt is being
made.  If you do not know the originating Purchase Order then refer to the next field (Supplier)

Supplier: This is prefilled with the Supplier of the Purchase Order selected in the previous field.  If
you don't know the originating Purchase Order then click on the drop-down list against this field. 
This will display all outstanding Purchase Orders for all Suppliers.  If you click on a specific
Purchase Order then all lines in that order will be displayed.

Create Purchase Invoice for this Receipt on Posting: If this is 'checked' then Ostendo will
automatically create an Invoice to match the Receipts.

Currency Code: This is only visible if the Supplier uses a Foreign Currency.  When displayed it
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shows the Currency Code taken from the Purchase Order record.  It is for information only and
cannot be changed

Exchange Rate: This is only visible if the Supplier uses a Foreign Currency.  When displayed it is
prefilled with the Exchange Rate held against the Purchase Order.  It can be amended here, if
required, and made specific to this Purchase Receipt.

Packing Slip No: This is an optional entry field for you to enter the number of the Supplier’s
Packing Slip

Receipt Date: This is the date of the Receipt and is prefilled with the system date.  It can be
amended at any time up to Posting the Batch by entering the date or by clicking on the drop-down
menu and selecting the date.

Receipt Total: This is a display only field that shows the current total value of the Lines in this
receipt

Post All Purchase Receipt Entries: If this button is selected then all the Receipts contained in
the ‘Lines’ panel will be actioned as follows.   If the receipt Line has an ‘Allocation Type’ of:

· ‘Inventory’ or ‘Sales Order’ then a stock movement transaction is created whose stock
movement records will have a movement Type of ‘Purchase Receipt’.  

· ‘Job Order’ or ‘Assembly Order’ then the receipt will be moved directly to the Order.  In
this case two Inventory Transactions will be created - one receiving into stock and the
other issuing to the Order.  It should be noted that this is for reference only and the
Inventory Average Cost calculation for these transactions is ignored ad the Cost has
been applied directly to the Job or Assembly Order

· ‘Cost Centre’, ‘Company Asset’, or ‘Employee’ then the receipt will be posted to the Cost
Centre related to those destinations

The status of this Batch will then be amended to ‘Updated’

Note:  If the Purchase Receipt has status 'Updated' then the caption on this button will change to
'Un-Post All Purchase receipt Entries'.  If it is selected then a confirmation panel will be presented
which, if confirmed, will reverse the Purchase receipts.  If the Purchase Receipt has already been
matched against a Supplier Invoice then you cannot reverse the Receipt.

Automatically Post the Purchase Invoice: If this is 'checked' then you must also enter a Supplier
Invoice reference in the next field.  Upon accepting the Receipt Ostendo will also create a matched
Supplier Invoice

Supplier Invoice No: If the previous field is 'checked' then you must enter a Supplier Invoice
reference in this field

Notes Tab

Notes: Extended Notes for your own information can be attached to this Purchase Receipt
Batch.   Whenever you click on this field an icon will appear in the top-right.   By clicking on
this Icon you can bring up the Frequently Used Text table.   Select the text to be copied and
either press the OK Button in that screen or double-click the selected record.

Overrides Tab

Override Locations: If this is 'checked' then you may override the Warehouse/Location that
will apply to this receipt
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Warehouse: This is prefilled with the default Receipt Warehouse for this Receipt.  You can
amend this by clicking on the drop-down list to select the Warehouse into which the Items are
to be received.  

Location: This is prefilled with the default Receipt Location - within the above Warehouse for
this Receipt.  You can amend this by clicking on the drop-down list to select the specific
Location into which the Items are to be received.  

Additional Fields Tab

If you have defined Additional Fields against the Receipt (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected,
will display the available fields.  Enter information in line with the available field formats:
§ Text: Any data format can be entered in a Text field
§ Decimal: Allows entry of numbers and decimals
§ Integer: Allows entry of whole numbers only
§ Currency: Shows Currency symbol and decimals as defined in Regional Settings
§ Yes/No: Shows a checkbox which can be checked/unchecked
§ Date: Contains a drop-down calendar for selection of a date
§ Time: Displays format HH:MM:SS for entry of a time of day

Financial Tab

Financial Category: If required, select the Financial Category applicable. If left blank, it
will use the Financial Category (if any) linked to the associated Cost Centre. (Used in linked
General Ledger system)

Buttons

Close: This will close the Purchase Receipt screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Receipt Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Receipt Batch Header record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Purchase Receipt.  You may
open and maintain information in those screens whilst still remaining in the Purchase Receipt
screen.

Reports: This will bring up a list of Reports that are related to the Purchase Receipt.  You can
immediately run the report whilst still remaining in the Purchase Receipt screen.

Lines Tab

This tab enables you to maintain Receipt lines.  The following information is shown at the top of
this panel:

· Purchase Receipt Batch Number
· Receipt Status
· Purchase Order Supplier
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· Purchase Order Number

A button ‘Prefill Receipt Quantities’ is available which, when pressed, will fill the outstanding
quantities against each line shown in the lower part of the screen.

Entry and Display fields

All the fields in the upper panel are taken from Purchase Receipt information entered into the ‘
Detail’ tab.  If you ‘right mouse’ in the main panel and select ‘Customize List Fields’ you can define
the sort sequence of the records by dragging the field from ‘Available Fields’ to ‘Sort By’.   You can
also move the field position by dragging the column heading left or right to the position where you
want it to appear.

The Purchase Receipts Line Grid displays the following fields for each Receipt Line:

 - Line No.
 - Type
 - Code
 - Unit
 - Unit Price 
 - Receipt Qty
 - Receipt Unit Price
 - Description 
 - Tax Code
 - Ext. Receipt Price
 - Line Allocations (Allocations summary)
 - Additional Fields (dynamically added if available)

Within this upper panel the following fields can be accessed for ‘quick entry’ of receipt information.

Receipt Qty: Enter the quantity being received.  No checks are made on this entry.

Receipt Unit Price: This is prefilled with the Purchase Order Line’s Unit Price.   It can be
amended here to reflect the actual Unit Price.

Receipts Tab

This tab shows details of a specific line selected in the upper panel. 

Line No: Display only field showing the Line Number within the Purchase Order

Line Type: Display only field showing the Type of line being ordered in the Purchase Order

Code: Display only field showing the Code being ordered in the Purchase Order

Unit: Display only field showing the Unit of Measure of the line

Remaining Qty: Display only field showing the remaining quantity to be receipted.

Order Unit Price: Display only field showing the Order Unit Price.

Description: Display only field showing a description of the Code.

Tax Code: This is prefilled with the Tax Code held against this Purchase Order Line.   It can be
amended for this receipt by clicking on the drop-down menu and selecting the appropriate Tax
Code.
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Receipted Qty: Enter the quantity being received.     No checks are made on this entry and you
can over-receive, under-receive, or even return the goods (negative quantity).

Receipt Unit Price: This is prefilled with the Purchase Order Line’s Unit Price.   It can be
amended here to reflect the actual Units Price.  Alternatively you may click on the adjacent button
and enter the Line's total price.  Ostendo will automatically evaluate the Unit Price by dividing this
Total by the Receipt Quantity.

Allocations Tab

This tab shows details of allocations against the selected line.  

Allocation Type: From the drop-down list select the allocation type.  The options are:
· Inventory
· Sales Order
· Job Order
· Assembly Order
· Cost Centre
· Company Asset
· Employee

Allocation Reference: The specific Reference relating to the Allocation Type.  For all Allocation
Types except Inventory the drop-down list will reflect the Allocation Type choice made above.

Allocation Quantity: This is the quantity that is allocated to the reference.

Receipt Quantity: This is the quantity received against this Allocation.

Warehouse: If the Allocation is for an Inventory Item then select a Warehouse from the drop-down
list.

Location: If the Allocation is for an Inventory Item then select the Location within the above
Warehouse from the drop-down list.

Batch No.:  Item Batch Number.

Revision: Item Revision number.

Task or Step: This is a display-only field showing the allocated Job Task name or Assembly Step
name.

Supply Batch No.:  Supply Batch number.

ContainerID: Displayed only if this is a containerised item. Select the Container.

Additional Fields Tab

If you have defined Additional Fields against the Purchase Receipt Lines (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
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· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Buttons

Close: This will close the Purchase Receipt screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Receipt record.

Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Receipt Line

Related: This will bring up a list of functions that are related to the Purchase Receipt.  You may
open and maintain information in those screens whilst still remaining in the Purchase Receipt
screen.

Reports: This will bring up a list of Reports that are related to the Purchase Receipt.  You can
immediately run the report whilst still remaining in the Purchase Receipt screen.

13.8 Purchase Invoices

This screen allows you to receive Supplier Invoices and - optionally - match them against
Purchase Order receipts.  The process for Purchase Invoice Receipts comprises the following
Steps

· Create an Invoice Batch and identify the Invoice and Invoice Amount
· ‘Save’ the Batch Header and go to the ‘Lines’ tab
· Match against prior receipts or add Invoice Line details
· Go back to the Batch Header
· Post the Batch - Ostendo generates the appropriate account activity details

Note: Until a Batch is ‘Posted’ the account activity details will not be recorded against the included
Lines

List Tab

This shows Purchase Invoice Batches.  By default it displays only batches that are in progress. 
You can click on the ‘Include Updated Status’ checkbox at the bottom of the screen to also include
batches that have been ‘posted’.

Display fields

The displayed fields are taken from Purchase Invoice information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field
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from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Purchase Invoice screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Invoice Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This allows you to delete the selected Batch.  If the current status is ‘Updated’ a panel will
appear asking you to confirm the deletion of the Updated Purchase Invoice’.  Upon acceptance
Ostendo will create financial transactions to cover the reversal in addition to resetting the status of
any Receipts that were matched to this Invoice

Related: This will bring up a list of functions that are related to Purchase Invoices.  You may open
and maintain information in those screens whilst still remaining in the Purchase Invoice screen.

Reports: This will bring up a list of Reports that are related to Purchase Invoices.  You can
immediately run the report whilst still remaining in the Purchase Invoice screen.

Detail Tab

This tab enables you to create and maintain a Purchase Invoice Batch Header.   After creation of a
Batch Header it must be saved (click on the ‘Save’ Button) before the Invoice amount can be
matched to Receipts or receipt lines added 

Entry and Display fields

Invoice Batch No:  This is a unique number automatically allocated by the program.  It cannot be
amended.
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Status: This is the status of the Invoice Batch and is maintained by the program.  The displayed
variants are:

In Progress - The Invoice Batch is still being worked on
Updated - The Invoice Batch has been ‘Posted’ and accounting details created for the
included lines

Invoice Date: This is the date of the Invoice Batch and is prefilled with the system date.  It can be
amended at any time up to Posting the Batch by keying a new date or by clicking on the drop-down
menu and selecting the date.  This will become the Invoice posting date when creating the
Accounting Journal.  It is validated against the date currently held in File>Financial
Configuration>Cut-Off Dates

Reference: Enter a brief description of the Invoice Batch.  No validation checks will be carried out
on this field.

Invoice Style: This is prefilled with ‘Invoice Matched to Receipts’.  If the Invoice matching is not
required then select ‘Invoice Only’ from the drop-down list

Supplier Invoice Number: Enter the Invoice Number shown on the Supplier’s Invoice.

Supplier: From the drop-down list select the Supplier of this Invoice.

Supplier Invoice Date: This is the date of the Invoice and is for reference only against this Invoice
entry.  Select the date by keying a date or clicking on the drop-down menu and selecting the date.

Credit Terms: This is prefilled with the Credit Terms held against the Supplier record.   You can
amend these Terms by selecting other Terms from the drop-down list.  Credit Terms are
maintained under File>Financial Configuration>Credit Terms.

Currency Code: This is only visible if the Supplier uses a Foreign Currency.  When displayed it
shows the Currency Code taken from the Supplier record.  It is for information only and cannot be
changed

Exchange Rate: This is only visible if the Supplier uses a Foreign Currency.  When displayed it is
prefilled with the Exchange Rate held against the Currency Code.  It can be amended here, if
required, and made specific to this Purchase Invoice.

Additional Charges

Freight - Nett: Enter the amount of Freight (Nett of Tax) charged in this Invoice.  

Freight - Tax Code: This is prefilled with the system default Tax code (as defined in File>Financial
Configuration>Tax Codes) and can be amended by selecting another Tax Code from the
drop-down list.

Freight - Tax: In the first instance this is calculated from the above Nett Amount and the Tax Rate
held against the selected Tax Code.  This amount can be manually overwritten to reflect the actual
amount on the Invoice, if different.

Freight - Total: Display only fields showing the sum of the Freight - Nett Amount and the Freight -
Tax Amount.

Other - Nett: Enter the amount of any other additional charges (Nett of Tax) included in this
Invoice.  
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Other - Tax Code: This is prefilled with the system default Tax code (as defined in File>Financial
Configuration>Tax Codes) and can be amended by selecting another Tax Code from the
drop-down list.

Other - Tax: In the first instance this is calculated from the above Nett Amount and the Tax Rate
held against the selected Tax Code.  This amount can be manually overwritten to reflect the actual
amount on the Invoice, if different.

Other - Total: Display only fields showing the sum of the Other - Nett Amount and the Other - Tax
Amount.

Supplier Invoice Values

Supplier Invoice - Nett Amount: Enter the amount of the Supplier’s Invoice excluding Tax.  

Supplier Invoice - Tax Amount: Enter the amount of Tax included in the Supplier’s Invoice.  

Supplier Invoice - Total Amount: System evaluated total taken from the sum of the Supplier’s
Nett Amount and the Supplier’s Tax Amount.

Batch Totals - Nett Amount: System evaluated amount taken from the line amounts contained in
this Batch

Batch Totals - Nett Additional Charges: System evaluated amount taken from the sum of the
Freight and Other amounts entered into this screen

Batch Totals - Tax Amount: System evaluated amount taken from the total Tax entered against
the Batch Lines and the Additional Charges Lines

Batch Totals - Total Amount: System evaluated total taken from the sum of the previous three
fields

Difference: System evaluated calculation showing the difference between the Supplier’s Total
Invoice amount and the Batch Totals amount:

· If this value is outside the tolerance defined in Purchase Rules then the Batch cannot be
posted.

· If this value is not zero but is inside the tolerance defined in Purchasing Rules then Ostendo
will add a new line to the Invoice covering this difference at the time the Invoice is posted.

Default Allocation Type: This is only visible if the Invoice Style is 'Invoice Only'.    Select the type
from the drop-down list.  The Options are:

Default: Uses the default allocation as held against the Item or Descriptor entered at line level
Job Order: Any Line added to this Invoice will use the Job Order Number selected in the next
field as its Allocation Reference
Assembly Order: Any Line added to this Invoice will use the Assembly Order Number
selected in the next field as its Allocation Reference
Cost Centre: Any Line added to this Invoice will use the Cost Centre selected in the next field
as its Allocation Reference

Allocation Reference: This is only visible if the Invoice Style is 'Invoice Only' and the content
depends on the selection made in the previous field.    Select the Job Order, Assembly Order, or
Cost Centre type from the drop-down list. 

Approval Status: This is only visible if you are authorised to carry out approvals (User Setup
option).  When visible you have the option to take the Invoice Batch through the following steps:
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· Waiting Approval
· Approved
· Approval on Hold

Until a batch is ‘Approved’ it cannot be ‘posted’

Date Approval: This is only visible if you are authorised to carry out approvals (User Setup
option).  When visible it shows the system date when this batch was ‘Approved’

Post Purchase Invoice: This button will only become active if the Difference Field (above) is zero
and the Approval Status is ‘Approved’.  (Note: If ‘Approvals’ are not being used then the Approval
Status is automatically set to ‘Approved’). If this button is selected then all the entries contained in
the ‘Lines’ panel will be actioned and the referenced Lines updated.  The status of this Batch will
then be amended to ‘Updated’

Notes Tab

Notes: Extended Notes for your own information can be attached to this Purchase Invoice. 
Whenever you click on this field an icon will appear in the top-right.   By clicking on this Icon
you can bring up the Frequently Used Text table.   Select the text to be copied and either press
the OK Button in that screen or double-click the selected record.

Overrides Tab

Override Locations: If this is 'checked' then you may override the Warehouse/Location that
will apply to this Invoice

Warehouse: This is prefilled with the default Receipt Warehouse for this Invoice.  You can
amend this by clicking on the drop-down list to select the Warehouse into which the Items are
to be received.  

Location: This is prefilled with the default Receipt Location - within the above Warehouse for
this Invoice.  You can amend this by clicking on the drop-down list to select the specific
Location into which the Items are to be received.  

Additional Fields Tab

If you have defined Additional Fields against the Invoice (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected,
will display the available fields.  Enter information in line with the available field formats:
§ Text: Any data format can be entered in a Text field
§ Decimal: Allows entry of numbers and decimals
§ Integer: Allows entry of whole numbers only
§ Currency: Shows Currency symbol and decimals as defined in Regional Settings
§ Yes/No: Shows a checkbox which can be checked/unchecked
§ Date: Contains a drop-down calendar for selection of a date
§ Time: Displays format HH:MM:SS for entry of a time of day

Financial Tab

Financial Category: If required, select the Financial Category applicable. If left blank, it
will use the Financial Category (if any) linked to the associated Cost Centre.(Used with external
General Ledger system).
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Buttons

Close: This will close the Purchase Invoice screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Invoice Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Invoice Batch Header record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Purchase Invoice.  You may
open and maintain information in those screens whilst still remaining in the Purchase Invoice
screen.

Reports: This will bring up a list of Reports that are related to the Purchase Invoice.  You can
immediately run the report whilst still remaining in the Purchase Invoice screen.

Lines Tab

This tab enables you to maintain Invoice lines.  The format of this screen differs dependent upon
the ‘Invoice Style’ (‘Matched to Receipt’ or ‘Invoice Only’)

Invoice Style - Matched to Receipts

Supplier: Display only field showing the Supplier of the Invoice.

(Button) Select Receipt Batch for matching: If this button is selected then a separate panel will
be presented for selecting specific Receipt Batches from this Supplier that have not yet been ‘
matched’ to an Invoice.  The fields shown are:

Select: Select the receipt lines(s) that are being matched.  You can select and/or unselect
all lines by clicking the button at the bottom of this panel.
Receipt Number: Display only field showing the Reference Number allocated to the
Receipt during the receiving process.
Receipt Date: Display only field showing the date when the line was received.
Packing Slip Reference: Display only field showing the Supplier’s Packing Sheet Number
applicable to this receipt reference.
Order Number: Display only field showing the originating Purchase Order Number.
Reference: Display only field showing a brief description of the receipt as entered during
the receipt process.
(Button) Select All Receipts: If this is selected then all the displayed receipt lines will
have their ‘Select’ checkbox selected
(Button) De-Select All Receipts: If this is selected then all the displayed receipt lines will
have their ‘Select’ checkbox un-selected
(Button) OK: If this is selected then all the selected Receipt Batches will have their
Receipt Lines copied to the Invoice Lines and this panel will be closed

Invoice Nett Amount: Display only field showing the Nett amount of the Invoice as entered into
the ‘details’ screen.
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Batch Nett Amount: Display only field showing the Nett amount of the Batch calculated from the
sum of the details entered below

Entry and Display fields

Upper panel

The displayed fields in this upper panel are taken from the selected Receipt Lines.  If you ‘right
mouse’ in the main panel and select ‘Customize Detail Order’ you can define the sort sequence of
the displayed records by dragging the field from ‘Available Fields’ to ‘Sort By’. 

You can also move the field position by dragging the column heading left or right to the position
where you want it to appear.

Match: ‘Check’ this checkbox if you are fully matching this line with the displayed Quantity and
Price.  If you wish to amend the Invoice Quantity or Invoice Price then highlight the line and amend
this information in the Lower Panel.  This ‘matching’ status will also update the Lower panel ‘Match’
field when you exit this record.

Line Number: Display only field showing the Line Number in the Purchase Receipt.

Line Type: Display only field showing the Type of line being matched.  Displayed options are Item
Code, Descriptor Code, or Catalogue Code.

Code: Display only field showing the Code being matched

Unit: Display only field showing the Unit of Measure of the line

Invoice Qty: Display only field showing the Invoice quantity.  This is prefilled with the outstanding
Receipt quantity against this receipt.  If you wish to amend the Invoice Quantity then highlight the
line and amend this in the Lower Panel

Invoice Unit Price: Display only field showing the Invoice Price.  This is prefilled with the Price
held against this receipt.  If you wish to amend the Invoice Price then highlight the line and amend
this in the Lower Panel

Receipt Qty: Display only field showing the outstanding quantity against this Receipt.

Receipt Unit Price: Display only field showing the Unit Price held against this Receipt.

Description: Display only field showing a description of the Code.

Ext Line Price: Display only field showing the extended line Price.

Ext Line Tax: Display only field showing the extended line Tax.

Ext Line Total: Display only field showing the extended line Total.

Line Allocations: Display only field showing the Allocations summary.

Additional Fields: These are dynamically added if available.

Lower panel

This lower panel allows you to make certain changes to the receipt as follows:

Match: ‘Check’ this checkbox if you are matching this line with the displayed/amended Quantity
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and Price.  This ‘matching’ status will also update the upper panel ‘Match’ field when you exit this
record.

Receipt Number: Display only field showing the Reference Number allocated to the Receipt
during the receiving process.

Receipt Date: Display only field showing the date when the line was received.

Purchase Order Number: Display only field showing the originating Purchase Order Number.

Close for future matching: If you have amended the Invoice Quantity to less than the Receipt
Quantity this checkbox field will be activated.  By ‘checking’ this checkbox you will be informing the
program that you will not be making any further matching against the receipt.

Line Number: Display only field showing the Line Number in the Purchase Receipt.

Line Type: Display only field showing the Type of line being matched.  Displayed options are Item
Code, Descriptor Code, or Catalogue Code.

Code: Display only field showing the Code being matched

Unit: Display only field showing the Unit of Measure of the line

Receipt Qty: Display only field showing the quantity that was received against this receipt
reference

Receipt Unit Price: Display only field showing the price that is held against the receipt reference

Description: Display only field showing a description of the Code.

Tax Code: This shows the Tax Code currently held against the Purchase Order Line.  If the
Invoice Tax Code is different then select the code from the drop-down list.

Invoice Qty: This is prefilled with the outstanding Quantity against this receipt.  If the Invoice
Quantity is different then you can change it here

Invoice Unit Price: This is prefilled with the Receipt Price.  If the Invoice Price is different then you
can change it here by clicking on the icon within this field and entering the new Unit Price or
alternatively, enter the Extended Price and Ostendo will evaluate the Unit Price for you.

Invoice Style - Invoice Only

Supplier: Display only field showing the Supplier of the Invoice.

Invoice Nett Amount: Display only field showing the Nett amount of the Invoice as entered into
the ‘details’ screen.

Batch Nett Amount: Display only field showing the Nett amount of the Batch calculated from the
sum of the details entered below

Entry and Display fields

Batch Entry Bar

Purchase Order Lines can be created - in batch - from the following sources:
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· Lists
· Items
· Descriptors
· Catalogues

Each Method is described here

Lists: Lists are pre-defined Lists of Item Codes, Descriptor Codes, Catalogue Codes, and Labour
Codes from which selections are made.  Maintenance of Lists is covered in it’s own section within
this guide.   To use ‘Lists’ click on the ‘Lists’ icon on the Batch toolbar.  On the displayed panel use
the drop-down list to select the specific List.   This will display the contents of the List. Now ‘check’
the checkbox against each line that you want to be copied to the Purchase Invoice.  You have the
option to click on the ‘Select All Contents’ Button at the bottom of this panel to select all the
records.  You may also click on the ‘De-select All Contents’ Button at the bottom of this panel to ‘
un-select’ all the records.   For each selected record you can amend the ‘Per Qty’ to denote the
quantity you require per ‘List’.  You can enter a multiplying quantity in ‘Multiplied Contents By’ field,
which will extend the above ‘Per Qty’ by this factor.
If you now click on the ‘Create Lines from Selected Contents’ Button then all the selected Lines will
be copied to the Purchase Invoice.   

Items: To select single or multiple Items click on the ‘Items’ icon on the upper toolbar.  This will
display all Items that are currently ‘Active’.   Simply highlight the Item in the top panel then click
the ‘Add to Selected Items’ Button to copy it to the lower part of the screen.  Repeat this for all
required Items.  In the Lower panel amend the required quantity per line as required, or remove the
line by clicking on the ‘Remove from Selected Items’ Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Purchase Invoice.   

Descriptors: To select single or multiple Descriptors click on the ‘Descriptors’ icon on the upper
toolbar.  This will display all Descriptors that are currently ‘Active’.   Simply highlight the Descriptor
in the top panel then click the ‘Add to Selected Descriptors’ Button to copy it to the lower part of the
screen.  Repeat this for all required Descriptors.  In the Lower panel amend the required quantity
per line as required, or remove the line by clicking on the ‘Remove from Selected Descriptors’
Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Purchase Invoice.   

Catalogue Items: To select single or multiple Codes from a Supplier’s Catalogue click on the ‘
Catalogue Items’ icon on the upper toolbar.  This will display all Codes that are included in the
Catalogue against whom this order is being placed.   Simply highlight the Code in the top panel
then click the ‘Add to Selected Items’ Button to copy it to the lower part of the screen.  Repeat this
for all required Codes.  In the Lower panel amend the required quantity per line as required, or
remove the line by clicking on the ‘Remove from Selected Items’ Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Purchase Invoice.  

Upper panel

The displayed fields in this upper panel are taken from the details entered into the Lower Panel.  If
you ‘right mouse’ in the main panel and select ‘Customize Detail Order’ you can define the sort
sequence of the displayed records by dragging the field from ‘Available Fields’ to ‘Sort By’. 

You can also move the field position by dragging the column heading left or right to the position
where you want it to appear.

Line Number: Display only field showing the Line Number entered in the Lower Panel.
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Line Type: Display only field showing the Line Type selected in the Lower Panel.  Displayed
options are Item Code, Descriptor Code, or Catalogue Code.

Code: Display only field showing the Code as entered into the Lower Panel

Unit: Display only field showing the Unit of Measure of the Code

Invoice Qty: Display only field showing the Invoice quantity as entered into the Lower Panel. 

Invoice Unit Price: Display only field showing the Invoice Price as entered into the Lower Panel. 

Description: Display only field showing a description of the Code.

Lower panel

This lower panel allows you to enter Invoice Line details as follows:

Invoice Lines Tab

Line No: Enter the Line Number of this entry.  It is prefilled with the last line number plus 10.  You
have the option to change this to any number if required.

Line Type: From the drop-down list select the Line Type.  The options are:
· Item Code
· Descriptor Code
· Catalogue Code.

Code: From the drop-down list select the Code that applies to this Line.

Invoice Qty: Enter the quantity of the Code that is being invoice

Unit: Display only field showing the Unit of Measure of the line.  However, if this is an Item that has
multiple Units of Measure you can amend this from the drop-down list of valid UOM’s for this Item

Invoice Unit Price: This is prefilled with the base Buy Price or the specific price linked to this
Supplier.   If the Invoice Price is different then you can change it here

Description: This is prefilled with the Description of the Code.  You can amend this description if
required.

Tax Code: This shows the Tax Code taken from the Code/Supplier matrix (Set up in
File>Financial Configuration>Tax Matrix).  If the Invoice Tax Code is different then select the code
from the drop-down list.

Allocation Type: From the drop-down list the type of allocation.  The options are:
· Job Orders
· Sales Orders
· Assembly Orders
· Cost Centre

Allocation Reference: This shows the Reference of the Allocation.  Note: If this line is allocated to
more than one reference then this will be filled with ‘Multiple’.  You should click on the Allocations
tab to view the details.
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Allocations Tab

You can define allocations defining where the Invoice Line is to be used.  If no allocation is made
then it is assumed that the balance will go into Inventory (applicable to Inventoried Items only) or a
Cost Centre (Descriptors and Catalogue Items only).

Allocation Type: From the drop-down list select the allocation type.  The options are:
· Inventory
· Sales Order
· Job Order
· Assembly Order
· Cost Centre
· Company Asset
· Employee

Allocation Reference: The specific Reference relating to the Allocation Type.  For all Allocation
Types except Inventory the drop-down list will reflect the Allocation Type choice made above.

Allocation Quantity: This is the quantity that is allocated to the reference.

Item Variants: If the Allocation is for an Inventory Item and the Item has variants (Colour, Batch,
Size, etc) then these fields will appear here and you can allocate specific variants.

Task or Step: This is a display only field showing the allocated Job Task name or Assembly Step
name.

Additional Fields Tab

If you have defined Additional Fields against the Purchase Invoice Lines (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Buttons

Close: This will close the Purchase Invoice screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will show a blank Lower Panel in preparation for creation of a new Invoice Line record.

Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Line



718 Ostendo Reference Guide

Related: This will bring up a list of functions that are related to the Purchase Invoice.  You may
open and maintain information in those screens whilst still remaining in the Purchase Invoice
screen.

Reports: This will bring up a list of Reports that are related to the Purchase Invoice.  You can
immediately run the report whilst still remaining in the Purchase Invoice screen.

13.9 Settings

13.9.1 Supplier Types

This screen allows you to maintain a file of Supplier Types, which are used to analyse Supplier
records.   Supplier Types are User-defined and can include such types as:

· Office Supplies
· Fastenings
· Raw Materials

Entry and Display fields

Type: Enter the Name of the Supplier Type.   Duplicates not allowed.

Description: Enter a short description of the Supplier Type.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Supplier Type screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Supplier Type.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Supplier Type.

Set Default: If you highlight a record and click this Button then the Default Supplier Type will
appear at the top of the screen.  The Supplier Type is used to prefill the Supplier screen when
adding a new Supplier.  It can, of course, be amended to another Type in that screen without
affecting this default.  The Default Supplier can be amended at any time.       

13.9.2 Supplier Categories

This screen allows you to maintain a list of Supplier Categories.   

Entry and Display fields

Supplier Category: Enter the Category Name.   Duplicates not allowed.
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Description: Enter a short description of the Supplier Category.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Category.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current record.

13.9.3 Supplier Regions

This screen allows you to maintain a file of Supplier Regions, which are used to analyse Supplier
records.    Supplier Regions are User-defined and can include such types as:

· Northern
· Suburbs
· Central

Entry and Display fields

Region: Enter the Name of the Supplier Region.   Duplicates not allowed.

Description: Enter a short description of the Supplier Region.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Supplier Region screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Supplier Region.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Supplier Region.
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13.9.4 Supplier Codes

This screen allows you to maintain a file of Supplier Codes, which are used to analyse Supplier
records.  Supplier Codes are User-defined and can include such groups as:

· Retail
· Hazardous Goods Supply

Entry and Display fields

Code: Enter the Name of the Supplier Code.  Duplicates not allowed.

Description: Enter a short description of the Supplier Code.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Supplier Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Supplier Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Supplier Code.

Set Default: If you highlight a record and click this Button then the Default Supplier Group will
appear at the top of the screen.  The Supplier Group is used to prefill the Supplier screen when
adding a new Supplier.  It can, of course, be amended to another Group in that screen without
affecting this default.  The Default Supplier can be amended at any time.       

13.9.5 Supplier Shipping Methods

This screen allows you to maintain a file of Supplier Shipping Methods, which are used to analyse
Supplier records.  Shipping Methods are User-defined and can include such groups as:

· UPS
· Rail
· Sea

Entry and Display fields

Shipping Method: Enter the Name of the Shipping Method.  Duplicates not allowed.

Description: Enter a short description of the Shipping Method.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.
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Buttons

Close: This will close the Supplier Shipping Method screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Supplier Shipping Method.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Shipping Method.

13.9.6 Supplier Shipping Types

This screen allows you to maintain a file of Supplier Shipping Types, which are used to analyse
Supplier Shipment records.   Supplier Shipment Types are User-defined and can include such
types as:

· Import
· Transfer

Entry and Display fields

Shippng Type: Enter the Name of the Supplier Shipment Type.   Duplicates not allowed.

Description: Enter a short description of the Shipment Type.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Supplier Shipment Type screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Supplier Shipment Type.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Supplier Shipment Type.

13.9.7 Purchase Types

This screen allows you to maintain a file of Purchase Types, which are used when creating
Purchase Orders to segregate the Type of order being created.  These can be, for example:

· Standard
· Non Production
· Office Supplies
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Entry and Display fields

Purchase Type: Enter the Name of the Purchase Type.  Duplicates not allowed.

Description: Enter a short description of the Purchase Type.  No checks are made on this entry

Creation Status: From the drop-down list select the status of the Purchase when it is created
using this Purchase Type.  The options are:

· Planned
· Open
· In Progress
· On-Hold

Numbering: From the drop-down list select the way in which Purchase Orders are numbered.
The options are:

· Automatic - commencing from the number set up in File>System Configuration>System
Settings

· Manual - manually entered at time of Order creation

Prefix: You have the option to provide a prefix to the Automatically generated Order Number.   For
example: if the Prefix was ‘PO-‘ then the generated Order could be ‘PO-12345’

Type used for Site Name : Select the site name from the drop-down list.

Use Type for Site linked to Source or Demand Order : Tick this box if the Site is taken from the
Order

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Purchase Types screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Purchase Type.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Purchase Type.

13.9.8 Purchase Tracking

This screen allows you to maintain a file of Purchase Tracking Codes, which are used to track a
Purchase Order through it’s ordering, processing, delivery and receipt process.  Purchase
Tracking Codes are User-defined and can include such codes as:

· Quayside
· In Customs
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Entry and Display fields

Tracking Code: Enter the Name of the Tracking Code.  Duplicates not allowed.

Description: Enter a short description of the Tracking Code.  No checks are made on this entry

Tracking Colour: From the drop-down list select the colour that you wish to associate with this
Tracking Status.  This will be displayed on the Purchase Order ‘List’ view when that field is
selected for display.

Exclude From Mobility: Tick this box if you wish to exclude this Tracking Code from Freeway
Mobility usage.

Status: Set the Tracking Status as either "Active" or "InActive".

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Tracking Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Tracking Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Tracking Code.

13.9.9 Purchase Shipment Tracking

This screen allows you to maintain a file of Shipment Tracking Codes, which are used to track a
Shipment through it’s delivery cycle.  Shipment Tracking Codes are User-defined and can include
such codes as:

· Quayside
· In Customs

Entry and Display fields

Tracking Code: Enter the Name of the Tracking Code.  Duplicates not allowed.

Description: Enter a short description of the Tracking Code.  No checks are made on this entry

Tracking Colour: From the drop-down list select the colour that you wish to associate with this
Tracking Status.  This will be displayed on the Purchase Shipments  ‘List’ view when that field is
selected for display.

Exclude From Mobility: Tick this box if you wish to exclude this Tracking Code from Freeway
Mobility usage.
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Status: Set the Tracking Status as either "Active" or "InActive".

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Tracking Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Tracking Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Tracking Code.

13.9.10 Purchase Approval Limits

This screen enables you to define purchasing approval limits by user.

This feature is designed to better manage a company’s purchasing liabilities. It does this at three
levels – on a per order basis, on a per Supplier basis, and on a total Purchase orders basis.

A company can specify one or more of these levels (Approval Scope) for one or more users.

If a user is limited on a per order basis (scope = “Current Order”), any Purchase Orders he create
or modify at any time, must be within his Current Order limit. If it is not, he will need to get it
approved by another user with a higher limit.

On a per Supplier basis (scope = “Current Supplier”), we look at the total value of the Purchase
Orders for that supplier (regardless of who raised the orders) over a specified time horizon. If that
value exceeds what is set for the user, then approval is required before the user can create or
modify the Purchase Order. This ensures that the company is made aware of any potential
excessive spending with a particular supplier.

Using the Approval Scope of “All Suppliers”, the company can manage any over-spending on a
total purchases basis over a specified period.

 
Entry and Display fields

User Name: From the dropdown list select the User to which this Approval Limit record is to apply.

Approval Limit: Enter the limit up to which this User can create/maintain a Purchase Order

Approval Scope: From the drop-down list select the coverage that this record covers.  The
options are described above and are Current Order, Current Supplier, or All Suppliers

Required Date Horizon in days: The approval limit is calculated based on all outstanding
Purchase Orders (status = Open or Receipts) whose Required Date falls within this number of
days (looking back from current date). 
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Use Remaining Value or Order Value: From the drop-down list select the value calculation that
should be applied to the valuation.  The options are:

Remaining Value: based on Remaining Quantity * Buy Price, or
Order Value: based on Order Quantity * Buy Price

Buttons

Close: This will close the Purchase Approval Limits screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Approval Limit record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Approval Limit record

13.9.11 Purchase Rules

This screen allows you to maintain Purchase Rules.  Purchase Rules allow you to define what
rules, within the Purchasing area, you wish to apply.  The following rule settings are available

Entry and Display fields

Purchase Receipt Approvals: ‘Check’ this checkbox if you wish to include Purchase Receipt
Approvals into the Receipt Process.  I.e.

· If this is checked then User Signon Codes designated as having ‘Approval’ rights will
approve Purchase Receipts before they are posted.

· If this is not checked then the ‘Approval’ process will not be used.

Purchase Invoice Approvals: ‘Check’ this checkbox if you wish to include Purchase Invoice
Approvals into the Invoice Process.  I.e.

· If this is checked then User Signon Codes designated as having ‘Approval’ rights will
approve Purchase Invoices before they are posted.

· If this is not checked then the ‘Approval’ process will not be used.

Default Purchase Cost Centre: From the drop-down list select the Cost Centre that will be used
as the default if the Purchase Receipt is not linked to a Cost Centre.  Cost Centres are maintained
via General>Cost Centres

Manually Close Purchases: If this is ‘checked’ then all Purchase Orders must be closed (I.e.
Have their status amended to ‘Closed’) manually.  If this is not ‘checked’ then the program will
evaluate when all the lines in a Purchase Order have been received and automatically amend the
order status to ‘Closed’.

Default Purchase Type: From the drop-down list select the Purchase Order Type that will be used
whenever a Purchase Order is being created.  Purchase Order Types are maintained via
Purchasing>Settings>Purchase Types.

Default Freight Descriptor: From the drop-down list select the Descriptor that will be used as the
default for Freight.  This Descriptor will record all Freight charges and provide a link to where these
charges are to be posted.
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Default Other Descriptor: From the drop-down list select the Descriptor that will be used as the
default for Other Charges.  This Descriptor will record all additional charges and provide a link to
where these charges are to be posted.

New Order Start Tab: From the drop-down list select the preferred tab that will appear when
creating a Purchase Order.  The options are:

Detail: shows the Supplier information for confirmation and amendment
Lines: Goes straight to Purchase Order Line entry.  You can still click on the Detail tab if
you wish to amend the Supplier and Order Header information

Required Date Lead Time: Whenever a new order is created the ‘Required Date’ shown on the
order creation screen will be calculated from the System Date plus this Leadtime.  Of course the
date can be amended during Order creation if required.

Default Order Line Type: From the drop-down list select the Purchase Order Line Type that will
be used as the default to prefill the Purchase Order Line entry screen.   The options available are:

· Item Code
· Descriptor Code
· Catalogue Code

Default Receipt Line Type: From the drop-down list select the Purchase Receipt Line Type that
will be used as the default to prefill the Purchase Receipt Line entry screen.   The options available
are:

· Item Code
· Descriptor Code
· Catalogue Code

Default Invoice Line Type: From the drop-down list select the Purchase Invoice Line Type that
will be used as the default to prefill the Purchase Invoice Line entry screen.   The options available
are:

· Item Code
· Descriptor Code
· Catalogue Code

Default Receipt Style: From the drop-down list select the Style of Receipt that will prefill the
Purchase Receipt's 'Detail' when creating a Receipt.  The options available are:

· Receipts for Order
· Receipts No Order

Default Invoice Style: From the drop-down list select the Invoice Style that will  prefill the
Purchase Invoices's 'Detail' when creating a Invoice record.  The options available are:

· Invoices matched to receipt
· Invoice Only

Order Speed Entry: If this is ‘checked’ then the Order ‘Lines’ panel enables fast entry of orders.
With this feature the cursor will be placed in the ‘Code’ field.  From here you have the following
options:
· Enter the Item Code by either selecting from the drop-down list or keying in the Code.  

Note: If the ‘Enable Auto Complete on Lookups’ is enabled in System Settings then
Ostendo will progressively assess the entry and will auto complete it if the partially entered
code is unique.

· If the required Order quantity is 1 (The Qty field is prefilled with 1) then hit the ‘Enter’ key
on the keyboard to save the current line and commence a new line.  
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· If the required Order quantity is other than 1 then click the ‘Tab’ key on your keyboard to
go the ‘Qty’ field.  Once again, if the remainder of the Order Line is OK click on the ‘Enter’
key otherwise continue with the ‘Tab’ key to go to the next field

Note: When creating a new Order Line the cursor will be positioned in the ‘Code’ field and the Line
Type will be ‘Item Code’.  If you wish to amend this then you can Shift/Tab to go back and amend
the Line Type

Allow Printing for Planned Status: If this is 'checked' then the Purchase Order can be printed
when the Order status is 'Planned'.  If it is not 'checked' then you must change the Order Status
away from 'Planned' before printing is allowed.

Create Invoice when Receipting:  If this is ‘checked’ then whenever a new Receipt record is
generated via Purchase Receipts screen the field ‘Create Purchase Invoice for this receipt on
posting’ will automatically be ‘checked’.   ‘Uncheck’ this default is you don’t require this default
setting.

Invoice Posting Tolerance: Enter a monetary tolerance within which Ostendo will accept an
entered Tax Amount compared to a Supplier's Invoiced Tax Amount in the Purchase Invoice
Screen.   

No Auto Code Creation: In the Purchase Order, Receipts and Invoices screens Ostendo will, by
default, allow the User to create an Item or Descriptor 'on the fly'.  If this checkbox is 'checked'
then this facility is disabled

Default Supplier Invoice Values: If this is checked then the values that appear in the Invoice
Detail's Nett Amount and Tax Amount fields will be calculated from the Purchase Invoice Lines. 
You still have the option to manually overwrite these calculated values in the Purchase Invoice
'Detail' Screen.  If there are any differences between the calculated and entered values then the
Invoice Posting Tolerance (defined above) will be applied.

Default Charges Tax Code: From the drop-down list select the Tax Code that will prefill the
Additional Charges ('Freight' and 'Other') in the Purchase Invoice screen.   If nothing is entered
here then the default Code as defined in the Tax Code screen (File>Financial Configuration>Tax
Codes) will be used

Touch Pad File Name: Click on the three dots icon and locate the .dat file that is to be used for
entry of Order Lines via a screen with Touch Pad facilities.  The .dat file is created via the Ostendo
Graphical Editor.

How to Update Costs for Closed Jobs/Assy Order: This defines how Ostendo deals with extra
costs posted to a closed Job or Assembly Order.  Select the option from the drop-down list.   The
options are:

· Open Order and Update Costs then Leave Open: This re-opens the order, updates the
costs and leaves the order open for manual closing

· Open Order and Update Costs then Close Off: This re-opens the order updates, the costs
and then closes the order.

· No Automatic Opening of Closed Orders: This will prevent additional costs from being
posted, unless the order is re-opened.

Allocate Job Purchases to Stock:  If this is 'Checked' then any Purchase Line originating from a
Job Order's 'Source On Demand' line will have its Allocation Type set to Inventory.  However, the
Allocation Reference field - which is normally blank for Inventory Allocations - will contain the
Source Reference.

Allocate Assembly Purchases to Stock:  If this is 'Checked' then any Purchase Line originating
from an Assembly Order's 'Source On Demand' line will have its Allocation Type set to Inventory. 
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However, the Allocation Reference field - which is normally blank for Inventory Allocations - will
contain the Source Reference.
demand

Purchase Order Approvals:  If this is 'Checked' then the Purchase Approval Limits (as entered
via Purchasing>Settings>Purchase Approval limits) will be applied.

No Self Approval of Purchase Orders Allowed:  If this is 'Checked' then the user cannot
approve his/her own Purchase Orders.

Auto Purchase Line Creation Consolidation:  This defines how Ostendo handles the
consolidation of Purchase Lines during Purchase Order generation from Create Required Orders.
Select the option from the drop-down list.   The options are:

· Separate PO Lines by Source: This is the default option. Separate PO Lines per Source
and Required Date (i.e. Jobs, Sales Orders and Assembly Orders)

· Consolidate PO Lines by Code: This means all orders for a particular code will be
consolidated into one PO line.

· Consolidate PO Lines by Code and Date: This means all orders for a particular code on
the same required date will be combined into one PO Line.

Default Shipment Charges Allocation: Select the default Allocation Method that will be displayed
in the Shipment Charges grid in Purchase Shipments screen. 

Allow Multiple Open Shipments: Tick this box if multiple open shipments are allowed.

Default Shipment Qty to Zero: Tick this box to set the default shipment quantity to zero.

Buttons

Close: This will close the Purchase Rules screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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14 Assembly

14.1 Bills Of Material

This function allows you to maintain Bills Of Material. These BOMs can be used when creating an
Assembly Order

List Tab

Display fields

The displayed fields are taken from the Bill Of Material information entered into the ‘Detail’ tab. 
The selection of which fields to display is at the user’s discretion.  To select the fields to display
simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Bill Of Material screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for entry of the following information that is required when creating
a new Bill Of Material

Item:  From the drop-down list select the Item against which the Bill Of Material is being
created
Create Bill Of Material From Scratch: If this radio button is ‘checked’ then the next field
may be completed

Optional Routing Template: From the drop-down list select a Routing Template.
 This will add the Route from that template to this BOM.  If you do not use a
Routing Template then you can - optionally - create the Route from scratch once
you have gone through this initial screen

Copy BOM from another Item: If this radio button is ‘checked’ then the next field must be
completed 

Select an Item with an existing BOM: From the drop-down list select an Item. 
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Its Bill Of Material will then be copied to the new BOM where it can be amended if
required

Copy BOM Version from selected BOM: If this radio button is ‘checked’ then the next
three fields must be completed; the fourth field being optional.  

Selected Bill Of Material: is prefilled with the current selected BOM from the
main 'List' or 'Detail' view.
Selected Version: is prefilled and is taken from the current selected BOM from
the main 'List' or 'Detail' view.
New Version: Enter your identifier for the new version.  (Example: Engineering
Change Note 1234). Duplicate Versions not allowed.
Version Description: Enter your description of the new Version.  No checks are
made on the entry.

Buttons
Create: Click the ‘create’ button to take you to the ‘Details’ tab for entering further
information.
Cancel: Click the ‘cancel’ button to exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Bill Of Material from this table

Related: This will bring up a list of functions that are related to the Bill Of Material.  You may open
and maintain information in those screens whilst still remaining in the Bill Of Material screen.

Reports: This will bring up a list of Reports that are related to the Bill Of Material. You can
immediately run the report whilst still remaining in the Bill Of Material screen.

Set Current:  This button is only visible when record's version is 'Non Current'.  Clicking this
button will change the current 'Non Current' record to a 'Current' version and will also revert the
existing 'Current' version to 'Non Current'

Detail Tab

The Detail Tab allows you to enter Times against this BOM in addition to identifying Process Steps
and required Resources.

Entry and Display fields

Item Code: Display only field showing the ‘Parent’ Item identity

Unit: Display only field showing the base unit for the Parent Item

Description: Display only field showing the description of the Parent Item

Version:  Display only field showing the BOM version. 

Version Description:  Description of the BOM version.   This can be amended here if required.
No checks are made on the entry

Status: Display only field showing the current status of the Parent Item.  The possible display
options are:

· Active



731Assembly

· Planned
· Run-Out
· Obsolete

Sourced By: Display only field showing how the Parent Item is normally procured.  The possible
display options are:

· Purchasing
· Assembly
· Custom

BOM Batch Size: This is prefilled with 1 to represent that all the components in the BOM will
make 1 of this parent item.  You may amend this Batch Size if required.  The quantities entered in
the Lines tab should relate to this Batch Size.  If components already exist when you amend this
Batch Size then they will be automatically be adjusted to reflect the change.

Leadtime & Duration Settings

Leadtime (Days): The leadtime is used by the Replenishment routine to calculate a Suggested
Assembly Order start date from its Required Date.  It is preflilled with the Leadtime taken from the
Item’s Master record.  It can be amended here and made specific to this BOM.     
Duration Settings: The Duration Settings allow the Assembly Order generation function to
establish a realistic duration for the quantity being made.  The Duration Settings have two
elements:

Set Up - the time required to set up to make the Item and this is carried out once per
Assembly Order.
Run - The time required to make each Item and this is multiplied by the Order quantity
when creating the Assembly Order

Complete the following Duration Settings fields:
· Run Time - Enter the Time per ‘Time Unit’ to make the ‘Per Qty’
· Time Unit - The Run Time Unit (Drop Down options are Hours or Minutes)
· Per Qty - Enter the quantity being made in the ‘Run Time’ duration
· Setup Time - Enter the duration to Setup in preparation to make the Item
· Time Unit - The Setup Time Unit (Drop Down options are Hours or Minutes)

Qty Used for setup Cost Ratio: As described in the above ‘Duration Settings’ the Setup is carried
out once per Assembly Job.  For costing purposes the cost of this Setup should be apportioned
across the quantity being made.  As that actual Order quantity can vary this field is available to
annotate a ‘nominal’ quantity used for cost roll-up purposes.  It is prefilled with 1 but you should
amend this to an ‘Average’ Order Quantity

Phantom Setting: If this is ‘checked’ then, whenever this Item appears as a component in another
BOM, the order will replace this Item with its Components.   Note: this will be repeated for
multi-level phantoms.  Although this could be ‘checked’ it will not prevent this Item from being
ordered in its own right.

Instructions: You can enter unlimited amount of instructions that relate to this Bill Of Material.
These Instructions will be available for printing on Assembly Order documents.  Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Routing Steps - Sub Tab

This sub-tab enables you to create the process steps required to make the Assembly.  The
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available fields are:
· Seq - The Assembly Order documents are printed in Step sequence.  Upon creation of a

step the program will increment the previous step by 10.  You can amend this as
required.

· Step - Enter a short name for the Step.  No checks are made against this entry
· Description - Enter a brief description of the Step.
· Department - From the drop-down list select the Department in which this sequence is

carried out.
· Instructions - Unlimited lines of Instructions on what to do during this step can be

entered.   
· If you have defined Additional Fields against BOM Steps (created via System

Configuration>Additional Fields) then an addition tab will be presented which, when
selected, will display the available fields.  Enter information in line with the available field
formats:
o Text: Any data format can be entered in a Text field
o Decimal: Allows entry of numbers and decimals
o Integer: Allows entry of whole numbers only
o Currency: Shows Currency symbol and decimals as defined in Regional Settings
o Yes/No: Shows a checkbox which can be checked/unchecked
o Date: Contains a drop-down calendar for selection of a date
o Time: Displays format HH:MM:SS for entry of a time of day

· Step Overlap - From the drop-down list select the Scheduling Overlap that will apply to
subsequent Steps in the process.  The options are
o End of Step: The next step will commence at the end of this Step taking into account

the Overlap and Buffer Minutes
o Beginning of Step: The next step will commence in parallel to this Step taking into

account the Overlap and Buffer Minutes
· Overlap Minutes - Enter the minutes that the subsequent Step can overlap this step 
· Buffer Minutes - Enter the minutes that the subsequent Step must wait before it can

begin

Routing Resources - Sub Tab

This sub-tab enables you to add Resource requirements to each step.  The Resource can be
either an Employee or a Company Asset.  The available fields are:

· Step Seq - A display only field showing the Step Sequence selected on the ‘Routing Step’
panel.

· Step - A display only field showing the short of the step as entered into the ‘Routing Step’
panel

· Resource Type - From the drop-down list select the Resource Type that you are adding
to this Step.  The options are Employee or Asset

· Resource Name - From the drop-down list select the specific Employee or Asset that will
be used during this Step.

BOM Hazards - Sub Tab

This sub-tab enables you to link hazards and/or instructions to the Bill of Materials steps. The
fields are:

· Step Name - Optional. Select a step from the drop-down or leave blank.
· Hazard Style - Select either Group or Code style. 
· Group or Code - Select the appropriate Group or Code as per style selected earlier.

Code refers to a specific hazard/instruction, while Group refers to a group of
hazards/instructions.

· Override Details - Ticking this box allows you to override the details of the
hazard/instruction.
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· Description - This is a description of the hazard/instruction or group of
hazards/instructions.

· Location - This is the location of the hazard/instruction.
· Notes - These notes further describe the hazard/instruction. 

By-Products & Co-Products - Sub Tab

This sub-tab enables you to define additional outputs to the main product covered under this Bill of
Material.  The outputs can be one of two types

Co-Products: These are planned products that will be produced along with the Main Product.  The
Cost attributed to a Co-Product will be expressed as a percentage of the Assembly Cost.  The
difference between the sum of the Co-Product costs and the Assembly Cost represents the Cost
of the Main Product.  A check is made to ensure that the sum of the Co-Product Cost percentages
must be equal to, or less than 100%.  

By-Products: These are products that MAY be generated as a result of making the Main Product.
If a By-Product is produced then the costs attributed to it will be the percentage held against the
Bi-Product Line multiplied by the Assembly Order Cost.

In both the above instances the evaluated cost is displayed during receipt into stock and you have
the option to amend the cost if required.

The available fields are:

Code - From the drop-down list select the Item code of the By-Product or Co-Product.
  
Description - Display only field showing the description of the By-Product or Co-Product.

Qty - For this By-Product enter the quantity normally made when producing one of the Main
product.

Unit - Display only field showing the base Unit held against the Item Code. 

Cost% - Enter the percentage of the Assembly Cost that will be allocated to this line.  The sum of
all Cost percentages against all By-Product Lines cannot exceed 100%.

Style - From the dropdown list select whether the line is a By-Product or Co-Product

Costing & Pricing - Sub Tab

This sub-tab allows you to view the current costs and estimated Sell Price for the Bill Of Material. 
It includes facility to amend the Margin% to adjust the estimated Sell Price.in this view

Rolled Up Item Costs: Display only field showing the Rolled-up Cost of the Items included in this
Bill of Material

Rolled Up Descriptor Costs: Display only field showing the Rolled-up Cost of the Descriptors
included in this Bill of Material

Rolled Up Labour Costs: Display only field showing the Rolled-up Cost of the Labour Codes
included in this Bill of Material

Total Rolled Up Costs: Display only field showing the sum of the previous three fields
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Unit Rolled Up Cost: Display only field showing the calculated Cost per Parent Item  when using
this Bill Of Material

Estimated Markup%: Enter the Markup% that you would apply to an Assembly to determine the
estimated Sell Price. 

Estimated Unit Sell Price: Display only field showing the calculated Sell Price based on the Unit
Rolled Up Cost multiplied by the Estimated Markup%.  This is for information only and is not held
in the database

Additional Fields - Sub Tab

If you have defined Additional Fields against the BOM (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Buttons

Close: This will close the Bill Of Material screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This button applies to the Routing Steps and Routing Resources tabs only and, when clicked
will send the cursor to a new line for creation of a new Routing Step or Routing Resource.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This button applies to the Routing Steps and Routing Resources tabs only and, when
clicked will delete the current highlighted line.

Related: This will bring up a list of functions that are related to the Bill Of Material.  You may open
and maintain information in those screens whilst still remaining in the Bill Of Material screen.

Reports: This will bring up a list of Reports that are related to the Bill Of Material. You can
immediately run the report whilst still remaining in the Bill Of Material screen.

Lines Tab

The Lines Tab enables you to add and amend Components to this Bill Of Material. The added
Components can include Items, Descriptors or Labour Codes.  NOTE: If the BOM is 'non current'
then components which are made 'Obsolete' in the Item Master screen will still be displayed here.  
However the Bill Of Material version cannot be amended to 'Current'

Entry and Display fields
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This screen allows you to add and maintain Component Lines in the Bill of Material.

Bill of Material Lines can be created from the following sources:
· Lists
· Items
· Descriptors
· Manual

Each Method is described here

Lists: Lists are pre-defined Lists of Item Codes, Descriptor Codes, and Labour Codes from which
selections are made.  Maintenance of Lists is covered in it’s own section within this guide.   To
use ‘Lists’ click on the ‘Lists’ icon on the Batch Entry toolbar.  On the displayed panel use the
drop-down list to select the specific List.   This will display the contents of the List. Now ‘check’ the
checkbox against each line that you want to be copied to the Purchase Order.  You have the
option to click on the ‘Select All Contents’ Button at the bottom of this panel to select all the
records.  You may also click on the ‘De-select All Contents’ Button at the bottom of this panel to ‘
un-select’ all the records.   For each selected record you can amend the ‘Per Qty’ to denote the
quantity you require per ‘List’.  You can enter a multiplying quantity in ‘Multiplied Contents By’ field,
which will extend the above ‘Per Qty’ by this factor.
If you now click on the ‘Create Lines from Selected Contents’ Button then all the selected Lines will
be copied to the Assembly Order. 

Items: To select single or multiple Items click on the ‘Items’ icon on the Batch Entry toolbar.  This
will display all Items that are currently ‘Active’.   Simply highlight the Item in the top panel then click
the ‘Add to Selected Items’ Button to copy it to the lower part of the screen.  Repeat this for all
required Items.  In the Lower panel amend the required quantity per line as required, or remove the
line by clicking on the ‘Remove from Selected Items’ Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Assembly Order. 

Descriptors: To select single or multiple Descriptors click on the ‘Descriptors’ icon on the  Batch
Entry toolbar.  This will display all Descriptors that are currently ‘Active’.   Simply highlight the
Descriptor in the top panel then click the ‘Add to Selected Descriptors’ Button to copy it to the
lower part of the screen.  Repeat this for all required Descriptors.  In the Lower panel amend the
required quantity per line as required, or remove the line by clicking on the ‘Remove from Selected
Descriptors’ Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Assembly Order. 

Manual: You can create Manual Order Lines by clicking on the ‘Add’ Button to the right of the
screen.  A Line is created in the upper panel, however maintenance of the record is carried out in
the lower panel.    

The Upper display panel shows all the components that are currently used in this Bill Of Material. 
The maintenance of those records are carried out in the lower part of the screen as follows:

Line Number: The Assembly Order documents are printed in Line Number within Step sequence.
Upon creation of a new component line the program will increment the previous line by 10.  You
can amend this as required.

Line Type: From the drop-down list select the Component Line Type.  The options are:
· Item Code
· Descriptor Code
· Labour Code
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Code: From the drop-down list select the specific component code.  The list will show details
relating to the Line Type option selected.

Unit: Prefilled with the Unit held against the Code.   If the Line Type is ‘Item Code’ and the
selected Item has multiple Units of Measure then you can select the specific Unit from the
drop-down list

Quantity: Enter the quantity of this Code that is required to make the parent Item. 

Scrap%: Enter the scrap factor (as a percentage) that you expect to incur during production of the
parent Item.  For example: If you normally scrap 2 for every 10 good assemblies then enter 20%

Description: Display only field showing the description of the Code taken from the Item,
Descriptor, or Labour record

Position Reference: Open format field where you can identify - for example - the drawing grid
reference or the location that it is used on a large assembly.  No checks are made on this entry.

Run or Setup: This is only visible if the Assembly Rules indicate that you are using ‘Setup’.  From
the drop-down list select whether this line is used during Setup or as a component in the final
assembly.  This dictates how the Assembly Order creation routine addresses the quantity held
against this line.  I.e.

· If it is ‘setup’ then the quantity specified will be used
· If it is ‘run’ then the quantity specified will be multiplied by the Order quantity

Step Seq: Display only field showing the step sequence of the Step selected in the next field.  This
field is only visible if the Assembly Rules indicate that you are using ‘Steps’. 

Step: This field is only visible if the Assembly Rules indicate that you are using ‘Steps’.  From the
drop-down list select the Routing Step where this line is to be used.  The drop-down list will show
all the current Steps held against this Bill Of Material

Line Instructions: You can enter unlimited amount of instructions that relate to this Line within the
Bill Of Material.  These Instructions will be available for printing on Assembly Order documents. 
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Line Additional Fields - Sub Tab

If you have defined Additional Fields against the BOM Line (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Buttons

Close: This will close the Bill Of Material screen.  If you have any unsaved data then you will be
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asked if you wish to save it before the screen is closed.

Add: This button will generate a new Line No in the Lower panel in preparation for entering a new
Line to the Bill Of Material.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This button will delete the current highlighted line.

Related:     This will bring up a list of functions that are related to the Bill Of Material.  You may
open and maintain information in those screens whilst still remaining in the Bill Of Material screen.

Reports:     This will bring up a list of Reports that are related to the Bill Of Material.  You can
immediately run the report whilst still remaining in the Bill Of Material screen.

BOM Tree Tab

This is a display only screen that shows a multi-level BOM explosion of the current parent Item.  If
you wish to view a 'Where-Used' inquiry then click on the 'Related' Button to the right of this screen
and select 'Where Used Inquiry'

Features Tab

The Features Tab is only visible if the Item is Sourced By 'Custom' and Configured By 'Features'. 
This screen enables you to define the Features and Options which will be used when configuring
this Item in a Sales or Job Order.

In the upper portion of this screen is displayed all the Features that have been entered in the lower
portion.  The lower part of the screen enables you to create and maintain Features along with all
Options used within each feature.

Entry and Display fields

Upper Panel

The Upper display panel shows all the Features that have been entered against this Item

Sequence: Display only field showing the Sequence Number related to this Feature. 

Feature: Display only field showing the Identity of the Feature as entered in the lower part of this
screen

Step: Display only field showing the Assembly Step where this feature is used.

Instructions: Display only field showing the Instruction held against this feature

Group Seq: Display only field showing the Group Sequence Number to which this line belongs.

Feature Group: Display only field showing the Feature Group to which this line belongs.
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Feature Tab

You can define and maintain the Features you wish to apply to this product.  

Group Seq: Display only field showing the Group Sequence Number of the Feature Group
selected in the next field

Feature Group: This is an optional entry field and facilitates the grouping of Features for reporting
purposes, etc.  When used you can select the Feature Group from the drop-down list.  Feature
Group are maintained via the 'Feature Groups' tab in this screen

Seq No: A user-defined number that dictates the Sequence in which the Features are presented
during Configuration.  

Feature: Enter the name of this Feature.  This can be up to 100 characters in length and will be
displayed during configuration for selection of the Option linked to this Feature

Step: From the drop-down list select the Step where this Feature is used.  The displayed Steps are
those included in this BOM via the Routing Step tab in the 'Detail' screen.

Instructions: Insert any additional instructions that will be referenced along with this Feature
during Product Configuration

Options Tab

You can define and maintain Options which can be selected against the current Feature

Option Name: Enter a brief narrative that describes the Option.  This will be displayed
when selecting an Option from the parent Feature

Code Type: From the drop-down list select the Code Type.  The options are Item Code,
Descriptor Code, or Labour Code

Option Code: From the drop-down list select the Item Code, Descriptor Code, or Labour
Code that will be added to, or subtracted from, the configured BOM.

Qty per Feature: Enter the quantity of the Item Code that will be added or subtracted from
the Configured BOM.  To demonstrate the quantity Add/Replace/Reduce process, see the 
Examples below:

Option Price: Enter the total Price of this Option that will be applied when it is selected. 
This can be either a positive or negative amount.

Description Segment: This is an optional entry field in which you can enter a series of
characters that will provide a configured description.   For example; if the Description of
the Main BOM Item is 'Workbench' and a Feature called 'Number of Drawers' has three
Options, each with their own Description Segment

       Option      Description Segment
No Drawers /No Drawers
1 Drawer /1 Drawer
2 Drawers /2 Drawers

The Description of the Configured product would combine the Base Item's Description plus
the Option's Description Segment to give a Description of Workbench/1Drawer



739Assembly

Option Instructions: Insert any additional instructions that will be referenced along with
this Option during Product Configuration

Feature Groups Tab

Feature Groups facilitates the grouping and sequencing of like features

Group Sequence: A unique number that dictates the Sequence in which the Features Groups are
presented.  Each line is prefilled in increments of 10 but can be manually amended if required.

Group: Enter the name of this Feature Group.  No checks are made on the entry

Buttons

Close: This will close the Bill Of Material screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This button will generate a new Line No in the Lower panel in preparation for entering a new
Line to the Bill Of Material.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This button will delete the current highlighted line.

Related:     This will bring up a list of functions that are related to the Bill Of Material.  You may
open and maintain information in those screens whilst still remaining in the Bill Of Material screen.

Reports:     This will bring up a list of Reports that are related to the Bill Of Material.  You can
immediately run the report whilst still remaining in the Bill Of Material screen.

Examples of a Configuration

The Basic BOM would have a structure of (say)

                                     A (with Description Parent)
                          |

--------------------------------------------------------------------------------
|                                     |                     |

        B (3 off)                        C (2 off)                                   D (1 off)
                Step: Assembly           Step: Assembly                      Step: Heat Treat
                Line# 1                        Line# 2                                   Line# 1

Using the above 'Base' BOM you can configure the BOM as follows:
· Add new Item
· Increase Quantity
· Decrease Quantity
· Remove Item
· Replace Item                 

Example 1: Add new Item
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In this example we will add a new Item (E) to the Assembly Step

Create a Feature using the following
Sequence: 10
Feature: Adding a Selected Option
Step: Assembly

Add the following Option to this Feature
Option Name: Selecting your Item
Option Item: E
Qty Per Feature: 2
Option Price: 16
Description Segment: /Item E

If you now raise a Sales Order for A and - in the Item Code field – click on the third Icon you can
configure the Product.   Click on the 'Related' button and select 'Create Required Assembly Order'
and convert the Configured Product into an Assembly Order.   Note that the Description of the
Configured Product is a combination of the Parent Item A's description plus the Option's
Description Segment.  I.e. Parent/Item E

Example 2: Increase quantity of an existing Item

In addition to adding new Item (E) to the Assembly Step we will increase the quantities against
Item B by 2 and Item C by 4.  This first thing that you need to do is tell Ostendo the SPECIFIC
Component that you are increasing.  To do this you should provide not only the Item Code but also
the Assembly Step and the Step Line Number.  Therefore we need to tell the Features and
Options function that we are amending the quantities against

Item B Step: Assembly Line# 1 Quantity: 2
Item C  Step: Assembly Line# 2 Quantity: 4                  

To achieve this you should first create a 'Phantom' BOM therefore create a new Item Code called
(say) 'Phantom M'.     Go into Assembly>Bills of Material and define it as being a Phantom
Assembly.  Go into the Routing Steps screen and add Assembly and Heat treat
Go into the Lines tab of the Bill of Material and add the following:

Item B Step: Assembly  Line# 1
Item C  Step: Assembly              Line# 2                           

Now go into the parent A's Bill of Material and select the 'Features' tab.  Add a new Feature

 
Create another Feature using the following

Sequence: 20
Feature: Increasing the quantity
Step: Assembly (Note: Must have the same Step as 'C' in the main BOM) 

Add the following Option to this Feature
Option Name: Increase the quantities
Option Item: Phantom M
Qty Per Feature: 1
Option Price: 8
Description Segment:

If you now raise a Sales Order for A and - in the Item Code field – click on the third Icon you can
configure the Product.   Click on the 'Related' button and select 'Create Required Assembly Order'
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and convert the Configured Product into an Assembly Order.   You will see that because the Item
Phantom M is a phantom the Assembly Order generation process will 'Blow Through' the Phantom
and match up the Item Code/Step Name/Line Number of the Option and will find that it exists in the
main BOM.  Therefore Ostendo will combine the base and Option quantities together in the final
Assembly Order

Example 3: Decrease quantity of an existing Item

This is similar to Example 2 except that the quantity entered in the option is a negative quantity.  

Example 4: Remove an Item

This is similar to Example 2 except that the quantity entered in the option is a negative quantity that
equals the quantity in the Main BOM.   As the sum of the two quantities is now zero Ostendo will
ignore the line when creating the Assembly Order.  

Example 5: Replace an Item

This is an extension to Example 4 where the Item being replaced has a negative quantity equal to
the positive quantity in the Main BOM.   As the sum of the two quantities is now zero Ostendo will
ignore the line when creating the Assembly Order.  Then, within the same Phantom Assembly, you
would add the new Item.   In this example we will replace Item D with Item G

Therefore go into Inventory>Items and create a new Item 'G' 

As earlier the first thing that you need to do is tell Ostendo the SPECIFIC Component that you are
deleting.  To do this you should provide not only the Item Code but also the Assembly Step and the
Step Line Number.  Therefore we need to tell the Features and Options function that we are
amending the quantities against.  I.e.

Item D Step: Heat Treat Line# 1 Quantity: -1                  

To achieve this you should first create a new Item Code called (say) 'Replace'.     Now go into
Assembly>Bills of Material and create a Bill of Material for this Item and define it as being a
Phantom Assembly.  Go into the Routing Steps screen and add Heat treat
Go into the Lines tab of the Bill of Material and add the following:

Item D Step: Heat Treat Line# 1 Quantity: -1
Item G  Step: Heat Treat Line# 1 Quantity: 1                 

Now go into the parent A's Bill of Material and select the 'Features' tab.  Create another Feature
using the following

Sequence: 30
Feature: Changing an Item
Step: Heat Treat (Note: Must have the same Step as 'D' in the main BOM) 

Add the following Option to this Feature
Option Name: Increase the quantities
Option Item: Replace
Qty Per Feature: 1
Option Price: 8
Description Segment:

If you now raise a Sales Order for A and - in the Item Code field – click on the third Icon you can
configure the Product.   Click on the 'Related' button and select 'Create Required Assembly Order'
and convert the Configured Product into an Assembly Order.     If you open the Assembly Order
you will find that component D had been replaced by component G
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14.1.1 History Notes

This function allows you to link multiple time-stamped notes to a Bill Of Material record.    This
screen can be accessed by clicking on the 'Related' button down the right of the 'Bills Of Material
Screen' and selecting 'History Notes'.

List Tab

Display fields

The displayed fields are taken from the BOM master record.  The selection of which fields to
display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the BOM History Notes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The BOM Item Code to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.



743Assembly

Reference: A short description of the entry.  No validation checks are carried out.

Call Classification: From the drop-down list select a Classification under which you wish to store
this History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.   Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this BOM is displayed in the lower part of the screen.   Each
record will also have the first 3 lines of the notes displayed.   To view the full Notes simply click on
the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the BOM History Notes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a BOM History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current BOM History Notes record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

14.2 Custom Products

Custom Products utilises the extensive flexibility of Pascal Scripting to enable you to establish a
simple Question and Answer routine to generate a full product configuration with quantities and
costs to support Quoting, Sales, and Job Ordering.  The finished ‘Custom Product’ can be
converted to an Assembly Order for manufacture.

List Tab

Display fields
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The displayed fields are taken from the Custom Products information entered into the ‘Detail’ tab.
 

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Custom Products screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for entry of the following information that is required when creating
a new Custom Product

Create Custom Product From Scratch: If this radio button is ‘checked’ then the next field
must be completed

Item:  From the drop-down list select the Item against which the Custom Product
Script will be created.  This list will only show those Items that have Sourced By of
'Custom' and Configured By of 'Rules'

Copy Custom Product Design from another Item: If this radio button is ‘checked’ then
the next two fields must be completed 

Select an Item with an existing Custom Design: From the drop-down list select an
Item.   Its Custom Product Script will then be copied to the new Product where it can
be amended if required
Copy Custom Design To:  From the drop-down list select the Item against which the
Custom Product Script will be copied.  This list will only show those Items that have
Sourced By of 'Custom' and Configured By of 'Rules'

Buttons
Create: Click the ‘create’ button to take you to the ‘Details’ tab for entering further
information.
Cancel: Click the ‘cancel’ button to exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Custom Product Script from this table

Related: This will bring up a list of functions that are related to Custom Products.  You may open
and maintain information in those screens whilst still remaining in the Custom Products screen.

Reports: This will bring up a list of Reports that are related to the Custom Products. You can
immediately run the report whilst still remaining in the Custom Products screen.
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Detail Tab

The Detail Tab allows you to enter reference details relating to this Custom Script.

Entry and Display fields

Item Code: Display only field showing the Custom Product's Item identity

Description: Display only field showing the description of the Item

Unit: Display only field showing the base unit for the Item

Revision Notes: Enter notes related to this Custom Product.

Buttons

Close: This will close the Custom Products screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for entry of the following information that is required when creating
a new Custom Product

Create Custom Product From Scratch: If this radio button is ‘checked’ then the next field
must be completed

Item:  From the drop-down list select the Item against which the Custom Product
Script will be created.  This list will only show those Items that have Sourced By of
'Custom' and Configured By of 'Rules'

Copy Custom Product Design from another Item: If this radio button is ‘checked’ then
the next two fields must be completed 

Select an Item with an existing Custom Design: From the drop-down list select an
Item.   Its Custom Product Script will then be copied to the new Product where it can
be amended if required
Copy Custom Design To:  From the drop-down list select the Item against which the
Custom Product Script will be copied.  This list will only show those Items that have
Sourced By of 'Custom' and Configured By of 'Rules'

Buttons
Create: Click the ‘create’ button to take you to the ‘Details’ tab for entering further
information.
Cancel: Click the ‘cancel’ button to exit this panel

Save: Not applicable to the Detail panel

Cancel: Not applicable to the Detail panel

Delete: This removes the current Custom Product Script from this table

Related: This will bring up a list of functions that are related to Custom Products.  You may open
and maintain information in those screens whilst still remaining in the Custom Products screen.

Reports: This will bring up a list of Reports that are related to the Custom Products. You can
immediately run the report whilst still remaining in the Custom Products screen.

Script Tab
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The Script Tab allows you to enter reference details relating to this Custom Script.

A ‘normal’ Custom Product Script has 3 segments

· Declare Variables
· Ask the Questions
· Generate the Custom Product

The more experienced programmer can intermingle the segments to produce a more streamlined
solution.

In addition to the standard Pascal Scripting functions some functions have been specifically
created for Ostendo’s Custom Product Configurator; these are shown below

Declare Variables

You should declare all variables being used in this script.  The standard format is used.  For
example

Var
  TimberType: String;
  DeskLength: Double;
  DeskDepth: Integer;

Ask the Questions

Four basic functions have been created for you to ask questions.  Whenever you run the Custom
Product generator these questions are presented to the screen for entry of answers to determine
the finished product.

Variable := AskMandatoryQuestion(‘Question’,’TYPE’, ‘Explanation’, ‘[d]List1, List2, List3’,
Current);

This type of question must be answered.  

The elements that make up this function are:
Variable: The variable defined in the above ‘Var’ section
Question: Define the question (max 200chars) enclosed on ‘commas’
TYPE: This is INTEGER, TEXT, DOUBLE, DATE, BOOLEAN, or TEXT LIST
Explanation: A longer explanation that can be referenced during configuration
[d]: Optional entry to define a default display entry from the List 
List: Allowable options - separated by a comma
Current: Optional Entry to prefill question with current answer if re-doing questions

Example: TimberType := AskMandatoryQuestion('Please select the type of Timber
','TEXT','Rimu provides a better finish','[d]Pine,Rimu',TimberType);

Variable := AskMandatoryQuestionWithLookup(‘Question’,‘Explanation’,LookupIndex,Current);

This type of question must be answered.  

The elements that make up this function are:
Variable: The variable defined in the above ‘Var’ section
Question: Define the question (max 200chars) enclosed on ‘commas’
Explanation: A longer explanation that can be referenced during configuration
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LookupIndex: The Index Reference of the Ostendo Table
Current: Optional Entry to prefill question with current answer if re-doing questions

Example: ItemNo := AskMandatoryQuestion('Please select the Item Number','User
Defines what is to be used',1004,ItemNo);

Variable := AskQuestionNumericRange(‘Question’,’TYPE’,’Explanation’, MinValue , MaxValue,
Increment,Current);

The elements that make up this function are:
Variable: The variable defined in the above ‘Var’ section
Question: Define the question (max 200 chars) enclosed on ‘commas’
TYPE: this is either DOUBLE or INTEGER
Explanation: A longer explanation that can be referenced during configuration
MinValue: The numeric value denoting the minimum value allowed during data entry
MaxValue: The numeric value denoting the maximum value allowed during data entry
Increment: A numeric value denoting the incremental steps within the range.  If nothing is
entered then any value in the range will be accepted.
Current: Optional Entry to prefill question with current answer if re-doing questions

Example 1: DeskLengthInteger := AskQuestionNumericRange('Please enter the Length
(mm) of the Desk', 'INTEGER','We can only make desks between 1000mm - 3000mm in
length',1000,3000,10,DeskLengthInteger);

Example 2: DeskLengthDouble := AskQuestionNumericRange('Please enter the Length
(m) of the Desk', 'DOUBLE','We can only make desks between 1.000m - 3.000m in
length',1,3,0.01,DeskLengthDouble);

Variable := AskQuestion(‘Question’,’TYPE’, ‘Explanation’, ‘[d]List1, List2, List3’,Current);

The elements that make up this function are:
Variable: The variable defined in the above ‘Var’ section
Question: Define the question (max 200chars) enclosed on ‘commas’
TYPE: This is INTEGER, TEXT, DOUBLE, DATE, BOOLEAN, or TEXT LIST
Explanation: A longer explanation that can be referenced during configuration
[d]: Optional entry to define a default display entry from the List 
List: Allowable options - separated by a comma
Current: Optional Entry to prefill question with current answer if re-doing questions

Example: TimberType := AskQuestion('Please select the type of Timber ','TEXT','Rimu provides a
better finish','[d]Pine,Rimu',TimberType);

Generate the Custom Product

Within this step you can:

· Access the Ostendo Database to get information
· Define If / Then / Else conditions
· Construct the finished Product

1.  The following functions are available to get information from the database

Variable := GetCost(‘CodeType’,’Code’);

This will access the Ostendo Database and get the Standard Cost of the selected Item, Descriptor,



748 Ostendo Reference Guide

or Labour.  The elements that make up this function are:
Variable: The variable defined in the above ‘Var’ section
Code Type: Descriptor, Item or Labour
Code: The actual Code of the Descriptor, Item or Labour

Example: PartCost1 := GetCost('Item','10234A24');

Variable := GetStdSellPrice(‘CodeType’,’Code’);

This will access the Ostendo Database and get the Standard Sell Price of the selected Item,
Descriptor, or Labour.  The elements that make up this function are:

Variable: The variable defined in the above ‘Var’ section
Code Type: Descriptor, Item or Labour
Code: The actual Code of the Descriptor, Item or Labour

Example: PartSell1 := GetStdSellPrice('Item','10234A24');

Variable := GetCustomerSellPrice(‘CodeType’,’Code’);

This will access the Ostendo Database and get the Sell Price of the selected Item, Descriptor, or
Labour linked to the Customer defined in the Order.  The elements that make up this function are:

Variable: The variable defined in the above ‘Var’ section
Code Type: Descriptor, Item or Labour
Code: The actual Code of the Descriptor, Item or Labour

Example: CustSell1 := GetCustomerSellPrice('Item','10234A24');

Variable := GetStdBuyPrice(‘CodeType’,’Code’);

This will access the Ostendo Database and get the Standard Buy Price of the selected Item,
Descriptor, or Labour.  The elements that make up this function are:

Variable: The variable defined in the above ‘Var’ section
Code Type: Descriptor, Item or Labour
Code: The actual Code of the Descriptor, Item or Labour

Example: PartBuy1 := GetStdBuyPrice('Item','10234A24');

Variable := GetStringFromTable(‘TableName’,’FieldName’,’KeyField’,’KeyValue’);

This will access the Ostendo Database and get the contents of a field in a nominated record.  The
elements that make up this function are:

Variable: The variable defined in the above ‘Var’ section
TableName: The name of the Ostendo Table containing the string
FieldName: The Field Name within the Table containing the string
KeyField: The Field against which you are identifying the specific record
KeyValue: The Specific record identity within the Key Field

Example: PartString1 := GetStringFromTable('ITEMMASTER','ITEMBARCODE’,’
ITEMCODE’,’10234A24');

Variable := GetBooleanFromTable(‘TableName’,’FieldName’,’KeyField’,’KeyValue’);

This will access the Ostendo Database and get the Boolean Value of a field in a nominated record.
The elements that make up this function are:

Variable: The variable defined in the above ‘Var’ section
TableName: The name of the Ostendo Table
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FieldName: The Field Name within the Table containing the Boolean Value
KeyField: The Field against which you are identifying the specific record
KeyValue: The Specific record identity within the Key Field

Example: PartYesNo1 := GetBooleanFromTable ('ITEMMASTER','WARRANTYAPPLIES’,
’ITEMCODE’,’10234A24');

Variable := GetIntegerFromTable(‘TableName’,’FieldName’,’KeyField’,’KeyValue’);

This will access the Ostendo Database and get the Integer Value of a field in a nominated record. 
The elements that make up this function are:

Variable: The variable defined in the above ‘Var’ section
TableName: The name of the Ostendo Table
FieldName: The Field Name within the Table containing the number
KeyField: The Field against which you are identifying the specific record
KeyValue: The Specific record identity within the Key Field

Example: PartYesNo1 := GetIntegerFromTable ('ITEMMASTER','REORDERLEVEL’,’
ITEMCODE’,’10234A24');

Variable := GetDoubleFromTable(‘TableName’,’FieldName’,’KeyField’,’KeyValue’);

This will access the Ostendo Database and get the numeric value including decimals of a field in a
nominated record.  The elements that make up this function are:

Variable: The variable defined in the above ‘Var’ section
TableName: The name of the Ostendo Table
FieldName: The Field Name within the Table containing the number
KeyField: The Field against which you are identifying the specific record
KeyValue: The Specific record identity within the Key Field

Example: PartYesNo1 := GetIntegerFromTable ('ITEMMASTER','AVERAGECOST’,’
ITEMCODE’,’10234A24');

Variable := GetDateFromTable(‘TableName’,’FieldName’,’KeyField’,’KeyValue’);

This will access the Ostendo Database and get the date currently held in a field in a nominated
record.  The elements that make up this function are:

Variable: The variable defined in the above ‘Var’ section
TableName: The name of the Ostendo Table
FieldName: The Field Name within the Table containing the date
KeyField: The Field against which you are identifying the specific record
KeyValue: The Specific record identity within the Key Field

Example: PartYesNo1 := GetIntegerFromTable ('ITEMMASTER','LASTCOSTDATE’,’
ITEMCODE’,’10234A24');

2.  The following are predefined constants that are available to you

CUSTOMPRODUCTCUSTOMER = Order Customer Name

CUSTOMPRODUCTCODE  = The ‘Custom’ Product Code

CUSTOMSALESORDERNUMBER = The Order Number containing this Custom Product

CUSTOMSALESLINEID = The Line No within the Order that contains this Custom Product
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3.  The following are predefined constants that can be configured

CUSTOMPRODUCTDESCRIPTION := ‘Description’;

Where ‘Description' is your assemble description of the Custom Product

Example:  CustomProductDescription := TimberType + ' Office Desk ' +
IntToStr(DeskLength) + 'mm x ' + IntToStr(DeskDepth) + 'mm with ' + Drawers;

LINEQTY := Qty;

Where Qty is the evaluated quantity for this Order Line

Example:  LineQty := 24;

LINEUNITPRICE := Qty;

Where Qty is the evaluated Unit Sell Price for this Order Line

Example:  LineUnitPrice := 36.67;

4.  The following functions enable you to assemble the Bill of Material Steps, Lines, and
Resources

InsertBOMHeader(‘Description’);

This is required to define that a BOM is being created.   The elements that make up this function
are:

Description: A description of the created BOM (max 50 chars).  Blank if not specified

Example: InsertBOMHeader; 

InsertBOMProperty(‘PropertyName’,’PropertyValue’);

If you wish to add Properties to the BOM then use this function.  The elements that make up this
function are:

PropertyName: The name of the Property (max 20 chars)
PropertyValue: The value being applied to the Property Name (max 50 chars)

Example: InsertBOMProperty('Length',inttostr(DeskLength));

Note: The instruction inttostr(DeskLength) converted a numeric variable to a string format

SetBOMSetupDuration(SetupDuration,’SetupDurationScale’);

This defines the total duration to ‘set up’ in preparation for making the Custom Product.  The
elements that make up this function are:

SetupDuration: Any Number including decimals
SetupDurationScale: Either ‘Hours’ or ‘Minutes’.  If nothing entered then Minutes is
assumed

Example: SetBOMSetupDuration(15,'Minutes');

SetBOMRunDuration(RunDuration,’RunDurationScale’);

This defines the total duration to make the Custom Product.  The elements that make up this
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function are:
RunDuration: Any Number including decimals
RunDurationScale: Either ‘Hours’ or ‘Minutes’.  If nothing entered then Minutes is
assumed

Example:  SetBOMRunDuration(45,'Minutes');

SetBOMInstructions(‘BOMInstructions’);

This defines the detailed instructions to make the Custom Product.  The elements that make up
this function are:

BOMInstructions: Unlimited amount of text to describe the actions required to make the
product

Example:  SetBOMInstructions('Cut the 2000mm Rimu Panel down to ' +
inttostr(DeskLength) + 'mm ');

SetBOMLeadTime(LeadTime);

This defines the anticipated Leadtime to product the Custom Product.  The elements that make up
this function are:

LeadTime: The number of Days (integer only) required to produce the product

Example:  SetBOMLeadTime(2);

InsertBOMStep(‘StepName’,StepSequence,’StepDescription’,’StepInstructions’);

This will create a Bill of Material Step.  The elements that make up this function are:
StepName: The name that you are applying to the Step (max 20 chars)
StepSequence: A number defining the sequence in which the Step will be carried out 
StepDescription: A brief description of the Step (max 50 chars)
StepInstructions: Unlimited Text defining what happens in this Step

Example:  InsertBOMStep('Cut',10,'Cut and Trim all Timber','Check the measurements');

InsertBOMResource(‘StepName’,’ResourceType’,’ResourceName’);

This will add a Resource to a process Step.  The elements that make up this function are:
StepName: The Step Name - The step should be created as defined above
ResourceType: Must be either ‘ASSET’ or ‘EMPLOYEE’ 
ResourceName: The name of the Asset or Employee (max 30 chars)

Example:  InsertBOMResource('Cut','Employee','John');

InsertBOMLine(‘StepName’,’CodeType’,’LineCode’,LineQty,LineNumber,ScrapPercent,’
RunOrSetup’,’PosReference’,’LineInstructions’);

This will add a Line to a step in the Bill of Material.  The elements that make up this function are:
StepName: The Step Name - The step should be created as defined above
CodeType: Must be Descriptor, Item or Labour 
LineCode: The name of the Descriptor, Item or Labour (max 50 chars)
LineQty: The quantity required against this line
LineNumber: Any Integer to define a Line number
ScrapPercent: Any Number (incl decimals).  Zero if it does not apply
RunOrSetup: Enter either Run or Setup
PosReference: Enter a position reference if applicable
LineInstructions: Unlimited amount of text to add Instructions
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Example: InsertBOMLine('Cut','Item','RIMUPANEL1600X600',1,10,0,'Run','','');

You should note that if the line being inserted is a Bill of Material Parent flagged as a Phantom
then all the Components of the Item will be copied and not the Item itself

InsertOrderLine(‘CodeType’,’LineCode’,LineQty,UnitPrice);

This function allows you to add new lines to the originating Sales or Job Order.  This emulates an ‘
Add-On Sale’ type function such as you also supply a ‘Chair’ when you configure a Desk. The
elements that make up this function are:

CodeType: Must be Descriptor, Item or Labour 
LineCode: The name of the Descriptor, Item or Labour (max 50 chars)
LineQty: The quantity required against this line (incl Decimals)
UnitPrice: The Unit Sell Price for this Line (incl Decimals)

Example:  InsertSOLine('Item','OFFICECHAIR',1,135);

5.  Other functions

Variable := RoundToDecimalPrecision(Variable1,DecimalPlaces);

This function allows you to round any evaluated Variable to a defined number of decimal places. 
The elements that make up this function are:

Variable: The variable in the above ‘Var’ section to which the result will be posted
Variable1: The variable in the above ‘Var’ section to which this is being applied
DecimalPlaces: Number of decimal places required (defaults to 2 if not specified) 

6.  Functions and Procedures

If you press the F2 key then a full list of classes and functions will be presented

Buttons

Close: This will close the Custom Products screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for entry of the following information that is required when creating
a new Custom Product

Create Custom Product From Scratch: If this radio button is ‘checked’ then the next field
must be completed

Item:  From the drop-down list select the Item against which the Custom Product
Script will be created.  This list will only show those Items that have Sourced By of
'Custom' and Configured By of 'Rules'

Copy Custom Product Design from another Item: If this radio button is ‘checked’ then
the next two fields must be completed 

Select an Item with an existing Custom Design: From the drop-down list select an
Item.   Its Custom Product Script will then be copied to the new Product where it can
be amended if required
Copy Custom Design To:  From the drop-down list select the Item against which the
Custom Product Script will be copied.  This list will only show those Items that have
Sourced By of 'Custom' and Configured By of 'Rules'

Buttons
Create: Click the ‘create’ button to take you to the ‘Details’ tab for entering further
information.
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Cancel: Click the ‘cancel’ button to exit this panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the 'Script' tab

Related: This will bring up a list of functions that are related to Custom Products.  You may open
and maintain information in those screens whilst still remaining in the Custom Products screen.

Reports: This will bring up a list of Reports that are related to the Custom Products. You can
immediately run the report whilst still remaining in the Custom Products screen.

Test Script: This will run through the script and display the results in the 'Function Results' tab.

Load From File: This will allow you to point to a .txt file and import the content of that file into this
screen.

Function Result Tab

This tab displays the results after clicking on the 'Test Script' button in the 'Script' screen

14.3 Standard Cost Rollup

BOM Costing allows a user to carry out multi-level Cost Roll-up using the Standard Cost for Items,
Descriptors and Labour plus Fixed and Variable Overheads related to Labour.   

The Cost Roll up program goes through the following steps:-
· Sorts all parent Items in the BOM table into Low-Level Code descending sequence
· Commencing with the first parent calculates the following from its components

     Set Up Cost
Items - Standard Cost * Usage Quantity / Setup Batch Size
Descriptors - Standard Cost * Usage Quantity / Setup Batch Size
Labour - Labour Code’s Labour Cost * Hours / Setup Batch Size
FOH - Labour Code’s FOH Cost * Hours / Setup Batch Size
VOH - Above Labour calculation * VOH recovery Rate

     Process Cost
Items - Standard Cost * Usage Quantity
Descriptors - Standard Cost * Usage Quantity
Labour - Labour Code’s Labour Cost * Hours
FOH - Labour Code’s FOH Cost * Hours 
VOH - Above Labour calculation * VOH recovery Rate

· Progressively repeats this process for all parent Items in the BOM
· The results are displayed for assessment and selection 
· The select Items have their Standard Cost updated

Opening Screen

Entry and Display fields
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Create New or Open Previous:  Only one Cost Rollup Run can exist at any time.  Therefore the
following scenarios can exist

· If the Cost Rollup has never been run before then you must generate ‘New’
· If the previous Cost Rollup has been ‘Updated’ then you must generate ‘New’
· If a previous run has not been ‘Updated’ then you have the option to open the current run

details or run ‘New’.  If you run ‘New’ then the old data is overwritten

In the first two instances you have no choice but to run ‘New’, in which case the Cost Rollup will
run after you click on the OK Button

Specific Site: If this is 'checked' then the Roll-up will be for the site selected in the next field and
will use the Inventory Costs specified for this Site.   

Site: This will become active if the previous filed is 'Checked'.  Select the Specific Site from the
drop-down list against which this Cost Roll-up will be carried out

Previous Standard Cost Rollup Run

Rollup Last Run Date: If a previous Rollup run exists then this will show the date when it was run.
 If no previous run has been done then this field will be blank

Status: If a previous Rollup run exists then this will be prefilled with the status ‘In Progress’.   If no
previous run has been done then this field will be blank.

Buttons

OK: If ‘Radio Button’ selection is:
· ‘Create New Standard Cost Rollup’ then the Standard Cost Rollup routine will be carried

out before displaying the results in the List screen
· ‘Open Previous Standard Cost Rollup’ then the program will go directly to the List screen

and display the results of the previous Rollup

Cancel: Will cancel and close this function 

List Tab

This tab displays all the assemblies whose Cost has been rolled-up.  You can select specific Items
that you wish to update.  These will then be updated with a single click of your mouse button.

Display fields

Select: ‘Check’ the checkbox where you want the Item’s revised Standard Cost to be updated.
You have the option to click on the ‘Select All Items’ Button at the bottom of this panel to select all
the records.  You may also click on the ‘De-select All Items’ Button at the bottom of this panel to ‘
un-select’ all the records

Item Code: Display only field showing the Item that has had its Standard Cost rolled up

Description: Display only field showing the description of the Item

Unit: Display only field showing the base Unit of Measure of the Item

Last Std Update: Display only field showing the Quantity required as amended in the Detail tab
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Std Cost: Display only field showing the current Standard Cost of the Item

Rolled Up Cost: Display only field showing the calculated Standard cost evaluated during this
Cost Rollup run

New Std Cost: Prefilled with the calculated Rolled Up Cost taken from the previous field.  You can
amend this value if you wish.  The entry in this field is the value that updates the current Standard
Cost against the Item 

Item Cost Content: Display only field showing the calculated Material (Item) content evaluated
during this Cost Rollup run

Descriptor Cost Content: Display only field showing the calculated Descriptor content evaluated
during this Cost Rollup run

Labour Cost Content: Display only field showing the combined calculated Labour, Fixed
Overhead and Variable Overhead content evaluated during this Cost Rollup run

Sourced By:  Display only field showing the Source of the Item

Category:  Display only field showing the Category currently held against the Item

Sub Category:  Display only field showing the Sub Category currently held against the Item

Rolled Up From:  This is normally from the BOM.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Buttons

Select All Required: Clicking this Button will place a check-mark in the Select column against all
displayed Items

De-select All Required: Clicking this Button will remove check-marks from the Select column
against all displayed Items

Update Standard Cost for Selected Requirements: All Items that have been selected will be
have their Standard Cost update with the above ‘New Std Cost’

Close: This will close the Cost Rollup screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: If you have made any changes to the ‘New Std Cost’ in a record you can save that cost and
remain in this screen by selecting this button.

Cancel: If you have made any changes to the ‘New Std Cost’ in a record you can ignore the
change and revert to the pre-change condition by selecting this button.

Related: This will bring up a list of functions that are related to Cost Rollup.  You may open and
maintain information in those screens whilst still remaining in the Cost Rollup screen.

Reports: This will bring up a list of Reports that are related to Cost Rollup.  You can immediately
run the report whilst still remaining in the Cost Rollup screen.
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Detail Tab

This tab displays the details that went into calculating the Standard Cost of the parent Item

Display fields

Item Code: Display only field showing the selected Item

Description: Display only field showing the description of the Item

Unit: Display only field showing the base Unit of Measure of the Item

Line Type:  Display only field showing the type of line being displayed.  The display options are:
· Item Code
· Descriptor Code
· Labour Code

Code: Display only field showing the specific component code.  

Qty Per: Display only field showing the usage quantity of this line in the parent assembly.

Std Cost: Display only field showing the Standard Cost of this line

Total Cost: Display only field showing the calculated (Qty per * Std Cost) extended Cost of this
line.  

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Buttons

Close: This will close the Cost Rollup screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Cost Rollup.  You may open and
maintain information in those screens whilst still remaining in the Cost Rollup screen.

Reports: This will bring up a list of Reports that are related to Cost Rollup.  You can immediately
run the report whilst still remaining in the Cost Rollup screen.

14.4 Routing Templates

This function allows you to maintain Routing Templates. These can be used when creating Bills of
Materials to insert a standard process route into the BOM

List Tab

Display fields

Routing Code: Display only field showing the Code Identity of the Routing Template
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Description: Display only field showing the description of the Routing Template

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Routing Template screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Template

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Routing Template from this table

Related: This will bring up a list of functions that are related to the Routing Template.  You may
open and maintain information in those screens whilst still remaining in the Routing Template
screen.

Reports: This will bring up a list of Reports that are related to the Routing Template. You can
immediately run the report whilst still remaining in the Routing Template screen.

Detail Tab

The Detail Tab allows you to create and maintain Routing Template Header information.

Entry and Display fields

Routing Code: Only accessible during an ‘Add’ transaction.  Enter the identity of the Routing
Template.  No validity checks are carried out on the content but duplicate Routing Codes are not
allowed.

Description: Only accessible during an ‘Add’ transaction.  Enter a brief description of the Routing
Code.  No validity checks are carried out on the entry.

Notes: You can enter unlimited amount Notes that relate to this Routing Template.  Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
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screen or double-click the selected record.

Buttons

Close: This will close the Routing Template screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank screen for entry of a new Template

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the List panel

Related: This will bring up a list of functions that are related to the Routing Template.  You may
open and maintain information in those screens whilst still remaining in the Routing Template
screen.

Reports: This will bring up a list of Reports that are related to the Routing Template. You can
immediately run the report whilst still remaining in the Routing Template screen.

Lines Tab

The Lines Tab enables you to create and maintain the Steps in the Route and the Resources
required at each step

Entry and Display fields

The Upper panel shows all the step sequences that are currently used in this Route Template. 
The maintenance of those records are carried out in the lower part of the screen as follows:

Step Detail - Sub Tab

This sub-tab enables you to create the process steps required in the Template.  

Seq - Enter a Step Sequence Number Identifier against the line.   When this is used in a BOM then
the Assembly Order documents are printed in Step sequence.  

Step - Enter a short name for the Step.  No checks are made against this entry

Description - Enter a brief description of the Step.

Department - From the drop-down List select the Department where this Sequence is being
carried out.

Instructions - Unlimited lines of Instructions on what to do during this step can be entered.  

 
Step Resources - Sub Tab

This sub-tab enables you to add Resource requirements to each step.    The Resource can be
either an Employee or a Company Asset.  The available fields are:
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Resource Type - From the drop-down list select the Resource Type that you are adding to this
Step.  The options are Employee or Asset

Resource Name - From the drop-down list select the specific Employee or Asset that will be used
during this Step.

Buttons

Close: This will close the Routing Template screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a Sequence or a Resource against the
Sequence.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current highlighted record

Related: This will bring up a list of functions that are related to the Routing Template.  You may
open and maintain information in those screens whilst still remaining in the Routing Template
screen.

Reports: This will bring up a list of Reports that are related to the Routing Template. You can
immediately run the report whilst still remaining in the Routing Template screen.

14.5 Where Used Inquiry

This screen allows you to inquire on where any Item, Descriptor or Labour Code is used in any Bill
of Material

Entry and Display fields

Code Type - From the drop-down list select the Code Type against which you are making the
Inquiry.  The options are:

· Item Code
· Descriptor Code
· Labour Code

Code: From the drop-down list select the specific component code.  The list will show details
relating to the Line Type option selected.

Description: Display only field showing the description of the code selected in the previous field.

Displayed fields

Upon selection of the above code the program will get all occurrences in the BOM file and show
you all the parent assemblies that use this Code.  The fields in this list are:
 
BOM Item Code: Display only field showing the Parent Item that uses the selected Code

BOM Description: Display only field showing the description of the parent Item.
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Qty Used: Display only field showing the qty that is used when making the Parent Item

Unit: Display only field showing the Unit of the previous Qty

Buttons

Cancel:     This will close the Where Used Inquiry screen.

14.6 Assembly Orders

This screen allows you to create and maintain Assembly Orders.

List Tab

Display fields

The displayed fields are taken from Assembly Order information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’.
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Assembly
Orders whose status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Assembly Order screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for entry of the following information that is required when creating
a new Assembly Order

Order Number:  This is only active if the Assembly Order Numbering is set to ‘Manual’ in
the Assembly Rules screen.  Upon clicking the ‘Create’ button this is checked to ensure
that it doesn’t currently exist
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Order Date: The Date that the Order was issued.  This is prefilled with system date but
can be amended by selecting the date from the drop-down calendar
Required Date: The Date when the Order should be completed.  This is prefilled with
system date but can be amended by selecting the date from the drop-down calendar
Create Assembly Order from Bill Of Material: If this radio button is ‘checked’ then the
next field should be completed

Item Code: From the drop-down list select the Item Code.  
Qty: Enter the quantity of the above Item that is to be made in this Order
Unit: Display only field showing the base unit for this Item
Version: If this BOM has multiple Versions then select the specific version from
the drop-down list
Version Status: Display only field showing the status of the selected Version

Copy Assembly from another Order: If this radio button is ‘checked’ then the next field
should be completed

Select Existing Order: From the drop-down list select the Assembly Order that is
to be used as the basis for creating this Assembly Order
Qty: Enter the quantity of the Item that is to be made in this Assembly Order
Change to a new Item Code: If this is ‘checked’ then the next field becomes
active.  You can then copy the details of the current Assembly Order and link it to
a different parent Item
Select New Item Code: From the dropdown list select the parent Item that will be
used against the copied Assembly Order.

Buttons
Create: Click the ‘create’ button to take you to the ‘Details’ tab for entering further
information.
Cancel: Click the ‘cancel’ button to exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Assembly Order from this table

Related: This will bring up a list of functions that are related to the Assembly Order.  You may
open and maintain information in those screens whilst still remaining in the Assembly Order
screen.

Reports: This will bring up a list of Reports that are related to the Assembly Order.  You can
immediately run the report whilst still remaining in the Assembly Order screen.

Print: This will generate and print the current Assembly Order

Detail Tab

Entry and Display fields

Order Number: This is the Assembly Order Number as accepted when the Assembly Job was
created.   It cannot be amended

Order Date: This is prefilled with the date entered into the Assembly Order creation panel.  You
can amend the date by either overtyping the date or selecting the date from the drop-down
calendar.

Status: During Purchase Order creation this is prefilled with status ‘Open’.  You can amend this
status by selecting the required status from the drop-down list.  The options are:
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· Planned
· Open
· In-Progress
· Finished
· On-Hold
· Closed

Assembly Sheet: This shows the status of the Assembly Sheet that is generated from this
Assembly Order.  It is initially set to ‘Not Printed’.   This can be amended to ‘Order Printed’ by
selecting this status from the drop-down list.  This gives you the option to confirm that print which
will automatically update the status to ‘Order Printed’.

Current Step: From the drop-down list select the Routing Step where the Assembly Order is
currently located.   This, combined with the Tracking Code provides a visual status of all Assembly
Orders in Inquiry View 'Inquiry - Assembly Progress'

Tracking Code: From the drop-down list select the Tracking Code.  Tracking Codes are user
maintained (Assembly>Settings>Assembly Tracking) and enable you to track your Assembly
Orders and filter views or reports by this Code.

Site Name: This is prefilled with the Site Name related to the User Signon.  If this User is flagged
as being allowed to change sites then this field is activated.  The Site can then be amended from
the drop-down list if required

Date & Times Tab

Required Date: This is prefilled with the date entered into the Assembly Order creation panel.
You can amend the date by either overtyping the date or selecting the date from the drop-down
calendar.  This field is used in the initial evaluation of the Start Date shown below.  After that it is
for information only.

Leadtime (Days): This is prefilled with the Leadtime Days held against this Item’s Bill Of Material
record.  It can be amended here if required.   This field is used in the initial evaluation of the Start
Date shown below.  After that it is for information only.
  
Durations: The Durations comprise of two elements:

Set Up - the time required to set up to make the Item and this is carried out once per
Assembly Order.
Run - The time required to make this order.  It is calculated from the time to make one
item multiplied by the Order quantity 

These fields are used in the initial evaluation of the End Date shown below.  After that they are for
information only.

Start Date: This date is initially calculated as follows:
· Subtract the Item’s Leadtime from the ‘Required Date’
· If that date is earlier than the system date then use the system date
· If date is not a workday (as defined in screen ‘Work Times’) then use next workday

This date can be amended by overtyping, or selecting it from the drop-down calendar.

End Date: This date is initially calculated as follows:
· Add together the above setup and run durations
· Forward schedule using the available hours per workday (as defined in screen ‘Work

Times’) taking into account calendar days not available for work
This date can be amended by overtyping, or selecting it from the drop-down calendar.
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No Expediting of this Order: The Inventory Replenishment routine has  an option to 'Expedite
Assembly Orders' which means that it will assume that an Assembly Order's required date can
potentially be moved to satisfy replenishment demands.  If that is not the case for this specific
Order then 'check' this checkbox

Urgent Order: Tick this box if this is an URGENT order. When and urgent Order is sent to
Freeway, it will be displayed at the top of the list for the Start Day it is assigned to. It will also be
marked with a Red indicator.

Additional Fields Tab

If you have defined Additional Fields against the Assembly Order (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

 
Dims Tab

If the ‘Display Dimensions’ field in Assembly Rules is ‘checked’ then this tab will be displayed.  It
contains the following fields that apply to the Assembly Header

Planned Order Weight: A display only field calculated from all the Order Line’s Planned
Quantity multiplied by the line’s ‘Unit Weight’.

Planned Order Volume: A display only field calculated from all the Order Line’s Planned
Quantity multiplied by the line’s ‘Unit Volume’.

Planned Order Area: A display only field calculated from all the Order Line’s Planned Quantity
multiplied by the line’s ‘Unit Area’.

Actual Order Weight: A display only field calculated from all the Order Line’s Actual Quantity
multiplied by the line’s ‘Unit Weight’.

Actual Order Volume: A display only field calculated from all the Order Line’s Actual Quantity
multiplied by the line’s ‘Unit Volume’.

Actual Order Area: A display only field calculated from all the Order Line’s Actual Quantity
multiplied by the line’s ‘Unit Area’

Scheduling Tab

Order Priority: This defines the priority attributed to the Order for use with the Order
Availability scheduling function.  It is prefilled with a value of 5 but can be changed here if
required.  The Priority number can be between 1 and 9 (1 being the highest priority). 

Full Pick Only: ‘Check’ this checkbox if you wish to see only those Assembly Orders where
the full component requirements are available for Issue.  This is prefilled with the setting held
against field ‘Availability Assembly Full Pick Only’ in the Requirements Rules but can be
changed here if required.
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Order or Product Sequence Number: Enter a sequence Number that will be used during the
Constraint Scheduling run if this is option is selected in the Priority Sequencing of the
scheduling process

The Scheduled Time has been Fixed: If this is 'checked' then this is telling the Constraint
Scheduling process that the current dates held against this Order are Fixed and cannot
therefore be re-scheduled.   

Fixed Earliest Start Date: From the drop-down calendar select the date before which this
Order cannot be scheduled by the Constraint Scheduling routine

Assembly Assigned : Display-only field showing whether this order has been assigned.

Overrides Tab

Override Location: If this is 'checked' then the following four fields will be made available to
override the Components' normal issue Warehouse/Location and the Assembled Item's
default Warehouse/Location

Issue Warehouse: From the drop-down list select the Warehouse from which all Assembly
Order components will be issued

Issue Location: From the drop-down list select the Location within the above Warehouse
from which all Assembly Order components will be issued

Receipt Warehouse: From the drop-down list select the Warehouse into which the finished
Item will be received

Receipt Location: From the drop-down list select the Location within the above Warehouse
into which the finished Item will be received

Financial Tab

Financial Category: If required, select the Financial Category applicable. If left blank, it
will use the Financial Category (if any) linked to the associated Cost Centre. (Used with linked
General Ledger system).

Source of Order: A display only field showing from where the Order originated.  The displayed
options are:

· Sales - Where this ‘Source on Demand’ Item is required against a Sales Order
· Manual - Manually created here
· Assembly - This ‘Source on Demand’ Item is a component in an assembly order
· Inventory - Order created from single selection in ‘Replenishment’ routine 
· Generated - Order created from multiple selection in ‘Replenishment’ routine
· Copied - Copied from an existing Assembly Order

Source Reference: A display only field showing the Source Reference.  Example: Sales, Jobs,
Manual, etc.

Name: A display only field showing the specific Reference within the above Source.   Example:
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Sales Order Number, Job Order Number, etc.

Item Code: Display only field showing the Item Number being made in this Order

Unit: Display only field showing the base Unit of Measure of the Item being made.

Description: Display only field showing the description of the Item being made.

Assembly Version: Display only field showing the Version reference of the Assembly being made.

Ordered Quantity: Shows the current Order quantity.  This can be amended if required.  When
amended the program will change the ‘%Complete to date’ to reflect the change.   It will also
pro-rate all planned component requirements whose Run/Setup flag is ‘run’

Scrapped Quantity: Display only field showing the current scrapped quantity. These quantities are
entered either through the ‘Order Receipts’ tab in the lower part of this screen or via screen
Assembly>Assembly receipts

Completed Quantity: Display only field showing the current completed quantity. These
completions are entered either through the ‘Order Receipts’ tab in the lower part of this screen or
via screen Assembly>Assembly receipts

% To Date: Display only field showing the percentage complete based on the quantity received as
a percentage of the quantity on order

The following four fields are only displayed if the Assembly Order contains Co-Products

(Co-Product) Order Quantity: Display only field that provides a summarised quantity of all
Co-Products.  

(Co-Product) Scrapped Quantity: Display only field that provides a summarised quantity of all
scrapped Co-Products.  

(Co-Product) Completed Quantity: Display only field that provides a summarised quantity of all
completed Co-Products.  

(Co-Products) % To Date: Display only field showing the percentage of Co-Products complete
based on the quantity received as a percentage of the quantity on order

Planned Setup Costs: Display only field showing the planned cost to set up this Assembly Job.
This calculates the Planned Cost for each Order Line based on the following cost criteria

Items - Assembly Order System Rules method (Last, Standard, Buy Price, Average)
Descriptors - Assembly Order System Rules method (Last, Standard, Buy Price)
Labour Code - Standard Cost as held against the Labour Code record  

Planned Run Costs: Display only field showing the planned run cost for this Assembly Job.  This
calculates the Planned Cost for each Order Line based on the same cost criteria defined above. 

Planned Total Costs: Display only field showing the sum of the Planned Setup and Run Costs

Actual Setup Costs: Display only field showing the actual cost to set up this Assembly Job.  This
calculates the actual cost of issues made against for each Order Line based on the following cost
criteria

Items - System Setting (Standard, Average)
Descriptors - System Setting (Last, Standard, Buy Price)
Labour Code - Employee’s Standard Cost as held against the linked Labour Code
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Actual Run Costs: Display only field showing the actual run cost for this Assembly Job.  This
calculates the actual cost of issues made against for each Order Line based on the same cost
criteria defined above.

Actual Total Costs: Display only field showing the sum of the Actual Setup and Run Costs

%: Display only fields showing the above ‘Actual’ values expressed as a percentage of the ‘
Planned’ values

Current Work In Progress Valuation: Display only field showing the actual costs still in Work In
Progress.   This is evaluated from the Total ‘Actual’ Cost of this order less the Cost of completed
Items that have been moved into stock

Instructions - Sub Tab

Instructions: This is prefilled with the Instructions taken from the Bill Of Material for the Item.
These can be amended and made specific to this Order.  Whenever you click on this field an icon
will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.  Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

Routing - Sub Tab

This sub-tab enables you to create the process steps required to make the Assembly.  It is prefilled
with the Routing Steps held against the Item’s Bill of Material but can be amended here and made
specific to this order.  The available fields are:

· Seq - The Assembly Order documents are printed in Step sequence.  Upon creation of a
step the program will increment the previous step by 10.  You can amend this as
required.

· Step - From the drop-down list select the Step that will be included in this Assembly
Order.  Steps are maintained via Assembly>Settings>Step Names

· Description - This is copied from the Step selected in the previous field.  However, it can
be amended here and made specific to this Assembly Order.

· Step Start - This is the start date of this Step.  Initially this will be prefilled with the
Assembly Order Start Date but you can amend this by either overtyping the date or
selecting a date from the drop-down calendar.

· Department - This is prefilled with the Department held against the Step selected above.
You can amend this department by selecting one from the drop-down list. Departments
are maintained via General>Settings>Departments.

· Instructions - Unlimited lines of Instructions on what to do during this step can be
entered. 

· Step Overlap - From the drop-down list select the Scheduling Overlap that will apply to
subsequent Steps in the process.  The options are

· End of Step: The next step will commence at the end of this Step taking into
account the Overlap and Buffer Minutes

· Beginning of Step: The next step will commence in parallel to this Step taking into
account the Overlap and Buffer Minutes

· Overlap Minutes - Enter the minutes that the subsequent Step can overlap this step 
· Buffer Minutes - Enter the minutes that the subsequent Step must wait before it can

begin
· Tracking Code - Select the Assembly Step Tracking Code
· Step Assigned - Display-only field showing whether the Assembly Step has been

assigned.
· Additional Fields - Any additional fields that have been defined for Assembly Lines via

File>System Configuration>Additional Fields.
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Resources - Sub Tab

This sub-tab enables you to add Resource requirements to each step.  It is prefilled with the
Resources held against the Item’s Bill of Material but can be amended here and made specific to
this order.  The Resource can be either an Employee or a Company Asset.  The available fields
are:

· Step Seq - A display only field showing the Step Sequence linked to the Step selected in
the next field.

· Step - From the drop-down list select the Step where this Resource is used.  The
displayed list is taken from those steps entered in the ‘Routing’ sub-tab (above)

· Resource Type - From the drop-down list select the Resource Type that you are adding
to this Step.  The options are Employee or Asset

· Resource Name - From the drop-down list select the specific Employee or Asset that will
be used during this Step.

By-Products & Co-Products Sub-Tab

Code - From the drop-down list select the Item code of the By-Product or Co-Product.
  
Qty - For this By-Product or Co-Product enter the quantity normally made when producing the
order quantity of the Main product.

Unit - Display only field showing the base Unit held against the Item Code. 

Cost% - Enter the percentage of the Assembly Cost that will be allocated to this line.  The sum of
all Cost percentages against all By-Product Lines cannot exceed 100%.

Style - From the dropdown list select whether the line is a By-Product or Co-Product

Qty Complete - Display only field showing the current received quantity as entered into the ‘Order
Receipts’ tab.

Qty Scrapped - Display only field showing the current scrapped quantity as entered into the ‘Order
Receipts’ tab.

Description - Display only field showing the description of the By-Product or Co-Product.

Order Receipts - Sub Tab

This sub-tab enables you to receive the completed Item into Stock.   Note: you may also use
screen Assembly>Assembly Receipts to ‘Batch’ receive single or multiple orders.  The available
fields are:

· Date - Prefilled with the system date.  You may amend this by overtyping or selecting a
date from the drop-down calendar

· Item Code - From the drop-down list select the Item code.  This can be the Main Product,
By-Product or Co-Product.

· Qty: Enter the Quantity being received. 
· Scrap Qty: Enter the Quantity being scrapped against this Order. 
· Scrap Code: If a scrap quantity was entered then select a scrap code from the

drop-down list.  Scrap Codes are maintained via Assembly>Settings>Scrap Codes
· Cost - Prefilled with the Item’s Standard Cost.  You have the option to amend this cost if

required
· Warehouse - Prefilled with the Item’s default receipt Warehouse.  This can be amended

by selecting another Warehouse from the drop-down list
· Location - Prefilled with the Item’s default receipt Location within the above Warehouse.
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This can be amended by selecting another Location from the drop-down list
· Variations - If the Item has sub-level variations such as Serial Number, Batch Number,

Colour, etc then the appropriate fields should be completed

Buttons

Close: This will close the Assembly Order screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: If the ‘Routing’, ‘Resources’, or ‘Order Receipts’ panel is at the front then this button refers to
adding lines within those panels.  If the ‘Instructions’ panel is at the front then the Order Create
function will be initiated

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: If the ‘Routing’, ‘Resources’, or ‘Order Receipts’ panel is at the front then this button refers
to deleting lines within those panels.  Note: If you delete an Order Receipt record the program will
create a Stock Movement Transaction with the line’s quantity being reversed.  If the ‘Instructions’
panel is at the front then this function is not available.

Related: This will bring up a list of functions that are related to the Assembly Order.  You may
open and maintain information in those screens whilst still remaining in the Assembly Order
screen.

Reports: This will bring up a list of Reports that are related to the Assembly Order.  You can
immediately run the report whilst still remaining in the Assembly Order screen.

Print: This will generate and print the current Assembly Order

Lines Tab

This screen allows you to add and maintain Component Lines in the Assembly Order.  The
Assembly Order Number and its Status is displayed at the top of the panel.

Assembly Order Lines can be created from the following sources:
· Lists
· Items
· Descriptors
· Manual

Each Method is described here

Lists: Lists are pre-defined Lists of Item Codes, Descriptor Codes, and Labour Codes from which
selections are made.  Maintenance of Lists is covered in it’s own section within this guide.   To
use ‘Lists’ click on the ‘Lists’ icon on the Batch Entry toolbar.  On the displayed panel use the
drop-down list to select the specific List.   This will display the contents of the List. Now ‘check’ the
checkbox against each line that you want to be copied to the Purchase Order.  You have the
option to click on the ‘Select All Contents’ Button at the bottom of this panel to select all the
records.  You may also click on the ‘De-select All Contents’ Button at the bottom of this panel to ‘
un-select’ all the records.   For each selected record you can amend the ‘Per Qty’ to denote the
quantity you require per ‘List’.  You can enter a multiplying quantity in ‘Multiplied Contents By’ field,
which will extend the above ‘Per Qty’ by this factor.



769Assembly

If you now click on the ‘Create Lines from Selected Contents’ Button then all the selected Lines will
be copied to the Assembly Order. 

Items: To select single or multiple Items click on the ‘Items’ icon on the Batch Entry toolbar.  This
will display all Items that are currently ‘Active’.   Simply highlight the Item in the top panel then click
the ‘Add to Selected Items’ Button to copy it to the lower part of the screen.  Repeat this for all
required Items.  In the Lower panel amend the required quantity per line as required, or remove the
line by clicking on the ‘Remove from Selected Items’ Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Assembly Order. 

Descriptors: To select single or multiple Descriptors click on the ‘Descriptors’ icon on the  Batch
Entry toolbar.  This will display all Descriptors that are currently ‘Active’.   Simply highlight the
Descriptor in the top panel then click the ‘Add to Selected Descriptors’ Button to copy it to the
lower part of the screen.  Repeat this for all required Descriptors.  In the Lower panel amend the
required quantity per line as required, or remove the line by clicking on the ‘Remove from Selected
Descriptors’ Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Assembly Order. 

Manual: You can create Manual Order Lines by clicking on the ‘Add’ Button to the right of the
screen.  A Line is created in the upper panel, however maintenance of the record is carried out in
the lower panel.     Using this method you can add Item Codes, Descriptor Codes, and Labour
Codes.

(Script): This button will only be displayed on the 'Batch Entry' bar if an ‘Order Script’ has been
created (via File>System Configuration>Order Scripts).   When visible the button name will be
prefilled with the script name and, when pressed, will perform the functions of that script. 

Info Line

A line is presented between the Upper and Lower panels which contains buttons relating to the
current line Item and is presented for further information and maintenance.   The displayed buttons
are:

Alternate Item:  The current Alternate Item linked to this Item is displayed for your
reference along with the current on-hand quantity of this alternative.
Stock/Avail:  This shows the current On-Hand quantity (in stock) and Available Quantities
(On-Hand + Supply - Demand) for this Item along with the Item’s basic Unit of Measure.
Clicking on this button will show further details. 

Lower Panel

The Line Maintenance applies to any line generated by any of the above methods.  Four ‘Tabs’ are
associated with this section:

· Assembly Line: Main Entry area for Assembly Order Lines
· Line Source: Demand Source (Sales, Jobs, etc) that are allocated to this Line
· Line Properties: Specific Properties that apply to the ordered Line
· Actual Issues: Receipt History of this Line

Assembly Line Tab

This is the main entry and maintenance area for Assembly Order Lines. 

Entry and Display fields

Line Number: This is auto-generated by the program in increments of 10 from the previous Line
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Number.  You can amend this number if required.  This number can be used as a sort sequence
for printing the lines on Assembly Order Route Sheets.  No checks are made on the entry

Line Type: From the drop-down list select the Line Type.  The options are:
Item Code
Descriptor Code
Labour Code

Code: From the drop-down list select the Code.  The drop-down list will vary dependent upon the
Line Type selection.  When entering a Inventoried Item you may wish to look at further Item Code
information:

· A ‘Stock Availability’ icon is situated just above the lower panel for this task.  
· An ‘Alternate Item’ icon is also available if the Item has alternatives

Order Quantity: This is prefilled with 1 but can be amended if required

Actual Quantity: Display only field showing the quantity currently completed against this Order.

Unit: This is prefilled with the Unit for the Code.  If this is an Inventoried Item with multiple Units
then you can amend the Unit of Measure by clicking on the drop-down icon and selecting the Unit.

Unit Cost: This is prefilled with the current unit cost of the Code.  This can be amended here if
required.

Description: This is prefilled with the description as held against the Item, Descriptor, or Labour
Code.  It can be amended here if required.

Position Reference: Open format field where you can identify - for example - the drawing grid
reference or the location that it is used on a large assembly.  No checks are made on this entry.

Run or Setup: This is only visible if the Assembly Rules indicate that you are using ‘Setup’.  From
the drop-down list select whether this line is used during Setup or as a component in the final
assembly.  This dictates how the Assembly Order creation routine addresses the quantity held
against this line.  I.e.

· If it is ‘setup’ then the quantity specified will be used
· If it is ‘run’ then the quantity specified will be multiplied by the Order quantity

Line Status: This shows the current status of this line.  The options are ‘Open’ or ‘Closed’.   The
program will close the status if the full quantity has been received.   You can amend this by
selecting ‘Open’ from the drop-down list.     Similarly, if you have not completed the full order
quantity and know that the remainder will not be made then you can amend the status to ‘Closed’. 

Step Seq: This field is only visible if the Assembly Rules indicate that you are using ‘Steps’.  When
visible it is a display only field showing the step sequence of the Step selected in the next field.  

Step: This field is only visible if the Assembly Rules indicate that you are using ‘Steps’.  When
visible you can select the Step from the drop-down list.  This list shows the current Steps held
against this Bill Of Material (entered via Assembly Orders>Detail>Routing tab).

Instructions: This is prefilled with any ‘Notes’ that are held against the Code that are flagged as
being copied to the Purchase Order Line.   It may be amended here and made specific to this Line.
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Line Source Tab
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The Line Source screen relates to Items and Descriptors and is only visible when those Line Types
are selected.  It tells you from where the line is to be supplied and, if its Supply Method is ‘Source
on Demand’ the actual Supply Order (Assembly Order or Purchase Order).  
If you decide to split the Source of Supply to (say) partially ‘Supply from Stock’, plus partially ‘
Supply on Demand’ from one Supplier and the remainder ‘Supply on Demand’ from another
Supplier then you can achieve all this via this screen.
To split an existing Line Source click on the ‘Add’ Button.  This will add a new line and display a
button ‘Edit Source Quantities’.   Clicking on this button brings up a separate panel for re-allocation
of quantities.

Supply Method: For Descriptors this can only be ‘Supply On Demand’.  For Items Codes select
the Supply Method from the drop-down list.  The options are Supply on Demand or Supply from
Stock.

Sourced By: Shows how this Line is to be provided.  The options are Internal or Purchasing

Source Qty: This is the quantity that is allocated to this Source reference.

Supplier: The Supplier if this Item or Descriptor.  You can amend the Supplier if the next field does
not have an Order Number held against it.  To amend the Supplier click on the drop-down icon and
select the Supplier from the list

Purchase Order Number: If the Supply Method is ‘Source on Demand’ and the Sourced By is ‘
Purchased’ then this is filled with the Purchase Order that has been raised to cover the demand.

Button

Edit Source Quantities: This button appears when the ‘Add’ button is selected.  The ‘Add’ button
also creates a new line in the ‘Line Source Tab’ screen.  You should complete the ’Supplier
Method’ and ‘Sourced By’ fields in the new record before selecting this button.  When you click on
this button a panel is presented showing the following fields

Source Qty: Amend the quantities as required.  The sum of the quantities must equal the
total line quantity before you can exit this panel.
Supply Method: Display only field showing the Supply Method as entered in the Line
Source Tab
Sourced By: Display only field showing the Source as entered in the Line Source Tab
Supplier: Display only field showing the Supplier as entered in the Line Source Tab
Purchase Order Number: Display only field showing the PO Number as entered in the
Line Source Tab

Line Properties Tab

Any specific property values for the Item, Descriptor, or Labour Code can be viewed here.  For
example: A ‘property’ against an Item could be ‘Voltage’ and the specific value entered against the
Item Master is ‘240 Volts’.  You also have the option to add properties by clicking on the ‘Add’
button.  The cursor will go to a new line for entry of the property as follows:

Property: From the drop-down list select the Property.

Value: Enter the specific value relating to this Property.

Actual Issues Tab

This shows the Issue History against this Line.  The screen layout varies dependent upon the Line
Type being issued.  You can also use this panel to make issues by clicking the ‘Add’ button and
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completing the following fields

Line Type ‘Item Code’

· Issue Date: This is prefilled with the system date.  You can amend the date by either
overtyping the date or selecting the date from the drop-down calendar.

· Qty: Enter the quantity being issued to this Job.  No checks are made against this
quantity

· Unit Cost: Display only field showing the Unit Cost of the Item.  
· Warehouse: This is prefilled with the default ‘Issue Warehouse’ held against the Item.

You can amend this by selecting another Warehouse from the drop-down list
· Location: This is prefilled with the default ‘Issue Location’ held against the Item.  You can

amend this by selecting another Location from the drop-down list
· Issue Source: Display only field showing the method by which this issue was made
· Issue No: Display only field showing the Issue Number if this was carried out via the

Assembly Issue Screen
· Issue Description: Display only field showing a description of the Issue Source
· To Container ID: (Displayed only if Virtual Container is defined for this Assembly Order) -

Issued to this Container ID.

Line Type ‘Descriptor Code’

· Issue Date: This is prefilled with the system date.  You can amend the date by either
overtyping the date or selecting the date from the drop-down calendar.

· Qty: Enter the quantity being issued to this Job.  No checks are made against this
quantity

· Unit Cost: Display only field showing the Unit Cost of the Descriptor.  
· Issue Source: Display only field showing the method by which this issue was made
· Issue No: Display only field showing the Issue Number if this was carried out via the

Assembly Issue Screen
· Issue Description: Display only field showing a description of the Issue Source

Line Type ‘Labour Code’

· Issue Date: This is prefilled with the system date.  You can amend the date by either
overtyping the date or selecting the date from the drop-down calendar.

· Qty: Enter the quantity being issued to this Job.  No checks are made against this
quantity

· Unit Cost: Display only field showing the Unit Cost of the Labour Code.  This can be
overwritten if required

· Employee: From the drop-down list select the employee that carried out this work.
· Rate Scale: From the drop-down list select the Rate Scales that applies to this Issue.

Rate Scales apply a conversion factor to the entered Unit Cost (Example: Evenings =
1.25, Saturday = 1.5).  Rate Scales are maintained via General>Settings>Rate Scales

· Issue Source: Display only field showing the method by which this issue was made
· Issue No: Display only field showing the Issue Number if this was carried out via the

Timesheet Entry Screen
· Issue Description: Display only field showing a description of the Issue Source

Dimensions Tab

If the ‘Display Dimensions’ field in Assembly Rules is ‘checked’ then this tab will be displayed.  It
contains the following fields that apply to the Assembly Line

Unit Weight: This is prefilled with the Unit Weight as held against the Item, Descriptor or
Catalogue Code record.  It can be amended here and made specific to this Order Line.

Unit Volume: This is prefilled with the Unit Volume as held against the Item, Descriptor or
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Catalogue Code record.  It can be amended here and made specific to this Order Line.

Unit Area: This is prefilled with the Unit Area as held against the Item, Descriptor or Catalogue
Code record.  It can be amended here and made specific to this Order Line.

Planned Order Weight: A display only field calculated from the Order Line Planned Quantity
multiplied by the above ‘Unit Weight’.

Planned Order Volume: A display only field calculated from the Order Line Planned Quantity
multiplied by the above ‘Unit Volume’.

Planned Order Area: A display only field calculated from the Order Line Planned Quantity
multiplied by the above ‘Unit Area’.

Actual Order Weight: A display only field calculated from the Order Line Actual Quantity multiplied
by the above ‘Unit Weight’.

Actual Order Volume: A display only field calculated from the Order Line Actual Quantity
multiplied by the above ‘Unit Volume’.

Actual Order Area: A display only field calculated from the Order Line Actual Quantity multiplied
by the above ‘Unit Area’.

Additional Fields Tab

If you have defined Additional Fields against the Assembly Lines (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Order Tab

If an Order Tab has been created for Assembly Orders (as defined in File>System
Configuration>Order Tabs) then the tab will be displayed here.  The content of the screen under
this tab is defined by the Query attached to the Order Tab.

Buttons

Close: This will close the Assembly Order Line screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Adds a new line to the currently active panel in the lower part of the screen

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Removes Lines from the currently active panel in the lower part of the screen
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Related: This will bring up a list of functions that are related to the Assembly Line.  You may open
and maintain information in those screens whilst still remaining in the Assembly Order screen.

Reports: This will bring up a list of Reports that are related to the Assembly Order.  You can
immediately run the report whilst still remaining in the Assembly Order screen.

Print: This will generate and print the current Assembly Order

14.6.1 Assembly  Properties

This screen allows you to define properties that are specific to an Assembly Order.  Property titles
are user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Assembly Orders.

Display fields

The displayed fields are taken from the Assembly Order Details.  The selection of which fields to
display here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Assembly
Orders whose status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Assembly Order Properties screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Assembly Order Properties.
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Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Order Number: Display only field showing the Assembly Order selected in the List screen

Status: Display only field showing the status of the Assembly Order selected in the List screen

Item Code: Display only field showing the Item Number being made in the Assembly Order

Description: Display only field showing the Description of the Item Number

Property: From the drop-down list select the Standard Property against which a value specific to
this Assembly Order will be made.

Value: Enter a value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Buttons

Close: This will close the Assembly Order Property screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Assembly Order Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Assembly Order Property record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: This enables you to delete the selected Assembly Order Property record.

14.6.2 Assembly Documents

This screen allows you to define documents, etc that are specific to an Assembly Order.    

List Tab

Display fields
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Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Assembly Order to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Assembly Order Documents screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Assembly Order Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from an Assembly Order record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name of the document that you are creating in this Document -
Assembly Order linkage.  No checks are made on the entry.

Document Type: Prefilled with ‘Assembly’

Linked to: From the drop-down list select the Assembly Order that uses this document

Print / Email with order: Tick this box if this document is to be printed/emailed with the Order.

Correspondence: Tick this box if this document is to be treated as correspondence in the
Operations Centre.
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Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Assembly Order Documents screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Assembly Order Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Assembly Order Documents record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

14.6.3 Assembly Images

This function allows you to link Images to an Assembly Order.    

List Tab

Display fields

Image Name: The name of the Image as entered into the Details screen,

Linked To: This is the specific Assembly Order to which this Image relates.

File Name: This is the full path name of the Image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon
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Buttons

Close: This will close the Assembly Order Images screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Assembly Order Images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Image from an Assembly Order.

View: If you select a line and then this button the Image will be displayed using your default Image
display software. 

Detail Tab

Entry and Display fields

Image Name: Enter the name that you are calling the Image on this Image - Assembly Order
linkage.    No checks are made on the entry.

Image Type: Prefilled with ‘Assembly’

Linked to: From the drop-down list select the Assembly Order that uses this Image

Image Details: locate the full path name of the Image.  It should be noted that the file extension
must be an image format (I.e. .jpg, .bmp, .ico, .wmf, .emf)

Preview: The selected Image is displayed for your reference

Buttons

Close: This will close the Assembly Order Image screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of an Assembly Order Image record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Assembly Order Image record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

14.6.4 Assembly History Notes

This function allows you to link multiple time-stamped notes to an Assembly Order record.    

List Tab

Display fields
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The displayed fields are taken from the Assembly Order master record.  The selection of which
fields to display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in
the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Assembly Order History Notes screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Assembly Order to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Call Classification: From the drop-down list select a Classification under which you wish to store
this History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
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Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.  Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this Assembly Order is displayed in the lower part of the
screen.  Each record will also have the first 3 lines of the notes displayed.  To view the full Notes
simply click on the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Assembly Order History Notes screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of an Assembly Order History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Assembly Order History Notes record or the last time
the ‘Save’ Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

14.7 Assembly Issues

This screen allows you to make Issues to single or multiple Assembly Orders.  

The process for issuing to Assembly Orders is:
· Create an Issue Batch
· ‘Save’ the Batch Header and go to the ‘Lines’ tab
· Add Lines to the Issues Batch - separate line to cover each Item
· Go back to the Batch Header
· Post the Batch - Ostendo generates the Issue activities related to each line in the Issue

Batch

Note: Until a Batch is ‘Posted’ the Issues will not be recorded against the included Assembly
Order(s)

List Tab

Display fields

Issue Batch No: This is the Issue Batch Number as generated by Ostendo and provides a unique
reference to the Issue Batch
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Reference: The Reference attached to this Issue Batch as entered into the Details screen,

Status: The status of this Issue Batch.  There are two statuses (In Progress and Updated), which
are maintained by the program. 

Batch Date: The date held against the Issue Batch.  

Display fields

The displayed fields are taken from the Issue Batch information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Issue screen.  If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Issue Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Issue Batch with status ‘In Progress’.  In this
instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Issues.  You may open and
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maintain information in those screens whilst still remaining in the Issue screen.

Reports: This will bring up a list of Reports that are related to Issues.  You can immediately run
the report whilst still remaining in the Issue screen.

Detail Tab

This tab enables you to create and maintain a Issue Batch Header.   After creation of a Batch
Header it must be saved (click on the ‘Save’ Button) before Lines can be added 

Entry and Display fields

Batch No:  This is a unique number automatically allocated by the program.  It cannot be
amended.

Status: This is the status of the Issue Batch and is maintained by the program.  The displayed
variants are:

In Progress - The Issue Batch is still being worked on
Updated - The Issue Batch has been ‘Posted’ and Assembly Order Lines updated

Reference: An optional entry field to briefly describe the batch.

Approval Status: This is only visible if you are authorised to carry out approvals (User Setup
option).  When visible you have the option to take the Issue Batch through the following steps:

· Waiting Approval
· Approved
· Approval on Hold

Until a batch is ‘Approved’ it cannot be ‘posted’

Date Approval: This is only visible if you are authorised to carry out approvals (User Setup
option).  When visible it shows the system date when this batch was ‘Approved’

Override Default Warehouse/Location: If this is ‘checked’ then the following two fields will
become ‘Active’ and an entry is required in each field.   These will become the ‘Issue’
Warehouse/Location for all Items in this Assembly Order and will override the default
Warehouse/Location held against individual Item Codes

Default Warehouse: From the drop-down list select the Warehouse from which the Assembly
Order Issue is being made.

Default Location: From the drop-down list of Locations within the above Warehouse select the
location from where the Assembly Order Issue is being made.

Batch Updating

Creation Date: This is prefilled with the system date.  

Creation Source: This is display only and denotes where the Issue Batch originated from.  The
displayed options are:

· Manual: Manually entered into the Batch
· Order Receipt: Issued by 'Backflush' receipt of an Ordered Assembly

Source Reference: Display only showing the Assembly Order against which the Issue was made
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Post All Issue Entries: If this button is selected then all the entries contained in the ‘Lines’ panel
will be actioned and the referenced Assembly Order Lines updated.  The status of this Batch will
then be amended to ‘Updated’

Notes: Extended Notes for your own information can be attached to this Issue Batch.   Whenever
you click on this field an icon will appear in the top-right.   By clicking on this Icon you can bring up
the Frequently Used Text table.   Select the text to be copied and either press the OK Button in
that screen or double-click the selected record.

Buttons

Close: This will close the Issue screen.  If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Issue Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Issue Batch Header record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Issue.  You may open and
maintain information in those screens whilst still remaining in the Issue screen.

Reports: This will bring up a list of Reports that are related to the Issue.  You can immediately run
the report whilst still remaining in the Issue screen.

Lines Tab

This tab enables you to add and maintain Assembly Issue lines.  The Issue Batch Number and
status will be displayed at the top of the panel.  You can create a batch for a single Item or can
product a large batch covering a range of Assembly Orders.  To help in putting together an Issue
Batch you can click on the ‘Select Assembly for prefilling Issues’.  This ‘speed entry’ has the
following options:

Order No: From the drop-down list select the first Order Number.  Two options are now available
for pulling in line details from this Assembly Order:

Prefill with planned usage for all lines: Select this radio button to copy all lines and
prefill the issue quantity field with the planned usage quantity.

Prefill with planned usage for lines linked to a single step: Select this radio button to
copy all lines within a Step and prefill the issue quantity field with he planned usage
quantity.  This option requires a selection in the next field

NOTE: The displayed list only shows:
· Items whose Supply Method is ‘Supply From Stock’ because all other Items are ‘

Source on Demand’ and will be supplied directly from Purchase or Assembly Orders
· Descriptors that are Sourced By ‘Internal’ because those Sourced By ‘Purchasing’

will be directly supplied from a Purchase Order 

Step Name: In the second option you are required to select the Step from a drop-down
list.
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Date to be used for lines: This is prefilled with the system date and denotes the
transaction date that will be used.  You may amend this date by entering the date or by
clicking on the drop-down menu and selecting the date.

Entry and Display fields

You may either use the above ‘Speed Entry’ to create lines or add individual lines as required.  All
lines can be amended as required prior to ‘posting’.  It is essential that you record all Item
variations (Colour, Batch, etc) otherwise the Batch Issue function will not accept the transaction. 
The following fields are available:

Date: In the first instance this is prefilled with the system Date.  You can change this date by
entering the date or clicking on the drop-down menu and selecting the date.

Order No: This shows the current selected Assembly Order against which this Item is being
issued.  You may amend this by selecting another Assembly Order from the drop-down list.  

Step Name: This shows the current selected Step in the Assembly Order.  You may amend this by
selecting another Step from the drop-down list of steps for the selected Assembly Order.  

Line No: This shows the Line Number covering this line.  You may amend this by overtyping this
number.

Line Type: This shows the Line Type covering this line.  You may amend this by selecting another
Line Type from the drop-down list.  The options are Descriptor Code or Item Code.

Code: From the drop-down list select the Descriptor Code or Item Code that applies to this line

Unit: Prefilled with the base Unit for the Item or Descriptor.  If the Item has more than a single Unit
of Measure then an alternate Unit can be selected from the drop-down list.

Ordered Qty: Display only field showing the original Quantity to issue taken from the Assembly
Order.

Issued To Date: Display only field showing the Quantity previously issued to this Assembly Order.

Qty: The Quantity to be issued in this batch.  This can be amended at any time prior to posting the
batch

Description: Description of the Code prefilled from the Code record.  This can be amended before
posting the batch.

Warehouse: For an Item Code this is prefilled with the default ‘Issue’ Warehouse.  You may
amend this by selecting another Warehouse from the drop-down list

Location: For an Item Code this is prefilled with the default ‘Issue’ Location.  You may amend this
by selecting another Location from the drop-down list

Variants: If the Line Item Number has variants (Serial Number, Expiry Date, Batch No, Rev No,
Size, Colour, Grade) then they should be entered into the respective fields.  

Recorded Notes: Extended Notes for your own information can be attached to this Line.   

To Container ID:  (Displays only if Virtual Container is defined for this Assembly Order) - 
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Buttons

Close: This will close the Assembly Issue screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Issue record.

Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Issue Line

Related: This will bring up a list of functions that are related to the Issue.  You may open and
maintain information in those screens whilst still remaining in the Issue screen.

Reports: This will bring up a list of Reports that are related to the Issue.  You can immediately run
the report whilst still remaining in the Issue screen.

14.8 Assembly Receipts

This screen allows you to make Receipts from single or multiple Assembly Orders.  

The process for receiving Assembly Orders is:
· Create an Issue Batch
· ‘Save’ the Batch Header and go to the ‘Lines’ tab
· Add Lines to the Receipt Batch - separate line to cover each Item
· Go back to the Batch Header
· Post the Batch - Ostendo generates the Receipt activities related to each line.

Note: Until a Batch is ‘Posted’ the Receipts will not be recorded against the included Assembly
Order(s)

List Tab

Display fields

Receipt Batch No: This is the Receipt Batch Number as generated by Ostendo and provides a
unique reference to the Receipt Batch

Reference: The Reference attached to this Receipt Batch as entered into the Details screen,

Status: The status of this Receipt Batch.  There are two statuses (In Progress and Updated),
which are maintained by the program. 

Batch Date: The date held against the Receipt Batch.  

Display fields

The displayed fields are taken from the Receipt Batch information entered into the ‘Detail’ tab. 
The selection of which fields to display is at the user’s discretion.  To select the fields to display
simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.   
On the displayed panel you can:
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· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Receipt screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Receipt Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Receipt Batch with status ‘In Progress’.  In this
instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Receipt.  You may open and
maintain information in those screens whilst still remaining in the Receipt screen.

Reports: This will bring up a list of Reports that are related to Receipt.  You can immediately run
the report whilst still remaining in the Receipt screen.

Detail Tab

This tab enables you to create and maintain a Receipt Batch Header.   After creation of a Batch
Header it must be saved (click on the ‘Save’ Button) before Lines can be added 

Entry and Display fields

Batch No:  This is a unique number automatically allocated by the program.  It cannot be
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amended.

Status: This is the status of the Issue Batch and is maintained by the program.  The displayed
variants are:

In Progress - The Receipt Batch is still being worked on
Updated - The Receipt Batch has been ‘Posted’ and Assembly Order Lines updated

Reference: An optional entry field to briefly describe the batch.

Approval Status: This is only visible if you are authorised to carry out approvals (User Setup
option).  When visible you have the option to take the Receipt Batch through the following steps:

· Waiting Approval
· Approved
· Approval on Hold

Until a batch is ‘Approved’ it cannot be ‘posted’

Date Approval: This is only visible if you are authorised to carry out approvals (User Setup
option).  When visible it shows the system date when this batch was ‘Approved’

Override Default Warehouse/Location: If this is ‘checked’ then the following two fields will
become ‘Active’ and an entry is required in each field.   These will become the Receipt’
Warehouse/Location for this Assembly Order and will override the default Warehouse/Location
held against individual Item Codes

Default Warehouse: From the drop-down list select the Warehouse into which the Assembly
Order Receipt will be made.

Default Location: From the drop-down list of Locations within the above Warehouse select the
location into which the Assembly Order Issue will be made.

Batch Updating

Batch Creation Date: This is prefilled with the system date.  It can be amended at any time up to
Posting the Batch by entering the date or by clicking on the drop-down menu and selecting the
date.

Post All Receipt Entries: If this button is selected then all the entries contained in the ‘Lines’
panel will be actioned and the referenced Assembly Orders updated.  The status of this Batch will
then be amended to ‘Updated’

Notes: Extended Notes for your own information can be attached to this Receipt Batch. 
Whenever you click on this field an icon will appear in the top-right.   By clicking on this Icon you
can bring up the Frequently Used Text table.   Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Receipt screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Receipt Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Receipt Batch Header record or the last time the ‘Save’
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Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Receipt.  You may open and
maintain information in those screens whilst still remaining in the Receipt screen.

Reports: This will bring up a list of Reports that are related to the Receipt.  You can immediately
run the report whilst still remaining in the Receipt screen.

Lines Tab

Entry and Display fields

A button ‘Select Assembly for Prefilling Receipts’ is available which, when pressed, will fill the
outstanding quantities against each line shown in the lower part of the screen.

Add the receipt lines using the following fields:

Date: In the first instance this is prefilled with the system Date.  You can change this date by
entering the date or clicking on the drop-down menu and selecting the date.

Order No: From the drop-down list select the Assembly Order Number

Item Code: This will initially display the primary product being made.  If you are receiving
Co-Products from this Order then click the drop-down and select the Co-Product

Description: Display only field showing the description of the parent Item

Unit: Display only field showing the Unit of Measure of the parent Item

Ordered Qty: Display only field showing the original Order Quantity taken from the Assembly
Order.

Receipted To Date: Display only field showing the Quantity previously received against this
Assembly Order.

Scrapped To Date: Display only field showing the Quantity previously scrapped against this
Assembly Order.

Qty:  Enter the Quantity being received.  If the Item is Serial Number controlled then you have the

facility to click on the (three dots) Icon in the quantity field from which a Text File of Serial Numbers

can be imported.

Scrap Qty: Enter the Quantity being scrapped against this Order. 

Scrap Code: If a scrap quantity was entered then select a scrap code from the drop-down list.
Scrap Codes are maintained via Assembly>Settings>Scrap Codes 

Unit Cost: Prefilled with the Unit Cost of the Item as held against the Item Master record.  This
can be amended here if required.

Warehouse: Prefilled with the default ‘Receipt’ Warehouse.  You may amend this by selecting
another Location from the drop-down list
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Location: Prefilled with the default ‘Receipt’ Location.  You may amend this by selecting another
Location from the drop-down list

Variants: If the Line Item Number has variants (Serial Number, Expiry Date, Batch No, Rev No,
Size, Colour, Grade) then they should be entered into the respective fields.  

Container:  This is the physical container the item is currently in. 

Recorded Notes: Extended Notes for your own information can be attached to this Line.   

To Container ID: (Displays only if Virtual Container is defined for this Assembly Order).
 

Buttons

Close: This will close the Assembly Receipt screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Receipt record.

Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Receipt Line

Related: This will bring up a list of functions that are related to the Receipt.  You may open and
maintain information in those screens whilst still remaining in the Receipt screen.

Reports: This will bring up a list of Reports that are related to the Receipt.  You can immediately
run the report whilst still remaining in the Receipt screen.

14.9 Assembly Closing

This screen allows you to select one or more Assembly Orders from a list and change their status
to ‘Closed’.  The displayed list shows all Assembly orders - each with a checkbox for you to select
it to be ‘Closed’.  An Additional field ‘Allow Close’ is automatically ‘checked’ if the Assembly Order
has no outstanding Purchase receipts linked to an Assembly Order Line.  You can override this by 
‘checking’ this checkbox if you want to close the Assembly Order.  It is only when both these fields
are ‘checked’ will Ostendo ‘Close’ the Order

Entry and Display fields

Select: ‘Check’ this checkbox if you wish Ostendo to change the Assembly Order Status to ‘
Closed’ 

Order Number: Display only field showing the Assembly Order Number 

Order Status: Display only field showing the current Status of this Assembly Order

Order Date: Display only field showing the date the Assembly Order was raised

Item Code: Display only field showing the Item Code being made by this Assembly Order

Item Description: Display only field showing the description of the above Item Code
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Item Unit: Display only field showing the base unit of the above Item Code

Order Qty: Display only field showing the Ordered Quantity of the above Item Code

Complete Qty: Display only field showing the Completed quantity of the above Item Code in this
Assembly Order

Scrap Qty: Display only field showing the Quantity of the above Item Code that has been
Scrapped in this Assembly Order

Order Start: Display only field showing the Start date of the Assembly Order

Order Finish: Display only field showing the Planned Finish date of the Assembly Order

Source Ref: Display only field showing the source demand for the Assembly Order

Source Name: Display only field showing the specific Source within the Source Ref

Planned Cost: Display only field showing the Planned Cost of this Assembly Order

Actual Cost: Display only field showing the total Actual Cost of this Assembly Order

WIP Value: Display only field showing the WIP Value contributed by this Assembly Order

Outstanding Purchases: Display only field showing the number of Purchase Order Lines linked to
this Assembly Order that have still to be received

Close Date: This shows the date that will be attached to Journals generated by ‘Closing’ the
Assembly Order.   It is a display only field and is evaluated from (The Last transaction Date carried
out against this Order) or (The Financial Cut-off Date plus 1 day) whichever is the later.

Allow Close: This is pre-‘checked’ if the Assembly Order has the Received quantity is equal to or
greater than the Ordered Quantity AND the ‘Outstanding Purchases’ field is zero.  This field must
be ‘checked’ before the Order can be closed.  If you wish to override the system evaluation then
you can ‘check’ or ‘uncheck’ this field as required

Side Buttons

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Related: This will bring up a list of functions that are related to Assembly Orders.  You may open
and maintain information in those screens whilst still remaining in this screen.

Reports: This will bring up a list of Reports that are related to the Assembly orders.  You can
immediately run the report whilst still remaining in this screen.

Lower Buttons

Cancel: This will exit the current screen without taking any action

Close Selected Assembly Order: Those Lines whose both ‘Select’ and ‘Allow Close’ checkboxes
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are ‘checked’ will change the Assembly Order Status to ‘Closed’

14.10 Settings

14.10.1 Assembly Tracking Codes

This screen allows you to maintain a file of Assembly Tracking Codes, which are used to track a
Purchase Order through it’s ordering, processing, delivery and receipt process.  Assembly
Tracking Codes are User-defined and can include such codes as:

· Quayside
· In Customs

Entry and Display fields

Tracking Code: Enter the Name of the Tracking Code.  Duplicates not allowed.

Description: Enter a short description of the Tracking Code.  No checks are made on this entry

Tracking Colour: From the drop-down list select the colour that you wish to associate with this
Tracking Status.  This will be displayed on the Assembly Order ‘List’ view when that field is
selected for display.

Exclude From Mobility: Tick this box if you wish to exclude this Assembly Tracking Code from
Freeway Mobility usage.

Status: Set the Tracking Code as either "Active" or "Inactive"

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Tracking Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Tracking Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Tracking Code.

14.10.2 Step Names

This screen allows you to maintain a file of Steps, which are used in Assembly Orders to facilitate
sub-dividing the Order into logical operational Steps.   Step Names are User-defined and can
include such names as:

· Assembly Shop
· Machining
· Inspection
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Entry and Display fields

Step Name: Enter the name of the Step.   Duplicates not allowed.

Step Status: Select either "Active" or "InActive" .

Description: Enter a short description of the Step.  No checks are made on this entry.

Department: From the drop-down list select the Department to which this Step belongs.
Departments are maintained via General>Settings>Departments

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Step Name screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Step Name.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Step Name.

Set Default: If you highlight a record and click this Button then the Default Step will appear at the
top of the screen.  The Default step is used when no Step is specified when creating an Assembly
Order.  It is also used when the ‘Steps Used’ checkbox in Assembly Rules screen is unchecked. 
This can be amended at any time.   

14.10.3 Scrap Codes

This screen allows you to maintain a list of Scrap Codes, which are used in Assembly Order
Receipts to record a meaningful reason for the Scrap record in addition to allocating a Cost Centre
to which the scrap booked.    

Entry and Display fields

Scrap Code: Enter the identity of the Scrap Code.  Duplicates not allowed.

Description: Enter a short description of the Scrap Code.  No checks are made on this entry

Cost Centre: From the drop-down list select the Cost Centre to which scrap will be booked.  Cost
Centres are maintained via General>Cost Centres

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.
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Buttons

Close: This will close the Scrap Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Scrap Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Scrap Code.

14.10.4 Configured Markups

This screen allows you to maintain a list of Markup Percentages against Analysis Codes.  This
helps to determination the Sell Price of a manually created Custom Product from the cost of each
selected component in the BOM and applying the Markup% based on the Analysis Group held
against each Component.

Entry and Display fields

Analysis Group: Select the Analysis Group from the drop-down List.  Analysis Groups are
maintained via General>Settings>Analysis groups.

Markup Percentage: Enter a Percentage by which components in this Group will have their costs
increased by this percentage.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Configured Markups screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Analysis group Markup.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Analysis Markup   

14.10.5 Item ChangeOver Times

This screen allows you to define the default changeover times for Item Codes and Setup Groups.

Entry and Display fields

ChangeOver By: Select either Item Code or Setup Group.
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From Code: Select either the Item Code or Setup Group.

To Code : Select either the Item Code or Setup Group.

Step Name: Select the Step Name that applies.

ChangeOver Time in Minutes: Enter the minutes required for changeover between these two
codes.

 

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record   

14.10.6 Item Setup Groups

This screen allows you to define the Setup Group names. This is used in Item ChangeOver Times
screen as well as ItemMaster - Item Details.

Entry and Display fields

Setup Group: Enter the name of the Setup Group.

Description: Enter the description of the Setup Group.

 

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted record   
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14.10.7 Assembly Rules

This screen allows you to maintain Assembly Rules.  Assembly Rules allow you to define what
rules, within the Assembly Order area, you wish to apply.  The following rule settings are available

Entry and Display fields

Steps Used: If you wish to use Assembly Steps in the Bills of Material and the Assembly Order
itself then ‘check’ this checkbox. 

Setup Used: If you wish to apply ‘Setup’ in addition to ‘Run’ in the Bills of Material and the
Assembly Order itself then ‘check’ this checkbox. 

Order Numbering: This defines the type of numbering that will be applied when generating
Assembly Orders.  The options are Automatic or Manual.

· If ‘Automatic’ is selected the numbering sequence is that defined under File>System
Settings>System Numbering

· If ‘Manual’ is selected then the order number will be keyed in each time an order is
created

Order Number Prefix: This allows you to place up to 5 characters of prefix; the generated or
manually entered number will form an extension to this prefix.  Examples of prefix are: WO-, ORD,
etc.

Planned Item Cost Method: From the drop-down list select the source of the Assembly Order’s
Planned Costs for Component Items in the Assembly Order.  The options are:

· Last
· Standard
· Buy Price
· Average

Planned Descriptor Cost Method: From the drop-down list select the source of the Assembly
Order’s Planned Costs for Component Descriptor in the Assembly Order.  The options are:

· Last
· Standard
· Buy Price

Assembly Issues Approvals: ‘Check’ this checkbox if you wish to include Assembly Issue
Approvals into the Issues Process.  I.e.

· If this is checked then User Signon Codes designated as having ‘Approval’ rights will
approve Assembly Issues before they are posted.

· If this is not checked then the ‘Approval’ process will not be used.
·

Assembly Receipt Approvals: ‘Check’ this checkbox if you wish to include Assembly Receipt
Approvals into the Receipt Process.  I.e.

· If this is checked then User Signon Codes designated as having ‘Approval’ rights will
approve Assembly Receipts before they are posted.

· If this is not checked then the ‘Approval’ process will not be used.

Default Order Line Type: From the drop-down list select the Assembly Order Line Type that will
be used as the default to prefill the Assembly Order Line entry screen.   The options available are:

· Item Code
· Descriptor Code
· Labour Code
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Default Receipt Cost Method:  From the drop-down list select the default Cost method to be
used for Assembly Receipts.  The options are ‘Planned’ or ‘Actual’.  The program evaluates the
Item’s (Main Product, Co-Product, or Bi-Product) unit Cost in the following manner

Planned: The Receipt Cost is derived from

(Total Planned Cost * (Receipt Qty + Scrap Qty) * Cost Percentage)
--------------------------------------------------------------------------------------------------
                                    Total Order Quantity

Actual: The Receipt Cost is derived from

                                              (Receipt Qty + Scrap Qty)       
Ratio being Received   =          ---------------------------------------
                                                     Total Order Qty

Unit Cost of Receipt   =   Ratio being Received * Total Actual Cost * Cost Percentage
                                     --------------------------------------------------------------------------------------
                                                             (Receipt Qty + Scrap Qty)

Standard: The Receipt Cost is derived from

Planned * Receipt Qty (Recommended not to be used)

Item Std: The Receipt Cost is derived from the Items

Standard Cost * Receipt Qty

Order Speed Entry: If this is ‘checked’ then the Order ‘Lines’ panel enables fast entry of orders.
With this feature the cursor will be placed in the ‘Code’ field.  From here you have the following
options:

· Enter the Item Code by either selecting from the drop-down list or keying in the Code.  
Note: If the ‘Enable Auto Complete on Lookups’ is enabled in System Settings then
Ostendo will progressively assess the entry and will auto complete it if the partially entered
code is unique.

· If the required Order quantity is 1 (The Qty field is prefilled with 1) then hit the ‘Enter’ key
on the keyboard to save the current line and commence a new line.  

· If the required Order quantity is other than 1 then click the ‘Tab’ key on your keyboard to
go the ‘Qty’ field.  Once again, if the remainder of the Order Line is OK click on the ‘Enter’
key otherwise continue with the ‘Tab’ key to go to the next field

Note: When creating a new Order Line the cursor will be positioned in the ‘Code’ field and the Line
Type will be ‘Item Code’.  If you wish to amend this then you can Shift/Tab to go back and amend
the Line Type

Display Dimensions: If this is ‘checked’ then the Assembly Order will show Weight, Volume, and
Area against each Order Line plus summated values at the Order Header level

Use Line Cost for Purchase: If this is ‘checked’ then if the Unit Cost is amended in an Assembly
Order Line then that Cost is used used as the Purchase Buy Price rather than the pre-defined Buy
Price against the Item or Descriptor

Allow Printing for Planned Status: If this is 'checked' then the Assembly Sheet can be printed
when the Order status is 'Planned'.  If it is not 'checked' then you must change the Order Status
away from 'Planned' before printing is allowed.
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Include Labour when Backflushing: If this is 'checked' then, if the Assembly Order's
components are to be backflushed, you have the additional option to define if Labour Code lines
are also to be backflushed.  If this is 'checked' then you must also specify a default Employee in
the next field.

Default Employee for Backflushing: If the previous field is 'checked' then you must select an
Employee from the dropdown list.  This will the default employee used against the Issue record.

Default Markup for Configured BOM: Enter the default Markup that will be used to calculate the
Sell Price for ‘Manual’ style Custom products.  This Markup can be amended within the Custom
Product configuration screen and made specific to that Order Line.

Use Phantom Step and Line in Order: If this is NOT 'checked' then the Steps in a Phantom
Sub-Assembly's Bill of Material will be ignored when creating an Assembly Order. The Step in the
Assembly Order where the Phantom Sub-Assembly resides will be used.
If this is 'checked' then the Steps in a Phantom Sub-Assembly's Bill of Material will be used but
only if the Step Names have been pre-loaded into the main Bill of Material.

Rollup Component Cost Type: From the drop-down list select the Cost Type that will be used
from Components in a Bill of Material when carrying out a Site specific Cost Roll-Up.  The options
are Last Cost, Average Cost, and Standard Cost.

Rollup Cost Method = 'Standard'

· Items = Standard Cost
· Descriptors = Standard Cost
· Labour Codes = Standard Cost

Rollup Cost Method =  'Average'

· Items = Average Cost
· Descriptors = Standard Cost
· Labour Codes = Standard Cost

Rollup Cost Method =  'Buy Price'

· Items =  Standard Buy Price
· Descriptors = Standard Buy Price
· Labour Codes = Standard Cost

Rollup Cost Method =  'Last'

· Items = Last Cost
· Descriptors = Standard Cost
· Labour Codes = Standard Cost

Touch Pad File Name: Click on the three dots icon and locate the .dat file that is to be used for
entry of Order Lines via a screen with Touch Pad facilities.  The .dat file is created via the Ostendo
Graphical Editor.

Auto Update Current Step on Issues:  If this is 'checked' then any issues are entered for an
order, the Step associated with that issue is checked against the ‘Current Step’ held in the
Assembly Order header, and if it is a later Step (based on sequence number) it automatically
updates that to become the "Current Step" for the Order. 

Block Receipts when Issues Remaining:  If this is 'checked' then receipt of the completed
assembly will not be allowed until all assembly line issues have been made. 

Do Not Explode Phantoms if Free Stock Available : If this is 'checked' then if free stock is
available the generated Assembly Order will show the Phantom as a component.   If this is not
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'checked' the generated Assembly Order will show the Phantom's components.
This rule will also apply to the Inventory Replenishment routine (Requirements>Inventory
Replenishment)

Automatically Issue to Linked Job:  If this is ‘checked’ then if an Assembly Order was created

from the Job (via Source on Demand), it will automatically issue the Assembly Receipt to the job.

Default Assembly Close Date:  Select either Last Transaction Date or Actual Close Date.

Exclude Purchased BOMs in Rollup:  If this is ‘checked’ then do not include Purchase BOM .

Only Backflush Remaining Issues:  If this is ‘checked’ then the system will only use remaining

issues when performing a backflush.

Buttons

Close: This will close the Assembly Rules screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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15 Sales

15.1 Customers

This screen allows you to create and maintain Customers in Ostendo.   

List Tab

Display fields

The displayed fields are taken from the Customers information entered into the ‘Detail’ tab.   The
selection of which fields to display is at the user’s discretion.   To select the fields to display simply
‘right mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel you
can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Customers
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customers screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Item.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Customer from this table

Related: This will bring up a list of functions that are related to the Customer.  You may open and
maintain information in those screens whilst still remaining in the Customers screen.
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Reports: This will bring up a list of Reports that are related to the Customer.  You can immediately
run the report whilst still remaining in the Customers screen.

Detail Tab

Entry and Display fields

Customer: This is mandatory entry and is only allowed during an Add transaction to enter the
name of the Customer.  Duplicate Customer Names are not allowed.
You should be aware that, in Ostendo, the apostrophe (‘) is not allowed in ‘Key’ fields.  If the
Customer Name contains an apostrophe (for example O'Brien) and it is keyed in then Ostendo  will
replace it with a ‘backwards’ apostrophe (found on your keyboard to the left of the number 1 key).

Customer Printout Name: This is the name that will print out on Customer related documents and
allows you to enter a name (Example; Their Trading Name) rather than the above Customer
Name.  If you leave this field blank then it will automatically be filled with the Customer Name when
you save the record.

Postal Address: Enter the following information that applies to the Postal Address of the
Customer.  No checks are made and these fields can be amended at any time.

· Address: Three lines are available for entry of the postal address of the site.  
· City: Enter the Town or City where this Customer is located.
· State: Enter the State where this Customer is located.
· Code: Enter the Postcode or ZIP Code where this Customer is located.
· Country: Enter the Country where this Customer is located.

Same as Postal Address: If this is ‘checked’ then the fields for the Physical Address cannot be
updated directly.  These are updated with the same data that you enter into the Postal Address
fields

Physical Address: Enter the following information that applies to the physical Address of the
Customer.  No checks are made and these fields can be amended at any time.

· Address: Three lines are available for entry of the postal address of the site.  
· City: Enter the Town or City where this Customer is located.
· State: Enter the State where this Customer is located.
· Code: Enter the Postcode or ZIP Code where this Customer is located.
· Country: Enter the Country Customer

(Button) - Additional Physical Addresses: Clicking on this button will bring up another panel for
maintenance of multiple additional addresses applicable to this Customer.  Each additional
address has the following fields

· Address Name: Enter a short name describing this additional address
· Address: Three lines are available for entry of the postal address of the site.  
· City: Enter the Town or City where this Customer is located.
· State: Enter the State where this Customer is located.
· Code: Enter the Postcode or ZIP Code where this Customer is located.
· Country: Enter the Country Customer
· Contact: From the drop-down list select the prime contact at this Customer Address.

Contacts related to this Customer are maintained by selecting ‘Contacts’ from the
drop-down list of options when the ‘Related’ button is pressed in the main Customer
screen.

· Phone: Enter the Telephone Number of this Additional Address
· Fax: Enter the Facsimile Number of this Additional Address
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Contact Details: Enter the following contact information that relates to the Customer.  Separate
detailed information can be entered for multiple contacts.  No checks are made and these fields
can be amended at any time.

· Phone: Enter the Telephone Number of the Customer
· Fax: Enter the Facsimile Number of the Customer
· Mobile: Enter the Mobile Telephone Number of the Customer
· Email: Enter the main email address of the Customer
· Website: Enter the Internet web address of the Customer
· Customer Style:  Select either Prospect or Customer. If the user is defined as only able

to create a Prospect, then the Customer  Style will be set to Prospect and put on Credit
Stop (therefore only allowing Quotes to be created) with a warning message indicating
they are a Prospect.  

· Primary Contact: from the drop-down list select the Primary Contact from the list of
contacts against this Customer.  To create a Contact you can click on the icon to the right
of this field or click on the ‘Related’ button and select Customer Contacts’.

General Tab

Billing Customer: If Invoices and Statements are made to a Customer Name other than the
above Customer then ‘check’ this checkbox.  This will activate the next field.

(Billing Customer): If the above checkbox is ‘checked’ then, from the drop-down list select the
Billing Customer. 

Status: From the drop-down list select the Status of this Customer.  The options are:
· Active
· Inactive

A Customer with a Status of Inactive will not be shown on the drop-down list when creating a Sales
Order.

Customer Type: This is prefilled with the default Customer Type as entered into the Customer
Type maintenance screen.  You may amend this Type by clicking on the drop-down icon and
selecting an alternative Customer Type.  Customer Types can be maintained by either clicking on
the icon to the right of this field or click on the ‘Related’ button and select ‘Customer Types’.

Customer Region: From the drop-down list select the region that covers this Customer.  You may
maintain Customer Regions by either clicking on the icon to the right of this field or click on the ‘
Related’ button and select ‘Customer Regions’.

Customer Code: From the drop-down list select the Customer Group to which this Customer
belongs.  You may maintain Customer Codes by either clicking on the icon to the right of this field
or click on the ‘Related’ button and select ‘Customer Codes’.

Shipping Method: From the drop-down list select the normal Shipping Method that you use to
ship goods to this Customer.  You may maintain Shipping Methods by either clicking on the icon to
the right of this field or click on the ‘Related’ button and select ‘Customer Shipping Methods’.

Salesperson: From the drop-down list select the Salesperson that is normally related to this
Customer.  You may maintain Salespeople by selecting General>Employees and identifying the
Employee as a ‘Salesperson’

Terms: From the drop-down list select the Credit Terms that apply to this Customer.  You may
maintain Credit Terms by selecting File>Financial Configuration>Credit Terms

Tax Group: From the drop-down list select the Tax Group that applies to this Customer.  The Tax
Group of this Customer combined with the Tax Group of the Item or Descriptor being sold defines
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the rate of Tax that will apply.  You may maintain Tax Group by selecting File>Financial
Configuration>Tax Groups

Foreign Currency: If you using multi Currency in Ostendo then ‘check’ this checkbox.  If you are
not using multi-currency then Ostendo will assume the Regional Settings of your Computer.

Currency Code: This will be activated if the previous field is ‘checked’.  In this instance select the
Customer’s Currency from the drop-down list.  Currencies are maintained via File>Financial
Configuration>Currency Codes

Company Number: Enter a Company Number.  This is an optional, open-format, entry field.

Pricing and Invoicing Tab

Price Level: From the drop-down list select the Price Level that applies to this Customer.  Price
Levels determine Item and Descriptor Sell prices using a pricing structure relating to this Price
level.  You may maintain Price Levels by either clicking on the icon to the right of this field or select
Pricing>Settings>Price Levels.

Override Price Level: From the drop-down list select the Override Price Level that applies to this
Customer.  Override Price Levels take preference in that if the Price exists within this Override
Price level it will be used.  If it does not exist then the above Price Level Price will be applied.  You
may maintain Price Levels by either clicking on the icon to the right of this field or select
Pricing>Settings>Price Levels.

NB: The override price levels only apply to Item (or Descriptor) Pricing not Special Pricing.
Special Pricing takes precedence over everything. Override Price Levels are not used.

Rate Level: From the drop-down list select the Rate Level that applies to this Customer.  Rate
Levels determine Labour Sell prices using a pricing structure relating to this Rate level.  You may
maintain Rate Levels by either clicking on the icon to the right of this field or select
Labour>Settings>Rate Levels.

Disc %: If you are offering this Customer an additional discount per order then enter this here as a
percentage.  This will appear on an invoice as a separate entry and will apply to the total Invoice
value. 

Requires Statement: If this is ‘checked’ then this Customer will be included in the Statement Print
run.

Invoice Consolidation: From the drop-down list select the option to define the content of each
Invoice.  The options are:

· Consolidate by Order - During Invoice generation all lines due to be Invoiced from a
single Order will be included in the Invoice.

· Consolidate by Customer - During Invoice generation all lines across all Orders due to
be Invoiced will be included in a single consolidated Invoice.

Invoicing Group: From the drop-down list select the Invoicing Group that applies to this
Customer.  Invoicing Groups enable you to generate Invoices limited to specified Invoice Groups. 
You may maintain Invoice Groups by either clicking on the icon to the right of this field or select
Sales>Settings>Invoice Groups.

Statement Cycle: From the drop-down list select the Statement Cycle that applies to this
Customer.  Statement Cycles enable you to generate Customer Statements limited to Customers
within a range of Statement Cycle Codes.  You may maintain Statement Cycles by either clicking
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on the icon to the right of this field or select Sales>Settings>Statement Cycles.

Last Statement Date: Display only field showing the date when the Statement was last produced
for this Customer

Delivery Tolerance %: Enter the tolerance percentage against which deliveries are matched.  If
the quantity picked against an Order Line is greater than the Order quantity but within this
tolerance then the Pick will be allowed.  

Priority: Add a Priority number between 1 and 9 (1 being the highest priority).  This priority is
copied to all Sales or Job Orders created for this Customer.  It will then be used to allocate
Inventory in the Sales Allocation screen.   If nothing is entered then priority 5 is assumed.

Full Delivery: ‘Check’ this checkbox if this Customer only accepts full deliveries of goods.  This
value is copied to all Sales and Job Orders created for this Customer.  It will then be used when
allocating Inventory in the Order Availability allocation screen. 

(Button) - Credit Control Settings: Clicking on this button will bring up another panel for
maintenance of Credit Settings relating specifically to this Customer.  The options available her
are:

· Customer Style:  Select either Prospect or Customer. If the user is defined as only able
to create a Prospect, then the Customer  Style will be set to Prospect and put on Credit
Stop (therefore only allowing Quotes to be created) with a warning message indicating
they are a Prospect.  

· On Stop Credit: If this is ‘checked’ then no further Sales Orders or deliveries against
current orders will be allowed for this Customer.  When checked the adjacent field will
become active.  Enter a short comment that will appear when you are attempting to raise
a Sales order whilst the Customer is on Stop Credit

· Credit Limit Applies: If you are applying a Credit Limit then ‘check’ this checkbox.  The
adjacent field will become active for you to enter a Credit Limit.  When raising a Sales
Order the program will check current outstanding Invoice values plus current uninvoiced
Sales Orders plus the value entered against this Sales Order and if it exceeds the Credit
Limit a message will be returned and the Sales Order will be given a status of 'On Hold'. 
Also see the next field.  

· Override Debtor Days Aging Days: If this is ‘checked’ then you can adjust the debtor's
aging days.  When you are creating a Sales Order or delivering goods and the Customer
has an outstanding payment that is greater than this number of days then a message will
be returned and the Sales Order will be given a status of 'On Hold'.    Note: If this field is
not 'checked' then the default Aging Days specified in File>System Configuration>System
Settings will be used.

· General Warning Message: Any message entered here will appear in a 'pop-up' panel
whenever you raise an Order for this Customer.

· Outstanding Invoices: Display only field showing the current value of outstanding
Invoices.

· Open Orders: Display only field showing the total un-invoiced Order value.
· Unapplied Payments: Display only field showing payments not yet applied to Invoices.
· Current Available Credit: Only shown if the ‘Credit Limit Applies’ checkbox is selected

and shows the nett credit amount.

Round Invoice Header Tax: If this is 'checked' then, for this Customer, Ostendo will evaluate Tax
at Invoice Header level rather than at Line level.  To describe why this is necessary here is an
example:

Ostendo, like many Operational and Accounting software packages, calculate Tax at Line Level. 
Let us assume Tax at 10% for the following two lines in an Invoice
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Line 1 Price = $10.47
Line 2 Price = $24.87

If the Tax was calculated at Line level then the total Tax would be

Line 1 Price = $10.47 Tax = 1.047 (rounded to 1.05)
Line 2 Price = $24.87 Tax = 2.487 (rounded to 2.49)
                                  
Therefore Total Tax = $3.54 

Some Accounting packages, on the other hand, calculate Tax at Invoice header level.  Using the
above two Invoice lines this method would produce the  following Tax

Line 1 Price = $10.47
Line 2 Price = $24.87

Total Line Price = $35.34 Tax = 3.534 (rounded to 3.53)
                                  
Therefore Total Tax = $3.53

Expiry Days Remaining for Picking: If the customer requires that items with Expiry Dates must
not be expiring within a certain number of days, then use this field to specify the number of days
remaining to expiry. This period will be the minimum number of days to expiry which is acceptable
to the customer. 

Defaults Tab

Default Payer Name: Enter the default name of the payer.  This entry will prefill the Detail screen
in the Customer Payments process where it can be amended if required

Default Bank Name: Enter the Bank Account Name of this Customer.  This entry will prefill the
Detail screen in the Customer Payments process where it can be amended if required

Default Branch Name: Enter the Branch Name where the Account is held.  This entry will prefill
the Detail screen in the Customer Payments process where it can be amended if required.

Payment Method: From the drop-down list select the method by which the Customer payment is
normally made.  Payment Methods are user-defined under File>Financial Configuration>Payment
Methods.  This entry will prefill the Detail screen in the Customer Payments process where it can
be amended if required.

List Code: If an entry has been made here then, whenever a Sales Order is raised against this
Customer, the Inventory List will populate the Sales Order screen.  From there the List details will
automatically be presented for addition of Sales Order Lines.   If you wish to use this facility then
select the Inventory List Code from the drop-down list.

Membership No: Enter the Customer’s Membership Code.   This is used in the POS module and
allows selection of the Customer by entering the Membership Code.

Lead Source: From the drop-down list select the Lead Source from where this Customer
originated.  You may maintain Lead Sources by either clicking on the icon to the right of this field or
select Sales>Settings>Customer Lead Sources.
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PO Mandatory: If this is ‘checked’ then the Customer’s Purchase Order must be supplied and
entered against this Sales Order.  Until the Purchase Order number is entered the Sales Order
cannot proceed

Unique Purchase Order: If this is ‘checked’ then whenever a Purchase Order Reference is
entered against a Sales or Job Order then that reference must not have been used before.   I.e. 
You can only create one Job or Sales Order linked to the Purchase reference
Note: This option is only used when the PO Mandatory option is selected.

.
 
Service Agreement: If the Customer has a Service Support Agreement (used in the CRM
function) then select the Service Agreement from the drop-down list.  This will be the Service
Agreement used when a Service Call is received from this Customer within the CRM module.
Service Agreements are maintained via CRM>Settings>Service Agreements

Lvl: For the Service Agreement selected in the previous field select the Service Agreement Level
from the drop-down list.  This will be the default Service Agreement Level used when a Service
Call is received from this Customer within the CRM module.  Service Agreement Levels are
maintained via CRM>Settings>Service Agreement Levels

POS Message: Enter a message for display in the POS function.   This message will appear in the
POS whenever this Customer is entered into the POS screen.

Service Zone: Select the Service Zone that this customer is in. (Used for Assignment Board).

Outputs Tab (Deliveries, Invoices, Statements)

Invoices side tab

Invoice Default Output: From the drop-down list select the default output method for the
Customer’s Invoice.  The options are:

· Print Only
· Email Only
· Print and Email

Invoice Email Address: This is the Customer’s Email address for receipts of Invoices and is
therefore not visible for the Print Only option.  When visible an entry must be made either here or
in the Customer’s main email address field.

Invoice CC Address: This is not visible for the Print Only option.  When visible it allows you to ‘
Copy’ the email to another address.  An entry in this field is optional.

Invoice BCC Address: This is not visible for the Print Only option.  When visible it allows you to ‘
Blind Copy’ the email to another address.  An entry in this field is optional.

Email Invoice to Order Customer: Tick this box if invoice is to be sent to Order Customer
(instead of Billing Customer). 

Send Invoice to a different Customer: Normally an Invoice would be sent to the Billing
Customer.  By ‘checking’ this checkbox you can specify a different Customer to which the Invoice
will be sent.  This is useful, for example, where an Order was received from a Subsidiary who
would receive the Goods and the Invoice but the Statement and expected payment receipts would
originate from the Billing Customer

Customer for Invoice Print: If the above checkbox is ‘checked’ then you can select the Customer
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to be invoiced from the drop-down list

Statements side tab

Statement Default Output: From the drop-down list select the default output method for the
Customer’s Statement.  The options are:

· Print Only
· Email Only
· Print and Email

Statement Email Address: This is the Customer’s Email address for receipts of Statements and
is therefore not visible for the Print Only option.  When visible an entry must be made either here
or in the Customer’s main email address field.

Statement CC Address: This is not visible for the Print Only option.  When visible it allows you to ‘
Copy’ the email to another address.  An entry in this field is optional.

Statement BCC Address: This is not visible for the Print Only option.  When visible it allows you
to ‘Blind Copy’ the email to another address.  An entry in this field is optional.

Deliveries side tab

Email Delivery Advice: 'Check' this checkbox if you wish to email a delivery advice message. 

Delivery Email Address: This is the Customer’s Email address for delivery advice.   An entry
must be made either here or in the Customer’s main email address field.

Delivery CC Address: This allows you to ‘Copy’ the email to another address.  An entry in this
field is optional.

Delivery BCC Address: This allows you to ‘Blind Copy’ the email to another address.  An entry in
this field is optional.

Additional Fields Tab

If you have defined Additional Fields against the Customer (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

  

Notes: Two types of Notes are available:
General Notes: You can enter unlimited amount of Notes that are related to this Customer.
These notes will be available wherever the Customer is reported.  Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Mobility Notes: This is similar to General Notes. 
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This is to provide you the flexibility to specify which set of notes (General or Mobility) will be
displayed as part of Customer information on the mobility device. 

Messages: You can enter a message here that will appear whenever this Customer is used in
the following areas

Customer: Message will be displayed in the Operations Centre for this customer.
Payment: Message will appear at the top of the Order Lines screen
Order: Message will appear at the top of the Payments screen
Invoice: Message will appear at the top of the Invoice Lines screen

Buttons

Close: This will close the Customer screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Customer.  You may open and
maintain information in those screens whilst still remaining in the Customer screen.

Reports: This will bring up a list of Reports that are related to the Customer.  You can immediately
run the report whilst still remaining in the Customer screen.

15.1.1 Customer Properties

This screen allows you to define properties that are specific to a Customer.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Customers.

Display fields

The displayed fields are taken from the Customers Details.  The selection of which fields to display
here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Properties screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Customer Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Customer Name: Display only field showing the Customer selected in the List screen

Property: From the drop-down list select the Standard Property against which a value specific to
this Customer will be made.

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Copy to Job Lines: Tick this box if the property is to be copied to Job Lines.

Copy to SO Lines: Tick this box if the property is to be copied to Sales Order Lines.

Buttons

Close: This will close the Customer Properties screen.  If you have any unsaved data then you will



809Sales

be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Customer Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Customer Property record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Customer Property record.

15.1.2 Customer Documents

This screen allows you to define documents, etc that are specific to a Customer.    

List Tab

Display fields

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Customer to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Customer Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Customer record

View: If you select a line and then this button the physical document will be displayed on the
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screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name of the document that you are creating in this Document -
Customer linkage.  No checks are made on the entry.

Document Type: Prefilled with ‘Customer’

Linked to: From the drop-down list select the Customer that uses this document

Copy to Jobs: ‘Check’ this checkbox if you want the contents of this document to be copied to Job
orders

Copy to Sales: ‘Check’ this checkbox if you want the contents of this document to be copied to
Sales orders

Print / Email with statement: Tick this box if this document is to be printed/emailed with the
Statement.

Correspondence: Tick this box if this document is to be treated as correspondence in the
Operations Centre.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Customer Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Customer Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Customer Documents record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 
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15.1.3 Customer Images

This screen allows you to define images that are specific to a Customer.    

List Tab

Display fields

Image Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Customer to which this image relates.

File Name: This is the full path name of the image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer image screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Customer images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected image from a Customer record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Image Name: Enter the name of the document that you are creating in this image - Customer
linkage.    No checks are made on the entry.

Image Type: Prefilled with ‘Customer’
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Linked to: From the drop-down list select the Customer that uses this image

Copy to Jobs: ‘Check’ this checkbox if you want the contents of this image to be copied to Job
orders

Copy to Sales: ‘Check’ this checkbox if you want the contents of this image to be copied to Sales
orders

Image Details: locate the full path name of the image.  It should be noted that any file extension
recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Image: This panel displays the selected Image.

Buttons

Close: This will close the Customer image screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Customer images.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Customer image record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

15.1.4 Customer History Notes

This function allows you to link multiple time-stamped notes to a Customer record.    

List Tab

Display fields

The displayed fields are taken from the Customer master record.  The selection of which fields to
display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
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against will sort in descending order.
· Click on the black ‘down arrow’ to the right of your selected column heading and you can

either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer History Notes screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Customer to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Call Classification: From the drop-down list select a Classification under which you wish to store
this History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.   Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this Customer is displayed in the lower part of the screen. 
Each record will also have the first 3 lines of the notes displayed.   To view the full Notes simply
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click on the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Customer History Notes screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Customer History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Customer History Notes record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

15.1.5 Customer Statistics

Customer Statistics
The Customer Statistics screen enables you to view complete sales and Invoicing history by Order
Customer, Billing Customer, or both.

List Tab

Display fields

The displayed fields are taken from the Customers information entered into the main Customer
Maintenance screen.   The selection of which fields to display is at the user’s discretion.   To select
the fields to display simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.   On
the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Customers
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
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revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Statistics screen

Related: This will bring up a list of functions that are related to the Customer and Statistics.  You
may open and maintain information in those screens whilst still remaining in the Customer
Statistics screen.

Reports: This will bring up a list of Reports that are related to the Customer and Statistics.  You
can immediately run the report whilst still remaining in the Customer Statistics screen.

Detail Tab

Entry and Display fields

Customer: This is a display only field that shows the Customer selected in the ‘List’ screen.

Primary Contact: Display only field showing the Primary Contact as held against the Customer
master record

Status: The current status of this Customer.  The displayed options are:
· Active
· Inactive

Activity Dates

Last Order: The date when the last order was received from this Customer

Last Invoice: The date when the last Invoice was sent to this Customer

Last Payment: The date when the last Payment was received from this Customer

Current Balances

Open Orders: Total value of orders with status Planned, Open, In-Progress, Finished, and
On-Hold

Current Invoices: Total Value of outstanding amounts against Invoices that have not yet been
closed

Unapplied Payments: Total Value of Receipts and Deposits that have not yet been applied to
Invoices.

Credit Limit: This is only displayed if the Customer has a Credit Limit and shows the amount of
Credit that has been given

Include History For: From the drop-down list select the source of the statistics relative to the
selected Customer.  The options are:

Order or Billing Customer: The Customer appears in the Order Customer or Billing
Customer fields of a Sales or Job Order
Order Customer Only: The Customer appears in the Order Customer field of a Sales or
Job Order
Billing Customer Only: The Customer appears in the Billing Customer field of a Sales or
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Job Order

Invoice Values

Last 30 Days: Total value of Invoices raised within the past 30 days

Previous 30 Days: Total value of Invoices raised within the past 31 to 60 days

Variance%: Percentage variance calculated from

Last 30 Days - Previous 30 Days
-------------------------------------------
          Previous 30 Days

Current MTD This Year: Value of Invoices raised to date during the current month

Current MTD Last Year: Value of Invoices raised at the equivalent stage in the previous year

Variance%: Percentage variance calculated from

Current MTD This Year - Current MTD Last Year
-----------------------------------------------------------------

     Current MTD Last Year

Current Year to Date: Value of Invoices raised to date during the current year

Last Year to Date: Value of Invoices raised at the equivalent stage in the previous year

Variance%: Percentage variance calculated from

Current Year to Date - Last Year to Date
------------------------------------------------------

     Last Year to Date

Average Margins

Margins are derived from (Sell Price - Cost of Sale) / Sell Price.  Three statistics are provided:

Last 30 Days: Average Margin achieved over the past 30 days

Last 12 Months: Average Margin achieved over the past 12 Months

Previous 12 Months: Average Margin achieved over the 12 Months prior to the last 12 months

Outstanding Invoices - Tab

This shows all the outstanding invoices for this Customer where the Invoice Status is not “Fully
Applied’ and the ‘Balance Due’ is not zero.  The displayed fields are:

Invoice Date: Date when the Invoice was printed
Due Date: Date when the payment is due
Classification: This can be Invoice or Credit
Current Status of the Invoice: This can be Planned, Printed, Partially Paid
Invoice No: Identity of the Invoice or Credit
Total Amount: Total Value of the Invoice
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Tax Amount: Total Tax amount included in the Invoice
Nett Amount: Total Nett Value of the Invoice
Amount Paid: Total amount paid against this Invoice
Balance Due: Outstanding amount due against this Invoice
Currency: The currency code if this is a foreign currency customer
Bill Customer: The billing customer
Order Customer: The order customer

If you select an Invoice and ‘Right Mouse’ you have two 'drill-down' options

1.  To go to the Invoice Details screen
2.  To show all Payment made against this Invoice

Invoice History -Tab

The History panel shows all Invoices and Credit Notes that have been included in the above
statistics.  The displayed fields are:

Invoice Date: Date when the Invoice was printed
Due Date: Date when the Invoice is due 
Classification: This can be Invoice or Credit
Status: The status of the invoice 
Invoice No: Identity of the Invoice or Credit
Invoice Value: Total Value,Tax, Nett, Amount Paid, Balance Due - of this Invoice
Currency: The currency code if this is a foreign currency customer
Bill Customer: The Billing Customer held against the Invoice or Credit
Order Customer: The Order Customer held against the Invoice or Credit

If you select an Invoice and ‘Right Mouse’ you have the option to go to the Invoice Details

Payment and Deposit History Tab

This shows all the Payments and Deposits that have been received from this Custom.  The
displayed fields are:

Payment Date: Date when the Payment or deposit was received
Status: Received, Partially Applied, or Fully Applied
Style: This can be Payment or Deposit
Number: This is the system generated Payment Number
Received Amount: The total Value of the payment
Applied Amount: Total Amount applied to date
Outstanding Balance: Total amount yet to be applied
Reference: Brief description of the entry made against the Payment
Customer: The Customer who made the payment

If you select an Invoice and ‘Right Mouse’ you have the option to go to the Payment Details

Open Orders Tab

This shows all the current open Orders for this Customer.  The displayed fields are:
Order Date: Date when the Order was created
Required Date: Date when the Order is required by the Customer
Status: Current Status of the Order (Planned, Open, In Progress, On Hold)
Classification: Order Classification (Sales Order, Job Order)
Order No: Identity of the Sales Or Job Order
Nett Value: Total Nett Value of the Order
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Description: Description of the Order as entered into the Order details screen
Order Customer: Customer who raised the Order
Billing Customer: Customer who will be Billed
Currency: The currency code if this is a foreign currency customer
Total Value: The total value of the invoice

Item Sales History

This shows all the Items and Descriptors that were sold to this Customer.  The displayed fields are:
Invoice Date: Date of the Invoice that contained this Sale Item or Descriptor
Line Type: The Line Type (Example:  Item, Descriptor, Task Bill Code, etc)
Code: The Code of the displayed Line Type
Description: The description of the displayed Line Code
Unit: The Unit of Measure of the Code
Qty: The quantity sold on this Invoice
Unit Price: The Unite Price when sold

Buttons

Close: This will close the Customer Statistics screen.  

Related: This will bring up a list of functions that are related to the Customer and Statistics.  You
may open and maintain information in those screens whilst still remaining in the Customer
Statistics screen.

Reports: This will bring up a list of Reports that are related to the Customer and Statistics.  You
can immediately run the report whilst still remaining in the Customer Statistics screen.

15.1.6 Location Map

This will display a panel in which you can select either Map or Directions

If you select 'Map' Ostendo will use the mapping system identified in System Settings (this is
initially set to use Google Maps) and, using the Customer Address, open up the Google Map at
that address

If you select 'Directions' Ostendo will use the mapping system identified in System Settings and
provide directions to travel from the address set up in System Settings to the Customer Address

15.2 Customer Hazards

This screen allows you to maintain the Hazards and Instructions associated with a Customer. 

Detail Tab

Entry and Display fields

The Customer to which these Hazards relate is shown at the top of this panel.

Hazard Style: Select either Code or Group. Code refers to an individual hazard/instruction, while
Group refers to a group of hazards/instructions. 

Group or Code: Select one of the Group or Code from the drop-down list of pre-defined
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hazards/instructions.

Override: Tick this box if you wish to override the Description and/or Location, and/or Notes.

Description: The description of the hazard or group of hazards/instructions.

Location: The location of the hazard/instruction.

Notes: Notes relating to the hazard or instruction.

Address Name: Select a Delivery Address from the drop-down list if this hazard is specific to this
address only.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank line for entry of a record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: This will delete the current highlighted record.

15.3 Customer Mobility

This screen allows you to define customer mobility properties where the customer can use the
Freeway Mobility app to access your Ostendo system in a business-to-business relationship.

A short tutorial on this concept can be found here: 
http://ostendo.info/downloads/ostendo/Freeway_For_B2B_Customers_Explained.pdf

List Tab

Display fields

The displayed fields are taken from the Customer Master record.  The selection of which fields to
display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

http://ostendo.info/downloads/ostendo/Freeway_For_B2B_Customers_Explained.p
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· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Customer to which these Customer Mobility settings relates is shown at the top of this panel.

Membership / Mobility ID: Enter the Membership No. or Mobility ID for this customer if none
exists. This is a unique value.

Activate Customer Mobility: Tick this box to allow this customer to use Freeway App to access
your Ostendo system. Unticking this box will stop the customer from accessing your Ostendo
database.

Mobility Settings Employee: Select the employee from the Employee Mobility Settings table to
be used by this customer for the Freeway App.

You can set up several Employees (e.g. TRADE, RETAIL,etc...) in the Employee Mobility Settings
which are earmarked for Customer use. Multiple customers can use the same "Employee name"
which means they can all do similar stuff with their Freeway connection to your Ostendo database.

Of course you can also create a specific Employee in Employee Mobility Settings for a specific
customer.

Mobility Registration Email Address: This should normally be the email address of the person in
the customer's organisation who has the responsibility for this business-to-business relationship.

Mobility Password: This is a display only field showing the unique password generated by
pressing the Send Password & Fast Code button. 

Send Password & Fast Code button: Three options:

- Password & Fast Code : A Password and a Fast Code are generated. An email will
be automatically created and ready to be sent out.

- Password : Only a Password is generated. This will replace the
previous password.

- Fast Code : Only a Fast Code is generated. Password is not changed.

When generating the Fast Code, you will first be presented with the list of Mobility B2B API
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Security records available (if you have multiple). Select one to generate the Fast Code.

The Fast Code and password is given to the Customer when he first set up his Freeway App to
link to your Ostendo database. Once he has established the link, he can then change the
password (using Freeway) if he wishes to do so.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: Not applicable to the Detail panel

15.4 Customer Reservations

This screen allows you to set up Customer Reservations Locations so that inventory stocks can be
reserved for this customer until required. 

The concept is that any Source on Demand or Supply from Stock items can be reserved for a
specific customer

Customer Reservation location codes can be defined with any unique code.

Stock can be either transferred or receipted into that location.

Detail Tab

Entry and Display fields

The Customer for which this Location is set up is shown at the top of this panel.

Reservation Warehouse: Select the warehouse from the drop-down list.

Reservation Location: Select the location from the drop-down list.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank line for entry of a record.

Save: This will save the current data without exiting the screen
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Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.

Delete: This will delete the current highlighted record.

15.5 Kitsets

This screen allows you to create and maintain Kitsets.  A Kitset - containing a user-defined mixture
of Items and Descriptors - can be called up and added to a Sales Orders line.  The content of the
kit is copied as a sub-set to the Sales Order Line and can be amended as required.  However, any
Invoice generated from the Sales order will state a sell price at the Kitset level. 

List Tab

Display fields

The displayed fields are taken from the Sales Kitset information entered into the ‘Detail’ tab.   The
selection of which fields to display is at the user’s discretion.   To select the fields to display simply
‘right mouse’ in the main panel and select ‘Customize List Fields’.   On the displayed panel you
can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Kitsets whose
status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Sales Kitset screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Kitset.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel



823Sales

Delete: This removes the current Kitset from this table

Related: This will bring up a list of functions that are related to the Kitset.  You may open and
maintain information in those screens whilst still remaining in the Kitset screen.

Reports: This will bring up a list of Reports that are related to the Kitset.  You can immediately run
the report whilst still remaining in the Kitset screen.

Detail Tab

Entry and Display fields

Kitset Code: Entry is only allowed during an Add transaction.  Select the Kitset Identity from the
drop-down list.  Kitset are maintained via Inventory>Descriptors and the descriptor being
designated as being ‘used as a Kitset Code’

Unit: Display only field showing the unit of measure as held against the selected Descriptor record.

Category: Display only field showing the Descriptor Category as held against the selected
Descriptor record.

Status: Display only field showing the current status of the selected Descriptor.  The display can
be either ‘Active’ or ‘Inactive’

Description: Display only field showing the description of the Descriptor as held against the
selected Descriptor record.

Standard Sell Price: Display only field showing the Sell Price of the Descriptor as held against the
selected Descriptor record.

Standard Sell Price Settings

Select the radio button that will define the sell price of this Kitset.  You should also note that this
defines the ‘base’ sell price and any ‘Price Level’ held against a Customer can adjust this price. 
The Standard Sell Price options are:

· From Descriptor Sell Price: The current Sell Price held against the Descriptor will be
used

· Rolled up from Kitset Lines: The Sell Price will be determined by the sum of all
Standard Sell Prices of each line in the Kitset.

· Rolled up Costs from Kitset Lines: The Sell Price will be determined by the sum of the
Cost of each line in the Kitset multiplied by the Markup% defined in the next field

- Markup%: The cost of all the lines in the Kitset will be multiplied by this
percentage to arrive at a Sell Price for the Kit.

Notes: You can enter unlimited amount of Notes that are related to this List.   Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons
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Close: This will close the Kitset screen.  If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Kitset.  You may open and
maintain information in those screens whilst still remaining in the Kitset screen.

Reports: This will bring up a list of Reports that are related to the Kitset.  You can immediately run
the report whilst still remaining in the Kitset screen.

Lines Tab

This screen allows maintenance of the content of an Kitset.   The Kitset name is displayed at the
top of this panel

Entry and Display fields

Line Number: The Kitset Lines are printed in Line Number sequence.  Upon creation of a new line
the program will increment the previous line by 10.  You can amend this as required.

Component Type:  Select the Component Type from the drop-down list.  The options are:
· Item Code
· Descriptor Code

Component Code: From the drop-down list select the code.   The drop-down list displays the
codes relating to the selection made in the Component Type field

Description: The description is copied from the Item or Descriptor record.  It may be amended
here and made specific to this List. 

Unit: The base unit is copied from the Item or Descriptor.   If it is an Item that has multiple Units
then an alternate Unit may be selected from the drop-down list.

Qty: Enter a default quantity to be used.   This will be copied to the sub-line of the Sales Order.  It
can be amended at that time if required and made specific to the Kitset in that Sales Order.   If
nothing is entered here then 1 is assumed.

Buttons

Close: This will close the Kitset screen.  If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Kitset Item.

Save: This will save the current data without exiting the screen
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Cancel: Any changes made since the line record was accessed or the last time the ‘Save’ Button
was pressed will be lost.

Delete: This will delete the current highlighted record.

Related: This will bring up a list of functions that are related to the Kitset.  You may open and
maintain information in those screens whilst still remaining in the Kitset screen.

Reports: This will bring up a list of Reports that are related to the Kitset.  You can immediately run
the report whilst still remaining in the Kitset screen.

15.6 Sales Orders

This screen allows you to create and maintain Sales Orders.   

List Tab

Display fields

The displayed fields are taken from Sales Order information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Note: If you select the CURRENTDUECOLOUR field then the field will show colours relating to the
Due Date of the Order compared to today's date.  The displayed colours are:

· Red - Overdue
· Orange - Due Today
· Yellow - Due Tomorrow

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Sales Orders
whose status is ‘Closed’

Include Lost Quotes - If this is checked then the displayed list will include those Sales Quotations
whose status is ‘Lost’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
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records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Sales Order screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for entry of the following information that is required when creating
a new Sales Order

Customer:  From the drop-down list select the Customer against who this Sales Order is
being created.  If the Customer does not currently exist in the database you have the
option to type in the Customer Name and - upon exiting this field - a panel will appear
asking if you wish to create the Customer record.  If you confirm this a Customer
Maintenance screen will appear.  After you have completed the creation details you will be
returned to this screen.
Order Date: The Date that the Order was raised.  This is prefilled with system date but
can be amended by selecting the date from the drop-down calendar
Required Date: The Date that the Order is required by the Customer.  This is prefilled with
system date plus the number of days defined against 'Required Date Leadtime' in Sales
Rules.  It can be amended by selecting the date from the drop-down calendar
Purchase Order: Open format field for entry of the Customer’s Purchase Order Number.
If the ‘Purchase Order Mandatory’ checkbox against the Customer Master record is ‘
checked’ then an entry here is mandatory. 
List Code: Once the Customer has been selected this field is filled with the Default List
Code (if any) held against that Customer record.  You can amend the List Code by
selecting another Code from the drop-down list.  Upon creating the Sales Order the List
will automatically be displayed for selection and entry of line quantities.
Create New Sales Order: If this radio button is ‘checked’ then the next field should be
completed

Sales Type: From the drop-down list select the Sales Type.   Sales Types are
user-defined and maintained under Sales >Settings> Sales Types
Order Number: If the Sales Order numbering is manual (as defined against the
Sales Type) then this field will become active.  You are required to enter a Sales
Order Number before you are allowed to proceed
Sales Style: Display only field showing the Order Style as defined against the
Sales Type.  The options are ‘Counter’ or ‘Delivery’
Rental Start: This is only active if the Sales Type is flagged as a Rental Order.
When active it is prefilled with the system date but can be amended to reflect the
actual or anticipated start date of the Rental Order 
Rental End: This is only active if the Sales Type is flagged as a Rental Order.
When active it is prefilled with the system date but can be amended to reflect the
actual or anticipated return (or completion) date of the Rental Order

Copy Sales Order from another Order: If this radio button is ‘checked’ then the next field
should be completed

Select Existing Order: From the drop-down list select the Sales Order that is to
be used as the basis for creating this Sales Order.  This drop-down only shows
Orders that have been created against the Customer Defined above.
Note: You have the option to select another Customer for the generated Order
within the Sales Order ‘Detail’ screen. 
Order Number: If the Sales Order numbering is manual (as defined against the
Sales Type) then this field will become active.  You are required to enter a Sales
Order Number before you are allowed to proceed
Pricing Method: From the drop-down list select the method by which the copied
lines will be priced.   The options are:

Re-Calculate Prices: which uses the Prices in force at the current date, or
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Existing Prices: which copies the prices from the order being copied
Reverse Quantities: If this is 'checked' then the original Order Quantities will be
copied but with a reversed sign.  This is useful when raising a new Sales Order to
facilitate returns from a Customer

Create a Quote revision from the Selected Quote: Multiple Quote Revisions can be
created by using this radio button. Each Revision created is automatically given the
original Job Number followed by a #99 where 99 is a system-generated increments
number.

Selected Quote Number: Display only showing the currently selected Quote.  If
you now click the 'Create Quote' button then a Quote Revision record will be
generated.
NOTE: Only one revision is current at any one time, and this can be swapped via
the Job Order's 'List' screen where a button captioned ‘Set Current’ (which only
displays when on a Non Current version Quote). 

Buttons
Create Quote: Click on this button to generate a Quote.  This action will take you
to the Quote ‘Details’ tab for entering further information.
Create Order: Click on this button to generate a Sales Order.  This action will take
you to the Order ‘Details’ tab for entering further information.
Cancel: Click the ‘cancel’ button to exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Sales Order from this table

Related: This will bring up a list of functions that are related to the Sales Order.  You may open
and maintain information in those screens whilst still remaining in the Sales Order screen.

Reports: This will bring up a list of Reports that are related to the Sales Order.  You can
immediately run the report whilst still remaining in the Sales Order screen.

Print: This will generate and print the current Sales Order

Invoice: This is only visible if the Status is not ‘Quote’ and when selected creates an Invoice for
any 'actual picked' lines awaiting Invoicing.   If the Sales Order Style is 'One-Step Invoicing' then a
check is made to see if there are any outstanding lines to be Invoiced.  If there are then an Invoice
will be created.  If there are no outstanding lines then you will receive a message stating 'There are
no quantity changes, do you wish to credit the previous invoice and generate a new one anyway?'. 
The instance where this condition may arise is where you have (for example) amended the
Invoicing Address or a Sell Price against a line and you wish to recreate the Invoice with the new
values.

Set Current: Only displayed if the Order is a 'Quote' and the Quote is an earlier Revision of the
current Quote. Clicking this button will change the current 'Non Current' status of the Quote to a
'Current' status and will also revert the existing 'Current' status Quote to 'Non Current'

Detail Tab

Entry and Display fields

Order Number: Display only field showing the Sales Order or Quote number.  During an ‘Add’
transaction an Automatic Number is not allocated until the ‘Save’ button is pressed.

Order Date: This is prefilled with the system date.  You can amend the date by either overtyping



828 Ostendo Reference Guide

the date or selecting the date from the drop-down calendar.

Status: During Order creation this is prefilled with ‘Quote’ for a Quotation and cannot be amended.
 
For Sales Orders this is prefilled with the status defined against the Sales Type.  You can amend
this status by selecting the required status from the drop-down list.  The options are:

· Planned
· Open
· In-Progress
· Finished
· On-Hold
· Closed

Description: Enter a brief description of the Sales Order or Quote.  A longer description can be
entered into the ‘Notes’ field at the bottom of the screen.  No checks are made on the entry

Sales Type: Display only field showing the Sales Type selected during order creation or the Sales
Type of the Order being copied.

Sales Style: If there are no Delivery Lines picked, then this field can still be changed. Options are "
Counter"  or  "Delivery" .
It becomes a Display only field when one or more delivery lines have been picked.

Quotation Print Status: This is only visible if the Status is ‘Quote’ and defines the current print
status of the Quote.  You can reset it to ‘Not Printed’ from the drop-down list if required.

Acknowledgement Status: This is visible if the Status is not ‘Quote’ and defines the current print
status of the order Acknowledgement.  You can print the Acknowledgement by clicking on the
'Print' Button to the right of this screen.  After printing this will be set to ‘Printed’.  You can reset it
to ‘Not Printed’ from the drop-down list if required.

Lead Source: Select the relevant source from the drop-down list.

Tracking Code: From the drop-down list select the Tracking Code.  Tracking Codes are user
maintained (Sales>Settings>Sales Tracking) and enable you to track your Sales Orders and filter
views or reports by this Code.

Site Name: This is prefilled with the Site Name related to the User Signon.  If this User is flagged
as being allowed to change sites then this field is activated.  The Site can then be amended from
the drop-down list if required

Quote Expiry: This is only visible if the Status is ‘Quote’ and defines the expiry date of the Quote.
The date is derived from the Quotation Date plus the number of days set up in
Sales>Settings>Sales Rules.  You can amend the Expiry date by keying in a new date or selecting
a date from the drop-down calendar.

Quote Opt (Button): This is only visible if the Status is ‘Quote’.  Clicking on this button will bring
up the Sales Quote Options screen.  This is prefilled with the Defaults identified in the Sales Rules
but you may amend these defaults and make the text specific to this Quotation
 
(Button) Convert Quote: This is only visible if the Status is ‘Quote’ or 'Lost'.  If you click on this
button and:

- The current status is 'Lost' then you will be asked if you wish to revert this Lost Quote to an Active
Quote.  Clicking the 'Yes' button will revert it to a Quote
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- The current status is 'Quote' then another panel will be presented that contains the following
fields:

Convert to Order: Select this radio Button if this quote is to be converted into a Sales
Order.
Quotation Is Lost: Select this radio Button if this quote has been lost.  In this instance the
next field will become active
Lost Code: Select the reason why the Quote was lost from the displayed list then click
the ‘OK’ button.  Lost Quote Codes are maintained via General>Settings>Quote Lost
Reason
(Button) OK: If the Quote is being converted into an Order then this will commence the
generation of that Order.  If the Quote is Lost then this will change the Quote Status to ‘
Lost’.  Note: Lost Quotes can be viewed via a report

Order Settings Sub-Tab

Credit Terms: This defaults to the Credit Terms held against the Customer.  You can amend the
Credit Terms by clicking on the drop-down icon and selecting the Terms that apply to this Order.  

Purchase Order: Open format field for entry of the Customer’s Purchase Order Number.  An entry
here is mandatory if the ‘Purchase Order Mandatory’ field on the Customer master screen has
been set. 

Tax Group: This defaults to the Tax Group held against the Customer but you may amend this
from the drop-down list and select the Tax Group that applies to this Sales Order.  This Tax Group
combined with the Tax Group of the Item or Descriptor being sold defines the rate of Tax that
applies.  You may maintain Tax Groups by selecting File>Financial Configuration>Tax Groups

Sales Person: This defaults to the Salesperson held against the Customer record but you may
amend this from the drop-down list of Salespeople.  Salespersons are maintained under
General>Employees

Charge Freight: ‘Check’ this checkbox if freight is to be charged.  The next field will become
active for entry of freight details.

Shipping Method: This defaults to the Shipping Method held against the Customer.   You can
change this method by clicking on the drop-down icon and selecting the Shipping Method that you
wish to apply to this Order.  Shipping methods are maintained under Sales>Settings>Customer
Shipping Methods.

(Button) Freight Details: Click on this button to enter the following details:
Freight is Taxed: ‘Check’ this if the Freight is Taxable. The next field will be activated
Tax Code: From the drop-down list select the Tax Code that applies to this Freight 
Freight Amount: Enter the Freight Amount (not including Tax)

Required Date: Prefilled with the Date entered during order creation.  It can be amended here
from the drop-down calendar

Order Properties: If you click on this button then a panel will appear for you to attach properties
that are specific to this Sales Order.  For more information on Sales Order Properties see separate
entry in this Guide

Additional Fields Sub-Tab

If you have defined Additional Fields against the Sales Order (created via System
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Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

  
Rental Info Sub-Tab

This tab is only visible if the Sales Order Style is a ‘Rental’ Order

Rental Start: This is prefilled with the date entered during order creation but can be amended
here if required to reflect the actual or anticipated start date of the Rental Order 

Rental End: This is prefilled with the date entered during order creation but can be amended
here if required to reflect the actual or anticipated return (or completion) date of the Order

Rental Items Issued: ‘Check’ this checkbox when the Lines have been issued.  This will
enable you to monitor and track Items that have been issued against a rental order

Rental Items Returned: ‘Check’ this checkbox when the Lines have been returned.  This will
inform Ostendo that the Items are now available for issuing against other Rental orders

Priority Sub-Tab

Order Priority: This defines the priority attributed to the Order for use with the Order
Availability scheduling function.  It is prefilled with the setting held against the Customer record
but can be changed here if required.  The Priority number can be between 1 and 9 (1 being the
highest priority). 

Full Delivery Only: ‘Check’ this checkbox if this Customer only accepts full deliveries of
goods.  The initial setting is copied from the Customer record but can be changed here if
required.  

Service Zone: ‘Select the Service Zone for this order. (Used in Assignment Board).

Overrides Sub-Tab

Override Pricing Levels: If this is 'checked' then you may override the Price Level that
applies to this Order

Price Level: From the drop-down list select the Price Level that you wish to apply to this Sales
Order if different to the Customer's normal Price Level.  Price Levels determine Item and
Descriptor Sell prices using a pricing structure relating to this Price level.

Deliver Purchase Direct to Customer: If this is 'Checked' then any Purchase Order
generated from a  'Supply on Demand' Sales Order Line will have its 'Deliver To' address in
the generated Purchase Order the same as the Customer Delivery Address of this Sales
order. 

Override Locations: If this is 'checked' then you may override the Warehouse/Location that
will apply to this Order
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Warehouse: This is prefilled with the default Issue Warehouse for this Order.  You can amend
this by clicking on the drop-down list to select the Warehouse from where Items are to be
issued.  

Location: This is prefilled with the default Issue Location - within the above Warehouse for
this Order.  You can amend this by clicking on the drop-down list to select the specific Location
from where Items are to be issued.  

Financial Sub-Tab

Financial Category: If required, select the Financial Category applicable. If left blank, it
will use the Financial Category (if any) linked to the associated Cost Centre.

Order Discounts Sub-Tab

Total Disc (Percentage): This is for information only and shows the sum of the discounts applying
to each line expressed as a percentage of the sum of each order line with no discount

Total Disc (Value): This is for information only and shows the sum of the discounts applying to
each line.

Batch Update Discount %: This will bring up a separate panel for adjusting the discount and
shows the following fields:

Discount Every Line with New discount: The discount against each line will be
overwritten with this discount
Ratio All Lines to reflect the New discount: Applies the increase or decrease
percentage change to the current discount percent against each line
Existing Discount %: Display only field showing current discount % 
New Discount %: Enter the revised discount % to be applied

Order Deposits Sub-Tab

Deposits Amount: Display only field that shows the total of all Deposits made against this Sales
Order

(Button) Create Deposit:  If this button is pressed then a separate panel will appear for you to
enter a deposit payment against this Order.  This screen contains the following fields;

Order Number: Display only field referring to this Order Number

Billing Customer: Display only field showing the Billing Customer for this Order

Deposit Date: This is prefilled with the system date.  You may amend this by over-typing
the date or selecting a date from the drop-down calendar.   Upon posting this Deposit a
check will be made to ensure that this date is after the ‘Cut-Off’ date as set up in
File>Financial Configuration>Cut-off dates.

Payment Method: From the drop-down list select the method by which the Deposit was
made.  Payment Methods are user-defined under File>Financial Configuration>Payment
Methods.

Payment Reference: Open-format field for you to enter any identifying reference to the
Deposit.  No checks are made on this entry.
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Banking Method: From the drop-down list select the method by which the Deposit will be
banked.  The options are:

Directly to Account: Posting will occur upon update in this screen
Using Bank Deposit: Posting will occur when banked through the Bank Deposit
routine

Account for Payment: From the drop-down list select the Account to which the Deposit
will be made.  Payment Accounts are user-defined under File>Financial
Configuration>Payment Accounts.

Payment Reference: Enter details of the Payment (Example: Cheque Number)

Order Amount: Display only field showing the total amount of the order.

Deposit Amount: Enter the amount received against this Deposit

Remaining Balance: Display only field showing the value of Deposits that have not yet
been applied.

Buttons

Accept: This will create a Deposit record linked to the Order

Cancel: Cancel and ignore the entry and return to the Order Deposits Sub-Tab

(Button) Edit Deposit:  This will bring up the Customer Deposits screen from which you can
select and amend the Deposit information

Unapplied Amount: Display only field that shows the amount of Deposits made against this Sales
Order that have yet to be applied.

Auto Apply Deposit: Only available to 'One Step' Orders.  When shown you should    'check' the
checkbox if you wish the entered Deposit to automatically be applied to generated Invoices.

Customer: You have the option to amend the Customer but only if no deliveries or Invoices have
been created for this Order.   Up to that time you can select another Customer by clicking on the
drop-down list.  Upon selecting the Customer you will be asked ‘Would you like to recalculate Line
prices’.  If ‘Yes’ is selected then all lines will have their sell Prices recalculated in line with the Price
Level linked to the new Customer.

Delivery Address: These fields are prefilled with the Delivery Address of the Customer.  They can
be amended at any time by either clicking the drop-down button and selecting an Additional
Address or by keying an address directly into the following fields.

· Address: Three lines are available for entry of the delivery address of the site.  
· City: Enter the Town or City where this Delivery Address is located.
· State: Enter the State where this Delivery Address is located.
· Code: Enter the Postcode or ZIP Code where this Delivery Address is located.
· Country: Enter the Country where this Delivery Address is located.

(Button) Additional Customer Details: These fields are prefilled with details from the Customer
record.  They can be amended at any time as follows.

· Contact: To change the Contact select from the drop-down list
· Phone: Enter the Telephone Number of the Customer
· Fax: Enter the Facsimile Number of the Customer
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· Email: Enter the Email Address of the Customer.  If an entry is not made here then the
email address held against the Customer will be used

Billing Customer: This is prefilled with the Billing Customer as held against the Customer record.
It may be amended by selecting a new Billing Customer from the drop-down list

Additional Billing Details: A drop-down panel shows the current address details of the Billing
Customer.  They can be amended at any time by keying directly into the following fields.

· Address: Three lines are available for entry of the Billing Address of the Customer.  
· City: Enter the Town or City of this Billing Address.
· State: Enter the State of this Billing Address.
· Code: Enter the Postcode or ZIP Code of this Billing Address.
· Country: Enter the Country of this Billing Address.

One Step Invoice Date: This is only displayed if the Sales Rule 'One Step Invoice Date' is set to
'Specified Date'.  This field is pre-populated with the System Date but can be amended from the
drop-down calendar.  This date will be used for all Inventory Issues and will also become the Date
of the Invoice produced from this Order

Currency Code: Prefilled with the currency code for this Customer but can be amended by
selecting another currency from the drop-down list

Exchange Rate: Prefilled with the exchange rate taken from the Exchange Rate table for the
currency.  This rate can be over-ridden if required

Order Values: This is for information only and shows:
Ordered Values

Nett Amount
Freight Amount
Tax Amount
Total Amount

Invoiced Values
Nett Amount
Freight Amount
Tax Amount
Total Amount

Sales Notes: You can enter unlimited amount of Notes that are related to this Sales Order.  These
notes will be available wherever the Order is reported.  Whenever you click on this field an icon will
appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text table. 
Select the text to be copied and either press the OK Button in that screen or double-click the
selected record.

Invoice Notes: You can enter unlimited amount of Notes that are related to this Sales Order.
These notes will be available wherever the Order Invoice is reported.  Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that screen or
double-click the selected record.

Buttons

Close: This will close the Sales Order screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel
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Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Sales Order.  You may open
and maintain information in those screens whilst still remaining in the Sales Order screen.

Reports: This will bring up a list of Reports that are related to the Sales Order.  You can
immediately run the report whilst still remaining in the Sales Order screen.

Print: This will generate and print the current Sales Order

Invoice: This is only visible if the Status is not ‘Quote’ and when selected creates an Invoice for
any 'actual picked' lines awaiting Invoicing.   If the Sales Order Style is 'One-Step Invoicing' then a
check is made to see if there are any outstanding lines to be Invoiced.  If there are then an Invoice
will be created.  If there are no outstanding lines then you will receive a message stating 'There are
no quantity changes, do you wish to credit the previous invoice and generate a new one anyway?'. 
The instance where this condition may arise is where you have (for example) amended the
Invoicing Address or a Sell Price against a line and you wish to recreate the Invoice with the new
values.

Set Current: Only displayed if the Order is a 'Quote' and the Quote is an earlier Revision of the
current Quote. Clicking this button will change the current 'Non Current' status of the Quote to a
'Current' status and will also revert the existing 'Current' status Quote to 'Non Current'

Lines Tab

This screen allows you to add Lines to the Sales Order.  The Sales Order Number and its Status is
displayed at the top of the panel.  

Sales Order Lines can be created from the following sources:
· Lists
· Items
· Descriptors
· Catalogues
· Matrices
· Kits
· Manual

Each Method is described here

Lists: Lists are pre-defined Lists of Item Codes, Descriptor Codes, Catalogue Codes,and Labour
Codes from which selections are made.  Maintenance of Lists is covered under Inventory>Lists.  
To use ‘Lists’ click on the ‘Lists’ icon on the upper toolbar.  On the displayed panel use the
drop-down list to select the specific List.   This will display the contents of the List. Now ‘check’ the
checkbox against each line that you want to be copied to the Sales Order.  You have the option to
click on the ‘Select All Contents’ Button at the bottom of this panel to select all the records.  You
may also click on the ‘De-select All Contents’ Button at the bottom of this panel to ‘un-select’ all the
records.   For each selected record you can amend the ‘Per Qty’ to denote the quantity you require
per ‘List’.  You can enter a multiplying quantity in ‘Multiplied Contents By’ field, which will extend
the above ‘Per Qty’ by this factor.
If you now click on the ‘Create Lines from Selected Contents’ Button then all the selected Lines will
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be copied to the Sales Order.   At this time any prices and quantity discounts will be applied to
determine the Sales Order Price for each Line.

Items: To select single or multiple Items click on the ‘Items’ icon on the upper toolbar.  This will
display all Items that are currently ‘Active’.   Simply highlight the Item in the top panel then click
the ‘Add to Selected Items’ Button to copy it to the lower part of the screen.  Repeat this for all
required Items.  In the Lower panel amend the required quantity per line as required, or remove the
line by clicking on the ‘Remove from Selected Items’ Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Sales Order.   At this time any prices and quantity discounts will be applied to
determine the Sales Order Price for each Line.
If you have Items that are designated as ‘Custom’ products then these should be added to the
Sales Order by clicking the ‘Add’ Button and selecting the Item in the lower part of the ‘Lines’
screen.  A display will appear depending upon whether the Custom Product is configured by ‘Rules
’, ‘Manual’, or 'Features'

· If ‘Rules’ then a screen is presented containing the ‘Questions’ from the Custom Script.
These will be presented in turn which, when answered, will generate a Customised
product whose Cost and Sell Price will be determined from the end configuration

· If ‘Manual’ then a screen is presented showing a basic Bill of Material to make the product.
The routing and line contents of the BOM can be amended to suit the specific
configuration.  You may also amend the Estimated Markup %.   Having configured the
BOM and adjusted the Markup% you should click on the ‘Update Sales Line Price’ button
to copy the resultant Sell Price to the Sales Order Line.  When completed, Ostendo will
generate a Customised BOM in preparation for generating an Assembly Order to
manufacture the Sales Order Line.

· If ‘Features’ then a screen is presented showing the Features and Options related to the
product.  Within each Feature you can nominate the Option to be used.  When completed,
Ostendo will generate a Customised BOM in preparation for generating an Assembly
Order to manufacture the Sales Order Line.

Descriptors: To select single or multiple Descriptors click on the ‘Descriptors’ icon on the upper
toolbar.  This will display all Descriptors that are currently ‘Active’.   Simply highlight the Descriptor
in the top panel then click the ‘Add to Selected Descriptors’ Button to copy it to the lower part of the
screen.  Repeat this for all required Descriptors.  In the Lower panel amend the required quantity
per line as required, or remove the line by clicking on the ‘Remove from Selected Descriptors’
Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Sales Order.   At this time any prices and quantity discounts will be applied to
determine the Sales Order Price for each Line.

Catalogues: To select single or multiple Codes from a Supplier’s Catalogue click on the ‘
Catalogue Items’ icon on the upper toolbar.  This will display all Codes that are included in the
Catalogue against whom this order is being placed.   Simply highlight the Code in the top panel
then click the ‘Add to Selected Items’ Button to copy it to the lower part of the screen.  If a
Catalogue Item exists as an Ostendo Item the program will display the Item’s current Ostendo
Stock level.  You have the option to use that stock or continue as a Catalogue Item.  If the
Catalogue Item option is selected then Ostendo will create a ‘Source On Demand’ record to satisfy
the Order.  

Kits: A Kitset - containing a user-defined mixture of Items and Descriptors - can be called up and
added to a Sales Order line.  The content of the kit is copied as a sub-set to the Sales Order Line
and can be amended as required.  However, any Invoice generated from the Sales order will state
a sell price at the Kitset level.  The selection of a Kitset is by clicking on the ‘Line Type’ drop-down
list when creating a Sales Order Line and selecting ‘Kitset Code’.  The relevant Kitset and quantity
then be selected for this line 

Matrices: This displays the Matrices set up via screen Inventory>Matrices.  Having selected a
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specific Matrix you can enter quantities relating to Items within the Matrix.  Upon exiting from that
panel all the Items that have a quantity entered against them will be copied to this Sales Order

Manual: You can create Manual Order Lines by clicking on the ‘Add’ Button to the right of the
screen.  A Line is created in the upper panel, however maintenance of the record is carried out in
the lower panel.  

NOTE:  To facilitate faster line maintenance you can, in the main Grid (Upper part of the screen) -
directly modify the Order Qty, Order Unit Price, Tax Inclusive Unit Price, and the Line Number
fields.  
  

(Batch Entry bar)

This bar displays Buttons that provide various options to add lines to the Sales Order in batch
form:

Lists: Clicking on this button will bring up the Lists maintained via Inventory>Lists.  From the
displayed List you can select single or multiple Items for copying to this Order

Items: Clicking on this button will bring up a list of Items currently in Ostendo.  From the displayed
list you can select single or multiple Items for copying to this Order

Descriptors: Clicking on this button will bring up a list of Descriptors currently in Ostendo.  From
the displayed List you can select single or multiple Items for copying to this Job

Catalogue Items: Clicking on this button will bring up a list of Supplier Catalogues from which you
can select a specific Catalogue.  Note: The Catalogue selection screen is by-passed if you only
have one Supplier Catalogue in Ostendo.   For the selected Supplier the Catalogue Items are
displayed from which you can select single or multiple Items for copying to this Order.

Picking: Clicking on this button will bring up the Sales Order Issues screen.  This is prefilled with
the Item and Descriptor lines currently contained in the Order.  You should note however that the
displayed list only shows:

· Items whose Supply Method is ‘Supply From Stock’ because all other Items are ‘Source on
Demand’ and will be supplied directly from Purchase or Assembly Orders

· Descriptors that are Sourced By ‘Internal’ because those Sourced By ‘Purchasing’ will be
directly supplied from a Purchase Order 

You can carry out ‘mass issue’ of the displayed lines as follows:
Pick Date: In the first instance this is prefilled with the system Date.  You can change this
date by entering the date or clicking on the drop-down menu and selecting the date.
Prefill Pick Lines (Button): Click this button to prefill all lines with the outstanding issue
quantity.  You may either use this ‘Speed Entry’ to prefill lines with the current outstanding
quantity or enter each line as required.  All lines can be amended prior to posting via the ‘
update Job with above Job Issues’ button.  Note that any line that has sub-level variations
(Serial Number, Batch Number, Colour, etc) are NOT prefilled and must be selected at line
level.  The following fields are displayed:
Date: This defines the date of this transaction and is prefilled with the above date.  You
can change this date by entering a date or clicking on the drop-down menu and selecting
the date.
Line Number: Display only field showing the Line Number within the Sales Order.
Line Type: This shows the Line Type covering this line.  You may amend this by selecting
another Line Type from the drop-down list.  The options are Item Code, Descriptor Code,
Kitset Code, or Catalogue Code.
Code: From the drop-down list select the Item Code, Descriptor Code, Kitset Code, or
Catalogue Code that applies to this line
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Unit: Prefilled with the base Unit for the Code.  If it is an Item Code and that Item has
more than a single Unit of Measure then an alternate Unit can be selected from the
drop-down list.
Qty: The Quantity to be issued.  This can be amended at any time.  If the Code is an Item
and that Item has sub-level variations (such as Colour, Size, Batch, etc) then you should
click on the Icon to the right of this field and selected the specific variant(s) from the
displayed panel.  This feature also applies if you are issuing an Item from a location other
than the displayed default location.
Description: Prefilled with the Description for the Code.  It can be amended if required
and made specific to this Issue.
Warehouse: For an Item Code this is prefilled with the default ‘Issue’ Warehouse.  You
may amend this by selecting another Warehouse from the drop-down list
Location: For an Item Code this is prefilled with the default ‘Issue’ Location.  You may
amend this by selecting another Location from the drop-down list
Variants: If the Line Item Number has variants (Serial Number, Expiry Date, Batch No,
Rev No, Size, Colour, Grade) then they should be entered into the respective fields.  
Recorded Notes: Extended Notes for your own information can be attached to this Line.   
(Button) Update Sales Order: Click this button to update the quantities entered in the
above panel.

Auto Pick: If the Sales Rule is set to ‘Allow Auto Pick from Counter Orders’ then this button will be
displayed for ‘Counter’ Sale orders.  If this is clicked then all outstanding issues for all lines are
automatically picked from their default location.  You should note, however, that if any line has
variants (Colour, Size, etc), or is ‘Source on Demand’ and Purchased then a message will be
returned informing you that these have not been picked.  The same will also apply if any Item’s
stock level is not allowed to go negative and this ‘issue will create that condition

Matrices: Clicking on this button will bring up the 'Matrices Batch Entry' screen.  On that screen
click the 'Add' button to add a new Matrix line and add the following:

Matrix Tab
Upper Panel

Matrix Style: From the drop-down list select the Matrix Style against which you are
going to enter the required quantities.  
Description: Display only showing the Description of the selected Matrix Style
Total Qty: Display only showing the sum of the entries made in the lower part of this
screen.
Required Date: Date when the Order Line is required.  This is prefilled with the
system date.  You can amend this any other date by clicking on the drop-down
calendar and selecting the date.

Lower Panel
Matrix Tab:  This panel displays the X, Y, and Z variables for the Matrix Style selected
above.  You can now enter the order quantities against the matrix combinations.  
Click on any XYZ cell and enter the required quantity.   If the Cell contains the
characters --- then that Matrix combination has not been defined for the Matrix Style
and a quantity cannot be save in this cell.
Notes Tab:  Enter any information Notes that will be specific to this Order/Matrix 

Properties Tab
Initially, this will display the Properties copied from the entry made against the Matrix Style
in screen (Inventory>Matrices>Properties).  You can amend the values here and make it
specific to this Order Line

Buttons
Close: This will close the Batch Entry - Matrices screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.  Upon closing this
screen Ostendo will generate an Order Line for each Item or Descriptor Code associated
with the Matrix Style/X/Y/Z combination
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Add: This will send the cursor to a new line for entry of a new Matrix Style for this Order
Save: This will save the current data without exiting the screen
Cancel: Any changes made to the Required Date and Notes field since this screen was
opened or the last time the ‘Save’ Button was pressed will be lost.
Delete: This will remove the current Matrix Style from this Batch entry screen along with
any Order Lines currently generated by this Matrix Style

(Script): This button will only be displayed if an ‘Order Script’ has been created (via File>System
Configuration>Order Scripts).   When visible the button name will be prefilled with the script name
and, when pressed, will perform the functions of that script. 

(One Step Invoicing Mode)

This bar is only displayed if the Invoicing Style for this Sales Type is 'One Step with Backorders'.  
In this instance you have the option to select the following from the drop-down list.

· Create New Invoice: A new Invoice will be created using the quantities as entered into
field 'Invoice Qty' in the lower part of this screen

· Adjust Previous Invoice: The quantities displayed in field 'Invoice Qty' in the lower part of
this screen are those from the previous Invoice.  They can be amended here.  If the
previous Invoice has not been printed then the quantities on that Invoice will be adjusted
accordingly.  If the previous Invoice has been printed then a Credit Invoice will
automatically be created with status 'Printed' and new Invoice generated for the new
quantity

(Line Info)

A line is presented between the Upper and Lower panels which contains buttons relating to the
current line Item and is presented for further information and maintenance.   The displayed buttons
are:

Max Kitset: If the Order Line is a Kitset then Ostendo will determine the number of kits –
using the current stock level - that can be assembled for each line in the Kit.  The lowest
calculated number represents the maximum number of full Kitsets that can be made.  This
value is displayed on this button.  Click on the button to view the Kitset Line details
Add-On Sale Items: The current Add-On Sales linked to this Item are displayed for further
maintenance if required.
Qty-Break Pricing:  The current Quantity Breaks and Sell Prices linked to this Item are
displayed for further maintenance if required.
Alternate Item:  The current Alternate Item linked to this Item is displayed for your
reference along with the current on-hand quantity of this alternative.
Stock/Avail:  This shows the current On-Hand quantity (in stock) and Available Quantities
(On-Hand + Supply - Demand) for this Item along with the Item’s basic Unit of Measure.
Clicking on this button will show further details. 
Mass Rental Availability: This allows you to view Rental Items within a Selected Item
Category and assess their availability over a defined time period.  This availability
commences with current free stock then, on a daily basis, takes into account current
Rental Order demand and return dates and quantities to provide a daily balance. 

Lower Panel

The Line Maintenance applies to any line generated by any of the above methods.  Seven ‘Tabs’
are associated with this section.  Which tabs are displayed is dependent upon the Line:

· Sales Line: Main Entry area for Purchase Order Lines
· Line Source: Demand Source (Sales, Jobs, etc) that are allocated to this Line
· Line Properties: Specific Properties that apply to the ordered Line
· Planned Variants: Identifying any Variants required (example Colour, Size, etc)
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· Picked Lines: Receipt History of this Line
· Kit Contents: Details of any Kitset Order Line
· Warranty: Warranty records that apply to this line

Sales Line Tab

This is the main entry and maintenance area for Sales Order Lines. 

Entry and Display fields

Line Number: This is auto-generated by the program in increments of 10 from the previous Line
Number.  You can amend this number if required.  This number can be used as a sort sequence
for printing the lines on a Sales Order.  No checks are made on the entry

Line Type: From the drop-down list select the Line Type.  The options are:
Item Code
Descriptor Code
Kitset Code
Catalogue

Code: From the drop-down list select the Code.  The drop-down list will vary dependent upon the
Line Type selection.  Note:

· If the Item is a Custom Product then a separate panel will appear for you to configure the
Product.  After configuration an extra ‘Icon’ appears to the right of this field.  Clicking on
this icon will bring forward a panel showing the configured questions and answers.

· When entering an Inventoried Item you may wish enquire on additional Item Code
information.  Therefore a ‘Stock Availability’ and ‘Alternate Items’ icons will be available
just above this lower panel.  

Order Quantity: This is prefilled with the quantity entered into the preliminary selection panels
defined above or 1 if manually entering the line.  This can be amended here if required.

· If the Line is for an Item Code and that Item has Order Dimensions then an Icon will appear
to the right of this field.  If you click on the Icon (or key Ctrl-Q) then a separate panel will be
presented into which you can enter the individual Dimensions.  From the entered lines
Ostendo will calculate the total quantity and populate the Order Line with this value.  You
may overtype this quantity if required.

· If the Line is for a Descriptor defined as a ‘Freight Descriptor’ then an Icon will appear to the
right of this field.  If you click on the Icon (or key Ctrl-Q) then a separate panel will be
presented into which you can enter the Weight(s) and Volume(s) for this delivery.  From the
entered lines Ostendo will determine – for each line entered here - the Freight Cost related
to the greater of the Weight and Volume.   Upon clicking the ‘Close’ button the sum of the
freight values will be populate the Order Line Qty field.  You may overtype this quantity if
required.

Unit: This is prefilled with the Unit for the Code.  If this is an Inventoried Item with multiple Units
then you can amend the Unit of Measure by clicking on the drop-down icon and selecting the Unit. 

Std Price: This is prefilled with the program calculated Unit Price of the Code taking into account
any quantity Discounts, etc.  If the User’s has been given the rights (via File>System
Configuration>User Security and Options) then this can be amended here.  

Order Price: This is prefilled with the program calculated Unit Price of the Code taking into
account any quantity Discounts, etc.  This can be amended here if required.  If it is amended then
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the Discount% field will automatically show the discount relative to the above Std Price.  

Order Price Icon:  This is situated to right of the 'Order Price' field.  If you select this then a
separate panel will be displayed that shows the following:

Line Info Tab
Price Changes: This will show any manual Price changes that have been made to this
Sales order Line
Price Route: This displays the process and values used by Ostendo to determine the
calculated Sell Price

Price Levels & Margins Tab
For the Current Line Price, Base Sell Price, and each Price Level Price this will shows
each Unit Sell Price.  Additionally, if the User is flagged to 'Display Sales Cost' in the
User's Options then this will also display the Unit Cost, Margin, and Gross Profit.  You now
have the option to override the current Sales Line price with another Price level Price by
selecting the appropriate line in this screen and clicking the 'Override Order Price with
Selected Price Level' button

Discount%: This is prefilled with the normal Discount % offered to this Customer.  This can be
amended if required.  In this instance the Order Price field will automatically show the discounted
amount relative to the above Std Price

Description: This is prefilled with the description as held against the Item, Descriptor, Kitset, or
Catalogue Item.  It can be amended here if required.

Nett Amount: The system-calculated nett amount for the Line based on the Order Quantity, and
Unit Price and taking into account the Sell Price matrix.

Tax Amount: The system-calculated tax amount based on the Order Quantity, Unit Price and Tax
Code.

Total Amount: The system-calculated total amount for the Line based on the Order Quantity, Unit
Price and Tax Code.

Price Override: Checkbox showing if the price has been manually overridden.  If this is ‘
unchecked’ then the Unit Price field will revert to the pre-amended price.

Invoice Qty: This is only available to One-Step Sales Orders and denotes the Quantity to be
Invoiced.  It is prefilled with with quantity that is derived from either (a) the Order Line Quantity, or
(b) the Previous Invoice Quantity if the Invoice Style is 'with Backorder' and you are adjusting the
previous Invoice.  In either case the quantity can be adjusted here to reflect the quantity to be
issued and Invoiced.

Required Date: The required date for this Order Line is initialised with the Sales Order required
date.   It can be amended and made specific to this line by overtyping the date or selecting a date
from the drop-down calendar.

Tax Code: The Tax Code as evaluated from the relationship between the Customer Tax Group
and the line’s Tax Group (See File>Financial Configurations>Tax Matrix).  The Tax Code can be
amended from the drop-down list if required

Analysis Group: This is prefilled with the Analysis Group held against the Code.  This can be
amended by selecting another Analysis Group from the drop-down list. 

Picked Qty: This is a system maintained quantity that shows the quantity of this line that has
already been ‘picked’.

Invoiced Qty: This is a system maintained quantity that shows the quantity of this line that has
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already been ‘Invoiced’.

Line Status: This shows the current status of this line.  The options are ‘Open’ or ‘Closed’.   The
program will close the status if the full quantity has been invoiced.   You can amend this by
selecting ‘Open’ from the drop-down list.     Similarly, if you have not despatched the full order
quantity and know that the remainder will not be delivered then you can amend the status to ‘
Closed’.  If the Line is an Inventoried Item then a status of ‘Closed’ will inform the Replenishment
Routine to ignore this line.

Line Notes: This is prefilled with any ‘Notes’ that are held against the Code that are flagged as
being copied to the Sales Order Line.   It may be amended here and made specific to this Line. 
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Note: When you are addressing a selected Sales Order line then you can use  Ctrl/Q to perform
the following actions:

· If the Line Type is Item Code and the Item Master record contains Order Dimensions then the Item
Dimensions screen is presented for entry of Dimensions

· If the Line Type is Descriptor Code, Kitset Code or Catalogue Code then a Line Freight Screen
screen is presented for entry of freight details directly relating to this line

Line Source Tab

The Line Source screen relates to Items and Descriptors and is only visible when those Line Types
are selected.  It tells you from where the line is to be supplied and, if its Supply Method is ‘Source
on Demand’ the actual Supply Order (Assembly Order or Purchase Order).  
If you decide to split the Source of Supply to (say) partially ‘Supply from Stock’, plus partially ‘
Supply on Demand’ from one Supplier and the remainder ‘Supply on Demand’ from another
Supplier then you can achieve all this via this screen.
To split an existing Line Source click on the ‘Add’ Button.  This will add a new line and display a
button ‘Edit Source Quantities’.   Clicking on this button brings up a separate panel for re-allocation
of quantities.

Supply Method: For Descriptors, Catalogue Items and Kitsets this can only be ‘Supply On
Demand’.  For Items Codes select the Supply Method from the drop-down list.  The options are
Supply on Demand or Supply from Stock.

Sourced By: Shows how this Line is to be provided.  The options are Internal or Purchasing

Source Qty: This is the quantity that is allocated to this Source reference.

Supplier: The Supplier if this Item, Catalogue Item or Descriptor.  You can amend the Supplier if
the next field does not have an Order Number held against it.  To amend the Supplier click on the
drop-down icon and select the Supplier from the list
Supply Order Number: If the Supply Method is ‘Source on Demand’ and the Sourced By is ‘
Purchased’ then this is filled with the Purchase Order that has been raised to cover the demand.

Button

Edit Source Quantities: This button appears when the ‘Add’ button is selected.  The ‘Add’ button
also creates a new line in the ‘Line Source Tab’ screen.  You should complete the ’Supplier
Method’ and ‘Sourced By’ fields in the new record before selecting this button.  When you click on
this button a panel is presented showing the following fields

Source Qty: Amend the quantities as required.  The sum of the quantities must equal the
total line quantity before you can exit this panel.
Supply Method: Display only field showing the Supply Method as entered in the Line
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Source Tab
Sourced By: Display only field showing the Source as entered in the Line Source Tab
Supplier: Display only field showing the Supplier as entered in the Line Source Tab
Purchase Order Number: Display only field showing the PO Number as entered in the
Line Source Tab

Line Properties Tab

Any specific property values for the Item, Descriptor, Kitset, or Catalogue Item can be viewed here.
For example: A ‘property’ against an Item could be ‘Voltage’ and the specific value entered against
the Item Master is ‘240 Volts’.  You also have the option to add properties by clicking on the ‘Add’
button.  The cursor will go to a new line for entry of the property as follows:

Property: From the drop-down list select the Property.

Value: Enter the specific value relating to this Property.

Buttons

When in this panel you can use the Add, Save, Cancel and Delete Buttons as follows
Add: The cursor will go to a new line for entry of a new Line Property Value.
Save: This will save the current data without exiting the screen
Cancel: Any changes made since the line record was accessed or the last time
the ‘Save’ Button was pressed will be lost.
Delete: This will delete the current highlighted Line Property record.

Planned Variants Tab

This panel will only be visible against Items with Variants (example Colour, Size, etc).  This shows
which variants are planned for this Sales Order Line.  The displayed fields are:

Quantity: The quantity planned for this variant.  The sum of these quantities cannot exceed the
Sales Order Line quantity.

Variant: All Variant fields applicable to this Item are displayed.  Any unique combination of variants
will be displayed in its own line.

Buttons

When in this panel you can use the Add, Save, Cancel and Delete Buttons as follows
Add: The cursor will go to a new line for entry of a new Planned Variant.
Save: This will save the current data without exiting the screen
Cancel: Any changes made since the line record was accessed or the last time
the ‘Save’ Button was pressed will be lost.
Delete: This will delete the current highlighted Planned Variant record.

Picked Lines Tab

This shows the Pick History against this Line.  The screen layout varies dependent upon the Line
Type being issued as follows:

Line Type ‘Item Code’

· Issue Date: The date when this was picked.
· Qty: The quantity picked on the above date
· Unit Cost: The Unit Cost of the Item when it was picked.  
· Warehouse: The Warehouse from where it was picked
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· Location: The Warehouse Location from where it was picked

Line Type ‘Descriptor Code’, Kitset Code, Catalogue Code

· Issue Date: The date when it was issued
· Qty: The quantity issued to this Sales Order Line
· Unit Cost: The Unit Cost when it was issued.  

Kit Contents Tab

When a Kitset is copied to the Sales Order Line its content is shown here.  It can be amended as
required.  You should note that the sell price if this line can vary according to the Sell Price
Settings defined against the Kitset Header record.

Line Number: The Kitset Lines are printed in Line Number sequence.  Upon creation of a new line
the program will increment the previous line by 10.  You can amend this as required.

Component Type:  Select the Component Type from the drop-down list.  The options are:
· Item Code
· Descriptor Code

Component Code: From the drop-down list select the code.   The drop-down list displays the
codes relating to the selection made in the Component Type field

Description: The description is copied from the Item or Descriptor record.  It may be amended
here and made specific to this List. 

Unit: The base unit is copied from the Item or Descriptor.   If it is an Item that has multiple Units
then an alternate Unit may be selected from the drop-down list.

Qty Per Kitset: Enter a default quantity to be used.  If nothing is entered here then 1 is assumed.

Qty Required: Extended quantity calculated from Qty per Kit multiplied by number of kits required.

Qty Issued: Display only field showing the quantity issued against this Kitset Line.

Buttons

When in this panel you can use the Add, Save, Cancel and Delete Buttons as follows
Add: The cursor will go to a new line for entry of a new Kitset Component.
Save: This will save the current data without exiting the screen
Cancel: Any changes made since the line record was accessed or the last time
the ‘Save’ Button was pressed will be lost.
Delete: This will delete the current highlighted Kitset Component record.

Warranty Tab

This enables you to adjust current Warranty records that may exist against this Line;

Warranty Code: From the drop-down list select the Warranty Code that you are adding to this
Sales order Line.

Description: Description of the Warranty Code taken from the warranty record

Term: Duration of the ‘Time Unit’ taken from the warranty record

Time Unit: Days or Months Time Unit taken from the warranty record



844 Ostendo Reference Guide

Buttons

When in this panel you can use the Add, Save, Cancel and Delete Buttons as follows
Add: The cursor will go to a new line for entry of a new Warranty Record.
Save: This will save the current data without exiting the screen
Cancel: Any changes made since the line record was accessed or the last time
the ‘Save’ Button was pressed will be lost.
Delete: This will delete the current highlighted Warranty Record.

Rental Code Tab

This tab is only visible if the Line is for a Descriptor Code that is flagged as a ‘Rental’ Descriptor.

Rental Item Code: This is the Rental Item normally linked to the Rental Descriptor.  You may
choose an alternative Item to be linked to the Rental Descriptor by selecting it from the
drop-down list

Description: This is a display only field showing the description of the above Item Code.

Rental Qty: This is prefilled with the ‘Default Rental Qty’ as held against the Descriptor record.
This can be amended here, if required, and made specific to this Order.   You should note that
this does not amend the rental charge but only adjusts the required quantity, and therefore, the
projected availability of this Item

Order History Tab

This shows the Customer's Order History of the Item or Descriptor.

Order Date: This is a display only field showing the date held against the Order Line

Status: This is a display only field showing the current status of the Order

Order Number: This is a display only field showing the Order Number that contained this
Item/Descriptor Code

Qty: This is a display only field showing the quantity ordered in this Order Number

Unit: This is a display only field showing the Unit of Measure held against this Order Number

Unit Price: This is a display only field showing the Unit Price charged in this Order

Currency Code: This is the currency code of the order.

Additional Fields Tab

If you have defined Additional Fields against the Sales Line (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day
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Buttons

Close: This will close the Sales Order screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Adds a line relative to the displayed ‘Tab’ in the lower part of this screen

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Deletes a line relative to the displayed ‘Tab’ in the lower part of this screen

Related: This will bring up a list of functions that are related to the Sales Order.  You may open
and maintain information in those screens whilst still remaining in the Sales Order screen.

Reports: This will bring up a list of Reports that are related to the Sales Order.  You can
immediately run the report whilst still remaining in the Sales Order screen.

Print: This will generate and print the current Sales Order

Invoice: This is only visible if the Status is not ‘Quote’ and when selected creates an Invoice for
any 'actual picked' lines awaiting Invoicing.   If the Sales Order Style is One-Step Invoicing then a
check is made to see if there are any outstanding lines to be Invoiced.  If there are then an Invoice
will be created.  If there are no outstanding lines then you will receive a message stating 'There are
no quantity changes, do you wish to credit the previous invoice and generate a new one anyway?'. 
The instance where this condition may arise is where you have (for example) amended the
Invoicing Address or a Sell Price against a line and you wish to recreate the Invoice with the new
values.

Set Current: Only displayed if the Order is a 'Quote' and the Quote is an earlier Revision of the
current Quote. Clicking this button will change the current 'Non Current' status of the Quote to a
'Current' status and will also revert the existing 'Current' status Quote to 'Non Current'

15.6.1 Line Qty Dimensions

This screen is accessed against Order Lines for Item Codes that contain Order Dimensions (as
entered into the Item Master screen).   For these Items an icon is presented to the right of the
Order Line Quantity field. If you click on this Icon (or key Ctrl-Q) then this panel will be presented
for entry of Dimensions

Entry and Display fields

Item Code: Display only field showing the Item Code against which the dimensions are being
entered

Unit: Display only field showing the basic Unit Of measure of the Item Code 

Current Order Line Qty: Display only field showing the current order quantity of this Item held
against the Order Line

Total Calculated Qty: Display only field showing the sum of the Calculated Line quantities in this
screen



846 Ostendo Reference Guide

Qty: Enter the Quantity to be ordered using the dimensions entered into the following fields

Length: If the Item Code has a Length Dimension then this column is displayed.  You should enter
a Length value.  If nothing is entered then a length of 1 is assumed

Width: If the Item Code has a Width Dimension then this column is displayed.  You should enter a
Width value.  If nothing is entered then a Width of 1 is assumed

Depth: If the Item Code has a Depth Dimension then this column is displayed.  You should enter a
Depth value.  If nothing is entered then a Depth of 1 is assumed

Pack Size: If the Item Code has a Pack Size Dimension then this column is displayed.  Click on
the drop-down and select a Pack Size.  If nothing is entered then a Pack Size of 1 is assumed. 
You should note if only one Pack Size is in the List then that entry will automatically prefill this field.

Calc Qty: This is the calculated quantity for the Line taken from

(Qty * Length * Width * Depth / Pack Size Qty) * Qty Conversion Factor

Buttons

Close: This will close the Line Qty Dimensions screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Qty Dimension record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the current Qty Dimension record from this list

15.6.2 Sales Order Picking

This screen is presented when the ‘Picking’ button on the Sales Order Line’s ‘Batch Entry’ bar is
selected.   Within this screen you can individually add lines that have been picked or click on the ‘
Prefill Issues’ button the display un-issued Sales Lines

NOTE: The displayed list shows:
· Items whose Supply Method is ‘Supply From Stock’ along with the quantity yet to be supplied
· Items whose Supply Method is ‘Source on Demand’.  In this instance the Quantity will be

prefilled with zero as they will be satisfied directly from the linked Purchase or Assembly
Orders.  You can amend this quantity, if required, and it will be issued from stock.  However
the linked Supply order will still remain.

· Descriptors that are Sourced By ‘Internal’ because those Sourced By ‘Purchasing’ will be
directly supplied from a Purchase Order.

· Descriptors that are Sourced By ‘Purchase’.   In this instance the Quantity will be prefilled
with zero as it will be satisfied directly from the linked Purchase Order.  You can amend this
quantity, if required, and it will be issued directly to the Order.  However the linked Supply
order will still remain.

Prefill Issues (Button): Click this button and a panel will appear for you to enter a date that covers
the transaction date for picked lines.  It is prefilled with the system date but can be amend from the
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drop-down calendar.  Clicking the ‘Create’ button will display the sales order lines that have an
outstanding issue quantity.   

Override Default Location: If this is ‘checked’ then the following two fields will become ‘Active’
and an entry is required in each field.   These will become the ‘Issue’ Warehouse/Location for all
Items in this Order Issue and will override the default Warehouse/Location held against individual
Item Codes

Warehouse: From the drop-down list select the Warehouse from which the Sales Order Issue is
being made.

Location: From the drop-down list of Locations within the above Warehouse select the location
from where the Sales Order Issue is being made.

All the displayed lines can be amended as required.  Note that any line that has sub-level
variations (Serial Number, Batch Number, Colour, etc) are NOT prefilled and must be selected at
line level.  The following fields are displayed:

Date: In the first instance this is prefilled with the above ‘Pick Date’ Date.  You can change this
date by entering the date or clicking on the drop-down menu and selecting the date.

Line No: This shows the current Line Number in the Sales Order. 

Line Type: This shows the Line Type covering this line.  You may amend this by selecting another
Line Type from the drop-down list.  The options are Descriptor Code, Kitset Code, Catalogue Code
or Item Code.

Code: From the drop-down list select the Descriptor, Kitset, Catalogue, or Item Code that applies
to this line

Unit: Prefilled with the base Unit for the Code.  If the line refers to an Item that has more than a
single Unit of Measure then an alternate Unit can be selected from the drop-down list.

Qty: The Quantity to be issued.  This can be amended at any time.  If the Item has sub-level
variations (such as Colour, Size, Batch, etc) then you should click on the Icon to the right of this
field and selected the specific variant(s) from the displayed panel.  This feature also applies if you
are issuing an Item from a location other than the displayed default location.

Warehouse: For an Item Code this is prefilled with the default ‘Issue’ Warehouse.  You may
amend this by selecting another Warehouse from the drop-down list

Location: For an Item Code this is prefilled with the default ‘Issue’ Location.  You may amend this
by selecting another Location from the drop-down list

Variants: If the Line Item Number has variants (Serial Number, Expiry Date, Batch No, Rev No,
Size, Colour, Grade) then they should be entered into the respective fields.  

Recorded Notes: Extended Notes for your own information can be attached to this Line.   

Buttons

Close: This will close the Sales Order Issues screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Issue record.
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Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Line

Update Sales Order: If you click this button then the quantities entered against each line will be
issued to the Sales Order and - in the case of Items - issued from stock.

15.6.3 Sales Order Properties

This screen allows you to define properties that are specific to a Sales Order.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Sales Orders.

Display fields

The displayed fields are taken from the Sales Order Details.  The selection of which fields to
display here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Sales Order Properties screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Sales Order Properties.

Save: Not applicable to the List panel
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Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Order No: Display only field showing the Sales Order Number selected in the List screen

Description: Display only field showing the description of the Sales Order.

Status: Display only field showing the current status of the Sales Order.

Customer: Display only field showing the Customer held against the Sales Order.

Sales Type: Display only field showing the Sales Type as held against the Sales Order.

Property: From the drop-down list select the Standard Property against which a value specific to
this Sales Order will be made.

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Buttons

Close: This will close the Sales Order Properties screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Sales Order Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Sales Order Property record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Sales Order Property record.

15.6.4 Sales Order Documents

This screen allows you to define documents, etc that are specific to a Sales Order.    

List Tab

Display fields
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Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Sales Order to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Sales Order Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Sales Order Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Sales Order record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name of the document that you are creating in this Document - Sales
Order linkage.  No checks are made on the entry.

Document Type: Prefilled with ‘Sales’

Linked to: From the drop-down list select the Sales Order that uses this document

Print / Email with order: Tick this box if this document is to be printed/emailed with the Order.

Print / Email with quote: Tick this box if this document is to be printed/emailed with the quote.
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Correspondence: Tick this box if this document is to be treated as correspondence in the
Operations Centre.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Sales Order Documents screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Sales Order Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Sales Order Documents record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

15.6.5 Sales Order Images

This screen allows you to define images that are specific to a Sales Order.    

List Tab

Display fields

Image Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Sales Order to which this image relates.

File Name: This is the full path name of the image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
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records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Sales Order image screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Sales Order images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected image from a Sales Order record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Image Name: Enter the name of the document that you are creating in this image - Sales Order
linkage.    No checks are made on the entry.

Image Type: Prefilled with ‘Sales’

Linked to: From the drop-down list select the Sales Order that uses this image

Image Details: locate the full path name of the image.  It should be noted that any file extension
recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Image: This panel displays the selected Image.

Buttons

Close: This will close the Sales Order image screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Sales Order images.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Sales Order image record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 
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15.6.6 Sales Order History Notes

This function allows you to link multiple time-stamped notes to a Sales Order record.    

List Tab

Display fields

The displayed fields are taken from the Sales Order master record.  The selection of which fields
to display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Sales Order History Notes screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Sales Order to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Mobile Employee : Select the Mobile employee name to make this History Note available to that
employee.
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Classification: From the drop-down list select a Classification under which you wish to store this
History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.   Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this Sales Order is displayed in the lower part of the screen. 
Each record will also have the first 3 lines of the notes displayed.   To view the full Notes simply
click on the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Sales Order History Notes screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Sales Order History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Sales Order History Notes record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

15.6.7 Sales Quote Options

Sales Quote Options screen is only visible if the Sales Order Status is ‘Quote’.  It enables you to
define the style to be used when printing the Sales Quotation.  The available options are:

Formal: Standard style quote showing Sales Order Lines
Letter: Letter Style showing descriptive narrative and single Quoted Price
User: Populated with the ‘Formal’ style fields for you to amend as required

Entry and Display fields

Order Number: Display only field showing the Number of the Sales Quote
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Order date: Display only field showing the date on the Quotation Header

Status: Display only field showing the current status of the Quote

Customer: Display only field showing the Customer against who the quote has been raised.

Description: Display only field showing the Description held against the Quote

Quote Style: Prefilled with the default Quote Style as defined in Sales Rules.  You may select
another Sales Quote Style from the drop-down list.  The current options are:

Formal: Standard style quote showing Sales Order Lines
Letter: Letter Style showing descriptive narrative and single Quoted Price
User: Populated with the ‘Formal’ style fields for you to amend as required

Print Quote: You can print the Quotation by clicking on this button.  After printing the print status
will be set to ‘Printed’.  If required you can reset it to ‘Not Printed’ by going into the Quote ‘Main’
screen and resetting the Quote Print Status.

Header Notes: This field is used by the ‘Letter’ style Quote and defines the content that you wish
to appear in the main body of the Quotation.  This area would normally have a detailed description
of the content or activities to be carried out.
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Lines to Print: Two options are available from the drop-down list:
Print Detail Lines: All the Order Lines in the Quotation will be printed
Print Single Line: The text in the next field will be printed

Description: Only used if the previous field is set to ‘Print Single Line’.  The content on this field
will be printed Header and Footer Notes and provides a brief description to the Quoted Price.

Nett Value: Display only field showing the current Nett Value of the Sales Quote.

Footer Notes: This field is used by the ‘Letter’ style Quote and defines the content that will appear
in the Footer area of the Quotation.  This area could (for example) have a summary text to
describe the Quote Expiry Date or Quote Terms, etc.
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Sales Quote Options screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.
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15.6.8 Location Map

This will display a panel in which you can select either Map or Directions

If you select 'Map' Ostendo will use the mapping system identified in System Settings (this is
initially set to use Google Maps) and, using the Sales Order Delivery Address, open up the Google
Map at that address

If you select 'Directions' Ostendo will use the mapping system identified in System Settings and
provide directions to travel from the address set up in System Settings to the Sales Order Delivery
Address

15.7 Sales Deliveries

This screen only applies to Sales Orders whose Order Style is ‘Delivery’.   Sales Orders with Style ‘
Standard’ are assumed to be ‘Counter Sale’ Orders and, as such, no delivery is involved.

Sales Deliveries allow you to make a single or multiple Order delivery to a selected Customer. 
Sales Deliveries include a ‘Picking’ function

The process for delivering an Order is:
· Create a Delivery Reference
· ‘Save’ the Reference Header and go to the ‘Lines’ tab
· Add Lines to the Delivery Reference - separate line to cover each Item
· Go back to the Reference Header and optionally enter size, weight and other shipping

info.
· Post the Reference - Ostendo generates the shipping activities related to each line in the

Delivery Reference

Note: Until a Delivery is ‘Posted’ the Despatch will not be recorded against the Sales Order.

List Tab

Display fields

Order No: Display only field showing the Sales Order Number against which this delivery is being
made.

Delivery No: This is the Delivery Number as generated by Ostendo and provides a unique
reference to the Delivery.

Delivery Date: The date when this Delivery Reference was created.  

Status: The status of this Delivery.  There are four statuses (Planned, In Picking, Shipped, and
Invoiced), which are maintained by the program.

Print Status: The status of the Delivery Document.  There are two statuses (Not Printed, Delivery
Printed), which are maintained by the program. 

PlannedPickMinutes : When the Delivery is created, all item specific planned Times for that
Delivery are accumulated into this field. 

ActualPickMinutes : This field accumulates the elapsed time between the Start Time of the
Datasheet and the last item picked for that delivery. This is automatically re-calculated if there
were multiple Datasheets involved in the picking of the Delivery. This field provides feedback to
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enabling an Ostendo site to determine the average time spent picking deliveries. By analysing this
information a site could determine what the default Duration setting should be within the
Assignment Rules for “Default Sales Duration. This is used when assigning Deliveries for Picking.

Display fields

The displayed fields are taken from the Delivery information entered into the ‘Detail’ tab.   The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Invoiced Status - By default the display will only show Deliveries that have not been
Invoiced.   If you wish to see all deliveries including those that have been Invoiced then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Delivery screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up a panel that will facilitate creation of a new Delivery No.  This Create
Deliveries panel now caters for both Sales Orders and Job Orders. 

Sales Order: Select this if this delivery is for Sales Orders
Job Order: Select this if this delivery is for a single Job Order

This panel has two options; each will require entry of parameter information as follows:
Create Delivery for Single Order: enter the following information

Order Number: Select the Order Number from the drop-down list of Sales Orders
that have ‘Order Type’ of ‘Delivery’ (or Job Orders)
Task Name: If Delivery is for a Job Order, you must select a job task name. (The
Task style must be "Multiple Job Lines can be linked to this Task")
From Required Date: Include sales lines whose required date is after this date.
Select a date from the drop-down calendar.  If nothing is entered then all lines are
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assumed
To Required Date: Include sales lines whose required date is before this date.
Prefilled with system date but you can amend it from the drop-down calendar

Create Deliveries for a range of Orders: enter the following information
From Order Number: Select the ‘From’ Order Number from the drop-down list. 
To Order Number: Select the ‘To’ Order Number from the drop-down list. 
From Required Date: Include lines whose required date is after this date.  Select
a date from the drop-down calendar.  If nothing is entered then all lines are
assumed
To Required Date: Include lines whose required date is before this date.  Prefilled
with system date but you can amend it from the drop-down calendar
Customer: From the drop-down list select a Customer against which this Delivery
is being made.

Button - Create: Upon clicking the ‘Create’ Button the program will generate a ‘Delivery
Number’ for each included Sales Order 

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Delivery with status ‘Planned’.  In this instance
it enables you to delete the selected Delivery Reference.

Related: This will bring up a list of functions that are related to Sales Deliveries.  You may open
and maintain information in those screens whilst still remaining in the Delivery screen.

Reports: This will bring up a list of Reports that are related to Sales Deliveries.  You can
immediately run the report whilst still remaining in the Delivery screen.

Detail Tab

This tab enables you to maintain Delivery information held against a system-generated Delivery
Number.  

Entry and Display fields

Delivery No:  This is a unique number automatically allocated by the program.  It cannot be
amended.  Delivery Number sequence can be set up in File>System Configuration>System
Settings

Required Date: Display only field showing the Required Date held against the Sales Order from
which this delivery is being made

Delivery Date: Prefilled with the above Required Date.  You can amend this from the  drop-down
calendar to define the actual Delivery Date

Status: This is the status of the Delivery and is maintained by the program.  The displayed variants
are:

Planned - The Delivery Batch has been created and is awaiting Picking/Shipping
In-Picking - The Delivery Batch is now in Picking
Shipped - The Delivery Batch has been shipped and awaiting Invoicing
Invoiced - The Delivery Batch has been Invoiced.

Order No: Display only field showing the Sales order Number covered by this Delivery Number.
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Invoice No: If the Delivery Status is ‘Delivered’ then this field will display the generated Invoice
Number.

Tracking Code: From the drop-down list select the Tracking Code.  Tracking Codes are user
maintained (Sales>Settings>Sales Tracking) and enable you to track your Deliveries and filter
views or reports by this Code.

Planned (Calc) Weight: Program calculated weight from the unit weight held against each Item *
line quantity.  Note: The Unit of Weight is defined in File>System Configuration>System Settings

Planned (Calc) Volume: Program calculated volume from the unit volume held against each Item
* line quantity.  Note: The Unit of Volume is defined in File>System Configuration>System
Settings

Picked Weight: Display only field showing the Weight (based on the Planned Weight) of Lines that
have been picked against this Delivery

Picked Volume: Display only field showing the Volume (based on the Planned Volume) of Lines
that have been picked against this Delivery

Actual Weight: Enter the Actual weight of this shipment

Actual Volume: Enter the Actual volume of this shipment

Number of Shipping Pieces: Prefilled with the number of lines in the Shipment.

Customer: Display only field showing the Customer to whom this delivery is being made.

Additional Delivery Address Details: Click on this button to view and maintain the delivery
address.  This is prefilled with the Delivery Address held against the Sales Order but can be
amended by clicking the drop-down button against the first field.  You can amend any of the
following information.

· Address: Three lines covering the delivery address.  
· City: The Town or City where this Delivery Address is located.
· State: The State where this Delivery Address is located.
· Code: The Postcode or ZIP Code where this Delivery Address is located.
· Country: The Country where this Delivery Address is located.
· Contact: To change the Contact select from the drop-down list
· Phone: The Telephone Number of the Contact
· Fax: The Facsimile Number of the Contact

Freight Information:
Shipping Method: This is prefilled with the Shipping Method held against the Customer related to
this delivery.  If you wish to amend it then select another Shipping Method from the drop-down list. 
Shipping Methods are maintained via Sales>Settings>Customer Shipping Methods

Shipping Reference: Enter the Reference Identifier of the shipment.

Charge Freight: If you are going to charge the freight to the Customer then ‘check’ this checkbox.
This charge will then appear on the Sales Invoice

Freight Amount: Enter the freight charge that this delivery has incurred.  This is prefilled with the
default amount held against the Shipping Method but can be amended here.

Freight is Taxed: If the Freight is to be Taxed then this should be ‘checked’.  This is prefilled with
the setting held against this Shipping Method but can be amended here.
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Tax Code: Prefilled with the default Tax Code.  You can amend this by selecting a Tax Code from
the drop-down list

Service Zone: This will be the Service Zone of the Customer. 

Dropped Off : Tick this box if the order is to be dropped-off.

Urgent Order : tick this box if this is an urgent order. When and urgent Order is sent to Freeway, it
will be displayed at the top of the list for the Start Day it is assigned to. It will also be marked with a
Red indicator.

Amount Includes Tax: If the Freight Amount includes Tax then this should be ‘checked’.  This is
prefilled with the setting held against this Shipping Method but can be amended here.

Update Delivery Status: This can alternate between ‘Shipped’ and ‘In-Picking’.  The status of ‘
Shipped’ means that this delivery is available to be invoiced via the Invoice Batch routine.  Up to
that you can revert the status back to ‘In-Picking’.  This status hides it from the Invoice Batch
routine.

When the Delivery Status is changed to ‘Shipped’ Ostendo will check the Sales Rule ‘Delivery
Shipping Action’ which, if set to ‘Create Next Delivery’ will bring up a panel for entry of an ‘Up To
Required Date’.   If there are any Sales Order Lines prior to, or equal, that date with outstanding
deliveries then Ostendo will create a new Delivery when the ‘OK’ button is selected

Sales Invoice: If you click on this button then the Batch Invoicing screen will be presented in which
the ‘From Delivery No’ and ‘To Delivery No’ fields will be prefilled with this Delivery No.

Change to Closed: If the delivery is for a Job Order, this button is displayed. Click this button if
you wish to close this Job Delivery after delivery status is updated to "Shipped".

Delivery Activity Tracking Panel.  

This panel provides a semi-automatic view of the progress of a Delivery through the Despatch
process.  Some filed are automatically updated as described.  However all fields can be manually
adjusted as required.

PickList Document:  Shows the status of the Pick List that covers this Delivery.  The fields are:
Status:  If the ‘Picklist’ button is selected and the Picklist printed then this will change to
status ‘Printed’.  You can amend this as required
Employee:  If you wish to record who printed the Picklist then select the Employee from
the drop-down list
Date:  If the ‘Picklist’ button is selected and the Picklist printed then this will be filled with
the system date.  You can amend this as required
Time:  If the ‘Picklist’ button is selected and the Picklist printed then this will be filled with
the system time.  You can amend this as required

Picking Process:  Shows the status of the Picking process for this Delivery.  The fields are:
Status:  From the drop-down list select the current status of the Picking Process.  The
options are ‘Planned’, ‘InProgress’, or ‘Complete’
Employee:  If you wish to record who is carrying out this step then select the Employee
from the drop-down list
Date:  If you wish to record the Date of the current status then select the date from the
drop-down calendar
Time:  If you wish to record the Time of the current status then enter the time as required.

Packing Process:  Shows the status of the Packing process for this Delivery.  The fields are:
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Status:  From the drop-down list select the current status of the Packing Process.  The
options are ‘Planned’, ‘InProgress’, or ‘Complete’
Employee:  If you wish to record who is carrying out this step then select the Employee
from the drop-down list
Date:  If you wish to record the Date of the current status then select the date from the
drop-down calendar
Time:  If you wish to record the Time of the current status then enter the time as required.

Shipping Labels:  Shows the status of the Labels Print for this Delivery.  The fields are:
Status:  If the ‘Labels’ button is selected and the Labels printed then this will change to
status ‘Printed’.  You can amend this as required
Employee:  If you wish to record who printed the Labels then select the Employee from
the drop-down list
Date:  If the ‘Labels’ button is selected and the Labels printed then this will be filled with
the system date.  You can amend this as required
Time:  If the ‘Labels’ button is selected and the Labels printed then this will be filled with
the system time.  You can amend this as required

Delivery Document:  Shows the status of the Delivery Document covering this Delivery.  The
fields are:

Status:  If the ‘Delivery’ button is selected and the Document printed then this will change
to status ‘Printed’.  You can amend this as required
Employee:  If you wish to record who printed the Document then select the Employee
from the drop-down list
Date:  If the ‘Delivery’ button is selected and the Document printed then this will be filled
with the system date.  You can amend this as required
Time:  If the ‘Delivery’ button is selected and the Document printed then this will be filled
with the system time.  You can amend this as required

Shipping: Shows the Shipping status that covers this Delivery.  The fields are:
Status:  If the ‘Update Delivery Status to Shipped’ in the upper part of this screen is
selected then this status will change to the default status defined in Sales Rules.  You can
amend this by clicking on the drop-down list and selecting from ‘Planned’, ‘Ready to
Invoice’, or ‘delivered’
Employee:  If you wish to record who amended the status then select the Employee from
the drop-down list
Date:  If the ‘Update Delivery Status to Shipped’ in the upper part of this screen is selected
then this will be filled with the system date.  You can amend this as required
Time:  If the ‘Update Delivery Status to Shipped’ in the upper part of this screen is
selected then this will be filled with the system time.  You can amend this as required

Notes: 
Delivery Notes : Extended Notes for your own information can be attached to this

Shipment.   Whenever you click on this field an icon will appear in the top-right.   By clicking 
on this Icon you can bring up the Frequently Used Text table.   Select the text to be copied and
either press the OK Button in that screen or double-click the selected record.

Drop Off Notes : These will be updated by the Freeway Mobility app where the template
uses the type"DELIVERYDROPOFF" which allows the delivery person to enter notes 
relating to a delivery.

Buttons

Close: This will close the Issue screen.  If you have any unsaved data then you will be asked if you
wish to save it before the screen is closed.
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Add: This will bring up a blank ‘Detail’ screen for entry of a new Delivery Reference.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Issue Delivery Reference Header record or the last time
the ‘Save’ Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Delivery.  You may open and
maintain information in those screens whilst still remaining in the Delivery screen.

Reports: This will bring up a list of Reports that are related to the Delivery.  You can immediately
run the report whilst still remaining in the Delivery screen.

Picklist: This will allow you to print the Pick List for the current Delivery

Labels: This will allow you to print the number of shipping labels defined above

Delivery: This will allow you to print the Delivery Note for the current Delivery

Lines Tab

This tab enables you to add and maintain Picking against the Delivery lines.  The Delivery
Reference Number and status will be displayed at the top of the panel.  If you select a line in this
upper panel then you can carry out stock movements related to that line in the lower panel

Auto Pick: If you click on this button then the ‘Picked Quantity’ against all Lines will be filled with
the ‘Req Qty’ and those quantities will immediately be picked.  If the Line Type is an Item Code and
the Item has sub-level variations (Batch, Serial No, Colour, etc) then the ‘Picked Quantity’ will not
be prefilled and you are required to action these lines manually.

Override default Warehouse/Location: If this is ‘checked’ then the default Warehouse and
Location held against each Item contained in this Delivery will be ignored and the
Warehouse/Location entered into the next two fields used

Default Warehouse: If the ‘Override default Warehouse/Location’ field is ‘checked’ then select the
Warehouse from the drop-down list that will be used for this Delivery

Default Location: If the ‘Override default Warehouse/Location’ field is ‘checked’ then select the
Location from the drop-down list that will be used for this Delivery

Pick Date: Prefilled with the system date to denote the date when the Delivery Lines are picked.
This can be amended using the drop-down calendar.

Upper panel

This is display only and shows all the lines that have been included in this Delivery Reference and
shows, for each line:

Line Number: Line number on the Delivery Reference document
Required Date: Required Date taken from the Order Line
Line Type: Line Type (Item, Descriptor, Kitset, or Catalogue)
Line Code: Identity of the Line Type
Unit: Unit of Measure for the Line
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Required Qty: Sales Order Quantity required
Total Picked Qty: Total quantity picked to date
Description: Description of the Item, Descriptor, Kitset, or Catalogue
Status: Display-only field showing the status of the delivery line.

If the Sales Rule “Delivery Quantity Based On” is set to ‘Free Stock’ then an additional field will be
displayed showing the current Free Stock.  When using Auto Pick this is the quantity that will be
picked.

(Button) Import Serial Numbers:  If the current selected Item (above) is Serial Number
Controlled then this button will appear.  You can click on this and point to a txt file of the Serial
Numbers being issued.  Note: The quantity of Serial Numbers in the Text file must equal the Line
Quantity.

Lower panel

For the Line selected in the Upper Panel this area enables you to ‘Issue’ the individual Lines.  For
Items a Warehouse and Location is required along with any variations (if the Item has Variants). 
For Descriptors, Kitsets, and Catalogue Items only a quantity is required

Entry and Display fields

Picked Date: In the first instance this is prefilled with the system Date.  You can change this date
by entering the date or clicking on the drop-down menu and selecting the date.

Picked Qty: Enter the quantity of this line that has been picked or issued to this Delivery  

Unit: Prefilled with the base Unit for the Item, Descriptor, Kitset, or Catalogue.  If the Item has
more than a single Unit of Measure then an alternate Unit can be selected from the drop-down list.

Warehouse: For an Item Code this is prefilled with the default ‘Issue’ Warehouse.  You may
amend this by selecting another Warehouse from the drop-down list

Location: For an Item Code this is prefilled with the default ‘Issue’ Location.  You may amend this
by selecting another Location from the drop-down list

Variants: If the Line Item Number has variants (Serial Number, Expiry Date, Batch No, Rev No,
Size, Colour, Grade) then they should be entered into the respective fields.  

Pick Notes: Display-only field showing notes entered during picking.

To Container ID: If picking to a container (e.g. pallet), then enter the Container ID here.

Buttons

Close: This will close the Sales Delivery screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Issue record.

Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.
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Delete: This will delete the selected Issue Line

Related: This will bring up a list of functions that are related to Sales Deliveries.  You may open
and maintain information in those screens whilst still remaining in the Sales Delivery screen.

Reports: This will bring up a list of Reports that are related to Sales Deliveries.  You can
immediately run the report whilst still remaining in the Sales Delivery screen.

15.8 Recurring Invoices

This screen allows you to create and maintain a schedule of planned Invoices against a Customer.
This feature facilitates the generation of Invoices to cover a regular Service (such as routine
Maintenance) rather than delivery of goods.

List Tab

Display fields

The displayed fields are taken from Recurring Invoice information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Recurring
Invoice schedules whose status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Recurring Invoice screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for entry of the following information that is required when creating
a new Recurring Invoice Schedule

Customer: From the drop-down list select the Customer against who this Recurring
Invoice is being created
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Billing Customer: This is prefilled with the Billing Customer held against the above
Customer record but may be amended here and made specific to this Recurring Invoice. 
To amend the Billing Customer click on the icon within this field and select the Customer
from the displayed list.
Description: Enter a brief description of the Invoicing Schedule.
Creation Date: The Date that the Invoicing Schedule was raised.  This is prefilled with
system date but can be amended by selecting the date from the drop-down calendar
Contract Type: From the drop-down List select the Type of Recurring Invoices that will be
generated.  The options are:

Fixed Term: The schedule is effective for a predefined period
Continuous: The schedule will repeat until manually stopped

Contract Category: From the drop-down List select the Contract Category to which this
Invoicing Schedule will be linked.  Contract Categories are user-defined via
Sales>Settings>Contract Categories and enable you to segregate Recurring Invoice for
Reporting and Analysis purposes.
Contract Start Date: The Date when the first Invoicing Schedule Line will be created.
This is prefilled with system date but can be amended by selecting the date from the
drop-down calendar.
Per Invoice Value: Enter the value (nett of Tax) that will be used against each Invoice.
Note: You have the option to amend this value against each line in the generated
schedule.
Planned Invoice Frequency: This has three fields

Every: The number of Days or Months that an Invoice will be generated
(Period): Select the period (Days or Months) from the drop-down list
No of Times: Only visible for ‘Fixed Term’ Contract Type.  Enter the number of
periods that is to be included in this Fixed Term. 

These fields are NOT applicable where the Contract Style (see below) is Customer Usage
Billing in which instance they are not displayed
Contract Style: From the drop-down List select the Style of Contract covering this Invoice
Schedule.  The options are:

Financial: For charges only (Example: Consultancy or Financial Services)
Customer Asset Service: Routine Servicing (Example: Aircon, Cleaning)
Company Asset Rental: Rentals (Example: Equipment Rental, etc)
Customer Usage Billing: Where the usage comes from Readings held against

this Asset
Currency Code: From the drop-down List select the Currency Code covering this Invoice
Schedule. 
Invoice Line Details: Covers the generated Invoice Line Information

Line Type: The Line Type is pre-defined as ‘Descriptor Code’
Code: Select the Descriptor from the drop-down list.  Descriptors are maintained
under Inventory>Descriptors
Line Description: Prefilled with the description of the Descriptor Code.  It can be
amended here and made specific to this Invoicing Schedule.

If the Contract Style is NOT Customer Usage Billing then the following fields will
be displayed:

Unit: Display only field showing the Unit as held against the Descriptor Code.
Invoice Quantity: Enter the quantity of this Descriptor that is used in the
Invoice.  This quantity will appear on the Invoice and is for information
purposes only.  I.e. It takes no part in calculating the invoice value.

If the Contract Style is Customer Usage Billing then the following fields will be
displayed:

Unit: Display only field showing the Unit as held against the Descriptor Code.
Unit Price: Enter the Unit Price per Billing Unit that is used in the Invoice.
Reading Name: From the drop-down list select the Reading Name from
which the billing Usage will be derived.  The derived Usage is multiplied by the
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Unit Price to arrive at an Invoicing amount.

Tax Code: Prefilled with the Tax Code from the Descriptor.  It can be amended
here and made specific to this Schedule by selecting another Tax Code from the
drop-down list.
Analysis Group: Prefilled with the Analysis Group from the Descriptor.  It can be
amended here and made specific to this Schedule by selecting another Analysis
Group from the drop-down list.

Buttons
Create: Click the ‘create’ button to create the Invoicing Schedule and take you to
the ‘Details’ tab for entering further information.
Cancel: Click the ‘cancel’ button to exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Recurring Invoice Schedule from this table

Related: This will bring up a list of functions that are related to the Recurring Invoice Schedule.
You may open and maintain information in those screens whilst still remaining in the Recurring
Invoice Schedule screen.

Reports: This will bring up a list of Reports that are related to the Recurring Invoice Schedule.
You can immediately run the report whilst still remaining in the Recurring Invoice Schedule screen.

Detail Tab

This tab allows you to maintain the Invoicing Schedule

Entry and Display fields

Contract Number: Display only field showing the Invoicing Schedule number.  Sales Contract
Numbers are maintained via File>System Configuration>System Settings

Creation Date: This is date when the Contract was created and is for information only.  You can
amend the date by either overtyping the date or selecting the date from the drop-down calendar.

Status: During Contract Invoicing Schedule creation this is prefilled with ‘Open’.  You can amend
this status by selecting the required status from the drop-down list.  The options are:

· Open
· On-Hold
· Closed

Description: Description of this Contract.  This may be amended at any time.  No checks are
made on the entry

Contract Type: Display only field showing the Contract Type selected during the Contract Invoice
Schedule creation routine.

Contract Style: Display only field showing the Contract Style selected during the Contract Invoice
Schedule creation routine.

Category: This Contract Category is initially populated with the Category selected during Contract
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Invoice Schedule creation.  You can amend this at any time by selecting another Contract from the
drop-down List.

Tax Code: This Tax Code is initially populated with the Tax Code selected during Contract Invoice
Schedule creation.  You can amend this at any time by selecting another Tax Code from the
drop-down List.

Currency Code: Display only field showing the Currency Code covered by this Contract

Site Name: This is prefilled with the Site Name related to the User's Signon record.  If this User is
flagged as being allowed to change sites then this field is activated.  The Site can then be
amended from the drop-down list if required

Scheduled Invoice Settings

Planned Invoice Frequency: Display only fields showing 
Every: The number of Days or Months that an Invoice will be generated
(Period): Select the period (Days or Months) from the drop-down list

Per Invoice Value: Not visible if Contract Style is 'Customer Usage Billing'.  This value will be
used when an Invoice is generated automatically from ‘Continuous’ Contract Type or manually
entered in the Scheduled Invoices tab.  It can be amended at any time.   

Contract Start Date: Display only field showing when the Contract commenced

Contract Finish Date: Only visible if the Contract Type is ‘Fixed Term.  This is a display only field
showing when the Contract will finish.  I.e. The date of the last planned Invoice in the ‘Scheduled
Invoices’ tab

Customer: Display only field showing the Customer to which this Contract relates.

Billing Customer: Display only field showing the Billing Customer to which this Contract relates.

Contract Information: You can enter unlimited amount of Information that is related to this
Contract.  Whenever you click on this field an icon will appear in the top-right.  By clicking on this
Icon you can bring up the Frequently Used Text table.  Select the text to be copied and either
press the OK Button in that screen or double-click the selected record.

Contract Style specific fields

For Contract Style 'Customer Asset Service' the following will be displayed
Customer Asset Name: The Customer Asset Name selected when creating  this record.
You can amend this if required from the drop-down list
Asset currently at: Display only field that shows where this Asset is located. 
(Button) Asset Tracking: This brings up a separate screen for maintenance of the Asset’
s Location.

For Contract Style 'Customer Usage Billing' and 'Company Asset Rental' the following will
be displayed

Company Asset Name: The Customer Asset Name selected when creating  this record.
You can amend this if required from the drop-down list

Contract Values: The following fields are maintained by the program and provides Invoice
summary information as follows:

Nett Contract: The sum of all the Scheduled Invoices excluding Tax
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Tax Amount: The sum of Tax due in all the Scheduled Invoices
Total Amount: Nett Amount + Tax Amount
Invoiced Amount: Value of Scheduled Invoices converted into physical Invoices
Remaining Amount: Value of Scheduled Invoices yet to be converted.  This is NOT
displayed if the Contract Style is 'Customer Usage Billing' 

Invoice Header Information: You can enter unlimited amount of information that is related to this
Contract.  This information will be copied to each generated Invoice.  Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that screen or
double-click the selected record.

Invoice Line Information: You may have multiple lines that will appear on the Invoice.  Each line
will comprise the following:

Line Number: This is automatically incremented by 10 each time a new line is added.
You can amend this this as required.

Descriptor Code: From the drop-down list select the Descriptor that will appear on the
generated Invoice

Description: prefilled with the description of the Descriptor selected in the previous field.
This can amended against this Invoice Line if required.

Unit: prefilled with the Unit of Measure of the selected Descriptor.  This can amended
against this Invoice Line if required.

Unit Price: prefilled with the Unit Price of the selected Descriptor.  This can amended
against this Invoice Line if required.

Analysis Group: prefilled with the Analysis Group held against the selected Descriptor.
This can amended against this Invoice Line if required by selecting the Analysis Group from the
drop-down list.

Line Instructions: This is populated with the ‘Notes’ information held against the Line’s
Descriptor. You can amend it at any time. This information will be copied to the generated Invoice
Line. Whenever you click on this field an icon will appear in the top-right. By clicking on this
Icon you can bring up the Frequently Used Text table. Select the text to be copied and either press
the OK Button in that screen or double-click the selected record

Reading Name: If this line is associated with Usage Billing then select the Reading Name
from the drop-down list.

Financial
Financial Category: Select the category from the drop-down list if applicable. (Used in linked
external General Ledger system).

Buttons

Close: This will close the Recurring Invoices screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Invoice Line Descriptor.

Save: This will save the current data without exiting the screen
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Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current Invoice Descriptor Line.

Buttons

Close: This will close the Recurring Invoices screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the same panel as described above for creating a new Recurring Invoice
Schedule

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Recurring Invoice Schedule.
You may open and maintain information in those screens whilst still remaining in the Recurring
Invoice Schedule screen.

Reports: This will bring up a list of Reports that are related to the Recurring Invoice Schedule.
You can immediately run the report whilst still remaining in the Recurring Invoice Schedule screen.

Scheduled Invoices Tab

This screen shows the Invoice Schedule.  Scheduled Lines are created in one of three ways:
Fixed Term Contract - Auto-generated during Recurring Invoice Contract Creation
Continuous Contract - Auto-generated when current Scheduled Invoice is converted to
physical Invoice.
Manually - Added directly into this screen
Usage Billing - If the Recurring Invoice Lines are related to a Reading Name that is
flagged as 'Usage Billing' then Scheduled Invoices are automatically created via the 'Batch
Invoice' screen and cannot be maintained here.

Entry and Display fields

Planned Date: The Planned Date for this line.  You can amend the date by either overtyping the
date or selecting the date from the drop-down calendar.  However, if this line has already been
converted into a physical Invoice then this is the actual Invoice Date and cannot be amended.

Invoice Value: The Invoice value of this Line.  Note:
· When creating a new line the ‘Per Invoice Value’ defined in the ‘Detail’ tab is used.
· You can amend this value if the Line has not been converted into an Invoice
· If this line has already been converted into an Invoice then this is the actual Invoice Value

and cannot be amended.

Actual Date: The date of the actual Invoice generated from this planned Invoice

Invoice No: The Invoice Number that was generated from this planned Invoice
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Reading Name: The Reading Name used for this Asset.

Reading Value: The Reading Value used for this invoice.

Readings (Lower Panel) - This is a record of all the readings done for this asset.

Date: Date of the reading.

Reading Value: The reading value recorded.

Buttons

Close: This will close the Recurring Invoices screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Creates a line (with default Date and Amount) for entry of a new scheduled Invoice. 

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Deletes a Scheduled Invoice line.  This only applies to lines that have not been converted
into a physical Invoice.

Related: This will bring up a list of functions that are related to the Recurring Invoice Schedule.
You may open and maintain information in those screens whilst still remaining in the Recurring
Invoice Schedule screen.

Reports: This will bring up a list of Reports that are related to the Recurring Invoice Schedule.
You can immediately run the report whilst still remaining in the Recurring Invoice Schedule screen.

15.9 Direct Invoicing

This function allows you to enter Customer Invoices that do not originate from a Sales Order

List Tab

Display fields

The displayed fields are taken from the Invoicing information entered into the ‘Detail’ tab.  

The selection of which fields to display is at the user’s discretion.  To select the fields to display
simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel
you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
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heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Fully Paid Status - If this is checked then the displayed list will include those Invoice
Batches whose status is ‘Fully Paid’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Direct Invoicing screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for selection of the Invoices to be included in this Batch

Specific Site: Ostendo will automatically add the Site held against the User Signon record to the
Invoice  when it is generated.  You may allocate this Invoice to another site if:-

· You select the site from the drop-down list in the next field, and
· Your User Signon record is flagged to allow you to make the change

Site Name:  Select the Specific Site from the drop-down list

Invoice Date: The Date of this Direct Invoicing Batch.  This is prefilled with system date but can be
amended by selecting the date from the drop-down calendar.  This date must be later than the
Cut-Off date defined in File>Financial Configuration>Cut-Off Dates.

Radio Buttons
Create an Invoice or Credit without an Order: Select this ‘Radio Button’ if you are
creating a single Invoice or Credit, then select a Billing Customer in the next field.  
Upon selection of the Billing Customer click on the ‘’Create’ Button to generate the Invoice
or Credit

Create Credit by Reversing an Existing Invoice: Select this ‘Radio Button’ if you are
crediting and existing Invoice.  Select the Originating Invoice from the drop-down list.  If
you want Ostendo to apply the Credit as a payment against the Invoice then ‘check’ the ‘
Apply credit as payment’ checkbox.
Upon selection of the existing Invoice click on the ‘’Create’ Button to generate the Credit

Buttons

· Create: Click the ‘create’ button to create the Invoice/Credit as defined above.  
· Cancel: Click the ‘cancel’ button to exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Invoice from this table
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Related: This will bring up a list of functions that are related to Direct Invoicing.  You may open
and maintain information in those screens whilst still remaining in the Direct Invoicing screen.

Reports: This will bring up a list of Reports that are related to Direct Invoicing.  You can
immediately run the report whilst still remaining in the Direct Invoicing screen.

Detail Tab

This tab allows you to maintain the individual Invoices or Credits

Entry and Display fields

Invoice Number: Display only field showing the system generated Invoice number.  Start and
current Invoice Numbers are maintained via File>System Configuration>System Settings

Invoice Date: This is date when the Invoice was created and is validated against the Financial
Cut-off date when posting.  You can amend the date by either overtyping the date or selecting the
date from the drop-down calendar.

Status: This status is updated by the program and records the progress of the Invoice.  The
display options are:

· Planned
· Printed
· Partially Paid
· Fully Paid

Invoice Type: A program maintained field that shows from where the Invoice was generated.  As
this is Direct Invoicing it is prefilled with ‘Direct Invoice’

Invoice Style: A program maintained field that shows whether it is an Invoice or Credit.

Invoice Print Status: Display only field showing the current status of the Invoice Print.  The
options are

· Printed
· Not Printed

Don’t Print on Statement: If this is ‘checked’ then this Invoice or Credit will not appear on the
Customer Statement.

Site Name: If the Invoice has not been printed then you may allocate this Invoice to another site
from the drop-down list but only if your User Signon record is flagged to allow you to make the
change

Invoice Settings

Credit Terms: This is prefilled with the credit terms taken from the Customer master record.  It
can be amended by selecting revised Terms from the drop-down list.  Credit Terms are maintained
via File>Financial Configuration>Credit Terms.

Due Date: Tin the first instance this is evaluated from the Invoice Date and takes into account the
Credit Terms.  This can be amended by over-typing or selecting a new date from the drop-down
calendar.



873Sales

Shipping Method: This is prefilled with the Shipping Method currently held against the Billing
Customer.  You can amend this by selecting another method from the drop-down list.  You may
maintain Shipping Methods by either clicking on the icon to the right of this field or click on the ‘
Related’ button and select ‘Customer Shipping Methods’.

Sales Person: This is prefilled with the Salesperson currently held against the Billing Customer.
You can amend this by selecting another Salesperson from the drop-down list.  You may maintain
Salespeople by selecting General>Employees and identifying the Employee as a ‘Salesperson’

Charge Freight: ‘Check’ this checkbox if freight is to be charged.  The next field will become
active for entry of freight details.

Freight Details: Click on this button to enter the following details:
Freight is Taxed: ‘Check’ this if the Freight is Taxable. The next field will be activated
Tax Code: From the drop-down list select the Tax Code that applies to this Freight 
Freight Amount: Enter the Freight Amount (not including Tax)

Purchase Reference: Optional entry field for you to record the Purchase reference.  No checks
are made against this entry

Project:: Optional entry field for you to link this Direct Invoice to a Project.  Select the Project from
the drop-down list.  Projects are maintained via Jobs>Projects

Billing Customer: This is prefilled with the Billing Customer as held against the Customer master
record.  It may be amended by selecting a new Billing Customer from the drop-down list

Billing Details: A drop-down panel shows the current address details of the Billing Customer. 
They can be amended at any time by keying directly into the following fields.

Address: Three lines are available for entry of the Billing Address of the Customer.  
City: Enter the Town or City of this Billing Address.
State: Enter the State of this Billing Address.
Code: Enter the Postcode or ZIP Code of this Billing Address.
Country: Enter the Country of this Billing Address.

Delivery Details: A drop-down panel allows you to enter Delivery Details relating to this Direct
Invoice

Customer: This is an optional entry field.  If a Customer is selected then it can be selected
from the drop-down list.
Address: Three lines are available for entry of the Billing Address of the Customer.  These
are optional entry fields and can be keyed in.  You may also click on the spyglass against
the first Address Line and select any alternate address that applies to the above
Customer.
City: Enter the Town or City of this Delivery Address.
State: Enter the State of this Delivery Address.
Code: Enter the Postcode or ZIP Code of this Delivery Address.

Currency Code: Prefilled with the currency code for this Customer but can be amended by
selecting another currency from the drop-down list

Exchange Rate: Prefilled with the exchange rate taken from the Exchange Rate table for the
currency.  This rate can be over-ridden if required

(Button) Pay Now:  If this button is pressed then a separate panel will appear for you to enter a
payment against this Invoice.  This screen contains the following fields;

Invoice Number: Display only field referring to this Invoice Number
Billing Customer: Display only field showing the Billing Customer for this Invoice
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Payment Date: This is prefilled with the system date.  You may amend this by over-typing
the date or selecting a date from the drop-down calendar.   Upon posting this Payment a
check will be made to ensure that this date is after the ‘Cut-Off’ date as set up in
File>Financial Configuration>Cut-off dates.
Payment Method: From the drop-down list select the method by which the Payment was
made.  Payment Methods are user-defined under File>Financial Configuration>Payment
Methods.
Payment Reference: Open-format field for you to enter any identifying reference to the
Payment.  No checks are made on this entry.
Banking Method: From the drop-down list select the method by which the Payment will
be banked.  The options are:

Directly to Account: Posting will occur upon update in this screen
Using Bank Deposit: Posting will occur when banked through the Bank Deposit
routine

Account for Payment: From the drop-down list select the Account to which the Deposit
will be made.  Payment Accounts are user-defined under File>Financial
Configuration>Payment Accounts.
Payment Reference: Enter details of the Payment (Example: Cheque Number)
Balance Due: Display only field showing the outstanding balance against this  Invoice.
Payment Amount: Enter the amount received against this Payment
Discount Given: Enter any discount that is given against this Invoice payment
Payment Rounding: Enter an amount around which the Payment will be rounded.  If
nothing is entered then 0.01 is assumed
Remaining Balance: Display only field showing the outstanding Invoice value
Change Due: Display only field showing the calculated change due as a result of the
entered Payment Amount taking into account and Discount and Rounding.

Buttons
Accept: This will create a Payment record linked to the Invoice
Cancel: Cancel and ignore the entry and return to the Direct Invoice screen

Invoice Values: Display only fields showing the current financial status of the Invoice.  The
displayed fields are:

Nett Amount: Amount not including Tax
Freight Amount: Freight Amount not including Tax
Tax Amount: Tax charged on Invoice Lines and Freight
Total Amount: Sum of the above
Amount Paid: Amount paid to date
Balance Due: Outstanding balance

Linked Projects: This panel is only visible if the Invoice is generated as a 'Direct' Invoice.and
shows details of the Project selected above
The displayed fields against each order are:

Project: The Project that this Direct Invoice is linked to
Description: Description of the linked Project
Customer: The Customer held against the Project
Planned Income: The Planned Income as entered against the Project record

Financial: If required, select the Financial Category applicable. If left blank, it will use the Financial
Category (if any) linked to the associated Cost Centre.

Instructions: Information entered here will be printed on the Invoice.  Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that screen or
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double-click the selected record.

Buttons

Close: This will close the Direct Invoicing screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the same panel as described above for creating a new Direct Invoice.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to Direct Invoicing.  You may open
and maintain information in those screens whilst still remaining in the Direct Invoicing screen.

Reports: This will bring up a list of Reports that are related to Direct Invoicing.  You can
immediately run the report whilst still remaining in the Direct Invoicing screen.

Lines Tab

‘Direct Invoice’ line details are maintained here.

Upper Panel

This panel shows a summary of the lines that make up the Invoice and is taken from the
information maintained in the lower panel.

The fields shown on the Upper Panel are:
Line No: Line No as created in the lower panel.
Code: The unique identity of the line code
Unit: The unit of measure of the code
Invoice Qty: Quantity of the Unit being Invoiced.
Unit Price: Unit Price of the Code being Invoiced.
Description: Description of the Code
Tax Code: Tax Code that applies to this line
Tax Amount: Tax amount that applies to this line
Total Amount: Total amount including tax for this line
Analysis Group: Analysis Group linked to this line
Special Instructions: 
Notes: Extended Notes applicable to the line

            Base Unit Price: 

Lower Panel

This is the main entry and maintenance area for Direct Invoices.   

Entry and Display fields

Invoice Line Tab

Line No: Enter a Line Number.  This number is used as a sort sequence for printing the lines on a
Invoice.  No checks are made on the entry
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Line Type: From the drop-down list select the Line Type.  The options are:
Item Code
Descriptor Code
Catalogue Code

Code: From the drop-down list select the Code.  The drop-down list will vary dependent upon the
Line Type selection.  

Unit: This is prefilled with the Unit for the Code.  If this is an Inventoried Item with multiple Units
then you can amend the Unit of Measure by clicking on the drop-down icon and selecting the Unit.

Invoice Qty: This is prefilled with the quantity entered into the preliminary selection panels defined
above or 1 if manually entering the line.  This can be amended here if required.  If the line is for an
Item Code that has Variants (Serial Number, Batch No, etc) then quantities must be entered by
clicking on the ‘Enter Qtys’ button described below.

Std Price: This is prefilled with the program calculated Unit Price of the Code taking into account
any quantity Discounts, etc.  If the User’s has been given the rights (via File>System
Configuration>User Security and Options) then this can be amended here.  

Order Price: This is prefilled with the program calculated Unit Price of the Code taking into
account any quantity Discounts, etc.  This can be amended here if required.  

(Button) Enter Qtys: This will send you to the ‘Line Variants’ tab (see below) for you to enter the
quantity that you are allocating to this Invoice Line.  For Inventoried Items you also need to
nominate a Stock Location and identify any specific variants (Batch, Expiry Date, Serial
Number….Etc)

Description: This is prefilled with the description as held against the Item, Descriptor, Kitset, or
Catalogue Item.  It can be amended here if required.

Discount %: The Discount Percentage currently held against the Customer Record.  You may
amend this here if required

Nett Amount: The system-calculated nett amount for the Line based on the Order Quantity, and
Unit Price and taking into account the Sell Price matrix.

Tax Amount: The system-calculated tax amount based on the Order Quantity, Unit Price and Tax
Code.

Total Amount: The system-calculated total amount for the Line based on the Order Quantity, Unit
Price and Tax Code.

Price Override: Checkbox showing if the price has been manually overridden.  If this is ‘
unchecked’ then the Unit Price field will revert to the pre-amended price.

Tax Code: The Tax Code as evaluated from the relationship between the Customer Tax Group
and the line’s Tax Group (See File>Financial Configurations>Tax Matrix).  The Tax Code can be
amended from the drop-down list if required

Special Instructions: Enter any special instructions for this item here. 

Analysis Group: This is prefilled with the Analysis Group held against the Code.  This can be
amended by selecting another Analysis Group from the drop-down list. 
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Line Notes: This is prefilled with any ‘Notes’ that are held against the Code that are flagged as
being copied to the Sales Order Line.   It may be amended here and made specific to this Line. 
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Line Properties Tab

Any specific property values for the Item, Descriptor, Kitset, or Catalogue Item can be viewed here.
For example: A ‘property’ against an Item could be ‘Voltage’ and the specific value entered against
the Item Master is ‘240 Volts’.  You also have the option to add properties by clicking on the ‘Add’
button.  The cursor will go to a new line for entry of the property as follows:

Property: From the drop-down list select the Property.

Value: Enter the specific value relating to this Property.

Buttons

When in this panel you can use the Add, Save, Cancel and Delete Buttons as follows
Add: The cursor will go to a new line for entry of a new Line Property Value.
Save: This will save the current data without exiting the screen
Cancel: Any changes made since the line record was accessed or the last time
the ‘Save’ Button was pressed will be lost.
Delete: This will delete the current highlighted Line Property record.

Line Variants Tab

This panel allows you to enter the quantity required for the line.  For Inventoried Items you also
need to nominate a Stock Location and identify any specific variants (Batch, Expiry Date, Serial
Number….Etc)

Quantity: The quantity to be used in this Invoice Line.  The sum of these quantities will appear in
the Invoice Qty field in the Invoice Line tab.

Variant: All Variant fields applicable to this Item are displayed.  Any unique combination of variants
will be displayed in its own line.

Write Off Qty: Upon entry of a Direct Credit the line quantity being credited (as entered in the
above 'Quantity' field) is immediately returned to Inventory.   The situation may arise however
where some, or all, of the returned quantity is to be written off.  In this instance you should enter
the quantity to be written off in this field (as a negative quantity).  When the Direct Credit is 'Printed'
the Write Off quantities are assembled into a Inventory Adjustment Batch (see Inventory>Inventory
Adjustment) where the Items can be assessed before issuing them from stock and posting to an
Inventory Adjustment Account.

Buttons

When in this panel you can use the Add, Save, Cancel and Delete Buttons as follows
Add: The cursor will go to a new line for entry of a new Planned Variant.
Save: This will save the current data without exiting the screen
Cancel: Any changes made since the line record was accessed or the last time
the ‘Save’ Button was pressed will be lost.
Delete: This will delete the current highlighted Planned Variant record.
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Additional Fields Tab

If you have defined Additional Fields against the Direct Invoice Lines (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Buttons

Close: This will close the Direct Invoice screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Adds a line relative to the displayed ‘Tab’ in the lower part of this screen

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Deletes a line relative to the displayed ‘Tab’ in the lower part of this screen

Related: This will bring up a list of functions that are related to the Direct Invoice.  You may open
and maintain information in those screens whilst still remaining in the Direct Invoice screen.  You
should note that if the 'Order Speed Entry' checkbox is 'checked' in Sales Rules then an additional
option called 'Set Speed Entry Order'.  This will allow you to not only define which fields you wish to
enter data, but also the tab order - by dragging and dropping the line where it is to appear in the
Tab Order)

Reports: This will bring up a list of Reports that are related to the Direct Invoice.  You can
immediately run the report whilst still remaining in the Direct Invoice screen.

15.10 Batch Invoicing

This function allows you to generate Invoices ‘In Batch’ from one of three sources:
· From Sales Deliveries, Job Orders and Scheduled Invoice Contracts
· Direct (without an Order)
· Create a Credit by reversing an existing Invoice

List Tab

Display fields

The displayed fields are taken from the Batch Invoicing information created:
· From the panel presented by clicking the ‘Add’ Button
· Entered into the ‘Detail’ tab.  

The selection of which fields to display is at the user’s discretion.  To select the fields to display
simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel
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you can:
· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Note: If you select the CURRENTDUECOLOUR field then the field will show colours relating to the
Due Date of the Invoice compared to today's date.  The displayed colours are:

· Red - Overdue
· Orange - Due Today
· Yellow - Due Tomorrow

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Fully Paid Status - If this is checked then the displayed list will include those Invoice
Batches whose status is ‘Fully Paid’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Batch Invoicing screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel for selection of the Invoices to be included in this Batch

Specific Site: Ostendo will automatically add the Site held against the User Signon record to the
Invoice  when it is generated.  You may allocate this Invoice to another site if:-

· You select the site from the drop-down list in the next field, and
· Your User Signon record is flagged to allow you to make the change

Site Name:  Select the Specific Site from the drop-down list

Invoice Date: The Date of this Invoicing Batch.  This is prefilled with system date but can be
amended by selecting the date from the drop-down calendar.  This date must be later than the
Cut-Off date defined in File>Financial Configuration>Cut-Off Dates.

Generate Invoices from Deliveries, Orders and Contracts: Select this ‘Radio Button’ if this
batch is to cover Invoices generated from

Sales Invoices
Job Orders,
Servicing Contacts (Recurring Invoices)
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Within this selection further refinements can be made as follows:

Select all invoice requirements from: From the drop-down calendar select the date from
which Invoices will be included.  If nothing is entered then all Invoices up to the ‘To Date’
will be selected.

To: From the drop-down calendar select the date up to which Invoices will be included.
This is prefilled with the system date but can be amended if required.

Include Sales Deliveries: If this is ‘checked’ then ‘Delivery’ Sales Type orders are to be
included.  The next four fields are available to refine the selection.

From Order Number
To Order Number
From Delivery
To Delivery

If nothing is entered then all Invoices raised against ‘Delivery’ Sales Type Orders will be
included.  You can also refine the selection by .checking' the checkbox 'Ready to Invoice
Status only'.  This will only include those Deliveries whose 'Shipping' Status is 'Ready to be
Invoiced'.  
You can make a further refinement by restricting the Invoice creation to a specific Billing
Customer or Invoicing Group (see below)

Include Sales Orders (Counter Sales): If this is ‘checked’ then ‘Counter’ Sales Type
orders are to be included.  The next two fields are available to refine the selection.

From Order Number
To Order Number

If nothing is entered then all Invoices raised against ‘Counter’ Sales Type Orders will be
included.
You can make a further refinement by restricting the Invoice creation to a specific Billing
Customer or Invoicing Group (see below)

Include Recurring Invoices: If this is ‘checked’ then Direct (Contract) Invoices are to be
included.  The next two fields are available to refine the selection.

From Contract Number
To Contract Number

If nothing is entered then all scheduled Invoices due against all Contracts will be included. 
You can make a further refinement by restricting the Invoice creation to a specific Billing
Customer or Invoicing Group (see below)

Include Job Orders by Range: If this is ‘checked’ then Job Order Invoices are to be
included.  The next two fields are available to refine the selection.

From Order Number
To Order Number

Include Job Orders by Selection: If this is ‘checked’ then you can click on the button
"Select Jobs" and this will present another screen for you to pick and choose one or more
jobs to include in this invoice. This Job Selection screen list is user customisable to display
the desired columns.

If nothing is entered then all scheduled Invoices due against all Job Orders will be
included. 

You also have the following selection options:
Specific Project:  From the drop-down list select a Project if you wish to restrict
the selection to a single Project 
From Job Schedule: If this is ‘checked’ then Invoices for Jobs with Invoice Style ‘
From Schedule’ will be included in this batch
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From Job Actuals: If this is ‘checked’ then Invoices for Jobs with Invoice Style ‘
From Actual Entries’ will be included in this batch
Finished Status Only: This field only becomes active if the previous checkbox is
selected.   If this is ‘checked’ then only those ‘From Actual Entries’ Jobs whose
status is ‘Finished’ will be selected. 

Additionally you can make a further refinement by restricting the Invoice creation to a
specific Billing Customer or Invoicing Group (see below)

Specific Billing Customer: If you wish to restrict the Batch to a specific Billing Customer
then select the Customer from the drop-down list.

Or

Specific Invoicing Group: If you wish to restrict the Batch to all Customers within an
Invoicing Group then select the Group from the drop-down list.

Upon completing the above click on the ‘’Create’ Button to generate the Invoice(s).

Create an Invoice or Credit without an Order: Select this ‘Radio Button’ if you are creating a
single Invoice or Credit, and select a Billing Customer in the next field.  
Upon selection of the Billing Customer click on the ‘’Create’ Button to generate the Invoice or
Credit

Create Credit by Reversing an Existing Invoice: Select this ‘Radio Button’ if you are crediting
and existing Invoice.  Select the Originating Invoice from the drop-down list.
If you want Ostendo to apply the Credit as a payment against the Invoice then ‘check’ the ‘Apply
credit as payment’ checkbox.
Upon selection of the existing Invoice click on the ‘’Create’ Button to generate the Credit

Buttons
Create: Click the ‘create’ button to create the Invoices from the above selections.  The
selected invoices are created in line with the Customer settings.  I.e. 

· If the Invoice Consolidation flag against the Customer is set to ‘Consolidate by
Customer’ then a single Invoice will be created for that Customer

· If the Invoice Consolidation flag against the Customer is set to ‘Consolidate by
Order’ then a single Invoice will be created for each Order

Cancel: Click the ‘cancel’ button to exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete (or Credit): If the current highlighted Invoice has not been printed then this button will
contain the label ‘Delete’.  If pressed then the Invoice will be deleted.  
If the Invoice has been printed then this button will display ‘Credit’.  In this instance selecting this
button will return a panel containing the following Radio Buttons

Create a Reverse Financial Credit for the selected Invoice
This will create a Credit Note only.  Any Stock Issues relating to the originating Invoice
should be manually reversed (or flagged as ‘non-charge’) within the originating order.

Create a Direct Credit using the Invoice as a Template
A screen will appear that displays the Lines of the original Invoice.  Against each line is a
checkbox.  You should select the Lines to be credited and click the 'Accept Selected Lines'
button to create a Direct Credit for these specific Lines.  

If you now go into the generated Credit you will see that the Credit Invoice status is 'Planned' and
the originating Invoice reference appears in the Description Line of the Credit.
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If you go to the Lines for the Credit Invoice and click on the 'Line Variants' tab you will see the
quantity being credited (as a negative amount).   You have the option to enter a negative quantity
in the field 'Write-Off Quantity'.  Upon Posting the Credit the full returned quantity will be returned
to Stock and the Write-Off Quantity will then be issued from Stock to the Cost Centre linked to the
Transaction Type selected in Item Rules field 'Stock Write-Off Type'

Related: This will bring up a list of functions that are related to Batch Invoicing.  You may open and
maintain information in those screens whilst still remaining in the Batch Invoicing screen.

Reports: This will bring up a list of Reports that are related to Batch Invoicing.  You can
immediately run the report whilst still remaining in the Batch Invoicing screen.

Print: This will generate and print the current Sales Invoice

Detail Tab

This tab allows you to maintain the individual Invoices or Credits

Entry and Display fields

Invoice Number: Display only field showing the system generated Invoice number.  Start and
current Invoice Numbers are maintained via File>System Configuration>System Settings

Invoice Date: This is date when the Invoice was created and is validated against the Financial
Cut-off date when posting.  You can amend the date by either overtyping the date or selecting the
date from the drop-down calendar.

Status: This status is updated by the program and records the progress of the Invoice.  The
display options are:

· Planned
· Printed
· Partially Paid
· Fully Paid

Invoice Type: A program maintained field that shows from where the Invoice was generated.  The
display options are:

· Direct Invoice
· Generated Invoice
· Credit From Invoice

Invoice Style: A program maintained field that shows whether it is an Invoice or Credit.

Invoice Print Status: Display only field showing the current status of the Invoice Print.  The
options are

· Printed
· Not Printed

Don’t Print on Statement: If this is ‘checked’ then this Invoice or Credit will not appear on the
Customer Statement.

Site Name: If the Invoice has not been printed then you may allocate this Invoice to another site
from the drop-down list but only if your User Signon record is flagged to allow you to make the
change
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Credit Terms: This is prefilled with the credit terms taken from the Order or Customer.  It can be
amended by selecting revised Terms from the drop-down list.  Credit Terms are maintained via
File>Financial Configuration>Credit Terms.

Due Date: Tin the first instance this is evaluated from the Invoice Date and takes into account the
Credit Terms.  This can be amended by over-typing or selecting a new date from the drop-down
calendar.

Shipping Method: This is prefilled with the Shipping Method currently held against the Billing
Customer.  You can amend this by selecting another method from the drop-down list.  You may
maintain Shipping Methods by either clicking on the icon to the right of this field or click on the ‘
Related’ button and select ‘Customer Shipping Methods’.

Sales Person: This is prefilled with the Salesperson currently held against the Billing Customer.
You can amend this by selecting another Salesperson from the drop-down list.  You may maintain
Salespeople by selecting General>Employees and identifying the Employee as a ‘Salesperson’

Charge Freight: ‘Check’ this checkbox if freight is to be charged.  The next field will become
active for entry of freight details.

Freight Details: Click on this button to enter the following details:
Freight is Taxed: ‘Check’ this if the Freight is Taxable. The next field will be activated
Tax Code: From the drop-down list select the Tax Code that applies to this Freight 
Freight Amount: Enter the Freight Amount (not including Tax)

Billing Customer: This is prefilled with the Billing Customer as held against the Order or
Customer record.  It may be amended by selecting a new Billing Customer from the drop-down list

Billing Details: If you click this button then a drop-down panel  will be presented that shows the
current address details of the Billing Customer.  They can be amended at any time by keying
directly into the following fields.

Address: Three lines are available for entry of the Billing Address of the Customer.  
City: Enter the Town or City of this Billing Address.
State: Enter the State of this Billing Address.
Code: Enter the Postcode or ZIP Code of this Billing Address.
Country: Enter the Country of this Billing Address.

Delivery Details: If you click this button then a drop-down panel  will be presented that shows the
current delivery address details of the order Customer.  They can be amended at any time by
keying directly into the following fields.

Address: Three lines are available for entry of the Delivery Address of the Customer.  
City: Enter the Town or City of this Delivery Address.
State: Enter the State of this Delivery Address.
Code: Enter the Postcode or ZIP Code of this Delivery Address.
Country: Enter the Country of this Delivery Address.

Currency Code: Prefilled with the currency code for this Customer but can be amended by
selecting another currency from the drop-down list

Exchange Rate: Prefilled with the exchange rate taken from the Exchange Rate table for the
currency.  This rate can be over-ridden if required

(Button) Pay Now:  If this button is pressed then a separate panel will appear for you to enter a
payment against this Invoice.  This screen contains the following fields;

Invoice Number: Display only field referring to this Invoice Number
Billing Customer: Display only field showing the Billing Customer for this Invoice
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Payment Date: This is prefilled with the system date.  You may amend this by over-typing
the date or selecting a date from the drop-down calendar.   Upon posting this Payment a
check will be made to ensure that this date is after the ‘Cut-Off’ date as set up in
File>Financial Configuration>Cut-off dates.
Payment Method: From the drop-down list select the method by which the Payment was
made.  Payment Methods are user-defined under File>Financial Configuration>Payment
Methods.
Payment Reference: Open-format field for you to enter any identifying reference to the
Payment.  No checks are made on this entry.
Banking Method: From the drop-down list select the method by which the Payment will
be banked.  The options are:

Directly to Account: Posting will occur upon update in this screen
Using Bank Deposit: Posting will occur when banked through the Bank Deposit
routine

Account for Payment: From the drop-down list select the Account to which the Deposit
will be made.  Payment Accounts are user-defined under File>Financial
Configuration>Payment Accounts.
Payment Reference: Enter details of the Payment (Example: Cheque Number)
Balance Due: Display only field showing the outstanding balance against this  Invoice.
Payment Amount: Enter the amount received against this Payment
Discount Given: Enter any discount that is given against this Invoice payment
Payment Rounding: Enter an amount around which the Payment will be rounded.  If
nothing is entered then 0.01 is assumed
Remaining Balance: Display only field showing the outstanding Invoice value
Change Due: Display only field showing the calculated change due as a result of the
entered Payment Amount taking into account and Discount and Rounding.

Buttons
Accept: This will create a Payment record linked to the Invoice
Cancel: Cancel and ignore the entry and return to the Direct Invoice screen

Invoice Values: Display only fields showing the current financial status of the Invoice.  The
displayed fields are:

Nett Amount: Amount not including Tax
Freight Amount: Freight Amount not including Tax
Tax Amount: Tax charged on Invoice Lines and Freight
Total Amount: Sum of the above
Paid Amount: Amount paid to date
Balance Due: Outstanding balance
(Button) Pay Now:  If this button is pressed then a separate panel will appear for you to
enter a payment against this Invoice.  This screen contains the following fields;

Invoice Number: Display only field referring to this Invoice Number
Billing Customer: Display only field showing the Billing Customer for this Invoice
Payment Date: This is prefilled with the system date.  You may amend this by
over-typing the date or selecting a date from the drop-down calendar.   Upon posting
this Payment a check will be made to ensure that this date is after the ‘Cut-Off’ date as
set up in File>Financial Configuration>Cut-off dates.
Payment Method: From the drop-down list select the method by which the Payment
was made.  Payment Methods are user-defined under File>Financial
Configuration>Payment Methods.
Payment Reference: Open-format field for you to enter any identifying reference to
the Payment.  No checks are made on this entry.
Banking Method: From the drop-down list select the method by which the Payment
will be banked.  The options are:

Directly to Account: Posting will occur upon update in this screen
Using Bank Deposit: Posting will occur when banked through the Bank Deposit
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routine
Account for Payment: From the drop-down list select the Account to which the
Deposit will be made.  Payment Accounts are user-defined under File>Financial
Configuration>Payment Accounts.
Payment Reference: Enter details of the Payment (Example: Cheque Number)
Balance Due: Display only field showing the outstanding balance against this  Invoice.
Payment Amount: Enter the amount received against this Payment
Discount Given: Enter any discount that is given against this Invoice payment
Payment Rounding: Enter an amount around which the Payment will be rounded.  If
nothing is entered then 0.01 is assumed
Remaining Balance: Display only field showing the outstanding Invoice value
Change Due: Display only field showing the calculated change due as a result of the
entered Payment Amount taking into account and Discount and Rounding.

Buttons
Accept: This will create a Payment record linked to the Invoice
Cancel: Cancel and ignore the entry and return to the Direct Invoice screen

Invoice Sources: This panel is only visible if the Invoice has been ‘Generated’ from Sales, Jobs,
or Contacts and shows the sources of all the Orders that contributed to this Invoice.  The displayed
fields against each order are:

Source No: Unique reference to this source linkage in this Invoice
Source Type: Originating Type (Job Order, Sales Order, Contract Order,
Number: The Number of the Originating Order Type
Reference: Order Header reference
Delivery Customer: The Customer for the originating Order
Freight Amount: Amount of freight charged in the Delivery

Instructions: Information entered here will be printed on the Invoice.  Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that screen or
double-click the selected record.

Buttons

Close: This will close the Batch Invoicing screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the same panel as described above for creating a new Batch Invoice.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to Batch Invoicing.  You may open and
maintain information in those screens whilst still remaining in the Batch Invoicing screen.

Reports: This will bring up a list of Reports that are related to Batch Invoicing.  You can
immediately run the report whilst still remaining in the Batch Invoicing screen.

Print: This will generate and print the current Sales Invoice
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Lines Tab

If the source of the Invoice was a ‘Generated Invoice’ from Sales Orders, Sales Deliveries, Job
Orders, or Contracts then Line details cannot be amended as the source determines the quantities
and values.

If the source of the Invoice was a ‘Direct Invoice’ then the line details are maintained here.

Upper Panel

This panel shows a summary of the lines that make up the Invoice.  In the case of ‘Direct Invoices’
this information can be maintained in the lower panel.

The fields shown on the Upper Panel are:
Source No: Not visible to ‘Direct Invoices’.  It refers to the ‘Generated Invoice’ source
referenced in the ‘Detail’ Tab
Line No: Line No of the Source or (for Direct Invoicing) as created in the lower panel.
Code: The unique identity of the line code
Unit: The unit of measure of the code
Invoice Qty: Quantity of the Unit being Invoiced.
Unit Price: Unit Price of the Code being Invoiced.
Description: Description of the Code
Tax Code: Tax Code that applies to this line
Tax Amount: Tax amount that applies to this line
Total Amount: Total amount including tax for this line
Analysis Group: Analysis Group linked to this line
Special Instructions: 
Notes: Extended Notes applicable to the line
Base Unit Price: the Standard Price of the item

Lower Panel

This is the main entry and maintenance area for Direct Invoices only.   Information from generated
Invoices cannot be maintained in this panel

Entry and Display fields

Invoice Line Tab

As the Invoice Lines have been generated from the Sales Picking, Sales Delivery, Contract, Job
Invoice Schedules or Job Actuals then the details cannot be amended in this screen.     You may,
however amend the following field if required.

Description: This is prefilled with the description as held against the Item, Descriptor, Kitset,
or Catalogue Item.  It can be amended here if required.

Line Notes: This is prefilled with any ‘Notes’ that are held against the Code that are flagged as
being copied to the Sales Order Line.   It may be amended here and made specific to this Line.
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon
you can bring up the Frequently Used Text table.  Select the text to be copied and either press
the OK Button in that screen or double-click the selected record.

Line Properties Tab

Any specific property values for the Item, Descriptor, Kitset, or Catalogue Item can be viewed here.
For example: A ‘property’ against an Item could be ‘Voltage’ and the specific value entered against
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the Item Master is ‘240 Volts’. 

Property: From the drop-down list select the Property.

Value: Enter the specific value relating to this Property.

Line Variants Tab

This panel allows you to enter the quantity required for the line.  For Inventoried Items you also
need to nominate a Stock Location and identify any specific variants (Batch, Expiry Date, Serial
Number….Etc)

Quantity: The quantity to be used in this Invoice Line.  The sum of these quantities will appear
in the Invoice Qty field in the Invoice Line tab.

Variant: All Variant fields applicable to this Item are displayed.  Any unique combination of
variants will be displayed in its own line.

Additional Fields Tab

If you have defined Additional Fields against the Batch Invoicing Lines (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Buttons

Close: This will close the Batch Invoice screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Deletes a line relative to the displayed ‘Tab’ in the lower part of this screen

Related: This will bring up a list of functions that are related to the Batch Invoice.  You may open
and maintain information in those screens whilst still remaining in the Batch Invoice screen.

Reports: This will bring up a list of Reports that are related to the Batch Invoice.  You can
immediately run the report whilst still remaining in the Batch Invoice screen.

Print: This will generate and print the current Sales Invoice
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15.11 Batch Invoice Printing

This function allows you to ‘Print’ selected Invoices.  Upon confirming the selections the program
will automatically send the Invoice(s) to one of the following:

· Direct to the printer
· As an attachment to an email
· Both direct to a printer and as an attachment to an email

The steps to be carried out in this process are:

· Enter the selection parameters in a selection panel
· Identify the specific Invoices that you are ‘Printing’
· Amend the ‘Print’ option as required
· ‘Print’ the Invoices

Parameter entry screen

This panel allows you to enter parameters to make an initial selection of Invoices.  

Display Invoices where print status is: From the drop-down list select the current Invoice
statuses that you want to include in the initial selection.  The options are:

· Not Printed
· Printed
· Both (Printed and Not Printed)

From Date: From the drop-down calendar select the date of the first Invoice record in the range.  If
nothing is entered then the first record in the ‘Invoice’ master file is assumed.

To Date: From the drop-down calendar select the date of the last Invoice record in the range.  This
is prefilled with the system date but can be amended if required.  If nothing is entered then the last
record in the ‘Invoice’ master file is assumed.

From Invoice Number: From the drop-down list select the first Invoice record in the range to be
extracted.  If nothing is entered then the first record in the ‘Invoice’ master file is assumed.

To Invoice Number: From the drop-down list select the last Invoice record in the range to be
extracted.  If nothing is entered then the last record in the ‘Invoice’ master file is assumed.

Specific Customer: If you wish to extract Invoices for a specific Customer then select the
Customer from the drop-down list of Customers.

Invoicing Group: If you wish to extract Invoices for a specific group of Customers then select the
Invoicing Group from the drop-down list.  Invoicing Groups are user maintained via
Sales>Settings>Invoicing Groups and a Customer is linked to a group in the Customer master
record.

Shipping Method: If you wish to extract Invoices using a specific Shipping Method then select the
Method from the drop-down list.  

Specific Site: If you wish to restrict the extract to Invoices for a specific Site  then 'check' the
checkbox and select the Site from the drop-down list. 

Buttons

OK: The program will go through the Invoice file using the above parameters and display the
following ‘Batch Invoice Printing’ screen containing the requested Invoices
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Cancel: This will close this selection panel.

Batch Invoice Printing Selected List Screen

This screen allows you to select specific Invoices for printing, define the output media, and then
print them.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Input and Display

Select: ‘Check’ the checkbox if you wish to ‘print’ the Invoice.  You have the option to select or
unselect all displayed Invoices by clicking the appropriate button at the bottom of the screen

Output Method: This displays the ‘Invoice Default Output’ method as held against the Customer
master record.  It can be amended here if required by selecting from the drop-down list.  The
options are:

· Print Only
· Email Only
· Print and Email

You should be aware that the email option automatically creates and sends an email using the
facilities on your computer.  The Customer master record must contain an email address in the
Invoice Email address field or (be default) a single Email address against the Billing Customer.

Invoice Number: Display only field showing the number of the extracted Invoice

Sales Type: Display only field showing the Sales Type that was used to create the Invoice.  The
displayed options are

Generated Invoice - created from Sales Orders, Job Orders, or Contract Orders
Direct Invoice - created without having an order

Status: Display only field showing the status of the extracted Invoice.  The display options are:
Planned - Invoice being prepared or waiting to be printed
Printed - Invoice confirmed and printed and/or emailed
Partially Paid - Payment(s) received and allocated to this Invoice but the invoice has an
outstanding balance
Fully Paid - Payment(s) received and allocated to this Invoice and the full invoice amount
has been paid

Invoice Date: Display only field showing the date the Invoice was raised

Billing Customer: Display only field showing the Billing Customer contained in the Invoice.

Print Options

Print All Selected Invoices: This will immediately perform the following action for each selected
Invoice:

· If the ‘Output Method’ is ‘Print Only’ then the Invoice will be printed directly to the default
printer
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· If the ‘Output Method’ is ‘Email Only’ then the Invoice will be generated as a pdf file and
attached to an email then sent to the email address defined in the Customer master
record

· If the ‘Output Method’ is ‘Print and Email’ then both the above actions will take place

Print as Proforma Invoices: ‘Check’ this checkbox if the selected Invoices are to be output as
Proforma.  I.e. The Invoice will be annotated as a ‘Proforma’ Invoice and its status will not change 

Preview: If this is ‘checked’ then the output will in 'Preview Only' mode and no formal  Invoice will
be generated

No physical Invoice is produced when printed: If this is ‘checked’ then if a Batch of Invoices is
run the Invoices themselves will have their status updated to ‘Printed’ but they will not be out put to
the Printer.

Select all Invoices: Click on this button to the ‘check’ the ‘Select’ field against all Invoices

De-select all Invoices: Click on this button to the ‘uncheck’ the ‘Select’ field against all Invoices

Print Current Invoice: Highlight a single record and click on this button to output this Invoice only.
In this instance the Output Method’ held against the record is ignored and the three output options
(Screen, Printer, or Email) are presented

Close: This will close the Batch Invoice Printing screen.  

15.12 Customer Deposits

This function allows you to enter and monitor Customer Deposits.  The deposits can (optionally) be
applied to subsequent Invoices received.

List Tab

Display fields

The displayed fields are taken from the Customer Deposits information entered into the ‘Detail’
tab.  The selection of which fields to display is at the user’s discretion.  To select the fields to
display simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed
panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
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(Custom…) to enter detailed selection criteria.

Include Fully Paid Status - If this is checked then the displayed list will include those Customer
Deposits that have been fully ‘matched’ to Invoices.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Deposit screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Deposit record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Deposit record from this table

Related: This will bring up a list of functions that are related to Customer Deposits.  You may open
and maintain information in those screens whilst still remaining in the Customer Deposit screen.

Reports: This will bring up a list of Reports that are related to Customer Deposits.  You can
immediately run the report whilst still remaining in the Customer Deposit screen.

Detail Tab

Entry and Display fields

Deposit No: This is a unique number automatically allocated by the program.  It cannot be
amended.

Deposit Date: This is the date the Deposit was received and is prefilled with the system date.  You
may amend this by overtyping the date or selecting a date from the drop-down calendar.   Upon
posting this Deposit a check will be made to ensure that this date is after the ‘Cut-Off’ date as set
up in File>Financial Configuration>Cut-off dates.

Status: This is the status of the Deposit and is maintained by the program.  The displayed variants
are:

Received - The Deposit has been registered
Partially Applied - The Deposit has been partially applied to an Invoice
Fully Applied - The Deposit has been fully applied to an Invoice

Customer: From the drop-down list selected the Customer that paid this Deposit.

Deposit For: From the drop-down list select the relationship of the deposit to an order.  The
options are:

· Unallocated
· Specific Sales Order
· Specific Job Order

If either of the last two options is selected then the next field will appear
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Order No: This will be visible if either Specific Sales Order or Specific Job Order was selected in
the previous field.  From the drop-down list select the specific Sales Order or Job Order against
which this Deposit was made

Payment Method: From the drop-down list select the method by which the Deposit was made.
Payment Methods are user-defined under File>Financial Configuration>Payment Methods.

Payment Reference: Open-format field for you to enter any identifying reference to the Deposit.
No checks are made on this entry.

Banking Method: From the drop-down list select the method by which the Deposit will be banked.
The options are:

Directly to Account: Posting will occur upon update in this screen
Using Bank Deposit: Posting will occur when banked through the Bank Deposit routine

Account for Payment: From the drop-down list select the Account to which the Deposit will be
made.  Payment Accounts are user-defined under File>Financial Configuration>Payment
Accounts.

Payer Name: Payer Name taken from the above Customer record.  This may be amended here if
required

Payer Bank Name: Payer Bank Name taken from the above Customer record.  This may be
amended here if required

Payer Branch Name: Payer Branch Name taken from the above Customer record.  This may be
amended here if required

Reference: Enter a brief description of the Deposit.  No validation checks will be carried out on this
field.

Currency Code: Prefilled with the currency code for this Customer but can be amended by
selecting another currency from the drop-down list

Exchange Rate: Prefilled with the exchange rate taken from the Exchange Rate table for the
currency.  This rate can be over-ridden if required

Received Amount: Enter the amount received against this Deposit

Applied Amount: Display only field showing the amount of this Deposit that has been applied to
an Invoice.  Applying Deposits is carried out in the ‘Customer Payments’ screen

Unapplied Balance: Display only field showing the amount of this Deposit that has not yet been
applied.

Notes Tab

Notes: You can enter unlimited amount of Notes relating to this Deposit.  Whenever you click on
this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.  

History Tab

This panel shows the history of where the Deposit has been allocated.
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Invoice Number: Display only field showing the Invoice to which this Deposit has been applied. 

Invoice Date: Display only field showing the date of the Invoice. 

Invoice Total: Display only field showing the full amount of the Invoice.

Discount Given: Display only field showing the discount given against the Invoice.

Applied Amount: Display only field showing the amount of this Deposit that has been applied to
this Invoice.

Payment Currency: Display only field showing the currency of the paid amount that has been
applied to this Invoice.

Payment Exchange Rate: Display only field showing the Exchange Rate of the Payment that was
used against this Invoice.

Invoice Currency: Display only field showing the currency of the Invoice amount that has been
applied to this Invoice.

Invoice Exchange Rate: Display only field showing the Exchange Rate that was used against this
Invoice.

Buttons

Close: This will close the Customer Deposit screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to Customer Deposits.  You may open
and maintain information in those screens whilst still remaining in the Customer Deposit screen.

Reports: This will bring up a list of Reports that are related to Customer Deposits.  You can
immediately run the report whilst still remaining in the Customer Deposit screen.

15.13 Customer Payments

This function allows you to enter and monitor Customer Payments.  These payments, along with
Customer Deposits and any Credits can be applied to Customer Invoices.

List Tab

Display fields

The displayed fields are taken from the Customer Payment information entered into the ‘Detail’
tab.  The selection of which fields to display is at the user’s discretion.  To select the fields to
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display simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed
panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Fully Paid Status - If this is checked then the displayed list will include those Customer
Payments that have been fully ‘matched’ to Invoices.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Payments screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Payment record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Payment record from this table if it has not been applied to an
Invoice.  If it has already been applied then you should first un-apply it by going into the 'Detail'
screen and clicking on the 'History' tab.  See the 'History' sub tab (below) for more details.

Related: This will bring up a list of functions that are related to Customer Payments.  You may
open and maintain information in those screens whilst still remaining in the Customer Payment
screen.

Reports: This will bring up a list of Reports that are related to Customer Payments.  You can
immediately run the report whilst still remaining in the Customer Payment screen.

Detail Tab

Entry and Display fields

Payment No: This is a unique number automatically allocated by the program.  It cannot be
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amended.

Payment Date: This is the date the Payment was received and is prefilled with the system date.
You may amend this by overtyping the date or selecting a date from the drop-down calendar.  
Upon posting this Payment a check will be made to ensure that this date is after the ‘Cut-Off’ date
as set up in File>Financial Configuration>Cut-off dates.

Status: This is the status of the Payment and is maintained by the program.  The displayed
variants are:

Received - The Payment has been registered
Partially Applied - The Payment has been partially applied to an Invoice
Fully Applied - The Payment has been fully applied to an Invoice

Customer: From the drop-down list selected the Customer that made this Payment.

Payment Style: From the drop-down list select the type of payment that you wish to work with.
The options are:

· Received Payment
· Match Credits to Invoices
· Use Customer Deposit

Note:
· For ‘Received Payment’ the record is created and maintained here
· For ‘Match Credit to Invoices’ the Credit will have already been created using the ‘Batch

Invoicing’ or ‘Direct Invoicing’ screens.  You can select the specific Credit from the
drop-down list in the next field.

· For ‘Use Customer Deposit’ the Deposit will have already been created using the ‘
Customer Deposit’ screen.  You can select the specific Deposit from the drop-down list in
the next field.

Credit No or Deposit No: This will be visible if you are Matching Credits to Invoices or matching
Customer Deposits to Invoices.  From the drop-down list select the specific Credit or Deposit that
is to be allocated to an Invoice.

Banking Method: From the drop-down list select the method by which the Payment will be
banked.  The options are:

Directly to Account: Posting will occur upon update in this screen
Using Bank Deposit: Posting will occur when banked through the Bank Deposit routine

Payment Method: From the drop-down list select the method by which the Payment was made.
Payment Methods are user-defined under File>Financial Configuration>Payment Methods.

Payment Reference: Open-format field for you to enter any identifying reference to the Payment.
No checks are made on this entry.

Account for Payment: From the drop-down list select the Account to which the Payment will be
made.  Payment Accounts are user-defined under File>Financial Configuration>Payment
Accounts.

Payer Name: Payer Name taken from the above Customer record.  This may be amended here if
required

Payer Bank Name: Payer Bank Name taken from the above Customer record.  This may be
amended here if required

Payer Branch Name: Payer Branch Name taken from the above Customer record.  This may be
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amended here if required

Reference: Enter a brief description of the Payment.  No validation checks will be carried out on
this field.

Payment Discount: This defines the type of discount that will be applied to Invoices in the ‘Apply
to Invoices’ tab.  Select the Discount type from the drop-down list.  The options are:

· Terms Percentage: The Discount taken from the Terms that are linked to the individual
Invoices

· Fixed Percentage:  All Invoices will have the percentage entered into the next field
applied to them.

· No Discount: No discounts will be applied to the Invoices 

Fixed Percentage: This field is only visible if ‘Fixed Percentage’ was selected against ‘Payment
Discount’.  Enter the percentage discount that will be applied to all Invoices in the ‘Apply to
Invoices’ tab.

Finance Charge: If a Finance Charge is to be applied then select the Charge Style from the
drop-down list.  The options are:

· Fixed Percentage
· Fixed Amount

Fixed Percentage: Only visible if 'Fixed Percentage' is selected as the 'Finance Charge' Style.   It
is a display only field that shows the Finance Charge Percentage held against the selected
Payment Method

Currency Code: Prefilled with the currency code for this Customer but can be amended by
selecting another currency from the drop-down list

Exchange Rate: Prefilled with the exchange rate taken from the Exchange Rate table for the
currency.  This rate can be over-ridden if required

Received Amount: Enter the amount received against this Payment.

Discount Given: Display only field showing the sum of the Discount Amounts entered into the ‘
Apply to Invoices’ tab

Total Applied Amount: Display only field showing the sum of the applied amounts entered into
the ‘Apply to Invoices’ tab

Payment Rounding: This facility enables you to ‘close off’ payments where the amount paid is at
variance to the applied Invoices - the variance amount being posted to its own account.
By default Ostendo will close off (amend status to ‘Fully Paid’) if the difference is 0.01     You can
amend this to any value as required.

Charge Amount: If the Finance Charge is 'Fixed Percentage' based then you cannot amend the
value in this field. If the Finance Charge is 'Fixed Amount' based then you may enter the Charge
Amount in this field. 

Outstanding Balance: Display only field showing the amount of this Payment that has not yet
been applied.

Notes sub-Tab

Notes: You can enter unlimited amount of Notes relating to this Payment.  Whenever you click on
this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
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Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.  

History sub-Tab

This panel shows the history of where the Payment has been allocated.

Invoice Number: Display only field showing the Invoice to which this Payment has been applied. 

Invoice Date: Display only field showing the date of the Invoice. 

Invoice Total: Display only field showing the full amount of the Invoice.

Discount Given: Display only field showing the discount given against the Invoice.

Applied Amount: Display only field showing the amount of this Deposit that has been applied to
this Invoice.

Payment Currency: Display only field showing the currency of the paid amount that has been
applied to this Invoice.

Payment Exchange Rate: Display only field showing the Exchange Rate of the Payment that was
used against this Invoice.

Invoice Currency: Display only field showing the currency of the Invoice amount that has been
applied to this Invoice.

Invoice Exchange Rate: Display only field showing the Exchange Rate that was used against this
Invoice.

Delivery Customer: Display only field showing the customer name for this invoice.

Buttons

Close: This will close the Customer Payments screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will present a blank ‘Detail’ screen for entry of a new Payments record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: If you are un-applying a Payment then highlight the applied Invoice in the 'History' tab and
click on this button.  Ostendo will create reversed Financial transactions and remove this history
record

Related: This will bring up a list of functions that are related to Customer Payments.  You may
open and maintain information in those screens whilst still remaining in the Customer Payment
screen.

Reports: This will bring up a list of Reports that are related to Customer Payments.  You can
immediately run the report whilst still remaining in the Customer Payment screen.



898 Ostendo Reference Guide

Apply to Invoices tab

This screen shows - for the selected Customer - all Invoices that have outstanding payments held
against them.  For the current Payment displayed at the top of the screen you can apply selected
amounts against one or more Invoices.  If the total applied amount is within the ‘Payment
Rounding’ tolerance then - upon saving - the status of the Payment record will be amend to ‘Fully
Paid’.  If the Payment has only been partially applied then the status will be amended to ‘Partially
Paid’.

Customer: Display only field showing the Customer of the Payment, Deposit or Credit being
applied.

Unapplied Amount: Display only field showing the initial unapplied amount from this Payment,
Deposit or Credit being applied.

Pending Amount: Display only field showing the sum of the amounts that have been ‘checked’ in
the list below.  (I.e. Amount ‘matched’ but not yet ‘Posted’).

New Balance: Display only field showing the ‘Unapplied Amount’ minus the ‘Pending Amount’

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Input and Display

Select: ‘Check’ the checkbox if you wish to select this Invoice for matching.  You have the option
to select or unselect all displayed Invoices by clicking the appropriate button at the bottom of the
screen.  When selecting an Invoice then the Applied Amount field will prefill with either the ‘
Unallocated Payment Amount’ or the ‘Outstanding Invoice Amount’ whichever is the lesser of the
two. 

Invoice Number: Display only field showing the Invoice to which this Deposit has been applied. 

Invoice Date: Display only field showing the date of the Invoice. 

Invoice Due Date: Display only field showing the due date of the Invoice.

Invoice Outstanding: Display only field showing the current outstanding amount against the
Invoice.

Discount Given: Enter the amount of discount you are giving against this Invoice.

Applied Amount: Enter the Amount that you are applying to this line.  Alternatively you can ‘check’
the Select checkbox to the left of the line and this field will prefill with either the ‘Unallocated
Payment Amount’ or the ‘Outstanding Invoice Amount’ whichever is the lesser of the two.

Balance: Display only field showing the Balance Due against this Invoice taking into account the
applied payment and discount given.

Currency: Display only field showing the currency code used in this Invoice.

Site Name: Display only field showing the Site Name code used in this Invoice.

Delivery Customer: Display only field showing the customer for this Invoice.



899Sales

Group Order Number: Display only field showing the order number for this Invoice.

DirectPurchaseRef: Display only field showing the Purchase Reference for this order.

Buttons

Select all Invoices: Selecting this button will ‘check’ all the Invoices in the main panel

De-select all Invoices: Selecting this button will ‘un-check’ all the Invoices in the main panel

Update selected Invoices: All the ‘checked’ lines will be ‘Posted’ and both the Payment and
Invoice records updated

Close: This will close the Customer Payments screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Customer Payments.  You may
open and maintain information in those screens whilst still remaining in the Customer Payment
screen.

Reports: This will bring up a list of Reports that are related to Customer Payments.  You can
immediately run the report whilst still remaining in the Customer Payment screen.

15.14 Bank Deposits

This function allows you to enter and monitor Bank Deposits.  

List Tab

Display fields

The displayed fields are taken from the Bank Deposit information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Banked Status - If this is checked then the displayed list will include those Deposits that
have been ‘Banked’.



900 Ostendo Reference Guide

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Bank Deposits screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Bank Deposit record.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Bank Deposit record from this table

Related: This will bring up a list of functions that are related to Bank Deposits.  You may open and
maintain information in those screens whilst still remaining in the Bank Deposit screen.

Reports: This will bring up a list of Reports that are related to Bank Deposits.  You can
immediately run the report whilst still remaining in the Bank Deposit screen.

Detail Tab

Entry and Display fields

Banking No: This is a unique number automatically allocated by the program.  It cannot be
amended.

Banking Date: This is the date the Bank Deposit batch was raised and is prefilled with the system
date.  You may amend this by overtyping the date or selecting a date from the drop-down calendar.
 Upon posting this Payment a check will be made to ensure that this date is after the ‘Cut-Off’ date
as set up in File>Financial Configuration>Cut-off dates.

Status: This is the status of the Bank Deposit batch and is maintained by the program.  The
displayed variants are:

Pending - The batch is being prepared for Banking
Banked - The batch has been Banked

Banking Reference: Enter a brief description of the Bank Deposit.  No validation checks will be
carried out on this field.

Bank Deposit Slip: This shows the print status of the Bank Deposit Slip.  The display options are:
· Not Printed
· Printed

If you print the Deposit Slip by clicking the printer icon then this status is automatically amended to 
‘Printed’.  You can revert this status to Not-Printed by selecting that status from the drop-down list.

Bank Account: From the drop-down list select the Account into which the monies will be
deposited.  Bank Accounts are maintained via File>Financial Configuration>Payment Accounts

(Bank Account): Display only field showing a description of the above Bank Account
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Banking Amount: Display only field showing the sum of the payments selected in the ‘Payments
Selection’ Tab

(Button) Update Status to ‘Banked’: This will become active once a payment is selected in the ‘
Payments Selection’ tab.  Clicking this button will ‘Post’ the batch and update the status to ‘Banked
’

Notes sub-Tab

Notes: You can enter unlimited amount of Notes relating to this Bank Deposit.  Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.  

History sub-Tab

This panel is for information only and shows the details that make up this Bank Deposit.
Payment Or Deposit: Shows if the line was a Payment or a Customer Deposit. 
Number: Identity of the Payment or Customer Deposit 
Payment Date: Date when the Payment or Customer Deposit was raised
Payment Amount: Amount paid in the Payment or Customer Deposit reference
Payment Method: The method by which the payment was made
Payment Reference: User entered reference against this payment
Customer: Customer who made this payment

Buttons

Close: This will close the Bank Deposits screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will present a blank ‘Detail’ screen for entry of a new Bank Deposit record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to Bank Deposits.  You may open and
maintain information in those screens whilst still remaining in the Bank Deposit screen.

Reports: This will bring up a list of Reports that are related to Bank Deposits.  You can
immediately run the report whilst still remaining in the Bank Deposit screen.

Payment Selection tab

This screen shows all the Payments and Customer Deposits that are not yet banked and contain a
Bank Account the same as that entered into this batch header.  

Bank Account: Display only field showing the Bank Account entered against the Bank Deposit
Header record.

Selected Total: Display only field showing the sum of the amounts that have been ‘checked’ in the
list below. 
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Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Input and Display

Select: ‘Check’ the checkbox if you wish to select this Payment or Customer Deposit for inclusion
in the Bank Deposit.  You have the option to select or unselect all displayed lines by clicking the
appropriate button at the bottom of the screen. 

(Payment or Deposit Information): Each displayed line is available for inclusion in this Banking
Deposit Batch.  Each Line shows:

Payment Or Deposit: Shows if the line was a Payment or a Customer Deposit. 
Number: Identity of the Payment or Customer Deposit 
Payment Date: Date when the Payment or Customer Deposit was raised
Payment Amount: Amount paid in the Payment or Customer Deposit reference
Payment Method: The method by which the payment was made
Payment Reference: User entered reference against this payment
Customer: Customer who made this payment

Buttons

Select all Payments: Selecting this button will ‘check’ all the Payments and Customer Deposit in
the main panel

De-select all Payments: Selecting this button will ‘un-check’ all the Payments and Customer
Deposit in the main panel

Update selected Payments: All the ‘checked’ lines will be ‘Posted’ and both the Payments and
Customer Deposit records updated

Close: This will close the Bank Deposits screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Bank Deposits.  You may open and
maintain information in those screens whilst still remaining in the Bank Deposit screen.

Reports: This will bring up a list of Reports that are related to Bank Deposits.  You can
immediately run the report whilst still remaining in the Bank Deposit screen.

15.15 Customer Aging

This produces an Aging Report for selected Customers.  The aging periods shown in the report
are user-defined in File>Financial Configuration>Aging Periods

Parameters

Run Aging as at: This is prefilled with the system date.  However you can amend the date from
the drop-down calendar and run the Aging ‘As At’ any selected date

Include Zero Balance Customers: ‘Check’ this checkbox if you wish to include Customers that
currently have a zero balance.
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Include Detail Transactions: ‘Check’ this checkbox if you wish to include details of all
transactions that contribute to the Aging Report

Include Contact Details: ‘Check’ this checkbox if you wish to include Contact details relating to
the Customer

Exclude Customer Deposits: ‘Check’ this checkbox if you wish to exclude  Deposits received
from the Customer

Exclude Customer Payments: ‘Check’ this checkbox if you wish to exclude  Unapplied
Payments.

Selection Criteria

Three distinct selection criteria are available:
· Select specific Customer
· Select all Customers linked to a Billing Customer
· Select a range of Customers

For specific Customer or Billing Customer: ‘Check’ this checkbox if you are selecting a Specific
Customer or Billing Customer.  This will activate the following two Radio Buttons 

Specific Customer: If this Radio Button is selected then also select the specific Customer
from the adjacent drop-down list

All Customers linked to this Billing Customer: If this Radio Button is selected then also
select the specific Billing Customer from the adjacent drop-down list

From Customer Type: From the drop-down list select the first Customer Type record in the range
to be printed.  If nothing is entered then the first record in the ‘Customer Type’ file is assumed.

To Customer Type: From the drop-down list select the last Customer Type record in the range to
be printed.  If nothing is entered then the last record in the ‘Customer Type’ file is assumed.

From Invoicing Group: From the drop-down list select the first Invoicing Group record in the
range to be printed.  If nothing is entered then the first record in the ‘Invoicing Group’ file is
assumed.

To Invoicing Group: From the drop-down list select the last Invoicing Group record in the range
to be printed.  If nothing is entered then the last record in the ‘Invoicing Group’ file is assumed.

Specific Site:'Check' this checkbox if the selection is to be restricted to a specific site.  In this
instance a Site must be selected in the next field

(Site Selection): If checkbox 'Specific Site is 'checked' then select the site from the drop-down list
Buttons

Print: This will bring the output selection panel to the screen.  The options are:
· Screen - View on Screen
· Print - Send to Printer
· Email - Email with this report attached

Cancel: This will exit this selection screen and any entered parameters will be ignored.
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15.16 Customer Statements

This produces Statements for selected Customers.  The Statement periods shown in the report
are user-defined in File>Financial Configuration>Statement Periods

Parameters

Run Statements as at: This is prefilled with the system date.  However you can amend the date
from the drop-down calendar and run the Statements ‘As At’ any selected date

Include Fully Applied Transactions From: All fully applied transactions completed on, or after,
this date will appear on the Statement.  This field is prefilled with the first day of the current month
but can be amended by selecting a new date from the drop-down calendar.

Include Zero Balance Customers: ‘Check’ this checkbox if you wish to include Customers that
currently have a zero balance.

Selection Criteria

Three distinct selection criteria are available:
· Select specific Customer
· Select all Customers linked to a Billing Customer
· Select a range of Customers

For specific Customer or Billing Customer: ‘Check’ this checkbox if you are selecting a Specific
Customer or Billing Customer.  This will activate the following two Radio Buttons 

Specific Customer: If this Radio Button is selected then also select the specific Customer
from the adjacent drop-down list

All Customers linked to this Billing Customer: If this Radio Button is selected then also
select the specific Billing Customer from the adjacent drop-down list

From Customer Type: From the drop-down list select the first Customer Type record in the range
to be printed.  If nothing is entered then the first record in the ‘Customer Type’ file is assumed.

To Customer Type: From the drop-down list select the last Customer Type record in the range to
be printed.  If nothing is entered then the last record in the ‘Customer Type’ file is assumed.

From Invoicing Group: From the drop-down list select the first Invoicing Group record in the
range to be printed.  If nothing is entered then the first record in the ‘Invoicing Group’ file is
assumed.

To Invoicing Group: From the drop-down list select the last Invoicing Group record in the range
to be printed.  If nothing is entered then the last record in the ‘Invoicing Group’ file is assumed.

From Statement Cycle: Statement Cycles are user-defined (Sales>Settings>Statement Cycles)
and linked to a Customer record.  This enables you to select Customers within a specific
Statement Cycle range.  From the drop-down list select the first Statement Cycle record in the
range to be printed.  If nothing is entered then the first record in the ‘Statement Cycle’ file is
assumed.  

To Statement Cycle: From the drop-down list select the last Statement Cycle record in the range
to be printed.  If nothing is entered then the last record in the ‘Statement Cycle file is assumed.

Specific Site: 'Check' this checkbox if the selection is to be restricted to a specific site.  In this
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instance a Site must be selected in the next field

(Site Selection): If checkbox 'Specific Site is 'checked' then select the site from the drop-down list

Buttons

OK: The program will go through the Invoice file using the above parameters and display the
following ‘Batch Invoice Printing’ screen containing the requested Invoices

Cancel: This will close this selection panel.

Customer Statement List Screen

This screen allows you to select specific Statements for printing, define the output media, and then
print them.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Input and Display

Select: ‘Check’ the checkbox if you wish to ‘print’ the Statement.  You have the option to select or
unselect all displayed Customers by clicking the appropriate button at the bottom of the screen

Output Method: This displays the ‘Statement Default Output’ method as held against the
Customer master record.  It can be amended here if required by selecting from the drop-down list. 
The options are:

· Print Only
· Email Only
· Print and Email

You should be aware that the email option automatically creates and sends an email using the
facilities on your computer.  The Customer master record must contain an email address in the
Statement Email address field or (be default) a single Email address against the Billing Customer.

Customer: Display only field showing the Customer Name

Total Balance: Display only field showing the current outstanding Balance held against this
Customer

Unapplied Deposits: Display only field showing the total value of Deposits from the Customer that
have yet to be applied to Invoices

Unapplied Payments: Display only field showing the total value of Payments from the Customer
that have yet to be applied

Buttons

Select all Statements: Click on this button to the ‘check’ the ‘Select’ field against all Customers

De-select all Statements: Click on this button to the ‘uncheck’ the ‘Select’ field against all
Customers
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Print Current Statement: Highlight a single Customer and click on this button to output a
Statement for this Customer only.  In this instance the Output Method’ held against the record is
ignored and the three output options (Screen, Printer, or Email) are presented

Print All Selected Statements: This will immediately perform the following action for each
selected Customer:

· If the ‘Output Method’ is ‘Print Only’ then the Statement will be printed directly to the
default printer

· If the ‘Output Method’ is ‘Email Only’ then the Statement will be generated as a pdf file
and attached to an email then sent to the email address defined in the Customer master
record

· If the ‘Output Method’ is ‘Print and Email’ then both the above actions will take place

Close: This will close the Batch Invoice Printing screen.  

15.17 Settings

15.17.1 Customer Types

This screen allows you to maintain a file of Customer Types, which are used to analyse Customer
records.   Customer Types are User-defined and can include such types as:

· Electrical Wholesale
· Fastenings Retail
· Reseller

Entry and Display fields

Type: Enter the Name of the Customer Type.   Duplicates not allowed.

Description: Enter a short description of the Customer Type.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Customer Type screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Customer Type.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Customer Type.

Set Default: If you highlight a record and click this Button then the Default Customer Type will
appear at the top of the screen.  The Customer Type is used to prefill the Customer screen when
adding a new Customer.  It can, of course, be amended to another Type in that screen without
affecting this default.  The Default Customer can be amended at any time.      
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15.17.2 Customer Regions

This screen allows you to maintain a file of Customer Regions, which are used to analyse
Customer records.    Customer Regions are User-defined and can include such types as:

· Northern
· Suburbs
· Central

Entry and Display fields

Region: Enter the Name of the Customer Region.   Duplicates not allowed.

Description: Enter a short description of the Customer Region.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Customer Region screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Customer Region.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Customer Region. 

15.17.3 Customer Codes

This screen allows you to maintain a file of Customer Codes, which are used to analyse Customer
records.  Customer Codes are User-defined and can include such groups as:

· Retail
· Overseas

Entry and Display fields

Code: Enter the Name of the Customer Code.  Duplicates not allowed.

Description: Enter a short description of the Customer Code.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Customer Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.
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Add: This will send the cursor to a new line for entry of a new Customer Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Customer Code.

15.17.4 Customer Lead Sources

This screen allows you to maintain a file of Customer Lead Sources, which are used to analyse
Sales by Lead Source.   Customer Lead Sources are User-defined and can include such types as:

· Newspaper
· White Pages
· Call Centre

Entry and Display fields

Type: Enter the Name of the Lead Source.   Duplicates not allowed.

Description: Enter a short description of the Lead Source.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Lead Source screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Lead Source.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Lead Source.

15.17.5 Shipping Methods

This screen allows you to maintain a file of Shipping Methods, which are linked to Customer and
Sales records to record Shipping method and charges.   Shipping Methods are User-defined and
can include such types as:

· Courier
· Standard Mail
· Sea Freight

Entry and Display fields

Shipping Method: Enter a brief name of the Shipping Method.   Duplicates not allowed.
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Description: Enter a longer description of the Shipping Method.  No checks are made on this
entry

Taxable: ‘Check’ this checkbox if the Shipping charge is Taxable.  When ‘checked’ the next field
must have a Tax Code

Tax Code: From the drop-down list select the Tax Code that applies to the Shipping Method.  Tax
Codes are maintained via File>Financial Configuration>Tax Codes.

Freight Amount: Enter the Freight Amount using this method.  This may include Tax depending
upon the setting in the next field.

Amount Includes Tax: ‘Check’ this checkbox if the Freight Amount entered in the previous field
includes Tax.

Display Sales Deliveries in Assignment Board for this method: ‘Check' this box if Sales
Deliveries are to be displayed in the Assignment Board. 

Instructions: You may enter instruction relating to this Shipping Method.  These can - optionally -
be printed whenever the Shipping Method is used.

Capabilities Required tab

Capability Name: Select the required capability from the drop-down list for this Shipping Method.

Capability Qty: Enter the quantity required.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Shipping Methods screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Shipping Method.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Shipping Method.

15.17.6 Contract Categories

This screen allows you to maintain a file of Contract Categories, which are used to categorise
Contracts when creating an Invoicing Schedule.  Contract Categories are User-defined and can
include such groups as:

· Consultancy
· Support and Maintenance

Entry and Display fields
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Category: Enter the Name of the Contract Category.  Duplicates not allowed.

Description: Enter a short description of the Contract Category.  No checks are made on this
entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Contract Category screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Contract Category.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Contract Category.

15.17.7 Invoicing Groups

This screen allows you to maintain a file of Invoicing Groups, which are held against Customer
records to facilitate processing of Invoices to cover all Customers within an Invoicing Group

Entry and Display fields

Name: Enter the Name of the Invoicing Group.  Duplicates not allowed.

Description: Enter a short description of the Invoicing Group.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Invoicing Group screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Invoicing Group.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Invoicing Group.
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15.17.8 Statement Cycles

This screen allows you to maintain a file of Statement Cycles, which is recorded against a
Customer record and facilitates selective printing of Statements.  Statement Cycles are
User-defined and can be, for example:

· Monthly
· 3 Monthly
· Selective

Entry and Display fields

Cycle: Enter the Name of the Statement Cycle Code.  Duplicates not allowed.

Description: Enter a short description of the Cycle Code.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Statement Cycle screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Statement Cycle Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Statement Cycle Code.

15.17.9 Sales Types

This screen allows you to maintain a file of Sales Types, which are used when creating Sales
Orders to segregate the Type of order being created.  These can be, for example:

· Mail Order
· Counter Sale
· Telephone

Entry and Display fields

Sales Type: Enter the Name of the Sales Type.  Duplicates not allowed.

Description: Enter a short description of the Sales Type.  No checks are made on this entry

Creation Status: From the drop-down list select the status of the Sales Order when it is created.
The options are:

· Planned
· Open
· In Progress
· Finished
· On-Hold
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· Closed

Numbering Is: From the drop-down list select the way in which Sales Orders are numbered.  The
options are:

· Automatic - commencing from the number set up in File>System Configuration>System
Settings

· Manual - manually entered at time of Order creation

Prefix: You have the option to provide a prefix to the Automatically generated Order Number.   For
example: if the Prefix was ‘SO-‘ then the generated Order could be ‘SO-12345’

Sales Style: From the drop-down list select the Sales Style.  The options are:
· Counter - Does not have a picking process
· Delivery - Picking and Delivery required

Rental Order: If this Sales Order Type cover Rentals (with a commence and Return Date) then ‘
check this checkbox.

Invoicing Style: If the Sales Style is 'Delivery' then this can only be set to 'Standard Invoicing'
If the Sales Style is 'Counter' then the following options are available from the drop-down list:

· Standard - Standard Process covering Order, Picking and Invoicing as definitive steps
· One Step No Backorder - An 'All-In-One' process that allows the creation of the Order,

Picking and Invoicing in one step.  Upon generation of the Invoice the Order is closed
irrespective of whether all lines have been picked

· One Step With Backorders - An 'All-In-One' process that allows the creation of the
Order, Picking and Invoicing in one step.  If, upon generation of the Invoice, some order
lines have yet to be picked the Order remains as 'In Progress' awaiting further picking
and Invoicing

Status: The default status is 'Active'.  If you wish to make this status 'Inactive' then select it from
the drop-down list.  Once selected the Sales Type will NOT be visible when creating new Sales
Orders

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Sales Types screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Sales Type.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Sales Type.
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15.17.10Sales Tracking

This screen allows you to maintain a file of Sales Tracking Codes, which are used to track a Sales
Order through it’s ordering, processing, and delivery process.  Sales Tracking Codes are
User-defined and can include such codes as:

· In Transit
· Awaiting Customer confirmation

Entry and Display fields

Tracking Code: Enter the Name of the Tracking Code.  Duplicates not allowed.

Description: Enter a short description of the Tracking Code.  No checks are made on this entry

Tracking Colour: From the drop-down list select the colour that you wish to associate with this
Tracking Status.  This will be displayed on the Sales Order ‘List’ view when that field is selected for
display.

Exclude from Mobility: Tick this box if you wish to exclude this Tracking Code from Freeway
Mobility usage.

Status: Set the Tracking Code as either "Active" or "InActive" .

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Tracking Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Tracking Code.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Tracking Code.

15.17.11Sales Rules

This screen allows you to maintain Sales Rules.  Sales Rules allow you to define what rules, within
the Sales Order area, you wish to apply.  The following rule settings are available

Entry and Display fields

Show Add-On Sales Message: ‘Check’ this checkbox if you would like the Sales Order Lines
entry panel to show when an Item has ‘Add-On’ Sales associated with it.

Show Stock Warning Message: ‘Check’ this checkbox if you would like the Sales Order Lines
entry panel to show when an Item has insufficient stock to satisfy the line being created.



914 Ostendo Reference Guide

Default Payment Method: From the drop-down list select the default payment method.  Payment
Methods are user-defined in File>Financial Configuration>Payment Methods

Default Payment Account: From the drop-down list select the default payment account.  Payment
Accounts are user-defined in File>Financial Configuration>Payment Accounts

Manually Close Sales: If this is ‘checked’ then all Sales Orders must be closed (I.e. Have their
status amended to ‘Closed’) manually.  If this is not ‘checked’ then the program will evaluate when
all the lines in a Sales Order have been delivered and automatically amend the order status to ‘
Closed’.

Invoice Payment Notes: Data entered here will appear at the bottom of the Invoice Print.  For
example, this can contain such information as “Our Bank Account details are:
01-012345-56669-00”

Quote Expiry Days: Enter the number of days that a Quotation will remain valid.  When creating a
Sales Quote this number of days will be added to the Quote Creation date to arrive at a Quote
Expiry date. 

Default Sales Type: From the drop-down list select the Sales Type that will prefill the Sale Type
field in the Order creation screen.  Sales Types are maintained via Sales>Settings>Sales Types.

Default BCC Email: On the 'Outputs' tab in each Customer record you can enter a BCC email
address for both Invoices and Statements.  This is useful, for example,  if you want a copy of all
emailed Invoices and Statements to be returned to yourself.  The email address entered here will
prefill the BCC address whenever you are creating  a Customer record.  It can, of course be
amended within that record.

New Order Start Tab: From the drop-down list select the preferred tab that will appear when
creating a Sales Order.  The options are:

Detail: shows the Customer information for confirmation and amendment
Lines: Goes straight to Order Line entry .  You can still click on the Detail tab if you wish to
amend the Customer and Order Header information

Required Date Lead Time: Whenever a new order is created the ‘Required Date’ shown on the
order creation screen will be calculated from the System Date plus this Leadtime.  Of course the
date can be amended during Order creation if required.

Default Order Line Type: From the drop-down list select the Sales Order Line Type that will be
used as the default to prefill the Sales Order Line entry screen.   The options available are:

· Item Code
· Descriptor Code
· Kitset Code
· Catalogue Code

Default Invoice Line Type: From the drop-down list select the Sales Invoice Line Type that will be
used as the default to prefill the Sales Invoice Line entry screen.   The options available are:

· Item Code
· Descriptor Code

Direct Invoice Numbering: From the drop-down list select the Invoice Numbering option you will
use when creating Invoices via the ‘Direct Invoice’ screen.  The options available are:

· Manual: If this is selected then, whenever you create an Invoice through the Direct
Invoicing screen, you will be required to manually enter your own number

· Automatic: If this is selected then, whenever you create an Invoice through the Direct
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Invoicing screen, Ostendo will use the automated Invoice Number as defined in System
Configuration.

Default Quote Header Notes: From the drop-down list select the name of the ‘Frequently Used
Text’ whose Text/Phrase will prefill a Sales Quote Header.  You can amend the Text/Phase in the
Sales Quote Header, if required, and make the text specific to that Order.  You can maintain
Frequently Used Text by going into General>Frequently Used Text

Default Quote Footer Notes: From the drop-down list select the name of the ‘Frequently Used
Text’ whose Text/Phrase will prefill a Sales Quote Footer.  You can amend the Text/Phase in the
Sales Quote Footer, if required, and make the text specific to that Order.  You can maintain
Frequently Used Text by going into General>Frequently Used Text

Default Quote Style: From the drop-down list select Quote Style that will be used as the default.
The options are:

Formal: Standard style quote showing Sales Order Lines
Letter: Letter Style showing descriptive narrative and single Quoted Price
User: Populated with the ‘Formal’ style fields for you to amend as required

You can amend the Default Quote Style in the Sales Quote Header and make it specific to that
Order. 

Default Quote Print Lines: From the drop-down list select the Default Print Line format.  Two
options are available from the drop-down list:

Print Detail Lines: All the Lines in the Quotation will be printed
Print Single Line: The text in the next field will be printed

You can amend the Default Quote Print Lines in the Sales Quote Header and make it specific to
that Order. 

Default Quote Line Description: Enter a short description that will become the default description
when creating a Quote against a Sales Order.  You can amend the Default Quote Line Description
in the Sales Quote and make it specific to that Order.

Order Speed Entry: If this is 'checked' then, on the Sales Order Lines and Direct Invoicing Lines
screens, a new entry is available under the ‘Related’ button called ‘Set Speed Order Entry'.  This
will show all the fields that are in the lower part of the Order Line screen.  You can ‘check’ those
fields that you want to enter data into.  When entering a line the cursor will go to the selected
field(s) when the ‘Enter’ key is pressed.  NOTE: In the Speed Entry Screen you can also define
the ‘tab order’ by dragging the field and moving it further up or down the list.

Allow Printing for Planned Status: If this is 'checked' then the Order Acknowledgement can be
printed when the Order status is 'Planned'.  If it is not 'checked' then you must change the Order
Status away from 'Planned' before printing is allowed.

Allow Auto Pick for Counter Orders: If this is ‘checked’ then an extra button will appear on the ‘
Batch Entry’ bar in the Sales Order ‘Lines’ panel for a ‘Counter’ Sale order.  If this is clicked then
all outstanding issues for all lines are automatically picked from their default location.  You should
note, however, that if any line has variants (Colour, Size, etc), or is ‘Source on Demand’ and
Purchased then a message will be returned informing you that these have not been picked.

Allow Invoice Creation from Auto Pick: If this is ‘checked’ then the Auto pick screen will also
contain a button to facilitate immediate generation of an Invoice for the Picked lines

Applying Payments Date:  Select the date that will be applied to the Payment Journal generated
from the payment transaction.  The options are:

· Payment Receipt Date:  The payment as entered into the Customer Payments screen
· Actual Applied Date: The Date the Payment was applied to Invoice(s)
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Optional Credit Blocking: By default Ostendo will allow you to complete the current Order  but
place the order ‘On Hold’ when the Credit Limit has been exceeded.  You are then NOT allowed to
create additional Orders.   If this flag is set then you can create additional Orders and they will also
be placed ‘On Hold’.  The status of ‘On Hold’ will prevent picking or delivery

Statement Un-Applied Payments:  This amends the way in which the unapplied payments are
displayed on the Customer Statement.  The options are:

Apply to Balances: The Unapplied payment will be included in the aging
Show Un-applied: The Unapplied payment amount will be printed but will not be taken
into account in the aging

Delivery Quantity Based on: When generating a Delivery for a Delivery Style order you can
define the method to be used to prefill the Pick Quantities.  The options are:

Remaining Qty: The quantity yet to be delivered against this Order
Freestock Qty: The quantity to be delivered or the available free-stock quantity whichever
is the lower quantity
Freestock By W/H: The quantity to be delivered or the available free-stock quantity
related to demands on the Delivery Warehouse whichever is the lower quantity

Default Delivery Shipping Activity Status:  The Delivery Activity Tracking panel in the Sales
Delivery screen contains a tracking step of ‘Shipping’.  This step is automatically changed when
the ‘Update Delivery status to Shipped’ button in the same screen is selected.  You can define the
Default Tracking status here.  The options are:

Delivered
Ready to Invoice

Delivery Shipping Action: From the drop-down list select the action you would like to happen in
the Sales Delivery screen when the current Delivery Document‘s status is changed to ‘Shipped’.
The options are:

No Action:  Simply amend the status to Shipped
Create Next Delivery: A window will appear asking if the User wishes to create a new
Delivery.  If confirmed then a new Delivery will automatically be generated

Delivery Line Entry Mode: This defines the way in which the 'Delivery' Order Pick process is
carried out.  The available options in the drop-down list are

Standard:  Manual entry of lines using mouse and keyboard
Scanning: If this option is selected then the barcode function is available which, when
scanned will cause the cursor to go to the quantity field for entry of a picked quantity
Single Scan: If this option is selected then the barcode function is available which, when
scanned, will assume a pick quantity of 1 and the cursor will immediately go to the next
line in preparation for entry of the next picked line

Use Order Number as Invoice Number for One Step: If this is 'checked' then - if the Order Type
used when creating an Order has an Invoicing Style of 'One Step' (with or without backorders) then
the generated Invoice will use the Sales Order Number as the primary Number followed by a
suffix.  The Suffix denotes a sequential Number and covers backorder Invoices and Credits from
the Sales order

Auto Pick Expiry Items: If this is 'checked' then if you choose 'Auto Pick' option to pick the Sales
Lines any line that is Expiry Date controlled will be picked in Expiry Date sequence taking the
oldest first.

Default Banking Method: From the drop-down list select the Default method by which the
Payment will be banked.  The options are:

Directly to Account: Posting will occur upon update in this screen
Using Bank Deposit: Posting will occur when banked through the Bank Deposit routine

This method will prefill the Payment and Deposit screens where it can be amended if required
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Deposit Deletion Date: From the drop-down list select the Date type to be used when you delete
a Customer Deposit that has been previously posted.  The options are:

Actual Date: Use the current system date in the reversing Journal
Deposit Date: Use the original Deposit date 
Determined by Cutoff: Use the original Deposit date OR the Financial Cutoff Date (as
entered in File>Financial Configuration Cutoff Dates) whichever is the later date to be the
date of the reversing Journals

Payment Deletion Date: From the drop-down list select the Date type to be used when you delete
a Customer Payment that has been previously posted.  The options are:

Actual Date: Use the current system date in the reversing Journal
Payment Date: Use the original Payment date
Determined by Cutoff: Use the original Payment date OR the Financial Cutoff Date (as
entered in File>Financial Configuration Cutoff Dates) whichever is the later date to be the
date of the reversing Journals

Round Invoice Header Tax for all: If this is 'checked' then Ostendo will evaluate Tax at Invoice
Header level rather than at Line level.  To describe why this is necessary here is an example:

Ostendo, like many Operational and Accounting software packages, calculate Tax at Line Level. 
Let us assume Tax at 10% for the following two lines in an Invoice

Line 1 Price = $10.47
Line 2 Price = $24.87

If the Tax was calculated at Line level then the total Tax would be

Line 1 Price = $10.47 Tax = 1.047 (rounded to 1.05)
Line 2 Price = $24.87 Tax = 2.487 (rounded to 2.49)
                                  
Therefore Total Tax = $3.54 

Some Accounting packages, on the other hand, calculate Tax at Invoice header level.  Using the
above two Invoice lines this method would produce the  following Tax

Line 1 Price = $10.47
Line 2 Price = $24.87

Total Line Price = $35.34 Tax = 3.534 (rounded to 3.54)
                                  
Therefore Total Tax = $3.53

You should therefore determine how the associated Accounting package evaluates Tax and set
this checkbox accordingly.  If you wish to set this at Customer level rather than 'across the board'
then 'uncheck' this checkbox and go to the Customer Master record and set it against the specific
Customer

One Step Invoice Date: This defines the default date to be used for picking and Invoicing for
Sales Orders whose Invoice Style is either 'One-Step Invoice' or 'One-Step Invoice with Backorder.
 Select from the drop-down list.  The options are:

System Date: The System Date will be used for Stock issues and the Invoice print/post date
Specified Date: The user can select a specific date when processing the Sales Order.  The
selected Date will be used for Stock issues and the Invoice print/post date

Credit Limit Compared To: This defines what will be included in the Credit Checks to determine
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the current Level of Credit.   The options are:
· Orders and Invoices 
· Invoices Only

Statistics YTD Start Month: From the drop-down list select the YTD Start Month against which
the Customer Statistics routine will be based.  The options are:

· Calendar: The Start Month will be January
· Financial: The Start Month will be that defined in System Settings (File>System

Configuration>System Settings)

One Step Invoice Print: From the drop-down list select the method by which you want the
One-Step Invoice to be printed.  The Options are:

· Printer: The Invoice will be immediately printed to the Printer identified against the Invoice in
the 'Report and View Developer'

· Queue Server: The Invoice will be queued for printing in line with the queue setting in
File>Queue Service

Finance Charge Tax Code: From the drop-down list select the Tax Code that will apply to
Finance Charges made during Customer Payment Receipts

Touch Pad File Name: Click on the three dots icon and locate the .dat file that is to be used for
entry of Order Lines via a screen with Touch Pad facilities.  The .dat file is created via the Ostendo
Graphical Editor.

Allow Delivery Invoice Before Shipping:  If this checkbox is 'checked' then Ostendo allows
invoices to be generated in the Sales Delivery screen before the delivery has been flagged as
shipped.   The objective here is to allow invoices to be sent for approval before the goods are
delivered.

De Activate Order Pricing Matrix Rules: This defines whether the Sales Order Pricing Rules
include or exclude the Order Pricing Matrix as part of the Pricing process (Pricing Matrix is created
via Pricing>Order Pricing Matrix).    This rule is applied to all Sales Orders.  However you can
override this for specific Sales Orders within that Order's Header record.

Use Delivery No as Invoice for Delivery Invoice: If this checkbox is 'checked' then Ostendo will
use the Sales Delivery number as the Invoice number with a suffix of '-NN'.  The -NN is a
sequential number and is included to cater for multiple invoices per delivery (example:- in case of
crediting). 
Note that you can either tick this box or the "Use Order as Invoice No for Delivery Invoice" box,
not both. 

Auto Apply Order Deposits when Printing Invoice: If this checkbox is 'checked' then Ostendo
will automatically apply deposits entered against a Sales Order at the time of printing the invoice.
This feature can be deactivated at Sales Order level

After One Step Invoice: After completing a One-Step Invoice you can define what action you wish
Ostendo to take.   The options in the drop-down list are:

No Action: No additional action takes place and Ostendo returns to the current Sales Order
Create a new Order: Brings up the Sales Order Creation panel in preparation for creating a
new Sales Order

Auto Pick All Items: If this is 'checked' then Ostendo will automatically picks only the current

revision number if the item has been defined as revision tracked.

Exclude S/Ns from Auto Pick All:  If this is 'checked then all Serial Numbered Items will be
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excluded from Auto Pick if 'Auto Pick All Items' is 'checked'.

Quote Followup required: 'Check' this checkbox if you require a Quote Followup.This rule
combined with the next rule (Followup days from Quote Date) creates a follow-up email (if
activated in Email Services) and queue services is running.  

Followup Days from Quote date:  Enter the number of days from the Quote Date when you want
to trigger a Followup Email.

Delivery Advice Query:  If you wish to send a Delivery Advice Email then select the Query from
the dropdown list.  Email Queries are created and maintained via File>Email Services>Email
Queries

Post Costs for Recurring Invoices: If this is 'checked' then costs, as defined against the
Recurring Invoice's Line Descriptor, will be posted to the Sales Invoices created.

Make a Copy of Converted Quotes:  If this is 'checked' then a copy of the quote is made at the
time it’s converted to an order.  It suffixes the quote number with a ‘@99’ – where the 99 indicates
the quote revision number.

AVG Line Pick Time in Minutes:  Enter the average pick time in minutes to pick one line item.
(This  is used when creating assignments in Assignment Board).

Use Order as Invoice No for Delivery Invoice: If this checkbox is 'checked' then Ostendo will use
the Sales Order number as the Invoice number with a suffix of '-NN'.  The -NN is a sequential
number and is included to cater for multiple invoices per sales order.
Note that you can either tick this box or the "Use Delivery No as Invoice for Delivery Invoice"
box, not both. 

Use Line Notes for Purchase:  Tick this box if Line Notes are to be used in the Purchase Order
Lines.

Buttons

Close: This will close the Sales Rules screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

15.17.12Sales Quote Change Rules

This is used to flag what, if any, quotes changes have been made when either converting the
Quote to an Order or when run from Sales Order detail tab.  Tolerance percentages can be
defined against the Cost & Price logging therefore reducing the sensitivity.  

Log Cost Changes: If this is 'checked' then any change to the Cost will be recorded if the
change is outside the tolerance specified in 'Cost Tolerance %'
Cost Tolerance %: Enter the percentage tolerance against which a change record is
triggered
Log Std Buy Price Changes: If this is 'checked' then any change to the Std Buy Price will
be recorded if the change is outside the tolerance specified in 'Buy Price Tolerance %'
Buy Price Tolerance %: Enter the percentage tolerance against which a change record is
triggered
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Log Std Sell Price Changes: If this is 'checked' then any change to the Std Sell Price will
be recorded if the change is outside the tolerance specified in 'Sell Price Tolerance %'
Sell Price Tolerance %: Enter the percentage tolerance against which a change record is
triggered
Log Item Revision Changes: If this is 'checked' then any change to the Item Revision will
be recorded.
Log Code Status Changes: If this is 'checked' then any change to the Code Status will
be recorded.
Log Primary Supplier Changes: If this is 'checked' then any change to the Primary
Supplier will be recorded.

Buttons

Close: This will close the Sales Quote Change Rules screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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16 POS

16.1 Point of Sale

This is the main Point of Sale Screen used for taking POS orders.  Upon first entry into this screen
you will asked to Log in as follows:

User Name: Enter your User Name.  This entry is validated against the Employee table whose
records are flagged as ‘This Employee is a POS Operator’.  Employees are maintained via
Labour>Employees

Password: Enter your password.  This entry is case-sensitive and validated against the Password
maintained in the Employee record.

If your User Name/Password is not valid for this Site then you will not be allowed to sign in.

Station ID: This is a display only field showing the current Station ID allocated to this workstation.

Once you have signed onto the workstation the main POS screen will be presented and shows the
following fields.

Entry and Display fields

Customer Information Section

Billing Customer: This is prefilled with the default Customer as entered into the POS Rules
screen.  This can be changed by selecting the Customer from the drop-down list.   If the Customer
does not currently exist in the database you have the option to type in the Customer Name and -
upon exiting this field - a panel will appear asking if you wish to create the Customer record.  If you
confirm this a Customer Maintenance screen will appear.  After you have completed the creation
details you will be returned to this screen.

Sales Style: This is prefilled with 'Invoice' but can be changed from the drop-down list.   The
available Styles are:

Invoice: The action of creating an Invoice Style will force the following steps:
· Issue the Line as it is entered and accumulate the Sell Price
· Enable the 'Pay' Button which facilitates payment at time of sale or post to Account

Customer
· Print the Invoice

Quote: The action of creating a Quote will:
· Disable the 'Pay' button
· Not issue any Lines
· Allow the quote to be printed (Alt P)

Press F10 to put the Quote 'On Hold'.

Order: The action of creating an Order will:

· Not issue any Lines but will generate demands which are taken into account via
Inventory Replenishment, Create Required Orders and Inventory Availability.     

· For 'Order' Style only an additional (Alt-Print) button appears from which you can
print the Purchase Order

· Place the Order 'On Hold' after printing
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· Receive any Payment/Deposit
· Changing Status to 'Invoice' will automatically issue lines.  Note: If the issue process

requires sub-level selections (Serial Number, Batch Number, etc) then you will be asked
to select these at this time

· Print the Invoice

Sales Mode: This is prefilled with the default Sales Mode as held against the POS Station record.
You can select another mode from the drop-down list.  The options are:

Retail: Covers the Sale, Collection and Delivery of products
Workshop:  Covers the quick creation of a Workshop Order
Layby: Covers the creation and maintenance of Laybys

Depending upon your selection the upper-Left area of this screen changes to accommodate the
Mode as follows:

Retail
Delivery Mode: From the drop-down list select the Delivery Mode.  This will
dictate subsequent activities relating to this Sales Mode.  The options are:

Counter: This will produce a Sales receipt at the Counter
Pickup: This will produce the Sales receipt but also produce a ‘docket’ so
that selected goods can be collected at a pickup point
Delivery: This will produce a Sales Receipt but also produce a ‘Delivery’
record for subsequent delivery of the goods to the Customer’s address

Instructions: You can enter unlimited amount of instructions that are related to
this Order.  These notes will be available wherever this order is reported. 
Whenever you click on this field an icon will appear in the top-right.  By clicking on
this Icon you can bring up the Frequently Used Text table.  Select the text to be
copied and either press the OK Button in that screen or double-click the selected
record.

Workshop
Required Date: This denotes when the Workshop Order is required to be carried
out.  It is prefilled with the system date but you can amend this from the
drop-down calendar if required

Reference: An open-format field into which you can enter a short description of
the Workshop Order.  No check are made on this entry

Instructions: You can enter unlimited amount of instructions that are related to
this Order.  These notes will be available wherever this order is reported. 
Whenever you click on this field an icon will appear in the top-right.  By clicking on
this Icon you can bring up the Frequently Used Text table.  Select the text to be
copied and either press the OK Button in that screen or double-click the selected
record.

Print (button) : If you click on this button (or key Alt P) you will print the current ‘
Workshop Order’.  

Layby
Layby Start: This denotes when the Layby Order was raised.  It is prefilled with
the system date but you can amend this from the drop-down calendar if required

Layby End: This denotes when the Layby Order is to be collected or delivered.  It
is prefilled with the System Date plus the number of days specified in the POS
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Rules (POS>Settings>POS Rules) but you can amend this from the drop-down
calendar if required

Reference: An open-format field into which you can enter a short description of
the Layby Order.  No check are made on this entry

Instructions: You can enter unlimited amount of instructions that are related to
this Order.  These notes will be available wherever this order is reported. 
Whenever you click on this field an icon will appear in the top-right.  By clicking on
this Icon you can bring up the Frequently Used Text table.  Select the text to be
copied and either press the OK Button in that screen or double-click the selected
record.

Print (button) : If you click on this button (or key Alt P) you will print the current ‘
Layby Order’.  

Line Entry Section

Batch Entry Bar

The Batch Entry Bar displays Buttons that provide various options to add lines to the POS Order in
batch form:

Lists: Clicking on this button will bring up the Lists maintained via Inventory>Lists.  From the
displayed List you can select single or multiple Items for copying to this POS Order

Items: Clicking on this button will bring up a list of Items currently in Ostendo.  From the displayed
list you can select single or multiple Items for copying to this POS Order

Descriptors: Clicking on this button will bring up a list of Descriptors currently in Ostendo.  From
the displayed List you can select single or multiple Items for copying to this POS Order

Catalogue Items: Clicking on this button will bring up a list of Supplier Catalogues from which you
can select a specific Catalogue.  Note: The Catalogue selection screen is by-passed if you only
have one Supplier Catalogue in Ostendo.   For the selected Supplier the Catalogue Items are
displayed from which you can select single or multiple Items for copying to this POS Order

Order Information Bar

The info bar provides current information about this Station.  The displayed fields are:
Sale Number.  This is the unique identity of the current Sales
Day/Date/Time: Current date and time
Orders on Hold: The number of Orders that are currently held in the background.  These
can be placed or released from ‘Hold’ by pressing the F10 key or clicking on the key along
the bottom row of this screen.
Price/Tax status: This defines if the prices in this line entry panel include or exclude Tax.
The setting for this is contained in the POS Rules screen (POS>Settings>POS Rules).
(Ctrl D) Order Discounts: If the Operator is NOT authorised to amend Sell Prices (as
defined against the Employee record) then access to this function will be denied.  If you
click on Ctrl-D then, in the displayed panel, you can apply discounts to the lines in this
order as follows:

Discount Every Line with new discount: This will apply the entered discount to
the Unit Price of all lines in the current order
Ratio All Lines with a discount….: This will ratio the current discounts against
each line by the entered discount.   For example, If the current discount is 10%
then a Discount Ratio of 150% will increase the Line discount to 15%
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Order Line Entry

This area allows you to enter lines using the following keyboard function.

Pressing the Tab Key when in the ‘Code’ field will take you to the ‘Qty’ field
Pressing the Tab Key when in the ‘Qty’ field will take you to a new line
Pressing the ‘Enter’ (or ‘Return”) will take you to a new line

Code: This is the product or descriptor code that is being entered in the line.  The
following options are available:

Barcode:  If the Item or Descriptor has a barcode then scanning the barcode on
the physical Item/Descriptor will automatically populate this field with the Item or
Descriptor Code.  You should note the following:

· If the Barcode for the Item or Descriptor is unique then the Item/Descriptor
will immediately populate the order line.

· If a Bar-coded Item has ‘sub-level’ variants (Lot, Colour, Serial Number,
etc) then a separate panel will be presented for you to select the correct
variant 

· In Inventory>Items>Item Barcodes you can enter a specific Barcode
against an Item’s ‘sub-level’ variant (Lot, Colour, Serial Number, etc) and
this will be used in preference to the previous option.  

· If more than one Item, Item Sub-Level Variant, or Descriptor have the
same Barcode a separate panel will be presented for you to select the
correct one

Item or Descriptor: You can select the Item or Descriptor directly in the following
ways:

· Click the ‘spyglass’ icon to the right of the field and select either Item or
Descriptor.  A panel will appear in which you can search and filter to arrive
at the specific line to add to the order.  Either double-click on the selected
line, or highlight the line and click the ‘OK’ button, to add the line to the
order.

· Key the Item Code or Descriptor Code directly into the field if known. 
Note: If you have an Item that has the same identity as a Descriptor then
another panel will appear for you to select the correct one

  
Qty: This is prefilled with a default quantity of 1.  You may alter this quantity as required.

Unit: This is prefilled with the base unit of measure of the Descriptor or Item.  If the Item
has other Units of Measure and that Unit of Measure is being sold then click on the F9
(Edit) button to select the specific Unit of Measure.  Press the F9 key to return to the Order
Line view

Unit Price: This is a display only field that is initially prefilled with the calculated sell price
based on the Pricing Level and order quantity.  If the POS Operator has permission to
amend Prices (as defined against the Operator record - Labour>Employees) then you can
click on the F9 (Edit) button and amending the Unit Price field as required.  Press the F9
key to return to the Order Line view

Ext Price: This is a display only field that shows the result of Unti Price * Order Quantity

Discount %: This is a display only field that shows the percentage discount when
compared against the normal sell price for this Price Level/Qty.  If the POS Operator has
permission to amend Prices (as defined against the Operator record - Labour>Employees)
then you can click on the F9 (Edit) button and amending the Discount %, or Discount
Amount fields as required.  Press the F9 key to return to the Order Line view
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Description: Display only field showing the description of the Item or Descriptor.  To
amend this field click on the F9 (Edit) button and amending the Description as required. 
Press the F9 key to return to the Order Line view

Display Line Details: immediately below the above Line entry ‘grid’ you will see a thin ‘button’.
This button allows you display or hide details against the current line.  The displayed details are for
information only and cannot be amended in this view.
You can set the default viewing option by going into POS>Settings>Rules and defining the
preferred view against field ‘Display Line Details’ 

Linked Images Section

If the Item or Descriptor contains an Image in its master record then that image will be displayed
here

Invoice Information Section

This section contains information about the Station and current Operator

Station ID: This is a display only field that shows the identity of this POS station.

Operator: This is a display only field that shows the current signed-on Operator.

Salesperson: If you are linking this POS Order to a Salesperson (for analysis purposes,
commissions, etc) then select the Salesperson from the dropdown list.  The list is maintained via
Labour>Employees and identifying the Employee as a Salesperson.

Sale Date: This is prefilled with the system date.  This can be amended but only if the POS
Operator has permission (as defined against the Operator record - Labour>Employees)

(Button) Sign Out (or use Alt-S): If this button is pressed then the current Operator is signed out
against this Station and the POS screen closed.

(Button) Operator (or use Alt-O): If this button is pressed then a panel will appear for entry of a
new Operator.  This is to facilitate temporary access so that, for example, a Supervisor can carry
out tasks (Example: Price Override) for which the current Operator does not have permission.   

Totals Section

This section contains information about the current sale

Total: This is a display only field showing the current Sell Price of this POS Order including Tax.
This is updated every time a line is entered and ‘saved’.

Tax Value: This is a display only field showing the Tax portion of the current Sell Price of this POS
Order.

Value Excluding Tax: This is a display only field showing the Total amount less Tax of this POS
Order.

(Button) No Sale (or use Alt-N): If this button is pressed then current POS Order will be removed
and this screen will revert back to taking a new Order.

(Button) Pay (or use F12 key): If this button is pressed then Payment screen will be presented for
entry of payment details.  See separate section on POS Payments.
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(Script): This button will only be displayed if an ‘Order Script’ has been created (via File>System
Configuration>Order Scripts).   When visible the button name will be prefilled with the script name
and, when pressed, will perform the functions of that script. 

Product or Related Buttons Section

Depending upon how your Station has been configured (POS>Settings>POS Rules) one of the
following two sections will be displayed

Touchpad Display

Displays a Touchpad for POS that are touch enabled.   This touchpad contains buttons which -
pictorially - show the Product Sections and products being sold.   The Display is created and
maintained via Ostendo's Workflow Editor and controlled by a Script (created via File>Scripting
Configuration>Script Editor).

Related Buttons 

This section displays buttons that will allow access to supporting functions.  The displayed buttons
are specific to the Operator and are defined against the Operator’s record (Labour>Employees).
The available buttons are:

Inventory Availability (or use Ctrl-1): This will bring up the Inventory Availability screen so
that you may view the current and projected stock for a selected Item

Price Inquiry (or use Ctrl-2): This will bring up the Price Inquiry screen so that you can
determine sell prices ‘on the fly’ without actually creating a POS Order line.

Customer Statistics (or use Ctrl-3): This will bring up the Customer History screen that
shows complete sales and Invoicing history by Order Customer, Billing Customer, or both.

Sales Orders (or use Ctrl-4): This will bring up the main Sales Order screen so that you can
view all current sales orders in Ostendo

Linked Images (or use Ctrl-5): This will bring up a screen showing any Images that are linked
to current Item or Descriptor record.  Note: If the Item or Descriptor contains Image records
then the first image will be displayed in the upper part of the screen (Not valid for screens set
to 800 x 600)

Cash In and Cash Out (or use Ctrl-6): This allows cash In/Out transactions to be carried out
during the current session.  When selected a panel will appear that shows four options:

Cash Drop (Out): Where ongoing cash is taken to the ‘Back Office’
Cash Drop (In): Where the Office adds more ‘Float’ to the Station
Pay (In): Where ‘Petty Cash’ is taken from the Station
Pay (Out): Where ‘Petty Cash’ is paid back into the Station

For each selection another panel appears for denoting the amount of Cash-In or Cash-Out
as follows:

Type of Transaction: Display only field showing the transaction Type selected in the
previous panel
Cash Amount: Enter the amount of cash being issued or received
Reason:  Enter a short reason why the Transaction is being carried out
(Button) Back (Alt-F4): This will exit this panel without taking any action
(Button) Accept (F12): This will accept, and post, the transaction
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POS History (or use Ctrl-7): This will bring up a panel that shows the history of Sales carried
out.  This enables any Invoices to be re-printed, if required.   Simply highlight the line and click
the ‘Re-Print Invoice’ button

Cash Drawer (or use Ctrl-8): Clicking on this button will open the Cash Drawer for
miscellaneous transactions such as Cash Drops, etc

End of Day (or use Ctrl-9): This will bring up a panel for entry of ‘End of Day’ balances.  See
POS End of Day screen in this functionality Help

Activity Buttons

These buttons provide easy access to functionality that supports the POS process.  The following
Buttons are available

Look Up (or use F3): This will look up data that is linked to the field where the cursor currently
resides

Customer (or use F4): This will bring up a maintenance screen for not only maintaining the
current POS Customer but also adding new customers

Add (or use F5): This will place the cursor in a new line in the entry panel for entry of a new order
line. 

Save (or use F6): This will save the current order details without exiting the order.

Cancel (or use F7): This will cancel the current line entry

Delete (or use F8): This will delete the current line entry

Edit Line (or use F9): This toggles between (a) showing the single line entry where you can enter
the sale item and quantity to (b) showing full details of the current line in which you can amend
details against the line.  The fields that can be amended are subject to the permission settings
against the Operator record (Labour>Employees).

Hold (or use F10): This toggles between (a) placing the current POS ‘On Hold’ and (b) viewing
current ‘held’ Quotes and Orders and restoring a selected Quote/Order to the Order Entry screen.

Lock (or use F11): This will lock the Station and no further entries or changes are possible until it
is ‘unlocked’ by entering the Operator/Password.

16.1.1 POSPayment

This screen allows you to enter payments against the current POS Order.   Access to this screen
is by keying F12 or clicking on the 'Pay' button in the main POS Screen.  Within this screen you
can:

· Take Payment for the current POS Order and print the Invoice
· Take Payment against a Layby Order and print a Payment Receipt
· Enter a Payment or Deposit against and post it to a Customer Account

Entry and Display fields

The displayed fields presented panel depend upon the Payment Style as set up in POS Rules: 
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There are two options:

· On Account
· Cash Sale

On Account Payment Style

Payment Style: Display only field showing the Payment Style

Sale Total: Display only field showing the Total of the lines in the main POS screen

Purchase Ref: Enter the Customer's Purchase Order reference.  Note: If the Customer
Master record says that a PO reference is Mandatory (Sales>Customer>Detail tab) then
this Reference would have been entered via the F4 Button in the main POS Screen.  It can
be amended here if required

Charge Amount: Display only field showing the Charge Amount due against this POS
Order.  This amount is evaluated from the Payment Method used.  Refer to File>Financial
Configuration>Payment Methods for more info)

Amount Due: Display only field showing the Amount due against this POS Order

Buttons

Back (or use Alt-F4): This will return you to the main POS screen

Print (or use F12): This will print the Invoice and post the Payment to the Customer's
Account

Cash Sale Payment Style

Payment Style: Display only field showing the Payment Style

Sale Total: Display only field showing the Total of the lines in the main POS screen

Rounding: Display only field showing the Rounding Amount taken from the current Payment Line
using the Rounding Factors specified in File>Financial Configuration>Payment Method
Denominations for this Payment method

Finance Charge: Display only field showing the Finance Charge Amount calculated from the
current Line Value using the Charge % defined against the Payment Method (File>Financial
Configuration>Payment Methods)

Amount Due: Display only field showing the Amount due against this POS Order

Date: The date of the payment line.  This is prefilled with the System Date but can be amended
from the drop-down calendar

Payment Method: Prefilled with the POS Default Payment Method but can be amended by either
selecting from the drop-down list or clicking on the appropriate button shown down the left of this
panel.

Value: Prefilled with the outstanding amount to be paid.  This can be amended to any other
amount as required.
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Reference: Open-format entry field where you can record specific reference applicable to the
current payment line

Total Received: Display only field showing the total value of the current payment entries.

Remaining Amount: Display only field showing the value yet to be paid against this sale.

Apply Change to Account: This checkbox is only visible if Total Received amount exceeds the
Amount Due.  When 'checked' the surplus amount is posted to the Customer's Account as a
Customer Payment record.

Change Due: Display only field showing the amount of change to be given if the 'Total Received'
amount is greater than the 'Amount Due'.

Buttons

Back (or use Alt-F4): This will return you to the main POS screen

Print (or use F12): This will print the Invoice (or Payment Receipt for Layby's).

Add (or use F5): This will complete the current payment line and add a new line

Delete(or use F8): This will delete the current Payment Line

16.2 POS Deliveries

This screen allows you to look at all POS Order Lines that are scheduled for Delivery then, for
selected lines, schedule and process the Delivery

List Tab

A single line is displayed for each Sales Line flagged as being scheduled for delivery

Sale No: Display only field showing the Sales Order Number allocated at the time the sale was
made. 

Sale Date: Display only field showing the Sales Date for the POS Order

Delivery Date: Display only field showing the required Delivery Date for the line in the POS Order

Billing Customer: Display only field showing the Customer held against the Sale No.

Display fields

The displayed fields are taken from the Item information maintained into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.
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Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Finished Deliveries - If this is checked then the displayed list will include those records
that have been delivered.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the POS Deliveries screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Related: This will bring up a list of functions that are related to the Delivery.  You may open and
maintain information in those screens whilst still remaining in the POS Delivery screen.

Reports: This will bring up a list of Reports that are related to the Delivery.  You can immediately
run the report whilst still remaining in the POS Delivery screen.

Detail Tab

Entry and Display fields

The upper portion of this screen shows the Customer and delivery details as entered into the POS
screen with any amendments made via the ‘Customer’ (F4) button in that screen.  This is display
only and shows

Billing Customer Name, Address and Contact details
Delivery Customer Name
POS Order Number and Line detail
Required Delivery Date

The following fields can be maintained against each record:

Delivery Addresses and Contact: The Delivery address fields, City, State, Code, Country,
Phone, Fax, Email Address, and Contact field.

Planned Delivery Date: This is the date when you plan to deliver this Sales line.  It is pre-filled
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with the Required Delivery.  You can amend this by selecting another date from the drop-down
calendar.

Shipping Reference: Open-format field for entry of a Shipping Reference (Example: Shipping
Docket).  No checks are made on this entry.

Goods Delivered: ‘Check’ this checkbox to denote that the goods have been delivered and
accepted by the Customer.

Actual Delivery Date: From the drop-down calendar select the date when this Sales Line was
actually delivered. 

Delivery Notes: You can enter unlimited amount of Notes that are related to this Delivery.
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the POS Deliveries screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the delivery line since the last time the ‘Save’ Button was pressed
will be lost.

Related: This will bring up a list of functions that are related to the Delivery.  You may open and
maintain information in those screens whilst still remaining in the POS Delivery screen.

Reports: This will bring up a list of Reports that are related to the Delivery.  You can immediately
run the report whilst still remaining in the POS Delivery screen.

16.3 POS Pickups

This screen allows you to look at all POS Order Lines that are scheduled for Pickup by the
Customer then process the record once it has been picked up

List Tab

A single line is displayed for each Sales Line flagged as being scheduled for Pickup

Sale No: Display only field showing the Sales Order Number allocated at the time the sale was
made. 

Sale Date: Display only field showing the creation date of the POS Order

Billing Customer: Display only field showing the Customer held against the Sale No.

Scheduled Pickup Date: Display only field showing the date when the POS Order Line is
scheduled to be picked up.

Actual Pickup Date: Display only field showing the date when the POS Order Line was actually
picked up.

Picked Up: Display only field showing the status of the Pickup
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Display fields

The displayed fields are taken from the Item information maintained into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Goods Picked Up - If this is checked then the displayed list will include those records that
have been collected by the Customer.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the POS Pickup screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Related: This will bring up a list of functions that are related to POS Pickup.  You may open and
maintain information in those screens whilst still remaining in the POS Pickup screen.

Reports: This will bring up a list of Reports that are related to the POS Pickup.  You can
immediately run the report whilst still remaining in the POS Pickup screen.

Detail Tab

Entry and Display fields

The upper portion of this screen shows the Customer and Pickup details as entered into the POS
screen with any amendments made via the ‘Customer’ (F4) button in that screen.  This is display
only and shows

Billing Customer Name, Address and Contact details
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Delivery Customer Name, Address and Contact details
POS Order Number and Line detail
Required Pickup Date

The following fields can be maintained against each record

Goods Picked Up: ‘Check’ this checkbox to denote that the goods have been collected by the
Customer.

Actual Pickup Date: From the drop-down calendar select the date when this Sales Line was
collected. 

Pickup Notes: You can enter unlimited amount of Notes that are related to this Pickup.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the POS Pickup screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the delivery line since the last time the ‘Save’ Button was pressed
will be lost.

Related: This will bring up a list of functions that are related to the Pickup.  You may open and
maintain information in those screens whilst still remaining in the POS Pickup screen.

Reports: This will bring up a list of Reports that are related to the Pickup.  You can immediately
run the report whilst still remaining in the POS Pickup screen.

16.4 POS Workshop

This screen allows you to look at POS Workshop Orders and maintain Work Instructions, Track
the Workshop Order, and add information that will appear on the Customer Invoice.

List Tab

A single line is displayed for each POS Order

Sale No: Display only field showing the Sales Order Number allocated at the time the Workshop
Order was rainsed. 

Sale Date: Display only field showing the creation date of the Workshop Order

Billing Customer: Display only field showing the Customer held against the Sale No.

Required Date: Display only field showing the date when the Workshop Order is required to be
completed

Display fields

The displayed fields are taken from the Item information maintained into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
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right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:
· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Work Finished  - If this is checked then the displayed list will include those Workshop
Orders that have been completed.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the POS Workshop screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Related: This will bring up a list of functions that are related to POS Workshop.  You may open
and maintain information in those screens whilst still remaining in the POS Workshop screen.

Reports: This will bring up a list of Reports that are related to the POS Workshop.  You can
immediately run the report whilst still remaining in the POS Workshop screen.

Detail Tab

Entry and Display fields

The upper portion of this screen shows the Customer and Pickup details as entered into the POS
screen with any amendments made via the ‘Customer’ (F4) button in that screen.  This is display
only and shows

Billing Customer Name and Contact details
Delivery Customer Name and Contact details
POS Workshop Order Number
Required Completion Date
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The following fields can be maintained against the Workshop Order

Reference: Prefilled with the Reference detail entered when creating the Workshop Order in the
POS Screen.  You may amend the information here if required

Tracking Code: From the drop-down list select the Tracking Code.  Tracking Codes are user
maintained (Sales>Settings>Sales Tracking) and enable you to track your Workshop Order and
filter views or reports by this Code.

Work Finished: ‘Check’ this checkbox to denote that the POS Workshop Order has been
completed.

Finished Date: From the drop-down calendar select the date when this Workshop order was
finished. 

Workshop Instructions: Display only field showing the instruction entered into the POS Screen
for this Workshop Order

Internal Workshop Notes: You can enter unlimited amount of Internal Workshop Notes that are
related to this Workshop Order.  These will appear on the Worksheet for this Order.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Customer Invoice Notes: You can enter unlimited amount of Customer Invoice Notes related to
this Workshop Order.  These will appear on the Customer’s Invoice for this Order.  Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the POS Workshop screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the Workshop Order since the last time the ‘Save’ Button was
pressed will be lost.

Related: This will bring up a list of functions that are related to the Workshop Order.  You may
open and maintain information in those screens whilst still remaining in the POS Workshop
screen.

Reports: This will bring up a list of Reports that are related to the Workshop Order.  You can
immediately run the report whilst still remaining in the POS Workshop screen.

16.5 POS Sessions

This screen is display only and shows the current active Stations using the POS function

Display fields

Site Name: The Site where the Station is located.  

Station ID: The ID reference of the active Station
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Employee Name: The name of the Employee currently assigned to the Station

Time Signed In: The date and time that the current session started

Data Display Options

Field Position - You can move the field position by dragging the column heading left or right to the
position where you want it to appear.

Filtering and Sorting - The displayed data is available for filtering and sorting:
· To sort the data in a selected column simply click on the column heading.  Clicking

against will sort in descending order.
· Click on the black ‘down arrow’ to the right of your selected column heading and you can

either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

OK: This will close the POS Sessions screen.  

16.6 POS End of Day

This screen is used to evaluate the End of Day account status of this Station.  Within this screen
you enter the individual amounts for each payment type currently in the till and Ostendo will
evaluate the closing balances and any variations that may be present.

You also have the option to run the End Of Day report as follows:

X Report:  This is a preview report of the end of day transactions and balances
Z Report:  This will ‘Post’ the included transactions to the General Ledger

Entry and Display fields

EOD No: This is system generated number that will cover this EOD activity.

Site Name: Display only field showing the Site where this Station is located

Station ID: Display only field showing the Station ID

Status: Display only field showing the current status of the EOD No

Start EOD Date and Time: Display only field showing the Date and Time when the current
Operator signed onto this Station

Closed EOD Date and Time: Display only field showing the Date and Time when the current
Operator signed out of this Station

Centre panel

The centre panel displays all the Payment Methods as entered into File>Financial
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Configuration>Payment methods that have been flagged as available to POS.  Against these
displayed lines the following fields and activities are available

Payment Method: Display only field showing the Payment Methods that are used in POS

Opening Float: You can enter the amount of Float that was made available to this session.  You
can either key the amount directly into this field or click on the drop-down spyglass icon and enter
the quantity per denomination.  Ostendo will then calculate the total

Till Balance: Display only field showing the calculated Till Balance taking into account all
transactions carried out since the Operator signed into this Station

Office Balance: Display only field showing the calculated amount resulting from the Cash Drop
(Out) and Cash Drop (In) values carried out since the Operator signed into this Station

Closing Balance: Enter the amount found in the Till at the End Of Day.  You can either key the
amount directly into this field or click on the drop-down spyglass icon and enter the quantity per
denomination.  Ostendo will then calculate the total

Variance: Display only field showing the variance evaluated from the previous fields.

Comments: You can enter a short comment relating to the entry if required.  This is held against
this line for your own information.

EOD Summary panel

This panel displays summary information about the current session and shows:

Opening Float: Sum of the ‘Opening Float’ amounts against the Payment Methods shown in the
centre panel

Till Balance: Sum of the ‘Till Balance’ amounts against the Payment Methods shown in the centre
panel

Office Balance: Sum of the ‘Office Balance’ amounts against the Payment Methods shown in the
centre panel

Closing Balance: Sum of the ‘Closing Balance’ amounts against the Payment Methods shown in
the centre panel

Under/Over/In Balance: Sum of the ‘Variance’ amounts against the Payment Methods shown in
the centre panel

Number of Sales: Total number of Sales made at this Station during this session

Number of No Sales: Total number of No Sales made at this Station during this session

Average Sale Value: Average value of Sales made at this Station during this session

Total Value of Sales: Calculated total value of Sales made at this Station during this session

Total Value of Payment: Calculated total value of Payments received at this Station during this
session

Buttons
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X Report: This will print a report of activities and balances carried out at this Station during the
current session.  This report is for information and assessment purposes and does not create any
financial journals

Z Report: This will create financial journals from this EOD session in addition to printing a report of
activities and balances.

Remove End Of Day: If you find that you have carried out further activity at the Station since
generating this EOD transaction then you should click on this button to remove the current display
as it will contain summary information that does not now apply.  If you then click on the End Of Day
button in the POS screen then a new EOD transaction will be generated taking into account the
new figures.

OK: If you click on this button then the current entries against this EOD session will be saved

Cancel: If you click on this button then any changes you have made since you last clicked the OK
button or entered this screen will be ignored.

16.7 POS History

This screen shows all the POS Orders that have been completed and had a payment receipt
printed from them.  You can reprint the Receipt if required

Display fields

The following fields are display only

Date: Date when the POS Order was created  

Time: Time of day when the POS Order was created  

Site Name: The Site where the POS Order was created

Station ID: The Station ID where the POS Order was created

Sale Number: The Order number against which the Invoice/Receipt was generated

Invoice Number: The Invoice number generated

Customer: The Customer to whom the sale was made

Sales Total Amount: The total amount of the Invoice

Operator: The Operator who took the Order

Data Display Options

Field Position - You can move the field position by dragging the column heading left or right to the
position where you want it to appear.

Filtering and Sorting - The displayed data is available for filtering and sorting:
· To sort the data in a selected column simply click on the column heading.  Clicking

against will sort in descending order.
· Click on the black ‘down arrow’ to the right of your selected column heading and you can

either select a specific entry to display all records containing that entry, or you can select
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(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the POS History screen.  

Re-Print Invoice: This will reprint the Invoice/Receipt  

16.8 Settings

16.8.1 POS Stations

This screen allows you to create and maintain POS Stations.  All POS transactions are recorded to
the Station where they were transacted.

Entry and Display fields

Computer Name: This is the name of the computer where Ostendo is located.  You can click on
the drop-down list and point to ‘My Network Places>Entire Network’ and drill down to find the
Computer Name.

Station ID: Using up to 3 AlphaNumeric characters, enter a Station ID.  This Identity must be
unique across the whole of Ostendo and not just within the Site Name.

EOD Station ID: If you wish more than one POS Stations to combine into a single EOD then, in up
to 3 AlphaNumeric characters, enter a Consolidation EOD ID.  The EOD process will now produce
one EOD for all POS Stations containing the same EOD Station ID

Description: Enter a short description of the Station.  No checks are made on this entry.

Site Name: From the drop-down list select the Site where the Station is located.  Sites are
maintained via General>Company Sites

Printer Name: From the drop-down list select the printer where the Receipt or Invoice Form is to
be printed

Print To: From the drop-down list select the way in which you want the Receipt ot Invoice form to
be output.  The options are:

· Printer: Output direct to Printer
· Screen: Output to screen from where you can further select the output media
· Prompt: Show the standard Ostendo output selection panel which shows Screen, Printer,

or Email options

Receipt Form Name: From the drop-down list select the Form (from the current Reports held
within Ostendo) that you will use for printing Payment Receipts

Invoice Form Name: From the drop-down list select the Form (from the current Reports held
within Ostendo) that you will use for printing POS Invoices

Default Sales Mode: From the drop-down list select the Default Sales Mode that will be used by
this Station.  The options are Retail, Workshop, or Layby
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Default Float Value: Enter the normal amount of cash that is allocated to this Station to form a ‘
Float’ whenever an Operator commences work at this station

Cash Drawer ESC Command: Enter the command that will activate the Cash Drawer whenever
the Payment is being recorded

Use Customer Display: ‘Check’ this checkbox if the Station uses an attached Pole Display to
enable the Customer to view the current Order total

Customer Display Com Port: Enter the COM Port that will be used by the Customer (Pole)
Display

Touch Pad File Name: Enter the full path (Example C:\Ostendo\TouchPad2.dat) to the location of
the .dat workflow file that you wish to display in the POS Screen

Default Order Style: From the dropdown list select the Order Style which will be used as the
default Order Style when creating a new POS order.  It may be amended in the POS screen and
made specific to that order.  The default options are:

· Order
· Quote
· Invoice

Buttons

Close: This will close the POS Stations screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will take you to a new line for creation of a new ‘Station’ record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the highlighted Station record.

16.8.2 POS Segmented Barcodes

This screen allows you to create and maintain POS Segmented Barcode formats.  
Segmented barcodes are normally used in retail environments which uses weighing scales like the
Wedderburn.
Such scales normally produces segmented barcodes which contains the product code and weight
or price of the purchase.

Entry and Display fields

Click Add button to add a record. Each record defines the format of the segmented barcode. 

Start Position of Code: Enter the starting position of the product code (or product barcode) here.

End Position of Code: Enter the ending position of the product code (or product barcode) here.

Start Position of Qty: Enter the starting position of the quantity value. This could be a weight or
price value.



941POS

End Position of Qty: Enter the ending position of the quantity value.

Barcode Length : Enter the total length of the segmented barcode.

Code Style: Options are : Product Barcode  or  Product Code .
Product Barcode means the code portion of the segmented barcode is a product barcode.
Product Barcode is often used when the actual itemcode or descriptor code are too long to fit into
the segmented barcode. 
Product Code means the code portion of the segmented barcode is the itemcode or
descriptorcode itself.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will take you to a new line for creation of a new record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the highlighted record.

16.8.3 POS Rules

This screen allows you to maintain POS Rules.  POS Rules allow you to define what rules, within
the Point of Sale area, you wish to apply.  The following rule settings are available

Entry and Display fields

Default Customer Name: From the drop-down list select the Customer Name that will become the
system default when creating POS orders

Display Line Detail: If this is ‘checked’ then the main POS screen will open with a panel showing
full details of each line being entered.  If it is not ‘checked’ then the basic entry information is
displayed.  You still have the option in the POS screen to toggle between these two displays.

Unit Prices Include Tax: If this is ‘checked’ then the unit prices displayed in the POS screen will
be the Tax-Inclusive price.  If not ‘checked’ then the Tax-Exclusive price will be shown

Round to Nearest: Enter the rounding amount to which the full order will be rounded to.  I.e. The
extended amounts against Individual lines will not be rounded but the total amount for the POS
Order will be rounded the nearest rounding factor entered here and based on the ‘Round Up From’
value entered in the next field.  See the next field for a further explanation.

Round Up From: Enter the amount around which the POS total amount will be rounded up or
rounded down.  For example:  Assuming the ‘Round to Nearest’ field is 0.05 and this field is set to
.03 then the following results will occur

0.00 No Action
0.01 Round down to 0.00
0.02 Round down to 0.00
0.03 Round up to 0.05
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0.04 Round up to 0.05
0.05 No Action
0.06 Round down to 0.05
0.07 Round down to 0.05
0.08 Round up to 0.10
0.09 Round up to 0.10

Layby Days: Enter the default number of days that will be used against Layby POS records to
define the expected date when the Layby will be fully paid and collected.

Layby Terms Text Code: This is descriptive text that outlines the Terms of the Layby and will be
printed on the Layby Documentation.  Select the Text from the drop-down List.   You can create
the Text via General>Frequently Used Text.  

Default Payment Method: From the drop-down list select the Default Payment Method that will
display on POS screen.  Payment methods are maintained via File>Financial
Configuration>Payment Methods.  In that screen you can define whether the method uses the
above rounding logic

Payment Method used for Cash: During day-to-day activities you may take cash for
miscellaneous transactions (Example: Purchase milk, Office Stationery, etc.); effectively using it
as ‘Petty Cash’.  You can record drawings and receipts of this ‘Petty Cash’ which will be allocated
to this Payment Method for posting and reconciliation purposes.

Scanning Mode: If this is ‘Checked’ then the POS will immediately go to the next line after the line
’s barcode has been scanned.  I.e. An order quantity of 1 is assumed.  If the quantity is not equal
to 1 then you should click on the F9 (Edit Line) button and make the amendment there.

Customer Selection Style: From the drop-down list select the method by which Customers are
selected in Point Of Sale.  The options are:

Default Customer: Always prefilled with the Default Customer Name identified above.
This would normally be used in the true POS environment where the Customer is (say) the
general public
Customer Lookup: The POS entry screen is fronted with Ostendo’s Customer List screen
for selection of a Customer before the POS Order can progress.  This style would normally
be used where all the Customers are currently held on fileMembership Number: The
POS entry screen is fronted with a panel that requires entry of a Customer’s Membership
Number.  On acceptance of the Membership Code the linked Customer is displayed in the
POS Order screen.   

Customer Required For Value: If you enter a value here then you will not be allowed to proceed
through Payments processing if the POS Order value exceeds this amount unless the Customer is
other than the above 'Default Customer'.  This ensures that Customer specific information is
retained for where an Order value exceeds this amount

Default Payment Style: From the drop-down select the payment style that will be the default that
appears in the POS Payments screen.

New Sale Sign-in: If this flag is 'checked' then the user must sign in for every sale.  This is useful
where there is one POS station that is used by multiple Sales personnel.

No Reprint Prompt: During the payment process you are required to print a Receipt or Invoice.
Upon printing the document this field is assessed for the following

· If it is is not 'checked' then a panel will appear asking if the document printed correctly.  If
the answer is 'No' then it will be re-printed.  If the answer is 'Yes' then the transaction will be
posted and you can continue with the next sale
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· If it is 'checked' then the transaction will be posted and you can immediately continue with
the next sale.  If you subsequently wish to reprint the document you should click the 'POS
History' button (Ctrl-7), select the document in the presented panel and click the 'Reprint
Invoice' button.  Note: If you cannot see the 'POS History' button then the POS settings in
the Employee's Master record (Labour>Employees) has excluded this option.

No Change Given for Zero Sales: If this flag is 'checked' then the POS Operator cannot hand out
change from the till if there is a zero Sale.

No EOD Bank Deposits: If this flag is not 'checked' then the POS EOD process will automatically
create a Bank Deposit whenever a 'Z' Report is generated.  If this flag is 'checked' then the no
Bank Deposit will be generated.  In this instance the Bank Deposit must be manually created via
Sales>Bank Deposits.  This feature enables you to select multiple EOD's into a single Bank
Deposit 

Back Orders Activated: If this flag is 'checked' then Ostendo allows the following (if a POS
transaction is entered as an Order first):

· An Order can be selected (from On Hold) and if the Style is changed to Invoice, the user
has the ability to enter override the the original Qty   

· If there are back order quantities remaining, a new POS order is automatically
generated for those lines (using the original POS number with a suffix of ‘-#’) with a style
of Order.    

Select Payment Method: If this flag is 'checked' then a list Payment methods is displayed with
selection buttons to select a specific method before displaying the POS Payment screen.

Allow Invoice Confirmation Print: If this flag is 'checked' then the POS user may print an Invoice
confirmation.

Allow Warehouse Override : Tick this box if you want to allow the warehouse to be changed in
the POS Lines screen (Override Warehouse Code). 

Create Bank Deposit by Station : Tick this box if you wish to create bank deposits by station ID.

Allow Creation of Sales Deposits : Ticking this box will allow user to take a deposit from within
POS and link it to a Sales Order.

Allow Creation of Job Deposits : Ticking this box will allow users to take a deposit from within
POS and link it to a Job Order.

Allow Application of Account Payment : Ticking this box allows users to not only receive an On
Account payment, but further allows him to apply it to any outstanding invoices on that customer's
account. NB: If the POS user does not have user securty access to Customer Payments, they will
not be able to apply the payment even if this rule is turned on.  

Buttons

Close: This will close the POS Rules screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
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pressed will be lost.
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17 Service

17.1 Customer Assets

This screen allows you to define Customer Assets. These Assets can be created directly or from
Item Sales.  The created Asset can then be linked to Service Jobs from which a complete Service
History is maintained.

Parent-Child relationships can also be defined for Customer Assets. This is done in the Customer
Asset Hierarchy screen. 

Ostendo Freeway can now help facilitate the servicing of multiple assets at a customer site.
For a full description of how to set this up, please refer to : Freeway Multi Asset Servicing

List Tab

This panel displays Assets that are owned by Customers.  For more information either double click
on the Asset or simply highlight the Asset and then click the ‘Detail’ tab

Display fields

Asset Name: Display only field showing the name of the Asset as entered into the ‘Detail’ panel.

Asset Number: Display only field showing the unique identity that was given to this Asset

Description: Display only field showing a brief description of the Asset.

Status: Display only field showing the current status of the Asset.  The available statuses are
Active and In-Active.

Customer: Display only field showing the owner of this Asset as maintained in the ‘Detail’ panel.

Asset Type: Display only field showing the type of Asset as entered into the ‘Detail’ panel.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Assets whose
status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

http://ostendo.info/downloads/ostendo/Freeway_Multi_Asset_Servicing_Explained.pdf
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Close: This will close the Customer Assets screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a panel that allows you to create a new Customer Asset ‘from scratch’ or ‘
by copy’.  The following fields are available for data entry

Create Asset from scratch - select this ‘Radio Button’ if you are creating a Customer
Asset from scratch.  The next field will be available for you to enter the new Asset Name. 
Upon clicking the ‘Create’ Button this entry will be checked to ensure that it does not
currently exist in Ostendo

New Customer Asset Name - In up to 50 characters enter the identity of the new
Customer Asset

Copy Asset from another - select this ‘Radio Button’ if you are creating a Customer
Asset by copying details of an existing Asset.  

Customer Asset to be copied - From the drop-down list select the Customer
Asset to be copied 
New Customer Asset Name - In up to 50 characters enter the identity of the new
Customer Asset.  This must not currently exist in Ostendo
Asset Number - Enter the identifying number of the Asset.  This will be copied to
the new Customer Asset
Copy the Planned Schedule - ‘Check’ this checkbox if you wish the Servicing
Schedule of the current Asset is to be copied to the New Customer Asset. 
 (Button) Create - Clicking this button will validate the above details before
generating the new Customer Asset and taking you to the Customer Asset ‘Detail’
screen 
(Button) Cancel - This will ignore any entries and exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Customer Asset from this table

Related: This will bring up a list of functions that are related to the Customer Asset.  You may
open and maintain information in those screens whilst still remaining in the Customer Asset
screen.

Reports: This will bring up a list of Reports that are related to the Customer Asset. You can
immediately run the report whilst still remaining in the Customer Asset screen.

Detail Tab

Entry and Display fields

Asset Name: Entry is only allowed during an Add transaction.  Enter the name of the new Asset.  
Duplicate Asset names are not allowed

An Asset Name can also represent a collection of assets. For example a customer
Site can be treated as an Asset which contains many assets.

Status: Select the current status from the drop-down list.  The options are ‘Active’ or ‘Inactive’

Description: Enter a brief description of the Asset.  A longer description can be entered into the
Notes (see below)

Asset Number: This is an open format field where you can enter any unique identifier for this
Asset.   No validation checks are carried out.
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Asset Type: Select the Asset Type from the drop-down list.  Asset Types are user-maintained my
either clicking on the icon to the right of this field or selecting Service>Settings>Customer Asset
Types.

Customer: From the drop-down list select the Customer to which the Asset belongs.  Customers
are user-maintained under their own screen under the Sales toolbar.

Asset Tracking Information

Asset currently at: Display only field that shows where the Asset is located.  The display options
are:

· Company Site
· Customer Site
· Supplier Site

The Asset’s movement history can be maintained by pressing the adjacent ‘Asset Tracking’
Button.

(Button) Asset Tracking: This brings up a separate screen for maintenance of the Asset’s
Location.  See ‘Customer Asset Tracking’ page (below)

Asset Origination

From: Display only field that shows from where the Asset originated  The display options are:
· Job - Created via the Job Order process
· Sales - Created via the Sales Order process
· Manual - Manually created in this Service Module
· Linked - Created via a Company Asset-Customer Asset link

Source Reference: Display only field showing the Job Order Number, Sales Order Number,  or
manually entered reference

Creation Date: Display only field showing the date that the Asset was created.

Asset Readings

Primary Reading Name: Select the primary Reading Name for this asset. This will be the default
Reading Name used for this asset.

Warranty Info

Warranty Expiry: This is a display only field. This shows the latest Warranty Expiry date (if there
are multiple valid warranties).

Warranty Status: This is a display only field. Possible values are "Out of Warranty", "In Warranty
", "N/A" (not applicable - when there are no valid warranties for this asset).

Customer Specific Information Tab

Location at Customer Site: This shows where - at the Customer’s Site - the Asset is currently
located.  Select the location from the drop-down list of available locations.  Note: A Warehouse can
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be linked to a Customer (Inventory>Warehouses) and within that Warehouse you can define
multiple Locations (Inventory>Locations).  These Locations are visible in this drop-down list.

Service Zone: From the drop-down list select the Service Zone in which this Asset is located.
This would then facilitate scheduling of Services for all Assets within the Service Zone.  Service
Zones are user-defined (via Service>Settings>Service Zones).  

Customer Requires Confirmation of planned servicing: If the Customer requires prior
notification of a scheduled service event the ‘check’ this checkbox.  The following three fields will
become active for entry of further information.

Days Notice required: Enter the number of days prior to a scheduled service event when this
Customer requires notification.  If nothing is entered then zero days is assumed.

Reminder Style: From the drop-down list select the format by which the reminder will be sent to
the Customer.  The options are email, phone or letter

Contact: Enter the name of the contact at the Customer site.  You may either manually key in the
Contact Name or select the name from the drop-down list of contacts held against this Customer.  
Contacts for the Customer are maintained under Sales>Customers>’Related’ Button

Confirmation Text: If the ‘Reminder Style’ is Email then - from the drop-down list - select the
Confirmation Text that will be used to send the reminder.  Confirmation Texts are maintained via
Service>Settings>Confirmation Text

Linked Company Asset

Asset Style:  From the dropdown list select either Customer or Company

Company Asset:  If Asset Style selected is “Company”, select the linked Company Asset. If the

Company Asset is already linked to another Customer Asset, saving this new link will de-link the

Company Asset from its previous Customer Asset. A Customer Asset can only be linked to one

Company Asset and vice versa.

Linked Service Type

Service Type:  From the dropdown list select one of the Asset Service Types. Linked Service

Type is used to group various assets under a common Service Type.

Group Service Asset :  Tick this box to indicate that this asset is a Group Service Asset
representing multiple assets.

Additional Fields Tab

If you have defined Additional Fields against the Customer Asset (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
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· Time: Displays format HH:MM:SS for entry of a time of day
  

General Notes: You can enter unlimited amount of General Notes that are related to this Asset.
These notes will be available wherever the Asset is reported.  Whenever you click on this field an
icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.  Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

Service Notes: You can enter unlimited amount of Service Notes.  For example; any access
restrictions to the Asset, or any formal Security processing, etc. 

Buttons

Close: This will close the Customer Asset screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.
Add: This will bring up a panel that allows you to create a new Customer Asset ‘from scratch’ or ‘
by copy’.  The following fields are available for data entry

Create Asset from scratch - select this ‘Radio Button’ if you are creating a Customer
Asset from scratch.  The next field will be available for you to enter the new Asset Name. 
Upon clicking the ‘Create’ Button this entry will be checked to ensure that it does not
currently exist in Ostendo

New Customer Asset Name - In up to 50 characters enter the identity of the new
Customer Asset

Copy Asset from another - select this ‘Radio Button’ if you are creating a Customer
Asset by copying details of an existing Asset.  

Customer Asset to be copied - From the drop-down list select the Customer
Asset to be copied 
New Customer Asset Name - In up to 50 characters enter the identity of the new
Customer Asset.  This must not currently exist in Ostendo
Asset Number - Enter the identifying number of the Asset.  This will be copied to
the new Customer Asset
Copy the Planned Schedule - ‘Check’ this checkbox if you wish the Servicing
Schedule of the current Asset is to be copied to the New Customer Asset. 
 (Button) Create - Clicking this button will validate the above details before
generating the new Customer Asset and taking you to the Customer Asset ‘Detail’
screen 
(Button) Cancel - This will ignore any entries and exit this panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related:     This will bring up a list of functions that are related to the Customer Asset.    You may
open and maintain information in those screens whilst still remaining in the Customer Asset
screen.

Reports:     This will bring up a list of Reports that are related to the Customer Asset.   You can
immediately run the report whilst still remaining in the Customer Asset screen.

Planning and History Tab
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Display fields

This screen shows the full Service History for the selected Customer Asset in addition to the Asset’
s current Servicing Schedule, Invoicing Schedule, and Warranty records.

Upper Panel

Order Type: Display only field showing the Type of Job Order that was used to carry out this
service.

Order No: Display only field showing the Job Number against which the Service was carried out.
You may 'right mouse' on the Job Number to bring up the Job details

Order Date: Display only field showing the date when the Service was carried out

Status: Display only field showing the current status of the Job taken from the Job record

Planned Cost: Display only field showing the Planned Cost of the Order

Invoiced Nett Value: Display only field showing the invoiced nett value

Actual Cost: Display only field showing the Cost of the Order

Planned Servicing Tab

This shows the current servicing schedule.  It can be created by adding each line individually or by
using the ‘Service Plans’ button just above this panel.  If you choose to use the Service Plans then
click on the button and select the Service Plan; enter the effective ‘From’ date and click on the ‘
Create Lines from the Service Plan’ button.  This will generate a servicing schedule based on the
contents of the Plan

Planned Date:  The date when the Service is planned.  You can amend the date by overtyping it or
selecting the date from the drop-down calendar.  

Job Type: The planned Job Type that will be used to carry out the Service.  You can amend this
by selecting an alternative Job Type from the drop-down list.  Job Types are maintained via
Jobs>Settings>Job Types

Template: The planned Job Template that will be used to carry out the Service.  You can amend
this by selecting an alternative Job Template from the drop-down list.  Job Templates are
maintained via Jobs>Templates

Confirmation Status: The current status of this planned Service.  The options are Confirmed or
Not-Confirmed.  If you wish to change this status then select the alternative from the drop-down
list.

Reminder Sent: Display only field showing if the Reminder Notification has been sent or not.  
This is automatically updated whenever the Reminder is generated.  

Reminder Date: Display only field showing the Date when the Reminder Notification was sent.
This is automatically updated with the system date when the Reminder was generated.  

Reminder Contact: Contact can be selected from the drop-down list. 

Confirmed Date: The date when the Planned Service was scheduled
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Recurring and Predictive Servicing Tab

Recurring and Predictive Servicing is an additional or alternative way to plan servicing schedules.
While Planned Servicing is based on a service plan for a defined period, Recurring/Predictive
Servicing is open-ended. The elements that make up Recurring and Predictive Servicing is as
follows:

Recurring Style:  The recurring style is either Frequency or WeekDay or Fixed. 
Frequency means the service event is repeated based on a set period of

days or weeks or months. 
WeekDay means the service event needs to occur on a particular

weekday (Mondays to Sundays) of the month.
Fixed means the service event needs to occur on a particular day (1 - 31)

of the month. 

Day of Month:  This is applicable to WeekDay style only. Select from one of the drop-down list.
(Example: First Monday of the month; or 3rd Wednesday of the month; etc...)

Fixed Day Number:  This is applicable to Fixed style only. Choose from 1 to 31. If a particular
month does not have that day (e.g. 31) then it will use the nearest day (for example 28 or 30). 

Frequency Period:  For Frequency Style, this can be Days or Weeks or Months. For WeekDay
and Fixed styles, this will be Months.

Recurring Frequency:  Enter a number for the recurring frequency. Recurring Frequency number
and Frequency Period together defines the frequency of the recurring service.

Predictive Style:  Predictive event can be included with Frequency Style only. For example, the
recurring service can be based on every 6 months (Frequency) or 20000KM travelled (Predictive
event). Predictive Event is defined by the Reading name and the Reading Cycle.

    To add predictive event to the Frequency style, select "Include Predictive
Event"; else select "No Predictive Event".

Reading Name:  Select the applicable Reading Name for the Predictive Event. Reading Names
are defined in Customer Asset Details - Related screen.

Reading Cycle:  Enter the value of the Reading - example: 20000 km or 50000 copies, etc...

Job Type:  The planned Job Type that will be used to carry out the Service.  You can amend this
by selecting an alternative Job Type from the drop-down list.  Job Types are maintained via
Jobs>Settings>Job Types

Template:  The planned Job Template that will be used to carry out the Service.  You can amend
this by selecting an alternative Job Template from the drop-down list.  Job Templates are
maintained via Jobs>Templates

Last Event Date:  Display only field showing the Date when the Last Service event occurred.  This
will be automatically updated when the last service is finished. 

Nearest Working Day:  Tick this box to use the Nearest Working Day to schedule actual date of
next recurring service event.

Recurring Invoices Tab

This shows the recurring Service Support Contracts that exist against this Asset.  Support
Contracts are created under Sales>Recurring Invoices where the Contract is linked to this Asset. 
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This is for information only and the following fields are shown
Contract Number: The Service Support Contract Number
Status: Current Status of the Service Support Contract
Contract Start: Date when the Contract begins
Contract End: Date when the Contract ends
Description: Description of the Service Support Contract

Linked Warranties Tab

This shows the Warranties that apply to this Asset.  Warranties are maintained under
Service>Warranty Definitions and are attached to an Asset when the Asset is sold in the Sales
function
This is for information only and the following fields are shown

Warranty Number: The Warranty Reference
Description: Description of the Warranty
Warranty Start: Date when the Warranty begins
Expiry Date: Date when the Warranty ends

Equipment Tab

This shows the list of equipment that is associated with this Asset. (example list of air-conditioners
as a site). This list can be maintained by adding or deleting records to it. The fields are as follows:

Seq: The sequence number (increase by 10 with each added line).
Name: The name of the equipment.
Type: The type of the equipment.
Serial No: The serial number of the item.
Manufacture Date: The date of manufacture.
Refurbish Date: The date refurbished.
Last Check Date: Date last checked.
Next Check Date: The next Check Date.
Expiry Date: The expiry date of the equipment.
Location: The location of the equipment.
Model Info: The model information of the equipment.
Notes: Enter relevant notes here.
Reading Value: Current reading value.

Maintenance History Tab

This shows the maintenance history of this Asset. 
Maintenance Date: Displays the date of maintenance performed.
Style Name: Shows the Style Template used.
Style Description: Shows the Style template description.
Employee: Shows the Employee name who performed the maintenance work.
Mobility Sheet ID: Shows the Service Sheet ID generated.
Maintenance Notes : Shows the notes recorded during maintenance work.

Buttons

Close:     This will close the Customer Asset screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add:     This will bring up the ‘Detail’ tab for entry of a new Customer Asset
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Save:     Not applicable to the History panel

Cancel:     Not applicable to the History panel

Delete:     Not applicable to the History panel

Related:     This will bring up a list of functions that are related to the Customer Asset.    You may
open and maintain information in those screens whilst still remaining in the Customer Asset
screen.

Reports:     This will bring up a list of Reports that are related to the Customer Asset.   You can
immediately run the report whilst still remaining in the Customer Asset screen.

17.1.1 Customer Asset Properties

This screen allows you to define properties that are specific to a Customer Asset.  Property titles
are user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Customer Assets.

Display fields

The displayed fields are taken from the Customer Asset Details.  The selection of which fields to
display here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Assets Properties screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.
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Add: This will bring up the ‘Detail’ tab for entry of Customer Asset Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Asset Name: Display only field showing the Customer Asset selected in the List screen

Description: Display only field showing the description of the Customer Asset selected in the List
screen

Status: Display only field showing the status of the Customer Asset selected in the List screen

Customer: Display only field showing the Customer that owns this Asset.

Asset Type: Display only field showing the Asset Type as held against the Customer Asset record.

Property: From the drop-down list select the Standard Property against which a value specific to
this Asset will be made.

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Copy to Jobs: If this checkbox is ‘checked’ then this property will be copied to a Job Order along
with the Asset

Buttons

Close: This will close the Customer Asset Properties screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Customer Asset Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Customer Asset Property record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: This enables you to delete the selected Customer Asset Property record.
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17.1.2 Customer Asset Documents

This screen allows you to define documents, etc that are specific to a Customer Asset.    

List Tab

Display fields

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Customer Asset to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Assets Documents screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Customer Asset Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Customer Asset

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name that you are calling the document in this Document - Customer
Asset linkage.    No checks are made on the entry.

Document Type: Prefilled with ‘Customer Asset’
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Linked to: From the drop-down list select the Customer Asset that uses this document

Copy to Jobs: If this checkbox is ‘checked’ then this document will be copied to a Job Order along
with the Asset

Print / Email with order: Tick this box if this document is to be printed/emailed with the Order.

Print / Email with quote: Tick this box if this document is to be printed/emailed with the quote.

Correspondence: Tick this box if this document is to be treated as correspondence in the
Operations Centre.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Customer Assets Documents screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Customer Asset Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Customer Asset Documents record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

17.1.3 Customer Asset Images

This function allows you to link Images to a Customer Asset.    

List Tab

Display fields

Image Name: The name of the Image as entered into the Details screen,

Linked To: This is the specific Customer Asset to which this Image relates.

File Name: This is the full path name of the Image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Assets Images screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Customer Asset Images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Image from a Customer Asset

View: If you select a line and then this button the Image will be displayed using your default Image
display software. 

Detail Tab

Entry and Display fields

Image Name:  Enter the name that you are calling the Image on this Image - Customer Asset
linkage.    No checks are made on the entry.

Image Type: Prefilled with ‘Customer Asset’

Linked to: From the drop-down list select the Customer Asset that uses this Image

Image Details: locate the full path name of the Image.  It should be noted that the file extension
must be an image format (I.e. .jpg, .bmp, .ico, .wmf, .emf)

Preview: The selected Image is displayed for your reference

Buttons

Close: This will close the Customer Assets Image screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of an Customer Asset Image record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Customer Asset Image record or the last time the ‘Save’
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Button was pressed will be lost.

Delete: Not applicable to the Detail panel

17.1.4 Customer Asset History Notes

This function allows you to link multiple time-stamped notes to a Customer Asset.    

List Tab

Display fields

The displayed fields are taken from the Customer Asset master record.  The selection of which
fields to display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in
the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Asset History Notes screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Customer Asset to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.
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Reference: A short description of the entry.  No validation checks are carried out.

Mobile Employee : Select the Mobile employee name to make this History Note available to that
employee.

Classification: From the drop-down list select a Classification under which you wish to store this
History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.  Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History: The Notes history against this Customer Asset is displayed in the lower part of the
screen.   Each record will also have the first 3 lines of the notes displayed.  To view the full Notes
simply click on the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Customer Assets History Notes screen.  If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Customer Asset History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Customer Asset History Notes record or the last time
the ‘Save’ Button was pressed will be lost.

Delete: Not applicable to the Customer Asset Notes Detail panel

17.1.5 Customer Asset Readings

This screen enables you to create and maintain Asset Readings.   Each Detail record reflects the
value of the latest reading and is used a basis when creating a Usage Billing Invoice via the Batch
Invoicing screen (Sales>Batch Invoicing).   The generated Invoice number is then added to the
Reading record.

List Panel
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Display fields

Asset Name: Display only field showing the Asset Name taken from the Customer Asset master
file.

Asset Number: Display only field showing the Asset Number as held against the Customer Asset
record.

Status: Display only field showing the status of the Asset as held against the Customer Asset
record.

Description: Display only field showing the description of the Asset as held against the Customer
Asset record.

Customer: Display only field showing Customer that owns the Asset.

Asset Type: Display only field showing the Type of Asset as held against the Customer Asset
record.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Asset Reading screen. If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Customer Asset Reading.

Related: This will bring up a list of functions that are related to the Customer Asset Reading. You
may open and maintain information in those screens whilst still remaining in the Customer Asset
Reading screen.

Detail Tab

Entry and Display fields

Reading Name: From the drop-down list select the Reading Name.   Reading Names for the
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Asset are maintained via the Related Menu in the Customer Asset screen

Reading Type: Display only field showing the Reading Type held against the Reading Name.

Reading Value: Enter the current Reading against this Readings Name.

Reading Date:  This is prefilled with the system date.  You can amend the date by either
overtyping the date or selecting the date from the drop-down calendar.

Invoice Number: This field is system maintained.  Whenever this reading has been used for
Usage Billing then the generated Invoice Number will be displayed here.

Notes: You can enter unlimited amount of Notes that are related to this Reading.  Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record

Buttons

Close: This will close the Customer Asset Reading screen. If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Customer Asset Reading.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current Customer Asset Reading from this table but only if it has NOT
been billed.

Related: This will bring up a list of functions that are related to the Customer Asset Reading. You
may open and maintain information in those screens whilst still remaining in the Customer Asset
Reading screen.

17.1.6 Customer Asset Reading Names

This screen is accessed via the Related Button of the Customer Asset screen.

This screen enables you to create and maintain Asset Reading Names.   Each name is a unique
identifier against which ongoing readings are accumulated.   The readings can optionally be used
to Invoice a Customer if this Asset Reading Name is flagged as being used for Usage Billing.

List Panel

Display fields

Asset Name: Display only field showing the Asset Name taken from the Customer Asset master
file.

Asset Number: Display only field showing the Asset Number as held against the Customer Asset
record.

Status: Display only field showing the status of the Asset as held against the Customer Asset
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record.

Description: Display only field showing the description of the Asset as held against the Customer
Asset record.

Customer: Display only field showing Customer that owns the Asset.

Asset Type: Display only field showing the Type of Asset as held against the Customer Asset
record.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Asset records
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Customer Asset Reading Name screen. If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Customer Asset Reading Name.

Related: This will bring up a list of functions that are related to the Customer Asset Reading
Name. You may open and maintain information in those screens whilst still remaining in the
Customer Asset Reading Name screen.

Detail Tab

Entry and Display fields

Reading Name: Enter a Reading Name.  Duplicates not allowed.  This Reading Name represents
a piece of equipment against which readings are maintained.  These readings may then be used to
bill a Customer .

Description: Enter a brief Description of the Reading Name.  No checks are made on this entry

Reading Type: Enter the Type of reading being taken.  This would then facilitate reporting against
all Reading Names within a Reading Type.  Reading Types are maintained via Service
>Settings>Customer Asset Reading Types
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Initial Reading: If, at the time of using the Reading Name the initial value is not zero then enter
that reading here.  Ostendo will then use that as the initial value for starting Usage Billing

Latest Reading:  This is a display only field as it is maintained from entries made in the Customer
Asset Readings screen 

Usage Billed: If this Reading Name is being used for Usage Billing then 'check' this checkbox.

Buttons

Close: This will close the Customer Asset Reading Name screen. If you have any unsaved data
then you will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Customer Asset Reading Name.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current Customer Asset Reading Name from this table

Related: This will bring up a list of functions that are related to the Customer Asset Reading
Name. You may open and maintain information in those screens whilst still remaining in the
Customer Asset Reading Name screen.

17.1.7 Customer Asset Hierarchy

The Customer Asset Hierarchy function allows you to link one or more ‘Child’ assets to a parent ‘
Asset’ and view the Parent/Child relationships as required.

List Tab

Display fields

Asset Name: Display only field showing the Customer Assets that are currently in Ostendo

Asset Number: Display only field showing the Asset Number (from the Customer Asset record)

Description: Display only field showing the description of the Customer Asset

Status: Display only field showing the current status of the Asset

Customer: Display only field showing the Customer that owns the Customer

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
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against will sort in descending order.
· Click on the black ‘down arrow’ to the right of your selected column heading and you can

either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Asset Hierarchy screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will take you to the ‘Details’ screen for entry of a new Hierarchy record.

Save: Not active in this view

Cancel: Not active in this view

Delete: This will delete the highlighted Asset Hierarchy record

Detail Tab

Entry and Display fields

Asset Name: Display only field showing the name of the Customer Asset

Asset Number: Display only field showing the Asset Number (from the Customer Asset record)

Description: Display only field showing the description of the Customer Asset

Customer: Display only field showing the Customer that owns the Asset

Child Assets section: 
Use this section to link child assets to the above-name Asset. Click Add button to add Child Asset
line.

Child Asset: The drop-down list will show the list of Customer Assets belonging to the same
customer. Select one of them to be the Child Asset.  This will be checked to ensure that it does not
currently exist as a Child against another Asset.

Description: Display only field showing the description of the Child Asset.  

Notes: An extended description can be added to the Hierarchy record.  No checks are made on
the entry. 

Buttons

Close: This will close the Asset Hierarchy screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank line for entry of a new Child Asset record.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made to the record or the last time the ‘Save’ Button was pressed will be
lost.

Delete: Delete the highlighted record

Hierarchy Tree Tab

This panel shows, for the selected Customer Asset, all Child Assets that are linked to it.  This is a
multi-level display and shows the complete hierarchy where the Child Asset itself contains Child
Assets, etc

Buttons

Close: This will close the Asset Hierarchy screen. 

Add: Not active in this panel

Save: Not active in this panel

Cancel: Not active in this panel

Delete: Not active in this panel

17.1.8 Customer Asset Tracking

This screen allows you to maintain a tracking history file of each Customer Asset.  This also
provides information relating to the current location of all the Assets owned by Customers.

List Panel

Display fields

Asset Name: Display only field showing the Asset Name taken from the Customer Asset master
file.

Asset Number: Display only field showing the Asset Number as held against the Customer Asset
record.

Description: Display only field showing the description of the Asset as held against the Customer
Asset record.

Status: Display only field showing the status of the Asset as held against the Customer Asset
record.

Customer: Display only field showing Customer that owns the Asset.

Type: Display only field showing the Type of Asset as held against the Customer Asset record.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Inactive Status - If this is checked then the displayed list will include those Asset records
whose status is ‘Inactive’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Company Asset Tracking screen.

Detail Panel

Display fields

Asset Name: Display only field showing the Asset Name taken from the Asset Register

Status: Display only field showing the status of the Asset as held against the Asset record.

Customer: Display only field showing the owner of the Asset.

Description: Display only field showing the description of the Asset as held against the Customer
Asset record.

Asset Number: Display only field showing the Asset Number as held against the Customer Asset
record.

Type: Display only field showing the Type of Asset as held against the Customer Asset record.

Movements and History

Data Entry fields

Date Out: The date when the Asset was moved to the new location.  This is prefilled with the
system date but can be amended by keying in the revised date or selecting it from the drop-down
calendar.

Time Out: The time of day when the Asset was moved to the new location.  This is prefilled with
the system time but can be amended by keying in the revised time.

Where: From the drop-down list select the type of location where the Asset is located.  The options
are:

· Customer Site
· Supplier Site
· Company Site

Comments: An optional entry field for entry of comments relating to this tracking record.
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Buttons

Close: This will close the Customer Asset Tracking screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Tracking record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Tracking record.

17.2 Warranty Definitions

This screen allows you to maintain Warranty Definitions.   These provide details of what is
contained in a Warranty ‘Template’ and is used as the basis for applying a specific Warranty to a
Customer Asset

List Tab

Display fields

Warranty Code: The Warranty Code as entered into the ‘Detail’ tab.   

Description: Description of the Warranty taken from the warranty record.   

Term: This is the length over which the Warranty will be in force

Term Unit: This, in association with the above Term defines the period of coverage of this
Warranty.  You should note that the commencement date is only applied when it is attached to a
Customer Asset

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Warranty Definitions screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.
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Add: This will bring up the ‘Detail’ tab for entry of a new Warranty Definition.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Warranty Definition from this table

Related: This will bring up a list of functions that are related to the Warranty Definition.  You may
open and maintain information in those screens whilst still remaining in the Warranty Definition
screen.

Reports: This will bring up a list of Reports that are related to the Warranty Definition.  You can
immediately run the report whilst still remaining in the Warranty Definition screen.

Detail Tab

Entry and Display fields

Warranty Code: Entry is only allowed during an Add transaction.   Enter the name of the new
Warranty Definition.   Duplicate Warranty Codes are not allowed.

Term: Enter the number of days or months that this Warranty will be in force

Time Unit: From the drop-down list select whether the above Terms apply to ‘Days’ or ‘Months’

Description: Enter a brief description of the Warranty Definitions.  No validation checks are
carried out on this entry.

Warranty Covers:  From the drop-down list select the coverage of this Warranty.  The options are:
· Labour and Parts 
· Labour Only
· Parts Only
· See Detailed Cover

Detailed Cover: If the ‘Warranty Covers’ selection is ‘See Detailed Cover’ then the content of this
field describes that coverage.  No validation checks are made on this entry.

Any Warranty Exclusions: Enter any exclusions that may not be covered under the broad
coverage covered above.  This will print on the appropriate documents.

Notes: You can enter unlimited amount of Notes that are related to this Warranty Definition.
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.   Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Warranty Definition screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen
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Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Warranty Definition.  You may
open and maintain information in those screens whilst still remaining in the Warranty Definition
screen.

Reports: This will bring up a list of Reports that are related to the Warranty Definition.  You can
immediately run the report whilst still remaining in the Warranty Definition screen.

17.3 Service Plans

This screen allows you to maintain Service Plans.   These provide a template for generating
Servicing Schedules against Customer Assets

List Tab

Display fields

Service Plan Code: The Service Plan Code as entered into the ‘Detail’ tab.   

Description: Description of the plan taken from the Service Plan record.   

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Service Plan screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Service Plan.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Service Plan from this table
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Related: This will bring up a list of functions that are related to the Service Plan.  You may open
and maintain information in those screens whilst still remaining in the Service Plan screen.

Reports: This will bring up a list of Reports that are related to the Service Plan.  You can
immediately run the report whilst still remaining in the Service Plan screen.

Detail Tab

Entry and Display fields

Service Plan Code: Entry is only allowed during an Add transaction.   Enter the name of the new
Service Plan Code.   Duplicate Codes are not allowed.

Description: Enter a brief description of the Service Plan.  No validation checks are carried out on
this entry.

Notes: You can enter unlimited amount of Notes that are related to this Service Plan.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.   Select the text to be copied and either press the OK Button in
that screen or double-click the selected record.

Buttons

Close: This will close the Service Plan screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will show a blank Service Plan detail screen for entry of a new Service Plan

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Service Plan.  You may open
and maintain information in those screens whilst still remaining in the Service Plan screen.

Reports: This will bring up a list of Reports that are related to the Service Plan.  You can
immediately run the report whilst still remaining in the Service Plan screen.

Lines Tab

At the line level you can define a series of Service events that make up a full servicing schedule for
the Asset.   Each Event can have a different template if required to cover the specific work content.

Entry and Display fields

Period: From the drop-down list select the period length (days or months), which - combined with
the next field - will define when the after-sale service is due.  

Days or months from asset creation: Enter the number of days or months when this service is
scheduled from sale of the asset.
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Job Type: From the drop-down list select the Job Type that will be used when auto generating the
Service Job relating to this Service

Template: From the drop-down list select the Task Template that will be used to provide the
details for the Service Job.  Templates are maintained under Jobs>Templates

Buttons

Close: This will close the Service Plan screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a scheduled Service event

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current highlighted Service event

Related: This will bring up a list of functions that are related to the Service Plan.  You may open
and maintain information in those screens whilst still remaining in the Service Plan screen.

Reports: This will bring up a list of Reports that are related to the Service Plan.  You can
immediately run the report whilst still remaining in the Service Plan screen.

17.4 Warranty List

This screen allows you to view all Warranties that have been created in Ostendo with drill-down to
show more details

List Tab

Display fields

The displayed fields are taken from the Warranty record.   The selection of which fields to display
is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the main panel and
select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
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either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Warranty List screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Warranty record from this table

Detail Tab

This panel shows more details of the selected Warranty Record with facility to amend the Warranty
Code and add notes to reference the change.

Display and Entry Fields

Warranty No: A system generated number that uniquely identifies the Warranty record.  

Status: The current status of the Warranty.  The display options are ‘Valid’ or ‘Invalid’.

Customer or Supplier: From the drop-down list select whether this Warranty applies to a
Customer or Supplier.

Company: From the drop-down list select the Customer or Supplier to which this Warranty
applies.

Order Type: The Type of Order that supplied this Warranty.  The display options are ‘Sales’ or ‘
Job’.

Order No: The Order Number to which this Warranty relates

Invoice Date: Date when the Invoice was raised against the Order.

Invoice No: The Invoice Number covering this Warranty.

Code Type: The Code Type covered by this Warranty.  The display options are ‘Item Code’ or ‘
Descriptor Code’.

Code: The Reference Number of the Item or Descriptor

Qty: The Quantity of the Code covered under this Warranty.

Description: A brief description of the Item or Descriptor.  

Serial Number: The Serial Number of the Item or Descriptor covered under this Warranty
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Warranty Details

Warranty Description: A short description of the type of Warranty

Start Date: The Date when this Warranty cover commenced.

Expiry Date: The Date when this Warranty cover will cease.

Warranty Covers: A short description of what the Warranty will cover

Warranty Code: The current Warranty Code.  This can be amended by selecting another
Warranty Code from the drop-down list.

Detailed Cover: These are extended details of what is covered under the Warranty

Any Warranty Exclusions: These are extended details of what is excluded from the Warranty

Notes: You can enter unlimited amount of Notes that are related to this Warranty record.
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.   Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Warranty List screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

17.5 Service Confirmations

Where a Customer Asset record is flagged as ‘Requiring Confirmation of Planned Service’ and the
Reminder is due to be sent then this will display in this screen.  You can ‘flag’ all or selections from
this list and generate the notification (Phone, Email, Letter).

List Tab

The List panel displays all scheduled services whose ‘Reminder Date’ is at, or before, the date
selected at the top of the screen.  The ‘Reminder Date is evaluated from the Asset’s scheduled
Service Date less the number of ‘Notification’ days held against the Customer Asset record.  In this
screen you can select specific lines for generation of the notification.  You also have the option to
make changes by highlighting a specific line and clicking on the ‘Details’ tab

Display and Entry fields

Display Confirmation Due By: From the drop-down calendar select the Date up to which all
scheduled Service Order ‘Reminder Notifications’ are due.  The ‘Reminder Date is evaluated from
the Asset’s scheduled Service Date less the number of ‘Notification’ days held against the
Customer Asset record.  

Exclude where reminders have been sent: ‘Check’ the checkbox if you wish to exclude those
scheduled service records where a Reminder Notification has already been sent.  Upon ‘checking’



974 Ostendo Reference Guide

this checkbox the list of service schedules will automatically refresh.

Select: ‘Check’ the checkbox where you want the Reminder Notification to be generated.  You
have the option to click on the ‘Select All Confirmations’ Button at the bottom of this panel to select
all the records.  You may also click on the ‘De-select All Confirmations’ Button at the bottom of this
panel to ‘un-select’ all the records

Reminder Style: Display only field showing the format by which the Reminder will be conveyed.
The display options are Phone, Email, or Letter.   You can amend this Style by selecting the record
and going into the ‘Detail Panel.

Planned Date: Display only field showing the planned date of the Service.  

Confirmation Status: Display only field showing the current status of the Customer’s confirmation
to this Reminder.  The display options are ‘Confirmed’ and ‘Not-Confirmed’.  You can amend this
Status by selecting the record and going into the ‘Detail Panel.

Reminder Sent: Display only field showing if the Reminder Notification has been sent or not.  
This is automatically updated whenever the Reminder is generated.  You can reset this by
selecting the record and going into the ‘Detail Panel.

Reminder Date: Display only field showing the Date when the Reminder Notification was sent.
This is automatically updated with the system date when the Reminder was generated.  You can
reset this by selecting the record and going into the ‘Detail Panel.

Customer: Display only field showing the Customer that owns this Asset

Reminder Contact: Display only field showing the Contact for the Reminder.  You can amend this
by selecting the record and going into the ‘Detail Panel.

Confirmed Date: Display only field showing the Date the Confirmation was received from the
Customer.  This field is maintained in the ‘Details’ panel

Service Zone: Display only field showing the Service Zone as held against the Customer Asset

Asset Name : Name of the asset

Asset Description : Description of the asset.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Buttons

Select All Confirmations: Clicking this Button will place a check-mark in the Select column
against all displayed Items

De-select All Confirmations: Clicking this Button will remove check-marks from the Select
column against all displayed Items

Generate Reminders for Selected Confirmations: All the selected planned services will have
their Reminder Notifications generated.  Three formats will be output depending upon the ‘
Reminder Style’ held against the Customer Asset record:
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· Phone: A simple List of all Customer requiring ‘Phone confirmations will be printed
· Email: An Email will be sent to each Customer using the ‘Confirmation Text’ template

held against the Customer Asset record.
· Letter: A Letter will be printed for mailing to each Customer

Close: This will close the Service Confirmations screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Details Tab

This tab displays a selected scheduled Service Reminder record and allows you to amend certain
information against that record.  The following fields are available for amendment.

Reminder Details

Selected:  ‘Check’ the checkbox where you want the Service Reminder to be generated
for this scheduled service.  
Reminder Style: From the drop-down list select the Style.  The available options are
Phone, Email, or Letter
Reminder Contact: From the drop-down list you can amend the Contact by selecting
another Contact held against this Customer
Actioned: This is automatically updated whenever the Reminder is generated.  You can
reset this by simply clearing this checkbox 
(Date): System generated date when the Reminder was generated.  You can amend this
by selecting another date from the drop-down calendar.  You should also ‘clear’ the date if
you are resetting the ‘Actioned’ flag

Confirmation Details

Confirmation Status: From the drop-down list select the status of the Reminder
Notification.  The options are ‘Confirmed’ and ‘Not-Confirmed’.  
Confirmation Service Date: This is prefilled with the Scheduled Service Date.  If the
Customer has requested another date then select this from the drop-down calendar.

Buttons

Close: This will close the Service Confirmations screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

17.6 Service Orders Required

This process enables you to generate Service Jobs from planned Service Schedules.  It should be
noted that three conditions could exist against planned scheduled Services.

· Is awaiting Customer confirmation
· Customer has confirmed
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· No Customer confirmation required

By default all scheduled services will be displayed but option is provided to ‘hide’ those that are
awaiting Customer confirmation.

List Tab

The List panel displays all scheduled services due on, or before, the date selected at the top of the
screen.  In this screen you can select specific lines for generation of Job Orders.  
You can click on the column headings to filter out Service Orders based on the desired column
value.
You also have the option to make changes by highlighting a specific line and clicking on the ‘
Details’ tab

Display fields

Display Service Due By: From the drop-down calendar select the Date up to which all scheduled
Service Orders are due.  

Exclude Services ‘Not Confirmed’ but require confirmation: ‘Check’ the checkbox if you wish
to exclude those scheduled service records where a Customer has been sent a Reminder
Notification and has not responded.  Upon ‘checking’ this checkbox the list of service schedules
will automatically refresh to exclude these.

Select: ‘Check’ the checkbox where you want the Scheduled Service to be converted to a Job
Order.  You have the option to click on the ‘Select All Planned’ Button at the bottom of this panel to
select all the records.  You may also click on the ‘De-select All Planned’ Button at the bottom of
this panel to ‘un-select’ all the records

Service Date: Display only field showing the planned date of the Service.  You can amend this
Date by selecting the record and going into the ‘Detail Panel.

Confirmation Required: Display only field showing whether the Customer requires to confirm the
Scheduled Service.

Confirmation Status: Display only field showing the current status of the Customer’s confirmation
to the Reminder Notification.  The display options are ‘Confirmed’ and ‘Not-Confirmed’.  You can
amend this Status by selecting the record and going into the ‘Detail Panel.

Asset Name: Display only field showing the name of the Asset

Asset Number: Display only field showing the unique identifier of the Asset

Customer: Display only field showing the Customer that owns this Asset

Description: Display only field showing the description of the Asset

Asset Type: Display only field showing the Asset Type as held against the Customer Asset record.

Service Zone: Display only field showing the Service Zone as held against the Customer Asset

Service Type : The related Asset Service Type

Group Asset : Indicates whether this is a Group Asset.

Template : the related Job Template. 
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Customer Asset Additional Fields  (if any) are also included in the List screen.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Buttons

Select All Planned: Clicking this Button will place a check-mark in the Select column against all
displayed scheduled service orders

De-select All Planned: Clicking this Button will remove check-marks from the Select column
against all displayed scheduled service orders

Generate Job Orders for Selected Services: All the selected planned services will have a Job
Order generated.  The Planned Service Schedule line will then be removed from this list

Close: This will close the Service Orders Required screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Related:     This will bring up a list of functions that are related to the Service Orders.    You may
open and maintain information in those screens whilst still remaining in the Service Orders
Required screen.

Reports:     This will bring up a list of Reports that are related to the Service Orders.   You can
immediately run the report whilst still remaining in the Service Orders Required screen.

Details Tab

This tab displays a selected scheduled Service Order Required record and allows you to amend
certain information against that record.  The following fields are available for amendment

Selected:  ‘Check’ the checkbox where you want the Planned Service Order to be
converted to a Job Order.  
Confirmation Status: From the drop-down list select the status of the Reminder
Notification.  The options are ‘Confirmed’ and ‘Not-Confirmed’.  
Service Date: This is prefilled with the Scheduled Service Date.  If the Customer has
requested another date then select this from the drop-down calendar.
Job Type: Display only field showing the Job Type to be used when creating this Service
Order
Template: Display only field showing the Job Template to use when creating this Service
Order
Notes: You can add Notes that are specific to this Planned Service

Buttons

Close: This will close the Service Orders Required screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Related:     This will bring up a list of functions that are related to the Service Orders.    You may
open and maintain information in those screens whilst still remaining in the Service Orders
Required screen.

Reports:     This will bring up a list of Reports that are related to the Service Orders.   You can
immediately run the report whilst still remaining in the Service Orders Required screen.

17.7 Settings

17.7.1 Customer Asset Types

This screen allows you to maintain a file of Customer Asset Types, which are used to segregate
Customer Assets for analysis purposes.  Customer Asset Types are User-defined and can include
such types as:

· Switchgear
· Vehicles
· Air Conditioning

Entry and Display fields

Name: Enter the Name of the Customer Asset Type.  Duplicates not allowed.

Description: Enter a short description of the Customer Asset Type.  No checks are made on this
entry

Equipment Check Frequency in Days: If this Asset has a list of equipment, enter the frequency
in days that the equipment needs to be checked.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Customer Asset Type screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Customer Asset Type.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Customer Asset Type.
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17.7.2 Customer Asset Service Types

This screen allows you to maintain Asset Service Types. These are used to link or group various
assets under a common Type for servicing.

Ostendo Freeway can be set up to facilitate the servicing of multiple customer assets at a site. 

For a full description of how to do that please refer to this paper: Freeway Multi Asset Servicing

Entry and Display fields

Service Type: Enter the Name of the Service Type.  Duplicates not allowed.

Description: Enter a short description of the Service Type.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Service Types screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Service Type record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Service Type record.

17.7.3 Customer Asset Reading Types

This screen allows you to maintain Asset Reading Types.  Reading Types are used in the
Customer Asset Readings screen to define the Type of reading being entered.

Entry and Display fields

Reading Type: Enter the Name of the Reading Type.  (Example: Mileage, Copies, etc). 
Duplicates not allowed.

Description: Enter a short description of the Reading Type.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Reading Types screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

http://ostendo.info/downloads/ostendo/Freeway_Multi_Asset_Servicing_Explained.pdf
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Add: This will send the cursor to a new line for entry of a new Reading Type record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Reading Type record.

17.7.4 Confirmation Text

This screen allows you to create and maintain different styles of Text for automatic inclusion in ‘
Reminder’ Emails sent to Customers.  The Text can contain plain text or can also include data
taken from the specific Customer Asset’s details such as Asset Name, Planned Service Date, etc.

Entry and Display fields

Text Code: Enter the Code of this Confirmation Text.  Duplicates not allowed.  This code is
selected against a Customer Asset and will be used when emailing a ‘Reminder’ Email

Subject: The content of this field will populate the Subject Line of the generated ‘Reminder’ Email.
It can be plain text or can include fields from the database.  These fields will be populated with the
information specific to the Customer.  For example, if the Customer’s Asset was ‘Air Conditioning
Unit’ and the next scheduled service date was ‘12/04/22’ then I would create a Subject Text as
follows:

Service reminder for [MD_."CUSTASSETDESCRIPTION"] due [MD_."PLANNEDDATE"]

Upon sending the Email the Subject Line in the Email would appear as:

Service reminder for Air Conditioning Unit due 12/04/22

All fields from the CustomerAssetMaster, CustAssetSchedule and CustomerMaster are available
to this screen.

Where there are common field names you may find you may have to suffix a '1' after the field
name. eg: [MD_."ADDITIONALFIELD_111"] may refer to
 CustomerMaster.AdditionalField_1 whereas [MD_."ADDITIONALFIELD_1"] may refer
to CustomerAssetMaster.Additionalfield_1

Field Name Examples:

[MD_."CUSTASSETTYPE"] - Customer Asset Type
[MD_."CUSTASSETNAME"] - Name of Customer’s Asset
[MD_."CUSTASSETNUMBER"] - Asset Identity
[MD_."CUSTASSETDESCRIPTION"] - Description of the Asset
[MD_."CUSTOMER"] - Customer Name
[MD_."PLANNEDDATE"] - Planned Service Date
[MD_."JOBTYPE”] - Type of Job required to complete the Service
[MD_."TEMPLATECODE"] Job Template that will be used to carry out the service 
[MD_."TEMPLATEDESCRIPTION”] - Description of the Job Template
[MD_."REMINDERCONTACTNAME"] - Contact Name held against the Asset record
[MD_."CONTACTFIRSTNAME”] - First Name of Contact (from the Customer record) 
[MD_."CONTACTLASTNAME”] - Last Name of Contact (from the Customer record)
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A maximum of 200 characters of information including spaces can be entered into this field

Body: The content of this field will populate the main area of the generated ‘Reminder’ Email.  This
field may also contain plain text plus the same database fields shown above.  There is no
restriction to the number of characters that you can use in this field

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Confirmation Text screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Confirmation Text record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Confirmation Text record.

17.7.5 Service Rules

This screen allows you to maintain Service Rules.  Service Rules allow you to define what rules,
within the Service function area, you wish to apply.  The following rule settings are available

Entry and Display fields

Offset Planned Event Dates by previous Finish Date: Tick this box if you wish to offset the next
Planned Service event dates by the last planned service job's finish date.

Default Service due Days Horizon for Service Orders Required : Specify the service due days
horizon to generate Service Orders that fall within that horizon only.

Exclude Duplicate Planned Service Events and Existing Jobs Horizon : Specify the horizon
days to exclude duplicate Planned Service Events along with any existing Jobs for Assets in the
same Service Type.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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18 Jobs

18.1 Projects

This screen allows you to create and maintain Projects.   

List Tab

Display fields

The displayed fields are taken from the Project information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Projects screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will go to the ‘Detail’ tab and present a blank screen for entry of a new Project

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Project from this list

Related: This will bring up a list of functions that are related to the Project.  You may open and
maintain information in those screens whilst still remaining in the Projects screen.

Reports: This will bring up a list of Reports that are related to the Project.  You can immediately
run the report whilst still remaining in the Projects screen.



983Jobs

Detail Tab

Entry and Display fields

Project Name: Enter the name of the Project.  Duplicate Project Names are not allowed

Status: During Project creation this is prefilled with ‘Open’.  You can amend this by selecting the
required status from the drop-down list.  The options are:

· Lost
· Quote
· Planned
· Open
· In-Progress
· Finished
· On-Hold
· Closed

Description: Enter a brief description of the Project.  A longer description can be entered into the ‘
Project Notes’ tab in the lower part of this screen

Project Type: From the drop-down list select the Project Type.  Project Types are user defined
and maintained via Jobs>Settings>Project Types

Project Leader: From the drop-down list select the Project Leader.  Project Leaders are user
maintained via General>Settings>Employees

Parent Project: If this Project is linked to a Parent Project then select that Project from the
drop-down list.

Project Dates: This area lets you assess dates relating to the Project and shows:
Project Budgeted Start: The scheduled start date of the Project. This can be amended
by overtyping the date or selecting the date from the drop-down calendar.
Project Budgeted End: The scheduled end date of the Project. This can be amended by
overtyping the date or selecting the date from the drop-down calendar.
‘From Jobs’ Start: The start date taken from the earliest ‘Start Date’ held against all Jobs
included in this Project
‘From Jobs’ End: The end date taken from the latest ‘End Date’ held against all Jobs
included in this Project

Current Work In Progress Value: This is the current cost the work in progress as evaluated by
the program.  It takes account of the cost of all work done in the Project less the cost of Invoices
raised against the Project

Project For: Select the Radio Button to define whom the Project is for.  The options are Company
or Customer.  The next field displays a drop-down list relating to this selection.

(Company or Customer): From the drop-down list select the Company or Customer to which this
Project relates

Additional Address & Contact Details: Click on this button to show a drop-down panel that
contains Address and Contact Details.  These fields are prefilled with the details already defined
against the Company Address or the Customer Address.  The following fields can be amended at
any time:

· Address: Three lines are available for entry of the delivery address of the site.  
· Code: Enter the Postcode or ZIP Code where this Delivery Address is located.
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· State: Enter the State where this Delivery Address is located.
· City: Enter the Town or City where this Delivery Address is located.
· Country: Enter the Country where this Delivery Address is located.
· Contact: From the drop-down list select a Contact at the address
· Phone: Enter the telephone number at this address
· Fax: Enter the facsimile number at this address

Budget, Planned Invoiced: This area compares the Budgeted, Planned and Invoiced Income and
Costs along with evaluations of Margins being achieved

Project Budget
Income: Enter the Budgeted Income for the whole Project.  This can be amended
at any time.
Cost: Enter the Budgeted Cost for the whole Project.  This can be amended at
any time.
Margin%: Program calculated value from (Income - Cost) / Income

Order Planned
Income: The sum of Planned Income from all the Jobs in this Project
Cost: The sum of Planned Costs from all the Jobs in this Project
Margin%: Program calculated value from (Income - Cost) / Income

Invoiced to Date
Income: The sum of Invoices raised by Jobs in this Project
Cost: The summed Costs from Invoices raised by Jobs in this Project
Margin%: Program calculated value from (Income - Cost) / Income

Project Values: This area shows the current and projected Income and expenditure based on the
current progress and costs of each Job in the Project

Order Planned
Income: The sum of Planned Income from all the Jobs in this Project
Cost: The sum of Planned Costs from all the Jobs in this Project
Margin%: Program calculated value from (Income - Cost) / Income

Projected
Income: A projection based on Income to Date & Percentage complete
Cost: A projection based on Costs to Date & Percentage complete
Margin%: Program calculated value from (Income - Cost) / Income

Variance %
Income: A projection based on Planned -v- Projected Income
Cost: A projection based on Planned -v- Projected Costs

Linked Job Orders - Sub-Tab

This screen shows all the Jobs that are included in this Project.  The displayed fields are: 

Display fields

Job Number: The number of the Job that is included in this Project.

Status: The current status of the Job

Description: Brief description of the Job taken from the Job Header

Customer: Customer against who the Job is linked

Job Value: The current Value of this Job as held against the Job Header
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Linked Direct Invoices - Sub-Tab

This screen shows all the Direct Invoices that have been raised against this Project.  The displayed
fields are: 

Display fields

Invoice Number: The number of the Invoice that has been booked to this Project.

Status: The current status of the Invoice

Customer: Customer against who the Invoice was raised

Nett Value: The Nett Value of the Invoice

Site Information Tab

This enables you to enter unlimited amount of detail about the Site (Example: Access, Safety,
Directions, etc).  Whenever you click on this field an icon will appear in the top-right.  By clicking on
this Icon you can bring up the Frequently Used Text table.  Select the text to be copied and either
press the OK Button in that screen or double-click the selected record.

Project Notes Tab

This enables you to enter unlimited amount of detail about the Project.  This is then available for
printing wherever the Project is called.  Whenever you click on this field an icon will appear in the
top-right.  By clicking on this Icon you can bring up the Frequently Used Text table.  Select the text
to be copied and either press the OK Button in that screen or double-click the selected record.

Project Progress Tab

Shows ongoing information about the Project.  The displayed fields are:

Total Costs: This area lets you view current and projected costs based on completions to date
Planned Cost: The sum of Planned Costs from all the Jobs in this Project
Actual Cost: The sum of Actual Costs to date across all the Jobs in this Project
% Of Planned: Percentage of current Actual Cost to Planned Cost
Remaining Planned: Remaining Cost taking into account the estimated percentage
completion of the project (see ‘Estimated %’ below)

Cost Completions: This area lets you view current and projected costs based on completions to
date

Estimated %: This is the program evaluated percentage completion taking into account
Job and Job Line over-issues, completions, etc
(Prediction): Display only field showing the current trend of this Project.  The display
options are:

· On Track (within percentage set up in Jobs>Settings>Job Rules)
· Higher Unit Costs
· Lower Unit Costs
· Higher Usage
· Lower Usage
· Hi-Low Costs
· Hi-Low Usage
· Hi-Low Costs & Higher Usage
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· Hi-Low Costs & Lower Usage
· Hi-Low Costs & Hi-Low Usage
· Higher Costs & Higher Usage
· Higher Costs & Lower Usage
· Higher Costs & Hi-Low Usage
· Lower Costs & Higher Usage
· Lower Costs & Lower Usage
· Lower Costs & Hi-Low Usage

Projected Cost: Based on continuing at current Cost Rate
% of Planned : Estimated final Cost percentage based on Planned Cost

Total Hours: This area lets you view current and projected hours based on completions to date
Planned Hours: The sum of Planned Hours from all the Jobs in this Project
Actual Hours: The sum of Actual Hours to date across all the Jobs in this Project
% Of Planned: Percentage of current Actual Hours to Planned Hours
Remaining Planned: Remaining Hours taking into account the estimated percentage
completion of the project (see ‘Estimated %’ below)

Hours Completion: This area lets you view current and projected Hours based on completions to
date

Estimated %: This is the program evaluated percentage completion taking into account
Job and Job Line status, over-bookings, Task completions, etc
(Prediction): Display only field showing the current time trend of this Project.  The display
options are:

· On Track (within percentage set up in Jobs>Settings>Job Rules)
· Higher Usage
· Lower Usage
· Hi-Low Usage

Projected Hours: Based on continuing at current rate
% of Planned : Estimated final Hours percentage based on Planned Hours

Buttons

Close: This will close the Projects screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will display blank ‘Detail’ screen for entry of a new Project

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the details screen

Related: This will bring up a list of functions that are related to Projects.  You may open and
maintain information in those screens whilst still remaining in the Projects screen.

Reports: This will bring up a list of Reports that are related to Projects.  You can immediately run
the report whilst still remaining in the Projects screen.
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18.1.1 Project Properties

This screen allows you to define properties that are specific to a Project.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Project.

Display fields

The displayed fields are taken from the Project Details.  The selection of which fields to display
here is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Project Properties screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Project Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Project Name: Display only field showing the Project selected in the List screen
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Description: Display only field showing a description of the Project

Status: Display only field showing the Project status

Customer: Display only field showing the Customer defined against this Project

Project Type: Display only field showing the Project Type

Property: From the drop-down list select the Standard Property against which a value specific to
this Project will be made.

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Buttons

Close: This will close the Project Properties screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Project Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Project Property record or the last time the ‘Save’
Button was pressed will be lost.

Delete: This enables you to delete the selected Project Property record.

18.1.2 Project Documents

This screen allows you to define documents, etc that are specific to a Project. 

List Tab

Display fields

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Project to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.
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Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Project Documents screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Project Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Project record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name of the document that you are creating in this Document -
Project linkage.  No checks are made on the entry.

Document Type: Prefilled with ‘Project’

Linked to: From the drop-down list select the Project that uses this document

Copy to Jobs: ‘Check’ this checkbox if you want the contents of this document to be copied to
Jobs orders

Copy to Sales: ‘Check’ this checkbox if you want the contents of this document to be copied to
Sales orders

Correspondence: Tick this box if this document is to be treated as correspondence in the
Operations Centre.

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
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screen or double-click the selected record.

Buttons

Close: This will close the Project Documents screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Project Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Project Documents record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

18.1.3 Project Images

This screen allows you to define images that are specific to a Project.    

List Tab

Display fields

Image Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Project to which this image relates.

File Name: This is the full path name of the image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Project image screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Project images.
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Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected image from a Project record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Image Name: Enter the name of the document that you are creating in this image - Project
linkage.    No checks are made on the entry.

Image Type: Prefilled with ‘Project’

Linked to: From the drop-down list select the Project that uses this image

Copy to Jobs: ‘Check’ this checkbox if you want the contents of this image to be copied to Job
orders

Copy to Sales: ‘Check’ this checkbox if you want the contents of this image to be copied to Sales
orders

Image Details: locate the full path name of the image.  It should be noted that any file extension
recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Image: This panel displays the selected Image.

Buttons

Close: This will close the Project image screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Project images.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Project image record or the last time the ‘Save’ Button
was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

18.1.4 Project History Notes

This function allows you to link multiple time-stamped notes to a Project record.    

List Tab
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Display fields

The displayed fields are taken from the Project master record.  The selection of which fields to
display is at the user’s discretion.   To select the fields to display simply ‘right mouse’ in the main
panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Project History Notes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Project to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Classification: From the drop-down list select a Classification under which you wish to store this
History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.
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Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Follow-up Actioned:  Tick this box if the follow-up has been actioned.

Priority Note:  Tick this box if this note is to be displayed as a Priority Note in Operations Centre.

Notes: Unlimited notes can be entered against this Date/Time History record.   Whenever you
click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this Project is displayed in the lower part of the screen.   Each
record will also have the first 3 lines of the notes displayed.   To view the full Notes simply click on
the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Project History Notes screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Project History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Project History Notes record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

18.2 Project Budgets

This screen allows you to create and maintain Project Budgets

List Tab

The List panel shows a grid of all Budgets currently in Ostendo

Display fields

Project: This is display only that shows the Projects in Ostendo.   

Status: This is display only showing the current Status of the Project  taken from the Project
record

Description: This is description of the project.

Project Type: This is display only showing the Project Type 

Project is for: This is display only showing whether this is a Customer or Company project
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Customer or Company: This is display only showing the Customer of the Project

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking against
will sort in descending order. 

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Detail Tab

This panel shows a grid of all Budgets currently held against the selected Job Order

Entry and Display fields

Budget Style 1: This is display only and shows the Budget Style 1.    The available Styles are:
· Project
· Job Type
· Job Category
· Line Type
· Analysis Group
· Item Code
· Labour Code
· Descriptor Code

Budget Style 2: This is display only and shows the Budget Style 2.    The available Styles are:
· None
· Line Type
· Analysis Group
· Item Code
· Labour Code
· Descriptor Code

Budget Type: Select the Budget Type from the drop-down list.  The available Types are:
· Revenue
· Cost
· Qty
· Profit

Total Value: This is display only and shows the Total Value of this Budget.  It is maintained by
Ostendo from the entries made in the following Monthly Value fields
 
Monthly Value Value: Enter the Monthly Budgets.  There are up to 36 months for the entries
commencing with the month that the Project was created
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Buttons

Close: This will close the Budgets screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Budget against the selected Job

Save: This will save the current data without exiting the screen.  It will also apply any Annual
Amount to the individual Monthly amount fields

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current Line record

Related: This will bring up a list of functions that are related to the Budget.  You may open and
maintain information in those screens whilst still remaining in the Budget screen.

Reports: This will bring up a list of Reports that are related to the Budget.  You can immediately
run the report whilst still remaining in the Budget screen.

18.3 Project Budget Comparisons

This screen enables you to run a Pivot or Analysis Budget View against parameters entered in this
screen.

Entry and Display fields

Project Name: From the drop-down list select the  Project to be used in this comparison.

Budget Style: From the drop-down list select the Budget Style.

Buttons

Pivot View: This will create a Pivot View using the above parameters and return the results to the
screen.  From here you have the option to Print, Email, Export, or Save the View

Analysis View: This will create an Analysis using the above parameters and return the results to
the screen.  From here you have the option to search and filter the results in addition to outputting
to Print, Email, or Export the View

Cancel: This will close the Job Budget Comparison parameter entry panel

18.4 Task Bills

This function allows you to maintain Task Bills.  These Task Bills are used as pre-defined lists that
can be copied when creating and maintaining Job Orders

List Tab



996 Ostendo Reference Guide

Display fields

Task Bill Code: Display only field showing the Task Bill Code identity

Description: Display only field showing a Description of the Task Bill as entered into the ‘Detail’
tab

Unit: Display only field showing a Unit for the Task Bill as entered into the ‘Detail’ tab

Status: Display only field showing the current status of the Task Bill.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Task Bill screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send you to the Detail tab in preparation for creating a new Task Bill

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Task Bill from this table

Related: This will bring up a list of functions that are related to the Task Bill.  You may open and
maintain information in those screens whilst still remaining in the Task Bill screen.

Reports: This will bring up a list of Reports that are related to the Task Bill. You can immediately
run the report whilst still remaining in the Task Bill screen.

Detail Tab

The Detail Tab allows you to define how the costs for this Task Bill are defined when the Task Bill
is copied to a Job

Entry and Display fields

Task Bill Code: This is only ‘active’ during an ‘Add’ Transaction.  From the drop-down list select
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the Descriptor.  This Descriptor must have been previously defined - in the Descriptor record - as
being ‘Used as a Task Bill Code’.  

Unit: Display only field showing the base unit for the Descriptor

Category: Display only field showing how the Descriptor Category held against this Descriptor
record

Status: Display only field showing the current status of the Descriptor.  The possible display
options are:

· Active
· Inactive

Description: Display only field showing the description of the Descriptor

Std Sell Price: Display only field showing the Standard Sell Price taken from the Descriptor
record.

Price Settings: Select the radio button to define how you want the Sell Price to be evaluated.  The
options are:

From Descriptor Sell Price: The above sell price will be used as the basis for pricing this
Task Bill
Rolled Up Prices from Bill Lines: The sum of (Standard Sell Price from each of the Bill
Lines multiplied by its usage quantity) will be used as the basis for pricing this Task Bill
Rolled Up Cost from Bill Lines: The sum of (Standard Cost from each of the Bill Lines
multiplied by its usage quantity) will be multiplied by the Markup % defined in the next field
to arrive at a Sell Price used as the basis for pricing this Task Bill
Markup%: Used to determine the Sell Price from the sum of the line costs - See previous
field.

When this Task Bill is copied to a Job then the evaluated Sell Price will become the ‘Base Price’
against which the Pricing Matrix and Discounts will be applied.

Notes: You can enter unlimited amount of Notes that relate to this Task Bill.  Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Task Bill screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will clear this Details Tab in preparation for creating a new Task Bill

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Task Bill.  You may open and
maintain information in those screens whilst still remaining in the Task Bill screen.

Reports: This will bring up a list of Reports that are related to the Task Bill. You can immediately
run the report whilst still remaining in the Task Bill screen.
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Lines Tab

The Lines Tab allows you to add details that make up the Task Bill content.  Each Line consists of
the following:

Entry and Display fields

Line Number: Task Bill Lines are printed in Line Number sequence.  Upon creation of a new line
the program will increment the previous line by 10.  You can amend this as required.

Component Type:  From the drop-down list select the Component Line Type.  The options are:
· Item Code
· Descriptor Code
· Labour Code
· Catalogue Code

Code: From the drop-down list select the specific component code.  The list will show details
relating to the Component Type option selected.

Description: Display only field showing the description of the Code taken from the Item,
Descriptor, or Labour record

Unit: Prefilled with the Unit held against the Code.   If the Line Type is ‘Item Code’ and the
selected Item has multiple Units of Measure then you can select the specific Unit from the
drop-down list

Qty: Enter the quantity of this Code that is required in the Task Bill. 

Buttons

Close: This will close the Task Bill screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This button will go to a new line in preparation for entering a new Component.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This button will delete the current highlighted line.

Related: This will bring up a list of functions that are related to the Task Bill.  You may open and
maintain information in those screens whilst still remaining in the Task Bill screen.

Reports: This will bring up a list of Reports that are related to the Task Bill. You can immediately
run the report whilst still remaining in the Task Bill screen.

18.5 Templates

This function allows you to maintain Templates.  Templates contain Tasks, Components, and
Resource requirements.  They can be used as the source for creating a complete Job or adding
large ‘segments’ to existing Jobs.
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List Tab

Display fields

Template Code: Display only field showing the Template identity

Description: Display only field showing the Template description

Status: Display only field showing the Template status.  The display options are ‘Active’ or ‘
Inactive’.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.   To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Template screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ panel for entry of a new Job Template

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Job Template from this table

Related: This will bring up a list of functions that are related to Job Templates.  You may open and
maintain information in those screens whilst still remaining in the Job Template screen.

Reports: This will bring up a list of Reports that are related to Job Templates. You can
immediately run the report whilst still remaining in the Job Template screen.

Detail Tab

The Detail Tab allows you to specify how this Template will be used when selected for inclusion in
a Job

Entry and Display fields

Template Code: The identity of the Template.  This is only ‘active’ during an ‘Add’ transaction
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when you should enter the Identity of the new Template.  Duplicate Template Identities are not
allowed.

Description: Description of the Template.  Changes can be made at any time and no validation
checks are carried out..

Status: select the status from the drop-down list.  The options are:
· Active
· Inactive

When Used this Template is configurable by Task: If this is ‘checked’ then - when this
Template is being added to a Job - the complete list of Tasks contained in this Template is
displayed for selection of the required Tasks.  If this is not ‘checked’ then all Tasks in the Template
will be copied to the Job

Task Sequencing: Select the radio button that applies to this Template.  The options are:
· Added: Task sequence numbers in this Template will be ignored and the program will

generate Task Sequence Numbers when adding to the Job.  The generated Sequence
Numbers will continue from the end of the current Job Sequence Numbers.

· Fixed: Task sequence numbers in this Template will be used irrespective of current Task
Sequence Numbers in the Job.  

Notes: You can enter unlimited Notes that relate to this Template.  Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that screen or
double-click the selected record.

Buttons

Close: This will close the Templates screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will present a blank Detail screen in preparation for creation of a new Template

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to this ‘Detail’ screen

Related:     This will bring up a list of functions that are related to the Template.    You may open
and maintain information in those screens whilst still remaining in the Template screen.

Reports:     This will bring up a list of Reports that are related to the Template.   You can
immediately run the report whilst still remaining in the Template screen.

Tasks Tab

The Tasks Tab enables you to add Tasks to a Template.  A Task can contain Instructions,
Duration, Resource requirements, and Components.  The Upper panel shows all the Tasks in this
Template whereas three sub-tabs in the lower part of the screen allows you to maintain each Task.

Entry and Display fields
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Upper panel 

This shows all the Tasks in this Template.  For each Task the following information is displayed

Sequence:  Display only field showing the Sequence Number assigned to the Task in the ‘Task
Detail’ sub tab (below)

Task Name:  Display only field showing the name of the Task as entered into in the ‘Task Detail’
sub tab (below)

Description:  Display only field showing the description of the Task as entered into in the ‘Task
Detail’ sub tab (below)

Job Lines to Task:  Display only field showing the source of the Job Lines when copying this Task
to a Job

Lower panel 

The Lower Panel has three sub tabs for maintenance of a Task.  These are:

Task Detail Sub-Tab

The Task Detail sub tab enables you to create and maintain Task Details

Entry and Display fields

The Upper panel shows all the components that are currently used in this Template.  The
maintenance of those records are carried out in the lower part of the screen as follows:

Sequence:  During an ‘Add’ Transaction the program automatically generates a Sequence that is
the current highest Sequence plus 10.  This can be amended if required.  Sequence Numbers
define the scheduling sequence for each.  To have concurrent Tasks you can use the same
Sequence Number.

Task Name: From the drop-down list select the Task that will be included in this Job Order.  Tasks
are maintained via Jobs>Settings>Task Names

Task Description: This is copied from the Task selected in the previous field.  However, it can be
amended here and made specific to this Job Order.

Department: This is prefilled with the Department held against the Task selected above.  You can
amend this department by selecting one from the drop-down list. Departments are maintained via
General>Settings>Departments.

How Are Invoice Lines Created: From the drop-down list select how the lines are created.  The
options are:

A Single Task Bill is linked to this Task: If this is selected then a single Task Bill is
selected in the next field and no lines can be added via the ‘Lines’ tab
Multiple Job Lines can be linked to this Task: If this is selected then Lines linked to this
Task can be entered via the ‘Lines’ tab

Task Bill Code: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  From the drop-down list select the Task Bill.  Task Bills are maintained under
Jobs>Task Bills
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Qty: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is selected.  Enter the
quantity of this Task Bill that is required tin this Template. 

Unit: Display only field showing the Unit of the Task Bill.

Description: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is selected.
This is prefilled with the Description of the selected Task Bill but it can be amended here and
made specific to this Template.

Dynamically Create Tasks for Customer Assets when Template is Linked to a Group
Service Asset : Tick this box if you want Ostendo to dynamically create job tasks for multiple
Assets under a Group Asset which is flagged as a Group Service Asset and linked to the Service
Type specified below.

Service Type to Condition Assets : Select the appropriate Service Type.

Style Name : Select the mobility Style Template name.

Scheduling Details: The duration specified here will be used by the Job scheduling process to
determine when - and for how long - this Task will take in the Job workflow.  Entries are:

Time: Enter the length of time that this Task normally takes
Time Unit: Select the time unit (Hours or Minutes) from the drop-down list

No Scheduling: ‘Check’ this checkbox if you do not want this Task to be scheduled nor displayed
in the Job Calendar

Step Overlap - From the drop-down list select the Scheduling Overlap that will apply to
subsequent Steps in the process.  The options are

· End of Step: The next step will commence at the end of this Step taking into account the
Overlap and Buffer Minutes

· Beginning of Step: The next step will commence in parallel to this Step taking into account
the Overlap and Buffer Minutes

Overlap Minutes - Enter the minutes that the subsequent Step can overlap this step 

Buffer Minutes - Enter the minutes that the subsequent Step must wait before it can begin

Task Instructions Sub-Tab

The Task Instructions Sub Tab allows you to add extensive notes against this Task.  You can enter
unlimited amount of instructions that relate to this Task within the Template.  These Instructions
will be available for printing on Job Order documents.  Whenever you click on this field an icon will
appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text table. 
Select the text to be copied and either press the OK Button in that screen or double-click the
selected record.

Task Resources Sub-Tab

The Task Resources Sub Tab allows you to identify any Resources that are required to perform
this Task.  These Resources will appear on the Job Planning Board for Resource Scheduling
purposes

Entry and Display fields

Resource Type: From the drop-down list select the Resource Type.  The options are Asset or
Employee.
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Resource Name: From the drop-down list select the Resource Name.  The options available are
related to the Resource Type selected above

Buttons

Close: This will close the Templates screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: If you are in the Task Detail Sub-Tab then a blank Task Detail screen will be presented for
entry of a new Task.  If you are in the Task Resource Sub-Tab then the cursor will go to a new line
for entry of a new Resource.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: If you are in the Task Detail Sub-Tab then this will delete the current highlighted Task from
the upper panel.  If you are in the Task Resource Sub-Tab then the current highlighted Resource
record will be deleted.

Related:     This will bring up a list of functions that are related to the Template.    You may open
and maintain information in those screens whilst still remaining in the Template screen.

Reports:     This will bring up a list of Reports that are related to the Template.   You can
immediately run the report whilst still remaining in the Template screen.

Task Lines

The Task Lines tab enables you to add lines to Tasks identified as ‘Multiple Job Lines can be
linked to this Task’.

Entry and Display fields

The Upper panel shows all the lines that are currently used in this Task.  The maintenance of
those records are carried out in the lower part of the screen as follows:

Task Name: Display only field showing the current Task selected via the 'Tasks' tab

Line No: During an ‘Add’ Transaction the program automatically generates a Line Number that is
the current highest Line Number plus 10.  This can be amended if required.  

Line Type: From the drop-down list select the Line Type.  The options are:
· Item Code
· Descriptor Code
· Kitset Code
· Task Bill Code

Code: From the drop-down list select the specific component code.  The list will show details
relating to the Line Type option selected.

Unit: Prefilled with the Unit held against the Code.   If the Line Type is ‘Item Code’ and the
selected Item has multiple Units of Measure then you can select the specific Unit from the
drop-down list
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Template Qty: Enter the quantity of this Code that is required in the Template Task. 

Description: Prefilled with the description of the Code taken from the Item, Descriptor, Task Bill,
or Kitset record

Task Name: If you wish to change the Task that this line relates to then select an alternative from
the drop-down list.  

Notes: You can enter unlimited Notes that relate to this Line.  Whenever you click on this field an
icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.  Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

Buttons

Close: This will close the Templates screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: The cursor will go to a new line for entry of a new Task Line record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the current highlighted Task Line record.

Related:     This will bring up a list of functions that are related to the Template.  You may open
and maintain information in those screens whilst still remaining in the Template screen.

Reports:     This will bring up a list of Reports that are related to the Template.  You can
immediately run the report whilst still remaining in the Template screen.

18.6 Job Calendar

The Calendar view allows you to see what resources (Employees and/or Assets) are required to
perform the required tasks.  The main screen is split into three sections

· The main panel shows Resources, when and on what Job they are required.
· The upper-right panel shows a calendar for you to select the displayed time periods
· The lower- right panel shows all Jobs yet to be scheduled

You can resize these panels by clicking on the panel boundaries and dragging them to the
required position

Main Panel

The Main Panel shows all Job Tasks scheduled for each day displayed.  The tasks on display can
be viewed:

· For single or multiple Employees and/or Assets
· Grouped by Resource within Date, Date within Resource, or Jobs by Date
· In Daily, Workday, Weekly, Monthly, or user-selected time periods
· With a horizontal Timeline
· Filtered by Customer, Project, Job Type, Job Order, or Department
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See the ‘Toolbar’ Buttons - below for setting up these functions

The following options are available.

Time Scale: To amend the timeslots of the visible panel right click on the scale down the left-hand
side.  The scale options are:

5 Minutes
6 Minutes (0.1 Hour)
10 Minutes
15 Minutes
30 Minutes
60 Minutes

Task Information: Each Task shows the following Information
Start and End Time - This is only shown if the start time and/or end time coincides with
the Time Scale defined above
Task Description - Description of the Task as held against the Job
Job Number - Job Number containing the Task

Over 1 day: If a Task goes over one day then it is presented above the timeslots:
Begins today - The panel will have a ‘clock’ icon on the left showing the start time of the
Task
Ends Today - The panel will have a ‘clock’ icon on the right showing the end time of the
Task
Begins Earlier and ends Later than today - The panel will appear above the timeslots
with no ‘clock’

Task Status: The Task Status is displayed as a coloured ‘band’ surrounding the Task.  To see the
assigned ‘Band’ colours right click on a Task and select ‘Task Status’.  The current assigned
colours are:

White - Closed
Diagonal White Stripe on Blue - Open
Blue - In Progress
Magenta - On Hold

Task Status Side Band: The Task Status is also displayed as a thin coloured ‘band’ to the left of
the Timeline.  This displays the Task Status of both Tasks completed within a day and Tasks that
take more than a day.

Tracking Code: The Task itself can be colour-coded to provide an immediate view of the Tracking
Status.  Tracking Statuses are user defined along with the displayed colours via
Jobs>Settings>Tracking Codes.   To assign and/or amend a Tracking Code to a Task right-click
and select ‘Tracking Code’.    This will immediately change the colour-code of this Task

Task Details: To look at the Task Details right click and select ‘Open Task’

The Job Tasks Details screen will be presented.  In this screen you can:
· Add new Tasks
· Remove current Tasks
· Amend the Start Time, End Time and/or Duration of the Task
· Amend the Resource allocated to the Task
· Add another Resource or delete the current assigned Resource

These changes will be immediately reflected in the Calendar View 
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Drag and Drop: You can drag a Task and drop:
· Against another Resource
· In the same Resource but to another timeslot

Amend Timeline: You can amend the timeline against a Task dragging the Start or End boundary
and dragging it to the Required Time

Parallel Tasks: You can assign Parallel Tasks to a Resource and they will appear side-by-side in
the Main View

Multiple Resources per Task: If you move one Resource’s Start and End time for a Task then all
other Resources involved with that task will also move.

Calendar Job Options

Creating Jobs and Resource Allocation

Create a job using the duration held against each Task: - Under a ‘Resource’ column
click on the time where you wish to start the Job and ‘Right Mouse’.  Select ‘New Job from
Start Time’.  This will bring up a Job Creation panel for you to create a new Job.  The
created Order will begin at the designated Start time and will auto-calculate the Job
duration based upon the included Tasks (default Task or Tasks in a Template)

Create a job using the specified Duration: - Under a ‘Resource’ column click on the
time where you wish to start and drag the cursor down to encompass a duration then ‘
Right Mouse’.  Select ‘New Job from Selected Time’.  This will bring up a Job Creation
panel for you to create a new Job.  The created Order will begin at the designated Start
time and have a duration as defined by the darker coloured area created by the above
cursor drag.

New Booking for an existing Job: - This feature allows you to allocate a Resource to an
existing Job/Task.  Under a ‘Resource’ column click on the time where you wish to start
the Allocation and ‘Right Mouse’.  Select ‘New Booking for an existing Job’.  In the
presented panel select a Job Order and click the ‘OK’ button.  (If the Job contains more
than one Task you will be required to select the Task)   The Allocation will be added to this
panel in addition to adding the Resource to the Job Task.

New Booking from Copy: - This feature allows you to allocate a Resource to an existing
Job/Task by copying an existing allocation.  You should first go to the Job Task that you
wish to copy and ‘Right Mouse’ then select ‘Copy Booking’.  You should then under the
under the ‘Resource’ column click on the time where you wish to start the copied
Allocation and ‘Right Mouse’.  Select ‘New Booking from Copy’.   The Resource will be
added to the Job Task in addition to the Allocation appearing in this calendar.

Display Today’s activities: - This feature shows the display commencing with the system
date.   Simply ‘Right Mouse’ and select ‘Today’.

Go to Date: - This feature shows the display commencing with your selected date.  You
also have the option to select a Day, Week, Month, or workday calendar display format. 
Simply ‘Right Mouse’ and select ‘Got To Date’.

Resource Layout Editor: - This feature allows you to restrict the display to selected
Resources.  Note: if you exit and return to the Job Calendar the selections are lost.. If you
wish to retain previous settings then add a Department Code to the Resource (Employee
or Asset) record.  In the Job Calendar you can filter by ‘Department’.  This filtering will be
retained (by User) when you exit the Calendar.
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Resources per Page: - You can select the number of Resources that is to be displayed.
If the number is greater than the maximum allowed by Ostendo then you the display will
remain at that maximum.  However you will see a scroll-bar and other options appearing at
the bottom of the Calendar.

Maintaining the Job Tasks and Allocations

Open Allocations: - Go to the Allocation and either 'double click' or ‘Right Mouse’ and
select ‘Open Allocations’.  In either case a panel (Resource Allocation) will be presented
which shows information about the current Resource and this Task.  Option is provided to
enter or amend the Labour Code linked to this Task/Resource in addition to entering
specific Notes.   Upon exiting the 'Resource Allocation screen the Notes from that screen
will appear in the Allocation.

Open Job Task: - Go to the Allocation and ‘Right Mouse’.  If you select ‘Open Task’ then
the Task screen for the selected Job will be displayed.  You can make changes to the
Task as required.

Open Job: - Go to the Allocation and ‘Right Mouse’.  If you select ‘Open Job’ then the
Detail screen for the selected Job will be displayed.  You can make changes to the Job as
required.

Open Resource Assignments: - Go to the Allocation and ‘Right Mouse’.  If you select ‘
Open Resource Assignments’ then a panel will be presented that shows all resources
assigned to this Job

Set Task Status: - Go to the Allocation and ‘Right Mouse’.  If you select ‘Set Task Status’
you have the option to define the status of the Task (Open, Closed, In Progress, or On
Hold).  The line colour of the Allocation in the Calendar will change to reflect the status

Set Task Tracking Code: - Go to the Allocation and ‘Right Mouse’.  If you select ‘Set
Task Tracking Code’ you have the option to select the current Tracking Code.  (Tracking
Codes are maintained via Jobs>Settings>Job Tracking).  If the selected tracking has a
linked colour code then the Allocation in the Calendar will be filled with that colour.

Set Resource Status: - Go to an Allocation and ‘Right Mouse’.  If you select ‘Set
Resource Status’ you have the option to select a Status icon.  Having selected the Status
you will see that the associated Icon will appear in the Allocation.

Delete Booking: - Go to an Allocation and ‘Right Mouse’.  If you select ‘Delete Booking’
you will be asked to confirm the action.  Upon acceptance the Allocation will be deleted
from both the Calendar and the Job.

Copy Booking: - This allows you to copy an Allocation and associate the copy to another
Resource (or even duplicate against this Resource).  For more info see ‘New Booking
from Copy’ above.

Creating an Allocation Hint

You can create a ‘Hint’ that is displayed whenever the cursor is positioned over the activity.  The
content of this can be plain text or can include fields from the Job’s Header record.  For example:
The text could be

Customer = [CUSTOMER]
Phone = [ORDERPHONE]
Contact = [ORDERCONTACT]
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When the cursor is positioned over the activity the following would be displayed

Customer = Jim Gold & Co Ltd
Phone = 44 312 587 6544
Contact = Ken Jolly

The fields in the square brackets are those defined in the JobHeader table.  

To create the Hint go into Jobs>Settings>Job Types.   You can create the Hint that applies to each
Job type.

To see the available fields go to General>Reports>Full Listing of Tables and select JobHeader

Calendar Panel

This panel shows a standard Calendar by month.  You can view more months by dragging the
Calendar Panel boundary left/right/up/down to let you view the desired months.  Within this panel
you will see the following:

Active Days: Any Days that contain a Job Task will be in Bold.  Clicking on this day will bring up
that day in the Main Panel.  Note: If the View is restricted to specific Resources (see Resources
and Filter Toolbar Buttons - below) then this highlighting reflects that selection.

View Days: If you Drag the cursor over a few days then release, the Main Panel will immediately
reflect the selected time-span.

Jobs Not Booked In Panel

This panel shows all the Jobs that have been generated but have not yet been ‘Booked In’.  A Job
must be ‘Booked In’ before it is scheduled and added to the Main Panel.  To ‘Book In’ a Job you
can either:

· Click on the ‘Job Booking’ Button on the Job Details screen (Jobs>Job Orders>’Details’
Tab)

· Highlight the Job in this panel then ‘Right Click’ and select ‘Book In’
· Double Click on the Job in this panel

All three options will bring up a ‘Booking In’ panel.  This panel contains the following:
Job Information: Display only area showing details on the Job
Job Start: Prefilled with the Jobs date and time.  You can amend this if required.  If you
click on the ‘Calculate Job End Date and Time’ button the program will apply the Job
duration to the calendar set up in General>Settings>Work Times to arrive at an end Date
and Time.  This will be shown at the bottom of the screen.
Job Tasks: Initially all the tasks will have no Start Date/Time and End Date/Time
information.  When the above ‘Calculate Job End Date and Time’ button is pressed the
program will calculate the times for each Task based on the ascending Sequence Number
and place the results against each Task.
Job End: Initially this will be blank.  When the above ‘Calculate Job End Date and Time’
button is pressed the program will calculate the times for each Task and finally calculate
that Job’s End Date and Time.
(Button) Display Job Calendar: This will take you back to the calendar view where the
Resource requirements can be viewed and adjusted. 
(Button) Clear Booking: Reverses the ‘Booked In’ status generated by the next button.
(Button) Book In: This generates the Resource Requirements for this Job, which will now
appear on the Job Calendar.
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Open Job Order: You can highlight a selected Job and right click then select ‘Open Job Order’ to
view and/or adjust the Job Details.

Toolbar Buttons

All the Toolbar Buttons can be turned on or off by selecting the drop-down to the right of the
Toolbar and selecting ‘Add or Remove Buttons’

Print: You can output the current view to your screen prior to printing or print directly to a selected
printer.

Email: The drop-down list provides the following options
PDF - Generates a Portable Document Format (PDF) document of the displayed
information and then opens up the Emailing routine on your PC with this PDF document as
an attachment
XLS - Generates an XLS (spreadsheet) from the displayed information and then opens up
the Emailing routine on your PC with this XLS document as an attachment
HTML - Generates an HTML format and displays this in the ‘body’ of the generated email
XML - Generates an XML document, which can be called and displayed as a standard
Web form.    It also creates an XSL document showing the source document from the
displayed information.  The program then opens up the Emailing routine on your PC with
the XML and XSL documents attached.
CSV - Generates an CSV (Comma Separated Value) document from the displayed
information and then opens up the Emailing routine on your PC with this CSV document as
an attachment

Export: The drop-down list provides the following options
PDF - Generates a Portable Document Format (PDF) document.   This file can then
printed and/or attached to an email
XLS -  If this is selected then a panel will appear for you to save the current displayed data
as an Excel Spreadsheet.  You may then call up Excel and manipulate the data as
required.
HTML - If this is selected then a panel will appear for you to save the current displayed
data as an HTML file.  This file can then be called and displayed as a standard Web form
using your Browser.
XML - If this is selected then a panel will appear for you to save the current displayed data
as an XML file.  Two files are created.    

· An XML document that can be called and displayed as a standard Web form
using your Browser.

· An XSL document showing the source document 
This file can then be called and displayed as a standard Web form using your
Browser.

CSV - If this is selected then a panel will appear for you to save the current displayed data
as a Comma Separated Value file.  This can be used as an import format to external
systems.     You may also call up the CSV file in Excel (File Type = .csv) and manipulate
the data as required.

New Job Order: This will bring up a panel for entry of the following information that is required
when creating a New Job Order.

Order Date: The Date that the Order was raised.  This is prefilled with system date but
can be amended by selecting the date from the drop-down calendar
Required Date: Enter the date when this Job is required.  It is prefilled with the system
date but you can amend it by either overtyping or selecting the date from the drop-down
calendar.
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Requested Time Of Day: This is an optional open-format field where you can specify
what time of day you would like this Job to be completed.  It is for reference only and does
not affect any Job scheduling function
Order or Quote:  Select the button to denote that your creating a Job Order or a
Quotation.
Job Type:  From the drop-down list select the Job Type that you are going to use against
this Job.  Job Types are user-defined and include the Job Style, Invoice Style (From
Schedule, From Actual Entries, No Invoice) and Job Number Prefix.  
Job Style: Display only field showing the Job Style held against the above Job Type
record.
Order Number: If the Job or Quote Order numbering is manual (as defined against the
Job Type) then this field will become active.  Enter a Job/Quote Number.  The program will
check that this number does not currently exist in Ostendo.  
Customer or Company Site: From the drop-down list select:
  - The Customer if this is a Customer related Job
  - The Company Site if this is an ‘Internal’ Job.
Description: Enter a brief description of the Job.  This will be displayed and print out
whenever the Job Number is referenced.
Use A Template for this Job: If this checkbox is ‘checked’ then the next field becomes
active
(Template): From the drop-down list select the Template that will generate the Job
Details.  You should note that if you select this option than the Task and Resource tabs
cannot be accessed.
Project or Company Asset: This is an optional entry field where you can select, from the
drop-down list:
  - A Project Code if this is a Customer related Job
  - The Company Asset if this is an ‘Internal’ Job.
(Description): Description of the Project or Company Asset chosen in the previous
drop-down selection
Notes: You can enter unlimited amount of Notes that are related to this Job Order.  These
notes will be available wherever the Order is reported.  Whenever you click on this field an
icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.
Estimated Duration: Enter the estimated duration that this Job will take to complete.  Two
fields are available.  The first field defines the quantity and then next the Units (Hours or
Minutes).  This is prefilled with the default duration as defined in Jobs>Settings>Job Rules.

Copy Existing Job Order 
Order or Quote:  Select the button to denote that your creating a Job Order or a
Quotation.
Select Existing Order No for Copy: From the drop-down list select the current Job Order
or Quote to copy and create a new Order or Quote

Task Information - To be completed if a Job Template is not used
Task Name:  This is prefilled with the Task defined as the ‘default’ Task in the Job Task
screen. 
Task Description: This is prefilled with the description of the default Task 
How Are Invoice Lines Created: From the drop-down list select how the lines are
created.  The options are:

· A Single Task Bill is linked to this Task: If this is selected then a single Task
Bill is selected in the next field.

· Multiple Job Lines can be linked to this Task: If this is selected then Lines can
be added within the generated

Task Bill Code: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  From the drop-down list select the Task Bill.  Task Bills are maintained under
Jobs>Task Bills
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Description: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  This is prefilled with the Description of the selected Task Bill but it can be
amended here and made specific to this Job.
Qty: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is selected.
Enter the quantity of this Task Bill that is required in this Job. 
Unit: Display only field showing the Unit of the Task Bill.
Unit Price: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  This is prefilled with the evaluated Sell Price for the Task Bill and the Pricing
Matrix relating to the Customer / Descriptor.  This price may be amended here and made
specific to this Job.  If a Price change is made then the ‘Price Override’ checkbox will be
flagged accordingly.
Tax Code: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  This is prefilled with the Tax Code derived from the Customer Tax Group /
Descriptor Tax Group relationship.  It can be amended here by selecting a Tax Code from
the drop-down list.  Tax Codes are maintained by selecting File>Financial
Configuration>Tax Codes.
Analysis Group: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option
is selected.  The Analysis Group enables you to report and analyse Descriptors by their
Group.  To select a Group click on the drop-down list.  Analysis Groups are
user-maintained by clicking on the icon to the right of the field or by selecting
General>Settings >Analysis Groups

Resources - To be completed if a Job Template is not used.  You may (optionally)
predefine the specific Resources used with this Job.  These Resources will appear on the
Job Planning Board for Resource Scheduling purposes
Resource Type: From the drop-down list select the Resource Type.  The options are
Asset or Employee.
Resource Name: From the drop-down list select the Resource Name.  The options
available are related to the Resource Type selected above

Buttons
Create: Click the ‘create’ button to generate the Job Order.

Cancel: Click the ‘cancel’ button to exit this panel

Horizon: This shows the current time-span of the calendar
· Date From: This is evaluated from today's date using the 'Calendar Days Back' value

defined in the Job Calendar Rules.  You can amend this specific view by selecting a new
date from the drop-down calendar and clicking the refresh icon

· Date To: This is evaluated from today's date using the 'Calendar Days Forward' value
defined in the Job Calendar Rules.  You can amend this specific view by selecting a new
date from the drop-down calendar and clicking the refresh icon

Resources: If you click on this button then the following options are presented in the drop-down
list

Group By: The Main Panel display will change to reflect the selection from
None - All Jobs (not showing Resources) for above Calendar View
Resource - Display will be Date within Resource for above Calendar View
Date - Display will be Resource within Date for above Calendar View

Resource Layout Editor: ‘Check’ the Resources that you want to appear on the Main
Panel and use the ‘Up’ or ‘Down’ buttons to defined the order in which they are to be
displayed.
Resources per page: Enter or select the number of Resources you wish to appear to be
visible on the Main Panel.  Note: At the bottom left of the Main Panel are scroll arrows that
lets you scroll left or right to view all Resources.
Employee and/or Asset: Check either (or both) Resources to select if they are to appear
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in the Main Panel

Views: The Views drop-down enables you to select a view that changes the way you look at the
current Jobs:

· Days - Shows Resource requirements for current Day
· Workdays - Shows Resource requirements for the days identified as a workday in the

current week as set up in General>Settings>Work Times.
· Weeks - Shows Resource requirements for current week
· Months - Shows Resource requirements for current Month
· Timeline - Displays the daily Resource requirements in a horizontal format
· Go to Date - Brings up a panel for you to enter the date to display
· View Position - You can select whether to have the ‘Calendar’ and ‘Jobs Not Booked In’

Panels appear on the left or right of the screen.

Job Orders: Brings up the main Job Orders screen for you to work with that function whilst still in
the Job Calendar screen

Customers: Brings up the main Customer screen for you to work with that function whilst still in
the Job Calendar screen

Employees: Brings up the Employee screen for you to work with that function whilst still in the Job
Calendar screen

Project: Brings up the main Projects screen for you to work with that function whilst still in the Job
Calendar screen

Tracking Codes: Brings up the Tracking Codes screen for you to work with that function whilst still
in the Job Calendar screen

Call Centre: Brings up the Call Centre screen for you to work with that function whilst still in the
Job Calendar screen

Filter By: Clicking on this button shows the filter options by:
· Customer
· Project
· Job Type
· Job Order
· Department

Selecting one of these brings up a field with a drop-down that allows you to select the specific filter.
The Main Panel display will then restrict the display to that selection.

18.7 Job Orders

This screen allows you to create and maintain Job Orders.

List Tab

Display fields

The displayed fields are taken from Job Order information entered into the ‘Detail’ tab.  The
selection of which fields to display is at the user’s discretion.  To select the fields to display simply ‘
right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
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· Define the sort sequence of the records by going to the lower panel and dragging the field
from ‘Available Fields’ to ‘Sort By’. 

· Click the ‘Save’ Button when done.

Note: If you select the CURRENTDUECOLOUR field then the field will show colours relating to the
Due Date of the Order compared to today's date
Similarly if you select PLANNEDDUECOLOUR field then the filed will show colours relating to the
Planned Date compared to today's date.  
The displayed colours are:

· Red - Overdue
· Orange - Due Today
· Yellow - Due Tomorrow

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Job Orders
whose status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Job Order screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will bring up a panel for entry of the following information that is required when creating
a new Job Order.

Creating a New Job Order 
Order Date: The Date that the Order was raised.  This is prefilled with system date but
can be amended by selecting the date from the drop-down calendar
Required Date: Enter the date when this Job is required.  It is prefilled with the system
date but you can amend it by either overtyping or selecting the date from the drop-down
calendar.
Requested Time Of Day: This is an optional open-format field where you can specify
what time of day you would like this Job to be completed.  It is for reference only and does
not affect any Job scheduling function
Job Type:  From the drop-down list select the Job Type that you are going to use against
this Job.  Job Types are user-defined and include the Job Style, Invoice Style (From
Schedule, From Actual Entries, No Invoice) and Job Number Prefix.  
Job Style: Display only field showing the Job Style held against the above Job Type
record.
Order Number: If the Job or Quote Order numbering is manual (as defined against the
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Job Type) then this field will become active.  Enter a Job/Quote Number.  The program will
check that this number does not currently exist in Ostendo.  
Customer or Company Site: From the drop-down list select:
  - The Customer if this is a Customer related Job
  - The Company Site if this is an ‘Internal’ Job.
Purchase Order: Open format field for entry of the Customer’s Purchase Order Number.
If the ‘Purchase Order Mandatory’ checkbox against the Customer Master record is ‘
checked’ then an entry here is mandatory. 
Description: Enter a brief description of the Job.  This will be displayed and print out
whenever the Job Number is referenced.
Use A Template for this Job: If this checkbox is ‘checked’ then the next field becomes
active
(Template): From the drop-down list select the Template that will generate the Job
Details.  You should note that if you select this option than the Task and Resource tabs
cannot be accessed. 
(Description): Description of the Project chosen in the previous drop-down selection
Customer or Company Asset: This is only visible if the Job Type covers a
Company/Customer Asset.  You should select the Asset from the drop-down list.  The field
displayed relates to the Type of Job being created:
  - A Customer Asset Code if this is related to a Customer Asset
  - The Company Asset if this is an ‘Internal’ Job.
(Description): Description of the Customer or Company Asset chosen in the previous
drop-down selection
Project: This is an optional entry field where you can select a Project Code from the
drop-down list. 
(Description): Description of the selected Project
Notes: You can enter unlimited amount of Notes that are related to this Job Order.  These
notes will be available wherever the Order is reported.  Whenever you click on this field an
icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.
Estimated Duration: Enter the estimated duration that this Job will take to complete.  Two
fields are available.  The first field defines the quantity and then next the Units (Hours or
Minutes).  This is prefilled with the default duration as defined in Jobs>Settings>Job Rules.

Copy Existing Order 
(Radio Buttons) Order or Quote: Select whether you are copying an Order or a Quote.
Select Existing Order Number for Copy: From the drop-down list select the current Job
Order or Quote to copy and create a new Order or Quote
OrderNumber: Display only showing the selected Order or Quote.
Purchase Order: Optional entry for you record the Customer's Purchase Order reference

Create a Quote revision from the Selected Quote
Multiple Quote Revisions can be created by using this radio button.  Each Revision
created is automatically given the original Job Number followed by a #99 where 99 is a
system-generated increments number.
Selected Quote Number: Display only showing the currently selected Quote
If you now click the 'Create Quote' button then a Quote Revision record will be generated
NOTE: Only one revision is current at any one time, and this can be swapped via the Job
Order's 'List' screen where a button captioned ‘Set Current’ (which only displays when on a
Non Current version Quote). 

(Tab) Task Information - To be completed if a Job Template is not used
Task Name:  This is prefilled with the Task defined as the ‘default’ Task in the Job Task
screen. 
Task Description: This is prefilled with the description of the default Task 
How Are Invoice Lines Created: From the drop-down list select how the lines are
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created.  The options are:
· A Single Task Bill is linked to this Task: If this is selected then a single Task

Bill is selected in the next field.
· Multiple Job Lines can be linked to this Task: If this is selected then Lines can

be added within the generated
Task Bill Code: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  From the drop-down list select the Task Bill.  Task Bills are maintained under
Jobs>Task Bills
Description: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  This is prefilled with the Description of the selected Task Bill but it can be
amended here and made specific to this Job.
Qty: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is selected.
Enter the quantity of this Task Bill that is required in this Job. 
Unit: Display only field showing the Unit of the Task Bill.
Unit Price: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  This is prefilled with the evaluated Sell Price for the Task Bill and the Pricing
Matrix relating to the Customer / Descriptor.  This price may be amended here and made
specific to this Job.  If a Price change is made then the ‘Price Override’ checkbox will be
flagged accordingly.
Tax Code: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  This is prefilled with the Tax Code derived from the Customer Tax Group /
Descriptor Tax Group relationship.  It can be amended here by selecting a Tax Code from
the drop-down list.  Tax Codes are maintained by selecting File>Financial
Configuration>Tax Codes.
Analysis Group: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option
is selected.  The Analysis Group enables you to report and analyse Descriptors by their
Group.  To select a Group click on the drop-down list.  Analysis Groups are
user-maintained by clicking on the icon to the right of the field or by selecting
General>Settings >Analysis Groups

(Tab) Resources - To be completed if a Job Template is not used.  You may (optionally)
predefine the specific Resources used with this Job.  These Resources will appear on the
Job Planning Board for Resource Scheduling purposes
Resource Type: From the drop-down list select the Resource Type.  The options are
Asset or Employee.
Resource Name: From the drop-down list select the Resource Name.  The options
available are related to the Resource Type selected above

Buttons
Create Quote: Click on this button to generate a Quote.  This action will take you to the
Quote ‘Details’ tab for entering further information.
Create Order: Click on this button to generate a Job Order.  This action will take you to
the Order ‘Details’ tab for entering further information.
Cancel: Click the ‘cancel’ button to exit this panel

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This removes the current Job Order from this table

Related: This will bring up a list of functions that are related to the Job Order.  You may open and
maintain information in those screens whilst still remaining in the Job Order screen.

Reports: This will bring up a list of Reports that are related to the Job Order.  You can immediately
run the report whilst still remaining in the Job Order screen.
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Print: This will allow you to generate and print the current Job Order

Job Invoices: Only displayed if the Job is an 'Order' (I.e. not a Quote).  When clicked this will take
you to the Job Invoices screen for maintenance of Invoices against this Job.  For more details see ‘
Job Invoices’ in this guide.

Set Current: Only displayed if the Job is a 'Quote' and the Quote is an earlier Revision of the
current Quote.   Clicking this button will change the current 'Non Current' status of the Quote to a
'Current' status and will also revert the existing 'Current' status Quote to 'Non Current'

Detail Tab

Entry and Display fields

Order Number: Display only field showing the Job Order number. 

Order Date: This is prefilled with the system date.  You can amend the date by either overtyping
the date or selecting the date from the drop-down calendar.

Status: During Order creation this is prefilled with ‘Quote’ for a Quotation and cannot be amended.
 
For Job Orders this is prefilled with the status defined against the Job Type.  You can amend this
status by selecting the required status from the drop-down list.  The options are:

· Planned
· Open
· In-Progress
· Finished
· On-Hold
· Closed

Description: Enter a brief description of the Job Order.  A longer description can be entered into
the ‘Notes’ field at the bottom of the screen.  No checks are made on the entry

· The Job Order Description is now automatically prefilled with the Job Template

Description if the Job was created via the “Service Orders Required” screen.

Previously this would be prefilled with the Job Template Code. If you wish this

to now behave as it did previously, then insert a new User Defined Constant

called Use Template Code for Order Description (ensure it is defined

exactly as this name) with a type of “Yes/No”. If this is set to Yes (True),

Ostendo will behave as it did previously.

Job Type: Display only field showing the Job Type selected during order creation or the Job Type
of the Order being copied during Order creation.

Job Style: Display only field showing the Job Style as held against the above Job Type.

Quotation Print: This is only visible if the Status is ‘Quote’ and defines the current print status of
the Quote.  You can print the Quotation by clicking on the adjacent ‘Print’ Button.  After printing this
will be set to ‘Printed’.  You can reset it to ‘Not Printed’ from the drop-down list if required.

Job Sheet: This is visible if the Status is not ‘Quote’ and defines the current print status of the Job
Sheet.  You can print the Job Sheet by clicking on the adjacent ‘Print’ Button.  After printing this will
be set to ‘Printed’.  You can reset it to ‘Not Printed’ from the drop-down list if required.
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Current Task: From the drop-down list select the Task that is currently being processed.   This,
combined with the Tracking Code provides a visual status of all Job Orders in Inquiry View 'Inquiry
-  Job Progress'

Tracking Code: From the drop-down list select the Tracking Code.  Tracking Codes are user
maintained (Jobs>Settings>Job Tracking) and enable you to track your Jobs and filter views or
reports by this Code.

Site Name: Select the site name from drop-down list.

Job Settings Tab

Credit Terms: Not available for Job Style ‘No Invoice’ Jobs.  This defaults to the Credit Terms held
against the Customer.  You can amend the Credit Terms by clicking on the drop-down icon and
selecting the Terms that apply to this Order.  

Purchase Order: Open format field for entry of the Customer’s Purchase Order Number.  

Tax Group: Not available for Job Style ‘No Invoice’ Jobs.  This defaults to the Tax Group held
against the Customer but you may amend this from the drop-down list and select the Tax Group
that applies to this Sales Order.  This Tax Group combined with the Tax Group of the Item or
Descriptor being sold defines the rate of Tax that applies.  You may maintain Tax Groups by
selecting File>Financial Configuration>Tax Groups

Sales Person: This defaults to the Salesperson held against the Customer record but you may
amend this from the drop-down list of Salespeople.  Salespersons are maintained under
General>Employees

Project: This defaults to the Project as entered during Job Order creation.   You can change this
by clicking on the drop-down icon and making the selection that you wish to apply to this Order.  

Job Category: From the drop-down list select the Job Category that applies to this Job Order.
Job Categories are used for analysis and reporting purposes.

Additional Fields Tab

If you have defined Additional Fields against the Job Order (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Dimensions Tab

If the ‘Display Dimensions’ field in Job Rules is ‘checked’ then this tab will be displayed.  It
contains the following fields that apply to the Job Header

Planned Order Weight: A display only field calculated from all the Order Line’s Planned
Quantity multiplied by the line’s ‘Unit Weight’.
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Planned Order Area: A display only field calculated from all the Order Line’s Planned Quantity
multiplied by the line’s ‘Unit Area’.

Planned Order Volume: A display only field calculated from all the Order Line’s Planned
Quantity multiplied by the line’s ‘Unit Volume’.

Actual Order Weight: A display only field calculated from all the Order Line’s Actual Quantity
multiplied by the line’s ‘Unit Weight’.

Actual Order Volume: A display only field calculated from all the Order Line’s Actual Quantity
multiplied by the line’s ‘Unit Volume’.

Actual Order Area: A display only field calculated from all the Order Line’s Actual Quantity
multiplied by the line’s ‘Unit Area’

Scheduling Tab

Order Priority: This defines the priority attributed to the Order for use with the Order
Availability scheduling function.  It is prefilled with the setting held against the Customer record
but can be changed here if required.  The Priority number can be between 1 and 9 (1 being the
highest priority). 

Full Pick Only: ‘Check’ this checkbox if you wish to see only those Job Orders where the full
Item requirements are available for Issue.  This is prefilled with the setting held against field ‘
Availability Job Full Pick Only’ in the Requirements Rules but can be changed here if required.

Job Assigned: This is a display-only checkbox to indicate whether this job is already
assigned.

The Scheduled Time has been Fixed: If this is 'checked' then this is telling the Constraint
Scheduling process that the current dates held against this Order are Fixed and cannot
therefore be re-scheduled.   

Earliest Start Date: From the drop-down calendar select the date before which this Order
cannot be scheduled by the Constraint Scheduling routine

Finished Date: From the drop-down calendar select the date this job was finished. Finished
date is used in the calculation of the next Recurring Service event or Planned Service event.

Service Zone: The Service Zone related to this customer.

Overrides Tab

Override Pricing Levels: If this is 'checked' then you may override the Price Level that
applies to this Order

Price: From the drop-down list select the Price Level that you wish to apply to this Job if
different to the Customer's normal Price Level.  Price Levels determine Item and Descriptor
Sell prices using a pricing structure relating to this Price level.

Rate: From the drop-down list select the Rate Level that you wish to apply to this Job if
different to the Customer's normal Rate Level.  Rate Levels determine Labour Sell prices
using a pricing structure relating to this Rate level.

Deliver Purchase Direct to Customer: If this is 'Checked' then any Purchase Order
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generated from a  'Supply on Demand' Job Order Line will have its 'Deliver To' address in the
generated Purchase order the same as the Customer Delivery Address of this Job order. 

Override Locations: If this is 'checked' then you may override the Warehouse/Location that
will apply to this Order

WH: This is prefilled with the default Issue Warehouse for this Order.  You can amend this by
clicking on the drop-down list to select the Warehouse from where Items are to be issued.  

Loc: This is prefilled with the default Issue Location - within the above Warehouse for this
Order.  You can amend this by clicking on the drop-down list to select the specific Location
from where Items are to be issued.  

Financial Tab

Financial Category: If required, select the Financial Category applicable. If left blank, it
will use the Financial Category (if any) linked to the associated Cost Centre.

Service Tab  

Mobility Team or Employee: This field allows you to assign the job to a particular employee or a
Mobility team of employees (Team / Employee).

Name: This is the name of the Employee or name of the Mobility team this job is assigned to.

Elapsed Days Before Required Date: This allows you to specify a lead time (no. of days) before
required start date for the job which will be taken into account when the job is listed in Freeway
app.

Urgent Order: Tick this box if this is an urgent job. When and urgent Order is sent to Freeway, it
will be displayed at the top of the list for the Start Day it is assigned to. It will also be marked with a
Red indicator.

Fixed Requested Time: Tick this box if the Requested Time is fixed (not flexible).

Assign Style: This drop-down allows you to select one of the options:
- Standard Job : This "Standard Job" Assign Style

means the job will be removed from the To Be Assigned list once it is assigned to a resource.
- Continuous Job : This option makes the job always

available for selection in the mobile device. 
- Continuous Assignment : This option makes the job always

available for assignment. It will not be removed from the To Be Assigned list in the Assignment
Board (unless the Job is Closed). 

- Assignment Reminder - This option allows you to set up a
job as a booking placeholder for the specific purpose of sending reminders to Freeway users to do
certain tasks.. The job can then be assigned through the assignment board and the Assignment
Subject can be changed to reflect the reminder message - so that the Freeway User sees the
reminder in their Jobs List. Such jobs can remain the the Assignment Board Jobs List area so it
can be used many times.

Style Name : Select the default Style Template for this job.

Asset Tab
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Customer Asset: This will only display if the Job covers a Customer Asset and shows the
Customer Asset as entered during Job Order creation.   You can change this by clicking on the
drop-down icon and making the selection that you wish to apply to this Order.  

(Customer or Company Asset Description): This will only display of the Job covers a Customer
Asset and shows the Assets Description

Tracking Tab

Asset Currently At: This will only display of the Job covers a Customer Asset.  When displayed it
shows the current location as entered into the next field

Asset Tracking (Button): This will only display of the Job covers a Customer Asset.  If you click
on this Button then a separate panel will appear for you to maintain the Asset’s current location in
addition to retaining a history of where it has been located

Readings Tab

Reading Name: This field shows the Reading Name associated with this Asset.

Last Reading: This field shows the last reading value and date.

Current Reading: You can enter the current reading and date here.

Order Discounts Tab

Total Disc: This is for information only and shows the sum of the discounts applying to each line
expressed as a percentage of the sum of each order line with no discount

(Discount Value): This is for information only and shows the sum of the discounts applying to
each line.

Batch Update Discount %: This will bring up a separate panel for adjusting the discount and
shows the following fields:

Discount Every Line with New discount: The discount against each line will be
overwritten with this discount
Ratio All Lines to reflect the New discount: Applies the increase or decrease
percentage change to the current discount percent against each line
Existing Discount %: Display only field showing current discount % 
New Discount %: Enter the revised discount % to be applied

Order Deposits Tab

Deposit: Display only field that shows the total of all Deposits made against this Sales Order

Unapplied: Display only field that shows the amount of Deposits made against this Sales Order
that have yet to be applied.

(Button) Create Deposit:  If this button is pressed then a separate panel will appear for you to
enter a deposit payment against this Order.  This screen contains the following fields;

Order Number: Display only field referring to this Order Number
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Billing Customer: Display only field showing the Billing Customer for this Order
Deposit Date: This is prefilled with the system date.  You may amend this by over-typing
the date or selecting a date from the drop-down calendar.   Upon posting this Deposit a
check will be made to ensure that this date is after the ‘Cut-Off’ date as set up in
File>Financial Configuration>Cut-off dates.
Payment Method: From the drop-down list select the method by which the Deposit was
made.  Payment Methods are user-defined under File>Financial Configuration>Payment
Methods.
Payer Name: Enter the name of the Payer. No checks are made on this entry.
Banking Method: From the drop-down list select the method by which the Deposit will be
banked.  The options are:

Directly to Account: Posting will occur upon update in this screen
Using Bank Deposit: Posting will occur when banked through the Bank Deposit
routine

Payer Branch Name: Enter the name of the Payer's Bank Branch. No checks are made
on this entry.
Account for Payment: From the drop-down list select the Account to which the Deposit
will be made.  Payment Accounts are user-defined under File>Financial
Configuration>Payment Accounts.
Payment Reference: Enter details of the Payment (Example: Cheque Number)
Order Amount: Display only field showing the total amount of the order.
Deposit Amount: Enter the amount received against this Deposit
Remaining Balance: Display only field showing the value of Deposits that have not yet
been applied.

Buttons

Accept: This will create a Deposit record linked to the Order
Cancel: Cancel and ignore the entry and return to the Order Deposits Sub-Tab

Customer: Display only field showing the Customer selected in the Order Creation panel.  If this is
a ‘No Invoice’ Job then Company Site will be displayed

(Button) Additional Order Address Details: This button brings up a small panel that is prefilled
with the Customer’s Address (or site address if the Job Style is ‘No Invoice’) and Contact details.
They can be amended at any time either by clicking the drop-down button and selecting an
Additional Address or by keying an address directly into the following fields.

· Address: Three lines are available for entry of the delivery address of the site.  
· City: Enter the Town or City where this Delivery Address is located.
· State: Enter the State where this Delivery Address is located.
· Code: Enter the Postcode or ZIP Code where this Delivery Address is located.
· Country: Enter the Country where this Delivery Address is located.
· Contact: From the drop-down list select the Contact for this Customer.
· Phone: Enter the Phone number at this Address.
· Fax: Enter the Fax number at this Address.
· Email: Enter the Email reference at this Address.  If an entry does not exist here then the

email address held against the Customer will be used when emailing Order
Confirmations, etc.

Billing Customer: Not available for Job Style ‘No Invoice’ Jobs.  This is prefilled with the Billing
Customer as held against the Customer record.  It may be amended by selecting a new Billing
Customer from the drop-down list

Additional Billing Address Details (Button): Not available for Job Style ‘No Invoice’ Jobs.  A
drop-down panel shows the current address details of the Billing Customer.  They can be
amended at any time by keying directly into the following fields.
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· Address: Three lines are available for entry of the Billing Address of the Customer.  
· City: Enter the Town or City of this Billing Address.
· State: Enter the State of this Billing Address.
· Code: Enter the Postcode or ZIP Code of this Billing Address.
· Country: Enter the Country of this Billing Address.

Job Scheduling

Required Date: It is prefilled with the date entered during Job Order creation, but you can amend it
by either overtyping or selecting the date from the drop-down calendar.

Requested Time Of Day: Prefilled with the time of day entered during Job Order creation. This is
an optional open-format field where you can specify what time of day you would like this Job to be
completed.  It is for reference only and does not affect any Job scheduling function

(Button) Job Tasks: Clicking on this button will bring up the Job Tasks scheduling panel for
maintenance of Tasks and Resources.  For more details see ‘Job Tasks’ in this guide.

Estimated Duration: Prefilled with the estimated duration entered during Job Order creation but
you can amend it here if required.  Two fields are available.  The first field defines the quantity and
then next the Units (Hours or Minutes).  
Job Booking Status: Display only field showing the Booking Status of this Job.  The display
options are ‘Booked In’ and ‘Not Booked In’.  This status is maintained if you press the next (Job
Booking) button

(Button) Job Booking: Clicking this button will bring up a separate panel for generating the Job’s
Scheduling information and comprises:

Job Information: Display only area showing details on the Job
Job Start: Prefilled with the system date and time.  You can amend this if required.  If you
click on the ‘Calculate Job End Date and Time’ button the program will apply the Job
duration to the calendar set up in General>Settings>Work Times to arrive at an end Date
and Time.  This will be shown at the bottom of the screen.
Job Tasks: Initially all the tasks will have no Start Date/Time and End Date/Time
information.  When the above ‘Calculate Job End Date and Time’ button is pressed the
program will calculate the times for each Task based on the ascending Sequence Number
and place the results against each Task.
Job End: Initially this will be blank.  When the above ‘Calculate Job End Date and Time’
button is pressed the program will calculate the times for each Task and finally calculate
that Job’s End Date and Time.
(Button) Display Job Calendar: This will take you to the calendar view where the
Resource requirements can be viewed and adjusted. 
(Button) Clear Booking: Reverses the ‘Booked In’ status generated by the next button.
(Button) Book In: This generates the Resource Requirements for this Job, which will now
appear on the Job Calendar.
(Button) Cancel: Cancels the current activity and returns to the Job Detail screen.

Planned Start Date & Time: Display only field showing the Job Start Date and Time as generated
via the ‘Job Booking’ screen  

Planned End Date & Time: Display only field showing the Job End Date and Time as generated
via the ‘Job Booking’ screen  

Invoice Style: This is only visible if the Status is not ‘Quote’ and is a display only field showing the
style of Invoice being used by this Job.  The displayed options are ‘From Schedule’, ‘From Actual
Entries’, or ‘No Invoice’. 
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Quote Expiry: This is only visible if the Status is ‘Quote’ and defines the expiry date of the Quote.
The date is derived from the Quotation Date plus the number of days set up in Jobs>Settings>Job
Rules.  You can amend the Expiry date by keying in a new date or selecting a date from the
drop-down calendar.

Quote Opt (Button): This is only visible if the Status is ‘Quote’.  Clicking on this button will bring
up the Job Quote Options screen.  This is prefilled with the Defaults identified in the Job Rules but
you may amend these defaults and make the text specific to this Quotation

Convert Quote (Button): This is only visible if the Status is ‘Quote’ and, if selected, will bring up a
new panel with the following fields:

Convert to Order: Select this radio Button if this quote is to be converted into a Job
Order.
Quotation Is Lost: Select this radio Button if this quote has been lost.  In this instance the
next field will become active
Lost Code: Select the reason why the Quote was lost from the displayed list then click
the ‘OK’ button.  Lost Quote Codes are maintained via 
(Button) OK: If the Quote is being converted into an Order then this will commence the
generation of that Order.  If the Quote is ‘Lost’ then this will change the Quote Status to ‘
Lost’.  Note: Lost Quotes can be viewed via a report 

Cost Centre: This is only visible if the Status is not ‘Quote’ and the Invoice Style is ‘No Invoice’.  It
represents the Cost Centre to where Costs are posted.  When displayed it is prefilled with the Cost
Centre currently held against the Job Type record.  You can amend this, is required, by selecting
another Cost Centre from the drop-down list.

This is a Fixed Price Job: This checkbox is active if the Invoice Style is ‘From Schedule’ and
allows you to override the evaluated amount by a Fixed Amount.  The Invoice Schedule can now
be generated using this Value rather that the Amount generated from the line content of the Job
Order.

Cost Centre: This drop-down is only visible if the Invoice Style is 'No Invoice' and allows you to
select a Cost Centre for posting non-labour charges

Labour C/C: This drop-down is only visible if the Invoice Style is 'No Invoice' and allows you to
select a Cost Centre for posting Labour charges

Create an Item: This is only visible if the Job Invoice Style is ‘No Invoice’.  When ‘checked’ it
denotes that you intend to produce an Item from this Job and receive that Item into Inventory. 
When ‘checked’ a new tab (‘Item Creation Info’) will appear for you to enter details of the Item
being produced.

(Button) Item Creation

This is only visible if the above ‘Create an Item’ field is ‘checked’.  When selected a drop-down
panel appears into which you can define the Item being produced by this Job.  You should note
that the Item Code should already exist in Ostendo and be ‘Serial Number’ controlled.  You may
also wish to identify the Item Code record to state that ‘Actual Costing is Used’.  This would then
retain the individual Costs against each Serial Number in stock.

How Item is valued: This is prefilled with the value set up against the Job Type.  It can be
amended here by selecting the way the Item will be valued in Inventory.  The options are:

Cost: The actual Costs booked against the Job Order will be used
Price: The current Sell Price as held against the Item in the Job will be used

Item Code: From the drop-down list select the Item that is being produced.  This Item must be
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identified as Serial Number controlled.  Having selected the above Item Code the following
fields are displayed based upon the ‘Inventory Tracking’ characteristics identified against the
Item.

Receipt Warehouse: This is the Warehouse into which the Item Code will be received.  It is
prefilled with the default Warehouse held against the Item Code record but can be amended
here and made specific to this Job Order.

Receipt Location: This is the Location within the above Warehouse into which the Item Code
will be received.  It is prefilled with the default Location held against the Item Code record but
can be amended here and made specific to this Job Order.

Serial Number: This will be the Serial Number of the Item when it is received into Inventory. It
is a mandatory entry field and the Serial Number must not currently exist in Inventory.

Expiry Date: If this Item Code is ‘Expiry Date’ controlled then this field will be displayed.
When displayed you must enter an Expiry Date prior to receiving the Item into Inventory.

Batch Number: If this Item Code is ‘Batch’ controlled then this field will be displayed.  When
displayed you must enter a Batch Number prior to receiving the Item into Inventory.

Revision Number: If this Item Code is ‘Revision’ controlled then this field will be displayed.
When displayed you must select a Revision Number from the drop-down list prior to receiving
the Item into Inventory.

Grade: If this Item Code is ‘Grade’ controlled then this field will be displayed.  When displayed
you must enter a Grade prior to receiving the Item into Inventory.

Colour: If this Item Code is ‘Colour’ controlled then this field will be displayed.  When
displayed you must enter a Colour prior to receiving the Item into Inventory.

Size: If this Item Code is ‘Size’ controlled then this field will be displayed.  When displayed you
must enter a Size prior to receiving the Item into Inventory.

Nett Value: This field is active if the Invoice Style is ‘From Schedule’ and, if the previous checkbox
is ‘checked’, allows you to specify a Fixed Amount that will represent the Job Price

Job Order Values: The following display-only fields show the current order Values status of this
order:
Order Values: This is for information only and shows:

Ordered Values
Nett Amount of current Job Order
Tax Amount of current Job Order
Total Amount of current Job Order

Invoiced Values
Nett Amount of Invoices raised to date
Tax Amount of Invoices raised to date
Total Amount of Invoices raised to date

To be Invoiced
Nett Amount of ‘Pending’ Invoices awaiting conversion
Tax Amount of ‘Pending’ Invoices awaiting conversion
Total Amount of ‘Pending’ Invoices awaiting conversion

Instructions section

Job : You can enter unlimited amount of Notes/Instructions that are related to this Job Order.



1025Jobs

These notes will be available wherever the Order is reported.  Whenever you click on this field an
icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.  Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

Invoice : You can enter unlimited amount of Notes/Instructions that are related to this Job Order.
These notes will be available wherever the Order Invoice is reported.  Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that screen or
double-click the selected record.

History Notes : All Job History Notes for this job will be displayed here.

Work : You can enter unlimited amount of Notes/Instructions that are related to this Job Order.
These notes will be available wherever the Order is reported.  Whenever you click on this field an
icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.  Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

The idea of having both Job instructions and Work Instructions is so that you can use one of them
solely for internal communications and the other to be sent to the mobile devices via Ostendo
Freeway. There is a rule in Mobility Settings -- Mobility Rules which allow you to specify which set
of instructions will be sent to the mobile devices.
 

Buttons

Close: This will close the Job Order screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: Not applicable to the Detail panel

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Job Order.  You may open and
maintain information in those screens whilst still remaining in the Job Order screen.

Reports: This will bring up a list of Reports that are related to the Job Order.  You can immediately
run the report whilst still remaining in the Job Order screen.

Print: This will allow you to generate and print the current Job Order

Job Invoices: Only displayed if the Job is an 'Order' (I.e. not a Quote). When clicked this will take
you to the Job Invoices screen for maintenance of Invoices against this Job. For more details see ‘
Job Invoices’ in this guide.

Set Current: Only displayed if the Job is a 'Quote' and the Quote is an earlier Revision of the
current Quote. Clicking this button will change the current 'Non Current' status of the Quote to a
'Current' status and will also revert the existing 'Current' status Quote to 'Non Current'

Lines Tab
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This screen allows you to add and maintain Lines in the Job Order.  The Job Order Number and its
Status is displayed at the top of the panel.

Job Order Lines can be created from the following sources:
· Lists
· Items
· Descriptors
· Catalogues
· Kits
· Task Bills
· Labour
· Manual

Each Method is described here

Lists: Lists are pre-defined Lists of Item Codes, Descriptor Codes, Catalogue Codes, and Labour
Codes from which selections are made.  Maintenance of Lists is covered under Inventory>Lists.  
To use ‘Lists’ click on the ‘Lists’ icon on the upper toolbar.  On the displayed panel use the
drop-down list to select the specific List.   This will display the contents of the List. Now ‘check’ the
checkbox against each line that you want to be copied to the Job.  You have the option to click on
the ‘Select All Contents’ Button at the bottom of this panel to select all the records.  You may also
click on the ‘De-select All Contents’ Button at the bottom of this panel to ‘un-select’ all the records.
 For each selected record you can amend the ‘Per Qty’ to denote the quantity you require per ‘List’.
You can enter a multiplying quantity in ‘Multiplied Contents By’ field, which will extend the above ‘
Per Qty’ by this factor.
If you now click on the ‘Create Lines from Selected Contents’ Button then all the selected Lines will
be copied to the Job.   At this time any prices and quantity discounts will be applied to determine
the Job Order Price for each Line.

Items: To select single or multiple Items click on the ‘Items’ icon on the upper toolbar.  This will
display all Items that are currently ‘Active’.   Simply highlight the Item in the top panel then click
the ‘Add to Selected Items’ Button to copy it to the lower part of the screen.  Repeat this for all
required Items.  In the Lower panel amend the required quantity per line as required, or remove the
line by clicking on the ‘Remove from Selected Items’ Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Job.   At this time any prices and quantity discounts will be applied to determine
the Job Order Price for each Line.
If you have Items that are designated as ‘Custom’ products then these should be added to the  Job
Order by clicking the ‘Add’ Button and selecting the Item in the lower part of the ‘Lines’ screen.  A
display will appear depending upon whether the Custom Product is configured by ‘Rules’, ‘Manual’,
or 'Featutes'

· If ‘Rules’ then a screen is presented containing the ‘Questions’ from the Custom Script.
These will be presented in turn which, when answered, will generate a Customised
product whose Cost and Sell Price will be determined from the end configuration

· If ‘Manual’ then a screen is presented showing a basic Bill of Material to make the product.
The routing and line contents of the BOM can be amended to suit the specific
configuration.  You may also amend the Estimated Markup %.   Having configured the
BOM and adjusted the Markup% you should click on the ‘Update Job Line Price’ button to
copy the resultant Sell Price to the Job Order Line.  When completed, Ostendo will
generate a Customised BOM in preparation for generating an Assembly Order to
manufacture the Job Order Line.

· If ‘Features’ then a screen is presented showing the Features and Options related to the
product.  Within each Feature you can nominate the Option to be used.  When completed,
Ostendo will generate a Customised BOM in preparation for generating an Assembly
Order to manufacture the Job Order Line.
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Descriptors: To select single or multiple Descriptors click on the ‘Descriptors’ icon on the upper
toolbar.  This will display all Descriptors that are currently ‘Active’.   Simply highlight the Descriptor
in the top panel then click the ‘Add to Selected Descriptors’ Button to copy it to the lower part of the
screen.  Repeat this for all required Descriptors.  In the Lower panel amend the required quantity
per line as required, or remove the line by clicking on the ‘Remove from Selected Descriptors’
Button.
If you click on the ‘Create Lines from the Selected Contents’ Button then all the selected Lines will
be copied to the Job.   At this time any prices and quantity discounts will be applied to determine
the Job Order Price for each Line.

Catalogues: To select single or multiple Codes from a Supplier’s Catalogue click on the ‘
Catalogue Items’ icon on the upper toolbar.  This will display all Codes that are included in the
Catalogue against whom this order is being placed.   Simply highlight the Code in the top panel
then click the ‘Add to Selected Items’ Button to copy it to the lower part of the screen.  If a
Catalogue Item exists as an Ostendo Item the program will display the Item’s current Ostendo
Stock level.  You have the option to use that stock or continue as a Catalogue Item.  If the
Catalogue Item option is selected then Ostendo will create a ‘Source On Demand’ record to satisfy
the Order.  

Kitsets: A Kitset - containing a user-defined mixture of Items and Descriptors - can be called up
and added to a Job Order line.  The content of the kit is copied as a sub-set to the Job Order Line
and can be amended as required.  However, any Invoice generated from the Job order will state a
sell price at the Kitset level.  The selection of a Kitset is by clicking on the ‘Line Type’ drop-down
list when creating a Job Order Line and selecting ‘Kitset Code’.  The relevant Kitset and quantity
then be selected for this line 

Labour: A Labour Code can be called up and added to a Job Order line.  The selection of a
Labour Code is by clicking on the ‘Line Type’ drop-down list when creating a Job Order Line and
selecting ‘Labour Code’.  The relevant Labour Code and with its cost and unit price will be copied
to this line 

Manual: You can create Manual Order Lines by clicking on the ‘Add’ Button to the right of the
screen.  A Line is created in the upper panel, however maintenance of the record is carried out in
the lower panel.     

(Batch Entry bar)

This bar displays Buttons that provide various options to add lines to the Job in batch form:

Lists: Clicking on this button will bring up the Lists maintained via Inventory>Lists.  From the
displayed List you can select single or multiple Items for copying to this Job

Items: Clicking on this button will bring up a list of Items currently in Ostendo.  From the displayed
list you can select single or multiple Items for copying to this Job

Descriptors: Clicking on this button will bring up a list of Descriptors currently in Ostendo.  From
the displayed List you can select single or multiple Items for copying to this Job

Templates: Clicking on this button will bring up a list of Job Templates currently in Ostendo.  From
the displayed List you can select single or multiple Templates for copying to this Job

Catalogue Items: Clicking on this button will bring up a list of Supplier Catalogues from which you
can select a specific Catalogue.  Note: The Catalogue selection screen is by-passed if you only
have one Supplier Catalogue in Ostendo.   For the selected Supplier the Catalogue Items are
displayed from which you can select single or multiple Items for copying to this Job
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Issues: Clicking on this button will bring up the Job Order Issues screen.  This is prefilled with the
Item and Descriptor lines currently contained in the Order.  You can carry out ‘mass issue’ of the
lines within that screen as follows:

Prefill Issues (Button): Click this button to prefill all lines with the outstanding issue
quantity. You should note however that the displayed list only shows:

· Items whose Supply Method is ‘Supply From Stock’ because all other Items are ‘
Source on Demand’ and will be supplied directly from Purchase or Assembly Orders

· Descriptors that are Sourced By ‘Internal’ because those Sourced By ‘Purchasing’
will be directly supplied from a Purchase Order 

You may either use this ‘Speed Entry’ to prefill lines with the current outstanding quantity
or enter each line as required.  All lines can be amended prior to posting via the ‘update
Job with above Job Issues’ button.  Note that any line that has sub-level variations (Serial
Number, Batch Number, Colour, etc) are NOT prefilled and must be selected at line level. 
The following fields are displayed:
Date: In the first instance this is prefilled with the system Date.  You can change this date
by entering the date or clicking on the drop-down menu and selecting the date.
Task Name: This shows the current selected Task in the Job Order.  You may amend this
by selecting another Task from the drop-down list of steps for the selected Job Order.  
Line Type: This shows the Line Type covering this line.  You may amend this by selecting
another Line Type from the drop-down list.  The options are Descriptor Code or Item
Code.
Code: From the drop-down list select the Descriptor Code or Item Code that applies to this
line
Unit: Prefilled with the base Unit for the Item or Descriptor.  If the Item has more than a
single Unit of Measure then an alternate Unit can be selected from the drop-down list.
Qty: The Quantity to be issued.  This can be amended at any time.  If the Item has
sub-level variations (such as Colour, Size, Batch, etc) then you should click on the Icon to
the right of this field and selected the specific variant(s) from the displayed panel.  This
feature also applies if you are issuing an Item from a location other than the displayed
default location.
Charge Style: Select the charge style from the drop-down list. The options are:
o Chargeable
o Warranty
o Contract
o Non-Charge

Non-Charge Code: If charge Style is ‘non-charge’ then select non-charge code from
drop-down list  
Warehouse: For an Item Code this is prefilled with the default ‘Issue’ Warehouse.  You
may amend this by selecting another Warehouse from the drop-down list
Location: For an Item Code this is prefilled with the default ‘Issue’ Location.  You may
amend this by selecting another Location from the drop-down list
Variants: If the Line Item Number has variants (Serial Number, Expiry Date, Batch No,
Rev No, Size, Colour, Grade) then they should be entered into the respective fields.  
Recorded Notes: Extended Notes for your own information can be attached to this Line.   

Buttons
Close: This will close the Job Order Issues screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.
Add: This will send the cursor to a new line for creation of a new Issue record.
Save: This will save the current line’s data without exiting the screen
Cancel: Any changes made to the current line record or the last time the ‘Save’ Button
was pressed will be lost.
Delete: This will delete the selected Transaction Batch Line
Update Job with the Issues Above: If you click this button then the quantities entered
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against each line will be issued to the Job and - in the case of Items - issued from stock.

(Script): This button will only be displayed if an ‘Order Script’ has been created (via File>System
Configuration>Order Scripts).   When visible the button name will be prefilled with the script name
and, when pressed, will perform the functions of that script. 

(Order Values bar)

If the ‘Display Lines Value Bar’ is ‘checked’ in Job Order Rules then this bar will be visible.  It gives
you the option to view Planned or Actual Values.  From the drop-down list select the Values that
you wish to appear in this ‘Values Bar’.  The options are to display the Planned or Actual values
showing:

Order Value: Display only field showing the sum of the extended sell prices of the above
lines
Order Cost: Display only field showing the sum of the extended costs of the above lines
Margin%: Display only field showing the Margin expected from the Line’s Price and Cost
information calculated from (Sell Price - Cost) / Sell Price
Markup%: Display only field showing the Margin expected from the Line’s Price and Cost
information calculated from (Sell Price - Cost) / Cost
(Button) Alter Markups: If you click on this button then a separate screen will appear that
allows you to amend the Markup% against selected lines in a Job Order. You have the
option - via Radio Button - to apply this to either Planned Cost or the Actual Cost of issues
made against lines.

Adjustment Level: Select the Radio Button against which you are going to adjust
the Markup percentage.  The selected option will define the display in the lower
part of this screen.  The options are:
§ Job - A single line will be displayed
§ Job Task - A single line for each Task in the Job will be displayed
§ Line Type - A single line for each Line Type in the Job will be displayed
§ Analysis Group - A single line for each Analysis Group in the Job will be

displayed
Name:  If the selected Radio Button is:
§ Job then this is populated with ‘Job’
§ Job Task then one line is created for each Task and this identifies the

Task
§ Line Type then one line is created for each Line Type and this identifies

the Type
§ Analysis Group then one line is created for each Analysis Group and this

identifies the Group
Planned Price: Display only field showing the sum of the extended Unit Nett Price
* Order Qty of each line contained within the selected Adjustment Level
Planned Cost: Display only field showing the sum of the Unit Cost * Order Qty of
each line contained within the selected Adjustment Level
Markup%: Display only field showing the current Markup% of the lines contained
within the selected Adjustment Level
Profit: Display only field showing the planned profit being made when using the
Planned Price and Planned Cost
New Markup%: Enter the new Markup percentage that wish to apply to all lines
within the Adjustment Level.
New Price: Display only field showing the recalculated sum of the Unit Cost *
Order Qty * New Markup% of each line contained within the selected Adjustment
Level
New Profit: Display only field showing the recalculated profit to be made when
comparing the New Price to the Planned Cost

Buttons
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Recalculate: This will recalculate the values in this display only and is for
information only.  It will not update the affected Job Lines
Update: This button is only active if the User is allowed to amend Sell Prices.
When active it will update each Job Order Line contained within the Level by the
value entered in the ‘New Markup %’ field
Cancel: This will cancel any changes that have been made and will close this
screen.

(Line Info bar)

A line is presented between the Upper and Lower panels which contains buttons relating to the
current line Item and is presented for further information and maintenance.   The displayed buttons
are:

Max Kitset: If the Order Line is a Kitset then Ostendo will determine the number of kits –
using the current stock level - that can be assembled for each line in the Kit.  The lowest
calculated number represents the maximum number of full Kitsets that can be made.  This
value is displayed on this button.  Click on the button to view the Kitset Line details
Add-On Sale Items: The current Add-On Sales linked to this Item are displayed for further
maintenance if required.
Qty-Break Pricing:  The current Quantity Breaks and Sell Prices linked to this Item are
displayed for further maintenance if required.
Alternate Item:  The current Alternate Item linked to this Item is displayed for your
reference along with the current on-hand quantity of this alternative.
Stock/Avail:  This shows the current On-Hand quantity (in stock) and Available Quantities
(On-Hand + Supply - Demand) for this Item along with the Item’s basic Unit of Measure.
Clicking on this button will show further details. 

Lower Panel

The Line Maintenance applies to any line generated by any of the above methods.  Seven ‘Tabs’
are associated with this section.  Which tabs are displayed is dependent upon the Line:

· Job Line: Main Entry area for Job Component Lines
· Line Source: Supply Source (Purchases, Jobs, etc) that are allocated to this Line
· Line Properties: Specific Properties that apply to the ordered Line
· Planned Variants: Identifying any Variants required (example Colour, Size, etc)
· Actual Issues: Receipt History of this Line
· Kit Contents: Details of any Kitset Order Line
· Warranty: Warranty records that apply to this line

Job Line Tab

This is the main entry and maintenance area for Job Order Lines. 

Entry and Display fields

Line Number: This is auto-generated by the program in increments of 10 from the previous Line
Number.  You can amend this number if required.  This number can be used as a sort sequence
for printing the lines on a Sales Order.  No checks are made on the entry

Line Type: From the drop-down list select the Line Type.  The options are:
Item Code
Descriptor Code
Labour Code
Kitset Code
Catalogue
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Code: From the drop-down list select the Code.  The drop-down list will vary dependent upon the
Line Type selection.  When entering a Inventoried Item you may wish to look at further Item Code
information:

· A ‘Stock Availability’ icon is situated just above the lower panel for this task.  
· An ‘Alternate Item’ icon is also available if the Item has alternatives

Order Qty: This is prefilled with the quantity entered into the preliminary selection panels defined
above or 1 if manually entering the line.  This can be amended here if required.
If the Line is for an Item Code and that Item has Order Dimensions then an Icon will appear to the
right of this field.  If you click on the Icon (or key Ctrl-Q) then a separate panel will be presented
into which you can enter the individual Dimensions.  From the entered lines Ostendo will calculate
the total quantity and populate the Order Line with this value.  You may overtype this quantity if
required.

Actual Qty: Display only field showing the current quantity issued against this line

Unit: This is prefilled with the Unit for the Code.  If this is an Inventoried Item with multiple Units
then you can amend the Unit of Measure by clicking on the drop-down icon and selecting the Unit. 

Std Price: This is prefilled with the program calculated Unit Price of the Code taking into account
any quantity Discounts, etc.  If the User’s has been given the rights (via File>System
Configuration>User Security and Options) then this can be amended here.  

Order Price: This is prefilled with the program calculated Unit Price of the Code taking into
account any quantity Discounts, etc.  This can be amended here if required.  If it is amended then
the Discount% field will automatically show the discount relative to the above Std Price.  You will
see a small icon at the right edge of this field.  If you select this then this will show the Price
changes (if any) that have been made

Discount%: This is prefilled with the normal Discount % offered to this Customer.  This can be
amended if required.  In this instance the Order Price field will automatically show the discounted
amount relative to the above Std Price

Description: This is prefilled with the description as held against the Item, Descriptor, Labour
Code, Kitset, or Catalogue Item.  It can be amended here if required.

Nett Amount: The system-calculated nett amount for the Line based on the Order Quantity, and
Unit Price and taking into account the Sell Price matrix.

Tax Amount: The system-calculated tax amount based on the Order Quantity, Unit Price and Tax
Code.

Total Amount: The system-calculated total amount for the Line based on the Order Quantity, Unit
Price and Tax Code.

Price Override: Checkbox showing if the price has been manually overridden.  If this is ‘
unchecked’ then the Unit Price field will revert to the pre-amended price.

Task Seq: Display only field showing the sequence number of the Task selected in the next field

Task: From the drop-down list select the Task where this component line is to be used.  You
should note that will only display those Tasks that have been assigned to this Job.

Tax Code: This is prefilled with the Tax Code as evaluated from the relationship between the
Customer Tax Group and the line’s Tax Group (See File>Financial Configurations>Tax Matrix).
The Tax Code can be amended from the drop-down list if required
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Analysis Group: The Analysis Group allows you to analyse Inventory, Labour, and/or Descriptor
records.  It is also used in defining the presentation of the order lines when it is printed on a Quote,
Order, or Invoice associated with an ‘Actual Quantity’ Job Order.  The presentations are selectable
by Analysis Group and offer different format options to the above three documents.

No Grouping: All Lines within the Analysis Group will printed
Header and Footer:  A Header containing the name of the Analysis Group will be printed
followed by the Lines within the Analysis Group.  At the end of the Group a Footer record
will be printed showing a summarised total of the Analysis Group content
Group Totals Only: A single line will be printed showing the summarised total for the
Analysis Group.

This is prefilled with the Analysis Group held against the Code.  This can be amended by selecting
another Analysis Group from the drop-down list. 

Invoice and Quote Display: This only applies to ‘Kitset’ and ‘Task Bill’ lines and allows you to
select the print options that will appear on the Invoice and Quote.  From the drop-down list select
the preferred option:

No Content Display: Don’t print the Kitset or Task Bill details to the document
Display Planned Contents: Print the Planned content of the Kitset or Task Bill 
Display Actual Contents: Print the Actual Issues made against the Kitset or Task Bill

Line Status: This shows the current status of this line.  The options are ‘Open’ or ‘Closed’.   The
program will close the status if the full quantity has been issued.   You can amend this by selecting 
‘Open’ from the drop-down list.     Similarly, if you have not issued the full order quantity and know
that the remainder will not be issued then you can amend the status to ‘Closed’.  If the Line is an
Inventoried Item then a status of ‘Closed’ will inform the Replenishment Routine to ignore this line.

Planned Unit Cost: This is prefilled with the current cost held against the line record.  With the
exception of Kitset it can be amended here if required.

Cost Markup%: Display only field showing the markup calculated from:
(Sell Price - Cost) / Cost

Sales Margin%: Display only field showing the margin calculated from:
(Sell Price - Cost) / Sell Price

Price is changed with Cost, Markup or Margin: This is prefilled with the settings defined in Job
Rules but you can amend it here and make it specific to this line.   If it is checked then the previous
three fields can be amended.  When the Margin or Markup ratios are amended they will
recalculate the Sell price based on the current cost.  If the Cost is amended then the Sell Price will
change using the current Margin/Markup.

Content Cost Rollup: This will display if the line is a Kitset or Task Bill.  If this is checked then any
changes to the Kitset or Task Bill content will immediately be applied to the Order Line Costs.

Content Price Rollup : This will display if the line is a Kitset or Task Bill. Tick this box if the price
is to be calculated from the contents that make up this line.

Instructions

Job Line: You can enter unlimited amount of Notes that are related to this Job Line.  These notes
will be available wherever the Line is reported.  Whenever you click on this field an icon will appear
in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text table.  Select
the text to be copied and either press the OK Button in that screen or double-click the selected
record.
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Invoice Line: You can enter unlimited amount of Notes that are related to this Job Line.  These
notes will be available wherever the Order Invoice Line is reported.  Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that screen or
double-click the selected record.

Line Source Tab

The Line Source tells you from where the line is to be supplied.  The options are ‘Source on
Demand’ or - for Inventory Item only - ‘Supply from Stock’.  If the Supply Method is ‘Source on
Demand’ the actual Supply Order (Assembly Order or Purchase Order) is also displayed if an
order has been placed.  
If you decide to split the Source of Supply to (say) partially ‘Supply from Stock’, plus partially ‘
Supply on Demand’ from one Supplier and the remainder ‘Supply on Demand’ from another
Supplier then you can achieve all this via this screen.
To split an existing Line Source click on the ‘Add’ Button.  This will add a new line and display a
button ‘Edit Source Quantities’.   Clicking on this button brings up a separate panel for re-allocation
of quantities.

Supply Method: For Descriptors, Catalogue Items, Labour and Kitsets this can only be ‘Supply On
Demand’.  For Items Codes select the Supply Method from the drop-down list.  The options are
Supply on Demand or Supply from Stock.

Sourced By: Shows how this Line is to be provided.  The options are Internal or Purchasing

Source Qty: This is the quantity that is allocated to this Source reference.

Supplier: The Supplier if this Item, Catalogue Item, Labour or Descriptor.  You can amend the
Supplier if the next field does not have an Order Number held against it.  To amend the Supplier
click on the drop-down icon and select the Supplier from the list

Supply Order Number: If the Supply Method is ‘Source on Demand’ and the Sourced By is ‘
Purchased’ then this is filled with the Purchase Order that has been raised to cover the demand.
You have the option to 'Right Mouse' and view the Supply Order

If the line item is Sourced on Demand, then the following values will be automatically updated and
displayed:

Purchase Order Qty
Purchase Receipt Qty
Purchase Invoice Qty
Assembly Order Qty
Assembly Receipt Qty

Button

Edit Source Quantities: This button appears when the ‘Add’ button is selected.  The ‘Add’ button
also creates a new line in the ‘Line Source Tab’ screen.  You should complete the ’Supply Method’
and ‘Sourced By’ fields in the new record before selecting this button.  When you click on this
button a panel is presented showing the following fields

Source Qty: Amend the quantities as required.  The sum of the quantities must equal the
total line quantity before you can exit this panel.
Supply Method: Display only field showing the Supply Method as entered in the Line
Source Tab
Sourced By: Display only field showing the Source as entered in the Line Source Tab
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Supplier: Display only field showing the Supplier as entered in the Line Source Tab
Purchase Order Number: Display only field showing the PO Number as entered in the
Line Source Tab

Line Properties Tab

Any specific property values for the Item, Descriptor, Kitset, Labour, or Catalogue Item can be
viewed here.  For example: A ‘property’ against an Item could be ‘Voltage’ and the specific value
entered against the Item Master is ‘240 Volts’.  You also have the option to add properties by
clicking on the ‘Add’ button.  The cursor will go to a new line for entry of the property as follows:

Property: From the drop-down list select the Property.

Value: Enter the specific value relating to this Property.

Copy to Invoice: Tick this box if the property is to be copied to the invoice.

Buttons

When in this panel you can use the Add, Save, Cancel and Delete Buttons as follows
Add: The cursor will go to a new line for entry of a new Line Property Value.
Save: This will save the current data without exiting the screen
Cancel: Any changes made since the line record was accessed or the last time
the ‘Save’ Button was pressed will be lost.
Delete: This will delete the current highlighted Line Property record.

Planned Variants Tab

This panel will only be visible against Items with Variants (example Colour, Size, etc).  This shows
which variants are planned for this Job Line.  The displayed fields are:

Quantity: The quantity planned for this variant.  The sum of these quantities cannot exceed the
Sales Order Line quantity.

Variant: All Variant fields applicable to this Item are displayed.  Any unique combination of variants
will be displayed in its own line.

Buttons

When in this panel you can use the Add, Save, Cancel and Delete Buttons as follows
Add: The cursor will go to a new line for entry of a new Planned Variant.
Save: This will save the current data without exiting the screen
Cancel: Any changes made since the line record was accessed or the last time
the ‘Save’ Button was pressed will be lost.
Delete: This will delete the current highlighted Planned Variant record.

Actual Issue Tab

This enables issuing against this Line.  The screen layout varies dependent upon the Line Type
being issued as follows:

Line Type ‘Item Code’

· Issue Date: The date when this was picked.
· Qty: The quantity picked on the above date **(See below)
· Charge Style: Select the charge style from the drop-down list. The options are:
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o Chargeable
o Warranty
o Contract
o Non-Charge

· Non-Charge Code: If charge Style is ‘non-charge’ then select non charge code from
drop-down list  

· Warehouse: The Warehouse from where it was issued
· Location: The Warehouse Location from where it was issued
· Variant: If the Item has variants then the specific Variant must be entered
· Issue Source: Display only field showing the Source of the Issue
· Issue No: Display only field showing the Receipt Number within the Source
· Issue Description: Display only field showing the Description as held against the Receipt

Number
· Recorded Notes: This shows both the Notes as entered into the Timesheet entry screen

and entered here
· To Container ID:  This is the Container ID that the item is issued to.

Line Type ‘Descriptor Code’, ‘Catalogue Code’

· Issue Date: The date when this was picked.
· Qty: The quantity picked on the above date  **(See below)
· Cost: The cost of this issue
· Charge Style: Select the charge style from the drop-down list. The options are:

o Chargeable
o Warranty
o Contract
o Non-Charge

· Non-Charge Code: If charge Style is ‘non-charge’ then select non charge code from
drop-down list  

· Issue Source: Display only field showing the Source of the Issue
· Issue No: Display only field showing the Receipt Number within the Source
· Issue Description: Display only field showing the Description as held against the Receipt

Number

Line Type ‘Kitset Code’

· Issue Date: The date when this was picked.
· Qty: The quantity picked on the above date
· Charge Style: Select the charge style from the drop-down list. The options are:

o Chargeable
o Warranty
o Contract
o Non-Charge

· Non-Charge Code: If charge Style is ‘non-charge’ then select non charge code from
drop-down list  

· Issue Source: Display only field showing the Source of the Issue
· Issue No: Display only field showing the Receipt Number within the Source
· Issue Description: Display only field showing the Description as held against the Receipt

Number

Line Type ‘Labour Code’
· Issue Date: The date when this was picked.
· Qty: The quantity picked on the above date
· Unit Cost: The cost of this issue
· Employee: From the drop-down list select the Employee who carried out the work
· Rate Scale: Select the Rate Scale from the Drop-down list
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· Charge Style: Select the charge style from the drop-down list. The options are:
o Chargeable
o Warranty
o Contract
o Non-Charge

· Non-Charge Code: If charge Style is ‘non-charge’ then select non charge code from
drop-down list  

· Issue Source: Display only field showing the Source of the Issue
· Issue No: Display only field showing the Receipt Number within the Source
· Issue Description: Display only field showing the Description as held against the Receipt

Number

** Note:  If the Item, Descriptor, or Catalogue Code has had an Actual Issue made against it then
you have the option to move the Actual Issue to another Job Order by clicking the right-mouse and
selecting 'Move Actual to another Job'.   

Kit Contents Tab

When a Kitset is copied to the Job Line its content is shown here.  It can be amended as required. 
You should note that the sell price if this line can vary according to the Sell Price Settings defined
against the Kitset Header record.

Line Number: The Kitset Lines are printed in Line Number sequence.  Upon creation of a new
line the program will increment the previous line by 10.  You can amend this as required.
Component Type:  Select the Component Type from the drop-down list.  The options are:

· Item Code
· Descriptor Code
· Labour Code
· Catalogue Code

Component Code: From the drop-down list select the code.   The drop-down list displays the
codes relating to the selection made in the Component Type field
Description: The description is copied from the Item or Descriptor record.  It may be amended
here and made specific to this List. 
Unit: The base unit is copied from the Item or Descriptor.   If it is an Item that has multiple
Units then an alternate Unit may be selected from the drop-down list.
Qty Per: Enter a default quantity to be used.  If nothing is entered here then 1 is assumed.
Qty Required: Extended quantity calculated from Qty per Kit multiplied by number of kits
required.
Qty Issued: Display only field showing the quantity issued against this Kitset Line.
Planned Unit Cost: Display only field showing the planned cost per unit of this Kitset Line.
Actual Unit Cost: Display only field showing the current actual cost per unit of this Kitset Line
Per Line Std Price: This shows the Sell Price of this Kitset Line.  It can be amended here if
required.   This field is for reference only and can be printed on documents.  It does not,
however, affect the Kitset Sell Price
Extended Rqd Std Price: Display only field showing the Planned Extended Price for this
Kitset Line
Extended Issued Std Price: Display only field showing the Planned Extended Price for  item
actually issued to this Kitset Line

Buttons

When in this panel you can use the Add, Save, Cancel and Delete Buttons as follows
Add: The cursor will go to a new line for entry of a new Kitset Component.
Save: This will save the current data without exiting the screen
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Cancel: Any changes made since the line record was accessed or the last time
the ‘Save’ Button was pressed will be lost.
Delete: This will delete the current highlighted Kitset Component record.

Task Bill Contents Tab

When a Task Bill is copied to the Job Line its content is shown here.   The content is displayed in
the following sub-tabs and can be amended as required.  

Task Bill Lines
Line Number: Task Bill Lines are printed in Line Number sequence.  Upon creation of a
new line the program will increment the previous line by 10.  You can amend this as
required.
Component Type:  From the drop-down list select the Component Line Type.  The
options are:

· Item Code
· Descriptor Code
· Labour Code
· Catalogue Code

Code: From the drop-down list select the specific component code.  The list will show
details relating to the Component Type option selected.
Description: Display only field showing the description of the Code taken from the Item,
Descriptor, or Labour record
Unit: Prefilled with the Unit held against the Code.   If the Line Type is ‘Item Code’ and the
selected Item has multiple Units of Measure then you can select the specific Unit from the
drop-down list
Quantity Per: Prefilled with the Quantity per single Task Bill.   This can be amended here
if required. 
Quantity Required: Prefilled with the Quantity per Task Bill multiplied by the Task Bill
Quantity used in this Job.   This can be amended here if required. 
Quantity Issued: System maintained field showing the quantity already issued against this
Task Bill Line 
Planned Unit Cost: Display only field showing the Planned Cost per Unit for each Line in
the Task Bill. 
Actual Unit Cost: Display only field showing the Actual Cost per Unit for each Line in the
Task Bill.
Per Line Std Price: This shows the Sell Price of this Task Bill Line.  It can be amended
here if required.   This field is for reference only and can be printed on documents.  It does
not, however, affect the Task Bill Sell Price
Extended Rqd Std Price: Display only field showing the Planned Extended Price for this
Task Bill Line
Extended Issued Std Price: Display only field showing the Planned Extended Price for
items actually issued to this Task Bill Line

Task Bill Line Source
The Line Source tells you from where the line is to be supplied.  The options are ‘Source
on Demand’ or - for Inventory Item only - ‘Supply from Stock’.  If the Supply Method is ‘
Source on Demand’ the actual Supply Order (Assembly Order or Purchase Order) is also
displayed if an order has been placed.  
Supply Method: For Descriptors, Catalogue Items, Labour and Kitsets this can only be ‘
Supply On Demand’.  For Items Codes select the Supply Method from the drop-down list.
The options are Supply on Demand or Supply from Stock.
Sourced By: Shows how this Line is to be provided.  The options are Internal or
Purchasing
Source Qty: This is the quantity that is allocated to this Source reference.
Supplier: The Supplier if this Item, Catalogue Item, Labour or Descriptor.  You can amend
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the Supplier if the next field does not have an Order Number held against it.  To amend
the Supplier click on the drop-down icon and select the Supplier from the list
Purchase Order Number: If the Supply Method is ‘Source on Demand’ and the Sourced
By is ‘Purchased’ then this is filled with the Purchase Order that has been raised to cover
the demand.

Task Bill Line Properties
Any specific property values for the Item, Descriptor, Kitset, Labour, or Catalogue Item can
be viewed here.  For example: A ‘property’ against an Item could be ‘Voltage’ and the
specific value entered against the Item Master is ‘240 Volts’.  You also have the option to
add properties by clicking on the ‘Add’ button.  The cursor will go to a new line for entry of
the property as follows:
Property: From the drop-down list select the Property.
Value: Enter the specific value relating to this Property.

Task Bill Line Warranty
This enables you to adjust current Warranty records that may exist against this Line;
Warranty Code: From the drop-down list select the Warranty Code that you are adding to
this Job order Line.
Description: Description of the Warranty Code taken from the warranty record
Term: Duration of the ‘Time Unit’ taken from the warranty record
Time Unit: Days or Months Time Unit taken from the warranty record

Warranty Tab

This enables you to adjust current Warranty records that may exist against this Line;

Warranty Code: From the drop-down list select the Warranty Code that you are adding to this Job
order Line.

Description: Description of the Warranty Code taken from the warranty record

Term: Duration of the ‘Time Unit’ taken from the warranty record

Time Unit: Days or Months Time Unit taken from the warranty record

Buttons

When in this panel you can use the Add, Save, Cancel and Delete Buttons as follows
Add: The cursor will go to a new line for entry of a new Warranty Record.
Save: This will save the current data without exiting the screen
Cancel: Any changes made since the line record was accessed or the last time
the ‘Save’ Button was pressed will be lost.
Delete: This will delete the current highlighted Warranty Record.

Dimensions Tab

If the ‘Display Dimensions’ field in Job Rules is ‘checked’ then this tab will be displayed.  It contains
the following fields that apply to the Job Line

Entry and Display fields

Unit Weight: This is prefilled with the Unit Weight as held against the Item, Descriptor or
Catalogue Code record.  It can be amended here and made specific to this Order Line.
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Unit Volume: This is prefilled with the Unit Volume as held against the Item, Descriptor or
Catalogue Code record.  It can be amended here and made specific to this Order Line.

Unit Area: This is prefilled with the Unit Area as held against the Item, Descriptor or Catalogue
Code record.  It can be amended here and made specific to this Order Line.

Planned Order Weight: A display only field calculated from the Order Line Planned Quantity
multiplied by the above ‘Unit Weight’.

Planned Order Volume: A display only field calculated from the Order Line Planned Quantity
multiplied by the above ‘Unit Volume’.

Planned Order Area: A display only field calculated from the Order Line Planned Quantity
multiplied by the above ‘Unit Area’.

Actual Order Weight: A display only field calculated from the Order Line Actual Quantity multiplied
by the above ‘Unit Weight’.

Actual Order Volume: A display only field calculated from the Order Line Actual Quantity
multiplied by the above ‘Unit Volume’.

Actual Order Area: A display only field calculated from the Order Line Actual Quantity multiplied
by the above ‘Unit Area’.

Order History Tab

This shows the Customer's Order History of the Item, Descriptor or Labour Code

Order Date: This is a display only field showing the date held against the Order Line

Status: This is a display only field showing the current status of the Order

Order Number: This is a display only field showing the Order Number that contained this
Item/Descriptor Code

Qty: This is a display only field showing the quantity ordered in this Order Number

Unit: This is a display only field showing the Unit of Measure held against this Order Number

Unit Price: This is a display only field showing the Unit Price charged in this order

Additional Fields Tab

If you have defined Additional Fields against the Job Line (created via System
Configuration>Additional Fields) then an addition tab will be presented which, when selected, will
display the available fields.  Enter information in line with the available field formats:

· Text: Any data format can be entered in a Text field
· Decimal: Allows entry of numbers and decimals
· Integer: Allows entry of whole numbers only
· Currency: Shows Currency symbol and decimals as defined in Regional Settings
· Yes/No: Shows a checkbox which can be checked/unchecked
· Date: Contains a drop-down calendar for selection of a date
· Time: Displays format HH:MM:SS for entry of a time of day

Buttons
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Close: This will close the Job Order screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: Adds a line relative to the displayed ‘Tab’ in the lower part of this screen

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Deletes a line relative to the displayed ‘Tab’ in the lower part of this screen

Related: This will bring up a list of functions that are related to the Job Order.  You may open and
maintain information in those screens whilst still remaining in the Job Order screen.

Reports: This will bring up a list of Reports that are related to the Job Order.  You can immediately
run the report whilst still remaining in the Job Order screen.

Print: This will allow you to generate and print the current Job Order

Job Invoices: Only displayed if the Job is an 'Order' (I.e. not a Quote). When clicked this will take
you to the Job Invoices screen for maintenance of Invoices against this Job. For more details see ‘
Job Invoices’ in this guide.

Set Current: Only displayed if the Job is a 'Quote' and the Quote is an earlier Revision of the
current Quote. Clicking this button will change the current 'Non Current' status of the Quote to a
'Current' status and will also revert the existing 'Current' status Quote to 'Non Current'

18.7.1 Line Qty Dimensions

This screen is accessed against Order Lines for Item Codes that contain Order Dimensions (as
entered into the Item Master screen).   For these Items an icon is presented to the right of the
Order Line Quantity field. If you click on this Icon (or key Ctrl-Q) then this panel will be presented
for entry of Dimensions

Entry and Display fields

Item Code: Display only field showing the Item Code against which the dimensions are being
entered

Unit: Display only field showing the basic Unit Of measure of the Item Code 

Current Order Line Qty: Display only field showing the current order quantity of this Item held
against the Order Line

Total Calculated Qty: Display only field showing the sum of the Calculated Line quantities in this
screen

Qty: Enter the Quantity to be ordered using the dimensions entered into the following fields

Length: If the Item Code has a Length Dimension then this column is displayed.  You should enter
a Length value.  If nothing is entered then a length of 1 is assumed

Width: If the Item Code has a Width Dimension then this column is displayed.  You should enter a
Width value.  If nothing is entered then a Width of 1 is assumed
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Depth: If the Item Code has a Depth Dimension then this column is displayed.  You should enter a
Depth value.  If nothing is entered then a Depth of 1 is assumed

Pack Size: If the Item Code has a Pack Size Dimension then this column is displayed.  Click on
the drop-down and select a Pack Size.  If nothing is entered then a Pack Size of 1 is assumed. 
You should note if only one Pack Size is in the List then that entry will automatically prefill this field.

Calc Qty: This is the calculated quantity for the Line taken from

(Qty * Length * Width * Depth / Pack Size Qty) * Qty Conversion Factor

Buttons

Close: This will close the Line Qty Dimensions screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Qty Dimension record

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will immediately delete the current Qty Dimension record from this list

18.7.2 Job Order Issues

This screen is presented when the ‘Issues’ button on the Job Order Line’s ‘Batch Entry’ bar is
selected.   Within this screen you can individually add lines that have been picked or click on the ‘
Prefill Issues’ button the display un-issued Job Lines

Prefill Issues (Button): Click this button and a panel will appear for you to enter a date that covers
the transaction date for picked lines.  It is prefilled with the system date but can be amend from the
drop-down calendar.  This panel also gives you the option to select All Lines within the Job or lines
linked to a specific Task.   Clicking the ‘Create’ button will display the Job order lines that have an
outstanding issue quantity.   You should note however that the displayed list shows:
· Items whose Supply Method is ‘Supply From Stock’ along with the quantity yet to be supplied
· Items whose Supply Method is ‘Source on Demand’.  In this instance the Quantity will be

prefilled with zero as they will be satisfied directly from the linked Purchase or Assembly Orders.
You can amend this quantity, if required, and it will be issued from stock.  However the linked
Supply order will still remain.

· Descriptors that are Sourced By ‘Internal’ because those Sourced By ‘Purchasing’ will be directly
supplied from a Purchase Order.

· Descriptors that are Sourced By ‘Purchase’.   In this instance the Quantity will be prefilled with
zero as it will be satisfied directly from the linked Purchase Order.  You can amend this quantity,
if required, and it will be issued directly to the Order.  However the linked Supply order will still
remain.

Override Default Location: If this is ‘checked’ then the following two fields will become ‘Active’
and an entry is required in each field.   These will become the ‘Issue’ Warehouse/Location for all
Items in this Job Order Issue screen and will override the default Warehouse/Location held against
individual Item Codes

Warehouse: From the drop-down list select the Warehouse from which the Transaction is being
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made.

Location: From the drop-down list of Locations within the above Warehouse select the location
from where the Transaction is being made.

All the displayed lines can be amended as required.  Note that any line that has sub-level
variations (Serial Number, Batch Number, Colour, etc) are NOT prefilled and must be selected at
line level.  The following fields are displayed:

Date: In the first instance this is prefilled with the above ‘Pick Date’ Date.  You can change this
date by entering the date or clicking on the drop-down menu and selecting the date.

Line No: This shows the current Line Number in the Job Order. 

Line Type: This shows the Line Type covering this line.  You may amend this by selecting another
Line Type from the drop-down list.  The options are Descriptor Code, Kitset Code, Catalogue Code
or Item Code.

Code: From the drop-down list select the Descriptor, Kitset, Catalogue, or Item Code that applies
to this line

Unit: Prefilled with the base Unit for the Code.  If the line refers to an Item that has more than a
single Unit of Measure then an alternate Unit can be selected from the drop-down list.

Qty: The Quantity to be issued.  This can be amended at any time.  If the Item has sub-level
variations (such as Colour, Size, Batch, etc) then you should click on the Icon to the right of this
field and selected the specific variant(s) from the displayed panel.  This feature also applies if you
are issuing an Item from a location other than the displayed default location.

Charge Style: Select the charge style from the drop-down list. The options are:
· Chargeable
· Warranty
· Contract
· Non-Charge

Non-Charge Code: If charge Style is ‘non-charge’ then select non-charge code from drop-down
list  

Warehouse: For an Item Code this is prefilled with the default ‘Issue’ Warehouse.  You may
amend this by selecting another Warehouse from the drop-down list

Location: For an Item Code this is prefilled with the default ‘Issue’ Location.  You may amend this
by selecting another Location from the drop-down list

Variants: If the Line Item Number has variants (Serial Number, Expiry Date, Batch No, Rev No,
Size, Colour, Grade) then they should be entered into the respective fields.  

Recorded Notes: Extended Notes for your own information can be attached to this Line.

Supplier: This displays the Supplier of the line if an Order has been placed against  the Supplier
for this specific Line.  Note:- If multiple Supply Orders from different Suppliers have been raised
then this field will display 'Multiple'

Supplier Order: This displays the Order Number raised against the Supplier for this specific Line.
Note:- If multiple Orders have been raised then this field will display 'Multiple'
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Buttons

Close: This will close the Job Order Issues screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Issue record.

Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Line

Update Job with Issues Above: If you click this button then the quantities entered against each
line will be issued to theJob Order and - in the case of Items - issued from stock.

18.7.3 Job Properties

This screen allows you to define properties that are specific to a Job.  Property titles are
user-defined in screen General>Settings>Standard Properties

List Tab

This displays the current list of Properties.

Display fields

The displayed fields are taken from the Job Details.  The selection of which fields to display here is
at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the main panel and
select ‘Customize List Fields’.   On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons
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Close: This will close the Job Properties screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Job Properties.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Detail Tab

Entry and Display fields

Order No: Display only field showing the Job Number selected in the List screen

Description: Display only field showing a description of the Job

Status: Display only field showing the Job status

Customer: Display only field showing the Customer defined against this Job

Project Type: Display only field showing the Job Type

Property: From the drop-down list select the Standard Property against which a value specific to
this Project will be made.

Value: Enter the value against the selected property.  The content will be validated against the
Property Type as follows:

Text
Decimal
Integer
Currency
Yes/No
Date
Time

If the Standard Property contains a pre-defined list of values then the specific value must be
selected from a drop-down list.    

Buttons

Close: This will close the Job Properties screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: Moves the cursor to the lower panel for creation of a new Job Property record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Job Property record or the last time the ‘Save’ Button
was pressed will be lost.

Delete: This enables you to delete the selected Job Property record.
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18.7.4 Job Documents

This screen allows you to define documents, etc that are specific to a Job. 

List Tab

Display fields

Document Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Job to which this document relates.

File Name: This is the full path name of the file on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Job Documents screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Job Documents.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected Document from a Job record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Document Name: Enter the name of the document that you are creating in this Document - Job
linkage.  No checks are made on the entry.

Document Type: Prefilled with ‘Job’
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Linked to: From the drop-down list select the Job that uses this document

Document Details: locate the full path name of the document.  It should be noted that any file
extension recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Notes: Extended Notes for your own information can be attached to this document link.  Whenever
you click on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up
the Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

Buttons

Close: This will close the Job Documents screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Job Documents.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Job Documents record or the last time the ‘Save’ Button
was pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 

18.7.5 Job Images

This screen allows you to define images that are specific to a Job.    

List Tab

Display fields

Image Name: The name of the document as entered into the Details screen,

Linked To: This is the specific Job to which this image relates.

File Name: This is the full path name of the image on your computer network.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
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records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Job image screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of Job images.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This enables you to delete the selected image from a Job record

View: If you select a line and then this button the physical document will be displayed on the
screen. 

Detail Tab

Entry and Display fields

Image Name: Enter the name of the document that you are creating in this image - Job linkage.  
No checks are made on the entry.

Image Type: Prefilled with ‘Job’

Linked to: From the drop-down list select the Job that uses this image

Image Details: locate the full path name of the image.  It should be noted that any file extension
recognised by your computer can be attached.  (Example:-  .exe, .jpg, .doc, .xls, etc)

Image: This panel displays the selected Image.

Buttons

Close: This will close the Job image screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of Job images.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Job image record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: Not applicable to the Detail panel

View: If you select a line and then this button the physical document will be displayed on the
screen. 
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18.7.6 Job History Notes

This function allows you to link multiple time-stamped notes to a Job record.    

List Tab

Display fields

The displayed fields are taken from the Job’s Details.  The selection of which fields to display here
is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the main panel and
select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Job History Notes screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Detail Tab

Entry and Display fields

The Job to which these History Notes relates is shown at the top of this panel.

Date: Upon adding a new Notes record this is prefilled with the system date but can be amended
by overtyping or using the drop-down calendar.

Time: Upon adding a new Notes record this is prefilled with the system time but can be amended
by overtyping or using the up and down arrows.

Reference: A short description of the entry.  No validation checks are carried out.

Classification: From the drop-down list select a Classification under which you wish to store this
History Note.  This facilitates analysis of all History Notes by Classification.  Classifications are
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maintained under CRM>Settings>Call Classifications

Sub Classification: From the drop-down list select a Sub-Classification within the above
classification by which you wish to analyse this History Note.  Sub Classifications are maintained
under CRM>Settings>Call Sub-Classifications.

Follow-up Required: ‘Check’ this box if you need to be reminded - via System Alerts - of follow-up
action against this History Note.  When ‘checked’ the next field becomes active for you to select a
Date on which the Alert will be generated.

(Follow-up Date): From the drop-down calendar select the date when you wish to be notified of
this follow-up action.  An Alert will be generated on that date against the User that set this Alert
request.

Notes: Unlimited notes can be entered against this Date/Time History record.  Whenever you click
on this field an icon will appear in the top-right.  By clicking on this Icon you can bring up the
Frequently Used Text table.  Select the text to be copied and either press the OK Button in that
screen or double-click the selected record.

History:  The Notes history against this Job is displayed in the lower part of the screen.  Each
record will also have the first 3 lines of the notes displayed.   To view the full Notes simply click on
the history record and the details will be displayed in the upper part of the screen

Buttons

Close: This will close the Job History Notes screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a Job History Notes record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Job History Notes record or the last time the ‘Save’
Button was pressed will be lost.

Delete: Not applicable to the Notes Detail panel

18.7.7 Job Quote Options

Job Quote Options screen is only visible if the Job Status is ‘Quote’.  It enables you to define the
style to be used when printing the Job Quotation.  The available options are:

Formal: Standard style quote showing the Job Order Lines
Letter: Letter Style showing descriptive narrative and single Quoted Price
User: Populated with the ‘Formal’ style fields for you to amend as required

Entry and Display fields

Order Number: Display only field showing the Number of the Job Quote

Order date: Display only field showing the date on the Quotation Header

Status: Display only field showing the current status of the Quote

Customer: Display only field showing the Customer against who the quote has been raised. 

Description: Display only field showing the Description held against the Quote
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Quote Style: Prefilled with the default Quote Style as defined in the Job Rules.  You may select
another Job Quote Style from the drop-down list.  The current options are:

Formal: Standard style quote showing Job Order Lines
Letter: Letter Style showing descriptive narrative and single Quoted Price
User: Populated with the ‘Formal’ style fields for you to amend as required

Print Quote: You can print the Quotation by clicking on this button.  After printing the print status
will be set to ‘Printed’.  If required you can reset it to ‘Not Printed’ by going into the Job Quote ‘Main
’ screen and resetting the Quote Print Status.

Header Notes: This field is used by the ‘Letter’ style Quote and defines the content that you wish
to appear in the main body of the Quotation.  This area would normally have a detailed description
of the content or activities to be carried out.
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Lines to Print: Two options are available from the drop-down list:
Print Detail Lines: All the Job Lines in the Quotation will be printed
Print Single Line: The text in the next field will be printed

Description: Only used if the previous field is set to ‘Print Single Line’.  The content on this field
will be printed Header and Footer Notes and provides a brief description to the Quoted Price.

Nett Value: Display only field showing the current Nett Value of the Job.

Footer Notes: This field is used by the ‘Letter’ style Quote and defines the content that will appear
in the Footer area of the Quotation.  This area could (for example) have a summary text to
describe the Quote Expiry Date or Quote Terms, etc.
Whenever you click on this field an icon will appear in the top-right.  By clicking on this Icon you
can bring up the Frequently Used Text table.  Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Job Quote Options screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

18.7.8 Job Tasks

This screen allows you to create and maintain Tasks held against Jobs.

List Tab

Display fields

The displayed fields are taken from the Job set up via the Jobs screen.  The selection of which
fields to display is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
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· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Job Tasks
whose status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Job Tasks screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will go to the ‘Detail’ tab and present a blank screen for entry of a new Job Task

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Related: This will bring up a list of functions that are related to the Job Task.  You may open and
maintain information in those screens whilst still remaining in the Job Task screen.

Reports: This will bring up a list of Reports that are related to the Job Task.  You can immediately
run the report whilst still remaining in the Job Task screen.

Detail Tab

This screen allows you to add and maintain Task related activities for a selected Job.  
The upper panel shows information taken from the selected Job.  
The centre panel shows the current Tasks within this Job.
The lower area has 4 sub tabs for maintenance of the individual Tasks as follows:

Entry and Display fields

Job Task - Detail - Upper Panel
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Order No:  Display only field showing the Job Order Number against which Tasks are being
maintained

Description: Display only field showing the description of the Job Order

Status: Display only field showing the current Status of the Job Order.

Ordered Date: Display only field showing the date when the Job was ordered.

Required Date: Display only field showing the date when the Job is required.

Required Time of Day: Display only field showing the time of day when the Job is required.

Estimated Duration: The quantity and time unit showing the estimated duration that this Job
Order will take.

Planned Job Start Date / Time: Display only field showing the current planned start date and time
for the Job Order.  This was program calculated when the Job Booking status was amended to ‘
Booked In’ and could be subsequently amended manually.

Planned Job End Date / Time: Display only field showing the current planned end date and time
for the Job Order.  This was program calculated when the Job Booking status was amended to ‘
Booked In’ and could be subsequently amended manually.

Job Booking Status: Display only field showing the current Booking Status of the Job.  The
displayed options are ‘Not Booked In’ and ‘Booked In’.

Job Task - Detail - Centre Panel

Display only list showing the current Tasks within the Job Order.  The displayed fields are:

Sequence: The Sequence is which the Tasks will be carried out.  Concurrent Tasks will have the
same Sequence Number.

Task Name:  The Task name as maintained in the Lower Panel.

Description: Short description of the Task. 

Task Detail Sub-Tab

This tab enables you to add new Tasks to an existing Job.

Entry and Display fields

Sequence:  During an ‘Add’ Transaction the program automatically generates a Sequence that is
the current highest Sequence plus 10.  This can be amended if required.  Sequence Numbers
define the scheduling sequence for each.  To have concurrent Tasks you can use the same
Sequence Number.

Task Name: From the drop-down list select the Task that will be included in this Job Order.  Tasks
are maintained via Jobs>Settings>Task Names

Description: This is copied from the Task selected in the previous field.  However, it can be
amended here and made specific to this Job Order.
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How Are Invoice Lines Created: From the drop-down list select how the lines are created.  The
options are:

A Single Task Bill is linked to this Task: If this is selected then a single Task Bill is
selected in the next field.
Multiple Job Lines can be linked to this Task: If this is selected then Lines can be
linked to this Task within the Job

Task Bill Code: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  From the drop-down list select the Task Bill.  Task Bills are maintained under
Jobs>Task Bills

Qty: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is selected.  Enter the
quantity of this Task Bill that is required tin this Job. 

Unit: Display only field showing the Unit of the Task Bill.

Unit Price: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is selected.
This is prefilled with the evaluated Sell Price for the Task Bill and the Pricing Matrix relating to the
Customer / Descriptor.  This price may be amended here and made specific to this Job.  If a Price
change is made then the ‘Price Override’ checkbox will be flagged accordingly.

Description: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is selected.
This is prefilled with the Description of the selected Task Bill but it can be amended here and
made specific to this Job.

Tax Code: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is selected.
This is prefilled with the Tax Code derived from the Customer Tax Group / Descriptor Tax Group
relationship.  It can be amended here by selecting a Tax Code from the drop-down list.  Tax Codes
are maintained by selecting File>Financial Configuration>Tax Codes.

Analysis Group: Entry is only allowed if the ‘Single Task Bill is linked to this Task’ option is
selected.  The Analysis Group enables you to report and analyse Descriptors by their Group.  To
select a Group click on the drop-down list.  Analysis Groups are user-maintained by clicking on the
icon to the right of the field or by selecting General>Settings >Analysis Groups

Price Override: Price Override selected to indicate that the above price has been manually
overwritten.  If you ‘uncheck’ this flag then the above price will revert to the program calculated
value.

Task Status: This is initially set to ‘Planned’ but can be amended to any Task status by selecting it
from the drop-down list.  The options are:

· Planned
· In-Progress
· On-Hold
· Closed

Customer Asset:  From the drop-down list select the Customer Asset that you wish to relate to
this Task Activity.

Estimated Duration: The quantity and time unit showing the estimated duration that this Job
Order will take.

No Scheduling: ‘Check’ this checkbox if you do not want this Task to be scheduled nor displayed
in the Job Calendar

Planned Job Start Date / Time: Display only field showing the current planned start date and time
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for the Job Order.  This was program calculated when the Job Booking status was amended to ‘
Booked In’ and could be subsequently amended manually.

Planned Job End Date / Time: Display only field showing the current planned end date and time
for the Job Order.  This was program calculated when the Job Booking status was amended to ‘
Booked In’ and could be subsequently amended manually.

Department: This is prefilled with the Department held against the Task selected above.  You can
amend this department by selecting one from the drop-down list. Departments are maintained via
General>Settings>Departments.

Step Overlap - From the drop-down list select the Scheduling Overlap that will apply to
subsequent Steps in the process.  The options are

· End of Step: The next step will commence at the end of this Step taking into account the
Overlap and Buffer Minutes

· Beginning of Step: The next step will commence in parallel to this Step taking into account
the Overlap and Buffer Minutes

Overlap Minutes - Enter the minutes that the subsequent Step can overlap this step 

Buffer Minutes - Enter the minutes that the subsequent Step must wait before it can begin

Task Instructions Sub-Tab

The Task Instructions Sub Tab allows you to add extensive notes against this Task.  You can enter
unlimited amount of instructions that relate to this Task within the Job.  These Instructions will be
available for printing on Job documents.  Whenever you click on this field an icon will appear in the
top-right.  By clicking on this Icon you can bring up the Frequently Used Text table.  Select the text
to be copied and either press the OK Button in that screen or double-click the selected record.

Task Resources Sub-Tab

The Task Resources Sub Tab allows you to identify any Resources that are required to perform
this Task.  These Resources will appear on the Job Planning Board for Resource Scheduling
purposes

Entry and Display fields

Resource Type: From the drop-down list select the Resource Type.  The options are Asset or
Employee.

Resource Name: From the drop-down list select the Resource Name.  The options available are
related to the Resource Type selected above

Task Progress Sub-Tab

Shows ongoing information about the Task.  The displayed fields are:

Total Costs: This area lets you view current and projected costs based on completions to date
Planned Cost: The sum of Planned Costs from this Task
Actual Cost: The sum of Actual Costs to date from this Task
% Of Planned: Percentage of current Actual Cost to Planned Cost
Remaining Planned: Remaining Cost taking into account the estimated percentage
completion of the Task (see ‘Estimated %’ below)
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Cost Completions: This area lets you view current and projected costs based on completions to
date

Estimated %: This is the program evaluated percentage completion taking into account
Job Line over-issues, completions, etc
(Prediction): Display only field showing the current trend of this Task.  The display options
are:

· On Track (within percentage set up in Jobs>Settings>Job Rules)
· Higher Unit Costs
· Lower Unit Costs
· Higher Usage
· Lower Usage
· Hi-Low Costs
· Hi-Low Usage
· Hi-Low Costs & Higher Usage
· Hi-Low Costs & Lower Usage
· Hi-Low Costs & Hi-Low Usage
· Higher Costs & Higher Usage
· Higher Costs & Lower Usage
· Higher Costs & Hi-Low Usage
· Lower Costs & Higher Usage
· Lower Costs & Lower Usage
· Lower Costs & Hi-Low Usage

Override % calculated completion: If this is ‘checked’ then you can enter an override
percentage that will take priority when calculating the projected Cost and percentage of
Planned value
Estimated %: This becomes ‘active’ if the Override % calculated completion’ checked is ‘
checked’.  You can enter a percentage complete value that will take priority when
calculating the projected Cost and percentage of Planned value
Calc-Est Diff: The difference between the Calculated and Estimated percentages
Projected Cost: Based on continuing at current Cost Rate
% of Planned : Estimated final Cost percentage based on Planned Cost

Total Hours: This area lets you view current and projected hours based on completions to date
Planned Hours: The sum of Planned Hours from this Task
Actual Hours: The sum of Actual Hours to date from this Task
% Of Planned: Percentage of current Actual Hours to Planned Hours
Remaining Planned: Remaining Hours taking into account the estimated percentage
completion of the project (see ‘Estimated %’ below)

Hours Completion: This area lets you view current and projected Hours based on completions to
date

Estimated %: This is the program evaluated percentage completion taking into account
over-bookings, completions, etc
(Prediction): Display only field showing the current time trend of this Task.  The display
options are:

· On Track (within percentage set up in Jobs>Settings>Job Rules)
· Higher Usage
· Lower Usage
· Hi-Low Usage

Override % calculated completion: If this is ‘checked’ then you can enter an override
percentage that will take priority when calculating the projected Cost and percentage of
Planned value
Estimated %: This becomes ‘active’ if the Override % calculated completion’ checked is ‘
checked’.  You can enter a percentage complete value that will take priority when
calculating the projected Hours and percentage of Planned value
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Calc-Est Diff: The difference between the Calculated and Estimated percentages
Projected Hours: Based on continuing at current rate
% of Planned : Estimated final Hours percentage based on Planned Hours

Buttons

Close: This will close the Job Tasks screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: If you are in the Task Detail Sub-Tab then a blank Task Detail screen will be presented for
entry of a new Task.  If you are in the Task Resource Sub-Tab then the cursor will go to a new line
for entry of a new Resource.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: If you are in the Task Detail Sub-Tab then this will delete the current highlighted Task from
the upper panel.  If you are in the Task Resource Sub-Tab then the current highlighted Resource
record will be deleted.

Related:     This will bring up a list of functions that are related to the Job Task.    You may open
and maintain information in those screens whilst still remaining in the Job Task screen.

Reports:     This will bring up a list of Reports that are related to the Job Task.   You can
immediately run the report whilst still remaining in the Job Task screen.

18.7.9 Job Order Resources

This screen allows you to create and maintain Job Resources held against Jobs.

List Tab

Display fields

The displayed fields are taken from the Job set up via the Jobs screen.  The selection of which
fields to display is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.  On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
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(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Job Tasks
whose status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Job Order Resources screen.  If you have any unsaved data then you
will be asked if you wish to save it before the screen is closed.

Add: This will go to the ‘Detail’ tab and present a blank screen for entry of a new Job Order
Resource

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: Not applicable to the List panel

Related: This will bring up a list of functions that are related to the Job Order Resource.  You may
open and maintain information in those screens whilst still remaining in the Job Order Resource
screen.

Reports: This will bring up a list of Reports that are related to the Job Order Resource.  You can
immediately run the report whilst still remaining in the Job Order Resource screen.

Detail Tab

This screen allows you to add and maintain Resource related activities for a selected Job.  
The upper part of the screen shows information taken from the selected Job.  
The lower part of the screen shows the current Resources within this Job.

Entry and Display fields

Order No:  Display only field showing the Job Order Number against which this Resource is being
maintained

Description: Display only field showing the description of the Job Order

Status: Display only field showing the description of the Job Order.

Ordered Date: Display only field showing the date when the Job was ordered.

Required Date: Display only field showing the date when the Job is required.

Required Time of Day: Display only field showing the time of day when the Job is required.

Estimated Duration: The quantity and time unit showing the estimated duration that this Job
Order will take.

Planned Job Start Date / Time: Display only field showing the current planned start date and time
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for the Job Order.  This was program calculated when the Job Booking status was amended to ‘
Booked In’ and could be subsequently amended manually.

Planned Job End Date / Time: Display only field showing the current planned end date and time
for the Job Order.  This was program calculated when the Job Booking status was amended to ‘
Booked In’ and could be subsequently amended manually.

Job Booking Status: Display only field showing the current Booking Status of the Job.  The
displayed options are ‘Not Booked In’ and ‘Booked In’.

Task Name: From the drop-down list select the Task against which this Resource will be used

Resource Type: From the drop-down list select the Resource Type.  The options are Asset or
Employee.

Resource Name: From the drop-down list select the Resource Name.  The options available are
related to the Resource Type selected above

Buttons

Close: This will close the Job Order Resource screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Add: The cursor will go to a new line for entry of a new Resource.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Delete: The current highlighted Resource record will be deleted.

Related:     This will bring up a list of functions that are related to the Job Order Resource.    You
may open and maintain information in those screens whilst still remaining in the Job Order
Resource screen.

Reports:     This will bring up a list of Reports that are related to the Job Order Resource.   You
can immediately run the report whilst still remaining in the Job Order Resource screen.

18.7.10 Job Values

This screen allows you to view the following current information about a selected Job:

· Planned and Actual Invoice Values (Prices and Costs)
· Planned and Actual Job Values (Hours, Prices and Costs)
· Cost Progress to date with projections
· Timeline Progress to date with projections
· Current WIP Value

List Tab

Display fields

The displayed fields are taken from the Job set up via the Jobs screen.  The selection of which
fields to display is at the user’s discretion.  To select the fields to display simply ‘right mouse’ in the
main panel and select ‘Customize List Fields’.  On the displayed panel you can:



1059Jobs

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Jobs whose
status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Job Values screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Detail Tab

This screen allows you to view values relating to the selected Job in the List panel

Display fields

Order No:  Display only field showing the selected Job Order Number.

Order Date: Display only field showing the date when the Job was ordered.

Status: Display only field showing the current Status of the Job Order.

Description: Display only field showing the description of the Job Order

Customer: Display only field showing the Customer for this Job Order.

Invoice Style: Display only field showing the Invoice Style being used for this Job Order.  The
displayed options are ‘From Actual Entries’ or ‘From Schedule’.

(Button) Invoice Schedule: Click on this button to bring up the ‘Job Invoices’ routine (described
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separately in this User Guide) for details on current and planned Invoices. 

Retention Applies: Display only checkbox showing if this Job includes Retentions.

Retention %: Display only field showing the percentage Retention that will be applied to each
Invoice generated from this Job,

Planned and Actual Invoices: Display only area showing the Invoices Planned and Actual
Invoices created for this Job:

Costs
Planned Cost: The sum of Planned Costs for this Job
Invoiced Cost: The Costs to date from generated Invoices
% to Date: Percentage of Invoiced Cost to Planned Cost

Price
Planned Price: The sum of Planned Prices for this Job
Invoiced Price: The Invoice Value to date
% to Date: Percentage of Invoiced Price to Planned Price

Margin%
Planned: (Planned Price - Planned Cost) / Planned Price * 100
Invoiced: (Invoiced Price - Invoiced Cost) / Invoiced Price * 100

Planned and Projected Values: Display only area showing the original Planned and program
evaluated Costs, Prices and Hours for the Job

Hours
Planned: The total planned Job hours evaluated from the Job Details
Projected: The projected Job hours taking account of actual hours to date.
Variance: Percentage of Projected to Planned Hours

Costs
Planned: The total planned Job Costs evaluated from the Job Details
Projected: The projected Job Cost taking account of actual costs to date.
Variance: Percentage of Projected to Planned costs

Price
Planned: The total planned Job Price evaluated from the Job Details
Projected: The projected Job Price taking account of actual Invoices to date.
Variance: Percentage of Projected to Planned Prices

Margin%
Planned: (Planned Price - Planned Cost) / Planned Price * 100
Projected: (Projected Price - Projected Cost) / Projected Price * 100

Costs and Progress: This area lets you view current and projected costs based on completions to
date with provision to override the system-evaluated percentage complete.

Planned: The total planned Job Costs evaluated from the Job Details
Actual: The total actual Job Costs evaluated from the Job Detail actuals
% of Planned: Actual Cost / Planned Cost * 100
Remaining Planned: Remaining Cost taking account of current Task completions
Calculated %: This is the program evaluated percentage completion taking into account
Job Line over-issues, completions, etc
(Prediction): Display only field showing the current trend of this Task.  The display options
are:

· On Track (within percentage set up in Jobs>Settings>Job Rules)
· Higher Unit Costs
· Lower Unit Costs
· Higher Usage
· Lower Usage
· Hi-Low Costs
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· Hi-Low Usage
· Hi-Low Costs & Higher Usage
· Hi-Low Costs & Lower Usage
· Hi-Low Costs & Hi-Low Usage
· Higher Costs & Higher Usage
· Higher Costs & Lower Usage
· Higher Costs & Hi-Low Usage
· Lower Costs & Higher Usage
· Lower Costs & Lower Usage
· Lower Costs & Hi-Low Usage

Override % calculated completion: If this is ‘checked’ then you can enter an override
percentage that will take priority when calculating the projected Cost and percentage of
Planned value
Estimated %: This becomes ‘active’ if the Override % calculated completion’ checked is ‘
checked’.  You can enter a percentage complete value that will take priority when
calculating the projected Cost and percentage of Planned value
Calc-Est Diff: The difference between the Calculated and Estimated percentages
Projected Cost: Based on continuing at current Cost Rate
% of Planned : Estimated final Cost percentage based on Planned Cost

Time and Progress: This area lets you view current and projected hours based on completions to
date

Planned Hours: The sum of Planned Hours from this Job
Actual Hours: The sum of Actual Hours to date from this Job
% Of Planned: Percentage of current Actual Hours to Planned Hours
Remaining Planned: Remaining Hours taking into account the estimated percentage
completion of the project (see ‘Estimated %’ below)
Calculated %: This is the program evaluated percentage completion taking into account
over-bookings, completions, etc
(Prediction): Display only field showing the current time trend of this Task.  The display
options are:

· On Track (within percentage set up in Jobs>Settings>Job Rules)
· Higher Usage
· Lower Usage
· Hi-Low Usage

Override % calculated completion: If this is ‘checked’ then you can enter an override
percentage that will take priority when calculating the projected Cost and percentage of
Planned value
Estimated %: This becomes ‘active’ if the Override % calculated completion’ checked is ‘
checked’.  You can enter a percentage complete value that will take priority when
calculating the projected Hours and percentage of Planned value
Calc-Est Diff: The difference between the Calculated and Estimated percentages
Projected Hours: Based on continuing at current rate
% of Planned : Estimated final Hours percentage based on Planned Hours

WIP Value: The current value of this job in WIP (I.e. The total Cost to date - Invoiced Cost)

Buttons

Close: This will close the Job Values screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
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pressed will be lost.

18.7.11 Location Map

This will display a panel in which you can select either Map or Directions

If you select 'Map' Ostendo will use the mapping system identified in System Settings (this is
initially set to use Google Maps) and, using the Job Order Address, open up the Google Map at
that address

If you select 'Directions' Ostendo will use the mapping system identified in System Settings and
provide directions to travel from the address set up in System Settings to the Job Order Address

18.8 Job Hazards

This screen allows you to maintain the Hazards and Instructions associated with a Job or Job
Tasks. 

Detail Tab

Entry and Display fields

The Job to which these Hazards and/or Instructions relate is shown at the top of this panel.

Task Name: Optional. Select a task name if the hazard/instruction relates to a specific task; else
leave blank if hazard/instruction relates to the job as a whole.

Hazard Style: Select either Code or Group. Code refers to an individual hazard/instruction, while
Group refers to a group of hazards/instructions. 

Group or Code: Select one of the Group or Code from the drop-down list of pre-defined
hazards/instructions.

Override: Tick this box if you wish to override the Description and/or Location, and/or Notes.

Description: The description of the hazard/instruction or group of hazards/instructions.

Location: The location of the hazard/instruction.

Notes: Notes relating to the hazard/instruction.

Buttons

Close: This will close the screen.  If you have any unsaved data then you will be asked if you wish
to save it before the screen is closed.

Add: This will bring up a blank line for entry of a record.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current record or the last time the ‘Save’ Button was pressed
will be lost.
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Delete: This will delete the current highlighted record.

18.9 Job Transactions

This screen allows you to make Transactions to single or multiple Job Orders.  

The process for issuing to Job Orders is:
· Create a Transaction Batch
· ‘Save’ the Batch Header and go to the ‘Lines’ tab
· Add Lines to the Transaction Batch - separate line to cover each Item
· Go back to the Batch Header
· Post the Batch - Ostendo generates the Issue activities related to each line in the

Transaction Batch

Note: Until a Batch is ‘Posted’ the Transactions will not be recorded against the included Job
Order(s)

List Tab

Display fields

Transaction Batch No: This is the Transaction Batch Number as generated by Ostendo and
provides a unique reference to the Transaction Batch

Reference: The Reference attached to this Transaction Batch as entered into the Details screen,

Status: The status of this Transaction Batch.  There are two statuses (In Progress and Updated),
which are maintained by the program. 

Batch Date: The date held against the Transaction Batch.  

Display fields

The displayed fields are taken from the Transaction Batch information entered into the ‘Detail’ tab.
 The selection of which fields to display is at the user’s discretion.  To select the fields to display
simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.   
On the displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
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either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Updated Status - By default the display will only show Batches that have not been
updated.   If you wish to see all batches including those that have been updated then ‘check’ this
checkbox. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Transaction screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up the ‘Detail’ tab for entry of a new Transaction Batch.

Save: Not applicable to the List panel

Cancel: Not applicable to the List panel

Delete: This only becomes ‘active’ when linked to a Transaction Batch with status ‘In Progress’.  In
this instance it enables you to delete the selected Batch.

Related: This will bring up a list of functions that are related to Transactions.  You may open and
maintain information in those screens whilst still remaining in the Transaction screen.

Reports: This will bring up a list of Reports that are related to Transactions.  You can immediately
run the report whilst still remaining in the Transaction screen.

Detail Tab

This tab enables you to create and maintain a Transaction Batch Header.   After creation of a
Batch Header it must be saved (click on the ‘Save’ Button) before Lines can be added 

Entry and Display fields

Batch No:  This is a unique number automatically allocated by the program.  It cannot be
amended.

Style:  From the drop-down list select the Delivery Style.  The options are:
Issue: The transaction batch will issue directly to the Job
Delivery: The transaction batch will create a Delivery Batch which can be progressed
through its various delivery steps

Status: This is the status of the Transaction Batch and is maintained by the program.  The
displayed variants are:

In Progress - The Transaction Batch is still being worked on
Updated - The Transaction Batch has been ‘Posted’ and Job Order Lines updated

Tracking Code: From the drop-down list select the Tracking Code.  Tracking Codes are user
maintained (Jobs>Settings>Job Tracking) and enable you to track your Deliveries and filter views
or reports by this Code.

Order No: Only displayed if Style is 'Delivery'.   From the drop-down list select the Order Number



1065Jobs

that applies to this Delivery Tracking Code.  Tracking Codes are user maintained
(Jobs>Settings>Job Tracking) and enable you to track your Deliveries and filter views or reports by
this Code.

Delivery Address: Only displayed if Style is 'Delivery'.    Display only field showing the base
delivery address of the Customer.

Additional Delivery Address Details: Only displayed if Style is 'Delivery'.   Click on this button to
view and maintain the delivery address.  This is prefilled with the Delivery Address held against the
Sales Order but can be amended by clicking the drop-down button against the first field.  You can
amend any of the following information.

· Address: Three lines covering the delivery address.  
· City: The Town or City where this Delivery Address is located.
· State: The State where this Delivery Address is located.
· Code: The Postcode or ZIP Code where this Delivery Address is located.
· Country: The Country where this Delivery Address is located.
· Contact: To change the Contact select from the drop-down list
· Phone: The Telephone Number of the Contact
· Fax: The Facsimile Number of the Contact

Override Default Warehouse/Location: If this is ‘checked’ then the following two fields will
become ‘Active’ and an entry is required in each field.   These will become the ‘Issue’
Warehouse/Location for all Items in this Job Transaction and will override the default
Warehouse/Location held against individual Item Codes

Default Warehouse: From the drop-down list select the Warehouse from which the Transaction is
being made.

Default Location: From the drop-down list of Locations within the above Warehouse select the
location from where the Transaction is being made.

Reference: An optional entry field to briefly describe the transaction batch.

Shipping Method: Select the desired method from the drop-down list.

Shipping Reference: Enter the Shipping reference code here.

No of Shipping Pieces for Label Printing: Only displayed if Style is 'Delivery'.   Enter the number
of Labels to be  printed.   You may print the Labels by clicking the 'Labels' Button down the right of
this screen

Batch Updating

Delivery Only with No Job Issues: Tick this box if this batch is raised for delivery purposes only
with no job issues required. This is used in situations when the items are already issued to the job,
but the delivery is spread out over several stages.

Task Bill Issue Level: This allow you to specify whether the Task Bill is issued at a Task Bill Code
level or at the individual component level. Issuing at the code level will be faster than issuing at the
component level.

Kitset Issue Level: This allow you to specify whether the KitSet is issued at a KitSet Code level or
at the individual component level. Issuing at the code level will be faster than issuing at the
component level.

Batch Date: Prefilled with the System Date.  This can be amended to another date by clicking on
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the drop-down calendar

Post Job Transaction: If this button is selected then all the entries contained in the ‘Lines’ panel
will be actioned and the referenced Job Order Lines updated.  The status of this Batch will then be
amended to ‘Updated’

Delivery Tracking

This panel provides a semi-automatic view of the progress of a Delivery through the Despatch
process.  Some fields are automatically updated as described.  However all fields can be manually
adjusted as required.

Pick List Document:  Shows the status of the Pick List that covers this Delivery.  The fields are:
Status:  If the ‘Picklist’ button is selected and the Picklist printed then this will change to
status ‘Printed’.  You can amend this as required
Employee:  If you wish to record who printed the Picklist then select the Employee from
the drop-down list
Date:  If the ‘Picklist’ button is selected and the Picklist printed then this will be filled with
the system date.  You can amend this as required
Time:  If the ‘Picklist’ button is selected and the Picklist printed then this will be filled with
the system time.  You can amend this as required

Picking Process:  Shows the status of the Picking process for this Delivery.  The fields are:
Status:  From the drop-down list select the current status of the Picking Process.  The
options are ‘Planned’, ‘InProgress’, or ‘Complete’
Employee:  If you wish to record who is carrying out this step then select the Employee
from the drop-down list
Date:  If you wish to record the Date of the current status then select the date from the
drop-down calendar
Time:  If you wish to record the Time of the current status then enter the time as required.

Packing Process:  Shows the status of the Packing process for this Delivery.  The fields are:
Status:  From the drop-down list select the current status of the Packing Process.  The
options are ‘Planned’, ‘InProgress’, or ‘Complete’
Employee:  If you wish to record who is carrying out this step then select the Employee
from the drop-down list
Date:  If you wish to record the Date of the current status then select the date from the
drop-down calendar
Time:  If you wish to record the Time of the current status then enter the time as required.

Shipping Labels:  Shows the status of the Labels Print for this Delivery.  The fields are:
Status:  If the ‘Labels’ button is selected and the Labels printed then this will change to
status ‘Printed’.  You can amend this as required
Employee:  If you wish to record who printed the Labels then select the Employee from
the drop-down list
Date:  If the ‘Labels’ button is selected and the Labels printed then this will be filled with
the system date.  You can amend this as required
Time:  If the ‘Labels’ button is selected and the Labels printed then this will be filled with
the system time.  You can amend this as required

Delivery Document:  Shows the status of the Delivery Document covering this Delivery.  The
fields are:

Status:  If the ‘Delivery’ button is selected and the Document printed then this will change
to status ‘Printed’.  You can amend this as required
Employee:  If you wish to record who printed the Document then select the Employee
from the drop-down list
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Date:  If the ‘Delivery’ button is selected and the Document printed then this will be filled
with the system date.  You can amend this as required
Time:  If the ‘Delivery’ button is selected and the Document printed then this will be filled
with the system time.  You can amend this as required

Notes: Extended Notes for your own information can be attached to this Transaction Batch. 
Whenever you click on this field an icon will appear in the top-right.   By clicking on this Icon you
can bring up the Frequently Used Text table.   Select the text to be copied and either press the OK
Button in that screen or double-click the selected record.

Buttons

Close: This will close the Transaction screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will bring up a blank ‘Detail’ screen for entry of a new Transaction Batch.

Save: This will save the current data without exiting the screen

Cancel: Any changes made to the current Transaction Batch Header record or the last time the ‘
Save’ Button was pressed will be lost.

Delete: Not applicable to the Detail panel

Related: This will bring up a list of functions that are related to the Transaction.  You may open
and maintain information in those screens whilst still remaining in the Transactions screen.

Reports: This will bring up a list of Reports that are related to the Transaction.  You can
immediately run the report whilst still remaining in the Transaction screen.

Picklist: This will allow you to print the Pick List for the current Delivery

Labels: This will allow you to print the number of shipping labels defined above

Delivery: This will allow you to print the Delivery Note for the current Delivery

Lines Tab

This tab enables you to add and maintain Job Issue lines.  The Transaction Batch Number and
status will be displayed at the top of the panel.  You can create a batch for a single Item or can
product a large batch covering a range of Job Orders.  To help in putting together an Issue Batch
you can click on the ‘Select Job for prefilling Issues’ button  This ‘speed entry’ has the following
options:

Order No: From the drop-down list select the Order Number.  Two options are now available for
pulling in line details from this Job Order:

Prefill with planned usage for all lines: Select this radio button to copy all lines and
prefill the issue quantity field with the planned usage quantity.

Prefill with planned usage for lines linked to a single Task: Select this radio button to
copy all lines within a Task and prefill the Transaction quantity field with he planned usage
quantity.  This option requires a selection in the Task field

NOTE: The displayed list only shows:



1068 Ostendo Reference Guide

· Items whose Supply Method is ‘Supply From Stock’ because all other Items are ‘
Source on Demand’ and will be supplied directly from Purchase or Assembly Orders

· Descriptors that are Sourced By ‘Internal’ because those Sourced By ‘Purchasing’
will be directly supplied from a Purchase Order 

Task Name: In the second instance you are required to select the Task from a drop-down
list.

Date to be used for lines: This is prefilled with the system date and denotes the
transaction date that will be used.  You may amend this date by entering the date or by
clicking on the drop-down menu and selecting the date.

Entry and Display fields

You may either use the above ‘Speed Entry’ to create lines or add individual lines as required.  All
lines can be amended as required prior to ‘posting’.  It is essential that you record all Item
variations (Colour, Batch, etc) otherwise the Batch Transaction function will not accept the
transaction.  The following fields are available:

Date: In the first instance this is prefilled with the system Date.  You can change this date by
entering the date or clicking on the drop-down menu and selecting the date.

Order No: This shows the current selected Job Order against which this Item is being issued.  You
may amend this by selecting another Job Order from the drop-down list.  

Task Name: This shows the current selected Task in the Job Order.  You may amend this by
selecting another Task from the drop-down list of steps for the selected Job Order.  

Line Type: This shows the Line Type covering this line.  You may amend this by selecting another
Line Type from the drop-down list.  The options are Descriptor Code or Item Code.

Code: From the drop-down list select the Descriptor Code or Item Code that applies to this line

Unit: Prefilled with the base Unit for the Item or Descriptor.  If the Item has more than a single Unit
of Measure then an alternate Unit can be selected from the drop-down list.

Qty: The Quantity to be issued.  This can be amended at any time

Unit Cost: The nominal Unit Cost of the Code.  This can be amended here is required

Description: The normal description of the Code.  You can amend this here and make it specific
to this Job Line Issue

Charge Style: Select the charge style from the drop-down list. The options are:
· Chargeable
· Warranty
· Contract
· Non-Charge

No Charge Code: If charge Style is ‘non-charge’ then select non-charge code from drop-down list
 

Warehouse: For an Item Code this is prefilled with the default ‘Issue’ Warehouse.  You may
amend this by selecting another Warehouse from the drop-down list

Location: For an Item Code this is prefilled with the default ‘Issue’ Location.  You may amend this
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by selecting another Location from the drop-down list

Variants: If the Line Item Number has variants (Serial Number, Expiry Date, Batch No, Rev No,
Size, Colour, Grade) then they should be entered into the respective fields.  

Recorded Notes: Extended Notes for your own information can be attached to this Line.   

Status: The status of the Job Transaction line.

To Container ID:  The container where this item is issued or picked to.

Buttons

Close: This will close the Job Transactions screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for creation of a new Transactions record.

Save: This will save the current line’s data without exiting the screen

Cancel: Any changes made to the current line record or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This will delete the selected Transaction Batch Line

Related: This will bring up a list of functions that are related to the Transaction.  You may open
and maintain information in those screens whilst still remaining in the Transactions screen.

Reports: This will bring up a list of Reports that are related to the Transaction.  You can
immediately run the report whilst still remaining in the Transactions screen.

18.10 Job Pending Invoices

Job Pending Invoices
This screen allows you to view Pending Invoices from:

‘Schedule’ Style Invoices - Those ‘Schedule’ Style Invoices that are now due.  Each
Invoice is approved prior to conversion to a physical Invoice

‘Actual Entry’ Style Invoices - Those Job Lines containing ‘Actual’ entries yet to be
Invoiced.   An additional step is included if approvals are required prior to generating the
physical invoice

List Tab

Data Entry Fields

Display Pending Invoice Requirements up to: All pending Invoices up to this date will be
displayed in the lower panel.  This field is prefilled with the system Date but you can amend this by
either keying in a new date or selecting the date from the drop-down calendar. 

Data Display Options
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Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Buttons

Close: This will close the Job Pending Invoice screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to the Job Pending Invoice.  You may
open and maintain information in those screens whilst still remaining in the Job Pending Invoice
screen.

Reports: This will bring up a list of Reports that are related to the Job Pending Invoice.  You can
immediately run the report whilst still remaining in the Job Pending Invoice screen.

Detail Tab

Entry and Display fields

At the top of this screen is the Job selected on the ‘List’ screen.  The displayed fields below are
related to the Invoice Style of the selected Job

‘Schedule’ Style Pending Invoices

All scheduled Invoices - up to the date in the List’ screen - for the selected Job will be displayed.

Approved for Invoicing: ‘Check’ this box if you are converting this scheduled Invoice into a
physical Invoice 

Planned Date: Display only field showing the date when this Invoice was scheduled to be
generated

Planned %: Display only field showing the percentage of the total Job Value that will be covered by
this Invoice

Planned Value: Display only field showing the monetary Value covered by this Invoice

‘Actual Entry’ Style Pending Invoices

All Job Transactions along with their date and quantity that have yet to be Invoiced will be
displayed.

Approved for Invoicing: This is only visible if the ‘Invoice Approvals’ checkbox in the Job Rules
screen (Jobs>Settings>Job Rules) has been ‘checked’.   When visible you should ‘check’ this box
if you are including this Job Transaction Line in the Invoice.

Line Type: Display only field showing the type of product or service covered by this Transaction.
The displayed variants are:

· Item Code
· Descriptor Code
· Labour Code
· Kitset Code
· Catalogue Code
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Code: Display only field showing the actual code of the Line Type displayed in the previous field

Order quantity: Display only field showing the total order quantity of the Code against this line of
the Job

To Be Invoiced Qty: Display only field showing the uninvoiced quantity held against this Job
Transaction.

Invoiced Qty: Display only field showing the total quantity previously invoiced against this line.

Task: Display only field showing the Job Task against which this Job Transaction was made

Actual Date: Display only field showing the date when the Job Transaction was carried out.

Line Number: Display only field showing the Line Number within the Job Task

Unit: Display only field showing the Unit of Measure held against the Job Line

Charge Style: Display only field showing the Charge Style linked to this Job Transaction

Unit Price: Display only field showing the Unit Price of this Job Transaction

Description: Display only field showing the Description of the Code

Line Notes: Display only field showing additional Notes against the Job Transaction Line

Employee: Display only field showing the employee for this Job Transaction

Issue Source: Display only field showing the source of the issue

Issue No: Display only field showing issue number

Buttons

Approve All Lines: If this is ‘checked’ then all the displayed lines will have their ‘Approved for
Invoicing’ checkbox ‘checked’.  You can then individually ‘uncheck’ boxes as required.

Unapprove All Lines: If this is ‘checked’ then all the displayed lines will have their ‘Approved for
Invoicing’ checkbox ‘un-checked’.  You can then individually ‘check’ boxes as required.

Close: This will close the Job Pending Invoice screen.  If you have any unsaved data then you will
be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Related: This will bring up a list of functions that are related to the Job Pending Invoice.  You may
open and maintain information in those screens whilst still remaining in the Job Pending Invoice
screen.

Reports: This will bring up a list of Reports that are related to the Job Pending Invoice.  You can
immediately run the report whilst still remaining in the Job Pending Invoice screen.
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18.11 Job Retentions

Job Retention records are created whenever a Job Invoice is generated that is subject to
Retentions. This screen enables you to maintain a record's Date and Value, create a Pending
Invoice and Print the Invoice for a selected Retention record.

List Tab

Display fields

The displayed fields are taken from Job Orders whose Invoices are subject to Retentions
The selection of which fields to display is at the user’s discretion.  To select the fields to display
simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.  On the displayed panel
you can:

· Click on the ‘Show field’ checkbox to display the field 
· Amend the column heading by changing the content of ‘Display Label’ 
· Define the sort sequence of the records by going to the lower panel and dragging the field

from Available Fields’ to ‘Sort By’.  
· Click the ‘Save’ Button when done. 

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking again
will sort in descending order. 

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Job Retentions screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Job Retentions.  You may open and
maintain information in those screens whilst still remaining in the Job Invoices screen.

Reports: This will bring up a list of Reports that are related to Job Retentions.  You can
immediately run the report whilst still remaining in the Job Retention screen.

Retentions Tab

 This tab displays all the Retention records generated against this Job Order.  A Retention record
is generated whenever the originating Invoice is created.    This screen allows you to amend the
planned date and value against each Retention record along with defining the specific Descriptor
that will appear on the generated Retention Invoice 
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Entry and Display fields

 Order No: Display only field showing the Job Order selected in the List panel.

Description: Display only field showing the description of the selected Job Order.

Status: Display only field showing the Status of the selected Job Order.

Customer: Display only field showing the Customer held against the selected Job Order.

Job Type: Display only field showing the Job Type taken from the selected Job Order.

Job Style: Display only field showing the Job Style taken from the selected Job Order.

Retentions Sub Tab

Displays the current Retention records. You have the option to maintain the Retention Date and
Retention Value if required.  

(Button) Create Retention Invoice: Selecting the scheduled Retention Invoice in the lower part of
this screen and clicking this button will generate the physical Invoice but not print it.  The printing
can be carried out by clicking the ‘Print Selected Invoice’ button to the right of this screen.

(Button) Generate a Credit for the Selected Invoice: This is displayed if you are generating a
Credit for a Retention Invoice that has already been ‘Printed’.  Selecting the Invoice in the lower
part of this screen and clicking this button will create a Credit for the Invoice. 

(Button) Delete Selected Invoice: This is displayed if you are deleting an Invoice that has not
been ‘Printed’.  Selecting the Retention Invoice in the lower part of this screen and clicking this
button will remove the Invoice Number from the 'Invoice No' field.  It will not delete this planned
Retention Invoice line. 

(Button) Display Invoice Screen: If a Planned Retention Invoice Line contains a generated
Invoice Number in the 'Invoice No' field then clicking on this button will bring back the Sales Invoice
Screen that shows the actual Invoice and its details.

Originating Invoice: Display only field showing the Originating Invoice against which this
Retention was generated.

Original Value: Display only field showing the Retention Value related to the Originating Invoice.

Retention Date: The Date when this Retention Invoice is scheduled to be issued.  You can amend
the date by either overtyping the date or selecting the date from the drop-down calendar. 
However, if this line has already been converted into a physical Invoice then this is the actual
Invoice Date and cannot be amended.
 
Retention Value: The Value of the Retention Invoice.  You can amend this value if required.
However, if this line has already been converted into a physical Invoice then this is the actual
Invoice Value and cannot be amended.

Invoice No: Display only field showing the Invoice Number generated against this Retention
Invoice when the above 'Create Retention Invoice' button was pressed.

Print Status: Display only field showing the current print status of the Invoice.  The displayed



1074 Ostendo Reference Guide

options are ‘Not Printed’ and ‘Printed’.

Status: This shows the current status of this Retention record.  This defaults to 'Open' but can be
amended to either 'Closed' or 'On-Hold' from the drop-down list only if the record does not contain
an Invoice Number in the 'Invoice No' field.

Invoice Line Sub Tab

This information will be printed on the Invoice as the Invoice Line.

Line No: Enter the Line Number that will appear on the Invoice.  No checks are made on this entry

Line Type: The Line Type for this style of Invoice is always ‘Descriptor’ and cannot be amended.

Code: From the drop-down list select the Descriptor Code that will appear on the Invoice.

Unit: Display only field showing the Unit of Measure of the Descriptor.

Qty: Display only field showing a unit quantity of 1.

Line Description: Prefilled with the description of the above Code.  It can be amended here and
made specific to this Invoice.

Tax Code: This Tax Code is initially populated with the Tax Code relating to the Customer’s Tax
Group and the Descriptor’s Tax Group.  You can amend this at any time by selecting another Tax
Code from the drop-down List.

Analysis Group: This is initially populated with the Analysis Group held against the Descriptor
record.  You can amend this at any time by selecting another Analysis Code from the drop-down
List.

Line Comments: You can enter unlimited amount of information that is related to this Invoice Line.
This information will be copied to the generated Invoice.  Whenever you click on this field an icon
will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.  Select the text to be copied and either press the OK Button in that screen or double-click
the selected record

Buttons

Close: This will close the Job Retentions screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Related: This will bring up a list of functions that are related to the Job Retentions.  You may open
and maintain information in those screens whilst still remaining in the Job Retentions screen.

Reports: This will bring up a list of Reports that are related to the Job Retentions.  You can
immediately run the report whilst still remaining in the Job Retentions screen.

Print: This will bring up a list of Reports that are related to the Job Retentions.  You can
immediately run the report whilst still remaining in the Job Retentions screen.
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Print: This will generate and print the current Invoice

18.12 Job Invoices

This screen allows you to generate and maintain Invoices:
· From actual work performed if Invoice Style is ‘From Actual Entries’
· From agreed Price if Invoice Style is ‘From Schedule’

List Tab

Display fields

The displayed fields are taken from Jobs whose ‘Invoice Style’ is either ‘From Actual Entries’ or ‘
From Schedule’.  The selection of which fields to display is at the user’s discretion.  To select the
fields to display simply ‘right mouse’ in the main panel and select ‘Customize List Fields’.  On the
displayed panel you can:

· Click on the ‘Show field’ checkbox to display the field
· Amend the column heading by changing the content of ‘Display Label’
· Define the sort sequence of the records by going to the lower panel and dragging the field

from ‘Available Fields’ to ‘Sort By’. 
· Click the ‘Save’ Button when done.

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking
against will sort in descending order.

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
(Custom…) to enter detailed selection criteria.

Include Closed Status - If this is checked then the displayed list will include those Jobs whose
status is ‘Closed’

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Buttons

Close: This will close the Job Invoices screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Job Invoices.  You may open and
maintain information in those screens whilst still remaining in the Job Invoices screen.

Reports: This will bring up a list of Reports that are related to Job Invoices.  You can immediately
run the report whilst still remaining in the Job Invoices screen.
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Detail Tab

This tab allows you to maintain Job Invoices.

Entry and Display fields

Order Number: Display only field showing the Job selected in the List panel.

Description: Display only field showing the description of this Job Order.

Status: Display only field showing the current status of the Job.  The options are:
· In Progress
· Open

Customer: Display only field showing the Customer for the Job.

Job Type: Display only field showing the Job Type of this Job Order.

Job Style: Display only field showing the Job Style of this Job Order.

A Planned Retention Applies: When ‘checked’ it denotes that this Job is subject to Retentions
and, for each Invoice raised, the percentage identified in the next field will be withheld.  A
Retention Invoice can be printed separately whose value is the accumulated Retention amount.

Retention % Amount: Enter the percentage of each Invoice Amount that will be held as a
Retention 

Planned Retention Date: Enter the date when you plan to claim the Retention amount. This date
enable Ostendo to keep track of Retentions and remind you when the Retention Invoice is due.  To
enter a date click on the drop-down calendar and select the date

Status: Display only field showing status of the Retention.  The display options are:
· Planned
· Invoiced

Line No: Enter the Line Number that will appear on the Retention Invoice.  No checks are made
on this entry

Code: From the drop-down list select the Descriptor Code to which the Retention relates

Unit: Display only field showing the Unit of Measure of the Descriptor.

Tax Code: This Tax Code is initially populated with the Tax Code relating to the Customer’s Tax
Group and the Descriptor’s Tax Group.  You can amend this at any time by selecting another Tax
Code from the drop-down List.

Analysis Group: This is initially populated with the Analysis Group held against the Descriptor
record.  You can amend this at any time by selecting another Analysis Code from the drop-down
List.

Accumulated Retention Value: Display only field showing the current value of Retentions taken
from Invoices raised.

(Button) Create Retention Invoice: This will generate a Retention Invoice for the outstanding
amount.
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Actual Retention Value: Display only field showing the value of Retentions claimed.

Actual Retention Date: Display only field showing the date when the last retention claim was
made.

Notes: You can enter unlimited amount of information that is related to this Retention.  This
information will be copied to the generated Retention Invoice.  Whenever you click on this field an
icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.  Select the text to be copied and either press the OK Button in that screen or double-click
the selected record.

Buttons

Close: This will close the Job Invoices screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Job Invoices.  You may open and
maintain information in those screens whilst still remaining in the Job Invoices screen.

Reports: This will bring up a list of Reports that are related to Job Invoices.  You can immediately
run the report whilst still remaining in the Job Invoices screen.

Invoices Tab

This screen shows:
· The Invoicing Schedule for ‘From Schedule’ Job Orders with current status
· The claimed Invoices from ‘From Actual Entries’ Job Orders

The format of the display depends upon the Invoice Style being invoiced.

‘From Schedule’ Style Invoicing

This screen facilitates a payment schedule to be created with percentage payments.  Each
scheduled Invoice can be independently generated as required. 

Entry and Display fields

Total Job Value: Display only field showing the current total Job Value

Unscheduled Job Value: This is displayed if the Invoice Style is ‘From Schedule and shows the
Total Job Value amount less the Value currently scheduled.

(Button) Create Pending Invoice: Selecting the scheduled Invoice in the lower part of this screen
and clicking this button will generate the physical Invoice but not print it.  The printing can be
carried out by either clicking the ‘Print Selected Invoice’ button at the bottom of this screen, or
running the Batch Invoice Print routine found under Sales>Batch Invoicing.

(Button) Generate a Credit for the Selected Invoice: This is displayed if you are generating a
Credit for an Invoice that has already been ‘Printed’.  Selecting the scheduled Invoice in the lower
part of this screen and clicking this button will create a Credit for the Invoice. 

(Button) Delete the selected Invoice: This is displayed if you are deleting an Invoice that has not
been ‘Printed’.  Selecting the scheduled Invoice in the lower part of this screen and clicking this
button will delete the Invoice.  You should note that an Invoice cannot be deleted if it has been
printed
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(Button) Display Invoice Screen: If a Line has a generated Invoice Number then clicking on this
button will bring back the Sales Invoice Screen that shows the actual Invoice and its details.

Sequence No: The system allocates this number whenever a new line is added.  It can be
amended to any other number as required.

Plan Date: The Date when this Invoice is scheduled to be issued.  You can amend the date by
either overtyping the date or selecting the date from the drop-down calendar.  However, if this line
has already been converted into a physical Invoice then this is the actual Invoice Date and cannot
be amended.

Plan %: When adding anew line this is prefilled with the outstanding percentage.  It can be
amended here to reflect a different percentage.

Plan Value: Display only field showing this Invoice value calculated from the full Job Value * This
Plan %.

Code: From the drop-down list select the Descriptor Code that will be used to define the
description of the Invoice Line.  You may select this from within the 'Invoice Lines' tab in addition to
amending the line's description and Tax Code, etc

Invoice No: The Invoice Number that was generated from this planned Invoice

Print Status: Display only field showing the current print status of the Invoice.  The displayed
options are ‘Not Printed’ and ‘Printed’.

Actual Date: Display only field showing the date of the actual Invoice generated from this planned
Invoice

Actual %: Display only field showing the actual percentage of the total value claimed.

Invoice Cost Style: This shows the source of costs that will be attributed to this Invoice.  The
options are: 

· Actual - The current total held in Job WIP for this Job
· Planned - The Planned % multiplied by the total 'Planned' Job Cost
· Projected - The Planned % multiplied by the total 'Projected' Job Cost (As calculated and

shown in the Job Costing Sheet)
· Fixed Amount - The amount entered into field 'Fixed Cost Value'
· Fixed Act Percent - The % amount entered into field 'Fixed Cost Value' multiplied by the

current total held in Job WIP for this Job
· Fixed Plan Percent - The % amount entered into field 'Fixed Cost Value' multiplied by the

total 'Planned' Job Cost
· Cost upto Inv Date - This will only include actual costs up to the date of the invoice

created.     

Fixed Cost Value: Manually entered value relating to the Fixed Cost Style entered into the
previous field

Accounting Style: Shows the accounting style adopted for this Invoice.  The options are

· Income Deferred - Invoice Based Accounting
· Income Recognised - Payment Based Accounting

Actual Nett Value: Display only field showing the Invoice amount less any Retention amount.



1079Jobs

Retention Value: Display only field showing the Retention amount.

Fixed Cost Value: Display only field showing the Fixed Cost amount.

Retention 1 % - enter the percentage for the first Retention to be applied to this Invoice

Retention 1 Date - enter the date when the first Retention is due to be paid

Retention 2 % - enter the percentage for any second Retention to be applied to this Invoice

Retention 1 Date - enter the date when the second Retention is due to be paid

Override Billing Customer - This is only visible if the Job Type is Scheduled.   You have the
option to send the Invoice to other than the Job Billing Customer by selecting from the drop-down
list of Customers.  

Invoice Line Tab

For each Scheduled Line created you need to identify the details that will be printed on the Invoice
as follows.  Further (sub level) details can be added via the 'Lines for Printing Only' tab

What to print on the Invoice: Select the Invoice line print option that you wish to use.  The
options are:

· Use the line below for printing on the Invoice
· Use the line below as the Priced Invoiced Line but also include a Descriptive Content

Breakdown.
· Enter Multiple Priced Descriptive Lines to print on the Invoice

If the second or third option is selected then an extra ‘Tab’ (Lines for Printing Only) will appear for
you to enter Freeform descriptions of the detailed Lines.  You may also click the Button 'Prefill
Descriptive Lines from Job Lines' and this will copy the current Job Line details to this tab.  You
should note that these are information only for the purpose of printing out on the Invoice.  You may
amend the information as required

Line No: Enter the Line Number that will appear on the Invoice.  No checks are made on this entry

Line Type: The Line Type for this style of Invoice is always ‘Descriptor’ and cannot be amended.

Code: From the drop-down list select the Descriptor Code that will appear on the Invoice.

Line Description: Prefilled with the description of the above Code.  It can be amended here and
made specific to this Invoice.

Unit: Display only field showing the Unit of Measure of the Descriptor.

Qty: Display only field showing a unit quantity of 1.

Tax Code: This Tax Code is initially populated with the Tax Code relating to the Customer’s Tax
Group and the Descriptor’s Tax Group.  You can amend this at any time by selecting another Tax
Code from the drop-down List.

Analysis Group: This is initially populated with the Analysis Group held against the Descriptor
record.  You can amend this at any time by selecting another Analysis Code from the drop-down
List.
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Line Comments: You can enter unlimited amount of information that is related to this Invoice Line.
This information will be copied to the generated Invoice.  Whenever you click on this field an icon
will appear in the top-right.  By clicking on this Icon you can bring up the Frequently Used Text
table.  Select the text to be copied and either press the OK Button in that screen or double-click
the selected record

'Lines for Printing Only' Tab

The current Invoice Lines can have the description extended as defined by the selection in the
'Invoice Line' tab.

Line:  Auto generated Line Number.  This can be amended if required if you wish to resort the print
sequence.

Code:  From the drop-down list select the Descriptor Code that will be used to represent this line.

Description:  This is copied from the above Descriptor but can be amended here and made
specific to this line if required.  No checks are made on the entry

Unit:  The Unit of Measure held against the above Descriptor is copied to this line.  It cannot be
amended here

Unit Price:  This is only visible for Line Printing Options 1 and 3.  When visible you should enter a
Unit Price for the Line

Qty:  Enter the quantity that you are using against this line.

Ext Price:  This is only visible for Line Printing Options 1 and 3.  When visible it displays the value
calculated from the Unit Price multiplied by the quantity.

Amount to Balance to:  This is only visible for Line Printing Options 1 and 3.  When visible it
displays the value of the Scheduled Invoice.  It is against this value that the sum of these Lines are
validated.

Difference:  This is only visible for Line Printing Options 1 and 3.  When visible it displays the
difference between the value of the Scheduled Invoice and the sum of the Lines in this screen.

Lines Total:  This is only visible for Line Printing Options 1 and 3.  When visible it displays the
sum of the ‘Extended Prices’ in this screen.

Line Comments: In the first instance this will be prefilled with the Notes that are attached to the
Descriptor record.   You can amend this and enter unlimited amount of Notes that are related each
Line.    These notes will be available wherever the Invoice is printed.  Whenever you click on this
field an icon will appear in the top-right.  By clicking on this Icon you can bring up the Frequently
Used Text table.  Select the text to be copied and either press the OK Button in that screen or
double-click the selected record.

'Cost Centre Mapping' Tab

This is only visible for 'Scheduled' Invoices and defines the Cost Centres (ledger codes) that this
will be posted to.  This panel is automatically populated with Cost Centres as defined by Job Rule
'Invoice Schedule Posting Style'.  That rule has the following options

Standard: Defaults both Cost Centres based on the Sales Mapping Matrix rules for the
Descriptor Code used in the Scheduled Invoice record
Job Type Posting Template: Uses the Cost Centres and their ratio’s defined in the new ‘
Job Type Posting Template’ screen
Job Lines Sales Mapping: Determines the Cost Centres and their ratio’s from the Lines
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in the Job Order and the Sales Mapping Matrix rules associated with each

Actual Entry Invoices

For ‘Actual Entries’ Invoices this screen facilitates the generation of Invoices from the current ‘
un-invoiced’ actual bookings against the Job

Entry and Display fields

Total Job Value: Display only field showing the current total Job Value

To Be Invoiced: This shows - for actual work performed - the amount yet to be Invoiced.

Non Charge: This shows work that has been carried out and is non-chargeable.

Approved Charge: This shows how much of the 'To Be Invoiced' amount has been approved for
Invoicing.

Approved Non Charge: This shows how much of the 'Non Charge' amount has been approved.

(Button) Create Pending Invoice: Clicking this Button will activate the program to address all
un-invoiced actual bookings and generate a single Invoice for that amount

(Button) Generate a Credit for the Selected Invoice: This is displayed if you are generating a
Credit for an Invoice that has already been ‘Printed’.  Selecting the scheduled Invoice in the lower
part of this screen and clicking this button will create a Credit for the Invoice. 

(Button) Delete the selected Invoice: This is displayed if you are deleting an Invoice that has not
been ‘Printed’.  Selecting the scheduled Invoice in the lower part of this screen and clicking this
button will delete the Invoice.  You should note that an Invoice cannot be deleted if it has been
printed

(Button) Display Invoice Screen: If a Line has a generated Invoice Number then clicking on this
button will bring back the Sales Invoice Screen that shows the actual Invoice and its details.

Invoice No: The Invoice Number that was allocated when generating this Invoice.

Print Status: Display only field showing the current print status of the Invoice.  The displayed
options are ‘Not Printed’ and ‘Printed’.

Actual Date: Display only field showing the date when the Invoice was generated.

Actual Nett Value: Display only field showing the Invoice amount less any Retention amount.

Retention Value: Display only field showing the Retention amount.

Fixed Cost Value: Display only field showing the Fixed Cost amount.

Retention 1 % - enter the percentage for the first Retention to be applied to this Invoice

Retention 1 Date - enter the date when the first Retention is due to be paid

Retention 2 % - enter the percentage for any second Retention to be applied to this Invoice

Retention 1 Date - enter the date when the second Retention is due to be paid
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Buttons

Close: This will close the Job Invoices screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Related: This will bring up a list of functions that are related to Job Invoices.  You may open and
maintain information in those screens whilst still remaining in the Job Invoice screen.

Reports: This will bring up a list of Reports that are related to Job Invoice.  You can immediately
run the report whilst still remaining in the Job Invoice screen.

Print: Clicking this button will print the selected Invoice. 

18.13 Job Budgets

This screen allows you to create and maintain Job Budgets

List Tab

The List panel shows a grid of all Budgets currently in Ostendo

Display fields

Order No: This is display only that shows the Job Orders in Ostendo.   

Status: This is display only showing the current Status of the Job Order taken from the Job
Header record

Job Type: This is display only showing the Job Type of the Order taken from the Job Header
record

Invoice Style: This is display only showing the Invoice Style used by the Order taken from the Job
Header record

Customer: This is display only showing the Customer of the Order taken from the Job Header
record

Job Value: This is display only showing the Order Value taken from the Job Header record

Invoice Value: This is display only showing the Invoice Value taken from the Job Header record

Data Display Options

Field Position - On the List screen you can move the field position by dragging the column
heading left or right to the position where you want it to appear.

Filtering and Sorting - If you ‘check’ the checkbox then the displayed data is available for filtering
and sorting:

· To sort the data in a selected column simply click on the column heading.  Clicking against
will sort in descending order. 

· Click on the black ‘down arrow’ to the right of your selected column heading and you can
either select a specific entry to display all records containing that entry, or you can select
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(Custom…) to enter detailed selection criteria. 

Searching - If you enter some text into the ‘Search’ field and click on the ‘binoculars’ Icon then all
records will be interrogated and those records that contain the entered text will be displayed.  To
revert back to displaying all records click on the ‘Eraser’ Icon

Detail Tab

This panel shows a grid of all Budgets currently held against the selected Job Order

Entry and Display fields

Budget Style 1: This is display only and shows the Budget Style 1.    The available Styles are:
· Job
· Task
· Line Type
· Analysis Group
· Item Code
· Labour Code
· Descriptor Code

Budget Style 2: This is display only and shows the Budget Style 2.    The available Styles are:
· Job
· Task
· Line Type
· Analysis Group
· Item Code
· Labour Code
· Descriptor Code

Budget Type: Select the Budget Type from the drop-down list.  The available Types are:
· Revenue
· Cost
· Qty
· Profit

Total Value: This is display only and shows the Total Value of this Budget.  It is maintained by
Ostendo from the entries made in the following Monthly Value fields
 
Monthly Value Value: Enter the Monthly Budgets.  There are up to 36 months for the entries
commencing with the month that the Job Order was created

Buttons

Close: This will close the Budgets screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Budget against the selected Job

Save: This will save the current data without exiting the screen.  It will also apply any Annual
Amount to the individual Monthly amount fields

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.
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Delete: This will delete the current Line record

Related: This will bring up a list of functions that are related to the Budget.  You may open and
maintain information in those screens whilst still remaining in the Budget screen.

Reports: This will bring up a list of Reports that are related to the Budget.  You can immediately
run the report whilst still remaining in the Budget screen.

18.14 Job Budget Comparisons

This screen enables you to run a Pivot or Analysis Budget View against parameters entered in this
screen.

Entry and Display fields

Order Number: From the drop-down list select the Job Order Number to be used in this
comparison.

Budget Style: From the drop-down list select the Budget Style.

Buttons

Pivot View: This will create a Pivot View using the above parameters and return the results to the
screen.  From here you have the option to Print, Email, Export, or Save the View

Analysis View: This will create an Analysis using the above parameters and return the results to
the screen.  From here you have the option to search and filter the results in addition to outputting
to Print, Email, or Export the View

Cancel: This will close the Job Budget Comparison parameter entry panel

18.15 Job Closing

This screen allows you to select one or more Job Orders from a list and change their status to ‘
Closed’.  The displayed list shows all Job orders - each with a checkbox for you to select it to be ‘
Closed’.  An Additional field ‘Allow Close’ is automatically ‘checked’ if the Job Order has no
outstanding Purchase receipts linked to a Job Order Line.  You can override this by ‘checking’ this
checkbox if you want to close the Job Order.  It is only when both these fields are ‘checked’ will
Ostendo ‘Close’ the Order

Entry and Display fields

Select: ‘Check’ this checkbox if you wish Ostendo to change the Job Order Status to ‘Closed’ 

Order Number: Display only field showing the Job Order Number 

Order Status: Display only field showing the current Status of this Job Order

Order Date: Display only field showing the date the Job Order was raised

Description: Display only field showing the description of the Job Order
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Job Type: Display only field showing the Job Type held against this Job Order

Job Style: Display only field showing the Job Style being used by this Job Order

Invoice Style: Display only field showing the Invoice Style being used by this Job Order

Order Start: Display only field showing the Start date of the Job Order

Order Finish: Display only field showing the Planned Finish date of the Job Order

Customer: Display only field showing the Customer held against this Job Order

Job Category: Display only field showing the Job Category held against this Job Order

Planned Cost: Display only field showing the Planned Cost of this Job Order

Actual Cost: Display only field showing the total Actual Cost of this Job Order

To Be Invoiced: Display only field showing the activities that are still awaiting Invoicing from this
Job Order

Invoiced Value: Display only field showing the current value of all Invoices raised against this Job
Order 

WIP Value: Display only field showing the WIP Value contributed by this Job Order

Non-Charge Cost centre: This is the non-charge Cost Centre defined against the Job if the
Invoice Style is ‘Non-Charge’.  It can be amended here if required by selecting the Cost Centre
from the drop-down list

Outstanding Purchases: Display only field showing the number of Purchase Order Lines linked to
this Job Order that have still to be received

Close Date: This shows the date that will be attached to Journals generated by ‘Closing’ the Job
Order.   It is a display only field and is evaluated from (The Last transaction Date carried out
against this Order) or (The Financial Cut-off Date plus 1 day) whichever is the later.

Allow Close: This is pre-‘checked’ if the Job Order has no outstanding charges to be Invoiced
AND the ‘Outstanding Purchases’ field is zero.  This field must be ‘checked’ before the Order can
be closed.  If you wish to override the system evaluation then you can ‘check’ or ‘uncheck’ this field
as required

Last Invoice Date: This shows the date of the last invoice issued.

Side Buttons

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the screen was opened or the last time the ‘Save’ Button was
pressed will be lost.

Related: This will bring up a list of functions that are related to Job Orders.  You may open and
maintain information in those screens whilst still remaining in this screen.

Reports: This will bring up a list of Reports that are related to the Job Orders.  You can
immediately run the report whilst still remaining in this screen.
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Lower Buttons

Cancel: This will exit the current screen without taking any action

Close Selected Assembly Order: Those Lines whose both ‘Select’ and ‘Allow Close’ checkboxes
are ‘checked’ will change the Job Order Status to ‘Closed’

18.16 Settings

18.16.1 Project Types

This screen allows you to maintain a list of Project Types, which are used to group Projects for
analysis and reporting purposes

Entry and Display fields

Project Types: Enter the Type of Project you wish to record for analysis and reporting purposes.
Duplicates not allowed.

Description: Enter a short description of the Project Type.  No checks are made on this entry

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Project Type screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Project Type.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Project Type.

18.16.2 Job Types

This screen allows you to maintain a file of Job Types, which are used when creating Job Orders
to segregate the Type of order being created.  These can be, for example:

· Standard
· Internal
· Service

Entry and Display fields

Job Type: Enter the Name of the Job Type.  Duplicates not allowed.

Job Style: From the drop-down list select the Job Style.  The options are:
· Customer - Order linked to a specified Customer
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· Customer Asset - Order linked to a Customer Asset that you are servicing
· Company Asset - Order linked to your own (internal) Asset that you are servicing
· Rental - Order linked to a Company Asset that you are renting

Invoice Style: From the drop-down list select the Invoice Style.  The options are:
· From Actual Entries - Billing what was used
· From Schedule - Billing to an agreed price
· No Invoice - Used for in-house maintenance, etc

Description: Enter a short description of the Job Type.  No checks are made on this entry

Creation Status: From the drop-down list select the status of the Job when it is created using this
Job Type.  The options are:

· Planned
· Open
· In Progress
· Finished
· On-Hold
· Closed

Numbering: From the drop-down list select the way in which Job Orders are numbered.  The
options are:

· Automatic - commencing from the number set up in File>System Configuration>System
Settings

· Manual - manually entered at time of Order creation

Prefix: You have the option to provide a prefix to the Automatically generated Order Number.   For
example: if the Prefix was ‘WO-‘ then the generated Order could be ‘WO-12345’

Show Costs: If this is ‘checked’ then Job Costs will be displayed on the Job Order screen.  If it is
not checked then costs can only be viewed from the Job Value screen

Display Lines Value Bar: If this is ‘checked’ then the ‘Lines Value’ Bar will be displayed on the
Job Order Lines panel 

Default Template Code: This is an optional entry field that defines the default Template Code to
be used whenever this Job Type is selected.  It can, of course, be amended during Order creation
is required. 

Stop Invoicing if Receipts are due: If this is ‘checked’ then, you will not be allowed to generate
an Invoice if lines on the Job have a Remaining Qty and have unreceipted Supply Orders

Simplified Scheduling: If this is ‘checked’ then the Job Scheduling information is not shown on
the Job Detail screen

Default Cost Centre: This is only enabled if the ‘Invoice Style’ is ‘No Invoice’.  When active select
the default Cost Centre from the drop-down list.   This Cost Centre is used in one of three ways:

· If the Job Type’s ‘Create an Item’ checkbox against this entry is not checked then this is
the default Cost Centre to where Costs are posted when the Job Order is ‘Closed’.  If a
Cost Centre is not entered here then the system-wide Cost Centre identified against ‘Job
Cost Variance’ (in screen File>Financial Configuration>Cost Centre Mapping) will be used.

· If the ‘Create an Item’ checkbox is ‘checked’ and field ‘How Item is valued’ contains ‘Cost’
then the actual Cost will be used when receipting the Item into stock and no Inventory
variance will occur.  Therefore the above default Cost Centre will not be used.

· If the ‘Create an Item’ checkbox is ‘checked’ and field ‘How Item is valued’ contains ‘Price’



1088 Ostendo Reference Guide

then the current Sell Price against the Job Order Line will be used when receipting the
Item into stock and the difference between that Sell Price and the Job Cost will be posted
to the above Cost Centre.

Create an Item: This is only enabled if the ‘Invoice Style’ is ‘No Invoice’.  If ‘checked’ then an Item
will be produced by this Job and that will be received into Stock. 

How Item is Valued: This is only enabled if the ‘Invoice Style’ is ‘No Invoice’ and the ‘Create Item’
field is ‘checked.   When active then select the option from the drop-down list.  The options are:

Cost: The actual Costs booked against the Job Order will be used
Price: The current Sell Price as held against the Item in the Job will be used

Calendar Info Hint:  The content of this field will be presented in a ‘Pop-Up’ whenever the cursor
is positioned over the Job activity in the Job Calendar.  The content of this can be plain text or can
include fields from the Job Header database.  These fields will be populated with the information
specific to the Job Order.  For example: You may wish to show the Customer’s primary contact
and telephone number.  Therefore the text could be

Customer = [CUSTOMER]
Phone = [ORDERPHONE]
Contact = [ORDERCONTACT]

When the cursor is positioned over the activity the following would be displayed

Customer = Jim Gold & Co Ltd
Phone = 44 312 587 6544
Contact = Ken Jolly

The fields in the square brackets are taken from the JobHeader table.  To see the available fields
go to General>Reports>Full Listing of Tables and select JobHeader

No Work In Progress:  If this is ‘checked’ then - when an invoice is generated for the job, only
revenue will be posted. All issues to the job will go straight to the Cost of Goods Sold account
(based on the Sales Mapping Matrix Rules).

Hazard Group:  You can associate the job type with a set of standard risks or hazards by
selecting the appropriate (pre-defined) Hazard Group. Hazard Groups are defined in the General
menu.

Style Name : You can select a Style Template Name  as the default Freeway Style Template for
this job type. 

Status: The default status is 'Active'.  If you wish to make this status 'Inactive' then select it from
the drop-down list.  Once selected the Job Type will NOT be visible when creating new Jobs

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Job Types screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Job Type.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Job Type.

18.16.3 Job Type Posting Template

This screen allows you to predefine cost centre mapping rules by Job Type

Entry and Display fields

Job Type: From the drop-down list select the Job Type to which this Template will be related.  
Job Types are maintained via Jobs>Settings>Job Types

Income Cost Centre: From the drop-down list select the Cost Centre relating to Income.    

COGS Cost Centre: From the drop-down list select the Cost Centre relating to the Cost Of Goods
Sold.    

Ratio: Enter the Ration by which the entered Cost will be apportioned

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Job Type Posting Template screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Job Type Posting Template.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Job Type Posting Template. 

18.16.4 Job Categories

This screen allows you to maintain a list of Categories, which are used to group and analyse Job
Orders

Entry and Display fields

Category Name: Enter the Name of the Category.   Duplicates not allowed.

Description: Enter a short description of the Category.  No checks are made on this entry

Status: You can make a job category to be either "Active" or "InActive".
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Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Category screen.  If you have any unsaved data then you will be asked if
you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Category.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Category.

18.16.5 Job Tracking

This screen allows you to maintain a file of Job Tracking Codes, which are used to track a Job
Order through it’s ordering, processing, delivery and receipt process.  Job Tracking Codes are
User-defined and can include such codes as:

· In Quarantine
· Awaiting Customer

Entry and Display fields

Tracking Code: Enter the Name of the Tracking Code.  Duplicates not allowed.

Description: Enter a short description of the Tracking Code.  No checks are made on this entry

Tracking Colour: From the drop-down list select the colour that you wish to associate with this
Tracking Status.  This will be displayed on the Job Order ‘List’ view when that field is selected for
display.

Exclude from Mobility: Tick this box if you wish to exclude this Tracking Code from being used in
Freeway Mobility.

Status: You can set the Tracking Code as "Active" or "InActive".

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Tracking Code screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Tracking Code.
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Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Tracking Code.

18.16.6 Task Names

This screen allows you to maintain a file of standard Tasks, which are used in Job Orders to
facilitate sub-dividing the Order into logical operational Tasks.   Task Names are User-defined and
can include such names as:

· Preparation
· Installation
· Commissioning

Entry and Display fields

Task Name: Enter the name of the Task.   Duplicates not allowed.

Task Status: Select either "Active" or "InActive" .

Description: Enter a short description of the Task.  No checks are made on this entry.

Department: From the drop-down list select the Department to which this Task belongs.
Departments are maintained via General>Settings>Departments

Default Mobility Template: From the drop-down list select the mobility Style Template that will
be used with this taskname. 

For mobility users, this setting will mean that only this Style Template will be used for this jobtask
and they cannot override it with another template.

No Scheduling: Tick this box to stop this task from being scheduled.

Data Display Options

Field Position - On this screen you can move the field position by dragging the column heading
left or right to the position where you want it to appear.

Buttons

Close: This will close the Task Name screen.  If you have any unsaved data then you will be
asked if you wish to save it before the screen is closed.

Add: This will send the cursor to a new line for entry of a new Task Name.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Delete: This removes the current highlighted Task Name.

Set Default: If you highlight a record and click this Button then the Default Task will appear at the
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top of the screen.  The Default Task is used when no Task is specified when creating a Job Order.
This can be amended at any time.       

18.16.7 Job Rules

This screen allows you to maintain Job Rules.  Job Rules allow you to define what rules, within the
Job Order area, you wish to apply.  The following rule settings are available

Entry and Display fields

Show Add-On Sales Message: ‘Check’ this checkbox if you would like the Job Lines entry panel
to show when an Item has ‘Add-On’ Sales associated with it.

Show Stock Warning Message: ‘Check’ this checkbox if you would like the Job Lines entry panel
to show when an Item has insufficient stock to satisfy the line being created.

Planned Item Cost Method: From the drop-down list select the method by which costs should be
used for stock Items.  The options are:

· Last Cost
· Standard Cost
· Buy Price
· Average Cost

Planned Descriptor Cost Method: From the drop-down list select the method by which costs
should be used for Descriptors.  The options are:

· Last Cost
· Standard Cost
· Buy Price

Planned Labour Cost Method: From the drop-down list select the method by which costs should
be used for Labour.  The options are:

· Last Cost
· Standard Cost

Planned Kitset Cost Method: From the drop-down list select the method by which costs should
be used for Kitsets.  The options are:

· Last Cost
· Standard Cost
· Buy Price
· Calculated

Planned Task Bill Cost Method: From the drop-down list select the method by which costs
should be used for Task Bills.  The options are:

· Last Cost
· Standard Cost
· Buy Price
· Calculated

Default Duration Scale: From the drop-down list select the default time elements that will prefill
Job Screens.  You may still amend the time element in the specific Job.  The options are:

· Minutes
· Hours

Default Estimated Duration: Enter a number of Minutes or Hours that will prefill Job Screens.
You may still amend the duration in the specific Job.  
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Completion Unit Cost Tolerance: Enter a percentage tolerance by which the Job Values routine
can assume that the Task or Job is complete.

Completion Estimating Level: From the drop-down list select the level at which you wish to apply
a user estimate of completion.  The options are Task Level or Job Level.  The Task Level will
provide a more accurate assessment of projected Job Costs but will incur more detailed input.

Invoice Approvals: ‘Check’ this checkbox if you wish to include Invoice Approvals into the
Invoicing Process.  I.e.

· If this is checked then User Signon Codes designated as having ‘Approval’ rights will
approve Job Invoices before they can be printed/posted.

· If this is not checked then the ‘Approval’ process will not be used.

Job Issue Approvals: ‘Check’ this checkbox if you wish to include Job Issue Approvals into the
Job Issue Process.  I.e.

· If this is checked then User Signon Codes designated as having ‘Approval’ rights will
approve Job Issues before they are posted.

· If this is not checked then the ‘Approval’ process will not be used.

Quote Expiry Days: Enter the number of days that a Quotation will remain valid.  When creating a
Job Quote this number of days will be added to the Quote Creation date to arrive at a Quote Expiry
date. 

Default Job Type: From the drop-down list select the Job Type that will be used whenever a Job
Order is being created.  Job Order Types are maintained via Jobs>Settings>Job Types.

How to post non-charge costs: From the drop-down list select the method by which you wish to
post costs for 'actual' bookings that are not to be included in an Invoice.  The options are:

· Post to Job Cost of Goods
· Post to a non-charge Type (Cost Centre)

New Order Start Tab: From the drop-down list select the preferred tab that will appear when
creating a Job Order.  The options are:

Detail: shows the Customer information for confirmation and amendment
Lines: Goes straight to Job Order Line entry .  You can still click on the Detail tab if you
wish to amend the Customer and Order Header information

Required Date Lead Time: Whenever a new order is created the ‘Required Date’ shown on the
order creation screen will be calculated from the System Date plus this Leadtime.  Of course the
date can be amended during Order creation if required.

Default Order Line Type: From the drop-down list select the Job Order Line Type that will be
used as the default to prefill the Order Line entry screen.   The options available are:

· Item Code
· Descriptor Code
· Labour Code
· Kitset Code
· Catalogue Code

Default Quote Header Notes: From the drop-down list select the name of the ‘Frequently Used
Text’ whose Text/Phrase will prefill a Job Quote Header.  You can amend the Text/Phase in the
Job Quote Header, if required, and make the text specific to that Order.  You can maintain
Frequently Used Text by going into General>Frequently Used Text

Default Quote Footer Notes: From the drop-down list select the name of the ‘Frequently Used
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Text’ whose Text/Phrase will prefill a Job Quote Footer.  You can amend the Text/Phase in the Job
Quote Footer, if required, and make the text specific to that Order.  You can maintain Frequently
Used Text by going into General>Frequently Used Text

Default Quote Style: From the drop-down list select Quote Style that will be used as the default.
The options are:

Formal: Standard style quote showing Job Order Lines
Letter: Letter Style showing descriptive narrative and single Quoted Price
User: Populated with the ‘Formal’ style fields for you to amend as required

You can amend the Default Quote Style in the Job Quote Header and make it specific to that
Order. 

Default Quote Print Lines: From the drop-down list select the Default Print Line format.  Two
options are available from the drop-down list:

Print Detail Lines: All the Lines in the Quotation will be printed
Print Single Line: The text in the next field will be printed

You can amend the Default Quote Print Lines in the Job Quote Header and make it specific to that
Order. 

Default Quote Line Description: Enter a short description that will become the default description
when creating a Quote against a Job.  You can amend the Default Quote Line Description in the
Job Quote and make it specific to that Order.

Order Speed Entry: If this is 'checked' then, on the Job Order Lines screen, a new entry is
available under the ‘Related’ button called ‘Set Speed Order Entry'.  This will show all the fields
that are in the lower part of the Order Line screen.  You can ‘check’ those fields that you want to
enter data into.  When entering a line the cursor will go to the selected field(s) when the ‘Enter’ key
is pressed.  NOTE: In the Speed Entry Screen you can also define the ‘tab order’ by dragging the
field and moving it further up or down the list.

Display Dimensions: If this is ‘checked’ then the Job Order will show Weight, Volume, and Area
against each Order Line plus summated values at the Order Header level

Use Line Cost for Purchase: If this is ‘checked’ then if the Unit Cost is amended in a Job Line
then that Cost is used as the Purchase Buy Price rather than the pre-defined Buy Price against the
Item or Descriptor

Default Price Changed with Cost: On the Job Lines screen a checkbox is available that defines
if Price is changed with Cost, Margin or Markup.   This field sets the default to whether it is
'checked' or not

Allow Printing for Planned Status: If this is 'checked' then the Job Sheet can be printed when
the Order status is 'Planned'.  If it is not 'checked' then you must change the Order Status away
from 'Planned' before printing is allowed.

Job WIP Variance Reporting Style:  If a Job’s status is changed to ‘Closed’ then any residual
costs for that Job remaining in Work In Progress will be posted to the Cost Centre defined by this
Rule.  The options are:

· Cost of Goods Sold
· WIP Variance

Optional Credit Blocking: By default Ostendo will allow you to complete the current Order  but
place the order ‘On Hold’ when the Credit Limit has been exceeded.  You are then NOT allowed to
create additional Orders.   If this flag is set then you can create additional Orders and they will also
be placed ‘On Hold’.  The status of ‘On Hold’ will prevent picking or delivery

Schedule Price Style:  This applies to ‘From Schedule’ Invoice Style Jobs only and defines the
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way in which current scheduled Invoices are affected when additional Lines (example - Variations)
are subsequently added to the Job.  From the drop-down list select the preferred option.  These
are:

Fixed Percent: The Planned Percentage values held against the current Scheduled
Invoices is not amended and the monetary amount of the additional Line is apportioned
across these Planned Invoices by this Planned Percentage value
Fixed Value: The Planned Monetary amount held against the current Scheduled Invoices
is not amended and the monetary amount of the additional Line is displayed in the ‘
Unscheduled Job Value’ field.  You would then be required to either create a new
Scheduled Invoice for this amount and/or apportion it across the current Scheduled
Invoices

Create PO Receipts from Job Issues:  If this is 'Checked' then whenever an issue is made
against a Job Line that has a Line Source of 'Source on Demand' and is Purchased then, Ostendo
will also create a PO Receipt record from the Supplier defined against this Line Source record.  If
this is not 'Checked' then the Receipt record will not be automatically created and this action must
be carried out manually via screen Purchasing>Purchase Receipts

Use Line Notes for Purchase:  If this is 'Checked' then the Notes held against this Job Order Line
will be copied to the generated Purchase Order Line.

Touch Pad File Name: Click on the three dots icon and locate the .dat file that is to be used for
entry of Order Lines via a screen with Touch Pad facilities.  The .dat file is created via the Ostendo
Graphical Editor.

Auto Update Current Task on Issues:  If this is 'checked' then any issues are entered for an
order, the task associated with that issue is checked against the ‘Current Task’ held in the Job
header, and if it is a later task (based on sequence number) it automatically updates that to
become the "Current Task" for the Job. 

Job Invoice Numbering:  From the drop-down list select the Job Invoice Numbering option.  This
can be either:

Automatic: The auto numbering sequence defined in the System Numbering tab of
File>System Configuration>System Settings
Manual:The default pre-fill is constructed from the Job Number PLUS a suffix indicating the
number of Invoices created for the Job

Quote Followup required: 'Check' this checkbox if you require a Quote Followup.This rule
combined with the next rule (Followup days from Quote Date) creates a follow-up email (if
activated in Email Services) and queue services is running.  

Followup Days from Quote date:  Enter the number of days from the Quote Date when you want
to trigger a Followup Email.

Invoice Schedule Posting Style: This is used with Scheduled Invoices only and defines the exact
Cost Centres (ledger codes) posted to.  An extra tab (Cost Centre Mapping) appears on the
'Invoices' screen in Job Invoices which is automatically populated via one of the following three
rules which is selected here from the drop-down list.

Standard: Defaults both Cost Centres based on the Sales Mapping Matrix rules for the
Descriptor Code used in the Scheduled Invoice record
Job Type Posting Template: Uses the Cost Centres and their ratio’s defined in the new ‘
Job Type Posting Template’ screen
Job Lines Sales Mapping: Determines the Cost Centres and their ratio’s from the Lines in
the Job Order and the Sales Mapping Matrix rules associated with each
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Job Actuals Sales Mapping: Determines the Cost Centres and their ratio’s from the Actual
Issued Lines in the Job Order and the Sales Mapping Matrix rules associated with each
issued job line. Each subsequent claim re-generates an adjusted Ratio based on the total
invoicing to date for that job. (See below for a fuller explanation and illustration).

Refresh Invoice Schedule Posting Cost Centres on Invoice Creation: If this is 'checked' then,
upon creation of an Invoice the Posting Cost Centres (see previous Rule 'Invoice Schedule Posting
Style') will be refreshed.

Make a Copy of Converted Quotes:  If this is 'checked' then a copy of the quote is made at the
time it’s converted to an order.  It suffixes the quote number with a ‘@99’ – where the 99 indicates
the quote revision number.

Allow Costs to be posted to Quotes:  If this is 'checked' then costs may be entered against Job
Quotes (Note: only for standard Job Lines, not Task Bills).  This will also allow Job Quotes to be
selected from within Timesheets. The costs are immediately posted to the cost centre as defined
in the Sales Mapping Matrix and are flagged as Non-Charge

Default Job Close Date:  Select either "Last Transaction Date" or "Actual Close Date". With this
selection you can set the default Job Close date to be either the date of the last transaction applied
to the job or the date the job was actually closed.

Job Delivery Default Issue Mode:  Select the default issue mode for Job Delivery - ISSUE, NO
ISSUE, or NEVER ISSUE. The difference between "No Issue" and "Never Issue" is that you can
still override "No Issue" (and change it to Issue) when creating Job Deliveries; but not "Never
Issue".

Default Assign Style:  Select one of the following:
Standard Job - This means the job will be

removed from the "To-Be-Assigned" list in the Assignment Board once it is assigned to a resource
on the board.

Continuous Job - This means the job is always
available in Freeway app until it is Finished or Closed. It will not appear in the Assignment Board.

Continuous Assignment - This means the job will always
remain on the "To-Be-Assigned" list in the Assignment Board, no matter how many times it has
been assigned (so long as it is not Finished or Closed).  

Job Line Price Rolled-Up from Contents : Tick this box to set the default for Content Price
Rollup in the Job lines screen. This is applicable only to Task Bill and Kitset lines.

Buttons

Close: This will close the Job Rules screen.  If you have any unsaved data then you will be asked
if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.

Invoice Schedule Posting Style

‘Job Actuals Sales Mapping’
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Determines the Cost Centres and their ratio’s from the Actual Issued Lines in the Job

Order and the Sales Mapping Matrix rules associated with each issued job line. Each

subsequent claim re-generates an adjusted Ratio based on the total invoicing to date

for that job.

This is typically used for Fixed Priced type work, where we wish to reflect the COS and

Revenue entries based on the Actual Issues and Prices of the job lines. (eg: Labour

Value Vs Material Value to be posted in the financials against their respective GL

accounts.)

Example Tutorial:

Let’s say a job consists of two lines. One line has a Labour Code (Item ‘A’) and the

other an Item Code (‘Item ‘B’) linked to their respective Categories. Each of these

categories have Sales Mapping Matrix rules setup to determine the Revenue and COS

Cost Centres.

When Item ‘A’ is invoiced the matrix will:

DR Cost Centre ‘COS-LABOUR’

CR Cost Centre ‘INC-LABOUR’

When Item ‘B’ is invoiced the matrix will:

DR Cost Centre ‘COS-GENERAL’

CR Cost Centre ‘INC-GENERAL’

Now create a Schedule Type Job with a Fixed Price of say $10,000

Insert Item A with a Unit Sell Price of $55.00

Insert Item B with a Unit Sell Price of $500.00

Issue a Qty of 5 against Item A with an Actual Unit Cost of $41.00

Issue a Qty of 3 against Item B with an Actual Unit Cost of $140.00

Summary:

Item ‘A’ Total Ext Price = Act Qty * Unit Price (5 * $55 = $275)

Item ‘A’ Total Act Costs = Act Qty * Act Unit Cost (5 * $41 =

$205.00)

Item ‘B’ Total Ext Price = Act Qty * Unit Price (3 * $500 = $1500)

Item ‘B’ Total Act Costs = Act Qty * Act Unit Cost (3 x $140 = $420)

Now create a progress claim of $2000.00

Ostendo will ratio the costs and revenue based on the items that have been issued on

the job. (These ratios can be seen on the Job Invoices, Cost Centre Mapping Tab

Eg:
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Item ‘A’ Ratio:

Item ‘A’ Ext Total Ext Price / Total Ext Price of all issued lines * 100

$275 / ($275 + $1500) * 100 = 15.493

Item ‘B’ Ratio:

Item ‘B’ Ext Total Ext Price / Total Ext Price of all issued lines * 100

$1500 / ($275 + $1500) * 100 = 84.507

These ratios are now used to calculate the respective Cost Centre postings

COS-LABOUR = (Item ‘A’ Ratio * Total Ext Costs of all issued lines) / 100

(15.493 * ($205 + $420)) / 100 = $96.83

INC-LABOUR = (Item ‘A’ Ratio * This Total Claim Amount) / 100

(15.493 * $2000) / 100 = $309.86

COS-GENERAL = (Item ‘B’ Ratio * Total Ext Costs of all issued lines) / 100

(84.507 * ($205 + $420)) / 100 = $528.17

INC-GENERAL = (Item ‘B’ Ratio * This Total Claim Amount) / 100

(84.507 * $2000) / 100 = $1690.14

It should be noted that future issues will potentially alter the overall mix of ratios,

therefore there could be some instances where negative ratios will be generated on

subsequent claims simply because the overall invoiced proportions of the job need to

be re-adjusted.

Whilst individual ratios may seem odd at times the overall totals for the job will be

reflective of actual issues to date.
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18.16.8 Job Calendar Rules

This screen allows you to maintain Job Calendar Rules.  This allows you to define the way that you
use the Calendar.  The following rule settings are available

Entry and Display fields

Calendar Days Back: Enter the number of days in the past that Ostendo will evaluate the
Calendar details before displaying the calendar.  Once the calendar is displayed you can amend
the selection for that view from a drop-down calendar on the toolbar

Calendar Days Forward: Enter the number of days in the future that Ostendo will evaluate the
Calendar details before displaying the calendar.  Once the calendar is displayed you can amend
the selection for that view from a drop-down calendar on the toolbar

Display Allocation Inquiry: If this is 'checked' then an Inquiry panel will be displayed at the
bottom of the Job Calendar.  The content of that display is defined by the queries entered into the
next two fields.

Allocation Inquiry SQL: Enter the SQL query that will define the displayed fields and format  of
the Inquiry Panel (shown at the bottom of the Calendar View) whenever an Allocation is selected

Calendar Inquiry SQL: Enter the SQL query that will define the displayed fields and format  of the
Inquiry Panel (shown at the bottom of the Calendar View) whenever the selection is made outside
of an Allocation.

18.16.9 Job Quote Change Rules

This is used to flag what, if any, quotes changes have been made when either converting the
Quote to an Order or when run from Job detail tab.  Tolerance percentages can be defined against
the Cost & Price logging therefore reducing the sensitivity.  

Log Cost Changes: If this is 'checked' then any change to the Cost will be recorded if the
change is outside the tolerance specified in 'Cost Tolerance %'
Cost Tolerance %: Enter the percentage tolerance against which a change record is
triggered
Log Std Buy Price Changes: If this is 'checked' then any change to the Std Buy Price will
be recorded if the change is outside the tolerance specified in 'Buy Price Tolerance %'
Buy Price Tolerance %: Enter the percentage tolerance against which a change record is
triggered
Log Std Sell Price Changes: If this is 'checked' then any change to the Std Sell Price will
be recorded if the change is outside the tolerance specified in 'Sell Price Tolerance %'
Sell Price Tolerance %: Enter the percentage tolerance against which a change record is
triggered
Log Item Revision Changes: If this is 'checked' then any change to the Item Revision will
be recorded.
Log Code Status Changes: If this is 'checked' then any change to the Code Status will
be recorded.
Log Primary Supplier Changes: If this is 'checked' then any change to the Primary
Supplier will be recorded.
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Buttons

Close: This will close the Job Quote Change Rules screen.  If you have any unsaved data then
you will be asked if you wish to save it before the screen is closed.

Save: This will save the current data without exiting the screen

Cancel: Any changes made since the line was actioned or the last time the ‘Save’ Button was
pressed will be lost.
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